# Table of Contents

**Employee Service Management** .................................................................................................................................................................................. 1

HR Service Delivery ......................................................................................................................................................................................... 4.5

HR Service Delivery overview ........................................................................................................................................................................... 11

Safe Workplace ................................................................................................................................................................................................. 14

Emergency Response Management ................................................................................................................................................................... 317

Case and Knowledge Management ................................................................................................................................................................. 410

Enterprise Service Management Integrations Framework ............................................................................................................................ 753

HR Service Delivery Integration with Cornerstone OnDemand ...................................................................................................................... 759

HR Service Delivery integration with Workday ........................................................................................................................................... 765

HR Service Delivery Advanced Integration with Workday ............................................................................................................................. 772

HR Service Delivery with Ultimate Kronos Group ........................................................................................................................................ 781

Employee Service Center .................................................................................................................................................................................. 786

Journey Accelerator ............................................................................................................................................................................................... 922

Enterprise Onboarding and Transitions ........................................................................................................................................................ 946

Learning Posts .............................................................................................................................................................................................................. 1044

Alumni Service Center .................................................................................................................................................................................... 1046

Employee Document Management ................................................................................................................................................................. 1053

Employee Experience Pack .................................................................................................................................................................................. 1106

HR Predictive Intelligence Workbench ............................................................................................................................................................ 1116

HR Service Delivery Agent Workspace .......................................................................................................................................................... 1122

Machine learning solutions for HR Service Delivery .................................................................................................................................... 1235

User Experience for HR Service Delivery ...................................................................................................................................................... 1243

Performance Analytics for HR Service Delivery ........................................................................................................................................... 1245

Virtual Agent for HR Service Delivery ............................................................................................................................................................ 1257

Now Mobile app for HR Service Delivery ...................................................................................................................................................... 1263

Mobile Onboarding ............................................................................................................................................................................................. 1277

Domain separation and HR Service Delivery .................................................................................................................................................. 1284

Quick start tests for HR Service Delivery ...................................................................................................................................................... 1285

Migration from Legacy to Scoped HR ............................................................................................................................................................. 1291

HR Service Delivery Legacy ............................................................................................................................................................................ 1300

Workplace Service Delivery ............................................................................................................................................................................. 1449

Workplace Service Delivery applications .................................................................................................................................................... 1456

Workplace Safety Management .......................................................................................................................................................................... 1457

Workplace Reservations Management ............................................................................................................................................................ 1529

Workplace Case Management ........................................................................................................................................................................... 1568

Workplace Visitor Management ......................................................................................................................................................................... 1595

Workplace Calendar Synchronization ............................................................................................................................................................. 1612

Workplace Space Mapping .................................................................................................................................................................................. 1627

Workplace Space Management ............................................................................................................................................................................ 1635
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace Reservations for Microsoft Outlook Add-in</td>
<td>1655</td>
</tr>
<tr>
<td>Legal Service Delivery</td>
<td>1663</td>
</tr>
<tr>
<td>Legal Request Management</td>
<td>1664</td>
</tr>
<tr>
<td>Legal Matter Management</td>
<td>1689</td>
</tr>
<tr>
<td>Legal Conflict of Interest</td>
<td>1710</td>
</tr>
<tr>
<td>Legal Digital Forensics</td>
<td>1719</td>
</tr>
<tr>
<td>Legal Simple Contracts</td>
<td>1737</td>
</tr>
<tr>
<td>Legal Stock Preclearance</td>
<td>1757</td>
</tr>
<tr>
<td>Legal Virtual Agent Conversations</td>
<td>1766</td>
</tr>
<tr>
<td>Legal Mobile</td>
<td>1772</td>
</tr>
<tr>
<td>Security in Legal Service Delivery</td>
<td>1781</td>
</tr>
<tr>
<td>Legal Service Delivery dashboard</td>
<td>1782</td>
</tr>
<tr>
<td>Domain separation and Legal Service Delivery</td>
<td>1785</td>
</tr>
<tr>
<td>Universal Request</td>
<td>1786</td>
</tr>
<tr>
<td>Exploring Universal Request</td>
<td>1787</td>
</tr>
<tr>
<td>Setting up and configuring Universal Request</td>
<td>1797</td>
</tr>
<tr>
<td>Using Universal Request</td>
<td>1824</td>
</tr>
<tr>
<td>Reporting solutions for Universal Request</td>
<td>1831</td>
</tr>
<tr>
<td>Universal Request reference</td>
<td>1835</td>
</tr>
<tr>
<td>Integrating Universal Request with other applications</td>
<td>1840</td>
</tr>
<tr>
<td>Quick start test for Universal Request</td>
<td>1840</td>
</tr>
<tr>
<td>Universal Request in Agent Workspaces</td>
<td>1841</td>
</tr>
<tr>
<td>Universal Task</td>
<td>1850</td>
</tr>
<tr>
<td>Exploring Universal Task</td>
<td>1851</td>
</tr>
<tr>
<td>Setting up and configuring Universal Task</td>
<td>1856</td>
</tr>
<tr>
<td>Using Universal Task</td>
<td>1866</td>
</tr>
<tr>
<td>Universal Task reference</td>
<td>1871</td>
</tr>
<tr>
<td>ServiceNow for Microsoft Teams</td>
<td>1874</td>
</tr>
<tr>
<td>Overview of IT Service Management integration with Microsoft Teams</td>
<td>1878</td>
</tr>
<tr>
<td>Overview of HR Service Delivery integration with Microsoft Teams</td>
<td>1962</td>
</tr>
<tr>
<td>Using ServiceNow for Microsoft Teams</td>
<td>2044</td>
</tr>
<tr>
<td>Now Mobile app</td>
<td>2077</td>
</tr>
<tr>
<td>Now Mobile app demo</td>
<td>2078</td>
</tr>
<tr>
<td>Configurations for Now Mobile</td>
<td>2083</td>
</tr>
</tbody>
</table>

**Index** ............................................................................................................. a
Employee Service Management

Create connected, engaging experiences for your employees by using digital workflows with ServiceNow® Employee Service Management.

Boost employee productivity and engagement

Delivering easy access to employee services is more important than ever. Employee Service Management provides connected digital workflows, such as automated onboarding processes, that give your new hires everything they need to succeed from day one. As employees continue their journey with your organization, you can provide HR and IT support that makes it easy for them to request time off, relocate to a different facility, or upgrade equipment. Your employees can get what they need, when they need it by maintaining communication through Slack, Virtual Agent for HR Service Delivery, and other channels. Whether your employees are working from home or on-site, intuitive workflows make it easy to break down siloed processes and build bridges between departments. In a constantly changing workforce, using Employee Service Management to clear logistical obstacles provides a painless employee experience and optimum employee productivity.

Streamline employee processes

Make it easy for employees to navigate complex processes and get the information they need in their preferred channels.

Manage a safe, efficient workplace

Automate steps for a safer return to the workplace and always keep your employee’s safety in mind.
Create new ways to work

Reinvent your organization to increase productivity and gain insights into a changing workforce.

Foster cross-functional collaboration

Provide a unified employee experience across IT, HR, facilities, legal, and other organizations.

Streamline employee processes

Deliver workflows that help employees to navigate complex processes like onboarding, location changes, seeking legal services, and completing to-dos. With Legal Service Delivery, provide employees with a single, unified mechanism to get the help they need from your legal department. By leveraging the Employee Service Center, ServiceNow for Microsoft Teams, or the Now® Mobile app, you can make sure that your employees can get the information and services they need any time, anywhere.
Manage a safe and efficient workplace

Prioritize the health and safety of your employees with the Safe Workplace suite. Establish trust with your employees through proactive communication. Provide employees with self-service reservations using distanced floor plans. You can also gauge employee readiness to return to the workplace, monitor personal protective equipment needs, and make informed decisions about workplace reopening.

Create new ways to work

Adapt the way you work to address the evolving needs of your employees. Gain valuable insight into the volume, types of requests, and the workloads that are handled by your teams. By deploying HR Service Delivery, Workplace Service Delivery, Legal Service Delivery,
and Universal Request, you can ensure that employee requests and inquiries are fulfilled quickly and efficiently. Use the Legal Counsel Center to enable the legal department to track, prioritize, and work on legal requests concurrently. Your employees can access these capabilities any time with Now Mobile for HR Service Delivery.

**Foster cross-functional collaboration**

Utilize Employee Service Management with other features of the Now Platform to optimize your employee experience. By integrating Service Portal, Walk-up Experience, and Service Catalog with Employee Service Management, you can provide your employees with streamlined interactions and easily accessible services across departments. When you supplement other communication channels with Knowledge Management knowledge bases and articles, and provide answers to your employees quickly with Virtual Agent, your employees can get the help that they need any time.

**Get started**

- Work with an implementation specialist to achieve your desired business outcomes. To learn more, visit the Customer Success Center.
- Explore which other tools can optimize your Employee Service Management experience, like Service Portal, Walk-up Experience, Virtual Agent, Service Catalog, and Knowledge Management.

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

**Notice regarding use by government agencies**

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

**Products**

- Emergency Response Management
- Employee Service Center
HR Service Delivery

Unlock enterprise productivity and give your employees the service experience they deserve with ServiceNow® HR Service Delivery. By providing employees with a single place to manage their work needs while shielding them from back-end complexity, you can deliver a great experience to meet the demands of a modern-day workforce.

Put service at the heart of your business

By meeting employees where they are, you empower them to find answers, get help, and get things done with a simple swipe, click, or chat. Employees can self-serve through the Now Mobile app and Employee Service Center. Digital workflows drive action across any organizational function and can enable every department to service employees more efficiently and effectively. New hires are guided through the onboarding process with the Mobile Onboarding app, ensuring they’re ready to succeed from day one.
HR Service Delivery

Deliver a great employee experience by providing employees with a single place to manage their work needs while shielding them from back-end complexity.

Make it easy for employees to get HR services
Give employees anytime, anywhere access to HR services to increase satisfaction.

Organize employee interactions by functional discipline
Manage employee interactions in a structured and efficient manner, driving down the cost of service delivery.

Use HR Service Delivery to build great experiences
Replace manual and siloed processes with cross-functional digital workflows for increased efficiency.

Employee-focused service creates competitive advantage
The intelligent, intuitive, and mobile-first tech that transformed real life will radically transform work life.

Streamline and automate activities to reopen workplaces after an emergency
Assess workforce and workplace readiness as you prepare for employees to return to the workplace after an emergency or pandemic like COVID-19.
Streamline and automate activities in the face of an emergency
Mobilize your business continuity efforts during natural disasters and pandemics like COVID-19.

Make it easy for employees to get HR services
Give employees anytime, anywhere access to HR services to increase satisfaction.

Organize employee interactions by functional discipline
Manage employee interactions in a structured and efficient manner, driving down the cost of service delivery.

Use HR Service Delivery to build great experiences
Replace manual and siloed processes with cross-functional digital workflows for increased efficiency.

Employee-focused service creates competitive advantage
The intelligent, intuitive, and mobile-first tech that transformed real life will radically transform work life.

Streamline and automate activities to reopen workplaces after an emergency

ServiceNow® Safe Workplace applications help you get insights into the readiness and needs of employees to return to the workplace after an emergency or a pandemic like COVID-19. You can then automate workflows to prepare workspaces and safety equipment for their return.
Streamline and automate activities in the face of emergencies

Whether you are anticipating or are in the midst of an emergency, ServiceNow® Emergency Response Management applications automate workflows that help you assess and respond to events while keeping everyone in your organization informed and connected.

Make it easy for employees to get HR services

Give employees anytime, anywhere access to HR services to increase satisfaction. Omni-channel service through the Now Mobile app and Employee Service Center enables employees to find answers, make requests, and get help. You can integrate with existing HR management systems (HRMS), identity providers (IDP), background check, e-signature, tax form, and other services to improve operational efficiency. And you can simplify any process by using intelligent and automated answers to guide employees.
Organize employee interactions by functional discipline

Manage employee interactions in a structured and efficient manner, driving down the cost of service delivery. A purpose-built Centers of Excellence data model organizes HR data, services, and processes by functional discipline, enabling you to support all types of employee requests. You can deliver intelligence behind every interaction with virtual agents. And a standardized case and knowledge management system means that live agents have answers at their fingertips to provide help that is accurate, timely, and consistent.

Use HR Service Delivery to build and deliver great experiences

Replace manual and siloed processes with cross-functional digital workflows for increased efficiency. You can orchestrate activities across systems, departments, and people. Intelligent, no-code builders such as the lifecycle event builder enable you to easily configure digital workflows for onboarding and other important life events. And employees get always-on assistance from virtual agents that speak their language and learn from previous requests.
Employee-focused service creates competitive advantage

The intelligent, intuitive, and mobile-first technology that transformed consumers' lives will radically transform work life. HR Service Delivery groups key applications into scalable packages that can grow with your business. You can easily integrate HR Service Delivery with the existing cloud and on-premise HR management systems you are already using. And by enabling self-service, you drive down service delivery costs while providing help that is accurate, timely, and intelligent.

Get started

• Work with an implementation specialist to achieve your desired business outcomes. To learn more, visit the Customer Success Center.

• Take an HR Service Delivery course to build expertise and realize ROI faster. To sign up, see ServiceNow training and certification.

• Read the product documentation, beginning with the HR Service Delivery overview.

Applications and features

• Safe Workplace suite
• Safe Workplace Dashboard
• Contact Tracing
• Employee Readiness Surveys
• Employee Health Screening
• Workplace Safety Management
• Workplace PPE Inventory Management
• Employee Readiness Core
• Return to Workplace - Employee Experience Pack
• Employee Travel Safety
• Health and Safety Testing
• Vaccination Status
• Safe Workplace for mobile
• Emergency Response Management
• Emergency Outreach
• Emergency Self Report
Note:
The Mobile Onboarding is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the Now Mobile app for HR Service Delivery.

• Now Mobile app for HR Service Delivery
• Performance Analytics for HR Service Delivery
• Predictive Intelligence for HR Service Delivery
• Virtual Agent for HR Service Delivery

HR Service Delivery overview

The ServiceNow® HR Service Delivery application improves the employee service experience by automating HR interactions and providing a single platform for all HR services.

Safe Workplace applications

ServiceNow® Safe Workplace applications help you prepare your workforce and workplace to resume operations after emergencies and pandemics like COVID-19.

Employee Readiness Surveys

Use surveys to measure the preparedness of your workforce, gain insights into workforce readiness, and determine the actions needed to ensure user wellness, safety, and security.

Employee Health Screening

Screen users before entering the workplace to ensure compliance with the organization’s entry requirements, such as a temperature check and PPE. Require that users agree to comply with health and safety policies before they return to the workplace.

Workplace Safety Management

Easily define and reserve workspaces for a safe and managed process, including scheduled shifts and automated cleaning tasks.

Workplace PPE Inventory Management

Manage your organization’s PPE inventory levels across various locations and facilities to provide for the physical safety needs of your workforce.

Safe Workplace Dashboard

Get a centralized view of your workforce and workplace readiness for a safer, user-ready working environment. Quickly evaluate your ability to open sites and remain open, based on user and workplace readiness data from the ServiceNow® Safe Workplace applications.
Contact Tracing

Help employers reduce workplace transmission of infectious diseases, such as COVID-19, by identifying any on-site employees who might have been in contact with an affected employee.

Health and Safety Testing

Streamline the user health testing process to help organizations reduce the spread of infectious diseases in the workplace.

Employee Readiness Core

Track employee data across all Safe Workplace and ServiceNow® Emergency Response Management applications.

Enterprise Employee Experience Pack

Quickly implement enterprise-wide use cases across multiple departments using Enterprise Employee Experience Pack.

Employee Travel Safety

Help support safe travel for employees by verifying the site safety and policy compliance of destinations, monitoring employee health status, and keeping a contact log during travel.

Vaccination Status

With the ServiceNow® Vaccination Status application, HR departments can track the status of vaccination programs in the workplace and collect vaccination data for workforce planning and workplace readiness needs.

Safe Workplace for mobile

Manage the essential steps for return to workplace from anywhere using the Safe Workplace for mobile app.

Emergency Response Management applications

Emergency Outreach

Notify users of important information about anticipated or occurring emergency situations. Send an outreach notification via email, mobile push message, or SMS message to request a user response. You can also configure other preferred communication channels.

Emergency Self Report

During a crisis, the ServiceNow® Emergency Self Report application gives users a way to notify their organization of their health status. It also provides a workflow for qualified users to safely return to work. Managers and response teams can track user reporting.

Emergency Exposure Management

The ServiceNow® Emergency Exposure Management application helps identify users who might have been exposed to infectious diseases by analyzing multiple data sources such as meetings, location, shifts, Wi-Fi access logs, and badge scans of affected users.

HR Service Delivery applications

Depending on the HR Service Delivery package you choose, deploy one or more of the following applications.

Case and Knowledge Management

Standardize the documentation, interaction, and fulfillment of employee inquiries and requests, improving HR efficiency and services over time.
**Employee Service Center**

Provide a single, unified portal for employees to get all the information, services, and help that they need.

ℹ️ **Note:** Employee Service Center is also available as a standalone application.

**Enterprise Onboarding and Transitions**

Automate onboarding and other employee lifecycle events that span multiple departments, improving employee satisfaction and efficiency across HR and other departments.

**Supporting applications**

You can also deploy the following supporting applications.

- **Document Templates** to automate and simplify the process of filling, signing, and reviewing a document online.
- **Employee Document Management** to secure, retain, access, and purge employee files with ease using paperless document management. A separate subscription is required.
- **Employee Experience Pack** to guide you through the HR processes that require configuration.
- **HR Predictive Intelligence Workbench** to guide you through your predictive machine learning implementation to create intelligent HR processes.
- **HR Service Delivery Agent Workspace** to interact with employees, respond to inquiries, and resolve issues quickly as an HR agent.
- **Machine learning solutions for HR Service Delivery** to help in auto determining assignment groups and services for HR cases, auto creating cases from emails, and discovering knowledge articles that help in faster resolution of cases and tasks.
- **Performance Analytics for HR Service Delivery** to reduce HR inefficiencies by reporting and analyzing service delivery performance and quality. A separate subscription is required.
- **Virtual Agent for HR Service Delivery** to enable automated chats for employees requesting HR services.

**Mobile applications**

You can use the following mobile apps with HR Service Delivery.

- **Now Mobile app for HR Service Delivery**
  
  You can let your employees view HR requests, request help, complete HR tasks, receive targeted mobile content and push notifications, chat with a virtual agent, and more using the Now Mobile app for HR Service Delivery.

- **Mobile Onboarding**

  Enable your new hires to complete onboarding tasks, receive targeted mobile content and push notifications, view relevant media sections, chat with an agent, and more using the Mobile Onboarding app.

**Domain separation and HR Service Delivery**

Domain separation separates data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

- **Domain separation and HR Service Delivery**
Quick start tests for HR Service Delivery

Copy and customize quick start tests to validate that your instance works after you make any configuration changes, such as after applying an upgrade or developing an application.

• Quick start tests for HR Service Delivery

If you are on the legacy version of HR

The legacy (non-scoped) version of HR Service Delivery is only available for customers that went live with HR in Helsinki or earlier. New features and functionality are no longer supported on the legacy version and require migration to the scoped version of HR. The HR Migration tool is available to facilitate the migration process.

• Migration from Legacy to Scoped HR
• HR Service Delivery Legacy

Safe Workplace

ServiceNow® Safe Workplace applications help you reopen your workplaces and support the health and safety of your employees after emergencies and pandemics like COVID-19.

Workforce readiness

Help employees return to the workplace when they’re healthy and ready with the following Safe Workplace applications.

Employee Readiness Surveys

With the ServiceNow® Employee Readiness Surveys application, send surveys to help gauge whether users are ready to return to the workplace. Ask questions to get insights into how users feel about returning to work, their current health status, and underlying concerns such as personal health, family obligations, and anxiety about workplace safety. Based on responses, you can measure and determine the steps needed to help users feel safe and secure upon their return.

Employee Health Screening
The ServiceNow® Employee Health Screening application enables organizations to screen users before entering the workplace to ensure compliance with the organization’s entry requirements, such as a temperature check and personal protective equipment (PPE). Based on their own criteria, organizations can determine whether it’s safe for the user to enter the workplace. Organizations can use a reporting dashboard to view trends by sites and record the return of users into their facilities.

**Workplace readiness**
Prepare your workplace for the return of employees with the following Safe Workplace applications.

**Workplace Safety Management**

Using the ServiceNow® Workplace Safety Management application, quickly configure sanitized and socially distanced workspaces for the return of users. With department leaders, workplace service managers can reserve available workspaces for users in shifts. Workspaces can be scheduled for disinfection before and after these shifts. Through reports and dashboards, workplace managers can view how many of the available workspaces have been reserved. Workplace managers also have a real-time view of all cleaning task statuses, including a full audit trail history.

**Workplace Personal Protective Equipment Inventory Management**
The ServiceNow® Workplace Personal Protective Equipment Inventory Management application helps you manage and monitor workplace needs for safety equipment provided to your workforce. A dashboard provides a comprehensive view of inventory by each facility, an aggregate scope of the entire workplace, and historical data on how equipment levels have changed over time. You can update current inventory levels daily for accurate and real-time inventory management.

Use the Safe Workplace applications together to automate workflows for determining your employees' readiness and needs for returning to work, preparing sanitized and socially distanced workspaces, and managing the inventory of safety equipment for your workforce.

Use guided setup to implement Safe Workplace suite apps
The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Notice regarding use by organizations
All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the
application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Employee Readiness Surveys

The ServiceNow® Employee Readiness Surveys application lets you evaluate the readiness of your workforce to return to the workplace by asking users to complete a survey. Employee Readiness Surveys is an application that you install to use with Emergency Outreach. For information about Emergency Outreach and how surveys are sent via outreach notifications, see Emergency Outreach.

After you install the application, the check-in administrator for Emergency Outreach can view and edit the survey questions to suit your needs. New surveys can be added, for example, to evaluate users in different regions or address other concerns.
The check-in administrator sends the surveys to targeted audiences using the Emergency Outreach notification methods.

**Use guided setup to implement Safe Workplace suite apps**

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to **Guided Setup > Safe Workplace Guided Setup**. For more information about using the guided setup interface, see **Using guided setup**.

**Use with other Safe Workplace suite applications**

Employee Readiness Surveys is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- Before users re-enter workspaces, use the Employee Health Screening application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.
- With the Workplace Safety Management application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.
- You can manage the inventory of safety equipment for your workforce with the Workplace Personal Protective Equipment Inventory Management application.

All Safe Workplace suite applications are available in the **ServiceNow Store**.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030256] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030256] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>
Domain separation for the Employee Readiness Surveys application

Surveys are configured and managed through the Survey Management application on your ServiceNow instance. For information about how domain separation is supported, see Domain separation for Survey Management.

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Employee Readiness Surveys

You can install Employee Readiness Surveys if you have the admin role. Installing Employee Readiness Surveys adds notification options and a default health readiness survey to the Emergency Outreach app.

Before you begin

Role required: admin

<table>
<thead>
<tr>
<th>Installation instructions for self-hosted and federal environments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>Commercial on-premise</td>
</tr>
<tr>
<td>Federal hosted</td>
</tr>
<tr>
<td>Federal on-premise</td>
</tr>
</tbody>
</table>
Installation instructions for self-hosted and federal environments (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you’ve subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)

About this task
The Send Outreach form in Emergency Outreach has an option to send a survey instead of a health status request. Users with the sn_imt_checkin.checkin_admin role become owners of the example health readiness survey.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Employee Readiness Surveys.
3. Click install.
   The Application installation dialog box opens.
4. Optional: Load the demo data by selecting the Load demo data check box.
   (Optional) For information about how to install or reinstall demo data after the initial installation, see the Work around to install demo data if application is already installed [KB0722909] article in the Now Support Knowledge Base.
5. Click install.
6. When the installation is complete, click Close.
Results
Employee Readiness Surveys is installed on your instance. Use it by navigating to the Emergency Outreach app.

Configure Employee Readiness Surveys notifications
The administrator can add or modify Employee Readiness Surveys notifications. Users with the sn_imt_checkin.checkin_admin or survey_admin role can view the base system survey and copy it to make changes, or add a new survey.

Before you begin
The Employee Readiness Surveys application must be installed from the ServiceNow Store to complete these procedures. The surveys are managed from the instance Survey Management application.

Modify the Employee Readiness Surveys notification
Modify the Employee Readiness Surveys base system email notification.

Before you begin
Review the details about planning for, creating, and modifying system notifications by starting with Create an email notification.
Role required: admin

Procedure
1. Navigate to Emergency Outreach > Send Outreach, and then click the Content configuration tab.
2. In the Response Mode field, select Survey.
   The Survey field appears and the entry in the Notification field changes to Outreach Surveys.
3. Click the preview icon (i) beside the Notification field, and then click Open record.
4. In the Notification form for this Outreach Surveys notification, modify the details as needed.
   Retain the default Assessment Instance [asmt_assessment_instance] table value.
5. Click Preview Notification and verify your changes.
6. When you’re finished, click Update.

Results
The modified notification is used for future Employee Readiness Surveys notifications.

Add an Employee Readiness Surveys email notification
Add a new Employee Readiness Surveys email notification to use in Emergency Outreach to send the survey link.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notifications > Email > Notifications.
2. Review the existing Outreach Surveys email notification to familiarize yourself with the scripts and other settings.
3. Click **New**.

4. In the **Table** field, select the Outreach Surveys [sn_int_checkin_employee_check_in] table.

5. On the **When to send** tab, set the conditions.
   - Set the **Conditions** criteria as shown in the image of the base system notification.
   - Enter the Advanced condition script with the following change.
     For this line: `var thisNotificationSysId = 'a1baaaba71201010fa9b986641bd1ca4';`
     Replace the sys_id with the sys_id notification that you’re adding. To get the sys_id, open the additional actions menu, and then select **Copy sys_id**.

6. On the **Who will receive** tab, open **Users/Groups in fields** and select **Assigned to**.

7. On the **What it will contain** tab, complete the remaining information.

8. Click **Submit**.

9. In the **Notifications list**, open the notification that you added and click **Preview Notification**.

10. Review the notification and make any necessary modifications.

11. Click **Update**.

**Configure Employee Readiness Surveys**

Review the default Employee workplace readiness survey installed with the Employee Readiness Surveys app. Modify the survey, or create one or more surveys to use based on the readiness concerns that you want to address and any legal obligations under applicable law, including data protection laws.
Before you begin
Familiarize yourself with Survey administration. Then meet with other emergency response team stakeholders to plan the changes to the survey. Decide whether to edit the existing survey before you send it to employees, or to create one or more new surveys.

Role required: sn_imt_checkin.checkin_admin, survey_creator, survey_admin, or admin

About this task
Users with the sn_imt_checkin.checkin_admin role have the survey_creator role, and are made owners of the default readiness survey. Users with the survey_creator role can edit or copy the default survey. These users can also add another readiness survey and add other users as owners to collaborate with them.

Survey definition owners

Procedure
1. Navigate to Surveys > View Surveys and open the Employee workplace readiness survey.
2. Using the plan that you made for changing the survey, update any of the following survey elements.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add owners</td>
<td>Click the lock icon (🔒) beside Owners to unlock the list of survey owners. Add the user to collaborate with on this survey.</td>
</tr>
<tr>
<td>Update the introductory and ending text</td>
<td>Click the Introduction &amp; End Notes section tab and update the text.</td>
</tr>
<tr>
<td>Work with the questions</td>
<td>a. In the Metric Categories related list, click Please complete this confidential survey. Questions appear in the Assessment Metrics related list.</td>
</tr>
<tr>
<td></td>
<td>b. Click the question to open the Survey Question form. Modify and complete your edits. The answers are listed in the Assessment Metric Definitions related list.</td>
</tr>
<tr>
<td>Work with the question responses</td>
<td>In the Assessment Metric Definitions related list, select the response to edit. Update the response as desired.</td>
</tr>
</tbody>
</table>

3. Complete any other changes to the survey options, and click **Update**.

**Results**
The modified survey is used for future outreach surveys.

**Add Employee Readiness Surveys**
Create one or more additional surveys to use for different workplaces or to evaluate other areas of concern. Start by planning the surveys carefully to gather the best data for your evaluation of readiness to return to the workplace.

**Before you begin**
Role required: sn_imt_checkin.checkin_admin, survey_creator, survey_admin, or admin

**About this task**
Consider how you want to begin to reopen your workplace, and what you must understand about the employees before you can begin. Work with a user with the survey_admin role in your company to plan the types of questions and responses for the survey. For information about adding surveys, see **Survey administration** and **Survey designer**.

**Procedure**
- To create a survey, navigate to **Surveys > View Surveys**.
- Select **New** or **Survey Designer** and enter the information to complete the survey from the plan that you made.
  Decide on a naming convention to use for surveys, so that a user with the sn_imt_checkin.checkin_admin role knows which one to select when sending outreach surveys. For example, **Readiness survey India** or **Customer service employees return readiness**.

**Related information**
Send a readiness survey in Emergency Outreach
## Employee Health Screening

Screen users before entering the workplace to ensure compliance with the organization’s entry requirements, such as a temperature check and PPE. Require that users agree to comply with health and safety policies before they return to the workplace.

The ServiceNow® Employee Health Screening application enables organizations to screen users before entering the workplace to ensure compliance with the organization’s entry requirements, such as a temperature check and personal protective equipment (PPE). Based on their own criteria, organizations can determine whether it’s safe for the user to enter the workplace. Organizations can use a reporting dashboard to view trends by sites and record the return of users into their facilities.

### Use guided setup to implement Safe Workplace suite apps

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

### Integrate with Customer Service Management

Use ServiceNow® Customer Service Management and Employee Health Screening together to provide consumers and contacts with access to a health verification form on your Consumer or Customer Service Portals. Conduct health screenings for consumers and contacts before they can be granted entry to a location. For more information about using Customer Service Management with Employee Health Screening, see Integrate Customer Service Management with Safe Workplace applications.

### Use with other Safe Workplace suite applications

Employee Health Screening is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- With the Employee Readiness Surveys application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.
- With the Emergency Outreach application, notify employees of important information about anticipated or occurring emergency situations. Send an outreach notification via
email, mobile push message, or SMS message to request an employee response. You can also configure other preferred communication channels.

• With the Workplace Safety Management application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.

• You can manage the inventory of safety equipment for your workforce with the Workplace Personal Protective Equipment Inventory Management application.

All Safe Workplace suite applications are available in the ServiceNow Store.

Safe Workplace suite for federal customers

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

### Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

### Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

### Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not
modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

**Install Employee Health Screening**

You can install the Employee Health Screening application if you have the admin role. This application includes demo data and installs the related store applications and plugins if they are not already installed.

**Before you begin**

Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)

Role required: admin

**Procedure**

1. Navigate to **System Applications** > **All Available Applications** > **All**.

2. Find the application using the filter criteria and search field.

   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.
3. Click **Install**.

4. In the Application installation dialog box, review the application dependencies.
   If your application requires other applications, install them first if they are not already installed.
   Installing your application also automatically installs the dependent applications or plugins if they are not installed already.

5. **Optional**: If demo data is available and you want to install it, click **Load demo data**.
   Some applications include demo data, which are sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Note**: If you don’t load the demo data for a store application during installation, it’s not available to load later.

6. Click **Install**.

**Components installed with Employee Health Screening**

Roles and tables are installed with the Employee Health Screening application.

**Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Health monitor [sn_imt_monitoring.monitoring_user] | Use the health screening page to record returning employee details. View employee health and safety status. | • report_user  
• sn_imt_core.reader |
| Health monitor administrator [sn_imt_monitoring.monitoring_admin] | Configure properties and temperature overrides and view the dashboard. | • report_user  
• sn_imt_monitoring.monitoring_user |

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request for Entry</td>
<td>Results of employee health screening events. If the</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>[sn_imt_monitoring_request_for_entry]</td>
<td>sn_imt_monitoring.auto_create_request property is enabled, the table also includes results from health monitors looking up an employee's health and safety status. For results from a health screening, the Source field is set to Health screen. For results from a status lookup, the Source field is set to Auto-checkin.</td>
</tr>
<tr>
<td>Location Override [sn_imt_monitoring_temperature_override]</td>
<td>Locations where temperature thresholds for employees are different from the system property threshold.</td>
</tr>
<tr>
<td>Employee Health Verification [sn_imt_monitoring_health_verification]</td>
<td>All health verifications submitted by employees.</td>
</tr>
<tr>
<td>Visitor Request For Entry [sn_imt_monitoring Visitor_request_for_entry]</td>
<td>Results of visitor health screening events.</td>
</tr>
<tr>
<td>Visitor Location Override [sn_imt_monitoring_visitor_temperature_override]</td>
<td>Locations where temperature thresholds for visitors are different from the system property threshold.</td>
</tr>
<tr>
<td>Information Messages [sn_imt_monitoring_information_message]</td>
<td>Messages provided to specific types of users (determined by their audience) when they attempt to enter a location.</td>
</tr>
</tbody>
</table>

**Configure Employee Health Screening**

Set properties to specify the global maximum temperature thresholds in Fahrenheit and Celsius. Temperatures taken during a health screening are compared to the global temperature threshold, established by the company, to allow or deny entry.

**About this task**

Another property lets you decide whether to generate QR codes when a health verification is submitted. You can also determine whether to store temperature readings within the application, and establish overrides by location.

Add an email notification and configure an outreach notification for the daily health verification. Send the outreach notification on demand or as scheduled to employees before they return to the workplace. For more information, see Send notifications for daily health verification.

**Set up Employee Health Screening properties**

Decide whether you store temperatures recorded during screening events. Also set the maximum temperature threshold to use to determine whether it is safe for employees or visitors to enter the workplace.

**Before you begin**

Role required: sn_imt_monitoring.monitoring_admin or admin

**About this task**

Employers remain solely responsible for complying with their legal obligations under applicable law, including data protection laws on collection, use, disclosure, and retention of personal data, and should enable, choose not to enable, or customize any functionality available within the application to meet the Employers’ specific requirements.
**Procedure**

1. Navigate to **Employee Health Screening > Properties**.
2. Set the following property values.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear health verification daily</td>
<td>If the <strong>Yes/No</strong> check box is selected, the <strong>Response</strong> field on health verification records is reset to <strong>No</strong> every day at the specified time. If the Employee Health Verification Requirement is active, the employee’s requirement status is reset to <strong>Not Cleared</strong>. This property is not enabled by default.</td>
</tr>
<tr>
<td>Time to reset health verifications</td>
<td>Sets the time when health verification responses are reset to <strong>No</strong> each day. The reset uses the local time for each user. For example, if set to 17:00:00, a user in Seattle has their verification reset at 5:00pm Pacific time and a user in Boston has their verification reset at 5:00pm Eastern time. The default time is midnight.</td>
</tr>
<tr>
<td>Limit health verification submissions to once per day.</td>
<td>If the <strong>Yes/No</strong> check box is selected, each employee can only submit the health verification once per day. If the <strong>Yes/No</strong> check box is cleared, there is no limit on the number of times per day that an employee can submit the health verification.</td>
</tr>
<tr>
<td>Enforce cleared status as condition for Health Screening.</td>
<td>If the <strong>Yes/No</strong> box is selected, each employee must have a Cleared status to gain entry to a location. If the <strong>Yes/No</strong> box is cleared, the employee’s health and safety status does not automatically deny entry.</td>
</tr>
<tr>
<td>Setting this value to true will track employee temperature.</td>
<td>If the <strong>Yes/No</strong> check box is cleared, the temperature thresholds entered are used only to determine whether the employee can enter. This information is not stored. By default, recording and storing temperatures is turned off.</td>
</tr>
<tr>
<td>Disable temperature check for vaccinated employees.</td>
<td>If the <strong>Yes/No</strong> box is selected, vaccinated employees do not require a temperature check during health screening.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Setting this value to true will track employee PPE data.</td>
<td>If the Yes/No check box is cleared, the PPE values entered are used only to determine whether the employee can enter. This information is not stored.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.track_ppe]</td>
<td></td>
</tr>
<tr>
<td>Global property for employee temperature fever cutoff in Fahrenheit. Values at or above this temperature are considered a fever.</td>
<td>Set this threshold based on what you consider a safe temperature in Fahrenheit to allow returning employees into the workplace.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.temperature_threshold_fahrenheit]</td>
<td></td>
</tr>
<tr>
<td>Global variable for employee temperature fever cutoff in Celsius. Values at or above this temperature are considered a fever.</td>
<td>Set this threshold for Celsius as described in the previous entry.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.temperature_threshold_celsius]</td>
<td></td>
</tr>
<tr>
<td>Setting this value to true will track visitor temperature data.</td>
<td>If the Yes/No check box is cleared, the temperature thresholds entered are used only to determine whether the visitor can enter. This information is not stored. By default, recording and storing temperatures is turned off.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.track_visitor_temperature]</td>
<td></td>
</tr>
<tr>
<td>Setting this value to true will track visitor PPE data.</td>
<td>If the Yes/No check box is cleared, the PPE values entered are used only to determine whether the visitor can enter. This information is not stored.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.track_visitor_ppe]</td>
<td></td>
</tr>
<tr>
<td>Global property for visitor temperature fever cutoff in Fahrenheit. Values at or above this temperature are considered a fever.</td>
<td>Set this threshold based on what you consider a safe temperature in Fahrenheit to allow visitors into the workplace.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.visitor_temperature_threshold_fahrenheit]</td>
<td></td>
</tr>
<tr>
<td>Global variable for visitor temperature fever cutoff in Celsius. Values at or above this temperature are considered a fever.</td>
<td>Set this threshold for Celsius as described in the previous entry.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.visitor_temperature_threshold_celsius]</td>
<td></td>
</tr>
<tr>
<td>Setting this property to true will show QR code for entry.</td>
<td>If the Yes/No check box is cleared, a QR code is displayed when an employee agrees to the health verification form. A health monitor at an entry point scans the code to review the employee’s requirements status.</td>
</tr>
<tr>
<td>[sn_imt_monitoring.show_qr_code]</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Requirements are created in the Employee Readiness Core application. For more information, see Employee Health and Safety Status.

© 2022 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create entry request record when screener views Health Status record.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_monitoring.auto_create_request</td>
<td>The QR code can be printed or displayed on a mobile device with the Now Mobile app. If the Yes/No check box is selected, a record is created in the Request for Entry table every time that a user with the sn_imt_monitoring.monitoring_user role views an employee's safety status by scanning the QR code or manually looking up the employee. If the employee's health and safety status is Cleared, the Access Granted field is set to true; otherwise it is set to false. This property is not enabled by default.</td>
</tr>
</tbody>
</table>

3. Click Save.

**Override maximum temperature by location**

Define overrides of the maximum temperature threshold specified in properties for particular locations. For example, a workplace in Mexico may have a higher setting because the climate is warmer. Also override the property for whether QR codes are generated.

**Before you begin**
Role required: sn_imt_monitoring.monitoring_admin or admin

**Procedure**

1. To define overrides for employees, navigate to Employee Health Screening > Location Overrides. To define overrides for visitors, navigate to Employee Health Screening > Visitor Location Overrides.

2. Click New.

3. On the form, fill in the fields.

**Location Override form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>The location to set a different maximum temperature threshold.</td>
</tr>
<tr>
<td>Track temperature</td>
<td>Option that indicates whether temperature data is stored when screened at this location.</td>
</tr>
<tr>
<td>Track PPE</td>
<td>Option that indicates whether PPE compliance is stored when screened at this location.</td>
</tr>
<tr>
<td>Show QR Code</td>
<td>Option that indicates whether to generate a QR code when an employee health verification is submitted.</td>
</tr>
</tbody>
</table>

**Note:** This field is not used for visitors.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Temperature measuring unit.</td>
</tr>
<tr>
<td>Temperature</td>
<td>Employees or visitors must be at or below this temperature to be considered okay to enter the workplace.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Modify the employee health verification page**

The Employee Health Screening application provides an employee health verification that is ready to use. However, you can modify the verification if you want to change the criteria that employees must agree to.

**Before you begin**

Role required: catalog_admin

**Procedure**

1. Navigate to Service Catalog > Catalog Definitions > Maintain Items.
2. Click the Health verification catalog item.
3. In the **Description** field, update the criteria that employees must agree to.
4. Click **Update**.

**Modify visitor notification emails**

The Employee Health Screening application provides visitor notifications that are ready to use. However, you can modify the notifications if you want to customize them for your company.

**Before you begin**

Role required: admin

**About this task**

The Employee Health Screening application uses the following visitor notifications.

**Visitor notifications**

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify about scheduled visit</td>
<td>When the <code>sn_imt_core.send_email_to_visitor</code> property is enabled, this email is sent to the visitor when an employee invites them to the workplace. The email is sent immediately after the employee submits the invitation. The email contains a brief confirmation of the scheduled visit, including information about the date of the visit and the name of the employee who invited them. This notification is installed with the Employee Readiness Core application.</td>
</tr>
<tr>
<td>Ask for health related data from visitor</td>
<td>This email is sent to the visitor before their scheduled visit. The <code>sn_imt_core.days_to_ask_for_health_data</code> property sets when the email is sent. The email contains information about safety requirements and policies that the visitor must agree to follow. The visitor must respond <strong>Yes</strong> to the email to complete the Visitor Invitation Requirement from Employee Health and Safety Status.</td>
</tr>
</tbody>
</table>
**Visitor notifications (continued)**

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitor Invitation Criteria Met</td>
<td>This email is sent to the visitor, the employee who invited them, and anyone on the watch list on the invitation. It is sent after the visitor responds Yes to the health data email. This email confirms the upcoming visit.</td>
</tr>
<tr>
<td>Visitor Invitation Criteria Not Met</td>
<td>This email is sent to the visitor, the employee who invited them, and anyone on the watch list on the invitation. It is sent after the visitor responds No to the health data email. This email asks the visitor to reschedule their visit.</td>
</tr>
</tbody>
</table>

*Note:* To ensure that a visitor’s requirement status is updated when the visitor responds to this email, set the glide.user.trusted_domain property to the default value (*). For more information, see Inbound mail configuration. If you need to perform filtering on inbound emails, see Email filters.

This notification is installed with the Employee Readiness Core application.

For more information about the properties used to configure the email notifications, see Set up Employee Health and Safety Status properties.

### Procedure

1. Navigate to System Notification > Email > Notifications.
2. Click the visitor notification that you want to update.
3. In the What it will contain form section, edit the Message HTML field to customize the notification email.
4. To verify your changes, click Preview Notification.
5. Click Update.

#### Add message for users during health screening

Add an optional custom message for people to read during their health screenings with additional information or guidelines.

**Before you begin**
Role required: sn_imt_monitoring_monitoring_admin

### Procedure

1. Navigate to Employee Health Screening > Information Message.
2. Click New.
3. Enter a name for the message in the Name field.
4. Select the users you want to receive the message in the Audience field.
5. Provide the text for the message in the Message field.
Example
For example, you might want to advise users to remain in a certain location in the building.

6. Click Submit.

Results
Users in the selected audience will see this message when they complete their health screening.

Add an email notification for daily health verification
Add an Employee Readiness Surveys email notification to use for sending the survey link.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notifications > Email > Notifications.
2. Review the existing Daily Health Verification email notification to familiarize yourself with the scripts and other settings.
3. Click New.
4. In the Table field, select the Health Verification Acknowledgements [sn_imt_checkin_health_verification_acknowledgement] table.
5. On the When to send tab, set the conditions.
   - In the Send when field, select Record inserted or updated from the drop-down list.
   - Set the Conditions criteria to [User.Active][is][true] and [Acknowledgment Status][is not][Acknowledged].
   - In the Advanced condition script, enter the following code:

```
var employeeDailyHealthVerificationSysId = <your-sys_id>
answer = current.employee_check_in.notification = employeeDailyHealthVerificationSysId;
```

Replace the <your-sys_id> variable with the sys_id notification that you're adding by opening the additional actions menu, selecting Copy sys_id, and pasting the sys_id into the code line.

The following figure shows example settings for the Daily Health Verification base system notification.
6. On the Who will receive tab, open Users/Groups in fields and select Assigned to.

7. On the What it will contain tab, complete the remaining information.

8. Click Submit.

9. In the Notifications list, open the notification that you added and click Preview Notification.

10. Review the notification and make any necessary modifications.

11. Click Update.

Verify your health status and compliance
Verify that you understand and will comply with your organization’s safety requirements and policies before you can be allowed entry to the location.

Before you begin
Role required: none

About this task
Typically, you receive an email or a mobile notification from your organization with a link to the health verification form.

Note: If the ServiceNow® Customer Service Management application is activated, consumers and contacts can access the health verification form on the Consumer or Customer Service Portals. To set up the health verification form on the portals, allow external users access to “Health Verification” catalog item (KB0856301). For more information about using Customer Service Management with Employee Health Screening, see Integrate Customer Service Management with Safe Workplace applications.
Procedure

1. Navigate to the health verification form.
   • Click the link provided by your organization.
   • In your organization's ServiceNow instance, navigate to Employee Health Screening > Health Verification.
   • In the Now Mobile app, navigate to Health > Follow these safety practices > Verify my health.

Health verification form

Health verification
Please read this form and acknowledge that you meet the criteria to be on-site.

By completing this form, you acknowledge that:
1. You currently don't have any of the following symptoms:
   • Coughing or sore throat
   • Sneezing or runny nose
   • Shortness of breath or difficulty breathing
   • Fever
   • Fatigue
   • Chills, body aches, or muscle pain
   • Headache
   • Diarrhea, nausea, or vomiting
   • A sudden loss of taste or smell that is not related to allergies.
2. You currently aren’t waiting for the results of a coronavirus test that you took. Or, if you took a coronavirus test in the last 14 days, you got a negative result.
3. In the last 14 days, you haven’t had close contact [within 6 feet for more than 15 minutes] with anyone who you know tested positive for the coronavirus or has any of the above symptoms.
4. You will wear personal protective equipment, such as a mask, while on-site and around others.
5. You will follow the social distancing requirements that are posted on-site.

Please check the box below if you acknowledge that you meet all the above criteria. If you do not meet all the criteria, do not submit this form. We recommend using the Emergency Self-Report app to report any symptoms or other situations.

* I acknowledge that I meet all the above criteria.

2. Carefully read the form and evaluate whether you can honestly answer that you agree.

3. Take one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you agree to all statements</td>
<td>Select the I acknowledge that I meet all the above criteria check box.</td>
</tr>
<tr>
<td>If you can't agree to one or more of</td>
<td>Exit the form without submitting it.</td>
</tr>
<tr>
<td>the statements</td>
<td></td>
</tr>
</tbody>
</table>
Confirmation screen

Submitted!

When you arrive at your location, show this QR code to the site team member. They will use the code to help check you in.

Abel Tuter
SHS quarto 5, Bloco E, Brasilia

- Self Report Requirement: Submit self-report
- Exposed Contacts Requirement: Report contacts
- Employee Health Verification Requirement: Verify health: Valid until 2020-10-29 09:26:39
- Privacy Consent Requirement: Update consent

Reserve a space

The confirmation screen shows your status for all of your organization’s entry requirements. A large green check mark at the top of the page indicates that you’ve completed all requirements. To complete any unfulfilled requirements, click the link next to the requirement. Some requirements may not have a link. If you need help with completing the requirements, contact your organization.

Note: If your organization does not use QR codes, the confirmation screen does not display the instructions or the QR code.

4. Optional: If you’re returning to an office and need to reserve a workspace, click Reserve a space.
The link enables you to reserve a space for a specific day. If you want to reserve a space for a longer period of time, you must request it separately and wait for the request to be approved. For more information about reserving a workspace, see Making workplace reservations.

Note: Reserving a workspace requires the sn_wsd_core.workplace_user role. If you do not see the link to reserve a space, contact your system administrator.

What to do next
Your organization may have health monitors at entrances to check that you completed the entry requirements or to conduct a health screening before entry. If you received a QR code when you submitted the health verification, navigate to Health > Prepare for arrival > My
office entry code in the Now Mobile app to show your QR code to the health monitor when you arrive at the location.

Related information
- Add an email notification for daily health verification
- Configure Emergency Outreach notifications
- Review daily health verification acknowledgements

Conduct a health screen for entry
Conduct a health screen before people enter a location, such as employees returning to the workplace or students returning to campus. Verify the person’s return requirement status on your smartphone, tablet, or computer. Then complete and submit a health screening form to determine whether the person is able to enter the location.

Before you begin
Role required: sn_imt_monitoring.monitoring_user

About this task
The following procedure includes the steps your organization might use in setting up health screening. Some of the steps might not be applicable to your location.

Note: If the ServiceNow® Customer Service Management (CSM) application is activated, the health screen can be performed for CSM consumers and contacts. The customer service agent [sn_customerservice_agent] and consumer service agent [sn_customerservice.consumer_agent] roles can optionally be given to health screeners so that they can view additional CSM information on the health screening form, but these roles are not required for screening consumers and contacts. For more information about using Customer Service Management with Employee Health Screening, see Integrate Customer Service Management with Safe Workplace applications.

Procedure
1. Open the QR code scanning or requirement status page based on the type of device that you’re using.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartphone or tablet</td>
<td>From the Now Mobile Health screen under the Health Screening section, tap Scan for Entry.</td>
</tr>
<tr>
<td></td>
<td>Scan the code that the person presents on their mobile device or on paper. If there is no QR code, enter the user ID in the User ID field, for example, john.smith.</td>
</tr>
<tr>
<td>Computer</td>
<td>Navigate to Employee Health and Safety Status &gt; View Employee and Visitor Status and select the person.</td>
</tr>
</tbody>
</table>

2. Review the requirement status to verify that the person is cleared to enter.

Note: Requirements are created in the Employee Readiness Core application. For more information, see Employee Health and Safety Status.
If the status is **Not cleared** and your organization’s policy is to deny entry at this check point, provide the person with the next steps to take based on your organization’s policy. Then, assist the next person in line.

3. Perform the health screen.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartphone or tablet</td>
<td>Tap <strong>Health Screen</strong> on the Scan for entry page.</td>
</tr>
<tr>
<td>Computer</td>
<td>Navigate to <strong>Employee Health Screening &gt; Request Entry</strong>. The screening form opens in a new browser tab.</td>
</tr>
</tbody>
</table>
4. Take the person’s temperature and fill out the screening form.

**Screen a person for entry form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Location of the health screening, such as the address of a workplace or campus.</td>
</tr>
<tr>
<td>Person</td>
<td>The person that you’re screening.</td>
</tr>
<tr>
<td>Account</td>
<td>The account for the contact. This field appears only when the Customer Service Management application is activated and a contact is selected from the Person field. You must have the customer service agent role [sn_customerservice_agent] to view this field.</td>
</tr>
</tbody>
</table>
| Suffix                        | The suffix for the consumer. This field appears only when the Customer Service Management application is activated and a consumer is selected in the Person field. **Note:** You must have the consumer service agent role [sn_customerservice.consumer_agent] to view this field.
| Temperature unit              | Temperature unit assigned to this location.                                                      |
| Temperature                   | The numerical value of the person’s temperature.                                                 |
| Personal protective equipment (PPE) | Whether the person is wearing PPE. Values are **Yes** or **No**.                                |

5. Tap or click **Submit**.
Results
You receive a message that indicates whether to allow the person to enter. If the person does not pass the health screening, provide them with the next steps based on your organization’s policy.

Screen a visitor for entry to the workplace
Verify the visitor’s entry requirement status on your smartphone, tablet, or computer. Then complete and submit the health screening form to determine whether the visitor is able to enter the workplace.

Before you begin
Role required: sn_imt_monitoring.monitoring_user

About this task
A visitor must be invited before they can be screened for entry. If an uninvited visitor needs entry, a health screener can complete the invitation process and then begin screening. For more information, see Invite a visitor to the workplace.

Procedure
1. Open the requirement status page based on the type of device that you’re using.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartphone or tablet</td>
<td>From the Now Mobile Health screen, under the Health Screening section, tap Screen Visitor.</td>
</tr>
</tbody>
</table>
| Computer              | Navigate to Employee Health and Safety Status > View Employee and Visitor Status. Choose the Visitor option and select the visitor.

2. Review the status to verify that the visitor is cleared to enter. If the status is Not cleared and your company policy is to deny entry at this check point, provide the visitor with the next steps based on your company policy. Assist the next visitor or employee in line.

3. Take one of the following actions to perform the health screen.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smartphone or tablet</td>
<td>Tap Screening &gt; Request Visitor Entry.</td>
</tr>
<tr>
<td>Computer</td>
<td>Navigate to Employee Health Screening &gt; Request Visitor Entry. The screening form opens in a new browser tab.</td>
</tr>
</tbody>
</table>

4. Take the visitor’s temperature and fill in the screening form.

Screen a visitor for entry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitor lookup</td>
<td>Visitor ID, which is generally firstname.lastname. When the visitor is selected, the form is automatically populated with information about the visitor, such as name, company, and host employee.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Visitor's first name</td>
<td>Visitor's first name. This field is automatically populated when theVisitor lookup field is selected.</td>
</tr>
<tr>
<td>Visitor's middle name</td>
<td>Visitor's middle name. This field is automatically populated when the Visitor lookup field is selected.</td>
</tr>
<tr>
<td>Visitor's last name</td>
<td>Visitor's last name. This field is automatically populated when the Visitor lookup field is selected.</td>
</tr>
<tr>
<td>Visitor's company</td>
<td>The company that the visitor works for. This field is automatically populated when the Visitor lookup field is selected.</td>
</tr>
<tr>
<td>Host employee</td>
<td>The employee who invited the visitor. This field is automatically populated when the Visitor lookup field is selected.</td>
</tr>
<tr>
<td>Invitation setup date</td>
<td>The date that the host employee submitted the visitor invitation. This field is automatically populated when the Visitor lookup field is selected.</td>
</tr>
<tr>
<td>Visitor criteria</td>
<td>Indicates whether the visitor has completed the Visitor Invitation Requirement by agreeing to follow safety requirements and policies. This field is automatically populated when the Visitor lookup field is selected.</td>
</tr>
<tr>
<td>Location</td>
<td>Your location, which may be the address of the workplace.</td>
</tr>
<tr>
<td>Temperature Unit</td>
<td>Temperature unit assigned to this location. Change it if necessary.</td>
</tr>
<tr>
<td>Temperature</td>
<td>The numerical value of the visitor's temperature.</td>
</tr>
<tr>
<td>Personal protective</td>
<td>The choice of Yes or No from the list to record whether the visitor is wearing PPE.</td>
</tr>
</tbody>
</table>

5. Tap or click Submit.
You receive a message that indicates whether to allow the visitor to enter. If the visitor doesn’t pass the health screening, provide them with the next steps based on your company policy.

Monitor progress with the Employee Health Screen Overview dashboard

View the dashboard to monitor the entry requests and assess how the return to the workplace is progressing. Evaluate the number of entry requests, how many requests were denied entry, and for what reason.

Before you begin
Role required: sn_imt_monitoring,monitoring_admin

Procedure
Navigate to Employee Health Screening > Overview.
The Employee Health Screen Overview dashboard opens in a new browser tab.
Click any area of a chart to see the corresponding records.

**View entry requests**

Filter the list of entry requests that were completed to evaluate different areas of your return to work progress. Entry requests are the records submitted by the health screener for each employee who is screened before entry.

**Before you begin**

Role required: sn_imt_monitoring.monitoring_admin

**About this task**

For example, you could see records for employees in San Diego who were not granted access, and compare the reasons for those denials. The reason for denial is either no personal protective equipment (PPE) or high temperature.
Procedure

1. Navigate to Employee Health Screening > Entry Requests.

2. To evaluate request for entry data, build a query or sort and group the list by the appropriate columns.

Workplace Safety Management

Use the ServiceNow® Workplace Safety Management application to create safer, managed processes for returning employees to the workplace and staying open. Establish distancing plans, shift assignments, and sanitation scheduling and manage workspace allocation in stages. The Workplace Safety Management is also available as a core application in the Workplace Service Delivery suite.
When offices are ready to open and employees return to work...
Space administration

Your organization’s workplace administrators can add details for all workplace locations, such as:

• Areas such as employee workstations, conference rooms, and cafeterias
• Office buildings and campuses
• Regions of all locations

By tracking the availability of workspaces, workplace managers can plan and implement a phased return of employees to the workplace. For example, after the COVID-19 pandemic, your organization might want to allow a certain percentage (for example, 20%) of the total staff to return at a time at each office location, based on office configuration, local health recommendations, and other factors. Workplace managers can indicate workspace availability, leaving space for physical distancing. They can evaluate the situation periodically and make more workspaces available as conditions improve.

As a workplace manager, you can upload floor plans of your organization so employees can more easily view and select available spaces when they request workspace reservations.

Avoid large gatherings or long queues for locations at your workplace such as the cafeteria, gym, and entry and exit gates by defining arrival intervals and having employees schedule their arrivals.

Shift management

Workplace managers can create shifts for employees and schedule them for specific times and days. They can use this data to start planning for the occupancy levels of your workplaces by allocating employees and available workspaces to specific shifts.

For example, workplace managers can create a morning shift schedule with work hours of 08:00 to 13:00. They can then assign available workspaces to this shift based on organizational guidelines. These assigned workspaces can then be reserved for employees operating from the office during this shift.

Shift owners can review and modify the details of the shifts that they own. They can also view workspace reservations and requests made for the shifts they own.

Workspace reservations

Using the information about available employees and workspaces, workplace managers can reserve areas and workspaces for employees. Workplace managers can also generate reservations for multiple employees at once. Both the employee and the workplace manager are notified of reservations through email.

Employees can request workspace reservations when they are ready to return to the office. Using interactive floor plans, they can choose to reserve workspaces for a specified date range, a single day, or a few hours. Depending on your organizational guidelines, reservation requests might require an approval for confirmation.

If the workplace profiles of all employees are set up, the application automatically assigns available workspaces for employees based on their date and time selection when they make a reservation.

For more advanced workplace reservation options, use Workplace Reservation Management in the Workplace Service Delivery suite. For more information, see Workplace Reservation Management.

Workplace tasks
Workplace managers can monitor maintenance activities that are scheduled in the workplace for each shift. They can also schedule planned or on-demand maintenance tasks, and generate reports to track the progress of these activities.

**Workplace Dashboard**

Using data visualizations, you can evaluate the availability of workspaces and occupancy levels of your office locations, and monitor the progress of workplace tasks on the workplace dashboard.

**Use guided setup to implement Safe Workplace suite apps**

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to **Guided Setup > Safe Workplace Guided Setup**. For more information about using the guided setup interface, see Using guided setup.

**Use with other Safe Workplace suite applications**

Workplace Safety Management is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- With the Employee Readiness Surveys application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.
- Before users re-enter workspaces, use the Employee Health Screening application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.
- You can manage the inventory of safety equipment for your workforce with the Workplace Personal Protective Equipment Inventory Management application.

All Safe Workplace suite applications are available in the ServiceNow Store.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

<table>
<thead>
<tr>
<th>Installation instructions for self-hosted and federal environments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>Commercial on-premise</td>
</tr>
<tr>
<td>Federal hosted</td>
</tr>
<tr>
<td>Federal on-premise</td>
</tr>
</tbody>
</table>
Installation instructions for self-hosted and federal environments (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
<td></td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Workplace Safety Management

You can install the Workplace Safety Management application if you have the admin role. This application includes optional demo data.

Before you begin

Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin
Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

About this task
The following components are installed with installation of the Workplace Safety Management application:

- Roles
- Tables

See Components installed with Workplace Safety Management for more information.

Procedure
1. Navigate to System Applications > All Available Applications > All.

2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.
   If your application requires other applications, install them first if they are not already installed.
   Installing your application also automatically installs the dependent applications or plugins if they are not installed already.

5. Optional: If demo data is available and you want to install it, click Load demo data.
   Some applications include demo data, which are sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.
**Note:** If you don’t load the demo data for a store application during installation, it is not available to load later.

6. Click **Install**.

**Components installed with Workplace Safety Management**

Several types of components are installed with installation of the Workplace Safety Management application, including user roles, scheduled jobs, tables, and business rules.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

Demo data is available for this feature.

**Roles installed with Workplace Safety Management**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace admin [sn_wsd_core.admin]</td>
<td>• Sets up data about the workplace</td>
<td>• sn_wsd_core.workplace_manager</td>
</tr>
<tr>
<td></td>
<td>• Has complete access to the application</td>
<td></td>
</tr>
<tr>
<td>Workplace manager [sn_wsd_core.workplace_manager]</td>
<td>• Reserves spaces at the workplace</td>
<td>• sn_wsd_core.workplace_exposure_analyst</td>
</tr>
<tr>
<td></td>
<td>• Links employees and shifts to spaces</td>
<td>• schedule_admin</td>
</tr>
<tr>
<td></td>
<td>• Manages preventive maintenance tasks</td>
<td>• template_editor_global</td>
</tr>
<tr>
<td>Workplace exposure analyst [sn_wsd_core.workplace_exposure_analyst]</td>
<td>• Identifies potentially exposed employees in the ServiceNow® Emergency Exposure Management application using workspace reservations.</td>
<td>• None</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| Workplace shift owner [sn_wsd_core.workplace_shift_owner] | • Has edit access to the shifts that they own.  
• Has edit access to details such as shift schedules, associated users, and spaces of owned shifts.  
• Has read-only access to workplace tasks of owned shifts.  
• Can view workspace requests and reservations for owned shifts | None           |
| Workplace user [sn_wsd_core.workplace_user]            | • Requests area or workspace reservations from the Workplace Service Portal or the Now® Mobile app  
• Schedules arrival to workplace locations using the Workplace Service Portal or the Now® Mobile app | None           |

**Note:** From Workplace Safety Management v1.3.2 onwards, this role is required for employees to request reservations from Workplace Service Portal.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workplace core writer [sn_wsd_core.task_writer] | • Create, read, update, and delete Workplace Tasks.  
• Create, read, update, and delete Task templates. | sn_wsd_core.task_reader      |
| Workplace core reader [sn_wsd_core.task_reader] | Has permission to read all workplace tasks.                                | None                         |
| Workplace knowledge base writer [sn_wsd_core.kb_writer] | • Create, view, publish, and update knowledge base articles.  
• Retire and republish knowledge base articles. | None                         |

### Scheduled jobs installed with Workplace Safety Management

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
</table>
| Find upcoming reservation periodically       | Finds upcoming workspace reservations between 4–8 hours from the time when this job is executed and sends email notifications to those employees with reservations.  
By default, this job is set to run every 4 hours. |                                                                                                                                              |
| Reservation check-in & check-out             | Performs the following actions.  
• Notifies employees via email to check in a reservation.  
• Notifies employees via email to check out a reservation.  
• Auto cancels a reservation if it is not checked in within 30 minutes after the employee is notified.  
• Auto checks out a reservation if it is not checked out an hour after the reservation end time. |
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Stores the list of areas on office floors.</td>
</tr>
<tr>
<td>[sn_wsd_core_area]</td>
<td></td>
</tr>
<tr>
<td>Arrival Entry</td>
<td>Stores the list of scheduled arrival entries of the employees.</td>
</tr>
<tr>
<td>[sn_wsd_core_arrival_entry]</td>
<td></td>
</tr>
<tr>
<td>Arrival Schedule</td>
<td>Store the list of scheduled arrival intervals created by the workplace manager.</td>
</tr>
<tr>
<td>[sn_wsd_core_arrival_schedule]</td>
<td></td>
</tr>
<tr>
<td>Building</td>
<td>Stores the list of office buildings.</td>
</tr>
<tr>
<td>[sn_wsd_core_building]</td>
<td></td>
</tr>
<tr>
<td>Campus</td>
<td>Stores the list of office campuses.</td>
</tr>
<tr>
<td>[sn_wsd_core_campus]</td>
<td></td>
</tr>
<tr>
<td>Floor</td>
<td>Stores the list of office floors.</td>
</tr>
<tr>
<td>[sn_wsd_core_floor]</td>
<td></td>
</tr>
<tr>
<td>Html Signing Template</td>
<td>Stores the templates to sign off on a planned task and generate a PDF.</td>
</tr>
<tr>
<td>[sn_wsd_core_html_signing_template]</td>
<td></td>
</tr>
<tr>
<td>Location Shift</td>
<td>Stores the relationship between shifts and workspace locations.</td>
</tr>
<tr>
<td>[sn_wsd_core_m2m_location_shift]</td>
<td></td>
</tr>
<tr>
<td>Planned Task Definition</td>
<td>Stores the planned task definitions that workplace managers create for workplace tasks.</td>
</tr>
<tr>
<td>[sn_wsd_core_planned_task_def]</td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td>Stores the list of regions of workplace locations.</td>
</tr>
<tr>
<td>[sn_wsd_core_region]</td>
<td></td>
</tr>
<tr>
<td>Reservation</td>
<td>Stores the relationship between shifts, employees, and workspaces.</td>
</tr>
<tr>
<td>[sn_wsd_core_reservation]</td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td>Stores the list of shifts.</td>
</tr>
<tr>
<td>[sn_wsd_core_shift]</td>
<td></td>
</tr>
<tr>
<td>Site</td>
<td>Stores the list of sites of the organization.</td>
</tr>
<tr>
<td>[sn_wsd_core_site]</td>
<td></td>
</tr>
<tr>
<td>Space</td>
<td>Stores the list of workspaces of the organization.</td>
</tr>
<tr>
<td>[sn_wsd_core_space]</td>
<td></td>
</tr>
<tr>
<td>Space Type</td>
<td>Stores the list of space type configuration created by the workplace manager.</td>
</tr>
<tr>
<td>[sn_wsd_core_space_type]</td>
<td></td>
</tr>
<tr>
<td>Space Staging</td>
<td>Acts as an interim placeholder table for imported data about spaces.</td>
</tr>
<tr>
<td>[sn_wsd_core_space_staging]</td>
<td></td>
</tr>
<tr>
<td>User Shift</td>
<td>Stores the relationship between shifts and employees.</td>
</tr>
<tr>
<td>[sn_wsd_core_m2m_user_shift]</td>
<td></td>
</tr>
<tr>
<td>For existing users who are upgrading from the first version of the app, ensure that you have the User</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Workplace Profile</td>
<td>Stores the relationship between employees and their designated workspaces.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_profile]</td>
<td></td>
</tr>
<tr>
<td>Workplace Client Role Rule</td>
<td>Stores the workplace client role assignment rules created for employees.</td>
</tr>
<tr>
<td>[sn_wsd_core_client_role_rule]</td>
<td></td>
</tr>
<tr>
<td>Workplace Location</td>
<td>Parent table for all workspace entity tables such as Regions, Sites, Campuses, Buildings, Floors, Areas, and Spaces.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_location]</td>
<td></td>
</tr>
<tr>
<td>Workplace Request</td>
<td>Stores the workplace reservation requests created by employees.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_request]</td>
<td></td>
</tr>
<tr>
<td>Workplace Task</td>
<td>Stores all the workplace tasks created for shifts.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_task]</td>
<td>If you are upgrading from version 1.1.1 or earlier of the app, ensure that the Default Value field is empty for the workplace_task_type column of this table. For more information on how to modify the default display value of a table column, see Specify a default field value.</td>
</tr>
<tr>
<td>Workplace rooms</td>
<td>Extends the Space [sn_wsd_core_space] table. It holds the reservable items of a room that are available to reserve.</td>
</tr>
<tr>
<td>[sn_wsd_core_room]</td>
<td></td>
</tr>
</tbody>
</table>

Properties installed with Workplace Safety Management

Customize the properties available with Workplace Safety Management.

These properties are available for Workplace Safety Management.

ℹ️ Note: All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.

Properties for Workplace Safety Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_core.AUTO_ASSIGN_LOCATION</td>
<td>Enables auto-assignment of workspaces when employees make workspace reservation requests.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
</tbody>
</table>
Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **sn_wsd_core.CANCEL_RES_BUILDING** | Determines whether the reservations made for spaces should be canceled based on the value of the *Is reservable* field.  
  • Type: true | false  
  • Default value: false  
  If this property is set to true, then the application cancels all the workspace reservations that are made for the areas and spaces of those buildings or floors for which the value of the *Is reservable* field is set to false. |
| **sn_wsd_core.CLEANING_TASK_MAX_DURATION** | Determines the duration (in days) by when you want the pre-cleaning and post-cleaning tasks to be executed.  
  • Type: Integer  
  • Default value: 7 |
| **sn_wsd_core.enable_wpuser_criteria_for_rp** | Enables the user criteria of the workplace_user role to access record producers that are used by employees when they submit requests with the ServiceNow® Workplace Service Portal.  
  This property is available only for new users installing v1.2.2 of the application. Users who install v1.3.2 (or later) or who upgrade from v1.1.4 (or
### Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_wsd_core.floor_plan.portal.show_non_reservables | Determines whether non-reservable workspaces appear in grey on the floor plan in the Workplace Service Portal.  
  - Type: true | false  
  - Default value: false  
  ⚠️ **Note:** Changing this value to true can negatively affect performance. |
| sn_wsd_core.floor_plan.portal.show_reservation_details | Determines whether reservation details appear when users point to booked spaces on the floor plan in Workplace Service Portal.  
  - Type: true | false  
  - Default value: false |
| sn_wsd_core.REQUEST_MAX_DURATION | Determines the maximum number of days that an employee can request a space reservation for at one time. This property is applicable when an employee requests a space reservation for multiple days.  
  - Type: Integer  
  - Default value: 7 |
| sn_wsd_core.show_book_uber | Determines the visibility of the **Book Uber** button on the Now® Mobile app. If this property is set to true, then employees can select **Book Uber** from their confirmed reservations on their mobile devices. Users are redirected to the Uber mobile app.  
  - Type: true | false  
  - Default value: false |
| sn_wsd_core.wsd_inbound_email | Checks for emails that are received for the ServiceNow® Workplace Service Delivery and Workplace Case Management applications. This property has been renamed from the sn_wsd_case.wsd_inbound_email property in Workplace Case Management version 1.0.1. |
## Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sn_wsd_core.floor_transform_map</strong></td>
<td>Enables you to configure customized transform maps.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2528fbf70f201010dbc3d2d92f767e04</td>
</tr>
<tr>
<td><strong>sn_wsd_core.ENABLE_RSV_CHECK_IN</strong></td>
<td>Enables reservation check-in and check-out via email. If this property is set to true, then employees can check in and check out a reservation.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td><strong>sn_wsd_core.dfx.rebuild_cache.max_floors</strong></td>
<td>Enables you to specify the maximum number of floors to build for an entity cache at any time.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td><strong>sn_wsd_core.CLEANING_TASK_MAX_DURATION</strong></td>
<td>Enables you to configure the maximum duration until when the cleaning tasks must be performed.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 7</td>
</tr>
<tr>
<td><strong>sn_wsd_core.CANCEL_RES_LOCATION</strong></td>
<td>Enables you to cancel all future reservations made on a location level. Set the Is reservable field to false for the location.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td><strong>sn_wsd_core.ALLOW_USER_SHIFT_FILTERING</strong></td>
<td>Enables a user to create shift-based reservations only if the user is part of that shift.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
</tbody>
</table>
## Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_wsd_core.ALLOW_AVAILABILITY_FILTERING | Displays only the available buildings and floors in the reservation record producers.  
  - Type: true | false  
  - Default value: false  
  **Note:** If the property is set to **true**, then the selected workplace locations take a longer time to load. |
| sn_wsd_core.MULTI_DAY_AVAILABILITY | Displays only the available areas and spaces in multi-day reservation record producers.  
  - Type: true | false  
  - Default value: false  
  **Note:** If the property is set to **true**, then the selected workplace locations take a longer time to load. |
| ARRIVAL_REQUEST_MAX_FUTURE_DAYS | Enables you to specify the maximum number of days in the future until when employees can schedule their arrival.  
  - Type: Integer  
  - Default value: 7 |

## Providing your workplace data

In the Workplace Safety Management application, provide data related to your workplace locations so you can efficiently assign shifts to employees and designate workspaces for these shifts.

## Workspace Record

The information available for each workspace record is:

- Region
- Site
- Campus
- Building
- Floor
- Area
- Space
Each designation should use a unique identifier. For example, if you are indicating the fourth floor in building 7, you would name the floor “7-4” rather than just “4.”

**Entering data for several work sites**

If you have a large organization, you might want to consider using a spreadsheet to contain the more global record information such as regions, buildings, and sites so you can avoid having to manually input repeated information for each workspace record. You can either export the information you’ve already entered into the application into a spreadsheet or use that information in an existing workspace spreadsheet. You would then import the spreadsheet that contains the full workspace data into the application in bulk form.

- If you have an existing spreadsheet, you would first manually convert the column headers and data of the global information to match the ServiceNow record names and identifier numbers. You would then do a bulk import of that data into the Workplace Safety Management application so you can assign workspaces.

  For example, say your organization’s spreadsheet uses the name "Location" for Sites or "Bldg 1” for every building 1 on every site. You would have to change the spreadsheet column header "Location" to "Sites" and change each “Bldg 1” to the unique identifier from the Workplace Safety Management application records.

- If you don’t have an existing spreadsheet, you would enter the repeated global information that you don’t want to have to input manually for each space. The data for each field should have a unique identifier. You would then export the information from the application into a spreadsheet where you would have to input only the space information manually.

**Floor plans**

The Now Platform supports Drawing eXchange Format (.dxf) files for floor plans. You can select the layers you need for end-user floorplans and configure the attributes (tags) you want assigned to fields. For information about how to export an AutoCAD .dwg file to a Drawing eXchange Format (.dxf) file, see the documentation for your version of AutoCAD.

Prior to uploading a .dxf file, work with your AutoCAD designers to ensure the following:

- The file uses block references and not single-line or multi-line text for space labels.
- The blocks attributes have human-understandable tags.
- The block references have attribute values appropriately set.

**Note:** Using blocks is highly recommended. Do not use text objects.

Uploading a floor plan creates a floor record. All the workspaces of the floor are automatically added to the Spaces related list of the floor record.

**Create records for your workplace data**

Create individual records of your workspaces, floors, office buildings, and workplace locations within the Workplace Safety Management application. Either insert new data or add records to the existing workplace data.

**Before you begin**

Ensure that you have the following details:

- Workplace data for your organization.
- Data of workspaces that can be marked as available.
Important: In the Workplace Service Delivery Suite, from Workplace Safety Management version 2.5.3, the **Space type (space_type)** choice field is depreciated. After the upgrade, Space types are configured in the **Space Type Configuration**. The **Space type (space_type)** field is migrated as **Space type (location_type)** field in the Space table [sn_wsd_core_space]. Customers having customization on the depreciated **Space type (space_type)** field are advised to manually migrate their flow to use the new **Space type (location_type)** field. A new fix script, **Populate Location Type from Space Type**, is introduced to execute the schedule job, **Populate location_type from space_type**, on the Space table [sn_wsd_core_space] to migrate the depreciated **Space type (space_type)** field value to the new **Space type (location_type)** field.

Role required: sn_wsd_core.admin

About this task
If you have a small number of workspaces, you can enter information individually for each workspace down to the Spaces level.

If you have many work sites, you might want to do the following:

1. Create a skeleton of repeated global information.
2. Add the individual spaces information in a spreadsheet.
3. Import the spreadsheet into the application.

   For more information on importing, see Configuring spreadsheets to import workplace data.

If you have floor plans, you can create records of data until the Buildings level. Uploading the floor plans loads the data of floors and of the spaces associated with these floors.

Procedure

1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select the applicable module.
   Create the records in the following order:
   - Regions
   - Sites
   - Campuses
   - Buildings
   - Floors
   - Areas
   - Spaces
   For example, if you want to locations of your offices, select **Sites**.
3. On the form, fill in the fields.

   **Note:**
   - The visibility of some of the following fields depends on the module that you selected.
   - You can leave a field that does not apply to your organization empty.

   The fields on the form differ based on what module you selected. For example, the following form is for Building.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the workplace. Ensure that you enter a unique name. For example, if the <strong>Building</strong> field is set to <strong>1C</strong>, and if the <strong>Space</strong> field is set to <strong>WST 1C 1601</strong>, then an appropriate value for the <strong>Name</strong> field can be <strong>1C-16</strong></td>
</tr>
<tr>
<td><strong>Note:</strong> Do not use workplace locations with the same name because it affects the reservation process.</td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td>Region where the office is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the office building for this workspace.</td>
</tr>
<tr>
<td>Floor</td>
<td>Name or number of the floor where this workspace is present.</td>
</tr>
<tr>
<td>Area</td>
<td>Name of the area on the office floor.</td>
</tr>
<tr>
<td>Space type</td>
<td>Type of the office space. To configure a new space type, see <a href="#">Add a space type configuration</a>.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate that this space is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate that the spaces for this workplace entity are available for reservation.</td>
</tr>
<tr>
<td></td>
<td>For example, if you do not mark a Building as reservable, then none the floors, areas, and spaces of this building would be available for reservation.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Latitude of a campus or a building. The latitude is displayed in the Workplace Service Portal Location directory map.</td>
</tr>
<tr>
<td>Longitude</td>
<td>Longitude of a campus or a building. The longitude is displayed in the Workplace Service Portal Location directory map.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
What to do next

- If you have floor plans for your workplace, you can upload them to create and display floor and workspace data. For more information, see Upload a workplace floor plan.
- If you are using a spreadsheet to enter and import bulk data for workspaces, see Configuring spreadsheets to import workspace data.
- If you have added all of your workplace data, you can define employee shifts. For more information, see Define shifts for your workplace.

Upload a workplace floor plan

Upload Drawing eXchange Format (.dxf) files of floor plans that you can configure and use to reserve space for your employees.

Before you begin

Role required: sn_wsd_core.workplace_manager

To avoid issues while rendering your floor plan, verify that the dxf.json attachment size is 5 MB or smaller. To view the size, download the dxf.json file and view the file properties. If the file size is larger than 5 MB, you can:

- Work with your AutoCAD designers to ensure that spaces are represented as blocks (not single or multi-line text).
- Ensure that the block reference attributes are appropriately set and try to import the dxf.json file again.
- Set the com.glide.attachment.max_get_size property to a size that is greater or equal to the dxf.json file size. For more information, see Administering attachments.

Procedure

1. Navigate to Workplace Safety Management > Administration > Upload Floor Plan.
2. On the form, fill in the fields.

Manage Workplace Floor form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A unique number automatically generated by the application that identifies the floor plan.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the floor plan.</td>
</tr>
<tr>
<td>Region</td>
<td>Geographic location of the building the floor plan represents.</td>
</tr>
<tr>
<td>Site</td>
<td>The location of the office or campus within a region.</td>
</tr>
</tbody>
</table>

**Note:** Be specific and have a consistent naming convention when naming your floor plans.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campus</td>
<td>Name of the campus if you have multiple buildings at a site.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the specific building if you have multiple buildings at a campus.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating whether this plan is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option indicating whether the space manager can reserve this plan for employee use.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>The group that manages the space reservation for the floor plan.</td>
</tr>
<tr>
<td>Managed by</td>
<td>The workplace manager of the group that manages the space reservation for the floor plan.</td>
</tr>
</tbody>
</table>

3. Select the attachment icon 📦 and upload your Drawing eXchange Format (.dxf) file. After you attach your .dxf file and import the floor plan, the .dxf file converts to a dxf.json file in your attachments. Don’t remove any of these files or your floor plan does not appear. Also, the dxf.json file size must be 5 MB or smaller. Try selecting fewer layers from your .dxf file during the import process.

4. Click **Next**.

5. In the Select layers column on the right, select the layers that you want to appear the plan. For example, you might not want electrical rooms, kitchens, storage closets, or other elements to appear on the floor plan when it renders.

6. Click **Render**. The floor plan appears under the **Preview plan** tab. Use your cursor to zoom in and out of the floor plan.

7. Click **Next**.

8. On the form, fill in the fields.

### Assign tags to fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| AutoCAD tag | The tag you want to map to your space fields. Tags identify spaces on the floor plan and come from the uploaded .dxf file. The tags that appear are the ones you selected in the Select layers column. **Note:** If you do not see any AutoCAD tags, you can use AutoCAD software to change text or text objects into block references.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Field</td>
<td>The field in the Space [sn_wsd_core_space] table with which you want to associate the tag. For example, you could associate an attribute named ROOM_NAME with the Name field and give it a higher order so it is the second part of the Name. The Space Field represents a specific location on the floor plan that you can assign to an employee.</td>
</tr>
<tr>
<td>Order</td>
<td>Determines the order of processing for your AutoCAD tag to Space Field mapping.</td>
</tr>
</tbody>
</table>

**Note:** Lower numbers process first.

9. Click **Submit**.

**Results**

A new floor record is created with the floor plan attached to it. The Spaces related list is populated with all the workspaces of this floor.

**Update a workplace floor plan**

Update a workplace floor plan by uploading a new plan.

**Before you begin**

Role required: sn_wsd_core.workplace_manager

**Procedure**

1. Navigate to **Workplace Safety Management > Space Administration > Floors**.
2. Click the floor you want to update.
3. Click the **Update floor plan** related link.
4. Click **Manage Attachments**, delete the current floor plan file, and attach the new floor plan file. You can have only one .dxf file uploaded at a time.
5. Click **Next**.
6. In the Select layers column, select the layers that you want to appear on the floor plan. For example, you might not want electrical rooms, kitchens, storage closets, or other elements to appear on the floor plan when it renders.
7. Click **Render**. The floor plan appears under the **Preview plan** tab. Use your mouse to zoom in and out.
8. Click **Next**.

**Assign tags to fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD tag</td>
<td>Tags from the uploaded .dxf file identify spaces on the floor plan.</td>
</tr>
</tbody>
</table>
Field | Description |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The tags that appear are those that you selected in the Select layers column.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you do not see any AutoCAD tags, you can use AutoCAD software to change text or text objects into block references.</td>
</tr>
<tr>
<td>Space Field</td>
<td>The field in the Space [sn_wsd_core_space] table with which you want to associate the tag. For example, you could associate an attribute named ROOM_NAME with the Name field and give it a higher order so it becomes the second part of the name.</td>
</tr>
<tr>
<td>Order</td>
<td>Determines the order of processing for your AutoCAD tag to Space Field mapping.</td>
</tr>
<tr>
<td>Note:</td>
<td>Lower numbers process first.</td>
</tr>
</tbody>
</table>

10. Click Preview Changes and in the Preview changes tab, review the changes you are going to make before you commit them.

11. Click Submit.

**Results**
The following changes occur:

- Map values are filled in.
- Existing spaces that no longer match are deleted.
- If old spaces have been renamed, the new names replace the old ones.
- Any reservations are deleted.

A original floor record is updated with the floor plan attached to it. The Spaces related list is also updated. To view your changes, go to Floor Plan Update Logs. For more information, see View your workplace floor plan update logs.

**View your workplace floor plan update logs**
After updating your workplace floor plan, you can view all changes made.

**Before you begin**
Role required: sn_wsd_core.workplace_manager

**Procedure**

1. Navigate to Workplace Safety Management > Administration > Floor Plan Update Logs. Logs appear for each floor plan updated with date and timestamps.

2. Click the Created date link to view the log record.

3. Click the Floor link to view the floor record.

**Configuring spreadsheets to import workplace data**

Doing a bulk import of the data of all your workspaces into the Workplace Safety Management application through a spreadsheet enables you to avoid manually entering redundant data for each workspace, which saves time and effort.
By using a spreadsheet that contains the global information for your work sites, you can enter only the distinguishing space information instead of having to manually repeat information such as the region, site, building, and floor. You can either create an Excel spreadsheet from the data you’ve entered into the Workplace Safety Management application or modify an existing workplaces spreadsheet.

Configure an existing workspaces spreadsheet

Customize the information in your organization's existing workspace spreadsheet to avoid having to manually enter repeated information for each workspace. You can then import the data into your ServiceNow instance.

Before you begin
Role required: sn_wsd_core.admin

About this task
If you have a spreadsheet containing your organization’s workspaces data, you need to customize it to match the record information in your ServiceNow instance.

This example describes how to modify the floor information for your workspace data. Repeat these instructions to replace the fields for your building, campus, site, and region, as appropriate.

Procedure
1. Modify the data in the spreadsheet to match the record information in your ServiceNow instance.
   a. Navigate to Workplace Safety Management > Space Administration > Floors.
   b. Search for the desired floor record and open it.
   c. Copy the value of the Number field.
   d. Paste the value in place of “Floor 1” in the Excel spreadsheet.

The example uses the following sample entry for workspaces that belong to Floor 1 of Building 1 at Florida Campus 2, Florida, USA:

- FLOR0001694 represents Floor 1
- BLDG0001028 represents Building 1
- CMP50001013 represents Florida Campus 2
- SITE0001007 represents Florida
- RGIN0001002 represents USA

Note: You can exclude the Area column as it is not mandatory. Enter a dummy value in the column instead of leaving it empty.
2. In your workspaces spreadsheet, add individual workspace information in the **Name** column.

3. Save your spreadsheet.

**What to do next**

Import your workspaces data from an Excel spreadsheet.

**Create a workplace data spreadsheet**

Create a Microsoft Excel spreadsheet from the data you entered into the Workplace Safety Management so you can avoid having to manually enter global information such as the site or building names for each workspace. You can then import the data into your ServiceNow instance.

**Before you begin**

Role required: sn_wsd_core.admin

**About this task**

If you have a large number of work sites, consider creating a spreadsheet that you can then import into your ServiceNow instance to avoid having to manually enter global information such as the site or building names for each workspace.

**Note:** If you already have an existing workspaces spreadsheet for your organization, follow the instructions in **Configure an existing workspaces spreadsheet** to customize it for exporting the data.

**Procedure**

1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select the module for the smallest unit for which you want to repeat the data.
   For example, if you have created global information records of regions, sites, buildings, and floors, you would select **Floors**.
3. **Optional:** Customize the columns to be displayed.
   For example, you can choose to hide the **Campus** column if your organization does not have campuses by entering a dummy value instead of leaving it empty.
4. Export the data by right-clicking on any column, selecting **Export**, and clicking **Excel (.xlsx)**. Data is exported from the application so that you can download it as an Excel file.
5. Click **Download**.
6. In your workspaces spreadsheet, add individual workspace information in the **Name** column.
7. Save your spreadsheet.

**What to do next**

Import your workspaces data from an Excel spreadsheet

**Import your workspaces data from an Excel spreadsheet**

Import your workspaces data from an Excel spreadsheet into the Workplace Safety Management application.

**Before you begin**

Complete **Configuring spreadsheets to import workplace data.**

Role required: sn_wsd_core.admin

© 2022 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure
1. Navigate to System Import Sets > Load Data.
2. Select Existing table.
3. In the Import set table field, select Space Staging [sn_wsd_core_space_staging].
4. In the Source of the import field, select File.
5. Click Choose File and select the source Excel spreadsheet.
6. Optional: Specify the worksheet number in the Sheet number field and header row number in the Header row field.
7. Click Submit.
   The imported data is now available in the new Import Set table.
8. Click Run Transform.
   Important: Ensure that the Import set field shows sn_wsd_core_space_staging and the selected map is Space Transform map - sn_wsd_core_space.
9. Click Transform.
10. Optional: Verify that the data records were imported into the Spaces table by navigating to Workplace Safety Management > Space Administration > Spaces

Related information
   Run an import
   Create a transform map

Add a space type configuration
Configure the different types of spaces available in your workplace. You can add spaces based on different space types. The space types enable your employee to identify the different types of spaces that are available on a floor in a Mappedin floor map

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

Procedure
1. Navigate to Workplace Safety Management > Administration > Space type configuration.
2. Click New.
3. On the form, fill in the fields.

 Space Type form
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the space type.</td>
</tr>
<tr>
<td>Code</td>
<td>Code for the space type. The code can also be a name.</td>
</tr>
<tr>
<td>Table</td>
<td>Table of the space type. The field is automatically set to Space [sn_wsd_core_space]. If the space type is a room, select Room [sn_wsd_core_room].</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Application of the space type. This field is automatically set. Make sure that <strong>Workplace Safety Management</strong> is selected.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the space type.</td>
</tr>
<tr>
<td>Available for</td>
<td>Option to specify the type of users for whom the space type is available.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**

The space type is configured. You can select this space type while creating a space or a type mapping.

**Workplace Service Portal**

The Workplace Service Portal is a self-service portal for employees, delivering workplace services from a central location. Employees can make reservations, view knowledge base articles, submit and review requests, and get help using virtual agent chat support.

From the Workplace Service Portal, you can do the following:

- Open the Reservation portal and make reservations for meeting rooms, desks, or any other reservable workplace items.
- Register visitors in advance and customize their visit. You can register a guest or an off-site colleague for either a short duration or a complete day.
- View and search through top-rated knowledge base articles to find information. As you type, the search field displays suggestions based on keywords.
- View your requests and approvals (if you are an approver).
- Submit requests for general inquiry, registering visitors, shift-based reservations, and other requests.
- Chat with a virtual agent to submit requests and view submitted requests.
- Raise a general help request by selecting from a list of service catalog items.
Mapping employees to their designated workspaces

Map your employees to their designated workplace locations in Workplace Safety Management to automatically fill in that detail in reservation requests and to take advantage of auto-assignment of workspaces if that feature has been enabled.

For employees who had a designated workspace before they started working remotely, create a mapping between the user profile and the designated workspace details. This mapping populates the workspace details on reservation request forms so employees don’t have to provide these details manually.

If your system administrator has enabled the auto-assign feature, mapping workspaces for all employees also means that designated workspaces are automatically assigned when employees make a reservation request.

The data from the User Workplace Profile [sn_wsd_core_workplace_profile] table is used to automatically assign the designated workspace to the employee.

- If the user’s designated space is available, this space is reserved for the employee.
- If the designated space is unavailable for the requested date or time, the application searches for and reserves an available space in the employee’s workplace in the order of Area > Floor > Building > Campus > Site > Region.

For example, if no spaces are available in the designated area of the employee, the application finds and reserves an available space from the floor of this area.

Map designated workspaces to user profiles

Map existing designated workspaces to employee user profiles in Workplace Safety Management. This mapping is used to automatically allocate workspaces for employees so they don’t have to select a workspace manually when requesting a reservation.

Before you begin

- Ensure that your workplace administrator has completed setting up your workplace data. For more information, see Providing your workplace data.
- Ensure that you have the designated workplace information for all the employees.
- You can also Navigate to the User Workplace Profiles [sn_wsd_core_workplace_profile] table by entering sn_wsd_core_workplace_profile.list in the navigation filter.

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task

Create a mapping for all employees and their designated workplaces. You can also perform an easy import of your employee workplace data. For more information, see Easy import.

Procedure

1. Navigate to Workplace Safety Management > Administration > Workplace profiles.
2. Click New.
3. On the form, fill in the fields.

User Workplace Profile form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Employee for whom you want to create a workplace mapping.</td>
</tr>
<tr>
<td>Workplace location</td>
<td>Designated workplace of the employee.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

5. Repeat the procedure for all the employees of the workplace that you manage.

**Results**
The User Workplace Profiles [sn_wsd_core_workplace_profile] table is populated with all the new profiles.

**Assign the workplace user role to employees**
Set rules in Workplace Safety Management to assign the workplace user role to employees in only the specific countries where you are starting a return to office operations.

**Before you begin**
Ensure that the user profiles of all your employees have required details. You can review the employee user profiles by navigating to **User Administration > Users**.

Role required: admin or sn_wsd_core.admin

**Procedure**
1. Navigate to **Workplace Safety Management > Administration**.
2. Click **Client Role Assignment Rules**.
3. On the form, fill in the fields.

**Workplace Client Role Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this assignment rule.</td>
</tr>
<tr>
<td>Role</td>
<td>This value is auto-generated with the workplace user role (sn_wsd_core.workplace_user).</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating whether this assignment rule is active.</td>
</tr>
<tr>
<td>Condition</td>
<td>Option to add filter conditions that a user profile must match. To add a condition, select <strong>Add filter condition</strong>. To add a OR clause, select <strong>Add &quot;OR&quot; clause</strong>.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which the conditions must be built. The field is automatically selected as sys_user.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The workplace user roles are assigned. If a record is created or updated on this table, a role assignment process is triggered in the background.
Apply the workplace client role assignment rule
Run the Add or Remove WSD User role scheduled job to apply the workplace client role assignment rule.

Before you begin
Role required: admin

Procedure
1. Navigate to System Definition > Scheduled Jobs.
2. Open the Add or Remove WSD User role scheduled job.
   This job is inactive by default.
3. Execute the job manually by clicking Execute Now.
4. Optional: Ensure that data is updated accurately by entering cache.do in the navigation filter to clear the cache of your ServiceNow instance.

Configuring shifts for your workplace
Configure shifts for your organization in the Workplace Safety Management application so you can efficiently plan and manage your workplace by assigning employees and workspaces to those schedules.

Define shifts for your workplace
Define shifts in Workplace Safety Management with specific schedules so you can designate areas or workplace and assign employees for each shift.

Before you begin
• Add your workplace data.
• Ensure you have the following information:
  ◦ Appropriate shift schedules
  ◦ Data of the employees who would operate from the office in this shift
  ◦ Data of the workplaces to be made available for this shift

Important: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_manager

About this task
Workplace managers can later reserve workplaces for employees according to the shifts assigned to them.

If your organization does not organize work in shifts, you can use the general shift schedule that is available with the application by default.

You can also access the Shift form by navigating to Workplace Safety Management > Shift Management > Create New.
Procedure
1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.

⚠️ Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Click Add a shift.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the shift, for example, Morning Shift.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule for the shift.</td>
</tr>
<tr>
<td></td>
<td>For a general shift schedule, select General shift.</td>
</tr>
<tr>
<td></td>
<td>For more information about how to create a shift schedule, see Define a schedule.</td>
</tr>
<tr>
<td>Owner</td>
<td>Shift owner who monitors activities during this shift.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the shift. Choose one of the following values:</td>
</tr>
<tr>
<td></td>
<td>• Draft: Indicates that the shift details are incomplete.</td>
</tr>
<tr>
<td></td>
<td>• Ready: Indicates that the shift is ready for assignments.</td>
</tr>
<tr>
<td></td>
<td>• Cancelled: Indicates that the shift is cancelled.</td>
</tr>
<tr>
<td>Start</td>
<td>Date from which this shift is active.</td>
</tr>
<tr>
<td>End</td>
<td>Date until which the shift is active.</td>
</tr>
<tr>
<td>Region</td>
<td>Region of the workplace site.</td>
</tr>
<tr>
<td>Site</td>
<td>Site location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus in which the office building is present.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the building in which the office floor is located.</td>
</tr>
<tr>
<td>Floor</td>
<td>Name or number of the floor where the area is located.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Area that is active for operation and use during this shift.</td>
</tr>
<tr>
<td>Users</td>
<td>Employees assigned to this shift. This field appears only on Workplace Service Portal.</td>
</tr>
<tr>
<td>Locations</td>
<td>Workplaces available for reservation during this shift. This field appears only on Workplace Service Portal.</td>
</tr>
</tbody>
</table>

#### Note:

- If this shift is applicable to all office buildings on your campus, you can leave the **Building**, **Floor**, and **Area** fields empty. The shift and its schedule will be automatically applied to all the records of buildings, floors, and areas associated with this campus.
- When an employee requests to make a reservation with shifts, only shifts that are active on the dates that the employee selected are displayed on the reservation form.

5. Click **Submit**.

6. If you accessed the Shift form from Workplace Service Portal, on the verification page, you can define another shift or view all the existing shifts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define another shift</td>
<td>Click <strong>Add another shift</strong>.</td>
</tr>
<tr>
<td>View all existing shifts</td>
<td>Click <strong>View all shifts</strong>.</td>
</tr>
</tbody>
</table>

**Results**

The shift is added to the list of all shifts that you can view by navigating to **Workplace Safety Management** > **Shift Management** > **All**.

**What to do next**

If you created the shift using Workplace Service Portal, you can directly create workplace reservations. For more information, see Managing workplace reservations for employees.

You can configure other information such as employees, workplaces, and maintenance tasks associated with this shift later.

- Assign more employees to a shift. For more information, see Assign employees to a shift.
- Associate more workplaces with a shift. For more information, see Associate areas and spaces with a shift.
- Associate tasks with a shift. For more information, see Managing workplace tasks.

**Assign employees to a shift**

Associate employees with a shift in Workplace Safety Management so that they operate from the office only in the shifts to which they are assigned. Workplace managers can later reserve workspaces for these employees according to their assigned shifts.
Before you begin
• Define shifts for your workplace.
• Ensure you have the data for the employees who will operate from the office in this shift.

Role required: sn_wsd_core.workplace_manager

Procedure
1. Navigate to Workplace Safety Management > Shift Management > All.
2. Open a shift to which you want to add employees.
3. In the Users related list, click Edit.
4. Add all the employees who should operate from the office in this shift.
5. Click Save.

Results
A pre-configured email with the shift details is sent to all employees assigned to this shift.

What to do next
Associate areas and spaces with a shift.

Associate areas and spaces with a shift
Associate work areas and spaces with a shift in Workplace Safety Management so that they are available only for that shift. Workplace managers can later reserve these workplace for employees operating in that shift.

Before you begin
• Define shifts for your workplace.
• Ensure you have the data for the workplaces to be made available for this shift.
• Ensure that the glide.ui.list.allow_extended_fields system property is set to true so that the filter criteria is displayed appropriately when you’re adding areas or spaces.

Role required: sn_wsd_core.workplace_manager

Procedure
1. Navigate to Workplace Safety Management > Shift Management > All.
2. Open a shift to which you want to add areas.
3. In the Locations related list, click Edit.
4. Add all the areas and spaces to be made available for this shift.
5. Click Save.

What to do next
Create workplace reservations for an employee.

Managing workplace shifts that you own
Review the workplace shifts that you own in Workplace Safety Management and update the shift details if necessary. You can also monitor the reservations and requests made for the workspaces associated with these shifts.
Update details of the shifts that you own

Review and modify the details of the workplace shifts that you own in Workplace Safety Management. You can modify the general shift details, and add or remove employees or workplaces associated with the shift.

Before you begin
Role required: sn_wsd_core.workplace_shift_owner

Procedure
2. Click Owned by Me.
3. Open the shift for which you want to view the details.
4. Optional: Modify the shift details.
   a. Edit the details on the shift form.

Shift form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the shift.</td>
</tr>
</tbody>
</table>
| Schedule  | Schedule for the shift.  
  (Optional) For a general shift schedule, select General shift. |
| Owner     | Shift owner who monitors activities during this shift.  
  (Optional) If you select a different user, you will lose access to this shift. |
| State     | Status of the shift. Choose one of the following values:  
  - Draft: Indicates that the shift details are incomplete.  
  - Ready: Indicates that the shift is ready for assignments.  
  - Cancelled: Indicates that the shift is cancelled. |
| Region    | Region of the workplace site. |
| Site      | Site location of the office campus. |
| Campus    | Name of the campus in which the office building is present. |
| Building  | Name of the building in which the office floor is located. |
| Floor     | Name or number of the floor where the area is located. |
| Area      | Area that is active for operation and use during this shift. |
Note: If this shift is applicable to all office buildings on your campus, you can leave the Building, Floor, and Area fields empty. The shift and its schedule will be automatically applied to all the records of buildings, floors, and areas associated with this campus.

b. Click Update.

5. Optional: Modify the list of employees assigned to this shift.
   a. In the Users related list, click Edit.
   b. Add or remove users.

6. Optional: Modify the list of workspaces associated with this shift.
   a. In the Locations related list, click Edit.
   b. Add or remove areas and spaces.

Review workplace reservations for shifts that you own

Review the workplace reservations and the reservation requests made for the shifts that you own in Workplace Safety Management. You can identify pending requests and work with your workplace manager to resolve them.

Before you begin
Role required: sn_wsd_core.workplace_shift_owner

Procedure
1. Navigate to the reservation requests from employees or workplace reservations by the workplace manager.

<table>
<thead>
<tr>
<th>Choice</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation requests made by employees</td>
<td>Navigate to Workplace Safety Management &gt; Workplace Requests &gt; All</td>
</tr>
<tr>
<td>Reservations made by the workplace manager</td>
<td>Navigate to Workplace Safety Management &gt; Space Reservations &gt; All Reservations</td>
</tr>
</tbody>
</table>

2. Review all reservations requested or made for your shift.

3. Optional: Open a reservation record to view its details.
   (Optional) If you want to make any changes to the reservation such as assigning another workspace to the employee, or changing the date of the reservation, reach out to the workplace manager to request those changes.

4. Optional: If you are viewing employee requests, note any requests in the Pending state so you can work with your workplace manager to resolve them.

Managing workplace reservations for employees

Reserve available areas or spaces for your employees and review pending reservation requests from employees in Workplace Safety Management so you can ensure physical distancing measures when they return to the workplace. Once you make reservations, employees are notified about the locations to which they have access. The Workplace Service Delivery also offers more advanced workplace reservation options in the Workplace Reservation Management application.
Creating workplace reservations for employees

Reserving workplace areas

As a workplace manager, you can make reservations for employees for areas on the floors of your office buildings. When employees return to the office, they can work from any of the spaces from the reserved area. The number of employee reservations that you can make for an area of your workplace depend on the capacity defined for that area. If the Capacity field of an area is set to 0 or left empty, reservations cannot be made for that area.

For more information on setting the capacity for an area, see Define the capacity of workplace areas.

Creating a single space reservation

Using the shifts that you defined, you can create a space reservation for an employee for a single day or multiple days. For more information, see Create workplace reservations for an employee.

Creating space reservations in bulk

You can generate in one action reservations for multiple employees who are assigned to a shift for a specific date range. For example, you can use this feature to create reservations for employees of a specific department who would all be assigned to the same shift. For more information, see Create workspace reservations for multiple employees.

Child reservation records for employee space reservations

When you reserve a workplace for an employee, the reservation generates child reservation records for every applicable working day of the specified period. The applicable days are determined by the shift schedule that you select for this reservation. The reservation that you initially created acts as the parent reservation record.

If a child reservation conflicts with an existing reservation for any day in the specified period, the child reservation is not created for that day. You can manually create a reservation for a different workplace for that day.

For example, say you created a reservation for the workplace 2CN1612 for Mark Andrews in the afternoon shift from 06-01-2020 to 06-10-2020. Eight child reservation records for Mark Andrews for the workplace 2CN1612 would be created for each working day between 06-01-2020 and 06-10-2020. However, if a reservation for 2CN1612 on 06-08-2020 exists for another employee Jane Doe, the child reservation for Mark Andrews on 06-08-2020 is not created. You can manually create a reservation for Mark Andrews for a different workplace for 06-08-2020.

If you update the details of a parent reservation later, all its child reservations except the ones with dates in the past are updated accordingly.

Working with space reservation requests from employees

After an employee requests a workplace for a given date range and the manager approves the request, the application checks the availability of the requested space. If the workplace is unavailable for any or all days of the specified period, the request moves to the Pending state. As a workplace manager, you can review these pending reservation requests and allocate a different workplace to the employee to complete the request. For more information, see Approve employee workplace reservation requests.
Define the capacity of workplace areas

Set the capacity for areas of your workplace in Workplace Safety Management to enable reservations for the area. The capacity ensures a limit to the workplace reservations for these areas so you can ensure safety guidelines.

Before you begin

• Add your workplace data.
• Ensure you have the details of the maximum capacity for the areas of your workplace.

Role required: sn_wsd_core.workplace_manager

Procedure

1. Navigate to Workplace Safety Management > Space Administration > Areas.
2. Open an area to which you want to add the capacity.
3. On the Area form, enter a value for the Capacity field. For example, if this area can accommodate only 8 people safely according to physical distancing guidelines, set the value to 8.
4. Click Update.

Create workplace reservations for an employee

Create workplace reservations for an employee in the Workplace Safety Management application using the shifts and shift schedules that you defined.

Before you begin

• Define shifts for your workplace.
• Assign employees to a shift.
• Associate areas and spaces with a shift.
• Define the capacity of workplace areas.
• Ensure you have the data that shows the mapping of employees to the workplaces in your workplace.

Important: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_manager

About this task

Reserve a workplace for an employee according to the assigned shift for a single day or multiple days.

You can also access the Reservation form by navigating to Workplace Safety Management > Space Reservations > Create New.

Procedure

1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
a. Click **Catalog**.

b. Click **Browse by Categories**.

c. In the Workplace Services Catalog, select **Site safety**.

   **Note:** If there are multiple catalogs configured on the portal, go to the Catalogs list and select **Workplace Services Catalog > Site safety**.

3. Click **Reserve a space**.

4. On the form, fill in the fields.

   **Reservation form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Shift for which this reservation is being made.</td>
</tr>
<tr>
<td>Location</td>
<td>Area or space for which this reservation is being made.</td>
</tr>
<tr>
<td>Requested for</td>
<td>Employee for whom this reservation is being made.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date and time from which the reservation is active.</td>
</tr>
<tr>
<td>End date</td>
<td>Date and time until which the reservation remains active.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. If you accessed the Reservation form from Workplace Service Portal, on the verification page, you can create another reservation or view all the existing reservations.

   **Option** | **Action** |
   -----------|------------|
   Create another workplace reservation | Click **Reserve another space**. |
   View existing workplace reservations | Click **View all reservations**. |

**Results**

- If you’ve reserved a space, then child reservation records are generated for every applicable occurrence of the specified period.

- A preconfigured email with the reservation details is sent to the shift owner and the employee for whom you reserved the workplace.

- The reservation is added to the list of all reservations that you can view by navigating to **Workplace Safety Management > Space Reservations > All Reservations**.

**Create workplace reservations for multiple employees**

Automatically generate workplace reservations in bulk for all employees assigned to a shift for a single day or multiple days.
Before you begin

- Define shifts for your workplace.
- Assign employees to a shift.
- Associate areas and spaces with a shift.
- Ensure that the number of locations associated with the shift is greater than the number of employees assigned to the shift.

Role required: sn_wsd_core.workplace_manager

Procedure

1. Navigate to Workplace Safety Management > Shift Management > All.
2. Open a shift for which you want to generate the bulk reservations.
3. Click Generate Bulk Reservation.
4. Select a date range from the Start date and End date fields.
   - If you want to create the bulk reservation for a single day, you can set the start and end date to the same day. Otherwise, set a date range.
5. Click OK.

Results

Reservations for the employees in this shift are created for the locations associated with the shift for the provided dates. You can view these reservations by navigating to Workplace Safety Management > Space Reservations > All Reservations.

Review pending workplace reservation requests

Review pending workplace reservation requests from employees in Workplace Safety Management and assign available workplaces to complete these requests.

Before you begin

Role required: sn_wsd_core.workplace_manager

Procedure

2. Open a pending request that you want to address.
3. Open the related reservation record, which is the parent reservation:
   a. Click the information (i) icon next to the Reservation field.
   b. Click Open Record for the desired request.
4. On the reservation form, review the reservation details such as the workplace location being requested, the start and end dates, and the number of reservations confirmed for that period.
   - From these details, you can review the number of days, with their dates, that are missing a reservation for the employee for the requested location.
5. If any dates are missing a reservation for the requested location, adjust the pending request to assign a workplace for all the missing desired dates.
• Change the workplace location in the parent reservation to a workplace available for all dates, which will also update the location for all applicable future child reservations.
  a. Select a different location from the **Workplace location** field.
  b. Click **Update**.
• Create a child reservation for a new workplace location for this employee for specific dates that are missing a reservation.
  a. In the Reservations related list, click **New**.
  b. Select the start and end dates in the **Start** and **End** fields.
  c. Select a location from the **Workplace location** field.
    The list of spaces displays the locations that are available for the requested dates.
  d. Click **Submit**.

6. After all the days that were missing a reservation are addressed, update the status of the pending workplace task to **Closed complete**.

7. Optional: Repeat this process for all pending workplace requests that you want to address.

**Results**
Once the status of workplace request is updated to **Closed complete**, the reservation information is populated in the **Notes** field of the workplace request.

**Setting and tracking arrivals at the workplace**
Workplace managers can set arrival intervals in Workplace Safety Management for different locations at your workplace with defined capacities to facilitate staggered entry of employees into the office. Employees can then choose from the defined arrival slots.

Workplace managers can define arrival times and capacity for different locations such as the entry and exit gates, elevator, gym, and cafeteria of your workplace. Employees can then schedule their arrival at these locations for an available time slot.

For example, say you define arrival times for the cafeteria at 12:00 h, 13:00 h, 14:00 h, and 15:00 h, and set a capacity of 15 for every slot. A maximum of 15 employees can schedule their arrival to the cafeteria for each of these times on any given day.

By setting arrival intervals for your workplace, you can facilitate employee actions such as entry and exit to the office, elevator use, lunch pickup, gym use, and so on, without employees having to wait in long lines or causing large gatherings at any of the locations.

⚠️ **Attention:** Starting with Workplace Safety Management version 2.3, time zones are introduced in the application. All the arrival schedules that were created on Workplace Safety Management version 2.2 and earlier are deactivated after the upgrade.

**Define arrival schedules at the workplace for employees**
Define arrival slot times in Workplace Safety Management for different locations at your workplace and indicate the capacity for each slot. Establishing arrival schedules enables safe staggered entry of employees to these locations.

**Before you begin**
• Add your workplace data.
• Ensure you have the data for arrival schedules of the locations of your workplace.
• Ensure that your time zone is set to the time zone of the building that is used for the arrival.
**Attention:** Starting with Workplace Safety Management version 2.3, time zones are introduced in the application. All the arrival schedules that were created on Workplace Safety Management version 2.2 and earlier are deactivated after the upgrade. Both existing customers and new customers must perform the following actions on existing arrival schedules to set them to active:

1. Set the time zone of the building where you are creating or updating the arrival schedule.

   - **Note:** If you are creating or updating the arrival schedule for a floor, area or a space, then select the building where it is located.

   1. Go to Workplace Safety Management > Space Administration.
   2. Select Buildings, Floors, Areas, or Spaces based on where you are scheduling an arrival slot.
   3. Select the building, floor, area, or the space for which you want to set the time zone.
   4. Set the building time zone.
      - If you selected a building, set the time zone in the Time zone field.
      - If you selected a floor, area, or the space, on the form, select the preview icon (i) that is next to the Building field.
         - In dialog box, select Open record.
         - On the Buildings form, set the time zone in the Time zone field.
   5. Click Update.

   - **Note:** All the active arrival schedules that were created on this building and on associated floors, areas, or spaces will be deactivated. Any future arrival requests that are related to this schedule will be canceled.

   - Click Ok on the warning that appears.

2. Change your session's time zone to the building's time zone.

   - **Note:** Ensure that the sn_wsd_core.workplace_manager role is included in the glide.timezone_changer.roles property. If it is not included, ask your system administrator to include the role so that you can change your time zone.

   1. Select the settings icon (⚙️) on your instance header.
   2. Set the Time zone field to the time zone of the building where you are creating or updating the arrival schedule.

Role required: sn_wsd_core.workplace_manager

**About this task**

**Procedure**

2. Click Create Arrival Schedules.
3. On the form, fill in the fields.
**Arrival Schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace location</td>
<td>Select a building, floor, area or space where you want to schedule the arrival times.</td>
</tr>
<tr>
<td>Arrival schedule time</td>
<td>Time (in hours, minutes, and seconds) at which employee arrivals can start at this location, for example, 12 30 00.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating whether this schedule time is active. If marked as active, this schedule time will appear every day in the list of available time slots.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Maximum number of employees that can schedule their arrival to this location at this slot time.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
An arrival schedule is created for this workplace location for the indicated time and capacity. You can view arrival schedules by navigating to **Workplace Safety Management > Workplace Arrival Scheduling > Arrival Schedules**.

**Schedule your arrival time at a workplace location**
Schedule your arrival in Workplace Safety Management at locations at your workplace so you can prevent long lines and safely enter the location.

**Before you begin**
To schedule an arrival using your mobile device, you must have the **Now® Mobile** app.

---

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the ServiceNow® Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see **Configure a catalog in Service Portal**.

Role required: sn_wsd_core.workplace_user

**About this task**
You can also access the Schedule your arrival form using your mobile device. From the Now Mobile app, navigate to **Services > Workplace Safety Management**.

**Procedure**
1. Navigate to **Workplace service portal > Workplace Service Portal Home**.
2. Open the **Site safety** category.
a. Click **Catalog**.

b. Click **Browse by Categories**.

c. In the Workplace Services Catalog, select **Site safety**.

   **Note:** If there are multiple catalogs configured on the portal, go to the Catalogs list and select **Workplace Services Catalog** > **Site safety**.

3. Select **Schedule your arrival**.

4. On the form, fill in the fields.

   **Schedule your arrival form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry point</td>
<td>Location where you want to schedule your arrival.</td>
</tr>
<tr>
<td>Building time zone</td>
<td>Time zone for the building of the selected entry point.</td>
</tr>
<tr>
<td>Date</td>
<td>Date of your arrival.</td>
</tr>
<tr>
<td>Arrival time</td>
<td>Time of your arrival. The time is displayed in 24-hour format.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

   **Results**
   The arrival request is created. The web page or your mobile screen is refreshed to show your arrival request details.

   **What to do next**
   You can check the details of your arrival schedule anytime.

   1. Depending on your platform, do one of the following to view your requests:
      - On the Workplace Service Portal, go to the **Requests** tab to view your requests and reservations.
      - On the Now Mobile navigation bar, tap **For Me** and scroll down to the My Request section to view your requests.

   2. If you want to cancel your arrival, select the arrival request and click **Cancel arrival**.

   **Updating arrival schedules at the workplace**
   Define building time zones, change the capacity of an arrival schedule, and set the schedule to active or inactive.

   **Before you begin**
   - Add your workplace data.
   - Ensure that you have the data for the arrival schedules of your workplace locations.
• Ensure that your time zone is set to the time zone of the building that is used for the arrival.

⚠️ **Attention:** Starting with Workplace Safety Management version 2.3, time zones are introduced in the application. All the arrival schedules that were created on Workplace Safety Management version 2.2 and earlier are deactivated after the upgrade. Both existing customers and new customers must perform the following actions on existing arrival schedules to set them to active:

1. Set the time zone of the building where you are creating or updating the arrival schedule.

   - **Note:** If you are creating or updating the arrival schedule for a floor, area or a space, then select the building where it is located.

   a. If you are updating the arrival schedule, do the following:

      i. Select the workplace location info icon (ℹ️) that is next to the **Workplace location** field.

      ii. In the dialog box, select **Open record**.

      iii. If the value of **Workplace location** is a floor, area or a space, then select the workplace location info icon (ℹ️) that is next to the **Building** field.

   b. On the Buildings form, set the time zone in the **Time zone** field.

   c. Click **Update**.

   - **Note:** All the active arrival schedules that were created on this building and on associated floors, areas, or spaces will be deactivated. Any future arrival requests that are related to this schedule will be canceled.

   d. Click **Ok** on the warning that appears.

2. Change your session's time zone to the building's time zone.

   - **Note:** Ensure that the sn_wsd_core.workplace_manager role is included in the glide.timezone_changer.roles property. If it is not included, ask your system administrator to include the role so that you can change your time zone.

   a. Select the settings icon (⚙️) on your instance header.

   b. Set the **Time zone** field to the time zone of the building where you are creating or updating the arrival schedule.

   - **Note:** You cannot update the **Workplace location** or **Arrival schedule time** fields of an arrival schedule if there are any arrival requests associated with it. You must create a new arrival schedule for the changed **Workplace location** or **Arrival schedule time** fields.

   4. To activate the schedule, select the **Active** option.

Role required: sn_wsd_core.workplace_manager

Procedure

1. Navigate to **Workplace Safety Management > Workplace Arrival Scheduling**.
2. Select **Arrival Schedules**.
3. Select the arrival schedule that you want to update.

   - **Note:** You cannot update the **Workplace location** or **Arrival schedule time** fields of an arrival schedule if there are any arrival requests associated with it. You must create a new arrival schedule for the changed **Workplace location** or **Arrival schedule time** fields.

4. To activate the schedule, select the **Active** option.
5. To change the capacity, edit the **Capacity** field.

6. Click **Update**.

**Results**
The arrival schedule is updated.

**Making workplace reservations**
Make workplace reservations in Workplace Safety Management when you are ready to return to the office. You can reserve a workplace for a day or less directly or request a workplace for a specified period. Once a reservation request is approved and confirmed, you are notified about the reservation details.

⚠️ **Attention:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

**Reserving a workplace**
As an employee, you can request a workplace reservation using Workplace Service Portal or the Now® Mobile app.

When making a reservation, you can choose an available space that you want to access or select an available area. If you've made a reservation for an area, you can work from any available space within that area when you return to office.

You can select a shift of your choice from the shift schedules defined by your organization. If your organization does not use shifts, you can select a custom time period. Depending on your organizational guidelines, your reservation request might require an approval. For more information, see Request a workplace reservation for multiple days.

⚠️ **Note:** If you need a workplace for only a day or less, you can reserve it directly and do not have to submit a request and get approval. For more information, see Reserve a workplace for a day.

You can check the status and details of all your reservation requests on Workplace Service Portal or through the Now Mobile app.

**Space reservation request states**
Once you submit a space reservation request, its status changes depending on the action taken on it by your approving manager or the workplace manager. You receive email notifications of these changes.

If you install the Now® Mobile app on your mobile device, you will also receive push notifications about your reservation requests.

- If your manager has not taken action on your request, the state of the request remains **Awaiting approval**.
- If your manager approves your request and the space availability is confirmed, the state of the request changes to **Closed complete**.
- If your manager rejects your request, the state of the request changes to **Closed incomplete**.
- If your manager approves your request but the space you requested for is not available for all or some days, the state of the request changes to **Pending**.
You can follow up with your workplace manager to get a new space assigned and resolve your pending space request.

- If you cancel your request, the state of the request changes to Cancelled.

**Request a workplace reservation for multiple days**

Request a workplace reservation for the days during which you want to return to office by using Workplace Safety Management.

**Before you begin**

To request a workplace reservation using your mobile device, you must have installed the Now® Mobile app.

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_user

**About this task**

Request a workplace reservation either in a defined shift schedule or for a custom time for a specific date range during which you want to work from the office.

You can also access the reservation form using your mobile device. From the Now Mobile app, navigate to Services > Workplace Safety Management and choose either Request a short-term shift and space or Request a short-term space.

**Procedure**

1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.
      * Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Reserve a space for a predefined shift or for a custom time.
   - To reserve a space for a defined shift schedule, click Request a short-term shift and space.
   - To reserve a space for a custom time, click Request a short-term space.
4. On the form, fill in the fields.
   * Note: The visibility of some of the following fields depends on the application settings made by your administrator.
Reserve a short-term space form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Region of your office location.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of your office.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus of your office building.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building that you want to return to.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date from which you want access to the workplace.</td>
</tr>
<tr>
<td>End date</td>
<td>Date until which you want to access the workplace.</td>
</tr>
<tr>
<td>Shift</td>
<td>The shift schedule during which you want to visit the office.</td>
</tr>
<tr>
<td></td>
<td>Only the shifts available for the selected location and date range are displayed.</td>
</tr>
<tr>
<td></td>
<td>Only the shifts that you are part of are displayed. This is dependent on the system properties which were configured by your organization.</td>
</tr>
<tr>
<td>Shift detail</td>
<td>Details of the shift that you selected.</td>
</tr>
<tr>
<td></td>
<td>The shift detail is auto-filled based on your shift selection.</td>
</tr>
<tr>
<td>Start time for each day</td>
<td>Time from when you would access the workplace.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if you selected Request a short-term space.</td>
</tr>
<tr>
<td>End time for each day</td>
<td>Time until when you would access the workplace.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if you selected Request a short-term space.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor of the area or space that you want to access.</td>
</tr>
</tbody>
</table>

5. If the Area and Space preference fields are available, select an area or a space that you want to reserve.
   - If you are using Workplace Service Portal or if you are using the Now Mobile app, and if you know which workplace to select, then select an area or a space from the Area or Space fields.
   - If you are using Workplace Service Portal and floor plans for your workplace have been uploaded, you can also select the area or space from the interactive floor plan that is displayed at the bottom of the form. The animation on the Workplace Service Portal header indicates that the map is rendering. Wait until the map fully renders. The label colors of the workplaces indicate their availability.
- Green: The workplace is active for reservation and is available for the date and time that you selected.
- Red: The workplace is active for reservation but is unavailable for the date and time that you selected.
You can see who has the reservation by hovering over a reserved space, if your system administrator has enabled this setting.
- Grey: The workplace is inactive for reservations.

6. Select **Submit**.

**Results**
The web page or your mobile screen is refreshed to show your submitted reservation request. The state of your request is set to Awaiting approval, which indicates that the request has been sent to your manager for approval.

**What to do next**
You can check the status of your reservation request or choose to cancel your request using Workplace Service Portal or the Now Mobile app.

- On Workplace Service Portal, go to the **Requests** tab to view your requests and reservations.
- On the Now Mobile app’s navigation bar, tap For Me and scroll down to the My request section to view your requests and reservations.
- To cancel a reservation, go to the Requests page in the Workplace Service Portal or My request page in the Now Mobile:
  - To cancel the reservation request, click **Cancel request**.
  - To cancel a single reservation within the reservation request, click **Reservation details**. Select the reservation you want to cancel and click **Cancel reservation**.
Reserve a workplace for a day

Reserve workplaces for a day on which you want to return to the office by using Workplace Safety Management.

Before you begin
To reserve a workplace using your mobile device, you must have the Now® Mobile app.

⚠️ Attention: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portalon Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_user

About this task
Reserve spaces for a period less than or equal to 24 hours on the day that you want to work from the office. Reserve spaces, either in a defined shift schedule or in your custom timings.

You can also access the reservation form from the Now Mobile app. Navigate to Services > Workplace Safety Management and choose one from Reserve a shift and space for a day or Reserve a space for a day.

Procedure
1. Navigate to Workplace Services Portal > Workplace Services Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.
      ❗ Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Reserve a space either for a defined day shift or a custom date.
   • To reserve a space for a defined shift schedule, click Reserve a shift and space for a day.
   • To reserve a space for custom timings, click Reserve a space for a day.
4. On the form, fill in the fields.
   ❗ Note: The visibility of some of the following fields depends on the application settings made by your administrator.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Region of your office location.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of your office.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus of your office building.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building that you want to return to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>On-site date</td>
<td>Date on which you want access to the workplace.</td>
</tr>
<tr>
<td>Shift</td>
<td>The shift schedule during which you want to visit the office.</td>
</tr>
<tr>
<td></td>
<td>Only the shifts available for the selected location and date range are displayed.</td>
</tr>
<tr>
<td></td>
<td>Only the shifts that you are part of are displayed. This depends on the system properties which were configured by your organization.</td>
</tr>
<tr>
<td>Shift detail</td>
<td>Details of the shift that you selected.</td>
</tr>
<tr>
<td></td>
<td>The shift detail is auto-filled based on your shift selection.</td>
</tr>
<tr>
<td>Start date/time</td>
<td>Date and time from when you would access the workplace.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if you selected Reserve a space for a day.</td>
</tr>
<tr>
<td>End date/time</td>
<td>Date and time until when you would access the workplace.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if you selected Reserve a space for a day.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor of the area or space that you want to access.</td>
</tr>
</tbody>
</table>

5. If the Area and Space fields are available, select an area or a space that you want to reserve.

- If you are using the Workplace Service Portal or if you are using the Now Mobile app, and if you know which workplace to select, then select an area or a space from the Area or Space fields.
- If you are using Workplace Service Portal and floor plans for your workplace have been uploaded, you can also select the area or space from the interactive floor plan that is displayed at the bottom of the form. The animation on the Workplace Service Portal header indicates that the map is rendering. Wait until the map fully renders. The label colors of the workplaces indicate their availability.

  - Green: The workplace is active for reservation and is available for the date and time that you selected.
  - Red: The workplace is active for reservation but is unavailable for the date and time that you selected.
You can see who has the reservation by hovering over a reserved space, if your system administrator has enabled this setting.

- Grey: The workplace is inactive for reservations.

6. Select Submit.

Results
The web page or your mobile screen is refreshed to show your reservation details.

What to do next
You can check the details of your reservation or choose to cancel it anytime using Workplace Service Portal or the Now Mobile app.

- On the Workplace Service Portal, go to the Requests tab to view your requests and reservations.
- On the Now Mobile app’s navigation bar, tap For Me and scroll down to the My Request section to view your requests and reservations.

If your organization has enabled the functionality to book an Uber from your mobile device, you would see a Book Uber option on your reservation details screen on Now Mobile. Tapping on it would redirect you to the Uber mobile app, if you have the app installed on your mobile device.

You will receive an email notification 15 minutes before the reservation to check in and another email notification 30 minutes before the reservation end time to check out.

- In the check-in email, select any of the following actions.
  - **Check in:** Check in your reservation.
  - **Cancel this reservation:** Cancel if the reservation is no longer required.
  - (Optional) **Check out:** Check out early before the reservation end time.

**Note:** You must check in within 30 minutes from the reservation start time, otherwise the reservation is canceled.
• In the check-out email received before the reservation end time, select **Check out** to check out the reservation.

**Note:** You must check out within an hour after the reservation end time. Otherwise, the reservation is automatically checked out.

### Approve employee workplace reservation requests

Review employee area and space reservation requests in Workplace Safety Management and approve or reject them.

**Before you begin**

To approve or reject a workplace request using your mobile device, you must have the **Now® Mobile** app.

⚠️ **Attention:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see [Configure a catalog in Service Portal](#).

**Role required:** approver_user

**Procedure**

1. Navigate to a reservation approval task.

<table>
<thead>
<tr>
<th>Application</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Now Mobile</strong></td>
<td>In the Now Mobile app, open a task from the My Tasks section.</td>
</tr>
<tr>
<td><strong>Workplace Service Portal</strong></td>
<td></td>
</tr>
<tr>
<td>a. From your ServiceNow instance, navigate to Service Portal &gt; Service Portal Home.</td>
<td></td>
</tr>
<tr>
<td>b. Click Approvals &gt; View all approvals.</td>
<td></td>
</tr>
<tr>
<td>c. Open the request that you want to review.</td>
<td></td>
</tr>
</tbody>
</table>

2. **Optional:** Review the details of the request.

3. Approve or reject the request by selecting **Approve** or **Reject**.
Managing workplace tasks
Using workplace tasks in Workplace Safety Management, workplace managers can monitor workplace activities that are created and scheduled in the workplace for each shift. They can also schedule planned or on-demand maintenance tasks and generate reports to track the progress of these activities.

Workplace task creation
You can create workplace tasks in the Workplace Safety Management application for various situations.

Automatically created pre-cleaning and post-cleaning tasks
Workplace managers can create shifts and associate employees and spaces to the shift. After workspaces are assigned to a shift and the shift's state is set to Ready, the system automatically creates pre-cleaning and post-cleaning tasks for that shift. These tasks are generated using the respective templates available with the application.

Note: If a shift doesn’t have a space associated to it, pre-cleaning and post-cleaning tasks are not auto-generated for it.

Planned tasks
Tasks for recurring planned activities that are independent of shifts.

Ad hoc tasks
Ad hoc tasks when on-demand cleaning is required.

Task assignment
Assignments for tasks depend on the task type:

- Pre-cleaning and post-cleaning tasks are automatically assigned based on their templates.
- Planned tasks are automatically assigned based on the planned task definition that is used to generate these tasks.
- Ad hoc tasks can be assigned manually by workplace managers when they create these tasks.

Signature of completion
For audit and compliance of workplace activities, workplace managers can electronically sign the completed workplace tasks. This action generates a PDF of the signed form and attaches it to the task.

Configure a workplace task template
Configure templates in Workplace Safety Management that can be used to create workplace tasks. You can either modify predefined workplace task templates or create your own templates and associate them with workplace tasks.

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task
Templates simplify the process of creating tasks in Workplace Safety Management by populating fields automatically. The following predefined templates are available with the application:

- Pre-cleaning
- Post-cleaning
Procedure

2. Create a new template or modify an existing template.
   • If you are creating a new template, click New.
   • If you are modifying an existing template, open the desired template.
   For information about the template form fields, see Create a template.
3. Select the Workplace Task [sn_wsd_core_workplace_task] table in the Table field.
4. Optional: Apply the template to the required workplace task type.
   a. In the Template section, select the Workplace task type field in the left column.
   b. Select the required task type in the right column.
5. Click Submit.
6. Add a checklist to the template.
   For steps on how to add a checklist, see Create a workplace task checklist.
7. Click Update.

Create a workplace task checklist

You can create a unique checklist for each workplace task template in Workplace Safety Management. You can also quickly create a checklist from an existing checklist template.

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task
You can also create checklists for individual workplace task records.

Procedure

1. Create a checklist to be included in all tasks using the same template or add a checklist to a specific task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checklist for workplace task template</td>
<td>a. Navigate to Workplace Safety Management &gt; Workplace Tasks &gt; Workplace Task Templates.</td>
</tr>
<tr>
<td>Checklist in a specific workplace task</td>
<td>a. Navigate to Workplace Safety Management &gt; Workplace Tasks.</td>
</tr>
</tbody>
</table>

2. In the Checklist section, click the down arrow (✔️) beside the Checklist formatter.
3. Add a checklist.
4. Add a checklist item.
   a. Click the Add item icon (+)
   b. Press the Enter key to add the checklist item.
   Add as many additional checklist items as desired.

5. Optional: Delete unwanted checklist items by clicking the delete item icon (-).

6. Optional: Change the order of checklist items by clicking the drag icon (↓) and dragging the item to a different position in the list.

7. Click Update.

Results
- If you created the checklist for a workplace task template, any task created using this workplace template will also contain this checklist.
- If you created the checklist in a workplace task form, the checklist will be part of only that task.

What to do next
You can save the checklist as a template for easy reuse, if required.

Save a workplace task checklist as a template
You can save a Workplace Safety Management workplace task checklist as a template for easy reuse. A template saves time by adding checklist items automatically in a record where you use it.

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task
When you add a template checklist to a record, you can add, edit, or remove checklist items in the record without affecting the template.

Procedure
1. Navigate to the record that contains a checklist you created.
   To find out how to access the record, see Create a workplace task checklist.

2. In the Checklist section, click the down arrow (▼) beside the Checklist formatter.

3. Click Save as Template.

4. Enter a name for the checklist template.

5. From the User Group list, select a group to limit who can use the checklist template.
   Only members of the selected group and the user who created the checklist can use the checklist as a template. Leaving this field blank prevents anyone but the template creator from using the checklist template.

6. Click Save.
Configure a workplace task signing template

Configure a signing template that you want to make available for signing the completed Workplace Safety Management workplace tasks. You can configure the default signing template available with the application or create a new template.

**Before you begin**
Role required: sn_wsd_core.admin

**About this task**
When a workplace manager signs a completed task, an e-signature PDF document is generated using a signing template and is attached to the task. For information about signing a workplace task, see Sign a completed workplace task.

**Procedure**
1. Navigate to Workplace Safety Management > Administration > HTML Signing Templates.
2. Click New or open an existing signing template to edit it.
   The application provides a default template called Task Signing Template.
3. On the form, fill in or modify the fields.

<table>
<thead>
<tr>
<th>Html Signing Template form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Acknowledgment text</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Domain</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>Body</td>
</tr>
<tr>
<td>Select variables</td>
</tr>
</tbody>
</table>

4. Customize the body of the signing template in the **Body** field.

   a. Enter and format the text to design the body of the template.

   Use the formatting tools to apply formatting options, such as bold, italic, underline, or font styling.
b. Insert variables by locating your cursor at the desired location and selecting the variable under **Fields**.
For example, to indicate which location to clean, you might insert the text Cleaning finished for the Workplace location: and, after a space, click **Workplace location** under **Select variables**. The variable in the **Body** field text would appear as follows:

```
Cleaning finished for the Workplace location: %{workplace_location}
```

The variable is replaced with the actual location when the PDF is generated.

5. At the desired location in the **Body** field, enter the following variables:
   - `{Checklist}`: Adds the checklist variable.
   - `{Signature}`: Adds the signature variable.

   ![In the signed PDF document, the signature and checklist are embedded at the same location where you entered these variables into the template body.](image)

6. Click **Submit**.

7. **Optional:** Review the look of the PDF document by impersonating a workplace manager and signing a closed task.

**Create planned task definitions**
Create planned task definitions in Workplace Safety Management to help workplace managers easily generate tasks that are often repeated and independent of shifts such as cleaning coffee vending machines or cleaning floors. You can quickly specify the task details and the frequency at which the task is to be performed.

**Before you begin**

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see **Configure a catalog in Service Portal**.

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager
About this task
You can also access the planned task definition form by navigating to Workplace Safety Management > Workplace Tasks > Planned Tasks Definitions and clicking New.

Procedure
1. Navigate to Workplace Services Portal > Workplace Services Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.

   **Note:** If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.

3. Click Add planned task definition.
4. On the form, fill in the fields.

   **Planned task definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the planned task definition. For example, “Clean conference rooms” for the activity of sanitizing conference rooms.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Work schedule to be used for planned tasks.</td>
</tr>
<tr>
<td>Workplace task template</td>
<td>Template used for the generated planned tasks. Selecting a template automatically populates certain fields such as Assigned to, Short description, and Workplace task type in the generated tasks. For information about workplace task templates, see Configure a workplace task template.</td>
</tr>
<tr>
<td>Processing Time (hours)</td>
<td>Amount of time it should take to complete a planned task.</td>
</tr>
<tr>
<td>Planned end time</td>
<td>Date and time by which the task should be finished.</td>
</tr>
<tr>
<td>Planned start time</td>
<td>Date and time when the task should start.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. If you accessed the form from Workplace Service Portal, on the verification page, you can create another planned task definition or generate planned tasks from this definition immediately.

   **Note:** You can also use this definition to generate planned tasks later. See the instructions in the Generate planned tasks topic.
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create another planned task definition</td>
<td>Click Add another task definition.</td>
</tr>
<tr>
<td>Generate planned tasks immediately</td>
<td>a. Click View all task definitions.</td>
</tr>
<tr>
<td></td>
<td>b. Open the planned task definition and</td>
</tr>
<tr>
<td></td>
<td>click Generate Task.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Workplace Tasks related list to</td>
</tr>
<tr>
<td></td>
<td>view the generated planned tasks.</td>
</tr>
</tbody>
</table>

Results

- The planned task definition is added to the list of all planned task definitions that you can view by navigating to Workplace Safety Management > Workplace Tasks > Planned Tasks Definitions.
- If you created planned tasks from this definition, they are added to the list of all planned tasks. You can view those tasks by navigating to Workplace Safety Management > Workplace Tasks > Planned Tasks.

Generate planned workplace tasks

Using planned task definitions in Workplace Safety Management to create planned tasks independent of shifts for recurring activities. For example, you can generate tasks for a selected number of days for cleaning all floors and buildings at midnight every day.

Before you begin

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task

You can also create an individual planned task using the Add a task option on the Workplace Service Portal. In this case, however, instead of multiple planned tasks for all dates between Planned start time and Planned end time in the selected planned task definition, only one planned task is created. For more information on creating a one-off planned task, see Create an ad hoc workplace task.

Procedure

2. In the list, open the planned task definition.
   - You can also generate planned tasks immediately when you create a new planned task definition. For more information, see Create planned task definitions.
3. Select Planned start time and Planned end time values based on the days and time when you need these tasks to be performed.
4. Click Generate now.

Results

- Based on the planned start time and planned end time, planned tasks are created for all occurrences of the schedule and appear in the Workplace Tasks related list.
- The Expected start time in each generated planned task is auto-calculated from the planned end time and processing time values in the respective tasks as follows:
  
  Planned start time = Planned end time – Processing Time
You can view all planned tasks by navigating to Workplace Safety Management > Workplace Tasks > Planned Tasks.

Create an ad hoc workplace task

Create an ad hoc task in Workplace Safety Management for unplanned activities. For example, if you notice that something isn’t clean in an area or want the area to be cleaned again, you can create an ad hoc workplace task to get the cleaning done immediately.

Before you begin

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task

You can also access the workplace task form by navigating to Workplace Safety Management > Workplace Tasks > Create New.

Procedure

1. Navigate to Workplace Services Portal > Workplace Services Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.

   **Note:** If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.

3. Click Add a task.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace task type</td>
<td>Type of the workplace task. Select Ad-hoc Task.</td>
</tr>
<tr>
<td>Workplace location</td>
<td>Workplace location where the task should be performed.</td>
</tr>
<tr>
<td>Signature template</td>
<td>Task signature template to use for signing off on this task when it is completed. For more information, see Sign a completed workplace task.</td>
</tr>
<tr>
<td>State</td>
<td>State of the task.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group assigned to the task.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>User assigned to the task.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor whose employees should perform the task.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the ad hoc task.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. If you accessed the form from Workplace Service Portal, on the verification page, you can create another task or view this task record in a list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create another task</td>
<td>Click <strong>Add another task</strong>.</td>
</tr>
<tr>
<td>View the task record in a list</td>
<td>Click <strong>View all tasks</strong>.</td>
</tr>
</tbody>
</table>

7. Add a checklist to the task to track the actions required to complete it.
   To add the checklist, open the task by navigating to Workplace Safety Management > Workplace Tasks > All. For more information, see Create a workplace task checklist.

### Results

The ad hoc task is added to the list of all tasks that you can view by navigating to Workplace Safety Management > Workplace Tasks > All.

#### Sign a completed workplace task

As the workplace manager for a space, sign the workplace tasks Workplace Safety Management for complete and closed activities. Signing a task generates a PDF document for the workplace activity, which is useful for compliance procedures.

### Before you begin

**Role required:** sn_wsd_core.workplace_manager

### Procedure

1. Navigate to Workplace Safety Management > Workplace Tasks > Closed.
2. In the list, click to open the workplace task that you want to sign.
3. In the **Sign template** field, review the signing template selected for the task.
   For more information, see Configure a workplace task signing template.
4. Click **Sign Task**.

   **Note:** The **Sign Task** button appears only once you have selected a template in the **Sign template** field.

5. In the **Sign Task** form, sign the form in one of the following ways:
   - In the **Type signature** tab, enter your name in the **Full name** field.
   - In the **Draw signature** tab, draw your signature using your mouse.
6. Click **Accept and complete**.

### Results

A PDF document of the signed form is generated based on the signing template associated with the task and is attached to the task.
Workplace knowledge management

As a workplace admin, you can create knowledge base articles for employees. In the articles, provide information to your employees about workplace services, such as workplace updates, self-help, troubleshooting, and others.

With the Workplace Service Delivery application, you can create knowledge base articles and display them as wiki pages or HTML pages. The Workplace Service Delivery Knowledge Management is the same as the Now Platform Knowledge Management, for more information, see Configure Knowledge Management.

You can add attachments and enable employees to view the attachments individually. If a knowledge base article is relevant only for a short duration, you can specify an end date for the knowledge base article.

You can view and update the knowledge base articles at any time. You can view published articles, unpublished articles and retired articles separately. You can also republish an article whenever needed.

The Workplace Service Delivery provides the following knowledge base articles in the Workplace Service Portal by default.

- Cafeteria services
- Parking policy for visitors

Create a workplace knowledge base article

Provide information to employees through knowledge base articles. Create knowledge base articles with information about workplace updates, self-help, troubleshoot steps, and others.

Before you begin

Role required: sn_wsd_core.admin or sn_wsd_core.kb_writer

Procedure

1. Navigate to Workplace Safety Management > Knowledge management > Create new article.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Knowledge form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge base</td>
<td>Name of the knowledge base. Select the Workplace services knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>Relevant category for the knowledge base article. Select an existing category, or click the add category icon (➕) to add a new category. You can also select or add a subcategory.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date until which the knowledge base article is valid. The date is automatically set to 2100-01-01.</td>
</tr>
<tr>
<td>Article type</td>
<td>Type of article which you want to create. Choices are as follows:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Wiki</strong> to create a wiki page.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>HTML</strong> to create an html web page.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to give an attachment for the knowledge base article.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display the attachments individually.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the knowledge base article. The short description is displayed as the title of the article.</td>
</tr>
<tr>
<td>Article body</td>
<td>Information that is displayed in the knowledge base article. Use the formatting options to change the style of the content. This field appears only if <strong>HTML</strong> is selected from the <strong>Article type</strong> field.</td>
</tr>
<tr>
<td>Wiki</td>
<td>Information that is displayed in the knowledge base article as a wiki. Select the <strong>Wikitext</strong> option to preview the text. This field appears if <strong>Wiki</strong> is selected from the <strong>Article type</strong> field.</td>
</tr>
</tbody>
</table>

4. **Optional:** To search existing articles for any duplicate content, click **Search for Duplicates.**

5. **Click** **Submit**.

**Results**
The knowledge base article is created.

**What to do next**
Publish the knowledge base article. For more information, see Publish a workplace knowledge base article.

For more information about the Now Platform Knowledge management, see Configure Knowledge Management.

**Publish a workplace knowledge base article**
After creating a knowledge base article, publish the article on the workplace services portal to make it available for employees.

**Before you begin**
Role required: sn_wsd_core.admin or sn_wsd_core.kb_writer

Before you publish, create a knowledge base article. For more information, see Create a workplace knowledge base article.

**Procedure**
1. Navigate to **Workplace Safety Management > Knowledge management > Unpublished articles.**
2. Select the knowledge base article that you want to publish.
3. On the knowledge form, click **Publish.**

**Results**
The knowledge base article is published for employees to view.
For more information on how to view the published knowledge base article, see View workplace knowledge base articles.
For more information on how to edit the publish knowledge base article, see Modify a workplace knowledge base article.

**View workplace knowledge base articles**

View workplace-related updates, processes, and other information in the knowledge base articles that your team created. Rate articles that you find useful.

**Before you begin**

Role required: sn_wsd_core.workplace_user

**Procedure**

1. Navigate to **Workplace Service Portal > Workplace Service Portal Home**.
2. Open the knowledge base page.
   - Click the **Knowledge** tab.
   - Click the **Knowledge Base** option.
3. In the KB categories list, select the category of the knowledge base article.
4. (Optional) If you are unsure about the category, search for the article.
5. From the list of published knowledge base articles, select the article that you want to view.
6. (Optional) Perform any of the following actions.
   - **Rate the article** out of 5.
   - If you found the article useful, Click **Yes**. If not, click **No**.
   - Leave a comment about the article and click **Submit**. You can also attach files.

**Modify a workplace knowledge base article**

Update a knowledge base article at any time. Retire a published article or republish a retired article.

**Before you begin**

Role required: sn_wsd_core.admin or sn_wsd_core.kb_writer

**Procedure**

1. Navigate to **Workplace Safety Management > Knowledge management**.
2. Select any of the following options to find your knowledge base article.
   - **All articles**
   - **Published articles**
   - **Unpublished articles**
   - **Retired articles**
3. Select the knowledge base article that you want to modify.
4. Select any of the following options to modify your knowledge base article.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Select this option to update any changes made to the knowledge base article.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Retire</td>
<td>Select this option to remove the knowledge base article from the portal.</td>
</tr>
<tr>
<td>Republish</td>
<td>Select this option to republish a retired article.</td>
</tr>
</tbody>
</table>

**Results**
The knowledge base article is modified with the changes.

**Workplace dashboards**
Use the Workplace dashboards in Workplace Safety Management to get a consolidated view of multiple workplace-related metrics so you can quickly check space utilization and monitor the progress of workplace tasks. Real-time information provides insights to enable making decisions such as how many people in the workforce can be allowed at a given time into the office space.

**Workplace manager dashboard**
Use the Workplace manager dashboard to monitor the space allocation and workplace maintenance activities at your office campus. For any given day, you can view the details for available spaces, space reservations, pending workplace requests, arrival times for different locations, employee arrivals, and maintenance tasks.
To access the Workplace Manager Dashboard, navigate to **Workplace Safety Management > Workplace dashboards > Safety management.**

Selecting a region, site, and a campus in the Workplace Report Filter at the top of the dashboard displays reports for that campus.
## End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace manager: Needs visibility into the real-time status of the workplace space availability, scheduled arrivals, and workplace maintenance.</td>
<td>sn_wsd_core.workplace_manager</td>
<td>• Review pending workplace requests</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor workplace reservation requests created by employees</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor arrival times</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Estimate employee gatherings at common workplace locations using scheduled arrivals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor the progress of workplace tasks</td>
</tr>
</tbody>
</table>

## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending workplace requests</td>
<td>Single score</td>
<td>Number of workplace requests that are pending.</td>
</tr>
<tr>
<td>Today’s available spaces</td>
<td>Single score</td>
<td>Number of active workspaces available for reservations today.</td>
</tr>
<tr>
<td>Today’s scheduled arrivals</td>
<td>Single score</td>
<td>Number of employee arrivals scheduled for today for different locations on the campus.</td>
</tr>
<tr>
<td>All unassigned cleaning tasks</td>
<td>Single score</td>
<td>Number of active workplace tasks that are not assigned to anyone and not in the Closed state.</td>
</tr>
<tr>
<td>Pending requests</td>
<td>List</td>
<td>List of pending workplace requests for this campus.</td>
</tr>
<tr>
<td>Today’s available spaces</td>
<td>List</td>
<td>List of active workspaces available for reservations today.</td>
</tr>
<tr>
<td>Today’s arrival times</td>
<td>List</td>
<td>List of arrival times scheduled for today for different locations on the campus.</td>
</tr>
<tr>
<td>Today’s scheduled arrivals</td>
<td>List</td>
<td>List of employee arrivals scheduled for today for different locations on the campus.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Today’s reservations by shift</td>
<td>Bar</td>
<td>Number of workplace reservations for today grouped by their shifts.</td>
</tr>
<tr>
<td>Today’s reservations</td>
<td>List</td>
<td>Number of workplace reservations for today.</td>
</tr>
<tr>
<td>Unassigned cleaning tasks by day</td>
<td>Trend</td>
<td>Trend of the number of active cleaning tasks per day that are not assigned to anyone and not in the Closed state. The cleaning tasks in this report have a due date between today and the next seven days and include all task types such as planned, unplanned, and ad hoc.</td>
</tr>
<tr>
<td>Unassigned cleaning tasks</td>
<td>List</td>
<td>List of active workplace tasks that are not assigned to anyone and not in the Closed state.</td>
</tr>
</tbody>
</table>

**Workplace dashboard in Workplace Service Portal**

Use the Workplace Dashboard from Workplace Service Portal to visually analyze the available workspace capacity, space request and reservation trends, and monitor the maintenance tasks of your workplace. You can also reserve a space for an employee or create a workplace maintenance task directly from this Workplace Service Portal page.

To open the Workplace dashboard on the Workplace Service Portal, navigate to **Workplace Safety Management > Dashboard**.

Selecting a region and site in the filter at the top displays reports for available campuses in separate tabs.

⚠️ **Attention:** For new customers, from Workplace Safety Management (sn_wsd_core) version 2.2, the **Dashboard** is removed from the Workplace Service Portal and Service Portal. Customers using Workplace Safety Management version 2.1 and below can still access the dashboard after an upgrade.
Workplace dashboard
Overview of California sites

California California Campus 1

Today's capacity: 60
Today's shifts: 3
Today's reservable spaces: 60
Today's reservations: 90

Reserved spaces per day

Reservable spaces per building

Cleaning tasks for this campus

Unassigned cleaning tasks: 10
Planned tasks: 95

Workplace requests for this campus

Pending workplace requests: 7
Workplace requests created today: 23
## End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace manager: Needs clear visibility into the real-time status of the</td>
<td>sn_wsd_core.workplace_manager</td>
<td>• Can plan for the phased return of employees to the workplace after an emergency situation</td>
</tr>
<tr>
<td>workplace space utilization and cleaning activities for shifts.</td>
<td></td>
<td>• Can monitor progress of workplace tasks for various office locations</td>
</tr>
</tbody>
</table>

## Reports

The data displayed in reports corresponds to the selected campus.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today’s capacity</td>
<td>Single score</td>
<td>Number of active workspaces available today.</td>
</tr>
<tr>
<td>Today’s shifts</td>
<td>Single score</td>
<td>Number of shifts used in today’s reservations.</td>
</tr>
<tr>
<td>Today’s reservable spaces</td>
<td>Single score</td>
<td>Number of active workspaces available to reserve.</td>
</tr>
<tr>
<td>Today’s reservations</td>
<td>Single score</td>
<td>Number of today’s active reservations.</td>
</tr>
<tr>
<td>Reservations per day</td>
<td>Trend</td>
<td>Trend of the number of active reservations per day in the last seven days for which the end date is today or later.</td>
</tr>
<tr>
<td>Reserved spaces per day</td>
<td>Spline</td>
<td>Trend of the number of reserved workspaces per day for all reservations made in the last seven days that are active starting today or later.</td>
</tr>
<tr>
<td>Reservable spaces per building</td>
<td>Bar</td>
<td>Breakdown of active workspaces that are available to reserve for each building on the campus.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unassigned cleaning tasks</td>
<td>Single score</td>
<td>Number of active workplace tasks that are not assigned to anyone and not in the Closed state.</td>
</tr>
<tr>
<td>Planned tasks</td>
<td>Single score</td>
<td>Number of active planned workplace tasks that are not yet closed.</td>
</tr>
<tr>
<td>Cleaning tasks by day</td>
<td>Trend</td>
<td>Trend of the number of active cleaning tasks per day for which the due date is between today and the next seven days, or for which no due date is defined. The tasks in this report are grouped by the workplace task type.</td>
</tr>
<tr>
<td>Workplace requests for this campus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pending workplace requests</td>
<td>Single score</td>
<td>Number of workplace requests that are pending.</td>
</tr>
<tr>
<td>Workplace requests created today</td>
<td>Single score</td>
<td>Total number of workplace reservation requests created by the employees today.</td>
</tr>
<tr>
<td>Workplace requests by day</td>
<td>Trend</td>
<td>Trend of the number of workplace reservation requests created per day.</td>
</tr>
</tbody>
</table>

**Related information**

- Create workplace reservations for an employee
- Create an ad hoc workplace task

**Workplace PPE Inventory Management**

Use the ServiceNow® Workplace Personal Protective Equipment Inventory Management application to manage PPE inventory to help safeguard the physical safety of your workforce. Monitor the availability of PPE at different locations, fulfill employee requests for PPE, and track PPE assigned to employees.
PPE supplies can easily be ordered from the self-service portal via mobile or desktop. A dashboard provides a comprehensive view of inventory by facility, an aggregate look at the entire workplace, and historical data on how equipment levels have changed over time. Inventory levels can be updated daily for accurate, real-time inventory management.

Use guided setup to implement Safe Workplace suite apps

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management.
applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

**Use with other Safe Workplace suite applications**

Workplace PPE Inventory Management is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- With the Employee Readiness Surveys application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.
- Before users re-enter workspaces, use the Employee Health Screening application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.
- With the Workplace Safety Management application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.

All Safe Workplace suite applications are available in the ServiceNow Store.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance
with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

**Notice regarding use by government agencies**

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

**Install Workplace PPE Inventory Management**

You can install Workplace PPE Inventory Management if you have the admin role.

**Before you begin**

Workplace PPE Inventory Management requires the Asset Management plugin (com.snc.asset_management). Asset Management is active by default.

Role required: admin

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the <a href="https://serviceurl.com/KB0030260">Federal downloads for the Emergency Response Management</a> and Safe Workplace suite apps article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the <a href="https://serviceurl.com/KB0030260">Commercial downloads for the Emergency Response Management</a> and Safe Workplace suite apps article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>
If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)

Procedure
1. Navigate to **System Applications > All Available Applications > All**.
2. Search for PPE Inventory Management.
3. Click **Install**.
   - The Application installation dialog box opens.
4. **Optional**: Load the demo data by selecting the **Load demo data** check box.
   (Optional) For information about how to install or reinstall demo data after the initial installation, see the **Work around to install demo data if application is already installed [KB0722909]** article in the Now Support Knowledge Base.
5. Click **Install**.
6. When the installation is complete, click **Close**.

**Components installed with Workplace PPE Inventory Management**
Several types of components are installed with Workplace PPE Inventory Management, including tables and user roles.

⚠️ **Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| PPE Inventory Management admin [sn_imt_ppe.ppe_admin] | Can create PPE models, manage PPE inventory, and assign PPE to employees. | • asset
|                                         |                                                                             | • inventory_admin |
Set up Workplace PPE Inventory Management

Complete setup tasks to start using Workplace PPE Inventory Management. Create models for PPE items, add PPE items to your service catalog, add PPE stock, and create stock rules.

Create models for PPE items

Create models to record the types of PPE in your inventory.

Before you begin

Ready-to-use models are installed with Workplace PPE Inventory Management. Create models for any of your PPE items that don’t have an existing model. View all models by navigating to PPE Inventory Management > Models > All.

Role required: sn_imt_ppe.ppe_admin

About this task

A model represents a specific type of PPE item. For example, use one model to track all of your N95 masks, and another model to track all of your nitrile gloves.

Procedure

1. Navigate to PPE Inventory Management > Models > Add Model.

   Note: To create a model in the Now Mobile app, navigate to Health > Manage PPE Inventory > Add Model.

2. On the form, fill in the fields.

Add PPE Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select <strong>Consumable</strong> for disposable PPE like masks or gloves. Select <strong>Hardware</strong> for PPE that is not disposable and could be reassigned, like a ventilator.</td>
</tr>
<tr>
<td>Name</td>
<td>Name for the model.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the model.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Manufacturer of the item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Add PPE models to Service Catalog**
Add PPE models through Service Catalog so employees can request the items they need.

**Before you begin**
Role required: catalog_admin

**Procedure**
1. Navigate to **Service Catalog > > Catalog Definitions > Record Producers**.
2. Filter the category to Personal Protective Equipment (PPE).
3. Click one of the record producers. Any record producer in the Personal Protective Equipment (PPE) category will work.
4. Click **Copy**.
5. Update the **Name**, **Model**, **Description**, and **Picture** fields for the item.
6. In the **Script** field, replace the sys_id value with the sys_id for the PPE model that you're adding to your service catalog.
   The sys_id is a unique alphanumeric code. To get the sys_id for a PPE model, navigate to the PPE model record, right-click the form header, and select **Copy sys_id**.
7. Click **Update**.

**What to do next**
Add the Personal Protective Equipment (PPE) category to your service catalog so employees can see the items. To add the category, navigate to **Self-Service > Service Catalog** and click the plus icon (➕) in the upper right.

**Add PPE stock**
Add stock for a PPE model to track the availability of the item at different locations.

**Before you begin**
Create stockrooms for your PPE. To create a stockroom, navigate to **PPE Inventory Management > Inventory > Stockrooms**. For more information, see Stockrooms.
Role required: sn_imt_ppe.ppe_admin

**Procedure**
1. Navigate to **PPE Inventory Management > Inventory** and select Add Consumable Stock or Add Hardware Stock.
   
   **Note:** To add PPE stock in the Now Mobile app, navigate to Health > Manage PPE Inventory and select Add Consumable Stock or Add Hardware Stock.

2. On the form, fill in the fields.
Add PPE Stock form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>The model to add stock for.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>The stockroom where the PPE is located.</td>
</tr>
<tr>
<td>Note:</td>
<td>Only the stockrooms that have the model appear.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The number of items in stock.</td>
</tr>
<tr>
<td>Note:</td>
<td>For hardware items, the quantity must be 1 so that each item is tracked with a unique asset tag and serial number.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>The asset tag for the item. This field is only visible for hardware models.</td>
</tr>
<tr>
<td>Serial number</td>
<td>The serial number for the item. This field is only available for hardware models.</td>
</tr>
</tbody>
</table>

3. Click Submit.
The stock log is updated with the PPE stock that you added. To view the stock log, navigate to PPE Inventory Management > Inventory > Stock Log.

What to do next
After adding PPE stock, you can view all of your available PPE by navigating to PPE Inventory Management > Inventory and selecting Consumables in Stock or Available Hardware.

| Note:          | The Consumables in Stock and Available Hardware pages have a New button. Do not add PPE stock using the New button. Using this button does not update the stock log. |

Reduce PPE stock
Reduce stock for a Personal Protective Equipment (PPE) model to reflect accurate inventory at different locations.

Before you begin
Role required: sn_lmt_ppe.ppe_admin

Procedure
1. Navigate to PPE Inventory Management > Inventory and select Reduce consumable stock or Reduce hardware stock.

| Note:          | To reduce PPE stock in the Now Mobile app, navigate to More > PPE Stock and select Reduce Consumable Stock or Reduce Hardware Stock. |

2. On the form, fill in the fields.
Reduce consumable stock form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>The model to remove stock for.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>The stockroom where the PPE is located.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The number of items to be reduced from stock.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is not available for hardware items.</td>
</tr>
<tr>
<td></td>
<td>The quantity must be 1 so that each item is</td>
</tr>
<tr>
<td></td>
<td>tracked with a unique asset tag and serial</td>
</tr>
<tr>
<td></td>
<td>number.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>The asset tag for the item. This field is only</td>
</tr>
<tr>
<td></td>
<td>visible for hardware models.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you enter an asset tag, only the stockrooms</td>
</tr>
<tr>
<td></td>
<td>that contain the asset appear.</td>
</tr>
<tr>
<td>Serial number</td>
<td>The serial number for the item. This field is</td>
</tr>
<tr>
<td></td>
<td>only available for hardware models.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you enter a serial number, only the stockrooms</td>
</tr>
<tr>
<td></td>
<td>that contain the serial number appear.</td>
</tr>
<tr>
<td>Comments</td>
<td>The reason that you're reducing stock.</td>
</tr>
</tbody>
</table>

Hardware stock

When reducing hardware models, if the asset tag and model number are not entered, the stock is removed from the stockroom listed first and the amount is set to zero (0).

When a model and asset tag are entered, or if the model and serial number are entered, hardware stock is matched and the amount is set to zero (0).

Consumable stock

If you try to enter a quantity larger than the quantity that is in stock, the system does not allow you to proceed.

3. Click Submit.

The stock log is updated with the PPE stock that you removed. To view the stock log, navigate to PPE Inventory Management > Inventory > Stock Log.

Create stock rules for PPE

Create a stock rule to automatically resupply a stockroom with an item.

Before you begin

Role required: sn_imt_ppe.ppe_admin

About this task

When an item drops below a specified quantity, the stock rule automatically creates a transfer order. The transfer order resupplies the stockroom by transferring the required items from another stockroom. For more information about transfer orders, see Transfer orders.
Procedure
1. Navigate to PPE Inventory Management > Inventory > Stock Rules.
2. Click New.
3. On the form, fill in the fields.

Stock Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>The product model for the rule.</td>
</tr>
<tr>
<td>Threshold</td>
<td>The item quantity that triggers a restock. For example, enter a threshold of 150 for masks that should be restocked when inventory drops below 150 in the specified stockroom.</td>
</tr>
<tr>
<td>Restocking option</td>
<td>Stockroom. This value is automatically populated.</td>
</tr>
<tr>
<td>Parent stockroom</td>
<td>The stockroom that the new items are transferred from.</td>
</tr>
<tr>
<td>Active</td>
<td>When selected, the rule is active and items are automatically restocked. When cleared, the rule is not active and items are not automatically restocked.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>The stockroom that you want to be automatically restocked by the rule.</td>
</tr>
<tr>
<td>Order size</td>
<td>The number of new items to order for the stockroom.</td>
</tr>
</tbody>
</table>

4. Click Submit.

PPE Inventory Overview dashboard
Use the PPE Inventory Overview dashboard to track PPE items that are in stock, on order, and assigned to employees.
To view the dashboard, navigate to PPE Inventory Management > Overview Dashboard.
## End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPE Inventory Management admin: Track PPE in stock and assigned over time. Plan</td>
<td><strong>sn_imt_ppe.ppe_admin</strong></td>
</tr>
<tr>
<td>ahead to anticipate PPE needs and ensure that all employees have access to the</td>
<td></td>
</tr>
<tr>
<td>appropriate PPE.</td>
<td></td>
</tr>
</tbody>
</table>

## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPE Items Consumed</td>
<td>Number of consumable PPE items assigned to employees.</td>
</tr>
<tr>
<td>PPE Items In Stock</td>
<td>Number of PPE items in stock.</td>
</tr>
<tr>
<td>PPE Items On Order</td>
<td>Number of PPE items on order.</td>
</tr>
<tr>
<td>PPE Items In Transit</td>
<td>Number of PPE items in transit.</td>
</tr>
<tr>
<td>PPE Items In Use</td>
<td>Number of hardware PPE items assigned to employees.</td>
</tr>
<tr>
<td>PPE Items Missing</td>
<td>Number of PPE items that are missing.</td>
</tr>
<tr>
<td>PPE Stockrooms By Type</td>
<td>Number of each type of stockroom that stores PPE.</td>
</tr>
<tr>
<td>Consumables Distributed By User</td>
<td>Number of consumable PPE items assigned to each employee.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Consumables In Stock By Location</td>
<td>Number of consumable PPE items in stock at each location.</td>
</tr>
<tr>
<td>Consumable Models</td>
<td>All models for consumable PPE.</td>
</tr>
<tr>
<td>Stock Rules</td>
<td>All stock rules for PPE.</td>
</tr>
</tbody>
</table>

**Request PPE**

Use Service Catalog to request personal protective equipment (PPE) for you to use at your workplace.

**Procedure**

1. Navigate to **Self-Service > Service Catalog** and click **Personal Protective Equipment (PPE)**.
   
   🔄 **Note:** To request PPE in the Now Mobile app, navigate to **Health > Follow These Safety Practices > Request PPE**.

2. Click the item that you want to order.

3. Select a quantity for the item.

4. Click **Submit**.

**What to do next**

View the status of your request by navigating to **PPE Inventory Management > My Requests**.

**Fulfill a request for PPE**

View employee requests for personal protective equipment (PPE). Fulfill the requests to make sure that employees get the PPE they need to stay safe at the workplace.

**Before you begin**

Role required: sn_imt_ppe.ppe_admin

**Procedure**

1. Navigate to **PPE Inventory Management > Requests**.

2. Click the request that you want to work on.

3. In the **State** field, select **Work in Progress**.

4. In the **Stockroom** field, select the stockroom that you want the items to come from.
   
   When you select a stockroom, the **Manager** field is automatically populated with the manager for that stockroom. When you update the request, the **Assigned to** field is also automatically populated with that manager unless you specify another user.

5. In the **Quantity** field, enter the number of items to assign to the employee.
   
   This number might be different from the requested quantity if the employee requested too many items, or if the stockroom doesn’t have enough inventory to fulfill the request. If the stockroom doesn’t have enough inventory, you’ll see an error message when you update the request so that you don’t assign more items than you have in stock.

6. Click **Update**.

**What to do next**

When the employee receives their PPE, update the request state to **Closed Complete**. A record is added to the assignment log and the consumable state changes to Consumed.

If the request won’t be fulfilled, update the state to **Closed Incomplete**.
Assign PPE to employees
You can assign PPE directly to an employee without them submitting a request.

Before you begin
Role required: sn_imt_ppe.ppe_admin

About this task
If an employee submits a request for PPE, follow the steps to fulfill a request for PPE instead.
When you assign hardware PPE to an employee, the state changes from In stock to In use. The state can be updated and the item can be reassigned to another employee.
When you assign consumable PPE to an employee, a consumable record is created with the quantity allocated to the employee. The state is set to Consumed and is read-only. Consumable PPE cannot be reassigned to another employee.

Note: Don't use the Consume button on consumable records to assign PPE. Instead, use the following steps.

Procedure
1. Navigate to PPE Inventory Management and select Assign Consumable or Assign Hardware.

   Note: To assign PPE in the Now Mobile app, navigate to Health > Manage PPE Inventory and select Assign Consumable or Assign Hardware.

2. On the form, fill in the fields.

   Assign PPE form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>The model to assign.</td>
</tr>
<tr>
<td>Issuing stockroom</td>
<td>The stockroom where the PPE is located.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The employee that you’re assigning PPE to.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The number of items to assign. This field is only available for consumable models.</td>
</tr>
<tr>
<td>Hardware</td>
<td>The specific item to assign, with a unique asset tag or serial number. This field is only available for hardware models.</td>
</tr>
</tbody>
</table>

3. Click Submit. The assignment log is updated with the PPE you assigned. To view the assignment log, navigate to PPE Inventory Management > Assignment Log.

What to do next
After assigning PPE to employees, you can view all assigned PPE by navigating to PPE Inventory Management > Inventory and selecting Assigned Hardware or Consumed.

Note: The Assigned Hardware and Consumed pages have a New button. Do not assign PPE using the New button. Using this button does not update the assignment log.
Safe Workplace Dashboard

The ServiceNow® Safe Workplace Dashboard provides leaders in HR, Workplace Services, and Health & Safety with a complete view of operations. Leaders have visual insight into the status of work sites and users to determine whether a site is ready to resume a safe operation.

The Safe Workplace Dashboard relies on ServiceNow® Performance Analytics Premium features to evaluate and display data that comes from other Safe Workplace suite applications and the COVID-19 Global Health Data Set.

Safe Workplace Dashboard and Safe Workplace suite applications

Install and configure the listed Safe Workplace suite and Emergency Response Management applications. Follow the configuration instructions to ensure that the data feeds to the dashboard successfully.

Note: Safe Workplace Dashboard does not support domain separation.

Use guided setup to implement Safe Workplace suite apps

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided
setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Safe Workplace suite for federal customers

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.
All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.

Install the Safe Workplace Dashboard
Install the Safe Workplace Dashboard application. You can install this application if you have
the admin role.

Before you begin
Ensure that the application and all of its associated ServiceNow® Store applications have
valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow
product or application.

The Map existing campus with locations fix script creates the initial mapping entries between
the Campus [sn_wsd_core_campus] table and the Location [cmn_location] table.

**Note:** Check that all existing campuses have sites and regions populated before
running this script.

Use the default setting `active=false` to avoid incorrect mappings in the Campus
[sn_wsd_core_campus] table.

Run this script after activating the Safe Workplace Dashboard (sn_imt_dashboard) plugin and
ensuring that your existing campuses have sites and regions populated.

After running the Map existing campus with locations fix script, validate that all campuses
and locations are accurate. For inaccurate data, remove entries and see Manually map a
location and campus for more information.

Role required: admin

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>
The Safe Workplace Dashboard application requires the ServiceNow® Performance Analytics - Premium application. If you're not already subscribed to Performance Analytics - Premium, you must install it before installing Safe Workplace Dashboard.

If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)

Procedure

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the application using the filter criteria and search field.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.
3. Click **Install**.
4. In the Application installation dialog box, review the application dependencies.
   If your application requires other applications, install them first if they're not already installed.
   Installing your application also automatically installs the dependent applications or plugins if they're not already installed.
5. **Optional:** If demo data is available and you want to install it, click **Load demo data**.
   Some applications include demo data, which are sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   ⚠️ **Note:** If you don’t load the demo data for a store application during installation, it’s not available to load later.
6. Click **Install**.
7. When the installation is complete, click **Close**.
Components installed with the Safe Workplace Dashboard

Components are installed with the Safe Workplace Dashboard, including user roles, scheduled jobs, and tables.

ℹ️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safe Workplace Dashboard user</td>
<td>View the dashboard information and drill into locations.</td>
<td>• pa_viewer</td>
</tr>
<tr>
<td>[sn_imt_dashboard.user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safe Workplace Dashboard administrator</td>
<td>Manage alert types and set system properties.</td>
<td>• sn_imt_dashboard.user</td>
</tr>
<tr>
<td>[sn_imt_dashboard.admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Scheduled Safe Workplace Dashboard data collector jobs installed

The data collector jobs installed with the Safe Workplace Dashboard are set to run daily and collect data for use in the dashboard and its widgets.

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[PA Workplace Service Delivery] Daily Data Collection</td>
<td>Collects metrics from Safe Workplace suite apps starting from the previous day to the current day. A user with the pa_data_collector role can change the parameters.</td>
</tr>
<tr>
<td>Aggregate campus status data</td>
<td>Collects data from check-ins and campus statuses to populate the Reopening Check-In Count [sn_imt_dashboard_reopening_checkin_count] table. Runs daily at 23:00 instance time.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alerts [sn_imt_dashboard_alerts]</td>
<td>Alerts by campus, generated from active alert types.</td>
</tr>
<tr>
<td>Alert Types [sn_imt_dashboard_alert_types]</td>
<td>Alert types are PA thresholds below which an alert is generated and displayed on the Safe Workplace Dashboard.</td>
</tr>
<tr>
<td>Breakdown All Time Values [sn_imt_dashboard_campus_all_time_values]</td>
<td>PA breakdown values, stored by campus.</td>
</tr>
<tr>
<td>Phase Definitions [sn_sw_planner_phase]</td>
<td>Definitions of phases and their assigned locations. Used to categorize what phase of reopening a location</td>
</tr>
</tbody>
</table>
### Table Description

is in. A location can be in only one phase at a time. A phase has a name, location, description, and allowed maximum occupancy percentage that is allowed during the phase. Phase definitions are required for information to populate widgets in the Safe Workplace Dashboard Reopening page.

<table>
<thead>
<tr>
<th>Campus Statuses</th>
<th>Primary table containing data that determines the current status of each location in the reopening page and widgets of the Safe Workplace Dashboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_sw_planner_campus_status]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reopening Check-In Audience</th>
<th>Table containing check-in audiences and their criteria based on the organization’s configurations. Administrators can create Check-In Audiences using the condition builder to create users. Users are uniquely counted across tables even if they have the same user ID. Check-In Audiences are required to provide information to populate widgets in the Safe Workplace Dashboard Reopening page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_imt_dashboard_reopening_checkin_audience]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reopening Check-In Count</th>
<th>The Aggregate campus status data scheduled job automatically populates the table with the dates and locations of all check-ins.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_imt_dashboard_reopening_checkin_count]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Campus Status Log</th>
<th>Tracks campus statuses and how a location’s status changes through each phase.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_imt_dashboard_reopening_campus_status_log]</td>
<td></td>
</tr>
</tbody>
</table>

### Safe Workplace Dashboard properties

Set up Safe Workplace Dashboard properties to add your Mapbox API token and configure how indicators are displayed across timezones.

You can obtain a token from Mapbox to add features to the Safe Workplace Dashboard map. The base system map is from OpenStreetMap, a collaborative, open source map application.

Mapbox requires a subscription, and their documentation site describes how to obtain an API token to add the extra features. For more information, open the Mapbox web site and select Documentation in the header.

To set properties, navigate to Safe Workplace Dashboard > Properties.

### Safe Workplace Dashboard properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter your Mapbox API Token to enable additional</td>
<td>Obtain a Mapbox token to add display features to the Safe Workplace Dashboard. This setting is optional.</td>
</tr>
</tbody>
</table>
Safe Workplace Dashboard properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
• Default value: none  
• Location: Safe Workplace Dashboard > Properties  
• Learn more: Read the documentation on the Mapbox website. |
| Use Indicator PA job timezone [sn_imt_dashboard.Use Indicator Job Timezone] | When enabled, the Performance Analytics (PA) indicators shown on the Safe Workplace Dashboard are displayed using the time zone of the indicator's data collection job. If the indicator job time zone is not set, the instance time zone is used instead. The indicators are displayed identically for all users viewing the dashboard, regardless of the user's time zone.  
When not enabled, the PA indicators are displayed based on the user's time zone. The indicators may show different daily data to users in different time zones. For example, an event occurs in the evening in Seattle, which is the next day's morning in Berlin. A user in Seattle sees the event in the data for October 5, while a user in Berlin sees the event in the data for October 6. |

Safe Workplace Dashboard widgets

The Safe Workplace Dashboard comprises ServiceNow® Service Portal widgets that are populated by Performance Analytics widgets.

Service Portal widgets in the Safe Workplace Dashboard

• Active Contact Tracing Cases  
• Safe Workplace Dashboard Announcement  
• Safe Workplace Dashboard Survey Sentiment  
• Safe Workplace Dashboard Favorite Location  
• Safe Workplace Dashboard Filter  
• Safe Workplace Dashboard Employee Health  
• Safe Workplace Dashboard Main Summary  
• Safe Workplace Dashboard Site Details  
• Safe Workplace Dashboard Main  
• Safe Workplace Dashboard Overview Maps  
• Safe Workplace Dashboard Site Details Ba  
• Safe Workplace Dashboard PA  
• Safe Workplace Dashboard Survey Donut  
• Safe Workplace Dashboard Alerts  
• Safe Workplace Dashboard Menu  
• Safe Workplace Dashboard Vaccination Widget
For information about customizing Service Portal widgets, see Service Portal widgets and the Widget developer guide.

**Performance Analytics widgets**

- Active Cases
- Number of Workplace Reservable Spaces
- Employees Rejected % Change from Prior Day
- Number of Employees Ready to Return
- Number of Employees Not Ready to Return
- Number of employees rejected
- % of Employees That Want To Return To Work
- Reserved Spaces
- Number of employees surveyed for readiness return
- PPE Inventory (time series)
- PPE Inventory (score)
- Number of Workplace Spaces
- Reservable vs Reserved Spaces
- Number of employees admitted Workplace Reservations
- Reservable Spaces
- Employees Admitted
- Employee Entry Health Monitoring
- Employees Rejected
- Number of Workplace Reserved Spaces
- PPE Inventory % Change from Prior Day

For information about using Performance Analytics, see Performance Analytics.

**Create a campus to appear on the Safe Workplace Dashboard**

You can create a campus from existing locations to appear on the Safe Workplace Dashboard.

Route the following information to the Safe Workplace Dashboard and display this information by campus:

- User health and willingness to return to work.
- Building readiness.
- Personal protective equipment inventory.
- Active contact tracing cases.
- Potentially exposed contacts under investigation.

Ensure that you install and use the following applications for the Safe Workplace Dashboard. Each application has a reference to a location.

- ServiceNow® Emergency Self Report references the location in the user’s profile.
- ServiceNow® Emergency Outreach with Employee Readiness Surveys installed. These applications reference the location in the user’s profile.
• ServiceNow® Workplace PPE Inventory Management has defined stockrooms, and the location is a required field for a stockroom.

• ServiceNow® Employee Health Screening has a form for selecting a location and a user to submit the compliance values.

• The Space Administration module of ServiceNow Workplace Safety Management is where organization facilities are defined. Within a building, floors, areas, and workspaces are defined. These definitions provide for proximity screening, cleaning assignments, and workspace reservations.

One or more buildings are assigned to a campus. The location icons displayed on the Safe Workplace Dashboard overview show the campus and any associated buildings when you point to an icon.

• ServiceNow Contact Tracing references the affected person’s campus from a case. If the campus information is not available, then Contact Tracing references the location in the affected person’s user profile.

Note: When selecting locations for users, stockrooms, and entry requests, select a company location that existed before you installed Workplace Safety Management. Don’t select a site, campus, or building created in the Workplace Safety Management application.

• For Workplace PPE Inventory Management, Employee Health Screening, and others, the location must be tied to a Workplace Safety Management campus or building for the location to appear on the Safe Workplace Dashboard.

Safe Workplace Dashboard map with location icons

The locations [cmn_location] defined for the organization are the reference that Performance Analytics uses to generate alerts. Configure the building definitions in Workplace Safety Management with a parent location and the corresponding latitude and longitude.

To associate locations with infectious diseases, such as COVID-19 data, from the COVID-19 Global Health Data Set, verify that all locations are associated with a state or country.
Create a campus to appear on the Safe Workplace Dashboard
There are multiple methods that you can use to create a campus that appears on the Safe Workplace Dashboard.

- Auto-map a location and create a campus.
- Manually associate a location and create a campus.
- Manually map a location to a campus (Workplace Safety Management).

Auto-map multiple locations and create campuses
You can create multiple campuses with corresponding latitude and longitude coordinates and a site automatically by selecting multiple locations.
The campuses appear on the Safe Workplace Dashboard.

Manually map a location to a campus
You can map an existing campus to an existing location manually and have it appear on the Safe Workplace Dashboard.

Manually map a location to a campus (Workplace Safety Management)
As an alternative, you can use Workplace Safety Management to manually create a campus and have it appear on the Safe Workplace Dashboard.

Auto-map a location and create a campus
Create multiple campuses automatically by mapping them from locations so that they appear on the Safe Workplace Dashboard.

Before you begin
Role required: sn_imt_dashboard.admin

Procedure
1. Navigate to Safe Workplace Dashboard > Campus Locations.
2. Click Generate Campuses.
The Add Locations pop-up appears.
3. Select all the locations that you want to be a campus.
The Populate OpenStreetMap data scheduled job runs every five (5) minutes and queries the Campus Locations [sn_imt_dashboard_locations] table. If the latitude and longitude are missing, an open street API is called to fetch the coordinates and update the Campus [sn_wsd_core_campus] table by passing the zip code and country name.
4. Click Add Locations to Dashboard.

Results
A site is created based on the parent name. The parent name is based on the location name. If a region does not exist, a region is created.

Manually map a location and campus
Manually map an existing location to an existing campus and site using Campus Locations.

Before you begin
Role required: sn_imt_dashboard.admin
**Procedure**

1. Navigate to Safe Workplace Dashboard > Campus Locations.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Campus Locations form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Click the Lookup using list icon (🔍) and select the location that you want to associate with a campus and site.</td>
</tr>
<tr>
<td>Campus</td>
<td>Click the Lookup using list icon (🔍) and select the campus that you want to associate with a location and site.</td>
</tr>
<tr>
<td>Site</td>
<td>Click the Lookup using list icon (🔍) and select the site that you want to associate with a location and campus.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Manually map a location to a campus (Workplace Safety Management)**

Use Workplace Safety Management as an alternative to the Safe Workplace Dashboard to manually map a location to a campus so that it appears on your Safe Workplace Dashboard.

**Before you begin**
Role required: sn_wsd_core.workplace_manager

**About this task**

**Procedure**

1. Navigate to Workplace Safety Management > Space Administration > Campuses, and click New.
2. Follow the steps in Configuring the form layout to add the Parent, Latitude, and Longitude fields to the Campus form.
3. In the list of campuses, open a record and complete the following steps.

   a. Select a parent location for the campus.
      Do not select a site, campus, or other building that you set up in Workplace Safety Management. Select a location from preexisting records.

   b. Click the preview icon (🔍) next to the parent location.

   c. Copy the latitude and longitude values from the preview window and paste them into the corresponding Campus form fields.
d. Click Update.

4. Continue updating campus records until they all have a parent location and the corresponding latitude and longitude values.

**Alert types used with the Safe Workplace Dashboard**

Alert types define the ServiceNow® Performance Analytics (PA) thresholds used to generate alerts on the Safe Workplace Dashboard. Alerts are generated from application data once per day.

**Alert types in the base system**

<table>
<thead>
<tr>
<th>Alert type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees Want to Return</td>
<td>Uses Employee Readiness Surveys responses to calculate the number of people who are ready or mostly ready, and the number of people who are not sure or not ready to return.</td>
</tr>
<tr>
<td>PPE is low</td>
<td>Uses the Workplace PPE Inventory Management count of PPE assets to identify when the available inventory falls below a threshold.</td>
</tr>
<tr>
<td>Screening Rejections Low</td>
<td>Uses Employee Health Screening entry requests to calculate the number of people denied entry.</td>
</tr>
<tr>
<td>Active Contact Tracing Cases</td>
<td>Uses Contact Tracing cases to determine when the number of active cases is greater than the threshold.</td>
</tr>
</tbody>
</table>

A user with the pa_admin role can define additional alert types. For information about using Performance Analytics, see Performance Analytics.

**Using the Safe Workplace Dashboard**

By using a map, you can review your organization's status regarding personnel and facility readiness to reopen. Focus on alert information regarding user readiness, personal protective equipment (PPE) inventory levels, health monitoring results, and active contact tracing cases...
created for affected users. View status data, by facility, to prepare the reopening of the facility and send invitations to users to return.

The Safe Workplace Dashboard presents data when the correlated Safe Workplace suite, ServiceNow® Contact Tracing, and ServiceNow® Emergency Response Management applications are installed. Verify that configuration is complete so that the application data is included when the ServiceNow® Performance Analytics data collection job runs.

**Note:** Assign Safe Workplace Dashboard users the pa_viewer role. This role is required to view the dashboard content.

**COVID-19 Global Health Data Set**

You can use the COVID-19 Global Health Data Set application at no extra charge. COVID-19 Global Health Data Set is installed with the Safe Workplace Dashboard. It appears as an application in the instance navigation menu, and displays global COVID-19 information on request in the Safe Workplace Dashboard.

<table>
<thead>
<tr>
<th>Safe Workplace Dashboard with COVID-19 data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview</strong></td>
</tr>
<tr>
<td><strong>Region</strong></td>
</tr>
<tr>
<td>All</td>
</tr>
</tbody>
</table>

**Welcome back, Beth**

NEW: CDC launches national viral genomics consortium to better map SARS-CoV-2 transmission

**Learn More >>**

Navigate to **COVID-19 Global Health Data Set** to view the collected data by date ranges, locations, state/provinces, and countries. Build reports or export the data to use for your own analysis.

**COVID-19 Global Health Data Set sources**

<table>
<thead>
<tr>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>European Centre for Disease Prevention and Control (ECDC)</td>
<td>COVID-19 metrics for the European Union and European Economic Area from the European Centre for Disease Prevention and Control. For more information on this data source, see the European Centre for Disease Prevention and Control website.</td>
</tr>
<tr>
<td>Government of Canada Public Health Infobase</td>
<td>COVID-19 metrics for Canada from the Canadian government. For more information</td>
</tr>
</tbody>
</table>
COVID-19 Global Health Data Set sources (continued)

<table>
<thead>
<tr>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>on this data source, see the Government of Canada Public Health Infobase website.</td>
</tr>
<tr>
<td>Our World in Data (OWID)</td>
<td>Worldwide COVID-19 metrics from Our World in Data. For more information on this data source, see the OWID GitHub repository.</td>
</tr>
<tr>
<td>USA Facts</td>
<td>COVID-19 metrics for the United States from USA Facts. For more information on this data source, see the USA Facts website.</td>
</tr>
</tbody>
</table>

Use the Safe Workplace Dashboard

Navigate to Safe Workplace Dashboard > Safe Workplace Dashboard to open the dashboard in a new browser window.

Locations with alerts are listed on the left. Click the arrow on the card or the location icon to zoom in to the location and its alerts. Use the Region and Site lists at the top left to select specific regions and sites to review.

To add a favorite location, click Manage Favorites and search for the location. After you select it, the location name appears in the header (R1 S1 in the example image). Click the location to open it directly. To remove a location from favorites, click Manage Favorites again and click the (x) on the location you want to remove.

Note: The Safe Workplace Dashboard shows only PPE inventory and health screening data associated with a Workplace Safety Management campus or building. PPE stockrooms and health screenings must have a Workplace Safety Management campus or building selected in the Location field to be displayed on the dashboard. For information about creating Workplace Safety Management campuses and buildings, see Providing your workplace data.

Safe Workplace Dashboard overview page

Continue drilling down to a facility to see its recent statuses. The New Confirmed COVID-19 Cases widget provides data from the COVID-19 Global Health Data Set. It shows the number...
of new cases and deaths for the location, and can also show the number of new cases and deaths per 100,000 people if population data for the location is available. For locations in the United States, you can filter the New Confirmed COVID-19 Cases widget to show data at the state or county level. The Populate OpenStreetMap data scheduled job retrieves county data for campuses.
Use the information to organize the reopening of the facility and reduce workplace transmission of infectious diseases, such as COVID-19.

- Order PPE inventory if levels are low.
- Send an outreach survey to reassess user readiness to return.
- Verify that the workplace cleaning schedule is on track to reopen safely.
- Encourage managers to have users make workspace reservations to return.
- Create cases for affected users and tasks for the follow-up interviews with potentially impacted users.

**Review the Safe Workplace Dashboard Reopening page**

View the Safe Workplace Dashboard Reopening page by clicking Reopening to see visualizations of reopening data across three widgets:

- The Location Reopened Status displays what regions are open and shows how many are open by region.
- Approved Worker Count vs. Avg Daily Check-Ins provides information to help determine whether too few or too many people are being checked in for the current week.
- The Campus Status widget is a filterable view with an overview of campus locations and metrics such as the current phase, maximum daily occupancy percent, and number of approved workers. You can manually add or edit locations by selecting the campus or clicking New.

⚠ Note: A location cannot have more than one campus status at a time.
To populate the Safe Workplace Dashboard page, create Phase Definitions to track locations through their various phases. Otherwise, no data will display. Updates are performed daily at 23:00 instance time regardless of the number of campuses in your organization and their geographic location.

For each phase, navigate to **Safe Workplace Dashboard > Phase Definitions** and click **New** to create customized phases for your organization. You can define their phases with the following information:

- Names for the phases such as Phases 1, 2, and 3 or red, yellow, and green (**Name**)
- The location the phase applies to (**Location**)
- The maximum daily occupancy percentage (**Max daily occupancy percent**)
- A description of the phase

You can determine your own criteria for what constitutes a check-in. Navigate to **Safe Workplace Dashboard > Reopening Check-In Audience** and click **New** to open a new record. Administrators can use the condition builder to define the tables and fields to add to a check-in and mark the Check-In Audience as active.

**Review COVID-19 vaccination metrics in the Safe Workplace Dashboard**

Organizations with the Vaccination Status application can use data from the application and public data from the COVID-19 Global Health Data Set to review COVID-19 vaccination metrics across the United States and worldwide. Organizations can then compare their
vaccination numbers to public numbers to gain a better understanding of their organization’s vaccination efforts.

This data is made available through the Safe Workplace Dashboard Vaccination Widget. The following metrics are available in the Safe Workplace Dashboard Vaccination Widget:

- The number of people fully vaccinated per 100
- The number of people vaccinated per 100
- The number of total vaccination doses per 100

Users with the admin role can add the Safe Workplace Dashboard Vaccination Widget to the Safe Workplace Dashboard Site View. For more information, see Add a vaccination widget to the Safe Workplace Dashboard.

**Important:** Users must have the sn_int_dashboard.user and sn_int_vaccine.vaccine_profile_reader roles to see any vaccination data in the dashboard.

Safe Workplace Dashboard Vaccination Widget

**COVID-19 Vaccinations**

<table>
<thead>
<tr>
<th>US/California</th>
<th>People fully vaccinated per 100</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>18.79</strong></td>
<td><strong>1.96</strong></td>
</tr>
<tr>
<td>Apr 07</td>
<td>Apr 08</td>
</tr>
<tr>
<td>Change: ~0.43</td>
<td>Change: ~1.96</td>
</tr>
</tbody>
</table>

Vaccination data is pulled from the last 30 days and includes campus data based on the vaccine responses per location from the Vaccination Status application. The widget is scheduled to update automatically once the COVID-19 Global Health Data Set and Vaccination Status are installed. Updates are performed daily at midnight (00:00) instance time, regardless of the number of campuses in your organization and their geographic location.

**Note:** If data is unavailable or missing, the widget will not display data for that day (even if available) until the next day the scheduled jobs run successfully.
Add a vaccination widget to the Safe Workplace Dashboard

As an admin, add the Safe Workplace Dashboard Vaccination widget to the Safe Workplace Dashboard Site View portal page.

Before you begin

To successfully add the Safe Workplace Dashboard Vaccination widget and populate it with data, note the following requirements:

- The Vaccination Status application must be installed and configured. For more information, see Vaccination Status.
- The Safe Workplace Dashboard application must be installed and configured. For more information, see Safe Workplace Dashboard.

Role required: admin

Procedure

1. Navigate to Safe Workplace Dashboard > Safe Workplace Dashboard.
2. Navigate to a campus and select View details.
3. Press Control-right-click on the widget instance and select Page in Designer.
4. Search for SWD Vaccination Graph.
5. Select SWD Vaccination Graph and drag it onto the page.
6. Change the chart type to Line.
   a. Click the edit icon.
   b. Change the Chart Type to Line.
   c. Click Save.

Results

The Safe Workplace Dashboard Vaccination widget appears in the Safe Workplace Dashboard.

Contact Tracing

The ServiceNow® Contact Tracing application helps organizations reduce workplace transmission of infectious diseases, such as COVID-19, by identifying any on-site users who might have been in contact with an affected user. The user receives updates about the number of reported cases or symptoms in the location. A list of potentially exposed users is created from various data inputs, such as badge scans, Wi-Fi access logs, and daily contact logs.

Features

- Identify on-site users who may have been in contact with a potentially infected user.
- Aggregate contact tracing information across workplace locations, work shifts and reservations, badge scans, Wi-Fi access logs, and self-reporting logs to enhance search criteria.
- Identify potential user interactions with a user using the Wi-Fi access data by correlating who connected to the same Wi-Fi network using laptops, mobile devices, or Bluetooth LE devices. You can get the Wi-Fi access data by manual import or through integration with Mist Systems or Cisco DNA Spaces.
- Get the contact tracing data of users who use handheld or wearable devices at the workplace. You can import the contact tracing report from Zebra MotionWorks Portal.
• Monitor risk scores of users who use wearable devices at the workplace. You can import risk score reports with Devvio integration.

• Create outreach cases and tasks for follow-up interviews with potentially impacted users.

• Assess the status of potentially exposed contacts and their next two levels of potential exposures from within a case using visualization.

• Maintain the data privacy of users, in the context of contact tracing by obtaining their consent.

• Use data retention settings to determine when the data collected for contact tracing is automatically deleted from the system.

---

### Contact Tracing

Minimize transmission of infectious disease at the workplace with rapid co-worker identification and outreach

- Identify on-site employees who may have been in contact with a potentially infected co-worker through enhanced search criteria.

- Create outreach cases with task assignments for follow-up interviews with potentially impacted employees.

---

**Use guided setup to implement Safe Workplace suite apps**

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to **Guided Setup > Safe Workplace Guided Setup**. For more information about using the guided setup interface, see **Using guided setup**.

**Use with other ServiceNow® Safe Workplace suite and Emergency Response Management applications**

The Contact Tracing application provides enhanced capabilities and additional features with other Emergency Response Management and Safe Workplace suite applications.

- **Emergency Outreach**: Configure and send email and mobile notifications to users requesting them to submit daily contact logs and to get responses for privacy consents.

- **Emergency Exposure Management**: Run a diagnostic report on affected users to identify potentially exposed users who might have interacted with the affected user. You can use multiple data sources to broaden the coverage of finding potential exposure. Review tracing systems for data sources provided by Contact Tracing to see whether these tracing systems meet your business needs. You can modify these tracing systems or set up a new tracing system for your data source. For more information, see **Set up a tracing system for an exposure data source**.

- **Safe Workplace Dashboard**: View the trend of active cases and potentially exposed contacts over a given time period for a campus or location. You can also get alerts to
determine when the number of active cases is higher than the threshold in a particular campus or location.

- Emergency Self Report: A case is created automatically for a user who is reported to be in quarantine if no active case exists for the user at the time of reporting.

- Employee Readiness Core:
  - Automatically adds or updates a user’s health and safety requirement status when a user is identified as a potentially exposed contact in a case. This up-to-date information helps you evaluate the readiness of your potentially exposed users to return to the workplace.
  - Automatically adds or updates a user's privacy consent requirement status when a user responds to the privacy consent request. This up-to-date information helps you ensure that your users acknowledge the privacy consent before entering the workplace to facilitate contact tracing as desired.

- Vaccination Status: Review a potentially exposed contact's vaccination status in the contact tracing visualization.

Domain separation for the Contact Tracing application

The Contact Tracing application supports domain separation at the Standard* level. For more information, see Domain separation and Contact Tracing. For a deeper understanding of the support levels, see Application support for domain separation.

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations' specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency's Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Contact Tracing

You can install Contact Tracing if you have the admin role.

Before you begin

The following applications are also installed when you install the Contact Tracing application:
- ServiceNow® Emergency Exposure Management
- ServiceNow® Employee Readiness Core

You can also install and activate the following applications to use all Contact Tracing features:
- ServiceNow® Emergency Outreach
- ServiceNow® Emergency Self Report
- ServiceNow® Safe Workplace Dashboard

Role required: admin

### Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>
| Federal on-premise   | If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team.  
                        | See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information. |
| On-premise            | See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information. |

The Contact Tracing application requires the ServiceNow® Performance Analytics - Premium application. If you're not already subscribed to Performance Analytics - Premium, you must install it before installing Contact Tracing.

If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
• Employee Travel Safety (sn_imt_travel)
• Health and Safety Testing (sn_imt_health_test)
• Vaccination Status (sn_imt_vaccine)

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Contact Tracing.
3. Click Install.
4. In the Application installation dialog box, click Install.
5. When the installation is complete, click Close.
6. Optional: Control access to the application by creating a group and assigning roles to the group or individual users.
   (Optional) For more information, see Roles.

Components installed with Contact Tracing
Several types of components are installed with Contact Tracing, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Contact Tracing admin [sn_imt_tracing.admin] | Application-specific admin for Contact Tracing and has administrative privileges. | sn_imt_tracing.case_manager
|                                           |                                                                             | sn_imt_tracing.badge_admin
|                                           |                                                                             | sn_imt_tracing.contact_tracing_user
| Contact tracing user [sn_imt_tracing.contact_tracing_user] | Can submit daily contacts log and privacy consent preference, and access contact tracing cases when added to the case watch list. | sn_imt_checkin.dailylog_user
<p>|                                           |                                                                             | sn_imt_tracing.privacy_consent_user |</p>
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge admin</td>
<td>Can create, update, delete, and import badge data.</td>
<td>• sn_imt_tracing.badge_manager</td>
</tr>
<tr>
<td>[sn_imt_tracing.badge_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Badge manager</td>
<td>Can create, update, and import badge data.</td>
<td>• sn_imt_tracing.badge_manager</td>
</tr>
<tr>
<td>[sn_imt_tracing.badge_manager]</td>
<td></td>
<td>• sn_imt_tracing.badge_reader</td>
</tr>
<tr>
<td>Badge reader</td>
<td>Can view badge access register data.</td>
<td>• None</td>
</tr>
<tr>
<td>[sn_imt_tracing.badge_reader]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case manager</td>
<td>Can create and manage outreach cases, run diagnostic requests to identify potentially exposed contacts. Can create, assign, and supervise tasks.</td>
<td>• sn_imt_diagnosis.diagnostics_admin</td>
</tr>
<tr>
<td>[sn_imt_tracing.case_manager]</td>
<td></td>
<td>• sn_imt_tracing.contact_tracer</td>
</tr>
<tr>
<td>Contact tracer</td>
<td>Can work on assigned case tasks to follow up on the health status of potentially exposed contacts, as per the predefined instructions.</td>
<td>• task_editor</td>
</tr>
<tr>
<td>[sn_imt_tracing.contact_tracer]</td>
<td></td>
<td>• survey_reader</td>
</tr>
<tr>
<td>Privacy consent user</td>
<td>Can submit and update the user policy consent for themselves.</td>
<td>• None</td>
</tr>
<tr>
<td>[sn_imt_tracing.privacy_consent_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tracing user</td>
<td>Can fill in the daily contacts log to submit a list of users that they</td>
<td>• None</td>
</tr>
<tr>
<td>[sn_imt_tracing.dailylog_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Wi-Fi admin [sn_imt_tracing.wifi_admin]</td>
<td>Can create, update, delete, and import Wi-Fi access logs.</td>
<td>• sn_imt_tracing.wifi_manager</td>
</tr>
<tr>
<td>Wi-Fi manager [sn_imt_tracing.wifi_manager]</td>
<td>Can create, update, and import Wi-Fi access Logs.</td>
<td>• import_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_imt_tracing.wifi_reader</td>
</tr>
<tr>
<td>Wi-Fi reader [sn_imt_tracing.wifi_reader]</td>
<td>Can view Wi-Fi access logs.</td>
<td>• None</td>
</tr>
<tr>
<td>Wearable admin [sn_imt_tracing.wearable_admin]</td>
<td>Can create, update, delete, and import handheld or wearable devices access logs.</td>
<td>• sn_imt_tracing.wearable_manager</td>
</tr>
<tr>
<td>Wearable manager [sn_imt_tracing.wearable_manager]</td>
<td>Can create, update, and import handheld or wearable devices access logs.</td>
<td>• sn_imt_tracing.wearable_reader</td>
</tr>
<tr>
<td>Wearable reader [sn_imt_tracing.wearable_reader]</td>
<td>Can view handheld or wearable device access logs.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Scheduled jobs installed**

<table>
<thead>
<tr>
<th>Scheduled Job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Retention Job For Contact Tracing</td>
<td>Deletes contact tracing data after the retention period is over from the last updated date for the records related to contact tracing. The data includes badge swipes, Wi-Fi access register data, employee daily contact logs, daily log notes, and daily log acknowledgements, cases and associated case tasks, exposed contacts, diagnostic requests, diagnostic jobs, and workplace reservations.</td>
</tr>
</tbody>
</table>
### Scheduled job

<table>
<thead>
<tr>
<th>Job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devvio Integration</td>
<td>Runs daily at 00:00:00 instance time and populates the Devvio Users Risk Report for organizations that use Devvio wearables and the DevvTrace platform.</td>
</tr>
<tr>
<td>Load Mist Systems</td>
<td>Runs daily at 00:00:00 and populates the sites for the organizations that use Wi-Fi logs from Mist Systems.</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge Access Register</td>
<td>Badge swipe records of all users.</td>
</tr>
<tr>
<td>[sn_imt_tracing_badge_access_register]</td>
<td></td>
</tr>
<tr>
<td>Badge Access Register Stage</td>
<td>The Import Set table for importing the badge access data from an Excel spreadsheet. When you load data from the Excel file into the application, the imported records are first saved in this import set table. After you run the transform, or execute the scheduled import script, the records are copied from this table to the Badge Access Register table.</td>
</tr>
<tr>
<td>[sn_imt_tracing_badge_access_register_stage]</td>
<td></td>
</tr>
<tr>
<td>Badge Reader</td>
<td>User ID badge reading devices installed in a location.</td>
</tr>
<tr>
<td>[sn_imt_tracing_badge_reader]</td>
<td></td>
</tr>
<tr>
<td>User Badge</td>
<td>Users and their ID badge information.</td>
</tr>
<tr>
<td>[sn_imt_tracing_user_badge]</td>
<td></td>
</tr>
<tr>
<td>Case</td>
<td>Outreach cases for affected users to help minimize potential exposure to others.</td>
</tr>
<tr>
<td>[sn_imt_tracing_case]</td>
<td></td>
</tr>
<tr>
<td>Case Task</td>
<td>Case tasks in outreach cases to follow up with the potentially exposed users to track health status.</td>
</tr>
<tr>
<td>[sn_imt_tracing_case_task]</td>
<td></td>
</tr>
<tr>
<td>Exposed Contacts</td>
<td>Potentially exposed users that might have interacted with a user who has been diagnosed with an infectious disease. The records in this table are stored when the case manager adds all impacted users to the case. Impacted users are identified through the diagnostic request using multiple data input.</td>
</tr>
<tr>
<td>Daily Contact Logs</td>
<td>The names of users submitted using daily contact logs by another user.</td>
</tr>
<tr>
<td>[sn_imt_tracing_daily_contact_log]</td>
<td></td>
</tr>
<tr>
<td>Daily Log Acknowledgements</td>
<td>Acknowledgement status to identify which users have responded to the notification to submit the daily contacts log.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Daily Log Notes</td>
<td>Names of users outside of the organization, such as visitors and contractors submitted using daily contact logs by another user.</td>
</tr>
<tr>
<td>Devvio Users Risk Report</td>
<td>Devvio users and their risk scores captured by Devvio wearables. The records in this table are imported from the DevvTrace platform and updated daily.</td>
</tr>
<tr>
<td>Location Privacy Configuration</td>
<td>Configuration for the location-based privacy policy, such as the privacy statement for a location and whether a particular location requires privacy consent.</td>
</tr>
<tr>
<td>Privacy Consent Template</td>
<td>Template to store the privacy statement for a location and is used in the location privacy configuration.</td>
</tr>
<tr>
<td>User Privacy Notice and Consents</td>
<td>Responses of users to the privacy consent.</td>
</tr>
<tr>
<td>Sites</td>
<td>Sites in the building of your organization. Each floor is considered as a site. Each site can be further divided into zones. Each zone can have multiple Wi-Fi routers installed, called as Wi-Fi access points.</td>
</tr>
<tr>
<td>Wi-Fi Diagnostic Preferences</td>
<td>Type of Wi-Fi data used for contact tracing. For example, you might have real-time data for a location collected through the integration with a network system, such as Mist Systems. For other locations, you might manually upload data from a spreadsheet.</td>
</tr>
<tr>
<td>Wi-Fi Access Register</td>
<td>Entry and exit time records of users who have connected to the office Wi-Fi access points or using the BLE enabled devices.</td>
</tr>
<tr>
<td>Wearable Access Register</td>
<td>User interaction records captured using the proximity sensing data via their handheld or wearable devices when they are in the close proximity for more than the permissible time.</td>
</tr>
</tbody>
</table>

### Setting up Contact Tracing

Configure system properties, scheduled jobs, script includes, Wi-Fi access log integration, and outreach notifications to aggregate contact tracing information for various data sources.

Get contact tracing information from various data sources such as workplace locations, work shifts and reservations, badge scans, Wi-Fi access logs, and self-reporting logs. Use these data sources to identify potentially exposed users by running the diagnostic request in the Emergency Exposure Management application.
Identifying potentially exposed users using tracing systems

A tracing system is configured for each contact tracing data source. Review the tracing systems for data sources to see whether these tracing systems meet your business needs. You can modify these tracing systems or set up a new tracing system for your data source.

For more information, see Set up a tracing system for an exposure data source.

Set up Contact Tracing properties

Configure system properties to adjust how contact tracing data is used.

Before you begin

Role required: admin

About this task

Employers remain solely responsible for complying with their legal obligations under applicable law, including data protection laws on collection, use, disclosure, and retention of personal data, and should enable, choose not to enable, or customize any functionality available within the application to meet the Employers’ specific requirements.

Note: For system properties associated with tracing systems, see System properties for tracing systems in Emergency Exposure Management.

Procedure

1. Navigate to Contact Tracing > Administration > Properties.

2. Set the following property values.

Properties for Contact Tracing

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.data_retention_period</td>
<td>Number of days after which the data collected for contact tracing is automatically deleted from the system. The retention period is calculated from the last updated date of the data. The retention policy applies to the following contact tracing data:</td>
</tr>
<tr>
<td></td>
<td>• Badge swipe data.</td>
</tr>
<tr>
<td></td>
<td>• User daily contact logs, daily log notes, and daily log acknowledgment data.</td>
</tr>
<tr>
<td></td>
<td>• All closed and canceled cases and associated potentially exposed contacts, case tasks, diagnostic requests and the underlying source data, and diagnostic events.</td>
</tr>
</tbody>
</table>

Note: A survey associated with cases eligible for deletion after the retention period is not deleted because surveys have their own retention period. For more information, see Clean up assessment data.

• Wi-Fi access register data

The default value is 90.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.auto_create_case_tasks</td>
<td>Enables or disables automatic creation of a case task when a case manager adds a potentially exposed contact to a contact tracing case.  If the property value is set to Yes, the base system workflow, <strong>Create case tasks for exposed contacts</strong>, triggers the creation of a case task when a potentially exposed contact is added to a case. The default value is Yes.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Domain separation and Contact Tracing**

Domain separation is supported for the ServiceNow® Contact Tracing application. The application helps organizations reduce workplace transmission of infectious diseases, such as COVID-19, by identifying anyone on site who might have been in contact with an affected person.

**Support level: Standard***

The support level is Standard but has some exceptions or special conditions.

- Includes **Basic** level
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must be able to configure minimum viable product (MVP) business logic and data parameters. This configuration is done per tenant, as expected for the specific application.

Use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

To learn more, see **Application support for domain separation**.

**Overview**

Service providers need to be able to manage multiple customers in a single instance to deliver their services via Contact Tracing in the **Safe Workplace** suite. Beginning with the Paris release, scheduled jobs introduced support for domain separation at the Standard level.

Admins must install the **Domain separation plugin** before working with the Contact Tracing tables.

See **Domain separation and Safe Workplace suite** to learn how to set up Contact Tracing with domain separation.

**Related information**

- **Domain separation for service providers**

**Modify the scheduled data import job**

As an administrator, review and modify the scheduled data import jobs used for importing badge access and Wi-Fi access data from an Excel file into the Contact Tracing application.

**Before you begin**

Role required: admin
About this task
The following scheduled jobs are installed with the Contact Tracing application:

- Badge Access Register Scheduled Import
- Wi-Fi Access Register Scheduled Import

These jobs are set for manual execution to import the badge access data or Wi-Fi access data from an Excel file. You can modify the settings based on when and how you want to import the data.

Procedure
1. Navigate to **Contact Tracing > Administration > Data Import Jobs**.
2. Open a Scheduled Import record.
3. Review and modify the settings as required.
   For more information on configuring a scheduled data import, see **Schedule a data import**.
4. Click **Update**.

Related information
Importing data using import sets

Configure the time zone setting for badge and daily log data
Add a script include in the Global scope to consider the affected user's time zone when you run a diagnostic request using the badge reader or user daily log data source.

Before you begin
Role required: admin

Procedure
1. Navigate to **System UI > Script Includes**.
2. Click **New**.
3. In the **Name** field, enter **TimeZoneUtils**.
4. From the Accessible from list, select **All application scopes**.
5. Copy the following script into the **Script** field.

```javascript
var TimeZoneUtils = Class.create();
TimeZoneUtils.prototype = {
  initialize: function() {
  },
  getTimeZone: function(timeZoneString) {
    return Packages.java.util.TimeZone.getTimeZone(timeZoneString);
  },
  getTimeZoneOffSet: function(timeZoneString, gdt) {
    var timeZoneObj = this.getTimeZone(timeZoneString);
    var dateTime = new GlideDateTime();
    if (gdt) {
      dateTime.setValue(gdt);
    }
    dateTime.setTZ(timeZoneObj);
    return dateTime.getTZOffset();
  },
  getBoundaryDates: function(timeZoneString, offset, dateTime) {
```
```javascript
var tz = this.getTimeZone(timeZoneString);
var gd = new GlideDateTime();
gd.setValue(dateTime);
gd.add(offset);
var startTime = '00:00:00';
var endTime = '23:59:59';
var actualDate = new GlideDate();
actualDate.setValue(gd.getValue());
var startDateTime = new GlideDateTime();
startDateTime.setTZ(tz);
startDateTime.setDisplayValueInternal(actualDate + ' ' + startTime);
var endDateTime = new GlideDateTime();
endDateTime.setTZ(tz);
endDateTime.setDisplayValueInternal(actualDate + ' ' + endTime);
return {
  startDateTime: startDateTime,
  endDateTime: endDateTime
},
type: 'TimeZoneUtils'
};
```

6. Click Submit.

**Results**
The script is used when you run the diagnostic request using the badge reader or user daily log data source. These data sources identify the potentially exposed users who might have come in contact with an affected user. The script considers the affected user's time zone while calculating the date and time from the badge swipe data or daily log data.

**Configure an email notification for the daily contact log**

Configure a custom email notification to use with Emergency Outreach notifications so you can request that users submit a list of other users they came in contact with throughout the workday.

**Before you begin**
Review the existing Employee Daily Log Alert and Daily Contact Log Notification email notifications to familiarize yourself with the base scripts and settings.

Role required: admin

**About this task**
When you configure an email notification for use as a daily contact log, you are creating a customized email notification for contact tracing purposes. The Employee Daily Log Alert and Daily Contact Log Notification are email notifications you can review for a better understanding on how notifications similar to the one you might create are configured.

**Procedure**
1. Navigate to System Notifications > Email > Notifications.
2. Click New.
3. Optional: In the Name field, enter a descriptive name for the notification.
4. In the Table field, select the Daily Log Acknowledgements [sn_imt_tracing_daily_log_acknowledgement] table.
5. On the When to send tab, set the conditions.
• Enter conditions in the condition builder to define when users are sent the email notification.

• Copy the following example script in the Advanced condition field and make these modifications.
  ◦ Give the variable a different name, for example, employeeCheckInAcmeSysId.
  ◦ Enter the new notification sys_id as the value.
  ◦ Enter the variable name that you declared at the end of the second line.

Example
Example Advanced condition script:

```javascript
var employeeCheckInAcmeSysId = '<replace with this notification sys_id';
answer = current.employee_check_in.notification == employeeCheckInAcmeSysId
```

6. On the Who will receive tab, select from Users and Groups to determine who will receive the notification.

7. Complete the remaining information on the What it will contain tab.

What it will contain tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email template</td>
<td>Select the email template used to determine any pre-configured content within the subject line and message body.</td>
</tr>
<tr>
<td>Subject</td>
<td>Create the subject line that users see when they receive the email.</td>
</tr>
<tr>
<td>Message HTML</td>
<td>In the Message HTML field, add and customize the text or source code of the message to meet your organization’s needs.</td>
</tr>
</tbody>
</table>

Note: While entering the email content in the Message HTML field, make sure that you include the link to the Daily Contact Log form.

8. Click Submit.

9. In the Notifications list, open the notification that you added and click Preview Notification.

10. Review the notification and make any changes required.

11. Click Update.

Results
You created a custom email notification for use as daily contact log with Emergency Outreach notifications. When you modify or create an Emergency Outreach notification, you can select this notification for the Daily Contact Log or custom outreaches.

What to do next
To use this email notification for as your daily contact log, see Configure an Emergency Outreach notification for the daily contact log.
Configure an Emergency Outreach notification for the daily contact log

As an administrator, create or configure the Emergency Outreach notification to send email and mobile push notifications to employees to ask them to submit a list of co-workers whom they have interacted with on a given day.

Before you begin

Ensure that you have the Emergency Outreach application installed. For details, see Install Emergency Outreach.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Role required: sn_imt_checkin.checkin_admin or admin

Procedure

1. Navigate to Contact Tracing > Administration > Daily Log Alerts.

2. Either edit the existing notification by opening the Daily Contact Log outreach record or click New to create one.

3. Enter the outreach notification name in the Event name field.

4. Select the Employee Daily Contact Log Alert check box.

   The Daily Contact Log option is selected in the Response mode field on the Content configuration tab. You cannot change this value if the Employee Daily Contact Log Alert check box is selected.

5. On the Select targeted audience tab, select the target audience for the notification, and click Save.
   - You can choose from user lists, groups, departments, locations, or other search filters such as building, cost center, or country code.
   - If you have the ServiceNow® Employee Health Screening application installed, the Use Employee Health Screen Data option is available. Select this check box to include all employees cleared in the health screening to enter the premises. For more information, see Employee Health Screening.
   - If you have the ServiceNow® Workplace Safety Management application installed, the User Workplace Reservation Data option is available. Select this check box to include all employees with confirmed or approved reservations for that day. For more information, see Workplace Safety Management.

6. On the Content configuration tab, select a notification in the Notification field, and choose how to send the notification.
   - To send the notification by email, select the Email notification check box and enter the email subject and body.
   - To send a mobile push notification, select the Now Mobile Push notification check box and enter or modify the push message and a detailed push message.

   This option is available only if the ServiceNow NowMobile App Screens and Applet Launcher (com.glide.mobile-employee) plugin is activated.

   Push notifications use the ServiceNow Request Application notification device.

   When users register their mobile application to an instance, this notification device is automatically created in their notification preferences. Ensure that this device is active for the users that you want to receive the push notification.
7. Click **Save**. The target audience and content configuration changes are saved.

8. Click **Schedule**.

9. In the Scheduled Script pop-up window, configure a scheduled job to the notification. For more information, see Configure a scheduled job.

10. Click **Submit**. A script is added to the scheduled job. The job is associated with the outreach notification.

**Results**
An outreach notification with a scheduled job is created. The job sends notifications to the target audience per the set schedule.

**What to do next**
A user with the sn_imt_checkin.checkin_admin role can send the Outreach notification on demand.

A user with the admin or sn_imt_checkin.checkin_admin role can stop the scheduled job to send the notifications automatically. To do so, click **Schedule** and in the dialog box, clear the **Active** check box, and then click **Update**.

**Configure Contact Tracing data retention settings**
Configure the data retention settings for the data collected for contact tracing such as badge swipe data, employee daily contact logs, and cases.

**Before you begin**
Role required: admin

**About this task**
Employers remain solely responsible for complying with their legal obligations under applicable law, including data protection laws on collection, use, disclosure, and retention of personal data, and should enable, choose not to enable, or customize any functionality available within the application to meet the Employers’ specific requirements.

A system property and scheduled jobs control the data retention policy for contact tracing data.

- The sn_imt_tracing.data_retention_period system property determines the number of days the contact tracing data will be available in the system before it is deleted automatically.
- The Data Retention Job For Contact Tracing scheduled job checks for records that have an updated date that is past the defined retention period, and deletes them. The data retention policy applies to the following contact tracing data:

  **Badge swipe data**
  Table impacted: Badge Access Register  
  [sn_imt_tracing_badge_access_register]

  **Closed and canceled cases and associated records**
  Tables impacted: Case [sn_imt_tracing_case], Case Task [sn_imt_tracing_case_task], Exposed Contacts [sn_imt_tracing_exposed_contact], Diagnostic Request [sn_imt_diagnosis_diagnostic_request], Diagnostics Events
The Diagnostic Request and Diagnostics Events tables are installed with the Emergency Exposure Management application.

Note: A survey associated with cases that are eligible for deletion after the retention period is not deleted because surveys have their own retention period. For more information, see Clean up assessment data.

Employee daily contact logs

Tables impacted: Daily Contact Logs [sn_imt_tracing_daily_contact_log], Daily Log Acknowledgements [sn_imt_tracing_daily_log_acknowledgement], and Daily Log Notes [sn_imt_tracing_daily_log_note]

Wi-Fi access data

Tables impacted: WiFi Access Register [sn_imt_tracing_wifi_access_register] and Wi-Fi Access Register Job [sn_imt_tracing_wifi_access_register_job]

• The Purge Contact Tracing Deleted Records (Data Retention) scheduled job purges all deleted records of contact tracing from the Audit Deleted Record [sys_audit_delete] table. All deleted records with an updated date past the defined retention period are purged.

Procedure

1. Set the period for which you want to keep the contact tracing data.
   a. Navigate to Contact Tracing > Administration > Properties.
   b. Enter a value in the Contact Tracing data retention period (in days) property.
      The default value is 90 days.
   c. Click Save.

2. Configure the scheduled job to determine when the job runs to check for and delete the contact tracing data.
   a. Navigate to System Definition > Scheduled Jobs.
   b. Open the Data Retention Job For Contact Tracing scheduled job.
   c. Configure the job settings and click Save.
      For more information, see Configure a scheduled job.

3. Download, import, and configure the Purge Contact Tracing Deleted Records (Data Retention) schedule job in the Global scope to purge deleted records.
   a. Download the Purge Contact Tracing Deleted Records (Data Retention) XML file from the Contact Tracing application page on the ServiceNow® Store.
   b. Navigate to System Definition > Scheduled Jobs.
   c. Import the downloaded XML file into the Scheduled Job [sysauto] table.
      For more information on importing, see Import a record from the template.
d. Search and open the Purge Contact Tracing Deleted Records (Data Retention) record.

e. Select Active to activate the job.

f. In the Run field, set the schedule for the job to run.

g. Click Update.

Create a requirement for potentially exposed contacts to return to work
Create a requirement for potentially exposed employees to meet to verify that they are eligible to return to work.

Before you begin

- Health and safety requirements are available in the ServiceNow® Employee Readiness Core application, which must be installed.
- Health and safety requirements are built with ServiceNow® Flow Designer, so make sure you’re familiar with the Flow Designer basics.

Role required: sn_imt_core.admin

About this task

Define health and safety requirements for employees to return to work. Employees should not be in any potentially exposed contacts investigation of a case. If they are part of an active case investigation, they should meet the requirement of a clear status to be eligible to return to workplace. For more information, see Follow up with potentially exposed contacts.

Note:

This procedure describes how to create a requirement using the base system Exposed Contacts Requirement as an example.

Procedure

1. In Flow Designer, create an action to add or update the requirement status for an employee added to the potentially exposed contacts list of a case.

a. Create an action and save it in the Employee Readiness Core application.

b. In the Inputs section of the Action Outline, create an input for the type of record to use to check whether the employee meets the requirement.

   For example, to meet the Exposed Contacts Requirement, employees must have a record in the Exposed Contacts table [sn_imt_tracing_exposed_contact].

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exposed Contact</td>
<td>exposed_contact</td>
<td>Reference.Exposed Contacts [sn_imt_tracing_exposed_contact]</td>
<td>Yes</td>
</tr>
</tbody>
</table>

c. Add a Script Step to the Action Outline.

d. In the Required Runtime field, select Instance.
e. Create an input variable using the input that you created for the action as the value. This variable enables you to use the input for the action in a script.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>exposed_contact</td>
<td>Exposed Contact input that you created in</td>
</tr>
<tr>
<td></td>
<td>the Inputs section.</td>
</tr>
</tbody>
</table>

f. In the Script field, add a script to define the conditions when an employee's requirement status is cleared or not_cleared.

For the Exposed Contacts Requirement, the requirement is not cleared for an employee if the health status in any exposed contact records for the employee is under_investigation or infected, and cleared for any other response.

```javascript
(function execute(inputs, outputs) {
  outputs.requirement_status = 'cleared';
  if (!inputs.exposed_contact.is_primary_exposed_contact) {
    var now_GR = new GlideRecord('sn_imt_tracing_exposed_contact');
    now_GR.addQuery('exposure_case.active',true);
    now_GR.addQuery('is_primary_exposed_contact',true);
    now_GR.addQuery('user',inputs.exposed_contact.user);
    now_GR.setLimit(1);
    now_GR.query();
    if (now_GR.next()) {
      if(now_GR.status == 'under_investigation' || now_GR.status == 'infected'){
        outputs.requirement_status = 'not_cleared';
      }else{
        outputs.requirement_status = 'cleared';
      }
    }else{
      var gr2 = new GlideRecord('sn_imt_tracing_exposed_contact');
      gr2.addQuery('exposure_case.active',true);
      gr2.addQuery('user',inputs.exposed_contact.user);
      gr2.query();
      while(gr2.next()){
        if(gr2.status == 'under_investigation' || gr2.status == 'infected'){
          outputs.requirement_status = 'not_cleared';
          break;
        }
      }
    }else{
      if(inputs.exposed_contact.status == 'under_investigation' ||
      inputs.exposed_contact.status == 'infected'){
        outputs.requirement_status = 'not_cleared';
      }else{
        outputs.requirement_status = 'cleared';
      }
    }
})(inputs, outputs);
```
g. Create an output variable for the requirement status.
This defines the `requirement_status` variable that you used in the script.

<table>
<thead>
<tr>
<th>Output Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>requirement_status</td>
</tr>
</tbody>
</table>

h. In the Outputs section of the Action Outline, create an output for the requirement status.
Creating this output enables you to use the `requirement_status` output variable from the script as an output returned by the action.

<table>
<thead>
<tr>
<th>Output Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Requirement status</td>
</tr>
</tbody>
</table>

i. Assign the `requirement_status` value to the output.

<table>
<thead>
<tr>
<th>Output Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Requirement Status</td>
</tr>
</tbody>
</table>

The action returns the value of the `requirement_status` for the employee (cleared or not_cleared) as an output.

j. Click Publish.

2. Create an exposed contacts requirement.

a. Navigate to Employee Health and Safety Status > Health and Safety Requirements.

b. Click New.

c. On the form, fill in the fields.
   The Include previous applicable records section defines a set of records that have already been created but should still trigger the requirement flow. Including previous records ensures that employees who complete the requirement before it is activated have their requirement status set to Not Cleared.
Health and Safety Requirement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the requirement. For example, Exposed Contacts Requirement.</td>
</tr>
<tr>
<td>Requirement flow</td>
<td>Flow to update the requirement status for a potentially exposed employee. Leave this field empty. You will return to the requirement record and fill in this field after you create the flow.</td>
</tr>
<tr>
<td>Active</td>
<td>This field is read-only. Once you update all fields for the requirement, you can use the <strong>Activate</strong> button to activate the requirement.</td>
</tr>
<tr>
<td>Default status</td>
<td>The default status assigned to employees who are not in the potentially exposed contacts list to meet the health and safety requirement. The options are Cleared and Not Cleared. For example, employees who don't have an exposed contact record are assigned a default status of Not Cleared for the Exposed Contacts Requirement.</td>
</tr>
<tr>
<td>Use duration</td>
<td>Option for setting a time limit for the validity of the requirement status. Do not select this field because the employee’s status is automatically updated when the status of the exposed contact task for the employee is updated.</td>
</tr>
<tr>
<td>Include previous applicable records</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Table to consult for previously created records that will trigger the requirement flow. For example, the Exposed Contacts Requirement uses the Exposed Contacts table [sn_imt_tracing_exposed_contact].</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to filter the records from the table that will trigger the flow.</td>
</tr>
</tbody>
</table>

d. Click **Submit**.

3. In Flow Designer, create a flow to update the requirement status for an employee.

   a. Create a flow and save it in the Employee Readiness Core application.

   b. Add a trigger so that the flow runs whenever the type of record that you’re using to check the requirement status is created or updated.

      For example, for the Exposed Contacts Requirement, the flow runs whenever an exposed contacts record in a case is created or updated.

      **Trigger**

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Table</th>
<th>Condition</th>
<th>Run Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created or Updated</td>
<td>Exposed Contacts</td>
<td>None.</td>
<td>Once</td>
</tr>
<tr>
<td></td>
<td>[sn_imt_tracing_exposed_contact]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
c. Add the action that you created to the flow, with the record from the trigger as the input. For example, for the Exposed Contacts input, add the Exposed Contacts record that was created or updated in the trigger event.

d. Add the Update User Requirement action provided in Employee Readiness Core to the flow.

**Update User Requirement inputs**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee or User</td>
<td>Health and safety requirement you created for the potentially exposed contacts.</td>
<td>requirement_status returned by the action you created.</td>
<td>Select Date/Time.</td>
</tr>
<tr>
<td>field from the trigger record. For example, the User field from the Exposed Contacts record.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

e. Click Activate.

4. Complete the health and safety requirement.
   a. Navigate to Employee Health and Safety Status > Health and Safety Requirements.
   b. Click the requirement.
   c. In the Requirement flow field, add the flow you created to update the requirement status for employees.
   d. Click Update.

**What to do next**
You must activate the requirement before you can track whether employees have fulfilled it. For instructions, see Activate a health and safety requirement.

Create a requirement for employees to acknowledge the privacy consent request
Create a requirement for your employees to respond to the privacy consent request before entering the workplace to facilitate the use of their data for contact tracing.

**Before you begin**
- Requirements are available in the ServiceNow® Employee Readiness Core application, which must be installed.
- Privacy Consent requirement is built with ServiceNow® Flow Designer, so make sure you're familiar with the Flow Designer basics.

Role required: sn_imt_core.admin

**About this task**
Define the privacy consent requirement for employees to return to work. Employees who agree to the use of their data for contact tracing fulfill the privacy consent requirement and are eligible to return to the workplace. Employees who disagree do not fulfill the privacy
consent requirement and are not eligible to return to the workplace. For more information, see Respond to a request for privacy consent in Contact Tracing.

Note: This procedure describes how to create a requirement using the base system Privacy Consent Requirement as an example.

Procedure
1. In Flow Designer, create an action to add or update the requirement status for an employee who responds to the privacy consent request.
   a. Create an action and save it in the Employee Readiness Core application.
   b. In the Inputs section of the Action Outline, create an input for the type of record to use to check whether the employee meets the requirement.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>preference</td>
<td>preference</td>
<td>String</td>
<td>Yes</td>
</tr>
</tbody>
</table>

c. Add a Script Step to the Action Outline.
d. In the Required Runtime field, select Instance.
e. Create an input variable using the input that you created for the action as the value. This variable enables you to use the input for the action in a script.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>preference</td>
<td>preference input that you created in the Inputs section.</td>
</tr>
</tbody>
</table>

f. In the Script field, add a script to define the conditions when an employee's requirement status is cleared or not_cleared.

For the Privacy Consent Requirement, the requirement is not_cleared for an employee if the employee disagrees to the privacy consent request, and cleared if the employee agrees.

```javascript
(function execute(inputs, outputs) {
  if (inputs.preferences == "agree") {
    outputs.requirement_status = "cleared";
  } else if (inputs.preferences == "withdraw_consent") {
    outputs.requirement_status = "not_cleared";
  }
})(inputs, outputs);
```
g. Create an output variable for the requirement status.
   This output variable defines the requirement_status variable that you used in the script.
h. In the Outputs section of the Action Outline, create an output for the requirement status. Creating this output enables you to use the `requirement_status` output variable from the script as an output returned by the action.

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
<th>Choice (Advanced options)</th>
</tr>
</thead>
<tbody>
<tr>
<td>requirement_status</td>
<td>requirement_status</td>
<td>Choice</td>
<td>Yes</td>
<td>Dropdown with --None--</td>
</tr>
</tbody>
</table>

i. Assign the `requirement_status` value to the output.

<table>
<thead>
<tr>
<th>Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement Status</td>
<td><code>requirement_status</code> output variable from the script step.</td>
</tr>
</tbody>
</table>

The action returns the value of the `requirement_status` for the employee (cleared or not_cleared) as an output.

j. Click **Publish**.

2. Create a privacy consent requirement.

a. Navigate to **Employee Health and Safety Status > Health and Safety Requirements**.

b. Click **New**.

c. On the form, fill in the fields.

The `Include previous applicable records` section defines a set of records that have already been created but should still trigger the requirement flow. Including previous records ensures that employees who complete the requirement before it is activated have their requirement status set to Cleared.

### Health and Safety Requirement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the requirement.</td>
</tr>
<tr>
<td>Requirement flow</td>
<td>Flow to update the requirement status for an employee.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| Leave this field empty. You will return to the requirement record and fill in this field after you create the flow. |  
| Active | This field is read-only. Once you update all fields for the requirement, you can use the **Activate** button to activate the requirement.  
| Default status | The default status assigned to employees who don’t have any activity towards completing the requirement. The options are Cleared and Not Cleared.  
For example, employees who don’t have a record in the User Privacy Notice and Consents [sn_imt_tracing_user_privacy_consent] table are assigned a default status of Not Cleared for the Privacy Consent Requirement.  
| Use duration | Option for setting a time limit for the validity of the requirement status.  
Do not select this field because the employee’s status is automatically updated when the employee responds to the privacy consent request.  
| Include previous applicable records |  
| Table | Table to consult for previously created records that will trigger the requirement flow.  
For example, the Privacy Consent Requirement uses the User Privacy Notice and Consents table.  
| Condition | Conditions to filter the records from the table that will trigger the flow.  

**d. Click Submit.**

**3. In Flow Designer, create a flow to update the requirement status for an employee.**

**a. Create a flow and save it in the Employee Readiness Core application.**

**b. Add a trigger so that the flow runs whenever the type of record that you’re using to check that the requirement status is created or updated.**

For example, for the Privacy Consent Requirement, the flow runs whenever a user privacy notice and consent record is created or updated.

**Trigger**

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Table</th>
<th>Condition</th>
<th>Run Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created or Updated</td>
<td>User Privacy Notice and Consents [sn_imt_tracing_user_privacy_consent]</td>
<td>[Preferences] [changes to] [I Agree] OR [Preferences] [changes to] [Withdraw Consent]</td>
<td>Only if not currently running</td>
</tr>
</tbody>
</table>
c. Add the action that you created to the flow, with the record from the trigger as the input.
   For example, for the preference input, add the User Privacy Notice and Consent record that was created or updated in the trigger event.

d. Add the Update User Requirement action provided in Employee Readiness Core to the flow.

<table>
<thead>
<tr>
<th>Update User Requirement inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User [User]</strong></td>
</tr>
<tr>
<td>User field from the trigger record. For example, the User field from the User Privacy Notice and Consent record.</td>
</tr>
</tbody>
</table>

e. Click Activate.

4. Complete the health and safety requirement.
   a. Navigate to Employee Health and Safety Status > Health and Safety Requirements.
   b. Open the Privacy Consent Requirement record.
   c. In the Requirement flow field, add the flow that you created to update the requirement status for employees.
   d. Click Update.

What to do next
You must activate the requirement before you can track whether employees have fulfilled it. For instructions, see Activate a health and safety requirement.

Configure an email notification for an exposure notice
Configure an email notification to use in the Emergency Outreach to send to potentially exposed contacts in an exposure case to notify them of potential exposure from an affected employee.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notifications > Email > Notifications.
2. Review the existing Notify Exposed Contact email notification to familiarize yourself with the script and other settings.
3. Click New.
4. In the Table field, select the Exposure Notice [sn_imt_tracing_exposure_notice] table.
5. On the When to send tab, complete the following settings.
a. In the **Send when** field, select **Record inserted or updated**.

b. Set the **Conditions** criteria to **[User.Active][is][true]** and **[Notification count][changes]**.

c. In the **Advanced condition** field, enter the following code:

```javascript
var exposedContactNotificationSysId = '<your-sys_id>';
answer = current.outreach.notification == exposedContactNotificationSysId;
```

Replace the `<your-sys_id>` variable with the sys_id notification that you're adding by right-clicking in the header, selecting the **Copy sys_id** option, and pasting the sys_id into the code line.

6. On the **Who will receive** tab, open **Users/Groups in fields** and select **Assigned to**.

7. Complete the remaining information on the **What it will contain** tab.

8. Click **Submit**.

9. In the Notifications list, open the notification that you added and click **Preview Notification**.

10. Review the notification and make any changes required.

11. Click **Update**.

**What to do next**
**Configure an Emergency Outreach notification for the exposure notice.**

Configure an Emergency Outreach notification to send email and mobile push notifications to potentially exposed employees in an exposure case to notify them of a potential exposure from an affected employee.

**Before you begin**
Ensure that you have the Emergency Outreach application installed. For details, see **Install Emergency Outreach**.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see **Now Mobile app**.

**Role required:** sn_imt_checkin.checkin_admin or admin

**About this task**
Review the existing **Notify Exposed Contact** outreach notification to familiarize yourself with the configuration.

**Procedure**
1. Navigate to **Emergency Outreach > View Outreaches**.

2. Click **New**.

3. Enter the outreach notification name in the **Event name** field.

4. On the **Content configuration** tab, select **Exposure Notice** in the **Response mode** field.

5. **Optional:** Review and edit the introductory message by modifying the subject and body in the **Email subject** and **Email body** fields respectively.

6. Specify how to send the outreach notification.
<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send an email notification</td>
<td>Select the <strong>Email</strong> check box.</td>
</tr>
<tr>
<td>Select a different notification</td>
<td>Click the lookup icon (🔍) and select an email notification configured for the exposure notice outreach.</td>
</tr>
</tbody>
</table>
| Send a mobile push notification | a. Select the **Now Mobile Push notification** check box. The check box is active if you have the ServiceNow Now-Mobile App Screens and Applet Launcher [com.glide-.mobile-employee] activated. The push notification content appears when the check box is active.  
   b. Modify the text in the **Push message** and **Detailed Push Message** fields. Push notifications use the ServiceNow Request Application notification device. When you register the mobile application to an instance, this notification device is automatically created in the user's notification preferences. Make sure that this device is active for the users that you want to receive the push notification. |
| Use a custom notification channel | a. Click the Additional Channels related list, click **Edit**, and move the channel to the Additional Channels List.  
   b. Click **Save**. If the **Email notification** and **Now Mobile Push notification** check boxes are selected, all three notifications are sent. To use only the custom notification channel, clear these two check boxes. |

7. Click **Submit**. The content configuration settings are saved.

**Results**
An exposure notice outreach notification is created. These exposure notice outreach notifications are available for selection when a case manager wants to send notifications to the potentially exposed contacts in a case.

**What to do next**
A case manager can send the outreach notification to the potentially exposed contacts in a case.

**Configure contact tracing visualization to show vaccination status**
Configure Contact Tracing so case managers can view the vaccination status of potentially exposed contacts in the contact tracing visualization.

**Before you begin**
The Vaccination Status application must be installed and configured. For more information, see Vaccination Status.
Role required: admin
Procedure

1. Navigate to **Contact Tracing > Properties**.

2. Set the `sn_imt_tracing.show_contact_vaccination_status` property to **Yes**.
   This step enables vaccination statuses to display on the contact tracing visualization.

3. Click **Save**.

4. Assign the Vaccination Status application `sn_imt_vaccine.vaccine_profile_reader` role to each case manager.
   The vaccination status and the **Vaccinated** column in **Exposed Contacts** are hidden until you have this role.

   **Note**: If the `sn_imt_tracing.show_contact_vaccination_status` property is set to **No**, case managers with the `sn_imt_vaccine.vaccine_profile_reader` role can see the **Vaccinated** column, but the column is empty.

Results

Case managers can see the vaccination status of users on the case form in both the contact tracing visualization and the **Exposed Contacts** list. For more information, see *Working on a case through contact tracing visualization*.

Trouble?

If a case manager can’t see vaccination statuses even though the `sn_imt_tracing.show_contact_vaccination_status` property is set to **Yes**, confirm that the case manager has the `sn_imt_vaccine.vaccine_profile_reader` role.

Setting up data privacy consent settings for Contact Tracing

As an admin, you can configure privacy consent templates, location-based privacy configurations, email notifications, and outreach notifications for sending privacy consent alerts in Contact Tracing.

In Contact Tracing, you can configure and send privacy consent notifications that request employees to consent to having their data used for contact tracing purposes.

User privacy regulations vary from country to country. For some countries, consent by employees to use their data is not required but for others it is a must. You can set different privacy policies for different locations and organization setups. Some organizations maintain a separate privacy policy for each location while others maintain a single privacy policy for all locations.

Modify or add a privacy consent template for Contact Tracing

Modify or add a privacy consent template to be used in the location privacy configuration.

**Before you begin**

Role required: `sn_imt_tracing.admin`

Procedure

1. **Contact Tracing > Privacy > Privacy Consent Templates**.

2. Open a **Default Template** record to modify it or click **New** to create one.

3. Enter a unique name of the template in the **Name** field.

4. Enter the privacy policy statement in the **Privacy statement** field.
   If the privacy policy is different for different locations, create one template for each location and specify the policy statement.
If your organization has a single policy for all locations across the globe, update the default template.

5. Click **Submit**.

**What to do next**
Use the privacy consent template to update the privacy statement in the applicable location’s privacy configurations. For more information, see Generate location-based privacy configurations for Contact Tracing.

**Generate location-based privacy configurations for Contact Tracing**
As an administrator, generate the privacy configuration for locations set up in your instance.

**Before you begin**
The privacy statement in the default template is copied in each location’s privacy configuration. Ensure that you have reviewed the privacy statement in the default consent template and modified it if necessary.
Role required: sn_imt_tracing.admin

**About this task**
You can generate a location-based, default privacy configuration for each country available in the Locations [cmn_location] table. For each location, you can specify whether the privacy consent is required and update the privacy policy statement.

**Procedure**
1. Navigate to **Contact Tracing > Privacy > Location Privacy Configuration**.
2. Click **Generate Location Configurations**.
   The default configuration is created for each country and appears in the Location Privacy Configurations list.
3. Open a location to review its configuration and modify it if necessary.
4. Configure the privacy consent text if necessary.

<table>
<thead>
<tr>
<th>Privacy consent status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consent is not required for the location</td>
<td>Clear the <strong>Needs privacy consent</strong> check box.</td>
</tr>
<tr>
<td>Consent is required for the location</td>
<td>Determine the privacy consent text.</td>
</tr>
<tr>
<td></td>
<td>• If you have defined a specific privacy consent template to assign to this location, select it from the <strong>Privacy consent template</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Retain the default privacy statement text and make any modifications.</td>
</tr>
</tbody>
</table>

5. Click **Update**.

**Results**
The location-based privacy configuration is set.
What to do next
Configure an email notification for a privacy consent request.

Create a custom Emergency Outreach notification channel
Create a custom Emergency Outreach notification channel to send privacy consent requests using your company's preferred communication method, such as the Slack or Microsoft Teams collaboration platforms. Create the notification channel using a script or a subflow.

Before you begin
Role required: sn_imt_checkin.checkin_admin or admin

About this task
After you create a notification channel, you can select it when sending a notification. The channel uses the specified subject and body, and sends notifications to the users that you select when you send the privacy consent request.
For example, if your company's IT network group has a Slack channel that they monitor more closely than email, you could create a Slack notification channel. To communicate with IT network group members, you would select the group as the target audience and select the Slack notification channel.

Procedure
1. Navigate to Emergency Outreach > Channels.
2. Click New.

3. Enter the name of your notification channel.
   Use a short name to indicate the communication method so requesters can easily pick the correct channel.
4. In the Subject field, enter the subject of your notification channel message.
5. In the Body field, enter the body of the message.
6. Create a script for the notification channel.

function notify(responses, channelGr) {
    var totalCount = responses.privacyGr.getTotalCount();
    var numSent = 0;
    if (responses.mode === 'privacy_consent') {
        while (responses.privacyGr.next()) {
            try {
                // sendNotification(record.user.email, channelGr.subject, channelGr.body, numSent ++ 1);
                catch (err) {
                    ga.error('Error occurred: ' + err.message);
                }
            }
        }
    }
    return {
        total_count: total_count,
        sent_count: numSent
    }
}(responses, channelGr);
a. In the **Notification type** field, leave the default notification type of **Script**.

b. In the **Script** field, replace the code in the comment with the script to connect to your channel.

**Example**

```
{
    // sendNotification(responses.privacyGr.user.email,
    channelGr.subject, channelGr.body);
}
```

For information about JavaScript APIs for GlideRecord, see [GlideRecord - Scoped](#).

c. Click **Submit**.

**Example**

The following example includes code to count the number of privacy consent requests generated when the notification is sent. It displays the number of privacy consent requests that were delivered successfully. Use this information to review and handle errors that appear in the Delivery Log related list in the Outreach record.

```
(function notify(responses, channelGr) {
    var totalcount = responses.privacyGr.getRowCount();
    var numSent = 0;
    if (responses.mode === 'privacy_consent') {
        while (responses.privacyGr.next()) {
            try {
                // sendNotification(record.user.email, channelGr.subject,
                channelGr.body)
                numSent += 1;
            } catch (err) {
                gs.error('Error occurred: ' + err.message);
            }
        }
    }
    return {
        total_count: totalcount,
        sent_count: numSent
    };
})(responses, channelGr);
```

7. Create a subflow notification channel.

a. Create a subflow to use in the notification.

For information about creating, publishing, and testing subflows, see [Subflows](#).

Use the following inputs in the subflow that you create:

- **mode** (string)
- **Privacy Consent** (Records of sn_int_tracing_user_privacy_consent)
  - If the mode is **Privacy Consent**, then acknowledgements are set to a valid GlideRecord and `survey_instances` is null.
- **channel** (Reference of sn_int_checkin_channels)

The following outputs are optional:
• total_count (integer)
• sent_count (integer)

To review these outputs, include the number of total privacy consent requests versus the successful privacy consent requests.

b. Select the Subflow notification type.
The Script section changes to Flow, and the Subflow reference field appears.

c. Select the subflow that you created.

8. Click Submit.

Trouble?
When a notification is sent using a custom notification channel, a Delivery Logs related list appears in the Outreach message.

1. Test the notification channel for an outreach message.
2. Open any failed channel record to review the error messages and fix errors that caused the notification to fail.
3. Continue testing the notification channel until the channel no longer fails.

Configure an email notification for a privacy consent request
Configure an email notification to use in the Emergency Outreach app to request that employees review the organization's privacy policy and provide their consent to use their data for contact tracing.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notifications > Email > Notifications.
2. Review the existing User Privacy Consent email notification to familiarize yourself with the script and other settings.
3. Click **New**.

4. In the **Table** field, select the User Privacy Notice and Consents [sn_int_tracing_user_privacy_consent] table.

5. On the **When to send** tab, set the conditions.

   a. In the **Conditions** field, set the criteria as shown in the image of the base system notification.

   b. Copy the following example script in the **Advanced condition** field.

   ```javascript
   var employeeCheckInAcmeSysId = '<replace with this notification sys_id';
   answer = current.employee_check_in.notification == employeeCheckInAcmeSysId
   ```

   c. Make the following modifications to the example script:

   - Give the variable a different name, for example, `employeeCheckInAcmeSysId`.
   - Enter the new notification sys_id as the value.
   - Enter the variable name that you declared at the end of the second line.

6. On the **Who will receive** tab, open **Users/Groups in fields** and select **Assigned to**.

7. Complete the remaining information on the **What it will contain** tab.
   While entering the email content in the **Message HTML** field, make sure that you include the link to the Privacy Consent form.

8. Click **Submit**.

9. In the Notifications list, open the notification that you added and click **Preview Notification**.
10. Review the notification and make any changes required.

11. Click Update.

**Configure an Emergency Outreach notification for Contact Tracing privacy consents**

As an administrator, create or configure an Emergency Outreach notification to send email and mobile push notifications to employees requesting them to view the privacy policy and seeking their consent to use their data for contact tracing.

**Before you begin**

Ensure that you have the Emergency Outreach application installed. For details, see Install Emergency Outreach.

You must have generated the location-based privacy configurations.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Role required: sn_imt_checkin.checkin_admin or admin

**Procedure**

1. Navigate to Emergency Outreach > View Outreaches.

2. Review and edit the existing outreach record User Privacy Consent record or click New to create one.

3. Enter the outreach notification name in the Event name field.

4. On the Select targeted audience tab, select the target audience for the notification, and click Save.
   
   You can choose from user lists, groups, departments, locations, or other search filters such as building, cost center, or country code.

5. On the Content configuration tab, select Privacy Consent in the Response mode field.

6. Optional: Enable the outreach to provide location-specific privacy consents by selecting the Use Country check box on the Content configuration tab.

   (Optional) When enabled, the privacy statement text in Location Privacy Configuration takes precedence over text in the privacy consent templates. This text is used for the outreach, system notification email, and push notification. If you need to update the text users receive, you must change the location’s privacy statement.

   For more information on updating a location’s privacy statement, see Generate location-based privacy configurations.

7. Select User Privacy Consent notification in the Notification field, and choose how to send the notification.

   - To send the notification by email, select the Email notification check box and enter the email subject and body.

   - To send a mobile push notification, select the Now Mobile Push notification check box and enter the push message and a detailed push message.

   This option is available only if the ServiceNow NowMobile App Screens and Applet Launcher (com.glide.mobile-employee) plugin is activated.

   - To use a custom notification channel, click the Additional Channels related list, click Edit, and move the channel to the Additional Channels List. Click Save.

     Make sure that the Email notification and Now Mobile Push notification check boxes are not selected or notifications will also be sent through those channels.
Push notifications use the ServiceNow Request Application notification device. When users register their mobile application to an instance, this notification device is automatically created in their notification preferences. Ensure that this device is active for the users that you want to receive the push notification.

8. Click **Save**. The target audience and content configuration changes are saved.

9. Click **Schedule**.

10. In the Scheduled Script pop-up window, configure a scheduled job to the notification. For more information, see **Configure a scheduled job**.

11. Click **Submit**. A script is added to the scheduled job. The job is associated with the outreach notification.

**Results**
An outreach notification with a scheduled job is created. The job sends notifications to the target audience per the set schedule.

⚠️ **Note:** The outreach notification is not sent to users in the selected audience if users do not have a location set in their user profile or the privacy consent is disabled in the location privacy configuration. The privacy consent notification is sent to a user only once even if the user is in the target audience of multiple privacy notifications.

**What to do next**
A user with the sn_imt_checkin.checkin_admin role can send the Outreach notification on demand.

A user with the admin or sn_imt_checkin.checkin_admin role can stop the scheduled job to send the notifications automatically. To do so, click **Schedule** and in the dialog box, clear the **Active** check box, and then click **Update**.

**Map handheld computing devices assigned to employees**
Map handheld computing devices that are assigned to employees and running the Zebra MotionWorks software to record proximity logs for contact tracing using those devices.

**Before you begin**
Handheld computing device data is stored in the Handheld Computing Device [cmdb_ci_handheld_computing] table. The table is installed with the CMDB CI Class Models application available on the ServiceNow Store. Ensure that you have that application installed and active. For more information, see **CMDB CI Class Models**.

Role required: sn_imt_tracing.wearable_manager

**About this task**
You can also import your handheld computing devices data from an Excel spreadsheet that you use with the Zebra MotionWorks software. For more information, see **Easy import data from a list**.

**Procedure**
1. Navigate to **Contact Tracing > Wi-Fi Access Management > Handheld Devices**.
2. Click **New**.
3. On the form, fill in the following fields required for contact tracing.
Handheld Computing Device form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the handheld computing device.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Unique ID to identify the handheld computing device.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Unique serial number of the handheld computing device.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Name of the employee who has the handheld computing device.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
A mapping of the handheld computing device and the employee to whom it is assigned is created.

**Configure KINEXON integration**
Configure Contact Tracing and enable the KINEXON SafeZone tracing system to use data from KINEXON wearable devices in diagnostic requests. This data enables the identification of potentially exposed contacts based on the interactions and proximity of users with KINEXON wearable devices.

**Before you begin**
To successfully enable the KINEXON SafeZone tracing system, note the following requirements:

- The Emergency Outreach application must be installed. For more information, see [Install Emergency Outreach](#).
- Privacy consent settings for Contact Tracing must be configured. For more information, see [Setting up data privacy consent settings for Contact Tracing](#).
- Users must have KINEXON wearable devices managed with KINEXON SafeZone.
- Users should have an email address in the **Name** column in the KINEXON SafeZone software. Email addresses are used to match KINEXON users to users in Contact Tracing.

Role required: admin

**Procedure**
1. Navigate to **Contact Tracing > Properties**.
2. Set the Contact Tracing property values related to the KINEXON SafeZone integration.

**Contact Tracing properties for KINEXON SafeZone integration**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.kinexon_api_endpoint</td>
<td>API endpoint used to log in to the KINEXON SafeZone instance and access KINEXON data. This API endpoint is also used to fetch information</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.kinexon_api_username</td>
<td>KINEXON administrator username.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_password</td>
<td>KINEXON administrator password.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_param_min_duration</td>
<td>The minimum duration of contact (in seconds) between two KINEXON sensors required to determine whether a user is a potentially exposed contact. The query omits all records with values below this duration. The default value is 300.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_param_min_acc_duration</td>
<td>The minimum total duration (in seconds) of all contact between two KINEXON sensors within the queried date range. If the total duration is shorter than this value, the query omits all records of contact between the pair of sensors. The default value is 300.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_param_max_distance</td>
<td>The maximum distance (in meters) between two KINEXON sensors that determines whether users are in contact. The query omits any instances of contact beyond this distance. The default value is 2.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_param_max_time_gap_in_sequence</td>
<td>Determines the amount of time that can pass (in seconds) between any two consecutive instances of contact before the potential exposure is considered two potential exposures. The default value is 15.</td>
</tr>
</tbody>
</table>

3. Navigate to **Emergency Exposure Management** > **Tracing Systems** and click **Kinexon SafeZone**.

4. Activate the tracing system.
a. Select Active.
b. Click Update.

5. Add all users with KINEXON wearable devices in your organization to the privacy consent audience.

a. Navigate to Emergency Outreach > Safe Workplace Audience and click privacy audience.

b. Add users to the audience.
   For detailed instructions on adding users to an audience, see Add a Safe Workplace audience

c. Click Update.

6. Assign the sn_int_core.privacy_consent_user role to KINEXON users to enable them to access and complete the privacy consent.

7. Send your organization's privacy consent outreach to KINEXON users.
   Users in a location that requires privacy consent must consent to the privacy policy to create exposed contact records. Users who do not have an assigned location or are in a location that does not require privacy consent do not have to submit a privacy consent.

Results
You can now use the KINEXON SafeZone tracing system in diagnostic requests. For more information on identifying potentially exposed contacts using diagnostic requests, see Identify potentially exposed contacts.

Virtual Agent conversations for Contact Tracing
Contact Tracing provides a Virtual Agent conversation to assess the health of potentially exposed contacts via SMS.

Overview
A Virtual Agent conversation topic enables a dialog between the Virtual Agent (chatbot) and a user to accomplish a specific goal. The provided Exposure conversation topic for Contact Tracing asks potentially exposed contacts questions based on the Exposure Case Task Survey. Contact tracers use the responses to assess the health of a potentially exposed contact.

Contact Tracing uses an SMS outreach to initiate the Virtual Agent conversation and begin the survey. The Exposure Case Task Survey outreach can be sent automatically when users are added to case tasks as exposed contacts. Alternatively, contact tracers can send the survey manually while working on a case task by selecting the Send SMS Survey button. Users who receive the survey can reply back via SMS.

Organizations can use the Exposure conversation topic and Exposure Case Task Survey as provided or customize it. For example, you might want to add a "Prefer not to say" answer option to one or more questions.

Note: To complete the customization, you must apply any changes to both the Exposure conversation topic in Virtual Agent > Designer and the Exposure Case Task Survey in Survey > View Surveys. Applying changes to only the conversation topic or the survey will not update both the topic and survey.

• For more information on updating conversation topics, see Virtual Agent Designer.
• For more information on updating surveys, see Survey designer.
Installation and setup requirements

Note the following requirements to use Virtual Agent with SMS:

• A Twilio account and phone number.

• The Emergency Outreach application.
  For details, see Install Emergency Outreach.

• The Virtual Agent plugin (com.glide.cs.chatbot).

• Conversational SMS Integration with Twilio application (sn_va_sms_twilio).
  For more information, see Set up the Conversational SMS Integration with Twilio.

Note the following requirements for users to complete Exposure Case Task Surveys via SMS:

• Your organization must install and set up Virtual Agent for use with SMS.

• To receive SMS messages for Contact Tracing, users must have a mobile phone number listed on their user record [sys_user]. Mobile numbers must be in E.164 format, for example, +18585551212.

• Privacy consent for Contact Tracing must be configured before users can reply to SMS messages. For instructions and more information, see Setting up data privacy consent settings for Contact Tracing.

• Users must agree to the privacy consent before they can respond to the survey.

Send Exposure Case Task Surveys automatically via SMS

As an administrator, you can configure Contact Tracing to enable Exposure Case Task Surveys to be automatically sent via SMS.

Before you begin

Ensure that the installation and setup requirements to enable Virtual Agent conversations for Contact Tracing are met. For more information, see Virtual Agent conversations for Contact Tracing.

Role required: admin

About this task

Enable the sn_imt_tracing.enable_sms_exposure_survey property so that Exposure Case Task Surveys are sent automatically when users are added to Exposed Contacts. Potentially exposed contacts can respond to the surveys via SMS, providing contact tracers with an assessment of their health status.

Procedure


   a. Navigate to Contact Tracing > Administration > Properties.

   b. Set the sn_imt_tracing.enable_sms_exposure_survey property to Yes.

   c. Click Save.

2. Optional: Modify the survey questions and answers sent to potentially exposed contacts.

   Example

   For example, add a “Prefer not to say” answer option to one or more questions.
a. Update the Exposure Virtual Agent conversation topic in Virtual Agent > Designer. For more information on updating conversation topics, see Virtual Agent Designer.

b. Update the Exposure Case Task Survey in Survey > View Surveys. For more information on updating surveys, see Survey designer.

**Trouble?**
(Optional) To complete the customization, you must apply any changes to both the Exposure conversation topic in Virtual Agent > Designer and the Exposure Case Task Survey in Survey > View Surveys. Applying changes to only the conversation topic or the survey will not update both the topic and survey.

**Results**
When adding users to potentially exposed contacts in case tasks:

- Potentially exposed contacts are automatically added to the Exposure case task survey audience.
- The Exposure Case Task Survey outreach sends the SMS notification to the audience and the Virtual Agent processes the responses, executing the survey as an SMS conversation.
- Survey answers are stored in the [asmt_metric_result] table.

**Maintaining user data privacy in Contact Tracing**
The Contact Tracing application enables your organization to maintain the data privacy of all users given the high sensitivity of the data collected throughout the contact tracing process.

The following Contact Tracing features can help your organization enforce data privacy for your users:

**User privacy consent**
- Provide your organization’s privacy policy to users and enable them to agree or disagree to the use of their data for contact tracing. Use the privacy consent requirement to ensure that your users acknowledge the privacy consent request before entering the workplace.

**Confidential cases**
- Enable case managers to mark cases as confidential if they have been created for affected users who need complete privacy protection. Confidential cases can be accessed only by the case manager and users included in the watch list.

**Data retention**
- Set a timeline to keep the data no longer than required.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including data protection laws on collection, use, disclosure, and retention of personal data, and should enable, choose not to enable, or customize any functionality available within the application to meet the Organizations’ specific requirements.

**User privacy consent for Contact Tracing**
The Contact Tracing application enables you to send notification to users seeking their consent for contact tracing. You can use user data for contact tracing based on the privacy configuration set for a location and the user response to the privacy consent.
You can determine whether privacy consents are needed for specific locations. If a location does not need privacy consent, the user data belonging to that location can be automatically considered for contact tracing.

If a location requires privacy consents and a user has not consented to use the data, that user will be flagged, which has the following impact in contact tracing:

- You can create a case for those users but cannot run a diagnostic request for them.
- You cannot create a diagnostic request to identify potentially impacted users for those users.
- If a diagnostic request was created for the user before the user declined to give consent, you cannot run the diagnostic request.
- In a diagnostic request for another affected user, non-consenting users are excluded in the impacted users list. However, they can be added to the impacted users manually.

Privacy consent requirements ensure that your users complete a privacy consent before entering the workplace to facilitate the use of their data for contact tracing.

- Users who agree to the use of their data for contact tracing, the status of their privacy consent requirement updates to Clear. Meeting the privacy consent requirement makes those users eligible to enter the workplace.
- Users who disagree to the use of their data for contact tracing, the status of their privacy consent requirement updates to Not Clear. Meeting the privacy consent requirement makes those users eligible to enter the workplace.

**Important:** Any data collected for contact tracing before a user withdraws consent remains in the system. The data will be deleted from the system depending on your data retention settings.

**Setting up privacy consents for Contact Tracing**
As an admin, you must configure the following settings to use privacy consents with Contact Tracing:

1. Modify or add a privacy consent template for Contact Tracing
2. Generate location-based privacy configurations for Contact Tracing
3. Create a custom Emergency Outreach notification channel
4. Configure an email notification for a privacy consent request
5. Configure an Emergency Outreach notification for Contact Tracing privacy consents

**Send an Emergency Outreach notification for employee privacy consents in Contact Tracing**
Send an Emergency Outreach notification, on demand, to employees to provide the privacy policy and seek their consent to use their data for contact tracing.

**Before you begin**
Ensure that you have the Emergency Outreach application installed. For details, see Install Emergency Outreach.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Role required: sn_imt_checkin.checkin_admin or admin

**About this task**
**Important:** The privacy consent notification is sent to a user only once even if the user is in the target audience of multiple privacy consent notifications.
Procedure

1. Navigate to Emergency Outreach > View Outreaches.

2. Open the User Privacy Consent outreach record.

3. On the Safe Workplace Audience tab, select the audience from the list, and click Save. If you don’t have an audience defined, click New and define an audience from user lists, groups, departments, locations, and so on. After you save the Safe Workplace audience, you can use it to send any outreach message.

4. On the Content configuration tab, select Privacy Consent in the Response mode field.

5. Optional: Enable the outreach to provide location-specific privacy consents by selecting the Use Country check box on the Content configuration tab.

(Optional) When enabled, the privacy statement text in Location Privacy Configuration takes precedence over text in the privacy consent templates. This text is used for the outreach, system notification email, and push notification. If you need to update the text users receive, you must change the location’s privacy statement.

For more information on updating a location’s privacy statement, see Generate location-based privacy configurations.

6. On the Content configuration tab, select a notification in the Notification field, and choose how to send the notification.

• To send the notification by email, select the Email notification check box.

• To send a mobile push notification, select the Now Mobile Push notification check box.

   This option is available only if the ServiceNow NowMobile App Screens and Applet Launcher (com.glide.mobile-employee) plugin is activated.

   Push notifications use the ServiceNow Request Application notification device. When a user registers their mobile application to an instance, this notification device is automatically created in their notification preferences. Ensure that this device is active for the users that you want to receive the push notification.

7. Review the message content.

   • For email notifications, review the email subject and email body and modify it if necessary.

   • For push messages, review the message details.

8. Click Update. The target audience and content configuration changes are saved.

9. To send the notification, click Schedule.

10. In the Scheduled Script pop-up window, click Execute Now.

Results

The notification is sent to the target audience.

Note: The outreach notification is not sent to any users in the selected audience who do not have a location set in their user profile or whose privacy consent is disabled in the location privacy configuration.

What to do next

Review user privacy consents in Contact Tracing to see who has responded to the notification.
Respond to a request for privacy consent in Contact Tracing

When you receive an email or mobile notification for privacy consent, read the privacy policy statement and submit a response indicating whether you agree to the usage of your data for contact tracing.

Before you begin
You must have received a mobile or email push notification to be able to submit your response to the privacy policy request.
Role required: sn_imt_tracing.privacy_consent_user

About this task
You can also click the link included in the notification to submit your response.

Procedure
1. Navigate to Contact Tracing > Privacy > My Privacy Consent.
2. Read the privacy policy statement in the Privacy Notice field.
3. Select your response and click Submit.
   - If you agree to the privacy policy and use of your data, select I Agree.
   - If you do not want the organization to use your data, select I Disagree.

 注意: If you previously agreed to the privacy consent, a Withdraw Consent option is available. You can change your response to withdraw your consent by selecting Withdraw Consent and clicking Submit.

Results
Your current privacy consent decision is updated. The status of the notification updates to Acknowledged.

If you have the Employee Readiness Core application installed and a health and safety requirement for the privacy consent activated, a record is created with the requirement status:
   - If you agreed to the privacy policy and use of your data, the requirement status updates to Cleared.
   - If you disagreed or withdrew your consent, the requirement status updates to Not Cleared.

Submit a privacy consent for Contact Tracing from a mobile phone

If you receive a mobile push notification request for a data privacy consent, read the privacy policy statement and indicate whether you agree to the use of your data for contact tracing.

Before you begin
To receive mobile push notifications, you must have the Now® Mobile app.
Role required: sn_imt_tracing.privacy_consent_user

Procedure
1. Tap the notification to open the message.
2. In the message, tap View privacy consent.
3. Read the privacy policy statement in the Privacy Notice field.
4. Select your response and click Submit.
• If you agree to privacy policy and use of your data, select I Agree.
• If you do not want the organization to use your data, select I Disagree.

**Note:** If you previously agreed to the privacy consent, the Withdraw Consent option is available. You can change your response to withdraw your consent by selecting Withdraw Consent and clicking Submit.

---

**Results**
Your current privacy consent decision is updated. The status of the notification updates to Acknowledged.

If you have the Employee Readiness Core application installed and a health and safety requirement for the privacy consent activated, a record is created with the requirement status.

- If you agreed to the privacy policy and use of your data, the requirement status updates to Cleared.
- If you disagreed or withdrew your consent, the requirement status updates to Not Cleared.

**Review user privacy consents in Contact Tracing**
Review user privacy consent responses submitted by employees in answer to notifications seeking their consent to use their data for contact tracing.

**Before you begin**
Role required: sn_imt_tracing.admin

**Procedure**
1. Navigate to Contact Tracing > Privacy > User Privacy Consents.
2. Click the status in the Consent status column to open the employee’s consent record.
3. Review the employee’s responses in the Consent History related list.

- If employees have responded and agreed to have their data used, the preference is **I Agree**.
- If employees have responded and have not agreed to have their data used, the preference is **I Disagree**.
- If employees previously agreed to have their data used but later withdrew the consent, the preference is **Withdraw Consent**.
- If employees have not responded yet, the preference is **Awaiting Response**.

💡 **Note:** The consent history record with the latest preference submitted date is the last response from the employee.

You can send the notification again to employees who have not yet responded.

**Collecting user badge data**

In the Contact Tracing application, manage data for user badges and badge readers. Identify potentially exposed users who may have come in contact with affected users by importing their badge swipe data into the application.

Use this badge swipe data when running the diagnostic requests in the Emergency Exposure Management application.

**Add badge reader details**

Create entries for all badge reading devices that are installed at your workplace to control employee access to building, floors, and workspaces.

**Before you begin**

Role required: sn_imt_tracing.badge_manager

**About this task**

You can also import your badge reader data from an Excel spreadsheet. For more information, see Easy import data from a list.

**Procedure**

1. Navigate to **Contact Tracing > Badge Management > Badge Readers**.
2. To add details of a new badge reader device, click **New**, or select an existing badge reader to edit the details.
3. On the form, fill in the fields.

**Badge Reader form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the device. Use a name that makes it easy to identify the device.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the functional or availability status of the device. If a badge device reader is not working or is removed, clear this check box.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the device. If the device is under repair or has any issue, you can enter the status in this field.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Identifier</td>
<td>Unique ID of the device. This value can be the hardware ID or serial number of the device.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the device.</td>
</tr>
<tr>
<td>Floor name</td>
<td>Location where the device is installed on the premises.</td>
</tr>
<tr>
<td>Type</td>
<td>Type to determine if the device is installed at the entry or exit point of the workspace, floor, restricted area, or building entrance or exit gates.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Add user badges**

Add user badges that are assigned to employees to use with badge readers when they enter or exit controlled access locations in the workplace. These badges can be used with badge readers for building entry, exit gates, or floors.

**Before you begin**

Role required: sn_imt_tracing.badge_manager

**About this task**

You can also import your user badge data from an Excel spreadsheet. For more information, see [Easy import data from a list](#).

**Procedure**

1. Navigate to **Contact Tracing > Badge Management > User Badges**.
2. Click **New** to add details of a new user badge or select an existing user badge to edit.
3. On the form, fill in the fields.

#### User Badge form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option for marking the user badge as active. Only active user badges can be swiped through the badge reader.</td>
</tr>
<tr>
<td>Badge number</td>
<td>Unique badge number.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the employee who owns the badge.</td>
</tr>
<tr>
<td>Facility code</td>
<td>Code that identifies the original location of the employee and badge.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Import your badge reader data from an Excel spreadsheet**

Import your badge reader data from an Excel spreadsheet into the Badge Access Register table.
Before you begin
Ensure that you have added all your user badge and badge reader data.
Role required: sn_imt_tracing.badge_manager

Procedure
1. Navigate to Contact Tracing > Badge Management > Badge Access Register.
2. Click Import Badge Data.
3. In the Scheduled Data Imports list, open Badge Access Register Scheduled Import.
4. Attach the Excel file and load data in the Import Set table.

   a. Click the preview icon (i) next to the Data source field, and then click Open Record.

   b. On the Data Source form, click the manage attachments icon (🔗).

   c. Click Choose File and select the source Excel file.

   d. Click Download All.
   The Excel file is attached to the data source record.

   e. Click the Load All Records related link to load the Excel data.
   The imported data is available in the new Import Set table, Badge Access Register Stage [sn_imt_tracing_badge_access_register_stage].

5. Click Execute Now.
   The process runs in the background to load data from the Badge Access Register Stage table to the Badge Access Register table.

   Note: Depending on the number of records in the source Excel file, it might take a longer time for the imported data to be available in the Badge Access Register table.

6. Optional: Verify that the data records were imported into the Badge Access Register table by navigating to Contact Tracing > Badge Management > Badge Access Register.

Related information
Importing data using import sets
Schedule a data import

Collecting risk scores in Contact Tracing
Identify at-risk and potentially exposed users by importing and monitoring risk scores from their wearable devices and external systems.

Use risk scores to identify at-risk and potentially exposed users by integrating the Devvio DevvTrace platform. Create cases to investigate potentially exposed or infected users based on their scores.

The Devvio DevvTrace platform collects data from supported wearable devices and generates a risk score. Use Contact Tracing and the Devvio API to import data into the Devvio Users Risk Reports [sn_imt_tracing_devvio_users_risk_report] table. You can use this data in the following ways:
• Update the Devvio Users Risk Reports table daily with the Devvio Integration scheduled job.
• Create cases and work notes automatically if a risk score is equal to or greater than a risk threshold value.

Configure Devvio integration
Configure Contact Tracing properties to import risk scores from the DevvTrace platform using the Devvio API.

Before you begin
Ensure you have a Devvio administrator user name and password.
Role required: sn_imt_tracing.wearable_admin or admin

About this task
ServiceNow Contact Tracing integrates with the DevvTrace platform to collect user risk scores based on interactions at the workplace. To leverage risk scores from DevvTrace, your employees must be using supported wearable devices and you must have access points for Devvio.

Procedure
1. Navigate to Contact Tracing > Administration > Properties.
2. Set the Contact Tracing property values related to the Devvio integration.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.devvio.login.api.endpoint</td>
<td>API endpoint used to log in to the Devvio instance and access DevvTrace data.</td>
</tr>
<tr>
<td>sn_imt_tracing.devvio.integration.username</td>
<td>Devvio administrator user name.</td>
</tr>
<tr>
<td>sn_imt_tracing.devvio.integration.password</td>
<td>Devvio administrator password.</td>
</tr>
<tr>
<td>sn_imt_tracing.devvio.risk.report.api.endpoint</td>
<td>Devvio Risk Report API endpoint used to fetch risk report and scores.</td>
</tr>
<tr>
<td>sn_imt_tracing.devvio.risk.threshold</td>
<td>The risk threshold value for Devvio case creation. The default value is 90.</td>
</tr>
<tr>
<td></td>
<td>• If the risk score is greater than or equal to this value but less than 100, the health status is set to <strong>Under Investigation</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If the risk score is equal to 100, the health status is set to <strong>Infected</strong>, regardless of this value.</td>
</tr>
</tbody>
</table>

3. Click Save.

Results
The Devvio Users Risk Report updates daily at midnight (00:00) instance time. New cases are created when risk scores trigger Devvio case creation. For these cases, the reported source is set to **Wearable**. If a user has an open case and their risk score is greater than or equal to the risk threshold value, the case is updated and a work note is added.
Note: If a user with an open case has a health status other than Cleared, a work note is added but the source remains unchanged. If a user with an open case has a health status of Cleared, their health status updates to Under Investigation or Infected and a work note is added. The source for the case remains unchanged.

Retrieving Wi-Fi access log data

Wi-Fi access logs help you to identify potential employee interactions with an affected employee by correlating who connected to the same Wi-Fi network as the affected employee. Wi-Fi access logs can also include information on employees who connected to the Wi-Fi network using laptops, mobile devices, or Bluetooth LE devices.

Contact Tracing provides the following options:

- Manually upload data from a Microsoft Excel spreadsheet by using the import Wi-Fi access logs option
- Automatically get the Wi-Fi access logs from external systems by using the integration option

Integration with the following systems is available:

Integration with Mist Systems

Use the Mist Systems API to automatically import the Wi-Fi access logs data into the Wi-Fi Access Register table.

Integration with Cisco DNA Spaces

Import the Cisco DNA Spaces Wi-Fi access data into the Wi-Fi Access Register [sn_int_tracing_wifi_access_register] table by either generating a proximity report or downloading the access data into a spreadsheet and then uploading it.

- Microsoft Excel spreadsheet: Download the proximity report from Cisco DNA Spaces and attach the file in the diagnostic request task.
- Proximity report: Log in to the Cisco DNA Spaces portal and generate the proximity report by providing the diagnostic request task number. The proximity report containing the Wi-Fi access logs is posted into the Wi-Fi Access Register table.

For more information, see Fetch potentially exposed user data from a data source.

- Wi-Fi access data files: Import Wi-Fi access data from the files from a Secured FTP server into the Wi-Fi Access Register table. Cisco DNA Spaces system uploads these raw data files containing the Wi-Fi access data each day on a scheduled time. The data is imported from these files when you run the diagnostic request to identify potentially exposed employees.

Note: The file from the SFTP server for a specific day is imported into the Wi-Fi Access Register table only once. Any subsequent diagnostic requests use the data in the table to generate the list of potentially exposed employees.

Add wearable devices assigned to employees

Add wearable devices such as Bluetooth LE-enabled devices that are assigned to employees to enable them to connect to the Wi-Fi network in your workplaces.

Before you begin

The wearable device data is stored in the Wearable Technology [cmdb_ci_wearable] table. The table is installed with the CMDB CI Class Models application available on ServiceNow.
Store. Ensure that you have the CMDB CI Class Models application installed and active. For more information, see CMDB CI Class Models.

Role required: sn_imt_tracing.wifi_manager

About this task
You can also import your wearable devices data from an Excel spreadsheet. For more information, see Easy import data from a list.

Procedure
1. Navigate to Contact Tracing > Wi-Fi Access Management > Wearables.
2. Click New to add details of a new device or select an existing device to edit.
3. On the form, fill in the following fields required for contact tracing.

Wearable Technology form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the wearable device.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Unique ID to identify the wearable device.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Name of the employee who has the device.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the device.</td>
</tr>
<tr>
<td>MAC address</td>
<td>MAC address of the device.</td>
</tr>
<tr>
<td></td>
<td>Follow the steps in Configuring the form layout to add this field to the Wearables form.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create an organization and load sites
Create an organization for which you are collecting the Wi-Fi access logs using Mist Systems. After you have created an organization, load sites using a scheduled job.

Before you begin
Role required: sn_imt_tracing.wifi_admin

About this task
Each floor in the organization can be considered as a site. Each site can be further divided into zones. Each zone can have multiple Wi-Fi access points.

Procedure
1. Navigate to Contact Tracing > Mist Systems > Organizations.
2. Click New.
3. On the form, fill in the fields.

Organization form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the organization.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Organization Id | Unique ID of the organization. You must have the network admin role to get the organization ID. For more information, see the [Mist Systems documentation](#).
Active | Option for marking the availability status of the organization. If the organization is removed, clear this check box.
Vendor | Mist Systems
API token | API token that is generated for the organization. You must have the network admin role to get the API token. For more information, see the [Mist Systems documentation](#).

4. Click **Submit**.

5. Click **Load Sites**.
   
The sites of the organization are fetched from the Mist Systems and displayed in the **Sites** related list. Later, the **Load Mist Sites** scheduled job runs at the configured time and updates the sites list for each of the organizations.

   The **BLE enabled** option helps you to identify potentially infected employees from the Wi-Fi access logs by correlating everyone who connected to the Wi-Fi network using Bluetooth LE devices. If a site is BLE enabled, the **BLE enabled** check box on the Sites form is selected.

### Configure Cisco DNA Spaces settings for Wi-Fi access logs

Set up the Cisco DNA Spaces integration for Wi-Fi access logs.

#### Before you begin

**Role required:** admin

#### About this task

Cisco DNA Spaces integration provides two options to get the Wi-Fi access data from Cisco DNA Spaces into your ServiceNow instance.

- By generating and downloading the proximity report from the Cisco DNA Spaces portal or through a manual import.
- By importing Wi-Fi access raw data files from a secured FTP (SFTP) server. These files are uploaded from Cisco DNA Spaces every day at a scheduled time.

To specify which option to use, configure the `sn_imt_tracing.wifi_log_cisco_tier` system property. For each option, you must also complete additional settings.

#### Procedure

1. Complete the following steps for using Wi-Fi access data from the proximity report.

   a. Create an OAuth application endpoint for Cisco DNA Spaces and share the Client Id and Client Secret with Cisco to complete the integration on their side.

      On the Application Registries form, enter the following callback URL in the **Redirect URL** field based on the region:

      - **USA region:** https://dnaspaces.io/integrations/servicenow
      - **Europe region:** https://dnaspaces.eu/integrations/servicenow

      For more information on creating the OAuth application endpoint and description of other fields on the form, see Create an endpoint for clients to access the instance.
b. Log in to the Cisco DNA Spaces portal to register and authenticate the application to complete the integration.

c. Set the proximity level in the sn_imt_tracing.wifi_proximity_preference system property to consider employee interaction with an affected employee as potential exposure. For more information, see System properties for tracing systems in Emergency Exposure Management.

d. Review the base system DiagnosticTaskImportUtil script include. The DiagnosticTaskImportUtil script include creates a data source from the attachment in a diagnostic request task and imports the data into the Wi-Fi Access Register [sn_imt_tracing_wifi_access_register] table. For more information, see Script includes.

2. Set system properties to use the Wi-Fi access data files imported from the SFTP server into the Wi-Fi Access Register table.

a. Navigate to **Contact Tracing > Administration > Properties**.

b. Configure the following system properties:
   - sn_imt_tracing.wifi_log_sftp_server
   - sn_imt_tracing.wifi_log_sftp_port
   - sn_imt_tracing.wifi_log_sftp_file_path
   - sn_imt_tracing.wifi_log_sftp_load_time
   - sn_imt_tracing.wifi_log_sftp_username
   - sn_imt_tracing.wifi_log_sftp_password
   For more information on these properties, see System properties for tracing systems in Emergency Exposure Management.

3. Configure office locations that contain Cisco Wi-Fi devices.

a. Navigate to **Contact Tracing > Wi-Fi Access Management > Wi-Fi Diagnostic Preferences**.

b. Click **Generate Location Preferences**.

c. In the Generate Location Preferences window, select **Use Cisco DNA Spaces** from the list.

d. Click **OK**.
   All locations with the **Use Cisco DNA Spaces** preference use the Wi-Fi access data from Cisco DNA Spaces.

**What to do next**

Run the diagnostic request using the Wi-Fi access logs for an employee who is classified as positive for a condition, such as COVID-19, and is from a location with a Cisco Wi-Fi network. The Wi-Fi access logs provide a list of potentially impacted employees who used the same Wi-Fi network as the affected employee. For more information on running the diagnostic request, see Identify potentially exposed users.

**Import your Wi-Fi access logs spreadsheet**

Import Wi-Fi access logs from an Excel spreadsheet into the Wi-Fi Access Register table.

**Before you begin**

Role required: sn_imt_tracing.wifi_manager
Procedure

1. Navigate to **Contact Tracing > Wi-Fi Access Management > Wi-Fi Access Register**.

2. Click **Import Wi-Fi Access Data**.

3. In the Scheduled Data Imports list, open **Wi-Fi Access Register Scheduled Import**.

4. In the **Data Source** field, open the **Wi-Fi Access Register Data Source** record.
   a. Click the manage attachments icon (_attach).
   b. Click **Choose File** and select the source Excel file.
   c. Click the **Load All Records** related link to load the Excel data.

5. Navigate to Scheduled Import record.

6. Click **Execute Now**.
   The process runs in the background to load data from the Wi-Fi Access Register Stage table to the Wi-Fi Access Register table.

   **Note:** The number of records in the source Excel file affect the time needed before the imported data is available in the Wi-Fi Access Register table.

7. **Optional:** Verify that the data records were imported into the Wi-Fi Access Register table by navigating to **Contact Tracing > Wi-Fi Access Management > Wi-Fi Access Register**.

Use Wi-Fi access logs from Mist Systems

Identify potentially exposed employees using Wi-Fi access logs from Mist Systems.

**Before you begin**

Role required: sn_imt_tracing.wifi_admin

**About this task**

ServiceNow Contact Tracing integrates with an external application, Mist Systems, to collect and process Wi-Fi access logs for organizations. To leverage access logs from Mist Systems, you must have Mist access points installed at your workplace.

**Procedure**

1. Set up the Contact Tracing Wi-Fi properties.
   - By default, the asset data is available in the Computer table [cmdb_ci_computer]. If you are using a different table, specify it using the sn_imt_tracing.wifi_client_table property.
   - Ensure that the MAC address is populated in the **mac_address** field in the table that has the asset data.
   For more information, see System properties for tracing systems in Emergency Exposure Management.

2. Set up the Contact Tracing BLE properties.
   - By default, the asset data is available in the Wearable Technology [cmdb_ci_wearable] table. If you are using a different table, specify it using the sn_imt_tracing.wifi_ble_client_table property.
   - Ensure that the MAC address is populated in the **mac_address** field in the table that has the asset data.
Note: The Wearable Technology [cmdb_ci_wearable] table is installed with the CMDB CI Class Models application available on ServiceNow Store. For more information, see CMDB CI Class Models.

For more information on adding BLE-enabled devices or other wearable devices, see Add wearable devices assigned to employees.

3. Set up an organization and load sites.
   For more information, see Set up an organization and load sites.

4. Indicate that the diagnostic data should be accessed from Mist Systems.
   a. Navigate to Contact Tracing > Wi-Fi Access Management > Wi-Fi Diagnostic Preferences.
   b. Click Generate Location Preferences.
   c. In the Generate Location Preferences window, select Use Mist Integration from the list.
   d. Click OK.
      The access log data for all locations will be taken from Mist Systems access log files.

5. If you want to use manually loaded access logs rather than Mist Systems logs for a specific location, create a separate location assignment.
   a. Click New.
   b. Specify the location for which you want to set the diagnostic preference.
   c. Set the Preference value to Use Manual Load.
   d. Click Submit.

6. Run the diagnostic request.
   a. Select the Use Wi-Fi access log check box.
   b. Specify the start date and end date.
   c. Click Run Diagnostics.
      For more information about how to run a diagnostic request, see Run a diagnostic request.

Results
Mist Systems identifies the MAC addresses of the affected user for the specified start date and end date. The MAC addresses identify the zones visited by the affected employee. Potentially exposed employees who visited those zones are identified and displayed in the related list of the diagnostic request.

Use imported Wi-Fi access logs
Identify potentially exposed employees by manually importing Wi-Fi access logs into the Wi-Fi Access Register table.

Before you begin
Role required: sn_imt_tracing.wifi_admin

Procedure
1. Set up the Contact Tracing Wi-Fi properties.
   By default, the asset data is available in the Computer table [cmdb_ci_computer]. If you are using a different table, specify it using the sn_imt_tracing.wifi_client_table property.
   For more information, see System properties for tracing systems in Emergency Exposure Management.

2. Indicate that the diagnostic data should be accessed from manually loaded access logs.
a. Navigate to Contact Tracing > Wi-Fi Access Management > Wi-Fi Diagnostic Preferences.
b. Click Generate Location Preferences.
c. In the Generate Location Preferences window, select Use Manual Load from the list.
d. Click OK.
The access log data for all locations will be taken from manually loaded access logs.

3. If you want to use Mist Systems access logs rather than manually loaded logs for a specific location, create a separate location assignment.
   a. Click New.
   b. Specify the location for which you want to set the diagnostic preference.
   c. Set the Preference value to Use Mist Integration.
   d. Click Submit.

4. Import Wi-Fi access logs into the Wi-Fi Access Register table [sn_int_tracing_wifi_access_register] using an Excel spreadsheet. For more information, see Import your Wi-Fi access logs spreadsheet.

5. Run the diagnostic request.
   a. Select the Use Wi-Fi access log check box.
   b. Specify the start date and end date.
   c. Click Run Diagnostics.
      For more information about how to run a diagnostic request, see Run a diagnostic request.

Results
Potentially exposed employees are displayed in the related list of the diagnostic request.

Tracking employee contacts using daily logs
After employees start returning to the workplace, use daily contact logs to help promote the health and safety of all your employees. Let employees submit a list of other people with whom they come in contact during the day. Send mobile and email push notifications to employees to submit their contact log for the day.

Keep a track of the employees who have responded from the daily contact log responses. You can resend notifications to employees who have not responded to alert them for submitting their daily contact log.

The employee daily contact log in the Contact Tracing application works with the Emergency Outreach application. For more information, see Emergency Outreach.

A user with the sn_int_checkin.checkin_admin role for Emergency Outreach can review and modify the outreach notification for the daily contact log. For more information, see Configure an Emergency Outreach notification for the daily contact log.

An administrator can modify the schedule associated with the outreach notification to configure the timing to send notifications to employees. For more information, see Configure a scheduled job.

Note: If you are using Service Portal using a URL suffix other than the default /sp, update the same in the Daily Log form for it to work properly. You must associate the form with the service catalog. For more information on Service Portal, see Create a portal and for Service Portal page navigation, see Page navigation by URL.

Send an Outreach notification for the daily contact log
Send an Emergency Outreach notification, on demand, to employees to ask them to submit a list of co-workers whom they have interacted with on a given day.
Before you begin
Ensure that you have the Emergency Outreach application installed. For details, see Install Emergency Outreach.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Role required: sn_imt_checkin.checkin_admin or admin

Procedure
1. Navigate to Contact Tracing > Administration > Daily Log Alerts, and then click New.
2. On the Safe Workplace Audience tab, select the target audience for the notification, and click Save.
   - If you don’t have an audience defined, click New and define an audience from user lists, groups, departments, locations, and so on.
   - If you have the Employee Health Screening application installed, the Use Employee Health Screen Data option is available. Select this check box to include all employees cleared in the health screening to enter the premises. For more information, see Employee Health Screening.
   - If you have the Workplace Safety Management application installed, the User Workplace Reservation Data option is available. Select this check box to include all employees with confirmed or approved reservations for that day. For more information, see Workplace Safety Management.
3. On the Content configuration tab, select a notification in the Notification field, and choose how to send the notification.
   - To send the notification by email, select the Email notification check box.
   - To send a mobile push notification, select the Now Mobile Push notification check box.
     This check box is active if the ServiceNow NowMobile App Screens and Applet Launcher (com.glide.mobile-employee) plugin is activated. The push notification content appears when the check box is active, and you can modify it.
     Push notifications use the ServiceNow Request Application notification device. When a user registers their mobile application to an instance, this notification device is automatically created in their notification preferences. Ensure that this device is active for the users that you want to receive the push notification.
4. Review the message content.
   - For email notifications, review the email subject and email body and modify it if necessary.
   - For push messages, review the message details.
5. Click Update.
   The target audience and content configuration changes are saved.
6. To send the notification, click When to run.
7. Keep the default mode of None and click Send Notification.

Results
The notification is sent to the selected audience.

What to do next
Review daily log responses to see who has responded to the notification.
Submit a list of contacts that you interacted with at the workplace
Submit a list of people that you’ve come into contact with at the workplace to help your organization identify on-site employees who may have been in contact with a potentially exposed coworker.

Before you begin
Role required: sn_imt_checkin.dailylog_user

About this task
If you’re among the employees who have returned to the workplace, you receive mobile or email push notifications to submit a list of people that you’ve come into contact with at the workplace. You can click the link available in the notification to submit the daily contact log.

Procedure
1. Navigate to Contact Tracing > Daily Contact Log > My Daily Contacts.
2. In the List of individuals field, search for and select the employees that you interacted with.
   The Contact Details list appears, listing employee names and their email IDs as you select them.
3. Optional: In the Additional individuals (including visitors, contractors, etc.) and interactions field, enter the names of other people with whom you interacted during the day.
4. Optional: Review the employees that you added in the Contact Details list.
   There can be many employees with the same name, but these employees would have a distinct email ID.
5. To remove any wrong selection, click the x next to the employee name in the List of individuals field.
6. Click Submit.

Submit the daily contact log from a mobile phone
If you receive a mobile push notification to submit the daily contact log, you can submit a list of people that you interacted with on a day.

Before you begin
To receive mobile push notifications, you must have the Now® Mobile app.
Role required: sn_imt_checkin.dailylog_user

Procedure
1. Tap the notification to open the message.
2. In the message, tap Select People You Met.
3. Search for and select the employees in the List of individuals field.
   The Contact Details list appears listing employee names and their email IDs as you select them.
4. Optional: In the Additional individuals (including visitors, contractors, etc.) and interactions field, enter the names of other people with whom you interacted during the day.
5. Optional: Review the employees that you added to the Contact Details list.
   There can be many employees with the same name, but these employees would have a distinct email ID.
6. To remove any wrong selection, click the x next to the employee name in the List of individuals field.
7. To send your daily contact log, tap Submit.

Results
After you reply to the notification, a record for your response is updated. Your personal information is secure. Only the staff managing the daily contact logs has access to your response.

Review daily log responses
Review daily contact log responses from employees who received a push notification requesting a list of contacts that they interacted with at the workplace.

Before you begin
Role required: sn_imt_checkin.checkin_admin or sn_imt_tracing.admin

Procedure
Navigate to Contact Tracing > Daily Contact Log > Contact Logs.
Responses to notifications are listed in the Daily Log Acknowledgements list. Because employees respond to the notification by submitting their daily contact log, their records are updated with their acknowledgement status.

- If employees have responded, the status is Acknowledged.
- If employees have not responded yet, the status is Not Acknowledged.

The Notification count field shows the number of times the notification is sent to the employees who have not yet responded. You can send the notification again only to employees who have not yet responded.

Managing cases to follow up with potentially exposed contacts
When an employee who returns to the workplace is classified as positive for a condition, such as COVID-19, the case manager creates a case to identify and follow up with potentially exposed contacts.
Run the diagnostic request to identify potentially exposed contacts

The diagnostic request helps you generate a report of all on-site employees who might have been in contact with an affected employee.

If any employee is confirmed to be affected with an infectious disease, send the employee name to the case manager to create a case.

ℹ️ Note: To protect the privacy of the affected employee, you can mark a case as confidential.

Case management process

The case manager sets up a case for an employee who might have been exposed to any infectious disease.

1. Create a case for an affected employee.
2. Run a diagnostic request to identify all potentially exposed contacts through various tracing systems such as workplace location, workplace shifts and reservations, meetings, employee badge swipe data, and Wi-Fi access data. For more information, see Identify potentially exposed users.
3. Send an outreach notification to potentially exposed contacts to notify them of a potential exposure from an affected employee.
4. Create case tasks to follow up with these potentially exposed contacts to assess their health status using predefined survey questions.

Automated case creation

You must have the Emergency Self Report application installed for the automatic case creation to work. For more information, see Set up Emergency Self Report.

If an employee is reported as being in quarantine through the self-reporting option in the Emergency Self Report application, a case is created automatically for the employee. The case is created automatically only if the employee doesn't have any active case at the time of self-reporting.

If the employee has an active case, a work note is added to the case for the case manager to take appropriate action, if needed.

The Automated Case Creation from Employee Self Report flow is installed with Contact Tracing. The contact tracing admin can review and configure the base system flow using the Flow Designer.

Automated case task creation on adding a potentially exposed contact

When a case manager adds a potentially exposed contact to a case, a case task is created automatically. By default, these case tasks are assigned to the case manager, and the case manager can assign it to a contact tracer to follow up with the employee.

ℹ️ Note: Case task creation occurs automatically only if the sn_imt_tracing.auto_create_case_tasks property is set to Yes, the default setting.

The Create case tasks for exposed contacts workflow is installed with Contact Tracing. The contact tracing admin can review and modify the base system flow using the Flow Designer.

Automated SMS outreach delivery to potentially exposed contacts

To take advantage of automatic SMS outreach delivery, you must have Virtual Agent installed and set up for use with SMS and Twilio. For more information on this feature, see Virtual Agent conversations for Contact Tracing.

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
When a user is added to a case task as a potentially exposed contact, they are automatically sent an SMS notification to answer questions for the Exposure Case Task Survey.

**Note:** SMS notifications are sent automatically only if the sn_imt_tracing.enable_sms_exposure_survey is set to **Yes**. When disabled (the default setting), you can send an SMS survey while working on a case task by clicking the **Send SMS Survey** button.

**Potentially exposed contacts visualization**

Contact Tracing provides interactive visualization to view the potentially exposed contacts in a case. The visualization enables case managers to quickly evaluate the contact tracing data on a single page. The potentially exposed contacts visualization includes the following options:

- View potentially exposed contacts with the source of exposure graphically
- Drill down to the next level of exposures to quickly identify the severity of the exposure from the affected employee
- Create and view cases and tasks for potentially exposed contacts
- Change the status of the investigation of potentially exposed contacts
- Filter the view by status or source of exposure, or both

**View case metrics in ServiceNow Safe Workplace Dashboard**

If you have the Safe Workplace Dashboard application installed, you can view the trends of the following data over a given time period for a campus or location:

- Number of active cases
- Number of potentially exposed contacts

For more information, see [Safe Workplace Dashboard](#).

You can also configure the alert type to determine when the number of active cases is above the threshold in a particular campus or location. For more information, see [Alert types used with the Safe Workplace Dashboard](#).

**Create a case for an affected employee**

As a case manager, create a case for an affected employee to identify and follow up with other employees who might have come in contact with the affected employee.

**Before you begin**
Role required: sn_imt_tracing.case_manager

**About this task**

**Important:** There can be only one active case for an affected employee. You can create a new case for the same employee only if the active case is closed or cancelled.

If the [Emergency Self Report](#) application is installed and an employee is reported being in quarantine through the self-reporting option, the system automatically creates a case. If an active case exists for the employee at the time of reporting, a work note is added to that case.
Procedure
1. Navigate to **Contact Tracing > Case Management > Create New Case.**
2. On the form, fill in the fields.

**Case form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reported person</td>
<td>Name of the affected employee.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the affected employee.</td>
</tr>
<tr>
<td>Date reported</td>
<td>The date on which the person was reported to be affected.</td>
</tr>
<tr>
<td>Reported source</td>
<td>Source from which the employee was reported to be affected, such as through health screening, self-reporting, or location.</td>
</tr>
<tr>
<td>Case manager</td>
<td>User assigned to work on the case. Users who have the sn_imt_tracing.case_manager role are listed.</td>
</tr>
</tbody>
</table>

**Note:** If a case was automatically created when the employee self-reported as being in quarantine, the case manager field is empty. Case managers can assign the case to themselves or to any other case manager. Only the assigned case manager can work on the case.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case state</td>
<td>Current state of the case.</td>
</tr>
<tr>
<td>Case start date</td>
<td>The date on which the case is created.</td>
</tr>
<tr>
<td>Case end date</td>
<td>The date on which the case is closed.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Other users who need to know about the status of the case.</td>
</tr>
<tr>
<td>Confidential</td>
<td>Option for keeping the case confidential to protect the privacy of the affected user. A confidential case can be accessed only by the case manager and users added in the Watch list field.</td>
</tr>
</tbody>
</table>

3. Click **Submit.**

**Results**
A case for the affected employee is created. If notifications are enabled, the case manager assigned to the case is notified via email.
An exposed contact record is created for the reported person with the default health status set to Infected.
The Exposed contacts visualization section appears.
The following related lists appear in the case:
• Diagnostics Requests: Used to request a diagnostic report to identify all impacted employees.
• Exposed Contacts: Potentially exposed contacts to follow up with about their health status.
• Case Tasks: The tasks created for each potentially exposed contact to track the follow-up.
• Notes: Notes containing the names of individuals submitted in the daily contact logs by the affected employee during the period specified for the case. If the end date is not specified in the case, all daily log notes submitted by the affected employee after the case start date are listed.

What to do next
Run the diagnostic request to identify all potentially exposed employees and add them to the case for follow-ups.

You can also add potentially exposed contacts to the case manually from the Exposed Contacts related list.

If you have the Safe Workplace Dashboard application installed, you can view a trend of active cases and potentially exposed contacts over a given time period for a campus or location on the dashboard.

Identify potentially exposed contacts
As a case manager, run the diagnostic request to identify other employees who might have come in contact with the affected employee.

Before you begin
The diagnostic request function is available in the Emergency Exposure Management application. Ensure that you have the Emergency Exposure Management application installed.

Role required: sn_imt_tracing.case_manager

About this task

⚠️ Note: You cannot create or run a diagnostic request for affected employees who have not consented to use their data for contact tracing. For more information, see User privacy consent for Contact Tracing.

Procedure

1. Navigate to Contact Tracing > Case Management > Cases Assigned to Me.
2. Open a case from the list of assigned cases.
3. If the case is newly assigned to you, click Start Work. The state of the case updates to Work in Progress.
4. In the Diagnostic Requests related list, click New. The Diagnostic Request form appears. The details of the affected user are pre-populated in the respective fields from the case record.
5. On the Diagnostic Request form, run the diagnostic request on the affected employee to identify other potentially exposed employees, and add them to the case.

   a. Select one or more tracing systems and a date range.
   b. Click Save.
   c. Click Run Diagnostics.
The potentially exposed employees, based on the selected tracing systems, are listed in the All Impacted Users related list on the Diagnostic Request form.

d. Select users from the All Impacted Users related list and select the Add Users to Case option in the Actions on selected rows list.

For more information on running a diagnostic request, see Run a diagnostic request.

6. Optional: If you know of other employees in addition to employees identified from the diagnostics, click New in the Exposed Contacts list and add them as potentially exposed contacts.

Results
The selected users from the All Impacted Users related list on the Diagnostic Request form are added to the Exposed Contacts related list on the Case form.
If automatic case task creation is enabled by the sn_imt_tracing.auto_create_case_tasks system property setting, a case task is created for each potentially exposed contact added to the case. These automatically created case tasks are assigned to the case manager by default. From the Case Tasks related list, the case manager can assign them to a contact tracer.

**Note:** If a potentially exposed employee added to the case has an active case, the health status of the employee in the current exposed contact record is automatically set from the corresponding exposed contact record of the active case.

These potentially exposed contacts also appear in the exposed contacts visualization section. For more information, see Working on a case through contact tracing visualization.

If you have the Employee Readiness Core application installed and a health and safety requirement for the potentially exposed contacts activated, a record is created with the requirement status as Not Cleared for these potentially exposed employees.

**What to do next**
Send notification to potentially exposed contacts in a case.

If the automatic case task creation is disabled, create a case task for each exposed contact.

Send notification to potentially exposed contacts in a case
As a case manager, send an outreach notification to potentially exposed employees to notify them of a potential exposure from an affected employee.

**Before you begin**
Ensure that your administrator has created an outreach notification that you can send to potentially exposed contacts in the case. To create an outreach notification, the ServiceNow Emergency Outreach application must be installed and active. For more information, see Emergency Outreach.

Role required: sn_imt_tracing.case_manager

**Procedure**
1. Navigate to Contact Tracing > Case Management > Cases Assigned to Me.
2. Open a case to send a notification to potentially exposed contacts.
3. In the Exposed Contacts related list, select the employees to whom you want to send a notification.
   If required, you can send a notification to a contact more than once.
4. In the Actions on selected rows list, select **Send Exposure Notice**.

5. In the Send Exposure Notice dialog box, select an outreach notification, and click **Send**.

**Results**

An email notification is sent to the selected contacts. The **Notice sent date** column for the selected contacts in the Exposed Contacts list updates to the current date.

You can review the notifications by navigating to **Emergency Outreach > View Outreaches** and open the outreach notification.

**What to do next**

Create a case task for each exposed contact.

Create a case task to follow up with an exposed employee

As a case manager, create case tasks for potentially exposed employees. Assign these tasks to contact tracers to follow up with them to evaluate their health status.

**Before you begin**

Role required: sn_imt_tracing.case_manager

**About this task**

The **sn_imt_tracing.auto_create_case_tasks** property, enabled by default, and the **Create case tasks for exposed contacts** workflow cause automatic creation of case tasks when potentially exposed employees are added to a case. If the admin has set the property to **No**, you must add a case task for potentially exposed employees added to a case.

**Procedure**

1. Navigate to **Contact Tracing > Case Management > Cases Assigned to Me**.

2. Open a case to create case tasks for the potentially exposed contacts.

3. In the Exposed Contacts related list, select employees for whom you want to create case tasks.

4. In the Actions on selected rows list, select **Create Task**.
   
   A task for each selected exposed contact is created and available in the Case Tasks related list. To add a case task for a user not in the exposed contacts list, click **New** in the Case Tasks related list. After creation of the task, the user is added to the Exposed Contacts related list.

5. In the Case Tasks related list, update the following fields:
   
   a. Double-click the **Due date** field and select the date that the task should be completed by.
   
   b. Double-click the **Assigned to** field and select a user to work on the task.

   If notifications are enabled, the contact tracers are notified via email.

   **Note:** To update multiple tasks in the list, click in a field, hold the Shift key, and press the Down Arrow or the Up Arrow key. Press the Enter key to open the list editor and enter appropriate values.

**Results**

The case tasks are created and assigned to the contact tracers to follow up about the health status of the exposed employees.
What to do next
The contact tracers can start working on the tasks by following up with the exposed contacts about their health status.

Follow up with potentially exposed contacts
As a case task owner, contact potentially exposed users to follow up on their health status using the predefined instructions and survey questions.

Before you begin
Role required: sn_imt_tracing.contact_tracer

About this task
The case manager defines instructions for contact tracers to use when following up with potentially exposed users, such as the follow-up frequency. Contact tracers should follow these instructions to work on the assigned tasks.
The Exposure Case Task Survey is available for contact tracers to use to assess the health status of the exposed contact. The administrator can review and modify the survey. For more information, see Survey designer.

Procedure
1. Navigate to Contact Tracing > Case Management > Case Tasks.
2. Open a task from the list.
3. To start work on a newly assigned task, click Start Work. The state of the case task updates to Work in Progress.
4. Follow up with the potentially exposed contact specified in the User field in one of the following ways:
   • Contact the user by calling or sending an email with the questions specified in the survey by clicking Take Survey.
   • Send the survey via SMS for the user to respond via SMS by clicking Send SMS Survey if available.

   Note: You must have Virtual Agent installed and set up for use with SMS and Twilio to complete SMS outreach delivery. For more information on this feature, see Virtual Agent conversations for Contact Tracing.

   Each follow-up result is added to the Survey results related list.

   Note: These follow-up results can be viewed only by the contact tracer to whom the case task is assigned, the case manager, and the contact tracing admin.
5. Update the final health status of the potentially exposed contact in the Outcome field when you complete the required number of follow-ups.
   • If the potentially exposed contact reports positive symptoms of the disease, select Infected.
   • If the potentially exposed contact reports normal, select Cleared.

   Note: An exposed contact’s health status and the Outcome field are updated when changes are made to either item. If there are multiple open case tasks for an exposed contact, the health status in all tasks will be updated to match the outcome of the most recently modified case task.
6. Click Close Task.
Results
The case task is closed. If notifications are enabled, the case manager is notified via an email.

What to do next
The case manager can review the closed task and update the health status of the exposed user's as per the outcome value.

⚠️ Note: The case manager can update the health status of an exposed contact only if there is no active case for the user.

If Employee Readiness Core is installed and the potentially exposed contacts requirement activated, the user’s health and safety requirement status is also updated.

After all the case tasks in the case have been closed, the case manager can close the case.

Working on a case through contact tracing visualization
The contact tracing visualization in a case is a graphical representation of the affected user and potentially exposed contacts. While working on a case, the case manager can use this visualization to view all potentially exposed contacts added to the case, their status, drill down to the next two levels of potential exposures, and take action as needed.

About Contact Tracing Visualization
The contact tracing visualization available on the case form provides multiple options based on the status of the potentially exposed contacts.

Contact tracing visualization

Each card represents a potentially exposed contact who might have been potentially impacted by the affected user. You can view how many potentially exposed and infected contacts users have for their current case (where they are the reported person) and the totals for other active cases they are in.

⚠️ Note: The totals for other active cases do not include numbers from a user’s current case.

For example, consider a sample employee’s case, Employee A. The employee has five potentially exposed contacts and one of them is infected. One of Employee A’s potentially
exposed contacts. Employee B, has three potentially exposed contacts from the current case. None of Employee B’s contacts are infected. Employee B is also a potentially exposed contact in two other cases. Employee B’s card provides the total number of potentially exposed contacts in those cases and how many are infected.

To review details about a potentially exposed contact’s current case, click Show Details. To navigate to cases in which the contact is a potentially exposed contact, click other active cases.

Tip: Use the Filter option to view a filtered list of cards, such as by status or the source of exposure.

Visualization options
Select a card to view various options on the card based on the status of the exposed contact.

You can change the health status or create case tasks for multiple potentially exposed contacts in one step. Select all cards by clicking Select All, or select a few cards by pointing to a card and selecting the check box. Updating the health status of an exposed contact updates their health status and outcome in all open case tasks in which they are included as an exposed contact.

Exposed contacts and available options

<table>
<thead>
<tr>
<th>Status of the exposed contact</th>
<th>Options available on the card</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Under investigation</strong></td>
<td>• View basic details of the user such as email ID and location.</td>
</tr>
<tr>
<td>The user is being contacted about the health status.</td>
<td>• View how many potentially exposed and infected contacts users have for their current case and any other active cases the user is in.</td>
</tr>
<tr>
<td></td>
<td>• Navigate to a user’s other active cases.</td>
</tr>
<tr>
<td></td>
<td>• Create a task for follow-up.</td>
</tr>
<tr>
<td></td>
<td>• Create a case.</td>
</tr>
<tr>
<td></td>
<td>• View potentially exposed contacts who might have been in contact with the selected user.</td>
</tr>
<tr>
<td><strong>Infected</strong></td>
<td>• View basic details of the user such as email ID and location.</td>
</tr>
<tr>
<td>The user has been classified as positive for a condition, such as COVID-19.</td>
<td>• View how many potentially exposed and infected contacts users have for their current case and any other active cases the user is in.</td>
</tr>
<tr>
<td></td>
<td>• Navigate to a user’s other active cases.</td>
</tr>
<tr>
<td></td>
<td>• Create a task for follow-up.</td>
</tr>
<tr>
<td></td>
<td>• Create a case if no case has been created yet.</td>
</tr>
<tr>
<td></td>
<td>• View the case if a case has been already created.</td>
</tr>
</tbody>
</table>
Exposed contacts and available options (continued)

<table>
<thead>
<tr>
<th>Status of the exposed contact</th>
<th>Options available on the card</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• View potentially exposed contacts who might have been in contact with the selected user.</td>
</tr>
<tr>
<td></td>
<td>• Change the status.</td>
</tr>
<tr>
<td><strong>Cleared</strong></td>
<td>• View basic details of the user such as email ID and location.</td>
</tr>
<tr>
<td></td>
<td>• View how many potentially exposed and infected contacts users have for their current case and any other active cases the user is in.</td>
</tr>
<tr>
<td></td>
<td>• Navigate to a user’s other active cases.</td>
</tr>
<tr>
<td></td>
<td>• Create a task for follow-up.</td>
</tr>
<tr>
<td></td>
<td>• Create a case if no case has been created yet.</td>
</tr>
<tr>
<td></td>
<td>• Change the status.</td>
</tr>
</tbody>
</table>

Vaccination statuses in contact tracing visualization

Organizations with Contact Tracing and the Vaccination Status application can view vaccination statuses on the Exposed Contacts list and contact tracing visualization. The Vaccinated label on a card indicates that the user is vaccinated.

For more information, see Configure contact tracing visualization to show vaccination status.

Potentially exposed contacts with Vaccinated status

Contact Tracing visualization Vaccination status features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccinated status</td>
<td>Case managers with the Vaccination Status sn_imt_vaccine.vaccine_profile_reader role can see the following:</td>
</tr>
</tbody>
</table>
Contact Tracing visualization Vaccination status features (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The <strong>Vaccinated</strong> status that displays for vaccinated contacts.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Vaccinated</strong> column appears in the <strong>Exposed Contacts</strong> list with values of <strong>True</strong> or <strong>False</strong>.</td>
</tr>
<tr>
<td>Vaccination filter</td>
<td>Case managers with the <code>sn_imt_vaccine.vaccine_profile_reader</code> role can filter exposed contacts based on their vaccination status. In the contact tracing visualization, click <strong>Filter</strong>. Select the <strong>Vaccinated</strong> check box to hide contacts who are not vaccinated. Clear the check box to remove the filter and show all contacts.</td>
</tr>
</tbody>
</table>

**Note:** The **Vaccinated** filter is visible to case managers without the `sn_imt_vaccine.vaccine_profile_reader` role but it does not reveal any vaccination data. Selecting the check box (without the role) hides all contacts as if none of them were vaccinated because the user does not have the necessary permissions to see vaccination statuses.

Health and Safety Testing

Streamline the user health testing process to help organizations reduce the spread of infectious diseases in the workplace.

The ServiceNow® Health and Safety Testing application streamlines the user health testing process to identify affected users and help reduce the spread of infectious diseases in the workplace. It provides organizations, where they are legally required or permitted to use them, with two options: request that users get tested or allow users to request optional health testing upon being notified of potential exposure to an infectious disease, such as COVID-19. Users can submit health testing preferences such as test type and preferred testing date and location. Administrators can use the employee request forms to coordinate testing availability and scheduling. After health testing is complete, users can use Health and Safety
Testing to provide a test result to satisfy the organization’s health and safety requirement, clearing the user for a safe return to the workplace.

**Use with other Safe Workplace suite applications**

Health and Safety Testing is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- With the **Employee Readiness Surveys** application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.

- Before users re-enter workspaces, use the **Employee Health Screening** application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.

- With the **Workplace Safety Management** application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.

- You can manage the inventory of safety equipment for your workforce with the **Workplace Personal Protective Equipment Inventory Management** application.

- With the **Contact Tracing** application, evaluate the readiness of your users to return to the workplace by using data such as badge scans, Wi-Fi access logs, and daily contact logs to help identify potential user interactions.

All Safe Workplace suite applications are available in the ServiceNow Store.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

### Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>
Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Health and Safety Testing

You can install Health and Safety Testing if you have the admin role.

Before you begin

Health and Safety Testing requires the ServiceNow® Employee Readiness Core application. The ServiceNow® Contact Tracing application can optionally be installed to send an email notification to employees who are potentially exposed individuals in a contact tracing case. The notification informs the employee of the potential exposure and provides them with a link to request testing.

The ServiceNow® Emergency Response Management for Now Mobile application can optionally be installed to add a Health tab to the Now Mobile app where employees can request testing or report a test result.

Role required: admin

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales team.</td>
</tr>
</tbody>
</table>
**Installation instructions for self-hosted and federal environments (continued)**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team.</td>
</tr>
<tr>
<td></td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you’ve subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Search for **Health and Safety Testing.**
3. Click **Install.**
   - The Application installation dialog box opens.
4. Click **Activate.**

**Components installed with Health and Safety Testing**

Several types of components are installed with Health and Safety Testing, including user roles and tables.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application.**
Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Important:</strong> By default, the System Administrator [admin] role contains the sn_imt_health_test.admin role. The sn_imt_health_test.admin role should be reassigned to another user and then removed from the admin. This process protects sensitive application data by restricting access to the application.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Health testing manager [sn_imt_health_test.testing_admin]</td>
<td>Can view and manage health testing requests, results, providers, and test types.</td>
<td>• None</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider [sn_imt_health_test_provider]</td>
<td>Health providers that your organization uses for COVID-19 diagnostic testing.</td>
</tr>
<tr>
<td>Test Request [sn_imt_health_test_request]</td>
<td>Test requests submitted by users.</td>
</tr>
<tr>
<td>Test Result [sn_imt_health_test_result]</td>
<td>Test results submitted by users.</td>
</tr>
<tr>
<td>Test Type [sn_imt_health_test_type]</td>
<td>Types of testing offered by providers. The options are At a facility and Self-administered. You can create additional test types if necessary.</td>
</tr>
</tbody>
</table>

Configure Health and Safety Testing

Complete all configuration tasks to ensure that Health and Safety Testing is set up correctly for your company.

Set up Health and Safety Testing properties

Set up Health and Safety Testing properties to define the data retention period for health testing data and enable or disable emails to potentially exposed individuals.

Before you begin

Role required: sn_imt_health_test.admin
**Procedure**

1. Navigate to **Health and Safety Testing > Properties**.
2. Set the following property values.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health and Safety Testing data retention period (in days). [sn_imt_health_test.data_retention_period]</td>
<td>Sets the number of days that data for COVID-19 diagnostic test requests and results is available in the system before it is deleted automatically. The Data Retention Job for Health and Safety Testing scheduled job runs daily to delete records that have an updated date past the specified retention period.</td>
</tr>
<tr>
<td>Send email to potentially exposed individuals asking them to submit a test request. [sn_imt_health_test.notify_potentially_exposed]</td>
<td>When enabled, an email notification is sent to employees who are potentially exposed individuals in a contact tracing case, alerting them to submit a test request.</td>
</tr>
</tbody>
</table>

**Note:** When an employee’s test results are deleted, their health and safety requirement status is reset to the default status for **Testing Requirement Satisfied**. If the employee is a potentially exposed individual in a contact tracing case, their health and safety requirement status is reset to **Not Cleared** until they submit a negative test result. For more information about health and safety requirements, see **Employee Health and Safety Status**.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tracing case and have a health status of <strong>Under investigation</strong>. The notification informs the employee of the potential exposure and provides them with a link to request testing. Use country-specific data retention policy for Health and Safety Testing. [sn_imt_health_test.use_country_specific_data_retention_policy]</td>
<td>Enable this property to use country-specific data retention policies for Health and Safety Testing. When enabled, records are compared to the data retention policy of the user's location to determine how long records are retained. For example, one country may have a 90 day retention period while another has a 120 day policy. When there is no country-specific policy, the policy defaults to the value in the <strong>Health and Safety Testing data retention period (in days)</strong> property. This property is inactive by default.</td>
</tr>
<tr>
<td>Message auto-created in work notes when test result is positive. [sn_imt_health_test.positive_result_message]</td>
<td>Create the message automatically generated in the work notes for users to read when a test result is positive, such as advice to self-quarantine or notify members of their household that they tested positive.</td>
</tr>
<tr>
<td>Prevent admin from accessing attachments [sn_imt_health_test.prevent_admin_access_to_attachments]</td>
<td>Enable this property to ensure that only scoped administrators can view attachments submitted by users for reported vaccinations. This prevents system administrators from viewing these attachments. The</td>
</tr>
</tbody>
</table>
Add COVID-19 test providers
Create a list of COVID-19 diagnostic test providers that your company uses to schedule testing for employees.

**Before you begin**
Role required: sn_imt_health_test.testing_admin

**Procedure**
1. Navigate to **Health and Safety Testing > Providers**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>The company providing COVID-19 diagnostic tests.</td>
</tr>
<tr>
<td>Supported test types</td>
<td>The types of testing offered by the provider. The options are <strong>At a facility</strong> and <strong>Self-administered</strong>. You can create additional test types if necessary.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**
When an employee submits a request for testing, use the list of providers to schedule the test according to the employee’s preferred test type and location.

**Customize the notification for potentially exposed individuals**
Modify the notification email that is sent to potentially exposed individuals to customize the notification for your company.

**Before you begin**
Role required: admin and sn_imt_health_test.admin

**About this task**
The **Potentially exposed health test request** notification is sent to employees who are potentially exposed individuals in a contact tracing case and have a health status of **Under investigation**. The notification informs the employee of the potential exposure and provides them with a link to request testing. The notification is only used when the `sn_imt_health_test.notify_potentially_exposed` property is enabled.

By default, the notification uses a ServiceNow® banner and a placeholder signature. Update the notification to use your company logo and signature.

**Procedure**
1. Navigate to **System Notification > Email > Notifications**.
2. Click the **Potentially exposed health test request** notification.
3. To view the default notification, click **Preview Notification**.
4. Navigate to the **What it will contain** form section.

5. In the **Message HTML** field, click **Insert/edit image** and select your banner image.

   - **Tip:** The image must be added before the mail script so that it appears at the top of the email.

   If you don’t already have an email banner image in your ServiceNow instance, you can upload an image to use. For instructions, see [Upload one or more images](#).

6. Click the **Show Notification Scripts** related link.

7. In the **Script** field, the code `template.print(util.getEmailCompanyLogo());` adds the default ServiceNow® banner to the email. Comment out or delete this line of code to remove the ServiceNow® banner.

8. In the **Script** field, replace `You can expect [these next outreach steps]` with the next steps that you want to communicate to employees.

9. In the **Script** field, replace `The Site Safety Team` signature with your preferred signature.

10. **Optional:** If you would like to make any other changes to the email notification, update the **Script** field as needed.

11. Click **Update**.

12. Return to the notification record and click **Preview Notification** to confirm your changes.

---

### Set up privacy consents for Health and Safety Testing

Set up privacy consents for users who are providing health and safety testing data to your company.

**Before you begin**

Role required: sn_imt_core.admin

**About this task**

Users must agree to a privacy policy in order to be able to request or report diagnostic data. They also must have the sn_imt_core.privacy_consent_user role.

**Procedure**

1. Customize the privacy consent template.
   - a. Navigate to **Employee Health and Safety Status > Privacy Consent Templates** and click **Testing Consent Template**.
   - b. Fill in the placeholder text with the name of your company and contact information.
   - c. Click **Update**.

2. Assign the sn_imt_core.privacy_consent_user role to all users who will be requesting and reporting diagnostic test results.
   
   This role allows users to complete the privacy consent.

3. Generate the **location-based privacy configurations** for the locations in your instance.

4. Configure an outreach to send the privacy consent to users.
   - a. Navigate to **Emergency Outreach > View Outreaches** and click the **Health and Safety Testing Diagnostic Test Placeholder** outreach.

   This outreach is preconfigured to use the Health and Safety Testing Diagnostic Test Placeholder Audience Record and the Testing Consent Template.
b. Make any modifications to the outreach if needed, such as scheduling a time to send. For more information, see Send notifications for an emergency.

c. Optional: Enable the outreach to provide location-specific privacy consents by selecting the Use Country check box on the Content configuration tab. When enabled, the privacy statement text in Location Privacy Configuration takes precedence over text in the privacy consent templates. This text is used for the outreach, system notification email, and push notification. If you need to update the text users receive, you must change the location’s privacy statement.

d. Click Update.

Results
Users can request and report diagnostic test results. Users that attempt to request a test are automatically added to the Health and Safety Testing Diagnostic Test Placeholder Audience Record about every 10 minutes. These users will also receive the notification around that time.

Request a COVID-19 diagnostic test
Request a COVID-19 diagnostic test if you have been potentially exposed, are having symptoms, or want testing for another reason.

Before you begin
Role required: sn_imt_core.privacy_consent_user

About this task
You must agree to a user privacy consent when you request a COVID-19 diagnostic test.

Procedure

   Note: To request testing in the Now Mobile app, navigate to Health > Follow These Safety Practices > COVID-19 Testing > Set up a COVID-19 diagnostic test.

2. On the form, fill in the fields.

   Set up a COVID-19 diagnostic test form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferred test type</td>
<td>The type of COVID-19 diagnostic test that you would like to take.</td>
</tr>
<tr>
<td>Preferred test date and time</td>
<td>The date and time that you would like to take your COVID-19 diagnostic test. This field appears only when At a facility is selected from Preferred test type.</td>
</tr>
<tr>
<td>Use a provider near me (please enter your address or city)</td>
<td>Your address or city. This field appears only when At a facility is selected from Preferred test type. Your company's health testing managers will use this address to find a test provider that is near you.</td>
</tr>
<tr>
<td>Reason for test</td>
<td>The reason that you are requesting a COVID-19 diagnostic test. The options are Having symptoms, Potential exposure, Prefer not to say, and Other.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

### Results
Your company’s health testing managers use your request to schedule a COVID-19 diagnostic test for you. You’ll receive an email from your company or the test provider with instructions and information about the test.

### What to do next
When you receive your test result, you can choose to report the result to your company. For instructions, see **Report your COVID-19 diagnostic test result**.

#### Report your COVID-19 diagnostic test result
If you would like to provide your company with an update on your health status, report your COVID-19 diagnostic test result.

### Before you begin
Role required: sn_imt_core.privacy_consent_user

### About this task
You must have agreed to a user privacy consent in order to be able to report your COVID-19 diagnostic test results.

### Procedure
1. Navigate to **Health and Safety Testing** > **Report a COVID-19 diagnostic test result**.

   **Note:** To report your test result in the Now Mobile app, navigate to **Health** > **COVID-19 Testing** > **Report a COVID-19 diagnostic test result**. If the **Health** tab is not available, find **COVID-19 Testing** under **More** instead.

2. On the form, fill in the fields.

   **Report a COVID-19 diagnostic test result form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related test request</td>
<td>The test request that you submitted to schedule testing.</td>
</tr>
<tr>
<td>Test result</td>
<td>Your test result. The options are <strong>Positive result</strong>, <strong>Negative result</strong>, and <strong>Inconclusive</strong>.</td>
</tr>
<tr>
<td>Date you received the result</td>
<td>The date that you received your test result.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

### Health and Safety Testing dashboard
Use the Health and Safety Testing dashboard to gain insight on the health of your users with reports detailing testing trends, the types of tests performed, and approvals.

To access the Health and Safety Testing dashboard, navigate to **Self-Service > Dashboards**.
End user and goals

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Health and Safety Testing manager or administrator: Needs an overview of the organization's testing status. They might want to see the frequency of tests, the number of results | • Administrator: sn_imt_health_test.admin  
• Manager: sn_imt_health_test.testing_admin | • Review the number of health test results by type  
• Monitor and compare the number of test results that have been approved or rejected |
<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| being reported each month approved, the authenticity of the tests, and what types of tests are being reported. | • (Optional) sn_imt_core.admin | • Monitor your organization's monthly testing rate  
| | | • Monitor the monthly number of test results reported |
| **Note:** The sn_imt_core.admin role is not required but users with that role can review some of the reports. Users with only the sn_imt_health_test.testing_admin role are unable to view the Test Results by Result Type and Test Approvals with Approved or Reject Status reports | | |

Employee Readiness Core admin: Needs an at-a-glance view of the organization's testing rate and the number of results reported to help determine employee readiness.  

| | • sn_imt_core.admin | • Monitor your organization's monthly testing rate  
| | | • Monitor the monthly number of test results reported |

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Results by Result Type</td>
<td>Pie breakdown</td>
<td>A breakdown of the test results in your organization by the result (positive, negative, and inconclusive).</td>
</tr>
<tr>
<td>Test Approvals with Approved or Rejected Status</td>
<td>Pie breakdown</td>
<td>The number of test results in your organization that have been either approved or rejected.</td>
</tr>
<tr>
<td>Employee Testing Rate (Monthly)</td>
<td>Line</td>
<td>Testing rate of users in your organization for the month.</td>
</tr>
</tbody>
</table>
### Title

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Results (Monthly)</td>
<td>Stacked bar</td>
<td>The monthly number of test results reported (positive, negative, and inconclusive).</td>
</tr>
</tbody>
</table>

### Employee Readiness Core

Use the ServiceNow® Employee Readiness Core application to track employee data across all Safe Workplace suite and ServiceNow® Emergency Response Management applications. The Employee Readiness Core app adds the Employee Health and Safety Status feature.
Employee Health and Safety Status

Employees can return to the workplace by fulfilling a set of requirements activated by the HR team.

Example process from the employee and HR manager perspective

**HR**
- Send email to employees that includes a link to the health verification agreement
  - Optional application: Emergency Outreach

**Employee**
- Receives an email with a link to the health verification
- Opens, reads, and submits the health verification
- Receives QR code (optional, New York and later releases)

**HR**
- Monitor requirement completion to start bringing employees back into the workplace

**Employee**
- Returns to work on the scheduled date
- Shows the QR code to the screener at the workplace entry

**Screener**
- If using QR codes, scan the code and review the requirement status page that opens.
  - Optionally, conduct health screen of employee temperature and PPE to grant or deny entry

Required apps:
- Employee Readiness Core
- Employee Health Screening
- Emergency Outreach (optional)
- Now Mobile (optional, NY and above)
- Additional Safe Workplace and Emergency Management apps can be installed to track additional requirements.
The Employee Readiness Core app also provides shared functionality and data structures for Employee Readiness apps, such as ServiceNow® Employee Readiness Surveys, ServiceNow® Employee Health Screening, and ServiceNow® Contact Tracing.

**Use guided setup to implement Safe Workplace suite apps**

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to **Guided Setup > Safe Workplace Guided Setup**. For more information about using the guided setup interface, see **Using guided setup**.

**Use with other Safe Workplace suite applications**

Employee Readiness Core is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- With the **Employee Readiness Surveys** application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.
- Before users re-enter workspaces, use the **Employee Health Screening** application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.
- With the **Workplace Safety Management** application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.
- You can manage the inventory of safety equipment for your workforce with the **Workplace Personal Protective Equipment Inventory Management** application.
- With the **Contact Tracing** application, evaluate the readiness of your users to return to the workplace by using data such as badge scans, Wi-Fi access logs, and daily contact logs to help identify potential user interactions.

All Safe Workplace suite applications are available in the ServiceNow Store.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team.</td>
</tr>
</tbody>
</table>
Installation instructions for self-hosted and federal environments (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See the <a href="https://kb0030260">Federal downloads for the Emergency Response Management and Safe Workplace suite apps</a> article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the <a href="https://kb0030258">Commercial downloads for the Emergency Response Management and Safe Workplace suite apps</a> article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

**Notice regarding use by government agencies**

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

**Install Employee Readiness Core**

You can install Employee Readiness Core if you have the admin role.

**Before you begin**

Employee Readiness Core version 1.1.0 and later requires the following plugins.

- ServiceNow Integration Hub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Integration Hub Action Step - REST (com.glide.hub.action_step.rest)

These plugins must be requested through the Now Support Service Catalog. For instructions, see [Request a plugin](https://kb0030260).

Role required: admin
Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Search for Employee Readiness Core.
3. Click Install.
   The Application installation dialog box opens.
4. Optional: Load the demo data by selecting the Load demo data check box.
   (Optional) For information about how to install or reinstall demo data after the initial installation, see the Work around to install demo data if application is already installed [KB0722909] article in the Now Support Knowledge Base.
5. Click Install.
6. When the installation is complete, click Close.

Components installed with Employee Readiness Core

Several types of components are installed with Employee Readiness Core, including user roles, tables, and scheduled jobs.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Employee Readiness Core admin [sn_imt_core.admin] | Can create and manage health and safety users. | • sn_imt_core.reader
• flow_operator
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Readiness Core reader [sn_imt_core.reader]</td>
<td>Can view health and safety requirement statuses in the View Employee and Visitor Status module.</td>
<td>• None</td>
</tr>
<tr>
<td>Safe Workplace audience admin [sn_imt_core.safe_workplace_audience_admin]</td>
<td>Can create and manage Safe Workplace audiences.</td>
<td>• None</td>
</tr>
<tr>
<td>External web service user [sn_imt_core.api_logging_user]</td>
<td>External service user that can make table API calls to insert log entries.</td>
<td>• None</td>
</tr>
<tr>
<td>Privacy consent user [sn_imt_core.privacy_consent_user]</td>
<td>Can submit and update the user privacy consent for themselves.</td>
<td>• None</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health and Safety User [sn_imt_core_health_and_safety_user]</td>
<td>List of users and visitors and their progress toward completing all applicable active requirements.</td>
</tr>
<tr>
<td>Health and Safety Requirement [sn_imt_core_health_and_safety_requirement]</td>
<td>List of all health and safety requirements.</td>
</tr>
<tr>
<td>Employee Health and Safety Requirement [sn_imt_core_employee_health_and_safety_requirement]</td>
<td>List of user and visitor statuses for all active requirements.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health and Safety Visitor [sn_imt_core_visitor]</td>
</tr>
<tr>
<td>Health and Safety Visitor Invitation [sn_imt_core_visitor_invitation]</td>
</tr>
<tr>
<td>Location Privacy Configuration [sn_imt_core_location_privacy_configuration]</td>
</tr>
<tr>
<td>Privacy Consent Template [sn_imt_core_privacy_consent_template]</td>
</tr>
<tr>
<td>User Privacy Notice and Consents [sn_imt_core_user_privacy_notice_and_consent]</td>
</tr>
<tr>
<td>Safe Workplace Audiences [sn_imt_core_safe_workplace_audience]</td>
</tr>
</tbody>
</table>

### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark expired user requirements as not_cleared</td>
<td>Runs every 30 minutes to update user requirement statuses to Not Cleared if they have exceeded the time limit they are valid for.</td>
</tr>
</tbody>
</table>
| Collect Safe Workplace users | Runs weekly to create health and safety user records for users [sys_user] with activity or an assigned role in any of the following Safe Workplace suite and Emergency Response Management applications.  
  • Contact Tracing  
  • Emergency Outreach  
  • Employee Health Screening  
  • Employee Readiness Core  
  • Employee Travel Safety  
  • Health and Safety Testing  
  • Safe Workplace Dashboard  
  • Vaccination Status |
<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Workplace PPE Inventory Management</td>
</tr>
<tr>
<td></td>
<td>• Workplace Safety Management</td>
</tr>
</tbody>
</table>

Health and safety user records are also created for visitors who are invited through the Employee Readiness Core app.

**Employee Health and Safety Status**

Use the Employee Health and Safety Status feature to track when people are ready to return to the workplace.

Pull data across all Safe Workplace suite and Emergency Response Management applications into a single data point that shows if a user is ready to return to the workplace or travel.

Create and activate requirements that users must fulfill before they can return to the workplace or complete travel to various locations. The requirements can be based on data from any of the Safe Workplace suite and Emergency Response Management applications. When a user fulfills all active requirements, they are ready to return to the workplace.

Due to the ability to set different health and safety requirements for different locations, a user might be cleared for their current travel or location but not for a specific location. For example, a user might be cleared for an active reservation but not travel to a campus across their country.

ℹ️ **Note:** If a user has an active travel and active reservation, that reservation takes precedence.

---

**Set up Employee Health and Safety Status properties**

Set up Employee Health and Safety Status properties to configure the email notifications that are sent to visitors.

**Before you begin**

Role required: sn_imt_core.admin
Procedure
1. Navigate to Employee Health and Safety Status > Properties.
2. Set the following property values.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_core.send_email_to_visitor</td>
<td>When enabled, the Notify about scheduled visit email notification is sent to the visitor when an employee invites them to the workplace. The email is sent immediately after the employee submits the invitation. The email contains a brief confirmation of the scheduled visit, including information about the date of the visit and the name of the employee who invited them.</td>
</tr>
<tr>
<td>sn_imt_core.days_to_ask_for_health_data</td>
<td>Sets the number of days before the scheduled visit that the Ask for health related data from visitor email notification is sent to the visitor. The email contains information about safety requirements and policies that the visitor must agree to follow. The visitor must respond Yes to the email to complete the Visitor Invitation Requirement.</td>
</tr>
</tbody>
</table>

For more information about the email notifications used by the properties, see Modify visitor notification emails.

3. Click Save.

Create health and safety user records
Create health and safety user records to track requirement statuses for all employees and visitors.

Before you begin
If the ServiceNow® Customer Service Management (CSM) application is activated, you can also create health and safety user records for consumers and contacts.
Role required: sn_imt_core.admin

About this task
Health and safety user records are automatically created for users [sys_user] with activity or an assigned role in any of the following Safe Workplace suite and Emergency Response Management applications.
• Contact Tracing
• Emergency Outreach
• Employee Health Screening
• Employee Readiness Core
• Employee Travel Safety
• Health and Safety Testing
• Safe Workplace Dashboard
• Vaccination Status
• Workplace PPE Inventory Management
• Workplace Safety Management

Health and safety user records are also created for visitors who are invited through the Employee Readiness Core app.

Some users might not have activity or assigned roles in the apps, so health and safety user records are not automatically created for them. If you want to view the requirement status for these users, you can manually create health and safety user records for them.

**Procedure**

1. Navigate to **Employee Health and Safety Status > Health and Safety Users**.
2. Click **New**.
3. In the **type** field, select **Visitor** or **Employee**.
   
   **Note:** If you're creating a health and safety user record for a CSM consumer or contact, select **Employee**.

4. Select a value in the **User** or **Visitor** field.
   - If you're creating a record for an employee, consumer, or contact, select the user in the **User** field.
   - If you're creating a record for a visitor, select the visitor in the **Visitor** field.

5. Click **Submit**.
   The **Requirement status** field is read-only and is updated after you submit the record.

   The user or visitor is added to the Health and Safety User table [sn_imt_core_health_and_safety_user]. A record is created for the user or visitor in the Employee Health and Safety Requirement table [sn_imt_core_employee_health_and_safety_requirement] for each active requirement using the default status for the requirement.

**What to do next**

You can view all health and safety user records by navigating to **Employee Health and Safety Status > Health and Safety Users**. The **Requirements status** column shows the user's or visitor's progress towards completing all active requirements. The value is **Cleared** if they have fulfilled all active requirements. The value is **Not cleared** if they are missing any requirements.

You can also look up the requirements status for individual users or visitors by navigating to **Employee Health and Safety Status > View Employee and Visitor Status**. The status page can be used during the health screening process for entry to a location. For more information, see **Conduct a health screen for entry**.

**Activate a health and safety requirement**

Activate requirements to track when employees are ready to return to the workplace or to safely travel to another site. You can also activate requirements that visitors must complete before entering the workplace.

**Before you begin**

Role required: sn_imt_core.admin

**About this task**

Use health and safety requirements to define the requirements that employees must fulfill before they can return to the workplace, safely travel to another site, or that visitors must fulfill before entering the workplace. Employee Readiness Core includes pre-built requirements. For more information, see **Included health and safety requirements**.
Requirements are not active by default. A requirement must be activated before you can track whether employees or visitors have fulfilled the requirement.

**Procedure**

1. Navigate to **Employee Health and Safety Status > Health and Safety Requirements**.

2. Click the requirement that you want to activate.

   **Note:** Pre-built requirements provided by Employee Readiness Core are ready to activate without any modifications. However, you can choose to edit them to meet your company’s needs. For example, you can edit the **Use duration** and **Valid for** fields to adjust the amount of time a requirement status is valid for. You can also select the **Actionable** check box to add a link for employees to complete the requirement on the Health and Safety Status page. If you’re activating a custom requirement, make sure that you select a flow in the **Requirement flow** field. You must also select a table and conditions in the **Include previous applicable records** section. You can’t activate the requirement unless these fields are populated.

3. Click **Activate**.

   After the requirement is activated, health and safety user records are created for employees or visitors who have activity for the requirement. Health and safety user records are also created for employees or visitors who have activity for the requirement before it was activated.

**What to do next**

You can view all health and safety user records by navigating to **Employee Health and Safety Status > Health and Safety Users**. The **Requirements status** column shows the employee’s or visitor’s progress towards completing all active requirements. The value is **Cleared** if the employee or visitor has fulfilled all active requirements for their current location. The value is **Not cleared** if the employee or visitor is missing any requirements.

You can also look up the requirements status for individual employees or visitors by navigating to **Employee Health and Safety Status > View Employee and Visitor Status**. The status page can be used during the employee or visitor health screening process for entering the workplace. For more information, see **Conduct a health screen for entry** and **Screen a visitor for entry to the workplace**.

**Create a health and safety requirement**

Create requirements to track when employees are ready to return to the workplace or visit a site. You can also create requirements that visitors must complete before entering the workplace.

**Before you begin**

Role required: sn_imt_core.admin

**About this task**

Use health and safety requirements to define the requirements that employees must fulfill before they can return to the workplace, or that visitors must fulfill before entering the workplace. Create separate requirements for employees and visitors. A requirement must apply to either employees or visitors, not both. Employee Readiness Core provides some **pre-built requirements**. However, you can create additional requirements using data from any of the Safe Workplace suite or Emergency Response Management apps.

Health and safety requirements are built with **Flow Designer**. Before creating a requirement, make sure that you’re familiar with the basics of ServiceNow® Flow Designer.

The following steps show how to create a requirement using the pre-built Employee Health Verification Requirement as an example.
Procedure

1. In Flow Designer, create an action to check the requirement status for an employee or visitor.

   a. Create an action. Save the action in the Employee Readiness Core application.

   b. In the Inputs section of the Action Outline, create an input for the type of record that you will use to check if the employee or visitor has fulfilled the requirement.

   For example, to fulfill the Employee Health Verification Requirement, employees must have a health verification record in the Employee Health Verification table [sn_imt_monitoring_health_verification].

<table>
<thead>
<tr>
<th>Inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Employee Health Verification</td>
</tr>
</tbody>
</table>

   c. Add a Script Step to the Action Outline.

   d. In the Required Runtime field, select Instance.

   e. Create an input variable using the input that you created for the action as the value.

   This enables you to use the input for the action in a script.

<table>
<thead>
<tr>
<th>Input Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>health_verification</td>
</tr>
</tbody>
</table>

   f. In the Script field, add a script to define the conditions when an employee's or visitor's requirement status is cleared or not_cleared.

   For the Employee Health Verification Requirement, the requirement is cleared for an employee if their health verification response is yes, and not_cleared for any other response.

   ```javascript
   (function execute(inputs, outputs) {
     outputs.requirement_status = inputs.health_verification.response == 'yes' ? 'cleared' : 'not_cleared';
   })(inputs, outputs);
   ```

   g. Create an output variable for the requirement status.

   This defines the requirement_status variable that you used in the script.
h. In the Outputs section of the Action Outline, create an output for the requirement status.
Creating this output enables you to use the requirement_status output variable from the 
script as an output returned by the action.

Output Variables

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
<th>Choice (Advanced options)</th>
</tr>
</thead>
<tbody>
<tr>
<td>requirement_status</td>
<td>requirement_status</td>
<td>Choice</td>
<td>Yes</td>
<td>Dropdown with --None--</td>
</tr>
</tbody>
</table>

i. Assign the requirement_status value to the output.

Output Variables

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement Status</td>
<td>requirement_status</td>
<td>requirement_status output variable from the script step.</td>
</tr>
</tbody>
</table>

The action returns the value of the requirement_status for the employee or visitor (cleared or not_cleared) as an output.

j. Click Publish.

2. Create a health and safety requirement.

a. Navigate to Employee Health and Safety Status > Health and Safety Requirements.

b. Click New.

c. On the form, fill in the fields.
The Include previous applicable records section defines a set of records that have already been created but should still trigger the requirement flow. Including previous records ensures that employees or visitors who complete the requirement before it is activated have their requirement status set to Cleared.

Health and Safety Requirement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the requirement. For example, Employee Health Verification Requirement.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requirement for</td>
<td>Who the requirement applies to. The options are <strong>Employee</strong> and <strong>Visitor</strong>. A requirement must apply to either employees or visitors, not both. For example, the Employee Health Verification requirement only applies to employees.</td>
</tr>
<tr>
<td>Requirement flow</td>
<td>Leave this field empty. You will return to the requirement record and fill in this field after you create the flow.</td>
</tr>
<tr>
<td>Active</td>
<td>This field is read-only. Once you update all fields for the requirement, you can use the <strong>Activate</strong> button to activate the requirement.</td>
</tr>
<tr>
<td>Default status</td>
<td>The default status is assigned to health and safety users who don’t have any activity towards completing the requirement. The options are <strong>Cleared</strong> and <strong>Not Cleared</strong>. For example, employees who don’t have a health verification record are assigned a default status of <strong>Not Cleared</strong> for the Employee Health Verification Requirement.</td>
</tr>
<tr>
<td>Use duration</td>
<td>Option to set a time limit that the requirement status is valid for.</td>
</tr>
<tr>
<td>Valid for</td>
<td>Time limit that the requirement status is valid for. For example, the Employee Health Verification Requirement status is valid for seven days. Employees must resubmit their health verification weekly to continue fulfilling the requirement. This field appears only when the <strong>Use duration</strong> field is selected.</td>
</tr>
<tr>
<td>Actionable</td>
<td>Option to add a link for employees to complete the requirement on the Health and Safety Status page.</td>
</tr>
<tr>
<td>Action name</td>
<td>The name of the action for the employee to complete the requirement. For example, <strong>Submit self-report</strong>. This name is shown on the Health and Safety Status page. This field appears only when the <strong>Actionable</strong> field is selected.</td>
</tr>
<tr>
<td>Action URL</td>
<td>The URL of the Service Catalog item that employees use to complete the requirement. For example, the Employee Health Verification Requirement is</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>completed by submitting the Health Verification form, which has the URL <code>?id=sc_cat_item&amp;sys_id=9c578864ed111010fa9b395e35885545</code></td>
</tr>
<tr>
<td>Action visibility</td>
<td>Sets when the link to complete the requirement is displayed on the Health and Safety Status page. Select <strong>Visible when false</strong> to only show the link when the employee hasn't completed the requirement, or select <strong>Always visible</strong> to always show the link.</td>
</tr>
<tr>
<td>Exclude</td>
<td>When selected, excludes all users in the <strong>Audience</strong> field from the requirement.</td>
</tr>
<tr>
<td>Audience</td>
<td>Select the audience to refine the number of users the requirement applies to. For example, you might want to target all users in an audience that happens to be located in California or target an audience you created specifically for a location, regardless of whether they are users who are traveling, visiting, or working in the location. No audience is selected by default and the requirement applies to users based on the rest of the form. <strong>Note:</strong> If <strong>Exclude</strong> is checked, the requirement targets all users except those in the audience.</td>
</tr>
<tr>
<td>Include previous applicable records</td>
<td>Table to look for previously created records that will trigger the requirement flow. For example, the Employee Health Verification Requirement uses the Employee Health Verification table <code>[sn_imt_monitoring_health_verification]</code>.</td>
</tr>
</tbody>
</table>

**d. Click Submit.**

**3. In Flow Designer, create a flow to update the requirement status for an employee or visitor.**
a. Create a new flow. Save the flow in the Employee Readiness Core application.

b. Add a trigger so that the flow runs whenever the type of record that you're using to check the requirement status is created or updated.

For example, for the Employee Health Verification Requirement, the flow runs whenever a health verification record is created or updated.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Table</th>
<th>Condition</th>
<th>Run Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created or Updated</td>
<td>Employee Health Verification</td>
<td>None.</td>
<td>For each unique change</td>
</tr>
<tr>
<td></td>
<td>[sn_imt_monitoring_health_verification]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

c. Add the action that you created to the flow. Add the record from the trigger as the input.

For example, for the Employee Health Verification input, add the Employee Health Verification record that was created or updated in the trigger event.

d. Add the Update User Requirement action provided in Employee Readiness Core to the flow.

<table>
<thead>
<tr>
<th>Update User Requirement inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>User [User]</td>
</tr>
<tr>
<td>Employee or User</td>
</tr>
<tr>
<td>field from the</td>
</tr>
<tr>
<td>trigger record.</td>
</tr>
<tr>
<td>Employee field from the</td>
</tr>
<tr>
<td>Employee Health</td>
</tr>
<tr>
<td>Health Verification</td>
</tr>
<tr>
<td>record.</td>
</tr>
</tbody>
</table>

e. Click Activate.

4. Complete the health and safety requirement.

a. Navigate to Employee Health and Safety Status > Health and Safety Requirements.

b. Click the requirement that you created earlier.

c. In the Requirement flow field, add the flow that you created to update the requirement status for employees or visitors.

d. Click Update.

What to do next
When you create the requirement, it's not active by default. You must activate the requirement before you can track whether employees or visitors have fulfilled the requirement. For instructions, see Activate a health and safety requirement.
Deactivate a health and safety requirement

If you no longer need employees to fulfill a requirement before returning to the workplace, deactivate the requirement.

Before you begin
Role required: sn_imt_core.admin

About this task
When you deactivate a requirement, all records for the requirement in the Employee Health and Safety Requirement table [sn_imt_core_employee_health_and_safety_requirement] are deleted. The requirement is no longer tracked for any employees.

Procedure
1. Navigate to Employee Health and Safety Status > Health and Safety Requirements.
2. Click the requirement that you want to deactivate.
3. Click Deactivate.

Included health and safety requirements
Employee Readiness Core provides pre-built requirements.

Requirements are not active by default. A requirement must be activated before you can track whether employees or visitors have fulfilled the requirement. Pre-built requirements provided by Employee Readiness Core are ready to activate without any modifications. However, you can choose to edit them to meet your company's needs.

Employee Health Verification Requirement
This requirement checks that employees have submitted their health verification. To fulfill the requirement, the health verification must have been submitted within the past seven days. Employees who don't have a record in the Employee Health Verification table [sn_imt_monitoring_health_verification] have a default requirement status of Not Cleared. This requirement uses data from the Employee Health Screening application. For more information, see Employee Health Screening.

Self Report Requirement
This requirement checks that employees have submitted a self report with a status of Returning to work. Employees who don't have a record in the Crisis Task table [sn_imt_quarantine_crisis_task] have a default requirement status of Not Cleared. This requirement uses data from the Emergency Self Report application. For more information, see Emergency Self Report.

Visitor Invitation Requirement
This requirement checks that visitors have agreed to follow the company safety policies outlined in their invitation email. To fulfill the requirement, the agreement must have been submitted within the past two days. Visitors who don't have a record in the Health and Safety Visitor Invitation table [sn_imt_core_visitor_invitation] have a default requirement status of Not Cleared. This requirement uses data from the Employee Readiness Core application.

Exposed Contacts Requirement
This requirement checks the status of employees who have been added to the potentially exposed contacts list of a contact tracing case and sets their health and safety requirement status. Employees with the status of Cleared in the Exposed Contacts table [sn_imt_tracing_exposed_contact] have the requirement status of Cleared. Otherwise, their status is Not Cleared.
This requirement uses data from the Contact Tracing application. For more information, see Contact Tracing.

Privacy Consent Requirement

This requirement checks that employees have responded to the privacy consent request. Employees who responded to the privacy consent as I Agree have the requirement status of Cleared. Otherwise, their status is Not Cleared. This requirement uses data from the Contact Tracing application. For more information, see Contact Tracing.

Testing Requirement Satisfied

This requirement checks the most recently submitted COVID-19 diagnostic test result for employees. Employees with a negative test result have a status of Cleared and employees with a positive test result have a status of Not Cleared. Employees without a test result or an inconclusive test result have a status of Cleared if they aren’t a potentially exposed individual in a contact tracing case and Not Cleared if they are a potentially exposed individual. However, submitting an inconclusive test result will not change an employee’s status if they have already submitted a positive or negative result. This requirement uses data from the Health and Safety Testing and Contact Tracing applications. For more information, see Health and Safety Testing.

COVID-19 Vaccine Requirement

This requirement checks that employees have received their COVID-19 vaccine. Employees who don't have a record in the Vaccine profile table [sn_imt_vaccine_vaccine_profile] have a default requirement status of Not Cleared. This requirement uses data from the Vaccination Status application. For more information, see Vaccination Status.

View your health and safety status

View your health and safety status page to check your progress on company requirements for returning to the workplace or visiting a site.

About this task

Your status page lists all the requirements that you must fulfill before you can return to the workplace or visit a site. If you’ve fulfilled any requirements that are valid for a limited amount of time, your status page shows the amount of time remaining until you must take action to complete the requirement again. If Workplace Safety Management is installed, your status page also shows your upcoming workspace reservations.

Note: Your status page shows your requirements and eligibility for your current location by default.

Procedure

1. Navigate to Employee Health and Safety Status > My Status.

   Note: To view your status page on the Now Mobile app, navigate to Health > Prepare for arrival > My readiness checklist.
2. **Optional:** Select one of your upcoming reservations and travel requests to review your eligibility for a reservation or travel request.

3. Complete any unfulfilled requirements by clicking the link next to the requirement. Some requirements might not have a link. If you need help completing the requirements, contact your organization.

**View your users' health and safety status**

View the health and safety status of your team to check their progress on company requirements for returning to the workplace.

**Before you begin**

All users can view the health and safety status of their direct reports. However, the `sn_imt_monitoring.monitoring_user` role is required to view details about team members who are not your direct reports.

All users can view the health and safety status of their direct reports. However, the `sn_imt_monitoring.monitoring_user` role is required to view details about an employee.

**Procedure**

1. Navigate to **Employee Health and Safety Status > View Team Status**.

   **Note:** To view the status page on the Now Mobile app, navigate to **Health > My Team > My Team's Safety Status**.

   The status page shows whether each user has completed all requirements for returning to the workplace.

   **Note:** A user is **Cleared** or **Not Cleared** based on the health and safety requirements of their current location.
2. **Optional:** View the specific list of requirements that a user has cleared or not cleared by clicking **View Details**.

**Invite a visitor to the workplace**

Submit a visitor invitation to send an email to your visitor with information about their upcoming visit. Before visitors can enter the workplace, they must respond to the email and agree to comply with the safety requirements and policies listed in the email.

**Procedure**

1. Open the visitor invitation form based on the type of device that you’re using.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Smartphone or tablet</strong></td>
<td>From the Now Mobile, tap <strong>Health</strong>, and under <strong>Follow These Safety Practices</strong>, tap <strong>Set up a visit</strong>.</td>
</tr>
<tr>
<td><strong>Computer</strong></td>
<td>Navigate to <strong>Employee Health and Safety Status &gt; Set up a visit</strong>.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

**Set up a visit to our company form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host employee</td>
<td>The employee who is inviting the visitor.</td>
</tr>
<tr>
<td>Location of visit</td>
<td>Workplace location of the visit.</td>
</tr>
<tr>
<td>Date of visit</td>
<td>The date of the visit.</td>
</tr>
<tr>
<td>Visitor's first name</td>
<td>Visitor's first name.</td>
</tr>
<tr>
<td>Visitor's middle name</td>
<td>Visitor's middle name.</td>
</tr>
<tr>
<td>Visitor's last name</td>
<td>Visitor's last name.</td>
</tr>
<tr>
<td>Visitor's phone</td>
<td>Visitor's phone number.</td>
</tr>
<tr>
<td>Visitor's email</td>
<td>Visitor's email address.</td>
</tr>
<tr>
<td>Visitor's company</td>
<td>The company that the visitor works for.</td>
</tr>
<tr>
<td>Reason for visit</td>
<td>The reason for the visit.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Watch list | Everyone on the watch list receives an email notification when the visit is approved or canceled.

3. Click **Submit**.

**Results**
A visitor record is created in the Health and Safety Visitors table [sn_imt_core_visitor], or updated if a record for the visitor already exists. A record is also created in the Health and Safety Visitor Invitation table [sn_imt_core_visitor_invitation].

**What to do next**
To view all of your invited visitors, navigate to **Employee Health and Safety Status > My Visitors**.

**Add a Safe Workplace audience**
Add a collection of users for Emergency Outreach notifications. Target individual users or specific users based on criteria such as location, department, or group.

**Before you begin**
Role required: sn_imt_core.admin, sn_imt_checkin.checkin_admin, or admin

**Procedure**
1. Navigate to **Employee Health and Safety Status > Safe Workplace Audience** and click **New**.
2. In the **Name** field, enter a descriptive name for the audience.

**Example**
For example, Building C Network Group or Facilities employees reporting to Bob.

3. Indicate the users who should receive notifications.

<table>
<thead>
<tr>
<th>Method</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add users manually</strong></td>
<td>Select the users that you want to add to the audience in the <strong>Users</strong> field. Click the link to add a file in the <strong>Upload file</strong> field. The header of the first column of the spreadsheet must be <strong>user_name</strong> if you upload a list of user IDs or <strong>email</strong> if you upload a list of email addresses.</td>
</tr>
<tr>
<td><strong>Upload a spreadsheet of users</strong></td>
<td>! <strong>Note:</strong> If you have more than 500 entries, split the spreadsheet into multiple files.</td>
</tr>
</tbody>
</table>
| **Use additional criteria based on common User [sys_user] table fields** | a. Select values for the **Groups**, **Roles**, **Companies**, **Locations**, or **Departments** fields.  
b. Select a value in the **Audience criteria** field.  |
<table>
<thead>
<tr>
<th>Method</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Include all of the users listed in the Users field and any additional users who fulfill at least one of the other criteria by selecting <em>Any of the criteria</em> (OR).</td>
<td></td>
</tr>
<tr>
<td>• Include only users who fulfill all selected criteria by selecting <em>All the criteria</em> (AND). Any users listed in the Users field are included in the audience only if they also fulfill all the additional criteria.</td>
<td></td>
</tr>
</tbody>
</table>

**Enter conditions in the condition builder**

**4. Click** Submit.

**Synchronize Employee Readiness Core visitors with Workplace Visitor Management**

As an administrator, synchronize the visitor tables in the Employee Readiness Core and Workplace Visitor Management applications.

**Before you begin**

To successfully enable visitor synchronization between Employee Readiness Core and the Workplace Visitor Management application in Workplace Service Delivery, note the following requirements:

- The Workplace Visitor Management application must be installed. For more information, see Install Workplace Visitor Management.
- Ensure your organization has a data backup before running the Sync Visitors fix script. Otherwise, syncing is not reversible.

Role required: admin or sn_imt_core.admin

**About this task**

To maintain consistent data on visitors, organizations may synchronize data between the Employee Readiness Core `sn_imt_core_visitor` table and the `sn_wsd_visitor_visitor` table in Workplace Visitor Management.
An initial synchronization using the Sync Visitors fix script is required before updates are synced automatically. Newly added fields to either visitor table are ignored by the fix script while existing fields are left as-is. Administrators with the script_include_admin role may customize the VisitorSyncing and WSDVisitorSyncing script includes called by the fix script to meet their organization’s needs, for example, to accommodate new fields added to the visitor tables. Administrators must run the fix script after performing any customizations to the script includes.

Any data conflicts are resolved by using the most recent changes to a table. After the tables are synchronized, updates to one table automatically are reflected on the other.

**Important:** Do not delete visitors from the Employee Readiness Core sn_imt_core_visitor table because they do not sync back to Workplace Visitor Management. Deletions from the sn_wsd_visitor_visitor table are performed when you anonymize a visitor. Anonymized data does sync to the sn_imt_core_visitor table. For more information on anonymizing visitors or deleting visitor data in Workplace Visitor Management, see Anonymize a visitor.

Synchronization can be disabled; however, the initial sync is irreversible without a backup.

**Procedure**

1. Unless the sn_imt_core.visitor_syncing property is already enabled and the initial fix script run was completed, enable this property. This property controls visitor syncing between visitors in Employee Readiness Core and Workplace Visitor Management. It is disabled by default.
   b. Set the sn_imt_core.visitor_syncing property to Yes.
   c. Click Save.

2. Navigate to System Definition > Fix Scripts.

3. Open the Sync Visitors fix script from the list.

4. If the Active check box for Sync Visitors is not selected, select it and click Update.

5. Click Run Fix Script.

**Results**

Visitor records synchronize between the Employee Readiness Core visitor table and the sn_wsd_visitor_visitor table in Workplace Visitor Management.

**Trouble?**

If your organization wants to disable synchronization, navigate to Employee Health and Safety Status > Properties, clear the sn_imt_core.visitor_syncing check box, and click Save.

**My Safe Workplace**

Use the ServiceNow® My Safe Workplace page to view all of your information and resources for returning to the workplace. Manage your requirement status for workplace entry, update your health status, track workspace reservations, and create requests for PPE or testing.

To view My Safe Workplace, navigate to Employee Health and Safety Status > My Safe Workplace.
# My Safe Workplace

## Manage your overall status

Adela Cervantsz

- Self Report Requirement
- Testing requirement satisfied
- Exposed Contacts Requirement
- Employee Health Verification Requirement: Valid until 2020-11-13

**Current status:** Returning to work

![Profile Picture]

### Widget Description

**Manage your overall status**

View whether you’re cleared to enter the workplace based on your completion of entry requirements for your current location.

**Submit an update about your health status**

View and update your current health status. Managers can also view and update the health status for their direct reports. For managers, this widget is called **Submit an update about a person’s health status.**

## Widget Details

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Manage your overall status</strong></td>
<td>View whether you’re cleared to enter the workplace based on your completion of entry requirements for your current location.</td>
</tr>
<tr>
<td><strong>Submit an update about your health status</strong></td>
<td>View and update your current health status. Managers can also view and update the health status for their direct reports. For managers, this widget is called <strong>Submit an update about a person’s health status.</strong></td>
</tr>
</tbody>
</table>
### Widget Description

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track your reservations</td>
<td>The <strong>Upcoming reservation</strong> tab shows your next workspace reservation. The <strong>All reservations</strong> tab shows your next five reservations. Click <strong>Reserve a space</strong> to create a new reservation to reserve a space for a day.</td>
</tr>
<tr>
<td>Things you can request</td>
<td>You can take the following actions.</td>
</tr>
<tr>
<td></td>
<td>• Submit a list of daily contacts for contact tracing</td>
</tr>
<tr>
<td></td>
<td>• Submit a user privacy consent form for contact tracing</td>
</tr>
<tr>
<td></td>
<td>• Submit a health verification about your health status and compliance with safety policies</td>
</tr>
<tr>
<td></td>
<td>• Screen a visitor for entry</td>
</tr>
<tr>
<td></td>
<td>• Invite a visitor</td>
</tr>
<tr>
<td></td>
<td>• Request permission to travel</td>
</tr>
<tr>
<td></td>
<td>• Request a COVID-19 diagnostic test or report your test results</td>
</tr>
<tr>
<td></td>
<td>• Request personal protective equipment (PPE) such as masks, gloves, or goggles</td>
</tr>
<tr>
<td></td>
<td>• Reserve shifts and workspaces</td>
</tr>
<tr>
<td></td>
<td>• Schedule your arrival time at a workplace</td>
</tr>
</tbody>
</table>

If some ServiceNow® Safe Workplace suite applications are not installed, some requests may not be available.

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Track the status of your travel, health testing, workspace reservation, and PPE requests.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View your team's status</td>
<td>View whether your direct reports are cleared to enter the workplace. This widget is only displayed for managers and reflects a user's status for their current location.</td>
</tr>
<tr>
<td>Key resources</td>
<td>View featured knowledge articles.</td>
</tr>
</tbody>
</table>

**Set up My Safe Workplace**

Add or remove widgets that employees can view on My Safe Workplace.

**Before you begin**

Role required: admin

**About this task**

My Safe Workplace uses widgets from ServiceNow® Safe Workplace suite applications.

- The **Submit an update about your health status** widget requires the ServiceNow® Emergency Self Report application.

- The **Track your reservations** widget requires the ServiceNow® Workplace Safety Management application.

If these applications are not installed, by default there are blank spaces in My Safe Workplace where the corresponding widgets would be displayed. Complete the setup steps to remove any blank spaces.

My Safe Workplace also has widgets for employees to create and track requests. The requests use features from the following Safe Workplace suite applications.

- ServiceNow® Contact Tracing
- ServiceNow® Employee Health Screening
• ServiceNow® Employee Readiness Core
• ServiceNow® Employee Travel Safety
• ServiceNow® Health and Safety Testing
• ServiceNow® Workplace PPE Inventory Management
• ServiceNow® Workplace Safety Management

If some of these applications are not installed, employees can still use the widgets to create and view requests based on the applications that are installed. Install the remaining applications to give employees access to all request types.

Procedure
1. Navigate to Service Portal > Service Portal Configuration.
2. Click Designer.
4. Adjust the page layout to remove any blank spaces. You can also remove any widgets that you don’t want to use, or add new widgets.
   For detailed instructions, see Create and edit a page using the Service Portal Designer.

What to do next
To complete the setup, make sure that employees have the required roles to view the widgets.

• The Submit an update about your health status widget requires the sn_imt_quarantine.crisis_task_user role.
• The Track your reservations widget requires the sn_wsd_core.workplace_user role.
• The View your team's status widget is only displayed for managers. The sn_imt_monitoring.monitoring_user role is required for managers to view details about their direct reports.
• There are no required roles for all other My Safe Workplace widgets.

Maintaining privacy consent in Employee Readiness Core
The Employee Readiness Core application enables your organization to maintain the data privacy of all employees and obtain consent to various privacy policies in Safe Workplace suite applications.

Manage your organization’s privacy policies with Employee Readiness Core:
• Create and manage privacy consent templates for your various privacy policies.
• Manage location-based privacy configurations and assign templates to various regions.
• Review the consent status to see whether an employee has agreed, disagreed, withdrawn consent, or not responded.
• Use Emergency Outreach to send email and mobile push notifications for employees to consent to privacy policies.
• Enable users to consent to privacy policies when reporting diagnostic test results with Health and Safety Testing.

Employers remain solely responsible for complying with their legal obligations under applicable law, including data protection laws on collection, use, disclosure, and retention of personal data, and should enable, choose not to enable, or customize any functionality available within the application to meet the Employers’ specific requirements.
Setting up privacy consent settings

As an administrator, you can configure privacy consent templates, location-based privacy configurations, and notifications used to send privacy consent alerts for Safe Workplace suite applications.

With Employee Readiness Core, you can configure various privacy policies such as those governing the use of data or test results, or to track health status, and send notifications to employees seeking consent to the use of their data.

User privacy regulations vary from country to country. For some countries, consent by employees to use their data is not required but for others it is a must. You can set different privacy policies for different locations and organization setups. Some organizations maintain a separate privacy policy for each location while others maintain a single privacy policy for all locations.

As an administrator, you must configure the following settings to use privacy consents with Employee Readiness Core:

1. Modify or create a privacy consent template.
2. Generate or locate privacy-based configurations.
3. Assign the sn_imt_core.privacy_consent_user role to all users who must respond to a privacy policy.
4. Add all users who must respond to a privacy policy to a Safe Workplace audience.

⚠️ Note: For more information, see Add a Safe Workplace audience.

Modify or add a privacy consent template

Modify or add a privacy consent template to be used in the location privacy configuration for Safe Workplace suite applications.

Before you begin
Role required: sn_imt_core.admin

Procedure

1. Navigate to Employee Health and Safety Status > Privacy > Privacy Consent Templates.
2. Open a template record to modify it or click New to create one.
3. Enter a unique name of the template in the Name field.
4. Enter the privacy policy statement in the Privacy statement field.
   - If the privacy policy is different for different locations, create one template for each location and specify the policy statement for that location.
   - If your organization has a single policy for all locations across the globe, update the default template.
5. Click Submit.

Generate location-based privacy configurations

As an administrator, generate the privacy configuration for locations set up in your instance to use with Safe Workplace suite applications.

Before you begin
Role required: sn_imt_core.admin
About this task
You can generate a location-based, default privacy configuration for each country available in the Locations [cmn_location] table. For each location, you can specify whether the privacy consent is required and update the privacy policy statement.

Procedure
1. Navigate to Employee Health and Safety Status > Privacy > Location Privacy Configuration.
2. Click Generate Location Configurations. The default configuration is created for each country and appears in the Location Privacy Configurations list.
3. Open a location to review its configuration and modify it if necessary.
4. Configure the privacy consent text if necessary.

<table>
<thead>
<tr>
<th>Privacy consent status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consent is not required for the location</td>
<td>Clear the Needs privacy consent check box.</td>
</tr>
<tr>
<td>Consent is required for the location</td>
<td>Determine the privacy consent text.</td>
</tr>
<tr>
<td></td>
<td>• If you have defined a specific privacy consent template to assign to this location, select it from the Privacy consent template.</td>
</tr>
<tr>
<td></td>
<td>The privacy statement content from the updated template is copied into the Privacy statement field.</td>
</tr>
<tr>
<td></td>
<td>• Retain the default privacy statement text and make any modifications.</td>
</tr>
</tbody>
</table>

5. Click Update.

Send an Emergency Outreach notification for employee privacy consents
Send an Emergency Outreach notification, on demand, to employees to provide a privacy policy and seek consent to use of their data in accordance with the privacy policy.

Before you begin
Ensure that you have the Emergency Outreach application installed. For details, see Install Emergency Outreach.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Role required: sn_imt_checkin.checkin_admin

About this task
**Important:** The privacy consent notification is sent to a user only once even if the user is in the target audience of multiple privacy consent notifications.

Procedure
1. Navigate to Emergency Outreach > View Outreaches.
2. Review and edit an existing outreach record or click New to create one.
3. On the Safe Workplace Audience tab, select the audience from the list and click Save.
If you don’t have an audience defined, click **New** and define an audience from user lists, groups, departments, locations, and so on. After you save the Safe Workplace audience, you can use it to send any outreach message.

4. On the **Content configuration** tab, select **Privacy Consent (common)** in the **Response mode** field.

5. On the **Content configuration** tab, select a **Privacy consent template**.

6. Optional: Enable the outreach to provide location-specific privacy consents by selecting the **Use Country** check box on the Content configuration tab.

   (Optional) When enabled, the privacy statement text in Location Privacy Configuration takes precedence over text in the privacy consent templates. This text is used for the outreach, system notification email, and push notification. If you need to update the text users receive, you must change the location’s privacy statement.

   For more information on updating a location’s privacy statement, see [Generate location-based privacy configurations](#).

7. Select a notification in the **Notification** field and choose how to send the notification.

   ![Note:](image)

   The default **Notification** is the **User Privacy Consent (Core)** that references the [sn_imt_core_user_privacy_notice_and_consent](#) table.

   - To send the notification by email, select the **Email notification** check box.
   - To send a mobile push notification, select the **Now Mobile Push notification** check box.

   This option is available only if the ServiceNow NowMobile App Screens and Applet Launcher (com.glide.mobile-employee) plugin is activated.

   Push notifications use the ServiceNow Request Application notification device. When a user registers their mobile application to an instance, this notification device is automatically created in their notification preferences. Ensure that this device is active for the users that you want to receive the push notification.

8. Review the message content.

   - For email notifications, review the email subject and email body and modify it if necessary.
   - For push messages, review the **Push message** and **Detailed Push message** fields.

9. Click **Update**.

   The target audience and content configuration changes are saved.

10. To send the notification, click **Send Notification**.

### Results

The notification is sent to the target audience.

![Note:](image)

The outreach notification is not sent to any users in the selected audience who do not have a location set in their user profile or whose privacy consent is disabled in the location privacy configuration.

If you need to resend the notification, navigate to **Emergency Outreach > View Outreaches**, select the outreach, and click **Resend Notification**.

### Submitting privacy consents

When you receive an email or mobile notification for a privacy consent, read the privacy policy statement and submit a response indicating whether you agree to the use of your data.
Respond to an email notification request for privacy consent

When you receive an email notification for privacy consent, read the privacy policy statement and submit a response indicating whether you agree to the use of your data.

Before you begin
Role required: sn_imt_core.privacy_consent_user

Procedure
1. Open the link contained in the notification for privacy consent.
2. Read the privacy policy statement in the Privacy Notice field.
3. Select your response and click Submit.
   - If you agree to the privacy policy and use of your data, select I Agree.
   - If you do not want the organization to use your data, select I Disagree.

Note: If you previously agreed to the privacy consent, a Withdraw Consent option is available. You can change your response to withdraw your consent by selecting Withdraw Consent and clicking Submit.

Results
Your current privacy consent decision is updated. The status of the notification updates to Acknowledged.

If you have a health and safety requirement for the privacy consent activated, a record is created with the requirement status.
   - If you agreed to the privacy policy and use of your data, the requirement status updates to Cleared.
   - If you disagreed or withdrew your consent, the requirement status updates to Not Cleared.

Submit a privacy consent from a mobile phone

If you receive a mobile push notification request for a data privacy consent, read the privacy policy statement and indicate whether you agree to the use of your data in accordance with the policy.

Before you begin
To receive mobile push notifications, you must have the Now® Mobile app.
Role required: sn_imt_core.privacy_consent_user

Procedure
1. Tap the notification to open the message.
2. In the message, tap View privacy consent.
3. Read the privacy policy statement in the Privacy Notice field.
4. Select your response and click Submit.
   - If you agree to privacy policy and use of your data, select I Agree.
   - If you do not want the organization to use your data, select I Disagree.
**Note:** If you previously agreed to the privacy consent, the **Withdraw Consent** option is available. You can change your response to withdraw your consent by selecting **Withdraw Consent** and clicking **Submit**.

**Results**
Your current privacy consent decision is updated. The status of the notification updates to **Acknowledged**.

If you have a health and safety requirement for the privacy consent activated, a record is created with the requirement status.

- If you agreed to the privacy policy and use of your data, the requirement status updates to **Cleared**.
- If you disagreed or withdrew your consent, the requirement status updates to **Not Cleared**.

**Review user privacy consents**
Review user privacy consent responses submitted by employees indicating their response to requests for consent to use their data in accordance with a privacy policy.

**Before you begin**
Role required: sn_imt_core.admin

**Procedure**
1. Navigate to **Employee Health and Safety Status > Privacy > User Privacy Consents**.
2. Click the status in the **Consent status** column to open the employee's consent record.
3. Review the employee's responses in the Consent History related list.
• **I Agree:** Employees have responded and agreed to have their data used.
• **I Disagree:** Employees have responded and have not agreed to have their data used.
• **Withdraw Consent:** Employees previously agreed to have their data used but later withdrew the consent.
• **Awaiting Response:** Employees have not responded yet.

**Note:** The consent history record with the latest preference submitted date is the last response from the employee.

You can send the notification again to employees who have not yet responded.

**Enterprise Employee Experience Pack**

Enterprise Employee Experience Pack is a new store application that delivers preconfigured process flows and sample content to help you quickly implement enterprise-wide use cases across multiple departments.

**Return to Workplace Location Readiness and Employee Return to Workplace lifecycle events**

The Return to Workplace Location Readiness and Employee Return to Workplace lifecycle events are part of the Enterprise Employee Experience Pack application. These lifecycle events work with other applications to help you administer and coordinate your employees' return to the workplace in a manner that promotes your company's safety requirements.

Bringing your workforce back into your reopened office after a closure requires that you do the following:

• Prepare your employees for returning to the workplace.
• Prepare your offices to be ready and safe for the return of your employees.

Enterprise Employee Experience Pack is an application that works with:

• **HR Service Delivery**
  ◦ For more information on using HR Service Delivery, see [HR Service Delivery](#).

• **Lifecycle Events**
  ◦ For more information on using Lifecycle Events, see [Understanding Enterprise Onboarding and Transitions](#).

• **Content Automation**
  ◦ For more information on using Content Automation, see [Campaigns for HR Service Delivery](#).

• **Content Delivery**
  ◦ For more information on using Content Delivery, see [Employee content publishing and delivery](#).

• **HR Knowledge Management**
  ◦ For more information on using HR Knowledge Management, see [HR Knowledge Management](#).

• **Employee Service Center or Service Portal**.
  ◦ For more information on using the Employee Service Center (ESC), see [Employee Service Center](#).
  ◦ For more information on using the Service Portal, see [HR Service Portal](#).
Note: Some of the configurations are installed conditionally based on specific plugin activation.

Store applications
For full functionality, Enterprise Employee Experience Pack works with:
• Emergency Exposure Management
• Contact Tracing
• Workplace PPE Inventory Management
• Employee Health Screening
• Workplace Safety Management

Install Enterprise Employee Experience Pack
You must have the admin role to install the Enterprise Employee Experience Pack application.

Before you begin
To access and use Enterprise Employee Experience Pack, the following plugins must be activated:
• Human Resources Scoped App: Lifecycle Events for Enterprise (com.sn_hr_lifecycle_ent)
• Knowledge Management Advanced Installer (com.snc.knowledge_advanced.installer)

The following plugins are activated automatically:
• Human Resources Scoped App: Core (com.sn_hr_core)
• Human Resources Scoped App: Integrations (com.sn_hr_integrations)
• Human Resources Scoped App: Lifecycle Events (com.sn_hr_lifecycle_events)
• Human Resources Scoped App: Mobile (com.sn_hr_mobile)
• Human Resources Scoped App: Mobile Onboarding (com.sn_hr_onboarding)
• Human Resources Scoped App: Security (com.snc.hrScoped_security)
• Content Automation (com.sn_content_automation)
• Content Delivery (com.sn_content_delivery)
• Employee Service Center (com.sn_hr_service_portal)

Note: If Restricted Caller Access (RCA) errors appear, you may be required to allow additional RCA privileges. For more information, see Restricted caller access privilege settings.

Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Enterprise Employee Experience Pack.
3. Click Install.
   The Application installation dialog box opens.
4. Optional: Load the demo data by selecting the Load demo data check box.
For information about how to install or reinstall demo data after the initial installation, see the Work around to install demo data if application is already installed [KB0722909] article in the Now Support Knowledge Base.

5. Click Install.

6. When the installation is complete, click Close.

Return to Workplace campaigns

Use campaigns to deliver important messages and information to your employees that are going through the Return to Workplace process.

For employees that have communicated that they are ready to return to the workplace, you can target them with specific emails or content on your Service Portal or Employee Service Center.

Campaigns are created in Content Automation and use Content Delivery to present information on the Service Portal or Employee Service Center. Emails are created and sent through Content Automation.

Note: For more information on Content Automation, see Campaigns for HR Service Delivery and for Content Delivery, see Employee content publishing and delivery.

Campaign structure

Campaign structure looks like a pyramid with the campaign at the top. A campaign contains campaign bundles. Each campaign bundle contains the content that you want to present to your employees. For example:

• Campaign
  ◦ Campaign Bundle
  • Campaign Content

The following campaign is part of this application:

Return to Workplace

The Return to Workplace campaign helps keep your employees informed during the return to work planning process.

The target audiences for this campaign are the employees with information on their HR profiles indicating they’re ready to return to work and have a specific return date. For more information, see Add or modify an HR profile.

The Return to Workplace campaign contains the following bundles and content:
• Announce and Plan Return
  ◦ Return to Workplace - Get Ready to Return Banner: Provides a banner on the Service Portal or Employee Service Center that links to the Return to Workplace Company Updates (KB0088880) knowledge base (KB) article. You can find this KB article by navigating to Knowledge > Articles > All and searching for KB0088880. The link to the KB article is configured in Link Content under Content Delivery. For more information, see Add or modify links to other content sources.
  ◦ Return to Workplace sample Notification: Sends an email with a sample message on returning to the workplace. The email uses notification content created in Content Delivery. For more information, see Add or modify notification content.
  
  The Announce and Plan Return campaign bundle triggers dynamically based on a trigger table and fields. For more information, see Create campaign bundles.

• Welcome back to the workplace
  ◦ Return to Workplace - Welcome Back Notification: Provides a sample email communicating information about plans to reopen the office. The link in the email points to the Workplace Health and Safety Policy FAQ knowledge article (KB0088882). You can find the KB article by navigating to Knowledge > Articles > All and searching for KB0088882. The link to the KB article is configured in Link Content under Content Delivery. For more information, see Add or modify links to other content sources.
  ◦ Return to Workplace Welcome Back: Provides a banner on the ESC with a link to the Social distancing and safety tips for common workspaces FAQ (KB0088883) article. You can find the KB article by navigating to Knowledge > Articles > All and searching for KB0088883. The link to the KB article is configured in Link Content under Content Delivery. For more information, see Add or modify links to other content sources.
  
  The Welcome back to the workplace bundle triggers dynamically based on a trigger table and fields. For more information, see Create campaign bundles.

Accessing the Return to Workplace campaign

View and edit the campaign content and campaign bundles in the Return to Workplace campaign.

Before you begin
You may choose to clone a campaign before making edits.

For more information on cloning, editing, and publishing a campaign, see Campaigns for HR Service Delivery.

Role required: sn_ca.campaign_manager

Procedure
1. Navigate to Content Automation > Campaigns.
2. Select Return to Workplace. You may choose to clone the campaign before editing. Scroll down to see the Campaign Bundles and Campaign Content tabs.
3. Click a campaign bundle or campaign content to edit.
4. After making edits, click Update.

Return to Workplace Location Readiness and Employee Return to Workplace lifecycle events

Lifecycle events enable you to automate a collection of activities to help prepare your employees and your workplace for the return to work.
The target audiences for these lifecycle events are employees with information in their HR profiles indicating that they’re ready to return to work and have a specific return date. For more information, see Add or modify an HR profile.

**Enterprise Employee Experience Pack structure**

The employee experience packs under Enterprise Employee Experience Pack are set up from a lifecycle event. Each employee experience pack consists of multiple activity sets. Each activity set contains one or more activities. For example:

- **Lifecycle Event**
  - **Activity Sets**
  - **Activities**

For more information on lifecycle events, see Understanding Enterprise Onboarding and Transitions.

**Accessing the lifecycle events**

Access the Employee Return to Workplace and Return to Workplace Location Readiness employee experiences from Lifecycle Events.

**Before you begin**

Role required: sn_hr_le.activity_writer

**Procedure**

1. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events.
2. From the Manage Lifecycle Events list, select Employee Return to Workplace or Return to Workplace Location Readiness.
Employee Return to Workplace lifecycle event

The Employee Return to Workplace lifecycle event helps to verify that your employees who are working from home are ready to return to the workplace. The Employee Return to Workplace lifecycle event provides you with preconfigured process flows, activity sets, activities, templates, and sample content items.

Important Note: Clone this lifecycle event prior to updating it with your company's specific information. For more information on cloning, see Clone a lifecycle event.

HR case

These HR cases start the Return to Workplace process.

- Request for Employee to Return to Workplace
- Request to prepare a workplace to reopen

Employees, managers, or HR agents can use the Employee Service Center or Service Portal to create the HR case. HR agents can also use the HR case form.

After the HR case is created and in the Ready state, a survey is sent to the employee. The first activity in the Employee Return to Workplace lifecycle event is the Employee Readiness Assessment.

Employee Return to Workplace - Lifecycle Event

Contains the following activity sets:

Notify Employees - Activity Set

Contains the following activity:

- Employee Readiness Assessment: An HR task for employees that collects feedback using the Employee Readiness Assessment HR survey.
  - The first question on the survey is: How do you feel about a possible return to your workplace?
  - The answer provided by the employee maps directly to the HR case form and HR profile of the employee.
If the employee answers Yes and provides a date of return, the Get ready to return activity set triggers. The employee becomes part of the User has Return to Workplace date audience.

If the employee answers I'm not ready to return or I'm not sure, an HR task is assigned to an HR agent. The employee becomes part of the Employee Return to Workplace audience.

Get ready to return - Activity Set
Contains the following activities:

• Review workplace health & safety guidelines: An HR task for employees that provides a URL link to a knowledge base (KB) article. The KB article provides workplace health and safety guidelines.
• Reactivate badges and parking passes: An HR task for agents to verify that work badges and parking passes are activated for employees.
• Review employee’s concerns about returning to the workplace: An HR task for agents to review the employee readiness assessments.
• Self-service space reservation: An HR task for employees that provides a URL to select a shift or reserve space to work.

Final Prep - Activity Set
Contains the following activities:

• Packing checklist for returning to the workplace: An HR task for employees to confirm that a checklist of items is completed before returning to work.
• Employee Health and Safety Prep activities:
  ◦ Request PPE: An optional HR task for employees requesting Personal Protective Equipment (PPE).
  ◦ Complete Health Verification: An HR task for employees to complete their health verification form prior to working on site.

Back at the workplace - Activity Set
Contains the following activities:

• Check in any borrowed equipment to IT: An HR task for employees to return any borrowed IT equipment while working from home.
• Complete contact log: An HR task for the employee to complete their daily contact log after their first day back in the office.

Follow Up - Activity Set
Contains the following activities:

• Employee Feedback: An HR task assigned to employees that collects feedback using the Feedback on your Return to Workplace Experience survey.

Return to Workplace Location Readiness lifecycle event
The Return to Workplace Location Readiness lifecycle event helps you confirm that your workplace is ready for employees to return safely.

The Return to Workplace Location Readiness lifecycle event provides you with preconfigured process flows, activity sets, activities, templates, and sample content items.
The structure for Return to Workplace Location Readiness is hierarchical with the lifecycle event at the top.

**Return to Workplace Location Readiness - Lifecycle Event**

Provides basic information about the lifecycle event like title, description, active, if the subject person on a case can view it, and the type.

These activity sets appear under the lifecycle event.

**Task Force Initiation - Activity Set**

Contains the following activities:

- Schedule location team training meeting: An HR task for agents to verify scheduling of workplace readiness training.
- Order additional supplies: An HR task that provides a checklist to agents to confirm supplies for returning to work are ordered.

**Update space and equipment - Activity Set**

Contains the following activities:

- Test devices in common areas: A catalog item assigned to agents to verify equipment in common areas like printers or fax machines are connected and working.
- Install protective materials in common areas: An HR task for agents to confirm that protective materials and equipment are installed in common areas.
- Request deep clean from cleaning services: An HR task for agents that provides a checklist to follow for requesting sanitation services for reopening your workplace.

**Final Readiness Check**

Contains the following activities:
• Conduct health and safety inspection: An HR task for agents to verify completion of a health and safety inspection.

• Create communication materials for the reopening location: An HR task for agents to create communication materials providing information on your workplace reopening.

• Go or No Go Decision: An HR service that contains an HR task that provides agents with a checklist to follow and help determine if their workplace should reopen. There is also an approval activity type to determine moving to the next activity set.

Location Reopens
Contains the following activity:

• Safety volunteers morning standup: An HR task for safety volunteers to meet prior to the reopening of your workplace location.

Return to Workplace Knowledge Management
Knowledge Management provides information to your employees during the return to workplace process.

Providing links to knowledge base (KB) articles enables your employees to be self-sufficient, answer common questions, and helps with the efficiency of the process.

The following knowledge articles are provided with Enterprise Employee Experience Pack. You can edit these articles, or substitute your own articles.

• Return to Workplace Company Updates (KB0088880)
  ◦ Found in the Return to Workplace - Get Ready to Return Banner content, under the Announce and Plan Return campaign bundle.

• Manager Guide to Return to Work (KB0088881)
  ◦ Sample KB article not used in campaigns or lifecycle events.

• Social distancing and safety tips for common workspaces FAQ (KB0088883)
  ◦ Found in the Return to Workplace - Welcome Back Notification campaign content, under the Welcome back to the workplace campaign bundle.

• Workplace Health and Safety Policy FAQ (KB0088882)
  ◦ Found in the Review workplace health & safety guidelines activity, under the Get ready to return activity set, under the Employee Return to Workplace lifecycle event.
  ◦ Also found in the Return to Workplace Welcome Back campaign content, under the Welcome back to the workplace campaign bundle.

For more information on using HR Knowledge Management, see HR Knowledge Management.

Accessing the Return to Workplace knowledge articles
Create or modify knowledge articles to share information across your organization.

Before you begin
Role required: knowledge_admin

Procedure
1. Navigate to Knowledge > Articles > All.
2. Select a knowledge article to edit.
3. Click Checkout.
4. Make your edits.
5. Click **Update**.

**Employee Travel Safety**

Use the ServiceNow® Employee Travel Safety application to help support safe travel for employees by verifying the site safety and policy compliance of destinations, monitoring employee health status, and keeping a contact log during travel.

Before booking travel in a travel management system, employees request permission for their trips. The employee’s manager or a designated travel approver can approve or reject the travel request based on COVID-19 case data and a site safety evaluation for the destination.

When an employee’s travel request is approved, monitor their health status using a daily health verification that the employee submits before and during the trip. Employees can also keep a daily contact log for the duration of the trip to track potential exposure.

**Use with other Safe Workplace suite applications**

Employee Travel Safety is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

- With the **Employee Readiness Surveys** application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.

- Before users re-enter workspaces, use the **Employee Health Screening** application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.

- With the **Workplace Safety Management** application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.

- You can manage the inventory of safety equipment for your workforce with the **Workplace Personal Protective Equipment Inventory Management** application.

- With the **Contact Tracing** application, evaluate the readiness of your users to return to the workplace by using data such as badge scans, Wi-Fi access logs, and daily contact logs to help identify potential user interactions.

All Safe Workplace suite applications are available in the ServiceNow Store.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications.
on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

### Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

### Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

### Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.
Install Employee Travel Safety
You can install Employee Travel Safety if you have the admin role.

Before you begin
Employee Travel Safety requires the following applications.

- ServiceNow® Employee Readiness Core
- ServiceNow® COVID-19 Global Health Data Set

The ServiceNow® Employee Health Screening and ServiceNow® Emergency Outreach applications can optionally be installed to have employees complete a daily health verification before and during travel.

The ServiceNow® Contact Tracing and Emergency Outreach applications can optionally be installed to have employees complete a daily contact log during travel.

Role required: admin

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
• Employee Travel Safety (sn_imt_travel)
• Health and Safety Testing (sn_imt_health_test)
• Vaccination Status (sn_imt_vaccine)

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Employee Travel Safety.
3. Click Install.
   The Application installation dialog box opens.
4. Click Activate.

Components installed with Employee Travel Safety
Several types of components are installed with Employee Travel Safety, including user roles and tables.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Travel Safety admin</td>
<td>Role required to set up Employee Travel Safety properties.</td>
<td>• sn_imt_travel.approver</td>
</tr>
<tr>
<td>[sn_imt_travel.admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Travel approver</td>
<td>Role required to view and approve travel requests for all employees. This role is assigned to the Travel Approvers group.</td>
<td>• approver_user</td>
</tr>
<tr>
<td>[sn_imt_travel.approver]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Managers must be assigned the approver_user role to approve travel for the employees that they supervise. Don’t assign managers the sn_imt_travel.approver role unless it’s acceptable for them to view and approve travel requests for all employees.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Travel Safety Request</td>
<td>List of all employee travel requests.</td>
</tr>
<tr>
<td>[sn_imt_travel_request]</td>
<td></td>
</tr>
</tbody>
</table>
Configure Employee Travel Safety

Complete all configuration tasks to ensure that travel notifications and approvals are set up correctly for your company.

Set up travel approvers

Set up user groups and roles so that employee travel can be approved by managers or by designated travel approvers.

Setting up manager approval or designated approvers is a required configuration step for the Employee Travel Safety application.

Manager approval

To set up travel approval by managers, assign the approver_user role to all managers. With this role, managers can only view and approve travel requests for the employees they directly supervise.

Designated approvers

To set up designated travel approvers, add users to the Travel Approvers group. Members of this group can view and approve travel requests for all employees. Don't add managers to the Travel Approvers group unless it's acceptable for them to view and approve travel requests for all employees.

By default, a travel request must be approved by both the employee's manager and a member of the Travel Approvers group. If the employee doesn’t have a manager listed in your ServiceNow instance or there are no users in the Travel Approvers group, one approval is enough to approve the travel request. An employee's travel request is automatically rejected if the employee doesn't have a manager listed in your ServiceNow instance and there are no users in the Travel Approvers group. For information about changing the default approval settings, see Modify the travel approval flow.

Set up Employee Travel Safety properties

Set up Employee Travel Safety properties to ensure that site safety verification emails, employee contact logs, and employee health verifications are managed according to your company's requirements.

Before you begin

Role required: sn_imt_travel.admin

About this task

Setting up the Employee Travel Safety properties is a required configuration step for the Employee Travel Safety application.

Procedure

1. Navigate to Employee Travel Safety > Properties.
2. Set the following property values.

<table>
<thead>
<tr>
<th>Employee Travel Safety properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the company's travel management system. [sn_imt_travel.travel.management.system.name]</td>
<td>Name of your company's travel management system. This property is used to provide employees who are approved for travel with a link to the travel management system.</td>
</tr>
<tr>
<td>URL of the company's travel management system. [sn_imt_travel.travel.management.system.url]</td>
<td>URL of your company's travel management system. This property is used to provide</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email travel contacts to ask them to verify site safety and policy compliance. [sn_imt_travel.email_site_verification]</td>
<td>When enabled, an email is sent to the primary contact that an employee provides on their travel request to verify site safety and policy compliance. The contact must respond to the email before the travel request can be approved by a manager or travel approver.</td>
</tr>
<tr>
<td>Comma-separated list of affirmative responses. [sn_imt_travel.affirmative_email_responses]</td>
<td>Defines the responses that are accepted as Yes responses for site verification emails.</td>
</tr>
<tr>
<td>Enables sending email reminders to travel request approvers for requests pending approval. [sn_imt_travel.enableApprovalEmailReminders]</td>
<td>When enabled, email reminders are sent to travel approvers and managers for travel requests that haven’t been approved or rejected.</td>
</tr>
<tr>
<td>Length of time (in hours) to wait before sending travel request approvers a reminder. Default is 48. [sn_imt_travel.approvalEmailReminderPeriod]</td>
<td>Sets the frequency of email reminders that are sent to travel approvers and managers. For example, when this property is set to 48, travel approvers and managers will receive a reminder every 48 hours after a travel request is submitted until it is approved or rejected. This property requires that the sn_imt_travel.enableApprovalEmailReminders property is enabled.</td>
</tr>
<tr>
<td>Enables outreach to relevant employees about travel-related health verifications. [sn_imt_travel.daily.healthverification.outreach.flag]</td>
<td>When enabled, employees who are approved for travel receive notifications to complete a health verification. To set the frequency of the notifications, select a value for the sn_imt_travel.healthverification.run.type property. For more information about employee health verification, see Employee Health Screening.</td>
</tr>
<tr>
<td>Choose whether Health Verifications will be sent to requester only once or daily. [sn_imt_travel.healthverification.run.type]</td>
<td>Sets the frequency of the health verification notifications that are sent to employees who are approved for travel. To send daily notifications before and during travel, select Send Daily. To send a notification once after the travel request is approved, select Send Once. Health verification notifications are only sent if the sn_imt_travel.daily.healthverification.outreach.flag property is enabled. Note: Employees who are already enrolled in daily health verifications before their travel request is approved will see no change. They will not receive additional notifications and they will still be enrolled after their trip is complete.</td>
</tr>
</tbody>
</table>
| Cancels a travel request if a health verification is not completed after a number of hours. | When enabled, travel requests are canceled if employees do not complete
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_imt_travel.allow.cancellation]</td>
<td>a health verification by the deadline. Enabling this property requires that the sn_imt_travel.daily.health.verification.outreach.flag property is also enabled.</td>
</tr>
<tr>
<td>For automatic request cancellation, enter the number of hours. [sn_imt_travel.cancellation_duration]</td>
<td>Sets the deadline for employees to complete a health verification. This property requires that the sn_imt_travel.allow.cancellation property is enabled.</td>
</tr>
<tr>
<td>Enables outreach to traveling employees about their daily travel contacts. [sn_imt_travel.daily.contact.log.outreach.flag]</td>
<td>When enabled, employees receive notifications to complete a daily contact log during internal travel. Contact log notifications are not sent for external travel. Employees must be assigned the sn_imt_tracing.dailylog_user role to receive contact log notifications. This property requires the Contact Tracing and Emergency Outreach applications. For more information about contact logs, see Contact Tracing.</td>
</tr>
</tbody>
</table>

Note: Employees who are already enrolled in daily contact logs before their trip will see no change. They will not receive additional notifications and they will still be enrolled after their trip is complete.

3. Click Save.

Modify the travel approval flow

Modify the travel approval flow to change the default travel approval settings.

Before you begin
Role required: flow_designer

About this task
Modifying the travel approval flow is an optional configuration step for the Employee Travel Safety application. The travel approval flow is ready to use but can be modified to meet your company's requirements.

Procedure
1. Navigate to Flow Designer > Designer.
2. In the Flows section, click Travel Approval Flow.
3. Click Deactivate, then click OK to confirm.
4. In the upper-right corner, click the More actions icon (ooo), then click Copy flow.
5. Enter a name for the new flow.
6. In the Application field, select Employee Travel Safety.
7. Click Copy.
8. Make any desired changes to the new flow.
   For example, in cases where an employee has a manager listed in your ServiceNow
   instance and there are also users in the Travel Approvers group, by default, both the
   manager and a travel approver must approve the request. This setting is defined in action
   8.1 of the flow. You can modify this action so that approval is only required from either
   a manager or a travel approver, not both. To make this change, the AND condition to
   approve must be replaced with an OR condition.

9. When you’re done modifying the flow, click **Activate**, then click **OK** to confirm.

**Customize notification emails**

Modify the notification emails that are sent to employees, managers and travel approvers,
and employee travel contacts to customize the notifications for your company.

**Before you begin**

Role required: admin

**About this task**

Modifying the notification emails is a required configuration step for the Employee Travel
Safety application. By default, the notifications use a ServiceNow® banner and the
placeholder signature Workplace, Co. Update the notifications to use your company name
and logo.

The Employee Travel Safety application uses the following notifications.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Verification Request</td>
<td>This email is sent to the primary contact that an employee provides on their travel request to verify site safety and policy compliance. By default, the email asks the contact to confirm the following policies.</td>
</tr>
<tr>
<td></td>
<td>• The site screens all employees and visitors for symptoms.</td>
</tr>
<tr>
<td></td>
<td>• All employees and visitors are required to wear personal protective equipment, such as masks.</td>
</tr>
<tr>
<td></td>
<td>• All employees and visitors are required to follow social distancing rules.</td>
</tr>
<tr>
<td></td>
<td>This email is only sent if the sn_imt_travel.email_site_verification property is enabled.</td>
</tr>
<tr>
<td>Employee Travel Safety Approver Request</td>
<td>This email is sent to an employee’s manager and all members of the Travel Approvers group asking them to approve or reject the travel request.</td>
</tr>
<tr>
<td>Employee Travel Safety Request Reminder</td>
<td>This email is sent to managers and travel approvers as a reminder to approve or reject pending travel requests.</td>
</tr>
<tr>
<td></td>
<td>This email is only sent if the sn_imt_travel.enableApprovalEmailReminders property is enabled.</td>
</tr>
<tr>
<td>Travel Request Approval</td>
<td>This email is sent to an employee if their travel request is approved. The email has a link to your company’s travel management system.</td>
</tr>
<tr>
<td>Travel Request Rejection</td>
<td>This email is sent to an employee if their travel request is rejected.</td>
</tr>
<tr>
<td>Travel-related contacts</td>
<td>This email asks an employee to complete a daily contact log. The email is sent to an employee daily for the duration of their trip.</td>
</tr>
<tr>
<td>Notification</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Travel-related health verification</td>
<td>This email asks an employee to complete a daily health verification. The email is sent to an employee daily once their travel request is approved though the duration of their trip.</td>
</tr>
<tr>
<td></td>
<td>This email is only sent if the sn_imt_travel.daily.health.verification.outreach.flag property is enabled.</td>
</tr>
<tr>
<td>Travel request rescinded</td>
<td>This email is sent to an employee if they don’t complete a health verification by the deadline.</td>
</tr>
<tr>
<td></td>
<td>This email is only sent if the sn_imt_travel.allow.cancellation property is enabled.</td>
</tr>
</tbody>
</table>

**Note:** All notifications except the Employee Travel Safety Approver Request are translated to the language selected on the employee's user profile. The Employee Travel Safety Approver Request is translated to the language selected on the manager's or travel approver's user profile. If no language is selected for a user, notifications are translated to the default language for the instance.

**Procedure**

1. Navigate to **System Notification > Email > Notifications**.
2. Click the notification that you want to update.
3. To view the default notification, click **Preview Notification**.
4. Navigate to the **What it will contain** form section.
5. In the **Message HTML** field, click **Insert/edit image** and select your banner image.

  ✨ **Tip:** The image must be added before the mail script so that it appears at the top of the email.

  If you don’t already have an email banner image in your ServiceNow instance, you can upload an image to use. For instructions, see **Upload one or more images**.

6. Click the **Show Notification Scripts** related link.
7. In the **Script** field, the code `template.print(util.getEmailCompanyLogo());` adds the default ServiceNow® banner to the email. Comment out or delete this line of code to remove the ServiceNow® banner.
8. In the **Script** field, replace all references to Workplace, Co. with your company name.
9. **Optional:** If you would like to make any other changes to the email notification, update the **Script** field as needed.
   - If you change any text used in calls to `gs.getMessage` or `gs.getMessageLang`, you must provide translations for your custom text in the Message table `[sys_ui_message]`. For more information, see **Message table**.
10. Click **Update**.
11. Return to the notification record and click **Preview Notification** to confirm your changes.

**Request permission to travel**

Before booking travel in a travel management system, request permission for your trip. Your manager or a travel approver can approve or reject your request based on infectious diseases, such as COVID-19 case data and a site safety evaluation for your destination.
Travel request

Use the following process when requesting permission to travel:

1. From your service portal or Employee Service Center (ESC), request permission to travel.

2. An email is sent to your manager to approve or reject the request. The email has a link to the travel request.

3. After approval, the **Additional comments** field on the Employee Travel Safety Request form is updated with the travel destination and details on the number of COVID-19 cases for the past 14 days for the location.

4. Travel requesters can request travel on the **Catalog** or **Request Something** tabs in the service portal.

5. Travel requesters can request travel on the **Catalog** tab in the ESC.

6. Travel requesters can check the status of their requests on the **Requests** tab in the service portal or the ESC.

7. Managers or approval team members can view employee travel requests from the **Employee Travel Safety** form.

Create a request to travel

Before booking travel in a travel management system, follow these steps to request permission for your trip.

**Procedure**

1. Navigate to **Employee Travel Safety > Request Travel**.

   **Note:** To create a travel request in the Now Mobile app, navigate to **Health > Follow These Safety Practices > Request Travel Permission.**

2. On the form, fill in the fields.

**Request permission to travel**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel type</td>
<td>The travel type. Select <strong>Internal</strong> if you're traveling to a location within your company. Otherwise, select <strong>External</strong>.</td>
</tr>
<tr>
<td>Location</td>
<td>The company location that you're traveling to. This field appears only when <strong>Internal</strong> is selected from the <strong>Travel type</strong> field.</td>
</tr>
<tr>
<td>Area of travel</td>
<td>Country, state, or county that you're traveling to. This field is used to provide managers and travel approvers with infectious diseases, such as COVID-19 case data for your destination.</td>
</tr>
<tr>
<td>Primary contact name</td>
<td>Name of your host or other contact at your destination. This field appears only when <strong>External</strong> is selected from the <strong>Travel type</strong> field.</td>
</tr>
<tr>
<td>Primary contact email</td>
<td>Email address of your host or other contact at your destination. This field appears only when <strong>External</strong> is selected from the <strong>Travel type</strong> field.</td>
</tr>
<tr>
<td>Primary contact company</td>
<td>Company of your host or other contact at your destination. This field appears only when <strong>External</strong> is selected from the <strong>Travel type</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Travel start date</td>
<td>Start date of your trip.</td>
</tr>
<tr>
<td>Travel end date</td>
<td>End date of your trip.</td>
</tr>
<tr>
<td>Reason for visit</td>
<td>Reason for your visit.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional comments you would like to provide for your manager or the travel approvers.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

When you submit the travel request, an email may be sent to your primary contact for the visit if your company has enabled this feature. The email notifies your contact about your intent to travel and asks them to verify the site safety and policy compliance.

---

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

---

**What to do next**

You’ll receive an email notification when your travel request is accepted or rejected. Depending on your company’s policies, you may need to complete daily health verifications before and during travel. You may also have to complete a daily contact log during travel. If you’re required to complete these tasks, you’ll receive emails with instructions. If you receive the daily health verification email, make sure to submit the health verification every day if you’re not symptomatic. Your trip may be canceled if you don’t submit the health verification.

To view all your travel requests, navigate to **Employee Travel Safety > My Requests**.

**Manage a travel request**

As a manager or travel approver, you can approve or reject travel requests. Before travel requests can be approved, user groups and roles must be set up for managers or travel approvers. For more information, see **Set up travel approvers**.

There are multiple ways to view requests for travel:

- An email detailing a request for travel sent to the requester’s manager and the group assigned.
- On the tabs in the Employee Service Center (ESC).
- On the **My Approvals** or **Requests** tabs in the service portal.
- From the View Travel Requests list.
Approve or reject travel requests

Managers or designated travel approvers are responsible for approving employee travel requests.

When an employee submits a travel request, an email is sent to the employee's manager and all members of the Travel Approvers group asking them to approve or reject the travel request. The email includes infectious diseases, such as COVID-19 case data for the travel destination. If the `sn_imt_travel.email_site_verification` property is enabled, the email also includes the results from the site safety verification. The email provides a link to the travel request, as well as direct links to approve or reject the request.

Travel approval request email

Hello, Adela,

You are an approver for a travel permission request from Abel Tuter.

Here are the details of the proposed travel and relevant public health data:
- Dates and location: 2020-09-02 to 2020-09-04, Colorado Campus 1
- Reason for visit: Sales meeting
- New COVID-19 cases in US/Colorado/Larimer by date:
  - 2020-08-26: 9
  - 2020-08-25: 23
  - 2020-08-24: 13
  - 2020-08-23: 14
  - 2020-08-22: 25
  - 2020-08-21: 19
  - 2020-08-20: 21
  - 2020-08-19: 14
  - 2020-08-18: 11
  - 2020-08-17: 13
  - 2020-08-16: 20
  - 2020-08-15: 16
  - 2020-08-14: 21
  - 2020-08-13: 25

If you have all the info you need, you can do one of the following:
- [Click here to approve TRV00001005](#)
- [Click here to reject TRV00001005](#)

Thank you,
The Workplace Services Team at Workplace, Co.

Unsubscribe | Notification Preferences

Managers can also view travel requests for their employees by navigating to **Employee Travel Safety > My Employee's Requests**.

Users in the Travel Approvers group can view travel requests for all employees by navigating to **Employee Travel Safety > View Travel Requests**.

Employees receive an email notification when their travel request is approved or rejected.

Cancel a travel request

Cancel a travel request when appropriate, such as when a meeting can be held virtually. You, your manager, or a user with the `sn_imt_travel.approver` role can cancel a travel request.

Before you begin
Role required: `sn_imt_travel.approver` or admin
Procedure

1. Navigate to Employee Travel Safety and select the appropriate module.

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel your travel request</td>
<td>My Requests</td>
</tr>
<tr>
<td>Cancel a travel request for a direct report</td>
<td>My Employee’s Requests</td>
</tr>
<tr>
<td>Cancel any employee travel request</td>
<td>View Travel Requests</td>
</tr>
</tbody>
</table>

2. Open the travel request to cancel and verify that it is the correct request to cancel. You can’t cancel a travel request that is complete.

3. Click Cancel.

Results

An email notification stating that the request was canceled is sent to the requester. The notification includes the name of the person who canceled the travel request.

Vaccination Status

The ServiceNow® Vaccination Status application gives HR departments the ability to track the status of user vaccinations in the workplace. Organizations can collect vaccination data for workforce planning, as needed based on business requirements, and report on the readiness of the workplace. Users are empowered to submit documentation of completed vaccinations to meet their organization’s health and safety requirement for a safe return to the workplace, while administrators can track the status of user vaccination in the workplace. Status updates can be made manually by the user.

Use with other Safe Workplace suite applications

Vaccination Status is part of a suite of ServiceNow® Safe Workplace suite applications. Use it with these other applications to help your organization prepare its workforce and workplaces to resume operations after emergencies and pandemics like COVID-19.

• With the Employee Readiness Surveys application, evaluate the readiness of your users to return to the workplace by asking them to fill in a survey.

• Before users re-enter workspaces, use the Employee Health Screening application to screen users and ensure compliance with your entry requirements, such as a temperature check and PPE.

• With the Workplace Safety Management application, prepare for the return of users by configuring and maintaining clean and socially distanced workspaces for them to use.

• You can manage the inventory of safety equipment for your workforce with the Workplace Personal Protective Equipment Inventory Management application.

• With the Contact Tracing application, evaluate the readiness of your users to return to the workplace by using data such as badge scans, Wi-Fi access logs, and daily contact logs to help identify potential user interactions.

All Safe Workplace suite applications are available in the ServiceNow Store.

Safe Workplace suite for federal customers

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications
on production instances. Customers are responsible for configuring the apps to meet U.S.
federal regulations and guidelines.

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Commercial on-premise</strong></td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td><strong>Federal hosted</strong></td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td><strong>Federal on-premise</strong></td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td><strong>On-premise</strong></td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole
decision of the Organization utilizing this application. Organizations agree that use of the
application is not a representation by ServiceNow regarding the application’s compliance
with any law or regulation and any suggested language provided out of the box with the
application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under
applicable law, including (but not limited to) data protection and employment laws, and
should modify any language within the templates provided to meet the Organizations’
specific requirements.

**Notice regarding use by government agencies**

ServiceNow is offering this application to government agencies and their authorized users,
not to government employees in their individual capacities. Use of the application does not
modify any existing, or future entitlements or payment obligations for ServiceNow software
or applications otherwise purchased by the government agency. ServiceNow shall not
be responsible for any implementation or configuration costs associated with use of the
application unless separately purchased. Government customers are solely responsible to
confirm with the agency’s Ethics Office or its authorized representative that acceptance and
usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.
Install Vaccination Status
You can install Vaccination Status if you have the admin role.

Before you begin
Vaccination Status requires the ServiceNow® Employee Readiness Core and Emergency Outreach applications.
Role required: admin

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you’ve subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)
Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Vaccination Status.
3. Click Install.
   The Application installation dialog box opens.
4. Click Activate.

Components installed with Vaccination Status
Several types of components are installed with Vaccination Status, including user roles and tables.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccination Status admin [sn_imt_vaccine.admin]</td>
<td>Application-specific admin for Vaccination Status.</td>
<td>• sn_imt_vaccine.profile_reader</td>
</tr>
<tr>
<td>Vaccine profile reader [sn_imt_vaccine.profile_reader]</td>
<td>Read-only access to the Vaccine profile [sn_imt_vaccine_vaccine_profile] table. Required to view vaccination status in contact tracing visualization.</td>
<td>• None</td>
</tr>
</tbody>
</table>

Important: By default, the System Administrator [admin] role contains the sn_imt_vaccine.admin role. The sn_imt_vaccine.admin role should be reassigned to another user and then removed from the admin. This process protects sensitive application data by restricting access to the application.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine profile [sn_imt_vaccine_vaccine_profile]</td>
<td>Shows which users received a COVID-19 vaccine. Users are not considered fully vaccinated until 14 days after receiving their vaccination (single-dose vaccine) or their final dose (multi-dose vaccine).</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note:</td>
<td>The COVID-19 vaccine completed column has a value of false until the 14-day vaccination period is complete.</td>
</tr>
<tr>
<td>Organizations can make the vaccine complete status dependent on whether a user reported receiving a vaccine booster when it became due. If the [sn_imt_vaccine.enforce_vaccination_complete_for_booster] property is enabled and a booster is due, the COVID-19 vaccine completed column has a value of false for users who have not reported receiving their booster after the due date.</td>
<td></td>
</tr>
<tr>
<td>Vaccine response</td>
<td>Contains a history of all reported vaccination statuses for each user.</td>
</tr>
<tr>
<td>[sn_imt_vaccine_vaccine_response]</td>
<td>Vaccine responses and their attachments are stored for the duration set by your organization's data retention policies. If the vaccine responses are deleted before the expiration date, the reported statuses and attachments are also deleted.</td>
</tr>
<tr>
<td>Note:</td>
<td>Any historical data saved for use in the Vaccination Status dashboard is count data only. Any personally identifying information is removed by default and is deleted based on your organization's policy.</td>
</tr>
<tr>
<td>Vaccine response definition</td>
<td>List of vaccines, including the type, manufacturer, and number of doses required. By default, this table contains several generic COVID-19 vaccines. A Vaccination Status admin can add and remove records to reflect the vaccines that are currently available to users.</td>
</tr>
<tr>
<td>[sn_imt_vaccine_vaccine_response_definition]</td>
<td></td>
</tr>
<tr>
<td>Campus vaccine summary</td>
<td>Stores vaccination data to map against data provided by the COVID-19 Global Health Data Set in the Safe Workplace Dashboard Vaccination Widget. User vaccination data is pulled from the Vaccine response table and entries are created daily based at midnight (00:00) instance time.</td>
</tr>
<tr>
<td>[sn_imt_vaccine_campus_vaccine_summary]</td>
<td></td>
</tr>
</tbody>
</table>

**Set up Vaccination Status properties**

Set up Vaccination Status properties to define the data retention period for user-reported vaccination status data and manage reminder emails.

**Before you begin**

Role required: sn_imt_vaccine.admin

**Procedure**

1. Navigate to Vaccination Status > Properties.
2. Set the following property values.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccination Status data retention period (in days).</td>
<td>Sets the number of days that user-reported vaccination status data is available in the Vaccine response table before it is deleted automatically. The Data Retention Job for Vaccination scheduled job runs daily to delete records that have an updated date past the specified retention period. The default value is 90 days.</td>
</tr>
<tr>
<td>Prevent admin from accessing attachments</td>
<td>Enable this property to limit the visibility of attachments in vaccination records to scoped administrators only. This property prevents system administrators from viewing these attachments. The property is inactive by default.</td>
</tr>
<tr>
<td>Frequency of reminders after 1st reminder. Default is set to 1, this will keep reminding users until they acknowledge.</td>
<td>Sets how often users receive reminder emails about their second dose after receiving their first reminder. For example, a value of 1 sends a reminder every day, and a value of 4 sends a reminder every 4 days. The reminder email is sent until the user reports their second dose. The Vaccine 2nd dose reminder email notification is sent until the due date. The Vaccine 2nd dose follow-up passed email notification is sent after the due date. The value of this property can't be 0.</td>
</tr>
<tr>
<td>Number of days before 2nd dose due date reminder</td>
<td>Sets when reminder emails to users for their second dose of a vaccine are sent. The value is set by the days between doses field on the Vaccine response definition record.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of days to send past due reminder before giving up.</td>
<td>Number of days before the due date that a user receives their first reminder email. The default value is 10 days before the due date.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.past_due_reminder_limit]</td>
<td></td>
</tr>
<tr>
<td>Set reminders for booster.</td>
<td>Enable this property to send reminders to users to report their vaccine booster. Booster reminders are not sent until a user reports their last vaccine dose. Organizations might need to extend or update their data retention policies to ensure enough time to send a reminder. If the data retention policy is not long enough, the date a final dose was administered could be erased before the booster is due.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.send_reminders_for_booster]</td>
<td></td>
</tr>
<tr>
<td>Frequency of booster reminders.</td>
<td>Sets how often users receive reminder emails about their vaccine booster.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.booster_reminder_frequency]</td>
<td></td>
</tr>
<tr>
<td>Number of days before booster due date reminder.</td>
<td>Sets the number of days before the due date that users receive their first reminder email about getting their vaccine booster. Booster reminders are sent by the date that users receive their final dose plus the Recommended days until booster required as determined by the organization on the Vaccine response definition record.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.remind_days_before_booster_due_date]</td>
<td></td>
</tr>
<tr>
<td>Number of days to send booster past due reminder before giving up.</td>
<td>Number of days past the due date before the user receives their first reminder email about getting their vaccine booster.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.booster_past_due_reminder_limit]</td>
<td></td>
</tr>
<tr>
<td>Set vaccine completed to false for users without booster.</td>
<td>Enable this property to force the vaccine completed status to false for users without booster.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.enforce_vaccination_complete_for_booster]</td>
<td></td>
</tr>
<tr>
<td>Number of days to wait after booster due date before setting vaccine completed to false.</td>
<td>Sets the number of days to wait after the due date before setting the vaccine completed status to false when a booster is due and a user has not reported receiving their booster.</td>
</tr>
<tr>
<td>[sn_imt_vaccine.set_covid19_completed_to_false_this_many_days_after_booster_due_date]</td>
<td></td>
</tr>
</tbody>
</table>
3. Click **Save**.

**Set up privacy consent for Vaccination Status**

Set up privacy consent for users who are providing their vaccination data to your organization.

**Before you begin**

Role required: sn_imt_core.admin and sn_imt_checkin.checkin_admin

**About this task**

Use Emergency Outreach to send a privacy consent form to users. Users must agree to the privacy consent before they can submit their vaccination status.

**Procedure**

1. Customize the privacy consent template.
   a. Navigate to **Employee Health and Safety Status > Privacy Consent Templates** and click **Vaccine Administration**.
   b. Fill in the placeholder text with the name of your organization and contact information.
   c. Click **Update**.

2. Assign the sn_imt_core.privacy_consent_user role to all users who will be reporting their vaccination status.
   This role enables users to complete the privacy consent.

3. Add all users who will be reporting their vaccination status to a **Safe Workplace** audience.
   a. Navigate to **Emergency Outreach > Safe Workplace Audience** and click **Vaccine Privacy Consent Audience**.
   b. Add users to the audience.
      For detailed instructions about adding users to an audience, see **Add a Safe Workplace audience**.
   c. Click **Update**.

4. Configure an outreach to send the privacy consent to users.
   a. Navigate to **Emergency Outreach > View Outreaches** and click the **Vaccine Privacy Consent Placeholder** outreach.
      This outreach is preconfigured to use the Vaccine Privacy Consent Audience and the Vaccine Administration privacy consent template.
   b. Make any modifications to the outreach if needed, such as scheduling a time to send.
      For detailed instructions about configuring an outreach, see **Send notifications for an emergency**.
   c. **Optional**: Enable the outreach to provide location-specific privacy consents by selecting the **Use Country** check box on the Content configuration tab.
      (Optional) When enabled, the privacy statement text in Location Privacy Configuration takes precedence over text in the privacy consent templates. This text is used for the
outreach, system notification email, and push notification. If you need to update the text users receive, you must change the location's privacy statement.

For more information on updating a location’s privacy statement, see Generate location-based privacy configurations.

d. Click Update.

Configure vaccine or vaccine booster types for Vaccination Status

Create or modify vaccine or vaccine booster types that people can use to report their vaccination status.

Before you begin
Role required: sn_imt_vaccine.admin

About this task
Vaccine and vaccine booster reporting requires Vaccine response definition records. Each record contains vaccine-specific information so users can properly report their vaccination status with the correct type of vaccine. For example, you can create a record for single-dose or multi-dose vaccine and set the number of days between doses. These configurations determine the questions users must answer when reporting their vaccination. Vaccination Status contains several generic COVID-19 vaccines that do not require configuration.

Procedure
1. Navigate to Vaccination status > Vaccine response definitions.
2. Click New or open a record.
3. On the form, fill in the fields.

Vaccine response definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine type</td>
<td>The type of vaccine, such as a COVID-19 mRNA vaccine or a vaccine booster.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The name of the vaccine manufacturer.</td>
</tr>
<tr>
<td>SMS friendly name</td>
<td>A display name for the vaccine that displays in SMS messages.</td>
</tr>
<tr>
<td>Number of doses required</td>
<td>Number of doses required for full vaccination.</td>
</tr>
<tr>
<td>Booster parent vaccine</td>
<td>The parent vaccine the booster supports, such as a booster for a COVID-19 mRNA vaccine.</td>
</tr>
</tbody>
</table>

*Note: The Booster parent vaccine field appears only when you set the Vaccine type to Booster.*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended days until booster required</td>
<td>Number of days since vaccination before a booster is required. This field is visible only if Vaccine type is set to Booster.</td>
</tr>
</tbody>
</table>

4. Click Submit.
Virtual Agent conversations for Vaccination Status

Vaccination Status provides a Virtual Agent conversation that enables users to report their vaccination status via SMS.

A ServiceNow® Virtual Agent conversation topic defines the dialog between the Virtual Agent (chatbot) and the user to accomplish a specific goal. The provided Vaccine conversation topic asks whether the user has been vaccinated, the date that they received the vaccine, and the type of vaccine that they received.

Installation and setup requirements

To use Virtual Agent with SMS, your organization must have a Twilio account and phone number. You must also install the Virtual Agent plugin (com.glide.cs.chatbot) and set up the Conversational SMS Integration with Twilio application (sn_va_sms_twilio). For more information, see Set up the Conversational SMS Integration with Twilio.

Configuration

To receive SMS messages for Vaccination Status, users must have a mobile phone number listed on their user record [sys_user]. Mobile numbers must be in E.164 format. For example, +18585551212.

Privacy consent for Vaccination Status must be configured before users can report their vaccination status via SMS. For instructions, see Set up privacy consent for Vaccination Status.

⚠️ Note: Users must agree to the privacy consent before they can submit their vaccination status. The Vaccine conversation topic prompts users to complete the privacy consent via SMS if they haven’t already submitted their consent. Users must belong to an audience associated with a vaccine privacy consent outreach to be able to complete the privacy consent via SMS.

Vaccination Status uses an SMS outreach to let users know that they can report their vaccination status via SMS. The outreach provides users with the information that they need to begin interacting with the Vaccine Virtual Agent conversation. To configure the outreach, add users to the placeholder Vaccination status request audience. For detailed instructions about adding users to an audience, see Add a Safe Workplace audience. Then, add the audience to the placeholder Vaccination status request outreach and make any modifications to the outreach if needed, such as scheduling a time to send.

Once users receive the SMS outreach, they can report their vaccination status through the Vaccine Virtual Agent conversation. The Vaccine conversation topic is ready to use without modifications, but can be customized to meet your organization’s requirements. To view or edit the Vaccine conversation topic, navigate to Collaboration > Virtual Agent > Designer. For more information about updating conversation topics, see Virtual Agent Designer.

The Vaccine conversation provides the user with options to select which type of vaccine they received. These options are pulled from the Vaccine response definition table [sn_imt_vaccine_vaccine_response_definition]. To set the display name for a vaccine type, enter the name in the SMS friendly name field on the vaccine response definition record.

Report your vaccination status

Provide your organization with information about whether you received a vaccine and the date that you received it.

Before you begin

Before you can submit your vaccination status, you must respond to the vaccine privacy consent.

Role required: sn_imt_core.privacy_consent_user
Procedure
1. Navigate to Vaccination Status > Report vaccination.

Note: To report your vaccination status in the Now Mobile app, navigate to Health > Follow These Safety Practices > Report Vaccination.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you received a vaccine dose?</td>
<td>Whether you received a vaccine dose or booster.</td>
</tr>
<tr>
<td>Vaccine</td>
<td>The type of vaccine or booster you received. If you select a vaccine that requires more than one dose, such as Covid-19 2 dose unknown manufacturer, you can select how many doses you want to report in the How many doses do you wish to report? field.</td>
</tr>
<tr>
<td>How many doses do you wish to report?</td>
<td>The number of doses you are reporting.</td>
</tr>
<tr>
<td>Date administered</td>
<td>The date you received your first dose.</td>
</tr>
<tr>
<td>Second date administered</td>
<td>The date you received your second dose.</td>
</tr>
</tbody>
</table>

Note: The Vaccine field appears only when Yes is selected as the answer to Have you been vaccinated?

Note: The Second date administered field appears only when you report more than one dose.

3. Optional: Add attachments, such as a SMART health card or an image of supporting documentation, by selecting Add attachments.
   For more information on supported formats, see Document Viewer.

4. Click Submit.

What to do next
Your organization might have a requirement that you be vaccinated before returning to the site. To check your progress on all site entry requirements, see View your health and safety status.

Note: You are not considered fully vaccinated until 14 days after receiving your vaccination (single-dose vaccine) or your final dose (multi-dose vaccine).

Depending on your organization's requirements, if your vaccine has a vaccine booster available, you might not be considered fully vaccinated until you report receiving your booster.

Viewing vaccine profile records
Vaccine profiles are records accessible in the Vaccine profile table that contain vaccination information for vaccine admins to review, such as a user's vaccination date, whether users are exempt from receiving a vaccine, or the results of their most recent COVID-19 tests.
Vaccine profile records
You can access vaccine profile records by navigating to Vaccination Status > Vaccine profiles and then creating a record or selecting an existing one.

⚠️ Note: You must have the Vaccine profile reader role or Vaccination Status admin role to view vaccine profile records.

### Vaccine profile records

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COVID-19 vaccine completed</td>
<td>Indicates whether a user is considered fully vaccinated. This status depends on a number of factors such as the type of vaccine, how your organization configures various system properties, and whether a booster is due.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>Vaccine exemption approved by</td>
<td>Name of the Vaccination Status admin who approved an exemption from requiring a COVID-19 vaccine for the user.</td>
</tr>
<tr>
<td>Vaccine exemption expiration date</td>
<td>Date that the vaccine exemption expires, which is set by the Vaccination Status admin.</td>
</tr>
<tr>
<td>Most recent COVID test date</td>
<td>Date that a COVID-19 test was most recently reported for the user.</td>
</tr>
<tr>
<td>Most recent COVID test result</td>
<td>The user’s most recently reported COVID-19 test result.</td>
</tr>
<tr>
<td>Most recent COVID test result verified</td>
<td>Indicates that the most recently reported COVID-19 test result was verified by a Vaccination Status admin in Health and Safety Testing.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Confirm COVID-19 test results for a user.</td>
</tr>
</tbody>
</table>

### Vaccination Status dashboard

Use the Vaccination Status dashboard to review reports that can provide insight into the vaccination status of your organization.

To access the Vaccination Status dashboard, navigate to Self-Service > Dashboards.
**End user and goals**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccination Status administrator: Review how well vaccination goals are being met and whether vaccine responses are being reported by the organization's users.</td>
<td>sn_imt_vaccine.admin</td>
<td>• Review the number of vaccine approvals that have been reviewed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor the percentage of Employee Health and Safety Status users who have been vaccinated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor the number of monthly vaccine responses for your organization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor the monthly vaccine response rate for your organization</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
<td>Benefits</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Employee Readiness Core admin: Must determine employee readiness and understand core vaccination metrics, such as the percentage of users who are or are not vaccinated.</td>
<td>sn_imt_core.admin</td>
<td>• Review the number of vaccine approvals that have been reviewed&lt;br&gt;• Monitor the percentage of Employee Health and Safety Status users who have been vaccinated&lt;br&gt;• Monitor the number of monthly vaccine responses for your organization&lt;br&gt;• Monitor the monthly vaccine response rate for your organization</td>
</tr>
</tbody>
</table>

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine Approvals</td>
<td>Pie breakdown</td>
<td>A breakdown of vaccine approvals by type:&lt;br&gt;• The number of vaccine responses that are approved&lt;br&gt;• The number of vaccine responses awaiting review&lt;br&gt;• The number of vaccine responses that are rejected</td>
</tr>
<tr>
<td>% of Health and Safety Users with Complete Vaccinations</td>
<td>Single score</td>
<td>Displays the percentage of health and safety users in your organization that are considered vaccine complete.</td>
</tr>
<tr>
<td>Note: Vaccine complete depends on your organization's configurations and what number of vaccines (doses, boosters) count as vaccine complete.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vaccine Responses (Monthly)</td>
<td>Stacked bar</td>
<td>Compares how many vaccine responses were received (yes) versus how many vaccine responses were not received (no) at a monthly rate.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Employee Vaccination Status Rate (Monthly)</td>
<td>Line</td>
<td>Indicates the number of people fully vaccinated. The rate is determined by the number of users in your organization with their vaccination profile COVID-19 completed status marked as true.</td>
</tr>
</tbody>
</table>

**Note:** A historical data collection job, Generate vaccine history records, runs daily to ensure that the report chart is up-to-date.

**Integrating with Safe Workplace suite**

Integrate ServiceNow Safe Workplace suite data with a third-party system. For example, you can integrate Employee Health Screening data with badge reader software to ensure compliance with your workplace entry requirements.

**Benefits**

Integrate with Safe Workplace suite:

- Ensure compliance with your workplace entry requirements.
- Improve efficiency between multiple systems.
- Ensure accuracy and safety across systems by maintaining a single source of data.

**Integrations**

You can integrate with Safe Workplace suite in these ways:

**Subscribe to request for entry updates**

Send the result of each Employee Health Screening entry request to a third-party system by configuring a webhook.

**Send data to the Employee Health Screening log**

Send data from a third-party system to the Employee Health Screening application log table. You can use this table to create reports and monitor health trends.

**Get employee or visitor health data**

Send a GET request for Employee Health and Safety Status data to use in your third-party system. Get data to determine an employee or visitor’s current health status.

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.
Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations' specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Subscribe to request for entry updates

Send the result of each Employee Health Screening entry request to a third-party system by configuring a webhook.

Before you begin

Sending outbound webhook calls requires the following plugins.

- ServiceNow Integration Hub Runtime (com.glide.hub.integration.runtime)
- ServiceNow Integration Hub Action Step - REST (com.glide.hub.action_step.rest)

These plugins must be requested through the Now Support Service Catalog. For instructions, see Request a plugin.

When you set up the webhook, the system automatically sends a REST request to a third-party endpoint every time an employee or visitor requests entry. Work with an administrator for the third-party system to determine the correct endpoint to provide.

Note: The webhook does not include authentication headers in the request. Ensure that you provide an endpoint that includes query parameters to authenticate the request.

To learn more about the Employee Health Screening Request Entry module, see Conduct a health screen for entry.

Role required: sn_imt_core.admin or admin

Procedure

1. Navigate to Employee Health and Safety Status > Outbound Webhooks.
3. On the form, fill in the fields.
## Webhook form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Internal identifier for the third-party endpoint.</td>
</tr>
<tr>
<td>Event</td>
<td>Event that you want to subscribe to. Options include:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Employee requested entry</strong>: Sends an update every time an employee requests entry.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Visitor requested entry</strong>: Sends an update every time a visitor requests entry.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Endpoint to send the Employee Health Screening Request Entry data to.</td>
</tr>
<tr>
<td></td>
<td>☛ <strong>Note</strong>: The webhook does not include authentication headers in the request. Ensure that you provide an endpoint that includes query parameters to authenticate the request.</td>
</tr>
<tr>
<td>Secure parameters</td>
<td>Query parameters for the endpoint that must be handled securely, such as an authorization token. Provide parameters in the format <code>?param1=value&amp;param2=othervalue</code>.</td>
</tr>
<tr>
<td></td>
<td>☛ <strong>Tip</strong>: If the third-party system that you’re sending data to doesn’t provide a securely generated authorization token, you can generate a token in your ServiceNow instance with the following script.</td>
</tr>
<tr>
<td></td>
<td>var secureRandom = GlideSecureRandomUtil;</td>
</tr>
<tr>
<td></td>
<td>var secret = secureRandom.getSecureRandomString(30);</td>
</tr>
<tr>
<td></td>
<td>gs.log(secret);</td>
</tr>
<tr>
<td>Active</td>
<td>Option to set the record to active.</td>
</tr>
</tbody>
</table>

### Results

The Employee Health Screening application sends request entry data to the third-party endpoint every time an employee requests entry. The JSON payload contains the following data.

```json
{
  "event": "entry.requested",
  "email": "aileen.motton@example.com",
  "username": "aileen.motton",
  "user_id": "a8f98bb0eb32010045e1a5115206fe3a",
  "location": "San Antonio",
  "location_id": "108486c7c611227500b093211aa88dcc",
  "access_granted": false,
  "updated": "2020-07-01 22:19:03"
}
```

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>event</td>
<td>Type of event defined in the Webhook table.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>email</td>
<td>Email address of the employee. Data type: String</td>
</tr>
<tr>
<td>username</td>
<td>Username of the employee from the Health and Safety Users</td>
</tr>
<tr>
<td></td>
<td>[sn_imt_core_health_and_safety_user] table. Data type: String</td>
</tr>
<tr>
<td>user_id</td>
<td>Sys_id of the user record from the Health and Safety Users</td>
</tr>
<tr>
<td></td>
<td>[sn_imt_core_health_and_safety_user] table. Data type: String</td>
</tr>
<tr>
<td>location</td>
<td>Location of the health screening. Data type: String</td>
</tr>
<tr>
<td>location_id</td>
<td>Sys_id of the location record from the Location [cmn_location] table.</td>
</tr>
<tr>
<td>access_granted</td>
<td>Flag that indicates whether the employee was granted access as a result of</td>
</tr>
<tr>
<td></td>
<td>the health screening. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• true: The employee passed the health screening and was granted access.</td>
</tr>
<tr>
<td></td>
<td>• false: The employee did not pass the health screening and was not granted</td>
</tr>
<tr>
<td></td>
<td>access.</td>
</tr>
<tr>
<td>updated</td>
<td>Date and time when the employee or visitor requested entry. Data type: Date/</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
</tbody>
</table>

**Send data to the Employee Health Screening log**

Send data from a third-party system to the Employee Health Screening application log table. You can use this table to create reports and monitor health trends.

**Before you begin**

Role required: sn_imt_core.api_logging_user

**Procedure**

1. Send a POST request to the Table API on your instance. For more information, see Table API.


   **Example**

   ```
   https://<your-instance>.servicenow.com/api/now/table/sn_imt_core_log_import
   ```

   b. Set fields in the Log table by defining these request body parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Internal name to identify the third-party system making the log entry.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Level</td>
<td>User status, log level, or any other meaningful string. For example, you can enter Allowed or Denied to indicate whether the individual is cleared for entry.</td>
</tr>
<tr>
<td>Message</td>
<td>Description of the health screening. For example, Temp too high.</td>
</tr>
<tr>
<td>User</td>
<td>Employee or visitor email from the Health and Safety User [sn_imt_core_health_and_safety_user] table.</td>
</tr>
<tr>
<td>Additional Info</td>
<td>Data to provide any additional information. For example, {'temperature':'101', 'location':'San Diego'}.</td>
</tr>
</tbody>
</table>

**Example**

This example cURL request sends a record to the Log Import table.

```bash
curl "http://<your-instance>.servicenow.com/api/now/table/sn_imt_core_log_import" \
--request POST \
--header "Accept:application/json" \
--header "Content-Type:application/json" \
--data "\"u_source\":"BadgesRUs","u_message\":"Temp too high","u_user\":"abel.tutor@servicenow.com","u_level\":"Denied\"\" \
--user 'username':'password'
```

The system automatically inserts the record into the Log [sn_imt_core_log] table.

2. Navigate to the Log [sn_imt_core_log] table to check that the data imported correctly.

**What to do next**

Generate reports on the data you imported to the Log [sn_imt_core_log] table using Reporting.

**Get employee or visitor health data**

Send a GET request for Employee Health and Safety Status data to use in your third-party system. Get data to determine an employee or visitor's current health status.

**Before you begin**

Role required: sn_imt_core.reader

**Procedure**

Send a GET request to the Table API on your instance. For more information, see Table API.


**Example**

https://<your-instance>.servicenow.com/api/now/table/sn_imt_core_health_and_safety_user

b. Add a query parameter to query a specific user's email address.

In the API explorer, you can enter one of the following strings in the sysparm_query field to generate an endpoint that includes the correct query parameter:
• user.email=<user-email-address>: Queries the provided employee's email address.
• visitor.email=<visitor-email-address>: Queries the provided visitor's email address.

**Query parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_query</td>
<td>user.email=<a href="mailto:abel.tuter@example.com">abel.tuter@example.com</a></td>
</tr>
</tbody>
</table>

**Example**

This example cURL request queries the Health and Safety User table and returns records associated with Abel Tuter's email address.

```
curl
"http://<your-instance>.servicenow.com/api/now/table/sn_imt_core_health_and_safety_user
/sysparm_query=user.email%3Dabel.tuter%40example.com&sysparm_limit=1" \
--request GET \
--header "Accept:application/json" \
--user 'username': 'password'
```

**Results**

The Employee Health and Safety Status application returns the Health and Safety User record associated with the email address in the request. The JSON payload contains the following data.

```
{
 "result": [
  {
   "sys_mod_count": "0",
   "sys_updated_on": "2020-07-14 19:58:00",
   "sys_tags": "",
   "type": "employee",
   "sys_id": "33f184491bce9010e3730e16ec4bcb71",
   "sys_updated_by": "system.administrator",
   "manually_created": "true",
   "sys_created_on": "2020-07-14 19:58:00",
   "sys_domain": {
    "link": "https://<my-instance>.servicenow.com/api/now/table/sys_user_group/global",
    "value": "global"
   },
   "requirements_status": "cleared",
   "visitor": "",
   "user": {
    "link": "https://<my-instance>.servicenow.com/api/now/table/sys_user/62826bf03710200044e0bfc8bcbe5df1",
    "value": "62826bf03710200044e0bfc8bcbe5df1"
   },
   "sys_created_by": "system.administrator"
  }
 ]
}
```
### Safe Workplace for mobile

Manage the essential steps for return to workplace from anywhere using the ServiceNow® Safe Workplace mobile app.

The ServiceNow® Safe Workplace mobile experience enables organizations to manage the essential steps for returning users to the workplace from anywhere with the Now Mobile app. With an intuitive mobile design and user-friendly interface, organizations can deliver a seamless return to workplace experience, enabling users to complete health screenings and...
surveys, set up visits, make reservations, request PPE, and more to support their health and safety.

Access other applications from Safe Workplace for mobile
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

<table>
<thead>
<tr>
<th>Emergency Response Management applications</th>
<th>Safe Workplace applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Emergency Outreach</td>
<td>• Employee Readiness Surveys</td>
</tr>
<tr>
<td>• Emergency Self Report</td>
<td>• Employee Health Screening</td>
</tr>
<tr>
<td>• Emergency Exposure Management</td>
<td>• Workplace Safety Management</td>
</tr>
<tr>
<td></td>
<td>• Workplace PPE Inventory Management</td>
</tr>
<tr>
<td></td>
<td>• Safe Workplace Dashboard</td>
</tr>
<tr>
<td></td>
<td>• Contact Tracing</td>
</tr>
<tr>
<td></td>
<td>• Health and Safety Testing</td>
</tr>
<tr>
<td></td>
<td>• Employee Readiness Core</td>
</tr>
<tr>
<td></td>
<td>• Enterprise Employee Experience Pack</td>
</tr>
<tr>
<td></td>
<td>• Employee Travel Safety</td>
</tr>
<tr>
<td></td>
<td>• Vaccination Status</td>
</tr>
</tbody>
</table>
Safe Workplace for mobile features

<table>
<thead>
<tr>
<th><strong>Receive and respond to outreach notifications</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Receive important notifications generated in the Emergency Outreach application on your mobile device. You can also self-report your health status through these notifications.</td>
</tr>
<tr>
<td>For more information about Emergency Outreach, see Emergency Outreach.</td>
</tr>
<tr>
<td>For information on how to report your health status through push notifications, see Report your health status.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Report your health status on the service response dashboard</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Under My Current Health Status, click your name to report your health status. For more information, see Report your health status in Now Mobile.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>View the status of your direct reports</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>As a manager, you can view My Team’s Health in the My Team section to see an overview of the health of your direct reports. For more information, see Manage the status of your direct reports in Now Mobile.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Reassign critical tasks to your working employees</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>As a manager, you can tap My Direct Reports Open Tasks in the My Team section to see the work assigned to your direct reports. From this list, you can reassign tasks, as needed, to your working direct reports. For more information, see Reassign tasks to your team members in Now Mobile.</td>
</tr>
</tbody>
</table>

## Mobile sections

If you’ve subscribed to the Safe Workplace suite, you see the Mobile sections available for Mobile experience for Emergency Response Management. Each section has multiple applications. To see all applications under a topic, scroll left.

### Mobile section topics

<table>
<thead>
<tr>
<th>Follow these safety practices</th>
<th>Health screening</th>
<th>Manage PPE inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health surveys</td>
<td>Screen employee</td>
<td>Assign consumable</td>
</tr>
</tbody>
</table>
Mobile section topics (continued)

<table>
<thead>
<tr>
<th>Follow these safety practices</th>
<th>Health screening</th>
<th>Manage PPE inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>• For more information, see Employee Readiness Surveys.</td>
<td>• For more information, see Conduct a health screen for entry.</td>
<td>• For more information, see Assign PPE to employees.</td>
</tr>
<tr>
<td>Verify my health</td>
<td>Screen visitor</td>
<td>Assign hardware</td>
</tr>
<tr>
<td>• For more information, see Verify your health status and compliance.</td>
<td>• For more information, see Screen a visitor for entry to the workplace.</td>
<td>• For more information, see Assign PPE to employees.</td>
</tr>
<tr>
<td>Request PPE</td>
<td>Scan for entry</td>
<td>Add consumable</td>
</tr>
<tr>
<td>• For more information, see Request PPE.</td>
<td>• For more information, see Collecting user badge data.</td>
<td>• For more information, see Add PPE stock.</td>
</tr>
<tr>
<td>Daily contact log</td>
<td>Employee status</td>
<td>Add hardware</td>
</tr>
<tr>
<td>• For more information, see Tracking employee contacts using daily logs.</td>
<td>• For more information, see View your health and safety status.</td>
<td>• For more information, see Add PPE stock.</td>
</tr>
<tr>
<td>Privacy Consent</td>
<td></td>
<td>Add model</td>
</tr>
<tr>
<td>• For more information, see User privacy consent for Contact Tracing.</td>
<td></td>
<td>• For more information, see Create models for PPE items.</td>
</tr>
<tr>
<td>Set up a visit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Invite a visitor to the workplace.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COVID-19 Testing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Request a COVID-19 diagnostic test.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request travel permission</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Request permission to travel.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report Vaccination</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Report your vaccination status.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Section topics (continued)

<table>
<thead>
<tr>
<th>My current health status</th>
<th>Prepare for arrival</th>
<th>My team</th>
</tr>
</thead>
</table>
| • For more information, see View your health status in Now Mobile. | My readiness checklist  
  • Provides a checklist of tasks to complete prior to arriving at the work location. | My team’s health  
  • Shows a list of your direct reports and their health status. |
|                         | My office entry code  
  • Provides a QR code that enables you to check into a work location. | My direct reports open tasks  
  • Shows all open tasks assigned to your direct reports that must be completed prior to arriving at a work location. |

Safe Workplace suite for federal customers

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>
| Federal on-premise    | If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team.  
  See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information. |
| On-premise            | See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information. |

If you’ve subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

• Emergency Outreach (sn_imt_checkin)  
• Employee Health Screening (sn_imt_monitoring)  
• Workplace PPE Inventory Management (sn_imt_ppe)  
• Employee Readiness Surveys (sn_imt_readiness)
• COVID-19 Global Health Data Set (sn_imt_c19datafeed)
• Contact Tracing (sn_imt_tracing)
• Emergency Self Report (sn_imt_quarantine)
• Workplace Safety Management (sn_wsd_core)
• Safe Workplace Dashboard (sn_imt_dashboard)
• Emergency Response Management for Now Mobile (sn_imt_mobile)
• Employee Travel Safety (sn_imt_travel)
• Health and Safety Testing (sn_imt_health_test)
• Vaccination Status (sn_imt_vaccine)

Notice regarding use by organizations
All decisions in connection with the implementation of this application are at the sole
decision of the Organization utilizing this application. Organizations agree that use of the
application is not a representation by ServiceNow regarding the application’s compliance
with any law or regulation and any suggested language provided out of the box with the
application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under
applicable law, including (but not limited to) data protection and employment laws, and
should modify any language within the templates provided to meet the Organizations’
specific requirements.

Notice regarding use by government agencies
ServiceNow is offering this application to government agencies and their authorized users,
not to government employees in their individual capacities. Use of the application does not
modify any existing, or future entitlements or payment obligations for ServiceNow software
or applications otherwise purchased by the government agency. ServiceNow shall not
be responsible for any implementation or configuration costs associated with use of the
application unless separately purchased. Government customers are solely responsible to
confirm with the agency’s Ethics Office or its authorized representative that acceptance and
usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.

Install Safe Workplace for mobile
Install the Now® Mobile app and Safe Workplace for mobile app.

Before you begin
The Safe Workplace for mobile app (sn_imt_mobile) is dependent on the
com.sn_imt_quarantine plugin.

The Safe Workplace for mobile app also has an optional dependency on other Safe
Workplace applications. If you have any of these plugins installed, the corresponding
applications will appear in your Safe Workplace for mobile app:
• sn_imt_checkin
• sn_imt_core
• sn_imt_monitoring
• sn_imt_ppe
• sn_imt_tracing
• sn_imt_travel
• sn_imt_health_testing

Role required: admin

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

**Procedure**

1. On your mobile device, download the Now Mobile app for Apple iOS or Google Android from the Apple App Store or the Google Play store.
2. In your instance, navigate to **System Applications > All Available Applications > All**.
4. Click **Install**.
5. In the Application installation dialog box, click **Install**.
6. When the installation is complete, click **Close**.
7. **Optional**: Control access to the application by creating a group and assigning roles to the group or individual users.  
   (Optional) For more information, see **Roles**.

**Report your health status in Now Mobile**

Use the Now® Mobile app to report your health status.

**Before you begin**

Role required: sn_imt_quarantine.crisis_task_user
To access this content, you must have the Now Mobile app. Your instance must have the Emergency Self Report application installed.

**About this task**
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

⚠️ **Note:** The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

**Procedure**
1. Open the Now Mobile app.
2. At the top of the Health page, click the quick action icon (+) to open the self-report applet.
3. Select your health status from the list, and tap the check icon (✓) to confirm your status.

4. Click **Submit**.
View your health status in Now Mobile

Use the Now Mobile app to view your health status record.

Before you begin
Role required: none

To access this content, you must have the Now Mobile app. Your instance must have the Emergency Self Report application installed.

About this task
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

⚠ Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

Procedure
1. Open the Now Mobile app.
2. Scroll down to My Current Health Status and click the See All link.
3. Click your name.

**My Current Health Status screen**

The My Current Health Status screen displays the following information:

- Use the **Status** tab to see your current reported status.
- Use the **Health history** tab to see a history of your health status updates.
- Use the **Assigned tasks** tab to see the tasks assigned to you.
- Use the **Update status** button to change your health status.
- If you're a manager, use the **Reassign all** action from the top menu icon to reassign all your tasks.
Manage the status of your direct reports in Now Mobile
Use the Now Mobile app to view the health status of your direct reports.

Before you begin
To access this content, you must have the Now Mobile app. Your instance must have the Emergency Self Report application installed.

Role required: none

About this task
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

Procedure
1. Open the Now Mobile app.
2. Scroll down to the My Team section and click the My Team’s Health link.
   In the My Team’s Health section, you can see a list of all your users.
3. In the My Team's Health section, a list of all your users and their status is displayed.
4. **Optional:** Update the status for a user.

   - Swipe to the left on an entry in the list to update the user's status.
   - Tap on a record in the list and click **Update status** at the bottom of the task form.
5. Tap an entry on the list to view the employee record screen.

**Employee record screen**

The employee record screen displays the following information:

- Use the **Health history** tab to see a history of the user's health status updates.
- Use the **Assigned Tasks** tab to see the tasks assigned to the user.
- Click the **Update status** button to change the user's health status.

---

**Reassign tasks to your team members in Now Mobile**

As a manager, view a list of tasks assigned to your team members and reassign the tasks to other team members.

**Before you begin**

To access this content, you must have the Now® Mobile app. Your instance must have the Emergency Self Report application installed.

Role required: none

**About this task**

From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

**Note:** The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.
Procedure
1. Open the Now Mobile app.
2. Scroll down to the My Team section and click **My Direct Reports Open Tasks**.

A list of all open tasks assigned to your direct reports is displayed. To view details about the task, click the open task.

To reassign a task, swipe left and click **Reassign**.

Search for a user that you want to reassign the task to and select the name of the user.

Click **Submit**.

**Domain separation and Safe Workplace suite**
The Safe Workplace suite applications support domain separation at the Basic level with the exception of Safe Workplace Dashboard.
With domain separation, you can separate data, processes, and administrative tasks into logical groupings called domains. You can then control aspects in each domain, including what users can see or whether they can access the data.

**Domain separation support**

ServiceNow applications that support domain separation might support the separation of data and data routing only, have advanced business logic separation, or support customer-level administration of the application. ServiceNow applications are defined with incremental support levels from the perspective of actual use cases and the people who use them.

**Basic**

- Data is domain-separated.
- Logic exists to ensure proper data routing, caching, rollups, and aggregations.
- Global configuration is operational for multiple tenants.

**Standard**

- Application properties are domain-aware as needed.
- Business logic can be domain-separated by the instance owner per tenant.

**Enhanced**

- Data-driven process enables failsafe configuration by tenants through the UI to drive business logic.

For more detail on the support levels, see [Application support for domain separation](#).

**How domain separation works in Safe Workplace applications**

The following applications use the Safe Workplace domain table:

- Contact Tracing
- Health and Safety Testing
- Emergency Outreach (Daily Contact Logs, Privacy Consent, and Privacy Consent (common))
- Emergency Exposure Management

Admins must install the [Domain separation plugin](#) before working with these application tables. Most of those tables contain a `sys_domain` field so they are able to be domain-separated if they have data that needs to be partitioned by domain.

- Core domain table: Included in the [Safe Workplace plugin](#) is an `sn_imt_core_domain` table. Domains in this table are iterated when scheduled jobs run.
- Property table: The `sn_imt_core_property` table extends the `sys_properties` table and adds a `sys_domain` field. Adding that field allows `sys_properties` values to be overridden for a domain.

**Note:** Values are handled differently for `password2` fields than for other property types. Therefore, the value displays as blank in the domain-separated properties list view.

The following tables do not have the `sys_domain` field:
• **app-imt-checkin**
  ◦ sn_imt_checkin_outreach_sysauto_script (extends sysauto_script)
  ◦ sn_imt_checkin_response_criteria
  ◦ sn_imt_checkin_response_option_for_health
  ◦ sn_imt_checkin_response_option_survey
  ◦ sn_imt_checkin_response_script

• **app-imt-diagnosis**
  ◦ task_compliance_result

• **app-imt-tracing**
  ◦ sn_imt_tracing_wifi_access_register_job
  ◦ sn_imt_tracing_wifi_access_register_stage

• **app-imt-core**
  ◦ sn_imt_core_sysauto_script (extends sysauto_script)

Scheduled jobs in applications with this level of domain separation run separately for each domain in the table. Scheduled jobs use the core table as the domain source table, and the **Domain Iterator** check box is automatically enabled by default when domain separation is installed. When the **Domain Iterator** option is enabled, the job can run in multiple domains.

The **Domain Source Table** value is also set to Safe Workplace Domains by default. If you don’t see the tables, verify that the **Domain Iterator** and Safe Workplace Domains settings are selected, and refresh the instance.

### Parent-child domains

Domains that also contain a sub-domain or “child” domain are not supported in these applications. Running a job in a parent domain that has a child would mean running the job twice and thus processing the data more than once. You could add a parent domain or add just the child domain but not both.

### Working with domain-separated properties in the Safe Workplace Suite

When the Domain separation plugin is installed and you navigate to the Properties page in any of the four Safe Workplace domain-separated applications, their properties do not display by default. You must override properties for a domain before they appear in the list.
To display the properties, click **New** on the Properties page. In the form that creates a new domain-separated property, search in the reference field for the property you would like to override. Enter a specific prefix to narrow your search:

- **sn_imt_core** for Employee Readiness Core
- **sn_imt_diagnosis** for Emergency Exposure Management
- **sn_imt_health_testing** for Health and Safety Testing
- **sn_imt_tracing** for Contact Tracing

The properties display with a full description of the overrides.

After you create your domain-separated property override, the form displays the domain-separated properties.
You can navigate back to the record form by selecting a property name in the list.

**Property functions**

Learn more about how these properties function in the following topics:

- Health and Safety Testing properties
- Contact Tracing properties
- System properties for tracing systems in Emergency Exposure Management
- Employee Health and Safety Status properties

**Related information**

Domain separation for service providers

**Emergency Response Management**

ServiceNow® Emergency Response Management applications help your organization mobilize its business continuity efforts during natural disasters and pandemics like COVID-19. Streamline and automate activities on multiple fronts to keep everyone informed and connected as you anticipate or experience emergencies.

**Video describing the Emergency Response Management apps and how they work together**

Emergency Response Management applications include:

**Emergency Outreach**

Stay connected with users via email or mobile push notifications. Share important information regarding emergency and safety measures, and ask users to report their status and location. With the installation of Employee Readiness Surveys, you will use Emergency Outreach to send a survey link to help you evaluate whether users are ready to return to the workplace.

**Emergency Self Report**

Enable your users to report their health status. If users report they are going into quarantine, a workflow helps them safely return to work when ready. Functions such as HR can also be alerted.

**Emergency Exposure Management**

Identify users who might have been exposed to an infectious disease by analyzing an affected user's meetings, locations, shifts and reservations, and badge scans.

**Emergency Response Management for Now Mobile**

Enable your users who use the Now Mobile app to respond to Emergency Outreach push messages and also self-report their health status.

Use the Emergency Response Management applications together to automate workflows for sharing information with users, assessing the impact on your team, and responding to the emergency event.
Emergency response app workflow from self-reporting to assessing exposure to requesting user health status check-in

Use guided setup to implement Safe Workplace suite apps

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Emergency Response Management for federal customers

Federal customers using IL4 or FedRAMP environments will see the Emergency Response Management applications ready and available to install on their instances without having to make any special requests. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

Domain separation support for Emergency Response Management applications

You can learn about domain separation support for service provider use cases in each Emergency Response Management application's topic.
Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole
decision of the Organization utilizing this application. Organizations agree that use of the
application is not a representation by ServiceNow regarding the application’s compliance
with any law or regulation and any suggested language provided out of the box with the
application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under
applicable law, including (but not limited to) data protection and employment laws, and
should modify any language within the templates provided to meet the Organizations’
specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized
users, not to employees of government agencies in their individual capacities. Use of this
application is being offered free of charge for a limited or extended time period and with
no expectation of payment from the government agency to ServiceNow for use during
that time period, nor does usage create an actual or implied future obligation on behalf of
the government. ServiceNow hereby expressly waives any future claims for payment from
the agency in connection with usage of the application. Government customers are solely
responsible to confirm with the agency’s Ethics Office or its authorized representative that
acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.

Emergency Outreach

Notify users of important information about anticipated or occurring emergency situations.
Send an outreach notification via email, mobile push message, or SMS message to request a
user response. You can also configure other preferred communication channels.

Emergency Outreach was developed with other ServiceNow® Emergency Response
Management apps to monitor and aid in stopping the community spread of infectious
diseases, such as COVID-19 among users. With the release of additional ServiceNow® Safe
Workplace suite apps, companies are able to manage an emergency situation from the
outbreak through the reopening of the workplace.

Some of the Safe Workplace suite apps leverage the Emergency Outreach notification
feature to communicate with users.

- **Employee Readiness Surveys** provides an outreach notification with a link to a survey to
  assess user readiness to return to the workplace. Customize the notification and the survey
to address your company’s concerns.

- **Employee Health Screening** uses outreach notifications to request that users submit their
  health status verification each day before they can return to the workplace.

- **Contact Tracing** uses the following outreach notifications:
  - An outreach notification to request that users in the workplace provide a list of users
    that they were in contact with throughout the day. The daily log notification can be
    scheduled and sent at a certain time every workday or as needed. Keeping daily logs
    enables contact tracers to follow up with impacted users when a user is affected.
An outreach notification to request that users review the organization’s privacy policy and provide their consent to use their data for contact tracing.

An outreach notification to potentially exposed contacts in an exposure case to notify them that they might have been potentially exposed to an affected user at the workplace.

**Note:** Safe Workplace suite apps require a subscription. Install Emergency Outreach first, then install the Safe Workplace suite app.

Use **guided setup to implement Safe Workplace suite apps**

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to **Guided Setup > Safe Workplace Guided Setup**. For more information about using the guided setup interface, see [Using guided setup](#).

**Use with other Emergency Response Management applications**

The Emergency Response Management applications, built on the Now Platform®, assist organizations in their emergency response efforts. With the [Emergency Exposure Management](#) application, you can identify users who might have been exposed to affected users. Through the [Emergency Self Report](#) application, users can self-report their health...
status. Managers can track the health status of their direct reports so that work can be reassigned and response teams can monitor the overall data and trends. Both applications are available in the ServiceNow Store.

Emergency Response Management for federal customers

Federal customers using IL4 or FedRAMP environments will see the Emergency Response Management applications ready and available to install on their instances without having to make any special requests. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to employees of government agencies in their individual capacities. Use of this application is being offered free of charge for a limited or extended time period and with no expectation of payment from the government agency to ServiceNow for use during that time period, nor does usage create an actual or implied future obligation on behalf of the government. ServiceNow hereby expressly waives any future claims for payment from the agency in connection with usage of the application. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.
All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.

Install Emergency Outreach
You can install Emergency Outreach if you have the admin role.

Before you begin
Role required: admin

<table>
<thead>
<tr>
<th>Installation instructions for self-hosted and federal environments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>Commercial on-premise</td>
</tr>
<tr>
<td>Federal hosted</td>
</tr>
<tr>
<td>Federal on-premise</td>
</tr>
<tr>
<td>On-premise</td>
</tr>
</tbody>
</table>

About this task
After you install Emergency Outreach, no additional administration configuration is required.
Optionally, you can configure notifications and response messages.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Emergency Outreach.
3. Click install.
   The Application installation dialog box opens.
4. Optional: Load the demo data by selecting the Load demo data check box. (Optional) For information about how to install or reinstall demo data after the initial installation, see the Work around to install demo data if application is already installed [KB0722909] article in the Now Support Knowledge Base.
5. Click install.
6. When the installation is complete, click Close.
Results
Emergency Outreach is installed on your instance.

What to do next
Optionally install Employee Readiness Surveys to use with Emergency Outreach. The Employee Readiness Surveys app enables you to evaluate the readiness of your employees to return to the workplace using Emergency Outreach notifications.

Install Employee Readiness Surveys to use with Emergency Outreach
You can install Employee Readiness Surveys if you have the admin role. Installing Employee Readiness Surveys adds notification options to the Emergency Outreach app. A default health readiness survey is provided as an example.

Before you begin
Role required: admin

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
About this task
The Send Outreach form in Emergency Outreach has an option to send a survey instead of a health status request. Users with the sn_imt_checkin.checkin_admin role become owners of the example health readiness survey.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Search for Employee Readiness Surveys.
3. Click install.
   The Application installation dialog box opens.
4. Optional: Load the demo data by selecting the Load demo data check box.
   (Optional) For information about how to install or reinstall demo data after the initial installation, see the Work around to install demo data if application is already installed KB0722909 article in the Now Support Knowledge Base.
5. Click install.
6. When the installation is complete, click Close.

Results
Employee Readiness Surveys is installed on your instance. Use it by navigating to the Emergency Outreach app.

Components installed with Emergency Outreach
Several types of components are installed with Emergency Outreach, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Outreach admin [sn_imt_checkin.checkin_admin]</td>
<td>Can create a new Emergency Outreach notification and view the responses received from the user. Can create and manage Safe Workplace audiences. The Employee Readiness Core app must be installed.</td>
<td>• survey_creator</td>
</tr>
</tbody>
</table>
## Tables installed

### Emergency Outreach tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emergency Outreach</strong></td>
<td>[sn_imt_checkin_employee_check_in]</td>
</tr>
<tr>
<td><strong>Outreach Acknowledgements</strong></td>
<td>[sn_imt_checkin_check_in_acknowledgement]</td>
</tr>
<tr>
<td><strong>Response Options</strong></td>
<td>[sn_imt_checkin_response_option]</td>
</tr>
<tr>
<td><strong>Emergency Outreach Channels</strong></td>
<td>[sn_imt_checkin_channels]</td>
</tr>
<tr>
<td><strong>Health Verification Acknowledgements</strong></td>
<td>[sn_imt_checkin_health_verification_acknowledgement]</td>
</tr>
<tr>
<td><strong>Emergency Outreach Notification Channels</strong></td>
<td>[sn_imt_checkin_m2m_channel_employee_check_in]</td>
</tr>
<tr>
<td><strong>Outreach Sysauto Script</strong></td>
<td>[sn_imt_checkin_outreach_sysauto_script]</td>
</tr>
<tr>
<td><strong>Survey Instances</strong></td>
<td>[sn_imt_m2m_asmt_assessment_instance_checkin]</td>
</tr>
<tr>
<td><strong>Response Criteria</strong></td>
<td>[sn_imt_checkin_response_criteria]</td>
</tr>
</tbody>
</table>
Emergency Outreach tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Script</td>
<td>List of all response scripts. Response scripts are used to automatically take actions based on employee responses to survey questions.</td>
</tr>
<tr>
<td>[sn_imt_checkin_response_script]</td>
<td></td>
</tr>
<tr>
<td>View Outreach Instance Logs</td>
<td>List of outreach surveys with information about their creation and the status of their survey instances.</td>
</tr>
<tr>
<td>[sn_imt_checkin_employee_check_in_log]</td>
<td></td>
</tr>
</tbody>
</table>

Configure Emergency Outreach notifications

A user with the admin role can add email notifications to use for any of the apps that communicate using Emergency Outreach. Each app provides a default email notification as an example to help with planning a new notification.

Before you begin
Role required: admin and sn_imt_checkin.checkin_admin

About this task
The Emergency Outreach notification feature supports the following applications and base system outreach notifications.

- Emergency Outreach: Request employee response indicating health status.
- Employee Readiness Surveys: Send a survey link with questions to determine employee readiness to return to the workplace.
- Employee Health Screening: Request that employees acknowledge their health status verification each day before they can return to the workplace.
- Contact Tracing:
  - Schedule an email notification to request that employees in the workplace list other employees they were in contact with.
  - Schedule an email notification to request that employees review the organization’s privacy policy and provide their consent to use their data for contact tracing.
  - Send an email notification to potentially exposed contacts in an exposure case to notify them that they might have been potentially exposed to an affected employee at the workplace.

Procedure

1. Add an email notification to customize the send conditions and notification content for an outreach.
2. Update the email notification used in the outreach notification.
3. Add a Safe Workplace audience for the employees to whom you want to send the notification.
4. Configure response options if an outreach requires them.
5. Optional: Create additional notification channels, such as Slack or Microsoft Teams through which you want to send notifications.
6. **Optional:** Add a survey such as the Employee Readiness survey to be sent with the outreach notification.  
(Optional) For information about selecting the survey, see .  
For information about creating a survey, see Survey administration and Survey designer.

7. Configure and send outreach email, mobile, and SMS notifications to your employees.

   - **Note:** SMS notifications are available only for outreach acknowledgments and daily health verifications.

### Add email notifications for use with Emergency Outreach

Add an email notification to customize the send conditions and notification for your employees and use it in place of the default notification for an Emergency Outreach notification.

#### Before you begin

Review the default email notification to familiarize yourself with the way that the notification is laid out and scripted. Use the default notification details to prepare the information to use for the notification that you’re adding.

<table>
<thead>
<tr>
<th>Default email notifications by application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
</tr>
<tr>
<td>Emergency Outreach</td>
</tr>
<tr>
<td>Employee Readiness Surveys</td>
</tr>
<tr>
<td>Employee Health Screening</td>
</tr>
</tbody>
</table>
| Contact Tracing | • Employee Daily Log Alert  
 | • User Privacy Consent  
 | • Notify Exposed Contact |

Role required: admin

#### Procedure

1. Navigate to **System Notifications > Email > Notifications**.
2. Click **New**.
3. On the form, fill in the fields.

### Notification form

<table>
<thead>
<tr>
<th>Outreach notification</th>
<th>Required fields for configuring the email notification</th>
</tr>
</thead>
</table>
| Voluntary health check-in | **Table** field: Outreach Acknowledgements [sn_imt_checkin_check_in_acknowledgement]  
 | **When to send** tab:  
 | • **Send when:** Select **Record inserted or update**  
 | • **Conditions:**  
 | [User.Active][is][true] |

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Outreach notification</th>
<th>Required fields for configuring the email notification</th>
</tr>
</thead>
</table>
| Outreach Surveys              | **Table** field: Assessment Instance [asmt_assessment_instance]  
When to send **tab:**  
• **Send when** field: Select **Event is fired**  
• **Event name** field: Select  
  sn_imt_checkin.survey_instance_notify  
• **Conditions:**  
  [Assigned to.Active][is][true] |
| Daily Contact Log             | **Table** field: Daily Log Acknowledgements [sn_imt_tracing_daily_log_ackednowledgement]  
When to send **tab:**  
• **Send when**: Select **Record inserted or update**  
• **Conditions:**  
  [User.Active][is][true] and  
  [Acknowledgment Status][is not][Acknowledged] |
| User Privacy Consent          | **Table** field: User Privacy Notice and Consents [sn_imt_tracing_user_privacy_consent]  
When to send **tab:**  
• **Send when**: Select **Record inserted or update**  
• **Conditions:**  
  [Parent consent][is empty] and  
  [Consent status][is][Not Acknowledged] and  
  [Notification count][changes] and  
  [Notification count][greater than or is][1] and  
  [User.Active][is][true] and  
  [Emergency Outreach.Email notification][is][true] |
| Notify Exposed Contact        | **Table** field: Exposure Notice [sn_imt_tracing_exposure_notice]  
When to send **tab:**  
• **Send when**: Select **Record inserted or update**  
• **Conditions:**  
  [User.Active][is][true] and  
  [Notification count][changes] |
| Daily Health Verification Outreach | **Table** field: Health Verification Acknowledgements [sn_imt_checkin_health_verification_ackednowledgement]  
When to send **tab:**  
• **Send when**: Select **Record inserted or update**  
• **Conditions:**  
  [User.Active][is][true] and  
  [Notification count][changes] |
### Required fields for configuring the email notification

<table>
<thead>
<tr>
<th>Outreach notification</th>
<th>Required fields for configuring the email notification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[User.Active][is][true] and [Acknowledgment Status][is not][Acknowledged]</td>
</tr>
</tbody>
</table>

4. In the **Advanced condition** field, enter the code to associate the email notification with the corresponding outreach notification.

   - For the Outreach Surveys notification:

   ```javascript
   var checkInSysId = event.getValue('parm1');
   var checkInGr = new GlideRecord('sn_imt_checkin_employee_check_in');
   checkInGr.get(checkInSysId);
   var thisNotificationSysId = '<your-sys_id>';
   answer = checkInGr.getValue('notification') === thisNotificationSysId &&
   checkInGr.email_notification;
   ```

   - For other outreach notifications:

   ```javascript
   var thisNotificationSysId = '<your-sys_id>'
   answer = current.employee_check_in.notification = thisNotificationSysId;
   ```

   Replace the `<your-sys_id>` variable with the sys_id of the notification that you're adding. To do so, right-click in the header, select the **Copy sys_id** option, and paste the sys_id into the code line.

5. In the **Who will receive** tab, select the audience to whom the notification will be sent. You can also select the target audience while configuring or sending the associated outreach notification. For more information, see **Send notifications for an emergency**.

6. In the **What it will contain** tab, enter the subject and text of the email message. Clear the email template if it does not apply to your outreach notification or you have defined the email content in the corresponding outreach notification.

7. Click **Submit**.

8. In the Notifications list, open the notification that you added and click **Preview Notification**.

9. Review the notification and modify as necessary.

10. Click **Update**.

**Modify notifications used with Emergency Outreach**

The administrator can modify email notifications used with Emergency Outreach.

**Before you begin**

Review the details about planning for, creating, and modifying system notifications by starting with **Create an email notification**.

Role required: admin

**Procedure**

1. Navigate to **Emergency Outreach > Send Outreach**, and then select the Content configuration tab.

2. In the **Response Mode** field, select the mode of the outreach notification to change. The default notification for that response mode appears. If it does not appear, search for the notification by name and select it.
Default email notifications by application

<table>
<thead>
<tr>
<th>Application</th>
<th>Notification name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Outreach</td>
<td>Employee Check-ins</td>
</tr>
<tr>
<td>Employee Readiness Surveys</td>
<td>Outreach Surveys</td>
</tr>
<tr>
<td>Employee Health Screening</td>
<td>Daily Health Verification</td>
</tr>
<tr>
<td>Contact Tracing</td>
<td>• Employee Daily Log Alert</td>
</tr>
<tr>
<td></td>
<td>• User Privacy Consent</td>
</tr>
<tr>
<td></td>
<td>• Notify Exposed Contact</td>
</tr>
</tbody>
</table>

3. Click the preview icon (i) beside the Notification field, and then click Open record.

4. In the notification record, modify the details of the notification. Follow the requirements for the particular notification for the application. To review the requirements for each application, see Add email notifications for use with Emergency Outreach.

5. Click Preview Notification and verify your changes. Ensure that the information required in the notification is correct and the links are valid.

6. When you’re finished, click Update.

Results
The modified notification is used for future outreach notifications for the corresponding application.

Add a Safe Workplace audience for Emergency Outreach
Add a collection of users for Emergency Outreach notifications. Target specific users based on criteria such as location, department, or group.

Before you begin
The Safe Workplace audience feature is available if you have purchased Employee Readiness Core.

Role required: sn_imt_checkin.checkin_admin or admin

Procedure
1. Navigate to Emergency Outreach > Safe Workplace Audience and click New.
2. In the Name field, enter a descriptive name for the audience.
3. Indicate the users who should receive notifications.

<table>
<thead>
<tr>
<th>Method</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add users manually</td>
<td>Select the users that you want to add to the audience in the Users field.</td>
</tr>
<tr>
<td>Upload a spreadsheet of users</td>
<td>Click the link to add a file in the Upload file field.</td>
</tr>
<tr>
<td>Method</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>The header of the first column of the spreadsheet must be user_name if you upload a list of user IDs or email if you upload a list of email addresses.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If you have more than 500 entries, split the spreadsheet into multiple files.

<table>
<thead>
<tr>
<th>Use additional criteria based on common User [sys_user] table fields</th>
<th>a. Select values for the <strong>Groups</strong>, <strong>Roles</strong>, <strong>Companies</strong>, <strong>Locations</strong>, or <strong>Departments</strong> fields.</th>
</tr>
</thead>
<tbody>
<tr>
<td>b. Select a value in the <strong>Audience criteria</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• Include all of the users listed in the Users field and any additional users who fulfill at least one of the other criteria by selecting <strong>Any of the criteria</strong> (OR).</td>
<td></td>
</tr>
<tr>
<td>• Include only users who fulfill all selected criteria by selecting <strong>All the criteria</strong> (AND). Any users listed in the Users field are included in the audience only if they also fulfill all the additional criteria.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enter conditions in the condition builder</th>
<th>a. Either retain the default setting of the User [sys_user] table or select a different table and select a column in that table to view its fields.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The condition builder lists fields based on your selection. Scroll to the bottom of the list and select <strong>Show related fields</strong> to view fields from related tables.</td>
<td></td>
</tr>
<tr>
<td>The number of users that the audience will contain is shown below the <strong>Audience criteria</strong> field. As you add criteria, check this number to ensure that users are added and filtered as you intend.</td>
<td></td>
</tr>
<tr>
<td>b. Create the condition.</td>
<td></td>
</tr>
<tr>
<td>For example, you could specify one floor of a particular building or users who report to a particular manager.</td>
<td></td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Configure Emergency Outreach response options

Configure the response options that employees choose from to respond to an Emergency Outreach health status request. You can modify the base system responses, add new responses, and deactivate responses you no longer use.

**Before you begin**

Role required: sn_imt_checkin.checkin_admin or admin
About this task
Response options appear in the Emergency Outreach email notification that employees receive.

Email message with responses

Hi Vivian,
Your voluntary participation in this check-in helps ServiceNow protect everyone’s health. Please know that any information you submit will be confidential.

To participate, select the statement that applies to you today:
I’d prefer not to say
I have symptoms of a fever, cough, or shortness of breath
I do not have symptoms of a fever, cough, or shortness of breath
I am currently under Quarantine
Update your response at: LINK

For more information, see the latest CDC guidelines.
Thanks for your help in keeping our employees safe!
ServiceNow

Unsubscribe | Notification Preferences

Procedure
1. Navigate to Emergency Outreach > Response Options.
2. Optional: Change the text of a response option.
   a. Open the response option.
   b. Edit the text in the Response text field.
   c. Click Update.
3. Optional: Change the order in which response options appear.
   The easiest way to change the order is to use the list edit feature in the list of response options. You can also open each option to update the order number. Responses appear in numerical order.
   a. In the Order list, double-click the order value to update.
b. Enter the number and click the green check mark icon.

c. Verify that the responses appear in the appropriate order by clicking the **Order** column header until it is sorted in descending order.

4. **Optional:** Add a response option.

   a. In the Response Options list, click **New**.

   b. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response text</td>
<td>The text the user can select as a response.</td>
</tr>
</tbody>
</table>
   | Order          | The number that specifies the position of this response in the list. To put the new response:  
                   | • First, give it the lowest number.                                           |
                   | • In the middle, give it a number between the numbers of the responses above and below. |
                   | • At the end, give it the latest number.                                     |
   | Response value | Read-only, unique value based on the response text.                         |
   | Active         | Option for ensuring that this response option appears in the notification.  |
   | SMS Option     | The number a user selects to reply to an SMS notification with this response. Every SMS option must have a unique number. |
   | **Note:**      | Assign a number if your company will use this response in SMS notifications. |
   | Response mode  | The mode of the outreach notification, such as Outreach Acknowledgements.    |

   c. Click **Submit**.

5. **Optional:** Deactivate a response option by clearing the **Active** check box and clicking **Update**.

**Create an Emergency Outreach notification channel**

Create a notification channel to send health status requests using your company’s preferred communication method, such as the Slack or Microsoft Teams collaboration platforms. Create the notification channel using a script or a subflow.

**Before you begin**

Role required: sn_imt_checkin.checkin_admin or admin

**About this task**

After you create a notification channel, you can select the channel when sending a notification. The channel uses the specified subject and body, and sends notifications to the users that you select when you send the health status request.
For example, your company’s IT network group has a Slack channel that they monitor more closely than email. Create a Slack notification channel. To communicate with IT network group members, select the group as the target audience and select the Slack notification channel.

If the **Email notification** and **Now Mobile Push notification** check boxes are selected, all three notifications are sent. To use only the Slack notification channel, clear these two check boxes.

**Procedure**

1. Navigate to **Emergency Outreach > Channels.**
2. Click **New.**

![Emergency Outreach Channels](image)

3. Enter the name of your notification channel.
   Use a short name that indicates the communication method to make it easy for the requester to pick the correct channel.

4. In the **Subject** field, enter the subject of your notification channel.
5. In the **Body** field, enter the body message.
6. Create a script notification channel.
   a. In the **Notification type** field, leave the default notification type of **Script.**
   b. In the **Script** field, replace the code in the comment with the script to connect to your channel.

**Example**

```javascript
// sendNotification(responses.acknowledgementsGr.user.email,
```
channelGr.subject, channelGr.body);

For information about JavaScript APIs for GlideRecord, see GlideRecord - Scoped.

c. Click Submit.

Example
The following example includes code to count the number of acknowledgements and survey instances generated when the notification is sent. It displays the number of acknowledgements and survey instances that succeeded. Use this information to review and handle errors that appear in the Delivery Log related list in the Outreach record.

```javascript
(function notify(responses, channelGr) {
  var record = responses.mode === 'acknowledgements' ? responses.acknowledgementsGr : responses.surveyInstancesGr;
  var totalCount = record.getRowCount();
  var numSent = 0;
  while (record.next()) {
    try {
      // sendNotification(record.user.email, channelGr.subject, channelGr.body)
      numSent += 1;
    } catch (err) {
      gs.error('Error occurred: ' + err.message);
    }
  }
  return { total_count: totalCount, sent_count: numSent };
})(responses, channelGr);
```

7. Create a subflow notification channel.

a. Create a subflow to use in the outreach notification. For information about creating, publishing, and testing subflows, see Subflows. Use the following inputs in the subflow that you create:

- **mode** (string)
- **acknowledgements** (Records of sn_imt_checkin_check_in_acknowledgement)
  
  If the mode is **acknowledgements**, then acknowledgements are set to a valid GlideRecord and **survey_instances** is null.

- **survey_instances** (Records of asmt_assessment_instance)
  
  If the mode is **survey_instances**, then **survey_instances** is set to a valid GlideRecord and **acknowledgements** is null.

- **channel** (Reference of sn_imt_checkin_channels)

  The following outputs are optional:

  - **total_count** (integer)
  - **sent_count** (integer)

  To review these outputs, include the number of total acknowledgements or surveys versus the successful acknowledgements or surveys.

b. Select the Subflow notification type.
The Script section changes to Flow, and the **Subflow** reference field appears.

c. Select the subflow that you created.

8. Click **Submit**.

Trouble?
When an outreach is sent using a custom notification channel, a Delivery Logs related list appears in the Outreach message.

1. Test the notification channel for an outreach message, and open the failed record to review the error message.
2. Fix errors that caused the notification to fail.
3. Continue testing the notification channel until it no longer fails.

**Example: Slack channel script**

> **Note:** The following script is for reference only. Refer to it when you develop a notification channel script for your environment.

```
(function notify(responses, channelGr) {
    var createClient = function () {
        var client = new sn_ws.RESTMessageV2();
        client.setRequestHeader('Authorization', 'Bearer xoxb-222222222222-11111111111-000000000000000000000000');
        client.setRequestHeader("Accept", "application/json");
        client.setRequestHeader('Content-type', 'application/json');
        return client;
    };

    var getEmailToSlackIdMap = function (users) {
        var emailToSlackIdMap = {};
        for (var i = 0; i < users.length; i++) {
            var email = users[i].profile.email;
            if (email) {
                emailToSlackIdMap[email] = users[i].id;
            }
        }
        return emailToSlackIdMap;
    };

    var runSlackCommand = function (method, params) {
        var client = createClient();
        client.setHttpMethod('post');
        client.setEndpoint('https://slack.com/api/' + method);
```
client.setRequestBody(JSON.stringify(params));
var response = client.execute();
if (response.getStatusCode() < 200 || response.getStatusCode() > 299) {
    throw new Error('Failure running ' + method + ':\n' + response.getBody());
}

var body = JSON.parse(response.getBody());
if (!body.ok) {
    throw new Error(body.error);
}

return body;

var sendMessage = function (userId, message) {
    var openConversationResponse = runSlackCommand('conversations.open', { users: userId });
    var channel = openConversationResponse.channel.id;
    runSlackCommand('chat.postMessage', { channel: channel, text: message });
};

var users = runSlackCommand('users.list').members;
var emailToSlackIdMap = getEmailToSlackIdMap(users);
var body = channelGr.getValue('body') || '<p></p>';
var record = responses.mode === 'acknowledgements' ? responses.acknowledgementsGr : responses.surveyInstancesGr;
var numSent = 0;

while (record.next()) {
    var email = record.user.email + '';

    var link = responses.mode === 'acknowledgements'
        ? gs.getProperty('glide.servlet.uri') + record.getLink(true)
        : gs.getProperty('glide.servlet.uri') + 'sp?id=take_survey&instance_id=' + record.getUniqueValue();

    var message = body + '\n' + link;

    var slackId = emailToSlackIdMap[email];
    if (slackId) {
        sendMessage(slackId, message);
        numSent += 1;
    }
}

return { sent_count: numSent };
Before you begin
Familiarize yourself with Survey administration. Then meet with other emergency response team stakeholders to plan the changes to the survey. Decide whether to edit the existing survey before you send it to employees, or to create one or more new surveys.

Role required: sn_imt_checkin.checkin_admin, survey_creator, survey_admin, or admin

About this task
Users with the sn_imt_checkin.checkin_admin role have the survey_creator role, and are made owners of the default readiness survey. Users with the survey_creator role can edit or copy the default survey. These users can also add another readiness survey and add other users as owners to collaborate with them.

Survey definition owners

| * Name | Employee workplace readiness survey |
| Description | This survey will help to determine the employee's ability to return to the workplace. |
| State | Published |
| Active | ✓ |
| Owners | Abel Tutor, Abraham Lincoln |

Procedure
1. Navigate to Surveys > View Surveys and open the Employee workplace readiness survey.
2. Using the plan that you made for changing the survey, update any of the following survey elements.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add owners</td>
<td>Click the lock icon (🔒) beside Owners to unlock the list of survey owners. Add the user to collaborate with on this survey.</td>
</tr>
<tr>
<td>Update the introductory and ending text</td>
<td>Click the Introduction &amp; End Notes section tab and update the text.</td>
</tr>
</tbody>
</table>
| Work with the questions             | a. In the Metric Categories related list, click Please complete this confidential survey. Questions appear in the Assessment Metrics related list.  
                                         b. Click the question to open the Survey Question form. Modify and complete your edits. The answers are listed in the Assessment Metric Definitions related list. |
| Work with the question responses    | In the Assessment Metric Definitions related list, select the response to edit. Update the response as desired. |

3. Complete any other changes to the survey options, and click Update.

Results
The modified survey is used for future outreach surveys.

Add additional Employee Readiness Surveys
Create one or more surveys to use for different workplaces or to evaluate other areas of concern. Start by planning the surveys carefully to gather the best data for your evaluation of readiness to return to the workplace.

Before you begin
Role required: sn_imt_checkin.checkin_admin, survey_creator, survey_admin, or admin

About this task
Consider how you want to begin to reopen your workplace, and what you must understand about the employees before you can begin. Work with a user with the survey_admin role in your company to plan the types of questions and responses for the survey. For information about adding surveys, see Survey administration and Survey designer.

Procedure
• To create a survey, navigate to Surveys > View Surveys.
• Select New or Survey Designer and enter the information to complete the survey from the plan that you made. Decide on a naming convention to use for surveys, so that a user with the sn_imt_checkin.checkin_admin role knows which one to select when sending outreach surveys. For example, Readiness survey India or Customer service employees return readiness.

Related information
Send a readiness survey in Emergency Outreach
Send notifications for an emergency

Use Emergency Outreach to notify users to report their health status. Use Emergency Outreach also to quickly notify users of important information if there is an emergency.

Before you begin

Users must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Note the following requirements to be able to send and receive SMS notifications:

- Your company must have a Safe Workplace suite subscription and Employee Readiness Core installed.
- Your company must have a Twilio account and phone number.
- The Notify plug-in and the Notify-Twilio Direct driver must be enabled.
- The Label for your number in Notify > Messages must be set to Outreach.

For more information on configuring Notify and the Notify-Twilio Direct driver, see Notify.

Role required: sn_imt_checkin.checkin_admin or admin

About this task

Emergency Outreach is available in the ServiceNow Store without a subscription. The base system provides a notification that requests a response from the recipient regarding their health status. The responses are stored as outreach records and the health status is updated each time the user responds with a change.

Some of the Safe Workplace suite apps leverage the Emergency Outreach notification feature to communicate with users. The Safe Workplace suite apps provide more flexible functions than using Emergency Outreach as a standalone app.

- Employee Readiness Surveys provides notification with a survey link to assess user readiness to return to the workplace.
- Employee Readiness Core provides the ability to use Safe Workplace audiences to simplify the selection of recipients for an outreach.
- Employee Health Screening: Request that users acknowledge their health status verification each day before they can return to the workplace.
- Contact Tracing supports these outreach notification needs:
  - A scheduled notification for returning users to fill out a daily contact log.
  - A request to review the organization’s privacy policy and provide consent to use their contact tracing data.

The following procedure is applicable to the use of Emergency Outreach as a standalone app or with Safe Workplace suite applications.

Procedure

1. Navigate to Emergency Outreach > Send Outreach.
2. Enter a name that describes the purpose of the outreach notification.
   
   Example
   - For example, Global health status check-in or London office health status check-in.
3. Optional: In the Description field, describe the purpose for sending the outreach.
4. On the When to run tab, specify when the outreach should be sent.
### To send the notification on demand

Keep the default Mode value of None. The outreach is sent when you click Send Notification.

#### a. Set the mode to Scheduled.

#### b. In the Run field, indicate how often the outreach should be sent. The options are Daily, Weekly, Monthly, or Once.

- For daily outreaches, enter the time that you want to send the outreach. You can specify hours, minutes, and seconds. For example, enter 17:30:00 to send the outreach at 5:30 p.m. If you don’t want the outreach to be sent on certain days of the week, select those days in the Exclude field.

- For weekly outreaches, select the day of the week and the time you want to send the outreach.

- For monthly outreaches, select the day of the month and the time you want to send the outreach. If you select a day that does not exist in all months, for example 31, the outreach will run on the last day of the month.

- For outreaches that are only sent once, schedule the date and time that you want to send the outreach in the Starting field.

#### c. (Optional) To send the outreach based on the time zone set in the user profile, select the Send in local time check box.

The outreach messages reference a send time based on the time zone of the user sending the notification. For example, if the sender is in the US Pacific time zone, an outreach scheduled to be sent at 4:30 p.m. shows a send time of 16:30:00 for users in that time zone and 18:30:00 (6:30 p.m.) for users in the US Central time zone because the Pacific time zone is two hours earlier than the Central time zone.

### Note:

In prior releases of Emergency Outreach, notification scheduling was configured by clicking Schedule and entering details in a pop-up window. Scheduling is now configured on the When to run tab.

Scheduled outreaches that you sent prior to upgrading provide the previous scheduling function if you need to resend it. This functionality provides the flexibility to set up new scheduled outreaches and to resend prior scheduled outreaches.

### 5. To identify who will receive the outreach, perform one of the following actions.

<table>
<thead>
<tr>
<th>Installed apps</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Outreach standalone</td>
<td>On the Select targeted audience tab, select the combination of users to send the outreach notification to. Choose from user lists, groups, departments, locations, or other search filters such as building, cost center, or country code.</td>
</tr>
<tr>
<td>With Safe Workplace</td>
<td>On the Safe Workplace Audience tab, select the name of the audience to send the outreach notification to.</td>
</tr>
</tbody>
</table>
6. Click **Save**.
The outreach details are saved and related lists appear. The Additional Channels related list is used to specify additional custom channels to use when you send the notification. Other related lists are filled in with outreach recipients and their status after you send the notification.

7. Click the **Content configuration** tab and leave the default response mode **Outreach Acknowledgements**.

8. On the **Content configuration** tab, specify how to send the outreach notification.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disable the email notification</strong></td>
<td>Clear the <strong>Email</strong> check box.</td>
</tr>
<tr>
<td><strong>Select a different notification</strong></td>
<td>Click the lookup icon (🔍) and select the notification to use.</td>
</tr>
<tr>
<td><strong>Review and edit the introductory message</strong></td>
<td>Modify the subject and body as desired. The default message template asks users to submit their health status regarding infectious diseases, such as COVID-19. The user selects a response from a list of possible responses.</td>
</tr>
<tr>
<td><strong>Send a mobile push notification</strong></td>
<td></td>
</tr>
</tbody>
</table>
| a. Select the **Now Mobile Push Notification** check box. | The check box is active if the ServiceNow NowMobile App Screens and Applet Launcher [com.glide.mobile-employee] is activated. The push notification content appears when the check box is active, and you can modify it. 
| b. Modify the push message text as desired. | Push notifications use the ServiceNow Request Application notification device. When mobile application is registered to an instance, this notification device is automatically created in the user’s notification preferences. Ensure that this device is active for the users that you want to receive the push notification. |
| **Send an SMS notification** |  
| a. Select the **Message via SMS** check box. | For existing outreaches, if **Message via SMS** is selected, the **SMS message** is not autopopulated. 
| b. Modify the SMS message text. |  
| **Use a custom notification channel** | a. Click the Additional Channels related list, click **Edit**, and move the channel to the Additional Channels List. 
| b. Click **Save**. | If the **Email notification**, **Now Mobile Push notification**, and **Message via SMS** check boxes are selected, all four notifi-
Option | Action
--- | ---
| | communications are sent. To use only the custom notification channel, clear these three check boxes.

9. Click **Send Notification**.
The notification is sent immediately or at the time specified on the **When to run** tab. As responses are received, they appear in the Outreach Acknowledgements related list.

**What to do next**
Review the Emergency Outreach acknowledgements.

**Related information**
- Add a Safe Workplace audience for Emergency Outreach
- Send an Outreach notification for the daily contact log
- Send an Emergency Outreach notification for employee privacy consents in Contact Tracing
- Send a readiness survey and view responses
- Send notifications for daily health verification

**Review Emergency Outreach acknowledgements**
Review the list of acknowledgements from an outreach notification to see each employee’s status. Resend the outreach notification to employees who did not respond.

**Before you begin**
Role required: sn_imt_checkin.checkin_admin or admin

**Procedure**
1. Navigate to **Emergency Outreach > View Outreaches** and open the outreach notification to view.
Responses are listed in the Outreach Acknowledgements related list. As employees respond to the notification, their records are updated with their status and whether they responded by email, mobile, or SMS.

If employees haven't responded yet, click **Resend Notification**. The notification is sent again only to employees who have not yet responded.

**Note:** If employees update their status in a subsequent email, the employee's record is updated in the original event and in the dashboard. Employees cannot change their status through mobile push notifications.
**Trouble?**

When an outreach is sent using a custom notification channel, a Delivery Logs related list appears in the outreach record. It lists successful and failed log records for the notification that you sent.

Depending on how the notification channel was created, success messages can show the number of notifications that were successfully sent, and the total number of notifications that were requested. If the total count is higher than the sent count, the difference is the number of notifications that failed.

Open the record and investigate the cause of the errors. Correct the cause of the failures, or use another notification method for the users whose notification was not sent.

2. **Optional:** View the Emergency Outreach dashboard, which summarizes data from employee notification events.
   
   a. Navigate to Emergency Outreach > View Dashboard.
   
   b. Review the accumulated notification data and trend.
   
   c. Click an event in the Events pie chart to show its data.

![Emergency Outreach Dashboard](image)

**Send notifications for daily health verification**

Use Emergency Outreach to notify users to report their daily health status.

**Before you begin**

Users must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Note the following requirements to be able to send and receive SMS notifications:
• Your company must have a Safe Workplace suite subscription and Employee Readiness Core installed.
• Your company must have a Twilio account and phone number.
• The Notify plug-in and the Notify-Twilio Direct driver must be enabled.
• The Label for your number in Notify > Messages must be set to Outreach.

For more information on configuring Notify and the Notify-Twilio Direct driver, see Notify.
Role required: sn_imt_checkin.checkin_admin or admin

Procedure
1. Navigate to Emergency Outreach > Send Outreach.
2. Enter a name that describes the purpose of the outreach notification.

   Example
   For example, Global daily health verification or London office daily health verification.

3. Optional: In the Description field, describe the purpose for sending the outreach.
4. On the When to run tab, specify when the outreach should be sent.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To send the notification on demand</td>
<td>Keep the default Mode value of None. The outreach is sent when you click Send Notification.</td>
</tr>
<tr>
<td>To schedule the notification</td>
<td>a. Set the mode to Scheduled.</td>
</tr>
<tr>
<td></td>
<td>b. In the Run field, indicate how often the outreach should be sent. The options are Daily, Weekly, Monthly, or Once.</td>
</tr>
<tr>
<td></td>
<td>• For daily outreaches, enter the time that you want to send the outreach. You can specify hours, minutes, and seconds. For example, enter 17:30:00 to send the outreach at 5:30 p.m. If you don’t want the outreach to be sent on certain days of the week, select those days in the Exclude field.</td>
</tr>
<tr>
<td></td>
<td>• For weekly outreaches, select the day of the week and the time you want to send the outreach.</td>
</tr>
<tr>
<td></td>
<td>• For monthly outreaches, select the day of the month and the time you want to send the outreach. If you select a day that does not exist in all months, for example 31, the outreach will run on the last day of the month.</td>
</tr>
<tr>
<td></td>
<td>• For outreaches that are only sent once, schedule the date and time that you want to send the outreach in the Starting field.</td>
</tr>
<tr>
<td></td>
<td>c. (Optional) To send the outreach based on the time zone set in the user profile, select the Send in local time check box.</td>
</tr>
</tbody>
</table>

The outreach messages reference a send time based on the time zone of the user sending the notification. For example, if the sender is in the US Pacific time zone, an outreach scheduled to be sent at 4:30 p.m. shows a send time of 16:30:00 for
users in that time zone and 18:30:00 (6:30 p.m.) for users in the US Central time zone because the Pacific time zone is two hours earlier than the Central time zone.

**Note:**

In prior releases of Emergency Outreach, notification scheduling was configured by clicking Schedule and entering details in a pop-up window. Scheduling is now configured on the When to run tab.

Scheduled outreaches that you sent prior to upgrading provide the previous scheduling function if you need to resend it. This functionality provides the flexibility to set up new scheduled outreaches and to resend prior scheduled outreaches.

5. Identify who will receive the outreach notification through either the Emergency Outreach or Safe Workplace application.

<table>
<thead>
<tr>
<th>App</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Outreach standalone</td>
<td>On the Select targeted audience tab, select the combination of users to send the outreach notification to. Choose from user lists, groups, departments, locations, or other search filters such as building, cost center, or country code.</td>
</tr>
<tr>
<td>Safe Workplace</td>
<td>On the Safe Workplace Audience tab, select the name of the audience to send the outreach notification to.</td>
</tr>
</tbody>
</table>

6. Click Save.

The outreach details are saved and related lists appear. You can use the Additional Channels related list to specify additional custom channels to use when you send the notification. Other related lists are populated with outreach recipients and their statuses after you send the notification.

7. Click the Content configuration tab and select the response mode Daily Health Verification.

8. On the Content configuration tab, specify how to send the outreach notification.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable the email notification</td>
<td>Clear the Email check box.</td>
</tr>
<tr>
<td>Select a different notification</td>
<td>Click the lookup icon (🔍) and select Daily Health Verification</td>
</tr>
<tr>
<td>Review and edit the introductory message</td>
<td>Modify the subject and body. The notification includes the link to the daily health verification form that the user can submit in the instance or mobile app.</td>
</tr>
<tr>
<td>Send a mobile push notification</td>
<td>a. Select the Now Mobile Push Notification check box.</td>
</tr>
<tr>
<td></td>
<td>The check box is active if the ServiceNow NowMobile App Screens and Applet Launcher [com.glide.mobile-employee] is activated. The push notification content appears when the check box is active.</td>
</tr>
<tr>
<td></td>
<td>b. Modify the push message text as desired.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Send an SMS notification** | a. Select the **Message via SMS** check box.  
   b. Modify the SMS message text as required.  
   
   **Note:** For existing outreaches, if **Message via SMS** is selected, then the **SMS message** is not autopopulated.  
   
   c. Click **Save**.  
   A daily health verification link is not sent when you send an SMS notification. Users respond to the SMS message directly with their status.  
   SMS reply options are dynamically populated from the Response Options table [sn_imt_checkin_response_option]. |
| **Use a custom notification channel** | a. Click the Additional Channels related list, click **Edit**, and move the channel to the Additional Channels List.  
   b. Click **Save**.  
   If the **Email notification**, **Now Mobile Push notification**, and **Message via SMS** check boxes are selected, all four notifications are sent. To use only the custom notification channel, clear these three check boxes. |

9. Click **Send Notification**.  
The notification is sent immediately or at the time specified on the **When to run** tab. As responses are received, they appear in the Health Verification Acknowledgements related list. New records are created for each day in the Health Verification Acknowledgements related list for each user included in the target audience.

**What to do next**  
Review the daily health verification acknowledgements. Resend the notification to users who have not responded for the day. If a user submits a response via a previous day notification, the status is updated for the notification of the latest date sent to the user.

For example, say you send the daily health notification to Zane from August 1 to August 10. If Zane uses the link in the notification sent on August 4, then the acknowledgement status for Zane is updated in the notification sent on August 10.

**Related information**  
[Add a Safe Workplace audience for Emergency Outreach](#)  
[Send an Outreach notification for the daily contact log](#)  
[Send an Emergency Outreach notification for employee privacy consents in Contact Tracing](#)  
[Send a readiness survey and view responses](#)
**Review daily health verification acknowledgements**

Review the list of acknowledgements from the daily health verification notification to see each user's status. Resend the outreach notification to users who did not respond.

**Before you begin**
Role required: sn_imt_checkin.checkin_admin or admin

**Procedure**
1. Navigate to Emergency Outreach > View Outreaches.
2. Open the Daily Health Verification outreach notification.
   Responses are listed in the Health Verification Acknowledgements related list. As users respond to the notification, their records are updated with their acknowledgements statuses.
   
   If users haven't responded yet, click Resend Notification. The notification is sent again only to users who have not yet responded.

   **Note:** If users submit their status in a subsequent email, the user’s record is updated in the original event for the day.

   New records are created in the Health Verification Acknowledgements related list for each user included in the target audience. If a user submits a response through a previous day’s notification, the response is updated for the latest date the user was sent the notification.

**Send a readiness survey and view responses**

Use Emergency Outreach to send a workplace readiness survey. Review the survey responses to assist with your plans to reopen your workplace.

**Before you begin**
In order to send a survey, you must have the Employee Readiness Surveys application installed.

Employees must have the Now® Mobile app installed on their phones to receive mobile push notifications. For more information, see Now Mobile app.

Role required: sn_imt_checkin.checkin_admin or admin

**Procedure**
1. Navigate to Emergency Outreach > Send Outreach.
2. Enter a name that describes the purpose of the survey.

   **Example**
   For example, “San Diego readiness survey” or “Employee readiness Europe.”

3. **Optional:** In the Description field, describe the purpose for sending the outreach survey.
4. On the When to run tab, specify when the outreach should be sent.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To send the notification on demand</strong></td>
<td>Keep the default Mode value of None. The outreach is sent when you click Send Notification.</td>
</tr>
</tbody>
</table>
| **To schedule the notification** | a. Set the mode to Scheduled.  
   b. In the Run field, indicate how often the outreach should be sent. The options are Daily, Weekly, Monthly, or Once. |
Option | Action
---|---
• For daily outreaches, enter the time that you want to send the outreach. You can specify hours, minutes, and seconds. For example, enter 17:30:00 to send the outreach at 5:30 p.m. If you don’t want the outreach to be sent on certain days of the week, select those days in theExclude field.
• For weekly outreaches, select the day of the week and the time you want to send the outreach.
• For monthly outreaches, select the day of the month and the time you want to send the outreach. If you select a day that does not exist in all months, for example 31, the outreach will run on the last day of the month.
• For outreaches that are only sent once, schedule the date and time that you want to send the outreach in theStarting field.
c. (Optional) To send the outreach based on the time zone set in the user profile, select theSend in local time check box.

The outreach messages reference a send time based on the time zone of the user sending the notification. For example, if the sender is in the US Pacific time zone, an outreach scheduled to be sent at 4:30 p.m. shows a send time of 16:30:00 for users in that time zone and 18:30:00 (6:30 p.m.) for users in the US Central time zone because the Pacific time zone is two hours earlier than the Central time zone.

Note:
In prior releases of Emergency Outreach, notification scheduling was configured by clicking Schedule and entering details in a pop-up window. Scheduling is now configured on theWhen to run tab.

Scheduled outreaches that you sent prior to upgrading provide the previous scheduling function if you need to resend it. This functionality provides the flexibility to set up new scheduled outreaches and to resend prior scheduled outreaches.

5. Identify who will receive the outreach notification through either the Emergency Outreach or Safe Workplace application.

<table>
<thead>
<tr>
<th>App</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Outreach standalone</td>
<td>On the Select targeted audience tab, select the combination of users to send the outreach notification to. Choose from user lists, groups, departments, locations, or other search filters such as building, cost center, or country code.</td>
</tr>
<tr>
<td>Safe Workplace</td>
<td>On the Safe Workplace Audience tab, select the name of the audience to send the outreach notification to.</td>
</tr>
</tbody>
</table>

6. Click Save.
The survey outreach details are saved and related lists appear. The Additional Channels related list is used to specify additional custom channels to use when you send the survey notification. The Survey Instances related list is filled in with outreach recipients and their survey status after you send the notification.

7. Click the Content configuration tab, and in the Response Mode field, select Survey.
Use the **Status** field that appears on the outreach form to confirm the creation status of your survey instances when you send the notification.

**8.** Select the survey to use or keep the default **Employee workplace readiness survey**.

**9.** To set a due date for the survey, enter a value in the **Duration** field.

The **Duration** field sets the amount of time allowed to complete assigned survey instances, starting from the time that the survey instance is generated. The survey instances created for the outreach use the **Duration** field for their due date instead of the **Assessment duration** field on the survey.

**10.** Specify how to send the outreach notification.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable the email notification</td>
<td>Clear the <strong>Email</strong> check box.</td>
</tr>
<tr>
<td>Select the survey</td>
<td>Select the survey to use or keep the default <strong>Employee workplace readiness survey</strong>.</td>
</tr>
<tr>
<td>Select a different notification</td>
<td>Click the lookup icon (🔍) and select the notification to use.</td>
</tr>
</tbody>
</table>
| Review and edit the introductory message | Modify the subject and body as desired.  
The notification includes the survey link that the employee can take in the instance or mobile app. |

**Send a mobile push notification**

- a. Select the **Now Mobile Push Notification** check box.  
The check box is active if the ServiceNow NowMobile App Screens and Applet Launcher [com.glide.mobile-employee] is activated. The push notification content appears when the check box is active, and you can modify it.

- b. Modify the push message text as desired.  
Push notifications use the ServiceNow Request Application notification device. When mobile application is registered to an instance, this notification device is automatically created in the user’s notification preferences. Ensure that this device is active for the users that you want to receive the push notification.

**Use a custom notification channel**

- a. Click the Additional Channels related list, click **Edit**, and move the channel to the Additional Channels List.  

- b. Click **Save**.  
If the **Email notification** and **Now Mobile Push notification** check boxes are selected, all three notifications are sent. To use only the custom notification channel, clear these two check boxes.

**11.** Click **Send Notification**.  
The notification and survey link are sent to the target audience. A survey instance is created for each recipient, with the status **Ready to take**.
When you send the outreach survey notification, any open survey instances for the recipients are canceled. When you resend a notification for an outreach, the open survey instances are not canceled.

If you have a recurring scheduled outreach, such as a survey that is sent daily or weekly, each time the outreach is sent, the open surveys from the previous day or week are canceled.

You can’t create an outreach survey notification if the survey is being used in a scheduled outreach notification.

After the notification is sent, the Emergency Outreach Instance Logs related list is displayed. The **Instance creation status** field values match the status on the outreach form.

- **Success**: An instance was created for every recipient in the target audience. The number of Assessment instances created should match the number of Target assessment instances or recipients of the survey.

- **Partial Success**: An instance was created for some recipients in the target audience but not all of them. The number of Target assessment instances and Assessment instances created do not match.

  Send the notifications to users who did not receive a notification or instance by clicking **Send to Remaining**.

- **Failed**: No instances were created and no surveys were sent.

  Resend the notification to all users by clicking **Send Notification** again.

12. To view survey instances, navigate to **Emergency Outreach > View Outreaches** and open the survey notification to view.

   📌 **Note**: Users with the **sn_imt_checkin.checkin_admin** role can see all survey instances. Users who have been assigned the survey can see only their own survey instances.

As employees complete the survey, the status updates in their survey instance.

If employees haven’t responded yet and instances were successfully created for all users, click **Resend Notification**. The notification is sent again only to employees who have not yet responded.

---

**Trouble?**

When an outreach is sent using a custom notification channel, a Delivery Logs related list appears in the outreach record. It lists successful and failed log records for the notification that you sent.
Depending on how the notification channel was created, success messages can show the number of notifications that were successfully sent, and the total number of notifications that were requested. If the total count is higher than the sent count, the difference is the number of notifications that failed.

Open the record and investigate the cause of the errors. Correct the cause of the failures, or use another notification method for the users whose notification was not sent.

13. To view the status of Outreach instances, navigate to Emergency Outreach > View Outreach Instance Logs.

14. To view the interactive scorecard showing all responses and the results, click the View Survey Scorecard related link.

Click any area of a chart to see the corresponding records.

Report your health status
If you receive an email, mobile push notification, or SMS notification to report your health status, you can update your status from the message.

Before you begin
To receive mobile push notifications, you must have the Now® Mobile app.
Role required: none
Procedure

• To reply to an email notification, select a response from the message and email it.

Example

To reply to a mobile push notification:

1. Tap the notification to open the message.
2. In the message, tap **Check In**.
3. **Optional:** On the Check In screen, provide your location and additional comments.
4. Tap **Status** and then select a response.

Example

To reply to an SMS notification:

1. Open the SMS message on your phone.
2. Reply with the number of your response.
Results
After you reply to the notification, your response is sent to you and your employer. A record for your response is also updated. Your personal information is secure. Only the staff managing the health situation have access to your response.

Response scripts
Use response scripts to automatically take actions based on user responses to survey questions. Response scripts can be used to create or update records across any of the Emergency Response Management and Safe Workplace suite apps.

Each response script is associated with a survey. The response script runs if a user completes the associated survey and their answers match the response criteria.

Note: The Employee Readiness Surveys app must be installed to use response scripts.

Included response scripts
Emergency Outreach provides the pre-built Request PPE response script.

The Request PPE response script requires the Workplace PPE Inventory Management app. This response script creates a PPE request for employees who complete the Employee workplace readiness survey and meet the response criteria for the health status, travel, and ready to return to the workplace questions.

The Request PPE response script is not active by default and must be manually activated. It is ready to activate without any modifications, but you can choose to edit the script to meet your company’s needs. To activate the Request PPE response script, navigate to Emergency Outreach > Response Scripts and click the Request PPE record. Select the Active check box, then click Update.

If you need to perform additional actions based on survey responses, you can create additional response scripts. Use the included Request PPE response script as an example to help create your own response scripts.

Create a response script
Create a response script to automatically create or update records based on user responses to survey questions.

Before you begin
Role required: sn_imt_checkin.checkin_admin

About this task
Response scripts can be used to create or update records across any of the Emergency Response Management and Safe Workplace suite apps. For example, you could create a response script to reserve a workspace for a user who is ready to return to the workplace.

Procedure
1. Navigate to Emergency Outreach > Response Scripts and click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Selected.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the script.</td>
</tr>
<tr>
<td>Survey</td>
<td>Survey that causes the script to run.</td>
</tr>
</tbody>
</table>
When a survey instance is completed by a user, the script runs if the user’s responses to the survey questions match the response criteria.

### Script

Script to insert or update a record.
The script should perform the following steps.

- Get the sys_id for the user who submitted the survey.

```javascript
var userSysId = userGr.getUniqueValue();
```

**Note:** The `userGr` variable is defined in the Run Response Scripts action. This action is used by the Response Script Actions flow, which runs the response scripts when a user completes a survey and fulfills the response criteria. The `userGr` variable is a user GlideRecord, so you can use it to get additional fields from the user as needed. For example, `userGr.getValue('location')` gets the user’s location.

- If the plugin that installs the table you want to write to is active, insert or update a record for the user.

**Note:** The following code is provided as an example only. You must provide the correct plugin, table, and field names in your script, and make any additional modifications that you require.

```javascript
//example code to insert a record
if (GlidePluginManager.isActive('plugin_name')) {
    var now_GR = new GlideRecord('table_name');
    now_GR.initialize();
    now_GR.user_field = userSysId;
    now_GR.field = 'value';
    //update additional fields here as needed
    now_GR.insert();
}

//example code to update an existing record associated with the user
if (GlidePluginManager.isActive('plugin_name')) {
    var now_GR = new GlideRecord('table_name');
    now_GR.get('user_field', userSysId);
    now_GR.field_to_update = 'value';
    //update additional fields here as needed
    now_GR.update();
}

//example code to update multiple existing records associated with the user
if (GlidePluginManager.isActive('plugin_name')) {
    var now_GR = new GlideRecord('table_name');
    now_GR.addQuery('user_field', userSysId);
    now_GR.setValue('field_to_update', 'value');
    //update additional fields here as needed
    now_GR.updateMultiple();
}
```

3. Save the response script record using the form context menu.
The Response Criteria related list is automatically populated with all questions from the associated survey.
4. Edit the response criteria to define the answers a user must provide for the response script to run.
   a. Define the required answer in the response criteria for relevant questions.
   b. Delete the response criteria for any questions that don't require a specific answer.
5. Click Update.

**Domain separation for Emergency Outreach**

This application fully supports domain separation service provider (SP) use cases. The following table lists the domain separation use cases for service providers (SPs) using this application.

### Domain separation use cases

<table>
<thead>
<tr>
<th>Use case</th>
<th>Functions</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP Internal - SP check-in admin uses the application to contact internal employees by email or through Now Mobile App.</td>
<td>Yes</td>
<td>None</td>
</tr>
<tr>
<td>SP External - SP check-in admin uses the application to contact tenant employees by email or through Now Mobile App.</td>
<td>Yes</td>
<td>None</td>
</tr>
<tr>
<td>Tenant - Tenant check-in admin uses the application to contact their employees (in their domain only) by email or through Now Mobile app.</td>
<td>Yes</td>
<td>None</td>
</tr>
</tbody>
</table>

Some modules in the Emergency Outreach application are affected by domain separation.

**SEND OUTREACH module (Create New for employee check-in table)**

- Notification can be configured to target users, groups, departments, locations or customized for conditional criteria
- Email is standard HTML
- Domain column exists

**RESPONSE OPTIONS module (Notification responses table)**

- Domain column exists
- Shows response links that appear in notifications

**VIEW OUTREACHES module (Employee check-in table)**

- Domain column exists
- Shows notification structure and a related list that contains all responses (Table: Check-In Acknowledgement); the response table has domain column row and business logic protections
- Can output an Excel spreadsheet that displays current responses and status

**DASHBOARD module**

- Reporting dashboard, shows aggregate of all notifications and their acknowledgment status
Emergency Self Report

During a crisis, the ServiceNow® Emergency Self Report application gives users a way to notify their organization of their health status. It also provides a workflow for qualified users to safely return to work. Managers and response teams can track user reporting.

In contrast to email or phone reporting and manual data consolidation, Emergency Self Report provides a digital workflow that captures and automatically rolls up user reporting data for analysis and action. The application offers benefits for various people within the organization, with different views displayed for various roles.

Use guided setup to implement Safe Workplace suite apps

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Users can report their status

A menu-driven interface enables users to report their status to their managers. Users can use the same interface to update their manager and global response team when they are ready to return to work. Managers can notify users when they may return.

User view

![Update your team about your health status](image)

If ServiceNow® Contact Tracing is installed, a case is created automatically for a user who self-reports as being in quarantine. If an active case exists for the user at the time of reporting, a note is added to the case for the self-reporting.

Managers can monitor the status of their teams

Managers can view a summary of their team’s reported status and the details of an individual person. They can reassign an affected user’s work to others on the team if the work is tracked in the ServiceNow instance. If users don’t have access to the application, the manager can submit a report on their behalf.
Manager view

Monitor your employees' health status

- My own health status
  - No updates yet

- Employees with symptoms or in quarantine
  - Employee: Armando Kolm, Health status: In quarantine
  - Employee: Bart Hachey, Health status: Reporting symptoms

Submit an update about your health status
- Person
  - Rob Phillips

- Health status
  - None

Save

Response teams can view the status of all teams

Response teams can view an overview dashboard that summarizes the status for all self-reported users. Data can be viewed and sorted in multiple ways for analysis and action.
Response team can work with HR tasks

HR tasks are created when a user self-reports. Each HR task is associated with a self-reported crisis task. The response team member can navigate to Emergency Self Response > HR tasks to view the list.
HR tasks do not have a specific workflow associated with them. They are created in the Open state, and closing the associated crisis task does not affect the HR task. Your organization can determine how to use or manage HR tasks, if at all. Review the HR task form to determine whether it can be of use within your response strategy.

**Use with other Emergency Response Management applications**

Emergency Self Report was originally developed to monitor and aid in stopping the community spread of COVID-19 among users. It is part of the suite of ServiceNow® Emergency Response Management applications built on the Now Platform® to assist companies in their emergency response efforts. With the Emergency Exposure Management application, you can identify users who might have been exposed. You can then contact affected users through the Emergency Outreach application. Both applications are available in the ServiceNow Store.

**Emergency Response Management for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Emergency Response Management applications ready and available to install on their instances without having to make any special requests. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

### Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.
Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to employees of government agencies in their individual capacities. Use of this application is being offered free of charge for a limited or extended time period and with no expectation of payment from the government agency to ServiceNow for use during that time period, nor does usage create an actual or implied future obligation on behalf of the government. ServiceNow hereby expressly waives any future claims for payment from the agency in connection with usage of the application. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Set up Emergency Self Report
To set up Emergency Self Report, install the application. Then configure user access, a dedicated knowledge base, and system properties.

Install Emergency Self Report
You can install Emergency Self Report if you have the admin role.

Before you begin
Role required: admin

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you've subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
• Workplace PPE Inventory Management (sn_imt_ppe)
• Employee Readiness Surveys (sn_imt_readiness)
• COVID-19 Global Health Data Set (sn_imt_c19datafeed)
• Contact Tracing (sn_imt_tracing)
• Emergency Self Report (sn_imt_quarantine)
• Workplace Safety Management (sn_wsd_core)
• Safe Workplace Dashboard (sn_imt_dashboard)
• Emergency Response Management for Now Mobile (sn_imt_mobile)
• Employee Travel Safety (sn_imt_travel)
• Health and Safety Testing (sn_imt_health_test)
• Vaccination Status (sn_imt_vaccine)

Procedure
1. Navigate to System Applications > All Available Applications > All.
3. Click Install.
   The Application installation dialog box opens.
4. Optional: Load the demo data by selecting the Load demo data check box.
   (Optional) For information about how to install or reinstall demo data after the initial installation, see the Work around to install demo data if application is already installed [KB0722909] article in the Now Support Knowledge Base.
5. Click Install.
6. When the installation is complete, click Close.

Results
The Emergency Self Report application is installed on your instance.

Components installed with Emergency Self Report
Several types of components are installed with Emergency Self Report, including tables and user roles.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self report user [sn_imt_quarantine.crisis_task_user]</td>
<td>Access the Emergency Self Report Dashboard to report health status.</td>
<td>• None</td>
</tr>
</tbody>
</table>
### Role title [name]

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crisis task users</td>
<td>View and manage HR tasks, submit updates for other users, and import crisis tasks. Also grant the self report user role.</td>
<td>• import_admin</td>
</tr>
<tr>
<td>[sn_imt_quarantine.humanResourceTeam]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crisis Task [sn_imt_quarantine_crisis_task]</td>
<td>Contains all self report crisis tasks, including HR crisis tasks.</td>
</tr>
<tr>
<td>Crisis Task Status Log [sn_imt_quarantine_crisis_task_status_log]</td>
<td>Contains a history of all reported health statuses for each user. This table is only populated when the sn_imt_quarantine.enable.health.status.log property is set to true.</td>
</tr>
<tr>
<td>Bulk Import Crisis Tasks [sn_imt_quarantine_bulk_load_crisis_task]</td>
<td>The Import Set table for importing reported health statuses from an Excel spreadsheet to create crisis tasks in bulk. When you load data from the Excel file into the application, the imported records are first saved in this import set table. After you run the transform or execute the scheduled import script, the records are copied to the Crisis Task table.</td>
</tr>
</tbody>
</table>

### Configure Emergency Self Report

Configure Emergency Self Report to align with your business needs.

**Before you begin**

Role required: admin

**About this task**

Complete the following configurations as needed.

- Grant app access to the appropriate response team members.
- Specify custom system messages to help your users and response team members.
- Set system properties to control how you use Emergency Self Report.
- Configure user health status choices.
- Create a dedicated knowledge base and add it to your Service Portal.

**Procedure**

1. Add the default application user roles to appropriate groups.

The application provides the following default roles in the sys_user_role table:

- **sn_imt_quarantine.crisis_task_user**
  
  Enables group members or individuals to submit a health alert for themselves. Managers can also submit and monitor alerts for their direct reports.

- **sn_imt_quarantine.humanResourceTeam**
Enables group members, such as HR or Global Security team members, to manage the reported health alerts.

For information about how to assign roles to groups, see Roles.

2. Navigate to Emergency Self Report > UI Configuration, set the desired message values, and then click Update.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_quarantine.crisisSubmitMessage</td>
<td>Configure the message that is displayed to users after they submit a health status.</td>
</tr>
<tr>
<td></td>
<td><strong>Example confirmation message</strong></td>
</tr>
<tr>
<td></td>
<td>Thank you for voluntarily updating us about your health status. Visit the latest CDC guidelines.</td>
</tr>
<tr>
<td></td>
<td>Update your team about your health status.</td>
</tr>
<tr>
<td>sn_imt_quarantine.openTasksInfoMessage</td>
<td>Configure a tooltip for managers who are viewing open tasks.</td>
</tr>
<tr>
<td></td>
<td><strong>Example message for open tasks</strong></td>
</tr>
<tr>
<td></td>
<td>View your direct reports' open tasks like cases, problems, and incidents. My direct reports' open tasks ści. Short Description ści. Assigned to ści.</td>
</tr>
</tbody>
</table>

3. Navigate to Emergency Self Report > Emergency Self Report Properties, set the desired property values, and then click Update.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_quarantine.enable.health.status.log</td>
<td>When this property is set to true, a new record is created in the Crisis Task Status Log table [sn_imt_quarantine_crisis_task_status_log] every time that a user health status update is submitted. Crisis task records have a Crisis Task Status Logs related list that shows all health status updates for that crisis task. When this property is set to false, the Crisis Task Status Log table is not populated. The default value is false.</td>
</tr>
<tr>
<td>sn_imt_quarantine.data.retention.period</td>
<td>Sets the number of days that records are stored in the Crisis Task Status Log table [sn_imt_quarantine_crisis_task_status_log] before they are deleted. The default value is 30 days.</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_imt_quarantine.fetchTaskQuery</td>
<td>Determines the data that is visible in the Emergency Self Report dashboard in the My direct reports' open tasks section. The default value is to show only P1 and P2 requests, incidents for the last month, and those assigned to the manager's direct reports:</td>
</tr>
<tr>
<td></td>
<td>sys_created_on&gt;javascript:gs.beginningOfLastMonth() ^active=true^assigned_to.managerDYNAMIC IC90d1921e5f510100a9ad2572f2b477fe ^sys_class_name=incident^ORSys_class_name=sc_task ^ORSys_class_name=sc_request^priority IN1,2</td>
</tr>
<tr>
<td>sn_imt_quarantine.healthStatusChangeTaskBehavior</td>
<td>Sets the behavior of crisis tasks for users who update their health status after their most recent crisis task is closed. When the value is update, the user's most recent HR crisis task is reopened and their health status is updated with their new reported status. When the value is create, a new HR crisis task is created if an open one doesn’t already exist for the user’s newly reported status. The default value is update.</td>
</tr>
<tr>
<td>sn_imt_quarantine.healthStatusesToTriggerTaskReopen</td>
<td>Sets the health statuses that reopen tasks or create new tasks if reported by a user after their most recent crisis task is closed. By default, the statuses that reopen or create new tasks are In quarantine and Reporting symptoms.</td>
</tr>
<tr>
<td>sn_imt_quarantine.hrGroup</td>
<td>Members of the global response team, who will have access to your team's user records. You can add a role to a group to act as a global response team or you can add the role directly to the users.</td>
</tr>
<tr>
<td>sn_imt_quarantine.MaxOrgLevelLimit</td>
<td>Number of levels in your organization structure. For example, If you have CEO, VP, Director, Manager, and Individual Contributors, you have five levels in your organization structure.</td>
</tr>
<tr>
<td>sn_imt_quarantine.outSickDuration</td>
<td>The time frame (in days) after which users are safe to return to work if sick. The default value is 20 days.</td>
</tr>
<tr>
<td>sn_imt_quarantine.quarantineDuration</td>
<td>The time frame (in days) after which users are safe to return to work if self-quarantined.</td>
</tr>
</tbody>
</table>
4. Configure the check-in choices that the user can select.

   a. Navigate to System Definition > Choice Lists.

   b. Set a search filter with the following conditions:
      - [Table] [is] [sn_imt_quarantine_crisis_task]
      - [Element] [is] [request_type]

   c. Change the label or value for choices in the list, or add new values.

   d. Click Update.

5. Configure knowledge articles about the emergency event.
   For example, provide local regulations, organization policies, and how-to information.

   a. Create a knowledge base to contain the application’s articles.
   b. Navigate to Service Portal > Pages.
   c. Search for ID self_report_dashboard and click the record.
   d. Click the Emergency Self Report - Container 2 link.
   e. Under Column 2, click Instance of Simple List.
   f. On the Table & Filter tab, name the knowledge base by setting the following filter condition: [Knowledge Base] [is] [<name>].
   g. Associate application articles with the application knowledge base.

**Report and track health statuses during an emergency**

Emergency Self Report is used by users to self-report their health status, by managers to track the health status of their users, and by response teams to view the status for all users and sort the data for analysis and action.

**Before you begin**

- To report your health status or as a manager to report and monitor the health status of your team, the **sn_imt_quarantine.crisis_task_user** role is required.
- To view all reported health alerts if you're part of a response team, the **sn_imt_quarantine.humanResourceTeam** role is required.

**About this task**

The workflow for Emergency Self Report begins with users self-reporting their health status, managers determining the actions that must be taken related to the user’s status, and a response team evaluating a unified view of the status of all reporting users.
**Procedure**

- To report your health status:


   ![Note: To report your health status in the Now Mobile app, navigate to the Health tab and tap the quick action icon (📍) in the top-right corner.]

   If you're a manager, your name is automatically selected in the **Person** field so that you can report your own health status. If you're reporting the status for a direct report, select the user's name from the **Person** field.

   If you're not a manager, you can report only your own status and the **Person** field doesn't appear.

2. Choose an option from the **Health status** list.
   System administrators can configure these options.

   ![Example](image)

   3. Click **Save**.
      The health status is updated on the left side of the screen. A message is sent to your manager, and a crisis task is generated for the response team. The crisis task can be assigned an approver, and the reporting user's assigned tasks can be reviewed.

      If Contact Tracing is installed and you selected the **In quarantine** option, a case is created automatically for the user. If an active case exists for the user at the time of reporting, a note is added to the case about the self-reporting. For more information, see ServiceNow® Contact Tracing.

4. Optional: When you're ready to return to work, update your health status to **Return to Work**.
   A Human Resources task is created so that HR can coordinate with you. The HR task is for information, and is not updated automatically when other tasks are updated. In the manager's view, your status changes to green.

   • To evaluate the health status of your direct reports if you're a manager:
   You see a single screen view of your direct team’s status and tasks, and can select individual user records. Green tiles indicate that the user has provided no information. The tiles of affected team members are red and display an icon.

   ![Monitor your employees' health status](image)

2. To display a user's assigned tasks, click a tile.

3. To reassign tasks for the user, click the Reassign link in the task row, assign the task to another user, and click Submit.

Related information

View a dashboard of all user reports if you are a response team member

View self-reported user HR tasks

Members of the emergency response team can view all user reports and associated HR tasks on the Emergency Self Report overview dashboard.
Before you begin
Role required: sn_imt_quarantine.humanResourceTeam

About this task
The Emergency Self Report dashboard enables monitoring by and tasks of the emergency response team. Users with the HR emergency response role can also report on behalf of anyone in their organization, and they can easily update records as needed.

Procedure
1. Navigate to Emergency Self Report > Overview Dashboard. You can also access the dashboard as a service portal page.
2. Review the numbers of reports and updates occurring today, and click any card to see the data.

3. Optional: To add someone who does not have self-reporting access, select the user’s name in the Person field and select a status from the Health status list.

4. Optional: To view an HR task for a reporting user, click the user’s name in the Users reporting list.
5. **Optional:** Export the list of reporting users in PDF, Excel, or CSV format by clicking the icon in the list banner.

6. Review the charts to see at a glance how the organization is affected. Click any element in a chart, such as a pie wedge or marker, to see the corresponding data.

**Import Crisis Task data**

As a crisis task administrator, upload a spreadsheet of self-reported health statuses to create crisis tasks in bulk.

**Before you begin**

You need a spreadsheet (.csv or .xlsx file) with data in the following columns: Person, User name, and Health Status. You can download a template from the Import Crisis Task Data data source record.

Role required: sn_imt_quarantine.humanResourceTeam

**About this task**

The Bulk Import Crisis Task Data scheduled job is installed with the Emergency Self Report application. When you upload the spreadsheet, you can manually execute the job to import data into the Crisis Task table. HR tasks and their associated crisis tasks are created for each user based on their reported health status.

**Procedure**

1. Navigate to **Emergency Self Report > HR Tasks**.

2. Click the **Import Crisis Task Data** button.

3. In the Scheduled Data Imports list, open the **Bulk Import Crisis Task Data** scheduled data import job.

4. In the **Data Source** field, open the **Import Crisis Task Data** record.

   a. Click the attachments icon (🔗).

   b. Click **Choose file** and select the source Excel file.

   c. Close the Attachments window.

5. Click **Update**.

   The Scheduled Data Import record appears with the attachment.

6. Click **Execute Now**.

   The process runs in the background to copy data from the Bulk Import Crisis Tasks table to the Crisis Task table.

   **Note:** The number of records in the source Excel file affect the time needed before the imported data is available in the Crisis Task table.

**Results**

Records are imported to the Bulk Import Crisis Tasks table and copied to the Crisis Task table. New HR tasks are created with their associated crisis tasks. Records are not copied to the Crisis Task table in the following situations:

- The user name is invalid or blank.
- The health status is invalid or blank.
- The user has an active case.
- The user is a duplicate.
Domain separation for Emergency Self Report

The following table lists the domain separation use cases for service providers (SPs) using this application.

<table>
<thead>
<tr>
<th>Use case</th>
<th>Functions</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP Internal - SP uses the application for internal employees to self-report their status via a dedicated service portal or web page.</td>
<td>Yes</td>
<td>None</td>
</tr>
<tr>
<td>SP External - SP uses the application for tenant employees to self-report their status via a dedicated service portal or web page.</td>
<td>Yes</td>
<td>None</td>
</tr>
<tr>
<td>Tenant - Tenant uses the application for their sub-domain for their employees to self-report their status via a dedicated service portal or web page.</td>
<td>Yes</td>
<td>None</td>
</tr>
</tbody>
</table>

Some modules in the Emergency Self Report application are affected by domain separation. These modules can be used by SPs and tenants.

**EMERGENCY SELF REPORT DASHBOARD module**

- A web page where users can self-report their current status. When they submit their status, a health record is created. (Table: Crisis Task)
- A knowledge base list of articles.

**ALL HEALTH RECORDS & HR TASKS module (Crisis Tasks)**

- Domain column row protections exist.
- Extended from the Task table and therefore contains the necessary domain-separated business logic.
- Related list, Approvers (Table: Approval) is an established domain-separated table.
- Related list, Tasks (Table: Task) is an established domain-separated table.

Emergency Exposure Management

The ServiceNow® Emergency Exposure Management application helps identify users who might have been exposed to infectious diseases by analyzing multiple data sources such as meetings, location, shifts, Wi-Fi access logs, and badge scans of affected users.

Emergency Exposure Management provides tracing systems to use the following data sources to generate a list of potentially exposed users:

- Microsoft Office 365 meeting invite
- Location of the ServiceNow user profile
- Workspace reservation
- Badge scan log
- Wi-Fi access log
- Employee daily log
- Field service task
• Visitors log
• Handheld or wearable device proximity sensing data

⚠️ Note: Some of the tracing systems require you to install other Safe Workplace suite and Emergency Response Management applications. For more information, see Tracing systems in Emergency Exposure Management.

You can also manually add users whom you know might have been potentially exposed to an affected user.

In addition to using the base system tracing systems, you can set up a tracing system that uses your own data source to identify potentially exposed users. For more information, see Set up a tracing system for an exposure data source.

Use guided setup to implement Safe Workplace suite apps

The Safe Workplace guided setup provides a sequence of tasks that help you configure the Safe Workplace and Emergency Response Management applications on your ServiceNow instance. To open the Safe Workplace guided setup, navigate to Guided Setup > Safe Workplace Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Use with other Emergency Response Management applications

Emergency Exposure Management was originally developed to monitor and aid in stopping the community spread of infectious diseases, such as COVID-19 among users. It is part of a suite of ServiceNow® Emergency Response Management applications built on the Now Platform® to assist companies in their emergency response efforts. You can also enable users to self-report their health status through the Emergency Outreach and Emergency Self Report applications, which are both available in the ServiceNow Store.

Emergency Response Management for federal customers

Federal customers using IL4 or FedRAMP environments will see the Emergency Response Management applications ready and available to install on their instances without having to make any special requests. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps</td>
</tr>
</tbody>
</table>
Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to employees of government agencies in their individual capacities. Use of this application is being offered free of charge for a limited or extended time period and with no expectation of payment from the government agency to ServiceNow for use during that time period, nor does usage create an actual or implied future obligation on behalf of the government. ServiceNow hereby expressly waives any future claims for payment from the agency in connection with usage of the application. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Emergency Exposure Management

You can install Emergency Exposure Management if you have the admin role.

Before you begin
Role required: admin

Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales</td>
</tr>
</tbody>
</table>
Installation instructions for self-hosted and federal environments (continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you’ve subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
- COVID-19 Global Health Data Set (sn_imt_c19datafeed)
- Contact Tracing (sn_imt_tracing)
- Emergency Self Report (sn_imt_quarantine)
- Workplace Safety Management (sn_wsd_core)
- Safe Workplace Dashboard (sn_imt_dashboard)
- Emergency Response Management for Now Mobile (sn_imt_mobile)
- Employee Travel Safety (sn_imt_travel)
- Health and Safety Testing (sn_imt_health_test)
- Vaccination Status (sn_imt_vaccine)

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Search for Emergency Exposure Management.
3. Click **Install.**
4. In the Application installation dialog box, click **Install.**
5. When the installation is complete, click **Close.**

   The Emergency Exposure Management application is installed on your instance.

6. **Optional**: Control access to the application by creating a group and assigning roles to the group or individual users.
   (Optional) For more information, see **Roles.**

**Components installed with Emergency Exposure Management**

Several types of components are installed with Emergency Exposure Management, including tables and user roles.
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Emergency Exposure Admin [sn_imt_diagnosis.diagnostics_admin] | Can create a new diagnostic request and view or download the list of impacted users. | • sn_imt_diagnosis.workplace_exposure_analyst  
  • sn_imt_monitoring.monitoring_user |
| Workplace exposure analyst [sn_imt_diagnosis.workplace_exposure_analyst] | Identifies potentially exposed employees using workplace reservations from the ServiceNow® Workplace Safety Management application. | • None |

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute employee diagnostic events</td>
<td>Looks up pending events from the Diagnostic Events [sn_imt_diagnosis_diagnostics_event] table and processes them to populate the Impacted Users [sn_imt_diagnosis_impacted_users] table.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostic Request [sn_imt_diagnosis_diagnostic_request]</td>
<td>Allows a user to create a diagnostic request for the affected user.</td>
</tr>
<tr>
<td>Diagnostic Events [sn_imt_diagnosis_diagnostics_event]</td>
<td>Subtasks generated for diagnostic requests. A scheduled job processes the tasks to identify the list of potentially impacted employees.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Diagnostic Request Task</td>
<td>Diagnostic request tasks created automatically for diagnostic requests to identify the list of potentially impacted employees. The task is created based on the selected data source in a diagnostic request.</td>
</tr>
<tr>
<td>Diagnostic Request Task Config</td>
<td>Configuration for a diagnostic request task. For a data source selected in a diagnostic request, the corresponding diagnostic request task when created matches the type of task configuration.</td>
</tr>
<tr>
<td>Impacted Users</td>
<td>Employees who may have been exposed to infectious diseases through an affected employee. Populated by analyzing multiple data sources for the affected employees.</td>
</tr>
<tr>
<td>Impacted Visitors</td>
<td>Visitors who might have been exposed to infection. Populated by analyzing the visitors request entry records invited by the affected employees. The table is available for use only if you also subscribe to ServiceNow® Contact Tracing and ServiceNow® Employee Health Screening. The data of this table is displayed in the Impacted visitors related list on the Diagnostic Report form.</td>
</tr>
<tr>
<td>Potential Workplace Exposure</td>
<td>Potentially exposed employees who had reservations for the same shifts as the affected employee during the specified time period. The table is available for use only if you also subscribe to Workplace Safety Management.</td>
</tr>
<tr>
<td>Tracing system</td>
<td>Data source configuration to identify potentially exposed employees by using diagnostic requests.</td>
</tr>
<tr>
<td>Tracing system properties</td>
<td>System properties for additional configuration of tracing systems</td>
</tr>
</tbody>
</table>

### Set up Emergency Exposure Management

After installing the Emergency Exposure Management application, set up tracing system for your data sources, diagnostic request task configuration, and register Microsoft applications.

### Before you begin

**Role required:** sn_imt_diagnosis.diagnostics_admin or admin

### Procedure

1. **Configure Microsoft Office 365 for Emergency Exposure Management.**
   
   Emergency Exposure Management uses Microsoft Office 365 data to analyze the meetings of affected employees to identify other potentially exposed employees.

2. **Set up a tracing system for an exposure data source.**
   
   A tracing system corresponds to a contact tracing data source that you can select in a diagnostic request to identify potential exposure from an affected employee.

3. **Create or modify a diagnostic request task configuration.**
   
   A diagnostic request task enables you to perform some manual tasks to fetch potentially exposed employees in a diagnostic request report for an affected employee.
Configure Microsoft Office 365 for Emergency Exposure Management

Configure Emergency Exposure Management by setting the application system properties. If you want to search by Microsoft Office 365 meeting information, you also must register the Microsoft application and configure it.

**Before you begin**

**Important:**

If you are an on-premise customer with Microsoft Office 365 and you need assistance in configuring Emergency Exposure Management, contact your sales representative or contact Customer Service and Support at https://support.servicenow.com/now?draw=case.

Role required: admin

**Procedure**

1. Register the Microsoft application.
   
   a. Sign in to your Azure portal.
   
   b. In the left navigation pane, select **Azure Active Directory**.
   
   c. Under **Create**, select **App registration**.
   
   d. On the form, fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name for the application.</td>
</tr>
<tr>
<td>Supported account types</td>
<td>Select the first option: Accounts in this organizational directory only</td>
</tr>
</tbody>
</table>

   The app is created with unique credentials to use.

2. Add permissions to the Microsoft application to read employee calendars.

   a. In the left navigation pane, select **API permissions**.
   
   b. Click **Add a Permission**.
   
   c. In the Request API permissions pane, under **Commonly used Microsoft APIs**, select **Microsoft Graph**.
   
   d. Click **Application Permissions**.
   
   e. Under **Calendars**, select **Calendars.Calendars read**.
   
   f. Click **Add permissions**.
   
   g. Click **Delegated Permissions**.
h. Under Calendars, select Calendars.Calendars read.

i. Click Add permissions.

j. On the Configured permissions screen, click Grant admin consent.

3. Obtain a trusted SSL certificate following your company’s procedure.
   For information about adding a TLS/SSL certificate in Microsoft Azure App Service, refer to Add SSL Cert in the Microsoft Azure App Service Documentation guide.

4. In the Azure portal, upload the certificate.
   a. Access your Azure portal.
   b. In the left navigation pane, select Certificates and Secrets.
   c. Select Upload certificate and upload the certificate created in step 3.

5. Create a Java Key Store certificate in your ServiceNow instance.
   a. Navigate to System Definition > Certificates.
   b. Click New and create a new certificate with a Type value of Java Key Store. Set the Short Description text to the alias used in 3. Set the Keystore Password to the password used in step 3.
   c. Attach the keystore.jks certificate exported in step 3.

6. In your ServiceNow instance, set system properties for Emergency Exposure Management.
   b. Verify the values or modify them for your environment.
   c. Add these required properties.
      • Client ID
      • Tenant ID
      • Certificate – The sys_id of the certificate created in Step 5.
      • Private key – Use the password used to generate the keystore in Step 3.
      • (Optional) Location – Location accessible from tables, such as a floor or building.
   d. Verify that the Microsoft URL for token generation is correct for your organization.
   e. Click Save.

Tracing systems in Emergency Exposure Management
A tracing system configured for a contact tracing data source enables you to identify potentially exposed employees by running a diagnostic request.

The diagnostic request for an affected employee queries the contact tracing data to identify people who might have interacted with the affected employee. You can select multiple tracing systems in a diagnostic request to use multiple data sources to broaden the coverage used to find potential exposure.

A tracing system can be a group of other tracing systems with a similar type of input data source. For example, say you have Wi-Fi access data integration with multiple systems such
as Cisco DNA Spaces and Mist Systems. You could have a tracing system called Wi-Fi access log and make it the parent tracing system of other tracing systems using the Wi-Fi input data sources.

You can customize the tracing systems for data sources available in Emergency Exposure Management or set up a new tracing system. For more information, see Set up a tracing system for an exposure data source.

For some tracing systems to be available in Emergency Exposure Management, you must install other Safe Workplace suite and Emergency Response Operations applications.

**Tracing systems installed with Emergency Exposure Management**

These tracing systems are active by default.

<table>
<thead>
<tr>
<th>Tracing system</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Employees co-located with the affected employee, for example, on the same floor or building.</td>
</tr>
<tr>
<td>Outlook meetings</td>
<td>Employees who accepted the same meetings as the affected employee during the specified time period.</td>
</tr>
<tr>
<td>(Microsoft Office 365)</td>
<td></td>
</tr>
</tbody>
</table>

**Tracing system installed with Workplace Safety Management**

This tracing system is not active by default. To use this tracing system for identifying potentially exposed employees, activate it and also configure the corresponding data source in Workplace Safety Management.

For more information, see Workplace Safety Management.

<table>
<thead>
<tr>
<th>Tracing system</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace reservations</td>
<td>Employees who had reservations for the same shifts as the affected employee during the specified time period.</td>
</tr>
</tbody>
</table>

**Tracing systems installed with Contact Tracing**

These tracing systems are not active by default. To use these tracing systems for identifying potentially exposed employees, activate them and also configure the corresponding data sources in Contact Tracing.

For more information, see Setting up Contact Tracing.

<table>
<thead>
<tr>
<th>Tracing system</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge reader</td>
<td>Queries the Badge Access Register [sn_imt_tracing_badge_access_register] table to fetch employees who swiped their badge on the same badge reader devices as the affected employee during the specified time period.</td>
</tr>
<tr>
<td>Employee daily log</td>
<td>Queries the Daily Contact Logs [sn_imt_tracing_daily_contact_log] table to fetch</td>
</tr>
</tbody>
</table>
### Tracing system

<table>
<thead>
<tr>
<th>Tracing system</th>
<th>Query</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visitor log</strong></td>
<td>Queries the Visitor Request For Entry [sn_imt_monitoring Visitor_request_for_entry] table to fetch visitors who interacted with the affected employee during the specified time period. Visitors who visited the workplace on invitation from the affected employee and have been screened through and let in are queried. Ensure that you have installed Employee Health Screening to use this tracing system.</td>
<td>The period for which you can get the data via a real-time API depends on the data retention policy of your Wi-Fi service provider.</td>
</tr>
</tbody>
</table>
| **Wi-Fi access log** | Queries the Wi-Fi Access Register [sn_imt_tracing_wifi_access_register] table to fetch employees who used the same Wi-Fi access points as the affected employee during the specified dates. Wi-Fi access log data used to identify potentially impacted employees depends on Wi-Fi location preferences and available integrations. The tracing system has the following child tracing systems based on the data source:  
  • Mist Systems  
  • Cisco DNA Spaces  
 For more information, see [Retrieving Wi-Fi access log data](#). |                                                                                                                                                                                                      |
| **Handheld/Wearables** | Queries the Wearable Access Register [sn_imt_tracing wearable_access_register] table to fetch employees equipped with handheld or wearable devices who were in the close proximity with the affected employee during the specified time period.  
The Handheld/Wearables tracing system has the Zebra MotionWorks Proximity tracing system added as a child tracing system. |                                                                                                                                                                                                      |
| **Kinexon SafeZone** | Uses an integration with the KINEXON SafeZone API to identify potentially exposed users with KINEXON wearable devices who were in close proximity with the affected KINEXON user during the specified dates. For more information, see [Configure KINEXON integration](#). |                                                                                                                                                                                                      |
Tracing system installed with Field Service Management

This tracing system is not active by default. To use this tracing system for identifying potentially exposed employees, activate it and also configure the corresponding data source in Field Service Management.

For more information, see Emergency Exposure Management for field service agents.

<table>
<thead>
<tr>
<th>Tracing system</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field service</td>
<td>Customers attended by an affected field agent during the specified time period. Also queries other field agents who interacted with the affected agent or visited the same customer as the affected agent during the specified time period.</td>
</tr>
</tbody>
</table>

Set up a tracing system for an exposure data source

Set up a tracing system for your exposure data source to identify potentially exposed employees by running the diagnostic requests for an affected employee.

Before you begin
Role required: admin

About this task
For more information about the available tracing systems, see Tracing systems in Emergency Exposure Management.

Procedure
1. Navigate to Emergency Exposure Management > Administration > Tracing Systems.
2. Click New.
3. On the form, fill in the fields.

Tracing System form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of the tracing system. The title is displayed as an option for selection in the Tracing system list on the Diagnostic Request form.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the tracing system.</td>
</tr>
<tr>
<td>Parent</td>
<td>Tracing system for a group of other tracing systems having the similar type of input data source. If the tracing systems are in a group, only the parent tracing system displays in the Tracing system list on the Diagnostic Request form.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the tracing system active. Only active tracing systems are available for selection as a data source for the diagnostic requests.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requires dates</td>
<td>Option for enabling the start and end dates to specify a period for querying the data source for the tracing system.</td>
</tr>
<tr>
<td></td>
<td>If selected, the <strong>Start date</strong> and <strong>End date</strong> fields appear when you select this tracing system on the Diagnostic Request form.</td>
</tr>
<tr>
<td>Processing script tab</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>Condition to determine the tracing system data for the diagnostic request on selecting a parent tracing system.</td>
</tr>
<tr>
<td></td>
<td>For example, if two tracing systems A1 and A2 have the same parent tracing system called A. In a diagnostic request, if you select A as the tracing source, the condition determines whether to query data from A1 or A2.</td>
</tr>
<tr>
<td></td>
<td>For reference, you can review the condition scripts of the base tracing systems Cisco DNA Spaces and Mist System having the parent tracing system as Wi-Fi access log.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when a tracing system is selected in <strong>Parent</strong>.</td>
</tr>
<tr>
<td>Use parent processing script</td>
<td>Option for executing the processing script of the parent tracing system. The parent tracing system's processing script populates the potentially exposed employees data in the corresponding related list on the Diagnostic Request form. If you select this option, the current tracing system's processing script does not process.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when a tracing system is selected in <strong>Parent</strong>.</td>
</tr>
<tr>
<td>Processing script</td>
<td>Script to populate the potentially exposed employees data in the corresponding related list on the Diagnostic Request form.</td>
</tr>
<tr>
<td>Contact graph tab</td>
<td></td>
</tr>
<tr>
<td>Legend icon</td>
<td>Icon representing the tracing system as data source for the potentially exposed contact's in the potentially exposed contacts visualization on the Case form.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Working on a case through contact tracing visualization.</td>
</tr>
<tr>
<td>Legend tooltip</td>
<td>Tooltip text that appears when you point to the legend icon.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the icons appear in the Reason for exposure section.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
Results
The tracing system is created. The tracing system appears as one of the options in the Tracing system field on the Diagnostic Request form.

What to do next
• Associate a system property with a tracing system.
• Create or modify a diagnostic request task configuration.

Associate a system property with a tracing system
Associate a system property with a tracing system to enable additional control on the use of the tracing system’s data source.

Before you begin
Role required: admin

About this task
For a list of system properties associated with various tracing systems, see System properties for tracing systems in Emergency Exposure Management.

Procedure
1. Navigate to Emergency Exposure Management > Administration > Tracing Systems.
2. Open a tracing system to associate a system property.
   To associate a new system property with the tracing system, create it by clicking New in the System Properties related list and filling in the System Property form.
   For more information about the System Property form fields, see Add a system property.
3. Associate a system property with the tracing system.
   a. In the System Properties related list, click Edit.
   b. On the Edit Members form, move the required system properties from the Collection column to the System Properties List column.
   c. Click Save.

System properties for tracing systems in Emergency Exposure Management
System properties associated with tracing systems that are available in the Emergency Exposure Management application.

To configure the system properties available for a tracing system, navigate to Emergency Exposure Management > Administration > Tracing Systems and open the tracing system record.

For more information on setting up or modifying a tracing system, see Set up a tracing system for an exposure data source.

System properties for tracing systems installed with Contact Tracing
For more information, see Setting up Contact Tracing.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracing system: Badge reader</td>
<td></td>
</tr>
</tbody>
</table>
### Properties for Contact Tracing (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_imt_tracing.badge_data_page_size</code></td>
<td>Number of records to process at a time for badge reader data. The default value is 500.</td>
</tr>
<tr>
<td><code>sn_imt_tracing.badge_reader_location</code></td>
<td>The field in the Badge Access Register [sn_imt_tracing_badge_access_register] table that refers to the location of the badge reader when the Use badge reader option is selected on the Diagnostic Request form. You can also specify a dot-walked field, for example, floor.floor_name. The default value is the floor_name field in the [sn_imt_tracing_badge_reader] table.</td>
</tr>
<tr>
<td><code>sn_imt_tracing.badge_owner_field</code></td>
<td>The field in the Badge Access Register [sn_imt_tracing_badge_access_register] table that refers to the badge owner when the Use badge reader option is selected on the Diagnostic Request form. You can also specify a dot-walked field, for example, user.user_name. The default value is the user field in the [sn_imt_tracing_user_badge] table.</td>
</tr>
<tr>
<td><strong>Tracing system: Wi-Fi access log</strong></td>
<td></td>
</tr>
<tr>
<td><code>sn_imt_tracing.wifi_client_table</code></td>
<td>The CMDB Class table to look up to identify the device and owner matching the Wi-Fi client in Wi-Fi access logs. The default value is cmdb_ci_computer.</td>
</tr>
<tr>
<td><code>sn_imt_tracing.wifi_client_mac_field</code></td>
<td>The field in the CMDB Class [cmdb_ci_computer] table that stores the mac address of the Wi-Fi client. The default value is mac_address.</td>
</tr>
<tr>
<td><code>sn_imt_tracing.wifi_client_owner_field</code></td>
<td>The field in the CMDB Class [cmdb_ci_computer] table that identifies the owner of the Wi-Fi client from the Wi-Fi access logs. The default value is assigned_to.</td>
</tr>
<tr>
<td><code>sn_imt_tracing.wifi_client_identification_fields</code></td>
<td>The fields in the CMDB Class [cmdb_ci_computer] table that identify the Wi-Fi client matching the Wi-Fi client in the Wi-Fi access log. The default values are mac_address, name.</td>
</tr>
<tr>
<td><code>sn_imt_tracing.wifi_ble_client_table</code></td>
<td>The CMDB Class table to look up to identify the device and owner matching the Wi-Fi Bluetooth LE (BLE) client in the Wi-Fi access logs. The default value is cmdb_ci_wearable.</td>
</tr>
</tbody>
</table>
### Properties for Contact Tracing (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sn_imt_tracing.wifi_ble_client_mac_field</strong></td>
<td>The field in the CMDB Class [cmdb_ci_wearable] table that stores the mac address of the Wi-Fi BLE client. The default value is mac_address.</td>
</tr>
<tr>
<td><strong>sn_imt_tracing.wifi_ble_client_owner_field</strong></td>
<td>The field in the CMDB Class [cmdb_ci_wearable] table that identifies the owner of the Wi-Fi BLE client from the Wi-Fi access logs. The default value is assigned_to.</td>
</tr>
<tr>
<td><strong>sn_imt_tracing.wifi_ble_client_identification_fields</strong></td>
<td>The fields in the CMDB Class [cmdb_ci_wearable] table that identify the Wi-Fi asset matching the Wi-Fi BLE client in the Wi-Fi access log. The default values are mac_address, asset_tag.</td>
</tr>
</tbody>
</table>

**Tracing system: Mist systems**

| **sn_imt_tracing.mist_api** | API that accesses the Wi-Fi access logs from Mist Systems. The default value is https://api.mist.com/api/v1.  |
| **sn_imt_tracing.mist_visits_page_size** | Maximum number of records to process by Mist Systems API calls. The default value is 1000. |

**Tracing system: Cisco DNA Spaces**

| **sn_imt_tracing.wifi_proximity_preference** | Level of proximity to consider employee interaction with an affected employee as potential exposure. The available options are 30ft, Floors, or Buildings. The default value is 30ft. |

Properties that apply only if you collect Wi-Fi raw data from Cisco DNA Spaces using Wi-Fi raw data files
## Properties for Contact Tracing (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.wifi_log_sftp_server</td>
<td>URL or IP Address (for example, 192.168.1.1) of the secured FTP (SFTP) server from which to access the Wi-Fi raw data files imported into the Wi-Fi Access Register [sn_imt_tracing_wifi_access_register] table.</td>
</tr>
<tr>
<td>sn_imt_tracing.wifi_log_sftp_port</td>
<td>Port on the SFTP server to allow an FTP connection to access the files.</td>
</tr>
</tbody>
</table>
| sn_imt_tracing.wifi_log_sftp_file_path | File path on the SFTP server where the Wi-Fi access data files from Cisco DNA Spaces are stored. For example, in the file path `/upload/Visit Data/Daily/ServiceNow_Daily_Visits_`:  
  - `/upload/Visit Data/Daily/` is the folder location on the SFTP server where the files are stored.  
  - `ServiceNow_Daily_Visits_` is the first part of the default file name that Cisco DNA Spaces uses, followed by the date and the upload time. For example, the default file name for the Wi-Fi access data for 19 August 2020 at 0100 UCT would be `ServiceNow_Daily_Visits_2020-08-19 0100 UTC.csv`:  
    - `ServiceNow_Daily_Visits_` is a fixed value  
    - `2020-08-19` is the date the Wi-Fi access data was captured  
    - `0100 UTC` is the time scheduled by you for Cisco DNA Spaces to upload the file  
  
  i **Note:** Make sure that only a limited number of users have read and write access to this location. |
| sn_imt_tracing.wifi_log_sftp_load_time | Time in HH:mm format when the Cisco DNA Spaces system uploads the day’s Wi-Fi access data files on the SFTP server. This timestamp is the last part of the name of the Wi-Fi access data file. |
| sn_imt_tracing.wifi_log_sftp_username | User name required to log in to the SFTP server. |
### Properties for Contact Tracing (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.wifi_log_sftp_password</td>
<td>Password required to log in to the SFTP server.</td>
</tr>
</tbody>
</table>
| sn_imt_tracing.wifi_log_ciscoTier           | Integration tier with Cisco DNA Spaces to fetch Wi-Fi access data. The available options are proximity_report and wifi_log_report.  

- **Note:** This property applies only if you are using integration with Cisco DNA Spaces to get the Wi-Fi access data.                                                                                                                                                                                                                     |

Tracing system: Kinexon SafeZone

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.kinexon_api_endpoint</td>
<td>API endpoint used to log in to the KINEXON SafeZone instance and access KINEXON data. This API endpoint is also used to fetch information required for Contact Tracing. Replace the default endpoint with the endpoint of your instance.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_username</td>
<td>KINEXON administrator user name.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_password</td>
<td>KINEXON administrator password.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_param_min_duration</td>
<td>The minimum duration of contact (in seconds) between two KINEXON sensors required to determine whether a user is a potentially exposed contact. The query omits all records with values below this duration. The default value is 300.</td>
</tr>
<tr>
<td>sn_imt_tracing.kinexon_api_param_min_acc_duration</td>
<td>The minimum total duration (in seconds) of all contact between two KINEXON sensors within the queried date range. If the total duration is shorter than this value, the query omits all records of contact between the pair of sensors. The default value is 300.</td>
</tr>
</tbody>
</table>

- **Note:** The query omits any instances of contact beyond this distance. The default value is 2.                                                                                                                                                                                                                                                                                                                    |

---

© 2022 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Properties for Contact Tracing (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_imt_tracing.kinexon_api_param_max_time_gap_in_sequence</td>
<td>Determines the amount of time that can pass (in seconds) between any two consecutive instances of contact before the potential exposure is considered two potential exposures. The default value is 15.</td>
</tr>
</tbody>
</table>

Create or modify a diagnostic request task configuration

Create or modify a diagnostic request task configuration to auto-create a diagnostic request task in a diagnostic request. Based on the selected tracing system in the diagnostic request, the corresponding task configuration creates a diagnostic request task to identify potentially impacted employees.

Before you begin

The Diagnostic Request Task Configs module in the application navigator is available only if you have the Contact Tracing application installed.

Role required: admin

About this task

A diagnostic request task configuration is required only when a tracing system requires additional work to be performed to generate the diagnostic request report. For example, say you select the Wi-Fi access log tracing system in a diagnostic request, and Cisco DNA Spaces is the Wi-Fi input data source. You must work on a diagnostic request task to fetch potentially exposed employees by attaching a Wi-Fi access data file or generating a proximity report from the Cisco DNA Spaces portal.

Procedure

1. Navigate to Emergency Exposure Management > Diagnostic Request Task Configs.
2. Click New.
3. On the form, fill in the fields.

### Diagnostic Request Task Config form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of diagnostic request task configuration.</td>
</tr>
<tr>
<td>Import set table</td>
<td>Staging table in which records are imported from a data source before transforming those records.</td>
</tr>
<tr>
<td>Transform map</td>
<td>A set of field maps that define the relationships between fields in an import set and fields in the target table. For example, the target table to maps fields for Wi-Fi access data is Wi-Fi Access Register [sn_imt_tracing_wifi_access_register]. During transformation, data is copied from the Import Set table to the target table based on the transform map.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>A single import set field may be mapped to multiple fields on other tables.</td>
<td>Type</td>
</tr>
<tr>
<td>Option for making the configuration active. Only active configurations can create a diagnostic request task.</td>
<td>Active</td>
</tr>
<tr>
<td>Conditions tab</td>
<td></td>
</tr>
<tr>
<td>Diagnostic Request [sn_imt_diagnosis_diagnostic_request] table to check which data source is selected.</td>
<td>Table</td>
</tr>
<tr>
<td>Script condition that evaluates any additional parameters.</td>
<td>Script condition</td>
</tr>
<tr>
<td>Script to run after the completion of the data import.</td>
<td>Post processing tab</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**

A diagnostic request task configuration for a data source type is created.

**Identify potentially exposed users**

When a user has indicated a health condition on a self-report, use Emergency Exposure Management to identify other users who might have come in contact with the affected user. You can analyze multiple data sources, such as location, meetings, workspace reservations, badge scans, and Wi-Fi access data of the affected user to identify potentially exposed users.

**Before you begin**

To query through multiple data sources, the Emergency Exposure Management requires the following applications, plugins, and configurations available on your instance.

- **Microsoft Office 365**
  Register and configure to scan Microsoft Outlook meeting data.

- **Workplace Safety Management**
  Scans workspace reservation data.

- **Contact Tracing**
  Badge reader scan, user daily contact log, Wi-Fi access log, handheld or wearable device proximity data, and visitor data.

- **Employee Health Screening and Contact Tracing**
  Scans visitor data.

- **Field Service Management (com.snc.work_management)**
Scans field service task data.

Important:
If you are an on-premise customer with Microsoft Office 365 and you need assistance in configuring Emergency Exposure Management, contact your sales representative or contact Customer Service and Support at https://support.servicenow.com/now?draw=case.

Role required: sn_imt_diagnosis.diagnostics_admin or admin

About this task
Note: You cannot create or run a diagnostic request for affected users who have not consented to use their data for contact tracing. For more information, see User privacy consent for Contact Tracing.

Procedure
1. Navigate to Emergency Exposure Management > Create New. The Report generation status field is set to Not Initiated and the Active check box is selected.
2. From the Affected user field, select the user’s name.
3. Click the lock icon (🔒) in the Tracing system field and select one or more tracing system options to query corresponding data sources. You can select multiple sources together for better identification of potentially impacted users.

<table>
<thead>
<tr>
<th>Tracing system (Required application/plugin)</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Users co-located with the affected user, for example, on the same floor or building.</td>
</tr>
<tr>
<td>Outlook meetings (Microsoft Office 365)</td>
<td>Users who accepted the same meetings as the affected user during the specified time period.</td>
</tr>
<tr>
<td>Workplace reservations (Workplace Safety Management)</td>
<td>Users who had reservations for the same shifts as the affected user during the specified time period.</td>
</tr>
<tr>
<td>Badge reader (Contact Tracing)</td>
<td>Users who swiped their badge on the same badge reader devices as the affected user, during the specified time period.</td>
</tr>
<tr>
<td>Employee daily log (Contact Tracing)</td>
<td>The list of users with whom the affected users interacted during the specified time period.</td>
</tr>
<tr>
<td>Visitor log (Contact Tracing and Employee Health Screening)</td>
<td>The list of visitors who interacted with the affected user during the specified time period. Visitors who are invited by the affected user and have been screened through and let in are queried.</td>
</tr>
<tr>
<td>Wi-Fi access log (Contact Tracing)</td>
<td>Users who used the same Wi-Fi access points as the affected user during the specified dates.</td>
</tr>
<tr>
<td>Tracing system (Required application/plugin)</td>
<td>Query</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Tracing system (Required application/plugin)</td>
<td>Wi-Fi access log data used to identify potentially impacted users depends on the Wi-Fi location preferences and the available integrations. For more information, see Retrieving Wi-Fi access log data.</td>
</tr>
<tr>
<td><strong>Note:</strong> Data received via a real-time API will be for a period based on the data retention policy of your Wi-Fi service provider.</td>
<td></td>
</tr>
<tr>
<td><strong>Handheld/Wearables</strong> (Contact Tracing)</td>
<td>Users using handheld or wearable devices in the close proximity with the affected user for more than the permissible time during the specified time period.</td>
</tr>
<tr>
<td><strong>Note:</strong> Users who are required to agree to a privacy consent but have not done so are excluded even if they are potentially exposed contacts.</td>
<td></td>
</tr>
<tr>
<td><strong>Kinexon SafeZone</strong> (Contact Tracing)</td>
<td>Users who with KINEXON wearables who were in close proximity with other KINEXON users during the specified dates. Data acquired from the KINEXON SafeZone API. Requires an active KINEXON integration. For more information, see Configure KINEXON integration.</td>
</tr>
<tr>
<td><strong>Note:</strong> Users who are required to agree to a privacy consent but have not done so are excluded even if they are potentially exposed contacts.</td>
<td></td>
</tr>
<tr>
<td><strong>Field service</strong> (Field Service Management)</td>
<td>Customers attended by an affected field agent during the specified time period. Also queries other field agents who interacted with the affected agent or visited the same customer as the affected agent during the specified time period.</td>
</tr>
</tbody>
</table>

4. When required for a selected tracing system, provide the start and end dates.
   a. In the **Start date** field, provide the estimated date of infection. Because the infection window that you’re concerned about may vary, pick a start date such as 14 days prior to the date of reported symptoms.
   b. In the **End date** field, provide the date of reported symptoms, at least one day prior to today.

5. Click **Save**. Related lists appear that are filled in after you run a diagnostics report.

6. Click **Run Diagnostics**. A scheduled job fetches potentially impacted user data from the selected sources and loads the data in corresponding related lists. Refresh a list to see the potentially impacted users immediately.

   If you selected the **Handheld/Wearables** option, a diagnostic request task is created. Follow the instructions in the task to fetch the potentially exposed users.

   If you selected the **Wi-Fi access log** option, the Wi-Fi data queried is based on the location preference set for the affected user’s location. The available options are:
- Mist Systems integration: The Wi-Fi data is fetched from Mist Systems when you run the diagnostic request. If the site network is Bluetooth LE-enabled and the organization has provided users with a BLE device, the Wi-Fi access using the BLE devices is used to identify potentially exposed users.

- Cisco DNA Spaces integration: The Wi-Fi data is available based on the Cisco tier value set in the `sn_imt_tracing.wifi_log_cisco_tier` property:
  - If the `wifi_log_report` value is set, the data is imported from the Wi-Fi access data files for the specified days from the SFTP server and queried by the location path to identify potentially exposed users.
  - If the `proximity_report` value is set, a diagnostic request task is created to fetch the potentially exposed users. Follow the instructions in the task to fetch data on potentially impacted users from the selected data source. For more information, see Fetch potentially exposed user data from a data source.

- Manual import: The Wi-Fi data is imported from a Microsoft Excel spreadsheet into the Wi-Fi Access Register table.

7. Optional: Add manually the potentially affected users, for example, users who visited a location with an affected user.

   a. In the Impacted users added manually list, click **New**.

   b. Select the potentially affected user.

   c. Optional: Add comments about why you added the user. Entering comments helps identify other users who might be potentially impacted by this user if this user starts to show symptoms.

   d. Click **Submit**.

   The user appears in the Impacted users added manually related list.

**Results**

The related lists display potentially impacted users. The Impacted visitors, Impacted customers, and Impacted field agents related lists appear only if relevant users exist.

**Note:** Users who have not consented to use their data are filtered out from the list of potentially impacted users. However, you can add them to the potentially impacted users list manually.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Impacted users</td>
<td>All users who might have been potentially exposed. This list is a combination of all the records in the other related lists. Under the <strong>Tracing system</strong> column, you can see the source of the exposure for an user.</td>
</tr>
<tr>
<td>Impacted users added manually</td>
<td>This list is empty unless a user with the <code>sn_imt_diagnosis.diagnostics_admin</code> role manually adds additional potentially impacted users.</td>
</tr>
</tbody>
</table>
(continued)

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted visitors</td>
<td>Visitors invited by the affected user who cleared the health screening and interacted with the affected user during the specified time period.</td>
</tr>
<tr>
<td>Impacted customers</td>
<td>Customers added from the field service work order analysis. Potentially impacted customers are determined by the work orders attended by an affected field agent between the specified dates.</td>
</tr>
<tr>
<td>Impacted field agents</td>
<td>Field agents added from the field service work order analysis. Potentially impacted field agents are determined if they interacted with an affected agent or visited the same customer as the affected agent between the specified dates.</td>
</tr>
</tbody>
</table>

Trouble?
If the diagnostics fail to run, click the **Show related jobs** link to check the status of all jobs that have been launched. You can view the details, including the log message, to determine the reason of failure.

**Note:** Failed jobs are automatically retried three times, the default setting in the Emergency Exposure Management properties. To retry the job after you fix the issue, click **Reprocess**.

What to do next
Depending on the applications and plugins installed, you can take the following actions:

- Click **Download Report** to download a spreadsheet listing all affected users. The report includes the email address and location of each user, and the source of identification, such as location, workplace reservation, collaboration, badge reader data, or field service work orders. For manually added users, the comment is included.

- Click **Download Visitor Report** to download a spreadsheet listing all potentially exposed visitors who met the affected user. The report includes the email address and name of each visitor.

**Note:** The button is available only when you have selected the **Visitor log** tracing system.

- The case manager can create a case for the affected user and add potentially impacted users from the related list to the case to follow up on their health status. For more information, see [Create a case for an affected employee](#).

- The manager of the affected field agents can take further actions such as blocking their future work order assignments. For more information, see [Emergency Exposure Management for field service agents](#).

Fetch potentially exposed user data from a data source
Work on the diagnostic request task to get information about potentially impacted users from a selected data source and populate the corresponding related lists on the Diagnostic Request form.

Before you begin
Role required: sn_imt_diagnosis.diagnostics_admin or admin
About this task
The diagnostic request task is created from the diagnostic request task configuration for the data source type selected in the Diagnostic Request form. For more information, see Create or modify a diagnostic request task configuration.

Procedure
1. Navigate to Emergency Exposure Management > All.
2. Open a diagnostic request from the list.
3. In the Diagnostic Request Tasks related list, open a diagnostic request task.
4. Follow the instructions in the task to fetch data on potentially impacted users from the selected data source.
5. If the task configuration requires you to manually close the task, select Closed in the State list.
6. Click Update.

Results
The state of the diagnostic request task updates to Close. The potentially exposed users from the data source are added to the corresponding related list on the Diagnostic Request form.

Fetch potentially exposed user data from Cisco DNA Spaces
Fetch potentially exposed user information from the Cisco Wi-Fi access log data and populate the corresponding related lists on the Diagnostic Request form.

Before you begin
Role required: sn_imt_diagnosis.diagnostics_admin or admin

Procedure
Access the potentially exposed user information through an attachment having the Cisco Wi-Fi access log data or by generating a report through the Cisco DNA Spaces portal.

<table>
<thead>
<tr>
<th>Options</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Attach a Wi-Fi access log file | a. Click the manage attachments icon.  
b. In the Attachments window, click Choose file and select a Wi-Fi access log file.  
c. Select Closed in the State list.  
d. Click Update.  
The state of the diagnostic request task updates to Close. |
| Generate a report and post data through the Cisco portal | a. Log in to the Cisco DNA Spaces portal.  
b. On the Proximity Reporting page, click Create Report.  
c. Enter the start and end date for the report period.  
d. Select the Auto-submit report data to ServiceNow task check box.  
e. In the Diagnostic Request Task # field, enter the number of the diagnostic request task.  
f. Click Generate Report. |
The Cisco system creates a proximity report and puts the Wi-Fi access log data from the report into the Wi-Fi Access Register [sn_imt_tracing_wifi_access_register] table on the ServiceNow instance. The state of the diagnostic request task updates to Close.

**Results**
Cisco Wi-Fi access log data includes the proximity level of the users connected to the Cisco Wi-Fi network in the workplace. Based on the proximity level options set by the sn_imt_tracing.wifi_proximity_preference property (within 30 feet of the router, on the same floor, or in the same building), the potentially impacted users are identified from the Cisco Wi-Fi access logs. The information about these potentially exposed users populates the corresponding related list on the Diagnostic Request form.

**Fetch potentially exposed user data from Zebra MotionWorks proximity report**
Upload a spreadsheet containing the Zebra MotionWorks proximity data to fetch a list of potentially exposed users and populate the corresponding related lists on the Diagnostic Request form.

**Before you begin**
You must have downloaded the Microsoft Excel file from the Zebra MotionWorks Portal.
Role required: sn_imt_diagnosis.diagnostics_admin or admin

**Procedure**
1. Click the manage attachments icon (_attach).
2. In the Attachments window, click Choose file and select a Zebra MotionWorks proximity report spreadsheet.
3. Select Closed in the State list.
4. Click Update.

**Results**
The Zebra MotionWorks proximity report contains a list of users equipped with handheld or wearable devices who were in close proximity to the affected user. The users who were in close proximity for more than the permissible time with the affected user during the specified dates are identified from this proximity report. The information about these potentially exposed users populates the corresponding related list on the Diagnostic Request form.

**Domain separation for Emergency Exposure Management**
The following table lists the domain separation use cases for service providers (SPs) using this application.

*Note:* This information is subject to change: Limit use to SPs only.

<table>
<thead>
<tr>
<th>Use case</th>
<th>Functions</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP Internal - SP uses the application for internal employees who might have collaborated with an affected internal employee.</td>
<td>Yes</td>
<td>None</td>
</tr>
<tr>
<td>Use case</td>
<td>Functions</td>
<td>Limitations</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SP External - SP uses the application to identify employees (SP or tenant) who might have collaborated with an affected employee (SP or tenant).</td>
<td>No</td>
<td>Without the domain column, there is no base system platform security that prevents an SP user who has access to the application from seeing tenant information they would otherwise be restricted from seeing. “Limiting” Application Properties for Outlook settings.</td>
</tr>
<tr>
<td>Tenant - Tenant uses the application to identify employees who might have collaborated with an affected employee.</td>
<td>No</td>
<td>Without the domain column, there is no base system platform security that prevents a tenant user with access to the application from seeing other tenant information they would otherwise be restricted from seeing. “Limiting” Application Properties for Outlook settings.</td>
</tr>
</tbody>
</table>

Some modules in the Emergency Exposure Management application are affected by domain separation.

**CREATE NEW & ALL module (Diagnostic Request)**

- No domain column row protections or business logic exist.
- Creates a Diagnostic Event based on Outlook meetings, exposure to an affected user, or the user's location, to identify users who might have been potentially exposed through collaboration.
- Results from the Diagnostic Event return back to the Diagnostic Request or can be manually added.

Note: Because the Diagnostic Request record contains the User (Table: Sys_User) and Location (Table: Cmn_Location) fields, visibility to those reference fields is affected by domain separation. If a user is in a domain that does not have the appropriate visibilities granted, those fields appear empty in the Diagnostic Request even if they contain data.

**PROPERTIES module**

- Standard Application Properties Page, all settings are global for the application.

Note: This property limits the ability of Outlook support in a domain-separated environment because tenants have different settings from the service provider.

- No domain column row protections or business logic exist.
- Captures the Outlook or Location responses and sends them back to the Diagnostic Request.
- Purely an admin function.

**Safe Workplace for mobile**

Manage the essential steps for return to workplace from anywhere using the Safe Workplace for mobile app.
The ServiceNow® Safe Workplace mobile experience enables organizations to manage the essential steps for returning users to the workplace from anywhere with the Now Mobile app. With an intuitive mobile design and user-friendly interface, organizations can deliver a seamless return to workplace experience, enabling users to complete health screenings and surveys, set up visits, make reservations, request PPE, and more to support their health and safety.

Access other applications from Safe Workplace for mobile
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

<table>
<thead>
<tr>
<th>Emergency Response Management applications</th>
<th>Safe Workplace applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Emergency Outreach</td>
<td>• Employee Readiness Surveys</td>
</tr>
<tr>
<td>• Emergency Self Report</td>
<td>• Employee Health Screening</td>
</tr>
<tr>
<td>• Emergency Exposure Management</td>
<td>• Workplace Safety Management</td>
</tr>
<tr>
<td></td>
<td>• Workplace PPE Inventory Management</td>
</tr>
<tr>
<td></td>
<td>• Safe Workplace Dashboard</td>
</tr>
<tr>
<td></td>
<td>• Contact Tracing</td>
</tr>
<tr>
<td></td>
<td>• Health and Safety Testing</td>
</tr>
<tr>
<td></td>
<td>• Employee Readiness Core</td>
</tr>
<tr>
<td></td>
<td>• Enterprise Employee Experience Pack</td>
</tr>
<tr>
<td></td>
<td>• Employee Travel Safety</td>
</tr>
<tr>
<td></td>
<td>• Vaccination Status</td>
</tr>
</tbody>
</table>
Safe Workplace for mobile features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Receive and respond to outreach notifications</strong></td>
<td>Receive important notifications generated in the Emergency Outreach application on your mobile device. You can also self-report your health status through these notifications. For more information about Emergency Outreach, see <a href="#">Emergency Outreach</a>. For information on how to report your health status through push notifications, see <a href="#">Report your health status</a>.</td>
</tr>
<tr>
<td><strong>Report your health status on the service response dashboard</strong></td>
<td>Under My Current Health Status, click your name to report your health status. For more information, see <a href="#">Report your health status in Now Mobile</a>.</td>
</tr>
<tr>
<td><strong>View the status of your direct reports</strong></td>
<td>As a manager, you can view My Team's Health in the My Team section to see an overview of the health of your direct reports. For more information, see <a href="#">Manage the status of your direct reports in Now Mobile</a>.</td>
</tr>
<tr>
<td><strong>Reassign critical tasks to your working employees</strong></td>
<td>As a manager, you can tap My Direct Reports Open Tasks in the My Team section to see the work assigned to your direct reports. From this list, you can reassign tasks, as needed, to your working direct reports. For more information, see <a href="#">Reassign tasks to your team members in Now Mobile</a>.</td>
</tr>
</tbody>
</table>

### Mobile sections

If you’ve subscribed to the Safe Workplace suite, you see the Mobile sections available for Mobile experience for Emergency Response Management. Each section has multiple applications. To see all applications under a topic, scroll left.

<table>
<thead>
<tr>
<th>Mobile section topics</th>
<th>Follow these safety practices</th>
<th>Health screening</th>
<th>Manage PPE inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health surveys</td>
<td>Screen employee</td>
<td>Assign consumable</td>
<td></td>
</tr>
</tbody>
</table>
### Mobile section topics (continued)

<table>
<thead>
<tr>
<th>Follow these safety practices</th>
<th>Health screening</th>
<th>Manage PPE inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>• For more information, see Employee Readiness Surveys.</td>
<td>• For more information, see Conduct a health screen for entry.</td>
<td>• For more information, see Assign PPE to employees.</td>
</tr>
<tr>
<td>Verify my health</td>
<td>Screen visitor</td>
<td>Assign hardware</td>
</tr>
<tr>
<td>• For more information, see Verify your health status and compliance.</td>
<td>• For more information, see Screen a visitor for entry to the workplace.</td>
<td>• For more information, see Assign PPE to employees.</td>
</tr>
<tr>
<td>Request PPE</td>
<td>Scan for entry</td>
<td>Add consumable</td>
</tr>
<tr>
<td>• For more information, see Request PPE.</td>
<td>• For more information, see Collecting user badge data.</td>
<td>• For more information, see Add PPE stock.</td>
</tr>
<tr>
<td>Daily contact log</td>
<td>Employee status</td>
<td>Add hardware</td>
</tr>
<tr>
<td>• For more information, see Tracking employee contacts using daily logs.</td>
<td>• For more information, see View your health and safety status.</td>
<td>• For more information, see Add PPE stock.</td>
</tr>
<tr>
<td>Privacy Consent</td>
<td></td>
<td>Add model</td>
</tr>
<tr>
<td>• For more information, see User privacy consent for Contact Tracing.</td>
<td></td>
<td>• For more information, see Create models for PPE items.</td>
</tr>
<tr>
<td>Set up a visit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Invite a visitor to the workplace.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COVID-19 Testing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Request a COVID-19 diagnostic test.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request travel permission</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Request permission to travel.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report Vaccination</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• For more information, see Report your vaccination status.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Section topics (continued)**

<table>
<thead>
<tr>
<th>My current health status</th>
<th>Prepare for arrival</th>
<th>My team</th>
</tr>
</thead>
<tbody>
<tr>
<td>• For more information, see View your health status in Now Mobile.</td>
<td>My readiness checklist</td>
<td>My team’s health</td>
</tr>
<tr>
<td></td>
<td>• Provides a checklist of tasks to complete prior to arriving at the work location.</td>
<td>• Shows a list of your direct reports and their health status.</td>
</tr>
<tr>
<td></td>
<td>My office entry code</td>
<td>My direct reports open tasks</td>
</tr>
<tr>
<td></td>
<td>• Provides a QR code that enables you to check into a work location.</td>
<td>• Shows all open tasks assigned to your direct reports that must be completed prior to arriving at a work location.</td>
</tr>
</tbody>
</table>

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

**Installation instructions for self-hosted and federal environments**

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

If you’ve subscribed to the Safe Workplace suite and you already have some of the apps installed, refer to the following order of installation for the remaining apps.

- Emergency Outreach (sn_imt_checkin)
- Employee Health Screening (sn_imt_monitoring)
- Workplace PPE Inventory Management (sn_imt_ppe)
- Employee Readiness Surveys (sn_imt_readiness)
• COVID-19 Global Health Data Set (sn_imt_c19datafeed)
• Contact Tracing (sn_imt_tracing)
• Emergency Self Report (sn_imt_quarantine)
• Workplace Safety Management (sn_wsd_core)
• Safe Workplace Dashboard (sn_imt_dashboard)
• Emergency Response Management for Now Mobile (sn_imt_mobile)
• Employee Travel Safety (sn_imt_travel)
• Health and Safety Testing (sn_imt_health_test)
• Vaccination Status (sn_imt_vaccine)

Notice regarding use by organizations
All decisions in connection with the implementation of this application are at the sole
decision of the Organization utilizing this application. Organizations agree that use of the
application is not a representation by ServiceNow regarding the application’s compliance
with any law or regulation and any suggested language provided out of the box with the
application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under
applicable law, including (but not limited to) data protection and employment laws, and
should modify any language within the templates provided to meet the Organizations’
specific requirements.

Notice regarding use by government agencies
ServiceNow is offering this application to government agencies and their authorized users,
not to government employees in their individual capacities. Use of the application does not
modify any existing, or future entitlements or payment obligations for ServiceNow software
or applications otherwise purchased by the government agency. ServiceNow shall not
be responsible for any implementation or configuration costs associated with use of the
application unless separately purchased. Government customers are solely responsible to
confirm with the agency’s Ethics Office or its authorized representative that acceptance and
usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.

Install Safe Workplace for mobile
Install the Now® Mobile app and Safe Workplace for mobile app.

Before you begin
The Safe Workplace for mobile app (sn_imt_mobile) is dependent on the
com.sn_imt_quarantine plugin.

The Safe Workplace for mobile app also has an optional dependency on other Safe
Workplace applications. If you have any of these plugins installed, the corresponding
applications will appear in your Safe Workplace for mobile app:
• sn_imt_checkin
• sn_imt_core
Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the Federal downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030260] article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the Commercial downloads for the Emergency Response Management and Safe Workplace suite apps [KB0030258] article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

Procedure

1. On your mobile device, download the Now Mobile app for Apple iOS or Google Android from the Apple App Store or the Google Play store.
2. In your instance, navigate to System Applications > All Available Applications > All.
4. Click Install.
5. In the Application installation dialog box, click Install.
6. When the installation is complete, click Close.
7. Optional: Control access to the application by creating a group and assigning roles to the group or individual users.
   (Optional) For more information, see Roles.

Report your health status in Now Mobile
Use the Now® Mobile app to report your health status.

Before you begin
Role required: sn_imt_quarantine.crisis_task_user
To access this content, you must have the Now Mobile app. Your instance must have the Emergency Self Report application installed.

About this task
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

⚠️ Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

Procedure
1. Open the Now Mobile app.
2. At the top of the Health page, click the quick action icon to open the self-report applet.
3. Select your health status from the list, and tap the check icon to confirm your status.

4. Click Submit.
**View your health status in Now Mobile**
Use the Now Mobile app to view your health status record.

**Before you begin**
Role required: none
To access this content, you must have the Now Mobile app. Your instance must have the Emergency Self Report application installed.

**About this task**
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

⚠️ Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

**Procedure**
1. Open the Now Mobile app.
2. Scroll down to **My Current Health Status** and click the **See All** link.
3. Click your name.

**My Current Health Status screen**
The **My Current Health Status** screen displays the following information:

- Use the **Status** tab to see your current reported status.
- Use the **Health history** tab to see a history of your health status updates.
- Use the **Assigned tasks** tab to see the tasks assigned to you.
- Use the **Update status** button to change your health status.
- If you're a manager, use the **Reassign all** action from the top menu icon to reassign all your tasks.
Manage the status of your direct reports in Now Mobile

Use the Now Mobile app to view the health status of your direct reports.

Before you begin
To access this content, you must have the Now Mobile app. Your instance must have the Emergency Self Report application installed.

Role required: none

About this task
From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

Note: The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.

Procedure
1. Open the Now Mobile app.
2. Scroll down to the My Team section and click the My Team's Health link.
   In the My Team's Health section, you can see a list of all your users.
3. In the My Team's Health section, a list of all your users and their status is displayed.
4. Optional: Update the status for a user.

- Swipe to the left on an entry in the list to update the user's status.
- Tap on a record in the list and click **Update status** at the bottom of the task form.
5. Tap an entry on the list to view the employee record screen.

**Employee record screen**

The employee record screen displays the following information:

- Use the contact and location information in the Details screen to keep in touch with your direct hires.
- Use the **Health history** tab to see a history of the user's health status updates.
- Use the **Assigned Tasks** tab to see the tasks assigned to the user.
- Click the **Update status** button to change the user's health status.

---

**Reassign tasks to your team members in Now Mobile**

As a manager, view a list of tasks assigned to your team members and reassign the tasks to other team members.

**Before you begin**

To access this content, you must have the *Now® Mobile* app. Your instance must have the **Emergency Self Report** application installed.

Role required: none

**About this task**

From the Safe Workplace for mobile app, users can access applications from the Emergency Response Management and Safe Workplace product suites.

**Note:** The Emergency Response Management for Now® Mobile app was renamed to Safe Workplace for mobile.
Procedure
1. Open the Now Mobile app.
2. Scroll down to the My Team section and click My Direct Reports Open Tasks.

3. A list all open tasks assigned to your direct reports is displayed. To view details about the task, click the open task.
4. To reassign a task, swipe left and click Reassign.
5. Search for a user that you want to reassign the task to and select the name of the user.
6. Click Submit.
Case and Knowledge Management

The Case and Knowledge Management application allows you to standardize the documentation, interaction, and fulfillment of employee inquiries and requests, which helps to improve HR efficiency and services over time.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Quebec</td>
<td>• Activate Case and Knowledge Management</td>
<td>• HR Administration</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HR Profile</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the HR Service Delivery community</td>
</tr>
<tr>
<td>• HR Case Management</td>
<td>• Developer documentation</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• HR Knowledge Management</td>
<td>• Components installed with Case and Knowledge Management</td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td>• HR Dashboards &amp; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• HR Integrations</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Understanding Case and Knowledge Management

Case and Knowledge Management for the scoped version of HR benefits your enterprise by automating standard HR processes within your organization that support relationships between employees and the HR department.

Who uses HR Service Delivery

HR Service Delivery is used by the enterprise HR department. An enterprise HR department is composed of many areas, such as employee relations, benefits administration, policy enforcement, recruitment and employment, and performance management. The members of a large HR organization typically include:

• HR specialists who specialize in one or more HR disciplines. For example, the benefits area has specialists in insurance administration, leave and vacation time, and employee stock purchase.

• HR generalists who work with a business group or in a geographical region to assist employees with questions, careers, performance management, and other employee relations requests.

• HR managers who monitor and measure the effectiveness of the HR group in supporting employees across the organization. They also ensure that the enterprise is compliant with federal, state, and local regulations.

• HR systems administrators who configure and maintain systems such as the central employee database, payroll, learning and performance management system, and others, including the Human Resources application.

How you use HR Service Delivery

HR Service Delivery enhances and supports your enterprise. The relationships between your employees, IT, and the HR department are supported in numerous ways:

• Employees can use the HR Service Portal or catalog to submit questions and other requests to the HR department.

• If you use the Connect Support feature, employees can chat with an HR agent who is monitoring the HR chat queue. See Connect Support.
• HR staff can create, manage, and view HR cases to answer questions and process the requests that employees submit.
• HR managers can run reports and view overview information to monitor and manage work done by the HR department.
• HR and corporate IT administrators can more effectively manage the company HR systems, such as the payroll and performance management systems, through the Enterprise Configuration Management Database (ECMDB).

How you benefit from HR Service Delivery
Your entire organization benefits by using the application in the following ways:

Automates standard HR processes
Several typical HR processes are automated. This automation reduces the number of checklists, email exchanges, and phone calls performed by the HR team.

Improves employee access
Employees access HR services through a service catalog, rather than having to write individual emails, make phone calls, or personally visit HR for each request.

Tracks requests and progress
HR managers use reports and views to help them understand the work their staff is performing to support the company. Employees can see the status of their requests.

Integrates with other services
Human resources processes can include both HR tasks and tasks for other teams, to provide significant service delivery improvements.

HR Service Delivery terminology
The following terminology is used for the application.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Criteria</td>
<td>Way to select groupings of HR and System users based on criteria</td>
</tr>
<tr>
<td>HR Services</td>
<td>List of HR Services</td>
</tr>
<tr>
<td>HR Topic Categories</td>
<td>List of HR Service Topic Categories</td>
</tr>
<tr>
<td>HR Relationships</td>
<td>User relationships with each other</td>
</tr>
<tr>
<td>HR Positions</td>
<td>Positions available in company table</td>
</tr>
<tr>
<td>HR Assignment Tier Definition</td>
<td>Specifies escalation hierarchy</td>
</tr>
<tr>
<td>HR Group Roles</td>
<td>List of groups that have HR group roles</td>
</tr>
<tr>
<td>HR Email Scripts</td>
<td>List of all HR email scripts</td>
</tr>
<tr>
<td>HR User Roles</td>
<td>List of users who have HR user roles</td>
</tr>
<tr>
<td>HR Templates</td>
<td>Templates for Case record creation based on catalog item</td>
</tr>
<tr>
<td>Client Role Rules</td>
<td>Specifies the rules to generate client roles</td>
</tr>
<tr>
<td>HR Topic</td>
<td>Details List of HR Service Topic Details</td>
</tr>
</tbody>
</table>
## Activate Case and Knowledge Management

You can activate Human Resources Scoped App: Core [com.sn_hr_core] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

### Before you begin
Role required: admin

### About this task
Human Resources Scoped App: Core allows you to standardize the documentation, interaction, and fulfillment of employee inquiries and requests. It activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Service Options</td>
<td>List of HR Services options that affect case creation</td>
</tr>
<tr>
<td>HR Departments</td>
<td>Departments available in company table</td>
</tr>
<tr>
<td>HR Locations</td>
<td>Locations available in company table</td>
</tr>
<tr>
<td>HR Chat Queues</td>
<td>List of HR chat queues</td>
</tr>
<tr>
<td>HR Surveys</td>
<td>Surveys used by HR application</td>
</tr>
<tr>
<td>HR Links</td>
<td>External links used by HR application</td>
</tr>
<tr>
<td>HR Properties</td>
<td>System properties used in HR Application</td>
</tr>
<tr>
<td>HR Email Templates</td>
<td>List of all HR-related email templates</td>
</tr>
<tr>
<td>HR Knowledge Bases</td>
<td>Knowledge bases used by HR application</td>
</tr>
<tr>
<td>HR Knowledge Articles</td>
<td>Knowledge articles used by HR application</td>
</tr>
<tr>
<td>HR Notifications</td>
<td>Email notifications used by HR application</td>
</tr>
<tr>
<td>HR Service Catalog Categories</td>
<td>Service catalog categories used by HR application</td>
</tr>
<tr>
<td>HR Service Catalog Items</td>
<td>Service catalog items used by HR application</td>
</tr>
<tr>
<td>HR Document Templates</td>
<td>Document templates for document content used in HR application</td>
</tr>
<tr>
<td>HR Groups</td>
<td>Groups used by HR users</td>
</tr>
<tr>
<td>HR Skills</td>
<td>Skills available to company users</td>
</tr>
<tr>
<td>HR Roles</td>
<td>Roles used by HR users</td>
</tr>
<tr>
<td>HR Benefit Provider / Plans</td>
<td>Benefit providers and plans used by HR Benefits service</td>
</tr>
<tr>
<td>HR Benefit Type</td>
<td>Benefit types used by HR Benefits service</td>
</tr>
<tr>
<td>Disciplinary Issue Types</td>
<td>Disciplinary issue types used by HR Employee Relations service</td>
</tr>
<tr>
<td>Disciplinary Warning Types</td>
<td>Warning types used by HR Employee Relations service</td>
</tr>
<tr>
<td>HR System Report Frequencies</td>
<td>System Report Frequencies defined for HR Systems Service</td>
</tr>
<tr>
<td>HR System Report Types</td>
<td>HR System Report types used by HR System service</td>
</tr>
</tbody>
</table>
Plugins for Human Resources Scoped App: Core

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Scoped App: Integrations [com.sn_hr_integrations]</td>
<td>Provides HR Integrations.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Case and Knowledge Management
Several types of components install with the activation of the Case and Knowledge Management plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Note:** The Human Resources Scoped app: Core [com.sn_hr_core] plugin activates the sn_hr_core.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only HR admin user by requiring a minimum number (default is two) of active users with those admin roles.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Case and Knowledge Management administrator [sn_hr_core.admin] | Can access and configure Case and Knowledge Management. | • approval_admin  
• assignment_rule_admin  
• knowledge_manager  
• link_generator_writer |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| HR agent [sn_hr_core.basic]       | Grants access to basic HR agents daily work need.                                                                             | • document_management_user  
• skill_user  
• sn_hr_core.case_writer  
• sn_hr_core.kb_writer  
• sn_hr_core.profile_writer  
• survey_reader  
• sn_hr_core.report_creator     |
| HR case reader [sn_hr_core.case_reader] | Grants access to read all HR cases.                                                                                           | • None                                                                                                                              |
| HR case writer [sn_hr_core.case_writer] | Grants access to write all HR cases.                                                                                           | • sn_hr_core.case_reader  
• sn_templated_snip.template_snippet_reader                                                                                         |
<p>| HR content reader [sn_hr_core.content_reader] | Grants access to read all manage content table records.                                                                      | • None                                                                                                                              |
| HR content writer [sn_hr_core.content_writer] | Grants access to create, update, read, and delete all manage content table records.                                         | • sn_hr_core.content_reader                                                                                                         |
| Alumni employee [sn_hr_core.hrsm_alumni] | Grants role to the employee who has left the company.                                                                           | • None                                                                                                                              |
| Contingent employee [sn_hr_core.hrsm_contingent] | Grants role to the employee who works temporary.                                                                               | • None                                                                                                                              |
| Contractor employee [sn_hr_core.hrsm_contractor] | Grants role to the employee who works as a contractor.                                                                          | • None                                                                                                                              |</p>
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-time employee [sn_hr_core.hrsm_employee]</td>
<td>Grants role to the full-time employee.</td>
<td>• None</td>
</tr>
<tr>
<td>New hire employee [sn_hr_core.hrsm_new_hire]</td>
<td>Grants role to the employee who is newly hired.</td>
<td>• None</td>
</tr>
<tr>
<td>HR knowledge writer [sn_hr_core.kb_writer]</td>
<td>Grants access to write all HR KB articles.</td>
<td>• None</td>
</tr>
<tr>
<td>HR manager [sn_hr_core.manager]</td>
<td>Grants access to all HR cases, profiles, secure information.</td>
<td>• approver_user • catalog • catalog_admin • skill_admin • sn_hr_core.basic • sn_hr_core.secure_info_writer • sn_templated_snip.template_snippet_writer • survey_admin</td>
</tr>
<tr>
<td>HR Performance Analytics Admin [sn_hr_pa.admin]</td>
<td>HR Performance Analytics Admin role for the scoped application.</td>
<td>• None</td>
</tr>
<tr>
<td>HR profile reader [sn_hr_core.profile_reader]</td>
<td>Grants access to read all HR Profile records.</td>
<td>• None</td>
</tr>
<tr>
<td>HR profile writer [sn_hr_core.profile_writer]</td>
<td>Grants access to write all HR Profile records.</td>
<td>• sn_hr_core.profile_reader</td>
</tr>
<tr>
<td>HR report creator [sn_hr_core.report_creator]</td>
<td>Allows HR agents with the sn_hr_core.basic role to access the HR case [sn_hr_core_case] and</td>
<td></td>
</tr>
</tbody>
</table>
You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-close case</td>
<td>Automatically closes HR cases based on the configuration of the HR service for service activity and lifecycle event fulfillment types. This scheduled job runs daily.</td>
</tr>
<tr>
<td>Bulk case creation</td>
<td>Creates bulk cases. This scheduled job runs every six hours.</td>
</tr>
<tr>
<td>HR Daily Job</td>
<td>Sends reminder notifications to users based on certain HR task parameters. This scheduled job runs daily.</td>
</tr>
<tr>
<td>Migrate HR e-signature tasks</td>
<td>Migrates HR task templates and open HR tasks to the new HR task type for e-signature. Also disables the old HR task types for credential, e-signature, and sign document. This scheduled job runs on an on-demand basis.</td>
</tr>
<tr>
<td>Update Client Roles</td>
<td>Updates role assignments for HR profiles that are beginning or ending their employment based on the HR condition table. This scheduled job runs daily.</td>
</tr>
</tbody>
</table>

**Note:** The base system assigns the HR Admin (hradmin) user to this scheduled job. If you delete the HR Admin user, ensure that you assign another user with the HR admin (sn_hr_core.admin) role to this scheduled job.

For further information on scheduled jobs and how to use them, see Scheduled jobs.
## Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allegation</td>
<td>Contains information about an allegation type and subtype.</td>
</tr>
<tr>
<td>[sn_hr_er_allegation]</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>A non-metadata table.</td>
</tr>
<tr>
<td>Allegation Subtype</td>
<td>Metadata table that provides 59 records to the base system. Allegation subtypes further define an allegation. For example:</td>
</tr>
<tr>
<td>[sn_hr_core_allegation_sub_type]</td>
<td></td>
</tr>
<tr>
<td>• Allegation type = Discrimination</td>
<td></td>
</tr>
<tr>
<td>• Allegation subtypes: Age, disability, Race, and so on.</td>
<td></td>
</tr>
<tr>
<td>Allegation Type</td>
<td>Metadata table that provides base system records. Examples are:</td>
</tr>
<tr>
<td>[sn_hr_core_allegation_type]</td>
<td></td>
</tr>
<tr>
<td>• Customer Mistreatment</td>
<td></td>
</tr>
<tr>
<td>• Discrimination</td>
<td></td>
</tr>
<tr>
<td>• Drugs and Alcohol</td>
<td></td>
</tr>
<tr>
<td>• Fraud and Theft</td>
<td></td>
</tr>
<tr>
<td>• Harassment</td>
<td></td>
</tr>
<tr>
<td>• Interpersonal Conflict</td>
<td></td>
</tr>
<tr>
<td>• Misconduct</td>
<td></td>
</tr>
<tr>
<td>• Retaliation</td>
<td></td>
</tr>
<tr>
<td>• Wage and Scheduling Issue</td>
<td></td>
</tr>
<tr>
<td>• Workplace Violence</td>
<td></td>
</tr>
<tr>
<td>Associated Allegation</td>
<td>Contains information that associates an allegation to subject of allegations.</td>
</tr>
<tr>
<td>[sn_hr_er_m2m_allegation_party]</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>A non-metadata table.</td>
</tr>
<tr>
<td>Bank Account</td>
<td>Bank account table.</td>
</tr>
<tr>
<td>[sn_hr_core_profile_bank_account]</td>
<td></td>
</tr>
<tr>
<td>Bulk Case Creation Data</td>
<td>Bulk case creation data table.</td>
</tr>
<tr>
<td>[sn_hr_core_bulk_case_creation_data]</td>
<td></td>
</tr>
<tr>
<td>Bulk Case Creation Run</td>
<td>Bulk case creation run table.</td>
</tr>
<tr>
<td>[sn_hr_core_bulk_case_creation_run]</td>
<td></td>
</tr>
<tr>
<td>Case Restriction Configuration</td>
<td>Extends the COE Security Policy [sn_hr_core_coe_security_policy] table.</td>
</tr>
<tr>
<td>{sn_hr_er_case_restriction}</td>
<td></td>
</tr>
<tr>
<td>Client Role Rule</td>
<td>Client role rule table.</td>
</tr>
<tr>
<td>[sn_hr_core_client_role_rule]</td>
<td></td>
</tr>
<tr>
<td>COE</td>
<td>Center of Excellence (COE) table.</td>
</tr>
<tr>
<td>[sn_hr_core_coe]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>COE Configuration Matching</td>
<td>Center of Excellence (COE) configuration matching table.</td>
</tr>
<tr>
<td>Compensation</td>
<td>Compensation table.</td>
</tr>
<tr>
<td>Compensation Bonus</td>
<td>Bonus compensation table.</td>
</tr>
<tr>
<td>Compensation Salary</td>
<td>Salary compensation table.</td>
</tr>
<tr>
<td>Compensation Stocks</td>
<td>Stocks compensation table.</td>
</tr>
<tr>
<td>Corrective Action</td>
<td>Contains information on corrective actions associated with an ER case.</td>
</tr>
<tr>
<td>Direct Deposit</td>
<td>Direct deposit table.</td>
</tr>
<tr>
<td>Employee Relations Case</td>
<td>Extends the HR case [sn_hr_case] table.</td>
</tr>
<tr>
<td>HR Beneficiary</td>
<td>HR beneficiary table.</td>
</tr>
<tr>
<td>HR Benefit</td>
<td>HR benefits table.</td>
</tr>
<tr>
<td>HR Benefit Plan</td>
<td>HR benefit plan table.</td>
</tr>
<tr>
<td>HR Benefit Type</td>
<td>HR benefit type table.</td>
</tr>
<tr>
<td>HR Case</td>
<td>HR case table.</td>
</tr>
<tr>
<td>HR Benefits Case</td>
<td>HR benefits case table.</td>
</tr>
<tr>
<td>HR Compensation</td>
<td>HR compensation case table.</td>
</tr>
</tbody>
</table>

Note: This table is an extension of the Compensation table.

Note: This table is an extension of the Compensation table.

Note: This table is an extension of the Compensation table.

Note: This table is an extension of the Compensation table.

Note: A non-metadata table.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Condition [sn_hr_core_condition]</td>
<td>HR condition table.</td>
</tr>
<tr>
<td>HR Conditions for Criteria [sn_hr_core_m2m_condition_criteria]</td>
<td>HR conditions for criteria table.</td>
</tr>
<tr>
<td>HR Contact [sn_hr_core_contact]</td>
<td>HR contacts table.</td>
</tr>
<tr>
<td>HR Corporate Communications Case</td>
<td>HR corporate communications case table.</td>
</tr>
<tr>
<td>[sn_hr_core_case_corporate_communications]</td>
<td></td>
</tr>
<tr>
<td>Note: This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>HR Criteria [sn_hr_core_criteria]</td>
<td>HR criteria table.</td>
</tr>
<tr>
<td>HR Criteria for Links [sn_hr_core_m2m_link_template]</td>
<td>HR criteria for links table.</td>
</tr>
<tr>
<td>HR Disability Benefit [sn_hr_core_disability_benefit]</td>
<td>HR disability benefits table.</td>
</tr>
<tr>
<td>Note: This table is an extension of the HR Benefits table.</td>
<td></td>
</tr>
<tr>
<td>HR Disciplinary Issue Type [sn_hr_core_disciplinary_issue_type]</td>
<td>HR disciplinary issue type table.</td>
</tr>
<tr>
<td>HR Disciplinary Warning Type [sn_hr_core_disciplinary_warning_type]</td>
<td>HR disciplinary warning type table.</td>
</tr>
<tr>
<td>HR Document Type [sn_hr_core_document_type]</td>
<td>HR document type table.</td>
</tr>
<tr>
<td>HR Employee Relations Case [sn_hr_core_case_relations]</td>
<td>HR employee relations case table.</td>
</tr>
<tr>
<td>Note: This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>HR Ethics Case [sn_hr_core_case_ethics]</td>
<td>HR ethics case table.</td>
</tr>
<tr>
<td>Note: This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>HR Global Mobility Case [sn_hr_core_case_global_mobility]</td>
<td>HR global mobility case table.</td>
</tr>
<tr>
<td>Note: This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>HR Health Benefit [sn_hr_core_health_benefit]</td>
<td>HR health benefits table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Insurance Benefit</td>
<td>HR insurance benefits table.</td>
</tr>
<tr>
<td>[sn_hr_core_insurance_benefit]</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This table is an extension of the HR Benefits table.</td>
</tr>
<tr>
<td>HR Investigations Case</td>
<td>HR investigations case table.</td>
</tr>
<tr>
<td>[sn_hr_core_case_investigation]</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This table is an extension of the HR Benefits table.</td>
</tr>
<tr>
<td>HR Operations Report</td>
<td>HR operations report table.</td>
</tr>
<tr>
<td>[sn_hr_core_op_report]</td>
<td></td>
</tr>
<tr>
<td>HR Operations Report Frequency</td>
<td>HR operations report frequency table.</td>
</tr>
<tr>
<td>[sn_hr_core_op_report_frequency]</td>
<td></td>
</tr>
<tr>
<td>HR Operations Report Type</td>
<td>HR operations report type table.</td>
</tr>
<tr>
<td>[sn_hr_core_op_report_type]</td>
<td></td>
</tr>
<tr>
<td>HR Operations System</td>
<td>HR operations system table.</td>
</tr>
<tr>
<td>[sn_hr_core_op_system]</td>
<td></td>
</tr>
<tr>
<td>HR Operations System to Report Type</td>
<td></td>
</tr>
<tr>
<td>[sn_hr_core_op_system_to_report_type]</td>
<td></td>
</tr>
<tr>
<td>HR Payroll Case</td>
<td>HR payroll case table.</td>
</tr>
<tr>
<td>[sn_hr_core_case_payroll]</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This table is an extension of the HR Case table.</td>
</tr>
<tr>
<td>HR PDF Template</td>
<td>HR PDF template table.</td>
</tr>
<tr>
<td>[sn_hr_core_pdf_template]</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This table is an extension of the HR Document Template table.</td>
</tr>
<tr>
<td>HR Performance Case</td>
<td>HR performance case table.</td>
</tr>
<tr>
<td>[sn_hr_core_case_performance]</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This table is an extension of the HR Case table.</td>
</tr>
<tr>
<td>HR Profile</td>
<td>HR profiles table.</td>
</tr>
<tr>
<td>[sn_hr_core_profile]</td>
<td></td>
</tr>
<tr>
<td>HR Retirement Benefit</td>
<td>HR retirement benefits table.</td>
</tr>
<tr>
<td>[sn_hr_core_retirement_benefit]</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>This table is an extension of the HR Benefits table.</td>
</tr>
<tr>
<td>HR Service</td>
<td>HR services table.</td>
</tr>
<tr>
<td>[sn_hr_core_service]</td>
<td></td>
</tr>
<tr>
<td>HR Service Options</td>
<td>HR service options table.</td>
</tr>
<tr>
<td>[sn_hr_core_service_option]</td>
<td></td>
</tr>
<tr>
<td>HR Talent Management Case</td>
<td>HR talent management case table.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_hr_core_case_talent_management]</td>
<td><img src="https://example.com/note_icon.png" alt="Note" /> This table is an extension of the HR Case table.</td>
</tr>
<tr>
<td>HR Task [sn_hr_core_task]</td>
<td>HR task table.</td>
</tr>
<tr>
<td>HR Template [sn_hr_core_template]</td>
<td>HR template table.</td>
</tr>
<tr>
<td>HR Tier Escalation [sn_hr_core_tier_definition]</td>
<td>HR tier escalation table.</td>
</tr>
<tr>
<td>HR Total Rewards Case [sn_hr_core_case_total_rewards]</td>
<td><img src="https://example.com/note_icon.png" alt="Note" /> This table is an extension of the HR Case table.</td>
</tr>
<tr>
<td>HR Visa Category [sn_hr_core_visa_category]</td>
<td>HR visa category table.</td>
</tr>
<tr>
<td>HR Workforce Administrator [sn_hr_core_case_workforce_admin]</td>
<td>HR workforce administration case table.</td>
</tr>
<tr>
<td><img src="https://example.com/note_icon.png" alt="Note" /> This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>HRIT Operations Case [sn_hr_core_case_operations]</td>
<td>HRIT operations case table.</td>
</tr>
<tr>
<td><img src="https://example.com/note_icon.png" alt="Note" /> This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>HR Lifecycle Events Case [sn_hr_le_case]</td>
<td>HR lifecycle events case table.</td>
</tr>
<tr>
<td><img src="https://example.com/note_icon.png" alt="Note" /> This table is an extension of the HR Case table.</td>
<td></td>
</tr>
<tr>
<td>Interview [sn_hr_er_interview]</td>
<td>Contains information related to ER interviews.</td>
</tr>
<tr>
<td><img src="https://example.com/note_icon.png" alt="Note" /> A non-metadata table.</td>
<td></td>
</tr>
<tr>
<td>Involved Party [sn_hr_er_involved_party]</td>
<td>Contains information on involved parties related to the ER case.</td>
</tr>
<tr>
<td><img src="https://example.com/note_icon.png" alt="Note" /> A non-metadata table.</td>
<td></td>
</tr>
<tr>
<td>Job Profile [sn_hr_core_job_profile]</td>
<td>Job profile table.</td>
</tr>
<tr>
<td>Language [snsn_hr_core_language]</td>
<td>Language table.</td>
</tr>
<tr>
<td>PDF Template Mapping [sn_hr_core_pdf_template_mapping]</td>
<td>PDF template mapping table.</td>
</tr>
<tr>
<td>Position</td>
<td>Position table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>[sn_hr_core_position]</td>
<td></td>
</tr>
<tr>
<td>Relationship [sn_hr_core_relationship]</td>
<td>Relationship table.</td>
</tr>
<tr>
<td>Service Activity [sn_hr_core_service_activity]</td>
<td>Service activity table.</td>
</tr>
<tr>
<td>Sn HR Core Background Search Details [sn_hr_core_service_activity]</td>
<td>Background check search details table.</td>
</tr>
<tr>
<td>Sn HR Core Badge [sn_hr_core_badge]</td>
<td>Badge table.</td>
</tr>
<tr>
<td>Sn HR Core Bulk Case Request [sn_hr_core_bulk_case_request]</td>
<td>Bulk case request table.</td>
</tr>
<tr>
<td>Sn HR Core Config Case [sn_hr_core_config_case]</td>
<td>HR service-based case configuration table.</td>
</tr>
<tr>
<td>Sn HR Core Config Case Creation [sn_hr_core_config_case_creation]</td>
<td>Case creation configuration table.</td>
</tr>
<tr>
<td>Sn HR Core Config Case Creation Service [sn_hr_core_config_case_creation_service]</td>
<td>Case creation service configuration table.</td>
</tr>
<tr>
<td>Sn HR Core Email Content [sn_hr_core_email_content]</td>
<td>Email content table.</td>
</tr>
<tr>
<td>Sn HR Core Substitute Approver [sn_hr_core_substitute_approver]</td>
<td>Substitute approver table.</td>
</tr>
<tr>
<td>Topic Category [sn_hr_core_topic_category]</td>
<td>Topic category table.</td>
</tr>
<tr>
<td>Topic Detail [sn_hr_core_topic_detail]</td>
<td>Topic detail table.</td>
</tr>
<tr>
<td>Tuition Reimbursement [sn_hr_core_tuition_reimbursement]</td>
<td>Tuition reimbursement table.</td>
</tr>
<tr>
<td>User Fields On Case [sn_hr_core_service_approval_option]</td>
<td>User fields on case table.</td>
</tr>
<tr>
<td>Who is covered [sn_hr_core_who_is_covered]</td>
<td>Who is covered table.</td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see [Table administration](#).

**HR Administration**

Administer the Case and Knowledge Management application to improve HR efficiency and make it easier for employees to get the services they need.
Note: To use guided setup to help configure HR Service Delivery on your instance, navigate to **HR Administration > Guided Setup**. For further information on how to use the guided setup interface, see Using guided setup.

HR properties
HR properties control the behavior of HR Service Delivery.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to **HR Administration > Properties**.
   Some HR properties are found under **sys_properties.list**.
2. Configure the HR properties, as appropriate.

**HR Properties form**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_core.hr_profile_default_fields</td>
<td>Fields that appear on the Generate HR Profiles page. You can add fields from the sn_hr_core_profile column, but use commas to separate the fields.</td>
</tr>
<tr>
<td>sn_hr_core.hr_email</td>
<td>Enter the default email address for general HR inquiries.</td>
</tr>
<tr>
<td>sn_hr_core.hr_phone</td>
<td>Enter the default phone number for general HR inquiries.</td>
</tr>
<tr>
<td>sn_hr_core.hr_profile_editable_fields</td>
<td>Fields that users can edit themselves about their employee profile.</td>
</tr>
<tr>
<td>sn_hr_core.profile.max.tries</td>
<td>The maximum number of attempts allowed before the application exits when creating a user.</td>
</tr>
<tr>
<td>sn_hr_core.hr_vip_default_priority</td>
<td>The default priority on cases that the <strong>Opened for</strong> and/or <strong>Subject person</strong> is tagged as a VIP.</td>
</tr>
<tr>
<td>sn_hr_core.impersonateCheck</td>
<td>Check <strong>Yes</strong> (true) to prevent any user impersonating another user from viewing HR information. Note: Even if the logged in user has HR access and impersonates another HR user with the same access, HR information is not visible.</td>
</tr>
<tr>
<td>com.snc.signaturepad.retrieveSignature</td>
<td>Check <strong>Yes</strong> to enable signature retrieval and allowing users to save their digital signatures for reuse. If true, retrieves the latest signature image for a user and show it by default when the user navigates to the signature pad.</td>
</tr>
</tbody>
</table>
| sn_hr_core.log | The level of detail for system logs. The valid values are:  
  • Info: Least amount of detail  
  • Warn: Default  
  • Debug: Most amount of detail |
<p>| sn_hr_core.duplicate_hr_case_time_out | The number of days that must pass before a duplicate case warning appears when an HR case is created for the same HR service and subject person in HR Agent Workspace. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_core.rollup_work_notes</td>
<td>Check Yes to have work notes from a task also appear on the case.</td>
</tr>
<tr>
<td>sn_hr_core.inbound_email</td>
<td>This parameter determines if an email to HR is converted into an HR case.</td>
</tr>
<tr>
<td></td>
<td>• Yes: Create an HR case from email.</td>
</tr>
<tr>
<td></td>
<td>• No: Do not create an HR case from email.</td>
</tr>
<tr>
<td>sn_hr_core.sync.exclusion_fields</td>
<td>Specifies which fields on the HR profile (sn_hr_core_profile) table you don't want to synchronize with the User (sys_user) table.</td>
</tr>
<tr>
<td></td>
<td>For example, specify fields that should not be overwritten as they are already synchronized with an external application.</td>
</tr>
<tr>
<td>sn_hr_core.sync.exclusion_fields</td>
<td>Specifies which fields on the User (sys_user) table you don't want to synchronize with the HR profile (sn_hr_core_profile) table (as a comma separated list).</td>
</tr>
<tr>
<td></td>
<td>For example, specify fields that should not be overwritten as they are already synchronized with an external application.</td>
</tr>
<tr>
<td>sn_hr_core.itext7.pdf_conversion</td>
<td>Activate this property to use the iText7 for your document templates for PDF conversion, pre-fill values, and merge signatures into your documents.</td>
</tr>
<tr>
<td>sn_hr_core.reclassify_default_transfer</td>
<td>Determines how you want your instance to behave when you transfer an HR case to another case after an upgrade.</td>
</tr>
<tr>
<td></td>
<td>Valid entries:</td>
</tr>
<tr>
<td></td>
<td>• true: Use the default transfer case to use the standard method. The HR case number changes when transferring an HR case from one HR service to another. Both HR case numbers appear on the HR case for reference.</td>
</tr>
<tr>
<td></td>
<td>• false: Use the reclassify method to transfer an HR case. The HR case number does not change after transferring an HR case from one HR service to another.</td>
</tr>
</tbody>
</table>

Note: For more information, see Transfer an HR case.
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_core.include_elevated_roles</td>
<td>Checks for logged in users that have roles with elevated privilege before granting access. Valid entries:</td>
</tr>
<tr>
<td></td>
<td>• true: Check if logged in user has role with elevated privilege before granting access.</td>
</tr>
<tr>
<td></td>
<td>• false: Do not check if logged in user has role with elevated privilege before granting access.</td>
</tr>
</tbody>
</table>

#### 3. Click **Save**.

**HR services**

HR services are the requests and assistance an HR organization provides its employees, such as benefits enrollment, direct deposit setup, and requests for relocation assistance. They are the starting point for HR case creation and define the process for that case type, from request to fulfillment. You can create new or modify existing HR services, as well as configure them to be available for internal use only or for employee self-service.

**HR Centers of Excellence data model**

HR services are categorized under one of the HR Centers of Excellence (COEs), which are part of a data model that organizes HR data, services, and processes by functional discipline. Each COE is an extension of the HR Case [sn_hr_core_case] table, and each COE is further organized by HR topic category and detail. Before you begin configuring the individual HR services, review and set up the categorization structure for them.

- **HR Centers of Excellence data model**
- **HR service categorization**

**HR request to fulfillment process**

In determining what HR services to offer, you should consider:

- What are the requests you expect to receive and the services you want to provide?
- How do you plan to report on this data? This affects how you categorize your HR services.
- What information must you collect to fulfill the requests?
- How can the requests be made?
  - Email
  - Phone
  - Employee self-service through the HR service catalog
- How is the request ultimately fulfilled?
  - HR case form
  - Fulfillment instructions
  - Approvals
  - Tasks
  - Child HR services
  - Lifecycle events
  - Knowledge articles

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**HR service configuration**

HR services are the starting point for HR case creation and define the request to fulfillment process for that case type. The configuration requirements for an HR service depend on whether it is available for internal use only, or if you are allowing the employee to request the service directly from the HR service catalog through a self-service portal such as the Employee Service Center.

<table>
<thead>
<tr>
<th>HR service type</th>
<th>Configuration requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal use only</td>
<td>• HR service</td>
</tr>
<tr>
<td></td>
<td>• HR case template</td>
</tr>
<tr>
<td>Employee self-service</td>
<td>• HR service</td>
</tr>
<tr>
<td></td>
<td>• HR case template</td>
</tr>
<tr>
<td></td>
<td>• HR catalog item (also known as a record producer)</td>
</tr>
</tbody>
</table>

Not all HR services need to be accessible for employee self-service. Some services may only be initiated by HR agents, such as to set up payroll for a new hire. Some services may require the employee to contact HR directly by email or phone, such as when a manager requests a promotion for one of her direct reports. In these cases, the HR case is created internally by the HR agent. HR services intended for internal use only require configuration of the HR service and HR case template. See HR service configuration for more information.

Other HR services, however, may also be initiated by the employee, such as to update an employee profile or to request a password reset. These services are made available as HR catalog items in the HR service catalog. Employees can browse the HR service catalog and make requests directly from a self-service portal such as the Employee Service Center. HR services intended for employee self-service require configuration of the HR catalog item (also known as a record producer) in addition to the HR service and HR case template. See HR catalog item configuration for more information.

**HR service catalog management**

The HR service catalog provides employees a catalog of HR services that they can request directly from HR. Employees can access the HR service catalog from a self-service portal such as the Employee Service Center. You can manage the setup and categorization of the HR service catalog, as well as configure the individual HR catalog items that populate it.

- HR service catalog management
- HR service catalog categorization

**HR template configuration**

HR templates allow you to automatically populate fields on an HR case or task form. You can configure HR templates for HR services, HR catalog items, HR service activities, and lifecycle event activities. See HR templates for more information.

**HR Centers of Excellence data model**

Organize HR data, services, and processes by functional discipline with the HR Centers of Excellence (COEs) data model. Each COE can be configured to its unique function, such as to payroll or employee relations. The COE data model further allows you to limit access to sensitive information, promote consistency for metrics and reporting, and help drive automation by defining the request to fulfillment process at the HR service level.
HR Centers of Excellence (COEs) overview

Each HR Center of Excellence is an extension of the HR Case [sn_hr_core_case] table and is organized around a functional discipline, such as employee relations, lifecycle events, payroll, talent management, workforce administration, total rewards, and HRIT operations.

**Note:** The COEs available to you may differ depending on the HR package you have.

Each COE is further organized by HR topic category and detail, which defines the first- and second-level of categorization for HR services under that COE. Each COE can have one or more topic categories. Each topic category can have one or more topic details. And each topic detail can have one or more HR services. This structure enables you to categorize HR services by functional area, and you can configure the categorization structure and the individual HR services to meet the needs of your organization.

The following video provides an overview of the HR Centers of Excellence, including the benefits of COEs and how to configure and use the COE data model.

The HR Centers of Excellence video provides an overview of the HR Centers of Excellence (COEs), their benefits, the COE data model, how to configure and use the COE data model, and how to handle a request for a new COE.

**HR service categorization setup**

Before you begin configuring the individual HR services, review and set up the categorization structure for them.
Roles
The System Administrator (admin) role can configure and create new COEs.
The Lifecycle Event Administrator (sn_hr_le.admin) role with the Delegated Developer
delegated_developer role can also configure and create new COEs.

HR service categorization
HR services are categorized under one of the HR Centers of Excellence (COEs), which are
part of a data model that organizes HR data, services, and processes by functional discipline.
Each COE is an extension of the HR Case [sn_hr_core_case] table, and each COE is further
organized by HR topic category and detail. Before you begin configuring the individual HR
services, determine which COEs you want to use, and then create or modify the appropriate
HR topic categories and details for each COE.

Enable or disable an HR Center of Excellence (COE)
Enable or disable an HR Center of Excellence (COE) for use. COEs are tables that extend the
HR Case [sn_hr_core_case] table and part of a functional discipline, such as total rewards
or talent management. COEs are also part of HR services that contain topic category and
detail.

Before you begin
Role required: sn_hr_core.admin
If your company:
• Does not use COEs.
• Wants to deactivate COEs.
• Has multiple environments and you’re using system update sets to update changes.
• Deactivate COEs manually on all your environments.

Note: System update sets capture deactivation in one environment, but after a
patch or upgrade, COEs are active in your other environments. See System update
sets.

Procedure
1. Navigate to HR Administration > COE Configuration.
2. Enable or disable the applicable HR Center of Excellence (COE).

Note: The COEs available to you may differ depending on the HR package you
have.
When you disable a COE, the corresponding HR services associated with that COE also disable.

- The extended tables associated with each COE do not disable. You can still access these tables. Any active cases under a deactivated COE remains active.
- Only the COE deactivates.

3. Click **Save**.

**Configure an HR topic category**

Create or modify an HR topic category to define the first-level of categorization for HR services. Each topic category is associated with a single HR Center of Excellence (COE).

**Before you begin**

Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > HR Services > Topic Categories**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**Topic Category form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate the HR topic category for use.</td>
</tr>
<tr>
<td>COE</td>
<td>Name of the HR Center of Excellence (COE) that the HR topic category is categorized under. Each HR topic category is associated with a single COE.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the HR topic category.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.
Configure an HR topic detail

Create or modify an HR topic detail to define the second-level of categorization for HR services. Each topic detail is associated with a single topic category and HR Center of Excellence (COE).

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > HR Services > Topic Details.
2. Click New or open a record.
3. Fill in the fields on the form.

Topic Detail form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box to activate the HR topic detail for use.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the HR topic detail.</td>
</tr>
<tr>
<td>Topic category</td>
<td>Name of the HR topic category that the HR topic detail is categorized under. Each HR topic detail is associated with a single HR topic category.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

Configuring HR Service Delivery Center of Excellence (COE) security policies

Use COE Access Control List (ACLs) Configuration to allow specific groups read or write access to HR cases under a specific COE.

For example, you don’t want the Benefits group to view the cases created by the Compensation group. You create a COE security policy that allows the Compensation group access. Groups that aren’t included on the policy cannot access the cases.

Use this feature as an alternative to using ACLs rules. For more information on ACLs, see Access control list rules.

COE security policies don’t affect case creation. COE security policies affect what cases you can view or modify after creation.

You can still reclassify (transfer) HR cases from one HR service to another. Depending on the security policy, you might not be able to view the case after reclassification.

COE ACL Configuration uses the COE Security Policy [sn_hr_core_coe_security_policy] table to determine access to the extended HR case tables (COEs).

The tables you can provide security for are:

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Benefits Case</td>
<td>sn_hr_core_case_benefits</td>
</tr>
<tr>
<td>HR Compensation Case</td>
<td>sn_hr_core_case_compensation</td>
</tr>
<tr>
<td>HR Corporate Communications Case</td>
<td>sn_hr_core_case_corporate_communications</td>
</tr>
<tr>
<td>HR Employee Relations Case</td>
<td>sn_hr_core_case_relations</td>
</tr>
<tr>
<td>HR Ethics Case</td>
<td>sn_hr_core_case_ethics</td>
</tr>
<tr>
<td>Label</td>
<td>Name</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>HR Global Mobility Case</td>
<td>sn_hr_core_case_global_mobility</td>
</tr>
<tr>
<td>HR Investigations Case</td>
<td>sn_hr_core_case_investigation</td>
</tr>
<tr>
<td>HR Payroll Case</td>
<td>sn_hr_core_case_payroll</td>
</tr>
<tr>
<td>HR Performance Case</td>
<td>sn_hr_core_case_performance</td>
</tr>
<tr>
<td>HR Talent Management Case</td>
<td>sn_hr_core_case_talent_management</td>
</tr>
<tr>
<td>HR Total Rewards Case</td>
<td>sn_hr_core_case_total_rewards</td>
</tr>
<tr>
<td>HR Workforce Administration Case</td>
<td>sn_hr_core_case_workforce_admin</td>
</tr>
<tr>
<td>HRIT Operations Case</td>
<td>sn_hr_core_case_operations</td>
</tr>
<tr>
<td>HR Lifecycle Events Case</td>
<td>sn_hr_le_case</td>
</tr>
</tbody>
</table>

**Note:** You can also provide security to any case table you extend.

To define security for a COE:

- Choose all or specific HR services that fall under a COE.

**Note:** When you select specific HR services for a COE, the unselected HR services are accessible by the case reader.

- Determine what groups have read or write access to HR services under a COE.
- Create conditions to filter the records that apply to your security policy.

**Note:** Condition builder is a powerful tool that filters specific actions on the COE. Use caution when using conditions on your security policy. It may also affect system performance.

**Create COE security**

Place security on a COE to prevent a group from accessing another group’s cases.

**Before you begin**

Role required: admin, sn_hr_core.admin, sn_hr_le.admin
Procedure
1. Navigate to **HR Administration > COE ACL Configuration**.

2. Select the COE (table that extends the HR case table) you want specified groups to have access to.

3. Check **Applies to all services** if you want all the HR services under the selected COE to be included in the security policy.

4. Leave this field blank to select specific HR services under a COE.

5. If you leave this field blank, the **Services** field appears and you can select specific HR services.
6. Ensure that the **Application** field displays the scope correctly. For more information, see System settings for the user interface (UI).

7. Check **Active** to enable security on the COE.

8. From the **Type** field, select how the policy you are defining controls security for the COE. Your choices are:
   - **Read**:
   - **Write**:
   - **Case Locking**:
     Selecting Case Locking displays the following fields:
     - **Able to lock cases**: Users that belong to the associated group can lock cases under the COE.
     - **Able to view locked cases**: Users that belong to the associated group can view locked cases.

9. Select the conditions the security policy must meet to be in effect. If you want the security policy to be in effect for cases that affect all cases under a COE that are not active:

10. Select **Save** to remain on the security policy you are working on or **Submit** to return to the list of COE Security Policies. If you select **Save**, the Groups related list appears.

11. Select **Edit** to associate groups to the COE security policy. For more information on Groups, see **Manage HR Groups**.

12. Move the groups you want associated with the COE security policy you are defining from the Collection column to the Groups List column.

**Note:** Use caution when creating conditions.
13. Select **Save**. The COE Security Policy returns.

14. Select **Update**.

**HR service configuration**

HR services are the requests and assistance an HR organization provides its employees. You can configure an HR service to define the request to fulfillment process for that case type. You can configure an HR case template to automatically populate fields on the HR case form when a request for that service is made. And if you need to make an existing HR service available for employee self-service, you can configure a record producer to make the service available as an HR catalog item in the HR service catalog.

**Tip:** For best results, do not configure multiple record producers to invoke a single HR service.

**Note:** If you are creating a new HR service and plan to make it available for employee self-service, see [HR catalog item configuration](#) instead. Creating a new HR catalog item automatically creates a corresponding HR service, and you can avoid creating duplicate services.

**Configure an HR service**

Create or modify an HR service to define the request to fulfillment process for that case type. Examples of HR services include benefits enrollment, direct deposit setup, and background check requests by third-party providers.

**Before you begin**

Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > HR Services > HR Service Configuration**.

2. Click **New** or open a record.

**Note:** If you are creating a new HR service and plan to make it available for employee self-service, see [HR catalog item configuration](#) instead. Creating a new HR catalog item automatically creates a corresponding HR service, and you can avoid creating duplicate services.
3. Fill in the fields on the form, as appropriate.

**HR Service form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR service name</td>
<td>Name of the HR service.</td>
</tr>
<tr>
<td>Value</td>
<td>This field is automatically set to the name of the HR service.</td>
</tr>
<tr>
<td>Badge</td>
<td>Badge to use with the HR service. Badges display on the portal to indicate to the employee which department is fulfilling that activity. See <a href="#">Configure an HR badge</a> for more information.</td>
</tr>
<tr>
<td>Fulfillment type</td>
<td>Fulfillment type of the HR service. Select one of the following values:</td>
</tr>
<tr>
<td>Manual</td>
<td>A simple fulfillment type with no associated configurations. For example, for a medical benefits inquiry, the HR agent would fulfill the employee's request by answering the employee's question.</td>
</tr>
<tr>
<td>Service Activity</td>
<td>Service activities fulfill the HR service. In the Service Activities section at the bottom of the HR Service form, add one or more service activities to fulfill the HR service. See <a href="#">Configure a service activity for an HR service</a> for more information.</td>
</tr>
<tr>
<td>Workflow</td>
<td>A workflow fulfills the HR service.</td>
</tr>
<tr>
<td>Lifecycle Event</td>
<td>(Enterprise Onboarding and Transitions only) A lifecycle event fulfills the HR service. In the Lifecycle Event Type field, select a lifecycle event to fulfill the HR service. See <a href="#">Building a lifecycle event</a> for more information.</td>
</tr>
<tr>
<td>Advanced</td>
<td>An advanced option to fulfill the HR service using a combination of workflows and service activities.</td>
</tr>
<tr>
<td>Flow</td>
<td>A flow fulfills the HR service. In the Flow field, select a flow to fulfill the HR service. See <a href="#">Flow designer</a> for more information.</td>
</tr>
</tbody>
</table>

**Topic detail**

HR topic detail that the HR service is categorized under.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>The HR topic detail is the second-level of categorization for HR services. See <a href="#">HR service categorization</a> for more information.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The HR topic category is the first-level of categorization for HR services. See <a href="#">HR service categorization</a> for more information.</td>
</tr>
<tr>
<td>Topic category</td>
<td>HR topic category that the HR service is categorized under.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The COEs are organized around functional disciplines and are extensions of the HR Case [sn_hr_core_case] table. See <a href="#">HR service categorization</a> for more information.</td>
</tr>
<tr>
<td></td>
<td>(Enterprise Onboarding and Transitions only) An HR service for a lifecycle event can be associated with any COE.</td>
</tr>
<tr>
<td>COE</td>
<td>HR Center of Excellence (COE) that the HR service is categorized under.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The COEs are organized around functional disciplines and are extensions of the HR Case [sn_hr_core_case] table. See <a href="#">HR service categorization</a> for more information.</td>
</tr>
<tr>
<td>Automatically close case</td>
<td>Option to automatically close the HR case after all of the to-dos or all of the mandatory to-dos are complete. This field appears when Service Activity or Lifecycle Event is selected from Fulfillment type.</td>
</tr>
<tr>
<td>Close when</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• All to-dos are complete</td>
</tr>
<tr>
<td></td>
<td>• Mandatory to-dos are complete</td>
</tr>
<tr>
<td>Close offset</td>
<td>Number of days to offset the closure of the HR case. For example, if the offset is set to three, then the HR case will close three days after the completion of all (or all mandatory) to-dos.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The maximum offset that you can apply is 90 days.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR service for use.</td>
</tr>
<tr>
<td>Show case to subject person</td>
<td>(Employee Service Center only) Option to show the HR case to the subject person when it is created, including:</td>
</tr>
<tr>
<td></td>
<td>• HR tasks assigned to the subject person</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The ticket page of the Employee Center shows all to-dos and requests for an HR case when the Opened for and Subject person are identical. If you want the Subject person to only see tasks assigned to them, change the Opened for person to someone different (possibly the Subject person’s manager).</td>
</tr>
<tr>
<td></td>
<td>• Child HR cases where the subject person is also the opened for</td>
</tr>
<tr>
<td></td>
<td>• Child HR cases when the subject person has a task assigned</td>
</tr>
<tr>
<td></td>
<td>• Requests where the subject person is the requested for</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Template</td>
<td>HR case template to use with the HR service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The HR case template automatically populates fields on the HR case form when a request for that service is made. See Configure an HR case template for more information.</td>
</tr>
<tr>
<td>Record producer</td>
<td>(Employee self-service only) Record producer to use with the HR service if you want to make the service available as an HR catalog item in the HR service catalog.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> For best results, do not configure multiple record producers to invoke a single HR service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The record producer defines the required fields and how the HR catalog item appears in the HR service catalog to employees. See Configure a record producer for an HR service for more information.</td>
</tr>
<tr>
<td>Case options</td>
<td>Additional case options for the HR service. For example, you can:</td>
</tr>
<tr>
<td></td>
<td>• Add Manager to Watchlist: The manager of the subject person is added to the watchlist and receives notifications about the case.</td>
</tr>
<tr>
<td></td>
<td>• Automatically Create Draft Document: Automatically place a document for HR services to the subject person on the HR Service Portal. An example is when an employee requests tuition reimbursement. An education expense agreement document is automatically sent to the employee to sign.</td>
</tr>
<tr>
<td></td>
<td>• Automatically Initiates Document tasks: Tasks are created for participants who are mapped to a document template. This option appears only when the Document Templates [com.snc.document_templates] plugin is installed and a document template is selected on a HR service.</td>
</tr>
<tr>
<td></td>
<td>• Do Not Default Subject Person: Subject Person is not defaulted from the Opened for person when a case is created.</td>
</tr>
<tr>
<td></td>
<td>• Skip Auto Assign: HR case is not automatically assigned to an HR group or agent using the HR template or matching rules. Skipping auto assignment does not affect HR templates, assignment rules, or workflows.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Skip Automatic User Acceptance State</td>
<td>Select to bypass the user acceptance state.</td>
</tr>
<tr>
<td>• User Cannot Cancel: Opened for person on HR case cannot cancel it via the Employee Service Center (ESC) or service portal.</td>
<td></td>
</tr>
<tr>
<td>HR criteria</td>
<td>HR criteria to apply to the HR service.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>• HR criteria defines the conditions that an employee must meet for an HR agent to be able to access that HR service on their behalf. For example, you can configure the HR criteria for a 401(k) request so that the HR service is only available to U.S. employees from the Create New Case module. See HR criteria for more information.</td>
</tr>
<tr>
<td></td>
<td>• (Employee self-service only) HR criteria applied to the HR service is internal-facing only, and has no relation to the user criteria that is used to control what HR catalog items an employee can access from the HR service catalog. See Edit the record producer for an HR catalog item for more information.</td>
</tr>
<tr>
<td>Opened for / Approver view</td>
<td>(Employee Service Center only) Configuration of the HR ticket page header for the person that the HR case was opened for and any approvers.</td>
</tr>
<tr>
<td></td>
<td>Note: The HR ticket page is where users can view the details of an HR case in the Employee Service Center. See Configure the HR ticket page header for an HR service for more information.</td>
</tr>
<tr>
<td>Subject person / Task assignee view</td>
<td>(Employee Service Center only) Configuration of the HR ticket page header for the subject person of the HR case and any task assignees.</td>
</tr>
<tr>
<td></td>
<td>Note: The HR ticket page is where users can view the details of an HR case in the Employee Service Center. See Configure the HR ticket page header for an HR service for more information.</td>
</tr>
<tr>
<td>Case creation service config</td>
<td>Configuration of the HR case creation form for the HR service.</td>
</tr>
<tr>
<td></td>
<td>Note: The HR case creation form is what displays when an HR agent selects an HR service from the Create New Case module. You can configure the form to include additional fields to collect relevant information. See Configure the HR case creation form for an HR service for more information.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the HR service.</td>
</tr>
</tbody>
</table>

4. In the Checklist related list, you can provide steps to help HR agents fulfill HR cases for the associated HR service.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checklist</td>
<td>Provide a checklist of items for HR agents to check off when fulfilling the HR case.</td>
</tr>
</tbody>
</table>

5. In the **HR Service Additional Information** related list, you can configure the fields that appear on the HR case form after a request for that service is made. This is a two-part process. In addition to the configuration here, you must also configure the HR case form for the HR Center of Excellence (COE) that the HR service is categorized under.

**Note:** The HR case form is what displays after an HR case is created. Configuration of the HR case form is a two-part process. See [Configure the HR case form for an HR service](#) for more information.

6. Click **Submit** or **Update**.

### Configure a service activity for an HR service

If the fulfillment type of an HR service is set to **Service Activity**, configure one or more service activities. Service activities can be approvals, tasks, or child HR services.

**Before you begin**

- Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > HR Services > HR Service Configuration**.
2. Open the HR service.
3. In the **Fulfillment type** field, verify that the value is set to **Service Activity**.
The **Service Activities** section appears at the bottom of the HR service form.

4. **Click New** or open a record, and follow the tasks as applicable. On the Service Activity form, you can configure the following types of service activities:

- Approval
- Task
- Child HR Service

For each service activity type, follow the applicable task.

**Configure an approval**

Configure a service activity that is an approval. Approvals require one or more users to approve the case before it can proceed.

**Before you begin**

Role required: sn_hr_core.admin

**Procedure**

1. On the Service Activity form, set the **Activity type** field to Approval.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity type</td>
<td>Set the value to <strong>Approval</strong>.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the service activity.</td>
</tr>
<tr>
<td>Missing any approver</td>
<td>Select one of the following actions for when any approver is missing:</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing all approvers</td>
<td>Select one of the following actions for when all approvers are missing:</td>
</tr>
<tr>
<td></td>
<td>- Select replacements</td>
</tr>
<tr>
<td></td>
<td>- Close incomplete</td>
</tr>
<tr>
<td>Wait for</td>
<td>Select one of the following actions for when an approval is completed:</td>
</tr>
<tr>
<td></td>
<td>- Anyone to approve</td>
</tr>
<tr>
<td></td>
<td>- Everyone to approve</td>
</tr>
<tr>
<td></td>
<td>- First response from anyone</td>
</tr>
<tr>
<td>On rejection</td>
<td>Select one of the following actions for when an approval is rejected:</td>
</tr>
<tr>
<td></td>
<td>- Allow resubmit of approvals</td>
</tr>
</tbody>
</table>
|                              | ![Note:](image)
|                              | When an approval is rejected, the **Assigned to** user for the case can submit another request for approval with work notes or comments. See [Resubmit an HR case for approval](#). |
|                              | - Close incomplete                                                          |
|                              | ![Note:](image)
|                              | To reject an approval, users should have the HR case writer [sn_hr_core.case_writer] role. |
| Parent HR service            | This field is automatically set to the parent HR service.                   |
| Order                        | Order number for when the service activity is made available. Lower numbered service activities are made available before higher numbered service activities. |
|                              | ![Note:](image)
|                              | The current service activity must be closed, completed, accepted, or rejected before the next service activity is made available. |
|                              | ![Note:](image)
|                              | Service activities with identical order numbers are made available at the same time. |
| Approvers from case          | User fields from the HR case to approve the task.                           |
| Approver users               | Users to approve the task.                                                  |
| Approver groups              | Groups to approve the task.                                                 |

3. Click **Submit** or **Update** on the Service Activity form.

4. Click **Update** on the HR Service form.

**Configure a task**

Configure a service activity that is a task.
Before you begin
Role required: sn_hr_core.admin

Procedure
1. On the Service Activity form, set the Activity type field to Task.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity type</td>
<td>Set the value to Task.</td>
</tr>
<tr>
<td>Child task template</td>
<td>Name of the child task template that the service activity is associated with.</td>
</tr>
<tr>
<td></td>
<td>Note: The HR task template automatically populates fields on the HR task form when the task is generated. See Configure an HR task template for more information.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the service activity.</td>
</tr>
<tr>
<td>Parent HR service</td>
<td>This field is automatically set to the parent HR service.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for when the service activity is made available. Lower numbered service activities are made available before higher numbered service activities.</td>
</tr>
<tr>
<td></td>
<td>Note: • The current service activity must be closed, completed, accepted, or rejected before the next service activity is made available. • Service activities with identical order numbers are made available at the same time.</td>
</tr>
</tbody>
</table>

3. Click Submit or Update on the Service Activity form.
4. Click Update on the HR Service form.

Configure a child HR service
Configure a service activity that is a child HR service.

Before you begin
Role required: sn_hr_core.admin

Note: This feature is only available when the Human Resources Scoped App: Lifecycle Events (com.sn_hr_lifecycle_events) plugin is activated. For more information, see Understanding Enterprise Onboarding and Transitions.

Procedure
1. On the Service Activity form, set the Activity type field to Child HR Service.
2. Fill in the fields on the form, as appropriate.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity type</td>
<td>Set the value to <strong>Child HR Service</strong>.</td>
</tr>
<tr>
<td>Child HR service</td>
<td>Name of the child HR service that the service activity is associated with.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the service activity.</td>
</tr>
<tr>
<td>Parent HR service</td>
<td>This field is automatically set to the parent HR service.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for when the service activity is made available. Lower numbered service activities are made available before higher numbered service activities.</td>
</tr>
</tbody>
</table>

**Note:**

- The current service activity must be closed, completed, accepted, or rejected before the next service activity is made available.
- Service activities with identical order numbers are made available at the same time.

3. Click **Submit** or **Update** on the Service Activity form.

4. Click **Update** on the HR Service form.

**Configure the HR ticket page header for an HR service**

Configure the HR ticket page header for an HR service. The HR ticket page is where users can view the details of an HR case in the Employee Service Center. You can define how the HR case header appears for the opened for/approver and subject person/task assignee users. The HR case header configuration records can be applied to one or more HR services.

**Before you begin**

*Role required: sn_hr_core.admin*

**Procedure**

1. Navigate to **HR Administration > HR Services > HR Service Configuration**.
2. Open the HR service.
3. For each of the following fields, open the HR case header configuration record.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opened for / Approver view</strong></td>
<td>Appearance of the HR case header for the opened for and approver users in the HR ticket page.</td>
</tr>
<tr>
<td><strong>Subject person / Task assignee view</strong></td>
<td>Appearance of the HR case header for the subject person and task assignee users in the HR ticket page.</td>
</tr>
</tbody>
</table>

**Note:** To create a new HR case header configuration record for the HR service, click the **Lookup** icon, and then click **New**.

4. Fill in the fields on the form, as appropriate.
5. In the **Title row** related list, configure the title of the HR case header.
   You can map one or more fields from the HR case table, such as the HR service and the subject person’s name. Alternatively, you can provide your own text for a custom title.

6. In the **Person row** related list, configure the person row of the HR case header.
   You can map one or more fields from the HR case table, such as the opened for, subject person, assigned to, and watch list users. You can also provide custom labels for each person’s column.

7. In the **Details** related list, configure the detail row of the HR case header.
   You can map one or more fields from the HR case table, such as the short description. You can also provide custom labels for each detail’s column.

8. Click **Submit** or **Update** on the HR case header configuration form.

9. Click **Update** on the HR service form.

**Example: Custom HR case header for dental benefits HR cases in the HR ticket page**

You are part of an enterprise HR organization using the HR Service Delivery application. You want to customize the appearance of the HR case header when a user views a dental benefits HR case in the HR ticket page in the Employee Service Center.

To do this, you need to configure the HR case header form for the dental benefits HR service for the opened for/approver users and the subject person/task assignee users. For each user group, you can customize the appearance of the title, person, and detail row.

Once configured, you can see how the HR case header appears in the HR ticket page for the dental benefits HR service.
Configure the HR case creation form for an HR service

Configure the fields that appear on the HR case creation form for an HR service. This is the form that displays when an HR agent selects an HR service from the Create New Case module. You can include additional fields on the HR case creation form so that HR agents are able to collect relevant information before beginning work on the case. The case creation configuration records can be applied to one or more HR services.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > HR Services > HR Service Configuration.
2. Open the HR service.
3. In the Case creation service config field, open the case creation configuration record.

   Note: To create a new case creation configuration record for the HR service, click the Lookup icon, and then click New.

4. Fill in the fields on the form.

Case Creation Service Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the case creation service configuration record.</td>
</tr>
<tr>
<td>Task create table</td>
<td>Name of the HR case table that the record is associated with.</td>
</tr>
<tr>
<td>Left task fields</td>
<td>Fields to add on the left side of the form.</td>
</tr>
<tr>
<td>Right task fields</td>
<td>Fields to add on the right side of the form.</td>
</tr>
<tr>
<td>Bottom task fields</td>
<td>Fields to add on the bottom of the form.</td>
</tr>
</tbody>
</table>

Note: When adding the Description(rich_description) field, the TinyMCE HTML editor does not appear until after the case is created and viewable. Any HTML formatted edits can be added after the case is created.
5. Click **Submit** or **Update** on the case creation service configuration record.

6. Click **Update** on the HR service form.

**Example: Additional fields for tuition reimbursement HR case creation forms**

You are part of an enterprise HR organization using the HR Service Delivery application. You have several HR services related to tuition reimbursement, and you know this case type requires the HR agent to collect information such as the school name, course title, and course justification before case work can begin. If that information is collected prior to case creation, you can save your organization time by avoiding the back-and-forth the HR agent and employee must engage in to capture the relevant information.

To do this, you need to configure the HR case creation form for tuition reimbursement HR services to include additional fields that ask for the school or program name, course title, course justification, course start date, and course end date. So you create a case creation service configuration record and associate it with the HR Total Rewards Case [sn_hr_core_case_total_rewards] table. For the left, right, and bottom task fields, you add the additional fields you want to appear on the form.

![Case Creation Service Configuration](image)

Once the configuration is complete, HR agents that select the tuition reimbursement request service from the **Create New Case** module will see the additional fields that you added. This enables the HR agent to collect the relevant information before beginning work on the case.
Configure the HR case form for an HR service

Configure the fields that appear on the HR case form for an HR service. This is the form that displays after an HR case is created. Configuration of the HR case form is a two-part process. First, you add or remove the additional fields on the HR service form. Second, you configure the HR case form for the HR Center of Excellence (COE) that the HR service is categorized under.

Before you begin
Role required: sn_hr_core.admin

Procedure

1. Add or remove the fields in the **HR Service Additional Information** related list.

   a. Navigate to **HR Administration > HR Services > HR Service Configuration**.

   b. Open the HR service.

   c. In the **HR Service Additional Information** related list, fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service table fields</td>
<td>Click the lock icon to view the list of available fields from the HR Center of Excellence (COE) that the HR service is categorized under. Select the fields you want to appear on the HR case form for the HR service. For example, the 401(k) retirement plan enrollment inquiry HR service includes the <strong>Benefit plan</strong> field.</td>
</tr>
</tbody>
</table>
Field | Description
------|--------------------------------------------------
Subject person related lists | Click the lock icon to search for a subject person related list you want to appear on the HR case form for the HR service. For example, the 401(k) retirement plan enrollment inquiry HR service includes the Retirement Benefits for Subject Person related list.

d. Click Update.

2. Configure the HR case form for the HR Center of Excellence (COE) that the HR service is categorized under.

a. Navigate to HR Case Management > All HR Cases, and open an HR case that is part of the same COE as the HR service.

b. In the HR case form header, click the menu icon and navigate to Configure > Form Layout.

c. Move the fields that you added to the HR service form to the Selected column.

d. Click Save.

**HR case form configuration examples**

Examples on how to configure the HR case form for an HR service.

**Example: Additional fields for 401(k) HR case forms**

You are part of an enterprise HR organization using the HR Service Delivery application. You have several HR services related to 401(k) retirement benefits, and you want to add several additional fields to the HR case form, specifically the benefit plan and the list of retirement benefits for the subject person. This way, HR agents can have access to that information when working on that case type. Configuration of the HR case form for an HR service is a two-part process:

First, you need to add the fields and/or related lists you want to appear on the HR case form for that HR service in the HR Service Additional Information related list.

Second, you need to configure the HR case form for the COE that the HR service is categorized under. For the 401(k) retirement plan enrollment inquiry HR service, that COE
is HR Total Rewards. Open any HR case for the HR Total Rewards COE. In the HR case form header, click the hamburger icon and navigate to Configure > Form Layout. Make sure the additional fields are included under the Selected column.

Once the configuration is complete, HR agents that are working on a 401(k) case will see the additional fields you added to the HR case form. This enables the HR agent to use the additional information as they work on the HR case.
Example: Requesting an e-signature for an HR document template

You are configuring an HR service to request electronic signatures for HR document templates using HR e-signature. Unlike managed documents or knowledge articles, the HR document template that the signatory will sign is selected on the HR case form. Therefore, you need to add the PDF Template field to the HR case form for your HR service. This way, HR agents can select the HR document template that they want the employee to sign when creating that case type.

First, on the HR service form, under the HR Service Additional Information related list, add the PDF Template field.

Second, create an HR case or open an existing case that is part of the COE that your HR service is categorized under. On the HR case form header, click the menu icon and navigate to Configure > Form Layout. Make sure that the PDF Template field is included under the Selected column.
Now, when an HR agent requests an electronic signature for an HR document template, the **PDF Template** field will appear on the HR case form for that HR service. This enables the HR agent to select an HR document template, preview it, and generate it so that the employee can then electronically sign the document.

### Configure an HR case template

Create or modify an HR case template for an HR service to automatically populate fields on the HR case form when a request for that service is made.

**Before you begin**

Role required: sn_hr_core.admin
Procedure

1. Navigate to **HR Administration > HR Services > HR Service Configuration**.

2. Open the HR service.

3. Open the HR template for that service.

   **Note:** To create a new HR case template for the HR service, click the **Lookup** icon, and then click **New**.

4. Fill in the fields on the form, as appropriate.

   **Note:** This is the new UI form view. To switch to the classic UI, click **Switch to Classic UI** in the form header.

### HR Case Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR case template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR case template for use.</td>
</tr>
<tr>
<td>COE</td>
<td>HR case table (COE) that the HR case is categorized under when a request for that HR service is made.</td>
</tr>
</tbody>
</table>

   **Note:** Make sure that the COE for the HR case template matches that of the associated HR service.

<table>
<thead>
<tr>
<th>Owning group</th>
<th>Group that is responsible for the HR case template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Short description that appears on the HR case form when a request for that HR service is made.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority assigned to the HR case when a request for that HR service is made.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>Assignment of the HR case when a request for that HR service is made.</td>
</tr>
</tbody>
</table>

- **Named user:** In the **Assigned to** field, select a user.
- **Skills/Assignment group:** In the **Skills** or **Assignment Group** field, select a skill or group.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use global descriptions for translations</td>
<td>Option to enable the use of global descriptions for translations. If selected, you can provide the short description and description for the HR case template in one or more languages. See Translations for HR cases and tasks for more information.</td>
</tr>
<tr>
<td>Add field</td>
<td>Fields to automatically populate on the HR case form when a request for that HR service is made. Select one or more fields from the Add field list and provide the desired values. For example, you can add the State field to set a default case state or add the PDF Template field to select a document for cases that require a document acknowledgement or signature.</td>
</tr>
</tbody>
</table>

**Note:** Select the Document Template option to associate a document template (of Document Templates [com.snc.document_templates] plugin) with an HR service.

5. Click Submit or Update on the HR template form.
6. Click Update on the HR service form.

**Configure a record producer for an HR service**

If you have an existing HR service that you want to make available for employee self-service, configure a record producer so that the service appears as an HR catalog item in the HR service catalog. (Do not create a new HR catalog item. Creating an HR catalog item automatically creates a corresponding HR service, and you can avoid creating duplicate services.)

**Before you begin**

Role required: sn_hr_core.admin

**Tip:** For best results, do not configure multiple record producers to invoke a single HR service.

**Procedure**

1. Navigate to **HR Administration > HR Services > HR Service Configuration**.
2. Open the HR service.
3. Open the record producer for that service.

**Note:** To create a new record producer for the HR service, click the Lookup icon, and then click New.
4. Fill in the fields on the form, as appropriate.

**Record Producer form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record producer.</td>
</tr>
<tr>
<td>Table name</td>
<td>HR case table that the record producer is associated with.</td>
</tr>
<tr>
<td>Note:</td>
<td>Make sure that the HR case table for the record producer matches that of the associated HR service.</td>
</tr>
<tr>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Service Portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the record producer for use.</td>
</tr>
<tr>
<td>Preview link</td>
<td>Link to preview how the HR catalog item appears to users in the HR service catalog.</td>
</tr>
</tbody>
</table>

5. In the **What it will contain**, **Accessibility**, and **Generated Record Data** related lists, fill in the fields as appropriate. Since you are configuring the record producer from the HR service form, make sure to:

a. In the **What it will contain** related list, provide the following script:

   ```java
   new sn_hr_core.hr_ServicesUtil(current, gs).createCaseFromProducer(producer, cat_item.sys_id);
   ```

b. In the **Accessibility** related list, set the **Catalogs** field to **Human Resources Catalog**.

6. In the **Variables** related list, configure the variables for the HR catalog item as appropriate.

Variables collect information from the user, and are used to ask questions and map answers to fields. You can add as many variables as you need to the HR catalog item. Commonly used variables types include:
To learn more about the different types of variables and how to configure them, see Types of service catalog variables.

7. In the **Available For** and **Not Available For** related lists, configure the user criteria to apply to the HR catalog item as appropriate. User criteria controls which employees can access and request the HR catalog item in the HR service catalog. To learn more about user criteria and how they are used to control access to HR catalog items, see Set security for items and categories.

⚠️ **Note:** User criteria applied to the HR catalog item is employee-facing only, and has no relation to the HR criteria that is used to control what HR services an HR agent can request for an employee from the Create New Case module. See Configure an HR service for more information.

8. Click **Submit** or **Update** on the record producer form.

9. Click **Update** on the HR service form.

**HR service catalog management**

Empower employees to request HR services through the HR service catalog. The HR service catalog provides employees a catalog of HR services that they can request directly from HR, such as to add beneficiaries to a benefits plan, request a travel visa, or inquire about a discrepancy in their paycheck. Employees can access the HR service catalog from a self-service portal such as the Employee Service Center. You can manage the setup and categorization of the HR service catalog, as well as configure the individual HR catalog items that populate it.

**HR service catalog categorization**

The HR service catalog is a collection of HR catalog items that employees can request directly from HR. The HR catalog items are organized into categories, which define the organizational structure for the catalog. For example, the items can be categorized by benefits, employee data management, employee relations, general, HR systems, payroll, talent management, and visas.

⚠️ **Note:** The categorization of HR catalog items are employee-facing only, and have no relation to the categorization of HR services under the HR Centers of Excellence (COEs) data model.
You can manage the creation or modification of categories in the HR service catalog, as well as assign or remove HR catalog items from a category or assign or remove categories from an HR catalog item. To manage the categorization of HR catalog items in the HR service catalog, see HR service catalog categorization.

HR catalog item configuration

HR catalog items are the HR services that your organization makes available for employees to request directly from the HR service catalog. (Not all HR services need to be accessible to employees; some services are only initiated internally by HR agents. This means that all HR catalog items have a corresponding HR service, but not all HR services have a corresponding HR catalog item.) To configure the HR catalog items, see HR catalog item configuration.

Once an HR catalog item is published to the HR service catalog, it is available for employees to request. When an employee submits an HR catalog item request, an HR case is created.

Related information

Service Catalog

HR service catalog categorization

HR catalog items in the HR service catalog are organized into categories. The categories define the organizational structure for the catalog so that employees can more easily browse and request the HR services they need. You can manage the creation or modification of categories in the HR service catalog, as well as assign or remove HR catalog items from a category or assign or remove categories from an HR catalog item.

Note: The categorization of HR catalog items are employee-facing only, and have no relation to the categorization of HR services under the HR Centers of Excellence (COEs) data model.

Create an HR catalog category

Create a new category in the HR service catalog.

Before you begin

Role required: sn_hr_core.admin

Procedure

1. Navigate to HR Administration > HR Services > Manage HR Catalog.
2. Click New Category.
3. Provide the category name and description.
4. Click Submit.

**Edit an HR catalog category**

Edit an existing category in the HR service catalog.

**Before you begin**
Role required: sn_hr_core.admin

**Procedure**
1. Navigate to HR Administration > HR Services > Manage HR Catalog.
2. Hover over the category you want to edit and click the edit icon.
3. Modify the category name, active state, or description as needed.
4. Click Submit.

**Assign or remove HR catalog items from a category**

Assign or remove one or more HR catalog items from a category in the HR service catalog.

**Before you begin**
Role required: sn_hr_core.admin
Procedure

1. Navigate to HR Administration > HR Services > Manage HR Catalog.

2. Select the category you want to assign or remove HR catalog items, and click Assign / Remove Catalog Items.

3. Select the HR catalog items to assign and deselect the items to remove.

4. Click Save.

Assign or remove categories for an HR catalog item
Assign or remove categories for an HR catalog item in the HR service catalog.

Before you begin
Role required: sn_hr_core.admin

Procedure

1. Navigate to HR Administration > HR Services > Manage HR Catalog.

2. Select All Catalog Items.
3. Locate the HR catalog item you want to assign or remove categories, and open the Categories list.

4. Select the categories to assign and deselect the categories to remove.

5. Click Save.

**HR catalog item configuration**

HR catalog items are the HR services that your organization makes available for employees to request directly from the HR service catalog. You can configure an HR catalog item (also known as a record producer) to define the required fields and how the item appears in the catalog to employees. You can configure an HR case template to automatically populate fields on the HR case form when a request for that item is made. And you can link to relevant knowledge articles or managed documents for employees to reference.

**Note:** If you have an existing HR service that you want to make available for employee self-service, do not create an HR catalog item. (Creating a new HR catalog item automatically creates a corresponding HR service.) Instead, see Configure a record producer for an HR service to add the existing service as an HR catalog item in the HR service catalog.

**Create an HR catalog item**

Create an HR catalog item so that employees can request the HR service directly from the HR service catalog through a self-service portal such as the Employee Service Center.
When you create a new HR catalog item, a corresponding HR service, record producer (synonymous to HR catalog item), and HR case template are automatically created.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > HR Services > Manage HR Catalog.
2. Select a category.
3. Click New Catalog Item.
   
   Note: If you have an existing HR service that you want to make available for employee self-service, do not create an HR catalog item. (Creating a new HR catalog item automatically creates a corresponding HR service.) Instead, see Configure a record producer for an HR service to add the existing service as an HR catalog item in the HR service catalog.

4. Fill in the fields on the form.

New Catalog Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR catalog item.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description of the HR catalog item.</td>
</tr>
<tr>
<td>Case type</td>
<td>Name of the HR Center of Excellence (COE) that the corresponding HR service and record producer are categorized under.</td>
</tr>
<tr>
<td></td>
<td>Note: The COEs are organized around functional disciplines and are extensions of the HR Case [sn_hr_core_case] table. To learn more, see HR service categorization.</td>
</tr>
<tr>
<td>Topic Category</td>
<td>Name of the HR topic category that the corresponding HR service and record producer are categorized under.</td>
</tr>
<tr>
<td></td>
<td>Note: The HR topic category is the first-level of categorization for HR services. To learn more, see HR service categorization.</td>
</tr>
<tr>
<td>Topic Detail</td>
<td>Name of the HR topic detail that the corresponding HR service and record producer are categorized under.</td>
</tr>
<tr>
<td></td>
<td>Note: The HR topic detail is the second-level of categorization for HR services. To learn more, see HR service categorization.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Default assignment group of the HR catalog item.</td>
</tr>
<tr>
<td>Priority</td>
<td>Default priority of the HR catalog item.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Note: If you click Publish, the HR catalog item will be available for employees to request in the HR service catalog.
What to do next
The creation of an HR catalog item automatically creates a corresponding HR service, record producer (synonymous to HR catalog item), and HR case template. Configure the record producer and HR case template before you publish the HR catalog item to the HR service catalog.

Edit the record producer for an HR catalog item
Edit the record producer for an HR catalog item to define the required fields and how the item appears in the HR service catalog to employees.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to **HR Administration > HR Services > Manage HR Catalog**.
2. Hover over the HR catalog item and click **Edit catalog item**.
3. Fill in the fields on the form, as appropriate.

**Record Producer form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record producer.</td>
</tr>
<tr>
<td>Table name</td>
<td>HR case table that the record producer is associated with.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Make sure that the HR case table for the record producer matches that of the associated HR service.</td>
</tr>
<tr>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Service Portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the record producer for use.</td>
</tr>
<tr>
<td>Preview link</td>
<td>Link to preview how the HR catalog item appears to users in the HR service catalog.</td>
</tr>
</tbody>
</table>
4. In the **What it will contain**, **Accessibility**, and **Generated Record Data** related lists, fill in the fields as appropriate. You can provide a short description and description, configure a script, add images, define a template, and more.

5. In the **Variables** related list, configure the variables for the HR catalog item as appropriate. Variables collect information from the user, and are used to ask questions and map answers to fields. You can add as many variables as you need to the HR catalog item. Commonly used variables types include:

   • Checkbox
   • Multiple Choice
   • Reference
   • Select Box
   • Single Line Text

   To learn more about the different types of variables and how to configure them, see [Types of service catalog variables](#).

6. In the **Available For** and **Not Available For** related lists, configure the user criteria to apply to the HR catalog item as appropriate. User criteria controls which employees can access and request the HR catalog item in the HR service catalog. To learn more about user criteria and how they are used to control access to HR catalog items, see [Set security for items and categories](#).

   **Note:** User criteria applied to the HR catalog item is employee-facing only, and has no relation to the HR criteria that is used to control what HR services an HR agent can request for an employee from the [Create New Case](#) module. See [Configure an HR service](#) for more information.

7. Click **Update**.

**Edit the HR case template for an HR catalog item**

Edit the HR case template for an HR catalog item to automatically populate fields on an HR case form when a request for that item is made.

**Before you begin**

Role required: sn_hr_core.admin

**Procedure**

1. Navigate to [HR Administration > HR Services > Manage HR Catalog](#).
2. Hover over the HR catalog item and click **Edit Case Template**.
3. Fill in the fields on the form, as appropriate.

   **Note:** This is the new UI form view. To switch to the classic UI, click **Switch to Classic UI** in the form header.

### HR Case Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR case template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR case template for use.</td>
</tr>
<tr>
<td>COE</td>
<td>HR case table (COE) that the HR case is categorized under when a request for that HR service is made.</td>
</tr>
</tbody>
</table>

   **Note:** Make sure that the COE for the HR case template matches that of the associated HR service.

<table>
<thead>
<tr>
<th>Owning group</th>
<th>Group that is responsible for the HR case template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Short description that appears on the HR case form when a request for that HR service is made.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority assigned to the HR case when a request for that HR service is made.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>Assignment of the HR case when a request for that HR service is made.</td>
</tr>
</tbody>
</table>

   - **Named user:** In the **Assigned to** field, select a user.
   - **Skills/Assignment group:** In the **Skills** or **Assignment Group** field, select a skill or group.

<table>
<thead>
<tr>
<th>Use global descriptions for translations</th>
<th>Option to enable the use of global descriptions for translations. If selected, you can provide the short description and description for the HR case template in one or more languages. See Translations for HR cases and tasks for more information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add field</td>
<td>Fields to automatically populate on the HR case form when a request for that HR service is made. Select one or more.</td>
</tr>
</tbody>
</table>
Field Description
more fields from the Add field list and provide the desired values. For example, you can add the State field to set a default case state or add the PDF Template field to select a document for cases that require a document acknowledgement or signature.


4. Click Update.

Link knowledge articles or managed documents to an HR catalog item

Link knowledge articles or managed documents to an HR catalog item so that employees can refer to the articles or documents when requesting the service through the HR service catalog. For example, an HR catalog item for a beneficiaries inquiry can include links to knowledge articles on who can be named as a beneficiary, the difference between a primary and contingent beneficiary, and so on.

Before you begin

For the link to display on the HR catalog item, make sure the item has a variable that is:

- Type set to Macro with Label
- In the Type Specifications related list, with Widget set to HRI Catalog to KB Article Display

Role required: sn_hr_core.admin

Procedure

1. Navigate to HR Administration > HR Services > Manage HR Catalog.

2. Hover over the HR catalog item that you want to add the knowledge article or managed document to, and click Manage KB articles.

3. Click New or open a record to add or edit a link.

4. Fill in the fields on the form.
### Catalog Item to KB Link form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR catalog item to knowledge article or managed document link.</td>
</tr>
<tr>
<td>Catalog Item</td>
<td>This field is automatically set to the HR catalog item.</td>
</tr>
<tr>
<td>Knowledge Article</td>
<td>Name of the knowledge article.</td>
</tr>
<tr>
<td>Managed Document</td>
<td>Name of the managed document.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the link for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for the link. Lowered numbered links are displayed before higher numbered links.</td>
</tr>
</tbody>
</table>

5. **Click Submit or Update.**
   The knowledge article will display under the **Related Knowledge Documents** section when employees open the HR catalog item in the HR catalog.

### HR fulfillment instructions

HR fulfillment instructions provide focused and targeted information on how an agent can complete an HR case faster and more efficiently for HR Service DeliveryAgent Workspace and legacy HR Case Management.

You can configure fulfillment instructions to appear for an HR case by group, HR service, table, conditions, or a combination of multiple requirements. For example, you can configure a different set of fulfillment instructions to appear for HR cases that are based on the employee’s location.

Using the condition builder, you can dynamically change what fulfillment instructions appear for an HR case when it is transferred from one HR service to another. For example:

- An HR case is created as a General Inquiry with specific fulfillment instructions.
- Later, this HR case is transferred to a Leave of Absence request. New fulfillment instructions appear for the transferred case.

**Checklist**

To add a checklist to an HR case, use HR services. See **HR service configuration**.

---

### Configure HR fulfillment instructions

Use HR fulfillment instructions to provide focused and targeted instructions for an HR case.

**Before you begin**

Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > HR Services > HR Fulfillment Instructions**.
2. Click **New** or open an existing fulfillment instruction.
3. On the form, fill in the fields.
**HR fulfillment instructions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Label of the fulfillment instructions.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table that contains the fulfillment instructions for an HR case.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions under which the fulfillment instructions are made available for an HR case. The conditions determine which fulfillment instructions appear for an HR case. For example, you can set conditions that an HR case has different fulfillment instructions by location. See Condition builder.</td>
</tr>
<tr>
<td>Active</td>
<td>Fulfillment instructions that are active and available for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the fulfillment instructions appear for an HR case in relation to other fulfillment instructions.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Text that provides instructions on how to complete the HR case. Use the tool suite to format the instructions.</td>
</tr>
<tr>
<td>Knowledge articles</td>
<td>Knowledge articles that you want to attach to the fulfillment instructions. HR agents use knowledge articles as reference when fulfilling an HR case. Note: Knowledge articles are visible only to HR agents and not to employees.</td>
</tr>
</tbody>
</table>

**Note:** Previously, Fulfillment Instructions and Checklists were configured from HR services. Checklists are still configured from HR services.

4. Click **Submit** or **Update**.

**HR templates**

HR templates allow you to automatically populate fields on an HR case or task form. You can configure HR templates for HR services, HR catalog items, HR service activities, and lifecycle event activities.

<table>
<thead>
<tr>
<th>For</th>
<th>Configure</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR service</td>
<td>Configure an HR case template to automatically populate fields on the HR case form when a request for that service is made.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Configure an HR catalog item
Edit the HR case template for an HR catalog item to automatically populate fields on the HR case form when a request for that item is made.

### Configure an HR service activity
Configure an HR task template to automatically populate fields on the HR task form when the HR service activity is triggered.

### Configure a lifecycle event activity
Configure an HR task template to automatically populate fields on the HR task form when the lifecycle event activity is triggered.

## Related information

### Form templates
Configure an HR task template
Create or modify an HR task template to automatically populate fields on the HR task form when that task is generated. You can configure an HR task template for an HR service or lifecycle event activity.

### Before you begin
Role required: sn_hr_core.admin

### Procedure

1. Choose one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| HR service activity | a. Navigate to HR Administration > HR Services > HR Service Configuration, and open the HR service.  
  *Note:* Make sure Fulfillment type is set to Service Activity.  
  b. In the Service Activities list at the bottom of the HR service form, open the service activity.  
  *Note:* Make sure Activity type is set to Task.  
  c. In the Child task template field, click the Lookup icon. |
| (Enterprise Onboarding and Transitions only) Lifecycle event activity | a. Navigate to Lifecycle Events > Administration > Activities, and open the lifecycle event activity.  
  *Note:* Make sure Activity type is set to Employee or Fulfiller. For fulfiller types, make sure Fulfiller activity is set to HR Task.  
  b. In the HR task template field, click the Lookup icon. |

2. Click New or open a record.

3. Fill in the fields on the form, as appropriate.
# HR Task Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the HR task template.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to activate the HR task template for use.</td>
</tr>
<tr>
<td><strong>Owning group</strong></td>
<td>Group that is responsible for the HR task template.</td>
</tr>
<tr>
<td><strong>Short Description</strong></td>
<td>Short description that appears on the HR task form when the task is generated.</td>
</tr>
<tr>
<td><strong>Optional</strong></td>
<td>Option to make the HR task optional.</td>
</tr>
</tbody>
</table>

## HR task type

Type of the HR task. Select one of the following:

- **HR Service**
  - An HR service fulfills the HR task. In the **HR Service** field, select an HR service.

- **Submit Catalog Item**
  - A catalog item fulfills the HR task. In the **Catalog Item** field, select a catalog item.

- **Submit Order Guide**
  - An order guide fulfills the HR task. In the **Order Guide** field, select an order guide.

- **Collect employee input**
  - Collects information from employees. In the **Employee form** field, select the employee form that the user will fill out or verify.

  **Note:** Employee forms are questionnaires built using the survey designer to collect information from employees. See **Collect employee input** for more information.

- **Checklist**
  - In the **Checklist Items** field, provide the checklist items.

- **E-signature**
  - User electronically signs a document. In the **E-signature template** field, select the e-signature template to use.

  **Note:**
  - E-signature is a scoped application that enables users to sign managed documents, knowledge articles, or HR document templates with their typed or drawn signature, credentials, or as an acknowledgment. See **HR e-signature** for more information.
  - If HR document template is the document type of the e-signature template, you must select the HR document template that the signatory will sign on the HR case form. See **Select an HR document template for an e-signature task** for more information.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential</td>
<td>Prompts the user to login with their credentials to acknowledge conditions and terms related to their signature. To add text that explains what their login credentials mean, add the <strong>Acknowledgment text</strong> field. To add a document, add the <strong>Acknowledgment document</strong> field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This option is only available for existing customers that have not yet migrated to e-signature. See <a href="#">Migrate existing HR task templates and open HR tasks to e-signature</a> for more information.</td>
</tr>
<tr>
<td>E-Signature</td>
<td>Prompts the user to sign a document. To add text that explains what their signature means, add the <strong>Acknowledgment text</strong> field. To add a document, add the <strong>Acknowledgment document</strong> field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This option is only available for existing customers that have not yet migrated to e-signature. See <a href="#">Migrate existing HR task templates and open HR tasks to e-signature</a> for more information.</td>
</tr>
<tr>
<td>Mark When Complete</td>
<td>Notify the user a Completed button appears on the HR Service Portal. Use the <strong>Short description</strong> field to provide details about this task.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Mark When Complete changes the state of the task to Closed Complete.</td>
</tr>
<tr>
<td>Sign Document</td>
<td>Requests the subject person to edit or sign a document. An example is sending an education agreement to be signed for tuition reimbursement.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This option is only available for existing customers that have not yet migrated to e-signature. See <a href="#">Migrate existing HR task templates and open HR tasks to e-signature</a> for more information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The document must be included in the HR case template in the <strong>PDF Template</strong> field. See <a href="#">Configure an HR case template</a> for more information.</td>
</tr>
<tr>
<td></td>
<td>To add text that explains what their signature means, add the <strong>Acknowledgment document</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acknowledgment text</td>
<td><strong>Acknowledgment text</strong> field. To add a document, add the <strong>Acknowledgment document</strong> field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Acknowledgment text entered on the HR document template overrides text written here. See <a href="https://servicenow.com">Configure an HR document template (HTML)</a> or <a href="https://servicenow.com">Configure an HR PDF document template</a>.</td>
</tr>
<tr>
<td>Take Survey</td>
<td>In the <strong>Survey</strong> field, select a survey that the user is assigned to take.</td>
</tr>
<tr>
<td>Upload Documents</td>
<td>Requests the person assigned to the task to upload documents. Examples are receipts, course registration, or transcripts for tuition reimbursement. Use the <strong>Short description</strong> field to provide instructions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The task must be in <strong>Ready</strong> or <strong>Work in Progress</strong>.</td>
</tr>
<tr>
<td>URL</td>
<td>In the <strong>URL</strong> field, provide a URL that the user acknowledges when accessed.</td>
</tr>
<tr>
<td>View Video</td>
<td>In the <strong>URL</strong> field, provide a video URL that the user is requested to view.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>Assignment of the HR task when the task is generated. You can assign the HR task to the employee or fulfiller. Select one of the following:</td>
</tr>
<tr>
<td>Employee</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Parent case subject person: Assign the task to the subject person of the parent case.</td>
</tr>
<tr>
<td></td>
<td>• Parent case opened for: Assign the task to the opened for person on the parent case.</td>
</tr>
<tr>
<td></td>
<td>• User from case: Assign the task to a user from the case.</td>
</tr>
<tr>
<td></td>
<td>• Named user: Assign the task to a specific user.</td>
</tr>
<tr>
<td>Fulfiller</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Parent case assigned to: Assign the task to the person the parent case is assigned to.</td>
</tr>
<tr>
<td></td>
<td>• Named user: Assign the task to a specific user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User from case</td>
<td>Assign the task to a user from the case.</td>
</tr>
<tr>
<td>Skills/Assignment group</td>
<td>Select the skills and group you want assigned to the task.</td>
</tr>
<tr>
<td>Due date</td>
<td>Due date of the HR task. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Based on task assignment date</td>
</tr>
<tr>
<td></td>
<td>• Based on parent case table</td>
</tr>
<tr>
<td>State</td>
<td>State of the HR task when the task is generated. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Draft</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Incomplete</td>
</tr>
<tr>
<td></td>
<td>• Cancelled</td>
</tr>
<tr>
<td></td>
<td>• Skipped</td>
</tr>
<tr>
<td>Task support team</td>
<td>Task support team for the HR task. Select one of the following:</td>
</tr>
<tr>
<td>None</td>
<td>No task support team.</td>
</tr>
<tr>
<td>Users and groups</td>
<td>Select users from the parent case or HR groups as the task support team for the HR task.</td>
</tr>
<tr>
<td>Queue</td>
<td>Select a chat queue as the task support team for the HR task.</td>
</tr>
<tr>
<td>Use global descriptions for translations</td>
<td>Option to enable the use of global descriptions for translations. If selected, you can provide the short description and description for the HR task template in one or more languages. See Translations for HR cases and tasks for more information.</td>
</tr>
<tr>
<td>Add field</td>
<td>Fields to automatically populate on the HR task form when the task is generated. Select one or more fields from the Add field list and provide the desired values.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**HR flows and triggers**

HR flows created in Flow Designer use natural language to automate approvals, tasks, notifications, and record operations without coding.

Three new flows are available to automate the triggering of Lifecycle Events. The triggers are based on changes in the HR Profile [sn_hr_core_profile] or Job [sn_hr_core_job] tables. These flows reduce or eliminate the need to write business rules to trigger Lifecycle Events.

⚠️ **Note:** Customize these flows to use in other Lifecycle Events other than on boarding events.

The following flows are installed with the Human Resources: Core application. These HR flows are deactivated by default.
**New Hire on Boarding Case Trigger HR Profile**

The trigger is based on the employee's start date in the HR Profile Table [sn_hr_core_profile]. If the employment start date is at or after today, the flow creates an HR Onboarding case. This flow runs every time an HR profile is created or updated.

For more information about the HR Profile, see Employee Profile table and HR Profile.

**New Hire on Boarding Case Trigger Job**

The trigger is based on the employee's start date in the Job Table [sn_hr_core_job]. If the employment start date is at or after today, the flow creates an HR Onboarding case. This flow runs every time an HR profile is created or updated.

For more information about the Job Table and related profile records, see Capturing multiple job records for a user.

**Case Trigger Custom Condition**

Table: HR Profile [sn_hr_core_profile]

This flow can be used as a template to create a customized trigger. The trigger is based on a custom date check for the employee start date. The default trigger is initiated two days prior to the employee start date. For more information about flows and triggers, see Flows.

These flows create an HR case adding an entry in the HR Lifecycle Events Case [sn_hr_le_case] table. If multiple flows are active at the same time, there is a high probability of creating duplicate records and cases.

> **Note:** Only one of these flows should be active at any given time for a particular lifecycle event.

**Activate an HR flow**

HR flows help automate task and case creation.

**Before you begin**

Role required: admin

**About this task**

There are three HR flows installed with the Human Resources: Core application.

- New Hire on Boarding Case Trigger HR Profile
- New Hire on Boarding Case Trigger Job
- Case Trigger Custom Condition

Activation is immediate. These flows create an HR case adding an entry in the HR Lifecycle Events Case [sn_hr_le_case] table. If multiple flows are active at the same time, there is a high probability of creating duplicate records and cases.

> **Note:** Only one of these flows should be active at any given time for a particular lifecycle event.

**Procedure**

2. Open the flow you want to activate.
3. Click the Activate button.
Configure how HR cases are created

Modify how search results for an employee appear and configure the default HR case creation form.

Before you begin
Role required: sn_hr_core.admin

About this task
HR case creation has multiple steps:
• Search for an employee or related case.
• Create an initial HR case.
• Complete the details of the case.

Using the Case Creation Configuration form you can control the information returned from a search and the required fields when creating an initial HR case.

Note: Zing text search is used to search on indexed fields in the User [sys_user], HR Profile [sn_hr_core_profile], and HR Case [sn_hr_core_case] tables. Refer to Zing text indexing and search engine.

Procedure
1. Navigate to HR Administration > Case Creation Configuration.
2. On the form, modify the fields as appropriate.

Case Creation Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page size</td>
<td>Determines the maximum number of search results for each page break when using the Search for Employee form. Note: The default is 10. If there are more than 10 search results, the form divides the results into chunks of 10. It does not limit the search results to 10.</td>
</tr>
<tr>
<td>Minimum input length</td>
<td>Specifies the minimum number of characters that must be entered in the Search for Employee form to return results.</td>
</tr>
</tbody>
</table>

3. Modify the default search behavior when searching by employee.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display table</td>
<td>Displays employee information. Search uses the HR Profile [sn_hr_core_profile] table when displaying information for an employee. This field is read-only.</td>
</tr>
<tr>
<td>Limit users on search</td>
<td>Option for adding filter conditions to your search. For example, you could add a filter for only active users.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Additional display fields</td>
<td>Option for adding fields to help narrow a user search. The base system configuration provides fields for the user department, user employee number, and user location when applicable.</td>
</tr>
<tr>
<td>Links</td>
<td>A URL link configured in Link Generator. See Link generator for HR Service Delivery.</td>
</tr>
<tr>
<td>User field</td>
<td>Read-only field that determines which users are displayed for a search the information displayed about them.</td>
</tr>
<tr>
<td>Force partial search</td>
<td>Option for providing the ability to enter a partial name to return search results.</td>
</tr>
<tr>
<td></td>
<td>For example, when searching for Abraham Lincoln, users could enter Abra to return search results.</td>
</tr>
<tr>
<td></td>
<td>Selecting this option also helps provide consistent search results when creating an HR case.</td>
</tr>
<tr>
<td></td>
<td>❗ Note: If this option is not selected, users must enter the whole word to match.</td>
</tr>
<tr>
<td>Allow skipping verification</td>
<td>Option for providing the ability to enter or skip the employee name or case number when creating an HR case. For more information, see Create an HR case.</td>
</tr>
<tr>
<td></td>
<td>For example, if your company receives a complaint from an external individual or an anonymous user, providing this option enables an HR agent to create a case without having to enter an employee name or case number.</td>
</tr>
</tbody>
</table>

4. In the **Case Search** related list, modify the default search parameters when searching by case number.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case table</td>
<td>Read-only field that contains the HR Case [sn_hr_core_case] table used for case search purposes.</td>
</tr>
<tr>
<td>Limit cases on search</td>
<td>Option for adding filter conditions to your search. For example, you could add a filter to search only for active cases.</td>
</tr>
<tr>
<td>User fields</td>
<td>Option for adding user fields to appear during a case search. The base system configuration provide fields for subject person, opened for, opened by, and watch list values when applicable.</td>
</tr>
</tbody>
</table>
5. In the **Employee Information** related list, modify the fields that appear in the **Employee Information** section of the **Case Creation** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left fields</td>
<td>Determines the fields that appear on the left side of the <strong>Employee Information</strong> section of the <strong>Case Creation</strong> form. The base system configuration displays fields for the user name and user employee number.</td>
</tr>
<tr>
<td>Right fields</td>
<td>Determines the fields that appear on the right side of the <strong>Employee Information</strong> section of the <strong>Case Creation</strong> form. The base system configuration displays fields for the user email and user ZIP or postal code.</td>
</tr>
</tbody>
</table>

6. In the **Case Creation** related list, determine the default fields that appear in the **Case Creation** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task create table</td>
<td>Read-only field that contains the HR Case [sn_hr_core_case] table used to show default case creation fields.</td>
</tr>
<tr>
<td>Limit services</td>
<td>Option for creating service conditions that determine the HR services that are available for specific employees. For example, you may not want to offer 401(k) benefits to employees outside of the United States.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** HR services work with HR criteria to select the correct HR service for the subject person on the HR case. When a subject person is selected for an HR case, these fields determine the HR services available. When no subject person is selected, only services with no criteria are shown.

| Left task fields | Determines the fields that appear on the Case Details Section (CDS). The base system provides the COE and HR service fields, which are non-configurable.             |
| Right task fields| Determines the fields that appear on the right side of the CDS. The base system configuration displays the Opened for and Subject person fields.                     |

⚠️ **Note:** Removing the Subject person field from the form or leaving it empty limits the HR services available to employees without associated HR criteria.
7. In the **Case Creation Service Configurations** section, configure the HR case creation form for individual HR services. For more information, see *Configure the HR case creation form for an HR service*.

8. Save your modifications.
   - To save the modifications and remain on the form, click **Save**.
   - To save the modifications and exit from the form, click **Update**.

### Configure an HR badge

Use **Badges** to create or modify existing identification badges used to quickly identify the organization of the **Assigned to** person for the **Activity** on the **HR Ticket** page.

**Before you begin**

Role required: sn_hr_core.admin

**About this task**

Custom badges only appear for specific types of HR activities.

- The base system provides defaults and is configurable.
- On the **HR Ticket** page, you can filter to-dos based on badges.
- Defaults are added to HR services.
- Can be overridden on an Activity.

**Procedure**

1. Navigate to **HR Administration > Badges**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**Badge form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR badge. Provide up to three characters to represent an organization, such as HR for Human Resources or IT for Information Technology.</td>
</tr>
<tr>
<td>Badge description</td>
<td>Description of the HR badge.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Application view of HR catalog**

The **Application View** provides an aerial view of your HR catalog. The **Application View** allows you to view your catalog with all categories and items and ensure that it is set up correctly.

**Before you begin**

Role required: sn_hr_core.admin

---

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to **HR Administration > Application View**.
   On the left side of the page, a list of application view categories and the number of records in each display. The main section of page displays the all application view probes and the number of records in each.

2. To view a list of records for application probe, click the down-arrow next to records. Clicking a record takes you to the record.

3. Click New Probe to report on a table or setup aspect in the HR Service Delivery system.

**HR criteria**

HR criteria defines the audience for HR content, services, or cases. You can make information available to or create an HR case for specific groups, individuals, or to all employees using HR criteria.

HR criteria uses the standard platform condition builder to support complex conditions for controlling the Employee Service Center content that employees see when logged in.

HR criteria contains a script include that can be called from an advanced User criteria.

**Note:** Complex conditional statements for scripted User criteria applied to a knowledge base with large amounts of documents can cause performance issues. Standard (non-scripted) User criteria is recommended for securing knowledge documents.

See [User criteria for Service Portal](#).

HR criteria define conditions that are evaluated against HR tables. Once HR criteria is defined, you can filter what is available to those users.

HR criteria helps group people using a condition builder on any table. User criteria is used across the ServiceNow platform to filter catalog items, Service Portal widgets, and knowledge articles. User criteria filters users based on role, department, group, location, or company. User criteria can be created when HR criteria is created. HR criteria:

- Filters content on the **HR Service Portal**.
- Applies only to **Subject person**. HR criteria filters **HR services** based on the **Subject person** during case creation or transfer.
- Filters **Lifecycle Event Activities** in the **Human Resources Scoped App: Lifecycle Events [com.sn_hr_lifecycle_events]** plugin.
- Selects document template for HR cases.
- Selects users when creating bulk HR cases.

For Lifecycle Events, activities have associated HR criteria that determines when to trigger an activity for the subject person selected on the Lifecycle event case. This step helps to personalize the workflow for the subject person.

**Note:** For HR Catalog Items (record producers), ensure **Use "User Criteria" to define access to catalog items and categories** is set to **Yes** under **Service Catalog > Catalog Administration > Properties**. Verify that this field is checked **Yes**.

You can use user criteria for Knowledge and Service catalog access.

- Add a reference column to the User Criteria [user_criteria] table when columns are required for the criteria query.
If you use HR criteria for Knowledge and Service catalog access, ensure:

- Referenced columns are correctly indexed.
- Conditions that can cause performance issues (starts with) are not used.
- Knowledge document searches and use cases are performance tested with instances that are similar to what is used in production.

Configure an HR criteria record
Create or modify HR criteria to define an audience for HR content, services, or cases.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > HR Criteria.
2. Click New or open a record.
3. Fill in the fields on the form.

HR Criteria form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR criteria record.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the HR criteria.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR criteria for use.</td>
</tr>
<tr>
<td>Related user criteria</td>
<td>You can create user criteria from HR criteria. User criteria is used across the ServiceNow platform to filter catalog items, HR Service Portal widgets, and knowledge articles.</td>
</tr>
</tbody>
</table>

Note: This field remains blank until you create User criteria.

The Create User Criteria link appears after you click Save.

4. Click Save. The Create User Criteria related link appears.
   You can create User criteria based on HR criteria. User criteria is used across the ServiceNow platform to filter catalog items, HR Service Portal widgets, and knowledge articles.

5. Select the Create User Criteria related link. In the Conditions section, add conditions to specify the fields and values that create the filter and based on the table selected.

   a. Click New or open a record.
   
   b. Fill in the fields on the form.

   Note: It is required to add a filter condition: User, is (dynamic), Me. This filter prevents placing the HR link for every user in your company. [User] [is] [dynamic me]
## HR Condition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR condition.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that the HR condition is associated with.</td>
</tr>
<tr>
<td></td>
<td>The table HR criteria conditions are defined from.</td>
</tr>
<tr>
<td></td>
<td>For example, select the [HR Profile (sn_hr_core_profile)] table to select a field and define a condition.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR condition for use.</td>
</tr>
<tr>
<td>User column</td>
<td>Together with the Table field, filters users when evaluating a condition for a user.</td>
</tr>
<tr>
<td></td>
<td>To create User criteria, select User.</td>
</tr>
</tbody>
</table>

**Note:** Depending on the table selected, this field can be required to match conditions. When the User [sys_user] table is selected, this field is mandatory otherwise a false positive can occur since the lookup is not associated to an expected user.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The field from the table selected and a value that defines the condition.</td>
</tr>
<tr>
<td></td>
<td>For example, you can select the following conditions from the [HR Profile (sn_hr_core_profile)] table:</td>
</tr>
<tr>
<td></td>
<td>• Home country\</td>
</tr>
<tr>
<td></td>
<td>• is</td>
</tr>
<tr>
<td></td>
<td>• United States of America</td>
</tr>
<tr>
<td></td>
<td>This condition selects all employees who have a home country of the United States.</td>
</tr>
<tr>
<td></td>
<td>You can have multiple conditions using:</td>
</tr>
<tr>
<td></td>
<td>• And: Multiple conditions are required.</td>
</tr>
<tr>
<td></td>
<td>• Or: Only one of the conditions are required.</td>
</tr>
</tbody>
</table>

**Note:** For more information on filters, see [Filters](#).

### Example

For example, to create a condition to show the link for new hires and contractors, select:

- **Table:** Client Role Rule [sn_hr_core_client_role_rule]
- **Condition:** [Role] [is] [sn_hr_core.hrsm_new_hire] AND [Role] [is] [sn_hr_core.hrsm_contractor]

After creating a condition, a clickable link appears with the number of matching records. Click the link to see if the correct users are being selected based on the condition.

- **c. Click Submit or Update.**

### HR document templates

HR Document Templates are used to create and modify reuseable HR documents.
Use HR document templates for documents that can be customized with dates, names, and signatures like:

- Employee verification letters
- Non-disclosure agreements
- Offer letters
- Educational reimbursement agreements

You can personalize HR document templates by mapping fields or using variables from the available tables to place data in fields. You can also capture multiple e-signatures in a document that automatically generates once all signatures are captured.

There are two types of HR **Document Templates**, both create PDF files, but are created and maintained differently:

1. Document templates (HTML)
2. PDF document templates

**Acknowledgement text**

Within your document templates, you can capture the meaning of a signature. You can add acknowledgement text to your document templates that prompts the user to check a box when signing or providing credentials to a document.

**Document templates (HTML)**

Document templates are created within the HR application and use variables to pre-fill information from tables into the document. You create how the document looks by defining the header, footer, images, placement of footer, and the text within the template. The base system provides default document templates that you can use to model your documents:

- Employee Verification Letter in Canada
- Employee Verification Letter in USA
- Offer Letter Template
- Education Agreement

Before you begin generating documents, configure the templates with your company logo and text. Obtain the following items and information to create or configure the predefined HR document templates:

- A page of your company letterhead.
- Copies of your current company employment verification letter and offer letter templates, if available.
- The logo image to use in your header. The header image can be a maximum of 50 px high. If your letterhead includes a logo and text, ensure that the logo image includes the text, because you can only configure the image (not text) in the header.
- The logo image to use in your footer, if applicable. The logo image can be a maximum of 15 pixels high. You can configure both an image and text in the footer.

**Note:** For best results, ensure that the image is optimized and a Scalable Vector Graphics (SVG) file.

**PDF document templates**

PDF document templates originate from Managed Documents and use field mapping to pre-fill information from tables into the document. Before you customize a document:
• The document must be a fillable PDF. See the Adobe home page and search for Convert existing forms to fillable PDFs to learn how to create fillable PDF documents https://www.adobe.com/.

• The document must be uploaded and published.

The base system provides the default PDF document template as an example:

• Non-Disclosure Agreement (Sample)

Generating documents
Both the Document template and PDF document template generate PDF documents that can be reviewed or printed and can require multiple signatures.

A common use case for generating a document from an HR case is when an employee requests an employment verification letter. For information on generating a PDF from a document template (HTML), see Generate a PDF from a document template (HTML).

For information on generating a PDF document from an HR case, see HR document generation.

Related information
Managed Document features

Configure an HR document template (HTML)
Create or modify HR document templates with your unique company logo and audience criteria. Document templates are created within the HR application and use variables to pre-fill information from tables to create reusable HR documents.

Before you begin
Role required: sn_hr_core.manager and sn_hr_le.admin

About this task
HR document templates customize HR documents to match the service and subject person.

The base system provides examples of employment verification letters, educational reimbursement agreements, and an offer letter.

Body text is defined and formatted with TinyMCE and can merge or include user and table variables during document generation. The PDF generator does not support some of the HTML elements.

Note: The example offer letter only appears when the Human Resources Scoped App: Lifecycle Events is activated.

Procedure
1. Navigate to HR Administration > Document Templates.
2. Click New or on an existing document template to edit it.
   When you select New, the HR Document Templates list appears.
   Note: To know the differences between the types of document template, see HR document templates.
4. Fill in the fields on the form.
# HR Document Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR document template.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table associated with the type of template. The table determines the available variables that can be used.</td>
</tr>
<tr>
<td>Document type</td>
<td>Select the document type the template applies to. Click <strong>New</strong> from <strong>HR Document Type</strong> to create a document type.</td>
</tr>
<tr>
<td></td>
<td>A document type is required when you want a list of documents to appear in the HR case form. <strong>HR criteria</strong> works with this field to narrow the list of documents you want available for an HR case.</td>
</tr>
<tr>
<td></td>
<td>See Using document types with HR document templates.</td>
</tr>
<tr>
<td></td>
<td>Note: When creating a document type, the <strong>Value</strong> auto-populates from the name you enter (all lower case and underscores).</td>
</tr>
<tr>
<td>Header image</td>
<td>Select to add an image in the header. You can add your company logo using this feature.</td>
</tr>
<tr>
<td></td>
<td>Note: Supported file types are: JPEG, JPEG2000, GIF, PNG, BMP, WMF, TIFF, and JBIG2.</td>
</tr>
<tr>
<td>Header image position</td>
<td>Select where you want the header image to appear.</td>
</tr>
<tr>
<td>HR criteria</td>
<td>Select the audience criteria for this document. For example, you can create a letter intended for only Canadian employees. The HR criteria narrows the number of users for the template.</td>
</tr>
<tr>
<td>Body</td>
<td>Enter and format the text to comprise the body of the template. To insert variables, place your cursor in the desired location and click the variable. Available variables are listed under <strong>Fields</strong>. Use the formatting tools in the <strong>Body</strong> to apply formatting options, such as bold, italic, underline, font styling. The body is a place holder for HTML text and tokenized variables. When the PDF is generated, the variables are resolved before sending it to the PDF Generator [com.snc.pdf_generator] plugin.</td>
</tr>
<tr>
<td></td>
<td>Note: Currently, there is no support for style tags to align text left or right. Space indentation must be used. Jelly and CSS Styling are not supported.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Select variables    | A list of variables that can be used in the body of the template. Variables pull information from the selected table to customize the template. Offsets are supported for date variables. Offsets extend or subtract days, weeks, or months from a date used in a template. Valid date offset variables are:  
  • + (plus)  
  • - (minus)  
  • d (days)  
  • w (weeks)  
  • m (months)  
Examples:  
  • Offer letter (five days after stated date): Your offer is valid until \${Date +5d}.  
  • Benefits for terminated employee (two weeks from termination date): Your benefits end effective \${subject_person.hr_profile.employment_end_date +2w}. |
| Note:              | Only variables that you have access to appear. |
| Footer image        | Select to add an image in the footer.  
The original height of your image should not exceed 170 pixels. Scale your image by 30% or ensure the image height is less than 50 pixels in order for the image to be clear and visible.  
Note: Supported file types are: JPEG, JPEG2000, GIF, PNG, BMP, WMF, TIFF, and JBIG2. |
| Footer image position | Select where you want the footer image to appear. |
| Footer text         | Enter text. For example, you can add proprietary and confidential statements. |
| Page size           | Select the page size from the choice list.  
Note: A4 is 8.3 x 11.7 inches or 210 x 297 millimeters. |

5. Place the cursor in the desired location in the body of the template and click the **Insert Date** or **Insert Signature** buttons to insert these variables. You can use these buttons multiple times to add different types of dates or signatures based on the variables you choose.

6. Click **Save** to save your document and remain on the **HR Document Template** form or click **Submit** to save and return to the **HR Document Templates** list.

7. Review the look of the generated document by impersonating an employee and submitting the associated catalog item. Impersonate the user assigned to work on the case to generate the letter within the HR case. Continue editing and testing the document template until you are satisfied with the generated PDF. TinyMCE provides rich text creation that the PDF generator does not support. Non-supported HTML elements are:
Related information

Configure an HR criteria record

Generate a PDF from a document template (HTML)
You can generate a PDF document from an HR case using a UI action, such as an Employment Verification letter.

Before you begin
Role required: admin

• Create a UI action on the table referenced in the Document Template.
• Code the UI action to call the document generation methods to generate a PDF.

Create a UI action
You can use the wrapper method to generate a PDF by creating an instance of our helper class and calling the generate method.

```javascript
new GeneralHRForm (tableName, tableId, targetTableName, targetTableId).generate();
```

Create an instance of the GeneralFormAPI class

```javascript
new GeneralFormAPI (fileName, targetTable, targetTableSysId);
```

Set the values saved in the Document Template class

```javascript
//header: Header image for the PDF.
//footer: Footer image for the PDF.
//headerLocation: Location of the header. Right, left, or center aligned.
```
Configure an HR PDF document template

Create or modify custom HR PDF document templates with your unique criteria. PDF document templates originate from Managed Documents and are either a fillable PDF with mapped fields or a standard PDF with an inline signature.

Before you begin
Role required: sn_hr_core.manager

About this task
With PDF document templates, you can take an existing document and reuse it with custom information from an HR case or any available table. For example, you can take a fillable PDF document from Managed Documents, and map fields to customize the document each time it is used.

The document must be a fillable PDF to map the fields to a table. See the Adobe home page and search for fillable PDF to learn how to create fillable PDF documents https://www.adobe.com/.

Note: Fillable PDFs presented to an employee does not save any data populated by the employee (except for signatures). Fillable PDFs are only used for mapping fields to a table.

Documents are uploaded and accessed from the Managed Documents application in the Documents [dms_document] table. Documents are required to be published as a document revision before it can be accessed.

The base system provides the Non-Disclosure Agreement document template as an example of a PDF document template.

Note: See Managed Document features

Procedure
1. Navigate to HR Administration > Document Templates.
2. Click New or on an existing PDF document template to edit it.
   When you select New, the HR Document Templates list appears.
   Note: To know the differences between the types of document template, see HR document templates.
4. Fill in the fields on the form.

HR PDF Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR PDF document template.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table associated with the type of template. The table determines the available fields that can be mapped.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Only tables that you have access to appear.</td>
<td></td>
</tr>
<tr>
<td>Document type</td>
<td>Select the document type the template applies to. Click <strong>New</strong> from <strong>HR Document Type</strong> to create a document type. A document type is required when you want a list of documents to appear in the HR case form. HR criteria works with this field to narrow the list of documents you want available for an HR case. See Using document types with HR document templates. Note: When creating a document type, the <strong>Value</strong> auto-populates from the name you enter (all lower case and underscores).</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR PDF document template for use.</td>
</tr>
<tr>
<td>Document revision</td>
<td>Select the document and revision the PDF document template is based on. Documents listed originate from Managed Documents. Note: User group and document owner determine what revisions are available to view or select.</td>
</tr>
<tr>
<td>HR criteria</td>
<td>Select the audience criteria for this document. For example, you can create a letter intended for only Canadian employees. The HR criteria narrows the number of users for the template.</td>
</tr>
<tr>
<td>PDF Preview</td>
<td>Appears after saving or selecting an existing PDF template. Click to view a preview of the template. Note: Using style tags for text alignment is not supported. Use spaces to align your text.</td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Save** to save your PDF document template.

The **Mark Signatures** button appears at the top menu bar. Click to map where signatures are required in the template. A preview of the PDF document template appears to define a signature block.

The **Parse PDF** related link appears. When there are fields on the template that can be mapped, the **Parse PDF** link appears under **Related Links**.

6. Click **Parse PDF** if it appears under **Related Links** to view the fields that can be mapped. The AcroForm PDF determines which fields can be mapped and the table selected determines what information you can have populated in those fields.

### Related Links

| **Parse PDF** | **PDF Template Mappings** | **Search** | **Document field type ▼** | **Search** |
The **PDF Template Mappings** list appears. Click the fields of the PDF to map them to fields on the table selected. You can customize your document with pre-filled information from the table. See [Add or modify a PDF template mapping](#). After creating or editing the field mappings, the PDF Preview button appears.

7. Click **Update**.

### Add or modify a PDF template mapping

With PDF template mapping you can pre-fill information from specified tables into a reuseable HR document configured in a PDF document template.

### Before you begin

Role required: sn_hr.core_admin

### About this task

PDF template mappings are derived from the table associated with the PDF document template. PDF template mapping is accessed from a PDF document template that contains fields that can be mapped. Refer to [Configure an HR PDF document template](#).

The PDF Template Mappings section appears when a new fillable PDF document has been uploaded from Managed Documents and the **Parse PDF** link is selected.

### Procedure

1. Select a field to edit. The PDF Template Mapping form appears.
2. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Enter a name that represents the field mapping and stored as part of the document mapping in the database.</td>
</tr>
<tr>
<td>HR PDF template</td>
<td>The name of the PDF template associated with the field mapping.</td>
</tr>
<tr>
<td>Document field</td>
<td>The field that appears in the document template. Typically the same name as the <strong>Field name</strong> but can be different. For example, on an I-20 document template, a <strong>Document field</strong> is <code>#form[0].First Name</code>. But, the <strong>Field name</strong> can be <code>First Name</code>.</td>
</tr>
<tr>
<td>Document field type</td>
<td>Select the type of field you are mapping. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• Signature</td>
</tr>
<tr>
<td></td>
<td>• Text Field</td>
</tr>
<tr>
<td></td>
<td>• Checkbox</td>
</tr>
<tr>
<td></td>
<td>• Combo</td>
</tr>
<tr>
<td></td>
<td>• Radio</td>
</tr>
<tr>
<td>Preview value</td>
<td>Enter a field mapping value for preview.</td>
</tr>
</tbody>
</table>

**Note:** Use this field to test a field value without going through the process of mapping fields or creating a case to test your mappings. What you enter here appears in your document.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced script</td>
<td>Use to configure script fields for complex mapping of a field. For example, to map a Social Security Number from the HR Profile [sn_hr_core_profile] table to a document and format it correctly, a script is used.</td>
</tr>
<tr>
<td>Mapping table</td>
<td>The table that the mapped fields come from.</td>
</tr>
<tr>
<td>Mapping field</td>
<td>The field that maps information into your document.</td>
</tr>
<tr>
<td>Use signing date</td>
<td>Check when the signing date should be captured with the signature when a user signs the document.</td>
</tr>
<tr>
<td>Page number</td>
<td>The page number of the PDF document where the mapped field should insert information. For example, enter 2 when the mapped field appears on page 2 of the PDF document.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to activate the field mapping.</td>
</tr>
<tr>
<td>Select date format</td>
<td>Appears when <strong>Use signing date</strong> is checked. Specify the date format to be used on a document.</td>
</tr>
<tr>
<td></td>
<td>• User date format: Uses date format specified on the User [sys_user] table for the logged in user.</td>
</tr>
<tr>
<td></td>
<td>• Specific date format: When selected, the Specific date format appears. Click the <strong>Suggestion</strong> icon and you can select from a list of formats.</td>
</tr>
</tbody>
</table>

3. Click **Save** to save your field mapping and remain on the HR PDF Template form, or click **Submit** to save your field mapping and return to the HR Document Templates list.

**Using document types with HR document templates**

Document types limit the choices for allowable documents based on HR service. For organizations with large amounts of documents, document types help categorize and make finding the correct document easier.

For example, you can have multiple employee verification letters depending on if the employee is full-time, part time, or contingent. HR criteria on an HR service determines which letter to send.

When an HR case is created for an HR service, it checks:

- HR case template for the HR service
- The document type for the HR case template
- HR criteria

Verifying this information allows the case to narrow the search for the correct letter or auto-populate the exact letter required.

**Setting up document types**

To use this feature:

- Add a document type to your document templates.
- Add the document type to an HR case template.
From the HR template classic UI, you can add a specific PDF template, but cannot specify a document type. Adding a specific PDF template automates populating the HR case form, but eliminates flexibility when you have multiple documents.

- Add the HR case template to an HR service.
- Add HR criteria to the HR service.
  - Using HR criteria provides flexibility in choosing or auto-populating a document for an HR service.

**How it works**

When an HR case is created from an HR service:

- The HR case template looks for a document type to determine what [Document template](#) or [PDF document template](#) to a case. It tries to automatically place a document template on an HR case by:
  - Checking if there are documents associated with the document type.
  - If there is only one document associated with the document type and the HR criteria is empty, place that document on the [HR case form](#).
  - If there is HR criteria on the document template, verify the [Subject person](#) on the [HR case form](#) matches the criteria. If yes, place the document template on the [HR case form](#).
  - If there are multiple document templates for the document type, check for [HR criteria](#). When a single document matches, populate the document template on the [HR case form](#). When multiple documents match, do not populate, but list documents on the [HR case form choice list](#).
  - When [HR criteria](#) is not available on any document templates, list documents on the [HR case form choice list](#).

**Note:** There is HR criteria on the HR service and HR document templates. On HR services, HR criteria narrows the allowable services for an employee. For example, you can provide 401 (k) services to US employees, but not to non-US employees. On HR document templates, HR criteria narrows what employees the document is for. For example, when you have employee verification letters for US employees and non-US employees, use HR criteria to determine the correct document.

**Adding a signature acknowledgment for HR documents**

You can add an acknowledgement check box with customized text on HR documents associated with an HR task.
Signature acknowledgements are a way to capture the meaning of the signature, such as review, approval, responsibility, or authorship.

For the e-signatures task type, you can show a check box and clarifying text about the meaning of the signature.

For the sign document task type, you can show a check box and clarifying text about the meaning of the signature.
For acknowledgments, you can show a check box and clarifying text about using login credentials. There are multiple ways to add the check box and text for the different task types.

**Create signature acknowledgment from an HR task**

Using this method creates the acknowledgment check box and text one time for the specific HR task. It does not save it for future HR tasks of the same type.

- From an existing HR case, add an HR task.
- From the HR task, select an HR Task Type of:
  - E-Signature
- Select an E-signature template.

⚠️ **Note:** See Adding an HR task to an HR case.

**Create or modify an HR template (task)**

Using this method creates an acknowledgment check box and text every time the HR service is requested for an HR case.

- Table: Select an HR task table.
- HR task type: Select one:
  - E-Signature
  - Sign Document

⚠️ **Note:** The parent HR case requires a PDF document.

- Credential
- Acknowledgment text: (Add this field) Enter text to appear next to check box.

⚠️ **Note:** See Configure an HR task template.

**Create or modify an HR document template**

Using this method creates an acknowledgment check box and text every time the document is associated with an HR case.

- From the HR document template, add text in the Acknowledgment text field.
Automate signing requests using templates

For more information on using DocuSign templates and automating signing requests using templates, see How to automate signing requests using templates.

Signature pad for HR

Signature pad is a feature that any application can use. It captures an electronic signature that can be associated with a document or a task.

The HR Service Delivery application uses signature pad with onboarding documents like offer letters, background check approval, company policy acknowledgements, and more.


Ensure Yes is checked in the com.snc.signaturepad.retrieveSignature field on HR properties. See HR properties.

Note: E-signature

Use

You can send your employees documents that require a user verification such as a digital signature or by typing their name.

When signature pad is associated with a document or a task, it captures the drawn signature as an image and stores it in the Signature Image [signature_image] table.

Note: Typing a signature provides acknowledgement, but does not capture an image that is stored.

For HR document templates, use the Insert Signature button to insert a variable that prompts a user to sign the document. For HR PDF document templates, use the Employee Signature field name and PDF Template Mappings to prompt a user to sign the document. Refer to HR document templates.

Note: Check the generate document UI action condition to ensure this feature works correctly.

Examples

The HR Delivery System uses PDF documents for various scenarios. An example of the code used to call a UI page or dialog box for the signature

```javascript
var gDialog = new GlideModal('accept_signature');
gDialog.setTitle(new GwtMessage().getMsg('Please sign document'));
gDialog.setWidth('500');
gDialog.setPreference('sysparm_document_id', get('task_sys_id').value);
gDialog.setPreference('sysparm_table_name', get('task_table').value);
gDialog.setPreference('sysparm_draw_only', 'false');
gDialog.render();
```
An example of the code used in a document after a signature has been accepted and a final PDF document is created:

```
<signature_image>
```

Activate the Signature Pad plugin

To activate signature pad in your application, activate the Signature Pad plugin [com.snc.signaturepad]. The Signature Image [signature_image] table installs with this plugin.

**Before you begin**

Role required: admin

**About this task**

To purchase a subscription, contact your ServiceNow account manager. After purchasing the subscription, activate the plugin within the production instance.

You can evaluate the feature on a sub-production instance without charge by requesting it from the HI Customer Service System.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
HR surveys

HR Surveys let users rate their satisfaction with HR case resolution, and provide management with feedback to improve HR processes.

One predefined HR survey is provided: HR Request Satisfaction Survey. HR administrators and HR managers can edit HR surveys and the associated trigger conditions.

The HR Request Satisfaction Survey is triggered randomly for 50% of closed HR cases. Users receive an email with the survey link after they accept the resolution or when the HR case is closed incomplete.

HR managers and administrators can review responses by question and see a scorecard. Comments entered by users provide feedback that can be used to improve the performance of HR case management. The following survey options can be configured.

- The look and feel of the questionnaire, for example, by adding the company logo.
- Conditional questions that appear when users answer other questions in a certain way.
- The trigger condition, for example, to send it for every case or to a lower percentage of users.

With trigger conditions, the system generates a survey instance each time a specific action occurs on a given table, such as when an HR request closes. You can choose to send a survey every time the condition is met. Or, you can set a probability for the system to send a survey at random when the condition is met. Trigger conditions are ideal for sending surveys to measure satisfaction with a recent experience, such as closing an HR request.

For more detailed information about working with surveys, trigger conditions, and survey questions, see Get started with Survey Management.

Add or modify an HR survey

You can modify the predefined HR satisfaction surveys to suit the needs of the organization, and create HR surveys.

**Before you begin**

Role required: sn_hr_core.admin or sn_hr_core.manager

**About this task**

For example, to create an HR survey to gauge the employee satisfaction of HR processes or services.

The following steps describe how to work with survey questions in the Survey Definition form. You can also click Survey Designer to open the survey and its questions in the survey designer. When you save the survey, the survey definition is automatically added. See Survey designer.

**Procedure**

1. Navigate to HR Administration > Surveys > All HR Surveys.
2. Click New or open an existing survey.
3. Complete the form. Some fields were eliminated for HR. See Modify a survey definition.
4. Click Submit.
Add or modify HR survey categories and questions

When an HR survey definition is created, a survey category is automatically added. You can create questions that are associated with this category or define another category for questions.

Before you begin
Role required: admin, hr_admin, or hr_manager

About this task
For example, the HR Request Satisfaction Survey has one category, with four questions about satisfaction with the HR request process. You can define another category to ask about satisfaction with the HR agent who handled the case, or you can add more questions to the existing category.

The following steps describe how to work with survey questions in the Survey Definition form. You can also click Survey Designer to open the survey and its questions in the survey designer.

Procedure
1. Navigate to HR Administration > Surveys > HR Surveys, and open the survey to add questions.

2. In the Metrics Categories related list, complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or edit questions in an existing category</td>
<td>Click the category name.</td>
</tr>
<tr>
<td>Add a category and questions</td>
<td>Click New. Enter the category name and description, right-click the form header, and click Save.</td>
</tr>
</tbody>
</table>

The Survey Category form that appears includes the Assessment Metrics related list, which contains any questions that are already defined.

3. To edit a question, complete the following steps.

   a. Click the question text and edit the fields on the form.

   b. Click Update.

   c. If required by the question type, add definitions in the Assessment Metric Definitions related list.

   Example
   For example, Likert and numeric scale data types require the scale metric definitions.

4. To add a question, complete the following steps.

   a. Click New and complete the form.

   b. Right-click the header and click Save.

   Additional fields appear based on the selected data type. For example, if you select Choice, you must enter the scale definition.
c. If applicable, add definitions in the Assessment Metric Definitions related list.

Example
For example, the Choice data type requires that you enter the choices.

5. Click Update.
The Survey Definition reopens.

Publish a new HR survey
Publish a new survey so users can complete it.

Before you begin
Role required: sn_hr_core.admin, or sn_hr_core.manager

About this task
After a survey is published, you can edit it and it remains published. The State field on the Survey Definition form indicates whether the survey is published.

Procedure
1. Navigate to HR Administration > Surveys > All HR Surveys, and open the survey to publish.
2. Click Publish.

Results
If there are assigned users, the system automatically generates a survey instance. You can click Send Invitations to send a notification to the assigned users with a link. Assigned users can also navigate to Self-Service > My Assessments and Surveys to take the survey.

Note: A survey cannot be returned to the Draft state after it has been published. You can, however, deactivate a survey by clearing the Active check box.

What to do next
If you want employees to receive a link to a survey, such as the HR Request Satisfaction Survey, create a notification. To get the URL of the published survey so it can be included in the notification, click the View Survey URL related link. You can copy the URL and paste it as a hyperlink in the notification.

Add a trigger condition for an HR survey
When you create an HR survey, you can add a trigger condition to specify when the survey is sent and to whom.

Before you begin
Role required: sn_hr_core.admin, or sn_hr_core.manager

About this task
Trigger conditions are ideal for sending surveys to measure satisfaction with a recent experience, such as closing an HR request. Some descriptions use the Incident table as an example. Substitute HR case information to create an HR survey trigger condition.

See Survey administration.
See Survey trigger conditions.
To create a trigger condition:
A user with the HR Admin role must also be designated as an HR delegated developer.

Via the Settings icon, this user must change the Developer application from Global to Human Resources: Core.

Procedure
1. Navigate to HR Administration > Surveys > Trigger Conditions.
2. Click New.
3. Complete the form.

Trigger condition fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Survey to send.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to run the trigger condition on. You can select only tables in the</td>
</tr>
<tr>
<td></td>
<td>current application scope. For example, to send a survey whenever an</td>
</tr>
<tr>
<td></td>
<td>incident closes, select the Incident [incident] table.</td>
</tr>
<tr>
<td>User field</td>
<td>Field that stores the users you want to send the survey. You can select any</td>
</tr>
<tr>
<td></td>
<td>field, on the selected table or on a referenced table, that references the</td>
</tr>
<tr>
<td></td>
<td>User [sys_user] table. Use the tree picker to select a field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To avoid requiring users to log in to take a survey with a trigger</td>
</tr>
<tr>
<td></td>
<td>condition, set the survey to Public.</td>
</tr>
<tr>
<td>Repeat interval</td>
<td>Minimum period that must pass before the trigger condition can resend the</td>
</tr>
<tr>
<td></td>
<td>survey to the same user. For example, assume the repeat interval is set to</td>
</tr>
<tr>
<td></td>
<td>30 days. Even if the same user qualifies for multiple surveys from this</td>
</tr>
<tr>
<td></td>
<td>trigger condition, the system can send only one survey every 30 days.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Ensure that the Schedule period of the selected survey definition</td>
</tr>
<tr>
<td></td>
<td>is set to No Limit. If the schedule period is set to a different value,</td>
</tr>
<tr>
<td></td>
<td>it prevents the trigger condition from sending surveys as expected.</td>
</tr>
<tr>
<td>Application</td>
<td>[Admin only] Application is set to Core.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this trigger condition is active (selected).</td>
</tr>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the selected table.</td>
</tr>
<tr>
<td></td>
<td>When the condition is met, the business rule sends the survey to the correct</td>
</tr>
<tr>
<td></td>
<td>user. No configuration is necessary for this business rule.</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>Check box that determines whether to send the survey to the appropriate</td>
</tr>
<tr>
<td></td>
<td>user every time the condition is met (cleared) or only a percentage of the</td>
</tr>
<tr>
<td></td>
<td>time (selected).</td>
</tr>
<tr>
<td>Probability (%)</td>
<td>Approximate probability that the survey is sent each time the condition is</td>
</tr>
<tr>
<td></td>
<td>met. For example, if the probability is set to 50, the system sends the</td>
</tr>
<tr>
<td></td>
<td>survey approximately 50% of the time the conditions are met. There are no</td>
</tr>
<tr>
<td></td>
<td>repeat interval restrictions is assumed. This field is visible and required</td>
</tr>
<tr>
<td></td>
<td>only when Trigger randomly is selected.</td>
</tr>
<tr>
<td>Related Field 1-4</td>
<td>Field that contains a value you want to store for reporting purposes. You can</td>
</tr>
<tr>
<td></td>
<td>pick any reference field on the selected table. When the trigger condition</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>generates a survey instance, the system stores the value from the triggering record. Specify up to four fields. For example, select the Incident table, <strong>Assigned to</strong> and <strong>Problem</strong> as related fields. The system stores the assigned user and problem associated with the incident as Related record 1 and Related record 2 in the survey instance record. To view the fields, configure the form for any survey instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition. <strong>Note:</strong> You cannot use a related field for the ticket number because you cannot select the Number column. You can, however, use the trigger_id column of the table.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder that defines the criteria that must be true to send the survey. For example, to send a survey whenever an incident closes, create the condition <code>[State] is [Closed]</code>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Managed lists**

You can use the **Managed Lists** module to view and manage administrative areas like departments, locations, positions, and details about HR services.

To access managed lists, go to **HR Administration > Managed Lists**.

**Add or modify departments**

You can use departments to categorize users. Departments are assigned to an employee user profile, and are synchronized to the HR profile.

**Before you begin**

Role required: admin

**About this task**

The base system provides various departments. You can create or edit existing departments and add users.

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Departments**.
2. Click a department name to view or edit details for that department.
3. Click **New** to create a department.
4. Use the ID field to enter a company-specific department number.
5. Click **Save** to stay on the **Departments** form. The **Expense Allocations** and **Users** tabs appear.
6. Click **Expense Allocations** to view all expense allocations associated with the department.
7. Click **New** to create a new expense allocation associated with the department.
8. Click **Users** to view all users associated with the department.
9. Click **New** to create a new user associated with the department.

10. Click **Save** to stay on the **Departments** form or **Update** to return to the **Departments** list.

**Add or modify locations**

If your company has multiple offices, location records store the address and contact details for each site, and are assigned in the employee HR profile and user records. The location of an HR agent can be used for automatic assignment of HR cases.

**Before you begin**

Role required: admin

**About this task**

The Administrator can view, edit, or create locations. You can use the location of an HR agent for automatic assignment of HR cases.

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Locations**.
2. Click a location name to view or edit details for that location.
3. Click **New** to create a location.
4. Click **Save** to stay on the **Locations** form. The Locations section displays at the bottom of the form. Use to create a parent/child relationship between locations.
5. Click **New** to create a child location.
6. Click **Save** to stay on the **Locations** form or **Submit** to return to the **Locations** list.

**Add or modify employee positions**

As part of the Human Resources setup process, you define positions to describe employee job functions within the organization. Positions are associated with employees in the HR profile.

**Before you begin**

Role required: admin

**About this task**

Create position records for your organization. Other organization information, such as location and department information, is already set up in the ServiceNow system and used in User [sys_user] records.

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Positions**.
2. Click **New** to create a position, or click an entry to open an existing position.
   - If you view an existing position, the **HR Profiles** related list displays HR profiles of users assigned to the position at the bottom.
3. Enter the **Position** title and select the **Department**.
4. Check **Active**.
5. Click **Save** to stay on the **Positions** form or **Submit** or **Update** to return to the **Positions** list.
Add or modify employee relationships

As part of the Human Resources setup process, you define relationships to describe how contacts and beneficiaries are related to employees.

Before you begin
Role required: admin

About this task
Create relationship records for your organization.

Procedure
1. Navigate to HR Administration > Managed Lists > Relationships.
2. Click New or edit an existing relationship.
3. Enter the relationship identifier or name. For example, Spouse.
4. Enter a value for the relationship. Used to further define the relationship.
5. Check Dependent when the relationship is a dependent on the employee for benefits or support.
6. Click Submit or Update.

Add or modify benefit types

Benefit types are benefits offered by your company and the associated table.

Before you begin
Role required: sn_hr_core.basic, or sn_hr_core.manager
You can add or modify a benefit type using the Managed Lists module.

Procedure
1. Navigate to HR Administration > Managed Lists > Benefit Types.
   The HR Benefit Types list opens.
2. Click New to create a benefit type or on an existing benefit type to edit.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

HR Benefit Type form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Benefit type.</td>
</tr>
<tr>
<td>Value</td>
<td>Issue value name, such as benefit_401k, or basic_life.</td>
</tr>
<tr>
<td>Type</td>
<td>Click and select the benefit type. Benefit types are:</td>
</tr>
<tr>
<td></td>
<td>• HR Disability Benefit</td>
</tr>
<tr>
<td></td>
<td>• HR Health Benefit</td>
</tr>
<tr>
<td></td>
<td>• HR Insurance Benefit</td>
</tr>
<tr>
<td></td>
<td>• HR Retirement Benefit</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make this benefit type active and available to use.</td>
</tr>
</tbody>
</table>
4. Click **Save**. The **HR Benefit Plans** section appears.

5. Click **New** to create a benefit plan associated with the benefit type.

6. To modify benefit type data, find the existing benefit type in the HR Benefit Types list. You can use the list search menu by typing the benefit type and pressing Enter.

7. Click the benefit type to open the form. The HR Benefit Type form opens displaying the benefit type and other populated fields.

8. Modify the form.

9. Click **Update**.

**Add or modify benefit plans**
You can add or modify a benefit plan and provider using the Benefit Plan for under Managed Lists. The plan name is a combination of the provider and plan type.

**Before you begin**
Role required: sn_hr_core.basic, or sn_hr_core.manager

**Procedure**
1. Navigate to **HR Administration > Managed Lists > Benefit Plans**. The HR Benefit Plans list opens.

2. Click **New** to create a benefit plan or on an existing plan to edit.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plan name</strong></td>
<td>The name of the benefit plan. This field is a combination the <strong>Provider</strong> name and <strong>Plan type</strong>. After you enter a Provider and Plan type, this field fills in.</td>
</tr>
<tr>
<td><strong>Provider</strong></td>
<td>Click and select the name of the benefit provider. For new providers, click the <strong>Reference field</strong> icon to enter details about the provider. This field combines with <strong>Plan type</strong> to create the <strong>Plan name</strong>.</td>
</tr>
<tr>
<td><strong>Benefit type</strong></td>
<td>The type of insurance or financial services provided.</td>
</tr>
<tr>
<td><strong>Plan type</strong></td>
<td>The name of the specific insurance or financial services plans offered by the provider. The <strong>Plan type</strong> combined with the <strong>Provider name</strong> make up the <strong>Plan name</strong>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make this benefit plan active and available to use.</td>
</tr>
<tr>
<td>Plan administrator</td>
<td>Click and select the company representative responsible for this benefit plan. The plan administrator is the person that communicates directly with the provider, understand the details of the benefit plan, and can be a point-of-contact for questions.</td>
</tr>
<tr>
<td>Plan URL</td>
<td>Click and enter the website or link to the benefit plan.</td>
</tr>
</tbody>
</table>

4. Click **Save** to stay on the **HR Benefit Plan** form or **Update** to return to the **HR Benefit Plans** list.

**Add or modify disciplinary issue types**

Disciplinary issue types are misconduct that can trigger a disciplinary action.

**Before you begin**

Role required: sn_hr_core.basic, or sn_hr_core.manager

**About this task**

Disciplinary issue types can be viewed at **HR Administration > Managed Lists > Disciplinary Issue Types**.

Default types of disciplinary issues include:
- Absenteeism
- Abusive Language or Behavior
- Improper Dress
- Misconduct
- Insubordination
- Tardiness
- Improper Use of Equipment
- Unsatisfactory Work Performance
- Failure to Follow Corporate Policy
- Other

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Disciplinary Issues Types**. The HR Disciplinary Issue Types list opens.
2. Click **New** to open a disciplinary issue type record.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>The disciplinary issue.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Order</td>
<td>Number set to indicate the order in which the issue appears in the HR Disciplinary Issue Types list.</td>
</tr>
<tr>
<td>Value</td>
<td>Issue value name, such as absenteeism, or improper_dress.</td>
</tr>
</tbody>
</table>

4. Click **Save** to stay on the **HR Disciplinary Issue Type** form or **Submit** to return to the **HR Disciplinary Issue Types** list.

5. To modify disciplinary issue type data, find the existing disciplinary issue type in the **HR Disciplinary Issue Types** list.
   You can use the list search menu by typing the disciplinary issue type and pressing Enter.

6. Click the disciplinary issue type to open the form.
   The HR Disciplinary Issue Type form opens displaying the issue and other populated fields.

7. Modify the form.

8. Click **Save** to stay on the **HR Disciplinary Issue Type** form or **Update** to return to the **HR Disciplinary Issue Types** list.

---

**Add or modify disciplinary warning types**

A disciplinary warning type is the method used to communicate or the action taken as a result of a disciplinary type.

**Before you begin**

Role required: sn_hr_core.basic, or sn_hr_core.manager

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Warning Types**.
   The **HR Disciplinary Warning Types** list opens.

2. Click **New** to create a disciplinary issue type record or on an existing record to edit.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

   **HR Disciplinary Warning Type form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>Warning type or action.</td>
</tr>
<tr>
<td>Order</td>
<td>Number set to indicate the order in which the issue appears in the <strong>HR Disciplinary Warning Types</strong> list.</td>
</tr>
<tr>
<td>Value</td>
<td>Issue value name, such as verbal or written.</td>
</tr>
</tbody>
</table>

4. Click **Save** to stay on the **HR Warning Type** form or **Submit** to return to the **HR Warning Types** list.

5. Click **Update** to return to the **HR Warning Types** list.

---

**Add or modify HR systems**

You can add or modify an HR operations system using the HR Administration module.

**Before you begin**

Role required: sn_hr_core.basic or sn_hr_core.manager
Procedure

1. Navigate to **HR Administration > Managed Lists > HR Systems**.
   The HR Operating Systems list opens.

2. Click **New** to open an HR Operations System record.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

   **HR Operations System form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR system.</td>
</tr>
<tr>
<td>Contact</td>
<td>The internal company contact for the system.</td>
</tr>
<tr>
<td>URL</td>
<td>The web address for the HR system.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make active and available to use.</td>
</tr>
<tr>
<td>Order</td>
<td>Number set to indicate the order in which the issue appears in the HR Operations Systems list.</td>
</tr>
</tbody>
</table>

4. Click **Save** to stay on the **HR Operations System** form or **Submit** to return to the **HR Operations Systems** list.

5. To modify an HR system, find the existing HR system in the HR Operations Systems list. You can use the list search menu by typing the HR system and pressing Enter.

6. Click the warning type to open the form. The HR Operations System form opens displaying the system and other populated fields.

7. Modify the form.

8. Click **Save** to stay on the **HR Operations System** form or **Update** to return to the **HR Operations Systems** list.

**Add or modify HR report frequencies**

HR operations report frequencies determines how often reports are generated.

**Before you begin**

Role required: sn_hr_core.basic or sn_hr_core.manager

**About this task**

Employees can ask about HR report frequencies or request an HR report frequency through the HR Service Portal.

By default, the report frequencies available are:

- Daily
- Weekly
- Monthly
- Quarterly
- Yearly

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Report Frequencies**.
   The **HR Operations Report Frequencies** list opens.
2. Click **New** to create an HR operations report frequency record or on an existing record to edit.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report frequency</td>
<td>How often the report generates, for example, daily, weekly, monthly.</td>
</tr>
<tr>
<td>Domain</td>
<td></td>
</tr>
</tbody>
</table>

4. Click **Save** to save the record and stay on the **HR Operations Report Frequency** form.

5. Click **Submit** and return to the **HR Operations Report Frequency** list.

### Add or modify HR report types

Report types define the category of information that appears in an HR operational report.

**Before you begin**

Role required: hr_basic, or hr_manager

**About this task**

Types of system reports include:

- Customer Satisfaction
- Compliance
- Operational
- Trend Analysis
- Other

**Procedure**

1. Navigate to **HR Administration** > **Managed Lists** > **Report Types**.
   
   The **HR Operations Report Types** list opens.

2. Click **New** to open a system report type record.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report type</td>
<td>The kind of report to generate, such as, compliance or operational.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. The system report type is listed in the **HR Operations Report Types** list.

5. To modify the system report type data, find the existing system report type in the **HR Operations Report Types** list.

   You can use the list search menu by typing the report type name and pressing Enter.

6. Click the system report type to open the form.

   The **HR Operations Report Type** form opens displaying the report type.
7. Modify the form.
8. Click Update.

**Add or modify visa categories**

You can add or modify a visa category using the HR Administrations module.

**About this task**

Currently, there are two types of visas:

- **Business** — Employee is traveling to a foreign country to conduct business. An example is Joe Employee is traveling to Japan for a week for meetings with a customer and co-workers in the Tokyo office.

- **Work** — Employee is traveling to a foreign country to work as an expatriate (expat). An example is Joe Employee is relocating to the Tokyo office to work in Japan for two years.

To create or modify a visa category:

**Procedure**

1. Navigate to **HR Administration > Managed Lists > Visa Category**. The **HR Visa Categories** list opens.
2. Click **New** or a visa category.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visa category</td>
<td>Enter or edit the name of the visa category.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**. The visa category appears in the **HR Visa Categories** list.

**HR notifications**

Notifications are reminders that are created using email templates and sent out for **Lifecycle Event Activities** and **HR Services**.

HR case writers or Lifecycle Event activity writers can set up reminder notifications on HR tasks and task templates to remind the **Assigned to** person about due dates. Reminder emails are created using email templates. See **Add or modify email content for notifications**.

HR notifications for HR services are recurring and are a one-time for Lifecycle Events.

**Process**

- Create or edit email content.
  - See **Add or modify email content for notifications**.
- Create or edit an HR task template.
  - See **Configure an HR task template**.
- Create or edit an HR Service.
  - See **Configure an HR service**.
Create or edit an HR service activity.

See Configure a service activity for an HR service. Ensure the HR task template selected has the Set reminder box checked.

Note: Notifications for HR Services are only sent to the Assigned to person for the HR task.

Add or modify email content for notifications

Use the Email Content form to create notification templates to alert the assigned to of an HR task when a due date is approaching.

Before you begin

Roles required: sn_hr_core.case_writer, sn_hr_le.activity_writer

You must have the HR Case Writer [sn_hr_core.case_writer] or Lifecycle Event Activity Writer [sn_hr_le.activity_writer] role to select an Email Content template. For Lifecycle Events, you must have the Lifecycle Event Activity Writer [sn_hr_le.activity_writer] role to create or edit an HR task template for Lifecycle Events.

When setting up notifications, an email template must be created. The base system provides an email template that can be used as a model.

Email notifications can be sent for HR tasks with due dates and can be configured:

• To be sent relative to the due date.
• To be sent at intervals until the task is completed or skipped.
• With customized content.

Procedure

1. Navigate to HR Administration > Email Content.
2. From the Email Contents list, select New or an existing email template to edit.
3. Enter or edit the fields on the Email Content form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter or edit the name of the email template.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of notification:</td>
</tr>
<tr>
<td></td>
<td>• Activity Notification</td>
</tr>
<tr>
<td></td>
<td>• HR Task Reminder</td>
</tr>
<tr>
<td>Subject</td>
<td>Enter or edit the subject line of the reminder notification. The text appears in the subject line of the email sent as a reminder notification.</td>
</tr>
<tr>
<td>Message HTML</td>
<td>Enter or edit text that is the main body of the email notification. Use the formatting tools to format the text such as bold, italic, underline, font styling, justification, bullets, insert image, and numbers.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
## Select variables

This section provides a list of variables that can be used in the email template. Variables pull information from a table so information can be repeatable and customizable depending on the type of notification selected. The variables that appear depend on the **Type** field.

- Activity Notification: HR Lifecycle Events Case [sn_hr_le_case]
- HR Task Reminder: HR Case [sn_hr_core_case]

### 4. Select **Save** to save the record and remain on the **Email Content** form. Or, select **Submit** or **Update** to return to the **Email Contents** list.

### Manage HR roles

Roles control access to features and capabilities in modules in the HR application.

The HR Service Delivery Scoped app prevents users outside of the HR organization from accessing HR data.

Scoped roles for both HR case workers and HR clients (employees, contractors, alumni, and others) grant access to HR services. Users without an HR scoped role cannot view HR cases or HR profile information.

Only the HR Administrator [sn_hr_core.admin] can assign scoped HR roles.

To configure your system, you must log in as a System Administrator [admin]. The HR Administrator [sn_hr_core.admin] role is contained in the System Administrator [admin] role. The combination of these two roles allows a user to perform all tasks associated with configuring your system.

After system configuration, ensure that only the HR Administrator [sn_hr_core.admin] role has access to sensitive information. Remove the HR Administrator role from System Administrator [admin] role to prevent the System Administrator from viewing sensitive HR information.

After granting access to a role, all the groups or users assigned to the role also have access. Roles can contain other roles, and grants access to any role that contains it.

#### Note:

IT System Administrators (admin) and HR scoped users can still impersonate ServiceNow users. When impersonating a user with a scoped HR role, an admin or any HR scoped user cannot access features granted by that role. HR cases and profile information are not accessible. Only users with the scoped HR Administrator [sn_hr_core.admin] can see case details when impersonating other scoped HR users. Also, admin cannot change the password of any user with a scoped HR role. For more information on impersonating a user, see **Impersonate a user**.

### HR Performance Analytics

To configure the Performance Analytics (PA) dashboard, assign the Performance Analytics Administrator [pa_admin] role to the HR Administrator [sn_hr_core.admin] role.

#### Note:

Only the System Administrator [admin] can assign PA roles to employees.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administrator</td>
<td>Also known as admin and IT admin. Within the global scope of the application, has access to all system features, functions, and data, regardless of security constraints.</td>
</tr>
<tr>
<td></td>
<td>• Grant users with the delegated developer role [delegated_developer].</td>
</tr>
<tr>
<td></td>
<td>• Build export sets, move content between instances (development to production), and clone instances.</td>
</tr>
<tr>
<td></td>
<td>• Run guided setup or modules to manage:</td>
</tr>
<tr>
<td></td>
<td>◦ Company-wide objects like user, departments, and locations.</td>
</tr>
<tr>
<td>HR Administrator</td>
<td>This role can:</td>
</tr>
<tr>
<td>[sn_hr_core.admin]</td>
<td>• Assign users any of the HR roles.</td>
</tr>
<tr>
<td></td>
<td>• View and access the HR Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• View, create, and edit HR cases in HR Case Management.</td>
</tr>
<tr>
<td></td>
<td>• Access and create HR tasks inside an HR case using the Add Task related link.</td>
</tr>
<tr>
<td></td>
<td>• View, create, and edit HR profiles including sensitive information like SSN and salary.</td>
</tr>
<tr>
<td></td>
<td>• Create HR profiles and generate for multiple users through custom criteria.</td>
</tr>
<tr>
<td></td>
<td>• Associate any user to HR roles, groups, and skills.</td>
</tr>
<tr>
<td></td>
<td>• View and access HR Administration.</td>
</tr>
<tr>
<td></td>
<td>• View and access HR Dashboards &amp; Reports.</td>
</tr>
<tr>
<td></td>
<td>• Run Application View to manage:</td>
</tr>
<tr>
<td></td>
<td>◦ HR objects like HR roles and profiles.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When the Human Resources Scoped App: Core (com.sn_hr_core) and Lifecycle Events (com.sn_hr_lifecycle_events) plugins are active, the Lifecycle Admin (sn_hr_le.admin) role is part of HR Admin (sn_hr_core.admin).</td>
</tr>
<tr>
<td>Delegated Developer</td>
<td>When added to the HR Administrator role, can:</td>
</tr>
<tr>
<td>[delegated_developer]</td>
<td>• Access, and manage HR objects like HR profile, cases, groups, roles, service catalog objects, and Service Portal.</td>
</tr>
<tr>
<td></td>
<td>• Modify HR application-related objects like skills, Knowledge Base, chat, notifications, surveys, reports, integrations, and SC.</td>
</tr>
<tr>
<td></td>
<td>• Modify application structures like tables, business rules, and client-side validation.</td>
</tr>
<tr>
<td>User with HR role</td>
<td>There are specific HR roles that allow users access to specific areas of the system. For example, the HR profile reviewer [sn_hr_core.profile_reader] role can read profiles, but not edit them.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User without HR role</td>
<td>Users without an HR role cannot access HR Service Delivery.</td>
</tr>
<tr>
<td>User with no role</td>
<td>Users with no role cannot see any HR information even on HR cases they created or have HR tasks assigned to them.</td>
</tr>
</tbody>
</table>

After system configuration, to ensure that only HR Administrator has access to sensitive information and prevent the System Administrator from accessing sensitive information:

- **Remove the HR Administrator** [sn_hr_core.admin] **role** from System Administrator [admin].
  - The base system requires a user with the System Administrator role to run scheduled jobs. For details on HR scheduled jobs, see **Components installed with Case and Knowledge Management**.
  - To ensure the scheduled jobs run, change the user in the **Run as** field for each scheduled job to a user that has the HR admin role.

  1 **Note:** Changing the user allows the scheduled jobs to run, but only a user with the System Admin role can view and run a scheduled job on demand.
  
  - Change the scope of the application to Human Resources: Core application. For information on changing the scope, see **Contextual development edit messages**.
  - Reveal the **Run as** field. For information on revealing hidden fields on a form, see **Configuring the form layout**.

- **Log out and log back in** to ensure that the changes take effect.

  1 **Note:** Ensure that you have completed setup before removing the HR Administrator role.

**Minimum number of scoped admins required**

System properties determine the minimum number (default is two) of scoped admins that must be active for an application. For example,

- sn_hr_ef.min_admin_count = 2
  - You have two users with the sn_hr_core.admin role.
  
  - If you try to delete one of the users, an error message appears and prevents you from deleting the user.

To list the properties, enter `sys_properties.list` in the filter navigator and search for the property to configure.

The list of system properties and what scoped admin can access:

**System Properties**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Scoped Admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_core.min_admin_count</td>
<td>HR admin [sn_hr_core.admin]</td>
</tr>
<tr>
<td>sn_hr_ef.min_admin_count</td>
<td>Employee Document Management admin [sn_hr_ef.admin]</td>
</tr>
<tr>
<td>sn_hr_integrations.min_admin_count</td>
<td>HR Integration Admin [sn_hr_integrations.admin]</td>
</tr>
<tr>
<td>sn_hr_le.min_admin_count</td>
<td>HR Lifecycle Event Admin [sn_hr_le.admin]</td>
</tr>
</tbody>
</table>
Remove HR Administrator role from IT System Administrator

After system configuration, ensure that only the HR Administrator [sn_hr_core.admin] role has access to sensitive information. Remove the HR Administrator role from System Administrator [admin] role to prevent the System Administrator from viewing sensitive HR information.

Before you begin
Role required: admin with sn_hr_core.admin
Ensure that you have at least two users with the HR Administrator role. If you assign only one person with the role and that person is deactivated, you no longer have a user that can perform the HR admin duties.

After removing the HR administrator role from System Administrator, log out and log back in to ensure that the changes take effect.

⚠️ Note: Ensure that you have completed setup before removing the HR Administrator role.

⚠️ Note: Scheduled jobs that require the Admin role do not run. But, all HR scheduled jobs should run after the Admin role is removed.

The Employee Service Center administrator [sn_hr_sp.esc_admin] role is contained in the System Administrator [admin] role.

Ensure that someone in your organization has the Employee Service Center administrator [sn_hr_sp.esc_admin] role after removing the admin role.

Procedure
1. Log in as admin.
2. From User Administration, go to Roles (left navigation menu).
3. Click admin.
4. From the Contains Roles tab, click Edit.
5. From the Contains Roles List column, highlight and move sn_hr_core.admin to the Collection column.
6. Click **Save**.
7. Log out.

**Add Delegated Developer to HR Administrator**

For an HR Administrator [sn_hr_core.admin] to perform some platform duties, the delegated developer role must be added.

**Before you begin**
Role required: admin with sn_hr_core.admin

**HR Administrator with Delegated Developer role**

The HR Administrator role with the delegated developer role can:

- Add and update script includes.
- Add and update ACLs.
- Configure forms.
- Configure related lists.
- Configure and create COEs. For more information, see HR Centers of Excellence data model.

⚠️ **Note:** The Lifecycle Event Administrator (sn_hr_le.admin) role with the Delegated Developer (delegated_developer) role can also configure and create new COEs.

To add the delegated developer role to a user:

**Procedure**

1. Log in as admin.
2. From the Filter navigator, enter `sys_store_app.list`. The **Store Application** list appears.
3. Click **Human Resources: Core**.
4. Under **Related Links**, click **Manage Developers**.
5. Ensure **Developers** is highlighted.
6. Enter the name of HR Administrator.
7. Click all items (green bar moves to the left) to grant permission.
8. Click **Save**.
9. Log out and log back in to ensure that the changes take effect.

**Manage HR Groups**

HR Groups are a set of users with common job skills.

**Before you begin**
Role required: sn_hr_core.admin, user_admin

You can have multiple levels of groups. For example, HR is a group that contains all HR employees within your company. You can have subgroups under HR such as HR Benefits, Employee Relations, and more.
Procedure
1. Navigate to **HR Administration > Manage Roles > Manage HR Groups.**
2. From the **Groups** list, click **New** or select an existing HR group. The **Group** form appears.

### HR Groups

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name that describes the group.</td>
</tr>
<tr>
<td>Manager</td>
<td>Click the <strong>Lookup using list</strong> icon and select the person responsible for this group.</td>
</tr>
<tr>
<td>Type</td>
<td>Use to define a category a group belongs to. A group can be associated with one group type (narrow scope) or multiple group types (expanded scope). This allows you to ensure qualified agents are assigned to complex cases or you have adequate coverage for less complex cases. Click the <strong>Unlock Type</strong> icon. Then click the <strong>Lookup using list</strong> icon and add <strong>human_resources</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>For more information on group types, see <strong>Manage HR group types</strong>.</td>
</tr>
<tr>
<td>Group email</td>
<td>Enter the email address of the group. This email acts as a group notification that sends an email to every member of the group.</td>
</tr>
<tr>
<td>Parent</td>
<td>Click the <strong>Lookup using list</strong> icon and select the HR group that is above the current group. For example, the HR group is the parent of HR Benefits, HR Employee Relations, and more. A child group inherits the roles of the parent group. But, the members of the child group are not members of the parent group. If a case is assigned to the parent group and you click the <strong>Assigned to lookup</strong> icon, only the members in the parent group are available. The members of the child group are not available. Currently, there are two levels to groups, the Parent at the top (HR) and all the other groups as children.</td>
</tr>
<tr>
<td>Vendors</td>
<td>Vendors that the group is responsible for.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the group.</td>
</tr>
</tbody>
</table>

3. Click **Save** and a series of tabs appear at the bottom of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roles</td>
<td>Click <strong>Edit</strong> and from the <strong>Edit Members</strong> form, move the roles from the <strong>Collection</strong> column to the <strong>Roles List</strong> column. Adding a role to a group means that all group members also have that role. <strong>Note:</strong> Roles associated with the parent group are automatically assigned.</td>
</tr>
<tr>
<td>Group Members</td>
<td>Click <strong>Edit</strong> to add users to the group.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Groups</strong></td>
<td>Click <strong>New</strong> to create a new group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Creating a group from here does not automatically create a child group under the group you have displayed.</td>
</tr>
<tr>
<td><strong>Skills</strong></td>
<td>Click <strong>New</strong> to create a new skill. Click <strong>Edit</strong> and the <strong>Edit Members</strong> form appears. Move skills from the <strong>Collection</strong> column to the <strong>Skills List</strong>. Click <strong>Save</strong> when done.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Skills associated with the parent group are automatically assigned.</td>
</tr>
<tr>
<td><strong>Activities</strong></td>
<td>This field only appears for the Lifecycle Events application. The HR Service Activities the group manages. The HR Service Activities are part of the Activity Set and together make up a Lifecycle Event. Only members of this group can update this HR Service Activity. Refer to Configure a lifecycle event activity.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Manage HR group types**

Group types help define and categorize a group. You can use group types to narrow or expand the focus of a group.

**Before you begin**

Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > Manage Roles > Manage HR Groups**.
2. Enter a name that describes the group type in the **Name** field.
3. Enter a description that further describes the group type.
4. Click **Update** or **Save**.

**HR skills management**

Your organization can define HR skills to establish the qualifications of HR staff. Skills can be included in the auto-assignment process used to assign HR agents to HR cases and tasks. Some HR skills are predefined, and you can create as many other skills as you need. You can assign skills to users or groups. When you assign a skill to a group, the skill is assigned to every group member. Skills are also a way to ensure that HR cases are assigned to the correct group or individual.

When an HR case is opened:

- Matching rules are used to determine case assignment by matching criteria. Refer to Matching rules for case assignment.
- An HR template is applied based on the HR Service selected.
- An HR template assigns the skill required for the case or task.
- The skill determines which group or individual is assigned to the case.
Assign an HR skill to a group

When you assign skills to HR groups, all members of the group inherit the skills and any child skills.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Manage Roles > Manage HR Groups.
   This list is the same that appears under User Administration > Groups.
2. Select the HR group that you want to assign skills to.
3. In the Skills tab, click Edit.
4. Double-click skills in the Collection list to move them to the Skills List.
5. Click Save.
   Messages are displayed to notify you of the skills that were assigned to each group member.

Add or modify an HR skill

You can create HR skills and assign them to HR staff to assist with the auto-assignment of HR cases and tasks.

Before you begin
Role required: sn_hr_core.admin

About this task
The following procedure describes how to create and edit HR skills from the Skills application. Although you can create and edit skills in the Manage HR Skills module, you must use the Skills application to assign child skills.

Procedure
1. Navigate to HR Administration > Manage Roles > Manage HR Skills.
2. Click New Skill or open an existing skill.
3. Enter or edit the name of the Skill and Description.
4. Click Submit to save your changes.
5. To assign users to the skill, complete the following steps.
   a. Locate and click the skill in the All Skills column.
   b. Click Assign/Remove Users at the top, right.
c. Click the users you want assigned to this skill.

d. Click Save.
   If you add users to a skill with child skills, the child skills are assigned to the user. Messages are displayed to notify you of the skills that were assigned.

Assign an HR skill to a user
You can assign skills to HR users to facilitate the auto-assignment of HR cases and tasks.

Before you begin
For more information about HR skills and the auto-assignment process, see HR skills management.
Role required: sn_hr_core.manager

About this task
The following procedure describes how to assign HR skills in the Manage HR Skills module. If you want to define a parent and child hierarchy for HR skills, you must use the Skills application.

Procedure
1. Navigate to HR Administration > Manage Roles > Manage HR Skills.

   Skills appear on the left. Select a skill to see the assigned users on the right. The user cards indicate how many skills each employee is assigned. If no skills are assigned to a user, the number on the user card is red. Skills with no assigned users are red in the skills list.

2. Select a skill in the All Skills list to assign to users.

3. Click Assign/remove users.
   The list of all users in the HR department appears on the right. Users assigned to the skill are highlighted in blue.
4. To search for an HR user, type any information, such as name, location, or title, in the search box above the list of users. As you type, the list narrows to display user cards that contain those letters in any field.

5. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a user</td>
<td>Click the user card. It is then highlighted in blue.</td>
</tr>
<tr>
<td>Unassign a user</td>
<td>Click the highlighted user card. Its highlight is removed.</td>
</tr>
</tbody>
</table>

6. Click Save.

7. To assign other skills to a user, complete the following steps.
   a. Select All Users in the list on the left and locate the user on the right.
   b. Click the arrow next to Skills: # in the user card.
   c. Select the skills for the user, and click Save.

8. To configure skills, perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a skill</td>
<td>Click New Skill, enter the skill name and description, and click Submit.</td>
</tr>
<tr>
<td>Edit a skill</td>
<td>Click the pencil icon beside the skill name in the HR Skills list. Change the information and click Submit.</td>
</tr>
</tbody>
</table>

Add or modify escalation rules

You can create an escalation process to assign HR cases to HR agents with the appropriate skills.

Before you begin
Role required: sn_hr_core.admin

About this task
You can create an escalation process to assign HR cases to HR agents with the appropriate skills. Ensure that the following items are in place to use HR tier escalation rules.

- The HR tier escalation rules are set up correctly.
- The email address for the tier group is correct.
- The correct roles are assigned to the tier. Roles, groups, skills, and location determine the group a case is escalated to.

The following procedure describes how to create and edit HR tier escalations used when cases are assigned to HR groups.

Procedure
1. Navigate to HR Administration > Manage Roles > Escalation Rules.
2. Click New or open an existing escalation tier.
3. From Escalate from, click the Lookup using list icon and select an existing tier or click New to create a new tier. This tier contains HR agents that have fewer skills than the next tier.

4. From Escalate to, click the Lookup using list icon and select an existing tier or click New to create a new tier. This tier contains HR agents that have more skills than the previous tier.

5. Click Submit to save your changes. Click an Escalate from or Escalate to group to view group information.

Related information

Manage HR Groups

Client roles

You can control what HR functionality that an employee can access using Client Roles. You can license all employees or provide HR services to users in a specific location or group.

Client roles define access within the application. ServiceNow provides these roles and modifying them is not recommended. These roles can be added to other roles or groups. There are two groups:

- HR fulfillment support: sn_core_hrsm
- HR Service Portal: sn_core_hrsp

Both roles contains conditions depending on the type of user:

- Alumni
- Contingent
- Contractor
- Employee
- Employment Type
- Location
- New Hire
- New Hires Only
- Office Based Employees
- Remote Employees
Client Roles

![List of client roles]

**Note:** When creating an HR case and an employee does not display, ensure that the employee has any of the sn_hr_core_hrsm roles assigned. Also, when an employee cannot access the HR Service Portal, ensure any of the sn_hr_core_hrsp roles are assigned.

Client roles are defined and administered like regular roles. ServiceNow tracks them for licensing purposes.

Assignment of client role rules is defined in the Client Role Assignment Rules module.

**Client role assignment rules**

Use Client Role Assignment Rules to automatically assign or reassign a role to an employee.

**Before you begin**

Role required: sn_hr_core.admin

A condition or set of multiple condition clauses based on the HR profile [sn_hr_core_profile] table are used to automate assigning roles.

**Note:** Client role assignment rules are for access to the Employee Service Center or service portal only.

For example:

- A newly hired employee can be automatically assigned the new hire [sn_hr_core.hrsm_new_hire] role. This role provides limited access to the Employee Service Center or service portal.
- The Update Client Roles scheduled job runs and acknowledges the employee start date for the new hire has not been reached.
- The Assign HR Roles business rule assigns the new hire role based on the conditions set on the client role assignment rules.

To map conditions to a client role:
Procedure

1. Navigate to **HR Administration > Manage Roles > Client Role Assignment Rules**.
2. Click **New** to create a client role rule or click an existing client role rule to edit.
3. **Active** is enabled by default.
4. From **Condition**, click the **Lookup using list** and select an existing HR condition. Click **New** to create an HR condition. You can also click the **Preview this record** icon to open the record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR condition.</td>
</tr>
<tr>
<td>Table</td>
<td>Table conditions are built on the HR profile [sn_hr_core_profile] table only.</td>
</tr>
<tr>
<td></td>
<td>Changing the table for client role assignment is not recommended.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for enabling condition.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Deactivate at the client role assignment level and not the conditions level.</td>
</tr>
<tr>
<td>User column</td>
<td>Together with the HR profile [sn_hr_core_profile] table, filters users when evaluating a condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions the Assign HR Roles business rule uses to automatically assign a role to an employee. For example, the base system automatically assigns the New Hire role to a user when:</td>
</tr>
<tr>
<td></td>
<td>• Employment type is</td>
</tr>
<tr>
<td></td>
<td>◦ Full Time Employee or</td>
</tr>
<tr>
<td></td>
<td>◦ Part Time Employee or</td>
</tr>
<tr>
<td></td>
<td>◦ Temporary Employee and</td>
</tr>
<tr>
<td></td>
<td>◦ Employment start date is after Today</td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Update**.
6. From **Role**, click and select the HR role you want to automatically assign when the conditions are met.
7. Click **Submit** or **Update** to save your changes.

**HR Service Delivery case assignment**

HR cases can be automatically assigned to your agents via an HR case template, assignment and matching rules, or advanced work assignment (AWA).

Assignment and matching rules and AWA use the platform Skill Management application to define skills.

• Assignment and matching rules associate skills using HR case templates.
• AWA uses skill determination rules.
Advanced Work Assignment (AWA) for HR Service Delivery

Use the ServiceNow Advanced Work Assignment for HR Service Delivery feature to automatically assign HR cases to agents based on availability, capacity, and skills. AWA for HR Service Delivery pushes cases and tasks to qualified agents using work item queues, routing conditions, and assignment criteria that you define.

For more information, see Agent Workspace Advanced Work Assignment (AWA).

AWA is also available for HR Service Delivery Agent Workspace. For more information, see Advanced Work Assignment (AWA) for HR Service Delivery Agent Workspace overview.

Assignment and matching rules in HR

The base system uses the automatic case assignment feature to assign an HR case to an agent. It attempts to assign an agent with the least number of cases assigned, has the skills required by the case, and matches the location of the subject person.

Auto Assign business rule

HR Case has a business rule called Auto Assign that invokes matching rule logic. Auto Assign depends on the HR case state, assignment group is empty, and assigned to is empty.

When auto assignment is triggered, the matching rules logic obtains a list of agents. The number of agents returned is based on a parameter that specifies the length of the list. The default is one.

Note: For specific HR services, the auto-assignment functionality can be skipped. See Case options in Configure an HR service.

Matching Rules

HR assignment rules use the Resource Matching Engine [com.snc.matching_rule] plugin that is activated with the Human Resources Scoped App: Core [com.sn_hr_core] plugin. You can specify a table and a condition. The base system defaults to Assignment group is empty and Assigned to is not empty.

For HR cases that meet these conditions, the hr_AssignmentAPI script include is called to return a list of agents that are eligible for assignment. See Add or modify a matching rule.

Note: The base system provides matching rules for every COE table and HR task table.

Each HR table and task in the base system have two matching rules:

• Agents by skills and country
• Agents by skills

The higher priority (lower execution order) rule for each pair is the match by skills and country.

• If this matching rule does not find eligible agents, then the condition of the lower priority rule is still true and attempts to match by skills alone.
• If the higher priority rule finds an agent, the assigned to field is no longer empty and the secondary rule does not match.
• Either the getAgentsByCountryAndSkillsOrderLeastLoaded or getAgentsBySkillOrderLeastLoaded in the hr_AssignmentAPI script include are called.
Assignment script includes

The hr_AssignmentAPI passes the call through to the hr_AssignmentUtil script include to reduce upgrade issues. Rather than update hr_AssignmentUtil, you can add to hr_AssignmentAPI or another customer script include.

The getAgentsByCountryAndSkillsOrderLeastLoaded or getAgentsBySkillOrderLeastLoaded in the hr_AssignmentAPI script include looks for the least ordered by country and skills.

- These scripts also look at the agents in the assignment group.
- They then look for agents that have the required skills for the case and are in the same country as the subject person.
- The list of agents that are returned are sorted according to case assignment load defined as active cases of type HR case (or extension) or active HR tasks.

Auto assignment for HR tasks is slightly different than HR cases.

- The list of possible agents for an HR task is generated like an HR case.
- But, after ordering the list, the task is checked for a parent HR case and if the agent assigned is on the list.
- If it is, the agent is placed at the top of the list ignoring case load.

Required skills

If you have more than one HR department, you can remove the HR group assignment from the HR template and use assignment rules to assign the HR group. For example, if you have HR departments in both the U.S. and German offices, you can create an HR group for each office. You set up assignment rules to assign the HR group based on the location of the employee who submitted the HR case.

If your organization is using HR skills to qualify HR case assignments, ensure that the assigned user or group members have the required skills. To determine whether skills are being used and assigned, check the following configuration options.

- **HR Administration > HR Services > HR Templates**: Look at the template that corresponds to the assignment rule to see what skills, if any, are required.
- **HR Administration > Manage Roles > Manage HR Skills**: Find the HR user assigned to the case and click the **Skills: #** button to see whether the required skill is assigned. If not, check the box to assign it, and click **Save**.

Refer to [Create rules to route and assign customer service cases](#) for more information on matching and assignment rules.

Add or modify an HR assignment rule

Assignment rules are used to assign the HR group when it is not assigned from the catalog item template. You can create HR assignment rules as needed.

**Before you begin**
Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > Assignment Rules > HR Assignment Rules**.
2. Click **New**.
3. Complete the form.
### Assignment Rules form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the HR assignment rule.</td>
</tr>
</tbody>
</table>
| Execution Order | Order in which the rule processes. Rules with lower-order numbers process first. For example:  
  • The first HR assignment rule has an execution order of 100.  
  • A second HR assignment rule has an execution order of 200.  
  • If a group has members that fit the conditions defined in the first HR assignment rule, it assigns an agent with the least amount of assigned cases.  
  • If the first HR assignment rule cannot find an agent to assign, the second HR assignment rule runs. |
| Application   | Indicates core application scope the assignment rule applies to.             |
| Active        | Check box that specifies the rule is in use.                                 |
| Applies To    | Table with the records that the assignment rule applies to. Default is the HR Task [hr_task] table. |
| Conditions    | Conditions in which the assignment rule applies.                             |
| Assign To     | User to assign to the case when this rule is applied.                       |
| Assign To     | Group to assign to the case when this rule is applied.                      |
| Script        | Script to define advanced assignment rule functionality.  
  Current.variable_pool set of variables is available. |

**Note:** Two example scripts are provided as a comment. You can modify either script or use the information as a starting point for your own script. Remove the examples when you are finished.

4. Click **Update**.

### What to do next
After creating the assignment rule, you can test it to verify that it works.

### Related information
- HR Administration

### Test an assignment rule
You can test a new assignment rule to verify that it works as intended.

### Before you begin
Role required: sn_hr_core.admin
Procedure
1. Create a new HR case.
2. Fill in the fields with data that matches the assignment rule conditions.
3. Submit the HR case.
4. Reopen the case and check that the correct assignment information was added.

What to do next
If the correct assignment information was not added, check to see whether you are using HR skills and if the user has the required skills.

Note: Assignment groups are assigned at the time an HR case is created from the HR case form. Once the State is changed to Ready, an agent is assigned. When an HR case is created from the Employee Service Center, an HR agent is assigned immediately.

- **HR Administration > HR Services > HR Templates**: Look at the template that corresponds to the assignment rule to see what skills, if any, are required.
- **HR Administration > Manage Roles > Manage HR Skills**: Find the HR user assigned to the case and click the Skills: # button to see whether the required skill is assigned. If not, check the box to assign it, and click Save.

After verifying that the necessary skills are assigned to the correct users, test the assignment rule again.

Related information
**HR Administration**

Add or modify a matching rule
You can add or modify a matching rule to assign HR cases to specific users or groups.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to **HR Administration > Assignment Rules > HR Matching Rules**.
2. Complete or edit the form.

**Assignment Rules form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the HR matching rule.</td>
</tr>
<tr>
<td>Execution Order</td>
<td>Order in which the rule processes. Rules with lower-order numbers are processed first. If a rule is applied, the rules with a higher-order number are not processed. For example, a matching rule with order 100 states to assign the case to an agent with the specified skill. Matching rule with order 200 states to assign the case to the group HR. If a group has the specified skill, then it is assigned. If not, then the second rule runs and assigns it to HR.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Indicates core application scope the assignment rule applies to.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies the rule is in use.</td>
</tr>
<tr>
<td>Applies To</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Table with the records that the assignment rule applies to. Default is the HR</td>
</tr>
<tr>
<td></td>
<td>Task [hr_task] table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions in which the assignment rule applies.</td>
</tr>
<tr>
<td>Assign To</td>
<td></td>
</tr>
<tr>
<td>Applies To</td>
<td>User to assign to the case when this rule is applied.</td>
</tr>
<tr>
<td>Assign To</td>
<td>Group to assign to the case when this rule is applied.</td>
</tr>
<tr>
<td>Script</td>
<td>Script to define advanced assignment rule functionality.</td>
</tr>
<tr>
<td></td>
<td>Current.variable_pool set of variables is available.</td>
</tr>
</tbody>
</table>

**Note:** Two example scripts are provided as a comment. You can modify either script or use the information as a starting point for your own script. Remove the examples when you are finished.

3. Submit the HR case.
4. Reopen the case and check that the correct assignment information was added.

**HR synonym dictionary**

HR Service Delivery provides a Synonym Dictionary that helps expand text searches with additional keywords.

**Before you begin**
Role required: admin, ts_admin
You can edit the HR Synonym Dictionary to better match your business and terminology.

**Note:** You must be in the Global scope to edit.

**Load the HR Synonym Dictionary**

The HR Synonym Dictionary loads automatically when you check the Load demo data box and activate the Human Resources Scoped App: Core [com.sn_hr_core] plugin.

**Activate the HR Synonym Dictionary**

- Navigate to System Properties > Text Search.
- Check Yes in the Enable Synonym (which can be defined in Synonym Dictionaries) field.
- Click Save.

**Edit the HR Synonym Dictionary**

- Navigate to System Definition > Text Index Synonym Dictionaries.
- Click HRSD Synonym Dictionary.
- The base system provides five default Synonym Sets.
- Click a Synonym Set to edit.
• Add words in the Synset box separated by commas. The words in this box are your custom words that you feel your employees use in search.
• Or, click **Insert a new row** to add a Synonym Set.
• Click **Update**.

Publish the HR Synonym Dictionary

• The HRSD Synonym Dictionary form appears.
• Click **Publish Dictionary** under Related Links.
• The Synonym Dictionary is active after a few minutes.

Link generator for HR Service Delivery

Use the Link Generator to create a link on an HR case form that accesses information outside of the application to help fulfill the case.

Create links on the HR case form to payroll, social media, or to products to fulfill computer or software requests. Generate URLs to manage content, knowledge articles, and catalogs.

An example would be to create a link to a third-party HR application from the HR case form so HR agents can access additional profile information. Creating these types of links assume:

• The HR agent has valid credentials to access a third-party HR application.
• The link takes the HR agent directly to the profile information in the third-party HR application and not to the home page.

The **Human Resources Scoped App: Core [com.sn_hr_core]** plugin activates the **Link Generator [com.snc.linkgenerator]** plugin.

The process for creating a link for a form is:

• Create a record for the target website name and URL in **Define Link** (Link Generator Sources).
• Create a record for the deep link name, website name, link type, and script in **Define Link Parameters** (Link Generator Services).
• Map information like the button name, button location type, form (table), Location (field), and Deep link name in **Define Button** (Link Generator Mappings).

Add or modify an HR deep link

Use the **Define Link** (Link Generator Sources) to create a record for the target website name and URL.

**Before you begin**
Role required: link_generator_writer

**Procedure**

1. Navigate to **Link Generator > Define Link**.
2. Click **New** or an existing record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Website name</td>
<td>Enter the external website name that is the target for the link.</td>
</tr>
<tr>
<td>Website URL</td>
<td>Enter the URL of the website.</td>
</tr>
</tbody>
</table>
3. Click **Submit** or **Update**.
4. Navigate to **Define Link Parameters**.
5. Click **New** or on an existing record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deep link name</td>
<td>Enter a name or location within the website you are linking to.</td>
</tr>
<tr>
<td>Value</td>
<td>A unique link generator service value automatically created from the Deep link name entered.</td>
</tr>
<tr>
<td>Website name</td>
<td>Enter the name of the website you are linking to.</td>
</tr>
</tbody>
</table>
| Link type      | Select:  
  - Button link: Creates a button that links to the website.  
  - Generated link: Use to generate a URL that you can copy and paste into any table with a field type of URL. For example, on the **Manage Content** form, create a URL content type. Then, copy and paste the URL in the Content URL field. Other examples include creating links to knowledge articles and catalogs. |
| Script         | Enter a script that directs the user to the external site. |

6. Click **Submit** or **Update**.
7. Navigate to **Define Button**.
8. Click **New** or on an existing record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button name</td>
<td>Enter a name for the button that links to the outside website. What you enter here appears on the button.</td>
</tr>
</tbody>
</table>
| Button location type | Select the location type for the button.  
  - Standard form: Use this type to place a deep link on the legacy HR case form.  
  - Custom form: Use this type to work with an API.  
  - Agent Workspace: Use this type to work with HR Service Delivery Agent Workspace. |
| Form (Table)   | Select the table that contains the field you want the deep link button to appear next to.  
  For example, select the **HR Profile [sn_hr_core_profile]** table when you want the
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location (Field)</td>
<td>Select the field from the table selected that you want the deep link button to appear next to. For example, select User to place the deep link button next to the User field on the HR Profile form.</td>
</tr>
<tr>
<td>Deep link name</td>
<td>This information is pulled from the Deep Link Parameters (Link Generator Service) form.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make this mapping active and available for use.</td>
</tr>
</tbody>
</table>

9. Click **Submit** or **Update**.

**HR security**

HR Service Delivery provides Restricted Caller Access, Encryption Support, and Edge Encryption security features.

**Restricted caller access for HR**

Restricted caller access (RCA) defines cross-scope access to HR Service Delivery applications.

RCA is available to help secure sensitive information in HR scoped tables and script include APIs. Without RCA, tables that are not private to a scope are susceptible to queries by any server-side script.

The **Scoped Application Restricted Caller Access [com.glide.scope.access.restricted_caller]** plugin is activated during the HR application installation or upgrade.

**Caller tracking**

This setting is recommended for the development stage. Access is allowed to tables and script includes, but tracked in the Restricted Caller Access table. Access information can be viewed from Application Restricted Caller Access.

**Caller restriction**

This setting is recommended for the production phase after development is complete.

To define cross-scope access to an application resource, refer to Define cross-scope access to an application resource.

**Related information**

Define application scope and resource access

**Encryption Support for HR and Employee Document Management**

HR Service Delivery and Employee Document Management provides encryption support to secure sensitive information.

To encrypt employee documents or fields in HR, activate the Encryption Support [com.glide.encryption] plugin. Encryption prevents unauthorized users from downloading and viewing employee documents or viewing specific fields.

After the plugin has been activated:
Reveal the Encryption Context field to the sn_hr_ef.encryption_context role.

Note: The base system does not reveal the Encryption Context field on the Role form. This field defines the encryption key used to encrypt fields and documents. Also, ensure the Application field has Employee Document Management selected. See Roles.

From the Encryption Context field, select an existing or add an encryption context. See Set up encryption contexts.

Add the sn_hr_ef.encryption_context role to the user adding employee documents. Users with this role can access encrypted documents.

Employees can view their own documents when HR Service Delivery is licensed, activated, and the document type allows employee access. The sn_hr_ef.encryption_context role is not required for employees to view their own documents that are encrypted. See Define policies for a document type.

Note: Documents created prior to plugin activation are not encrypted.

See Encryption Support.

Edge Encryption for HR and Employee Document Management

HR Service Delivery and Employee Document Management provides edge encryption to secure sensitive information.

Edge encryption provides you with direct control over your data security. Encryption and key management are performed on your intranet between your browser and your ServiceNow instance.

See Understanding Edge Encryption.

Because edge encryption is enabled on a proxy server on your side of the network, there is significant planning, network administration and management, and setup required.

See Planning for Edge Encryption.

To install edge encryption, see Edge Encryption installation.

To configure edge encryption, see Edge Encryption configuration.

Edge encryption for HR

You can encrypt columns (fields) or attachments associated with an HR table. See Encrypt fields using encryption configurations.

Note: There are limitations when using edge encryption. See Edge Encryption limitations.

HR chat from lists and forms

You can chat with employees about their HR services request from any HR list or form in HR Service Delivery.

Access chat from the Toggle Connect Sidebar from the Form Header on any HR form or list. A number display on the Toggle Connect Sidebar icon to indicate that someone is trying to chat with you.

A chat initiated about a specific HR case is part of the case record. By default, the chat conversation saves to the Work notes of the HR case. Work notes on an HR case are not visible to the employee. Changing chat to Comments make the chat visible to the employee on the HR case.

In the chat widow, click the icon next to the HR case number to access the details of the HR case.
**Note:** When an agent is not assigned to an HR case, some features are not available from the Employee Service Center. For example, the Ask a Question link to chat about a specific case cannot assign an agent. For information on automatically assigning an HR agent to a case, see Assignment and matching rules in HR.

See Connect.

**Manage the HR chat queue**

You can configure the HR department chat queue and review the chat records to measure how well employees are being assisted when they initiate a conversation.

**Before you begin**

To use the HR chat queue, the administrator must activate the Connect Support [com.glide.connect.support] plugin.

Role required: admin or hr_admin

**About this task**

You can configure the assignment group for monitoring the chat queue and the messages that employees see when they initiate a conversation and while they are waiting.

You can review the chat records to see how long employees waited for a response and who is accepting the chat requests.

**Procedure**

1. Navigate to Collaborate > Connect Support > Support Administration > Queues.
2. Select HR Department Chat Queue from the Chat Queues list.
3. Fill in the fields, as appropriate.

**Chat Queue form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group that contains the support staff for the queue. Any user in the group can view the queue in the Connect sidebar and accept chats. No other users can access the queue. This field must be populated.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average time it takes for an agent to accept a chat in the queue. This value is automatically calculated. Do not manually edit.</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Different queue to which an agent can escalate a chat. For example, there is a queue for high priority support chats. When a queue is defined in this field, agents can access the Escalate option in conversations.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts their chat. For example, Thank you for contacting support. We are looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Not available</td>
<td>Message that users see when they attempt to start a chat outside the defined queue <strong>Schedule</strong>. You can use HTML to format the message and include links or media.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example, How can I help you?</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule that defines when the queue is available. Leave the field blank to make the queue available all the time. Users cannot start a new conversation in the queue outside the schedule hours.</td>
</tr>
</tbody>
</table>

4. To review conversations associated with the queue, add the Chat Queue Entries related list and review the records for the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How long the user waited and the result</td>
<td>Review information in the State and Wait time columns.</td>
</tr>
<tr>
<td>Who is actively helping employees in the queue</td>
<td>Review the names of agents in the Assigned to column.</td>
</tr>
</tbody>
</table>

Monitor the HR chat queue

Employees can ask a question from the Chat with HR link on the HR Portal. Their question is placed in the HR chat queue, and any HR agent monitoring the queue can respond to it.

About this task

By default, all members of the HR group monitor the HR chat queue. When a question is submitted to the queue, a pop-up notification appears.

![HR chat queue notification](image)

A new customer has joined your support queue

Procedure


2. Click the support tab of the Connect sidebar, indicated by a headset icon. The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a user starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue can accept the conversation.
3. Accept a conversation in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accept a conversation from a queue</strong></td>
<td>Under <strong>Queues</strong>, click <strong>Accept</strong> by the queue. The conversation opens in</td>
</tr>
<tr>
<td></td>
<td>the conversation pane and an entry appears in the <strong>Cases</strong> section of the</td>
</tr>
<tr>
<td></td>
<td>sidebar.</td>
</tr>
<tr>
<td><strong>Accept a transfer request</strong></td>
<td>Under <strong>Cases</strong>, click <strong>Accept</strong> by a transfer request. The conversation</td>
</tr>
<tr>
<td></td>
<td>opens in the conversation pane. The agent who transferred the conversation</td>
</tr>
<tr>
<td></td>
<td>can stay in the conversation.</td>
</tr>
</tbody>
</table>

4. Respond to the user and help resolve the issue. By default, your messages are added to the conversation record as comments and are visible to the user.
**What to do next**
If necessary, you can open a new HR case or incident from the conversation for further investigation. You can also transfer the conversation to a different agent or queue, or escalate the conversation to a higher priority queue.

**Create an HR case from a chat**
If an HR chat results in the need to open a case, create the case directly from the conversation.

**Before you begin**
Role required: sn_hr_core.basic or sn_hr_core.case_writer.

**About this task**
When you create an HR case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

**Procedure**
1. Navigate to **Connect > Connect Support**.
   The Connect workspace opens in a new tab.
2. Click the support tab of the Connect sidebar, indicated by a headset icon (🎧).
3. Under **Cases**, open an HR conversation.
4. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.
5. In the Connect actions menu, select **Create HR Case**.
   In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details.
6. Complete the form as necessary and click **Submit**.
   Any comments or work notes in the record conversation appear as comments on the incident form. Work notes do not appear in the chat for the ESS user. The chat agent can select whether a message is a Comment or Work Note in the conversation.
   a. In the record conversation, by the text entry field, click the message type icon (💬).
   b. Select **Comment** or **Work Note**.
   c. Enter a message.
      By default, record conversation messages are added as comments.
   
   **Note:** If you add an attachment to a record conversation, it is attached to the underlying record as well.

   The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table. Any new journal fields added to the record do not appear in the chat. The system also changes the document ID for the conversation to reference the incident number instead of the entry in the Chat Queue Entry table.

**HR e-signature**
Sign electronic documents from any desktop or mobile device with e-signature. E-signature is a scoped application that enables users to sign managed documents, knowledge articles, or HR document templates with their typed or drawn e-signature, their credentials, or as an acknowledgment.
The e-signature [com.snc.esign] plugin activates the sn_esign.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only e-signature admin user by requiring a minimum number (default is two) of active users with this role.

**HR and e-signature roles**

By default, the following HR roles contain the following e-signature roles.

<table>
<thead>
<tr>
<th>HR role</th>
<th>E-signature role</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR administrator [sn_hr_core.admin]</td>
<td>E-signature administrator [sn_esign.admin]</td>
</tr>
<tr>
<td>HR basic [sn_hr_core.basic]</td>
<td>E-signature manager [sn_esign.config_manager]</td>
</tr>
</tbody>
</table>

You can use the assignments as-is or change them. To change the default assignments, see Components installed with e-signature for information on how to assign a role to another role, group, or user.

**How to use e-signature templates with HR tasks**

Users with the HR administrator [sn_hr_core.admin] or basic [sn_hr_core.basic] role can create e-signature templates. Each e-signature template pairs a document type to sign (managed document, knowledge article, or HR document template) with a signature type (signature, credential, or acknowledgment). For example, you could create an e-signature template for a non-disclosure agreement that requires a typed or drawn signature.

- Configure an e-signature template

You can then use the e-signature templates in HR tasks or HR task templates to request signatures from users.

**Note:** On the HR task form, make sure that the HR task type sets to E-signature.

- Adding an HR task to an HR case
- Configure an HR task template

**Migrating existing HR task templates and open HR tasks to e-signature**

Migrate existing HR task templates and open HR tasks to the new HR task type for e-signature with the Migrate HR e-signature tasks scheduled job. The scheduled job automatically updates the HR task type and e-signature template based on your existing configurations. It also disables the old HR task types for credential, e-signature, and sign document.

- Migrate existing HR task templates and open HR tasks to e-signature

**Activation information**

E-signature automatically activates when you activate Case and Knowledge Management. If it does not activate, you can manually activate e-signature. For information on what components install with the feature, see Components installed with e-signature.

**Related information**

E-signature
Select an HR document template for an e-signature task

If the document type of the e-signature template you are using is an HR document template, then you must select the HR document template that the signatory will sign on the HR case form. Depending on the HR service you are using to request the e-signature, you may need to configure the HR case form so that the PDF template field appears and an HR document template can be selected.

Before you begin
Role required: sn_hr_core.basic or sn_hr_core.case_writer

Procedure
1. Navigate to HR Case Management, and create a new or open an existing HR case.
2. On the HR case form, in the PDF Template field, select an HR document template.

⚠️ Note: If the PDF Template field is not visible, make sure that the HR case form for the HR service you are using is configured to show that field. See Configure the HR case form for an HR service for more information, and also HR case form configuration examples for an e-signature-specific example.

Example

3. Click Start Work.
4. Click Preview Document to preview the document.
5. From the Preview Document window, click Generate to generate the document for signing.
   The document to sign is added as an attachment to the HR case form.

What to do next
You can add an HR task to the HR case to request an electronic signature from an employee.
Migrate existing HR task templates and open HR tasks to e-signature

Migrate existing HR task templates and open HR tasks to the new HR task type for e-signature with the **Migrate HR e-signature tasks** scheduled job. The scheduled job automatically updates the HR task type and e-signature template based on your existing configurations. It also disables the old HR task types for credential, e-signature, and sign document.

**Before you begin**
Role required: sn_hr_core.admin

**About this task**
The **Migrate HR e-signature tasks** scheduled job migrates existing HR task templates and open HR tasks from the **Credential**, **E-Signature**, and **Sign Document** HR task types to the new **E-signature** HR task type.

The associated document and signature configurations are also migrated to new or existing e-signature templates. If an e-signature template for the applicable document and signature configuration already exists, then the existing e-signature template is used. Otherwise, a new e-signature template is created.
<table>
<thead>
<tr>
<th>Pre-migration HR task type</th>
<th>Post-migration e-signature template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential</td>
<td>• Document type: Managed document</td>
</tr>
<tr>
<td></td>
<td>• Signature type: Credential</td>
</tr>
<tr>
<td>E-Signature</td>
<td>• Document type: Managed document</td>
</tr>
<tr>
<td></td>
<td>• Signature type: Signature</td>
</tr>
<tr>
<td>Sign Document</td>
<td>• Document type: HR document template</td>
</tr>
<tr>
<td></td>
<td>• Signature type: Signature</td>
</tr>
</tbody>
</table>

Finally, the HR task types for **Credential**, **E-Signature**, and **Sign Document** are disabled. Only the new HR task type for **E-signature** remains.

**Procedure**

1. Navigate to **System Definition > Scheduled Jobs**.
2. Open the **Migrate HR E-signature Tasks** scheduled job.
3. Click **Execute Now**.
   - Depending on the data you have, the migration may take some time.
     - Existing HR task templates are updated to the e-signature task type and an e-signature template.
     - Open HR tasks are updated to the e-signature task type and an e-signature template.
     - HR task types for **Credential**, **E-Signature**, and **Sign Document** are disabled.

**Collect employee input**

Collect employee input without creating additional case records or adding new fields to existing tables with employee forms. Employee forms are questionnaires built using the survey designer that you can use in HR tasks to verify or update information from employees. The information collected can be mapped directly to fields on a target table. You can also use HR criteria to query answers for use in downstream processes, such as for lifecycle event activities.

**How to collect employee input**

Employee forms enable you to collect or verify information from employees. To use them, you must first create the employee form. Employee form questionnaires are built using the survey designer, and you can map questions from the employee form to corresponding fields on a target table. The mappings allow you to auto-populate information onto the employee form, and that information can be read-only or editable. If editable, the updated values will be pushed back to the corresponding table fields.

- Create an employee form

Once created, you can use the employee forms in HR tasks or HR task templates.

⚠️ **Note**: Make sure that the HR task type is set to **Collect employee input**.

- Adding an HR task to an HR case
- Configure an HR task template
You can also use HR criteria records to query collected answers for use in downstream processes, such as for lifecycle event activities. Because questions on the employee form are built using the survey designer, the answers collected are saved to the Metric Result [asmt_metric_result] table. You can use HR criteria records to query answers from that table to determine whether an activity should trigger for a particular user. For example, if on an invention disclosure form, the new hire answers yes, then you can use that answer to trigger the creation of another task to collect details on the invention.

- Create an HR criteria record for an employee form

**Example: Gathering intellectual property information**

As part of the onboarding process, you want to ask new hires if they have any inventions to disclose. If they do, you want to gather details on the invention. To collect this information, you need to create an employee form, which is a questionnaire built using the survey designer. The questionnaire can include:

- New hire’s manager
- New hire’s business unit
- Do you have inventions to disclose?
- If yes, provide details on your invention.

After you create the employee form, you can use the form in HR tasks to collect the information you need. The following GIF shows an example of an HR agent creating a collect employee input task for an employee, Eva Seahorn, as part of an HR case.

The employee can then provide that information when they receive the to-do. The follow GIF shows an example of the employee, Eva Seahorn, then completing the collect employee input to-do in the Employee Service Center.
Collect employee input error handling
If an error occurs when updating the employee form, a work note will be added to the HR case and HR task forms. Information not updated must be manually updated by the HR agent, and you can navigate to HR Administration > Employee Form Errors for further details on the error.

Create an employee form
Create or modify an employee form so that you can collect employee input. Configuration of the employee form is a three-part process. First, create the employee form record. Second, use the survey designer to build one or more questions for the employee form. Third, you can map questions from the employee form to corresponding fields on a target table.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Employee Form.
2. Click New.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the employee form.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the employee form.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the employee form for use.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.
The Form Designer button appears.
5. Click **Form Designer** to open the survey designer in a new window.

6. Use the survey designer to build questions for your employee form.

**Note:** If you plan to map the question to a table field, make sure that the data types match. Mapping is supported for the following question types:

- Boolean
- Choice
- Date
- Date/Time
- Number
- String
- Reference

For further details on the different question types, see [Survey designer elements](#).

**Example**

The following GIF shows an example of a user building a reference question and a boolean question in the survey designer.

**Note:** Make sure to provide each question a name so that you can more easily identify the question when creating mappings or HR criteria records.
7. After building your questions, click **Save and Publish**.

8. Return to and reload the employee form.
   
   The **Add Mappings** field appears on the employee form.

9. If you want to map one or more questions to fields on a table, fill in the following new fields on the form.

   **Employee Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Mappings</td>
<td>Option to map questions from the employee form to fields on a target table. This field appears after you save and publish at least one question in the survey designer.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that the employee form is mapping to. This field appears when <strong>Add Mappings</strong> is selected.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Use the condition builder to identify one record on the table to access. Make sure that the result is a match to a single record. This field appears when <strong>Add Mappings</strong> is selected.</td>
</tr>
</tbody>
</table>

**Example**

For example, you can map an employee form to the HR Profile [sn_hr_core_profile] table with the following condition:
• [User] is (dynamic) [Me]

The result is that the logged-in user’s HR profile record is accessed for mapping.

10. To map one or more questions from the employee form to fields on the target table.

a. In the Employee Form Field Mappings section, click New.

b. Fill in the fields on the form.

**Employee Form Field Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee form</td>
<td>This field is automatically set to the name of the employee form.</td>
</tr>
<tr>
<td>Table name</td>
<td>This field is automatically set to the table that the employee form is associated with.</td>
</tr>
<tr>
<td>Question</td>
<td>Question from the employee form that is being mapped from.</td>
</tr>
<tr>
<td>Field</td>
<td>Field that is being mapped to</td>
</tr>
</tbody>
</table>

**Note:** Make sure that the data type matches that of the target field.

**Note:** Make sure that the data type matches that of the source question.

Read only  | Option to make the question read-only. If selected, the user can read but not update the field value on the employee form. This field appears after you select a question in the Question field.

**Example**

For example, you can map a question for the user’s manager to the corresponding field on the User [sys_user] table. When the user views the employee form in an HR task, they will see their manager’s name filled in for that field. Because it is marked as read-only, the user will be able to read but not update that field.
c. Click **Submit** or **Update**.

d. Repeat the process as needed.

11. Click **Update**.

**What to do next**

You can use the employee form in task forms to collect employee input from users.

The following GIF shows an example of an HR agent creating a collect employee input task for an employee, Eva Seahorn, as part of an HR case.

The follow GIF shows an example of the employee, Eva Seahorn, then completing the collect employee input to-do in the Employee Service Center.
Create an HR criteria record for an employee form

Create an HR criteria record for an employee form. Answers from the employee form are stored in the Metric Result [asmt_metric_result] table. You can query the answers using HR criteria. For example, if on an invention disclosure form, the new hire answers yes, then you can use that answer to trigger the creation of another task to collect details on the invention.

**Before you begin**
Role required: sn_hr_core.admin

**Procedure**
1. Navigate to HR Administration > HR Criteria.
2. Click New.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR criteria record.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the HR criteria record.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR criteria record for use.</td>
</tr>
</tbody>
</table>

4. Right-click the former header and click Save. The Conditions section appears.
5. In the Conditions section, click New.
6. On the HR Condition form, enter the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>&lt;Name for the HR condition&gt;</td>
</tr>
<tr>
<td>Table</td>
<td>Metric Result [asmt_metric_result] table</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Employee form</td>
<td>Select the employee form you want to query. This field appears when the Metric Result table is selected in the Table field.</td>
</tr>
<tr>
<td>Condition</td>
<td>Select the question and answer from the employee form you want to query.</td>
</tr>
<tr>
<td></td>
<td>For the question, provide the following condition:</td>
</tr>
<tr>
<td></td>
<td>• [Metric] [is] [&lt;Question&gt;]</td>
</tr>
<tr>
<td></td>
<td>For the answer, provide the following condition based on the value type:</td>
</tr>
<tr>
<td></td>
<td>• [String value] [is] [&lt;Answer&gt;]</td>
</tr>
<tr>
<td></td>
<td>• [Reference value] [is] [&lt;Answer&gt;]</td>
</tr>
<tr>
<td></td>
<td>• [Actual value] [is] [&lt;Answer&gt;]</td>
</tr>
</tbody>
</table>

**Active**

**User column**

**Example**

7. Click **Submit**.

8. On the HR Criteria form, click **Update**.

**What to do next**

Depending on the case type, the HR criteria record will use the following survey instance:

- If you are using the HR criteria record with a lifecycle event, it will use the survey instance that is associated with the lifecycle event case.
- If you are using the HR criteria record with any other HR case, it will use the latest survey instance.

**Capturing multiple job records for a user**

Capture multiple job records for a user with the new Jobs (sn_hr_core_job) table. When creating HR cases, you can specify which job the case pertains to. For example, say that you
have a payroll discrepancy case and the employee has two associated job records. When the case is created, you can specify which job the case is for.

**Jobs table overview**

Beginning in the New York release, you can use the new Jobs (sn_hr_core_job) table to store multiple job records per user and capture the job history of users within your organization.

**Jobs table and HR Profile table**

The HR Profile table has a reference to the Jobs table for the user’s primary job.

### HR Profile (sn_hr_core_profile) table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>primary_job</td>
<td>Reference field to the Jobs (sn_hr_core_job) table.</td>
</tr>
<tr>
<td>• Job start date</td>
<td></td>
</tr>
<tr>
<td>• Job end date</td>
<td></td>
</tr>
</tbody>
</table>

For example, the following HR profile record is for Eva Seahorn. Eva was first hired as a UX designer in May 2017. In August 2018, she left the company. In June 2019, she was rehired as a marketing director. Eva has two associated job records, and her marketing director position is her primary job.

- In the Employment Information related list, information about the primary job is displayed.
- In the Jobs related list, all of the associated job records are displayed.

**Note:** The employment start date represents the first day the user was employed with the organization. The job start date represents the first day of the user’s current primary job. In Eva’s case, because she left the organization in August 2018, her rehired start date of June 2019 represents her new employment start date.
Jobs table and HR Case table

The HR Case table has a reference to the Jobs table for the subject person’s job.

HR Case (sn_hr_core_case) table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>subject_person_job</td>
<td>Reference field to the Jobs (sn_hr_core_job) table.</td>
</tr>
</tbody>
</table>

In the case of Eva Seahorn, for example, she is rehired as a marketing director in June 2019. She has two associated job records. When an onboarding case is created for her, the subject_person_job field enables you to specify which job the onboarding case pertains to. For Eva, the onboarding case would be for the marketing director job she was rehired for.

Supporting multiple jobs in a lifecycle event

Use the Jobs table to create lifecycle event cases where you can specify which job the case pertains to. For example, say that you have an intern that is being transferred to a full-time position. The intern has two associated job records. When an onboarding case for the full-time position is created, the case is associated with the full-time job record, ensuring that downstream activity sets and activities are triggered based on information from that relevant job record.

- Support multiple jobs in a lifecycle event
HR Service Portal

Your employees can use the HR Service Portal as a self-service way to get information on benefits, policy information, or request help from the HR team.

From the HR Service Portal, you can:

- View top rated knowledge base articles or search for HR knowledge articles that answer your questions to quickly access top-rated articles. As you type, articles are suggested based on keywords.
- View your HR profile and upload a company photo. You can update fields that are not disabled in your HR profile.
- View your HR cases, requests, approvals (if you are an approver), team, and organization chart.
- Submit HR questions and requests that are not answered in HR knowledge articles.
- View weather and a map for your location.
- Chat with an HR specialist. (An administrator must enable the HR chat queue for the link to appear.)
- Email HR to create your request.
- Browse the HR Service Catalog to:
Enroll in benefits.
Request direct deposit for your paycheck.
Select or modify benefits or beneficiaries.
Request to onboard or offboard employees.
Report or ask about disciplinary issues.
Request HR Service Portal support.

- View your assigned tasks to complete.
- View tasks HR, Facilities, and IT are completing.

**HR ticket page**

The HR ticket page is where you and your employees can view the details of an HR case and can be used with the HR service portal.

The HR ticket page appears when you open an HR request from the requests page in the portal. (Non-HR requests open to a non-HR ticket page.) Different users have different views of the HR ticket page, and you can configure the HR ticket page header for individual HR services.

The HR ticket page shows the details of an HR case, such as the description, attachments, history, approvers, and to-dos.

**Note:** What you see on the HR ticket page depends on your persona. For example, because Mara Rineheart is the person that the HR case was opened for, she can see all the to-dos that are associated with her case.
**HR ticket page user types**

There are four different user types that can view the HR ticket page: the person that the HR request was opened for, the person that is the subject of the request, any task assignees, and any approvers. Each user type has a unique view.

<table>
<thead>
<tr>
<th>User type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opened for</td>
<td>Person that the HR request was opened for. Sees the HR case when it is created, including all to-dos for all user types.</td>
</tr>
<tr>
<td><strong>Note:</strong> If an HR case has one or more child cases, the children are automatically rolled up with the parent up to three generations. HR child cases that are rolled up with the parent do not appear as separate requests on the requests page. Non-HR child cases appear both as a separate request and as part of the roll-up on the parent case.</td>
<td></td>
</tr>
<tr>
<td>Subject person</td>
<td>Person that is the subject of the HR request. (This person may or may not be the same person that the HR request was opened for.) Only sees the HR ticket page if an HR task is assigned to the user as a to-do. You can further configure the subject person view to:</td>
</tr>
<tr>
<td></td>
<td>• Show case to subject person: If selected, the subject person sees the HR case when it is created, as well as:</td>
</tr>
<tr>
<td></td>
<td>◦ HR tasks assigned to the subject person</td>
</tr>
<tr>
<td></td>
<td>◦ Child HR cases where the subject person is also the opened for</td>
</tr>
<tr>
<td></td>
<td>◦ Child HR cases when the subject person has a task assigned</td>
</tr>
<tr>
<td></td>
<td>◦ Requests where the subject person is the requested for See Configure an HR service for more information.</td>
</tr>
<tr>
<td>Task assignee</td>
<td>Person that is assigned a task to help fulfill the HR request. Only sees the HR ticket page if an HR task is assigned to the user as a to-do.</td>
</tr>
<tr>
<td>Approver</td>
<td>Person that is an approver for the HR request. Only sees the HR ticket page if an approval is assigned to the user as a to-do.</td>
</tr>
</tbody>
</table>

**HR ticket page header configuration**

The HR ticket page header provides information about the HR case such as the HR service type, description, attachments, history, option to cancel the request, and who is assigned to the case.

You can configure the appearance of the HR ticket page header for individual HR services.

- Configure the HR ticket page header for an HR service

**Standard Ticket Page view for HR Service Delivery**

Configure your HR services to use the Standard Ticket page to provide a consistent user experience for your employees.
You can configure the appearance of your ticket page layout (such as header and tabs) from **Standard Ticket > Standard Ticket Configuration**. For more information, refer to **Configure custom HR services**.

For new and restarted instances, the Standard Ticket page view is available by default. For upgraded instances, you must configure the page route map. For more information, see **Enable the page route map**.

After you have configured the HR services and have completed the page route mappings, your HR requests appear in the Standard Ticket page view in the following format:

![Standard Ticket Page](image)

**Configure custom HR services**

Configure your custom HR services in the Standard Ticket page to provide consistent employee experience in the Portal.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Standard Ticket > Standard Ticket Configuration**.

   **Important:** By default, the standard ticket configurations are done for the following HR services:
   - `sn_hr_core_case_talent_management`
   - `sn_hr_core_case`
   - `sn_hr_core_case_payroll`
   - `sn_hr_core_case_relations`
   - `sn_hr_le_case`
   - `sn_hr_core_case_operations`
   - `sn_hr_core_case_total_rewards`
   - `sn_hr_core_case_workforce_admin`
2. Select your custom HR service.
3. On the form, configure the required fields:

**Ticket Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>COE table for which you want to configure the standard ticket page.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to specify if the ticket configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td>State field</td>
<td>Any field of the task-extended table. By default, this field is mapped to the</td>
</tr>
<tr>
<td></td>
<td><strong>State</strong> field of the task-extended table. Configure the form to add this field.</td>
</tr>
<tr>
<td>Note:</td>
<td>You cannot add fields for any of the following information:</td>
</tr>
<tr>
<td></td>
<td>• Number</td>
</tr>
<tr>
<td></td>
<td>• Short description</td>
</tr>
<tr>
<td></td>
<td>• Created date</td>
</tr>
<tr>
<td></td>
<td>• Updated date</td>
</tr>
<tr>
<td></td>
<td>• Watch list</td>
</tr>
<tr>
<td></td>
<td>• Any user input such as comments and work notes</td>
</tr>
</tbody>
</table>

**Info Region**

<table>
<thead>
<tr>
<th>Show 'Description'</th>
<th>Scenario where the request description should be displayed. Possible options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Always</td>
</tr>
<tr>
<td></td>
<td>• When no variables</td>
</tr>
<tr>
<td>Note:</td>
<td>When displayed, you can expand and collapse the description.</td>
</tr>
</tbody>
</table>

| Advanced         | Option to specify that a widget should be displayed in the info region.        |
|                  |                                                                             |
|                  | Info widget                                                                  |
|                  | Widget that should be displayed in the info region. This field appears only when the Advanced check box is selected. |
| Note:            | By default, the HRM Case Info widget is used to display the HR case-related information. |
|                  | Info widget parameters                                                       |
|                  | Comma-separated list of info widget parameters. This field appears only when the Advanced check box is selected. |
|                  | Info fields                                                                  |
|                  | Fields that should be displayed in the info region. This field disappears when you select the Advanced check box. |
### Field | Description
--- | ---
Note: You cannot add fields for any of the following information:
- Number
- Short description
- Created date
- Updated date
- Watch list
- State
- Any user input such as comments and work notes

#### Action Region

| Action widget | Widget to specify the actions available in the info region.  
| Note: By default, the HR Standard Ticket Actions widget is used. |
| Action widget parameters | Comma-separated list of action widget parameters. |

#### Note:
- By default, two types of tabs are activated and configured: **Activity** and **Attachments** type.
- You cannot duplicate any tab type other than Custom.
- You can configure a maximum of five tabs.
- You can add only one of these tab types:
  - Variable Editor (Read-Only)
  - Variable Summarizer

4. Right-click the header menu and click **Save**.
5. On the Tab Configurations related list, configure the fields.

### Tab Configuration form

| Field | Description |
--- | --- |
Type | Tab type based on which a widget is displayed. Possible options are:
- None
- Activity
- Attachments
- Custom
- Variable Editor (Read-Only)
- Variable Summarizer
Tab name | Name of the tab.
Application | Application associated with the ticket configuration.
Order | Order in which the tab should be displayed in the tabs section.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>Conditions for the tab visibility.</td>
</tr>
</tbody>
</table>
| Widget           | Widget that should be displayed in the tabs section. This field appears only when **Custom** is selected from **Type**.

**Note:** For the **Tasks/To-dos** tab, by default the HRM Task Parent widget is used. For the **Approvers** tab, by default the HRM Approval Tab widget is used. For the **Attachments** tab, by default the HR Standard Ticket Attachments widget is used. This widget also displays employee documents (EDM).

| Widget parameters | Comma-separated list of tab widget parameters. This field appears only when **Custom** is selected from **Type**. |

6. On the Ticket Configuration form, click **Update**.

**Enable the page route map**

If you have upgraded your instance, redirect your HR ticket pages to the Standard Ticket page in Portal. View your HR requests in the Standard Ticket Page view.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Service Portal > Page Route Maps**.
2. Create the page route map from **hrm_ticket_page** to **standard_ticket**.

**Note:** **hrm_ticket_page** is available only when you have the Employee Service Center [com.sn_hr_service_portal] plugin.

3. Create the page route map from **hrsp_ticket** to **standard_ticket**.

---

© 2022 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note: hrsp_ticket is available only when you have Human Resources Scoped App: Core [com.sn_hr_core] plugin, without the Employee Service Center [com.sn_hr_service_portal] plugin.

4. Create the page route map from ticket to standard_ticket.

Note: ticket is available only Non-HR catalog items.

Translations for HR cases and tasks
Enable translations on HR case and task templates so that employees can view the short descriptions and descriptions of their HR cases and tasks in their preferred language.

Configure the global descriptions for translations for an HR template
Configure an HR case or task template to enable translations. You can provide the global descriptions for translations in multiple languages so that users can view the short descriptions and descriptions of their HR cases and tasks in their preferred language.

Before you begin
Make sure to activate the languages that you want to support translations for. See Activate a language for more information.

Role required: admin

Procedure
1. Navigate to HR Administration > HR Services > HR Templates.
2. Click New or open a record.
3. Fill in the fields on the form, as appropriate.

For details on how to configure an HR case or task template, see:
• Configure an HR case template
• Configure an HR task template

4. To enable translations, make sure that the **Use global descriptions for translations** field is selected. When selected, the **Global short description** and **Global description** fields display.

5. Provide the global short description and description for each of your activated languages.

   **Note:** Make sure to provide global descriptions for each supported language. You cannot select the **Use global descriptions for translations** option within a single HR template for some languages and not others.

   a. Go to **System Systems > General**, and select the language that you want to provide translations for.

   **Example**
   For example, you can set the language to Spanish.
b. On the HR template form, provide the global short description and description in the selected language.

**Example**
For example, you can provide the global short description and description for dental benefits in Spanish.

![Image of HR template form with descriptions in Spanish]

```
Utilizar descripciones globales para traducciones

Descripción global breve

Descripción global

Seleccioné su plan de beneficios dentales
```

c. Repeat the process for each language you are supporting.

**Example**
For example, if English, Spanish, and Korean are activated on your instance, then make sure to provide global translations for each of those languages in the HR template.

![Image of HR template form with descriptions in multiple languages]

6. Click **Submit** or **Update**.

7. If you are configuring an HR case template, then you can also update the corresponding HR service to use case headers that support the use of global descriptions.

a. Navigate to **HR Administration > HR Services > HR Service Configuration**.

b. Open the corresponding HR service record.
c. Update the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opened for / Approver view</td>
<td>Opened for/approver case header configuration using global descriptions</td>
</tr>
<tr>
<td>Subject person / Task assignee view</td>
<td>Subject person/task assigned to case header configuration using global descriptions</td>
</tr>
</tbody>
</table>

d. Click **Update**.

**Example: Dental benefits enrollment**

This is an example of how the global short description and description displays for the Dental Benefits Enrollment/Modification HR service in the Employee Service Center when the language is set to Spanish.

**Employee Profile table**

The Employee Profile (sn_employee) plugin provides an Employee Profile (sn_employee_profile) table that makes the employment start date and employment end date fields available outside of HR Service Delivery. For example, the table can be used with IT Business Management to update the resource capacity of users.

**Overview**

Beginning in the Paris release, you can use the Employee Profile (sn_employee_profile) table to make the `employment_start_date` and `employment_end_date` fields available outside of HR Service Delivery.

**Employee Profile (sn_employee_profile) table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>Reference to the User (sys_user) table.</td>
</tr>
<tr>
<td>employment_start date</td>
<td>Represents the employment start date.</td>
</tr>
<tr>
<td>employment_end date</td>
<td>Represents the employment end date.</td>
</tr>
</tbody>
</table>
If you are using Employee Profile with HR Service Delivery

When you activate the Employee Profile plugin, the following fields are pulled from the HR Profile (sn_hr_core_profile) table to populate the Employee Profile (sn_employee_profile) table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>employment_start_date</td>
<td>Represents the employment start date.</td>
</tr>
<tr>
<td>employment_end_date</td>
<td>Represents the employment end date.</td>
</tr>
</tbody>
</table>

Sync employee profile from HR profile is a one-time scheduled job that will pull all users with their corresponding employment_start_date and employment_end_date values from the HR Profile table upon plugin activation. Subsequent updates will be made by the Synchronize fields to HR profile and Synchronize fields to employee profile business rules.

⚠️ Note: If you need to run the one-time scheduled job again, make sure to first activate the job and allow for the invalidated RCA before running it. Do not run the job on a scheduled basis.

Activation information

You must activate the Employee Profile (sn_employee) plugin to use the Employee Profile table with your application.

⚠️ Note: If you are using the table with IT Business Management, see Update the resource capacity for more information.

Activate Employee Profile

You can activate the Employee Profile plugin [sn_employee] if you have the admin role.

Before you begin

Role required: admin

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   ⚠️ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference

- List of plugins (Quebec)

Components installed with Employee Profile

Several types of components are installed with activation of the Employee Profile [sn_employee_profile] plugin, including tables, user roles, and scheduled jobs.
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Profile</td>
<td>Grants access to create, read, update, and delete for the Employee Profile</td>
<td>• None</td>
</tr>
<tr>
<td>admin</td>
<td>table.</td>
<td></td>
</tr>
<tr>
<td>[sn_employee.admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync employee profile from HR profile</td>
<td>(HR Service Delivery only) One-time scheduled job that pulls all users with their corresponding employment_start_date and employment_end_date values from the HR Profile (sn_hr_core_profile) table.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Profile [sn_employee_profile]</td>
<td>Employee Profile table.</td>
</tr>
</tbody>
</table>

Response templates for HR Service Delivery

You can use response templates with HR Service Delivery to resolve cases faster and more efficiently.

Response templates (formerly known as templated snippets) are reusable messages. You can copy these messages created from these templates to an HR case, task, email, or chat to provide quick and consistent messages to employees. For example, a response template for a payroll discrepancy case enables HR agents to use a standardized message when responding to that case type.

Note: For more information on response templates, see Response templates.

Response template channels

Response templates can correspond to multiple channels. A channel represents the media you want the response template to be available for. For example:

• Chat channel: Provides response templates for chat conversations.
• Email channel: Provides response templates for emails.
• Form: Provides response templates for HR case or tasks.

If you create a new response template and do not assign it to a channel, it is not available to use.
To create a universal response template that is available for all channels, assign it to all channels.

**Note:** Any response templates created prior to the Quebec release are associated with all channels preserving their prior behavior and can be used universally.

**Activation information**
The response templates feature automatically activates when Case and Knowledge Management activates. See [Activate response templates](#).

To use response templates in a chat in Agent Workspace for HR Service Delivery, activate:

- Advanced Work Assignment for HRSD (com.sn_hr_awa) plugin

For more information, see [Advanced Work Assignment (AWA) for HR Service Delivery Agent Workspace overview](#) and [Setting up chat in workspace](#).

For more information on setting up chat in Virtual Agent, see [Virtual Agent](#).

**How to use response templates with form (HR case or task)**

HR administrators and managers can create response templates. Each template is associated with an HR table that is an extension of the Task [task] table. Configure the template to include variables pulled from that table. Also, use a condition builder to specify what a case must meet for the template to be available, such as for a specific HR service.

For more information on creating or modifying a response template, see [Create or modify an HR Service Delivery response template](#).

Response templates appear for an HR case form for templates associated with the Form channel and satisfy the conditions on the response template. For the HR case form, the Responses button appears at the top. If there are multiple templates available, you can select the appropriate one. See [Work an HR case](#).

**Note:** For more information on using a response template with an HR case, see [Copy a response template to an HR case](#).

For Agent Workspace for HR Service Delivery, the Response Templates icon ( ) appears in the Contextual sidebar. For more information, see [Response template for HR Service Delivery Agent Workspace](#).

**Components installed with response templates**

Several types of components are installed with activation of the Templated Responses (com.sn_templated_snip) plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

Demo data is available for this feature.

**Roles installed**

By default, the following HR roles contain the following response template roles.

**Note:** The Templated Responses [com.sn_templated_snip] plugin activates the sn_templated_snip.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Response Template admin user by requiring a minimum number (default is two) of active users with this role.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response templates administrator&lt;br&gt;[sn_templated_snip.template_snippet_admin]</td>
<td>Grants access to scoped administration of the response templates feature.</td>
<td>• sn_templated_snip.template_snippet_writer&lt;br&gt;• sn_templated_snip.template_snippet_reader&lt;br&gt;• sn_templated_snip.template_snippet_admin</td>
</tr>
<tr>
<td>Response templates writer&lt;br&gt;[sn_templated_snip.template_snippet_writer]</td>
<td>Grants access to create, read, update, and delete (CRUD) response template content.</td>
<td>• sn_templated_snip.template_snippet_reader&lt;br&gt;• None</td>
</tr>
<tr>
<td>Response templates reader&lt;br&gt;[sn_templated_snip.template_snippet_reader]</td>
<td>Grants access to read response template content.</td>
<td></td>
</tr>
</tbody>
</table>

You can assign these roles to the appropriate roles, groups, or users in your application.

• To assign a role to another role, see Add a role to an existing role.
• To assign a role to a group, see Assign a role to a group.
• To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Template&lt;br&gt;[sn_templated_snip_note_template]</td>
<td>Table for .</td>
</tr>
<tr>
<td>M2M Response Template to Channel&lt;br&gt;[m2m_response_template_to_channel]</td>
<td></td>
</tr>
<tr>
<td>Response Template Channel&lt;br&gt;[sn_templated_snip_channel]</td>
<td></td>
</tr>
<tr>
<td>Note Template for Table&lt;br&gt;[sn_m2m_note_template_for_table]</td>
<td></td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see Table administration.
Create or modify an HR Service Delivery response template

Create or modify a response template (formerly known as a templated snippet) to define a reusable message. You can copy these messages when responding to employees to provide quick and consistent messages.

Before you begin
Role required: sn_hr_core.manager, sn_templated_snip.template_snippet_admin

Each template is associated with an HR table that is an extension of the Task [task] table. The template can be configured to include variables pulled from that table. Also, use condition builder to define when a case meets the criteria for a template, such as for a specific HR service.

Procedure
1. Navigate to **HR Administration > Response template configuration**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

### Response template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the response template.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Short description that identifies the response template when using chat in Agent Workspace. Use the short name with a quick command (/) to show the text from the template body of the response template while in chat. This feature provides a fast and consistent way to populate text while in chat. For example, the short name gm identifies the chat response template for a Good Morning greeting. Enter /gm in a chat window to show the text from this response template.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table that the response template is associated with.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that determine when the response template is available for use.</td>
</tr>
</tbody>
</table>

**Note:** If you are creating a response template for Agent Workspace chat, the associated table is the Interaction [interaction] table. For other response templates, the table must be an extension of the Task [task] table.

**Note:** The conditions available depend on the table you select. For chat response templates, specify the condition: `[Type] [is] [Chat]`
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>The application that created the response template.</td>
</tr>
<tr>
<td>Group visibility</td>
<td>Indicates what groups have access to the response template. Adding groups filters who can view the response template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Leaving this field empty makes the response template available to all groups.</td>
</tr>
</tbody>
</table>
| Template body         | Text of the response template providing instructions to the agent on how to respond to a specific case or task.  
                          You can reference field values by selecting variables from the variables list based on the table you select.  
                          You can manually enter custom variable references:  
                          • Current user: ${current_user}  
                          • Current date: ${Date}  
                          Or, place your mouse where you want the custom variable reference to appear and select the **Insert Current User** or **Insert Current Date** buttons. |
|                       | **Note:** Response templates do not support rich text.                      |
| Select variables      | Variables you can add to the template body.                                 |
|                       | **Note:** The variables available depend on the table you select.          |

**Example**

The following GIF shows an example of an HR manager in the HR Service Delivery application creating a response template to escalate payroll discrepancy cases. The template is associated with the HR Payroll Case [sn_hr_core_case_payroll] table, and a condition is set to filter on cases that match the Payroll Discrepancy HR service. The template text is pasted into the body, and then a variable for the subject person is added to the salutation.
4. Click **Submit** or **Update**. The Channels related list appears. Channels limit the response template to only the channels you add. If you leave this blank, the response template is available to no channels. This feature allows you to have different messages for chats, emails, or form. For more information, see Create a response template channel.

**What to do next**
You can copy response template content to any field on a form that meets the specified conditions.

The following GIF shows an example of an HR case writer in the HR Service Delivery application opening a payroll discrepancy case and copying a payroll discrepancy escalation template to the comments field in the HR case form for the employee to read.
Create a response template channel

Follow these steps to create a response template channel. Response template channels ensure the correct response templates appear for use with chat, email, or HR case or task.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **HR Administration > Response Template Configuration**.
2. Select an existing response template or click **New**.
3. Select **Channels**.
4. Select the **Lookup using list** icon.
5. Select **New**. Fill in the fields on the form.

### Response Template Channel

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the channel. Channels represent a category you want the response template to appear for. The base system provides:</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Form</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Value</td>
<td>The name of the channel you want to remain consistent in relation to different languages. For example, if I am working in French, the <strong>Name</strong> field could be LeChat, but Chat in the <strong>Value</strong> field. This ensures that the correct template is selected regardless of language.</td>
</tr>
<tr>
<td>Application</td>
<td>The application the response template is available to use in.</td>
</tr>
<tr>
<td>Active</td>
<td>Activates the Response Template Channel. <strong>Note:</strong> Unchecking the box inactivates the record without deleting it.</td>
</tr>
</tbody>
</table>

6. Select **Save**. The Channels related list appears. Channels limit the response template to only the channels you add. If you leave this blank, the response template is available to all channels. This feature allows you to have different messages for chats, emails, or form.

7. Click **New** to create a new channel or **Edit** to access an existing channel.

8. After you select the channel(s), click **Save**. The **Response Template** form returns.

9. Click **Update**. For more information on response templates, see Create or modify an HR Service Delivery response template.

**Copy a response template to an HR case**
Copy response template (formerly known as templated snippet) content to any field on an HR case form that meets the specified conditions.

**Before you begin**
Role required: sn_hr_core.case_writer

**Procedure**

1. Navigate to **HR Case Management > All HR Cases**, and open one of the modules, such as **Assigned to me** or **Open**.

2. Open the HR case.

3. Click **Responses** to open the **Response Templates** side panel.

   **Note:** If the **Responses** button is not visible, make sure that a response template that meets the conditions for the open case is available to use. See Create or modify an HR Service Delivery response template for more information.
4. In the **Response Templates** side panel, you can select a template and copy it to the clipboard.

5. Once copied, you can paste the content to a field on the form, such as to **Comments**, or into an email that you send to the employee.

⚠️ **Note:** For information on using response templates in HR Agent Workspace, see [Use Response templates on an HR case](#).

### HR Profile

The HR Profile application stores confidential employee data, such as name, personal contact information, email addresses, employment history, and contacts, in the scoped version of HR.

HR Profile enables the organization to access and track employee information throughout the period of employment and beyond. HR profile records are associated with user records, but unlike user records, HR profile records are stored confidentially and are not publicly viewable.

Organizations can use an integration method to populate or synchronize HR profile records from their employee database.

The fields that are editable by employees are defined in **HR Properties** under **HR profile fields editable by users**. See [HR properties](#).
HR profile editable field configuration

An option in Human Resources Configuration provides a list of HR profile fields that can be enabled for edit. Understand the difference between how the personal and the employment information fields are updated in the HR profile based on this configuration.

Typically, organizations allow employees to update certain personal information, but not sensitive and employment information. HR agents or managers change this information. For example, employees can change their home address and personal email address, but the manager must update the position when the employee is promoted.

The **HR profile fields that users or managers can edit without HR approval include** <number of fields> option in Human Resources Configuration provides the list of editable HR profile fields. The following list of fields indicates which of the configurable fields contain personal and which contain sensitive and employment information.

<table>
<thead>
<tr>
<th>Personal information fields</th>
<th>Sensitive and employment information fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Home address</td>
<td>• Date of birth</td>
</tr>
<tr>
<td>• Home city</td>
<td>• Department</td>
</tr>
<tr>
<td>• Home country</td>
<td>• Employee number</td>
</tr>
<tr>
<td>• Home phone</td>
<td>• Employment end date</td>
</tr>
<tr>
<td>• Home state/province</td>
<td>• Employment start date</td>
</tr>
<tr>
<td>• Home zip/postal</td>
<td>• Employment status</td>
</tr>
<tr>
<td>• Middle name</td>
<td>• Employment type</td>
</tr>
<tr>
<td>• Personal email</td>
<td>• Ethnicity</td>
</tr>
<tr>
<td>• Personal mobile phone</td>
<td>• First name</td>
</tr>
<tr>
<td>• Prefix</td>
<td>• Gender</td>
</tr>
<tr>
<td>• Work email</td>
<td>• Last name</td>
</tr>
<tr>
<td>• Work mobile</td>
<td>• Location</td>
</tr>
<tr>
<td>• Work phone</td>
<td>• Location type</td>
</tr>
</tbody>
</table>

In the configuration option field list, all the personal information fields are enabled for edit by default. All employees can open their HR profile from the HRSM Portal and update these fields. If you do not want to allow employees to update one or more of these fields, disable editing by clearing the check box in the configurable list. For example, you do not want employees updating their work email address or phone number.
ACLs control the HR profile personal information fields, which can be modified for more controlled access.

You must have the `sn_hr_core.secure_info_reader` role to view the Social Security field on an HR profile. This role is contained in the `sn_hr_core.manager` role.

The employment information fields that you enable for edit allows a manager to update the field. However, the manager cannot open an employee HR profile. The manager must submit an employee information change request with the updated information. When the request to change the editable fields is submitted, the HR Employee Change Workflow takes the following actions.

- Opens an HR case.
- Updates the employee HR profile.
- Closes the HR case.

To update any HR profile fields that are not editable, employees or their managers submit an employee information change request. An HR case is created and the HR Employee Change Workflow is started. The workflow requires that the change request is approved. When it is approved, the fields are updated and the HR case is closed.

**At a Glance panel in Agent Workspace for HR Service Delivery**

The fields that appear on the **At a Glance** panel in Agent Workspace for HR Service Delivery are dependent on what fields appear in an HR profile.

⚠️ **Note:** Fields with no data on the HR profile do not appear in the **At a Glance** panel.

If you want additional fields to appear on the **At a Glance** panel, see Configuring the form layout.

**Related information**

- **HR Profile**

**HR profile and HR case security**

Because HR profile information is sensitive and confidential, the System Administrator [admin] cannot view it. The same is true for some of the information in HR cases and HR tasks.

HR administrators `[sn_hr_core.admin]` are able to perform all tasks and view all data. However, HR profile information is confidential and viewed only by authorized HR personnel who are assigned a role that includes `sn_hr_core.profile_reader` or `sn_hr_core.profile_writer`, such as `hr_basic`.

For HR cases and HR tasks, only authorized HR personnel are allowed to view attachments, work notes and comments, description, calendar, and payload (configurable). Authorized HR personnel are assigned a role with `sn_hr_core.case_reader` and `sn_hr_core.case_writer`, such as `sn_hr_core.basic`.

Therefore, access to specific HR profile, case, and task data is restricted from view by users with the HR system admin role.

**HR profile information that system administrators can access**

System Administrators cannot create an HR profile. They can see the list of HR profiles and open HR profile records, but only have access to the following information.

- The HR profile number and prefix of an employee.
- Employment information that is synchronized with the user record [sys_user]. This information includes name, employee number, department, manager, and location.
• Work contact information, such as work email address and work phone number. Personal information is hidden.
• Information that appears in the following related lists.
  ◦ Employment Information
  ◦ Contact Information
  ◦ Beneficiaries
  ◦ Who is Covered
  ◦ Emergency Contacts
  ◦ Direct Reports
  ◦ Colleagues
  ◦ Cases

**HR case and task information accessible by HR Administrators**

HR Administrators can view the employee user information, such as location and department, and the short description. Activities, such as state changes, are displayed in the activity stream, but comments and work notes are hidden. System Administrators cannot view this information.

When the HR Administrator opens an HR case or HR task, a message describes the information that is not displayed.

An HR case can be created from an HR profile. Click **Create New Case** under Related Links and **Case Creation** appears.

**Impersonating a user**

You can prevent a user from accessing HR information by impersonating a user that has HR access by using the **If true, ACLs check if the user is being impersonated.** property.

• Navigate to **HR Administration > Properties**.
• Scroll to **If true, ACLs check if the user is being impersonated.**
• Check **Yes** (true) to enable ACLs to check when a user is impersonating another user and prevent the user from viewing HR information.

• Even if the logged in user has HR access and impersonates another HR user with the same access, HR information is not visible.

[Note: This property was introduced for the HR Service Delivery scoped application and not applicable to the HR Services Delivery Non-scoped application.]

See **Add field security in HR.**
See **Restricted caller access for HR.**
See **Manage HR roles.**

**Customized profile information**

As part of designing the HR processes, you can customize the way HR profile information is processed. Keep in mind that some of the fields that appear are referenced from the User [sys_user] table.

If you have the **sn_hr_core.admin** role, you can customize HR profile information.
Extend profile information

You can collect more profile information in a separate table. For example, you can create a Dependents table that extends the HR Profile [hr_profile] table.

Because profile information is sensitive and confidential, the system administrator cannot view it. For more information, see HR profile and HR case security.

Associate profiles with user records

An HR profile record must be associated with the employee record in the User [sys_user] table, to ensure that both employee records can be accessed conveniently. During the creation of an HR profile record, you can select the user record to associate with the profile.

Certain fields are displayed in both the user and HR profile records, but they are in only one of the tables, User [sys_user] or HR Profile [hr_profile]. The following fields are in the User [sys_user] table.

- Prefix [introduction]
- First name [first_name]
- Middle name [middle_name]
- Last name [last_name]
- Manager [manager]
- Department [department]
- Location [location]
- Employee number [employee_number]

*Note:* Bot phone number sync is not supported.

The following table describes the other fields that are synchronized by the Synchronize fields to hr_profile business rule.

<table>
<thead>
<tr>
<th>Fields synchronized using the business rule</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HR profile [hr_profile] field</strong></td>
</tr>
<tr>
<td>Position [position]</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Home address [address]</td>
</tr>
<tr>
<td>Country [country]</td>
</tr>
<tr>
<td>Work email [work_email]</td>
</tr>
</tbody>
</table>
Note: The User form must be configured to show address, country, and email fields.

Add field security in HR
You can secure a field on a form so that specific HR users cannot view it.

Before you begin
Role required: sn_hr_core.admin, security_admin

About this task
Use Access Control (ACL) on a field to secure it.

Note: This example shows how to secure the Ethnicity field on an HR Profile form so users with the HR Manager [hr_manager] role or below cannot view it.

Procedure
1. Navigate to HR Profile.
2. Elevate your role to add security_admin. Select your login name and select Elevate
   ![Elevate Roles](image)
3. Check security_admin.
4. Select OK.
5. Select an HR profile record to edit. It can be any record.
6. Right-click the **Ethnicity** field and select **Configure**.

![Configure Security](image)

7. The **Security Mechanic** menu appears. Change the **Operation to secure** field to **read**.

![Security Mechanic](image)

8. Move a role that you want to view the field to the **Selected** column. For example, move **sn_hr_core.admin**.

By selecting **read** and adding **sn_hr_core.admin**, any role below this role, cannot read the field. For example, **sn_hr_core.manager** is below this role and cannot view this field after completing the steps.

9. Click **OK**.

Because HRSM is a scoped application, you have to ensure that you are in the scoped version within the form.
• Click the Settings icon.
• Select Developer under System Settings.
• Change Application to Human Resources:

![Developer settings](image)

• Close the window.

**Related information**

**Access control list rules**

**Add or modify an HR profile**

Employees can directly edit some information in their HR profile, such as emergency contact information, but they are restricted from editing certain fields. If employees want to change information that they are restricted from editing, they must submit a general request to HR for the changes.

**Before you begin**

Role required: sn_hr_core.secure_info_writer, sn_hr_core.basic, or sn_hr_core.manager

**About this task**

The HR Administrator [sn_hr_core.admin] can configure which HR profile fields an employee can update. An update to information that the employee cannot change requires an HR employee information change request.

1. Navigate to **HR Profile > HR Profiles**.

**Procedure**

The HR Profiles list opens.
2. Find the existing HR profile to update by selecting User from the HR Profiles list search menu, typing the name, and pressing Enter. Also, you can click a profile number to open a user profile. From HR Profiles, select New and type the user name in the User field on the HR Profile New record form to create the profile. You cannot change the user name after an HR profile is saved.

3. Click the profile number to open the user profile. The profile opens displaying populated name, manager, department, location, and contact fields from the user record.

4. Complete or update the form with as much additional information as you have.

<table>
<thead>
<tr>
<th>Section or related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned profile ID number, which cannot be changed.</td>
</tr>
<tr>
<td>User</td>
<td>The user associated with the profile. Click the Lookup using list icon and New to create a user.</td>
</tr>
<tr>
<td>Prefix</td>
<td>Click and select the personal title of the user.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the user, pulled from the user record.</td>
</tr>
<tr>
<td>Middle name</td>
<td>Middle name of the user, pulled from the user record.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of the user, pulled from the user record.</td>
</tr>
<tr>
<td>Gender</td>
<td>Select the gender of the user.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to indicate that the user is a current employee for your company.</td>
</tr>
<tr>
<td>Legal hold</td>
<td>Indicates that the HR profile is under legal hold and all associated employee documents cannot be deleted.</td>
</tr>
<tr>
<td></td>
<td>• Click the Add Legal Hold button in the form header.</td>
</tr>
<tr>
<td></td>
<td>• Select a Reason.</td>
</tr>
<tr>
<td></td>
<td>• Enter comments.</td>
</tr>
<tr>
<td></td>
<td>• Click OK.</td>
</tr>
<tr>
<td></td>
<td>To remove an HR profile from legal hold, click the Remove Legal Hold button in the form header.</td>
</tr>
<tr>
<td>Date of birth</td>
<td>Click the Select Date icon and select the birth date of the user.</td>
</tr>
<tr>
<td>Place of birth</td>
<td>Enter the location the user was born.</td>
</tr>
<tr>
<td>Country of birth</td>
<td>Select the country the user was born.</td>
</tr>
<tr>
<td>Marital status</td>
<td>Select the marital status of the user.</td>
</tr>
<tr>
<td>Nationality</td>
<td>Enter the nationality or nation in which the user is a citizen.</td>
</tr>
<tr>
<td>Ethnicity</td>
<td>Enter the ethnic group the user identifies with.</td>
</tr>
<tr>
<td>Section or related list</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Ready to return to workplace</td>
<td>Identifies if the employee is ready to return to work. Works with Enterprise Employee Experience Packs for employees working from home during a health crisis. Select <strong>Yes</strong> and the employee is included in campaigns and lifecycle events related to returning to work. Select <strong>I'm not sure</strong> and the employee is included in some of the lifecycle events related to returning to work. An HR task triggers for HR to review the employee's concerns. For more information, see Enterprise Employee Experience Pack.</td>
</tr>
<tr>
<td>Return to workplace date</td>
<td>Works with the <strong>Ready to return to workplace</strong> field. Select a date when the employee plans to return to work.</td>
</tr>
<tr>
<td>Employment Information</td>
<td>Information such as employment status and type of employment, employee number, and start and end dates.</td>
</tr>
<tr>
<td>Employment start date</td>
<td>For onboarding employees, click the <strong>Select Date</strong> icon and select the first day of employment.</td>
</tr>
<tr>
<td>Employment end date</td>
<td>For offboarding employees, click the <strong>Select Date</strong> icon and select the last day of employment.</td>
</tr>
<tr>
<td>Employment type</td>
<td>Select the employment type for the user.</td>
</tr>
<tr>
<td>Probation period</td>
<td>Enter the period the user is on probation.</td>
</tr>
<tr>
<td>Probation end date</td>
<td>Enter the date probation ends for the user.</td>
</tr>
</tbody>
</table>
| Leave status | The status of the employee if leave was requested. Values are:  
  • Requested  
  • Approved  
  • On Leave  
  • Rejected  
  • Completed  
  • Cancelled |
| Position | Click and select the job title for the user. |
| Department | Select the department the user belongs to. |
| Manager | Select the manager the user reports to. |
| Location | Select the office location of the user. |
| Location type | Select the location type of the user to further define the location. |
| Offboard type | For employees offboarding, click, and select the type of employment termination. |
### Section or related list | Description
--- | ---
Notice period | For companies that require notice before dismissing an employee. Enter the time period between receipt of the letter of dismissal and the end of the last working day.
Employee number | Enter the employee number of the user.
Social Security number | Enter the social security number of the user.
Contact Information | Information such as address, phone number, personal email address. Some field values are copied from the onboarding form.

#### The following related links are available:
- **Create new case**
  - Click to create an HR case for the HR profile displayed.
- **Show employee org chart**
  - Click to view the organization chart of the employee.
- **View Manager Profile**
  - Click to view the HR profile of the manager of the employee.

#### The following related lists are automatically populated.
- **Beneficiaries**
  - A list of beneficiaries associated with the employee. Click **New** to create a beneficiary.
- **Who is covered**
  - A list of people who are covered under the benefits for the employee.
- **Emergency Contacts**
  - A list of the employee emergency contacts. One contact in the list is designated as the primary and others can be entered as alternates.
- **Employee Documents**
  - Lists all HR employee documents associated with the HR profile. **Note:** This tab only appears when the **Employee access** field is checked from the **Document Type** form.
- **Direct Reports**
  - List of the employees who report directly to the user.
- **Colleagues**
  - List of other employees who have the same manager as the user.
- **Cases**
  - Open HR cases for the user.
- **Legal Holds**
  - Lists legal or litigation holds on any employee-related documentation. Click **Add Legal Hold** or **New** to place documents associated with the employee on legal hold.

5. Click **Submit** and return to the **HR Profiles** list page or **Save** and remain on the **HR Profile** form.

**Note:** Some HR profile information, such as department, is synchronized between the User [sys_user] and HR Profile [hr_profile] records. Updating information in one record automatically applies the updates in the other record.
Add or modify contacts for HR
You can add or modify contact information to an HR profile and specify who to contact in an emergency through the Contacts module or related list.

Procedure
1. Navigate to HR Profile > HR Profiles.
2. Click New or an existing contact.
3. Enter or modify the contact name, telephone numbers, and other information.
4. In the Employee field, click and select the employee that the contact is associated with.
5. To specify the person as an emergency contact, check the Emergency contact box. The Priority field appears.
6. Select the priority of the contact, Primary, or Alternate.
7. Click Submit and return to the HR Contacts list or Save and remain on the HR Contact form.

Who is covered
You can create or modify who is covered under an employee benefit plan using the HR Health Benefits module.

About this task
Employees request to create or modify who is covered under their benefit plan by submitting a request through the HR Service Portal. Once a contact is added to the HR application, HR agents can add a contact as a beneficiary to an employee benefit record.

Procedure
1. Navigate to HR Profile > Who is covered.
2. Click New or an employee to open a record.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>The user who submitted the case. Click the Lookup using list icon and select the employee.</td>
</tr>
<tr>
<td>Contact</td>
<td>Click the Lookup using list icon to view a list of contacts for the employee. Click New to enter a new contact for the employee. You can specify the relationship to the employee and emergency contact here.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the beneficiary. Displays from Contact information.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of beneficiary. Displays from Contact information.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Relationship to the employee.</td>
</tr>
<tr>
<td>National tax ID</td>
<td>Social security number of the beneficiary or tax ID number for a trust account.</td>
</tr>
<tr>
<td>Date of birth</td>
<td>Beneficiary birth date.</td>
</tr>
<tr>
<td>Gender</td>
<td>Gender of the person being covered.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
The person covered is listed in the **Who is covered** list.

5. To modify who is covered data, use the **Who is covered** list.
   You can use the list search menu by typing the who is covered name and pressing Enter.
   You can also search on the employee name the same way.

6. Click the who is covered name to open the form.
The **Who is covered** form opens displaying full name and other populated fields.

7. Modify the form.

8. Click **Update**.

**Add or modify a beneficiary**
You can create or modify an employee beneficiary using the Beneficiaries module.

**About this task**
Employees request to create or modify a beneficiary to a particular benefit plan by submitting a request through the HR Service Portal. A beneficiaries case is opened and can be viewed and managed at **HR Profile > Beneficiaries**.

**Procedure**
1. Click **New** or a beneficiary to open a beneficiary record.
2. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

### HR Beneficiary form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>The user who submitted the case. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Contact</td>
<td>Click the <strong>Lookup using list</strong> to view a list of contacts for the employee. Click <strong>New</strong> to enter a new contact for the employee. You can specify the relationship to the employee and emergency contact here.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the beneficiary. Displays from <strong>Contact</strong> information.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of beneficiary. Displays from <strong>Contact</strong> information.</td>
</tr>
<tr>
<td>Date of birth</td>
<td>Beneficiary birth date.</td>
</tr>
<tr>
<td>National tax ID</td>
<td>Social security number of the beneficiary or tax ID number for a trust account.</td>
</tr>
<tr>
<td>Trust</td>
<td>Check if the beneficiary is a trust.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Relationship to the employee.</td>
</tr>
<tr>
<td>Benefit type</td>
<td>Type of benefit, such as, 401(k), Basic Life, Retirement Plan, or Voluntary Life.</td>
</tr>
<tr>
<td>Beneficiary type</td>
<td>Primary or contingent.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage amount of the benefit distributed to the beneficiary.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
The beneficiary is listed in the HR Beneficiaries list.
4. To modify beneficiary data, find the existing beneficiary in the HR Beneficiaries list. You can use the list search menu by typing the beneficiary name and pressing Enter. You can also search on the employee name the same way.

5. Click the beneficiary name to open the form. The HR Beneficiary form opens displaying full name and other populated fields.

6. Modify the form.

7. Click Update.

Add or modify a health benefit
You can add or modify a health benefit for an employee using the Health Benefits module.

Before you begin
Role required: sh_hr_core.basic, or sn_hr_core.manager

About this task
Employees can ask questions about health benefits and request to enroll or modify a health insurance plan by submitting a request through the HR Service Portal. A health benefits case is opened and can be viewed and managed at HR Profile > Health Benefits.

Procedure
1. Navigate to HR Profile > Health Benefits.
2. Click New to open a health benefit record.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan</td>
<td>The name of the insurance plan. Click the Lookup using list icon and select the plan for the employee.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the Lookup using list icon and select the user.</td>
</tr>
<tr>
<td>Benefit type</td>
<td>The type of health benefit plan selected. Fills in when the plan is selected.</td>
</tr>
<tr>
<td>Provider</td>
<td>The health care company that provides the health benefit plan. Fills in when the plan is selected.</td>
</tr>
<tr>
<td>Plan type</td>
<td>The type of health benefit plan. Fills in when the plan is selected.</td>
</tr>
<tr>
<td>Plan ID</td>
<td>The membership/enrollment ID number of the employee.</td>
</tr>
<tr>
<td>Coverage type</td>
<td>The type of health coverage the plan provides to the employee.</td>
</tr>
<tr>
<td>Enrollment form</td>
<td>The enrollment form the employee attached for enrollment or modification.</td>
</tr>
<tr>
<td>Who is covered</td>
<td>List of family members of the employee covered under the health benefit.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>Employer Contribution (per paycheck)</td>
<td>Dollar amount employer contributes to plan per paycheck.</td>
</tr>
<tr>
<td>Employer Contribution (per year)</td>
<td>Dollar amount employer contributes to plan per year.</td>
</tr>
<tr>
<td>Employee Contribution (per paycheck)</td>
<td>Dollar amount employee contributes to plan per paycheck.</td>
</tr>
<tr>
<td>Employee Contribution (per year)</td>
<td>Dollar amount employee contributes to plan per year.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   
   The health benefit is listed in the **HR Health Benefits** list.

5. To modify health benefit data, find the existing health benefit in the **HR Health Benefits** list. You can use the list search menu by typing the employee name and pressing Enter.

6. Click the health benefit to open the form.
   
   The **HR Health Benefit** form opens displaying benefit name and other populated fields.

7. Modify the form.

8. Click **Update**.

---

**Add or modify Life, AD&D insurance benefits**

You can add or modify an insurance benefit for an employee using the HR Benefits module.

**Before you begin**

Role required: sn_hr_core.basic, or sn_hr_core.manager

**About this task**

Employees can ask questions about insurance benefits and request to enroll in or modify an insurance plan by submitting a request through the HR Service Portal. An insurance benefits case is opened and can be viewed and managed.

**Procedure**

1. Navigate to **HR Profile > Life, AD&D Insurance Benefits**.

2. Click **New** to open an insurance benefit record.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

**HR Insurance Benefit form**

<table>
<thead>
<tr>
<th>Description</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>The name of the insurance plan. Click the Lookup using list icon and select the plan for the employee.</td>
<td>Plan</td>
</tr>
<tr>
<td>The user who requested enrollment. Click the Lookup using list icon and select the user.</td>
<td>Employee</td>
</tr>
<tr>
<td>Description</td>
<td>Field</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>The membership/enrollment ID number of the employee.</td>
<td>Plan ID</td>
</tr>
<tr>
<td>The life insurance company that provides the insurance benefit. Fills in</td>
<td>Provider</td>
</tr>
<tr>
<td>when the plan is selected.</td>
<td></td>
</tr>
<tr>
<td>The type of insurance plan. Fills in when the plan is selected.</td>
<td>Plan type</td>
</tr>
<tr>
<td>Enter the coverage type of the plan. An example is Family Coverage or Individual Plan.</td>
<td>Coverage type</td>
</tr>
<tr>
<td>Not all insurance plans have coverage type.</td>
<td></td>
</tr>
<tr>
<td>The period the insurance policy covers.</td>
<td>Term</td>
</tr>
<tr>
<td>Click the <strong>Lookup using list</strong> icon to search for and select contacts that</td>
<td>Beneficiaries</td>
</tr>
<tr>
<td>are beneficiaries.</td>
<td></td>
</tr>
<tr>
<td>List of family members of the employee covered under the health benefit.</td>
<td>Who is covered</td>
</tr>
<tr>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
<td>Start date</td>
</tr>
<tr>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
<td>End date</td>
</tr>
<tr>
<td>Dollar amount employer contributes to plan per paycheck.</td>
<td>Employer Contribution</td>
</tr>
<tr>
<td>(per paycheck)</td>
<td>(per paycheck)</td>
</tr>
<tr>
<td>Dollar amount employer contributes to plan per year.</td>
<td>Employer Contribution</td>
</tr>
<tr>
<td>(per year)</td>
<td>(per year)</td>
</tr>
<tr>
<td>Dollar amount employee contributes to plan per paycheck.</td>
<td>Employee Contribution</td>
</tr>
<tr>
<td>(per paycheck)</td>
<td>(per paycheck)</td>
</tr>
<tr>
<td>Dollar amount employee contributes to plan per year.</td>
<td>Employee Contribution</td>
</tr>
<tr>
<td>(per year)</td>
<td>(per year)</td>
</tr>
</tbody>
</table>

4. Click **Submit**.  
The insurance benefit is listed in the **HR Insurance Benefits** list.

5. To modify insurance benefit data, find the existing insurance benefit in the **HR Insurance Benefits** list.  
You can use the list search menu by typing the employee name and pressing Enter.

6. Click the health benefit to open the form.  
The **HR Insurance Benefit** form opens displaying benefit name and other populated fields.

7. Modify the form.

8. Click **Update**.

**Add or modify a retirement benefit**

You can add or modify a retirement benefit for an employee using the **Retirement Benefits** module.

**Before you begin**
Role required: sn_hr_core.basic or sn_hr_core.manager
About this task
Employees can ask questions about retirement benefits and request to enroll in a retirement benefit plan by submitting a request through the HR Service Portal. A retirement benefits case is opened and can be viewed and managed.

Procedure
1. Navigate to **HR Profile > Retirement Benefits**.
2. Click **New** to open a retirement benefit record.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

**HR Retirement Benefit form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan</td>
<td>The name of the insurance plan. Click the <strong>Lookup using list</strong> icon and select the plan for the employee.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the <strong>Lookup using list</strong> icon and select the user.</td>
</tr>
<tr>
<td>Plan ID</td>
<td>The identification number of the insurance plan.</td>
</tr>
<tr>
<td>Provider</td>
<td>The financial company that provides the retirement benefit. Fills in when the plan is selected.</td>
</tr>
<tr>
<td>Plan type</td>
<td>The type of retirement plan selected.</td>
</tr>
<tr>
<td>Coverage type</td>
<td>Enter the coverage type of the plan. An example is Family Coverage or Individual Plan. Not all retirement plans have coverage type.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>Employee contribution percent</td>
<td>Percentage deducted from the employee paycheck toward the benefit.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. The retirement benefit is listed in the HR Retirement Benefits list.
5. To modify retirement benefit data, find the existing retirement benefit in the HR Retirement Benefits list. You can use the list search menu by typing the employee name and pressing Enter.
6. Click the retirement benefit to open the form. The HR Retirement Benefits form opens displaying benefit name and other populated fields.
7. Modify the form.
8. Click **Update**.

Add or modify disability insurance benefits
You can add or modify a disability insurance benefit for an employee using the Disability Insurance Benefits module.
Before you begin
Role required: sn_hr_core.basic, or sn_hr_core.manager

About this task
Employees can ask questions about disability insurance benefits or be enrolled in or modify their disability insurance program. A disability insurance benefits case is opened and can be viewed and managed.

Procedure
1. Navigate to HR Profile > Disability Insurance Benefits.
2. Click New to open a disability benefit record.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan</td>
<td>The name of the disability insurance plan. Click the <strong>Lookup using list</strong> icon and select the plan for the employee.</td>
</tr>
<tr>
<td>Plan type</td>
<td>The type of health benefit plan. Fills in when the plan is selected.</td>
</tr>
<tr>
<td>Plan ID</td>
<td>The identification number of the health plan.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the <strong>Lookup using list</strong> icon and select the user.</td>
</tr>
<tr>
<td>Employee Contribution (per paycheck)</td>
<td>Dollar amount employee contributes to plan per paycheck.</td>
</tr>
<tr>
<td>Employee Contribution (per year)</td>
<td>Dollar amount employee contributes to plan per year.</td>
</tr>
<tr>
<td>Employer Contribution (per paycheck)</td>
<td>Dollar amount employer contributes to plan per paycheck.</td>
</tr>
<tr>
<td>Employer Contribution (per year)</td>
<td>Dollar amount employer contributes to plan per year.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. The health benefit is listed in the **HR Disability Benefits** list.

5. To modify insurance benefit data, find the existing insurance benefit in the **HR Disability Benefits** list. You can use the list search menu by typing the employee name and pressing Enter.

6. Click the amount under the **Employee Contribution** column to open the form. The **HR Disability Benefit** form opens displaying benefit name and other populated fields.

7. Modify the form.

8. Click **Update**.
Generate HR Profiles

For new customers using HR Service Delivery, you can create an HR profile for multiple employees using conditions and criteria.

Before you begin
Role required: sn_hr_core.basic or sn_hr_core.manager

Procedure

1. Navigate to HR Profile > Generate HR Profiles.
   The Generate HR Profiles form opens.

2. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Users</td>
<td>Click and select the conditions that must be met for an employee to be assigned the profile.</td>
</tr>
<tr>
<td>Profiles</td>
<td>Click and select the type of profile for employees that meet the conditions.</td>
</tr>
</tbody>
</table>

3. Click Create Profiles.

Add or modify an employee direct deposit

You can add or modify an employee direct deposit using the Direct Deposit module.

Before you begin
Role required: sn_hr_core.basic or sn_hr_core.manager

About this task

Procedure

1. Navigate to HR Profile > Direct Deposit.

2. Click New to open an HR direct deposit record.

3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>HR Profile Direct Deposit form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>Employee</td>
</tr>
<tr>
<td>Bank account</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Deposit type</td>
</tr>
<tr>
<td>Deposit amount</td>
</tr>
</tbody>
</table>
Add or modify tuition reimbursement
You can add or modify a tuition reimbursement for an employee using the HR Benefits module.

Before you begin
Role required: sn_hr_core.basic, or sn_hr_core.manager

About this task
Employees can ask questions about approved courses and classes and request tuition reimbursement by submitting a request through the HR Service Portal. A tuition reimbursement case is opened and can be viewed and assigned at HR Benefits > Tuition Reimbursements.

Procedure
1. Navigate to HR Benefits > Tuition Reimbursements > Tuition Reimbursements. The HR Benefit Tuition Reimbursements list opens.
2. Click New to open an HR tuition reimbursement record.
3. Complete the form. (The fields you see depend on how the form is configured and what fields are selected to display.)

HR Tuition Reimbursement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>The user who requested tuition reimbursement. Click the Lookup using list icon and select the user.</td>
</tr>
<tr>
<td>School/Program name</td>
<td>Name of the school or program where the employee took the course.</td>
</tr>
<tr>
<td>Course justification</td>
<td>Explanation of why the employee took the course.</td>
</tr>
<tr>
<td>Course start date</td>
<td>Date when the course started.</td>
</tr>
<tr>
<td>Course end date</td>
<td>Date when the course ended.</td>
</tr>
</tbody>
</table>

4. Click Submit. The tuition reimbursement is listed in the HR Tuition Reimbursements list.
5. To modify tuition reimbursement data, find the existing tuition reimbursement in the HR Tuition Reimbursements list. You can use the list search menu by typing the employee name and pressing Enter.

6. Click the tuition reimbursement to open the form. The HR Tuition Reimbursement form opens displaying course title and other populated fields.

7. Modify the form.

8. Click Update.

**HR Case Management**

You use the Case and Knowledge Management application to create, view, or edit HR cases in the scoped version of HR. HR cases are created from HR requests or inquiries related to HR account or systems, benefits, payroll, performance management, reporting, talent acquisition, time and expense reporting, and more.

**Self-Service HR case creation**

From the Employee Service Center (HR Service Portal), employees can inquire or request HR services from the following categories:

- Benefits
- Employee Data Management
- Employee Relations
- General
- HR Systems
- Payroll
- Talent Management
- Visas

An HR case is created when an HR service is requested through the Employee Service Center.

**HR agent case creation**

Employees can inquire about HR services via email, chat, or phone. HR agents can create an HR case based on a Center of Excellence (COE) or HR service.

After an HR case is created, it is assigned to an HR agent and/or an assignment group via the HR service and associated HR template.

HR cases can have one or more associated HR tasks or HR child cases that make up the parent case.

**Example HR request**

An employee named Alan wants to find out about the dental plans offered for his company.

1. Alan submits an HR request through the Employee Service Center asking about one of the dental plans offered.

2. An HR case is created and assigned to an HR agent.

3. The HR agent can answer the inquiry by phone, email, chat, or through the Comments section of the HR case.

4. If the answer satisfies the inquiry, the HR case can be closed.
Create an HR case

Create HR cases for employees or other individuals that require an HR service. Note that employees can also use the HR Service Portal to create HR cases for themselves.

Before you begin
Role required: sn_hr_core.case_writer

About this task
For information about configuring case creation, see Configure how HR cases are created.

Procedure
1. Navigate to HR Case Management > Create New Case. Or, from any case list, click New.
2. Determine the person for whom you are filing the case.

<table>
<thead>
<tr>
<th>Status of the person related to the case</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous employee or external individual</td>
<td>Select Skip verification to create the case without having to enter an employee name or case number. Selecting this option takes you directly to the Case Details section and the Employee information section is not displayed.</td>
</tr>
</tbody>
</table>

**Note:** The Skip verification option is displayed only if Allow skipping verification was selected during the configuration of HR case creation.

<table>
<thead>
<tr>
<th>Status of the person related to the case</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>An employee</td>
<td>Validate the employee by using the Search Employee field to search for the employee. You can search by employee name, case number, or any indexed field on the HR Profile of the sys_user table. Additional information about the employee appears in the Employee Information section to help verify that you are creating an HR case for the correct person.</td>
</tr>
</tbody>
</table>

3. Fill out the information in the Case Details section.

Case Details fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>The Center of Excellence associated with the HR case you are creating. Selecting a COE filters the choices for HR service. See HR Centers of Excellence data model.</td>
</tr>
</tbody>
</table>

**Note:** If an HR service is selected first, the associated COE automatically populates.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR service</td>
<td>The HR service based on the COE selected or what you select based on communication with the employee request. The HR services that are available to an employee are filtered by:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Document Template Type</td>
<td>The category for the document template.</td>
</tr>
<tr>
<td>Document Template</td>
<td>The document template associated to the case to generate document template tasks.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information specific to the case that can help other HR agents. Text in the Work Notes field is not visible to the user named in the Subject person field. The sn_hr_core.restrict_guest_email system property allows a user to send an email from a personal email account referencing an HR case. If this property is set to false (the default), the text from the email appears in the Work notes field.</td>
</tr>
</tbody>
</table>

4. Select the person responsible for the service request in the Opened for field.
   - If the case is being created by the person making the request, the values for Subject person and Opened for are the same.
   - If the case is being created for a different user, for example, a manager filing a case for an employee, use the choice list to select a different user.

5. Select the subject of the case in the Subject person field by selecting the Lookup using list icon (🔍) and searching for and selecting another employee.

6. Click Create Case.

7. Optional: Continue working on the case. For more information, see Work an HR case

Results: The HR case form appears with additional information about the case. The values selected for the COE and HR service fields determine the fields that appear.
Open an HR case to create a Journey Accelerator action plan

Journey Accelerator action plans can be created by opening an HR case with a related lifecycle event.

Before you begin
Role required: sn_hr_core.case_writer

About this task
When the Create Journey Accelerator Action Plan template is configured to automatically create Journey Accelerator action plans, a task is created and assigned to a manager for review.

When the template is not configured to automatically create Journey Accelerator action plans, a to-do task is created. The task is assigned to the manager (Opened for) to create a plan. The to-do contains the following information pre-filled in the plan:

- Who is this plan for (mapped from the subject person)
- Plan type (mapped from the activity)
- Publish date (mapped from the activity)

Procedure
1. Navigate to HR Case Management > Create New Case.
2. Enter the name of the new employee in the Search for Employee field.
3. Fill in the Case Details:
   - COE: HR Lifecycle Events Case
   - HR service: New Hire Onboarding
   - Opened for: managers name
   - Subject person: new hire name
4. Click Create Case.
5. Review all the fields and make any updates that are needed and click Ready for Work. A to-do task is created in the managers to-do list in the Employee Center. Managers review and publish plans from the Employee Center.

Related information
Use action plans created from the Journey Accelerator app

Request a background check through a third-party background check provider
Request a background check for an employee through a third-party background check provider such as First Advantage, Accurate, or Sterling.

Before you begin
An HR integrations administrator must have set up the integration between HR Service Delivery and the third-party background check system before requests can be made. See HR Integrations for more information.
Role required: sn_hr_core.case_writer

Procedure
1. Navigate to HR Case Management > Create New Case.
2. In the Search for Employee field, select the employee you are creating the case for.
3. In the **Case Details** section, in the **HR service** field, select one of the following services to request a background check through the third-party background check provider.
   - Request Background Check by First Advantage
   - Request Background Check by Accurate
   - Request Background Check by Sterling
   - <Name of HR service for a custom background check system integration>

4. Fill in the other fields on the form, as appropriate. For further details on the form fields, see [Create an HR case](#).

5. Click **Create Case**.

6. In the **Background check package** field, select the background check package you want to use for the case.

7. Click **Ready for Work** to send the background check request to the appropriate third-party background check provider.

**Results**
As the background check application progresses, the status is updated in the **Background check application status** field.

**What to do next**
To view the background check details, navigate to the **Background Check Details** related list.

**Request an electronic signature through the DocuSign service**
Request an electronic signature through the DocuSign service. When the case state changes to **Ready**, the flow triggers and creates DocuSign tasks for all of the signers. For parallel signing, the tasks are assigned all at once. For serial signing, the tasks are created in the order defined.

**Before you begin**
An HR integrations administrator must have set up the integration between HR Service Delivery and the DocuSign system before requests can be made. See [Integrating with the DocuSign service](#) for more information.

Role required: sn_hr_core.case_writer
Procedure

1. Navigate to **HR Case Management > Create New Case**.

2. In the **Search for Employee** field, select the employee you are creating the case for.

3. In the **Case Details** section, in the **HR service** field, select an HR service.
   - Request Signature using DocuSign on Adhoc Document
   - Request Signature using DocuSign Template
   - <Name of custom HR service>

4. Fill in the other fields on the form, as appropriate.
   For further details on the form fields, see **Create an HR case**.

5. Click **Create Case**.

What to do next

When the case state changes to **Ready**, the flow triggers and creates DocuSign tasks for all of the signers. For parallel signing, the tasks are assigned all at once. For serial signing, the tasks are assigned in the order defined.

Note:

- The tasks are created using the HR task template named DocuSign Task Template.
- Users with the sn_hr_core.admin role can track the flow execution with the **Show Flow** related link.
  - If a case is cancelled from platform, you must manually cancel the associated flow. Otherwise, the flow will remain in waiting. To cancel the flow, click the **Show Flow** related link to open the flow designer in a new window, and then click **Cancel Flow**.
- Signers must complete their DocuSign tasks through a self-service portal such as the Employee Service Center. Signing in platform is not supported.

Case and task status change

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document signed by all</td>
<td>• Case and tasks closed completed&lt;br&gt;• Signed document(s) attached to case and tasks</td>
</tr>
<tr>
<td>Document declined</td>
<td>• Case and declined task closed incomplete&lt;br&gt;• Pending tasks canceled&lt;br&gt;• No attachments to case</td>
</tr>
<tr>
<td>Document voided or flow errored</td>
<td>• Case closed incomplete and tasks canceled&lt;br&gt;• No attachments to case</td>
</tr>
</tbody>
</table>
Request an electronic signature through the Adobe Sign service

Request an electronic signature through the Adobe Sign service. When the case state changes to **Ready**, the flow triggers and creates Adobe Sign tasks for all of the signers. For parallel signing, the tasks are assigned all at once. For serial signing, the tasks are created in the order defined.

**Before you begin**
An HR integrations administrator must have set up the integration between HR Service Delivery and the Adobe Sign system before requests can be made.

Role required: sn_hr_core.case_writer

**Procedure**

1. Navigate to **HR Case Management > Create New Case**.
2. In the **Search for Employee** field, select the employee for whom you are creating the case.
3. In the **Case Details** section, in the **HR service** field, select an HR service.
   - <Name of custom HR service>
   - Signature using Adobe Sign

4. Fill in the other fields on the form, as appropriate. 
   For further details on the form fields, see **Create an HR case**.

5. Click **Create Case**.

**What to do next**

When the case state changes to **Ready**, the flow triggers and creates Adobe Sign tasks for all of the signers. For parallel signing, the tasks are assigned all at once. For serial signing, the tasks are created in the order defined.

Signers must complete their Adobe Sign tasks through a self-service portal such as the Employee Service Center. The Adobe Sign task is displayed as a URL in the to-dos page in the Employee Service Center.

On clicking the URL, the signer is directed to the Adobe Sign system to sign the document. After completing the task, the signer is redirected to the to-dos page in the Employee Service Center. The status of the Adobe Sign task is not updated immediately because the callback is asynchronous.
Note:

- The Adobe Sign tasks are created using the HR task template named the Adobe Sign task template.
- Auto-close integration type tasks are created using the HR task template.
- Users with the sn_hr_core.admin role can track the flow execution with the Show Flow related link.
  - If a case is canceled from platform, you must manually cancel the associated flow. Otherwise, the flow remains in waiting. To cancel the flow, click the Show Flow related link to open the flow designer in a new window, and then click Cancel Flow.

### Case and task status change

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document signed by all</td>
<td>• Case and tasks closed completed&lt;br&gt;• Signed document(s) attached to case and tasks</td>
</tr>
<tr>
<td>Document declined</td>
<td>• Case and declined task closed incomplete&lt;br&gt;• Pending tasks canceled&lt;br&gt;• No attachments to case</td>
</tr>
<tr>
<td>Document voided or flow errored</td>
<td>• Case closed incomplete and tasks canceled&lt;br&gt;• No attachments to case</td>
</tr>
</tbody>
</table>

### Work an HR case

After initial creation of an HR case, the next steps are to change the state, provide additional information, and ensure that any outstanding tasks are completed.

#### Before you begin

**Role required:** sn_hr_core.case_writer

HR case creation and completion require different information depending on the Center of Excellence (COE) and HR service selected. The HR service an employee is requesting determines the type of HR case.

1. After employee verification, click **Create Case**. The following fields appear:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An HR case number is assigned and is a unique identifier, cannot be changed, and has an HRC prefix.</td>
</tr>
</tbody>
</table>
| Parent  | Populates the parent case when the displayed case is a child.  
For example, a Request onboarding case has multiple child cases and tasks under it. |
<p>| Skills  | The required skills of the person assigned to this category of HR case. Skills can auto-populate based on the HR case template associated with the HR service. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **State** | The state of the case. The state can auto-populate based on the HR case or task template associated with the HR service.  
  - Draft: The default state for a case when it is first opened.  
    - **Note:** Can only be changed to Ready, Closed Complete, Closed Incomplete, Cancelled, or Suspended.  
  - Ready: The case is ready to be worked on.  
  - Awaiting Approval: Requires approval before it can move to the next state.  
    - **Note:** Can only be changed to Ready, Closed Complete, Closed Incomplete, Cancelled, or Suspended.  
  - Work in Progress: The case is assigned and being worked on.  
  - Closed Complete  
  - Closed Incomplete  
  - Cancelled  
  - Awaiting Acceptance: The Opened for person must accept the HR case before it can proceed. For example, a Request for Onboarding case was opened for a hiring manager. The hiring manager must accept the case before it can move to the next state.  
  - Suspended: Use to temporarily prevent violation of a service level agreement (SLA). Refer to Suspend and resume an HR case.  
    - **Note:** The State cannot be edited in List view. |
| **Priority** | The precedence of the case, based on the HR service.  
  The priority automatically overrides the template and changes to 2 - High for users flagged as VIP. Configured in HR Properties (sys_property). |
| **Source** | From where the case originated. Sources are:  
  - Not selected  
  - Self Service  
  - Phone  
  - Chat / Connect / Live Feed  
  - In Person  
  - Email  
  - Other |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Virtual Agent</strong></td>
<td>• Virtual Agent</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Cases created through email or self-service are automatically moved to <strong>Ready</strong> state and assigned to a group or user.</td>
</tr>
<tr>
<td><strong>Opened by</strong></td>
<td>The user who created the case.</td>
</tr>
<tr>
<td><strong>Assignment group</strong></td>
<td>The group the record is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the <strong>Assigned to</strong> field. Assignment groups are restricted to those groups with a type of human_resources. To change the <strong>Assignment group</strong>, the <strong>Assigned to</strong> agent must be a member of the new group and the <strong>State</strong> must be <strong>Ready</strong>. <strong>Note:</strong> To automatically assign a group to an HR case, see Assignment and matching rules in HR and Configure an HR case template.</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>The user assigned to work on this case. When a group is automatically assigned, a user from the group is automatically assigned when the case is created. If the user is not auto-assigned, click the <strong>Lookup using list</strong> icon to select a user who is a member of the selected assignment group. To change the <strong>Assigned to</strong> HR agent, the agent must be a member of the <strong>Assignment group</strong> and the <strong>State</strong> must be <strong>Ready</strong>. If <strong>Assigned to</strong> is left blank, some features are not available from the Employee Service Center ticket page. For example, the <strong>Ask a Question</strong> link to chat directly about an HR case cannot assign an agent. Comments or work notes do not appear on a case until an agent is assigned.</td>
</tr>
<tr>
<td><strong>Collaborators</strong></td>
<td>Add collaborators or other HR agents to the case. Only HR agents can be added as collaborators. For example, an HR agent can add them self as a collaborator after transferring a case to a different agent or group. This action permits the original agent to still track the case. Or, an HR agent can add another HR agent as a collaborator to request help. Adding a collaborator populates the case on the collaborations list. Other factors related to adding collaborators:  • Collaborators can remove themselves from the case. To remove yourself, highlight your name in the <strong>Collaborators</strong> list and click the <strong>X</strong>.  • Collaborators are not required to be part of the assignment group.  • Assigned to person can add or remove collaborators.  • Collaborators cannot add or remove collaborators.  • Notifications are sent to collaborators when added to the HR case.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Adding collaborators can alleviate the amount of emails requesting help on an HR case by consolidating communication.</td>
</tr>
<tr>
<td>Case support team</td>
<td>Employees assigned to answer questions about onboarding a new hire. Only appears for Lifecycle Events cases. You can add users or define a group that can support the Subject person for a Lifecycle Event case. The Subject person can communicate with the case support team while the case progresses.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Anyone in the company can be added to the Watch list. For example, an employee requests a travel visa. Add the manager of the employee to ensure that updates are communicated. Click the Edit Watch List icon to add users. Click the Add me icon to include yourself.</td>
</tr>
<tr>
<td>Short description</td>
<td>Populates from the HR service. After the case is created, you can modify the description.</td>
</tr>
<tr>
<td>Description</td>
<td>You can add a longer, detailed description after the HR case is created. Use the Rich Text Format (RTF) tools to format your text. Rich text formatting also appears for a case or task description on the Employee Service Center or service portal.</td>
</tr>
</tbody>
</table>

The following embedded lists appear:

**Special Handling Notes List**

- Shows notes of messages specific to an HR case or conditions. For more information, see Add special handling notes for an HR Service Delivery case.

**Knowledge results**

- Shows knowledge results based on the short description of the HR case. There are two tabs. One showing articles that you have access to, and one showing articles that the Opened for employee can access. Click Attach to make the article visible to the person that the HR case was opened for in the Additional comments section. See Attach knowledge articles to an HR case for more information.

**Tasks**

- Appears when there are tasks associated with the case. Click a task to view or update it.

**Note:** When you close the parent case, all child tasks are assigned the Closed Incomplete state.

**Fulfillment Instructions**

- View information on how to complete the case. This information is defined in the HR Service configuration.

- A checklist outlining the exact steps to complete appears when configured by the HR service. See Configure an HR service.
Comments and Work Notes

You can add comments or work notes to the case to provide details about the case. **Work notes** are not visible to the **Subject person**.

ℹ️ **Note:** Translate the text in your preferred language using the **Translate** option. For configuring the dynamic translation framework, see **Dynamic translation**.

If your company uses templated snippets and depending on the conditions defined, the **Responses** button appears in the form header:

1. Click the **Responses** button.
2. Select a response template.
3. Click **Copy to clipboard**.

ℹ️ **Note:** This button copies all text in the message field. To copy partial text, highlight the text, and use the copy command. You can also edit the text after pasting it.

4. You can paste the text into the **Work Notes**, **Comments**, or any text field.

Parental Leave Details

Appears for Parental Leave of Absence Request cases. Provides details about the leave request.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave subtype</td>
<td>Identifies the role of the Subject person for parental leave of absence or the type of parental leave. Select:</td>
</tr>
<tr>
<td></td>
<td>• Birthing parent</td>
</tr>
<tr>
<td></td>
<td>• Partner of birthing parent</td>
</tr>
<tr>
<td></td>
<td>• Adoption</td>
</tr>
<tr>
<td></td>
<td>• Surrogacy</td>
</tr>
<tr>
<td></td>
<td>• Foster placement</td>
</tr>
<tr>
<td>Leave status</td>
<td>Indicates the status of the parental leave. Select:</td>
</tr>
<tr>
<td></td>
<td>• Requested</td>
</tr>
<tr>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td>• On Leave</td>
</tr>
<tr>
<td></td>
<td>• Rejected</td>
</tr>
<tr>
<td></td>
<td>• Completed</td>
</tr>
<tr>
<td></td>
<td>• Cancelled</td>
</tr>
<tr>
<td>Child arrival date</td>
<td>The date the child is expected to arrive.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** Use this field for Adoption or Foster placement.
Parental Leave Details (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First day of leave</td>
<td>The date the employee is requesting to start parental leave.</td>
</tr>
<tr>
<td>Estimated last day of leave</td>
<td>The estimated date the employee is expected to end parental leave.</td>
</tr>
<tr>
<td>Due date</td>
<td>The birth date of the child.</td>
</tr>
</tbody>
</table>

*Note:* Use this field when Birthing parent, Partner of birthing parent, or Surrogacy is selected from Leave subtype.

The following sections appear dependent on the type of task or case:

**Reimbursement**

Appears when a Tuition Reimbursement Request case is selected. Complete the fields related to the school or program name, justification, refund amount, and course dates.

**Activities**

Shows a list of all changes or updates to the HR case with the most current at the top.

**Related Links**

The following appear dependent on the type of case and roles associated with the user:

- Add Task: Click to add a task to the case. Refer to add a task.
- Show SLA Timeline: The SLA in timeline format that shows elapsed time.
- Show Workflow: The workflow that is associated with the case.
- Escalate Case: Click to escalate the case and provide a reason.
- Activity Set Execution: Populates for Lifecycle event cases. Click to view the Activity Set Contexts and each activity set.
- Repair SLAs: Click to repair any service level agreements associated with the case.
- Assign to Me: Appears when Assignment group is empty or if you belong to the Assignment group. Click to assign the HR case to you. A button also appears in the header form.

The related lists appear dependent on type of case or task:

**Emergency Contacts**

List of emergency contacts for the Subject person

**Cases for Subject Person**

List of cases associated with the Subject person.

**Cases Opened for User**

List of cases associated with the Opened for person.

**Attached Knowledge**

List of knowledge articles attached to the HR service type.
Approvers
Lists employees that can approve changed information or the case, state of approval, comments, and associated dates.

⚠️ Note: To reject an approval, users should have the HR case writer [sn_hr_core_case.writer] role.

Requested Item
List items like laptops, software, or furniture requested for the Subject person.

Requested Items
List of items requested for the case. Requested items are created from tasks, but do not appear under HR Tasks.

Similar Cases
List of related cases by type of request.

KB Articles Read by User
List of Knowledge Base articles read by the Subject person.

Direct Deposit for Subject Person
List of direct deposit information for the

Health Benefits for Subject Person
List of health benefits the subject person is enrolled. This tab only appears for health benefit cases.

Retirement Benefits for Subject Person
List of retirement benefits the subject person is enrolled. This tab only appears for retirement benefit cases.

HR Cases
All HR cases for the Subject person.

Child Cases
Lists child cases associated with this case. Click New to create a child case under the case you are working on.

⚠️ Note: When you close the parent case, all child cases are cancelled.

Beneficiaries
Only appears for Total Rewards cases with an HR service type of Beneficiaries Add/Modify or Inquiry.
List of beneficiaries for Opened for and Subject person.

View HR case information
There are multiple ways to find a specific HR case.

Procedure
1. Navigate to HR Case Management > All HR Cases.
   • Assigned to me: All cases assigned to the logged-in user.
   • Open: All open cases.
   • Open - Unassigned: Open cases that do not have agent assignments.
• **Closed:** All closed cases.

• **All:** All cases regardless of state or HR Service.

• **Case SLAs:** All cases with SLAs.
  You can also view cases by HR service.

• **Employee Relations Cases:** All cases related to disciplinary issues.

• **HRIT Cases:** All cases related to HR accounts, password reset, HR Portal support, and HR reports.

• **Payroll Cases:** All cases related to direct deposit, payroll discrepancy, and request corporate credit card.

• **Total Rewards Cases:** All cases related to medical, dental, retirement, beneficiaries, leave of absence, pharmacy, relocation, vision, and tuition reimbursement.

• **Workforce Administration Cases:** All cases related to employment verification letters and general inquiries.

• **Lifecycle Events Cases:** Cases related to Onboarding or Account Notification.

2. Select the case to view.

3. Buttons appear at the top:

• **Follow:** Track activity on the case or follow a record in Connect Chat to track activity as it happens. For more information, see *Follow a record in Connect*.

• **Update:** Save and update the record. Takes you back to the list form.

• **Associate Interaction:** Select to associate an interaction to the case. Interactions are requests for assistance through a given channel, for example, a call or a chat. For more information, see *Interaction Management*.

• **Ready for Work:** Select to change the state of the case to Ready and assign an agent.

• **Close Complete:** Close the case and change the state to Complete.

• **Close Incomplete:** Close the case and change the state to Incomplete.

• **Preview Document:** Click to preview a document for accuracy before generating and sending it.

• **Sign Document:** For documents that require an HR signature, click to preview, sign, and save the document.

• **Send Email:** Appears after signing and saving the signature for a document. Click to send the saved document to the contact email provided by the end user.

• **Suspend:** Suspends an HR case that does not have a state of closed or canceled.
  You can suspend the timing specified in the service level agreement (SLA) to perform additional research.
• Cancel: Cancels the case.
• Delete: Deletes the case and related SLAs. Deleted cases do not show in any case view.

**HR document generation**

There are multiple ways to generate documents in HR Service Delivery.

• **Automatically**
  
• Multiple signatures are collected.
• Preview, Sign, or Save

**Automatically**

Document is generated and made available for the subject person to sign. Following are some examples:

• A document such as Tuition Reimbursement Request must be sent to the employee for signature. The Request Tuition Reimbursement service has a work flow that triggers a task for the subject person (employee) of the case.

An administrator enables the **Automatically Create Draft Document** case option on the HR service and sets up the HR service. When a case is created with that HR service and its state is changed to Work in Progress or Ready, a task gets automatically generated for the employee with the document available for signing.

• A document such as Employee Verification Letter must be sent to the employee that does not require any signature.

An administrator selects the template on the HR service. An HR case is created with that HR service. The HR agent previews the document using the **Preview Document** option, generates the document, and sends an email to the employee using the **Send email** option on the case.

**Multiple signatures are collected**

Documents like offer letters can require multiple signatures. When all signatures are collected, the document is automatically generated.
Preview, Sign, or Save
Some documents require an HR agent to review, sign, or save it prior to sending it to a subject person for an HR case. An example is when a subject person requests an employment verification letter. This document requires an HR agent to review it for accuracy, sign it, and send it to the requested email address.

• Open a case requiring a document to be sent to the subject person.
• Ensure that the state is **Work in Progress**.
• The Form Header shows:

![Form Header](image)

• Click **Preview Document** to view the document.
• Click **Sign Document** for documents that require an HR signature.

Note: By default, the document is available for the subject person to view once you preview it. Change this behavior by changing the **State** field on the HR task template. You can access the task template from the HR Case form by selecting the **HR service > Service Activities > Child task template**.

Change values
When there are errors in the document:

• Check the table the incorrect information is pulled from. For example, check the HR profile `[hr_profile]` when contact information for the user is incorrect.
• Check the HR case to ensure correct case information.
• Check the document template for errors within the body of the document, incorrect field mapping, or variable information.

Checklists in HR cases and tasks
A feature of HR services is the ability to automatically add a checklist to an HR case or task. A checklist can serve as a reminder to the HR agent to ensure that the procedure is followed.

1. An employee submits a direct deposit request through the HR Service Portal. An HR case is created with the request.
2. A checklist appears on the HR case. Checklists can be added directly into the case or can be automatically added to a case from the associated HR service. For example, the checklist items are:
   • Verify that the employee has attached the correct direct deposit form.
   • Validate the direct deposit case information.

Note: For more information on setting this feature up, please see **Advanced form configuration** and **Advanced Forms Management in HR Service Delivery**.
• Send information to the payroll department, put case in progress.
• Approve and close case when payroll completes setup.

Refer to Configure an HR service on adding a checklist automatically to an HR case.

Adding an HR task to an HR case
You can add, view, or work on HR tasks assigned to HR cases.

Before you begin
Role required: sn_hr_core.basic or sn_hr_core.case_writer

About this task
You can view HR tasks from the parent HR case or by going to HR Case Management > HR Tasks.

Procedure
1. Open an HR case.
2. Scroll to Related Links and click Add Task.
   • HR Task: Select to add an HR task.
   • Facilities Request: Select to create a facilities request such as desk or office space.
3. To create an HR Task, complete:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned task ID.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot change this value.</td>
</tr>
<tr>
<td>Parent</td>
<td>The case number you are creating the task for.</td>
</tr>
<tr>
<td>Location</td>
<td>Select the location of the employee you are creating the task for. Location determines the HR agent assigned to the task.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For onboarding cases that task selecting an office or desk, the location determines the building map that shows.</td>
</tr>
<tr>
<td>Template</td>
<td>Click and select the HR Task template for this task. The HR Task template can auto-populate fields like the HR task type, short description, and the group or person the task is assigned to.</td>
</tr>
<tr>
<td>Due date</td>
<td>Select the date the task is to be completed.</td>
</tr>
<tr>
<td>Set reminder</td>
<td>Check to send an email notification based on the Due date calculation entries.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Reminders can also be set up on the HR Task Template to automatically populate.</td>
</tr>
<tr>
<td>Reminder template</td>
<td>Select the email template used for reminder notifications. Email templates are set up from HR Administration &gt; Email Content. Refer to Add or modify email content for notifications.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When to send (days)</td>
<td>Enter the number of days before the task due date to send the reminder email.</td>
</tr>
<tr>
<td>Interval (days)</td>
<td>Enter the number of days the reminder email should be sent on an interval.</td>
</tr>
<tr>
<td></td>
<td>For example, entering a 5 indicates that the reminder notification is sent every 5 days until the due date is reached.</td>
</tr>
<tr>
<td>HR task type</td>
<td>When assigning a task to an employee, you can request how the employee acknowledges completion of the task. The tasks appear on the HR Service Portal for the employee.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The short description comes from the template, but you can add or modify it. It shows on the HR Service Portal.</td>
</tr>
<tr>
<td>HR Service</td>
<td>An HR service fulfills the HR task. In the <strong>HR Service</strong> field, select an HR service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <strong>Bulk Parent Case</strong> does not appear as a selection because it is only used when creating a parent case for child bulk cases. Refer to Add or modify bulk HR cases.</td>
</tr>
<tr>
<td>Submit Catalog Item</td>
<td>A catalog item fulfills the HR task. In the <strong>Catalog Item</strong> field, select a catalog item.</td>
</tr>
<tr>
<td>Submit Order Guide</td>
<td>An order guide fulfills the HR task. In the <strong>Order Guide</strong> field, select an order guide.</td>
</tr>
<tr>
<td>Collect Employee Input</td>
<td>Collects information from employees. In the <strong>Employee form</strong> field, select the employee form that the user fills out or verifies.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Employee forms are questionnaires built using the survey designer to collect information from employees. See Collect employee input for more information.</td>
</tr>
<tr>
<td>Checklist</td>
<td>In the <strong>Checklist Items</strong> field, provide the checklist items.</td>
</tr>
<tr>
<td>E-signature</td>
<td>User electronically signs a document. In the <strong>E-signature template</strong> field, select the e-signature template to use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Credential</td>
<td>Indicates that you want the user to acknowledge reading a document by logging in with their login credentials. The <strong>Acknowledgment text</strong> and <strong>Acknowledgement document</strong> fields appear. Using these fields shows a check box and text above the login credentials. In the Acknowledgement document field, select a document that the user is asked to read.</td>
</tr>
<tr>
<td>E-Signature</td>
<td>Indicates that you want the user to provide an e-signature to acknowledge or validate a document. The <strong>Acknowledgment text</strong> and <strong>Acknowledgement document</strong> fields appear. Using these fields shows a check box and text above the e-signature.</td>
</tr>
<tr>
<td>Mark When Complete</td>
<td>Notify the user a <strong>Completed</strong> button appears on the HR Service Portal. Use the <strong>Short description</strong> to provide details about this task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Mark When Complete</strong> changes the state of the task to <strong>Closed Complete</strong>.</td>
</tr>
<tr>
<td>Sign Document</td>
<td>Requests the user to sign a document. An example is sending an education agreement to be signed for tuition reimbursement. The <strong>Acknowledgment text</strong> field appears. Using this field shows a check box and text above the signature.</td>
</tr>
<tr>
<td>Take Survey</td>
<td>In the <strong>Survey</strong> field, select a survey that the user is assigned to take.</td>
</tr>
<tr>
<td>Upload Documents</td>
<td>Requests the person assigned to the task to upload documents. Examples are receipts, course registration, or transcripts for tuition reimbursement. Use the <strong>Short description</strong> field to provide instructions.</td>
</tr>
<tr>
<td>URL</td>
<td>The <strong>URL</strong> field appears. Enter a URL link that the user acknowledges when accessed.</td>
</tr>
<tr>
<td>View Video</td>
<td>The <strong>URL</strong> field appears. Requests the person assigned to the task to view a video.</td>
</tr>
<tr>
<td>Activity</td>
<td>Shows when an employee responds or completes a task and shows task activities by employee and assigned HR agent.</td>
</tr>
<tr>
<td>Optional</td>
<td>Check to make the task optional. The <strong>Skip</strong> button appears for a task in the <strong>Open Case</strong> page. The <strong>Subject person</strong> can skip the task or do nothing and the HR agent can close complete the case.</td>
</tr>
<tr>
<td>State</td>
<td>The work status of the case. The states are:</td>
</tr>
<tr>
<td></td>
<td>• Draft</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The HR group the case is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the Assigned to field. Assignment groups are restricted to those groups with a type of human_resources. Note: To change the Assignment group, the Assigned to agent must be a member of the new group.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. If the user is not auto-assigned, click the lookup icon to select a user who is a member of the selected assignment group. Note: To change the Assigned to HR agent, the agent must be a member of the Assignment group. You can also use this field to assign a task to the Subject person of the case. For example, if you want the Subject person to sign and return a document or make a task optional.</td>
</tr>
<tr>
<td>Task support team</td>
<td>The point of contact within your company for questions. Users and groups Select when you want specific users or groups assigned to the HR case or task to be the primary support for this HR task. You can select from fields on the HR case or task such as the Opened by, Opened for, and others or you can select from different groups. You can further filter by selecting specific skills. Connect Selecting Connect indicates your company is using ServiceNow Connect messaging. After you select Queue, the Queue field appears below it. Select a chat queue you want to support the task you are creating. You can further filter by selecting specific skills. Note: In previous releases, this field was labelled Queue. Agent Workspace Supports Agent Workspace for chat. Selecting Agent Workspace indicates your company uses Virtual Agent conversations for chat. After you select Agent Workspace, the AWA Queue field appears below it. Select the Advanced Work Assignment chat queue you want to support the task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Parent case users</td>
<td>Appears when Users and groups are selected from Task support team. Select fields like Opened by, Opened for, and others from the parent HR case that you want to support this HR task.</td>
</tr>
<tr>
<td>Groups</td>
<td>Appears when Users and groups are selected from Task support team. Select a group associated to the HR case or task to be the support for this HR task.</td>
</tr>
<tr>
<td>Queue</td>
<td>Appears when Queue is selected from Task support team. Select the chat queue you want this HR task to be routed to for questions or help.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> What you select here must match the value in the HR Queue field on the Chat Setup form under Collaboration. If these values don’t match, an error occurs.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Click the lock icon to add users. Click the Add me icon to include yourself.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short descriptions populate from the HR task template selected and can be overwritten. Enter information that prompts the user about the task request. The short description appears on the HR Service Portal to the employee.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer, detailed description of the case. Use the Rich Text Format (RTF) tools to format your text. Rich text formatting also appears for a case or task description on the Employee Service Center or service portal.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Enter comments, updates, or information about the task that is visible to the Subject person on the case.</td>
</tr>
<tr>
<td>(Customer visible)</td>
<td><strong>Note:</strong> Translate the text in your preferred language using the Translate option. For configuring the dynamic translation framework, see Dynamic translation.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Enter notes about the case to correspond with other HR agents. These notes are not visible to the Subject person.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Translate the text in your preferred language using the Translate option. For configuring the dynamic translation framework, see Dynamic translation.</td>
</tr>
</tbody>
</table>

4. You can:
**5.** Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assign to me</strong></td>
<td>Click</td>
</tr>
<tr>
<td><strong>Close a task</strong></td>
<td>Enter information in the Work notes field and other fields as needed, and change the State to Closed Complete.</td>
</tr>
<tr>
<td><strong>Clone task</strong></td>
<td>Click the Clone Task related link. Enter the new task information in the task form and click Update.</td>
</tr>
<tr>
<td><strong>Cancel the task</strong></td>
<td>Click Cancel Task in the form header.</td>
</tr>
<tr>
<td><strong>Review the progress of sibling tasks</strong></td>
<td>The Sibling Tasks tab shows all tasks under the same case. Click a task number to see the details.</td>
</tr>
<tr>
<td><strong>HR Document Acknowledgement</strong></td>
<td>Lists HR document acknowledgement types returned from an employee. You can filter by type:</td>
</tr>
<tr>
<td></td>
<td>• User</td>
</tr>
<tr>
<td></td>
<td>• Document revision</td>
</tr>
<tr>
<td></td>
<td>• Signature</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
</tbody>
</table>

When all tasks are closed for an HR case, an email notification is sent to the HR agent who is assigned to the case.

> **Note:** When you close the parent case, all child tasks are assigned the Closed Incomplete state.

**6.** To add a document attachment, click the attachment icon at the top of the form. Attachments to tasks are available on the parent case.

**7.** Click Update.

**Create Office Space Request Task**

As part of the onboarding process, you can find and reserve an office space for a new hire.

**Procedure**

1. Select an HR Case.
2. Select Add Task under the Related Links section.
3. Select **HR Task** from the Task Type window.

4. Complete the form. These instructions describe the required fields for requesting an office space. For a complete listing of all HR task fields, refer to [Adding an HR task to an HR case](#).

<table>
<thead>
<tr>
<th>Location</th>
<th>Select the building location the new hire is assigned to.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>Select the HR task template that corresponds to this type of task. The <strong>Select Office/Desk Space</strong> template is provided as a model.</td>
</tr>
<tr>
<td>Due date</td>
<td>Select a date the HR task is to be completed.</td>
</tr>
<tr>
<td>HR Task Type</td>
<td><strong>Submit Catalog Item</strong> appears from the HR task template.</td>
</tr>
<tr>
<td>Catalog Item</td>
<td><strong>Select Office Space</strong> appears from the HR task template.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Appears from the HR task template, but you can overwrite this entry.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Appears from the HR task template, but you can override it. If blank, select a group to be assigned to this task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Appears from the HR task template, but you can override it. If blank, select an HR agent to be assigned to this task.</td>
</tr>
</tbody>
</table>

5. Select **Submit** or **Ready for Work**.

**View HR task information**

There are multiple ways to find a specific HR task.

**Procedure**

1. Navigate to **HR Case Management > HR Tasks**.
   - **Assigned to me**: All tasks assigned to the current user.
   - **Open**: All open tasks.
   - **Open - Unassigned**: All open tasks that have not been assigned.
   - **Closed**: All closed tasks.
   - **All**: All tasks regardless of state or assignment.

2. Select the task to view.

**Finding HR cases**

There are several ways to search and find an HR case.

The quickest way to find cases assigned to you is to use the HR Service Portal. The HR Service Delivery provides multiple ways to search for an HR case. You can search by:
   - **All cases assigned to you**
   - **All open cases**
• All open cases that are unassigned
• All closed cases
• All cases
• Cases by SLA information

You can also search for cases by type:
• Employee relation cases
• HRIT cases
• Payroll cases
• Total Rewards cases
• Workforce Administration cases

Resubmit an HR case for approval

HR cases that are rejected can be resubmitted for approval. Resubmitting a rejected case alleviates having to recreate a new case.

Before you begin
Role required: sn_hr_core.case_writer

About this task
After a new case is submitted, an email notification is sent to all approvers. Approvals for HR cases are assigned to individual users or to members of a specified group. Approvers can reject or approve from the HR Service Portal or HR Ticket Page.

When a service activity for an HR service has Allow resubmit of approvals for On rejection, the Assigned to person can resubmit an approval request after rejection. See Configure an approval.

You can view a list of approvers at the bottom of the HR case form under the Approvers tab.

HR cases

Approvals for HR cases use workflows. To resubmit a rejected HR case:
1. Open the HR case that has a rejected approval. A message appears at the top of the form.

2. Select the **here** link. The **Enter the reason for resubmitting approval requests** pop-up appears. You can enter work notes (not visible to employee) or comments (visible to employee). Work notes or comments are required.

3. Select **OK**.

**Lifecycle Events cases**
Approved for HR activities under a lifecycle event are configured differently than an HR case. There are more options for approvals. See **For an approval**.

**Note:** Approvers that do not have the sn_hr_core.manager role cannot access the HR case after the state changes to **Closed Complete**.

**Transfer an HR case**
You can create and use methods to reclassify or transfer an opened HR case from one HR service to another. Oftentimes an HR case opens as a General Benefits Inquiry. After investigating, you can transfer it to a specific HR service that is applicable.

You can configure different transfer case scenarios. The base system provides:
• Reclassify:
  ◦ The HR case number does not change after transferring an HR case from one HR service to another.
  ◦ Links redirect to the new case.
  ◦ Notification emails are not sent for reclassification cases.

• Standard:
  ◦ The HR case number changes when transferring an HR case from one HR service to another. Both HR case numbers appear on the HR case for reference.
  ◦ Links do not redirect from original case to new case.
  ◦ The subject person receives a notification email with the closed case and transferred case information.

• Common to both Reclassify and Standard:
  ◦ Fields from the current case are copied and moved to the new case.

  Note: The sn_hr_core.transfer_case.ignored_fields sys property can be set with fields that are not copied in an HR case transfer.
  ◦ Work notes copy from original case to new case.
  ◦ Attachments are copied and moved the current case to the new case.
  ◦ Previous interaction records from the current case are copied and moved to the new case.

Configure HR transfer case

The base system provides examples of HR transfer case configuration types. You can also create your own.

Before you begin
Role required: sn_hr_core.admin

About this task
If you are creating a transfer case configuration, you must also create a script include to implement the sn_hr_core HR case transfer extension point.
Refer to the existing script includes as examples:
  • hr_TransferCase
  • ReclassifyCaseTransfer
  • StandardCaseTransfer

The hr_TransferCase script include provides a list of fields ignored in the transfer and acts as a utility for the other two script includes.

  Note: Refer to Script includes.

Procedure
1. Navigate to HR Administration > Transfer Case Configuration.
2. Select New.
3. Fill in the form.
## HR Transfer Case Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name          | The name of the HR case transfer type. The defaults are:  
|               | • Reclassify  
|               | • Standard                                                                                                                                   |
| Display text  | The HR case transfer type that appears on the Transfer Case menu from the HR case form. The defaults are:  
|               | • Transfer with existing case number  
|               | • Transfer to a new case number                                                                                                             |
| HR criteria   | Defines what HR agents can view and use this transfer type when performing an HR case transfer from the HR case form. See HR criteria. |
| Is default    | Indicates that the transfer type is the default and appears first in the Transfer Case menu from the HR case form.  
|               | **Note:** To mark a transfer type as the default, click the **Set as Default** button at the bottom.                                           |
| Active        | Indicates if the HR case transfer type is active and available for use. Inactive indicates that the transfer type does not appear in the Transfer Case menu from the HR case form. |

4. Select **Submit** or **Update**.

### Move an HR case from one HR service to another

You can reclassify an HR case that you originally create under one HR service but want to move it under a different HR service.

**Before you begin**
Role required: sn_hr_core.case_writer

**About this task**
You can also retain the details of the original case. For example, you can take a General Inquiry case and reclassify it as a Medical Benefits Inquiry case.

**Procedure**
1. Open an existing HR case.
2. From the **Form Context Menu**, select **Transfer Case**.
3. From **Transfer type**:
4. From **New HR Service**, select the HR service you want to assign to your original case.

5. Select **OK**.

The current case and its child tasks close. When you transfer an HR case from one HR service to another, some field values do not transfer to the new case. The Opened for person receives a notification email with the closed case and transferred case information. Replies to the email appear in the Comments section of the HR case. If the subject person replies to the email associated with the closed case, the reply appears in the comments for both the closed and transferred cases.

**Note:** If the sn_hr_core.restrict_guest_email system property is False (default), text from an email appears in the Work notes field when the employee is responding from a personal email account.

See **Email setup**.

### Escalate an HR case

If you are unable to resolve an issue, you can escalate an HR task. This action reassigns it to the manager of the HR group.

**Before you begin**

Role required: sn_hr_core.basic or sn_hr_core.case_writer

**About this task**

Escalate an HR case when you encounter any of the following conditions.

- Are unable to complete the task due to excessive workload.
- Do not have the necessary skills.
- Need help with some part of the HR case.

An escalated HR case is reassigned based on escalation rules. See **Add or modify escalation rules**.

**Procedure**

1. Open an HR case to be escalated.
2. Under **Related Links**, click **Escalate case**.
3. Enter a reason for the escalation in the dialog window that opens.
4. Click **OK**.

The case is reassigned to an agent in the escalated group.

### Suspend and resume an HR case

If you are unable to close the HR case within the duration specified in the service level agreement (SLA), you can suspend the case.

**Before you begin**

Role required: sn_hr_core.basic or sn_hr_core.case_writer
About this task
For example, to contact a vendor, such as the insurance administrator or payroll processing company, to obtain the required information to close the case. After beginning work on the case, you can suspend it until the information is received. This way the HR case does not show that the SLA is breached. When the information is received, you enter it into the case and resume SLA tracking.

Procedure
1. Open the HR case to suspend. Begin work on the case before suspending it.
2. From the State field, click and select Suspended. The Suspend Reason pop-up window opens.
3. Select one of the following suspension reasons and enter the information you are waiting for.
   • User: If you need more information from the employee before proceeding.
   • Company: If you are waiting for a reply from a vendor or other outside company.
   • Group: If you are waiting for a reply from an internal group.
   • Other: If you suspend the case for any other reason.
   Example
   For example, if you are waiting for the health insurance administrator to investigate an employee claim, select Company for the reason and enter Results of investigation or something similar.
4. In the Work Note field, enter information about why the case is suspended.
   Note: Translate the text in your preferred language using the Translate option. For configuring the dynamic translation framework, see Dynamic translation.
5. Click Suspend. The SLA stops progressing and the suspension notes appear in the activity stream as work notes. You can continue to add work notes to a suspended case.
6. To resume a suspended HR case, open the case and click Resume. The SLA progress is resumed.

Add special handling notes for an HR Service Delivery case
Create special handling notes that appear for a specific HR case or set of conditions.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to Special Handling Notes > Special Handling Notes.
2. Select New or an existing record.
3. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Enter a short description that describes the special handling note.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Message</td>
<td>Enter a message that appears in the special handling notes. Rich text formatting is available.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of special handling note:</td>
</tr>
<tr>
<td></td>
<td>• Standard: Select to display a special handling note for a specific table and related record. For example, if you select HR case, you can select from list of HR cases. A special handling note appears for a specific HR case already created.</td>
</tr>
<tr>
<td></td>
<td>• Conditional: Select to use filter conditions. Use filter conditions to specify when a special handling note appears.</td>
</tr>
<tr>
<td>Display as a pop-up alert</td>
<td>Leave this field blank.</td>
</tr>
<tr>
<td>Note:</td>
<td>Currently, a pop-up window is only for HR Service Delivery Agent Workspace.</td>
</tr>
<tr>
<td>Priority</td>
<td>Assign a priority to the special handling note. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• 1 - Critical (red)</td>
</tr>
<tr>
<td></td>
<td>• 2 - High (orange)</td>
</tr>
<tr>
<td></td>
<td>• 3 - Moderate (light green)</td>
</tr>
<tr>
<td></td>
<td>• 4 - Low (light blue)</td>
</tr>
<tr>
<td></td>
<td>The priority and color appear in the special handling note.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the special handling note.</td>
</tr>
<tr>
<td></td>
<td>• Active: The special handling note is active.</td>
</tr>
<tr>
<td></td>
<td>◦ Active notes appear in the pop-up window.</td>
</tr>
<tr>
<td></td>
<td>◦ Active notes remain until dismissed or set to Inactive or Expired.</td>
</tr>
<tr>
<td></td>
<td>• Inactive: The special handling note is no longer active and does not appear in a pop-up window. Inactive special handling notes still appear when you navigate to <strong>Special Handling Notes &gt; Special Handling Notes</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Expired: The special handling note is no longer active. The expiration date has passed or manually expired.</td>
</tr>
<tr>
<td>Effective immediately</td>
<td>Check to activate the special handling note immediately.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Effective on</td>
<td>If you leave this field unchecked, you can specify a date and time the special handling note appears.</td>
</tr>
<tr>
<td>Expires on</td>
<td>If you want to automatically inactivate a special handling note, select a date and time.</td>
</tr>
<tr>
<td>Table name</td>
<td>Appears when you select Conditional from the Type field. Select the HR table the special handling note appears for when a specific HR case appears or when you satisfy filter conditions.</td>
</tr>
<tr>
<td>Related record</td>
<td>Appears when you select Standard from the Type field. Select and a pop-up menu appears. Select the table name and a corresponding case from the Document field. For example, select HR case from the Table name field and the HR case you want the special handling note to appear.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Appears when you select Conditional from the Type field. Select conditions when met, show the special handling note. For example, select:</td>
</tr>
<tr>
<td></td>
<td>• HR profile</td>
</tr>
<tr>
<td></td>
<td>• is</td>
</tr>
<tr>
<td></td>
<td>• Aileen Mottern                                                                  This condition shows the special handling note for a General Inquiry case for Aileen Mottern.</td>
</tr>
</tbody>
</table>

4. Select Submit or Update.
HR cases for VIPs

Your organization can assign VIP status to users, such as the CEO and vice-presidents, to ensure that the resolution of their tasks is given high priority.

If your organization uses the VIP feature, set up the following to ensure that VIP HR cases are handled appropriately.

• Navigate to Skills > Groups.

• Add members or a group to HR VIP Watchlist. When an HR case is submitted, members of this group receive notification as the case progresses.

• Review the HR service level agreement (SLA) for handling VIP cases. The duration is two hours. When the duration is reached, the SLA is breached and the members of the watchlist are notified.

• Navigate to HR Administration > Properties.

• Enter a case priority number in the Default case priority for VIP requestor field.

• For VIP employees, check the VIP box on their User [sys_user] record.

   Note: The VIP check box does not show by default. Customize the User record form in the Form Designer to show the VIP check box.

You can identify VIP HR cases in the following ways:

• HR Cases list: A VIP icon appears in the Opened for and/or Subject person fields. If the Opened for and/or Subject person fields do not appear, personalize the list.

• HR Case form: The employee name in the Opened for and/or Subject person fields is red.

• HR catalog items: When the form is submitted, a message appears at the top identifying the submitter as a VIP.

Add or modify bulk HR cases

You can create the same type of HR case, for multiple employees, without having to create the same case multiple times.

Before you begin

Role required: sn_hr_core.case_writer or sn_hr_core.admin

About this task

Bulk case creation can save you time and effort. For example, onboarding 20 new hires, a payroll run issue, or an annual recertification process, are cases that can be created as a bulk case.

Bulk HR cases can be created for all active users. For users without an HR profile, like new hires, an HR profile is automatically created.

HR bulk case creation is designed to create up to 10,000 basic HR cases, or 1,000 cases using workflows such as Lifecycle Event cases.

   Note: Performance declines when attempting to create more bulk cases than the system is designed to handle.

You can create one bulk case that creates individual HR cases for each employee in a group. Examples include:

• Sending an annual recertification task to a group of employees every year.

• Onboarding multiple new hires.

• Managing a payroll issue that affects multiple employees.
Scheduled job

The **Bulk case creation** scheduled job runs to process the HR bulk case submittal. By default, the scheduled job runs every six hours, but is configurable.

Navigate to System Definition > Scheduled Jobs.

To run the scheduled job immediately, click **Execute Now**.

See Create a scheduled job.

ℹ️ **Note:** Anyone running this job must have the sn_hr_core.case.writer role. Add the Run as field to the Scheduled Script Execution form and add a user with the sn_hr_core.case.writer role. This role is required to run the job.

---

Procedure

1. Navigate to **HR Case Management > Create Bulk Cases**.
2. Complete or edit the form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter by</td>
<td>Select how you want to determine who to create the bulk HR case for:</td>
</tr>
<tr>
<td></td>
<td>• Upload file: Upload a file with user names or email addresses. Click Download Template for the correctly formatted file.</td>
</tr>
<tr>
<td></td>
<td>• HR criteria: Use pre-defined HR criteria. Criteria based on conditions defined by the HR Profile [sn_hr_core_profile] or User [sys_user] tables. The base system provides examples that can be used.</td>
</tr>
<tr>
<td></td>
<td>ℹ️ <strong>Note:</strong> Only available to users with the sn_hr_core.content_reader, sn_hr_core.content_writer, or sn_hr_core.admin roles.</td>
</tr>
<tr>
<td></td>
<td>• User criteria: Criteria based on role, department, group, location, or company.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload file</td>
<td>Appears when Upload file is selected from the Filter by field. Check the one you are uploading:</td>
</tr>
<tr>
<td>HR criteria</td>
<td>Criteria based on HR profiles to determine the Subject person of each HR case created. Select one or more HR criteria.</td>
</tr>
</tbody>
</table>

**Note:** Only available to users with the sn_hr_core.content_reader, sn_hr_core.content_writer, or sn_hr_core.admin roles.

**Tip:** Only available to users with the sn_hr_core.content_reader, sn_hr_core.content_writer, or sn_hr_core.admin roles.

**Note:** The header of the first column must contain user_name or email.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User criteria</td>
<td>Criteria based on user records to determine the <strong>Subject person</strong> of each HR case created. Select a User criteria. <strong>Note:</strong> Only available to users with the sn_hr_core.content_reader, sn_hr_core.content_writer, or sn_hr_core.admin roles.</td>
</tr>
<tr>
<td>HR profiles</td>
<td>Select filter conditions on the <strong>HR profile</strong> [sn_hr_core_profile] table to determine the <strong>Subject person</strong> of each HR case created. Select one or multiple conditions.</td>
</tr>
<tr>
<td>Users</td>
<td>Select filter conditions on the <strong>User</strong> [sys_user] table to determine the <strong>Subject person</strong> of each HR case created. Select one or multiple conditions.</td>
</tr>
<tr>
<td>All cases have same Opened for</td>
<td>Check to assign the same person as the <strong>Opened for</strong> on each case.</td>
</tr>
<tr>
<td>Opened for</td>
<td>Appears when <strong>All cases have same Opened for</strong> is checked. Select the person that is the <strong>Opened for</strong> on each case created.</td>
</tr>
<tr>
<td>HR service</td>
<td>Select the <strong>HR Service</strong> for the bulk case. <strong>Note:</strong> <strong>HR criteria</strong> on an HR service can also filter who is selected for bulk cases. This filter further refines the selections from the <strong>Filter by</strong> field. See Configure an HR service.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description of the HR service. <strong>Note:</strong> This field auto-fills by the HR template when the HR service is selected, but you can edit it.</td>
</tr>
<tr>
<td>Create a parent case (Choose this if you want to group the cases under a parent case)</td>
<td>Check to indicate that you want to create a parent case with the bulk cases as a child cases. A parent case with the <strong>HR service</strong> as <strong>Bulk Parent Case</strong> and the person creating the bulk case as the <strong>Subject person</strong> is created.</td>
</tr>
</tbody>
</table>

3. Click **Create Cases**. This button only activates when at least one user has been selected based on the parameters defined. A message appears at the top of the form with the bulk case number. Click the link to go to the **Bulk Case Request** form.
View bulk case request

Bulk Case Requests show a list of all created and processed HR bulk cases.

Before you begin
Role required: admin
After an HR bulk case request has been submitted, the details about the case appear in the Bulk Case Request form.

More details appear after the Bulk case creation job runs to process the request. See Create a scheduled job.

Note: When a scheduled job does not complete and remains in the In Progress state, you can reset it. See Reset the state for a scheduled job.

Procedure
1. Navigate to HR Case Management > Bulk Case Requests.
2. From the Bulk Case Requests list, click the bulk case number to see the details of the HR bulk case.
3. Click the Show cases created link to view the individual HR cases created from the bulk HR case.

Reset the state for a scheduled job
You can reset the state of a scheduled job when it does not complete its run.

Before you begin
Role required: admin

Procedure
1. Navigate to System Definition > Scheduled Jobs.
2. Select the Configure Job Definition related link.
3. Right-click on the State field and select Configure Dictionary.
4. From the Dictionary Entry form, make sure that the Read only field is unchecked.

5. Select Update. You can now change the In Progress state of the scheduled job back to Ready.

Employee Relations cases

Because of the sensitive nature of employee relations (ER) cases, there are expectations for tighter security to protect privacy. These aspects make employee relations cases different from standard HR cases.

When ER cases are handled correctly, there is less risk to your company. Features are:

- You can create ER cases without an Opened for or Subject person.
- You can create related records for allegations, interviews, and corrective actions.

ER covers a large area within HR and includes different types of cases, situations, and scope.

Investigations

Currently, HR Service Delivery supports one type of ER case:

- Report Misconduct

Related records that support this type of ER case are:
Security
Confidentiality and securing employee relations cases is the utmost importance.
HR Service Delivery employee relations uses the following to ensure that the correct people have visibility:
• Roles
• Groups
• Assignment rules

Intake
HR Service Delivery employee relations provides:
• Catalog item (Report misconduct)
• Sample KB articles
• Record forms for:
  ◦ Allegations
  ◦ Involved Parties
  ◦ Interviews
  ◦ Corrective Actions

Fulfillment
To work and close an ER case:
• COE and HR service:
  ◦ Report Misconduct
• HR case template
• Case form
• Fulfillment instructions and checklist

Reports
The following reports are provided:
• Case volume by month
• Case volume by allegation type
• Case volume by location
• Case volume by department

For more information on reports, see HR Service Delivery Employee Relations dashboards.
Activate employee relations

You can activate Human Resources Scoped App: Employee Relations [com.sn_hr_employee_relations] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Human Resources Scoped App: Employee Relations [com.sn_hr_employee_relations] enables you to create and manage employee relations cases.

Plugins for Human Resources Scoped App: Employee Relations

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Scoped App: Core [com.sn_hr_core]</td>
<td>Enables you to standardize the documentation, interaction, and fulfillment of employee inquiries and requests.</td>
<td>Employee relations requires activation of this plugin, but is a separate scope.</td>
</tr>
<tr>
<td>Human Resources Scoped app: Workspace [com.sn_hr_agent_workspace]</td>
<td>A single-pane view that tier 1 agents use to respond to all task types, view the full context of an issue, and get relevant recommendations to resolve issues.</td>
<td>This is an optional plugin for ER.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with HR Service Delivery Employee Relations

Several types of components are installed with activation of the Human Resources Scoped App: Employee Relations [com.sn_hr_employee_relations] plugin, including tables, and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.
### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR ER administrator [sn_hr_er.admin]</td>
<td>Can access and configure HR Service Delivery Employee Relations.</td>
<td>• ER case writer [sn_hr_er.case_writer]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ER configuration manager [sn_hr_er.config_manager]</td>
</tr>
<tr>
<td>HR ER case reader [sn_hr_er.case_reader]</td>
<td>Can access and view HR ER cases.</td>
<td>• HR case reader [sn_hr_core.case_reader]</td>
</tr>
<tr>
<td>HR ER case writer [sn_hr_er.case_writer]</td>
<td>Can access, create, and edit HR ER cases.</td>
<td>• HR case reader [sn_hr_core.case_reader]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HR case writer [sn_hr_core.case_writer]</td>
</tr>
<tr>
<td>HR ER confidential [sn_hr_er.confidential]</td>
<td>Can access locked HR ER cases when locking configuration is activated.</td>
<td>• HR basic [sn_hr_core.basic]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HR case writer [sn_hr_core.case_writer]</td>
</tr>
<tr>
<td>HR ER configuration manager [sn_hr_er.config_manager]</td>
<td>Can access, setup, and edit HR ER configuration.</td>
<td>• None</td>
</tr>
</tbody>
</table>

### Tables installed

**HR ER tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allegation [sn_hr_er_allegation]</td>
<td>Contains information about an allegation type and subtype.</td>
</tr>
<tr>
<td>Note:</td>
<td>A non-metadata table.</td>
</tr>
<tr>
<td>Allegation Subtype [sn_hr_er_allegation_subtype]</td>
<td>Metadata table that provides 59 records to the base system. Allegation subtypes further define an allegation. For example:</td>
</tr>
<tr>
<td></td>
<td>• Allegation type = Discrimination</td>
</tr>
<tr>
<td></td>
<td>• Allegation subtypes: Age, disability, Race, and so on.</td>
</tr>
<tr>
<td>Allegation Type [sn_hr_er_allegation_type]</td>
<td>Metadata table that provides base system records. Examples are:</td>
</tr>
</tbody>
</table>
### HR ER tables installed (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Note:</th>
</tr>
</thead>
</table>
| Table Description                                      | • Interpersonal Conflict  
• Misconduct  
• Retaliation  
• Wage and Scheduling Issue  
• Workplace Violence |       |
| Associated Allegation                                   | Contains information that associates an allegation to subject of allegations.|       |
| [sn_hr_er_m2m_allegation_party]                        |                                                                             |       |
| Case Restriction Configuration                          | Extends the COE Security Policy [sn_hr_core_coe_security_policy] table.     |       |
| {sn_hr_er_case_restriction}                             |                                                                             |       |
| Corrective Action                                       | Contains information on corrective actions associated with an ER case.      |       |
| [sn_hr_er_corrective_action]                            |                                                                             |       |
| Employee Relations Case                                 | Extends the HR case [sn_hr_case] table.                                     |       |
| [sn_hr_er_case]                                         |                                                                             |       |
| Interview                                               | Contains information related to ER interviews.                              |       |
| [sn_hr_er_interview]                                    |                                                                             |       |
| Involved Party                                          | Contains information on involved parties related to the ER case.            |       |
| [sn_hr_er_involved_party]                               |                                                                             |       |

### HR Service Delivery Employee Relations

Set up HR Service Delivery Employee Relations (ER) so that your agents can engage with your employees, answer questions, create ER cases, create related records, and resolve issues.

To set up ER:

- Activate the Human Resources Scoped App: Core (com.sn_hr_core) plugin.
- Activate the Human Resources Scoped App: Employee Relations (com.sn_hr_employee_relations) plugin.
- Activate the Human Resources Scoped app: Workspace (com.sn_hr_agent_workspace) plugin.

**Note:** This plugin is optional and for customers using HR Service Delivery Agent Workspace.

**Note:** For additional information on tables and roles installed, see Components installed with HR Service Delivery Employee Relations.
HR Service Delivery Employee Relations case restrictions

Use Case Restriction Configuration to determine what groups and agents can access or restrict ER cases.

Groups

Restrict access by Center of Excellence (COE) for specific groups:

- Define what groups can restrict ER cases.
- Define what groups can view ER cases.

The base system provides one case restriction configuration that enables the HR Confidential group to access ER cases.

For more information, see Manage HR Groups.

⚠️ Warning: When creating case restrictions, be sure that you have at least one configuration that enables you to read these cases.

Roles

Members of groups that can access ER cases must have the sn_hr_er.confidential role.

For more information, see Manage HR roles.

COE Security Configuration

Use COE Security Configuration to define group restrictions for a COE and for all or specific HR services under it.

You can then restrict the COE with read and write capabilities.

ℹ️ Note: If you choose to restrict other COEs besides Employee Relations Case [sn_hr_er_case], you can cause performance issues. ER cases numbering more than 100 K can impact performance.

For more information, see Create a COE security policy.

ER assignment rules

Use ER assignment rules to assign a group to an ER case.

For more information, see HR Service Delivery Employee Relations assignment rules.

ER matching rules

Use ER matching rules to assign an agent that has the least number of cases, the required skills, and matches the location.

For more information, see HR Service Delivery Employee Relations matching rules.

Configure an employee relations case restriction

Define what groups can view or access employee relations cases using Case Restriction Configuration.

⚠️ Warning: When creating case restrictions, be sure that you have at least one configuration that enables you to read these cases.
Procedure
1. Navigate to Employee Relations > Administration > Case Restriction Configuration.
2. Click New.
3. On the form, fill in the fields.

Case Restriction Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>Center of Excellence (COE) that you want to restrict access to.</td>
</tr>
<tr>
<td>Note:</td>
<td>For more information on COE, see HR Centers of Excellence data model.</td>
</tr>
<tr>
<td>Able to restrict cases</td>
<td>Option to enable members of a group to restrict access to all HR cases for the COE.</td>
</tr>
<tr>
<td>Able to view restricted cases</td>
<td>Option that enables a group to view restricted HR cases for the COE.</td>
</tr>
<tr>
<td>Application</td>
<td>The application that the case restriction configuration applies to. This field is automatically set to Human Resources: Employee Relations.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the case restriction configuration record.</td>
</tr>
</tbody>
</table>

4. Click Save or Submit.
5. Add the groups that you want the case restriction configuration to apply to.

6. Click Update.
Create a COE security policy

Use COE Security Configuration to define group restrictions for a COE and for all or specific HR services under it.

Before you begin
Role required: admin, sn_hr_er.admin

Procedure
1. Navigate to HR Administration > COE Security Configuration.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>Center of Excellence (COE) that you want to create a security policy for.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The COEs that appear depend on the Application selected.</td>
</tr>
<tr>
<td>Applies to all services</td>
<td>Option for applying all HR services for the COE security policy.</td>
</tr>
<tr>
<td>Services</td>
<td>The HR service that the COE security policy applies to.</td>
</tr>
<tr>
<td></td>
<td>This field appears only if the Applies to all services check box is not selected.</td>
</tr>
<tr>
<td>Application</td>
<td>The application that the COE security policy applies to.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate the active status of the COE security policy. Only active security policies are applied.</td>
</tr>
</tbody>
</table>
| Type                   | The access that you want your HR agents to have for the cases that fall under the COE or HR services. Valid values:
                          | • Read
                          | • Write
| Applies when           | The condition statement that filters an HR case.                             |
|                        | If the HR case matches the conditions, the COE security policy applies to it. |
|                        | You can create conditions based on key words or fields from the HR case.     |

4. Click Save or Submit.
5. Add the groups that you want the COE security policy to apply to.
6. Click **Update**.

**HR Service Delivery employee relations allegation types and subtypes**

Allegation types and subtypes help you further define an employee relations case.

Allegation types and subtypes are attached to an HR Service Delivery ER case and are the foundation for the case.

When creating an allegation type, you directly associate subtypes.

Subtypes further define an allegation and provide flexibility to categorize an employee relation case and provide specific details.

The base system provides allegation types and subtypes that you can use immediately.

**Configure an employee relations allegation type**

Create allegation types and subtypes to help provide details on an employee relations case.

**Before you begin**

Role required: sn_hr_er.config_manager

**Procedure**

1. Navigate to **Employee Relations > Administration > Allegation Types**.
2. Click **New**.
3. On the form, fill in the fields.

**Allegation Type form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Description of an allegation. An allegation is a high-level category and allegation subtypes can provide details of the allegation. For example, harassment can be an allegation. Subtypes can be:</td>
</tr>
</tbody>
</table>
4. Click **Save**. The Allegation Subtypes related list appears.

5. Click **New**.

6. On the form, fill in the fields.

### Allegation Subtype form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Description of allegation subtype. Subtypes help define the allegation type.</td>
</tr>
<tr>
<td>Allegation type</td>
<td>Enter a description of an allegation subtype. For example, harassment can be an allegation. Subtypes can be:</td>
</tr>
<tr>
<td></td>
<td>• Bullying</td>
</tr>
<tr>
<td></td>
<td>• Insubordination</td>
</tr>
<tr>
<td></td>
<td>• Profanity</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**HR Service Delivery Employee Relations assignment rules**

HR Service Delivery employee relations assignment rules allow you to automatically assign a group to ER cases when the assignment group is empty.

When the HR case template sets the assignment group, assignment rules are ignored.

When an ER case is created, it:

• Checks for the Skills/Assignment group from the HR Case Template for the associated HR service. See [Configure an HR case template for an HR service](#).

• If there is no assignment group for the HR case template, the base system provides the Employee Relations Case assignment rule.

• The Employee Relations Case assignment rule assigns the Employee Relations group to the case.

⚠️ **Note:** For more information, see [Add or modify an HR assignment rule](#).

**HR Service Delivery Employee Relations matching rules**

Because ER cases do not use a subject person, matching rules try to find an agent with the required skills and in the same country where the case was opened to determine case assignment.

Matching rules look for:

• Country the ER case was opened in.

• If no country is available, find any involved parties with a type of complainant and use their country.
• If there are no involved parties with type of complainant, look for involved parties with type of subject of allegation and use their country.
• If there are no involved parties with a country that can be used, then only skills are used.

**Note:** For more information, see [Add or modify a matching rule](#).

You can restrict an ER case to be assigned to only members of a specific group. See [Configure an employee relations case restriction](#).

**Use HR Service Delivery Employee Relations**

Creating an HR Service Delivery Employee Relations (ER) case is similar to creating any HR case with some differences.

Currently, HR Service Delivery supports one type of ER case:

• Report Misconduct
  Falls under the COE:
  ◦ Employee Relations Case

**Opened for is not an employee**

When creating HR cases, you must identify an Opened for person. For ER cases, you are not required to identify the Opened for person.

• If you are an HR agent and using the HR case form or Agent Workspace, select **Skip verification** from the Case Creation Search for Employee form.

**Related information**

After opening an ER case, related information provides the details of an ER case and includes:

• Allegations
• Involved Parties
• Interviews

**Allegations**

Allegations provide additional details about the misconduct and includes:

• Allegation type
• Description
• Involved parties

**Involved Parties**

As part of capturing important information about the misconduct, you can capture information about anyone involved.

Information like:
• The type of involved party. Is the involved party a:
  ◦ Witness
  ◦ Complainant
  ◦ Subject of allegation
  ◦ Other
• Is the involved party a user in the system or not a user.

Interviews
Interviews from all related parties are important and captures the following information:
• The interview date
• Names of the interviewers
• Name of the person being interviewed
• Any people you want to link to the investigation
• Notes on the interview

Employee using Employee Service Center (ESC) or Service Portal
When an employee creates an ER case from the Employee Service Center (ESC) or Service Portal, the Opened for, Opened by, and Complainant are assigned to the employee.

⚠️ Note: A role is not required for employees to create an ER case.
• Agents that can work an ER case must have the HR ER case writer [sn_hr_er.case_writer] role.
• Agents that can access/read an ER case must have the HR ER case reader [sn_hr_er.case_reader] role.

Create an HR Service Delivery Employee Relations case
You create ER cases for employees that wish to report misconduct or report a disciplinary issue.

Before you begin
Role required: sn_hr_er.case_writer

Procedure
1. Navigate to HR Case Management > Create New Case.
2. From Search for Employee, enter an employee name or click Skip verification.
### Case Creation form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>The <strong>Center of Excellence</strong> associated with the HR case you are creating. Currently, Employee Relations Case is the only COE available for ER cases. Selecting a COE filters the choices for HR service. See <a href="https://servicenow.com">HR Centers of Excellence data model</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can also select an HR service first and the associated COE automatically populates.</td>
</tr>
<tr>
<td>HR service</td>
<td>The HR service based on the COE selected or what you select based on communication with the employee request. Currently, Report Misconduct is the only HR service available for ER cases. What HR services are available to an employee filter by: • COE selected. • HR criteria for the <strong>Subject person</strong> based on the HR service configuration. Limit services filter on the <strong>Case Creation Configuration</strong> form. If the HR service field is empty, ensure that you did not remove the Opened for field.</td>
</tr>
<tr>
<td>Note:</td>
<td><strong>Bulk Parent Case</strong> does not appear as a selection because it only appears when creating a parent case for child bulk cases. Refer to <strong>Add or modify bulk HR cases</strong>.</td>
</tr>
<tr>
<td>Document Template Type</td>
<td>Category from which a document template is selected.</td>
</tr>
<tr>
<td>Note:</td>
<td>This option appears only when the Document Templates [com.snc.document_templates] plugin is activated, and the <strong>Document Template Type</strong> field is selected while configuring the HR service.</td>
</tr>
<tr>
<td>Document Template</td>
<td>Document template associated to the case to generate document template tasks.</td>
</tr>
<tr>
<td>Note:</td>
<td>This option appears only when the Document Templates [com.snc.document_templates] plugin is activated, and the <strong>Document Template</strong> field is selected while configuring the HR service.</td>
</tr>
<tr>
<td>Subject person</td>
<td>The person the HR service request is for. Click the <strong>Lookup using list</strong> icon to find a user. Use the choice list to search and select another employee. Click the <strong>Reference field</strong> icon to view or edit <strong>HR profile</strong> information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Selecting the <em>Do Not Default Subject Person</em> HR Service Option for an HR service, prevents the <em>Subject Person</em> from automatically filling in when creating an HR case. For more information, see <em>Configure an HR service.</em></td>
<td></td>
</tr>
</tbody>
</table>

Work notes

Information specific to the case that can help other HR agents. *Work Notes* are not visible to the *Subject person.*

The `sn_hr_core.restrict_guest_email` system property allows a user to send an email from a personal email account referencing an HR case. When the property has a value of false (default), the text from the email appears in the Work notes field. To access system properties, enter `sys_properties.list` in the navigation filter.

**Note:** Translate the text in your preferred language using the *Translate* option. For configuring the dynamic translation framework, see *Dynamic translation.*

3. Click *Create Case* and the *HR case* form appears with additional information about the case. The *COE* and *HR service* selected for the HR case determines the fields that appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An HR case number is assigned and is a unique identifier, cannot be changed, and has an HRC prefix.</td>
</tr>
</tbody>
</table>
| External opened for | The ER case was reported by somebody outside of your company. Checking this box removes the following fields:  
  - *Opened for*  
  - *Preferred contact method* |
| Opened for       | The person who is responsible for the HR service request.  
  **Note:** Unlike other HR cases, you can leave this field blank.  
  - The person requesting the HR service. When you make an HR service request for yourself, the *Subject person* and *Opened for* person are the same.  
  - The person requesting the HR service on behalf of an employee. For example, a manager requesting an HR service for a direct report. In this example, the |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>manager (Opened for) made an HR request on behalf of an employee (Subject person). Use the choice list to search and select another employee.</td>
</tr>
<tr>
<td></td>
<td>Click the Reference field icon to view or edit HR profile information.</td>
</tr>
<tr>
<td>Preferred contact method</td>
<td>The communication method the Opened for person (if applicable) prefers to be contacted. Select:</td>
</tr>
<tr>
<td></td>
<td>• Not Specified</td>
</tr>
<tr>
<td></td>
<td>• Personal Phone</td>
</tr>
<tr>
<td></td>
<td>• Work Phone</td>
</tr>
<tr>
<td></td>
<td>• Personal Email</td>
</tr>
<tr>
<td></td>
<td>• Work Email</td>
</tr>
<tr>
<td>Incident date</td>
<td>The date of the incident. If there are multiple incidents, select the date of the most recent incident.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case. Skills can auto-populate based on the HR case template associated with the HR service.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the case. The state can auto-populate based on the HR case or task template associated with the HR service.</td>
</tr>
<tr>
<td></td>
<td>• Draft: The default state for a case when it is first opened.</td>
</tr>
<tr>
<td></td>
<td>⚠️ Note: Can only be changed to Ready, Closed Complete, Closed Incomplete, Cancelled, or Suspended.</td>
</tr>
<tr>
<td></td>
<td>• Ready: The case is ready to be worked on.</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Incomplete</td>
</tr>
<tr>
<td></td>
<td>• Cancelled</td>
</tr>
<tr>
<td></td>
<td>• Suspended: Use to temporarily prevent violation of a service level agreement (SLA). Refer to Suspend and resume an HR case.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority that the incident needs resolution. Use impact and urgency to determine the priority.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source</td>
<td>The reporting method the incident was opened.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time the ER case was opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The person who created the ER case.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group the ER case is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the Assigned to field. For automatic assignment, refer to HR Service Delivery Employee Relations assignment rules.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. When a group is automatically assigned, a user from the group is automatically assigned when the case is created. If the user is not auto-assigned, click the Lookup using list icon to select a user who is a member of the selected assignment group. To change the Assigned to HR agent, the agent must be a member of the Assignment group.</td>
</tr>
<tr>
<td>Collaborators</td>
<td>Agents or interested parties you want to associate with the case. Collaborators can track and stay up-to-date on the progress of the ER case. If an ER case transfers from the assigned to agent to another agent, the original assigned to agent can add themselves as a collaborator and still monitor the case. By having visibility to the case, collaborators can also help the assigned to agent with the case. Other factors: Collaborators can remove themselves from the case. The Assigned to agent can add or remove collaborators. Collaborators cannot add or remove collaborators. Notifications are sent to the collaborators when added to the ER case.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Interested parties that can view all updates and receive notifications for the ER case.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Populates from the HR service. After the case is created, you can modify the description.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer, detailed description after the ER case is created. Use the Rich Text Format (RTF) tools to format your text. Rich text formatting also appears for a case or task description on the Employee Service Center or service portal.</td>
</tr>
</tbody>
</table>

The following embedded lists appear:

**Fulfillment Instructions**

Information on how to complete the case. This information is defined in the HR Service configuration.

A checklist outlining the exact steps to complete appears when configured by the HR service. See [Configure an HR service](#).

**Comments and Work Notes**

Comments or work notes that provide details about the case. Work notes are not visible to the **Subject person**.

⚠️ Note: Translate the text in your preferred language using the **Translate** option. For configuring the dynamic translation framework, see [Dynamic translation](#).

**Related Links**

The following appear dependent on the type of case and roles associated with the user:

- Add Task: Task you want to add to the case. Refer to [Add an HR task to an HR case](#).
- Show SLA Timeline: The SLA in timeline format that shows elapsed time.
- Repair SLAs: Click to repair any service level agreements associated with the case.

The related lists appear dependent on type of case or task. For additional information, see [Work an HR case](#).

**Involved Parties**

People associated with the ER case. Involved parties can be the complainant, subject of the allegation, a witness, or other (undefined).

**Allegations**

Information that further defines an employee relations case.

**Interviews**

Interview record for an involved party. For more information, see [Create an interview in HR Service Delivery Employee Relations](#).

**Corrective Actions**

Information about the resolution and any associated corrective actions after an investigation related to the ER case.
Attached Knowledge
List of knowledge articles attached to the HR service type.

Approvers
Lists employees that can approve changed information or the case, state of approval, comments, and associated dates.

⚠️ Note: To reject an approval, users should have the HR case writer [sn_hr_core_case.writer] role.

HR Cases
Child cases for the current case.

ER Cases for Involved Parties
ER cases for the involved parties of the ER case.

Create an involved parties record for HR Service Delivery Employee Relations
Capture information about people associated with the ER case. Involved parties can be the complainant, subject of the allegation, a witness, or other (undefined).

Before you begin
Role required: sn_hr_er.case_writer

Procedure
1. Navigate to Employee Relations > Involved Parties.

![Involved Party form](image)

2. Fill in the fields in the Involved Party form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR case</td>
<td>The HR employee relations case number.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of involved party. Select:</td>
</tr>
</tbody>
</table>
### Field Description

- **Complainant** (the person or group that makes a complaint).
- **Subject of allegation**
- **Witness**
- **Other**

**Not in system**

Option for indicating the involved party is not an employee of your company.

**Note:** When you check this box, the Name field replaces the User field.

**User**

The person who is the involved party. Only appears when you don’t check the Not in system box.

**Name**

The name of the involved party. Only appears when you check the Not in system box.

---

3. Click **Save** or **Submit**.

- Use the **Interviews** tab to create and associate an interview record with an involved party. For more information, see *Create an interview in HR Service Delivery Employee Relations*.

- Use the **Corrective Actions** tab to create and associate a corrective action record with an involved party. For more information, see *Create an involved parties record for HR Service Delivery Employee Relations*.

- Use the **HR Tasks** tab to create and associate an HR task with an involved party. For more information, see *Add an HR task to an HR case*.

### Create an allegation record for HR Service Delivery Employee Relations

Allegations provide details for an ER case.

**Before you begin**

Role required: sn_hr_er.case_writer

**Procedure**

1. Navigate to **Employee Relations > Allegations**.
2. Fill in the fields in the Involved Party form.

### Allegation form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR case</td>
<td>The HR case number associated with the allegation.</td>
</tr>
<tr>
<td>Allegation type</td>
<td>The allegation type describing the ER case. Allegation subtypes further describe an allegation. Allegation types are:</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Customer Mistreatment  
Discrimination  
Drugs and Alcohol  
Fraud and Theft  
Harassment  
Interpersonal Conflict  
Misconduct  
Retaliation  
Wage and Scheduling  
Workplace Violence  

| Allegation subtype | Further describes an allegation type. Your choice of allegation subtype is dependent on what you select for allegation type. |
| Description | Details about the allegation. |

3. Click **Save** or **Submit**. The Subjects of Allegation section appears.

4. Click the Lookup using list icon and the Involved Parties list appears.

5. Click **New** to add an involved party to the allegation. Or, search for specific names or type of involved party. For more information, see Create an involved parties record for HR Service Delivery Employee Relations.

6. Click **Update** or **Save**.

**Create an interview in HR Service Delivery Employee Relations**

Documenting interviews is crucial to ER cases. Use the Interview form to take notes and capture important details of the ER case.

---

© 2022 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Before you begin
Role required: sn_hr_er.case_writer

Procedure
1. Navigate to Employee Relations > Interviews. You can also create an allegation from the Related list of an ER case.
2. Fill in the fields in the Involved Party form.

<table>
<thead>
<tr>
<th>ER Interview</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Number</td>
<td>The number identifying the interview record.</td>
</tr>
<tr>
<td></td>
<td>Interview numbers are automatically assigned and cannot be changed.</td>
</tr>
<tr>
<td>HR case</td>
<td>The HR ER case number associated with the interview.</td>
</tr>
<tr>
<td>Note:</td>
<td><strong>Note:</strong> If you access interview from an HR ER case, the number automatically appears.</td>
</tr>
<tr>
<td>Interview date</td>
<td>The date the interview took place.</td>
</tr>
<tr>
<td>Interviewers</td>
<td>Names of the people who conducted the interview.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon and search for the names of the people who conducted the interview.</td>
</tr>
<tr>
<td></td>
<td>You can optionally enter the email addresses for each interviewer.</td>
</tr>
<tr>
<td>Interviewee</td>
<td>Name of the person who was interviewed.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon and search for the names of the people who conducted the interview.</td>
</tr>
<tr>
<td>Additional parties</td>
<td>Other people you want as part of the interview record.</td>
</tr>
<tr>
<td></td>
<td>Click the Add me icon to add yourself</td>
</tr>
<tr>
<td></td>
<td>or the Unlock additional parties icon to add yourself or other people.</td>
</tr>
<tr>
<td></td>
<td>You can optionally enter the email addresses for each interviewer.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes from the interview.</td>
</tr>
</tbody>
</table>

3. Click Save or Submit.

Create a corrective action in HR Service Delivery Employee Relations
Create a corrective action record for an ER case.
**Before you begin**
Role required: sn_hr_er.case_writer

**Procedure**
1. Navigate to **Employee Relations > Corrective Actions**.
2. Fill in the fields of the Corrective Actions form.

### Corrective Actions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number identifying the corrective action record. The system automatically assigns the corrective action numbers and you cannot change it.</td>
</tr>
<tr>
<td>HR case</td>
<td>The HR ER case number associated with the corrective action.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you access corrective actions from an HR ER case, the number automatically appears.</td>
<td></td>
</tr>
<tr>
<td>Involved party</td>
<td>The person the corrective action is for.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon and select from the list.</td>
</tr>
<tr>
<td>Corrective action type</td>
<td>The corrective action for this ER case. Select from the list:</td>
</tr>
<tr>
<td></td>
<td>• Verbal warning</td>
</tr>
<tr>
<td></td>
<td>• Written warning</td>
</tr>
<tr>
<td></td>
<td>• Suspension</td>
</tr>
<tr>
<td></td>
<td>• Termination</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the corrective action.</td>
</tr>
<tr>
<td></td>
<td>• Draft</td>
</tr>
<tr>
<td></td>
<td>• Ready</td>
</tr>
<tr>
<td></td>
<td>• In progress</td>
</tr>
<tr>
<td></td>
<td>• Completed</td>
</tr>
<tr>
<td>Discussion date (yyyy-MM-dd)</td>
<td>Select the date of the corrective action discussion.</td>
</tr>
<tr>
<td>Discussion held by</td>
<td>The lead user of the corrective action discussion.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon and search for the person who led the discussion.</td>
</tr>
<tr>
<td>Also present</td>
<td>Identifies other people that were part of the discussion.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Click the Add me icon to add yourself</td>
<td>or the Unlock additional parties icon to add yourself or other people.</td>
</tr>
<tr>
<td>Due date (yyyy-MM-dd HH:mm:ss)</td>
<td>The date and time the corrective action is complete.</td>
</tr>
<tr>
<td>Description</td>
<td>Notes and information on the corrective action meeting.</td>
</tr>
</tbody>
</table>

3. Click Save or Submit.

**HR Service Delivery Employee Relations dashboards**

The HR Service Delivery Employee Relations dashboards provides visual reports that give you statistics on ER cases.

There are four (4) sections that provide information:

- Employee Relations Case Volume by Month
  - A bar chart showing the number of ER cases per month and year. Click a bar and the Employee Relations Cases list appears.

- Employee Relations Case Volume by Allegation Type
  - A bar chart showing the number of ER cases by Allegation Subtype. Click a bar and the Allegations list appears.

- Employee Relations Case Volume by Location
  - Map showing the number of ER cases per geographic region. Click the country and a detailed view appears.

- Employee Relations Case Volume by Department
  - Shows the number of ER cases by company department. Click the image and the Involved Parties list appears.
Employee Relations Performance Analytics dashboard

The HR Service Delivery Employee Relations (ER) Performance Analytics (PA) dashboard provides you with historical trends, data comparisons.

The HR ER PA dashboard provides timely information for the following:

**Executive overview**

Provides data on trends or areas of concern that are emerging and require a deeper analysis in order to create proactive strategies.

**Investigation analysis**

ER investigation leaders need to understand the quality of service in an ER investigation and be able to identify trends beyond individual cases. Comparing cases and trends in allegation data are important in this area.

**Case analysis**

Provides case metrics and goals for ER agents and teams. Having this information can also help your ER teams plan their workload based on volume trends and the details on case data.

**Analytics and Reporting Solutions for Employee Relations**

Analytics and Reporting Solutions contain prepackaged Performance Analytics and Reporting content for use with other Now Platform products. This Analytics and Reporting Solution provides you with historical trends and data comparisons for Employee Relations to assess organizational performance.

**Required roles**

The following roles and tasks are associated with this Solution:
Now Platform administrator (admin): Install and activate this Analytics and Reporting Solution and make any necessary changes to system properties.

Performance Analytics administrator (pa_admin): Review the indicators, breakdowns, widgets, and dashboards. Set up and start data collection. Share the dashboards with appropriate stakeholders.

HR Service Delivery Employee Relations case reader (sn_hr_er.case_reader): Grants access to read all HR ER cases and the Employee Relations Executive Overview.

Related information

Analytics and Reporting Solutions

Activate the Analytics and Reporting Solution for Employee Relations

Activate the content pack plugins for the Analytics and Reporting Solution.

Before you begin

Activate the full, subscription version of Performance Analytics on the instance where you are activating this Analytics and Reporting Solution. You can activate Performance Analytics on a sub-production instance without purchasing a subscription. For more information, see Activate your Performance Analytics subscription.

Role required: admin

About this task

Activate the following plugins prior to activating the Performance Analytics - Content Pack - Human Resources: Employee Relations Scoped App [com.sn_hr_employee_relations_pa] plugin:

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Scoped App: Core [com.sn_hr_core]</td>
<td>Enables you to standardize the documentation, interaction, and fulfillment of employee inquiries and requests.</td>
</tr>
<tr>
<td>Human Resources Scoped App: Employee Relations [com.sn_hr_employee_relations]</td>
<td>Enables you to easily manage employee relations and investigations cases.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Applications > All.

2. Search for Human Resources Scoped App: Employee Relations [com.sn_hr_employee_relations].

3. Install the application.

4.
Configure the Analytics and Reporting Solution for Employee Relations

Run diagnostics, review and customize components, and start collecting data.

Before you begin
A Now Platform administrator must have installed the content pack plugins or ServiceNow Store application for this Analytics and Reporting Solution.
Role required: pa_admin

Procedure
1. Run all diagnostics on all records, as described in Performance Analytics diagnostics.
   These diagnostics can catch many mismatches between the configuration of your Analytics and Reporting Solutions and your tables.
2. Navigate to Performance Analytics > Administration Console.
3. Click the Dashboards link in the Explore and Manage tile.
4. Verify the names of the dashboards that have been installed with this Analytics and Reporting Solution.
   - Employee Relations Executive Overview
5. Open the Indicator Sources tab.
6. For each dashboard included in this Analytics and Reporting Solution:
   a. Filter the indicator sources on the dashboard name.
   b. Review the facts table, conditions, and frequency of the indicator sources compared to the data structure on your own instance.
   c. If necessary, open an indicator source and make corrections.

Example
This screenshot shows the indicator sources filtered on the Self-Service Analytics dashboard from the Employee Relations Executive Overview.
d. If you are editing an indicator source record, go to the Indicators related list and review the **Conditions** field for each indicator.

Changing the indicator source can also affect the additional conditions on the individual indicators.

7. If you changed the time field stamps in any indicator sources, also change any related Performance Analytics scripts.

For more information, see **Update Performance Analytics scripts**.

8. Open the Breakdown Sources tab.

9. For each dashboard included in this Analytics and Reporting Solution:

a. Filter the breakdown sources on the dashboard name.

b. Review the conditions on the breakdown source as described in **Review the breakdown sources**.

10. Navigate to **Performance Analytics > Jobs**.

11. Set up and run the historical job for this Analytics and Reporting Solution, ERCases.HistoricalDataCollection.

Follow the procedure in **Run historical data collection for an Analytics and Reporting Solution**.

12. Edit and activate the scheduled data collection job for this Analytics and Reporting Solution, ERCases.DailyCollection.

Follow the procedure in **Schedule data collection for an Analytics and Reporting Solution**.

**Employee Relations Executive Overview dashboard**

The Employee Relations Executive Overview dashboard provides you with high level data on Employee Relations cases and detailed information on the types of ER cases, locations, cases by HR service and department, and trends.
Required Now Platform roles
• sn_hr_er.case_reader

Use cases
For examples of how different people in your organization would use this dashboard, see these use cases.

<table>
<thead>
<tr>
<th>User</th>
<th>Dashboard use</th>
</tr>
</thead>
</table>
| Employee Relations employee or HR leadership | The dashboard provides:  
• A high-level overview of the current ER case volume, status, and distribution.  
• An understanding of the top ER case types and issues by different employee populations.  
• Identification of hot spots early so they can be resolved quickly.  
• An analysis of trends and changes that can inform process improvements and ER strategy. |

Indicators

**ERCases.CorrectiveActions**
Checks corrective actions taken for closed cases.

**ERCases.AllegationTypes**
Shows data for each allegation type on open ER cases.

**ERCases.Restricted**
The number of restricted ER cases.

**ERCases.NewThisWeek**
The number of ER cases created this week.

**ERCases.Open**
The total number of open ER cases.

**ERCases.PastSLA**
The number or ER cases that have past the Service Level Agreement (SLA).

Breakdowns
• ERCases.AllegationTypes
• ERCases.CorrectiveActionTypes
• ERCases.HRService
• ERCases.Priority
• ERCases.State
HR Knowledge Management

HR knowledge management allows the enterprise HR department to provide employees with a searchable knowledge base of HR policies, procedures, and other articles. By sharing information with employees, HR can reduce the time spent answering routine questions and enable employees to find answers that are relevant to them.

**Note:** Knowledge Management V3 is automatically enabled with the Case and Knowledge Management application. If you want to enable advanced features such as article versioning, you must activate Knowledge Management Advanced.

HR knowledge bases

The Case and Knowledge Management application provides the following preconfigured HR knowledge base:

- Human Resources General Knowledge

A knowledge administrator can create additional HR knowledge bases. Each knowledge base can be assigned to a knowledge owner and managers, as well as have unique workflows, user criteria, and category structures. See Create a knowledge base for more information.

HR knowledge articles

Each knowledge base contains knowledge articles, which are organized into categories and subcategories. For example, knowledge articles in the Human Resources General Knowledge base are organized among six categories.

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open cases by location</td>
<td></td>
<td>Employee Realties</td>
<td>Provides the number of open ER cases by geographical location. This data can help you recognize trends or you can use it for data comparisons. The location represents the location of the Opened for users at the time the case was opened.</td>
</tr>
<tr>
<td>Case [sn_hr_er_case] table</td>
<td>42</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Knowledge contributors can create HR knowledge articles in a knowledge base.

- Create an HR knowledge article

You can also attach or link HR knowledge articles to an HR case or HR catalog item.

- Attach knowledge articles to an HR case
- Link knowledge articles or managed documents to an HR catalog item

**HR knowledge blocks**

You can use knowledge blocks with HR knowledge management to simplify knowledge authoring for writers and knowledge consumption for readers. Knowledge blocks are reusable pieces of content secured by user criteria that you can add to knowledge articles in a knowledge base. The user criteria controls which users can read or not read the block content in an article or search, enabling users to more easily view content that is relevant to them.

- Knowledge blocks for HR knowledge management

**Related information**

- Knowledge Management

**Create an HR knowledge article**

Create or modify a knowledge article within an HR knowledge base to share HR information across your organization.

**Before you begin**

Role required: none. User must have contributor access to the knowledge base.

**Procedure**

1. Navigate to **HR Administration > Knowledge Management > Create New Article**.
2. Fill in the fields on the form.

**Knowledge form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>This field is automatically set to a knowledge article number.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Name of the knowledge base.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> You can use an existing or create a new HR knowledge base. See <strong>Create a knowledge base</strong> for more information.</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Name of the knowledge category or subcategory.</td>
</tr>
<tr>
<td><strong>Note:</strong> You can use existing or create categories to organize the articles in the knowledge base. Click the Lookup icon to open the category picker, where you can select, add, and edit knowledge categories and subcategories.</td>
<td></td>
</tr>
<tr>
<td>Valid to</td>
<td>Date that the knowledge article expires. After the valid to date, or if the valid to field is empty, the article does not appear in the search results.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the knowledge article.</td>
</tr>
<tr>
<td>Text</td>
<td>Text of the knowledge article.</td>
</tr>
<tr>
<td>Article type</td>
<td>Type of knowledge article: HTML or Wiki.</td>
</tr>
<tr>
<td>Workflow</td>
<td>This field is automatically set to the publication state of the article, such as Draft, Published, or Retired.</td>
</tr>
<tr>
<td>Source Task</td>
<td>This field is automatically set to the task record that the article was created in response to, if applicable.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Check box for enabling the automatic download of attachments. If selected, attached files automatically download when the user opens the article.</td>
</tr>
<tr>
<td><strong>Note:</strong> Currently, this option is not supported on the Employee Service Center.</td>
<td></td>
</tr>
<tr>
<td>Display attachments</td>
<td>Check box for enabling the display of attachment. If selected, attached files are displayed and accessible to users at the bottom of the article.</td>
</tr>
<tr>
<td><strong>Note:</strong> This option is contingent upon adding one or more attachments to the article. To add or manage attachments, click the paperclip icon in the title bar.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click **Save** or **Update** to create or update the article.
4. Click **Publish** to publish the article.

**Note:** Any additional steps required to publish the knowledge article, such as approvals, depend on the publishing workflow for the knowledge base. See [Knowledge workflows](#) for more information.

## Attach knowledge articles to an HR case

Attach one or more knowledge articles to an HR case to help process that record. For example, you can attach an article about the company dress code policy when an HR case is submitted that asks about wearing shorts to work.

### Before you begin

Role required: hr_basic or hr_case_writer

### Procedure

1. Navigate to **HR Case Management > All HR Cases**, and open one of the modules, such as **Assigned to me** or **Open**.

2. Open an HR case.

3. Click **Related Search Results**.

   ![Related Search Results](image)

   The following options are displayed in a list:

   - **Knowledge Articles**: Based on the short description of the HR case and the user criteria that is associated with the knowledge base, relevant knowledge articles are displayed in two tabs: **My Results** displays a list of articles you can access. **[employee name] Results** displays a list of articles that the Opened for employee can access.

   - **Similar Knowledge Articles**: Based on the short description of the HR case, user criteria associated with the knowledge base, auto-training of the Similar Knowledge Articles for HR Case (ml_sn_sn_hr_core_global_case_to_articles) solution definition, similar knowledge articles are displayed in the **My Results** tab.

      The **Similar Knowledge Articles** option narrows down and displays the most relevant knowledge articles to resolve the HR case. This option is displayed only when the Predictive Intelligence for Contextual Search plugin is activated along with Human Resources Scoped App: Core plugin.

4. Review the list of suggested knowledge articles, and:
### Option Description

**Preview the article**
Click the article title. After reviewing the article in the pop-up window, click **Attach to HR Case** if it is relevant, or click (X) to close the article.

**Attach the article without previewing it**
Click **Attach** next to the article.

i **Note:** When you attach an article, its text is copied to **Additional comments**. After you save the case, it also appears in the **Attached Knowledge** related list.

### 5. Click **Save**.

#### Create a knowledge article from an HR case

Create a knowledge article from an HR case. When an HR case is closed and the **Knowledge** check box is selected on the HR case form, a draft knowledge article is created that you can edit and publish for employees to reference.

#### Before you begin
An administrator must have enabled the creation of knowledge articles from HR cases. See [[[ Enable creating a knowledge article from an HR case ]]] for more information.

**Role required:** hr_case_writer. User must also have contributor access to the knowledge base.

#### Procedure

1. Navigate to **HR Case Management** > **All HR Cases**, and open one of the modules, such as **Assigned to me** or **Open**.
2. Open an HR case.
3. On the HR case form, select the **Knowledge** check box.

   i **Note:** If the **Knowledge** check box is not visible, you can add the field to the form by right-clicking the form header and navigating to **Configure > Form Layout**.
4. Close the HR case.
Results
A draft knowledge article is created. The following content is copied from the HR case form the knowledge article form.

<table>
<thead>
<tr>
<th>Field on HR case form</th>
<th>Field on knowledge article form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Source</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Article body</td>
</tr>
</tbody>
</table>

What to do next
To edit and publish the knowledge article, navigate to Knowledge > Articles > Unpublished. For further details on the form fields, see Create an HR knowledge article.

Knowledge blocks for HR knowledge management
You can use knowledge blocks with HR Service Delivery to simplify knowledge authoring for writers and knowledge consumption for readers. Knowledge blocks are reusable pieces of content secured by user criteria that you can add to knowledge articles in a knowledge base. The user criteria controls which users can read or not read the block content in an article or search, enabling users to more easily view content that is relevant to them.

How to use knowledge blocks
To use knowledge blocks, a knowledge administrator or manager must enable the knowledge blocks feature for each knowledge base in which the blocks will be used.

• Enable knowledge blocks for each knowledge base

Knowledge contributors can create knowledge blocks and insert them into articles in a knowledge base:

**Note:** Knowledge blocks are not supported in articles of type wiki.

• Create a knowledge block
• Add knowledge blocks to a knowledge article
• Preview a knowledge article with knowledge blocks by user or date

Knowledge block content can be read or not read in an article or search based on user criteria set at the knowledge base and knowledge block level. See Select user criteria for a knowledge block for more information.

Example: Holiday calendar with location-specific knowledge block content
You are part of an enterprise HR organization that maintains a company knowledge base. You want to create a holiday calendar so that employees know which days of the year are company holidays. Since the company has multiple locations and holiday dates vary based on where the employee is located, there are several ways that you could create the knowledge article.

One way is that you could create a knowledge article for each location, with an article for Location A, Location B, and so on.

• Pros: simplified consumption. Employees have a single article to search for and read.
• Cons: more work for HR. HR has multiple articles to manage and update for each location where the company has employees.
Another way is that you could create a single knowledge article that includes sections for each location.

- Pros: simplified authoring. HR has a single article to manage and update.
- Cons: more work for employees. Employee must scroll through and disregard extraneous content to find the section in the article that pertains to them.

With knowledge blocks, you can create a single knowledge article with location-specific block content secured by user criteria. This approach helps to reduce the workload for both HR and employees. As an HR agent, you have a single article to manage and update. Employees have a single article to search for and read, with the user criteria ensuring that they only view content that is relevant to them.

**If you are using a custom search or knowledge article viewer**

If you are using a custom search or knowledge article viewer with your application, you should integrate it with the appropriate knowledge or knowledge blocks API. (Integration is only necessary if you are using a custom search or knowledge article viewer.)

- Integrating a custom search or knowledge article viewer with knowledge blocks

**Activation information**

To use knowledge blocks in your application, you must activate knowledge blocks. For information on what components are installed with the feature, see Components installed with knowledge blocks.

**Note:** Activating knowledge blocks automatically activates Knowledge Management Advanced, which enables advanced features such as article versioning. Knowledge blocks can be used with or without the article versioning feature. To disable the feature, see Disable the article versioning feature.

**Related information**

- Knowledge blocks

**HR Dashboards & Reports**

The HR Dashboards & Reports application provides the HR organization with visual representations of accountability, progress, performance metrics, monitor employee satisfaction, and status on HR cases in the scoped version of HR.

Depending on your HR job function, you can use any of the following tools to help you with day-to-day HR operations.

- Dashboards, including the Overview, Case, and Manager Dashboard. Dashboards are a type of homepage containing reports and other widgets. You click a listed record or a segment in a report to see details.
- HR reports, including reports that are available on the dashboards. Several HR reports are predefined for you, and you can create more reports.
- Survey response charts and detail for the HR case satisfaction survey or other HR surveys that you create.

You can customize any dashboard that you can access to add or remove reports and other widgets. For example, an HR benefits administrator adds a report to the Overview dashboard that displays the status of HR cases in the **Benefits** service.
### Add content
Click, highlight topics, and move to sections of the page.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add content</td>
<td>Click, highlight topics, and move to sections of the page.</td>
</tr>
<tr>
<td>Change Layout</td>
<td>Click the column layouts on the left.</td>
</tr>
<tr>
<td>Save the chart as an image file</td>
<td>If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.</td>
</tr>
</tbody>
</table>

The HR Dashboards & Reports provide:
- Overview
- Manager Dashboard
- HR Case Dashboard
- Reports
- Satisfaction Survey Scorecard

**View Overview Dashboard**
The Overview dashboard provides a graphical representation of HR cases.

**Before you begin**
Role required: sn_hr_core.manager

**About this task**
By default, the Overview Dashboard shows the following reports:
- **HR Cases Opened in the Last 6 Months by Topic Category**: Provides a color coded bar chart on the number of cases opened in the last six months by type of Topic Category.
- **Active HR Case Breakdown by Topic Category**: Provides a bar chart color coded by active HR cases and the HR agent assigned.
- **Active HR Cases by Topic Category**: A pie chart, color coded by active HR cases by Topic Category.
- **Active HR Cases Pivot Table by Topic Category**: A spreadsheet that cross-references the HR agent assigned to the HR case by Topic Category with number of cases.

You can customize any dashboard that you can access to add or remove reports and other widgets.

**Procedure**
1. Navigate to **HR Dashboards & Reports > Overview**.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add content</td>
<td>Click, highlight topics, and move to sections of the page.</td>
</tr>
</tbody>
</table>
View Manager Dashboard

You can use the Manager Dashboard to monitor HR team effectiveness based on metrics. Metrics includes state of assigned cases by HR agent and service level agreement (SLA) elapsed time percentage.

Before you begin
Role required: sn_hr_core.manager

About this task
By default, the following reports appear on the Manager Dashboard:

- Case Satisfaction Survey - 30 Day AVG: Evaluate the satisfaction of employees with the handling of HR cases. This chart shows information if you ask employees to complete the HR Request Satisfaction Survey.
- HR Case SLAs by Elapsed Time Percentage: Monitor the time to resolve HR cases and follow up when case SLAs are breached.
- Active HR Cases by Assignment And State: Review the numbers of HR cases assigned to each HR agent by state, for example, Ready or Work in Progress, to help you evaluate the effectiveness of each HR agent.
- HR Case Transfer Rate: Review the number of cases transferred to a different HR agent by case category to determine whether the right assignments are taking place.

You can customize any dashboard that you can access to add or remove reports and other widgets. For example, an HR benefits administrator adds a report to the Manager Dashboard that has the assignment and state of HR cases in the Benefits category.

Procedure

1. Navigate to HR Dashboards & Reports > Manager Dashboard.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Layout</td>
<td>Click the column layouts on the left.</td>
</tr>
<tr>
<td>Add content</td>
<td>Click, highlight topics, and move to sections of the page.</td>
</tr>
<tr>
<td>Change Layout</td>
<td>Click the column layouts on the left.</td>
</tr>
<tr>
<td>Save the chart as an image file</td>
<td>If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.</td>
</tr>
</tbody>
</table>

View HR Case Dashboard

The HR Case Dashboard is a central place for HR users to monitor ongoing HR operations. The dashboard contains reports that query the database and display the results.
Dashboards are the home pages for products on the ServiceNow instance. The HR Case Dashboard provides summary information about your Open/Assigned cases, High Priority cases, and cases breached by the Service Level Agreement (SLA). It displays cases by service and cases assigned to you.

To show the HR Case Dashboard, navigate to **HR Dashboards & Reports > HR Case Dashboard**.

**Features of the HR Case Dashboard**

The HR Case Dashboard shows:

- The number of Open/Assigned cases.
- The number of High Priority cases.
- The number of cases that have breached an SLA.
- The details of all cases assigned to you.
- All cases assigned to you by Topic Category.

**Run Reports**

You can run reports to view and monitor the status of HR cases.

**Before you begin**

Role required: sn_hr_core.manager, sn_hr_core.admin, sn_hr_core.basic

**About this task**

Use HR reports to improve overall efficiency and effectiveness. For example, you can view all Employee Relations cases that were created in the past month.

**Procedure**

1. Navigate to **HR Dashboards & Reports > Reports**.
   
   Reports in the HR report group are listed. The icon to the left of the report indicates the type of report, such as a list, pie chart, or bar chart. Point your cursor to the icon to see a pop-up window of report information. Click the star on the left to make the report a favorite. You can filter for favorite reports by clicking the star above the Reports list.

2. Click the name of the report to run.
   
   The report opens with the runtime options and the results.

3. Perform any of the following actions.
   
   - Change any runtime option and click **Run** to see the results.
   - In a list report, click a listed case to see its details.
   - In a chart, click a segment to see the corresponding cases.
   - Publish or schedule the report.
   - Edit the runtime options and save a new report.

**What to do next**

If you want to create additional HR reports, click **Create a report** above the Reports list. After you create reports, share them with the HR report group. Once on the Reports list, the group can view them.

**Related information**

- [Getting started with reports](#)
Available HR reports
Predefined HR reports are available in the **HR Case Management > Reports** list.

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active HR Cases</td>
<td>Tabular view of all active cases.</td>
<td>Number, Type, Category, State, Short description, Opened by, Assignment group, Assigned to</td>
</tr>
<tr>
<td>Active HR Cases Pivot Table by Category</td>
<td>Pivot table view of all active cases.</td>
<td>Assigned to, Category</td>
</tr>
<tr>
<td>Active HR Onboarding Cases by Assigned To</td>
<td>Tabular view of active onboarding cases, grouped by Assigned to.</td>
<td>Number, Priority, State, Short description, Opened by, Opened for, Assignment group, Assigned to</td>
</tr>
<tr>
<td>Active HR Onboarding IT Requests</td>
<td>Tabular view of onboarding tasks assigned to IT, for example, for computers and other office equipment.</td>
<td>Number, Priority, State, Short description, Assigned to, Location</td>
</tr>
<tr>
<td>Active HR Onboarding Tasks by Assigned To</td>
<td>Tabular view of open HR tasks for active onboarding HR cases, grouped by Assigned to.</td>
<td>Number, Case, Priority, State, Short description, Assignment group, Assigned to</td>
</tr>
<tr>
<td>Case Satisfaction Survey - 30 Days AVG</td>
<td>Bar chart showing the averages over 30 days of responses to the HR case satisfaction survey.</td>
<td>Average Actual Value, Metric</td>
</tr>
<tr>
<td>Cases Awaiting Approval</td>
<td>Count of unapproved HR cases or requests.</td>
<td>Number</td>
</tr>
<tr>
<td>HR Case SLAs by Assigned</td>
<td>Bar chart showing the number of overdue cases by the assigned user.</td>
<td>Count, User, State</td>
</tr>
<tr>
<td>HR Case SLAs by Elapsed Time Percentage</td>
<td>Bar chart showing the number of cases by the elapsed time percentage until the SLA is breached.</td>
<td>Count, Elapsed time percentage</td>
</tr>
<tr>
<td>HR Case Transfer Rate</td>
<td>Bar chart showing the number of reassignments for an HR agent by category for the last six months.</td>
<td>Number of reassignments, Category</td>
</tr>
<tr>
<td>HR Cases Opened Last Month by Category</td>
<td>Bar chart of cases raised over the last month by HR case category.</td>
<td>Category, Count, Month</td>
</tr>
<tr>
<td>HR Cases Opened This Month by Category</td>
<td>Bar chart of cases raised over the current month by HR case category.</td>
<td>Category, Count</td>
</tr>
</tbody>
</table>
Available reports (continued)

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Onboarding by Location</td>
<td>Bar chart showing the number of onboarding cases by location.</td>
<td>Location, Count</td>
</tr>
<tr>
<td>My HR Cases by Category</td>
<td>Pie chart of cases assigned to you, where each slice represents an HR case category.</td>
<td>Category, Count</td>
</tr>
<tr>
<td>Number of HR Profiles</td>
<td>Count of HR profile records.</td>
<td>Number</td>
</tr>
<tr>
<td>Open High Priority Cases</td>
<td>Count of active high priority HR cases</td>
<td>Number</td>
</tr>
<tr>
<td>Open Onboarding cases</td>
<td>Count of active onboarding cases</td>
<td>Number</td>
</tr>
<tr>
<td>SLA Breached</td>
<td>Count of HR cases with a breached SLA</td>
<td>Number</td>
</tr>
<tr>
<td>Unassigned HR Cases</td>
<td>List of HR cases not assigned to any user.</td>
<td>Number, Type, Category, State, Short description, Opened by, Assignment group, Assigned to</td>
</tr>
</tbody>
</table>

Related information

HR Administration

Evaluate HR survey responses

After you have collected responses to an HR survey, you can review the survey responses and scorecard.

Before you begin

Role required: sn_hr_core.manager, or sn_hr_core.admin

About this task

A scorecard displays charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.

Procedure

1. Navigate to HR Administration > Surveys > HR Surveys.
2. Click the survey to evaluate responses.
3. To review individual responses to each question, click the View Responses related link and perform any of the following tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>See individual responses for a metric (question)</td>
<td>Expand the metric group in the Metric Results list.</td>
</tr>
</tbody>
</table>
View responses based on when the survey was taken

Personalize the Metric Results list to include the **Created** column, and add a filter using the condition builder. For example, to see all responses since the beginning of the month, add this condition: `[Created] [at or after] [select date]`

If the survey was not submitted anonymously, you can see how users answered and follow up if necessary.

4. To review the survey scorecard, click the **View Scorecard** related link and perform any of the following tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display a different view for the scorecard</strong></td>
<td>Select the view from the left choice list above the chart. The interactive scorecard shows the name of the survey and results or comparisons of the ratings. Show results in the following views: following views:</td>
</tr>
<tr>
<td></td>
<td>• Category Results</td>
</tr>
<tr>
<td></td>
<td>• Question Results</td>
</tr>
<tr>
<td></td>
<td>• Average Ratings</td>
</tr>
<tr>
<td></td>
<td>• History</td>
</tr>
</tbody>
</table>

| **Save a chart as an image** | Click the menu icon and select the type of image file. After the file is generated, click **Download**. The file is downloaded to the download folder of your browser. |

**Related information**

HR surveys
Survey responses and results
View a survey scorecard

**Satisfaction Survey Scorecard**

You can modify the predefined HR satisfaction surveys to suit the needs of the organization, and create HR surveys.

**Before you begin**

Role required: sn_hr_core.admin, or sn_hr_core.manager

**About this task**

For example, to create an HR survey to gauge the satisfaction for more complex HR processes, such as onboarding.

Select a category from the list to display the questions from that category in the chart.

This view displays responses that use the following data types:

- Checkbox
- Choice
• Likert Scale
• Number
• Template
• Yes/No

Note: The Checkbox and Yes/No data types are combined into the Boolean data type in the Survey Designer

Survey category results

To view details about a specific response, point to a colored bar, the number of responses, and the percentage it represents displays.

Survey scorecard category results detail

HR Integrations

Integrate HR Service Delivery with: HR management systems to synchronize employee profiles, to-dos, and other data; background check systems to request background checks; e-signature systems to request electronic signatures; and more.

For select systems, preconfigured integrations are available to use. You can also configure your own custom integration with third-party systems that use SOAP or REST services.

Preconfigured integrations

HR Service Delivery provides preconfigured integrations for the following third-party systems.

<table>
<thead>
<tr>
<th>Third-party system</th>
<th>Preconfigured integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR management system</td>
<td>• Integrating with the SAP SuccessFactors service</td>
</tr>
</tbody>
</table>
### Third-party system Preconfigured integration

| Background check system | • Integrating with the First Advantage service  
 | • Integrating with the Accurate Background service  
 | • Integrating with the Sterling Talent Solutions service |

| E-signature system | • Integrating with the DocuSign service  
 | • Integrating with the Adobe Sign service |

| Tax form management system | • Integrating with the CIC Plus service |

### Custom integrations

If a preconfigured integration is not available for a third-party system used by your organization, you can set up your own custom integration.

- Custom third-party HR management system integrations
- Custom third-party background check system integrations

### Integrating with an HR management system

The following video provides an overview of integrating HR Service Delivery with a third-party HR management system. To set up the integration, you must provide the source credentials for the third-party system, configure the inbound integration, configure the outbound integration, and schedule the integrations job.

The Integrating with HR Management Systems video provides an overview of how to integrate HR Service Delivery with a third-party HR management system.

For the inbound integration, data is pulled from the third-party HR management system to the HR tables in HR Service Delivery as follows.

A schedule or an event triggered in the ServiceNow platform starts the process of pulling data from the HR management system using the HR service mapping configuration, which binds the source and web services. Credentials allow access, so that the SOAP and REST services can retrieve the data. The data is parsed and mapped using the HR schema mappings, and sent to the HR staging tables. Finally, the data in the table is transformed via the HR transform maps, and sent to the HR profile table in the platform.
For the outbound integration, data is pushed from the HR tables or HR service in HR Service Delivery to the third-party HR management system as follows.

A schedule or an event triggered in the ServiceNow platform starts the process of pushing data from the HR tables or HR service. The HR web services transfer the data to the HR external interface, which is another table in the ServiceNow platform. The HR service mapping configuration binds the source and web services. The HR outbound schema mappings map the data from the source tables to the fields in the target system. Credentials provide access to that system, and the data is incorporated into that system.
How data is pushed for the outbound integration

Integrating with a background check system

The following video provides an overview of integrating HR Service Delivery with a third-party background check system. To set up the integration, you must provide the source credentials for the third-party system, configure the integration, and add the background check packages. Once the integration setup is complete, you can request background checks through the third-party system.

The Integrating with Background Check Systems video provides an overview of how to integrate HR Service Delivery with a third-party background check system.

Once the integration setup is complete, HR agents from your organization can request third-party background checks through the HR Service Delivery application.

- Request a background check through a third-party background check provider

Data is pushed between the HR service in HR Service Delivery and the third-party background check system as follows.

An HR agent first creates a case to request the background check, and the ServiceNow platform sends the request to the third-party system. That system evaluates the request,
updates it with the applicant ID and status, and sends it back to the ServiceNow platform. The platform then creates a task for the employee to sign up on the third-party site, and sends an email with a link to the site’s portal. The employee clicks the link in the email and completes the application on the site portal. The third-party system starts the background check, and notifies the ServiceNow platform that the check is in progress. When the background check is complete, the third-party system sends a notification to the ServiceNow platform and the record is updated to include the status of the background check, and a link to the details.

**How data is pushed between HR Service Delivery and the background check system**

1. **First Advantage**
   - Evaluates request and updates case with applicant ID and status

2. **Third-party background check system**
   - Creates task for employee to sign up on third-party site
   - Sends email to employee

3. **HR agent creates case to request background check**
   - Clicks link in email and completes application on site portal

4. **HR System**
   - Background check in progress
   - Updates case with status

5. **Employee, Candidate or Agent**
   - Background check complete
   - Updates case with status and link to details

**Support and troubleshooting information**

For information on HR Integrations support and troubleshooting, see the HR Integrations FAQs [KB0678031] article in the HI Knowledge Base.

**Note:** There are scenarios that are not supported in the initial integration, specifically when an employee is rehired or when an employee moves from contingent to full time.

**Activation information**

HR Integrations is automatically activated when you activate Case and Knowledge Management. If it is not activated, you can manually activate HR Integrations. For information on what components are installed with the application, see Components installed with HR Integrations.

**Activate HR Integrations**

You can activate Human Resources Scoped App: Integrations [com.sn_hr_integrations] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Human Resources Scoped App: Integrations allows you to integrate HR Service Delivery with third-party systems.
Procedure

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.

3. Click **Install**, and then in the **Activate Plugin** dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with HR Integrations

Several types of components install with the activation of the HR Integrations plugin, including tables, user roles, and scheduled jobs.

   **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.

   **Note:** The Human Resources Scoped App: Integrations [com.sn_hr_integrations] plugin activates the sn_hr_integrations.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only HR Integrations admin user by requiring a minimum number (default is two) of active users with this role.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR integrations administrator [sn_hr_integrations.admin]</td>
<td>Can access and configure the HR Integrations application.</td>
<td>• sn_hr_integrations.user</td>
</tr>
<tr>
<td>HR integrations user [sn_hr_integrations.user]</td>
<td>Can access and read data in the HR Integrations application.</td>
<td>• None</td>
</tr>
</tbody>
</table>

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign HR Client Roles for Integration Users Sync</td>
<td>Assigns HR roles for integration users daily.</td>
</tr>
<tr>
<td>HR Integrations - External Interface Push Retry Job</td>
<td>Retries data push to the third-party system on a periodic basis.</td>
</tr>
<tr>
<td>HR Integrations-Accurate Background Check Get Order Updates</td>
<td>Gets background check order updates for the Accurate integration on a periodic basis.</td>
</tr>
<tr>
<td>HR Integrations-PushExistingTodosSF</td>
<td>Pushes existing to-dos to the SuccessFactors service on an on-demand basis.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Integrations-SuccessFactors Sync</td>
<td>Synchronizes data for the SuccessFactors integrations daily.</td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Integrations Additional Inputs</td>
<td>Table for additional inputs.</td>
</tr>
<tr>
<td>[sn_hr_integrations_additional_inputs]</td>
<td></td>
</tr>
<tr>
<td>Background Check Package</td>
<td>Table for background check packages.</td>
</tr>
<tr>
<td>sn_hr_integrations_background_check_package</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Background Check Staging</td>
<td>Staging table for background checks.</td>
</tr>
<tr>
<td>[sn_hr_integrations_background_check_staging]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Department Staging</td>
<td>Staging table for departments.</td>
</tr>
<tr>
<td>[sn_hr_integrations_dept_staging]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations External Interface</td>
<td>Table for HR external interfaces.</td>
</tr>
<tr>
<td>[sn_hr_integrations_external_interface]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Job Profile</td>
<td>Staging table for job profiles.</td>
</tr>
<tr>
<td>[sn_hr_integrations_job_profile]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Job Tracker</td>
<td>Table for job trackers.</td>
</tr>
<tr>
<td>[sn_hr_integrations_job_tracker]</td>
<td></td>
</tr>
<tr>
<td>Leave Types</td>
<td>Table for leave types.</td>
</tr>
<tr>
<td>[sn_hr_integrations_leave_type]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Location Staging</td>
<td>Staging table for locations.</td>
</tr>
<tr>
<td>[sn_hr_integrations_loc_staging]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Outbound Schema Mapping</td>
<td>Table for HR outbound schema mappings.</td>
</tr>
<tr>
<td>[sn_hr_integrations_outbound_schema_mapping]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Outbound Service</td>
<td>Table for HR integration outbound services.</td>
</tr>
<tr>
<td>[sn_hr_integrations_outbound_service]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Outbound Service Trigger</td>
<td>Table for outbound service trigger.</td>
</tr>
<tr>
<td>[sn_hr_integrations_outbound_service_trigger]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Schema Mapping</td>
<td>Table for HR schema mappings.</td>
</tr>
<tr>
<td>[sn_hr_integrations_schema_mapping]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Service</td>
<td>Table for HR integration services.</td>
</tr>
<tr>
<td>[sn_hr_integrations_service]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Service Job Tracker</td>
<td>Table for service job trackers.</td>
</tr>
<tr>
<td>[sn_hr_integrations_service_job_tracker]</td>
<td></td>
</tr>
<tr>
<td>HR Integrations Service Mapping</td>
<td>Table for HR service mappings.</td>
</tr>
<tr>
<td>[sn_hr_integrations_service_mapping]</td>
<td></td>
</tr>
</tbody>
</table>
Integrating with the SAP SuccessFactors service

The preconfigured SAP SuccessFactors integration uses SOAP and REST services to synchronize employee profiles and employee to-dos between HR Service Delivery and the SAP SuccessFactors service. You can use the preconfigured integration as-is or customize it to meet your needs.

SuccessFactors integration overview

The preconfigured SuccessFactors integration is set up to:

Pull employee profile data from SuccessFactors to HR Service Delivery

By default, the following data is pulled from the SuccessFactors service:

- Departments
- Locations
- Job profiles
- Worker profiles
- Effective worker profiles

Synchronize employee to-dos between the two systems

You can also synchronize employee to-dos so that employees can view and complete their to-dos from either system. This creates a connected experience that directs employees to the system of origin to complete their to-dos. For example, employees would be able to view and complete their SuccessFactors to-dos in the Employee Service Center.

- For the inbound integration, the integration is configured to pull new and updated to-dos, as well as existing to-dos. Existing to-dos are all pulled to HR Service Delivery the first time the scheduled job executes. Make sure to delete any existing job trackers before scheduling the first pull.
- For the outbound integration, the integration is configured to push new to-dos, as well as existing to-dos. For existing to-dos, you must execute a one-time scheduled job to push them to the SuccessFactors service.
SuccessFactors integration setup
To set up the SuccessFactors integration, you must provide the source credentials, verify the inbound integration settings, and schedule the integrations job.

Provide source credentials for the SuccessFactors service
Provide the source, SOAP, and REST credentials for the SuccessFactors service so that it can be accessed for integration.

Before you begin
So the SuccessFactors service can be accessed for integration, you must provide:

- SOAP and REST credentials, including the endpoint URL, user name, and password
- Company ID

Role required: sn_hr_integrations.admin

Procedure
1. Navigate to HR Integrations > Sources.
2. Open the SuccessFactors record.
3. In the SOAP credentials related list, provide the SOAP credentials to use with your integration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint URL</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
<tr>
<td>Inbound Username</td>
<td>User name for inbound data pull.</td>
</tr>
<tr>
<td>Inbound Password</td>
<td>Password for inbound user name.</td>
</tr>
<tr>
<td>Outbound Username</td>
<td>User name for outbound data push.</td>
</tr>
<tr>
<td>Outbound Password</td>
<td>Password for outbound user name.</td>
</tr>
</tbody>
</table>

Note:
- The default value is a placeholder URL only. Make sure to replace it with the unique endpoint URL that you get from your third-party provider.
- Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.

4. In the REST credentials related list, provide the Basic authentication profile credentials to use with your integration.

Important: In the corresponding HR REST service, you must provide the unique endpoint URL that you get from your third-party provider.

a. In the Basic auth profile list field, click the Unlock icon.

b. Select the SuccessFactors OData API profile, and then click Preview and open the record.
c. In the Basic Auth Configuration form, provide the user name and password.

![Basic Auth Configuration Form](image)

![Username and Password Fields](image)

d. Click Update.

5. Right-click the form header and click Save.

6. In the HR Integrations Additional Inputs related list, provide or verify the value for each key.

- company_id
- sf_push_category: 57

   **Note:** This is the designated category for all HR Service Delivery to-dos.

- sf_todo_state: 2

   **Note:** This is the state of the to-dos that are open from HR Service Delivery on the SuccessFactors service.

- sf_subjectId: ServiceNow

   **Note:** This is to identify that the to-do task is a ServiceNow task.

7. In the HR integrations source properties related list, you can turn on or off the following source properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>Enables the debug log to display responses from the third-party system. Turn on to troubleshoot and debug the integration on an as-needed basis.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|          | • Type: true or false  
|          | • Default value: false  
|          | • Location: Navigate to HR Integrations > Logs to view the development logs. |

**sn_hr_integrations.dryrun**

Enables a dry run of the integration, where data is pulled into the staging tables but not into the target tables. Turn on to validate integration data on an as-needed basis.

• Type: true or false  
• Default value: false  
• Learn more: Perform a dry run for an HR management system

**sn_hr_integrations.enable_push**

(Outbound integration for HR management systems only) Enables data push to the third-party system. Use with the sn_hr_integrations.enable_auto_update property.

• Type: true or false  
• Default value: true

**What to do next**

If you need to further configure the source credentials, see Configure source credentials for an HR management system.

**Verify integration for employee profiles**

The integration to synchronize employee profiles is set up to pull employee profile data (departments, locations, job profiles, worker profiles, and effective worker profiles) from the SuccessFactors service to HR Service Delivery. You can verify the preconfigured settings and determine whether they meet your needs or if further customization is required.

**Before you begin**

Role required: sn_hr_integrations.admin

**Procedure**

1. Verify the HR service mappings, which map the HR integration services to the HR web services.

   a. Navigate to HR Integrations > HR Service Mapping.

   b. Right-click the HR external source column and select Group By HR external source.

   c. For the SuccessFactors group, click the arrow to expand the list. For each record, click the information icon to verify that the HR integration services are correctly mapped to the appropriate HR web services for the inbound integration.

   ✨ Note: Make sure to provide the endpoint URL for the SuccessFactors OData API record.
### HR service mapping

<table>
<thead>
<tr>
<th>HR service mapping</th>
<th>HR integration service</th>
<th>HR web service</th>
</tr>
</thead>
<tbody>
<tr>
<td>SuccessFactors - Departments</td>
<td>Departments</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Effective Worker Profiles</td>
<td>Effective Worker Profiles</td>
<td>SuccessFactors Compound Employee Sync</td>
</tr>
<tr>
<td>SuccessFactors - Job Profiles</td>
<td>Job Profiles</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Locations</td>
<td>Locations</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Worker Profiles</td>
<td>Worker Profiles</td>
<td>SuccessFactors Compound Employee Sync</td>
</tr>
</tbody>
</table>

2. Verify the HR schema mappings.

   **a.** Navigate to **HR Integrations > HR Schema Mapping**.

   **b.** Right-click the **Source** column and select **Group By Source**.

   **c.** For the **SuccessFactors** group, click the arrow to expand the list. For each record, click the information icon to verify that the data fields from SuccessFactors are correctly mapped to the appropriate fields in the staging tables.

3. Verify the HR transform maps.

   **a.** Navigate to **HR Integrations > HR Transform Maps**.

   **b.** In the **Table Transform Maps list**, verify that the staging tables are correctly mapped to the appropriate target tables.

<table>
<thead>
<tr>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Integrations Department Staging [sn_hr_integrations_dept_staging]</td>
<td>Department [cmn_department]</td>
</tr>
<tr>
<td>HR Integrations Job Profile [sn_hr_integrations_job_profile]</td>
<td>Job Profile [sn_hr_core_job_profile]</td>
</tr>
<tr>
<td>HR Integrations Worker Profile [sn_hr_integrations_worker_profile]</td>
<td>HR Profile [sn_hr_core_profile]</td>
</tr>
<tr>
<td>HR Integrations Location Staging [sn_hr_integrations_loc_staging]</td>
<td>Location [cmn_location]</td>
</tr>
</tbody>
</table>

**What to do next**

If you need to further customize the inbound integration, see Configure inbound integration for an HR management system.

**Verify integration for employee to-dos**

If you are synchronizing employee to-dos between HR Service Delivery and SuccessFactors, the integration is set up to pull new, updated, and existing to-dos and push new and existing to-dos between the two systems. You can verify the preconfigured settings and determine whether they meet your needs or if further customization is required.

**Verify inbound integration for employee to-dos**

For the inbound integration, the integration is set up to pull new, updated, and existing to-dos to HR Service Delivery. Existing to-dos are all pulled to HR Service Delivery the first time the
scheduled job executes. Make sure to delete any existing job trackers before scheduling the first pull.

Before you begin
Role required: sn_hr_integrations.admin

Procedure
1. Verify the HR service mappings, which map the HR integration services to the HR web services.

   a. Navigate to HR Integrations > HR Service Mapping.

   b. Right-click the HR external source column and select Group By HR external source.

   c. For the SuccessFactors group, click the arrow to expand the list. For each record, click the information icon to verify that the HR integration services are correctly mapped to the appropriate HR web services for the inbound integration.

   😡 Note: Make sure to provide the endpoint URL for the SuccessFactors OData API record.

<table>
<thead>
<tr>
<th>HR service mapping</th>
<th>HR integration service</th>
<th>HR web service</th>
</tr>
</thead>
<tbody>
<tr>
<td>SuccessFactors - Pull Todos</td>
<td>Pull Todos</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Refresh</td>
<td>Refresh Session Tokens</td>
<td>Success Factors Compound</td>
</tr>
<tr>
<td>Session Tokens</td>
<td></td>
<td>Employee Sync</td>
</tr>
</tbody>
</table>

2. Verify the HR schema mappings.

   a. Navigate to HR Integrations > HR Schema Mapping.

   b. Right-click the Source column and select Group By Source.

   c. For the SuccessFactors group, click the arrow to expand the list. For each record, click the information icon to verify that the data fields from SuccessFactors are correctly mapped to the appropriate fields in the staging tables.

3. Verify the HR transform maps.

   a. Navigate to HR Integrations > HR Transform Maps.

   b. In the Table Transform Maps list, verify that the staging tables are correctly mapped to the appropriate target tables.

<table>
<thead>
<tr>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_hr_integrations_todo_inbound_staging] Pull To-do Staging</td>
<td>[sn_hr_integrations_todo_inbound]Pulled To-do</td>
</tr>
<tr>
<td>[sn_hr_integrations_todo_outbound_staging] To-do Mapping Staging</td>
<td>[sn_hr_integrations_todo_outbound]To-do Mapping</td>
</tr>
</tbody>
</table>

Verify outbound integration for employee to-dos

For the outbound integration, the integration is set up to push new to-dos. For existing to-dos, you must execute a one-time scheduled job to push them to the SuccessFactors
service. For existing to-dos, you must execute a one-time scheduled job to push them to the SuccessFactors service.

Before you begin
Role required: sn_hr_integrations.admin

Procedure
1. Verify the HR service mappings, which map the HR integration outbound services to the HR web services.

   a. Navigate to **HR Integrations > HR Service Mapping**.

   b. Right-click the **HR external source** column and select **Group By HR external source**.

   c. For the **SuccessFactors** group, click the arrow to expand the list. For each record, click the information icon to verify that the HR integration outbound services are correctly mapped to the appropriate HR web services for the outbound integration.

   ✪ **Note:** Make sure to provide the endpoint URL for the **SuccessFactors OData API** record.

<table>
<thead>
<tr>
<th>HR service mapping</th>
<th>HR integration outbound service</th>
<th>HR web service</th>
</tr>
</thead>
<tbody>
<tr>
<td>SuccessFactors - Delete Approval Todo</td>
<td>Delete Approval Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Delete CD Task Todo</td>
<td>Delete CD Task Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Delete HR Case Todo</td>
<td>Delete HR Case Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Delete HR Task Todo</td>
<td>Delete HR Task Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Push Approval Todo</td>
<td>Push Approval Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Push CD Task Todo</td>
<td>Push CD Task Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Push HR Case Todo</td>
<td>Push HR Case Todo</td>
<td>SuccessFactors OData API</td>
</tr>
<tr>
<td>SuccessFactors - Push HR Task Todo</td>
<td>Push HR Task Todo</td>
<td>SuccessFactors OData API</td>
</tr>
</tbody>
</table>

2. Verify the HR outbound schema mappings.

   a. Navigate to **HR Integrations > HR Outbound Schema Mapping**.

   b. In the **HR Integrations Outbound Schema Mapping** list, click the information icon for each SuccessFactors record to verify that the data fields from the source tables are correctly mapped to the appropriate fields in SuccessFactors.
Schedule integrations job for the SuccessFactors service

Schedule the integrations job to synchronize data between HR Service Delivery and the SuccessFactors service on a daily, weekly, monthly, periodically, one-time, or on-demand basis.

Before you begin
Navigate to HR Integrations > Sources, and open the SuccessFactors record. In the HR integrations source properties related list, verify the source properties are set as follows.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>false</td>
</tr>
<tr>
<td>sn_hr_integrations.dryrun</td>
<td>false</td>
</tr>
</tbody>
</table>

Role required: sn_hr_integrations.admin

Procedure
1. Navigate to HR Integrations > HR Integrations Schedule Jobs.
2. Open one of the following records:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use this scheduled job to:</td>
</tr>
<tr>
<td></td>
<td>• Pull employee profile data</td>
</tr>
<tr>
<td></td>
<td>• Pull new, updated, and existing to-dos</td>
</tr>
<tr>
<td></td>
<td>• Push new and updated to-dos</td>
</tr>
<tr>
<td><strong>Note:</strong> Existing to-dos are all pulled to HR Service Delivery the first time the scheduled job executes. Make sure to delete any existing job trackers before scheduling the first pull.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use this scheduled job to push existing to-dos to the SuccessFactors service.</td>
</tr>
</tbody>
</table>

3. Fill in the fields on the form.

**Note:** For jobs that run on a scheduled (daily, weekly, or monthly) basis, make sure the Active check box is selected so that the integrations job is activated.

Schedule Script Execution form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the integrations job.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the integrations job for use.</td>
</tr>
<tr>
<td><strong>Note:</strong> For jobs that run on a scheduled basis, make sure that the box is selected so that the integrations job is activated.</td>
<td></td>
</tr>
<tr>
<td>Run</td>
<td>Frequency that the integrations job runs: daily, weekly, monthly, periodically, once, or on demand. For scheduled</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jobs, provide</td>
<td>the scheduled time and interval in the specified fields.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Option for enabling conditional jobs. If selected, provide the condition to</td>
</tr>
<tr>
<td></td>
<td>use in the <strong>Condition</strong> field.</td>
</tr>
<tr>
<td>Run this script</td>
<td>Script to run.</td>
</tr>
</tbody>
</table>

4. Schedule or run the integrations job.

- To schedule the integrations job, click **Submit** or **Update**. The integration runs according to the schedule.
- To immediately run the integrations job, click **Execute Now**.

### What to do next

- To track jobs that are currently running, completed, or failed, navigate to **HR Integrations > Job Tracker**.
- To perform dry runs, see Perform a dry run for an HR management system to validate the data or troubleshoot and debug the integration.

### Custom third-party HR management system integrations

If a preconfigured integration isn’t available for the third-party HR management system used by your organization, you can configure a custom integration with HR Service Delivery to synchronize employee profiles, employee to-dos, and other data between the two systems.

### Custom integration setup

To set up the custom integration, you must configure the source credentials, inbound integration, outbound integration, and scheduled job. Once the integration is configured, you can synchronize data between HR Service Delivery and the third-party HR management system.

**Note:** If you are further customizing a preconfigured integration, follow the integration tasks as applicable.

### Configure source credentials for an HR management system

Configure the source credentials for the third-party HR management system so that it can be accessed for integration. If needed, you can also configure the source properties, additional inputs, and source versions.

### Before you begin

So the third-party HR management system can be accessed for integration, you must provide:

- SOAP or REST credentials, including the endpoint URL, user name, and password

Role required: sn_hr_integrations.admin

**Procedure**

1. Navigate to **HR Integrations > Sources**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**HR Integrations Source form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>SOAP</td>
<td>Option to enable the use of SOAP services. If you are using SOAP services with your integration, make sure the box is selected and provide the SOAP credentials to use in the SOAP credentials related list.</td>
</tr>
<tr>
<td>REST</td>
<td>Option to enable the use of REST services. If you are using REST services with your integration, make sure the box is selected and provide the REST credentials to use in the REST credentials related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR integrations source for use.</td>
</tr>
<tr>
<td>Use session token</td>
<td>Option to enable the use of session tokens.</td>
</tr>
<tr>
<td>Outbound push retry count</td>
<td>Number of times to retry the push if the job fails.</td>
</tr>
</tbody>
</table>

4. If you are using SOAP services with your integration, provide the credentials to use in the SOAP credentials related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint URL</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you are using a preconfigured integration, the default value is a placeholder URL only. Make sure to replace it with the unique endpoint URL that you get from your third-party provider.</td>
</tr>
<tr>
<td></td>
<td>Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbound Username</td>
<td>User name for inbound data pull.</td>
</tr>
<tr>
<td>Inbound Password</td>
<td>Password for inbound user name.</td>
</tr>
<tr>
<td>Outbound Username</td>
<td>User name for outbound data push.</td>
</tr>
<tr>
<td>Outbound Password</td>
<td>Password for outbound user name.</td>
</tr>
</tbody>
</table>

5. If you are using REST services with your integration, provide the Basic authentication profile credentials to use in the REST credentials related list. You can:

**Important:** In the corresponding HR REST service, you must provide the unique endpoint URL that you get from your third-party provider.
### Create a new Basic authentication profile

To create a new profile to use with your integration:

- **a.** In the Basic auth profile list field, click the Unlock icon.
- **b.** Click the Lookup button, and then click New.
- **c.** In the Basic Auth Configuration form, provide the profile name, user name, and password.
- **d.** Click Submit.

**Note:** In the corresponding HR REST service, you must provide the endpoint URL of the third-party system.

---

### Update an existing Basic authentication profile

To update an existing profile to use with your integration:

- **a.** In the Basic auth profile list field, click the Unlock icon.
- **b.** Select the profile to update, and then click Preview and open the record.
- **c.** In the Basic Auth Configuration form, provide the user name and password.
- **d.** Click Update.

**Note:** In the corresponding HR REST service, you must provide the endpoint URL of the third-party system.

---

6. Right-click the form header and click **Save**.

7. In the HR integrations source properties related list, you can turn on or off the following source properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>Enables the debug log to display responses from the third-party system. Turn on to troubleshoot and debug the integration on an as-needed basis.</td>
</tr>
<tr>
<td></td>
<td>• Type: true or false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Navigate to HR Integrations &gt; Logs to view the development logs.</td>
</tr>
<tr>
<td>sn_hr_integrations.dryrun</td>
<td>Enables a dry run of the integration, where data is pulled into the staging tables but not into the target tables. Turn on to validate integration data on an as-needed basis.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_hr_integrations.enable_auto_update | (Outbound integration for HR management systems only) Enables automatic updates of employee profile records in the third-party system. Use with the sn_hr_integrations.enable_push property.  
  • Type: true or false  
  • Default value: false  
  • Learn more: Perform a dry run for an HR management system |
| sn_hr_integrations.enable_push | (Outbound integration for HR management systems only) Enables data push to the third-party system. Use with the sn_hr_integrations.enable_auto_update property.  
  • Type: true or false  
  • Default value: true |

8. If the third-party system requires additional information (for example, the company ID, parent account, and so on), add the additional inputs as key and value pairs in the **HR Integrations Additional Inputs** related list.

⚠️ **Note:** Make sure to update the corresponding HR web services.

9. If different XPaths must be used with different versions of the third-party system, add one or more source versions to be applied to the HR schema mappings in the **HR Integrations Source Versions** related list.

⚠️ **Note:** Make sure to update the corresponding HR schema mappings.

### Configure inbound integration for an HR management system

Configure the inbound integration to pull data from the third-party HR management system to the HR tables in HR Service Delivery. You must configure the HR integration services, web services, service mappings, schema mappings, and transform maps.

⚠️ **Note:** If you are further customizing a preconfigured integration, follow the inbound integration tasks as applicable.

1. HR integration services
2. HR web services (SOAP or REST)
3. HR service mappings
4. HR schema mappings
5. HR transform maps

### Configure HR integration services for an HR management system

Create or modify the HR integration services to define the staging tables that data from the third-party HR management system will be pulled to.

### Before you begin

If you need to create a new staging table, see **Create a table**. Make sure that the staging table is an extension of the core HR Integrations Staging [sn_hr_integrations_staging] table.
Procedure
1. Navigate to HR Integrations > HR Integration Service.
2. Click New or open a record.
3. Fill in the fields on the form.

HR Integrations Service form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR integration service.</td>
</tr>
<tr>
<td>Staging Table</td>
<td>Name of the staging table that data from the third-party system is pulled to.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The staging table must be an extension of the core HR Integrations Staging [sn_hr_integrations_staging] table.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR integration service for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for when data is pulled. Lower numbered data is pulled before higher numbered data.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

Configure SOAP services for an HR management system
If you are using SOAP services with your integration, create or modify the appropriate HR web services to define the SOAP messages used to communicate with the third-party HR management system for the inbound integration.

Before you begin
Role required: sn_hr_integrations.admin

About this task
You can use SOAP messages to communicate with the third-party system. For example, the preconfigured SuccessFactors integration uses both SOAP and REST services. See Outbound SOAP web service for more information.

Procedure
1. Navigate to HR Integrations > HR Web Services > HR SOAP Services.
2. Click New or open a record.
3. Fill in the fields on the form.

SOAP Message form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the SOAP message.</td>
</tr>
<tr>
<td>WSDL</td>
<td>URL for the Web Service Description Language (WSDL) that describes the table schema and available operations. This field appears when the Download WSDL check box is selected.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| **Note:** Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link. | **Download WSDL** | Option for enabling download of the WSDL.  
- To download and use an online WSDL source, select the **Download WSDL** check box, and then enter the URL for the WSDL in the **WSDL** field.  
- To enter the WSDL directly, clear the **Download WSDL** check box, and then copy and paste the WSDL XML into the **WSDL XML** field. |
| **Use mutual authentication** | Option for enabling mutual authentication. If selected, provide the credentials to use for mutual authentication in the **Protocol profile** field. |
| **Description** | Description of the SOAP message. |
| **WSDL XML** | XML for the Web Service Description Language (WSDL) that describes the table schema and available operations. Provide this information when the **Download WSDL** check box is cleared. |
| **Application** | This field is automatically set to Human Resources: Integrations. |
| **Accessible from** | This field is automatically set to This application scope only. |
| **Authentication type** | Authentication type of the SOAP message.  
| **Note:** If you are using SOAP services, set the value to **None**. The integration uses the credentials you provided when configuring your source. |

4. Right-click the form header and click **Save**.

5. In the **SOAP Message Functions** related list, you can create new or modify existing SOAP message functions.  
   See **SOAP message functions** for more information.

   | **Note:** Do not click **Generate sample SOAP messages**, as this overwrites existing functions. |

6. Click **Update**.

**Configure REST services for an HR management system**

If you are using REST services with your integration, create or modify the appropriate HR web services to define the REST messages used to communicate with the third-party HR management system for the inbound integration.

**Before you begin**

Role required: **sn_hr_integrations.admin**

**About this task**

You can use REST messages to communicate with the third-party system. For example, the preconfigured First Advantage integration uses REST services, while the preconfigured
SuccessFactors integration uses both SOAP and REST services. See Outbound REST web service for more information.

**Procedure**

1. Navigate to HR Integrations > HR Web Services > HR REST Services.
2. Click New or open a record.
3. Fill in the fields on the form.

**REST Message form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the REST message.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the REST message.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
</tbody>
</table>

**Note:**

- If you are using a preconfigured integration, the default value is a placeholder URL only. Make sure to replace it with the unique endpoint URL that you get from your third-party provider.
- Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.

<table>
<thead>
<tr>
<th>Application</th>
<th>This field is automatically set to Human Resources: Integrations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible from</td>
<td>This field is automatically set to This application scope only.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.
5. In the Authentication related list, fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication type</td>
<td>Authentication type of the REST message.</td>
</tr>
</tbody>
</table>

**Note:** If you are using REST services, set the value to Basic. Provide the credentials to use in the Basic auth profile field.

<table>
<thead>
<tr>
<th>Basic auth profile</th>
<th>Credentials for the REST message. Click the Lookup icon to add or create your authentication credentials. This field appears when Basic is selected from Authentication type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use mutual authentication</td>
<td>Option for enabling mutual authentication. If selected, provide the credentials to use for mutual authentication in the Mutual authentication profile field.</td>
</tr>
</tbody>
</table>

6. Click Update.

Under the HTTP Methods section, several default HTTP methods are automatically created using settings inherited from the REST message record. Subsequent changes to the REST message record are not applied to the HTTP methods automatically.
You can create additional HTTP methods or modify the default HTTP methods to implement new behavior. See Define a REST message HTTP method for more information.

**Important:** If you are using a preconfigured integration, the default endpoint URL for each method is a placeholder value only. Make sure to replace each value with the unique endpoint URL that you get from your third-party provider.

Configure HR service mappings for an HR management system

Create or modify the HR service mappings to map the HR integration services to the appropriate HR web services for the inbound integration.

**Before you begin**

Role required: sn_hr_integrations.admin

**Procedure**

1. Navigate to HR Integrations > HR Service Mapping.
2. Click New or open a record.
3. Fill in the fields on the form.

**HR Integrations Service Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Response content type</td>
<td>Response content type of the HR service mapping: XML or JSON.</td>
</tr>
<tr>
<td>HR external source</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>HR service</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• (Outbound integration for HR management systems only) If you are using an HR service, the HR service to use with the HR service mapping. Otherwise, provide an HR integration outbound service to use in the <a href="#">HR integration outbound service</a> field.</td>
</tr>
<tr>
<td></td>
<td>• (Background check systems only) HR service to use with the HR service mapping.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR integration service</td>
<td>(Inbound integration for HR management systems only) HR integration service to use with the HR service mapping.</td>
</tr>
<tr>
<td>HR integration outbound service</td>
<td>(Outbound integration for HR management systems only) If you are using an HR integration outbound service, the HR integration outbound service to use with the HR service mapping. Otherwise, provide an HR service to use in the <strong>HR service</strong> field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR integrations service mapping for use.</td>
</tr>
<tr>
<td>Response root key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the appropriate root node. The children of the root node are recorded in the associated staging table.</td>
</tr>
<tr>
<td>Response total results key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the total number of results in the XML or JSON response.</td>
</tr>
<tr>
<td>Response has more data</td>
<td>Additional metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the appropriate root node. The children of the root node are recorded in the associated staging table.</td>
</tr>
<tr>
<td>Response page results key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the number of page results in the XML or JSON response.</td>
</tr>
<tr>
<td>Response current page key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the number of the current page in the XML or JSON response.</td>
</tr>
<tr>
<td>Response total pages key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the total number of pages in the XML or JSON response.</td>
</tr>
<tr>
<td>Outbound request type</td>
<td>Outbound request type of the HR service mapping: SOAP or REST.</td>
</tr>
<tr>
<td></td>
<td>• If you are using SOAP web services, you should have provided the credentials when configuring your source.</td>
</tr>
<tr>
<td></td>
<td>• If you are using REST web services, you should have provided the credentials when configuring your HR web service. Alternatively, provide the authentication type and profile in the Authentication type and Basic auth profile fields.</td>
</tr>
<tr>
<td>SOAP or REST outbound service</td>
<td>SOAP or REST web service to use with the HR service mapping.</td>
</tr>
<tr>
<td>SOAP or REST outbound service function</td>
<td>SOAP or REST web service function to use with the HR service mapping. This function runs (except for the first time) when data is pulled from or pushed to the third-party system.</td>
</tr>
</tbody>
</table>
| SOAP or REST outbound service function all| SOAP or REST web service function to be used with the HR service mapping. This function runs the first time that data is pulled from or pushed to the third-party system. }
### Configure HR schema mappings for an HR management system

Create or modify the HR schema mappings to map the data fields from the third-party HR management system to the appropriate fields in the staging tables.

#### Before you begin

**Role required:** sn_hr_integrations.admin

#### Procedure

1. Navigate to HR Integrations > HR Schema Mapping.
2. Click New or open a record.
3. Fill in the fields on the form.

#### HR Integrations Schema Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>Source version</td>
<td>Version of the third-party system, if applicable.</td>
</tr>
<tr>
<td>Service mapping</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option to enable a mandatory field value.</td>
</tr>
<tr>
<td></td>
<td>• If selected, the value from the third-party system cannot be null. If the record is null, then the record it originates from is ignored and not placed into the staging table.</td>
</tr>
<tr>
<td></td>
<td>• If cleared, then any field value from the third-party system is accepted.</td>
</tr>
<tr>
<td>Use script</td>
<td>Option to enable use of source scripts. If selected, provide the source script to use in the <strong>Source script</strong> field.</td>
</tr>
<tr>
<td>Staging Table</td>
<td>Name of the staging table that the data from the third-party system is pulled to.</td>
</tr>
<tr>
<td>Staging table column</td>
<td>Name of the column in the staging table that the data from the third-party system is pulled to.</td>
</tr>
<tr>
<td>Type</td>
<td>Value type of the column: XPath (variable), constant, or JSON.</td>
</tr>
<tr>
<td>External Entity Column Key</td>
<td>Value (XPath, constant, or JSON) to insert into the corresponding column of the HR staging table.</td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Type</strong> is set to <strong>XPath</strong>, then provide the XPath so that HR Service Delivery can parse the XML response, get the respective value, and insert it into the corresponding column in the HR staging table. For example, the...</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.
preconfigured SuccessFactors integration uses XPaths for data being pulled into the HR Integrations Worker Profile [sn_hr_integrations_work_profile] staging table.

- If the **Type** is set to **Constant**, then provide the text value so that HR Service Delivery can copy it into the corresponding column in the HR staging table.

- If the **Type** is set to **JSON**, then provide the JSON path so that HR Service Delivery can extract the JSON response, get the respective value, and insert it into the corresponding column in the HR staging table. For example, the preconfigured SuccessFactors integration uses JSON for data being pulled into the HR Integrations Department Staging [sn_hr_integrations_dept_staging] table.

4. Click **Submit** or **Update**.

**Configure HR transform maps for an HR management system**

Create or modify the HR transform maps to map the staging tables from the third-party HR management system to the appropriate target tables.

**Before you begin**

Role required: sn_hr_integrations.admin

**Procedure**

1. Navigate to **HR Integrations > HR Transform Maps**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**Table Transform Map form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR transform map.</td>
</tr>
<tr>
<td>Source table</td>
<td>Name of the staging table.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the transform map for use.</td>
</tr>
<tr>
<td>Run business rules</td>
<td>Option to enable business rules to run.</td>
</tr>
<tr>
<td>Enforce mandatory fields</td>
<td>Enforcement type for the fields: no mandatory fields, only mapped fields, or all fields.</td>
</tr>
<tr>
<td>Copy empty fields</td>
<td>Option to enable copying of empty fields.</td>
</tr>
<tr>
<td>Create new record on empty coalesce fields</td>
<td>Option to create a new record on empty coalesce fields.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Created</td>
<td>This field is automatically set to the date of creation.</td>
</tr>
<tr>
<td>Target table</td>
<td>Name of the target table.</td>
</tr>
</tbody>
</table>
Field Map form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map</td>
<td>Name of the HR transform map.</td>
</tr>
<tr>
<td>Source table</td>
<td>Name of the HR staging table.</td>
</tr>
<tr>
<td>Source field</td>
<td>Name of the field in the HR staging table.</td>
</tr>
<tr>
<td>Use source script</td>
<td>Option to enable use of source scripts.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Target table</td>
<td>Name of the HR target table.</td>
</tr>
<tr>
<td>Target field</td>
<td>Name of the field in the HR target table.</td>
</tr>
<tr>
<td>Coalesce</td>
<td>Option to enable coalesces.</td>
</tr>
</tbody>
</table>

6. In the Transform Scripts related list, create one or more transform scripts.

   a. Click New or open a record.

   b. Fill in the fields on the form.

   Transform Script form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When</td>
<td>When the transform script is run: onAfter, onBefore, onChoiceCreate, onComplete, onForeignInsert, onReject, onStart.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the transform script for use.</td>
</tr>
</tbody>
</table>
Configure outbound integration for an HR management system

Configure the outbound integration to push data from the HR tables or HR service in HR Service Delivery to the third-party HR management system. Depending on whether data is pushed from the HR tables or HR service, you must configure the HR integration outbound services or HR service, web services, service mappings, and outbound schema mappings.

Note: If you are further customizing a preconfigured integration, follow the outbound integration tasks as applicable.

<table>
<thead>
<tr>
<th>Push data from HR tables</th>
<th>Push data from HR service</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. HR integration outbound services</td>
<td>1. HR service. See Configure an HR service for more information.</td>
</tr>
<tr>
<td>2. HR web services (SOAP or REST)</td>
<td>2. HR web services (SOAP or REST)</td>
</tr>
<tr>
<td>3. HR service mappings</td>
<td>3. HR service mappings</td>
</tr>
<tr>
<td>4. HR outbound schema mappings</td>
<td>4. HR outbound schema mappings</td>
</tr>
</tbody>
</table>

Configure HR integration outbound services for an HR management system

Create or modify the HR integration outbound services to define the source tables that data from HR Service Delivery will be pushed from.

Before you begin

Note: If you are using an HR service to directly update the third-party HR management system, you need to configure the appropriate HR service instead. See Configure an HR service for more information.

Role required: sn_hr_integrations.admin

Procedure

1. Navigate to HR Integrations > HR Integration Outbound Service.
2. Click New or open a record.
3. Fill in the fields on the form.

HR Integrations Outbound Service form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to activate the HR integration outbound service for use.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the HR integration outbound service.</td>
</tr>
<tr>
<td>Source Table</td>
<td>Name of the source table that data is pushed from.</td>
</tr>
</tbody>
</table>
4. Right-click the form header and click **Save**.

5. If the source table is the HR Profile [sn_hr_core_profile] or User [sys_user] table, create one or more triggers for the HR integration outbound service in the **HR Integrations Outbound Services Trigger** related list.

   a. Click **New** or open a record.

   b. Fill in the fields on the form.

**HR Integrations Outbound Service Trigger form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR integrations outbound service</td>
<td>Name of the HR integrations outbound service.</td>
</tr>
<tr>
<td>Trigger source</td>
<td>Name of the trigger source.</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>The conditions, which, if fulfilled, causes the HR integrations outbound service to be triggered. Conditions are built with the condition builder.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
</tbody>
</table>

c. Click **Submit** or **Update**.

**Configure SOAP services for an HR management system**

If you are using SOAP services with your integration, create or modify the appropriate HR web services to define the SOAP messages used to communicate with the third-party HR management system for the outbound integration.

**Before you begin**

Role required: sn_hr_integrations.admin

**About this task**

You can use SOAP messages to communicate with the third-party system. For example, the preconfigured SuccessFactors integration uses both SOAP and REST services. See [Outbound SOAP web service](#) for more information.

**Procedure**

1. Navigate to **HR Integrations > HR Web Services > HR SOAP Services**.

2. Click **New** or open a record.

3. Fill in the fields on the form.

**SOAP Message form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the SOAP message.</td>
</tr>
<tr>
<td>WSDL</td>
<td>URL for the Web Service Description Language (WSDL) that describes the table schema and available operations. This field appears when the Download WSDL check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.</td>
</tr>
<tr>
<td>Download WSDL</td>
<td>Option for enabling download of the WSDL.</td>
</tr>
<tr>
<td></td>
<td>• To download and use an online WSDL source, select the <strong>Download WSDL</strong> check box, and then enter the URL for the WSDL in the <strong>WSDL</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• To enter the WSDL directly, clear the <strong>Download WSDL</strong> check box, and then copy and paste the WSDL XML into the <strong>WSDL XML</strong> field.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option for enabling mutual authentication. If selected, provide the credentials to use for mutual authentication in the <strong>Protocol profile</strong> field.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the SOAP message.</td>
</tr>
<tr>
<td>WSDL XML</td>
<td>XML for the Web Service Description Language (WSDL) that describes the table schema and available operations. Provide this information when the <strong>Download WSDL</strong> check box is cleared.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>This field is automatically set to This application scope only.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Authentication type of the SOAP message.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you are using SOAP services, set the value to <strong>None</strong>. The integration uses the credentials you provided when configuring your source.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. In the **SOAP Message Functions** related list, you can create new or modify existing SOAP message functions.

   See [SOAP message functions](#) for more information.

   **Note:** Do not click **Generate sample SOAP messages**, as this overwrites existing functions.

6. Click **Update**.

**Configure REST services for an HR management system**

If you are using REST services with your integration, create or modify the appropriate HR web services to define the REST messages used to communicate with the third-party HR management system for the outbound integration.

**Before you begin**

Role required: sn_hr_integrations.admin

**About this task**

You can use REST messages to communicate with the third-party system. For example, the preconfigured First Advantage integration uses REST services, while the preconfigured
SuccessFactors integration uses both SOAP and REST services. See [Outbound REST web service](#) for more information.

**Procedure**

1. Navigate to **HR Integrations** > **HR Web Services** > **HR REST Services**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**REST Message form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the REST message.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the REST message.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
</tbody>
</table>

**Note:**

- If you are using a preconfigured integration, the default value is a placeholder URL only. Make sure to replace it with the unique endpoint URL that you get from your third-party provider.
- Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>This field is automatically set to This application scope only.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. In the **Authentication** related list, fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication type</td>
<td>Authentication type of the REST message. If you are using REST services, set the value to <strong>Basic</strong>. Provide the credentials to use in the <strong>Basic auth profile</strong> field.</td>
</tr>
<tr>
<td>Basic auth profile</td>
<td>Credentials for the REST message. Click the Lookup icon to add or create your authentication credentials. This field appears when <strong>Basic</strong> is selected from <strong>Authentication type</strong>.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option for enabling mutual authentication. If selected, provide the credentials to use for mutual authentication in the <strong>Mutual authentication profile</strong> field.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

Under the **HTTP Methods** section, several default HTTP methods are automatically created using settings inherited from the REST message record. Subsequent changes to the REST message record are not applied to the HTTP methods automatically.
You can create additional HTTP methods or modify the default HTTP methods to implement new behavior. See Define a REST message HTTP method for more information.

**Important:** If you are using a preconfigured integration, the default endpoint URL for each method is a placeholder value only. Make sure to replace each value with the unique endpoint URL that you get from your third-party provider.

Configure a scripted REST API for an HR management system

If your integration requires it, you can build a scripted REST API so that the third-party HR management system can push data to HR Service Delivery.

**Before you begin**
Role required: sn_hr_integrations.admin

**About this task**
You can build a scripted REST API so that the third-party system can push data to HR Service Delivery. See Scripted REST APIs for more information.

**Procedure**

1. Navigate to HR Integrations > HR Web Services > HR Scripted REST APIs.
2. Click New or open a record.
3. Fill in the fields on the form.

**Scripted REST Service form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scripted REST service.</td>
</tr>
<tr>
<td>API ID</td>
<td>This field is automatically set based on the name of the scripted REST service.</td>
</tr>
<tr>
<td>Protection policy</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>API namespace</td>
<td>This field is automatically set to sn_hr_integrations.</td>
</tr>
</tbody>
</table>
4. Click **Submit** or **Update**. 
   After you create the API, configure the service as needed. See [Create a Scripted REST API](#) for more information.

**Configure HR service mappings for an HR management system**

Create or modify the HR service mappings to map the HR integration outbound services or HR services to the appropriate HR web services for the outbound integration.

**Before you begin**

Role required: sn_hr_integrations.admin

**Procedure**

1. Navigate to **HR Integrations > HR Service Mapping**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

### HR Integrations Service Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Response content type</td>
<td>Response content type of the HR service mapping: XML or JSON.</td>
</tr>
<tr>
<td>HR external source</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>HR service</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• (Outbound integration for HR management systems only) If you are using an HR service, the HR service to use with the HR service mapping. Otherwise, provide an HR integration outbound service to use in the <strong>HR integration outbound service</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• (Background check systems only) HR service to use with the HR service mapping.</td>
</tr>
<tr>
<td>HR integration service</td>
<td>(Inbound integration for HR management systems only) HR integration service to use with the HR service mapping.</td>
</tr>
<tr>
<td>HR integration outbound service</td>
<td>(Outbound integration for HR management systems only) If you are using an HR integration outbound service, the HR integration outbound service to use with the HR service mapping. Otherwise, provide an HR service to use in the <strong>HR service</strong> field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR integrations service mapping for use.</td>
</tr>
<tr>
<td>Response root key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the appropriate root node. The children of the root node are recorded in the associated staging table.</td>
</tr>
<tr>
<td>Response total results key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the total number of results in the XML or JSON response.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Response has more data</td>
<td>Additional metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the appropriate root node. The children of the root node are recorded in the associated staging table.</td>
</tr>
<tr>
<td>Response page results key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the number of page results in the XML or JSON response.</td>
</tr>
<tr>
<td>Response current page key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the number of the current page in the XML or JSON response.</td>
</tr>
<tr>
<td>Response total pages key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the total number of pages in the XML or JSON response.</td>
</tr>
<tr>
<td>Outbound request type</td>
<td>Outbound request type of the HR service mapping: SOAP or REST.</td>
</tr>
<tr>
<td></td>
<td>• If you are using SOAP web services, you should have provided the credentials when configuring your source.</td>
</tr>
<tr>
<td></td>
<td>• If you are using REST web services, you should have provided the credentials when configuring your HR web service. Alternatively, provide the authentication type and profile in the Authentication type and Basic auth profile fields.</td>
</tr>
<tr>
<td>SOAP or REST outbound service</td>
<td>SOAP or REST web service to use with the HR service mapping.</td>
</tr>
<tr>
<td>SOAP or REST outbound service function</td>
<td>SOAP or REST web service function to use with the HR service mapping. This function runs (except for the first time) when data is pulled from or pushed to the third-party system.</td>
</tr>
<tr>
<td>SOAP or REST outbound service function all</td>
<td>SOAP or REST web service function to be used with the HR service mapping. This function runs the first time that data is pulled from or pushed to the third-party system.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Authentication type of the REST web service. This field appears when REST is selected from Outbound request type.</td>
</tr>
<tr>
<td>Basic auth profile</td>
<td>Basic auth profile of the REST web service. This field appears when Basic is selected from Authentication type.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Configure HR outbound schema mappings for an HR management system**

Create or modify the HR outbound schema mappings to map the data fields from the source tables to the appropriate target fields in the third-party HR management system.

**Before you begin**

Role required: sn_hr_integrations.admin
**Procedure**

1. Navigate to **HR Integrations > HR Outbound Schema Mapping**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**HR Integrations Outbound Schema Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service mapping</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Source table</td>
<td>Name of the source table that data is pushed from.</td>
</tr>
<tr>
<td>Source table column</td>
<td>Name of the column in the source table that data is</td>
</tr>
<tr>
<td></td>
<td>pushed from.</td>
</tr>
<tr>
<td>Target column</td>
<td>Name of the target column in the third-party system.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option to indicate that the data is mandatory for</td>
</tr>
<tr>
<td></td>
<td>integration.</td>
</tr>
<tr>
<td>Use source script</td>
<td>Option to enable use of source scripts. If selected,</td>
</tr>
<tr>
<td></td>
<td>provide the source script to use in the <strong>Source script</strong> field.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Configure the integrations job for an HR management system**

Configure the integrations job to synchronize data between HR Service Delivery and the third-party HR management system on a scheduled or on-demand basis. You can also perform dry runs to validate data or troubleshoot and debug the integration on an as-needed basis.

**Schedule the integrations job for an HR management system**

Schedule the integrations job to synchronize data between HR Service Delivery and the third-party HR management system on a daily, weekly, monthly, periodically, one-time, or on-demand basis.

**Before you begin**

Role required: sn_hr_integrations.admin

**Procedure**

1. Navigate to **HR Integrations > HR Integrations Schedule Jobs**.
2. Click **New** or open a record.

Note: If you are using a preconfigured integration, open the applicable record.

3. Fill in the fields on the form.

Note: For jobs that run on a scheduled (daily, weekly, or monthly) basis, make sure the **Active** check box is selected so that the integrations job is activated.

**Schedule Script Execution form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the integrations job.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the integrations job for use.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>For jobs that run on a scheduled basis, make sure that the box is selected so that the integrations job is activated.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency that the integrations job runs: daily, weekly, monthly, periodically, once, or on demand. For scheduled jobs, provide the scheduled time and interval in the specified fields.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Option for enabling conditional jobs. If selected, provide the condition to use in the Condition field.</td>
</tr>
<tr>
<td>Run this script</td>
<td>Script to run.</td>
</tr>
</tbody>
</table>

4. Schedule or run the integrations job.
   - To schedule the integrations job, click **Submit** or **Update**. The integration runs according to the schedule.
   - To immediately run the integrations job, click **Execute Now**.

What to do next
- To track jobs that are currently running, completed, or failed, navigate to **HR Integrations > Job Tracker**.
- To view data that is scheduled for pushing to the third-party system, navigate to **HR Integrations > HR External Interface**.

Perform a dry run for an HR management system
Perform dry runs to validate the data or troubleshoot and debug the integration on an as-needed basis. Dry runs pull data into the staging tables but not into the target tables.

Before you begin
Navigate to **HR Integrations > Sources**, and open the applicable record. In the **HR integrations source properties** related list, verify the source properties are set as follows.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>true</td>
</tr>
<tr>
<td>sn_hr_integrations.dryrun</td>
<td>true</td>
</tr>
</tbody>
</table>

Role required: sn_hr_integrations.admin

Procedure
1. Navigate to **HR Integrations > HR Integrations Schedule Jobs**.
2. Click **New** or open a record.
   - **Note:** If you are using a preconfigured integration, open the applicable record.
3. Fill in the fields on the form, making sure the **Active** check box is cleared for the dry run.
**Note:** For dry runs, make sure the **Active** field is cleared so that the data is pulled into the staging tables but not into the target tables.

### Schedule Script Execution form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the integrations job.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the integrations job for use.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency that the integrations job runs: daily, weekly, monthly, periodically, once, or on demand. For scheduled jobs, provide the scheduled time/interval in the specified fields.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Option for enabling conditional jobs. If selected, provide the condition to use in the <strong>Condition</strong> field.</td>
</tr>
<tr>
<td>Run this script</td>
<td>Script to run.</td>
</tr>
</tbody>
</table>

4. Click **Execute Now**.

**What to do next**

To view the logs, navigate to **HR Integrations > Logs**.

### Integrating with the First Advantage service

The preconfigured First Advantage integration uses SOAP services to request background checks through the First Advantage service. You can use the preconfigured integration as-is or customize it to meet your needs.

#### First Advantage integration overview

The First Advantage integration is configured to request background checks as follows.

- The HR agent creates a case to request a background check through the First Advantage service.
- The First Advantage service evaluates the request to:
  - Update the case with the background check applicant ID and status.
  - Create a task, as well as send an email, for the employee to sign up and complete a background check application through the First Advantage website.
- Once the employee completes the task, the First Advantage service performs the background check.
- When the background check is complete, the First Advantage service updates the case with the background check status and details.

### First Advantage integration setup

To set up the First Advantage integration, you must provide the source credentials, verify the integration settings, and add the appropriate background check packages. Once the integration is complete, you can request background checks through the First Advantage service.
Provide source credentials for the First Advantage service

Provide the source and SOAP credentials for the First Advantage service so that it can be accessed for integration.

Before you begin

So the First Advantage service can be accessed for integration, you must provide:

- SOAP credentials, including the endpoint URL, user name, and password
- Parent account
- Account
- Requestor email address

Role required: sn_hr_integrations.admin

Procedure

1. Navigate to **HR Integrations > Sources**.

2. Open the **First Advantage** record.

3. In the **SOAP credentials** related list, provide the SOAP credentials to use with your integration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint URL</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• The default value is a placeholder URL only. Make sure to replace it with the unique endpoint URL that you get from your third-party provider.</td>
</tr>
<tr>
<td></td>
<td>• Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.</td>
</tr>
<tr>
<td>Inbound Username</td>
<td>User name for inbound data pull.</td>
</tr>
<tr>
<td>Inbound Password</td>
<td>Password for inbound user name.</td>
</tr>
<tr>
<td>Outbound Username</td>
<td>User name for outbound data push.</td>
</tr>
<tr>
<td>Outbound Password</td>
<td>Password for outbound user name.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. In the **HR Integrations Additional Inputs** related list, provide the value for each key:
   - parent_account
   - account
   - requestor_email_address

6. In the **HR integrations source properties** related list, you can turn on or off the following source properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>Enables the debug log to display responses from the third-party system. Turn on to troubleshoot and debug the integration on an as-needed basis.</td>
</tr>
<tr>
<td></td>
<td>• Type: true or false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Navigate to HR Integrations &gt; Logs to view the development logs.</td>
</tr>
</tbody>
</table>

What to do next
If you need to further configure the source credentials, see Configure source credentials for a background check system.

Verify integration for the First Advantage service
The integration is configured to push background check data between the HR service in HR Service Delivery and the First Advantage service. You can verify the preconfigured settings and determine whether they meet your needs or if further customization is required.

Before you begin
Role required: sn_hr_integrations.admin

Procedure
1. Verify the HR service mapping, which maps the HR service to the HR web service.
   a. Navigate to HR Integrations > HR Service Mapping.
   b. Right-click the HR external source column and select Group By HR external source.
   c. For the First Advantage group, click the arrow to expand the list. For each record, click the information icon to verify that the HR service is correctly mapped to the appropriate HR web service.

<table>
<thead>
<tr>
<th>HR service mapping</th>
<th>HR service</th>
<th>HR web service</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Advantage - Request Background Check by First Advantage</td>
<td>Request Background Check by First Advantage</td>
<td>First Advantage Web Service</td>
</tr>
</tbody>
</table>

2. Verify the HR outbound schema mappings.
   a. Navigate to HR Integrations > HR Outbound Schema Mapping.
   b. Right-click the Source Table column and select Group By Source Table.
   c. For the HR Talent Management Case [sn_hr_core_case_talent_management] group, click the arrow to expand the list. Click the information icon for each First Advantage record to verify that the data fields from the source tables are correctly mapped to the appropriate fields in First Advantage.

3. Verify the HR schema mappings.
a. Navigate to **HR Integrations > HR Schema Mapping**.

b. Right-click the **Source** column and select **Group By Source**.

c. For the **First Advantage** group, click the arrow to expand the list. For each record, click the information icon to verify that the data fields from First Advantage are correctly mapped to the appropriate fields in the staging tables.

4. Verify the HR transform maps.

a. Navigate to **HR Integrations > HR Transform Maps**.

b. In the **Table Transform Maps** list, verify that the staging tables are correctly mapped to the appropriate target tables.

<table>
<thead>
<tr>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Integrations Background Check Staging [sn_hr_integrations_background_check_staging]</td>
<td>HR Talent Management Case [sn_hr_core_case_talent_management]</td>
</tr>
</tbody>
</table>

**What to do next**

If you need to further customize the integration, see **Configure integration for a background check system**.

**Add background check packages for the First Advantage service**

Add one or more background check packages to your instance so they can be accessed when a request for a background check by First Advantage is made. For example, you can add a package for a background check only and a package for both a background check and drug screening.

**Before you begin**

A background check package is a set of activities that are defined by the third-party system to be included in a background check. You can have a package for a background check only, a package for both a background check and drug screening, and so on. For each background check package, you must provide:

- Package ID
- Package name
- Package description

Role required: **sn_hr_integrations.admin**

**Procedure**

1. Navigate to **HR Integrations > Background Check Package**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**Background Check Package form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package ID</td>
<td>ID of the background check package.</td>
</tr>
<tr>
<td>Package name</td>
<td>Name of the background check package.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the background check package.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the third-party background check system.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**What to do next**
If you have more background check packages to add, repeat the process. If you want to set a background check package to appear as the default package in the HR service form, see **Configure background check packages for a background check system**. Otherwise, the integration setup is complete.

**Integrating with the Accurate Background service**
The preconfigured Accurate Background integration uses REST services to request background checks through the Accurate Background service. You can use the preconfigured integration as-is or customize it to meet your needs.

**Accurate integration overview**
The Accurate integration is configured to request background checks as follows.

- The HR agent creates a case to request a background check through the Accurate service.
- The Accurate service evaluates the request to:
  - Update the case with the background check applicant ID and status.
  - Send an email to the employee with a link to sign up and complete a background check application through the Accurate website.
- Once the employee completes the background check application, the Accurate service performs the background check.
- When the background check is complete, the Accurate service will update the case with the background check status and details.

**Accurate integration setup**
To set up the Accurate integration, you must provide the source credentials, verify the integration settings, and add the appropriate background check packages. Once the integration is complete, you can request background checks through the Accurate service.

**Provide source credentials for the Accurate service**
Provide the source and REST credentials for the Accurate service so that it can be accessed for integration.

**Before you begin**
So the Accurate service can be accessed for integration, you must provide:

- REST credentials, including the endpoint URL, user name, and password

Role required: sn_hr_integrations.admin

**Procedure**
1. Navigate to **HR Integrations > Sources**.
2. Open the **Accurate Background Check** record.
3. In the **REST credentials** related list, provide the Basic authentication profile credentials to use with your integration.

**Important:** In the corresponding HR REST service, you must provide the unique endpoint URL that you get from your third-party provider.

a. In the **Basic auth profile list** field, click the **Unlock** icon.

b. Select the **Accurate BG Check Credentials** profile, and then click **Preview** and open the record.

c. In the **Basic Auth Configuration** form, provide the user name and password.

d. Click **Update**.

4. Right-click the form header and click **Save**.

5. In the **HR integrations source properties** related list, you can turn on or off the following source properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>Enables the debug log to display responses from the third-party system. Turn on to troubleshoot and debug the integration on an as-needed basis.</td>
</tr>
<tr>
<td></td>
<td>• Type: true or false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Navigate to <strong>HR Integrations &gt; Logs</strong> to view the development logs.</td>
</tr>
</tbody>
</table>
**What to do next**
If you need to further configure the source credentials, see Configure source credentials for a background check system.

**Verify integration for the Accurate service**
The integration is configured to push background check data between the HR service in HR Service Delivery and the Accurate service. You can verify the preconfigured settings and determine whether they meet your needs or if further customization is required.

**Before you begin**
Role required: sn_hr_integrations.admin

**Procedure**
1. Verify the HR service mappings, which maps the HR service or HR integration outbound services to the HR web services.
   a. Navigate to **HR Integrations > HR Service Mapping**.
   b. Right-click the **HR external source** column and select **Group By HR external source**.
   c. For the **Accurate** group, click the arrow to expand the list. For each record, click the information icon to verify that the HR service or HR integration outbound services are correctly mapped to the appropriate HR web services.

   **Note:** Make sure to verify the endpoint URL for the Accurate Background Check API record.

<table>
<thead>
<tr>
<th>HR service mapping</th>
<th>HR service or HR integration outbound service</th>
<th>HR web service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accurate Background Check - Accurate Background Check - Get Order Updates</td>
<td>Accurate Background Check - Get Order Updates</td>
<td>Accurate Background Check API</td>
</tr>
<tr>
<td>Accurate Background Check - Accurate Background Check - Get Report Data</td>
<td>Accurate Background Check - Get Report Data</td>
<td>Accurate Background Check API</td>
</tr>
<tr>
<td>Accurate Background Check - Accurate Background Check - Place Order</td>
<td>Accurate Background Check - Place Order</td>
<td>Accurate Background Check API</td>
</tr>
<tr>
<td>Accurate Background Check - Request Background Check by Accurate</td>
<td>Request Background Check by Accurate</td>
<td>Accurate Background Check API</td>
</tr>
</tbody>
</table>

2. Verify the HR outbound schema mappings.
   a. Navigate to **HR Integrations > HR Outbound Schema Mapping**.
   b. Right-click the **Source Table** column and select **Group By Source Table**.
c. For the HR Talent Management Case [sn_hr_core_case_talent_management] group, click the arrow to expand the list. Click the information icon for each Accurate record to verify that the data fields from the source tables are correctly mapped to the appropriate fields in Accurate.

3. Verify the HR schema mappings.
   a. Navigate to HR Integrations > HR Schema Mapping.
   b. Right-click the Source column and select Group By Source.
   c. For the Accurate group, click the arrow to expand the list. For each record, click the information icon to verify that the data fields from Accurate are correctly mapped to the appropriate fields in the staging tables.

4. Verify the HR transform maps.
   a. Navigate to HR Integrations > HR Transform Maps.
   b. In the Table Transform Maps list, verify that the staging tables are correctly mapped to the appropriate target tables.

<table>
<thead>
<tr>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Integrations [sn_hr_integrations]</td>
<td>HR Talent Management Case [sn_hr_core_case_talent_management]</td>
</tr>
<tr>
<td>Background Check Staging</td>
<td></td>
</tr>
<tr>
<td>[sn_hr_integrations_background_check_staging]</td>
<td></td>
</tr>
</tbody>
</table>

What to do next
If you need to further customize the integration, see Configure integration for a background check system.

Add background check packages for the Accurate service
Add one or more background check packages to your instance so they can be accessed when a request for a background check by Accurate is made. For example, you can add a package for a background check only and a package for both a background check and drug screening.

Before you begin
A background check package is a set of activities that are defined by the third-party system to be included in a background check. You can have a package for a background check only, a package for both a background check and drug screening, and so on. For each background check package, you must provide:

- Package ID
- Package name
- Package description

Role required: sn_hr_integrations.admin

Procedure
1. Navigate to HR Integrations > Background Check Package.
2. Click New or open a record.
3. Fill in the fields on the form.
### Background Check Package form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package ID</td>
<td>ID of the background check package.</td>
</tr>
<tr>
<td>Package name</td>
<td>Name of the background check package.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the background check package.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the third-party background check system.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

#### What to do next

If you have more background check packages to add, repeat the process. If you want to set a background check package to appear as the default package in the HR service form, see [Configure background check packages for a background check system](#). Otherwise, the integration setup is complete.

#### Integrating with the Sterling Talent Solutions service

The preconfigured Sterling Talent Solutions integration uses REST services to request background checks through the Sterling service. You can use the preconfigured integration as-is or customize it to meet your needs.

#### Sterling integration overview

The Sterling integration is configured to request background checks as follows.

- The HR agent creates a case to request a background check through the Sterling service.
- The Sterling service evaluates the request to:
  - Update the case with the background check order ID.
  - Send an email to the employee with a link to sign up and complete a background check application through the Sterling website.
- Once the employee completes the background check application, the Sterling service performs the background check.
- When the background check is complete, the Sterling service will update the case with the background check status and details.

#### Sterling integration setup

To set up the Sterling integration, you must provide the source credentials, verify the integration settings, and add the appropriate background check packages. Once the integration is complete, you can request background checks through the Sterling service.

**Provide source credentials for the Sterling service**

Provide the source and REST credentials for the Sterling service so that it can be accessed for integration.

**Before you begin**

So the Sterling service can be accessed for integration, you must provide:

- REST credentials, including the endpoint URL
- user_id
- client_reference_id
• integration_id
• password
• account

Role required: sn_hr_integrations.admin

Procedure
1. Navigate to HR Integrations > Sources.
2. Open the Sterling Background Check record.
3. In the REST credentials related list, do not provide the credentials to use with your integration. Instead, you must provide those credentials in the HR Integrations Additional Inputs related list.

   ! Important: In the corresponding HR REST service, you must provide the unique endpoint URL that you get from your third-party provider.

4. Right-click the form header and click Save.
5. In the HR Integrations Additional Inputs related list, provide the value for each key.
   • user_id
   • client_reference_id
   • integration_id
   • password
   • account
6. In the HR integrations source properties related list, you can add the following source property.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>Enables the debug log to display responses from the third-party system. Turn on to troubleshoot and debug the integration on an as-needed basis.</td>
</tr>
<tr>
<td></td>
<td>• Type: true or false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Navigate to HR Integrations &gt; Logs to view the development logs.</td>
</tr>
</tbody>
</table>

What to do next
If you need to further configure the source credentials, see Configure source credentials for a background check system.

Verify integration for the Sterling service
The integration is configured to push background check data between the HR service in HR Service Delivery and the Sterling service. You can verify the preconfigured settings and determine whether they meet your needs or if further customization is required.

Before you begin
Role required: sn_hr_integrations.admin
Procedure

1. Verify the HR service mappings, which maps the HR service to the HR web service.

   a. Navigate to **HR Integrations > HR Service Mapping**.
   
   b. Right-click the **HR external source** column and select **Group By HR external source**.
   
   c. For the **Sterling** group, click the arrow to expand the list. For each record, click the information icon to verify that the HR service is correctly mapped to the appropriate HR web service.

   **Note:** Make sure to provide the endpoint URL for the **Sterling Background Check API** record.

<table>
<thead>
<tr>
<th>HR service mapping</th>
<th>HR service</th>
<th>HR web service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sterling Background Check - Request Background Check by Sterling</td>
<td>Request Background Check by Sterling</td>
<td>Sterling Background Check API</td>
</tr>
</tbody>
</table>

2. Verify the HR outbound schema mappings.

   a. Navigate to **HR Integrations > HR Outbound Schema Mapping**.
   
   b. Right-click the **Source Table** column and select **Group By Source Table**.
   
   c. For the HR Talent Management Case [sn_hr_core_case_talent_management] group, click the arrow to expand the list. Click the information icon for each Sterling record to verify that the data fields from the source tables are correctly mapped to the appropriate fields in Sterling.

3. Verify the HR schema mappings.

   a. Navigate to **HR Integrations > HR Schema Mapping**.
   
   b. Right-click the **Source** column and select **Group By Source**.
   
   c. For the **Sterling** group, click the arrow to expand the list. For each record, click the information icon to verify that the data fields from Sterling are correctly mapped to the appropriate fields in the staging tables.

4. Verify the HR transform maps.

   a. Navigate to **HR Integrations > HR Transform Maps**.
   
   b. In the **Table Transform Maps** list, verify that the staging tables are correctly mapped to the appropriate target tables.

<table>
<thead>
<tr>
<th>Staging table</th>
<th>Target table</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Integrations Background Check Staging [sn_hr_integrations_background_check_staging]</td>
<td>HR Talent Management Case [sn_hr_core_case_talent_management]</td>
</tr>
</tbody>
</table>

**What to do next**

If you need to further customize the integration, see [Configure integration for a background check system](#).
Add background check packages for the Sterling service

Add one or more background check packages to your instance so they can be accessed when a request for a background check by Sterling is made. For example, you can add a package for a background check only and a package for both a background check and drug screening.

Before you begin

A background check package is a set of activities that are defined by the third-party system to be included in a background check. You can have a package for a background check only, a package for both a background check and drug screening, and so on. For each background check package, you must provide:

- Package ID
- Package name
- Package description

Role required: sn_hr_integrations.admin

Procedure

1. Navigate to HR Integrations > Background Check Package.
2. Click New or open a record.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package ID</td>
<td>ID of the background check package.</td>
</tr>
<tr>
<td>Package name</td>
<td>Name of the background check package.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the background check package.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the third-party background check system.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

What to do next

If you have more background check packages to add, repeat the process. If you want to set a background check package to appear as the default package in the HR service form, see Configure background check packages for a background check system. Otherwise, the integration setup is complete.

Custom third-party background check system integrations

If a preconfigured integration isn’t available for the third-party background check system used by your organization, you can configure your own custom integration with HR Service Delivery.

Custom integration setup

To set up the custom integration, you must configure the source credentials, integration settings, and background check packages. Once the integration is configured, HR agents from your organization can request third-party background checks through the HR Service Delivery application.
Configure source credentials for a background check system

Configure the source credentials for the third-party background check system so that it can be accessed for integration. If needed, you can also configure the source properties, additional inputs, and source versions.

Before you begin

So the third-party background check system can be accessed for integration, you must provide:

- SOAP or REST credentials, including the endpoint URL, user name, and password

Role required: sn_hr_integrations.admin

Procedure

1. Navigate to **HR Integrations** > **Sources**.
2. Click **New** or open a record.
   
   **Tip:** If you are using a preconfigured integration, open the applicable record for editing.

3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>SOAP</td>
<td>Option to enable the use of SOAP services. If you are using SOAP services with your integration, make sure the box is selected and provide the SOAP credentials to use in the SOAP credentials related list.</td>
</tr>
<tr>
<td>REST</td>
<td>Option to enable the use of REST services. If you are using REST services with your integration, make sure the box is selected and provide the REST credentials to use in the REST credentials related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR integrations source for use.</td>
</tr>
<tr>
<td>Use session token</td>
<td>Option to enable the use of session tokens.</td>
</tr>
<tr>
<td>Outbound push retry count</td>
<td>Number of times to retry the push if the job fails.</td>
</tr>
</tbody>
</table>

4. If you are using SOAP services with your integration, provide the credentials to use in the SOAP credentials related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Endpoint URL</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
</tbody>
</table>
5. If you are using REST services with your integration, provide the Basic authentication profile credentials to use in the REST credentials related list. You can:

**Important:** In the corresponding HR REST service, you must provide the unique endpoint URL that you get from your third-party provider.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Create a new Basic authentication profile** | To create a new profile to use with your integration:  
  a. In the Basic auth profile list field, click the Unlock icon.  
  b. Click the Lookup button, and then click New.  
  c. In the Basic Auth Configuration form, provide the profile name, user name, and password.  
  d. Click Submit.  
  
  **Note:** In the corresponding HR REST service, you must provide the endpoint URL of the third-party system. |
| **Update an existing Basic authentication profile** | To update an existing profile to use with your integration:  
  a. In the Basic auth profile list field, click the Unlock icon.  
  b. Select the profile to update, and then click Preview and open the record.  
  c. In the Basic Auth Configuration form, provide the user name and password.  
  d. Click Update. |
6. Right-click the form header and click Save.

7. In the **HR integrations source properties** related list, you can turn on or off the following source properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_integrations.debug</td>
<td>Enables the debug log to display responses from the third-party system. Turn on to troubleshoot and debug the integration on an as-needed basis.</td>
</tr>
<tr>
<td></td>
<td>• Type: true or false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Navigate to <strong>HR Integrations &gt; Logs</strong> to view the development logs.</td>
</tr>
</tbody>
</table>

8. If the third-party system requires additional information (for example, the company ID, parent account, and so on), add the additional inputs as key and value pairs in the **HR Integrations Additional Inputs** related list.

**Note:** Make sure to update the corresponding HR web services.

9. If different XPaths must be used with different versions of the third-party system, add one or more source versions to be applied to the HR schema mappings in the **HR Integrations Source Versions** related list.

**Note:** Make sure to update the corresponding HR schema mappings.

**Configure integration for a background check system**

Configure the integration to push background check data between the HR service in HR Service Delivery and the third-party background check system. You must configure the HR service, web services, service mappings, outbound schema mappings, schema mappings, and transform maps.

**Note:** If you are further customizing a preconfigured integration, follow the integration tasks as applicable.

1. HR service
2. HR web services (SOAP or REST)
3. HR service mappings
4. HR outbound schema mappings
5. HR schema mappings
6. HR transform maps
Configure an HR service for a background check system

Create an HR service to request background checks through the third-party background check system. You must also create an accompanying HR case template and update the related business rule.

Before you begin
Role required: sn_hr_core.admin

Procedure

1. Create an HR service for the third-party background check system.
   a. Navigate to HR Administration > HR Services > HR Service Configuration.
   b. Click New.
   c. In the HR Service form, provide the following field values to create an HR service in the appropriate topic detail, category, and COE.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR service name</td>
<td>&lt;Name of the HR service&gt;</td>
</tr>
<tr>
<td>Note: For example, the HR service for the preconfigured First Advantage integration is named <em>Request Background Check by First Advantage</em>.</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>This field is automatically set to the name of the HR service.</td>
</tr>
<tr>
<td>Topic detail</td>
<td>Background Check</td>
</tr>
<tr>
<td>Topic category</td>
<td>This field will automatically set to Talent Acquisition when you set the Topic detail to Background Check.</td>
</tr>
<tr>
<td>COE</td>
<td>This field will automatically set to HR Talent Management Case [sn_hr_core_case_talent_management] when you set the Topic detail to Background Check.</td>
</tr>
</tbody>
</table>

   d. Fill in the other fields on the form, as appropriate.
   For further details on creating an HR service, see Configure an HR service.

   e. Right-click the form header and click Save.

2. Create an accompanying HR case template.
a. In the **Template** field, click the Lookup icon.

b. In the **HR Templates** list, click **New** to create a new HR case template.

c. Fill in the fields on the form, as appropriate.
   For further details on creating an HR case template, see [Configure an HR case template](#).

d. Click **Submit**.

e. On the **HR Service** form, click **Update**.

3. Update the related business rule.

   a. Navigate to **System Definition > Business Rules**.

   b. Open the **Push Background Request to Ext Interface** record.

   c. In the **When to run** related list, under the **Filter Conditions** section, click **OR** to add another condition.

   
   d. Add the following condition: `[HR service] [is] `<Name of HR service>`

---

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
e. Click **Update**.

**Configure SOAP services for a background check system**

If you are using SOAP services with your integration, create or modify the appropriate HR web services to define the SOAP messages used to communicate with the third-party background system.

**Before you begin**

Role required: sn_hr_integrations.admin

**About this task**

You can use SOAP messages to communicate with the third-party system. For example, the preconfigured SuccessFactors integration uses both SOAP and REST services. See Outbound SOAP web service for more information.

**Procedure**

1. Navigate to **HR Integrations > HR Web Services > HR SOAP Services**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**SOAP Message form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the SOAP message.</td>
</tr>
<tr>
<td>WSDL</td>
<td>URL for the Web Service Description Language (WSDL) that describes the table schema and available operations. This field appears when the Download WSDL check box is selected.</td>
</tr>
</tbody>
</table>

**Note:** Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.

| Download WSDL | Option for enabling download of the WSDL.                                                                                                         |
4. Right-click the form header and click **Save**.

5. In the **SOAP Message Functions** related list, you can create new or modify existing SOAP message functions.
   
   See [SOAP message functions](#) for more information.

   **Note:** Do not click **Generate sample SOAP messages**, as this overwrites existing functions.

6. Click **Update**.

### Configure REST services for a background check system

If you are using REST services with your integration, create or modify the appropriate HR web services to define the REST messages used to communicate with the third-party background system.

**Before you begin**

Role required: sn_hr_integrations.admin

**About this task**

You can use REST messages to communicate with the third-party system. For example, the preconfigured First Advantage integration uses REST services, while the preconfigured SuccessFactors integration uses both SOAP and REST services. See [Outbound REST web service](#) for more information.
**Procedure**

1. Navigate to **HR Integrations > HR Web Services > HR REST Services**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**REST Message form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the REST message.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the REST message.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Unique endpoint URL provided by the third-party system.</td>
</tr>
</tbody>
</table>

**Note:**

- If you are using a preconfigured integration, the default value is a placeholder URL only. Make sure to replace it with the unique endpoint URL that you get from your third-party provider.
- Data that is transferred between the customer instance and the third-party system is secured through standard SSL. For a secure connection, provide an encrypted HTTPS link.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Accessible from</td>
<td>This field is automatically set to This application scope only.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.
5. In the **Authentication** related list, fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication type</td>
<td>Authentication type of the REST message.</td>
</tr>
</tbody>
</table>

**Note:** If you are using REST services, set the value to **Basic**. Provide the credentials to use in the **Basic auth profile** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic auth profile</td>
<td>Credentials for the REST message. Click the Lookup icon to add or create your authentication credentials. This field appears when <strong>Basic</strong> is selected from <strong>Authentication type</strong>.</td>
</tr>
<tr>
<td>Use mutual authentication</td>
<td>Option for enabling mutual authentication. If selected, provide the credentials to use for mutual authentication in the <strong>Mutual authentication profile</strong> field.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

Under the **HTTP Methods** section, several default HTTP methods are automatically created using settings inherited from the REST message record. Subsequent changes to the REST message record are not applied to the HTTP methods automatically.
You can create additional HTTP methods or modify the default HTTP methods to implement new behavior. See Define a REST message HTTP method for more information.

**Important:** If you are using a preconfigured integration, the default endpoint URL for each method is a placeholder value only. Make sure to replace each value with the unique endpoint URL that you get from your third-party provider.

Configure a scripted REST API for a background check system

If your integration requires it, you can build a scripted REST API so that the third-party background check system can push data to HR Service Delivery.

**Before you begin**

Role required: sn_hr_integrations.admin

**About this task**

You can build a scripted REST API so that the third-party system can push data to HR Service Delivery. See Scripted REST APIs for more information.

**Procedure**

1. Navigate to HR Integrations > HR Web Services > HR Scripted REST APIs.
2. Click New or open a record.
3. Fill in the fields on the form.

**Scripted REST Service form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scripted REST service.</td>
</tr>
<tr>
<td>API ID</td>
<td>This field is automatically set based on the name of the scripted REST service.</td>
</tr>
<tr>
<td>Protection policy</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>API namespace</td>
<td>This field is automatically set to sn_hr_integrations.</td>
</tr>
</tbody>
</table>
4. Click **Submit** or **Update**.
   After you create the API, configure the service as needed. See [Create a Scripted REST API](#) for more information.

**Configure HR service mappings for a background check system**

Create or modify the HR service mappings to map the HR services to the appropriate HR web services.

**Before you begin**
Role required: sn_hr_integrations.admin

**Procedure**

1. Navigate to **HR Integrations > HR Service Mapping**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

### HR Integrations Service Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Response content type</td>
<td>Response content type of the HR service mapping: XML or JSON.</td>
</tr>
<tr>
<td>HR external source</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>HR service</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• (Outbound integration for HR management systems only) If you are using an HR service, the HR service to use with the HR service mapping. Otherwise, provide an HR integration outbound service to use in the <strong>HR integration outbound service</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• (Background check systems only) HR service to use with the HR service mapping.</td>
</tr>
<tr>
<td>HR integration service</td>
<td>(Inbound integration for HR management systems only) HR integration service to use with the HR service mapping.</td>
</tr>
<tr>
<td>HR integration outbound service</td>
<td>(Outbound integration for HR management systems only) If you are using an HR integration outbound service, the HR integration outbound service to use with the HR service mapping. Otherwise, provide an HR service to use in the <strong>HR service</strong> field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR integrations service mapping for use.</td>
</tr>
<tr>
<td>Response root key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the appropriate root node. The children of the root node are recorded in the associated staging table.</td>
</tr>
<tr>
<td>Response total results key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the total number of results in the XML or JSON response.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Response has more data</td>
<td>Additional metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the appropriate root node. The children of the root node are recorded in the associated staging table.</td>
</tr>
<tr>
<td>Response page results key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the number of page results in the XML or JSON response.</td>
</tr>
<tr>
<td>Response current page key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the number of the current page in the XML or JSON response.</td>
</tr>
<tr>
<td>Response total pages key</td>
<td>Metadata from the third-party system. Provide the XPath of the XML or the address of the JSON pointing to the total number of pages in the XML or JSON response.</td>
</tr>
<tr>
<td>Outbound request type</td>
<td>Outbound request type of the HR service mapping: SOAP or REST.</td>
</tr>
<tr>
<td></td>
<td>• If you are using SOAP web services, you should have provided the credentials when configuring your source.</td>
</tr>
<tr>
<td></td>
<td>• If you are using REST web services, you should have provided the credentials when configuring your HR web service. Alternatively, provide the authentication type and profile in the Authentication type and Basic auth profile fields.</td>
</tr>
<tr>
<td>SOAP or REST outbound service</td>
<td>SOAP or REST web service to use with the HR service mapping.</td>
</tr>
<tr>
<td>SOAP or REST outbound service function</td>
<td>SOAP or REST web service function to use with the HR service mapping. This function runs (except for the first time) when data is pulled from or pushed to the third-party system.</td>
</tr>
<tr>
<td>SOAP or REST outbound service function all</td>
<td>SOAP or REST web service function to be used with the HR service mapping. This function runs the first time that data is pulled from or pushed to the third-party system.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Authentication type of the REST web service. This field appears when REST is selected from Outbound request type.</td>
</tr>
<tr>
<td>Basic auth profile</td>
<td>Basic auth profile of the REST web service. This field appears when Basic is selected from Authentication type.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Configure HR outbound schema mappings for a background check system**

Create or modify the HR outbound schema mappings to map the data fields from the source tables to the appropriate target fields in the third-party background check system.

**Before you begin**

Role required: sn_hr_integrations.admin
Procedure
1. Navigate to **HR Integrations > HR Outbound Schema Mapping**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**HR Integrations Outbound Schema Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service mapping</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Source table</td>
<td>Name of the source table that data is pushed from.</td>
</tr>
<tr>
<td>Source table column</td>
<td>Name of the column in the source table that data is pushed from.</td>
</tr>
<tr>
<td>Target column</td>
<td>Name of the target column in the third-party system.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option to indicate that the data is mandatory for integration.</td>
</tr>
<tr>
<td>Use source script</td>
<td>Option to enable use of source scripts. If selected, provide the source script to use in the <strong>Source script</strong> field.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Configure HR schema mappings for a background check system**
Create or modify the HR schema mappings to map the data fields from the third-party background check system to the appropriate fields in the staging tables.

**Before you begin**
Role required: sn_hr_integrations.admin

Procedure
1. Navigate to **HR Integrations > HR Schema Mapping**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**HR Integrations Schema Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Name of the third-party system.</td>
</tr>
<tr>
<td>Source version</td>
<td>Version of the third-party system, if applicable.</td>
</tr>
<tr>
<td>Service mapping</td>
<td>Name of the HR service mapping.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option to enable a mandatory field value.</td>
</tr>
<tr>
<td></td>
<td>• If selected, the value from the third-party system cannot be null. If the record is null, then the record it originates from is ignored and not placed into the staging table.</td>
</tr>
<tr>
<td></td>
<td>• If cleared, then any field value from the third-party system is accepted.</td>
</tr>
<tr>
<td>Use script</td>
<td>Option to enable use of source scripts. If selected, provide the source script to use in the <strong>Source script</strong> field.</td>
</tr>
</tbody>
</table>
### Table Transform Map form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR transform map.</td>
</tr>
<tr>
<td>Source table</td>
<td>Name of the staging table.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the transform map for use.</td>
</tr>
</tbody>
</table>

#### 4. Click **Submit** or **Update**.

**Configure HR transform maps for a background check system**

Create or modify the HR transform maps to map the staging tables to the appropriate target tables.

**Before you begin**

Role required: `sn_hr_integrations.admin`

**Procedure**

1. Navigate to **HR Integrations > HR Transform Maps**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staging Table</td>
<td>Name of the staging table that the data from the third-party system is pulled to.</td>
</tr>
<tr>
<td>Staging table column</td>
<td>Name of the column in the staging table that the data from the third-party system is pulled to.</td>
</tr>
<tr>
<td>Type</td>
<td>Value type of the column: XPath (variable), constant, or JSON.</td>
</tr>
<tr>
<td>External Entity Column Key</td>
<td>Value (XPath, constant, or JSON) to insert into the corresponding column of the HR staging table.</td>
</tr>
</tbody>
</table>

- If the **Type** is set to **XPath**, then provide the XPath so that HR Service Delivery can parse the XML response, get the respective value, and insert it into the corresponding column in the HR staging table. For example, the preconfigured SuccessFactors integration uses XPaths for data being pulled into the HR Integrations Worker Profile [sn_hr_integrations_work_profile] staging table.

- If the **Type** is set to **Constant**, then provide the text value so that HR Service Delivery can copy it into the corresponding column in the HR staging table.

- If the **Type** is set to **JSON**, then provide the JSON path so that HR Service Delivery can extract the JSON response, get the respective value, and insert it into the corresponding column in the HR staging table. For example, the preconfigured SuccessFactors integration uses JSON for data being pulled into the HR Integrations Department Staging [sn_hr_integrations_dept_staging] table.
Field Map form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map</td>
<td>Name of the HR transform map.</td>
</tr>
<tr>
<td>Source table</td>
<td>Name of the HR staging table.</td>
</tr>
<tr>
<td>Source field</td>
<td>Name of the field in the HR staging table.</td>
</tr>
<tr>
<td>Use source script</td>
<td>Option to enable use of source scripts.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Target table</td>
<td>Name of the HR target table.</td>
</tr>
<tr>
<td>Target field</td>
<td>Name of the field in the HR target table.</td>
</tr>
<tr>
<td>Coalesce</td>
<td>Option to enable coalesces.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. In the **Field Maps** related list, create one or more field mappings to map fields from the staging table to the appropriate fields in the target table.

   a. Click **New** or open a record.

   b. Fill in the fields on the form.

   c. Right-click the form header and click **Save**.

6. In the **Transform Scripts** related list, create one or more transform scripts.

   a. Click **New** or open a record.

   b. Fill in the fields on the form.
### Transform Script form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When</td>
<td>When the transform script is run: onAfter, onBefore, onChoiceCreate, onComplete, onForeignInsert, onReject, onStart.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Human Resources: Integrations.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the transform script for use.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for when transform scripts are applied. Lower numbered transform scripts are applied before higher numbered transform scripts.</td>
</tr>
<tr>
<td>Script</td>
<td>Function of the transform script.</td>
</tr>
</tbody>
</table>

**Configure background check packages for a background check system**

Configure the background check packages so they can be accessed when a background check request is made through the HR service configured for your third-party background check system. You can also select a background check package to appear as the default package in the HR service form.

**Add background check packages for a background check system**

Add one or more background check packages to your instance so they can be accessed when a request for a background check by your third-party background check system is made. For example, you can add a package for a background check only and a package for both a background check and drug screening.

**Before you begin**

A background check package is a set of activities that are defined by the third-party system to be included in a background check. You can have a package for a background check only, a package for both a background check and drug screening, and so on. For each background check package, you must provide:

- Package ID
- Package name
- Package description

Role required: sn_hr_integrations.admin

### Procedure

1. Navigate to **HR Integrations > Background Check Package**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

### Background Check Package form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package ID</td>
<td>ID of the background check package.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Package name</td>
<td>Name of the background check package.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the background check package.</td>
</tr>
<tr>
<td>Source</td>
<td>Name of the third-party background check system.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**What to do next**
If you have more background check packages to add, repeat the process. If you want, you can set a background check package to appear as the default package in the HR service form. Otherwise, the integration process is complete.

**Set a default background check package for the HR service**
Select a background check package to appear as the default package in the HR service form for your third-party background check system. For example, if you have a package for background check only and a package for background check and drug screening, you can designate the former as the default package.

**Before you begin**
Role required: sn_hr_core.admin

**Procedure**
1. Navigate to **HR Administration > HR Services > HR Service Configuration**.
2. Open the appropriate HR service.
3. In the **Template** field, click the information icon to open the record.

**Example**

4. In the HR case template, at the bottom of the form, click the **Add field** list and select the **Background check package** field.
5. In the **Background check package** field, select a background check package as the default value.
Example

6. Click Update.
7. On the HR Service form, click Update.

What to do next
The integration process is complete. You can now request background checks through the third-party background check system.

Integrating with the DocuSign service
Request electronic signatures through the DocuSign service with the DocuSign integration. This integration depends on the DocuSign spoke in IntegrationHub, and is enabled for the signing of ad hoc documents (HR PDF document templates) and DocuSign templates. A preconfigured HR service, flow, and HR case template for both the ad hoc document flow and DocuSign template flow are available to use.

DocuSign spoke
The DocuSign integration depends on the DocuSign spoke in IntegrationHub. Before you begin, an admin must have set up the DocuSign spoke, including registering as an OAuth provider and creating credential and connection records. You must also synchronize DocuSign with your ServiceNow instance.

- Set up DocuSign spoke
- Synchronize DocuSign with ServiceNow

Note:
- You must synchronize each time you need to get new or updated DocuSign templates. To synchronize, navigate to DocuSign > Accounts and click the Get Accounts related link.
- If your organization has more than one DocuSign account, the ad hoc document flow uses the first available account.

DocuSign integration setup
Once the DocuSign spoke is set up and synchronized, you can configure the integration for HR. Depending on whether the user is signing an ad hoc document (HR PDF document
template) or a DocuSign template, the integration has two flows that you can use. For each document that you want to make available for signing through the DocuSign service, configure as follows.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Configuration requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad hoc document flow</td>
<td>1. Create a managed document that you want to make available for signing. See Managed Documents for more information.</td>
</tr>
<tr>
<td></td>
<td>2. Configure an HR PDF document template for an ad hoc document</td>
</tr>
<tr>
<td></td>
<td>3. Configure an HR service for the DocuSign integration</td>
</tr>
<tr>
<td>DocuSign template flow</td>
<td>1. Create a DocuSign template that you want to make available for signing. See the DocuSign eSignature User Guide for more information.</td>
</tr>
<tr>
<td></td>
<td>2. Configure an HR PDF document template for a DocuSign template</td>
</tr>
<tr>
<td></td>
<td>3. Configure an HR service for the DocuSign integration</td>
</tr>
</tbody>
</table>

The ad hoc document flow is for the signing of static documents that originate from a managed document in the ServiceNow system. Each ad hoc document is configured as a standard HR PDF document template. You can add signers to the document with Mark Signatures, and then map each signature field to an appropriate user field in a table. (The positioning of the markings are not used, and the DocuSign integration allows the signer to sign anywhere in the document.) You can also parse the PDF to map document fields to corresponding table fields to auto-populate the document when it is generated for signing. The generated document is static, which means that it is read-only and the signatory cannot update any of the fields.

The DocuSign template flow is for the signing of dynamic documents that originate from the DocuSign system. Each DocuSign template is brought into the ServiceNow system, and then configured into an HR PDF document template to enable mappings. You must map each signature field from the DocuSign template to an appropriate user field in a table. You can also map fields from the DocuSign template to corresponding table fields to auto-populate the document for signing. The generated document is dynamic, which means that the signatory can write in editable fields, such as to update an address or provide W-4 information. However, any updates made are saved to the document only. They are not mapped back to the source table.

**Requesting electronic signatures through the DocuSign service**

Once the integration setup is complete, HR agents from your organization can request electronic signatures through the DocuSign service.

- Request an electronic signature through the DocuSign service

**Configure an HR PDF document template for an ad hoc document**

If you are using the DocuSign integration, configure an HR PDF document template for each ad hoc document that you want to make available for signing. You can use an existing or create a new HR PDF document template. You can add signers to the document with Mark Signatures, and then map each signature field to an appropriate user field in a table. You can also parse the PDF to map document fields to corresponding table fields to auto-
populate the document when it is generated for signing. As part of the DocuSign integration only, you can also enable serial signing for documents that require multiple signers.

Before you begin
Create the managed document that you want to make available for signing through the DocuSign system. See Managed Documents for more information.

Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Document Templates.
2. Click New or open a record
   
   **Note:** If you are creating a new record, make sure to select PDF Document Template.

3. On the PDF Document Template form, set the Template type field to HR PDF Templates.

4. Configure the HR PDF document template, as appropriate.
   You can add signers to the document with Mark Signatures, and then map each signature field to an appropriate user field in a table. You can also parse the PDF to map document fields to corresponding table fields to auto-populate the document when it is generated for signing. For further details on configuring an HR PDF document template, see Configure an HR PDF document template.
   
   **Note:** The positioning of Mark Signatures is not used, and the integration allows the signer to sign anywhere in the document.

5. If you want to enable serial signing for documents that require multiple signers, assign the signing order for each signature field in the PDF Template Mappings section.
   
   **Note:**
   
   • By default, if a document has two or more signature fields, parallel signing is enabled.
   
   • If the Signing order column is not visible, click the gear icon to personalize the list columns. Add the Signing order field to the Selected column.

Example

6. Click Update.
Configure an HR PDF document template for a DocuSign template

If you are using the DocuSign integration, configure an HR PDF document template for each DocuSign template that you want to make available for signing. You must map each signature field from the DocuSign template to an appropriate user field in a table. You can also map fields from the DocuSign template to corresponding table fields to auto-populate the document when it is generated for signing.

Before you begin
Create the DocuSign template that you want to make available for signing through the DocuSign system. See the DocuSign eSignature User Guide for more information. You must also synchronize your accounts to bring the DocuSign template (and any other new or updated templates) into the ServiceNow system. See Synchronize DocuSign with ServiceNow for more information.

⚠ Note: Each DocuSign template must have one associated document. Multiple documents per template are not supported.

Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Document Templates.
2. Click New or open a record.

⚠ Note: If you are creating a new record, make sure to select PDF Document Template.

3. On the PDF Document Template form, set the Template type field to DocuSign Template.

4. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR document template.</td>
</tr>
<tr>
<td>Table</td>
<td>HR table that the HR document template is associated with.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type that the HR document template is categorized under.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR document template for use.</td>
</tr>
<tr>
<td>Template type</td>
<td>Set the value to DocuSign Template.</td>
</tr>
<tr>
<td>DocuSign template</td>
<td>Select the DocuSign template to use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Note:</td>
<td>You must synchronize each time you need to get new or updated DocuSign templates. To synchronize, navigate to <strong>DocuSign &gt; Accounts</strong> and click the <strong>Get Accounts</strong> related link. See <strong>Synchronize DocuSign with ServiceNow</strong> for more information.</td>
</tr>
<tr>
<td>HR criteria</td>
<td>Defines the conditions that the subject person of an HR case must meet for an HR agent to be able to access the HR document template on their behalf.</td>
</tr>
</tbody>
</table>

5. Right-click on the form header and click **Save**. The **Get template fields status** field, **Get Template Fields** related link, and PDF Template Mappings section displays.

6. Click the **Get Template Fields** related link.

**Note:** If any changes are made to the signature or document fields on the DocuSign template, you must click the **Get Template Fields** related link to synchronize those changes. Existing mappings are not affected.

**Related Links**
- **Get Template Fields**

7. When the **Get template fields status** field changes to **Completed**, reload the form.

**Note:** If you are using a Safari browser, you must reload the form to see the changed state.

In the **PDF Template Mappings** section, a list of the mappable fields displays.

8. In the **PDF Template Mappings** section, you must map each signature field from the DocuSign template to an appropriate user field in a table.

**Note:**
- Configuration of the signature fields, including for parallel and serial signing, must be completed within the DocuSign system. You cannot add or configure the signature fields from within the HR PDF document template.

**Example**

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
9. In the **PDF Template Mappings** section, you can also map fields from the DocuSign template to corresponding table fields to auto-populate the document when it is generated for signing.

**Note:**
- Make sure that the data type of the DocuSign field matches that of the table field.
- Mapping is not supported for the following DocuSign field types:
  - Initial
  - Date signed
  - Payment item
  - Formula
  - Attachment
  - Note
  - Approve
  - Decline

10. **Click Update.**

**Configure an HR service for the DocuSign integration**

Create or modify an HR service to request electronic signatures through the DocuSign service. Preconfigured flows to collect signatures for either an ad hoc document (HR PDF document template) or a DocuSign template are available to use. You must also configure an associated HR case template to set a default ad hoc document or DocuSign template for signing.

**Before you begin**

Role required: sn_hr_core.admin

**About this task**

Depending on whether the user is signing an ad hoc document (HR PDF document template) or a DocuSign template, the following preconfigured HR services, flows, and HR case templates are available for your use and example. See [HR services](#) to learn more about HR service configuration, generally.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad hoc document</td>
<td>HR service</td>
<td>Request Signature using DocuSign on Adhoc Document</td>
</tr>
<tr>
<td>flow</td>
<td>Flow</td>
<td>DocuSign Integration Flow - Adhoc Document</td>
</tr>
<tr>
<td></td>
<td>HR case template</td>
<td>Signature using DocuSign on Adhoc Document</td>
</tr>
<tr>
<td>DocuSign template flow</td>
<td>HR service</td>
<td>Request Signature using DocuSign Template</td>
</tr>
<tr>
<td></td>
<td>Flow</td>
<td>DocuSign Integration - DocuSign Template</td>
</tr>
<tr>
<td></td>
<td>HR case template</td>
<td>Signature using DocuSign Template</td>
</tr>
</tbody>
</table>
Procedure

1. Configure an HR service for the DocuSign integration.

   a. Navigate to HR Administration > HR Service Configuration.
   
   b. Click New or open a record.
   
   c. On the HR service form, provide the following values.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad hoc document flow</td>
<td>HR service name</td>
<td>&lt;Name of the HR service&gt;</td>
</tr>
<tr>
<td></td>
<td>Fulfillment type</td>
<td>Flow</td>
</tr>
<tr>
<td></td>
<td>Flow</td>
<td>DocuSign Integration Flow - Adhoc Document</td>
</tr>
<tr>
<td>DocuSign template flow</td>
<td>HR service name</td>
<td>&lt;Name of the HR service&gt;</td>
</tr>
<tr>
<td></td>
<td>Fulfillment type</td>
<td>Flow</td>
</tr>
<tr>
<td></td>
<td>Flow</td>
<td>DocuSign Integration - DocuSign Template</td>
</tr>
</tbody>
</table>

   d. Fill in the other fields on the form, as appropriate.

   ! Note: In the HR Service Additional Information related list, make sure that the PDF Template field is included so that it appears on the HR case form when a request for this service is made. See Configure the HR case form for an HR service for more information.

   e. Right-click the form header and click Save.

2. Configure an accompanying HR case template.

   a. In the Template field, click the Lookup icon.

   b. In the HR Templates list, click New or open a record.

   c. From the Add fields list, select PDF Template.

   d. In the PDF Template field, select the HR PDF document template that you want to make available for signing.

   ! Note:
   - For the ad hoc document flow, make sure to select an HR PDF document template with the Template type field set to HR PDF Templates.ake
   - For the DocuSign template flow, make sure to select an HR PDF document template with the Template type field set to DocuSign Templates.

   e. Fill in the other fields on the form, as appropriate.

   For further details on creating an HR case template, see Configure an HR case template.
f. Click **Submit**.

g. On the HR service form, click **Update**.

**Integrating with the Adobe Sign service**

Request electronic signatures through the Adobe Sign service with the Adobe Sign integration. This integration depends on the Adobe Sign spoke in IntegrationHub, and is enabled for the signing of adhoc documents (HR PDF document templates) and Adobe Sign templates.

A preconfigured HR service, flow, and HR case template for both the adhoc document and Adobe Sign document are available to use.

**Adobe Sign spoke**

The Adobe Sign integration depends on the Adobe Sign spoke in IntegrationHub. Before you begin, your administrator must have:

- **activated the Adobe Sign spoke**
- **set up the Adobe Sign spoke**

**Adobe Sign integration setup**

Once the Adobe Sign spoke is set up, you can configure the integration for HR. The integration has a single flow that branches out into sub flows, one for signing an adhoc document (HR PDF document template) and another for signing an Adobe Sign template. The sub flow triggered for a document depends on the PDF template type that is configured for that document.

For each document that you want to make available for signing through the Adobe Sign service, configure as follows.

<table>
<thead>
<tr>
<th>Type of document</th>
<th>Configuration requirements</th>
</tr>
</thead>
</table>
| Adhoc document (HR PDF document template) | 1. Create a managed document that you want to make available for signing. See [Managed Documents](#) for more information.  
2. Configure an HR service for the adhoc document.  
2. Configure an HR service for the Adobe Sign integration.  

Each adhoc document is configured as a standard HR PDF document template. You can add signers to the document with **Mark Signatures**, and then map each signature field to an appropriate user field in a table. The positioning of the markings are not used, and the Adobe Sign integration allows the signer to sign anywhere in the document. You can also parse the PDF to map document fields to corresponding table fields to auto-populate the document when it is generated for signing. The generated document is static, which means that it is read-only and the signatory cannot update any of the fields.
Each Adobe Sign template is brought into the ServiceNow system, and then configured into an HR PDF document template to enable mappings. Map each signature field from the Adobe Sign template to an appropriate user field in a table. The generated document is dynamic, which means that the signatory can write in editable fields, such as to update an address or provide W-4 information. However, any updates made are saved to the document only.

**Requesting electronic signatures through the Adobe Sign service**

Once the integration setup is complete, HR agents from your organization can request electronic signatures through the Adobe Sign service.

- Request an electronic signature through the Adobe Sign service.

**Activate the Adobe Sign spoke**

Activate the Adobe Sign spoke in IntegrationHub from the ServiceNow Store, and enable the signing of adhoc documents (HR PDF document templates) and Adobe Sign templates.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to the ServiceNow Store.
2. In the ServiceNow Store, search for the Adobe Sign spoke.
3. Click the application tile.
   - Detailed information about the application you are installing is displayed. Consider reading the Other Requirements and Dependencies sections, as applicable.
4. Click Get and enter your HI login credentials.
5. Enter the **Instance Name** and Reason for request, and click Validate Instance.
   - You will receive an email with detailed installation instructions.
6. Log in to the instance and set up the Adobe Sign spoke.

**Configure an HR PDF document template for an adhoc document**

If you are using the Adobe Sign integration, configure an HR PDF document template for each adhoc document that you want to make available for signing. You can use an existing or create an HR PDF document template. You can add signers to the document with Mark Signatures, and then map each signature field to an appropriate user field in a table. As part of the Adobe Sign integration, you can also enable serial signing for documents that require multiple signers.

**Before you begin**

Create the managed document that you want to make available for signing through the Adobe Sign system. See Managed Documents for more information.

Role required: sn_hr_core.admin

**Procedure**

1. Navigate to **HR Administration > Document Templates**.
2. Click **New** or open a record.
   - **Note**: If you are creating a record, make sure to select **PDF Document Template**.
3. On the PDF Document Template form, set the **Template type** field to HR PDF Templates.
4. Fill in the fields on the form, as appropriate.

**HR PDF Template form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR document template.</td>
</tr>
<tr>
<td>Table</td>
<td>HR table that the HR document template is associated with.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type that the HR document template is categorized under.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR document template for use.</td>
</tr>
<tr>
<td>Template type</td>
<td>Set the value to HR PDF Templates.</td>
</tr>
<tr>
<td>Document revision</td>
<td>Select the adhoc template to use.</td>
</tr>
<tr>
<td>HR criteria</td>
<td>Defines the conditions that the subject person of an HR case must meet for an HR agent to be able to access the HR document template on their behalf.</td>
</tr>
</tbody>
</table>

5. Right-click on the form header and click **Save**. The PDF Template Mappings section is displayed.

6. Configure an HR PDF document template, as appropriate.

   You can add signers to the document with **Mark Signatures**, and then map each signature field to an appropriate user field in a table. You can also parse the PDF to map document fields to corresponding table fields to auto-populate the document when it is generated for signing.

   **Note:** The positioning of **Mark Signatures** is not used, and the integration allows the signer to sign anywhere in the document.

7. If you want to enable serial signing for documents that require multiple signers, assign the signing order for each signature field in the PDF Template Mappings section. If the **Signing order** column is not visible, click the gear icon to personalize the list columns. Add the **Signing order** field to the Selected column.

   **Note:**
   - The **Signing order** field remains empty in case of parallel signing.
   - Ensure that the **Field name** of **Document field type** Signature is specified as Participant1, Participant2, Participant3, and so on.
   - Ensure that the signing order of the first participant is lesser than the signing order of the second participant.

8. Click **Update**.
Configure an HR PDF document template for an Adobe Sign template

If you are using the Adobe Sign integration, configure an HR PDF document template for each Adobe Sign template that you want to make available for signing. You must map each signature field from the Adobe Sign template to an appropriate user field in a table.

Before you begin
Create the Adobe Sign template that you want to make available for signing through the Adobe Sign system. See the Adobe Sign user guide for more information. You must also synchronize your accounts to bring the Adobe Sign template (and any other new or updated templates) into the ServiceNow system. See Sync Adobe Sign with ServiceNow for more information.

Note: Each Adobe Sign in template must have one associated document. Multiple documents per template are not supported.

Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Document Templates.
2. Click New or open a record.
   
   Note: If you are creating a record, make sure to select PDF Document Template.
3. On the PDF Document Template form, set the Template type field to Adobe Sign Templates.
   
   Note: Pre filled Adobe sign templates are not supported.
4. Fill in the fields on the form, as appropriate.

HR PDF Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the HR document template.</td>
</tr>
<tr>
<td>Table</td>
<td>HR table that the HR document template is associated with.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type that the HR document template is categorized under.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the HR document template for use.</td>
</tr>
<tr>
<td>Template type</td>
<td>Set the value to Adobe Sign Templates.</td>
</tr>
<tr>
<td>Adobe Sign Document</td>
<td>Select the Adobe Sign template to use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> You must synchronize each time you need to get new or updated Adobe Sign templates.</td>
<td></td>
</tr>
<tr>
<td>HR criteria</td>
<td>Defines the conditions that the subject person of an HR case must meet for an HR agent to be able to access the HR document template on their behalf.</td>
</tr>
</tbody>
</table>

5. Right-click on the form header and click **Save**. The PDF Template Mappings section is displayed.

6. In the **PDF Template Mappings** section, you must manually map fields from the Adobe Sign template to corresponding table fields to populate the document when it is generated for signing.

**Example**

![PDF Template Mappings example](image)

**PDF Template Mappings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Name of the field that is being mapped from the Adobe Sign system to the ServiceNow system.</td>
</tr>
<tr>
<td><strong>Note:</strong> Ensure that the <strong>Field name</strong> of <strong>Document field type</strong> Signature is specified as Participant1, Participant2, Participant3, and so on.</td>
<td></td>
</tr>
<tr>
<td>HR PDF Template</td>
<td>Name of the HR PDF template.</td>
</tr>
<tr>
<td>Document field</td>
<td>Suitable name of the field that is being mapped.</td>
</tr>
<tr>
<td>Document field type</td>
<td>Type of the document field that is being mapped, such as Signature, Text, or checkbox.</td>
</tr>
<tr>
<td>Mapping table</td>
<td>HR table that stores all the field mappings.</td>
</tr>
<tr>
<td>Mapping field</td>
<td>Reference field from which the value is rendered in the <strong>Document</strong> field.</td>
</tr>
<tr>
<td>Signing order</td>
<td>Order in which the participants are to sign the document.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Note:       | • If the **Signing order** column is not visible, click the gear icon to personalize the list columns. Add the **Signing order** field to the Selected column.  
|             | • Ensure that the signing order of the first participant is lesser than the signing order of the second participant.  
|             | • The **Signing order** field remains empty in case of parallel signing.    |

| Active      | Option for enabling or disabling a field mapping.                         |

### Note:
Field mappings are case sensitive.

### 7. Click Submit.

#### Configure an HR service for the Adobe Sign integration

Create or modify an HR service to request electronic signatures through the Adobe Sign service. A preconfigured flow to collect signatures for either an adhoc document (HR PDF document template) or an Adobe Sign template is available to use.

#### Before you begin

**Role required:** sn_hr_core.admin

#### About this task

For signing an adhoc document (HR PDF document template) or an Adobe Sign template, the following preconfigured HR service, flow, and HR case template are available for your use.

- Case template: Signature using Adobe sign in
- HR service: Signature using Adobe sign in
- Flow: Adobe Sign Integration Flow

#### Procedure

1. Configure an HR service for the Adobe Sign integration.
   
a. Navigate to **HR Administration > HR Service Configuration**.

b. Click **New** or open a record.

c. On the HR service form, provide the following values for an adhoc document and Adobe Sign document:
   
   - **HR service name**: Signature using Adobe sign in
   - **Fulfillment type**: Flow
   - **Flow**: Adobe Sign Integration Flow
d. Fill in the other fields on the form, as appropriate.
   For further details on creating an HR service, see Configure an HR service.

   ⚠️ Note: In the HR Service Additional Information related list, make sure that the PDF Template field is included so that it appears on the HR case form when a request for this service is made. See Configure the HR case form for an HR service for more information.

   e. Right-click the form header and click Save.

2. Configure an accompanying HR case template.

   a. In the Template field, click the Lookup icon.

   b. In the HR Templates list, click New or open a record.

   c. From the Add fields list, select PDF Template.

   d. In the PDF Template field, select the HR PDF document template that you want to make available for signing.

      ⚠️ Note:
      • For adhoc document, make sure to select an HR PDF document template with the Template type field set to HR PDF Templates.
      • For the Adobe Sign template, make sure to select an HR PDF document template with the Template type field set to Adobe Sign Templates.

   e. Fill in the other fields on the form, as appropriate.
   For further details on creating an HR case template, see Configure an HR case template.

   f. Click Submit.

   g. On the HR service form, click Update.

Integrating with the CIC Plus service

Integrate with the CIC Plus service so that you can enable US-based new hires to provide relevant tax information as part of the onboarding process. This integration assumes you are already integrated with a third-party identity provider (IDP) service, and is configured to work with the lifecycle event for new hire onboarding that is included as demo data with the Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

Setting up the CIC Plus integration

To set up the CIC Plus integration, you must configure a SAML connection between your third-party identity provider (IDP) and CIC Plus accounts. Your CIC Plus partner must then set up your account to get employee profiles for US-based employees through the get_usa_employee_profile REST endpoint, as well as verify that the callback is properly configured. Finally, you must configure the source credentials to include the login URL of the identity provider service you are using with the CIC Plus integration. For details on how to set up the CIC Plus integration, see Set up the CIC Plus integration.
Using the CIC Plus integration with new hire onboarding

Once the integration is set up, you can use the CIC Plus service with new hire onboarding. The following components are included in the demo data for your use and example.

ℹ️ Note: The lifecycle event for new hire onboarding is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

<table>
<thead>
<tr>
<th>Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle event activity</td>
<td>Complete Tax Forms (in the Day One activity set)</td>
</tr>
<tr>
<td>HR service</td>
<td>Complete Tax Forms through CIC Plus</td>
</tr>
<tr>
<td>HR case template</td>
<td>Complete Tax Forms through CIC Plus</td>
</tr>
</tbody>
</table>

How the CIC Plus integration works

The CIC Plus integration works as follows. Your HR management system (HRMS) pushes employee information to your IDP and Now Platform systems. The CIC Plus integration then invokes the get_usa_employee_profile REST endpoint to fetch employee information. When a user opens an assigned task and clicks on the link to connect to the CIC Plus service, the CIC Plus integration authenticates the user through a SAML identification via your IDP service. After the user completes the required tax forms, the status is pushed back to the Now Platform system and the employee task is automatically closed.

Set up the CIC Plus integration

Integrate with the CIC Plus service by configuring a SAML connection between your third-party identity provider (IDP) and CIC Plus accounts. Your CIC Plus partner must then set up your account to get employee profiles for US-based employees through the get_usa_employee_profile REST endpoint, as well as verify that the callback is properly configured. Finally, you must configure the source credentials to include the login URL of the identity provider service you are using with the CIC Plus integration.

Before you begin

To set up your integration with the CIC Plus service, you must first:

- Be integrated with a third-party identity provider (IDP) service. That provider must have user records for the new hire in their system.
- Create a user with the sn_hr_core.usa_employee_only role.
- Gather the following information from your CIC Plus partner:
SAML configuration details

- Company ID

Provide the following information to your CIC Plus partner:

- IP address range
- Platform instance URL
- Credentials for a user with the sn_hr_core.usa_employee_only role

Role required: sn_hr_integrations.admin

Procedure

1. Configure a SAML connection between your third-party identity provider (IDP) and CIC Plus accounts.

   **Important:** Make sure to configure the SAML connection with the name identifier as the employee number.

   For information on how to configure the SAML connection, refer to the CIC Plus documentation.

2. Your CIC Plus partner must then:

   a. Configure your account to get employee profiles for US-based employees through the get_usa_employee_profile REST endpoint.
      For information and examples on the get_usa_employee_profile REST endpoint, see get_usa_employee_profile.

   b. Verify that the callback is properly configured within your CIC Plus account.

3. Configure the source credentials to include the login URL of the identity provider service:

   a. Navigate to **HR Integrations > Sources**.

   b. Open the **CIC Plus** record.

   c. In the **HR Integrations source properties** related list, open the **CIC Plus URL** source property.

   d. In the **Value** field, provide the login URL of the identity provider service you are using with the CIC Plus integration.
HR Service Delivery integration with Universal Request

With the integration of HR Service Delivery and Universal Request applications, you can provide a consistent user experience for employees while creating service requests. You can hide the complexities of inter-department request transfers and multi-department use cases by providing a common help desk for all employees.

Overview

A universal request gets created when an employee clicks the Request help option in Employee Service Center. A universal request routing agent analyses the issue (as HR department related) and creates an HR case from that universal request. After the case gets resolved by an HR agent, the state of the HR case changes to Awaiting Acceptance. Automatically, the state of the universal request changes to Awaiting response. Finally, after the employee accepts the resolution, the universal request gets closed and in turn the HR case gets closed.

At any point in time, the HR agent can transfer the HR case back to the universal request queue with or without resolution.

All the important details, such as, users who are working on the issue, inter-department transfers, and work notes, are recorded in the universal request ticket, providing complete visibility to the employee who has raised the request.

Activating the necessary plugins

After you have activated the Universal Request (com.snc.universal_request), Human Resources Scoped App: Core (com.sn_hr_core), and Employee Service Center (com.sn_hr_service_portal) plugins, you notice that:

• The Universal Request form contains a UI action to create an HR case.

• The Universal Request field appears on the HR case form when an HR case is associated with a universal request record.

• The Transfer button appears on the HR case form to let an HR agent transfer an HR case back to Universal Request, another department, or service.

• An HR case created from a record producer automatically creates a universal request. It happens only when the Create Universal Request check box is enabled on the record producer.

Similarly in the Create a test case topic block, if the Create Universal Request check box is enabled on the record producer, then a universal request ticket is created and shared with the employee on the Virtual Agent conversation.

• When an HR case associated to a universal request goes through a state change, a notification is sent to the employee (requester) with the universal request number and not the HR case number.

• On Now Platform, HR cases that are associated with Universal Request appear under HR Case Management > All.

• On Employee Service Center, HR requests that are associated with Universal Request appear under Employee Service Center > Requests.

Custom configurations in Universal Request

Transferring and state mappings are preconfigured for all the base system HR states. Do these configurations only when you have a custom state.

About this task

If you have created COEs (Center of Excellence), then create service configurations, state mappings, and transfer configurations as well. In case you have activated the Predictive
Intelligence plugin, configure the service assignment groups by referring to Department Setup for UR.

**Procedure**

1. Navigate to **Universal Request > Administration**.
2. Create your service set and services for Universal Request.
3. Assign the assignment groups for service sets and services.
4. Assign roles to UR users.
5. Map a custom state to that of a universal request.
   The following image is an example of a default state mapping. The **Suspended**, **Work in Progress**, and **Awaiting Approval** states of an HR case are mapped to **In Progress** state of a Universal Request.

![State Mapping Image]

6. Set the transfer configuration for any custom state of an HR case. This transfer configuration allows you to determine what happens to the departmental ticket when the request is transferred to another department or back to UR.
   If an HR case is being transferred with resolution, the state of the HR case automatically changes to **Awaiting Acceptance**. If an HR case is being transferred without a resolution, the state of the HR case automatically changes to **Closed Incomplete**.

7. Create record producers specific to an HR service. A record producer is a specific type of catalog item that allows end users to create task-based records from the service catalog.
   On the record producer, if you select the **Create Universal Request** check box, an HR case created from that record producer automatically creates a universal request record.
Following is an example of a record producer for General Inquiry HR service. When a user selects the catalog item as General Inquiry and creates a ticket, automatically a universal request is created and associated to that HR case.

Create an HR case from Universal Request

Follow these steps to create an HR case from a universal request:

1. Navigate to Universal Requests > All.
2. Open the universal request record from which you want to create an HR case.
3. Click Create HR case.
4. Fill in the fields on the HR case form.
   - Note: The Employee Information field values are automatically copied from the universal request to the HR case.

HR case form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>The Center of Excellence</td>
</tr>
<tr>
<td>HR service</td>
<td>The HR service type</td>
</tr>
<tr>
<td>Opened for</td>
<td>The person the ticket is opened for</td>
</tr>
<tr>
<td>Subject person</td>
<td>The subject person</td>
</tr>
<tr>
<td>Work notes</td>
<td>Other notes if any</td>
</tr>
</tbody>
</table>

5. Click Submit. The universal request number from which the HR case is created appears in the Universal Request field on the HR case form. The HR case number appears in the Primary Ticket field on the universal request form and also under the Associated Tickets related list.

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Work on an HR case of Universal Request

Provide resolution to an HR case that is initiated from a universal request.

Before you begin
Role required: sn_hr_core.case_writer

About this task
The state changes described in the procedure can be configured to suit your requirements. For more information, see Universal Request state mapping.

Procedure
1. Open the HR case that is created from a Universal Request.
2. Click Start Work. The state of the case changes to Work in Progress.

   Note:
   • If another department in HR must work on the request, you can transfer the case with the same number or with a new number. When you transfer the case with a new number, the universal request gets associated to that new case number.
   • If this issue is not related to the HR department, the HR agent must select the Transfer option on the case. For more details on how to transfer the case, see Transfer an HR case in Universal Request.
3. Click Closed Complete when the resolution is provided.
   The state of the HR case is changed to Awaiting acceptance and the state of the universal request is automatically changed to Awaiting response from user. On the Employee Service Center:
   • If the user accepts the resolution, the state of the universal request is changed to Closed. The state of the HR case is automatically changed to Closed Complete.
   • If the user rejects the resolution, the state of the universal request is changed to In progress. The state of the HR case is automatically changed to Work in progress.

   Important: If for any reason the HR agent clicks Closed Incomplete without routing the HR case back to universal request, then the behavior is as follows:
   • If the Needs Additional Review check box is selected on the universal request, the universal request will be in the In progress state, and the HR case will be in the Close Incomplete state.
   • If the Needs Additional Review check box is deselected on the universal request, the universal request gets closed based on the state mapping.

Transfer an HR case in Universal Request

Transfer an HR case back to the Universal Request, or to another department or service with or without resolution.

Before you begin
Role required: sn_hr_core.case_writer

About this task
Configure the sn_uni_req.transfer_type property in the Universal Request properties page to determine how to handle the primary ticket transfers. For more information, see Universal Request Properties.
Procedure
1. Open the HR case that you want to transfer.
2. Click Transfer.

ℹ️ Note: The Transfer option is displayed only if you are a part of the assignment group or if the case is assigned to you.

3. In the Transfer Ticket dialog box, provide the following details.

ℹ️ Note: Based on your transfer type configuration, the given fields are displayed. For more information, see Universal Request properties.

- **Action**: Select if the case should be transferred to another department or back to Universal Request
- **Department**: Select the department from the list.
- **Service**: Select the specific service of the chosen department.
- **Transfer reason**: Select the reason from the list.
- **Transfer notes**: A brief description for routing the primary ticket that you want to pass to the UR Routing agent.
- **Copy additional comments and attachments**: Deselect if you do not want to transfer the ticket with additional comments and attachments. By default, all attachments and comments are transferred.

ℹ️ Note: Work notes are not copied while transferring.

4. Click Transfer.

Results
- On the HR case form, you can view the reason for transferring in the Transfer reason field.
- The state of the HR case is changed to **Awaiting Acceptance** or **Closed Incomplete** based on transfer reason and the transfer reason and transfer notes are copied to the universal request.
- The state of the universal request remains **In progress**.

ℹ️ Note: The state changes mentioned can be configured. See Transfer configuration for more information.

AI Search for HR Service Delivery
The ServiceNow® AI Search application provides a modern consumer-grade search engine for the ServiceNow® Service Portal, Employee Service Center (ESC), ServiceNow® Mobile, and ServiceNow® Virtual Agent.

New customers automatically have the ServiceNow® AI Search application configured with their base system for the ESC only.

If you are an existing customer, you can configure HR Service Delivery to use the ServiceNow® AI Search application.

For more information, see Al Search.

Configuration
For detailed information on configuring the ServiceNow® AI Search application, see Configuring AI Search.
Use the **Search Application Configuration** form to associate the AI Search engine with an HR Service Delivery application.

**Note:** For more information, see `Create a search application configuration for AI Search`.

In the **Search Application Configuration** form, you must also choose a **Search Profile**. The search profile determines the search sources and conditions for people, articles, and services.

The base system provides the following that you can also modify:
- Mobile: NowMobile Default Search Profile
- ESC: ESC Portal Default Search Profile
- Service Portal: Service Portal Default Search Profile
- VA: Service Portal Default Search Profile

**Note:** For mobile, people search is only available to customers that have the ESC.

Under the search profile, there are a series of tabs that enhance AI search. The base system provides the following that you can also modify:
- Search Sources
- Synonyms
- Stop Words
- Typo Handling
- Genius Results
- Result Improvement Rules

**Note:** For more information, see `Defining search profiles`.

### Integration
For detailed information on integrating AI Search with HR Service Delivery, see `Integrating AI Search into your application`.

### Administration
Learn how the AI Search features and behavior affect indexing and search. For more information, see `Administering AI Search`.

### Using
See how AI Search displays results, how to use refinement filter options, and Genius Result answers. For more information, see `Using AI Search`.

**ServiceNow® Mobile**
Configure AI Search for the ServiceNow® Mobile. For more information, see `Advanced text search in mobile`.

**Service Portal or Employee Service Center**
Configure AI Search for the Service Portal or Employee Service Center (ESC) so your users can take advantage of this powerful search tool. For more information, see `AI Search in Service Portal`.

**Virtual Agent**
Virtual Agent uses AI Search to return search results in bot conversations when there are no relevant topics to display. For more information, see Virtual Agent integration with AI Search.

Enterprise Service Management Integrations Framework

The ServiceNow® Enterprise Service Management Integrations Framework application contains common components that can be used for integrating your ServiceNow application with third-party systems. It leverages the flow designer capability to communicate with external instances and third-party systems.

The application provides a consistent way of building integrations for common use cases such as pulling employee profiles and tasks from third-party application to a ServiceNow application, and pushing data from a ServiceNow application into a third-party application.

Setting up the application


Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Components installed with Enterprise Service Management Integrations Framework

Several types of components are installed with activation of the Enterprise Service Management Integrations Framework plugin [sn_hr_integre_fw], including tables and user roles.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Framework Integrations Admin</td>
<td>Can access and set up Enterprise Service Management Integrations Framework.</td>
<td>• Flow Operator [flow_operator]</td>
</tr>
<tr>
<td>[sn_hr_integr_fw.admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration Source [sn_hr_integr_fw_source]</td>
<td>Stores source records representing third-party systems which are integrating with your ServiceNow application.</td>
</tr>
<tr>
<td>Integration Service [sn_hr_integr_fw_service]</td>
<td>Stores records of integration services. An integration service is created for each entity that is pulled from a third-party system.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Integration Job Tracker  
[sn_hr_integr_fw_job_tracker] | Stores source job details, such as start time, run end time, and state. For more information, see View job tracker details. |
| Integration Service Job Tracker  
[sn_hr_integr_fw_service_job_tracker] | Stores service job details such as start time, end time, and state. For more information, see View job tracker details. |
| Pulled Integration To-do  
[sn_hr_integr_fw_todo_inbound] | Stores tasks that are pulled from the third-party system into Enterprise Service Management Integrations Framework. For more information, see View tasks of a third-party system. |
| External Interface  
[sn_hr_integr_fw_ext_interface] | Stores modified records that are pushed from a ServiceNow application into a third-party system. |

**Set up Enterprise Service Management Integrations Framework**

Understand how to set up Enterprise Service Management Integrations Framework to use for integration with third-party systems.

**Before you begin**

Role required: sn_hr_integr_fw.admin

**Procedure**

1. Create a source record by specifying the third-party application with which you want to integrate your ServiceNow application. For more information, refer to Create a source in Enterprise Service Management Integrations Framework.

2. Create a flow in Flow Designer. For more information, refer to Create a flow.

   **Note:** The flows or subflows you are parsing into integration services must follow the input and output structure of Template Integration Service.

3. Create an integration service to connect with the third-party system. For more information, refer to Create an integration service in Enterprise Service Management Integrations Framework.

4. Create transformation maps. For more information, see [Create transformation maps](#).

   **Note:**
   - You must create transformation maps only for Schedule Pull services, and not for Ondemand Push services.
   - If you are using Enterprise Service Management Integrations Framework to pull tasks from a third-party system, use the Pull to-do transform map.

**Create a source in Enterprise Service Management Integrations Framework**

Create a source record that represents the third-party system which is integrating with your ServiceNow application.

**Before you begin**

Role required: sn_hr_integr_fw.admin
Procedure
1. Navigate to **Integrations Framework > Source**.
2. Click **New**.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Integration Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Properties</td>
</tr>
<tr>
<td>Domain</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Create an integration service in **Enterprise Service Management Integrations Framework**
Create an integration service to connect with the third-party system.

**Before you begin**
Role required: sn_hr_integr_fw.admin

Procedure
1. Navigate to **Integrations Framework > Source**.
2. In Integration Services, click **New**.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Integration Services</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Import set tables</td>
</tr>
<tr>
<td>Note: This field is enabled only when Scheduled pull service is selected in the <strong>Service type</strong> field.</td>
</tr>
<tr>
<td>Flow</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Source</td>
</tr>
<tr>
<td>Application</td>
</tr>
<tr>
<td>Order</td>
</tr>
<tr>
<td>Service type</td>
</tr>
<tr>
<td>Retry policy</td>
</tr>
<tr>
<td>Note: This field appears only when Ondemand Push service is selected in the <strong>Service type</strong> field.</td>
</tr>
</tbody>
</table>
Use Enterprise Service Management Integrations Framework

Understand how you can use Enterprise Service Management Integrations Framework to connect with a third-party system.

Before you begin
Role required: sn_hr_integr_fw.admin

Procedure

1. Create a source.
   For more information, see Create a source in Enterprise Service Management Integrations Framework.

2. Create an integration service for the source.
   For more information, see Create an integration service in Enterprise Service Management Integrations Framework.

3. Create a scheduled job and trigger the run job flow for the source.
   - Entries are created in the Integration Job Tracker [sn_hr_integr_fw_job_tracker] table. Entries are created for active Scheduled Pull services in Integration Service Job Tracker [sn_hr_integr_fw_service_job_tracker] table.
   - Import sets are created and attached to the service job tracker, and load start time is populated. Once data is loaded in the import set tables, the state of the service job tracker changes to loaded and the load end time is populated.
   - Once data is loaded for all the services, transformation begins based on the service order defined in the Integration Service [sn_hr_integr_fw_service] table. The states of services change to complete, and then the state of the job tracker record changes to complete. For more information, see View job tracker details.

View job tracker details

View details of the source job and service job, such as when did the job begin and end, when did the records start loading into staging tables, or did the job run completely or fail in between.

Before you begin
Role required: sn_hr_integr_fw.admin

About this task

Once a scheduled flow is triggered or the Run job button on source module is clicked, records are created in the Integration Job Tracker and Integration Service Job Tracker tables.

Procedure

1. Navigate to Integrations Framework > Job Tracker.

2. View the job details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>Name of the job with application name appended.</td>
</tr>
<tr>
<td>Job start time</td>
<td>Date and time when the source job has begun.</td>
</tr>
</tbody>
</table>
### Integration Service Job Tracker

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration service</td>
<td>Name of the integration service.</td>
</tr>
<tr>
<td>Sets</td>
<td>Lists of import sets.</td>
</tr>
<tr>
<td>Load started at</td>
<td>Option indicating the date and time when records started loading into staging table.</td>
</tr>
<tr>
<td>Load ended at</td>
<td>Option indicating the date and time when the records finished loading into staging table.</td>
</tr>
<tr>
<td>Last run date</td>
<td>Option indicating the last time and date when the service was pulled correctly.</td>
</tr>
<tr>
<td>Error message</td>
<td>Message displayed when the service job fails. If the service job fails, you must run the job again.</td>
</tr>
<tr>
<td>State</td>
<td>State of the service job such as loaded, running, or completed.</td>
</tr>
<tr>
<td>Transform started at</td>
<td>Option indicating the date and time when the transformation has begun, and records are moved from staging table to target table.</td>
</tr>
<tr>
<td>Transform ended at</td>
<td>Option indicating the date and time when the transformation has ended.</td>
</tr>
<tr>
<td>Flow Execution ID</td>
<td>Unique identifier of the flow that is executed for integration service.</td>
</tr>
<tr>
<td>Sync token</td>
<td>Stores token returned by APIs for certain integration services.</td>
</tr>
</tbody>
</table>

**View tasks of a third-party system**

View tasks that are pulled from the third-party system into Enterprise Service Management Integrations Framework.

**Before you begin**

Role required: sn_hr_integr_fw.admin

**Procedure**

1. Navigate to **Integrations Framework > Todos**.

2. View details of tasks.
### Pulled Integration To-do

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration todo ID</td>
<td>Unique identifier for the integration Todo.</td>
</tr>
<tr>
<td>Todo description</td>
<td>Description of the Todo or task in the third-party system.</td>
</tr>
<tr>
<td>Todo state</td>
<td>State of the Todo or task in ServiceNow system, such as Open or Closed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating whether the Todo or task is active in the third-party system.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User to whom the Todo or task is assigned.</td>
</tr>
<tr>
<td>External Status</td>
<td>Status of the Todo or task in external system.</td>
</tr>
<tr>
<td>Extension System</td>
<td>Option indicating the origin of Todo or task.</td>
</tr>
<tr>
<td>Domain</td>
<td>Option indicating that domain separation is enabled for this table.</td>
</tr>
</tbody>
</table>

**Important:**

- By default, the Auto Flush data retention policy removes to-dos after seven days. If you do not want the to-dos to be removed from the table:
  
  a. Navigate to **System Maintenance > Table Cleanup** and select **sn_hr_integr_fw_todo_inbound**.
  
  b. To inactivate the retention policy, deselect the **Active** checkbox.
  
  c. To specify a different condition in the retention policy, add a script in the **Condition** field.

- If you want use the Pulled Integration To-do table to pull to-dos or tasks from a third-party system, then you must create an implementation of this extension point: **sn_hr_integr-fw.TodoTransformHelper**.

#### Widgets to display tasks from a third-party system

The **HRSD Framework Integration** and **HRSD Integration Framework Complete** pre-configured widgets help to display tasks from a third-party system to the To-dos page in Employee Service Center.

These widgets are available only when the Human Resources Scoped App: Core [com.sn_hr_core] application is activated. For more information on these widgets, navigate to **Employee Service Center > To-dos Configuration**.

#### External Interface in Employee Service Management Integrations Framework

Use External Interface to view details of records that are being pushed from ServiceNow into a third-party system.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Integrations Framework > External Interface**.
2. On the form, view the fields:
## External Interfaces form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>OnDemand push service that is invoked to interact with a third-party system.</td>
</tr>
<tr>
<td>Source table name</td>
<td>Source table in which the record is stored.</td>
</tr>
<tr>
<td>Table Sys ID</td>
<td>Sys ID of the table record that has been modified. A combination of Source table name and Table Sys ID is used to identify and push the modified record into a third-party system.</td>
</tr>
<tr>
<td>Status</td>
<td>Current status of the push, such as completed or pending.</td>
</tr>
<tr>
<td>Error message</td>
<td>Error message displayed when the push failed.</td>
</tr>
<tr>
<td>Error code</td>
<td>Error code displayed when the push failed.</td>
</tr>
</tbody>
</table>

### What to do next

The Trigger External Interfaces flow automatically:

- Identifies records whose Status is Pending, Service is Active, and Service type is OnDemand Push from the External Interface [sn_hr_integr_fw_ext_interface] table.
- Pushes the identified records into third-party system.

### HR Service Delivery Integration with Cornerstone OnDemand

With the ServiceNow® HR Service Delivery Integration with Cornerstone OnDemand application, display relevant learning courses for employees as part of their To-do tasks in the ServiceNow Employee Service Center.

Cornerstone OnDemand is a learning system that hosts learning videos, training, and certifications for employees. Using HR Service Delivery Integration with Cornerstone OnDemand, you can pull learning tasks from the Cornerstone OnDemand system to ServiceNow so that employees can view all their To-do tasks in a single location, Employee Service Center.

### Setting up the application

To set up the HR Service Delivery Integration with Cornerstone OnDemand application, you must first activate the HR Service Delivery Integration with Cornerstone OnDemand plugin [sn_hr_cornerstone] from ServiceNow Store. This plugin activates Cornerstone spoke in IntegrationHub and HR Service Delivery Integrations Framework plugin [sn_hr_integre_fw]. Next you must set up the Cornerstone spoke in IntegrationHub. For details on how to complete the set up, refer to Set up HR Service Delivery Integration with Cornerstone OnDemand.

### Using Enterprise Service Management Integrations Framework

Enterprise Service Management Integrations Framework provides a consistent way of building integrations for common use cases such as pulling employee profile information, pulling to-dos, or pulling other data from third-party systems and storing it in ServiceNow instance. It contains common components, such as the Source table, HR Integration Services table, scheduled flows, and transform maps, that can be used for building integrations.
By default, when the HR Service Delivery Integration with Cornerstone OnDemand application is set up, source, HR integration services, scheduled flows, and transform maps are automatically set up for the Cornerstone OnDemand system in Enterprise Service Management Integrations Framework. The schedule flows in Enterprise Service Management Integrations Framework interact with the Cornerstone OnDemand system to pull users, learning objects, and transcripts into ServiceNow.

Assigning learning tasks to employees

When learning tasks are assigned to employees in the Cornerstone OnDemand system, transcripts are created for those employees in the Cornerstone OnDemand system.

Enterprise Service Management Integrations Framework, using the Sync Transcripts service, pulls the transcripts from the Cornerstone OnDemand system and displays them as tasks in the To-dos page in Employee Service Center.

On clicking the learning task in Employee Service Center, the employee is navigated to Cornerstone OnDemand system for completing the task. When the employee completes the task in Cornerstone OnDemand system, the status of task gets updated in Employee Service Center after the scheduled job is run for the Cornerstone OnDemand system.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Components installed with HR Service Delivery Integration with Cornerstone OnDemand

Several types of components are installed with activation of the HR Service Delivery Integration with Cornerstone OnDemand plugin [sn_hr_cornerstone], including tables and user roles.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Cornerstone Admin [sn_hr_cornerstone.admin]</td>
<td>Can access and set up the HR Service Delivery Integration with Cornerstone OnDemand application.</td>
<td>None</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Mapping [sn_hr_cornerstone_user_mapping]</td>
<td>Details of users mapped from the Cornerstone OnDemand system into the ServiceNow system.</td>
</tr>
<tr>
<td>CSOD Learning Object [sn_hr_cornerstone_lo]</td>
<td>Details of learning objects (such as learning type, learning ID, title) that are pulled from the Cornerstone OnDemand system into the ServiceNow system.</td>
</tr>
<tr>
<td>CSOD Status [sn_hr_cornerstone_status]</td>
<td>Status of transcripts in the Cornerstone OnDemand system.</td>
</tr>
</tbody>
</table>
Set up HR Service Delivery Integration with Cornerstone OnDemand

Understand how to set up the HR Service Delivery Integration with Cornerstone OnDemand application for pulling learning courses from the Cornerstone OnDemand system into the ServiceNow system.

Before you begin

• Role required: sn_hr_cornerstone.admin
• Activate the Human Resources Scoped App: Core plugin [com.sn_hr_core].
• Activate the HR Service Delivery Integration with Cornerstone OnDemand plugin [sn_hr_cornerstone] from ServiceNow Store. This plugin activates Cornerstone spoke in IntegrationHub and HR Service Delivery Integrations Framework plugin [sn_hr_integre_fw].

Procedure

1. Set up the Cornerstone spoke in IntegrationHub.
   For more information, refer to the Cornerstone spoke documentation.

2. Configure the URL prefix in the Cornerstone source record in HR Service Delivery Integration with Cornerstone OnDemand.
   For more information, refer to Use deep link for HR Service Delivery Integration with Cornerstone OnDemand.

   Important: Once you have activated the necessary plugins and set up the Cornerstone spoke, HR Integration Services (for Cornerstone OnDemand application) are automatically created. For more information, refer to HR Integration Services for HR Service Delivery Integration with Cornerstone OnDemand.

3. Configure the flow for HR Service Delivery Integration with Cornerstone OnDemand.
   For more information, refer to Configure the flow for HR Service Delivery Integration with Cornerstone OnDemand.

Use deep link for HR Service Delivery Integration with Cornerstone OnDemand

Use the deep link prefix to pull learning objects from the Cornerstone OnDemand system during run time.

Before you begin

Role required: sn_hr_cornerstone.admin

Procedure

1. Login to the Cornerstone OnDemand application and generate deep links.
   For more information, refer to the documentation of Cornerstone OnDemand system.

   Note: Ensure that you have selected LO Details in Page URL list in the Deep link Generator tab.

2. Copy the URL prefix.

3. Navigate to HR Cornerstone Integrations > Source.

4. Click Cornerstone.

5. In Properties, append the copied value in url_prefix.
Configure the flow for HR Service Delivery Integration with Cornerstone OnDemand

Specify the frequency and time at which you want to run the scheduled flow that pulls learning objects, users, and transcripts from the Cornerstone OnDemand application into the ServiceNow system.

**Before you begin**
Role required: sn_hr_cornerstone.admin

**Procedure**

1. Navigate to Flow Designer > Designer.
2. Activate the Trigger CSOD Sync scheduled flow.
3. Click Trigger.
   
   a. Select a frequency such as daily or weekly or monthly. The default value is Daily.
   
   b. Specify a time. The default value is 21:00:00.

**Source for HR Service Delivery Integration with Cornerstone OnDemand**

Once you set up the HR Service Delivery Integration with Cornerstone OnDemand application, the source record for Cornerstone OnDemand application is automatically created in Enterprise Service Management Integrations Framework, Source module. The Cornerstone OnDemand source record in the Enterprise Service Management Integrations Framework application contains a predefined set of properties and HR Integration Services.

**Properties**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-pull</td>
<td>When set to True, all the active users, active trainings, incomplete to-dos from the Cornerstone OnDemand system are pulled into respective tables in ServiceNow instance. When set to False, only modified users, modified trainings, modified transcripts (based on last successful schedule run time) are pulled from the Cornerstone OnDemand system and are pulled into respective tables in ServiceNow instance.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If there is no information on the last successful schedule run time, the first pull will always be a full pull.</td>
</tr>
<tr>
<td>page-count</td>
<td>Number of records that are pulled through an API call from the Cornerstone OnDemand system. By default, the value is 500.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is honored only by the Sync Trainings and Sync Transcripts HR Integration Services, and not by Sync Users HR Integration Service.</td>
</tr>
<tr>
<td>url-prefix</td>
<td>Deep link prefix to pull learning objects from the Cornerstone OnDemand system during run time. For more information, see Use deep link for HR Service Delivery Integration with Cornerstone OnDemand.</td>
</tr>
</tbody>
</table>

**HR Integration Services for HR Service Delivery Integration with Cornerstone OnDemand**

Once you set up the HR Service Delivery Integration with Cornerstone OnDemand application, HR integration services for Cornerstone are automatically created in Enterprise Service Management Integrations Framework. The flows in HR Integration Services
communicate with the Cornerstone OnDemand system to pull users, learning objects, and transcripts into ServiceNow.

**Important:** You must activate all of these HR integration services so that data is properly synchronized between the Cornerstone OnDemand system and ServiceNow.

### HR Integration Services for Cornerstone

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync Users</td>
<td>This HR integration service maps users in the Cornerstone OnDemand system to users in the ServiceNow system using email Ids. When the Trigger CSOD Sync schedule flow is run, users are pulled from the Cornerstone OnDemand system to the User Mapping Staging [sn_hr_cornerstone_user_mapping_staging] table. After transformation scripts are run, mapped users are displayed in <a href="#">HR Cornerstone Integrations &gt; Users</a>.</td>
</tr>
<tr>
<td>Sync Trainings</td>
<td>This HR integration service pulls learning objects such videos or curriculum from the Cornerstone OnDemand system to the ServiceNow system. When the Trigger CSOD Sync schedule flow is run, learning objects are pulled into the CSOD Learning Object Staging [sn_hr_cornerstone_lo_staging] table. After the transformation scripts are run, learning objects are displayed in <a href="#">HR Cornerstone Integrations &gt; Learning Objects</a>.</td>
</tr>
<tr>
<td>Sync Transcripts</td>
<td>This HR integration service pulls transcripts from the Cornerstone OnDemand system to the ServiceNow system. When the Trigger CSOD Sync schedule flow is run, transcripts are pulled into HR Pulled To-do Integration Staging [sn_hr_integr_fw_todo_inbound_staging] table. After the transformation scripts are run, transcripts are displayed in <a href="#">HR Integrations Framework &gt; Todos</a>.</td>
</tr>
</tbody>
</table>

**Users for HR Service Delivery Integration with Cornerstone OnDemand**

Users from the Cornerstone OnDemand system are mapped to the users in ServiceNow system using email Ids. User mapping helps in assigning learning tasks to the correct user in the ServiceNow system.

When the Trigger CSOD Sync schedule flow is run, users are pulled from the Cornerstone OnDemand system to the User Mapping Staging [sn_hr_cornerstone_user_mapping_staging] table. Once the transformation scripts are run, mapped users are displayed in [HR Cornerstone Integrations > Users](#).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSOD ID</td>
<td>CSOD ID from Cornerstone OnDemand system.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates whether or not the user is active in the Cornerstone OnDemand system.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user in the ServiceNow system.</td>
</tr>
<tr>
<td>CSOD User</td>
<td>Name of the user in the Cornerstone OnDemand system.</td>
</tr>
<tr>
<td>CSOD User ID</td>
<td>ID of the user in the Cornerstone OnDemand system.</td>
</tr>
<tr>
<td>CSOD Email</td>
<td>Email ID of the user in the Cornerstone OnDemand system.</td>
</tr>
</tbody>
</table>

**Note:** In case you want to use **CSOD ID**, **CSOD user**, and **CSOD User ID** fields for mapping users, you must override the getUser method in CSODIntegrationsUtil script.
Learning objects for HR Service Delivery Integration with Cornerstone OnDemand

View details of learning objects that are pulled from the Cornerstone OnDemand system to ServiceNow system. Learning objects help in navigating users to the correct learning to-do details.

When the Trigger CSOD Sync schedule flow is run, the flow in the Sync Trainings service pulls learning objects from the Cornerstone OnDemand system into the CSOD Learning Object Staging [sn_hr_cornerstone_lo_staging] table. After the transformation scripts are run, learning objects are displayed in HR Cornerstone Integrations > Learning Objects.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the learning object.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating that the learning object is in use.</td>
</tr>
<tr>
<td>Learning ID</td>
<td>Unique identifier of the learning object.</td>
</tr>
<tr>
<td>Learning Type</td>
<td>Type of learning object.</td>
</tr>
<tr>
<td>Learning Type ID</td>
<td>Unique identifier of the learning type.</td>
</tr>
<tr>
<td>Root LO</td>
<td>Parent of the learning object.</td>
</tr>
</tbody>
</table>

⚠️ Note:
- These type of learning objects are not displayed in the Learning Objects page: Session, Cohort, Program, and Library type. These type of learning objects appear in the CSOD Learning Object Staging [sn_hr_cornerstone_lo_staging] table, but do not appear in the Learning Objects page after transformation.
- Only the child topics of a certification are displayed as tasks in the To-dos page in Employee Service Center, and not the certification itself.

Status mapping in Cornerstone OnDemand System

Once you set up HR Service Delivery Integration with Cornerstone OnDemand, mapping between transcript status ID and status value is displayed in the Status page in HR Service Delivery Integration with Cornerstone OnDemand. This information helps to manage the task external status in the HR Pulled Integration To-do table, for Cornerstone OnDemand system.

For example, a transcript with status ID 25 is pulled into Cornerstone OnDemand system into ServiceNow system. 25 implies that the status value of the task is Pending approval in the Cornerstone OnDemand system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Status of the task in the Cornerstone OnDemand system.</td>
</tr>
<tr>
<td>Status ID</td>
<td>Unique identifier of the status in Cornerstone OnDemand system.</td>
</tr>
</tbody>
</table>

Transform maps for HR Service Delivery Integration with Cornerstone OnDemand

By default, when HR Service Delivery Integration with Cornerstone OnDemand is set up, the CSOD user mapping transform and CSOD learning object mappings transformation maps are automatically available for HR Service Delivery Integration with Cornerstone OnDemand. These transform maps specify data relationships between source table and target table.
### Transformation maps

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSOD user mapping transform</td>
<td>Maps users from the User Mapping Staging [sn_hr_cornerstone_user_mapping_staging] source table into the User Mapping [sn_hr_cornerstone_user_mapping] target table.</td>
</tr>
<tr>
<td>CSOD learning object mappings</td>
<td>Maps learning objects from the CSOD Learning Object Staging [sn_hr_cornerstone_lo_staging] source table into the CSOD Learning Object [sn_hr_cornerstone_lo] target table.</td>
</tr>
<tr>
<td>HR Pull to-do transform map</td>
<td>Maps tasks or Todos from the HR Pulled To-do Integration Staging [sn_hr_integr_fw_todo_inbound_staging] table to the HR Pulled Integration Todo [sn_hr_integr_fw_todo_inbound] table. For more information, refer to.</td>
</tr>
</tbody>
</table>

### HR Service Delivery integration with Workday

The ServiceNow® HR Service Delivery integration with Workday application is built by Bristelcone, Inc.

With this application, you can do the following:

- Synchronize worker profiles from Workday to ServiceNow.
- Pull Workday tasks into ServiceNow. Enable employees to view all their to-dos or tasks in a single place, Employee Service Center.

#### Application setup

First, you must activate the HR Service Delivery integration with Workday application from ServiceNow Store. This automatically activates the Workday HR Spoke. Next you must set up Workday HR Spoke.

#### Note:

- HR Service Delivery integration with Workday V1 (Synchronise worker profiles) depends on Workday HR Spoke V 1.1.2.
- HR Service Delivery integration with Workday V2 (Pull workday to-dos) depends on Workday HR Spoke V 1.3.0.

#### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

#### Components installed with HR Service Delivery integration with Workday

Several types of components are installed with activation of the HR Service Delivery Integration with Workday (sn_hr_workday) application, including tables and user roles.

Demo data is available for this feature.
Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Workday Admin [sn_hr_workday.admin]</td>
<td>• Can access all features and capabilities of the HR Service Delivery integration with Workday application. &lt;br&gt; • Can configure worker profile settings.</td>
<td>• flow_operator &lt;br&gt; • import_admin &lt;br&gt; • sn_hr_workday.user</td>
</tr>
</tbody>
</table>

Scheduled flows installed

<table>
<thead>
<tr>
<th>Scheduled flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Workday Integration Flow</td>
<td>Pulls data from Workday to ServiceNow. By default the flow is in inactive state. &lt;br&gt; For information on how to activate the flow, see Schedule flow for HR Service Delivery integration with Workday.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workday Worker Profile Sync Configuration [sn_hr_workday_configuration_worker_profile_sync]</td>
<td>Stores one-time configuration parameters for the initial setup of the HR Service Delivery integration with Workday application. These parameters ensure that worker profile information is pulled from Workday into ServiceNow.</td>
</tr>
<tr>
<td>Workday Integration Job Tracker [sn_hr_workday_job_tracker]</td>
<td>Tracks every job pull that has been performed from ServiceNow to Workday either by schedule job or manual reconciliation process.</td>
</tr>
<tr>
<td>Workday Integration Service Job Tracker [sn_hr_workday_service_job_tracker]</td>
<td>Tracks every service job pull that has been performed from ServiceNow to Workday either by schedule job or manual reconciliation process.</td>
</tr>
<tr>
<td>Workday Todos [sn_hr_workday_todo]</td>
<td>Stores todos that are pulled from Workday.</td>
</tr>
<tr>
<td>Workday Configuration Pull To-Dos [sn_hr_workday_pull_todo_config]</td>
<td>Stores parameters or inputs which help in setting up the todos configuration.</td>
</tr>
</tbody>
</table>

Worker profile synchronization

Pull worker profile data from Workday into ServiceNow. View worker profile details from Workday in ServiceNow HR Service Delivery.

The following sections explain how to set up the application, configure worker profile settings, activate and run the schedule flow to synchronise worker profiles.
Application setup
First, you must activate the HR Service Delivery integration with Workday application from ServiceNow Store. This automatically activates the Workday HR Spoke V 1.1.2. Next, you must set up Workday HR Spoke V 1.1.2.

Worker profile settings
Store one-time configuration parameters for synchronizing data between Workday and ServiceNow. For more information, see

⚠️ Note: Even if you are not using Worker profile synchronization, ensure that you have configured the Workday tenant time zone field in the Workday Worker Profile Sync Configurations form. This field handles the time zones between the two systems, ServiceNow and Workday.

Schedule flow activation
Activate and run the schedule flow that pulls Worker profile information into ServiceNow. For more information, see Schedule flow for HR Service Delivery integration with Workday.

Mapping worker profile fields
The Run Workday Integration Flow schedule flow maps Worker profile fields from Workday to the HR profile fields in ServiceNow.

⚠️ Important:
- For details on fields that are mapped, refer to this KB article.
- Create an index on the first_name, last_name columns of HR profile to improve performance.

Worker profile synchronization limitations
Limitations to the data that is synchronized from Workday to ServiceNow.

- Partial pull is not supported for Department and Location. It is only supported for HR profile and Job Profile.
- When an organization, a location, and a job profile is made inactive in Workday, it does not become inactive in ServiceNow. This is because the Department table, Location table, and Job profiles table in ServiceNow do not have the Active field to record the status information.
- The following fields are not mapped while synchronizing HR profiles:
  - Under Employee Information: Leave status, Location type, Notice period, Probation end date, Probation period, Social Security number, and Business.
  - Under Jobs: Location type and Work email.

Workday to-dos
Pull tasks from Workday into ServiceNow and allow employees to view all their to-dos at a single place, Employee Service Center.

Application setup
- Activate the HR Service Delivery integration with Workday application from ServiceNow Store. This automatically activates the Workday HR Spoke.
- Set up Workday HR Spoke V 1.3.0.
• Activate the HR Service Delivery Integrations Framework from ServiceNow Store. HR Service Delivery integration with Workday uses HR Service Delivery Integrations Framework to pull tasks from Workday into ServiceNow. For more information on HR Service Delivery Integrations Framework, see Enterprise Service Management Integrations Framework.

To-dos settings
Store one-time configuration parameters for pulling tasks from Workday into ServiceNow. For more information, see Configure Workday to-dos.

Schedule flow activation
Activate and run the schedule flow that pulls tasks into ServiceNow. For more information, see Schedule flow for HR Service Delivery integration with Workday.

Configure Workday to-dos
Store one-time configuration parameters to pull tasks from Workday into the ServiceNow application.

Before you begin
Role required: sn_hr_workday.admin

Procedure
1. Navigate to Workday Pull To-dos > Configuration Pull To-dos.
2. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workday to dos RAAS report name</td>
<td>Name of the report that is pulled from Workday.</td>
</tr>
<tr>
<td>Note:</td>
<td>Make sure you provide the exact name of the report for proper synchronization.</td>
</tr>
<tr>
<td>Workday to dos report owner username</td>
<td>Owner of the report.</td>
</tr>
<tr>
<td>Note:</td>
<td>Make sure you provide the exact name of the owner for proper synchronization.</td>
</tr>
<tr>
<td>Initial load start date time</td>
<td>Date and time from which you want to pull todos from Workday into ServiceNow.</td>
</tr>
<tr>
<td>Load Interval</td>
<td>Interval in which you want to pull data, for example, in terms of days or months or hours. Example: For initial load, if you want to pull data from the last six months, then you can set the load interval as 15 days. Data is pulled from the last six months (in a set of 15 days) till the starting time captured in the Job Started at field in Job tracker. In case the data is large, an outbound call timeout error is displayed in ServiceNow. You must then decrease the load interval. If a schedule flow is run for every 12 hours, then data is always pulled till current time.</td>
</tr>
</tbody>
</table>
View tasks from Workday

View details of the todos or tasks that are pulled from Workday into ServiceNow.

Before you begin
Role required: admin

Procedure
1. Navigate to Workday Pull To-Dos > Workday To-Dos
2. On the form, view the fields.

Workday Todos

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration todo ID</td>
<td>Unique identifier for the Workday task.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating whether the task is active in Workday.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User to whom the task is assigned.</td>
</tr>
<tr>
<td>Todo state</td>
<td>Current state of the task in ServiceNow. For example, Open, and Complete.</td>
</tr>
<tr>
<td>URL</td>
<td>URL that navigates to Workday to complete the task.</td>
</tr>
<tr>
<td>Todo description</td>
<td>Description of the Workday task visible in ServiceNow Employee Service Center</td>
</tr>
<tr>
<td>Due date</td>
<td>Date and time by which the task has to be completed.</td>
</tr>
<tr>
<td>External status</td>
<td>Current status of the task in Workday. For example, Awaiting Action, and Cancelled</td>
</tr>
<tr>
<td>Extension system</td>
<td>Option indicating the origin of the task, that is Workday.</td>
</tr>
</tbody>
</table>

Widgets to display Workday tasks

The HRSD Framework Integration and HRSD Integration Framework Complete pre-configured widgets help to display Workday tasks in the To-dos page in Employee Service Center.

For more information on these widgets, navigate to Employee Service Center > To-dos Configuration.

Schedule flow for HR Service Delivery integration with Workday

Activate the schedule flow that interacts with Workday to pull worker profile information and tasks into a ServiceNow application.

Before you begin
Role required: sn_hr_workday.admin

Procedure
1. Navigate to Flow Designer > Designer.
2. Open Run Workday Integration Flow.
3. Click Activate.
4. In the **Trigger** field, specify the time and interval at which you want to automatically run the scheduled flow.

5. Expand **Call Run Workday Service Subflow**.

6. Enable the **Department, Location, Job Profile, Worker Profile, Effective Worker Profile, Future Worker Profile, Retrieve All Data, and Pull To-dos** check boxes.

The schedule flow pulls data in the following order:

- Locations
- Departments
- Job profile
- Workers
- Future workers
- Effective workers
- Jobs

Once data is pulled into staging tables, transform maps move data into target tables. For more details, refer to [Transform maps for HR Service Delivery integration with Workday](#).

**Note:**

- For a partial pull, deselect the **Retrieve all data** check box. Partial pull is not supported for Department and Location. It is only supported for HR profile and Job Profile.
- The **Retrieve All Data** check box is not supported for Pull To-Dos. The first pull will always be a full pull based on the configuration parameter **Initial Load Date time**. The subsequent ones are incremental pulls.
- Before you run the flow, turn off reporting: `com.snc.process_flow.reporting.level`.

### Transform maps for HR Service Delivery integration with Workday

Transform maps specify data relationships between source table and target table.

For details on the transform maps, navigate to **System Import Sets > Administration > Transform Maps**.

<table>
<thead>
<tr>
<th>Transformation Maps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>Job Profile Transform Map</td>
</tr>
<tr>
<td>Location Transform Map</td>
</tr>
<tr>
<td>HR Profile Transform Map</td>
</tr>
<tr>
<td>Department Transform Map</td>
</tr>
</tbody>
</table>
Transformation Maps (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Job Transform Map</td>
<td>Maps jobs from the HR Job Staging [sn_hr_workday_hr_job_staging] table to the Job [sn_hr_core_job] table.</td>
</tr>
<tr>
<td>HRSD Workday Pull Inbox Items</td>
<td>Maps to-dos from the Workday Integration Todos Staging [sn_hr_workday_todo_staging] table into the Workday Todos [sn_hr_workday_todo] table.</td>
</tr>
</tbody>
</table>

View job tracker details for Workday

Track every pull that has been performed from ServiceNow to Workday either by schedule job or manual reconciliation process. View details of the job, such as when did the job begin and end, when did the records start loading into staging tables, or did the job run completely or fail in between.

Before you begin
Role required: sn_hr_workday.admin

Procedure
1. Navigate to Workday Worker Profile Sync > Job Tracker > Workday Integration Job Tracker.
2. View job details.

Workday Integration Job Trackers form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>Name of the job that has run.</td>
</tr>
<tr>
<td>Job started at</td>
<td>Date and time when the job started.</td>
</tr>
<tr>
<td>Job ended at</td>
<td>Date and time when the job ended.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the job, such as Complete and Failed.</td>
</tr>
<tr>
<td>Error message</td>
<td>Message displayed when the job has failed.</td>
</tr>
</tbody>
</table>

3. Select a job record. In the Workday Integration Service Job Trackers related list, view the service job details.

Workday Integration Service Job Trackers form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique identifier for the service job run.</td>
</tr>
<tr>
<td>Workday Integration Service</td>
<td>Name of the service job that has run. For example, Worker Profiles integration service.</td>
</tr>
<tr>
<td>Job state</td>
<td>Current state of the service job. For example, Completed or Failed.</td>
</tr>
<tr>
<td>Job started at</td>
<td>Date and time when the service job run started.</td>
</tr>
<tr>
<td>Job ended at</td>
<td>Date and time when the service job run ended.</td>
</tr>
<tr>
<td>Error Source</td>
<td>Phase during which the error has occurred: API Error, Transformation Error, or Configuration Error.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Message</td>
<td>Message displayed when the job has failed.</td>
</tr>
<tr>
<td>Start Date Time-API Parameter</td>
<td>Date after which the modified records are pulled from Workday into ServiceNow.</td>
</tr>
<tr>
<td>End Date Time-API Parameter</td>
<td>Date until which the modified records are pulled from Workday into ServiceNow.</td>
</tr>
<tr>
<td>Import Set</td>
<td>Name of the import set that is pulled.</td>
</tr>
</tbody>
</table>

## HR Service Delivery Advanced Integration with Workday

The ServiceNow® HR Service Delivery Advanced Integration with Workday application is built by Bristelcone, Inc.

HR Service Delivery Advanced Integration with Workday enables you to complete the following tasks:

### As an advanced Workday administrator

- Configure templates to display customized Total Rewards information to employees in the configured Service Portal. See [Set up Total Rewards](#).
- Configure legal name change settings to enable employees to change their legal name from Employee Service Center. See [Legal name change configuration](#).
- Import time offs, holiday calendars, and schedule calendars from Workday into ServiceNow application enabling employees to submit a time off request from Employee Service Center. See [Time off request to Workday](#).

### As an employee

- Submit your time off request from Employee Service Center. See [Request a time off](#).
- Change your legal name through virtual agent conversation in Employee Service Center. See [Set up plans for Total Rewards](#).
- Report discrepancy in your Workday payslip from Employee Service Center. See [Report an issue with your payslip](#).
- View your Total Rewards information (such as benefits, compensation, and allowances) in the configured Service Portal.
- View your holiday calendars in configured Service Portal.

### Application setup

First, you must activate the HR Service Delivery Advanced Integration with Workday application from ServiceNow Store, which automatically activates the Workday HR Spoke. Next, set up [Workday HR Spoke](#) and install the following applications:

- Glide Virtual Agent plugin [com.glide.cs.chatbot]
- Human Resources Scoped App: NLU Model [com.sn_hr_nlu_model]
- Human Resources Scoped App: Core [com.sn_hr_core]
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Components installed with HR Service Delivery Advanced Integration with Workday

Several types of components are installed with activation of the HR Service Delivery Advanced Integration with Workday, including tables, user roles, and scheduled jobs.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Workday Admin [sn_hr_workday_adv.admin]</td>
<td>• Can configure Workday reports.</td>
<td>• flow_operator</td>
</tr>
<tr>
<td></td>
<td>• Can customize Total rewards templates.</td>
<td>• import_admin</td>
</tr>
<tr>
<td></td>
<td>• Can configure Legal name change settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can import time offs from Workday.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can pull holiday calendars and schedule calendars from Workday.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can pull Workday reference IDs.</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Offs [sn_hr_workday_time_offs]</td>
<td>Stores details of time offs, such as time off ID, and references to time off plan, and time off type.</td>
</tr>
<tr>
<td>Time Off Plans [sn_hr_workday_time_off_plans]</td>
<td>Stores details of time off plans, such as time off plan ID, unit of time, and daily quantity.</td>
</tr>
<tr>
<td>Time Off Types [sn_hr_workday_time_off_types]</td>
<td>Stores details of time off types, such as time off type ID.</td>
</tr>
<tr>
<td>Time Off Reasons [sn_hr_workday_time_off_reasons]</td>
<td>Stores details on time off reasons such as time off reason ID and reference to time off.</td>
</tr>
<tr>
<td>Absence Table [sn_hr_workday_absence_table]</td>
<td>Stores the Absence table ID and Reason required fields.</td>
</tr>
<tr>
<td>Absence Table Tiers [sn_hr_workday_absence_table_tiers]</td>
<td>Stores the combination of leave plans and time offs. For example, combination of time off plan (USA Sick Plan (GPS) and time off (USA Sick Time Off (GPS)).</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Absence Table Reasons [sn_hr_workday_absence_table_reasons]</td>
<td>Stores reasons of the Absence table.</td>
</tr>
<tr>
<td>Holiday Calendar [sn_hr_workday_holiday_calendar]</td>
<td>Stores details of holiday calendars (such as holiday calendar name, start date, and end date) that are pulled from Workday.</td>
</tr>
<tr>
<td>Work Schedule Calendar [sn_hr_workday_work_schedule_calendar]</td>
<td>Stores details of work schedule calendars (such as work schedule calendar name, ID, and pattern start date) that are pulled from Workday.</td>
</tr>
<tr>
<td>Legal Name Change Configuration [n_hr_workday_adv_legal_name_change_configuration]</td>
<td>Stores the configuration options that are set for legal name change.</td>
</tr>
<tr>
<td>Workday Reference ID List [sn_hr_workday_adv_reference_id_list]</td>
<td>Stores the legal name change document categories and total rewards (plans) that are pulled from Workday.</td>
</tr>
<tr>
<td>Workday Report Configuration [sn_hr_workday_adv_report_configuration]</td>
<td>Stores details of reports that are created in Workday. For example, name of the report, owner of the report, and purpose of creating the report.</td>
</tr>
<tr>
<td>Total Rewards Section Setup [sn_hr_workday_adv_total_rewards_section_setup]</td>
<td>Stores details of Total Rewards sections with plans associated to it.</td>
</tr>
<tr>
<td>Total Rewards Template Setup [sn_hr_workday_adv_total_rewards_template_setup]</td>
<td>Store details of Total Rewards templates with sections and plans associated to it.</td>
</tr>
</tbody>
</table>

**Set up Total Rewards**

Configure Total Rewards templates by choosing plans, sections, and target audience. Display a customized Total Rewards widget to employees in the configured Service Portal.

**Before you begin**

Role required: sn_hr_workday_adv.admin

Configure the required reports for the Total Rewards functionality. See .

**Procedure**

1. Set up plans to include in sections in Total Rewards Template. For more information, see Set up plans for Total Rewards.
2. Set up sections to include in Total Rewards Template. For more information, see Set up sections for Total Rewards templates.
3. Set up Total Rewards template by choosing sections, and target audience. For more information, see Set up a template for Total Rewards.
What to do next

1. Navigate to Service Portal > Service Portal Configuration > Designer. Display the Total Rewards view to employees by adding the View Workday Total Rewards widget to the required Service Portal.

2. Configure the system property, sn_hr_workday_adv.workday_total_rewards.currency_code, which stores the currency code to call the Total Rewards RAAS (Report As A Service) based API. The default value of the property is USD.

Set up plans for Total Rewards

Complete the one time set up of pulling plans, such as employee benefits plan, compensation plan, insurance plan, from Workday into ServiceNow application.

Before you begin
Role required: sn_hr_workday_adv.admin

Procedure

1. Navigate to Workday Advanced Use Cases > Total Rewards > Plans Available.

2. Click Get Reference IDs to pull the plans from Workday into ServiceNow tables.

   Note: The plans from Workday are pulled into Workday Reference ID List Staging [sn_hr_workday_adv_reference_id_list_staging] table and from staging table into Workday Reference ID List [sn_hr_workday_adv_reference_id_list] table.

3. On the form, view the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descriptor</td>
<td>Description of the plan that is pulled from Workday.</td>
</tr>
<tr>
<td>Descriptor ID</td>
<td>Descriptor ID of the plan that is pulled from Workday.</td>
</tr>
<tr>
<td>Workday ID</td>
<td>Unique identifier that is generated from Workday.</td>
</tr>
<tr>
<td>Reference ID Type</td>
<td>Reference ID of the plan that is pulled from Workday. For example, Compensation Plan ID, Health Care Coverage Plan ID, and Insurance Coverage Plan ID.</td>
</tr>
</tbody>
</table>

Set up sections for Total Rewards templates

Create sections and associate plans to it. Add those sections to Total Rewards Template.

Before you begin
Role required: sn_hr_workday_adv.admin

Procedure

1. Navigate to Workday Advanced Use Cases > Total Rewards > Plans Available.

2. Click New.

3. On the form, fill in the fields:
### Total Rewards Section Setup

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section name</td>
<td>Name of the section. For example: Allowances.</td>
</tr>
<tr>
<td>Plans</td>
<td>Plans that you want to include in the section. For example, Allowance - Car, Allowance - Mobile, and Allowance - Housing</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Set up a template for Total Rewards

Set up a template by adding sections to it. Templates enable you to display a customized Total Rewards view to employees in the configured Service Portal.

**Before you begin**

Role required: sn_hr_workday_adv.admin

**Procedure**

1. Navigate to **Workday Advanced Use Cases > Total Rewards > Template Set up**.
2. Click **New**.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template name</td>
<td>Suitable name of the template.</td>
</tr>
<tr>
<td>Sections</td>
<td>Sections that you want to include in the template, for example, Base Pay, Allowances, Incentive Pay, and Commission.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Template applies only to the selected user criteria. For example, the template is applicable only to employees whose Employment Type Is Full Time.</td>
</tr>
<tr>
<td>Order</td>
<td>If more than one template is applied to an employee, only the template with a lesser order is displayed to the employee in the configured Service Portal.</td>
</tr>
<tr>
<td>Domain</td>
<td>Reference to domain.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Time off request to Workday

You can submit a time off request to Workday from Employee Service Center.

The following sections explain how to configure time off settings, and raise a time off request from Employee Service Center.
**Time off settings**
- Configure the reports for time offs, absence tables, holiday calendars, and work schedule calendars. See .
- Import set up data for time offs. See Time offs.
- Get Holiday Calendars from Workday. See Holiday calendars.
- Get Work Schedule Calendars from Workday. See Work schedule calendars.

**Time off request**
Request a time off to Workday from Employee Service Center. For more information, see Request a time off.

**Limitations**
- Custom validations that are supported in Workday are not handled in the ServiceNow application. For example, if an organization has a time off plan configured to enter time off quantity in multiples of 2 or 4, such validations are not supported for such time off plans in the ServiceNow application.
- A maximum of 25 days of leave, including holidays and non-working days, can be applied from the ServiceNow application.

**Time offs**
Complete the one time set up of pulling time offs from Workday into the ServiceNow application.

**Before you begin**
Role required: sn_hr_workday.admin
Configure the required reports for the Time Off request functionality. See .

**Procedure**
1. Navigate to Workday Advanced Use Cases > Time Off Request > Time Off Types.
2. Click Import time off setup data.
3. Click Submit.

**What to do next**
1. Navigate to Service Catalog > Catalog Definitions > Content Items.
2. Configure the URL of time off request page in Workday.
3. Open the Time Off Request – Link to Workday record and modify the URL field.
4. Navigate to Employee Service Center. In the Catalog menu, open Benefits Category > Time Off Request – Link to Workday. You are directed to the Workday Time Off request page.

**Work schedule calendars**
Pull work schedule calendars from Workday into the ServiceNow application.

**Before you begin**
Role required: sn_hr_workday.admin
Procedure

1. Navigate to Workday Advanced Use Cases > Time Off Request > Work Schedule Calendar.

2. Click Get Work Schedule Calendars to run a flow that pulls schedule calendars from Workday into ServiceNow application.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work schedule calendar</td>
<td>Name of the work schedule calendar. For example, Standard 40 Hour Week.</td>
</tr>
<tr>
<td>Work schedule calendar ID</td>
<td>Unique identifier of the work schedule calendar that is pulled from Workday.</td>
</tr>
<tr>
<td>Work week start day</td>
<td>Day in a week when the work schedule calendar begins.</td>
</tr>
<tr>
<td>Work week start day ID</td>
<td>ID of the day in a week when the work schedule calendar begins.</td>
</tr>
<tr>
<td>Start time</td>
<td>Time when the work schedule begins for the day.</td>
</tr>
<tr>
<td>End time</td>
<td>Time when the work schedule ends for the day.</td>
</tr>
<tr>
<td>Day of week</td>
<td>Day in a week in a work schedule calendar.</td>
</tr>
<tr>
<td>Day of week ID</td>
<td>ID of a day in a week in a work schedule calendar.</td>
</tr>
</tbody>
</table>
| Domain                        | Reference to domain.                                                       

3. Click Submit.

Holiday calendars

Pull holiday calendars from Workday into the ServiceNow application. Display the Holiday Calendar widget to employees in the configured Service Portal.

Before you begin

Role required: sn_hr_workday.admin

Configure the Get holiday calendar WID report. For more information, see .

Procedure

1. Navigate to Workday Advanced Use Cases > Time Off Request > Holiday Calendars.

2. Click Get Holiday Calendars to run the subflow that interacts with Workday to pull holiday calendars.

3. To create a holiday calendar, click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar event name</td>
<td>Name of the holiday event. For example, Holidays for Argentina</td>
</tr>
<tr>
<td>Holiday calendar ID</td>
<td>ID for the holiday calendar that is pulled from Workday.</td>
</tr>
<tr>
<td>Holiday calendar WID</td>
<td>Unique identifier of the holiday calendar that is pulled from Workday.</td>
</tr>
<tr>
<td>Domain</td>
<td>Reference to domain.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Start date of the calendar event.</td>
</tr>
<tr>
<td>Start time</td>
<td>Start time of the calendar event.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the calendar event.</td>
</tr>
<tr>
<td>End time</td>
<td>End time of the calendar event.</td>
</tr>
<tr>
<td>Holiday Calendar name</td>
<td>Name of the holiday calendar. For example, Christmas day.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**

Display holiday calendar widget to employees.

1. Navigate to **Service Portal > Service Portal Configuration > Designer**.
2. In widget, select the **View Workday Holiday Calendar** and add it to the required Service Portal page.

#### Request a time off

Request a time off to Workday from Employee Service Center.

**Before you begin**

Role required: none

You might not be able to submit a time off request if your HR profile does not have a valid employee number and employment type.

**Procedure**

1. Navigate to **Employee Service Center > Catalogs > Benefits**.
2. Click **Time Off Request**.
3. In the **Time off start date** field, specify the date from which you are applying the time off.
4. In the **Type of time off** field, specify the type of time off you are availing. For example, USA sick plan leaves plan, or Mexico leave plan.
5. In the **How many days you want to take off** field, specify the number of days for which you are applying time off.
6. In the **Time off per day** field, specify value for the time off in hours or days.

**Note:** The **Unit of Time** field auto-populates the unit of time (days or hours) for the time off.

7. Click **Submit**.

An HR case is created. If the time off is submitted successfully, the HR case changes to Closed complete state. If the time off is not submitted successfully, the HR case changes to Closed Incomplete state.

**Legal name change configuration**

Complete the legal name change configuration to allow employees to change their legal name through virtual agent conversation in Employee Service Center.

**Before you begin**

Role required: sn_hr_workday.admin
Procedure
1. Navigate to Workday Advanced Use Cases > Legal Name Change > Document Categories.

2. To pull the legal name change document categories from Workday into ServiceNow application, click Get Reference IDs. A data source with a predefined script imports document categories into the Workday Reference ID List Staging [sn_hr_workday_adv_reference_id_list_staging] table and from staging table into the Workday Reference ID List [sn_hr_workday_adv_reference_id_list] table.

What to do next
1. Navigate to Workday Advanced Use Cases > Legal Name Change > Configuration.

2. On the Legal Name Change Configurations form, click New.

3. To allow an employee to upload the name change document in Virtual Agent conversation in Employee Service Center, click the Enable document upload option and select a relevant document category.

4. Click Submit.

Publish the VA topic template for legal name change
Publish the Workday Legal Name Change Template which contains an NLU model that recognizes and processes employee utterances, intentions (intents), and objects of, or contexts for, an action (entities).

Before you begin
Role required: sn_hr_workday.admin

Procedure
1. Navigate to Collaboration > Virtual Agent > General Settings. The Enable NLU model toggle switch must be enabled.

2. Navigate to Collaboration > Virtual Agent > Designer.

3. Select Workday Legal Name Change Template.

4. Click Publish.

Change legal name through Virtual Agent
Change your legal name change through Virtual Agent chat in Employee Service Center.

Procedure
1. Navigate to Employee Service Center.

2. Click Virtual Agent.

3. Enter a text. For example, name change. Your current first name and last name are displayed.

4. To continue with the legal name change in Workday, press Yes.

5. Enter a first name, a last name, and a middle name.

6. Upload the supporting legal name change document.

Note: The option does not appear if it is not configured by your administrator.

7. Enter a description for the uploaded legal name change document.
8. Review your updated legal name changes and supporting document and press Yes. An HR case is created and the chat conversation is ended.

Report an issue with your payslip

Report an issue with your Workday payslip from Employee Service Center.

Before you begin
Role required: none
You might not be able to report payslip discrepancy if your HR profile does not have a valid employee number and employment start date.

Procedure
1. Open Employee Service Center.
2. Navigate to Catalog > Payroll > Payroll Discrepancy - Workday.
3. In the Payroll year field, select the year in which the payslip was generated.
4. In the Payroll month field, select the month in which the payslip was generated.
5. In the Payment date field, select the date on which the payslip was generated.
6. In the How can we help you with this payslip field, specify the discrepancy that is found in the payslip.
7. Click Submit.
   An HR case is created that is in Ready state.

HR Service Delivery with Ultimate Kronos Group

With the HR Service Delivery with Ultimate Kronos Group application, provide employee assistance through conversations in the Virtual Agent conversational (client) interface. Enable employees to view their accrual leave balances, schedules, and upcoming shifts from the Ultimate Kronos Group application in the ServiceNow Employee Service Center.

Key features include:

• Build conversations that are based on keywords that an employee or a manager enters.

• Apply Natural Language Understanding (NLU) models, which enable the Virtual Agent to pick utterances for understanding, processing, and responding to what employees are saying during a conversation.

Application setup
First, you must activate the HR Service Delivery Integration with the Ultimate Kronos Group [sn_hr_ukg] application from the ServiceNow Store. Next, you must set up HR Service Delivery Integration with Ultimate Kronos Group application.

Overview
After the activation and setup of HR Service Delivery Integration with Ultimate Kronos Group is complete, the Virtual Agent responds to what employees or managers are saying during a conversation, and allows employees to view the following details from the Ultimate Kronos Group application in the ServiceNow Employee Service Center.

Topics accessible to employees
As an employee, you can view your accrual balances, work hours, list of punches, schedules, time-off requests, and upcoming shifts using the Virtual Agent.

Retrieve My Accrual Balance
You can view the aggregate of accrual leaves balance (by type) by selecting the Retrieve My Accrual Balance (Template). If the NLU model is trained, you can ask a question in the chat (for example, show my sick leaves) and view the balance of a single type of leave.

**Retrieve My Hours Worked**

You can view the number of hours worked for a given period by selecting the Retrieve My Hours Worked (Template) and choosing a symbolic period.

**Retrieve My List of Punches**

You can view the list of punches by selecting the Retrieve My List of Punches (Template) and choosing a symbolic period.

**Retrieve My Schedule**

You can view the work schedule for a given period by selecting the Retrieve My Employee Schedule (Template) and choosing a symbolic period. If the NLU model is trained, you can ask a question in the chat (for example, my work schedules of the previous pay period) and view the work schedules for that symbolic period.

You can also view your schedule location for three days from the current day.

**Retrieve My Time Off Requests**

You can view the status of the time off requests by selecting the Retrieve My Time Off Requests (Template) and specifying an end date.

ℹ️ Note: Ensure that the selected time-off period ranges for 15 days from the start date (current day).

**Retrieve My Upcoming Shift**

You can view the next upcoming shift by selecting the Retrieve My Upcoming Shift (Template). If the NLU model is trained, you can ask a question in chat (for example, show my shifts) and directly view the next upcoming shift.

You can also view your location along with the shift date and time.

**Topics accessible to managers**

As a manager, you can access and view the locations, schedules, and time-off requests of your team using the Virtual Agent.

ℹ️ Note: The templates are visible only to a user with the manager role.

**Reportee’s Location Today**

You can view the location of a reportee in the team (for today) by selecting the Reportee’s Location Today (Template).

**Reportee’s Schedule Changes**

You can view the schedule change requests such as shift cover, shift swap, availability change, open shift, and self-schedule. Follow the onscreen instructions for more information on the schedule changes.

ℹ️ Note: You can view the change requests in offered, invalidated, or pending state.

**Reportee’s Time Off Requests**

You can view the pending time off requests from your team for a specified time period. You can check the requests from the individual team members or the entire team.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Components installed with HR Service Delivery Integration with Ultimate Kronos Group

Several types of components are installed with activation of the HR Service Delivery Integration with Ultimate Kronos Group plugin, including tables and user roles.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>UKG admin [sn_hr_ukg.admin]</td>
<td>• Can set up symbolic periods and accrual codes.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>• Can train the UKG Topics Model.</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accrual Code [sn_hr_ukg_accrual_code]</td>
<td>Stores accrual codes with their associated IDs. Accrual codes help in pulling accrual leave balances of an employee from the Ultimate Kronos Group application into ServiceNow.</td>
</tr>
<tr>
<td>Symbolic Period [sn_hr_ukg_symbolic_period]</td>
<td>Stores symbolic periods with their associated IDs. Symbolic periods denote the time periods that are identifiable by the Ultimate Kronos Group application.</td>
</tr>
</tbody>
</table>

Set up HR Service Delivery Integration with Ultimate Kronos Group

Set up the HR Service Delivery Integration with Ultimate Kronos Group application to start pulling information, such as accrual balances and shifts from the Ultimate Kronos Group application into ServiceNow.

Before you begin

Activate the HR Service Delivery Integration with Ultimate Kronos Group [sn_hr_ukg] application, which automatically activates the following plugins and spoke:

- Glide Virtual Agent [com.glide.cs.chatbot]
- Human Resources Scoped App: Core [com.sn_hr_core]
- Employee Service Center [com.sn_hr_service_portal]
- Virtual Agent Service Portal Widgets [com.glide.va.sp_widgets]
- NLU Workbench [com.snc.nlu_studio]
- Predictive Intelligence [com.glide.platform_ml]
- UKG spoke
Procedure

1. Integrate your Ultimate Kronos Group application with your ServiceNow instance. Register an OAuth application in the Ultimate Kronos Group application and authenticate requests from ServiceNow.
   For more information, see Set up UKG spoke.

2. Complete the one time set up of loading accrual codes from the Ultimate Kronos Group application into ServiceNow.
   For more information, see Set up accrual codes for Ultimate Kronos Group.

3. The Person number field in Ultimate Kronos Group application should match the Employee number field in ServiceNow User table. If the Person number field in Ultimate Kronos Group application matches with some other field in the ServiceNow User table, you must override the getPersonNumberBySysID method in HRKronosUtils script.

Set up symbolic periods for Ultimate Kronos Group

By default, the symbolic periods of Ultimate Kronos Group application are setup when you activate the HR Service Delivery Integration with Ultimate Kronos Group application. Symbolic periods denote the time periods that are identifiable by the Ultimate Kronos Group application.

Before you begin
Role Required: sn_hr_ukg.admin

About this task
When an employee posts a question in virtual chat in Employee Service Center, an NLU model selects an utterance from the question, checks for its mention in vocabulary sources, identifies its symbolic code and ID. A flow uses the ID to pull the requested information from the Ultimate Kronos Group application and display in virtual chat in Employee Service Center.

Procedure
If you have made any modifications to the symbolic periods in Ultimate Kronos Group:

a. Navigate to HR UKG Integrations > Symbolic periods and click Refresh Symbolic Periods.

b. Navigate to NLU Workbench > Vocabulary sources, and sync @UKGTimeKeepingSymbolicPeriod.

c. Navigate to NLU Workbench > Models, select UKG Topics Model, and click Train.

Set up accrual codes for Ultimate Kronos Group

Complete the one time set up of loading accrual codes from the Ultimate Kronos Group application into ServiceNow. Accrual codes help in pulling accrual leave balances of employees from the Ultimate Kronos Group application into ServiceNow.

Before you begin
Role Required: sn_hr_ukg.admin

About this task
When an employee posts a question in virtual chat in Employee Service Center, an NLU model selects an utterance from the question, checks for its mention in vocabulary sources, identifies its accrual code and ID. A flow uses the ID to pull the requested information from the Ultimate Kronos Group application and display in virtual chat in Employee Service Center.
For example, an employee wants to view the accrual balance for annual leave. The NLU model selects annual leave as the utterance. It identifies **Annual Leave** as the accrual code whose ID in Ultimate Kronos Group is **1531**. The flow uses the ID **1531** to pull the requested information from the Ultimate Kronos Group application.

**Procedure**

If you have made any modifications to accrual periods in Ultimate Kronos Group:

a. Navigate to **HR UKG Integrations > Accrual codes** and click **Refresh Accrual codes**.

b. Navigate to **NLU Workbench > Vocabulary sources**, and sync **@AccrualCode**.

c. Navigate to **NLU Workbench > Models**, select the **UKG Topics Model**, and click **Train**.

**Train the NLU model for HR Service Delivery Integration with Ultimate Kronos Group**

Use the UKG Topics Model (Natural Language Understanding model) to recognize and process employee utterances, intentions (intents), and objects of, or contexts for, an action (entities).

**Before you begin**
Role required: sn_hr_ukg.admin

**About this task**
You can train the model dataset iteratively using utterance examples so that the system predicts the optimal intent output for a new utterance.

**Procedure**

1. Navigate to **NLU Workbench > Models**.
2. Select **UKG Topics Model**.
3. Click **Train**.

**Subflows for HR Service Delivery Integration with Ultimate Kronos Group**

Use the subflows to pull data from the Ultimate Kronos Group application into ServiceNow.

**Before you begin**
Role required: None

**Procedure**

1. Navigate to **Process Automation > Flow Designer**.
2. In the Subflow lists, view the following:

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Accrual Balance</td>
<td>Pulls the accrual leave balances (by type) of an employee from the Ultimate Kronos Group application into ServiceNow.</td>
</tr>
<tr>
<td>Extract Employee Schedule</td>
<td>Pulls the schedule of an employee from the Ultimate Kronos Group application into ServiceNow.</td>
</tr>
</tbody>
</table>
### Subflow Description

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract Hours Worked</td>
<td>Pulls the number of hours that the employee has worked from the Ultimate Kronos Group application into ServiceNow.</td>
</tr>
<tr>
<td>Extract Time Off Requests</td>
<td>Pulls the future time off requests of an employee from the Ultimate Kronos Group application into ServiceNow.</td>
</tr>
</tbody>
</table>

### Employee Service Center

The Employee Service Center allows you to provide a single, unified portal for employees to find information, get help, and request the services they need. It is available as part of HR Service Delivery or as a standalone application.

#### Explore

- Upgrade to Quebec

#### Set up

- Understanding Employee Service Center
- Activate Employee Service Center

#### Administer

- Employee Service Center configuration
- HR Employee Service Center configuration

#### Use

- Employee to-dos page
- Employee requests page
- Employee knowledge page
- Employee catalog page
- Employee org chart page
- Employee live chat overview

#### Develop

- Developer training
- Developer documentation
- Components installed with Employee Service Center

#### Troubleshoot and get help

- Ask or answer questions in the HR Service Delivery community
- Search the Known Error Portal for known error articles
- Contact Customer Service and Support

### Understanding Employee Service Center

Use the Employee Service Center to provide a unified and consumer-like experience for your employees. From within a single portal, employees can complete their to-dos, view all their requests, browse knowledge bases and catalogs, chat with live agents, and more. The Employee Service Center is available as part of HR Service Delivery or as a standalone application.

#### Overview

The Employee Service Center is designed to provide a single place for employees to get all the information, services, and help that they need. Available as part of HR Service Delivery or as a standalone application, you can configure the Employee Service Center to meet the needs of your organization.

#### Activation information

Make sure to activate Employee Service Center. For information on what components are installed with the application, see Components installed with Employee Service Center.

**Note:** Each portal must have a unique URL suffix. If you are a new customer, the default suffix is esc. If there is already an existing portal with that suffix, then the suffix is escm. Before you activate Employee Service Center, verify that no existing portal has the escm suffix.
Configuring the Employee Service Center

Users with the Employee Service Center administrator [sn_hr_sp.esc_admin] role can configure the Employee Service Center. Configuration requirements depend on how you are using the portal. The core features comprise the portal content, to-dos page, requests page, associated knowledge bases and service catalogs, live support chat, communities, and campaigns. If you are using Employee Service Center as part of HR Service Delivery, you can configure the HR ticket page for individual HR services. And if you are subscribed to Virtual Agent, you can set up a conversational bot platform.

<table>
<thead>
<tr>
<th>Use</th>
<th>Configuration requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Service Center</td>
<td>• Employee content publishing and delivery</td>
</tr>
<tr>
<td></td>
<td>• Employee to-dos page</td>
</tr>
<tr>
<td></td>
<td>• Employee requests page</td>
</tr>
<tr>
<td></td>
<td>• Employee knowledge page</td>
</tr>
<tr>
<td></td>
<td>• Employee catalog page</td>
</tr>
<tr>
<td></td>
<td>• Employee org chart page</td>
</tr>
<tr>
<td></td>
<td>• Employee live chat overview</td>
</tr>
<tr>
<td></td>
<td>• Employee Forums</td>
</tr>
<tr>
<td></td>
<td>• Campaigns for HR Service Delivery</td>
</tr>
<tr>
<td>With HR Service Delivery</td>
<td>• Link the HR ticket page with the Employee Service Center</td>
</tr>
<tr>
<td></td>
<td>• HR ticket page</td>
</tr>
<tr>
<td></td>
<td>• Virtual Agent for HR Service Delivery</td>
</tr>
</tbody>
</table>

Using the Employee Service Center

Once the Employee Service Center is configured, users with access to the portal can do the following and more.

**Complete all their to-dos**
- See and complete all their to-dos, such as onboarding tasks, document signings, and approvals.

**View all their requests**
- See and track all their requests, such as benefits inquiries, hardware requests, and password resets.

**View their employee profile**
- See and change their employee profile, such as to add a new photo or update an address.

**Find answers to their questions**
- Search and navigate to find information on policies, procedures, and other articles across multiple knowledge bases.

**Request services and products**
- Search and navigate to request catalog items such as services and products across multiple service catalogs.

**Chat with live or virtual agents**
Initiate a chat to get real-time help from support agents across different departments such as HR, IT, Finance, and Facilities.

**Activate Employee Service Center**

You can activate Employee Service Center [com.sn_hr_service_portal] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

If you are a new customer, navigate to Service Portal > Portals to verify that no existing portal has the escm URL suffix. Each portal must have a unique URL suffix, and when you activate Employee Service Center, the default suffix is esc. If there is already an existing portal with that suffix, then the suffix is escm.

Role required: admin

**About this task**

Employee Service Center provides a single place for employees to quickly and easily get all of the services they need.

It activates these related plugins if they are not already active.

### Plugins for Employee Service Center

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Support [com.glide.connect.support]</td>
<td>Builds on the Connect messaging platform and enables support agents to provide real-time assistance to end users, using queues.</td>
</tr>
<tr>
<td>Content Delivery [com.sn_content_delivery]</td>
<td>Content Delivery.</td>
</tr>
<tr>
<td>User Criteria Scoped API [com.glideapp.user_criteria.scoped.api]</td>
<td>User Criteria Scoped API to support CRUD operations on User Criteria.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Components installed with Employee Service Center

Several types of components install with the activation of the Employee Service Center plugin, including user roles and tables.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

⚠️ Note: The Employee Service Center [com.sn_hr_service_portal] plugin activates the sn_hr_sp.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Employee Service Center admin user by requiring a minimum number (default is two) of active users with this role.

Roles installed

Users without an HR service portal (sn_hr_sp) role can still access:

- HR contact form (hri_contact_form)
- HR task details (hrj_task_details)
- HR ticket page (hrj_ticket_page)
- HRM ticket page (hrm_ticket_page)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Employee Service Center administrator | Can configure the Employee Service Center. This role is contained in the System Administrator [admin] role. To ensure that only the HR Administrator [sn_hr_core.admin] role has access to sensitive information, remove the HR admin [sn_hr_core.admin] role from the admin role after installation and configuration. See Remove HR Administrator role from IT System Administrator. Ensure that someone in your organization has the Employee Service Center administrator [sn_hr_sp.esc_admin] role after removing the admin role. | • sn_hr_sp.admin  
• sp_admin  
• catalog_admin |
| Alumni employee [sn_hr_sp.hrsp_alumni]| (HR Service Delivery only) Alumni employee.                                 | • sn_hr_core.hrsm_alumni            |
| Contingent employee                   | (HR Service Delivery only) Contingent employee.                              | • sn_hr_core.hrsm_contingent        |

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_hr_sp.hrsp_contingent]</td>
<td><img src="#" alt="Note:" /> If you are using Employee Service Center with HR Service Delivery, you can use this role.</td>
<td></td>
</tr>
<tr>
<td>Contractor employee [sn_hr_sp.hrsp_contractor]</td>
<td>(HR Service Delivery only) Contractor employee.</td>
<td>• sn_hr_core.hrsm_contractor</td>
</tr>
<tr>
<td>Employee [sn_hr_sp.hrsp_employee]</td>
<td>(HR Service Delivery only) Employee.</td>
<td>• sn_hr_core.hrsm_employee</td>
</tr>
<tr>
<td>New hire employee [sn_hr_sp.hrsp_new_hire]</td>
<td>(HR Service Delivery only) New hire employee.</td>
<td>• sn_hr_core.hrsm_new_hire</td>
</tr>
</tbody>
</table>

You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC Portal Configuration</td>
<td>ESC portal configuration table.</td>
</tr>
<tr>
<td>[sn_hr_sp_esc_portal_config]</td>
<td></td>
</tr>
<tr>
<td>Pre-chat</td>
<td>Pre-chat table.</td>
</tr>
<tr>
<td>[sn_hr_sp_pre_chat]</td>
<td></td>
</tr>
<tr>
<td>To-dos Configuration</td>
<td>To-dos configuration table.</td>
</tr>
<tr>
<td>[sn_hr_sp_todos_config]</td>
<td></td>
</tr>
<tr>
<td>To-dos Widget Mapping</td>
<td>To-dos widget mapping table.</td>
</tr>
<tr>
<td>[sn_hr_sp_todos_widget_mapping]</td>
<td></td>
</tr>
</tbody>
</table>
For further information on table administration and how to manage data, see Table administration.

Employee Service Center configuration
Create a unified, consumer-like experience for your employees with the Employee Service Center. You can configure the portal to meet the needs of your organization.

Employee content publishing and delivery
Reach more people in your organization with greater effectiveness and efficiency by creating meaningful content that can be distributed through multiple channels with Content Delivery.

Use Content Delivery to create different types of information you want to distribute to your employees.

• You can create different kinds of content for your Employee Service Center. Content such as videos, links to forum posts, links to news or articles, announcements, calendars, and banners.

• Create notifications such as a mass email or short message service (SMS) to your employees.

• Customize your content by defining your audience. For example, you can provide information links about your 401k plan that only appear for US employees.

• Schedule your content to be available from specific start and end dates.

• Customize what information appears in the organization chart for your company.

• Form your content into a campaign such as Open Enrollment for Benefits. See Campaigns for HR Service Delivery.

• Create a banner that is an announcement and links to content on your employee’s mobile devices.

Activate Content Delivery
You can activate the Content Delivery [com.sn_content_delivery] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active. To use the Employee Communities feature, activate the Customer Communities [com.sn_customer_communities] plugin.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>. 
Related information

List of plugins (Madrid)

Components installed with Content Delivery

Several types of components install with the activation of the Content Delivery [com.sn_content_delivery] plugin, including tables, user roles, and scheduled jobs.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Note: The Content Delivery [com.sn_content_delivery] plugin activates the sn_cd.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Content Delivery admin user by requiring a minimum number (default is two) of active users with this role.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Delivery Admin [sn_cd.content_admin]</td>
<td>Grants access to all Content Delivery information and privileges. Can access read and write records to the content delivery tables. Can add or edit content type.</td>
<td>Content Delivery Manager [sn_cd.manager]</td>
</tr>
<tr>
<td>Content Delivery Manager [sn_cd.content_manager]</td>
<td>Can create and schedule content for Content Delivery.</td>
<td>• None</td>
</tr>
<tr>
<td>Content Delivery Analytics Admin [sn_cda.analytics_admin]</td>
<td>Required to set up an analytics profile.</td>
<td></td>
</tr>
<tr>
<td>Content Delivery Analytics Reader [sn_cda.analytics_reader]</td>
<td>Can access and view analytics reports.</td>
<td></td>
</tr>
</tbody>
</table>

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Delivery: Send Notifications</td>
<td>Sends email notification for a specified audience and specified date. Runs every hour by default.</td>
</tr>
<tr>
<td>Content Delivery: Post to Forums</td>
<td>Posts community content to community forums. Runs every hour by default.</td>
</tr>
<tr>
<td>Content Deliver: Process Todos</td>
<td>Creates to-do tasks for assigned audience. Runs every hour by default.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Audience</td>
<td>A targeted group of users.</td>
</tr>
<tr>
<td>Audience Data</td>
<td>Used when Audience type is Upload File from the Audience form. Where you store uploaded users.</td>
</tr>
<tr>
<td>Block Content</td>
<td>Reusable content for notifications, rich-text announcements, or community posts (when you install communities).</td>
</tr>
<tr>
<td>Community Content</td>
<td>Content posted to a topic or forum in a community. Community content can be:</td>
</tr>
<tr>
<td>To-do Content</td>
<td>Defines the to-do content.</td>
</tr>
<tr>
<td>Content Task</td>
<td>Extends the HR task [sn_hr_core_task] table and where you create tasks for the Employee Service Center to-dos.</td>
</tr>
<tr>
<td>Org Chart Configuration</td>
<td>What information appears on the Org Chart.</td>
</tr>
<tr>
<td>User Display Configuration</td>
<td>Controls when users display on the Org Chart page and HRI My Team widget in the Employee Service Center.</td>
</tr>
<tr>
<td>Content</td>
<td>Base table for fields common to Content tables.</td>
</tr>
<tr>
<td>Notification Content</td>
<td>Defines an email blast announcing important news and links directing the user to the service portal.</td>
</tr>
<tr>
<td>Portal Content</td>
<td>Content or information you make available to your employees on the service portal. Content can be a banner, calendar, event, image-based link, rich text, URL, or video.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Classifies the content you want to appear on the service portal. Examples are:</td>
</tr>
</tbody>
</table>
### Properties installed with content delivery

The Content Delivery [com.sn_content_delivery] plugin adds the following properties that are designed to control how scheduled jobs work in relation to notifications, to-dos, and communities.

### Scheduled jobs

The following scheduled jobs work with properties to fine-tune and configure the behavior of Content Delivery:

- Content Delivery Profile
- Content Delivery: Create To-dos
- Content Delivery: Send Email notifications
- Content Delivery: Send SMS notifications

### Properties

- To access Content Automation properties, navigate to **Content Delivery > Configurations > Properties**.

Content Delivery properties determine how the scheduled jobs run and help to ensure that there is limited impact on the performance of your instance.

#### Approvals

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.all_must批准</td>
<td>Indicates that all approvers must approve any scheduled content prior to publishing it. If you check <strong>No</strong>, only one approver is required to publish it.</td>
</tr>
</tbody>
</table>

#### Content Delegation/Restriction

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.activate_audience_delegation_controls</td>
<td>Indicates you want to be able to delegate audiences for content delivery. For more information, see Restrict content for Content Delivery and Content Automation.</td>
</tr>
<tr>
<td>sn_cd.activate_content_authoring_controls</td>
<td>Indicates you want to be able to restrict content items for content delivery.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Community content</td>
<td></td>
</tr>
<tr>
<td>• Portal content</td>
<td></td>
</tr>
<tr>
<td>• Notification content</td>
<td></td>
</tr>
<tr>
<td>• To-do content</td>
<td></td>
</tr>
<tr>
<td>Schedule Content [sn_cd_content_visibility]</td>
<td>Determines what content appears on the service portal, for what audience, and when.</td>
</tr>
<tr>
<td>Link Content [sn_cd_url_asset]</td>
<td>URL links to information to appear on the service portal.</td>
</tr>
</tbody>
</table>
## Content Delegation/Restriction (continued)

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.todo.max_run_time</td>
<td>The maximum run time in seconds for the Content Delivery: Create To-dos scheduled job. When the job finishes running, any</td>
</tr>
</tbody>
</table>

### Notifications

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.notification.max_run_time</td>
<td>The maximum amount of time (in seconds) the Content Delivery: Send notifications scheduled job runs. Limits the length of the scheduled job, but completes any work in progress and does not pick up any new work. <strong>Default value:</strong> 600</td>
</tr>
<tr>
<td>sn_cd.sms_notification.max_recipients</td>
<td>The maximum number of people you can send an SMS notification to. <strong>Default value:</strong> 50,000.</td>
</tr>
<tr>
<td>sn_cd.sms_notification.max_users_per_event</td>
<td>The maximum number of users to add per event for an SMS notification. <strong>Default value:</strong> 1000.</td>
</tr>
<tr>
<td>sn_cd.notification.event_stagger</td>
<td>The amount of time between events when a scheduled job runs. Staggering provides time for the events to be processed during the staggered time. <strong>Default value:</strong> 60 seconds.</td>
</tr>
<tr>
<td>sn_cd.notification.max_events</td>
<td>The maximum number of events from campaigns to process during the scheduled job. <strong>Default value:</strong> 50.</td>
</tr>
<tr>
<td>sn_cd.notification.max_users_per_event</td>
<td>The maximum number of users to add per event for an email notification.</td>
</tr>
<tr>
<td>sn_cd.notification.max_recipients</td>
<td>The maximum number of recipients allowed per email notification.</td>
</tr>
</tbody>
</table>

### To-dos

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.todo.max_run_time</td>
<td>The maximum run time in seconds for the Content Delivery: Create To-dos scheduled job. When the job finishes running, any</td>
</tr>
</tbody>
</table>
### To-dos (continued)

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.todo.event_stagger</td>
<td>The number of seconds between events.</td>
</tr>
<tr>
<td>sn_cd.todo.max_events</td>
<td>The maximum number of events that are queued per scheduled job run.</td>
</tr>
<tr>
<td>sn_cd.todo.max_users_per_event</td>
<td>The maximum number of users that can be added per event.</td>
</tr>
<tr>
<td>sn_cd.todo.max_assignees</td>
<td>The maximum number of people you can assign to a task.</td>
</tr>
</tbody>
</table>

### Forums

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.content_community.max_posts</td>
<td>The maximum number of posts to a forum allowed per Content Deliver: Post to Forums scheduled job.</td>
</tr>
</tbody>
</table>

### Add or modify portal content

Ensure that your Employee Service Center meets the needs of your organization by customizing its appearance and the content included.

**Before you begin**

Role required: sn_cd.content_manager

**About this task**

Use Portal Content to create content that appears on your Employee Service Center.

Use the Styled Content content type to access a suite of tools and fields to create custom banners without coding.

Content can be static. For example, a holiday calendar changes once a year, have a start and end date (runs for a specific time period), or used in campaigns (see [Campaigns for HR Service Delivery](#)).

Portal Content provides flexibility with configuration. Creating a Portal Content record allows you to interchange content at any time or have multiple contents appear at the same time in a carousel.

You can also edit some widgets directly from the Employee Service Center.

- Background color: Turn off the background color. The default is set to On.
- Header and bounding box: Turn off headings and borders. The default is set to On.

To edit a widget, header, or bounding box, select Control-Click and select Instance Options.

**Note:** Only HR and content delivery widgets can be edited this way. Banners cannot be edited this way.
Procedure
1. Navigate to Content Delivery > Manage Content > Portal Content.
2. Click New or edit an existing portal content.
3. Fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A name that describes the content.</td>
</tr>
<tr>
<td>Content type</td>
<td>The type of content for a campaign or the service portal. Enter a number defining the order the content appears on the service portal or employee service center. Content appears closer to the beginning of the carousel when assigned a lower number.</td>
</tr>
</tbody>
</table>

Click the Lookup Using List icon to select a content type.

Content types are provided with the base system, but you can click New to create a content type. See Add or modify content type for Content Delivery.

Note: The Content section of the form changes depending on what content type you select.

The base system provides the following content types:
- Banner
- Calendar
- Event
- Image-based link
- Rich text
- Styled Content
- URL
- Video
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Use increments of 100 when determining the order. This method makes it easier to edit. For example, you numbered your links 1, 2, 3, 4, 5 and wanted to place a new content after 2. You would have to renumber 3, 4, and 5. If you use 100, 200, and 300 and wanted to place content from 100 through 200, you would simply use any number from 101 through 199.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the content is active and available to use.</td>
</tr>
</tbody>
</table>

4. Click **Save** and the Content fields appear depending on what was selected in **Content type**.

**Banner**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading text</td>
<td>The headline you want to appear over the banner.</td>
</tr>
<tr>
<td>Body text</td>
<td>The detailed message you want to appear over the banner.</td>
</tr>
<tr>
<td>Show button</td>
<td>Creates a button or link that the employee can click.</td>
</tr>
<tr>
<td>Button text</td>
<td>Text that labels the button or prompts the user to click.</td>
</tr>
<tr>
<td></td>
<td>Appears when <strong>Show button</strong> is checked.</td>
</tr>
<tr>
<td>Button link</td>
<td>A link to content that provides access after clicking the button.</td>
</tr>
<tr>
<td></td>
<td>Appears when <strong>Show button</strong> is checked.</td>
</tr>
<tr>
<td>Link text</td>
<td>Text that labels the link or prompts the user to click.</td>
</tr>
<tr>
<td></td>
<td>Appears when <strong>Link</strong> is selected from <strong>Action</strong>.</td>
</tr>
<tr>
<td>Link</td>
<td>A link to content that provides access after clicking the link.</td>
</tr>
<tr>
<td></td>
<td>Appears when <strong>Link</strong> is selected from <strong>Action</strong>.</td>
</tr>
<tr>
<td>Use custom HTML</td>
<td>Click to create a custom HTML banner.</td>
</tr>
<tr>
<td>User reference table</td>
<td>Table used to personalize the banner. Use variables from the selected table to add content that is customized. For example, you can select a variable that pulls the home address of an employee based on the HR profile table.</td>
</tr>
</tbody>
</table>
### Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rich text</td>
<td>Message for your banner. Use the editing tools to format your text. Appears when you select <strong>Use custom HTML</strong>.</td>
</tr>
<tr>
<td>Select variables</td>
<td>Variables that customize the rich text of the banner. The <strong>User reference table</strong> determines what variables are available.</td>
</tr>
<tr>
<td>Background image</td>
<td>An image that represents the background of the portal content.</td>
</tr>
<tr>
<td>Background size</td>
<td>The size of the background image. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• Auto: Use the original size of the image. Auto is the default value.</td>
</tr>
<tr>
<td></td>
<td>• Contain: Resize the image to ensure it is entirely visible.</td>
</tr>
<tr>
<td></td>
<td>• Cover: Resize the image to cover the entire container, even if the image must be stretched or cut off on the edges.</td>
</tr>
<tr>
<td>Background position</td>
<td>The location you want the background image on the Employee Service Center to appear.</td>
</tr>
<tr>
<td>Background color</td>
<td>The color of the background image. Use the hex color code to define what color appears.</td>
</tr>
<tr>
<td>Text color</td>
<td>The hue of the background color.</td>
</tr>
<tr>
<td>Text alignment</td>
<td>The positioning of the heading and body text.</td>
</tr>
</tbody>
</table>

### Calendar

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>The calendar you want to appear on the Employee Service Center. <strong>Note:</strong> For more information about schedules and calendars, see <strong>Calendars and schedules</strong>.</td>
</tr>
</tbody>
</table>

### Event

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event start</td>
<td>The date and time the event begins.</td>
</tr>
<tr>
<td><strong>Fields</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event end</td>
<td>The date and time the event ends.</td>
</tr>
<tr>
<td>User reference table</td>
<td>Table used to personalize the event. Use variables from the selected table to add content that is personalized. For example, you can select a variable that pulls the home address of an employee based on the HR profile table.</td>
</tr>
</tbody>
</table>

**Note:** You can also use any table that extends the User [sys_user] or HR profile [sn_hr_core_profile] tables.

<table>
<thead>
<tr>
<th><strong>Fields</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rich text</td>
<td>Message for your event. Use the editing tools to format your text.</td>
</tr>
<tr>
<td>Select variables</td>
<td>Variables that customize the rich text of the event. The <strong>User reference table</strong> determines what variables are available.</td>
</tr>
</tbody>
</table>

**Image-based Link**

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Descriptions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>The URL you want employees to click when on the Employee Service Center.</td>
</tr>
<tr>
<td>Image</td>
<td>The image the URL is embedded in.</td>
</tr>
</tbody>
</table>

**Rich Text**

<table>
<thead>
<tr>
<th><strong>Fields</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use block content</td>
<td>You can create rich text or use block content for portal content. Select this check box to show the <strong>Block content</strong> Lookup using list.</td>
</tr>
<tr>
<td>Block content</td>
<td>The block content you want to appear on the Employee Service Center. Only appears when you select the <strong>Use block content</strong> check box. For more information on block content, see <strong>Add or modify block content</strong>.</td>
</tr>
<tr>
<td>Glyph</td>
<td>An icon or pictograph that represents the block content on the Employee Service Center.</td>
</tr>
<tr>
<td>Glyph size</td>
<td>The size you want the glyph to appear on the Employee Service Center.</td>
</tr>
<tr>
<td>Heading text</td>
<td>The headline you want to appear for your portal content.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Body text</td>
<td>The main message you want to appear for your portal content.</td>
</tr>
<tr>
<td>Action</td>
<td>A button or a URL link you want employees to click.</td>
</tr>
<tr>
<td>Button text</td>
<td>Text you want to appear over the button. Only appears when you select <strong>Button</strong> from <strong>Action</strong>.</td>
</tr>
<tr>
<td>Button link</td>
<td>URL link for the button. Only appears when you select <strong>Button</strong> from <strong>Action</strong>. Links must be created in Link Content. For more information, see Add or modify links to other content sources.</td>
</tr>
<tr>
<td>Link text</td>
<td>Text you want to appear for the URL link. Only appears when you select <strong>Link</strong> from <strong>Action</strong>.</td>
</tr>
<tr>
<td>Link</td>
<td>URL link you want employees to click. Only appears when you select <strong>Link</strong> from <strong>Action</strong>. Links must be created in Link Content. For more information, see Add or modify links to other content sources.</td>
</tr>
<tr>
<td>User reference table</td>
<td>Table used to personalize the portal content. Use variables from the selected table to add content that is personalized. For example, you can select a variable that pulls the home address of an employee based on the HR profile table.</td>
</tr>
<tr>
<td>Use custom HTML</td>
<td>Indicates that you want to use rich text to create portal content.</td>
</tr>
<tr>
<td>Rich text</td>
<td>Message the portal content. Use the editing tools to format your text. Appears when you select <strong>Use custom HTML</strong>.</td>
</tr>
<tr>
<td>Background image</td>
<td>An image that represents the background of the portal content.</td>
</tr>
<tr>
<td>Background size</td>
<td>The size of the background image. The choices are:</td>
</tr>
</tbody>
</table>
### Fields

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Auto: Use the original size of the image. Auto is the default value.</td>
</tr>
<tr>
<td>• Contain: Resize the image to ensure it is entirely visible.</td>
</tr>
<tr>
<td>• Cover: Resize the image to cover the entire container, even if the image must be stretched or cut off on the edges.</td>
</tr>
</tbody>
</table>

### Background position
The location you want the background image on the Employee Service Center to appear.

### Background color
The color of the background image. Use the hex color code to define what color appears.

### Text color
The hue of the background color.

### Text alignment
The positioning of the heading and body text.

---

### Styled Content

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading text</td>
<td>The headline you want to appear over the banner.</td>
</tr>
<tr>
<td>Body text</td>
<td>The detailed message you want to appear over the banner.</td>
</tr>
<tr>
<td>Text color</td>
<td>Do you want the text to be dark or light.</td>
</tr>
<tr>
<td>Text alignment</td>
<td>How you want the text to be aligned.</td>
</tr>
<tr>
<td>Call to action</td>
<td>Creates a button or link that the employee can click.</td>
</tr>
<tr>
<td>Button text</td>
<td>Text that labels the button or prompts the user to click. Only appears when <strong>Button</strong> is selected from <strong>Call to action</strong>.</td>
</tr>
<tr>
<td>Button link</td>
<td>The link a user is directed to after selecting the button. Only appears when <strong>Button</strong> is selected from <strong>Call to action</strong>.</td>
</tr>
<tr>
<td>Link text</td>
<td>Text that labels the link or prompts the user to click. Only appears when <strong>Link</strong> is selected from <strong>Call to action</strong>.</td>
</tr>
<tr>
<td>Link</td>
<td>The URL link a user is directed to after selection. Only appears when <strong>Link</strong> is selected from <strong>Call to action</strong>.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add background image</td>
<td>Indicates that you want an image to appear as the background.</td>
</tr>
<tr>
<td>Image</td>
<td>The image you want to appear as a background. Only appears when Add background image is checked.</td>
</tr>
<tr>
<td>Image size</td>
<td>How you want the image to appear. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Fill Widget: Resize the image to cover the entire container, even if the image must be stretched or cut off on the edges.</td>
</tr>
<tr>
<td></td>
<td>• Fit Widget: Resize the image to ensure it is entirely visible.</td>
</tr>
<tr>
<td></td>
<td>• Original Size: Use the original size of the image.</td>
</tr>
<tr>
<td></td>
<td>Only appears when Add background image is checked.</td>
</tr>
<tr>
<td>Image position</td>
<td>Where you want the image to appear in the banner. Only appears when Add background image is checked.</td>
</tr>
<tr>
<td>Background color</td>
<td>The background color of the banner. Use the hex color code to define what color appears.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the style of text you want to appear.</td>
</tr>
<tr>
<td></td>
<td>Block has smaller text, appears below the image, and can include an icon.</td>
</tr>
<tr>
<td></td>
<td>Banner has larger, vertically centered text with wider margins.</td>
</tr>
<tr>
<td>Add icon</td>
<td>Only appears when Add icon is checked.</td>
</tr>
<tr>
<td>Icon</td>
<td>Only appears when Add icon is checked.</td>
</tr>
<tr>
<td>Icon size</td>
<td>Only appears when Add icon is checked.</td>
</tr>
<tr>
<td>Text over background</td>
<td>Indicates that you want the text to appear over the background image. If you leave unchecked, the text appears below the image. Only appears when Block is selected from Type.</td>
</tr>
<tr>
<td>Add icon</td>
<td>Indicates that you want to add an icon to your banner. Only appears when Block is selected from Type.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Icon</td>
<td>The icon you want to appear in the banner above the text.</td>
</tr>
<tr>
<td>Icon size</td>
<td>The size of the icon.</td>
</tr>
<tr>
<td></td>
<td>Only appears when <strong>Block</strong> is selected from <strong>Type</strong>.</td>
</tr>
<tr>
<td>Add gradient</td>
<td>Indicates that you want the text to include color gradient to make your text easier to read. Only appears when <strong>Text over background</strong> is checked.</td>
</tr>
</tbody>
</table>

**URL**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>URL link you want employees to click.</td>
</tr>
<tr>
<td></td>
<td>Only appears when you select <strong>URL</strong> from <strong>Content type</strong>.</td>
</tr>
<tr>
<td></td>
<td>Links must be created in Link Content. For more information, see Add or modify links to other content sources.</td>
</tr>
</tbody>
</table>

**Video**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video URL</td>
<td>Video link you want employees to click.</td>
</tr>
<tr>
<td></td>
<td>Only appears when you select <strong>Video</strong> from <strong>Content type</strong>.</td>
</tr>
<tr>
<td></td>
<td>Video links must be created in Link Content. For more information, see Add or modify links to other content sources.</td>
</tr>
</tbody>
</table>

5. Click **Save** to save and remain on the form, or click **Update** to save and return to the Community Content list.

**Results**

Go to Schedule Content to define the audience, date, and time your content is available. For more information, see Schedule the delivery of HR content. Or, go to Campaign Content to add your content to a campaign bundle. For more information, see Create campaign bundles.

**Add or modify Employee Forums content**

Provide content to your employees through employee forums and as part of a campaign that appears on your Employee Service Center or service portal.

**Before you begin**

Role required: **sn_cd.campaign_manager**

**About this task**

Creating forum content also requires the following to post to a community or forum:
• A forum to post community content. For information on creating forums, see Configure community forums.

• Scheduling the content. You can automatically create a link while scheduling the forum content. For more information on scheduling, see Schedule the delivery of HR content.

• Use the link for campaigns, emails, or on the Employee Service Center.

• The Content Delivery: Post to Forums scheduled job runs every hour by default to process posts. For more information on scheduled jobs, see Scheduled jobs.

Procedure
1. Navigate to Content Delivery > Manage Content > Community Content.
2. On the form, fill in the fields.

### Community Content form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title or name that identifies the community post.</td>
</tr>
<tr>
<td>Content type</td>
<td>Classification of the community post. Fields used to define the post change based on the content type selection.</td>
</tr>
<tr>
<td></td>
<td>• Community Blog</td>
</tr>
<tr>
<td></td>
<td>• Community Event</td>
</tr>
<tr>
<td></td>
<td>• Community Video</td>
</tr>
<tr>
<td></td>
<td>• Forums Post List (lists posts from a specific forum)</td>
</tr>
</tbody>
</table>

**Note:** For more information on community content types, see Community content types.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates that the community post is active and available to post.</td>
</tr>
</tbody>
</table>

Fields change depending on which content type you select.

### Community Blog fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use block content</td>
<td>Indicates that you are using block content and not rich text. For information on creating block content, see Add or modify block content.</td>
</tr>
<tr>
<td>Block content</td>
<td>Appears when you check the Use block content box. Click to access existing block content or to create content for your community blog.</td>
</tr>
</tbody>
</table>
### Community Event

If you select **Virtual event**, the fields are different.

#### Community Event fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show attendee list</td>
<td>Indicates that attendees can view a list of other attendees.</td>
</tr>
<tr>
<td>Attendee limit</td>
<td>Determines the maximum number of attendees that can attend the event.</td>
</tr>
<tr>
<td>Virtual event</td>
<td>Indicates that event is online. When checked, the Event URL, Start time,</td>
</tr>
<tr>
<td></td>
<td>and End time fields appear.</td>
</tr>
<tr>
<td>Event URL</td>
<td>The URL link to the virtual meeting.</td>
</tr>
<tr>
<td>Start time</td>
<td>The date and time the virtual event begins.</td>
</tr>
<tr>
<td>End time</td>
<td>The date and time the virtual event ends.</td>
</tr>
<tr>
<td>Location name</td>
<td>The name or description of the event location.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the event location.</td>
</tr>
<tr>
<td>City</td>
<td>The city of the event location.</td>
</tr>
<tr>
<td>Zip / postal code</td>
<td>The zip or postal code of the event location.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone of the event location. Used to determine the event scheduling</td>
</tr>
<tr>
<td></td>
<td>and reminder.</td>
</tr>
<tr>
<td>Event reminder</td>
<td>Indicates when you want an event reminder sent.</td>
</tr>
<tr>
<td>State / province</td>
<td>The state or province of the event location.</td>
</tr>
<tr>
<td>Country</td>
<td>The country of the event location.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the event.</td>
</tr>
</tbody>
</table>

### Community Video
## Community Video fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Video   | Link to the video you want to post to your community, use as part of a campaign, or post to the Employee Service Center. Videos appear as web URLs that link to popular video sites. Supported video link hosts are:  
  - dailymotion.com  
  - facebook.com  
  - vimeo.com  
  - youtube.com  
For more information on video content, see Add or modify links to other content sources. |
| Description | Description of the video. |

## Forums Post List

### Forums Post List fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| List type   | How you want the posts from a forum to appear on the Employee Service Center.  
  - Dynamic List: Automatically generated list. |
| Forum links | Determines what forum links you want to appear on the Employee Service Center.  
Appears when you select Manual List from List type.  
Click the Unlock forum links icon and select the links you want to appear.  
**Note:** The first forum link you select appears first on the Employee Service Center. |
| Dynamic list type | The method your posts appear in the forum list.  
  - Recently Added: The most recently added forum posts appear.  
  - Most Popular: Forum posts that |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Appears when you select <strong>Dynamic</strong> in <strong>List type</strong>.</td>
</tr>
<tr>
<td>Number of list items</td>
<td>The number of forum posts you want to appear. Only appears when you select <strong>Most Popular</strong> from <strong>Dynamic list type</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Save** to save and remain on the form, or click **Update** to save and return to the Community Content list.

**Results**

Go to Schedule Content to define the audience, date, and time your content is available. For more information, see [Schedule the delivery of HR content](#). Or, go to Campaign Content to add your content to a campaign bundle. For more information, see [Create campaign bundles](#).

**Content Automation and Content Delivery notifications**

Content Automation and Content Delivery use the Now Platform email, push, and SMS notifications feature to send messages directly to employees. Messages can also be sent as part of a campaign.

**Now Platform**

To use email, push, or SMS with HR Service Delivery follow the steps and processes from the Now Platform® documentation.

- Activate the Notify [com.snc.notify] plugin.
- Ensure that the following system properties are configured correctly:
  - `sn_ca.sms_notification.max_events`: Determines the maximum number of campaign events to queue per job run for SMS. The default value is 50.
  - `sn_ca.sms_notification.max_users_per_event`: Determines the maximum number of users to add per a campaign event for SMS. The default is 1,000.
  - `sn_cd.sms_notification.max_recipients`: Determines the maximum number of users to add per Content Delivery notification for SMS. The default value is 50,000.
  - `sn_cd.sms_notification.max_users_per_event`: Determines the maximum number of users to add for a Content Delivery event for SMS. The default value is 1,000.
  - `glide.notify.sms.max_concatenation`: Notify supports the concept of SMS concatenation. The maximum length of a single SMS is 160 characters for plaintext or 70 characters for Unicode SMS messages. Up to 10 SMS messages are linked together when the maximum length is reached. This property configures the maximum number of SMS messages that are linked into one large SMS message. If the body length is exceeded the body truncates and a message logs.

**Note:** The charges are per SMS, which means that 1600 character SMS is 10 times as expensive as a 160 character SMS. Also, not all providers support SMS concatenation.
• Configure notifications to work with an SMS service provider or configure a Twilio account.
  ◦ See Configure Notify with Twilio.

• Configure a notify number in SMS configuration.
  ◦ See Manage SMS configuration for Content Delivery and Content Automation.

• Create notification content.
  ◦ See Add or modify notification content.

• Map SMS content to a campaign (Content Automation).
  ◦ See Create a campaign.

• Schedule content (Content Automation).
  ◦ See Create a campaign, Create content for a campaign, or Create campaign bundles, or Schedule the delivery of HR content.

• Run scheduled jobs.
  ◦ Content Automation: Send SMS Notifications: Responsible for sending SMS notifications for campaigns. Default value is to run every hour.
  ◦ Content Automation: Update Campaign Audience: Reevaluates the audience for a campaign and removes employees that no longer satisfy the criteria.
    Adds users that match your defined criteria to the campaign. Users show up in the Campaign Targets related list for a campaign.
  ◦ Content Automation: Add Non-Portal Campaign Content: Creates sn_ca_campaign_item_user_records for sent emails. It does not send the email.
  ◦ Content Delivery: Send SMS notifications: Responsible for sending SMS notifications for Content Delivery. Default value is to run every hour.

For more information, see:
• Email and SMS notifications.
• Notify
• Numbers and number groups

Add or modify notification content
Use Notification Content to send an information blast directly to your employees via email or push to their mobile devices. Notifications are intended to direct users to the portal for detailed information.

Before you begin
Role required: sn_cd.campaign_manager

Procedure
1. Navigate to Content Delivery > Manage Content > Notification Content.
2. Click New or an existing notification content.
<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A descriptive title of the notification. The title is not the subject of the notification, although they can be identical.</td>
</tr>
<tr>
<td>From</td>
<td>The person or group you want the notification to come from.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field only appears when Content type is email.</td>
</tr>
<tr>
<td>Reply to</td>
<td>The email address that can accept a reply when you want your audience to be able to respond to the notification.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field only appears when Content type is email.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject of the notification, similar to the subject line in an email.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field only appears when Content type is email.</td>
</tr>
<tr>
<td>Use block content</td>
<td>You can select reusable block content for your notification message.</td>
</tr>
<tr>
<td>Note:</td>
<td>For more information, see Add or modify block content.</td>
</tr>
<tr>
<td>Block content</td>
<td>Click the Lookup using list icon to select the block content you want for your notification message. Only appears when you select the Use block content check box.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field only appears when Content type is email.</td>
</tr>
<tr>
<td>Content type</td>
<td>The type of notification you want sent.</td>
</tr>
<tr>
<td>Note:</td>
<td>All recipients move into the BCC field and are not visible.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the notification is active and available.</td>
</tr>
<tr>
<td>Body</td>
<td>The body or message of the notification.</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When you insert an image, use 1440 x 600 pixels (px) and a file size of 100–500 kilobytes (KB). A file size of 100 KB is optimal. This field only appears when Content type is email.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Optimize your image. It improves performance on the service portal. Also, use SVG files for optimal quality.</td>
</tr>
<tr>
<td>Message</td>
<td>The message you want to send via push. You are limited to 1600 characters.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field only appears when Content type is Push.</td>
</tr>
</tbody>
</table>

3. Select **Submit** or **Update** to save and return to the Notification Content list.

**Results**

Go to Schedule Content to define the audience, date, and time your content is available. For more information, see Schedule the delivery of HR content. Or, go to Campaign Content to add your content to a campaign bundle. For more information, see Create campaign bundles.

**Manage SMS configuration for Content Delivery and Content Automation**

Use SMS configuration to configure the phone number your messages come from.

**Before you begin**

Role required: sn_cd.content_manager

**Procedure**

1. Navigate to **Content Delivery > Configurations > SMS Configuration**.
2. Enter a phone number that SMS message are sent from. For more information, see **Notify**.
3. Click **Submit** or **Save**.

**Add or modify task (to-do) content**

You can assign tasks to your employees as part of a campaign and, if needed, trigger additional content once a task is completed. To-dos can also be sent via email or posted to the Employee Service Center.

**Before you begin**

Role required: sn_cd.campaign_manager

**About this task**

For example, an Open Enrollment for Benefits campaign can have tasks that appear on the Employee Service Center as to-dos. These tasks prompt employees to sign up for health care.

**There are four Content types:**

- Button Complete: Employee clicks button to complete the task.
- Play Video: Employee launches video to complete the task.
• View Link: Employee clicks link to complete the task.
• E-Signature: Requires an e-signature to complete to task.

Procedure
1. Navigate to Content Delivery > Manage Content > To-do Content.
2. Click New or an existing To-do Content record.
3. On the form, fill in the fields.

To-do Content form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name that identifies the to-do link.</td>
</tr>
<tr>
<td>Content type</td>
<td>Defines the kind of to-do link. See Add or modify content type for Content Delivery.</td>
</tr>
<tr>
<td>Use block content</td>
<td>Indicates that you want to use block content in your to-do. See Add or modify block content.</td>
</tr>
<tr>
<td>Block content</td>
<td>The block content to be used for the to-do. Appears when you check Use block content.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates the to-do content is active and available to use.</td>
</tr>
<tr>
<td>Button text</td>
<td>Text describing the button. For example, to indicate that enrollment in a benefits plan was completed, enter Enrollment Complete. Appears when Button Complete is selected from Content type.</td>
</tr>
<tr>
<td>E-signature template</td>
<td>The e-signature template to be used with the e-signature content type. See Configure an e-signature template.</td>
</tr>
<tr>
<td>Video</td>
<td>The video link you want an employee to click. Video links are defined in Link Content. For more information, see Add or modify links to other content sources. Appears when you select Play Video in Content type.</td>
</tr>
<tr>
<td>Link</td>
<td>The link you want an employee to click. Appears when View Link is selected from Content type. Links are defined in Link Content. For more information, see Add or modify links to other content sources.</td>
</tr>
<tr>
<td>Rich text</td>
<td>Area to provide detailed information about the task.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
| Use the editing tools to enhance the appearance of the text. Appears if you do not check **Use block content**.

4. Click **Submit**. The Campaign Content form appears. Complete the form.

### Campaign Content

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title you entered from the <strong>To-do content</strong> form.</td>
</tr>
<tr>
<td>Content</td>
<td>The content you created from the <strong>To-do content</strong> form.</td>
</tr>
<tr>
<td>Due date</td>
<td>Assigns a date when an employee must complete the to-do. Adding a due date allows you to sent a to-do and override the campaign bundle or stage end date.</td>
</tr>
<tr>
<td>End campaign on completion</td>
<td>Removes employees from the campaign after the to-do is completed.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates the to-do content is active and available to use.</td>
</tr>
<tr>
<td>Campaign bundle</td>
<td>The campaign bundle or stage you want the content to belong to.</td>
</tr>
<tr>
<td>Refine audience</td>
<td>Narrows your audience selected at the campaign level. Selecting an existing audience creates a subset of the original audience.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the to-do content.</td>
</tr>
</tbody>
</table>

**Results**

Go to **Schedule Content** to define the audience, date, and time your content is available. For more information, see **Schedule the delivery of HR content**. Or, go to **Campaign Content** to add your content to a campaign bundle. For more information, see **Create campaign bundles**.

**Configure mobile content**

Configure mobile content such as banners, text cards, and video for content delivery or for use in campaigns. Mobile content is delivered to users that meet the audience criteria on the Now Mobile app.

**Before you begin**

Role required: **sn_cd.content_manager**
About this task

Mobile content displays in a carousel section on both the Now Mobile and Mobile Onboarding apps to users that meet the specified audience criteria. You can configure mobile banners, text cards, and videos for content delivery or for use in campaign.

⚠️ Note:

The Mobile Onboarding is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the Now Mobile app for HR Service Delivery.

Procedure

1. Navigate to Content Delivery > Mobile Content.
2. Click New or open a record.
3. On the Mobile Content form, set the Content type field value to one of the following:
   - Mobile Banner
   - Mobile Text Card
   - Mobile Video
   For each content type, follow the applicable task.

For mobile banner

Configure content for a mobile banner.

Before you begin

Role required: sn_cd.content_manager

Procedure

1. On the Mobile Content form, set the Content type field value to Mobile Banner.
2. Fill in the fields on the form, as appropriate.
Mobile Content form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of the mobile banner.</td>
</tr>
<tr>
<td>Content type</td>
<td>Set the value to Mobile Banner.</td>
</tr>
<tr>
<td>Image</td>
<td>Image to display for the mobile banner.</td>
</tr>
<tr>
<td>Link</td>
<td>Link to use with the mobile banner. The link displays when the user taps anywhere on the banner.</td>
</tr>
<tr>
<td>Header text</td>
<td>Header text to display for the mobile banner.</td>
</tr>
<tr>
<td>Text</td>
<td>Text to display for the mobile banner.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the mobile content displays. Lower numbered content displays before higher numbered content.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the mobile content for use.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and click **Save**. The **Schedule Content** and **Campaign Content** related lists display.

4. Schedule the content or use it in a campaign.
   - To schedule the content for delivery, see **Schedule the delivery of HR content**.
   - To use the content in a campaign, see **Create content for a campaign**.

**For mobile text card**
Configure content for a mobile text card.

**Before you begin**
Role required: sn_cd.content_manager

**Procedure**
1. On the Mobile Content form, set the **Content type** field value to Mobile Text Card.
2. Fill in the fields on the form, as appropriate.

Mobile Content form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of the mobile text card.</td>
</tr>
<tr>
<td>Content type</td>
<td>Set the value to Mobile Text Card.</td>
</tr>
<tr>
<td>Link</td>
<td>Link to use with the mobile text card. The link displays when the user taps anywhere on the text card.</td>
</tr>
<tr>
<td>Header text</td>
<td>Header text to display for the mobile text card.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the mobile content displays. Lower numbered content displays before higher numbered content.</td>
</tr>
<tr>
<td>Style</td>
<td>Style of the mobile text card:</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
• Light |  
• Dark |  
Active | Option to activate the mobile content for use.

3. Right-click the form header and click **Save**. The **Schedule Content** and **Campaign Content** related lists display.

4. Schedule the content or use it in a campaign.
   - To schedule the content for delivery, see **Schedule the delivery of HR content**.
   - To use the content in a campaign, see **Create content for a campaign**.

**For mobile video**

Configure content for a mobile video.

**Before you begin**

Role required: sn_cd.content_manager

**Procedure**

1. On the Mobile Content form, set the **Content type** field value to **Mobile Video**.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Mobile Content form</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of the mobile video.</td>
<td></td>
</tr>
<tr>
<td>Content type</td>
<td>Set the value to <strong>Mobile Video</strong>.</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td>Link to use with the mobile video. The link displays when the user taps on the area below the video.</td>
<td></td>
</tr>
<tr>
<td>Video link</td>
<td>Video to display for the mobile video.</td>
<td></td>
</tr>
<tr>
<td>Header text</td>
<td>Header text to display for the mobile video.</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>Text to display for the mobile video.</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the mobile content displays. Lower numbered content displays before higher numbered content.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the mobile content for use.</td>
<td></td>
</tr>
</tbody>
</table>

3. Right-click the form header and click **Save**. The **Schedule Content** and **Campaign Content** related lists display.

4. Schedule the content or use it in a campaign.
   - To schedule the content for delivery, see **Schedule the delivery of HR content**.
   - To use the content in a campaign, see **Create content for a campaign**.
Configure mobile push notification content

Configure mobile push notifications for content delivery or for use in campaigns. Notifications are pushed to users that meet the audience criteria on either the Now Mobile app. When you schedule the content for delivery, you can specify the mobile app and screen that the notification will be pushed to.

Before you begin
Role required: sn_cd.content_manager

Procedure
1. Navigate to Content Delivery > Notification Content.
2. Click New or open a record.
3. On the Notification Content form, set the Content type field value to Push.
4. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title to display for the push notification.</td>
</tr>
<tr>
<td>Description</td>
<td>Description to display for the push notification.</td>
</tr>
<tr>
<td>Content type</td>
<td>Set the value to Push.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the push notification for use.</td>
</tr>
</tbody>
</table>

5. Right-click the form header and click Save. The Schedule Content and Campaign Content related lists display.

6. Schedule the content or use it in a campaign.

Note: When you schedule the content for delivery or for use in a campaign, you can specify the mobile app and screen that the notification will be pushed to.

- To schedule the content for delivery, see Schedule the delivery of HR content.
- To use the content in a campaign, see Create content for a campaign.

Add or modify links to other content sources

Use link content to create URL or video links. You can use these links on the Employee Service Center, in a campaign, or in Communities (when Communities is installed).

Before you begin
Role required: sn_cd.content_manager

Procedure
1. Navigate to Content Delivery > Manage Content > Link Content.
2. Click New or an existing Notification Content.

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that describes the link to content.</td>
</tr>
<tr>
<td>Field</td>
<td>Descriptions</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL</td>
<td>The URL link to content to appear on the service portal.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of link for the content.</td>
</tr>
<tr>
<td></td>
<td>• Video: Link is a video.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: Must be an embedded link.</td>
</tr>
<tr>
<td></td>
<td>• Link: Link is to content, information, image, or documentation.</td>
</tr>
<tr>
<td></td>
<td>• Forums Link: Link to a Communities forum post.</td>
</tr>
<tr>
<td></td>
<td>Note: After link content is associated with Portal Content, the Type cannot be modified. See Add or modify portal content.</td>
</tr>
<tr>
<td>Forum</td>
<td>The forum in Communities you want the link to appear and share with members of the forum.</td>
</tr>
<tr>
<td></td>
<td>Only appears when Forums Link is selected from Type.</td>
</tr>
<tr>
<td></td>
<td>For information on Communities, see Communities.</td>
</tr>
<tr>
<td>Topic</td>
<td>Topic you want the link to appear in. Topics are subcategories to a forum.</td>
</tr>
<tr>
<td></td>
<td>For example, HR is the forum and Benefits is a subcategory to HR.</td>
</tr>
<tr>
<td>Forum post</td>
<td>The list of posts from the topic or forum the link appears.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>• Forum: HR</td>
</tr>
<tr>
<td></td>
<td>• Open Enrollment: Benefits</td>
</tr>
<tr>
<td></td>
<td>• Forum post:</td>
</tr>
</tbody>
</table>

3. Click Submit, Update, or Save

Add or modify block content
Create block content as reusable information you can insert into campaigns, notifications, rich-text announcements, or community posts (when community is installed).

Before you begin
Role required: sn_cd.content_manager

Procedure
1. Navigate to Content Delivery > Manage Content > Block Content.
2. Click New or on an existing block content record.
3. On the form, fill in the fields.
### Block content fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the block content. The name is what you select when you pull in block content for a community blog.</td>
</tr>
<tr>
<td>Allow personalization</td>
<td>Enables the use of variables taken from either the HR Profile or Sys User tables to personalize your content. Select the box and <strong>User reference table</strong> appears.</td>
</tr>
<tr>
<td>User reference table</td>
<td>Determines the variables you can use to personalize text for the block content. Select <strong>HR Profile</strong> to select variables from the sn_hr_core_profile table. Select <strong>User</strong> to select variables from the sys_user table.</td>
</tr>
<tr>
<td>Select variables</td>
<td>Displays variables dependent on the table selected in <strong>User reference table</strong>. Variables pull information from the selected table to personalize the block content.</td>
</tr>
<tr>
<td>Rich text</td>
<td>Text that comprises the block content. To insert variables, place your cursor in the desired location and click the variable. Use the formatting tools to apply formatting options such as bold, italic, underline, and font styling.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Audiences

Target portal content and lifecycle event activities to specified audiences with audience records.

<table>
<thead>
<tr>
<th>For</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal content</td>
<td>Defines the conditions or criteria that a user must meet to see content in the portal. See <a href="#">Schedule the delivery of HR content</a> for more information.</td>
</tr>
<tr>
<td>Org chart page and my team widget</td>
<td>Defines when new hires display on the org chart page and my team widget in the portal. See <a href="#">Configure a user display configuration record</a> for more information.</td>
</tr>
<tr>
<td>Lifecycle event activity</td>
<td>(Enterprise Onboarding and Transitions) Defines whether the activity should trigger for the lifecycle event case. See <a href="#">Configure a lifecycle event activity</a> for more information.</td>
</tr>
</tbody>
</table>
Configure an audience record

Create or modify an audience record to define the conditions or criteria that users must meet for an applicable use case. Each audience record is configured based on user conditions, user criteria, HR profile conditions, HR criteria, or an uploaded file. You can apply them to portal content or lifecycle event activities. For example, a lifecycle event activity for a work visa transfer is targeted only to employees that need a visa transfer.

Before you begin
Role required: sn_cd.content_admin or sn_hr_le.admin

Procedure
1. Navigate to Content Delivery > Manage Content > Manage Audiences.
2. Click New or open a record.
3. Fill in the fields on the form.

Audience form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the audience record.</td>
</tr>
<tr>
<td>Audience type</td>
<td>The audience the content is directed to. Audiences are defined from:</td>
</tr>
<tr>
<td><img src="https://example.com" alt="Note:" /></td>
<td>After audience type and conditions are selected, a blue link appears with the number of users that meet the criteria. Click this link to view all users by audience type.</td>
</tr>
<tr>
<td>Users [sys_user]</td>
<td>Use conditions defined by the User [sys_user] table with custom conditions you choose.</td>
</tr>
<tr>
<td>User Criteria [user_criteria]</td>
<td>Criteria based on role, department, group, location, or company. User criteria is a platform feature. See User criteria for Service Portal.</td>
</tr>
<tr>
<td>HR Profiles [sn_hr_core_profile]</td>
<td>(HR Service Delivery only) Use conditions based the HR profile [sn_hr_core_profile] table with conditions you choose.</td>
</tr>
<tr>
<td>HR Criteria [sn_hr_core_criteria]</td>
<td>(HR Service Delivery only) Use predefined HR criteria. HR criteria is based on conditions defined by the HR Profile [sn_hr_core_profile] or User [sys_user] tables. The base system provides examples that can be used.</td>
</tr>
<tr>
<td>Upload File</td>
<td>Browse and choose a file with populated with user names or email addresses.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
• user_name template: Indicates that you are uploading a file with user names.  
• email template: Indicates that you are uploading a file with email addresses.  

**Note:** The header of the first column must contain user_name or email.

4. Click **Save, Submit, or Update**.  
   If you click **Save** and the **Restrict/delegate audiences** property is set to **Yes**, the **Restrict audience by user** and **Restrict audience by group** related tabs appears.

5. From the **Restrict audience by user** tab, click **New**.

### Schedule the delivery of HR content
After you create content in Content Delivery, use **Schedule Content** to post to your Employee Service Center, in a campaign, To-dos, email notifications, and community.

**Before you begin**  
Role required: sn_cd.content_manager

#### Procedure

1. Navigate to **Content Delivery > Manage Content > Schedule Content**.
2. To schedule Community content, fill in the form.

#### Community content

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Content | The content or information made available to employees.  
Select content or **New** to create content. See:  
• Add or modify portal content  
• Add or modify Employee Forums content  
• Add or modify notification content  
• Add or modify task (to-do) content  

**Note:** You cannot schedule Link Content and Block Content as standalone content because it is reusable content. |
| Title | A descriptive name for the schedule content record. |
| Forum | The forum you want to post the community content.  
For more information on forums, see [Create a forum](#) |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topics</strong></td>
<td>The area of interest that users can discuss. Click to select a topic that is within the forum. For more information on topics, see <a href="#">Create a topic</a>.</td>
</tr>
<tr>
<td><strong>Note:</strong> Only appears when <strong>Community Content</strong> is the content type for content selected.</td>
<td></td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>Filters widget instances for the page you select. Select a page and only the widget instances that appear on the page are available in the <strong>Widget instance</strong> choice list.</td>
</tr>
<tr>
<td><strong>Note:</strong> Only appears when <strong>Portal Content</strong> is the content type for content selected.</td>
<td></td>
</tr>
<tr>
<td><strong>Widget instance</strong></td>
<td>The service portal widget instance. A widget instance is a reference to a widget that contains properties and CSS specific to that instance. A list of filtered widget instances appear when you select a page from the <strong>Page</strong> choice list.</td>
</tr>
<tr>
<td><strong>Note:</strong> Only appears when <strong>Portal Content</strong> is the content type for content selected.</td>
<td></td>
</tr>
<tr>
<td><strong>Content identifier</strong></td>
<td>Associates portal content to a component in HR Agent Workspace. This field only appears when <strong>Workspace</strong> is selected from the <strong>Content location</strong> field. When the landing page of HR Agent Workspace renders, the following components search for scheduled content that matches the content identifier, applies to the current user, and current time:</td>
</tr>
<tr>
<td></td>
<td>• Announcements</td>
</tr>
<tr>
<td></td>
<td>• Quick Links</td>
</tr>
<tr>
<td></td>
<td>• My frequently used apps To find content identifiers for the base system provided workspace landing pages, see <a href="#">Create a custom landing page in UI Builder</a>.</td>
</tr>
</tbody>
</table>
### Content Delivery schedule content fields

Use Schedule Content to schedule different content types from Content Delivery.

#### Notification content

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>The content or information made available to employees. Content is created from Content Delivery:</td>
</tr>
</tbody>
</table>
### Notification content (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Portal Content</td>
<td>• Community Content</td>
</tr>
<tr>
<td>• Notification Content</td>
<td>• To-do Content</td>
</tr>
</tbody>
</table>

**Note:** Link Content and Block Content create reusable content and cannot be scheduled as standalone content.

<table>
<thead>
<tr>
<th>Title</th>
<th>A descriptive name for the schedule content record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates that the schedule for content is active and available to employees.</td>
</tr>
<tr>
<td>Add Users</td>
<td>Check to show the Users field so you can add users not part of the original audience.</td>
</tr>
<tr>
<td>Users</td>
<td>Select to add specific users that were not part of the original audience. Only appears when Add Users is active.</td>
</tr>
<tr>
<td>Audience</td>
<td>The audience the content is directed to. Audiences are defined in Manage Audience. Does not show for Community Content or when Add Users is active.</td>
</tr>
<tr>
<td>Use Schedule</td>
<td>Check to show the Schedule field.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Use this field to select a specific schedule for content. Only appears when Use Schedule is active. For information on schedules, see Defining schedules. <strong>Note:</strong> Select a schedule with a time zone. Floating time zones are not supported.</td>
</tr>
<tr>
<td>When to process</td>
<td>Indicates a date and time that the content is sent to the audience. The time zone is the user’s time zone. Only appears when Use Schedule is not active.</td>
</tr>
<tr>
<td>Content status</td>
<td>The status of the scheduled content. • Pending: The scheduled job has not processed the content. • Scheduled: Content is scheduled and is queued to be processed.</td>
</tr>
</tbody>
</table>
### Notification content (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Exceeded</td>
<td>• Max Exceeded: The scheduled content exceeded the allowable records to be posted to a forum. The maximum value is configured in the sn_cd.content_community.max_posts property under Content Delivery/Configurations/Properties.</td>
</tr>
<tr>
<td></td>
<td>• Error: An error scheduling or posting community content occurred.</td>
</tr>
<tr>
<td>Completed on</td>
<td>The date and time the Content Delivery:Send notifications scheduled job ran and content was posted to a community.</td>
</tr>
</tbody>
</table>

### Portal content

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>The content or information made available to employees. Content is created from Content Delivery: • Portal Content • Community Content • Notification Content • To-do Content</td>
</tr>
<tr>
<td>Note:</td>
<td>![Information symbol] Link Content and Block Content create reusable content and cannot be scheduled as standalone content.</td>
</tr>
<tr>
<td>Title</td>
<td>A descriptive name for the schedule content record.</td>
</tr>
<tr>
<td>Create link</td>
<td>Indicates that you want to automatically create link content for the forum content when processed. Once link content is created, it can be used in campaigns and posts to the Employee Service Center.</td>
</tr>
<tr>
<td>Note:</td>
<td>![Information symbol] Only appears for Content types: Community Blog and Community Event. For more information on community content type, see Add or modify forum content.</td>
</tr>
<tr>
<td>Page</td>
<td>Filters what widget instances are available for the <strong>Widget instance</strong> field based on the service portal page you choose.</td>
</tr>
</tbody>
</table>
## Portal content (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use this field and the <strong>Widget instance</strong> choice list to define where your content appears on the Employee Service Center.</td>
</tr>
<tr>
<td>Widget instance</td>
<td>The service portal widget instance you want your content to appear on the Employee Service Center. A widget instance is a reference to a widget that contains location, properties, and CSS specific to that instance. When you select a page from the <strong>Page</strong> choice list, you can choose from a list of widget instances for that page. Only shows for content that appears on the Employee Service Center.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the schedule for content is active and available to employees.</td>
</tr>
<tr>
<td>Audience</td>
<td>The audience the content is directed to. Audiences are defined in Manage Audience. Does not show for Community Content.</td>
</tr>
<tr>
<td>Availability start date</td>
<td>You can optionally restrict when content is available by start date. The date the content is first available to the audience. Does not show for Community Content.</td>
</tr>
<tr>
<td>Availability end date</td>
<td>You can optionally restrict when content is available by end date. The date the content is no longer available to the audience. Does not show for Community Content.</td>
</tr>
</tbody>
</table>

### To-do content

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td>The content or information made available to employees. Content is created from Content Delivery: • Portal Content • Community Content • Notification Content • To-do Content</td>
</tr>
</tbody>
</table>

**Note:** Link Content and Block Content create reusable content and cannot be scheduled as standalone content.
**To-do content (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A descriptive name for the schedule content record.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the schedule for content is active and available to employees.</td>
</tr>
<tr>
<td>Audience</td>
<td>The audience the content is directed to. Audiences are defined in Manage Audience. Does not show for Community Content.</td>
</tr>
<tr>
<td>When to process</td>
<td>Indicates a date and time that the content is sent to the audience.</td>
</tr>
<tr>
<td>Due date</td>
<td>Indicates a completion date and time for the To-do.</td>
</tr>
<tr>
<td>Content status</td>
<td>The status of the scheduled content.</td>
</tr>
<tr>
<td></td>
<td>• Pending: The scheduled job has not processed the content.</td>
</tr>
<tr>
<td></td>
<td>• Scheduled: Content is scheduled and is queued to be processed.</td>
</tr>
<tr>
<td></td>
<td>• Max Exceeded: The scheduled content exceeded the allowable records to be posted to a forum. The maximum value is configured in the sn_cd.content_community.max_posts property under Content Delivery/Configurations/Properties.</td>
</tr>
<tr>
<td></td>
<td>• Error: An error scheduling or posting community content occurred.</td>
</tr>
<tr>
<td>Completed on</td>
<td>The date and time the Content Delivery: Process To-dos scheduled job ran and content was posted to a community.</td>
</tr>
</tbody>
</table>

**Employee to-dos page**

The to-dos page is where employees can view and complete all their to-dos on a single page in the Employee Service Center. You can configure the to-dos page by applying filters to show a user's approvals, content tasks, HR acceptances, HR tasks, and more.

**Overview**

The to-dos page shows all open and completed to-dos for an employee. The following GIF shows an example of an employee viewing and completing to-dos on the to-dos page.
Configuring the to-dos page
You control the type of open and completed to-dos that appear by configuring the to-dos filters. The filters define the table and conditions that a to-do must meet for it to appear on the to-dos page for an employee. You can associate one filter per table. For example, you can configure an Approvals filter by:

- Associating it with the Approval [sysapproval_approver] table with the conditions that the employee is the approver.
- There is an entity that the approval is for.
- The approval is in the requested state.

**Note:** The default order for to-dos is due date. If you have too many filters and find that performance is affected, you can order the to-dos by filter. To order by filter, you must enable filter prioritization and assign priority numbers for each filter.

Preconfigured filters
The following filters are included with the Employee Service Center application. You can use them or configure your own.

<table>
<thead>
<tr>
<th>Application</th>
<th>Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Service Center</td>
<td>• Approvals</td>
</tr>
<tr>
<td></td>
<td>• Approvals - Completed</td>
</tr>
<tr>
<td></td>
<td>• CD Task</td>
</tr>
<tr>
<td></td>
<td>• CD Task - Completed</td>
</tr>
</tbody>
</table>
Create or modify a to-dos filter

Create or modify a to-dos filter for the to-dos page in the Employee Service Center. Each to-dos filter is associated with a table that is an extension of the Task [task] table, and you can associate one filter per table. You can use a condition builder to specify the conditions that a task must meet for it to appear on the user’s to-dos page. You can also define the appearance of the to-dos configuration header.

Before you begin
Role required: sn_hr_sp.esc_admin

Procedure
1. Navigate to Employee Service Center > Administration > To-dos Configuration.
2. Click New or open a record.
3. Fill in the fields on the form.

To-dos Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the to-dos configuration filter.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table that the to-dos configuration is associated with.</td>
</tr>
</tbody>
</table>

**Note:**
- You can associate one filter per table.
- The table must be an extension of the Task [task] table.

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Conditions that a task must meet to appear on the to-dos page in the Employee Service Center.</th>
</tr>
</thead>
</table>

**Note:** The conditions available to use are dependent on the table you select.

| Active     | Check box to activate the to-dos configuration for use.                                      |

4. In the **Title row** related list, configure the title row of the to-dos configuration header. Select one of the following title types:

<table>
<thead>
<tr>
<th>Title type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Provide custom text to appear as the to-dos configuration title.</td>
</tr>
<tr>
<td>Field</td>
<td>Map a field from the associated table to appear as the to-dos configuration title.</td>
</tr>
</tbody>
</table>
5. In the **Detail row** related list, configure the details row of the to-dos configuration header. Select one of the following detail types:

<table>
<thead>
<tr>
<th>Detail type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No details appear.</td>
</tr>
<tr>
<td>Custom</td>
<td>Provide custom text to appear as the to-dos configuration details.</td>
</tr>
<tr>
<td>Fields</td>
<td>Map one or more fields from the associated table to appear as the to-dos configuration details. The fields will be separated by a hyphen.</td>
</tr>
<tr>
<td>Parent fields</td>
<td>Select a parent table, and then map one or more fields from that table to appear as the to-dos configuration details. The fields will be separated by a hyphen.</td>
</tr>
</tbody>
</table>

**Note:** To display a link to the corresponding ticket page, make sure that the **Link to task** check box is selected.

6. In the **To-dos Widget Mappings** list, you can map the filter to one or more custom to-dos widgets.

**Note:** If no widget mapping is provided, a default to-dos widget is used.

a. Click **New** or open a record.

b. Fill in the fields on the form.

**To-dos Widget Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To-dos Configuration</td>
<td>This field is automatically set to the to-dos configuration that the widget mapping is associated with.</td>
</tr>
<tr>
<td>Table</td>
<td>This field is automatically set to the table that the to-dos configuration is associated with.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions that a to-do must meet for it to display with the widget.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the widget mapping for use.</td>
</tr>
<tr>
<td>Widget</td>
<td>Name of the widget that the to-dos configuration is associated with.</td>
</tr>
</tbody>
</table>

**Note:** To learn more about widgets and how to configure them, see [Service Portal widgets](#).

c. Click **Submit** or **Update**.

7. Click **Submit** or **Update**.
Enable prioritization by filter

If you are ordering the to-dos by filter instead of due date, you must enable the `sn_hr_sp.todos_config_display_with_priority` property, add the Display priority field to the to-dos configuration form, and assign each to-dos filter a priority number. The to-dos will then be sorted by the filter they are associated with. Within each filter, the to-dos will be sorted by due date.

Before you begin
Role required: sn_hr_sp.esc_admin

Procedure

1. Enable the `sn_hr_sp.todos_config_display_with_priority` property.
   a. In the navigation filter, enter `sys_properties.list`. The System Properties list is displayed.
   b. Open the `sn_hr_sp.todos_config_display_with_priority` property.
   c. In the Value field, set the value to `true`.

2. Add the Display priority field to the to-dos filter form.
   a. Navigate to Employee Service Center > Administration > To-dos Configuration.
   b. Open a record.
   c. In the to-dos configuration form header, click the menu icon and navigate to Configure > Form Layout.
   d. Move the Display priority field to the Selected column.
   e. Click Save.

3. Set the priority number for each to-dos filter.
   a. Navigate to Employee Service Center > Administration > To-dos Configuration.
   b. Open a to-dos filter record.
   c. In the Display priority field, set the priority number.
   d. Repeat the process for each filter.

Employee requests page

The requests page is where employees can view all their requests on a single page in the Employee Service Center. You can configure the requests page by applying filters to show a user's service catalog requests, IT incidents, HR cases and more.

Overview

The requests page displays all of an employee's requests. The following GIF shows an example of an employee viewing and opening requests on the requests page.
Configuring the requests page

You control the type of requests that appear by configuring the request filters. The filters define the table and conditions that a request must meet for it to appear on the requests page for an employee. For example, you can configure a Service Catalog Request filter by associating it with the Request [sc_request] table with the conditions that the request is active and that the request was opened by or for the employee.

**Note:** If you are using Employee Service Center as part of HR Service Delivery, HR cases appear on the requests page for the user that the case was opened for. If an HR case has one or more child cases, the child cases are automatically rolled up with the parent case up to three generations (children, grand-children, and great-grand-children). Furthermore:

- HR child cases that are rolled up with the parent do not appear as separate requests on the requests page.
- Non-HR child cases (such as IT or service catalog requests) appear both as a separate request and as part of the roll-up on the parent case.

To learn more, including how to configure the view for the subject person of an HR case, see [HR ticket page](#).

**Preconfigured filters**

The following filters are included with the Employee Service Center application. You can use them or configure your own.

<table>
<thead>
<tr>
<th>Application</th>
<th>Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Service Center</td>
<td>• Incident Portal</td>
</tr>
<tr>
<td></td>
<td>• Service Catalog Request</td>
</tr>
<tr>
<td>Application</td>
<td>Filters</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
|             | • Service Catalog Request Portal  
|             | • Service Order Portal |
| With HR Service Delivery | • HR - My Requests  
|                         | • HR Cases Closed  
|                         | • HR Cases Open  
|                         | • HR Service Request Closed  
|                         | • HR Service Request Open |

Create or modify a request filter

Create or modify a request filter for the requests page in the Employee Service Center. Each request filter is associated with a table that is an extension of the Task [task] table. You can use a condition builder to specify the conditions that a request must meet for it to appear on the user’s requests page. You can also associate the request filter with a ticket page.

Before you begin
Role required: sn_hr_sp.esc_admin

Procedure
1. Navigate to Service Catalog > Catalog Administration > My Request Filter.
2. Click New or open a record.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>My Request Filter form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Short Description</td>
<td>Description of the request filter.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Name of the table that the request filter is associated with.</td>
</tr>
<tr>
<td></td>
<td>Note: The table must be an extension of the Task [task] table.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the request filter for use.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Select one of the following:</td>
</tr>
</tbody>
</table>
|                        | • Desktop  
|                        | • Service Portal  
|                        | • All  
| Filter                 | Conditions that a request must meet to appear on the requests page in the Employee Service Center. |
|                        | Note: The conditions available to use are dependent on the table you select. |
| Portal page            | Ticket page that the request filter is associated with. |

4. Click Submit or Update.
Employee knowledge page

The knowledge page is where employees can browse knowledge articles and find answers to their questions in the Employee Service Center. You can associate one or more knowledge bases with the Employee Service Center. If no knowledge base is selected, then all your knowledge bases appear in the Employee Service Center.

Overview

The following GIF shows an example of an employee browsing knowledge bases and articles in the Employee Service Center.

Configuring the knowledge page

You can associate one or more knowledge bases with the Employee Service Center.

**Note:** If no knowledge base is selected, then all your knowledge bases appear in the Employee Service Center.

- Associate a portal with a knowledge base

You can also map related articles and catalog items to a knowledge article so that employees can more easily find relevant information and submit relevant requests. For knowledge articles, you can manually map the related articles or allow a machine learning algorithm to predict and display the related articles. For catalog items, you can manually map the related catalog items.

- Map related articles
- Map catalog items related to an article

To learn more about knowledge management, including how to configure a knowledge base, create knowledge articles, and use knowledge blocks to simplify knowledge authoring, see:

- Knowledge Management
- (HR Service Delivery only) HR Knowledge Management
Employee catalog page

The catalog page is where employees can request catalog items such as services and product offerings in the Employee Service Center. You can associate one or more service catalogs with the Employee Service Center. If no service catalog is selected, then all your service catalogs appear in the Employee Service Center.

Overview

The following GIF shows an example of an employee browsing service catalogs and catalog items in the Employee Service Center.

Configuring the catalog page

You can associate one or more service catalogs with the Employee Service Center.

Note: If no service catalog is selected, then all your service catalogs appear in the Employee Service Center.

- Associate a portal with a catalog

You can also map related articles and catalog items to a catalog item so that employees can more easily find relevant information and submit relevant requests. For knowledge articles, you can manually map the related articles or allow a machine learning algorithm to predict and display the related articles. For catalog items, you can manually map the related catalog items. See Specify related items and articles for a catalog item.

To learn more about service catalog, including how to configure a catalog, set up categories, and create catalog items, see:

- Service Catalog
- (HR Service Delivery only) HR service catalog management

Employee org chart page

The org chart page is where employees can view their company’s organization chart, search for employees, and more in the Employee Service Center. You can configure when users
display on both the org chart page and my team widget. You can also configure what
details to display on the org chart card for all employees.

Overview
The org chart page displays an employee's organization chart, their relationships to other
employees, and more. The following GIF shows an example of an employee accessing the
org chart page from the my team widget in the Employee Service Center.

Configuring the org chart page
You control when users appear on both the org chart page and my team widget with user
display configuration records. The user display configuration records define when members
of a targeted audience display based on a specified date. For example, you can configure
a record so that new hires appear on their start date or several days prior.

**Note:** User display configuration records control when other users can see the new
hire in the org chart page and my team widget. However, the new hire can still access
the org chart page and my team widget to see their team if they have access to the
portal.

You can also configure what details to display on the org chart card for all employees.

Default user display configuration record
A default user display configuration record is included with the Content Delivery application.

**Note:** You can have one or more user display configuration records, and they are
evaluated in the order assigned. The default user display configuration record is always
evaluated last.

Depending on whether you are a new or upgrading customer, the default record is set to the
following values:
<table>
<thead>
<tr>
<th>User type</th>
<th>Date</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>New customers with Employee Service Center only</td>
<td>sys_created_on</td>
<td>User [sys_user]</td>
</tr>
<tr>
<td>New customers with HR Service Delivery</td>
<td>employment_start_date</td>
<td>HR profile [sn_hr_core_profile]</td>
</tr>
<tr>
<td>Upgrading customers</td>
<td>sys_created_on</td>
<td>User [sys_user]</td>
</tr>
</tbody>
</table>

**Note:** (HR Service Delivery only) User display configuration records control when other users can see the new hire in the org chart page and my team widget. If the record is configured to display based on the HR profile [sn_hr_core_profile] table and an associated date field, the new hire must have an HR profile with an associated date value in order to appear. They will not appear based on the creation of their record in the User [sys_user] table.

**Configure a user display configuration record**

Create or modify a user display configuration record to define when members of a targeted audience display on the org chart page and my team widget in the Employee Service Center. Each user display record is associated with an audience record and a date for when members of that audience are set to appear. You can have one or more user display records, and they are evaluated in the order assigned. The default user display record is always evaluated last, and only if none of the previous records were a match.

**Before you begin**

Role required: sn_hr_sp.esc_admin or sn_cd.content_admin

**Procedure**

1. Navigate to **Content Delivery > Configurations > User Display**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

### User Display Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user display configuration record.</td>
</tr>
<tr>
<td>Audience</td>
<td>Audience record to apply to the user display configuration record.</td>
</tr>
</tbody>
</table>

**Note:** Audiences define the conditions or criteria that a user must meet for the user display configuration to apply to them. See **Configure an audience record** for more information.

<table>
<thead>
<tr>
<th>Table</th>
<th>Table that the user display configuration record is associated with.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date field that the user display configuration record is associated with.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Offset type to apply to the date field.</td>
</tr>
<tr>
<td>Offset in days</td>
<td>Number of days to apply to the offset type.</td>
</tr>
</tbody>
</table>
Order number for when the user display configuration record is evaluated. Lower numbered user display configuration records are evaluated before higher numbered user display configuration records.

**Note:**
- Make sure that the order number is unique for each user display configuration record.
- The default user display configuration record is always evaluated last, and only if none of the previous user display configuration records were a match.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Option to activate the user display configuration record for use.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Configure the org chart card**

Use **Org Chart Card Configuration** to define what to show in the org chart cards.

**Before you begin**

Role required: sn_hr_core.admin

Org chart cards show additional information on employees that are useful for identifying and contacting the employee.

**Note:** New hires appear in an org chart when they are onboarded and a sys_user record is created.

You can configure up to four lines of information on the card of an employee.

**Note:** The defaults are: user.email, work_phone, work_mobile, and location.

Information is dot-walked from the HR Profile [sn_hr_core_profile] or User [sys_user] tables.

**Procedure**

1. Navigate to **Content Delivery > Configurations > Organization Chart**.
2. Change the scope to the application you are using.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile table</td>
<td>The table you want to pull details from.</td>
</tr>
<tr>
<td></td>
<td>• HR profile [sn_hr_core_profile]</td>
</tr>
</tbody>
</table>

**Note:** Only displays when you have HR Service Delivery licensed and activated.

|             | • User [sys_user] |

**Note:** Any tables that extend the HR profile or User tables also appear.
### Field | Description
--- | ---
Show detail | Check to show the detail information on the org chart card.

**Detail** | Select the field from the table you selected. Detail pulls the information from the field to show in the org chart card.

3. Select **Submit** or **Update**.

### Employee live chat overview

As an employee, you can chat directly and in real time with support agents through the Employee Service Center. When you initiate a chat and select a conversation topic, you are routed to the appropriate chat queue and connected to a support agent.

Connect Support is a messaging tool that enables support agents to provide real-time assistance for end users, and is automatically enabled with Employee Service Center. Your administrator can create multiple chat queues for different departments, such as queues for HR, IT, Payroll, or Facilities. To set up the chat queues and learn more about Connect Support, see [Connect Support](#).

**Note:** If no chat queues are defined, then the chat queue defaults to:
- Virtual Agent Support
- (HR Service Delivery only) HR Department Chat Queue

When you initiate a chat in the Employee Service Center, a pre-chat conversation is displayed with pre-chat categories. The following GIF shows an example of initiating a chat.

![Employee Service Center](image)

**Note:** These pre-chat categories are only used with live chat. If you are using Virtual Agent with Employee Service Center, then these pre-chat categories don’t apply.

### Configuring the pre-chat categories in live chat

Your administrator can control the pre-chat categories that appear in the pre-chat conversation by adding survey choices in the appropriate configuration in the ESC Pre-Chat Configuration. For example, your administrator can configure benefits, employee relations, and travel and expense categories that route to an HR chat queue; finance and payroll categories that route to a finance chat queue.
ESC Pre-Chat Configuration

The ESC Pre-Chat Configuration module enables you to map a survey category to appropriate chat queue. It contains survey configurations that control the pre-chat categories that appear in the pre-chat conversation in the Employee Service Center. It also enables you to create a customized pre-chat survey configuration.

<table>
<thead>
<tr>
<th>Pre-chat survey configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Hire Pre Chat</td>
<td>Survey configuration for new hires. It is available when the Human Resources Scoped App: Lifecycle Events for Enterprise (com.sn_hr_lifecycle_ent) plugin is installed.</td>
</tr>
<tr>
<td>ESC Pre Chat</td>
<td>Survey configuration for enterprise employees. It is available when the Employee Service Center (com.sn_hr_service_portal) plugin is installed.</td>
</tr>
</tbody>
</table>

**Note:** If you have been using the Pre-chat module and are upgrading to the Quebec release, an upgrade script is run to migrate your pre-chat categories as survey choices. If you have any categories with user criteria defined, such categories are migrated without the user criteria. You can manually configure the user criteria for such categories through this module.

Create or modify a pre-chat category

Create or modify a pre-chat category that appears in the pre-chat conversation in the Employee Service Center. When an employee initiates a chat, a list of pre-chat categories are displayed. Each category routes the employee to a specific chat queue.

**Before you begin**

- Role required: sn_hr_sp.esc_admin
- Open the ESC pre-chat in survey designer. Add a category as a survey choice.

**Procedure**

1. Navigate to **Employee Service Center > Administration > ESC Pre-chat Configuration**.
2. Select a pre-chat configuration.
3. In the **Categories** related list, click **New**.
4. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Name of the pre-chat category.</td>
</tr>
</tbody>
</table>

**Note:** This field is displayed only if you are upgrading to the Quebec release.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category (pre_chat_category)</td>
<td>Name of the pre-chat category, which is a reference field.</td>
</tr>
<tr>
<td>Pre-chat</td>
<td>Pre-chat configuration to which the category is associated.</td>
</tr>
<tr>
<td>Can View</td>
<td>User who can view the pre-chat category in the Employee Service Center.</td>
</tr>
</tbody>
</table>
| Note:                       | • You can apply user criteria to control access. When you do not apply user criteria, any user with access to the Employee Service Center can view the pre-chat category.  
                                • The Can View field is displayed only if you are upgrading to the Quebec release. |
| Queue                       | Name of the chat queue that the category is associated with. For example, you can have an HR chat queue, IT chat queue, payroll chat queue. |

5. Click **Submit** or **Update**.

**Employee Forums**

Employee Forums help your employees connect, engage, and collaborate with other employees. Use Employee Forums to share business information, promote employee engagement, encourage ideas and feedback, and to give your employees a voice.

Users can receive fast responses to their issues by posting questions, reviewing blogs or videos, and searching for past discussions. Employee communities can become an important part of your self-service strategy.

Employee Forums integrate with the Employee Service Center to deliver a full suite of self-service forums. A link from the Employee Service Center takes employees to the community where they can post, view, and subscribe to topics.

Employee Forums integrate with campaigns and the Employee Service Center so that:

• You can post content directly to a community or forum from Content Delivery and create a link automatically when scheduling the content.

• Community or forum content can be part of a campaign or posted to the Employee Service Center. Community or forum content can include blog posts, events, videos, or links to posts or other content.

Configure Employee Forums to prompt users to accept the terms and conditions of the community and ensure that their community profile is in sync with their HR profile. See the `sn_communities.disable_terms_conditions_role` property in `sn_communities.disable_terms_conditions_role` property in `Properties installed with Communities` and `. See Configure the community profile. For information on communities, see Communities.

**Activate Employee Forums for HR Service Delivery**

Employee Forums is a feature that can accompany the Employee Service Center.
Before you begin
Role required: admin

About this task
To activate Employee Forums, you must activate:
• Employee Service Center [com.sn_hr_service_portal] plugin.
• Communities [com.sn_communities] plugin.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Add or modify forum content
Provide content to your employees through employee forums and as part of a campaign that appears on your Employee Service Center or service portal.

Before you begin
Role required: sn_cd.campaign_manager

About this task
Creating forum content also requires the following to post to a community or forum:
• A forum to post community content. For information on creating forums, see Configure community forums.
• Scheduling the content. You can automatically create a link while scheduling the forum content. For more information on scheduling, see Schedule the delivery of HR content.
• Use the link for campaigns, emails, or on the Employee Service Center.
• The Content Delivery: Post to Forums scheduled job runs every hour by default to process posts. For more information on scheduled jobs, see Scheduled jobs.

Procedure
1. Navigate to Content Delivery > Manage Content > Community Content.
2. On the form, fill in the fields.

Community Content form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title or name that identifies the community post.</td>
</tr>
<tr>
<td>Content type</td>
<td>Classification of the community post. Fields used to define the post change based on the content type selection.</td>
</tr>
</tbody>
</table>
Fields change depending on which content type you select.

**Community Blog**

**Community Blog fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use block content</td>
<td>Indicates that you are using block content and not rich text. For information on creating block content, see Add or modify block content.</td>
</tr>
<tr>
<td>Block content</td>
<td>Appears when you check the <strong>Use block content</strong> box. Click to access existing block content or to create content for your community blog.</td>
</tr>
<tr>
<td>Description</td>
<td>Appears when the <strong>Use block content</strong> box is unchecked. Enter rich text for your community blog.</td>
</tr>
</tbody>
</table>

**Community Event**

If you select **Virtual event**, the fields are different.

**Community Event fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show attendee list</td>
<td>Indicates that attendees can view a list of other attendees.</td>
</tr>
<tr>
<td>Attendee limit</td>
<td>Determines the maximum number of attendees that can attend the event.</td>
</tr>
<tr>
<td>Virtual event</td>
<td>Indicates that event is online. When checked, the Event URL, Start time, and End time fields appear.</td>
</tr>
<tr>
<td>Event URL</td>
<td>The URL link to the virtual meeting.</td>
</tr>
</tbody>
</table>

---

**Note:** For more information on community content types, see Community content types.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The date and time the virtual event begins.</td>
</tr>
<tr>
<td>End time</td>
<td>The date and time the virtual event ends.</td>
</tr>
<tr>
<td>Location name</td>
<td>The name or description of the event location.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the event location.</td>
</tr>
<tr>
<td>City</td>
<td>The city of the event location.</td>
</tr>
<tr>
<td>Zip / postal code</td>
<td>The zip or postal code of the event location.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone of the event location. Used to determine the event scheduling and reminder.</td>
</tr>
<tr>
<td>Event reminder</td>
<td>Indicates when you want an event reminder sent.</td>
</tr>
<tr>
<td>State / province</td>
<td>The state or province of the event location.</td>
</tr>
<tr>
<td>Country</td>
<td>The country of the event location.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the event.</td>
</tr>
</tbody>
</table>

**Community Video**

**Community Video fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Video | Link to the video you want to post to your community, use as part of a campaign, or post to the Employee Service Center. Videos appear as web URLs that link to popular video sites. Supported video link hosts are:  
  - dailymotion.com  
  - facebook.com  
  - vimeo.com  
  - youtube.com  
  For more information on video content, see Add or modify links to other content sources. |
| Description | Description of the video. |
Forums Post List fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List type</td>
<td>How you want the posts from a forum to appear on the Employee Service Center.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic List: Automatically generated list.</td>
</tr>
<tr>
<td>Forum links</td>
<td>Determines what forum links you want to appear on the Employee Service Center.</td>
</tr>
<tr>
<td></td>
<td>Appears when you select <strong>Manual List</strong> from <strong>List type</strong>.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Unlock forum links</strong> icon and select the links you want to appear.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> The first forum link you select appears first on the Employee Service Center.</td>
</tr>
<tr>
<td>Dynamic list type</td>
<td>The method your posts appear in the forum list.</td>
</tr>
<tr>
<td></td>
<td>• Recently Added: The most recently added forum posts appear.</td>
</tr>
<tr>
<td></td>
<td>• Most Popular: Forum posts that</td>
</tr>
<tr>
<td></td>
<td>Appears when you select <strong>Dynamic</strong> in <strong>List type</strong>.</td>
</tr>
<tr>
<td>Number of list items</td>
<td>The number of forum posts you want to appear.</td>
</tr>
<tr>
<td></td>
<td>Only appears when you select <strong>Most Popular</strong> from <strong>Dynamic list type</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Save** to save and remain on the form, or click **Update** to save and return to the Community Content list.

Results
Go to Schedule Content to define the audience, date, and time your content is available. For more information, see **Schedule the delivery of HR content**. Or, go to Campaign Content to add your content to a campaign bundle. For more information, see **Create campaign bundles**.

Campaigns for HR Service Delivery
Keeping your organization up-to-date and informed is essential and challenging. With Content Automation, you can package your content into a campaign using multiple channels to deliver the right message to the right audience at the right time.

What your campaign is trying to accomplish determines how you set up campaigns. Is your campaign trying to:
• Deflect: For example, you are trying to prevent your employees from creating more Inquiry cases.
• Drive action: For example, you are trying to drive your employees to sign up for health benefits.
• Provide communication: You are trying to ensure that your employees know about a specific subject and not trying to deflect or drive action.

You can also determine how successful your campaign is. You can use historical data or create a base to compare and contrast the success of the campaign.

Features

There are many features you can use targeted content for:
• Use HR criteria and flexible time windows to reduce irrelevant communications.
• Improve employee engagement.
• Reduce reliance on email.
• Improve employee experience and deflect cases by pushing content.

Campaign structure

Campaigns are organized into a hierarchical structure for maximum flexibility.

For example:
• You can create a campaign that targets all employees to sign up for company benefits during the open enrollment period.
  ◦ This campaign has multiple campaign bundles/stages.
  ◦ This campaign has a target audience of all employees.
• You can have multiple campaign bundles/stages within the campaign.
  ◦ Each campaign bundle/stage has a trigger type indicating when each launch.
  ◦ Each campaign bundle/stage has a duration defining how long each is scheduled to run.
  ◦ Each campaign bundle/stage can have multiple types of content.
• You can create multiple types of content.
  ◦ Campaign content is information being directed to your audience.
  ◦ Campaign content can be email, videos, banners on the service portal, webinars, links to training, links to information, and much more.
  ◦ You can refine the audience so that only specific employees see the content within the campaign. For example, you can target managers with content that is different from content sent to their direct reports.
You can define where the content is to be placed on the service portal.

You can define the start and end dates of the content within the overall campaign dates.

**Activate Content Automation**

You can activate the Content Automation plugin (com.sn_content_automation) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Content Automation plugin (com.sn_content_automation) activates these related plugins if they are not already active.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Related information**

List of plugins (Madrid)

**Components installed with Content Automation**

Several types of components install with the activation of the Content Automation [com.sn_content_automation] plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Note:** The Content Automation [com.sn_content_automation] plugin activates the sn_ca.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Content Automation admin user by requiring a minimum number (default is two) of active users with this role.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Approver [sn_ca.campaign_approver]</td>
<td>When configured, can approve content for a</td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Content Automation Admin [sn_ca.campaign_admin]</td>
<td>Grants access to all Content Automation information and privileges. Can create, configure, administer, and schedule campaigns. Can access read and write records to the content automation tables. Can use an analytics tracking profile with a campaign. <strong>Note:</strong> Does not inherit Content Delivery Analytics Admin [sn_cda.analytics_admin] role to set up tracking profiles.</td>
<td>Content Automation Manager [sn_ca.campaign_manager]</td>
</tr>
<tr>
<td>Content Automation Manager [sn_ca.campaign_manager]</td>
<td>Can read and write records to the content automation tables.</td>
<td>• Campaign Approver [sn_ca.campaign_approver]</td>
</tr>
</tbody>
</table>

### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Automation: Add Non-Portal Campaign Content</td>
<td>Creates sn_ca_campaign_item_user_records for sent emails. It does not send the email. Runs every four hours by default.</td>
</tr>
<tr>
<td>Content Automation: Calculate Campaign Engagements</td>
<td>Calculates the total number of actionable engagements (videos viewed, links clicked) recorded divided by the total number possible with an engagement percentage. Runs on a designated repeating interval.</td>
</tr>
<tr>
<td>Content Automation: Create To-dos</td>
<td>Creates to-do tasks for assigned audience for a campaign. Runs every hour by default.</td>
</tr>
<tr>
<td>Content Automation: Deactivate Campaign Users</td>
<td>Deactivates users assigned to a campaign that has ended. Runs every six hours by default.</td>
</tr>
</tbody>
</table>
| Content Automation: Evaluate Campaign Success Goals | Populates the base count and evaluation period count. Runs the evaluation criteria set up for a campaign. Takes the success goals from published or finished (end date has passed) campaigns and evaluates them to calculate the:  
  - Baseline count  
  - Target count  
  - Evaluation count |
<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scheduled job</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Scheduled job</strong></td>
<td>Evaluation count analyzed against the Target count to determine success. Runs daily.</td>
</tr>
<tr>
<td>Content Automation: Manage Content States</td>
<td>Updates the state of targeted content and marks content as available or expired. For example:</td>
</tr>
<tr>
<td></td>
<td>• A Targeted Content record is available starting on 12-01-2019.</td>
</tr>
<tr>
<td></td>
<td>• Today is 11-27-2019.</td>
</tr>
<tr>
<td></td>
<td>• When 12-01-2019 arrives, the state of the targeted content changes from Pending to Ready or Available.</td>
</tr>
<tr>
<td></td>
<td>• If the same content is only available until 12-05-2019 and the date is 12-06-2019, the state of the targeted content changes to Complete or Incomplete.</td>
</tr>
<tr>
<td></td>
<td>Runs every hour and five minutes by default.</td>
</tr>
<tr>
<td>Content Automation: Manage Content States</td>
<td>Updates the state of targeted content and marks content as available or expired. For example:</td>
</tr>
<tr>
<td></td>
<td>• A Targeted Content record is available starting on 12-01-2019.</td>
</tr>
<tr>
<td></td>
<td>• Today is 11-27-2019.</td>
</tr>
<tr>
<td></td>
<td>• When 12-01-2019 arrives, the state of the targeted content changes from Pending to Ready or Available.</td>
</tr>
<tr>
<td></td>
<td>• If the same content is only available until 12-05-2019 and the date is 12-06-2019, the state of the targeted content changes to Complete or Incomplete.</td>
</tr>
<tr>
<td></td>
<td>Runs every hour and five minutes by default.</td>
</tr>
<tr>
<td>Content Automation: Manage Content States</td>
<td>Updates the state of targeted content and marks content as available or expired. For example:</td>
</tr>
<tr>
<td></td>
<td>• A Targeted Content record is available starting on 12-01-2019.</td>
</tr>
<tr>
<td></td>
<td>• Today is 11-27-2019.</td>
</tr>
<tr>
<td></td>
<td>• When 12-01-2019 arrives, the state of the targeted content changes from Pending to Ready or Available.</td>
</tr>
<tr>
<td></td>
<td>• If the same content is only available until 12-05-2019 and the date is 12-06-2019, the state of the targeted content changes to Complete or Incomplete.</td>
</tr>
<tr>
<td></td>
<td>Runs every hour and five minutes by default.</td>
</tr>
<tr>
<td>Content Automation: Process SNC analytics</td>
<td>Processes analytics captured using a ServiceNow tracker to update campaign statistics. Runs daily.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Available to use if the SNC tracking profile fails to upgrade and work with flow designer.</td>
</tr>
<tr>
<td>Content Automation: Purge Campaign Data</td>
<td>Purges campaigns and users based on the Content Automation Configurations Properties settings.</td>
</tr>
<tr>
<td></td>
<td>See the Purging section in <a href="#">Properties installed with content automation</a>.</td>
</tr>
<tr>
<td></td>
<td>Runs every hour by default.</td>
</tr>
<tr>
<td>Content Automation Profile</td>
<td>Works with the trigger associated with Content Automation Profile. Processes analytics collected by the Content Automation Profile tracker to update campaign statistics.</td>
</tr>
<tr>
<td></td>
<td>Runs daily.</td>
</tr>
<tr>
<td>Content Automation: Send Email Notifications</td>
<td>Sends the emails for a campaign. Runs every hour by default.</td>
</tr>
<tr>
<td>Content Automation: Send Email Notifications</td>
<td>Sends the emails for a campaign. Runs every hour by default.</td>
</tr>
<tr>
<td>Content Automation: Send SMS Notifications</td>
<td>Sends SMS notifications for a campaign. Runs on a designated repeating interval.</td>
</tr>
<tr>
<td>Content Automation: Update Campaign Audience</td>
<td>Reevaluates the audience for a campaign and removes employees that no longer satisfy the criteria. Adds users that match your defined criteria to the campaign. Users show up in the Campaign Targets related list for a campaign.</td>
</tr>
<tr>
<td></td>
<td>You can view the updated audience from the Campaign Targets tab of a campaign. See <a href="#">View campaign targets</a>.</td>
</tr>
<tr>
<td>Content Automation: Update Campaign Audience</td>
<td>Reevaluates the audience for a campaign and removes employees that no longer satisfy the criteria. Adds users that match your defined criteria to the campaign. Users show up in the Campaign Targets related list for a campaign.</td>
</tr>
<tr>
<td></td>
<td>You can view the updated audience from the Campaign Targets tab of a campaign. See <a href="#">View campaign targets</a>.</td>
</tr>
<tr>
<td></td>
<td>Runs daily by default.</td>
</tr>
</tbody>
</table>
**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign [sn_ca_campaign]</td>
<td>Defines high-level information about a campaign, including the to and from date range a campaign runs and the audience that can view it.</td>
</tr>
<tr>
<td>Campaign Bundle [sn_ca_campaign_bundle]</td>
<td>Grouping mechanism for items that have the same triggering mechanism and availability.</td>
</tr>
<tr>
<td>Campaign Content [sn_ca_campaign_item]</td>
<td>Campaign content associated with a bundle.</td>
</tr>
<tr>
<td>Targeted Content [sn_ca_campaign_item_user]</td>
<td>Campaign content available to the audience. After a campaign publishes and content is available, users appear under the Campaign Target tab of the campaign.</td>
</tr>
<tr>
<td>Campaign Target [sn_ca_campaign_user]</td>
<td>Who in your company is part of a campaign.</td>
</tr>
<tr>
<td>Creation Status [sn_ca_creation_status]</td>
<td>Tracks whether a campaign target has visited a particular widget instance that is part of the campaign.</td>
</tr>
</tbody>
</table>

**Campaign structure**

Use Content Automation and Content Delivery to create all aspects of a campaign. This process includes creating bundles of content that targets specific groups of employees, and triggers and spans specific dates and times.

**Planning**

Planning the details of your campaign ensures that the right content reaches the right employees at the right time. Things to consider:

- **Information that you want to communicate**
  
  Define the information, links, videos, SMS messages, and emails that you want to communicate to your employees. For example, the campaign for open enrollment of benefits, all new hires joining your company, upcoming training, or another subject related to your specific scenario.

- **Audiences**
  
  Target different content to different audiences. You can have a campaign deliver one set of content to managers and another set to direct reports.

- **When to communicate**
  
  Communication is available in fixed or dynamic date ranges that determine when to add employees to the campaign. For example, a new hire start date for orientation and training content.

**Set up a campaign**

- Create a campaign that includes the audience, start and end dates, campaign bundles, and campaign content.
- Create campaign content from Content Delivery. You can create content for your Employee Service Center or Service Portal, notifications, mobile, or to-dos.
- Create campaign bundles for a campaign that include the content you want to provide to your audience, trigger, and start and end dates.
• Refine the campaign audience at the bundle level. You can target a specific audience that is part of the overall campaign audience. For example, you can create specific content for managers and specific content for direct reports, all within the same campaign. This step is optional.

• Configure when to purge campaign data. Campaign data consists of campaign users, the targeted content, campaign, and campaign bundles.

• Analyze how effective your campaign is. Using analytics, you can verify that your campaign is targeting the correct audience. Create goals to see if your campaign is driving action from your employees, or reducing activity such as the number of inquiry cases coming in. Continually evaluate your campaign as it progresses.

Create a campaign using one of the following methods.

• **Overview** (legacy lists and forms)
• **Schedule of content** (campaign builder)

**Overview (legacy lists and forms)**

To use the **Overview** method, start by creating the details of a campaign. For more information, see [Create a campaign](#).

A campaign is a hierarchy that contains bundles, and each bundle contains content. Define the start and end date and time, as well as the intended audience.

**Campaign bundles**

The Campaign Bundles related list shows all bundles associated with a campaign.

For more information, see [Create campaign bundles](#).

**Campaign content**

The Campaign Content related list shows all content associated with a bundle.

Content is information that you want your employees to read or view. For example, a mass email and Employee Service Center announcement announcing that Open Enrollment for benefits is coming soon. Create content from Content Delivery and place it in a campaign bundle in Content Automation for a campaign.

There are several types of content available to create:

• Post information in Communities (employee forums)
• Notification content (emails)
• Portal content
• Create tasks or to-dos as part of a campaign to engage your audience and trigger action

For more information, see [Create content for a campaign](#).

**Campaign targets**

The Campaign Targets related list shows all employees scheduled to have campaign content directed to them.

Define the audience at the campaign level. Use campaign content to refine your audience.
For more information, see: Create a campaign and Create content for a campaign.

Schedule of content (campaign builder)

To use the Schedule of content method, start by creating the details of a campaign. For more information, see Create a campaign.

After you define a campaign, move campaign stages (bundles) and content using the drag-and-drop feature from the Content library column to your stages.

Campaign stages (bundles)

Campaign stages give you the flexibility to group multiple types of content and define how and when to deliver content to your audience.

Use information that you created in Manage Content to use in a campaign stage. For more information, see Create content for a campaign.

After you create content, move it to a campaign stage.

For more information, see Create campaign stages (bundles) using campaign builder.

Campaign content

When using campaign builder, you can find content under the Content library.

Use the drag-and-drop existing content to a stage.
For more information, see Create content using campaign builder.

### Campaign Schedule of content

To create content, select the accordion list icon ( ) next to a content type. A list of existing content appears.

Select **Create new**.

### Campaign Content library

**Audience**

Define the audience that you want your campaign to reach. For more information, see Create a campaign.

You can further refine your audience to include subsets. For example, if your audience includes all active users, you can refine your audience to include only active U.S. users. Refine your audience from the campaign content. See Create content using campaign builder.

Reevaluate an audience after a campaign starts.

- Evaluate your audience for a campaign on a schedule to ensure that your content is relevant. Dynamic trigger dates can cause content to be presented to an employee at the wrong time. For example, a new hire changes their start date after a campaign has started. The campaign may contain content that you don't want the employee to see until they actually start working.

- For more information, see Create a campaign.
Configure campaign purging and properties
After a campaign ends, decide when content is no longer available via Content Automation properties.
Depending on the size of your company, configure Content Automation properties to improve system performance. This step includes how many employees to add to a campaign, staggering events, event purging, and configuring scheduled jobs.

Publishing a campaign
For a campaign to launch, you must publish it. After you create all the parts of a campaign and are ready to make the content available, publish it. Publishing:
- Freezes the content, bundles, and audience.
- The Content Automation: Update Campaign Audience scheduled job runs. Users are added to the campaign based on the Audience criteria and conditions.
- The Content Automation: Add Non-Portal Campaign scheduled job runs. Notifications like email and SMS messages are sent to the audience.
- When a user visits the Employee Service Center or portal for campaign information, portal content records are created.
- During the campaign, if a user no longer matches the Audience criteria and conditions, the Content Automation: Update Campaign Audience scheduled job removes the user.

⚠️ Note: After you create your campaign, publish the campaign. Publishing before the campaign start date allows the scheduled jobs to add users to the campaign and create and schedule the content for the campaign. You can edit a published campaign, but users that have already been added prior to the edit can still access the content.

Publish with approvals
You can set up a campaign to require approval from one or multiple users assigned to a campaign prior to publishing. To require approvals:
- Approvers must have the Campaign Approver [sn_ca.campaign_approver] role. For more information, see Components installed with Content Automation.
- To require approval from all approvers, check Yes in the sn_ca.all_must_approve property. Check No to require only one approval. For more information, see Properties installed with content automation.
- Add approvers to a campaign. For more information, see Create a campaign.
- After adding approvers and selecting Update, the Publish with Approval button appears.
- After selecting Publish with Approval, approvers receive an email requesting their approval. Publication of the campaign requires approval.

Analyze the campaign for effectiveness
Determine if a campaign was successful by setting up criteria to measure the campaign objectives.
For more information, see Analyzing your campaign for effectiveness.
You can also:
- View the users assigned to the campaign. You can verify that the campaign targets the correct audience.
- Create campaign success goals to measure and determine the success of your campaign.
- View a progress bar that shows the progression towards the target of a campaign.
• View the base count and target count set for each success criteria.
• Continually reevaluate the audience for a campaign.
• Refine your audience at the campaign content level.

Create a campaign
Create a campaign to push communications to your employees.

Before you begin
Role required: sn_ca.campaign_manager or sn_cd.content_admin

About this task
Campaigns are organized in a hierarchical structure.
First, you create a campaign defining a title, state, audience, start and end times, and other information. For example, you can create a campaign that promotes open enrollment for health benefits, targeting new hires, and runs through the open enrollment period.

Procedure
1. Navigate to Content Automation > Campaigns.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique name for the campaign.</td>
</tr>
<tr>
<td>State</td>
<td>State of the campaign.</td>
</tr>
<tr>
<td></td>
<td>• Draft: The campaign is in the creation process. When content and bundles are attached to the campaign, the Publish button appears in the form header.</td>
</tr>
<tr>
<td></td>
<td>• Published: Activates all content for an audience.</td>
</tr>
<tr>
<td></td>
<td>• Editing: You’ve temporarily stopped the campaign to make edits.</td>
</tr>
<tr>
<td>Note:</td>
<td>The campaign must be in the Published state to launch, based on the start time. Scheduled jobs and properties affect the launch of a campaign.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Components installed with Content Automation and Properties installed with content automation.</td>
</tr>
<tr>
<td>Audience</td>
<td>Audience that will view the content of a campaign. Navigate to Manage Audiences.</td>
</tr>
</tbody>
</table>

This field is automatically set to Draft.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Click the Unlock Audience icon (🔒)</td>
<td>to select the audience that you want the campaign to target. For more information, see Configure an audience record.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>After a campaign is in the Published state, you cannot add users. To add new users to a published campaign, click the Edit Campaign button. Or, go to the specific content of a campaign and use the <strong>Refine audience</strong> field. For more information, see Create content for a campaign.</td>
</tr>
<tr>
<td>Approvers</td>
<td>User responsible for approving the campaign. You require specific users to approve content before campaign publication. Only users with the Campaign Approver sn_ca.campaign_approver role appear after clicking the Lookup user list icon (🔍). After adding approvers, click <strong>Update</strong>. To send notifications to approvers, click <strong>Publish with Approval</strong>. Email notifies approvers that you require their approval. For more information, see Notifications and Email templates.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select Yes in the sn_ca.all_must_approve property, all approvers must approve before the campaign publishes. If you select No, only one approver is required.</td>
</tr>
<tr>
<td>Start time (yyy-MM-dd HH:mm:ss)</td>
<td>The date and time that a campaign should launch. <strong>Note:</strong> To publish a campaign, you must define the start date and time.</td>
</tr>
<tr>
<td>End time (yyy-MM-dd HH:mm:ss)</td>
<td>The date and time that a campaign should end.</td>
</tr>
</tbody>
</table>
| Re-evaluate campaign | Option for reviewing the audience for a campaign. If the box is unchecked, the Content Automation: Update Campaign Audience scheduled job runs one time after which the targeted audience is never re-evaluated or changed. Check the box to display the **Re-evaluate frequency** field so you can define how...
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>often you want the <strong>Content Automation: Update Campaign Audience</strong> scheduled job to run.</td>
</tr>
<tr>
<td></td>
<td>When your campaign is re-evaluated, it removes or adds users depending on the current audience criteria.</td>
</tr>
<tr>
<td>Re-evaluate frequency</td>
<td>The frequency, in days, that you want to re-evaluate the audience. Audiences are re-evaluated after the Content Experiences: Update Campaign Audience scheduled job runs based on the value you enter here.</td>
</tr>
<tr>
<td></td>
<td>This field appears only after you select the <strong>Re-evaluate campaign</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>This field allows you to override the default (7 days) value that is set in the <strong>Campaign Re-evaluation</strong> field in the Content Automation sys property. For more information, see Properties installed with content automation.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the campaign.</td>
</tr>
<tr>
<td>Tracking on</td>
<td>Option for capturing analytics for your campaign.</td>
</tr>
<tr>
<td></td>
<td>For more information about campaign analytics, see Content Analytics measures employee engagement.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when a tracking profile is selected from the <strong>Tracking profile</strong> field.</td>
</tr>
<tr>
<td>Tracking profile</td>
<td>Tracking profile to use for content automation analytics. Profiles determine what data to capture for campaign analytics.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon (🔍) and select the tracking profile that you want to use.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select **Save** to remain on the form, or click **Submit** or **Update** to return to the Campaigns list.

Next, click the **Overview** tab to create:

- Content for your campaign: For more information, see Create content for a campaign.
- Bundles or Stages for your campaign: For more information, see Create campaign bundles.

**What to do next**

Click **Clone Campaign** to copy the campaign, bundles or stages, and content.

Click **Next** to view the **Schedule of content** and access the **Content library**, stages, and content of the campaign.
After completing all parts of a campaign, click the **Publish** button.

Publishing a campaign prior to the start date enables the scheduled jobs to add users to the campaign and create and schedule the content for the campaign.

Campaign Targets show a list of users assigned to a campaign after the Content Automation: Update Campaign Audience scheduled job runs.

ℹ️ **Note:** The **Publish** button only appears when at least one bundle or stage with content is attached to the campaign, a title, and start time. Publishing activates all content for a selected audience and duration.

### Create content for a campaign

There are different places you can create content. You can create content from a campaign, bundle or stage, or directly from **Manage Content**.

**Before you begin**

Role required: sn_ca.campaign_manager, sn_cd.content_admin

**Procedure**

1. Navigate to **Content Automation > Manage Content**.
   
   You can also create content from:
   - The **Campaign Content** tab of a campaign
   - Select **Create new** from the content library column after selecting the . For more information, see [Create content using campaign builder](#).

2. Click **New**.
3. Select the **Lookup using list** icon next to Content. A list of content appears.

4. Select existing content or **New**.
5. Select the content type.

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Mobile Content        | Announcement banners you can send to your employee’s mobile devices. The banner can be an image that links to content of your Employee Service Center or Service Portal.  

**Note:** For information on creating mobile content, see Configure mobile content.

| Notification Content  | Information blast you send directly to your employees via email or push to their mobile devices.  

**Note:** For information on creating notification content, see Add or modify notification content. |
|-----------------------|-----------------------------------------------------------------------------|
| Portal Content        | Content that appears on your Employee Service Center or Service Portal.       

**Note:** For information on creating portal content, see Add or modify portal content. |
| To-do Content         | Content that assigns tasks to your employees and can be sent via email, SMS, or posted to your Employee Service Center or Service Portal. |
6. Click **Submit**.

7. Right-click the form header and select **Save** to remain on the form. Or, click **Submit** or **Update** and return to the list.

**What to do next**

Since you attached your content to a bundle or stage, you can launch your campaign by clicking **Publish** from the campaign. Publish only appears when at least one bundle with content is attached to the campaign, and the campaign has a title and a start time. Publishing activates all content for a selected audience and duration.

After the **Content Automation: Update Campaign Audience** schedule job runs, the **Campaign Targets** tab shows specific employees that are part of the refined audience for the campaign content.

Click **Edit Campaign** to pause the campaign and make edits to the content, audience, or duration.

Click **Cancel Campaign** to de-activate all undelivered content (including notifications) to a scheduled audience. You cannot reverse this step. Canceling a campaign that has already launched de-activates all undelivered content and you cannot restart it.

Click **Deactivate Content** to remove the content from a campaign. The content does not appear for users who have not yet viewed it.

**Create content using campaign builder**

Create or place content into a bundle or stage for a campaign using campaign builder. The Content library holds existing content and is organized by content type.

**Before you begin**

Role required: sn_ca.campaign_manager or sn_cd.content_admin

**Procedure**

1. Navigate to **Content Automation > Campaigns**.
2. From a campaign, select the **Schedule of content** tab or click **Next**.

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> For information on creating to-do content, see <strong>Add or modify task (to-do) content</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
3. From the Content library, click the accordion icon (.expand) next to a content type. A list of existing content appears. You can either drag existing content into a stage, or click Create new.

4. The content type that you select from the Content library determines what appears.

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Notification Content</strong></td>
<td>Information blast that you send directly to your employees via email or push to their mobile devices.</td>
</tr>
<tr>
<td><strong>Portal Content</strong></td>
<td>Content that appears on your Employee Service Center or Service Portal.</td>
</tr>
<tr>
<td><strong>To-do Content</strong></td>
<td>Content that assigns tasks to your employees and can be sent via email, SMS, or posted to your Employee Service Center or Service Portal.</td>
</tr>
</tbody>
</table>

**Note:** For information on creating mobile content, see Configure mobile content.

**Note:** For information on creating notification content, see Add or modify notification content.

**Note:** For information on creating portal content, see Add or modify portal content.

**Note:** For information on creating to-do content, see Add or modify task (to-do) content.

5. After you create content, drag it into a stage.

6. Click **Update**.

### Create campaign bundles

Use campaign bundles to group your campaign content within a campaign. This process allows you to determine when the content is available to your employees and for how long.
Before you begin
Role required: sn_ca.campaign_manager, sn_cd.content_admin

Procedure
1. Navigate to Content Automation > Manage Campaign Bundles.
2. Click New or on an existing campaign bundle.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name of the campaign bundle.</td>
</tr>
<tr>
<td>Campaign</td>
<td>The campaign associated with the campaign bundle.</td>
</tr>
<tr>
<td>Trigger type</td>
<td>How the campaign bundle starts or ends.</td>
</tr>
<tr>
<td></td>
<td>• Immediate: The campaign bundle triggers immediately after campaign</td>
</tr>
<tr>
<td></td>
<td>publication and within the start and end date and time of the campaign.</td>
</tr>
<tr>
<td></td>
<td>Or the campaign bundle ends immediately after an employee clicks Complete</td>
</tr>
<tr>
<td></td>
<td>content.</td>
</tr>
<tr>
<td></td>
<td>◦ Offset trigger start: Select to indicate that you want content made</td>
</tr>
<tr>
<td></td>
<td>available before or after the campaign is published.</td>
</tr>
<tr>
<td></td>
<td>◦ Date offset quantity: The number of days, weeks, or months to offset the</td>
</tr>
<tr>
<td></td>
<td>trigger type. This field works with the next fields to determine when</td>
</tr>
<tr>
<td></td>
<td>content is available.</td>
</tr>
<tr>
<td></td>
<td>◦ Date offset units: Units of time to offset the trigger type.</td>
</tr>
<tr>
<td></td>
<td>◦ Date offset type: When the trigger type provides content.</td>
</tr>
<tr>
<td></td>
<td>◦ Specify end: Select to indicate content availability ends after a specific</td>
</tr>
<tr>
<td></td>
<td>amount of time.</td>
</tr>
<tr>
<td></td>
<td>◦ Duration type: Defines when content is no longer available. Select Time</td>
</tr>
<tr>
<td></td>
<td>Length to end content after a specific number of days or hours. Or, you can</td>
</tr>
<tr>
<td></td>
<td>select Dynamic field to use a trigger table and field to determine when</td>
</tr>
<tr>
<td></td>
<td>content is no longer available. An example is to end content based on an</td>
</tr>
<tr>
<td></td>
<td>employee's HR profile and start date.</td>
</tr>
<tr>
<td></td>
<td>◦ Offset trigger end: Appears when you select Dynamic field from the</td>
</tr>
<tr>
<td></td>
<td>Duration type field. Select to indicate you want</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>content to end days, weeks, or months before or after the trigger field end value.</td>
<td>• Fixed date: The campaign bundle triggers according to a specific start and end date and time and within the start and end date and time of the campaign.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic: The campaign bundle triggers based on a trigger table (sn_hr_core_profile or sys_user), trigger field, and date offsets. For example, if you want the bundle to trigger two weeks before an employee start date. Enter:</td>
</tr>
<tr>
<td></td>
<td>◦ Trigger table: HR Profile</td>
</tr>
<tr>
<td></td>
<td>◦ Trigger field: Employment start date</td>
</tr>
<tr>
<td></td>
<td>◦ Offset trigger start: Checked or True.</td>
</tr>
<tr>
<td></td>
<td>◦ Date offset type: Before.</td>
</tr>
<tr>
<td></td>
<td>◦ Date offset units: Weeks.</td>
</tr>
<tr>
<td></td>
<td>◦ Date offset quantity: 2.</td>
</tr>
<tr>
<td></td>
<td>◦ Specify duration: When checked, indicates the number of days, hours, minutes, or seconds that the content is available.</td>
</tr>
<tr>
<td></td>
<td>• To-do Completion: Completes the campaign bundle when a user completes the trigger item.</td>
</tr>
<tr>
<td></td>
<td>• Condition: This trigger type is specifically for Employee Journeys: Parental Leave of Absence. You can use it for your process, but it is an advanced feature that requires building a triggering mechanism, like a business rule or scripting to work. For more information, see Business rules and Scripts.</td>
</tr>
<tr>
<td></td>
<td>* Note: Creating scripts or business rules requires the admin role. For more information, see Manage HR roles and Base system roles.</td>
</tr>
<tr>
<td></td>
<td>The campaign must be in the Published state to launch based on the start time. Scheduled jobs and properties affect when and how a campaign launches.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Components installed with Content Automation, Employee Experience Pack, and Properties installed with content automation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Trigger table end</td>
<td>The table used to calculate the campaign bundle end date. You can select a date field from the HR profile [sn_hr_core_profile] or User [sys_user] tables. This field appears after selecting <strong>Dynamic field</strong> from <strong>Duration type</strong>.</td>
</tr>
<tr>
<td>Trigger field end</td>
<td>The date field from the table selected in <strong>Trigger table end</strong> that defines the campaign bundle end date.</td>
</tr>
<tr>
<td>Offset trigger end</td>
<td>Field that enables you to move the end date forward or backward from the value in the <strong>Trigger type</strong> field.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Offset</strong>, <strong>Offset time unit</strong>, and <strong>Offset length</strong> fields all work in the same way as the <strong>Offset trigger start</strong> field.</td>
</tr>
</tbody>
</table>

Depending on what you select from the **Trigger type** field determines what fields appear in the Details section.

**Trigger type: Immediate**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset trigger start</td>
<td>Enables you to move the start date forward or backward from the value in the <strong>Trigger type</strong> field.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>When using the <strong>Offset trigger start</strong> and <strong>Date offset units</strong>, the number of units to offset.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>When using the <strong>Offset trigger start</strong> and <strong>Date offset quantity</strong>, how you want to measure the offset. Your choices are days, weeks, or months.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Determines when to trigger the bundle content.</td>
</tr>
<tr>
<td></td>
<td>Appears when you check the <strong>Offset trigger start</strong>.</td>
</tr>
<tr>
<td>Specify end</td>
<td>Indicates if you want the campaign bundle to have a specific end.</td>
</tr>
<tr>
<td>Duration type</td>
<td>Defines how long the campaign bundle is active. You can specify a duration or define a duration using a combination of fields from the HR profile [sn_hr_core_profile] or User [sys_user] tables and triggers.</td>
</tr>
<tr>
<td></td>
<td>Appears when you check <strong>Specify end</strong>.</td>
</tr>
<tr>
<td>Item duration</td>
<td>The length of end time for the campaign bundle. Appears when you select <strong>Time Length</strong> from the <strong>Duration type</strong> field.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the campaign bundle.</td>
</tr>
</tbody>
</table>

### Fixed Date

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The start time and date the campaign bundle starts.</td>
</tr>
<tr>
<td>End time</td>
<td>The end time and date the campaign bundle ends.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the campaign bundle.</td>
</tr>
</tbody>
</table>

### Dynamic

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| Trigger table | Table to provide the trigger field that defines when you want content from your campaign bundle to be available. You can use:  
- HR profile (sn_hr_core_profile)  
- User (sys_user)  |

**Note:** (HR Profile requires that you license and activate HR Service Delivery.) |
<p>| Trigger field | Field from the selected table you want the trigger to key on. |
| Offset trigger start | Indicates that you want the trigger to start after or before a defined number of days, weeks, or months from the trigger field you selected. |
| Date offset quantity | The number of date offset units (days, weeks, or months) the trigger date should occur. |
| Date offset units | The unit of time (days, weeks, or months) the date offset type should trigger. |
| Date offset type | Indicates if the trigger date should be before or after what you select in the trigger field. |
| Specify end | Indicates that you want to define an end date for your campaign bundle. |
| Duration type | How long you want the content from your campaign bundle to be available. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Time Length:</td>
<td>You can select a specific number of days and hours the content from the campaign bundle is available.</td>
</tr>
<tr>
<td>• Dynamic field:</td>
<td>Your content from the campaign bundle is available based on the HR profile or User tables and a field found on the selected table.</td>
</tr>
<tr>
<td>Item duration</td>
<td>The number of days and hours content from your campaign bundle is available to your users. Appears when you select Time Length from Duration type.</td>
</tr>
<tr>
<td>Trigger table end</td>
<td>Table to provide the trigger field that defines when you want content from your campaign bundle to stop. You can use:</td>
</tr>
<tr>
<td></td>
<td>• HR profile (sn_hr_core_profile)</td>
</tr>
<tr>
<td></td>
<td>• User (sys_user)</td>
</tr>
<tr>
<td>Note:</td>
<td>(HR Profile requires that you activate and license HR Service Delivery.)</td>
</tr>
<tr>
<td>Trigger field end</td>
<td>Field from the selected table you want the trigger to key on.</td>
</tr>
<tr>
<td>Offset trigger end</td>
<td>Indicates that you want the content from your campaign bundle to end after or before a defined number of days, weeks, or months from the current date.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>The number of days, weeks, or months that defines your offset units.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>Do you want your offset date to be based on days, weeks, or months.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Do you want your offset to be before or after the trigger field you selected.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the campaign bundle.</td>
</tr>
</tbody>
</table>

**To-do Completion**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger item</td>
<td>The item (content) that you require a user to complete when the Trigger type is To-do Completion. The item must be a To-do Content. See Add or modify task (to-do) content.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Close other content</strong></td>
<td>Closes all remaining content in a campaign after a user completes the trigger item (to-do content). Any remaining content in the current bundle and other bundles are not visible to the audience.</td>
</tr>
<tr>
<td><strong>Date offset quantity</strong></td>
<td>The number of date offset units (days, weeks, or months) the trigger date should occur.</td>
</tr>
<tr>
<td><strong>Date offset units</strong></td>
<td>The unit of time (days, weeks, or months) the date offset type should trigger.</td>
</tr>
<tr>
<td><strong>Date offset type</strong></td>
<td>Indicates if the trigger date should be before or after what you select in the trigger field.</td>
</tr>
<tr>
<td><strong>Specify end</strong></td>
<td>Indicates that you want to define an end date for your campaign bundle.</td>
</tr>
<tr>
<td><strong>Duration type</strong></td>
<td>How long you want the content from your campaign bundle to be available.</td>
</tr>
<tr>
<td></td>
<td>• Time Length: You can select a specific number of days and hours the content from the campaign bundle is available.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic field: Your content from the campaign bundle is available based on the HR profile or User tables and a field found on the selected table.</td>
</tr>
<tr>
<td><strong>Item duration</strong></td>
<td>The number of days and hours content from your campaign bundle is available to your users. Appears when you select Time Length from <strong>Duration type</strong>.</td>
</tr>
<tr>
<td><strong>Trigger table end</strong></td>
<td>Table to provide the trigger field that defines when you want content from your campaign bundle to stop. You can use:</td>
</tr>
</tbody>
</table>

**Note:** When you check **End campaign on completion** on the content (trigger item), you remove the user from the campaign. See Create content for a campaign.

**Note:** If you have more than one bundle with this field checked in a campaign, the last bundle to trigger becomes the end bundle. If all bundles have this field checked, the last bundle to trigger is the end bundle.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR profile</td>
<td>• HR profile (sn_hr_core_profile)</td>
</tr>
<tr>
<td></td>
<td>• User (sys_user)</td>
</tr>
<tr>
<td>Note:</td>
<td>(HR Profile requires that you license and activate HR Service Delivery.)</td>
</tr>
<tr>
<td>Trigger field end</td>
<td>Field from the selected table you want the trigger to key on.</td>
</tr>
<tr>
<td>Offset trigger end</td>
<td>Indicates that you want the content from your campaign bundle to end after or before a defined number of days, weeks, or months from the current date.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>The number of days, weeks, or months that defines your offset units.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>Do you want your offset date to be based on days, weeks, or months.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Do you want your offset to be before or after the trigger field you selected.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the campaign bundle.</td>
</tr>
</tbody>
</table>

**Condition**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition table</td>
<td>The table you want to use to create condition triggers for your campaign bundle.</td>
</tr>
<tr>
<td>User field</td>
<td>The fields from the table you selected that you want to create a condition that triggers your campaign bundle.</td>
</tr>
<tr>
<td>Start condition</td>
<td>Filter conditions based on the table and field you select for when you want the campaign bundle to trigger.</td>
</tr>
<tr>
<td>Stop condition</td>
<td>Filter conditions based on the table and field you select for when you want the campaign bundle to stop.</td>
</tr>
<tr>
<td>Offset trigger start</td>
<td>Indicates that you want the trigger to start after or before a defined number of days, weeks, or months from the trigger field you selected.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>The number of date offset units (days, weeks, or months) the trigger date should occur.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>The unit of time (days, weeks, or months) the date offset type should trigger.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Indicates if the trigger date should be before or after what you select in the trigger field.</td>
</tr>
<tr>
<td>Specify end</td>
<td>Indicates that you want to define an end date for your campaign bundle.</td>
</tr>
<tr>
<td>Duration type</td>
<td>How long you want the content from your campaign bundle to be available.</td>
</tr>
<tr>
<td></td>
<td>• Time Length: You can select a specific number of days and hours the content from the campaign bundle is available.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic field: Your content from the campaign bundle is available based on the HR profile or User tables and a field found on the selected table.</td>
</tr>
<tr>
<td>Trigger table end</td>
<td>Table to provide the trigger field that defines when you want content from your campaign bundle to stop. You can use:</td>
</tr>
<tr>
<td></td>
<td>• HR profile (sn_hr_core_profile)</td>
</tr>
<tr>
<td></td>
<td>• User (sys_user)</td>
</tr>
<tr>
<td>Note: HR Profile requires activation and license for HR Service Delivery.</td>
<td></td>
</tr>
<tr>
<td>Trigger field end</td>
<td>The number of days and hours content from your campaign bundle is available to your users. Appears when you select Time Length from Duration type.</td>
</tr>
<tr>
<td>Offset trigger end</td>
<td>Field from the selected table you want the trigger to key on.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>Indicates that you want the content from your campaign bundle to end after or before a defined number of days, weeks, or months from the current date.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>The number of days, weeks, or months that defines your offset units.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information about the campaign bundle.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and select **Save** to remain on the Campaign Bundle form. Or, click **Submit** or **Update** and return to the Campaign list.

**What to do next**

When a campaign is in the Edit state, you can edit the campaign bundles. You can also click **Deactivate Bundle** to remove the bundle from the campaign. Deactivating removes the content from the campaign, but remains viewable for existing users.

When a campaign is in the **Editing** state, you can also add new campaign bundles and campaign content for matching audiences.
Create campaign stages (bundles) using campaign builder

Use campaign builder to create stages for your campaign. Campaign builder provides a simple, single-page view for managing content and assembling your campaign.

Before you begin
Role required: sn_ca.campaign_manager or sn_cd.content_admin

About this task
You can drag your content into a stage for your campaign.

When using campaign builder, you see the term stages. When using the legacy forms and lists version, you see the bundles. Stages and bundles are the same, containers for campaign content. Stages are a visible area to add content.

Procedure
1. Navigate to Content Automation > Campaigns.
2. From a campaign, click Schedule of content.
3. Click Create stage.
   A stage is a visible area to add content.

The Campaign Bundle form appears.
4. On the form, fill in the fields.

### Campaign Bundle form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name of the campaign bundle.</td>
</tr>
<tr>
<td>Campaign</td>
<td>The campaign associated with the campaign bundle.</td>
</tr>
<tr>
<td>Trigger type</td>
<td>How the campaign bundle starts or ends.</td>
</tr>
</tbody>
</table>

- **Immediate**: The campaign bundle triggers immediately after campaign publication and within the start and end date and time of the campaign. Or the campaign bundle ends immediately after an employee clicks **Complete content**.
- **Offset trigger start**: Select to indicate that you want content made available before or after the campaign is published.
- **Date offset quantity**: The number of days, weeks, or months to offset the trigger type. This field works with the next fields to determine when content is available.
- **Date offset units**: Units of time to offset the trigger type.
- **Date offset type**: When the trigger type provides content.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>◦ Specify end</td>
<td>Select to indicate content availability ends after a specific amount of time.</td>
</tr>
<tr>
<td>◦ Duration type</td>
<td>Defines when content is no longer available. Select <strong>Time Length</strong> to end content after a specific number of days or hours. Or, you can select <strong>Dynamic field</strong> to use a trigger table and field to determine when content is no longer available. An example is to end content based on an employee's HR profile and start date.</td>
</tr>
<tr>
<td>◦ Offset trigger end</td>
<td>Appears when you select <strong>Dynamic field</strong> from the <strong>Duration type</strong> field. Select to indicate you want content to end days, weeks, or months before or after the trigger field end value.</td>
</tr>
<tr>
<td>◦ Fixed date</td>
<td>The campaign bundle triggers according to a specific start and end date and time and within the start and end date and time of the campaign.</td>
</tr>
<tr>
<td>◦ Dynamic</td>
<td>The campaign bundle triggers based on a trigger table (sn_hr_core_profile or sys_user), trigger field, and date offsets. For example, if you want the bundle to trigger two weeks before an employee start date. Enter:</td>
</tr>
<tr>
<td>◦ Trigger table: HR Profile</td>
<td></td>
</tr>
<tr>
<td>◦ Trigger field: Employment start date</td>
<td></td>
</tr>
<tr>
<td>◦ Offset trigger start: Checked or True.</td>
<td></td>
</tr>
<tr>
<td>◦ Date offset type: Before.</td>
<td></td>
</tr>
<tr>
<td>◦ Date offset units: Weeks.</td>
<td></td>
</tr>
<tr>
<td>◦ Date offset quantity: 2.</td>
<td></td>
</tr>
<tr>
<td>◦ Specify duration: When checked, indicates the number of days, hours, minutes, or seconds that the content is available.</td>
<td></td>
</tr>
<tr>
<td>◦ To-do Completion</td>
<td>Completes the campaign bundle when a user completes the trigger item.</td>
</tr>
<tr>
<td>◦ Condition</td>
<td>This trigger type is specifically for Employee Journeys: Parental Leave of Absence. You can use it for your process, but it is an advanced feature that requires building a triggering mechanism, like a business rule or scripting to work. For more information, see <strong>Business rules</strong> and <strong>Scripts</strong>.</td>
</tr>
</tbody>
</table>
Trigger table end

The table used to calculate the campaign bundle end date. You can select a date field from the HR profile [sn_hr_core_profile] or User [sys_user] tables.

This field appears after selecting Dynamic field from Duration type.

Trigger field end

The date field from the table selected in Trigger table end that defines the campaign bundle end date.

Offset trigger end

Field that enables you to move the end date forward or backward from the value in the Trigger type field.

The Offset, Offset time unit, and Offset length fields all work in the same way as the Offset trigger start field.

5. Click Submit.

Edit, clone, and cancel a campaign

You can edit, clone, or cancel a published campaign.

Before you begin

Role required: sn_ca.campaign_manager, sn_cd.content_admin

About this task

Use the Clone Campaign related link to make a copy of the existing campaign. A draft campaign creates with a (1) next to the campaign name and no start and end times. You can rename the campaign or change other parts of the new campaign. Content and user criteria clone, but users are not. The cloned campaign is in Draft state.

Procedure

1. Click Cancel Campaign to de-activate all undelivered content (including notifications) to a scheduled audience.

2. Click Edit Campaign to edit details of a published campaign.
Editing a campaign removes the publish state of a campaign. The campaign, campaign bundles, and campaign content are editable, but you cannot add new users during the editing state. Content not yet available suspends.

When a campaign is in the Editing state, you can also add new campaign bundles and campaign content for matching audiences.

Analyzing your campaign for effectiveness

Analyze your HR campaign to ensure that your messaging is effective and that you are targeting the correct audience when you use campaign success goals. You can also check your campaign’s progress and evaluate how successful your campaign is.

Because many factors can impact how effective a campaign is, define the factors that matter to your campaign. For example, you can configure the Content Automation: Update Campaign Audience scheduled job to continually reevaluate the audience for your campaign and remove employees that no longer satisfy the criteria that you define. With this process, you can develop campaign targets to help you verify if your intended audience is accurate.

You define an audience at the campaign level and refine that audience at the content level.

Once a campaign has at least one bundle/stage with content, you can publish it. See Create a campaign. Campaign targets appear after a campaign has been published and the Content Automation: Update Campaign Audience scheduled job runs.

Audience

You can define these factors to make your campaign more effective:

After a campaign starts, you can continually evaluate your audience and add or delete users that don’t fit your audience criteria and conditions. For more information, see Create a campaign.

For example, let’s say that you want to target new hires with a drip campaign that triggers on their first day and during their first 30 days. You can customize your campaign in these ways:

• Start a drip (sends pre-written set of messages over time) campaign that targets new hires.
• Target the new hires that start after the campaign is underway.
• Prevent employees with a later start date from receiving new hire information.

The audience that you assign to a campaign determines who sees your content. Your content can be delivered in different ways. It can be on your Employee Service Center or portal, or it can be sent via email or SMS to your intended audience. To learn more about targeting an audience, see Audiences.

To add or delete users based on your target audience for that campaign, you configure the Content Automation: Update Campaign Audience scheduled job. For more information, see Create a campaign.
Click the **Campaign Targets** tab to view the users that you are targeting for your campaign.

### Trigger type and dates

The bundles or stages of your campaign can start in different ways. The trigger type and offsets (optional) you select determines when the content for your bundle/stage is available to your employees. For more information, see Create campaign bundles or Create campaign stages (bundles) using campaign builder.

When a campaign starts and employees are added, you can reevaluate the trigger type and dates of a campaign bundle or stage. By continually reevaluating the trigger types and dates, you can ensure that the correct audience receives the correct campaign content.

For more information on trigger types and dates, see Create campaign bundles or Create campaign stages (bundles) using campaign builder.

### Campaign success goals

By using campaign success goals, you can determine if your campaign is driving employees to do something like enrolling in benefits. You can also determine if your campaign reduces the number of inquiry cases that your employees create. For more information on how to develop campaign success goals, see Campaign success goals for HR Service Delivery.
Click the **Campaign Success Goals** tab to view the progress of a campaign. Depending on the type of success goal that you create, you can see a progress chart under Drive action progress or Deflection progress.

You can also select the campaign success goal to view the record.

### View campaign targets

Use campaign targets to view a list of employees that your campaign has targeted, their status, and the date they were added.

### Before you begin

**Role required:** sn_ca.campaign_manager, sn_cd.content_admin

### Procedure

1. Navigate to **Content Automation > Campaigns**.
2. Select a published campaign.
   - The campaign target list appears with the date the user was added, the user, the campaign the user is assigned, and if the campaign is active.

### Campaign success goals for HR Service Delivery

Determine if your campaign meets your success goals. For example, you can see if your campaign drives your employees to enroll in benefits. Or, you can see if your campaign reduces the number of inquiry cases that your employees create.

You can design campaigns to teach your employees about organization offerings or task employees to do something.

As a campaign manager, you want to understand how effective your campaign is. You may also want to change the content of your campaign after you analyze the data. For example, let's say you create a campaign that provides information about benefits to your employees. Your goal is to drive your employees to sign up for the program. During the campaign, you
analyze the data to determine if your employees are creating fewer inquiry cases. If you aren't seeing the results that you expected, you can make modifications.

Here are some ways that you can analyze if your campaign is successful:

• Compare your campaign against a base count or a previous campaign within your organization. This way, you can measure how this campaign is doing.

  Note: The base count is the total number of cases created for the HR service.

• Learn if your campaign is successfully driving a specific type of action, like employees signing up for benefits. For example:
  ◦ You have 2,000 employees and 1,500 have already signed up for payroll direct deposit.
  ◦ You create a campaign that is directed at the 500 employees who have not signed up for payroll direct deposit yet.
  ◦ You create success goals to see how effective your campaign is.

• See if your campaign is successfully reducing a type of action. For example, you can create a campaign that provides videos, knowledge articles, and links to assist employees with a specific program. Your goal for this campaign may be to reduce the number of inquiry cases from your employees.

• View a progress chart to see if your campaign is reaching a specific goal.

• Set up multiple success goals to measure your campaign.

As you evaluate your campaign against the success goals that you define, you can add or remove content to improve the outcome.

Note: You can create campaign success goals only when the state of a campaign is in Draft or Editing. For more information, see Campaign success goals for HR Service Delivery.

Create campaign success goals
Create your own success goals to see how your campaign is progressing and learn how to use baselines to compare against your target goals.

Before you begin
Role required: sn_ca.campaign_manager, sn_cd.content_admin

Procedure
1. Navigate to Content Automation > Campaigns and select a campaign.
2. Click the Campaign Success Goals tab and select New.
3. On the form, fill in the fields.

Campaign Success Goals form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the success goal.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the success goal.</td>
</tr>
</tbody>
</table>

Note: The title and description help to identify how you are measuring the success of your campaign.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success Goal Type</td>
<td>How you want to create and calculate your campaign success goal.</td>
</tr>
<tr>
<td></td>
<td>• Deflection: You want your campaign to inform employees so the number of inquiry cases decreases.</td>
</tr>
<tr>
<td></td>
<td>• Drive action: You want your campaign to drive employees to create cases, like enrolling in health benefits.</td>
</tr>
<tr>
<td>Table</td>
<td>Provides field that the Success Goal Type uses to calculate from. You can use to create filter conditions to create specific success goals.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is not editable.</td>
</tr>
<tr>
<td>Case date field</td>
<td>Shows the field from the HR Case [sn_hr_core_case] table that the Success Goal Type uses to calculate on.</td>
</tr>
<tr>
<td></td>
<td>After the Content Automation: Evaluate Campaign Success Goals scheduled job runs, and the first active case that is related to the HR service is created, tracking starts for your success criteria. Use the filters to identify specific conditions you want to track.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is not editable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate this campaign success goal.</td>
</tr>
<tr>
<td>Filters</td>
<td>Filters that you use to determine your evaluation and target goals. For example, for a Drive Action type, you can set your filters to this condition:</td>
</tr>
<tr>
<td></td>
<td>• HR service</td>
</tr>
<tr>
<td></td>
<td>• is</td>
</tr>
<tr>
<td></td>
<td>• General Benefits Inquiry</td>
</tr>
<tr>
<td></td>
<td>After selecting your evaluation criteria and target, you can see the number of general benefits inquiry cases that were created and compare it to your target count.</td>
</tr>
</tbody>
</table>

4. Select the **Evaluation Criteria** tab.

**Campaign Success Criteria section fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation type</td>
<td>How you want to define your campaign data collection. You can select three types:</td>
</tr>
</tbody>
</table>
### Field Description

- **Target count only**: Use this type when you have no historical data to compare your campaign to. This type uses date ranges and a specific **Target value** (see Target tab) to determine campaign success.

- **Date range**: Use this type when you want to compare your campaign data to a past campaign.

- **Relative to campaign**: Use this type when you only want to compare success within the campaign and not compare it to historical data. For example, you can define the type to start 10 days before and after the campaign and view the activity. You can also specify a date that is related to a campaign like Created, Publish time, Updated, and others.

**Note**: The fields change based on the evaluation type that you select.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
</table>
| From date | Date that you want the evaluation period to start. The start date can be:  
- Before the campaign starts.  
- The start date of the campaign.  
- Any date after the campaign starts. |
| To date   | Date that you want the evaluation period to end. The end date can be:  
- After the campaign ends.  
- The date that the campaign ends.  
- Any date before the campaign ends. |

### Evaluation Criteria tab

5. From the **Evaluation type** field, select the **Date range**. On the Campaign Success Goal form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Evaluation date range: From date | Date that you want the evaluation period to start. The start date can be:  
- Before the campaign starts.  
- The date that the campaign starts.  
- Any date after the campaign starts. |
### Field | Definition
--- | ---
To date | Date that you want the evaluation period to end. The end date can be:  
• After the campaign ends.  
• The date the campaign ends.  
• Any date before the campaign ends.
Baseline date range | Date that you want the baseline period to start. Baseline dates are for past campaigns or any period you want to establish as your baseline to compare against your campaign data. The start date for your baseline can be:  
• Before the campaign starts.  
• The date the campaign starts.  
• Any date after the campaign starts.
Baseline date range  
From date | Date that you want the baseline period to end. The end date can be:  
• After the campaign ends.  
• The date that the campaign ends.  
• Any date before the campaign ends.

**Note:** Select the Calculate baseline related link to quickly see what your historical data is for the date ranges that you selected. If the calculation doesn’t show data, you can expand your date range.

---

6. From the **Evaluation type** field on the Campaign Success Goal form, select **Relative to campaign**. On the Campaign Success Goal form, fill in the fields.

### Evaluation Criteria tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date offset quantity</td>
<td>Number of days, weeks, or months that you want to collect campaign data before and after the value you select in the Campaign date field.</td>
</tr>
</tbody>
</table>
| Date offset units       | Unit of time measurement that you want to define as your period to evaluate campaign data. The values you can select are:  
• Days  
• Weeks  
• Months |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date offset type</td>
<td>Value that indicates the date offset quantity and units collect data before and after these values.</td>
</tr>
<tr>
<td>Campaign date field</td>
<td>Dates or times that are affiliated with a campaign that the evaluation period uses to collect data.</td>
</tr>
</tbody>
</table>

7. Select the **Target** tab. On the Campaign Success Goal form, fill in the fields.

### Target tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target value</td>
<td>Only appears when you select Target count only from the Evaluation type field. The number of cases deflected or created you target for your campaign.</td>
</tr>
<tr>
<td>Direction</td>
<td>Identifies the data based on the success goal type that you select. The values are:</td>
</tr>
<tr>
<td></td>
<td>• Maximize: Drive action</td>
</tr>
<tr>
<td></td>
<td>• Minimize: Deflection</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage of cases deflected or created that you target for your campaign.</td>
</tr>
</tbody>
</table>

8. Click **Submit** or **Update**.

After the Content Automation: Evaluate Campaign Success Goals scheduled job runs (daily by default), the base count and evaluation period count populates.

**Campaign preview**

When creating a campaign, you can preview the content prior to publishing it.

Being able to see how your content looks to your audience is crucial to ensuring you have correct messaging and visuals. Campaign preview provides:

• A way to verify that your campaign is error-free from a user, scheduling, and content perspective.

• A method to gain insight and an accurate view into your content and overall campaign.

• A means to preview a single piece of content, a stage, or a full portal view.

**Single content preview**

Single content preview provides a view of the following content types:

• Banner

• Calendar

• Event

• Rich text (styled content)
• URL
• Video
• Notification
  - Email
  - SMS
  - Push
• To-do (content shown as to-do in the service portal or ESC)
• Audience the content is targeted to
• Content type
• Stage details the content belongs to

⚠️ Note: Mobile (with exception to Push and SMS) and community content are not available for preview.

Stage preview
Stage preview provides a view into all content in a stage or bundle of a campaign.
You can also view a specific page (not just your home page if you are presenting content on multiple pages).

⚠️ Note: Also available in full portal preview.
Full portal preview
Full portal preview provides a view into all content that appears on your portal. There are filters you can use to view:

- A specific stage within your campaign
- Content targeting a specific audience
- A specific page (not just your home page if you are presenting content on multiple pages)

**Note:** Also available in stage preview.

Only pages with content are available for preview.

**Information tags**
When previewing your campaign content, a blue outline and information tags shows you what content on your portal is part of your campaign. It also shows additional
information about the content like a URL, and what stage the content is part
of.

ℹ️ Note: Previews can't be edited.

Content highlight
Content highlighted in blue is active and content highlighted in grey is inactive.

Campaign Preview property
If you have multiple service portals, use the sn_ca.campaign.preview.portal_url_suffix property to select the portal you want to render campaign previews. Navigate to Content Automation > Configurations > Properties to view this property.

Preview your portal
Use campaign preview to view the campaign content that appears on your portal.

Before you begin
Role required: sn_ca.campaign_manager

Procedure
1. Navigate to Content Automation > Campaigns.
2. Select a campaign.
3. Select the Portal Preview tab.

ℹ️ Note: You can also show a portal preview by selecting the show preview icon from the top of a stage.

4. Use Preview filters to determine what you preview.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a stage</td>
<td>The stage or campaign bundle you want to view.</td>
</tr>
<tr>
<td>Refine your audience</td>
<td>The targeted audience for the content in the selected stage.</td>
</tr>
<tr>
<td>Filter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Selecting an audience</td>
<td>Shows you what content that audience sees.</td>
</tr>
<tr>
<td>Select a page</td>
<td>The page you want to preview when the campaign has multiple pages.</td>
</tr>
<tr>
<td>i Note:</td>
<td>When any of these fields are read-only, the displayed value is the only available selection.</td>
</tr>
<tr>
<td>Show inactive content</td>
<td>Toggle switch to preview content in your campaign that is not currently active.</td>
</tr>
</tbody>
</table>

Content highlighted in blue is active and content highlighted in grey is inactive.

5. Exit **Preview filters** to view the portal.

   ![Note](icon.png)

   **Note:** Select the **View content details** icon to see additional details about the content.

**Preview single content**

Use the **Schedule of content** tab to view specific content or a stage in your campaign.

**Before you begin**

Role required: sn_ca.campaign_manager

**Procedure**

1. Navigate to **Content Automation > Campaigns**.
2. Select the **Schedule of content** tab.
3. Select the show preview icon (-eye) in the content you want to view.

   ![Email](image.png)

   **Email Blast for Open Enrollment**
   
   Active

4. Select the show preview icon (-eye) in a stage to preview all content for that stage.
5. Close the preview to return to the schedule of content view of the campaign.

**Note:** When the show preview icon is gray, a preview is not supported at this time.

**Content Delivery Starter Portal**

To get started faster, the Content Delivery base system includes a Starter Portal Setup and View Portal that provides links to the records directly within in each content widget. You can swap out content with your own to transform this portal into a true enterprise employee service center.

Demo Portal Setup helps you quickly configure your employee service center with content or campaign content to view before making it available to your employees.

**Configure the Delivery Starter Portal**

Use the Portal Setup to configure the Delivery Starter Portal. The Demo Portal provides links to the records directly within in each content widget.

**Before you begin**

Role required: admin

You can swap out content with your own to transform this portal into a true enterprise employee service center.

**Procedure**

1. Navigate to **Content Delivery > Content Delivery Starter Portal > Portal Setup**.
2. See **Set up Service Portal**.
3. If you do not use the Content Delivery Theme provided, you must define the CSS variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$sp-navbar-height</td>
<td>50px !default</td>
</tr>
<tr>
<td>$sp-navbar-inverse-bg</td>
<td>#3a3f51 !default</td>
</tr>
<tr>
<td>$navbar-inverse-bg</td>
<td>#3a3f51 !default</td>
</tr>
<tr>
<td>$navbar-inverse-link-color</td>
<td>#bdc0c4 !default</td>
</tr>
<tr>
<td>$navbar-inverse-link-hover-color</td>
<td>#ffffff !default</td>
</tr>
<tr>
<td>Variable</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>$sp-logo-margin-x</td>
<td>15px !default</td>
</tr>
<tr>
<td>$sp-tagline-color</td>
<td>$text-color !default</td>
</tr>
<tr>
<td>// Define Bod</td>
<td></td>
</tr>
<tr>
<td>$sp-body-bg</td>
<td>#f0f3f4 !default</td>
</tr>
<tr>
<td>$body-bg</td>
<td>#f0f3f4 !default</td>
</tr>
<tr>
<td>// Define SN Brand Colors</td>
<td></td>
</tr>
<tr>
<td>$color-darkest</td>
<td>#343D47</td>
</tr>
<tr>
<td>$color-darker</td>
<td>#485563</td>
</tr>
<tr>
<td>$color-dark</td>
<td>#81878E</td>
</tr>
<tr>
<td>$color-disabled</td>
<td>#a9a9a9</td>
</tr>
<tr>
<td>$color-light</td>
<td>#BDC0C4</td>
</tr>
<tr>
<td>$color-lighter</td>
<td>#E6E8EA</td>
</tr>
<tr>
<td>$color-lightest</td>
<td>#FFFFFF</td>
</tr>
<tr>
<td>$color-accent</td>
<td>#278EFC</td>
</tr>
<tr>
<td>$color-accent-light</td>
<td>#BDDCFC</td>
</tr>
<tr>
<td>$color-accent-lightest</td>
<td>#428bca</td>
</tr>
<tr>
<td>$color-blue-lightest</td>
<td>#dee5e7</td>
</tr>
<tr>
<td>$border</td>
<td>#e6e8ea</td>
</tr>
<tr>
<td>$panel-primary</td>
<td>$border</td>
</tr>
<tr>
<td>$primary</td>
<td>#428bca</td>
</tr>
<tr>
<td>$overdue</td>
<td>#F95050</td>
</tr>
<tr>
<td>$due-today</td>
<td>#FCC742</td>
</tr>
<tr>
<td>$due-later</td>
<td>#52DBA7</td>
</tr>
<tr>
<td>$complete</td>
<td>$border</td>
</tr>
<tr>
<td>$in-progress</td>
<td>$primary</td>
</tr>
<tr>
<td>$error</td>
<td>#9D0010</td>
</tr>
<tr>
<td>$danger</td>
<td>$error</td>
</tr>
</tbody>
</table>
4. Click **Submit** or **Update**.

**Customize your Content Delivery Starter Portal**

Quickly view and make changes to your Employee Service Center so that it best meets your needs using the View Portal feature.

**Before you begin**

Role required: sn_cd.campaign_manager

The quickest and easiest way to make changes is to go to the Content Delivery Starter Portal and click on links:

- **Button Text**: View Content
- **Important Link URL**
- **Demo Org Chart Link**
- **Suggested Reading URL**
- **Product Documentation URL**
- **Event1** or **Event2**

Clicking a link takes you to the Portal Content form to configure the content and look.

Also use the Content Delivery Starter Portal to view your configuration and layout to ensure that correct information appears.

**Procedure**

Navigate to **Content Delivery > Content Delivery Demo > Demo Portal**.

**Content Delivery and Content Automation widgets**

When activated, the Content Delivery [com.sn_content_delivery] and Content Automation [com.sn_content_automation] plugins install the following widgets.

<table>
<thead>
<tr>
<th>Widget</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announcements (CD)</td>
<td>cd-announcements</td>
<td>Shows portal content with content type of Rich Text. Generally, a brief broadcast message and shows in a carousel when there are multiple items.</td>
</tr>
<tr>
<td>Content Analytics Site Tracker</td>
<td>cda-site-analytics</td>
<td>See Set up Content Analytics tracking.</td>
</tr>
<tr>
<td>Content To-do (CD)</td>
<td>cd-content-todo</td>
<td>This widget is part of the HR to-do completion process used in the Employee Service Center, but cannot be used as a standalone widget.</td>
</tr>
</tbody>
</table>
### Content Delivery widgets (continued)

<table>
<thead>
<tr>
<th>Widget</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Calendar (CD)</td>
<td>cd-event-calendar</td>
<td>Shows portal content with content type of Calendar. Shows schedules.</td>
</tr>
<tr>
<td>Information Links (CD)</td>
<td>cd-information-links</td>
<td>Shows portal content with content type of URL. Shows hyperlinks.</td>
</tr>
<tr>
<td>Organization Chart (CD)</td>
<td>cd-orgchart</td>
<td>Shows an organization chart of an employee.</td>
</tr>
<tr>
<td>Preview Mobile Content (CD)</td>
<td>cd-preview-mobile-content</td>
<td>Notifications that show up in mobile view.</td>
</tr>
<tr>
<td>Preview of Content To-do (CD)</td>
<td>preview_content_todos</td>
<td>Shows a preview of to-do content.</td>
</tr>
<tr>
<td>Quick Links (CD)</td>
<td>cd-quick-links</td>
<td>Shows portal content with content type of Image-based Link. Shows a row of clickable images.</td>
</tr>
<tr>
<td>Styled Content (CD)</td>
<td>cd-styled-content</td>
<td>Shows portal content with content type of Styled Content. Shows informative banners or text. You can configure color, alignment, and other options for text and background. Appears as a carousel when there are multiple items.</td>
</tr>
<tr>
<td>Upcoming Events (CD)</td>
<td>cd-upcoming-events</td>
<td>Shows portal content with content type of Event. Shows upcoming events.</td>
</tr>
<tr>
<td>Video Carousel (CD)</td>
<td>cd-video-carousel</td>
<td>Shows portal content with content type of Video. Multiple items show in a carousel.</td>
</tr>
<tr>
<td>Welcome Banner (CD)</td>
<td>cd-banner</td>
<td>Shows portal content with content type of Banner. Generally used to show informative banners/text. Shows in a carousel when there are multiple items.</td>
</tr>
</tbody>
</table>

### Content Automation Widgets

<table>
<thead>
<tr>
<th>Widget</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Automation Header</td>
<td></td>
<td>The header for the Content Automation demo portal.</td>
</tr>
</tbody>
</table>
Properties installed with content automation

The Content Automation [com.sn_content_automation] plugin adds properties that determine how a campaign runs related to scheduled jobs and performance.

Scheduled Jobs

The following scheduled jobs work with properties to fine-tune and configure the behavior of Content Automation:

- Content Automation Profile
- Content Automation: Add Non-Portal Campaign Content
- Content Automation: Calculate Campaign Engagements
- Content Automation: Create To-dos
- Content Automation: Deactivate Campaign Users
- Content Automation: Evaluate Campaign Success Goals
- Content Automation: Manage Content States
- Content Automation: Process SNC analytics
- Content Automation: Purge Campaign Data
- Content Automation: Send Email Notifications
- Content Automation: Send SMS Notifications
- Content Automation: Update Campaign Audience

See Components installed with Content Automation.

Properties

To access Content Automation properties, navigate to Content Automation > Configurations > Properties.

Content Automation properties determine how the scheduled jobs run and help to ensure that there is limited impact on the performance of your instance.

Approvals

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ca.all_must_approve</td>
<td>Indicates that all approvers must approve any scheduled content prior to publishing it. If you check No, only one approver is required to publish a campaign.</td>
</tr>
</tbody>
</table>

Content Delegation/Restriction

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cd.activate_audience_delegation_controls</td>
<td>Indicates you want to be able to delegate audiences for a campaign.</td>
</tr>
<tr>
<td>sn_cd.activate_content_authoring_controls</td>
<td>Indicates you want to be able to restrict content items for a campaign.</td>
</tr>
</tbody>
</table>
### Add Users

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.add_users.max_run_time` | The maximum amount of time (in seconds) the Content Automation: Add users to Campaigns scheduled job runs. Limits the length of the scheduled job, but completes any work in progress and does not pick up any new work.  
  - **Default value**: 600 |

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.add_users.event_stagger.campaign` | The amount of time between campaign events when a scheduled job runs. Staggering provides time for the events to be processed during the staggered time.  
  - **Default value**: 300 seconds |

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.add_users.event_stagger.users` | The amount of time between campaign events to add users when a scheduled job runs. Staggering provides time for the events to be processed during the staggered time.  
  - **Default value**: 900 seconds |

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.add_users.max_events` | The maximum number of events that users can be added for a campaign.  
  - **Default value**: 100 |

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.add_users.max_users_per_event` | The maximum number of users you can add in a single event.  
  - **Default value**: 1000 |

### Non-Portal Content

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.campaign.max_run_time` | The maximum amount of time (in seconds) the Content Automation: Add Non-Portal Campaign Content scheduled job runs. Limits the length of the Content Automation: Send Email Notifications scheduled job, but completes any work in progress and does not pick up any new work.  
  The default is 300 seconds. |

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
</table>
| `sn_ca.campaign.max_records_process` | The maximum number of people a campaign can target per scheduled job run.  
  The default is 15,000. |

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_ca.campaign.max_records_create</code></td>
<td>The maximum number of records to create per job run.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_ca.campaign.pending.event_stagger</code></td>
<td>The number of seconds between each time the Content Automation: Add Non-Portal Campaign Content scheduled job runs to try to send non-portal content.</td>
</tr>
</tbody>
</table>
Non-Portal Content (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> These properties determine limits on non-portal content (emails and SMS). The Content Automation: Send Email Notifications scheduled job runs every hour by default and attempts to send non-portal content not sent in the first pass. Customers with a large database should consider increasing this property after testing the impact it could have on performance.</td>
<td></td>
</tr>
</tbody>
</table>

To-do Content

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ca.task.max_run_time</td>
<td>The maximum amount of time (in seconds) the Content Automation: Create To-dos scheduled job runs. Limits the length of the scheduled job, but completes any work in progress and does not pick up any new work. The default is 300 seconds.</td>
</tr>
<tr>
<td>sn_ca.task.max_records_create</td>
<td>The maximum number of records to create per scheduled job run. The default is 25,000.</td>
</tr>
</tbody>
</table>

Notifications

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ca.sms_notification.max_users_per_event</td>
<td>The maximum number of users to add per event for an SMS notification.</td>
</tr>
<tr>
<td>sn_ca.notification.max_run_time</td>
<td>The maximum amount of time (in seconds) the Content Automation: Send Notifications scheduled job runs.</td>
</tr>
<tr>
<td>sn_ca.notification.event_stagger</td>
<td>The amount of time between events when a scheduled job runs. Staggering provides time for the events to be processed during the staggered time. The default is 60 seconds.</td>
</tr>
<tr>
<td>sn_ca.notification.max_events</td>
<td>The maximum number of events to queue per job run.</td>
</tr>
<tr>
<td>sn_ca.notification.max_events</td>
<td>The maximum number of events to queue per job run for email notifications.</td>
</tr>
<tr>
<td>sn_ca.notification.max_users_per_event</td>
<td>The maximum number of users to add per event for email notifications.</td>
</tr>
</tbody>
</table>
## State Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_ca.state_management.max_run_time</code></td>
<td>The maximum amount of time (in seconds) the Content Automation: Manage Content States scheduled job runs.</td>
</tr>
<tr>
<td><code>sn_ca.state_management.max_records_update</code></td>
<td>The maximum number of records to update per job run.</td>
</tr>
</tbody>
</table>

## User Deactivation

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_ca.user_deactivation.max_run_time</code></td>
<td>The maximum amount of time (in seconds) the Content Automation: Deactivate Campaign Users scheduled job runs.</td>
</tr>
<tr>
<td>The scheduled job deactivates flagged users.</td>
<td>The default value is 300 seconds.</td>
</tr>
<tr>
<td><code>sn_ca.user_deactivation.max_users_per_job</code></td>
<td>The maximum number of users to deactivate per job run.</td>
</tr>
<tr>
<td>The Content Automation: Deactivate Campaign Users scheduled job runs every six hours by default.</td>
<td>The default is 25,000 users.</td>
</tr>
</tbody>
</table>

**Note:** These properties determine limits on the Content Automation: Deactivate Campaign Users scheduled job for optimal performance. Customers with a large database should consider increasing this property after testing the impact it could have on performance.

## Purging

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_ca.purging.max_run_time</code></td>
<td>The maximum amount of time (in seconds) the Content Automation: Purge Campaign Data scheduled job runs.</td>
</tr>
<tr>
<td><code>sn_ca.purging.max_users_per_job</code></td>
<td>The maximum number of users to purge per job run.</td>
</tr>
<tr>
<td><code>sn_ca.purging.purge_after_campaign_end</code></td>
<td>Purge all campaigns when the end date is reached.</td>
</tr>
<tr>
<td><code>sn_ca.purging.days_after_campaign_end</code></td>
<td>The number of days after the campaign end date when campaigns are purged.</td>
</tr>
<tr>
<td><code>sn_ca.purging.purge_on_user_removed</code></td>
<td>Indicates if campaign information for a user should be purged after the user is removed from the campaign.</td>
</tr>
<tr>
<td><code>sn_ca.purging.days_after_user_removed</code></td>
<td>The number of days after a user is removed from a campaign to remove the campaign information.</td>
</tr>
</tbody>
</table>
Campaign Re-evaluation

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ca.campaign.reevaluation_frequency</td>
<td>The default number of days to re-evaluate a campaign audience. The default is seven days. You can override this default from the <strong>Re-evaluate campaign</strong> and <strong>Re-evaluate frequency</strong> fields on the Campaign form. For more information, see Create a campaign.</td>
</tr>
</tbody>
</table>

Campaign Preview

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ca.campaign.preview.portal_url_suffix</td>
<td>The URL suffix of the service portal or Employee Service Center (ESC) your company uses for campaign previews. Use this property provides when you want to preview your campaign over multiple portals.</td>
</tr>
</tbody>
</table>

Add or modify content type for Content Delivery

Use Content Types to associate the content type category with a service portal widget to determine where content resides on your service portal.

**Before you begin**
Roles required: sn_cd.content_manager
The base system provides content types and content that you can use.

**Procedure**
1. Navigate to Content Delivery > Configurations > Content Type.
2. Click New or an existing content type to edit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that describes the content.</td>
</tr>
</tbody>
</table>

**Category**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The content type category. The types are:</td>
</tr>
<tr>
<td>• Portal Content</td>
</tr>
<tr>
<td>• Notification Content</td>
</tr>
<tr>
<td>• Community Content</td>
</tr>
<tr>
<td>• To-do Content</td>
</tr>
<tr>
<td>• Mobile Content</td>
</tr>
<tr>
<td>See Employee content publishing and delivery.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Associated widgets** | Widgets that can show the type of content you are defining or editing.
**Active** | Indicates that the content type is active and available to use.
**Value** | Unique identification of the content type.

3. Click **Submit** or **Update**.

**Restrict content for Content Delivery and Content Automation**

When creating sensitive content for your Employee Service Center (ESC), service portal, or as part of a campaign, you can restrict this content to authorized content managers.

Examples of sensitive content are:
- Mergers or acquisitions
- Reduction in Force (RIF)
- Content specific to geographic region
- Legal announcements

**Restrict content**

If you have multiple content or campaign managers, you can control which managers have access to sensitive content.

You assign sensitive content to one person or a group of people.

Content or campaign managers that are not assigned to the sensitive content, cannot access the content.

**Plugin**

Content restriction is installed with the Content Delivery (com.sn_content_delivery) plugin.

**Properties**

The `Restrict/delegate content items (sn_cd.activate_content_authoring_controls)` property enables content restrictions.

⚠️ **Note:** Turning on a property under Content Delivery, turns it on for Content Automation. For more information, see Properties installed with content automation and Properties installed with content delivery.

**Roles**

The following are roles for content restriction:
## Content Restriction

<table>
<thead>
<tr>
<th></th>
<th>CD Admin</th>
<th>CD Manager</th>
<th>Campaign Admin</th>
<th>Campaign Manager</th>
<th>Campaign Admin + CD Admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create content</td>
<td>True</td>
<td>True</td>
<td>True</td>
<td>True</td>
<td>True</td>
</tr>
<tr>
<td>Read content</td>
<td>Can view all</td>
<td>Can view own or non-assigned</td>
<td>Can view own or non-assigned</td>
<td>Can view own or non-assigned</td>
<td>Can view all</td>
</tr>
<tr>
<td>Edit content</td>
<td>Can edit all</td>
<td>Can edit own or non-assigned</td>
<td>Can edit own or non-assigned</td>
<td>Can edit own or non-assigned</td>
<td>Can edit all</td>
</tr>
<tr>
<td>Schedule content</td>
<td>Can schedule all</td>
<td>Can schedule own or non-assigned</td>
<td>Can schedule own or non-assigned</td>
<td>Can schedule own or non-assigned</td>
<td>Can schedule all</td>
</tr>
<tr>
<td>Assign to campaigns</td>
<td>Not available</td>
<td>Not available</td>
<td>Can assign own or non-assigned</td>
<td>Can assign own or non-assigned</td>
<td>Can assign all</td>
</tr>
</tbody>
</table>

### Authorizing content

Assign a content manager, campaign manager, or a group of managers to a content item so only those users can access and schedule it.

### Before you begin

**Role required:** content_admin

### Procedure

1. Navigate to **Content Delivery**.
2. Select a content type.

   **Note:** You can authorize an individual or a group.

3. To authorize an individual, select the **Restrict content by user** tab.
4. Select **New**. The **Content authoring user** form appears.
5. From the **User** field, click the **Lookup using list** (🔍) icon and select a user.

   **Note:** Only users with the content admin (sn_cd.content_admin) or content manager (sn_cd.content_manager) roles appear.

6. Select **Submit**.
7. To authorize a group, select the **Restrict content by group** tab.
8. Select **New**. The **Content authoring user** form appears.
9. From the **Group** field, click the **Lookup using list** (🔍) icon and select a group.

   **Note:** Only groups that have the Content admin (sn_cd.content_admin) or Content manager (sn_cd.content_manager), and Campaign manager (sn_ca.campaign_manager) roles appear. If the members of the group have these roles, but the group does not, the group does not appear.

10. Select **Submit**.
After a user or group is associated with content, only that user or group can access the content when scheduling content under Schedule content or when adding content to a campaign. Removing the user or group makes the content accessible by all content managers.

Delegate audiences for Content Delivery and Content Automation

To further secure your sensitive content, you can delegate an audience to a content manager, campaign manager, or a group of managers.

For example:

- You have a content manager in the United States.
- The United States content manager can only schedule content for audiences in the United States.
- The United States content manager cannot schedule content for other audiences.

Delegate audiences

When you delegate an audience to a content manager, campaign manager, or group of managers, only they have access to that audience.

For campaigns, you can refine an audience at the content level.

⚠️ Note: Delegated audiences are visible to anyone that has access to Manage Audiences, but only users with the Campaign manager (sn_ca.campaign_manager) role can assign to a campaign.

Plugin

Audience delegation is installed with the Content Delivery (com.sn_content_delivery) plugin.

Properties

The Restrict/delegate audiences (sn_cd.activate_audience_delegation_controls) property enables audience delegation.

⚠️ Note: Turning on a property under Content Delivery, turns it on for Content Automation. For more information, see Properties installed with content automation and Properties installed with content delivery.

Roles

The following are roles for audience delegation:
Delegating an audience

Delegate an audience to a content manager, campaign manager, or a group of managers so only they can access and schedule content for the audience.

Before you begin
Role required: content_admin

Procedure
1. Navigate to Content Delivery > Manage Content > Manage Audiences.
2. Select an audience.
   
   Note: You can restrict an audience by an individual or a group.
3. To restrict an individual, select the Restrict audience by user tab.
4. Select New. The Delegated user form appears.
5. From the User field, click the Lookup using list (🔍) icon and select a user.
   
   Note: Only users with the Content admin (sn_cd.content_admin) or Campaign manager (sn_ca.campaign_manager) roles appear.
6. Select Submit.
7. To authorize a group, select the Restrict content by group tab.
8. Select New. The Delegated group form appears.
9. From the Group field, click the Lookup using list (🔍) icon and select a group.
   
   Note: Only groups that have the content admin (sn_cd.content_admin), content manager (sn_cd.content_manager), or campaign manager (sn_ca.campaign_manager) roles appear. If the members of the group have these roles, but the group does not, the group does not appear.
10. Select Submit. After a user or group is associated with an audience, only that user or group can access the audience. Removing the user or group makes the audience accessible by all content managers.

Content Analytics measures employee engagement

Determine how engaged employees are with content you provide on the Employee Service Center or your portals and campaign content by using Content Analytics.

Content Analytics helps you decide when content is stale, needs refreshing, and how engaged your employees are with your communication.

Tracking profiles

Tracking profiles define a bucket where you want to capture analytics. It can correspond to a portal, campaign, application, or any context you like. An example is the Google Analytics property.

Tracking profiles are like a bucket that you want to store your captured analytics.

The ServiceNow tracking profiles are similar to Google Analytics property.

You can choose from two types of tracking profiles:

• ServiceNow
• Google

The base system provides the Content Automation and Content Delivery profiles under ServiceNow. Pre-configuration of the Content Automation and Content Delivery demo portals use the corresponding profile for portal analytics.

ServiceNow profiles

The base system tracks portal analytics for the Employee Service Center for the default profile. Portal analytics includes:

• Page views.
• Top page clicks, downloads
• Notification activity, email opens, and email clicks.

Google Analytics

If you choose Google, you have to configure your Google account so that it can communicate with Content Delivery and Content Automation. See Configure content analytics for Google.

Using Google Analytics provides a rich set of data that provides granular information.

Reports show page views, top page clicks, and views vs. clicks for specific campaign content.

You have access to event-based analytic reports that measures engagement with the Employee Service Center or your service portal:

• Page views.
• Top page clicks, downloads.
• Notification activity, email opens and email clicks.
• Unique users.
• Average session duration.
• Average time per page.
• Bounce rate.
• Devices.

Data flow

Data flows differently depending on what type of tracking profile you are using.

The ServiceNow tracking profiles move data in multiple steps:
• Data stores in the browser memory.
• After a user navigates to other content or after five minutes, the data moves to the server in memory.
• The data moves to the ServiceNow content analytics tables.
  ◦ Tracked Event [sn_cda_tracked_evt_agg]
  ◦ Tracked Page [sn_cda_tracked_page_agg]
  ◦ Tracked Visit [sn_cda_tracked_visit_agg]
• The ServiceNow tracking profiles trigger runs to transfer data to the shared analytics tables. Google Analytics transfers data directly to the shared analytics tables.
  ◦ Event Statistic [sn_cda_event_stat]
  ◦ Page Statistic [sn_cda_page_stat]
  ◦ Analytics Visit Statistic [sn_cda_analytics_visit_stat]
  ◦ *Browser Statistic [sn_cda_browser_stat]
  ◦ *Device Statistic [sn_cda_device_stat]
  *Used only for Google Analytics.

Activate content analytics

If you have the admin role, you can activate Content Analytics.

Before you begin
Role required: admin

About this task
Activate these plugins:
• Content Analytics [com.sn_content_analytics]
• Content Delivery [com.sn_content_delivery] with demo data.
• Content Automation [com.sn_content_automation] with demo data.
• Employee Service Center [com.sn_hr_service_portal] with demo data.

⚠️ Note: The Content Analytics [com.sn_content_analytics] plugin is a stand-alone plugin and collects analytics. The other plugins are where content resides.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

[List of plugins (Orlando)]

**Components installed with Content Analytics**

Several types of components install with the activation of the Content Analytics [com.sn_content_analytics] plugin, including tables, user roles, and scheduled jobs.

⚠️ **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

⚠️ **Note:** The Content Analytics [com.sn_content_analytics] plugin activates the `sn_cda.min_admin_count` system property [sys_properties.list]. This property prevents you from deleting your only Content Analytics admin user by requiring a minimum number (default is two) of active users with this role.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analytics admin [sn_cda.analytics_admin]</td>
<td>Scoped admin role that creates profiles and restricted countries. Can read data in Content Analytics tables (not necessarily in the Content Automation tables.</td>
<td>• None</td>
</tr>
<tr>
<td>Analytics reader [sn_cda.analytics_reader]</td>
<td>Can read data in the Content Analytics tables (not necessarily in the Content Automation tables.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Scheduled jobs installed**

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Automation: Calculate Campaign Engagements</td>
<td>Calculates the engagement score for every published campaign with tracking turned on. By default, runs every five minutes.</td>
</tr>
<tr>
<td>Content Automation: Process SNC analytics</td>
<td>Converts analytics from the Tracked Event [sn_cda_tracked_evt_agg] table into the Analytics Statistic [sn_ca_analytics_stat] table. This fills in campaign, action, and content references.</td>
</tr>
</tbody>
</table>
### Scheduled job

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>By default, runs daily.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You can trigger or run a tracking profile scheduled job from the Tracking Profile list. You may have to add the **Trigger** field by using the Update Personalized List feature. See **Personal lists**.

## Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analytics Import [sn_cda_import]</td>
<td>Stores information regarding profile imports.</td>
</tr>
<tr>
<td>Analytics Log [sn_cda_analytics_log]</td>
<td>Stores logs created when profile validation or import fails.</td>
</tr>
<tr>
<td>Analytics Visit Statistic [sn_cda_analytics_visit_stat]</td>
<td>An accumulation of visit statistics on a per day and per profile basis. For example, the number of visitors and page views per session.</td>
</tr>
<tr>
<td>Browser [sn_cda_visit_browser]</td>
<td>Stores unique list of browsers.</td>
</tr>
<tr>
<td>Browser Statistic [sn_cda_browser_stat]</td>
<td>Stores analytics related to visits based on browsers and devices.</td>
</tr>
<tr>
<td>Device Statistic [sn_cda_device_stat]</td>
<td>Stores analytics related to device types (for example, desktop, mobile).</td>
</tr>
<tr>
<td>Event Statistic [sn_cda_event_stat]</td>
<td>Stores browser event analytics (for example, video plays, button clicks) from all profiles.</td>
</tr>
<tr>
<td>External Tracking Profile [sn_cda_external_tracking_profile]</td>
<td>Generic table that holds external tracking profiles.</td>
</tr>
<tr>
<td>Google Tracking Profile [sn_cda_google_tracking_profile]</td>
<td>Stores tracking profiles configured for Google Analytics.</td>
</tr>
<tr>
<td>Page Statistic [sn_cda_page_stat]</td>
<td>Stores page view analytics from all profiles.</td>
</tr>
<tr>
<td>Profile Trigger [sn_cda_profile_trigger]</td>
<td>Stores schedule jobs, one per profile, which imports data for the tracking profile.</td>
</tr>
<tr>
<td>Restricted Country [sn_cda_m2m_prof_country]</td>
<td>Defines what countries you do not want to track. Do not track users that reside in the defined country.</td>
</tr>
<tr>
<td>ServiceNow Tracking Profile [sn_cda_snc_tracking_profile]</td>
<td>Stores profiles when tracking with ServiceNow. Extends Tracking Profile [sn_cda_tracking_profile]</td>
</tr>
<tr>
<td>Tracked Event [sn_cda_tracked_evt_agg]</td>
<td>Stores raw tracked events for ServiceNow profiles. When imported, transforms to the sn_cda_event_stat table.</td>
</tr>
</tbody>
</table>
### Tables installed with Content Automation and Content Analytics

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analytics Statistic</td>
<td>Stores aggregate analytics for a campaign, including interactions with campaign, action, and content.</td>
</tr>
<tr>
<td>[sn_ca_analytics_stat]</td>
<td></td>
</tr>
<tr>
<td>Archived Campaign Statistic</td>
<td>Stores archived campaign statistics.</td>
</tr>
<tr>
<td>[sn_ca_campaign_arch]</td>
<td></td>
</tr>
<tr>
<td>Tracked Action</td>
<td>What unique actions you want to track with a campaign.</td>
</tr>
<tr>
<td>[sn_ca_tracked_action]</td>
<td></td>
</tr>
<tr>
<td>Campaign Tracked Action</td>
<td>Track the many-to-many relationships between actions and a campaign. Track only actions that are part of a campaign.</td>
</tr>
<tr>
<td>[sn_ca_m2m_campaign_action]</td>
<td></td>
</tr>
<tr>
<td>Convertive Action</td>
<td>Many-to-many relationship between actions and content types. Defines what types of actions contribute to the engagement score of a campaign. For example, a banner impression action should not change the engagement score, but a banner click-through should.</td>
</tr>
<tr>
<td>[sn_ca_m2m_action_content_type]</td>
<td></td>
</tr>
</tbody>
</table>

### Configure content analytics for ServiceNow

Use Tracking Profiles to configure your ServiceNow content analytics dashboards.

**Before you begin**

Role required: sn_cda.analytics_admin  

Tracking profiles define:

- What website you want to collect data from.
- From what time zone a day starts and ends for data tracking.
• From what time zone the time data collection should start.
• What countries you want to exclude in your analytics data collection and where you want to capture data from.

The base system provides two example profiles:
• Content Automation Profile:
  ◦ Tracks analytics for the Content Automation demo portal when active.
• Content Delivery Profile:
  ◦ Tracks analytics for the Content Delivery demo portal when active.
Analytics for the Employee Service Center track to the default profile.

Note: You can trigger or run a tracking profile scheduled job from the Profile list. You may have to add the Trigger field by using the Update Personalized List feature. See Personal lists.

Procedure
1. Navigate to Content Analytics > Setup.
2. Click New or an existing tracking profile.
3. Click ServiceNow.
4. Fill in the form.

<table>
<thead>
<tr>
<th>Tracking Profile</th>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A description of the tracking profile.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Indicates that the profile is active and available to use.</td>
<td></td>
</tr>
<tr>
<td>Note: If you attempt to deactivate a tracking profile that is in use, a warning message appears to confirm your actions.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>Indicates that the profile is the default profile. Portals use the default tracking profile when configured for tracking without setting a specific tracker.</td>
<td></td>
</tr>
<tr>
<td>Note: The base system Employee Service Center (ESC) uses the default tracking profile.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>The user that is responsible for the profile.</td>
<td></td>
</tr>
<tr>
<td>Collection time zone</td>
<td>Defines when a day starts for data collection based on the time zone you select. A day starts at 12:00 AM and ends at 11:59:59 PM by default. For example, if you select System (America/Los_Angeles), that means a day starts at 12:00 AM PST.</td>
<td></td>
</tr>
</tbody>
</table>
### Fields and Description

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
</table>
| Import run time               | For the ServiceNow profiles, the time and the time zone data moves from the content analytics tables to the shared analytics tables. See Content Analytics measures employee engagement.  
For Google Analytics, the time and time zone when data moves from Google to the shared analytics tables. |
| Import run time zone          | The time zone for the Import run time. For example, if you set the Import run time as 00:00:00 and System (America/Los_Angeles) as the Import run time zone, your data moves from the content analytics tables to the shared analytics tables at midnight, PST. |
| Restricted Countries         | The countries of the users you do not want to track.                                                                                       |

**Note:** Restricted countries are based on the user profile (sys_user) and not the country the user is in at the time.

Click in **Insert a new row...** and select a country.

---

5. Click **Submit** or **Update**.

6. If a country you want restricted does not appear, go to **Organization > Locations**.

7. Click **New**.

8. Click the **Form Context Menu** icon.

9. Select **Configure**.

10. Select **Table**.

11. Under the **Columns** tab, select **Country**.

12. Under the **Choices** tab, click **New**.

**Results**

Next, set up your Employee Service Center to use a profile. See Set up Content Analytics tracking.

**Configure content analytics for Google**

Use Tracking Profiles to configure your Google content analytics dashboards.

**Before you begin**

Role required: sn_cda.analytics_admin

**About this task**

Do the following before creating a Google tracking profile:

- Create a Google Analytics account ID, property (Tracking ID), and View ID in Google Analytics.
- Create a Client ID, Client Secret, and Redirect URL for Google OAuth.
• Enable Google Analytics API and Analytics Reporting API.

**Note:** Refer to Google Analytics.

• Update your portal header with the tracking profile name you use for Google. See Set up Content Analytics tracking.

• Create a Google Analytics tracking profile.

To create a Google Analytics tracking profile:

**Procedure**

1. Navigate to **Content Analytics > Setup**.
2. Click **New**.
3. Click **Google**.
4. Fill in the form.

**Google Tracking Profile**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies your Google tracking profile.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates if the tracking profile is active and available to use.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you attempt to deactivate a tracking profile that is in use, a warning message appears to confirm your actions.</td>
</tr>
<tr>
<td>Default</td>
<td>Indicates that the profile is the default for the Employee Service Center (content delivery), campaign (content automation), or your service portal.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you set a profile tracker to default, you do not have to modify the header to point to a specific tracking profile.</td>
</tr>
<tr>
<td>Owner</td>
<td>The user name of the owner of the tracking profile.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the Google tracking profile. The Google tracking profile must be Validated prior to use.</td>
</tr>
<tr>
<td>Sampling level</td>
<td>The data sampling level to analyze your data. Sampling level is a measurement of your analyzed data. For definitions, refer to the Google Analytics Reporting API v4 document.</td>
</tr>
</tbody>
</table>

5. Fill in the fields in each of the tabs.

**Account Info**

The Account Info requires information from your Google Analytics account.
After entering the correct Google account information, it validates after logging in. The View name and Time zone validates against your Google Analytics account. Ensure that they match.

OAuth Connection
The OAuth Connection tab requires information from your Google developer account.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>The countries of the users you do not want to track.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** Restricted countries are based on the user profile (sys_user) and not the country the user is in at the time.

Click in *Insert a new row...* and select a country.

ℹ️ **Note:** If a country you want restricted does not appear, add a dictionary entry. See *Dictionary entry form*.

6. Click *Save*.

7. Click *Log in*.

Your connection to Google Analytics goes through testing and validation.

8. Under the **Choices** tab, click *New*.

**Results**
Next, set up your Employee Service Center to use a profile. See *Set up Content Analytics tracking*.

**Set up Content Analytics tracking**
To use Content Analytics, add the tracking profile to your Employee Service Center or service portal theme header and add the cdaAnalytics service to your custom widgets.

**Before you begin**
Role required: **sn_cda.analytics_admin**

**About this task**
More steps for page tracking:

Add the tracking profile to your Employee Service Center or service portal theme header.

```xml
<widget
  id="cda-site-analytics"
  options="{"tracking_profile_name": "[PROFILE_NAME]", 'enable_logging': false}"
/>
```

ℹ️ **Note:** If you do not specify a tracking profile in the options, content analytics tries to use the default tracking profile. See *Configure content analytics for ServiceNow*. 

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Service Portal > Headers & Footers.

2. Select your header (Content Automation Header, Content Delivery Header, ESC Header, or HRMadrid Header).

3. If necessary, clone the header. See Service Portal configuration page. Or, you can use Angular Providers, see Reuse components with Angular Providers.

4. If using a clone from the Content Automation, Content Delivery, or Employee Service Center portals, search for the cda-site-analytics widget tag in the Body HTML template field. Then replace PROFILE_NAME with the profile you want to use for tracking. See Configure a portal header menu.

5. If you are using a different header, add the following to the Body HTML and replace PROFILE_NAME:

   ```html
   <widget
       id="cda-site-analytics"
       options="{"tracking_profile_name": '{PROFILE_NAME}', 'enable_logging': false}"
   />
   ```

   PROFILE_NAME:
   If you do not specify a tracking profile in the widget options, content analytics tries to use the default tracking profile (if it exists).

   **Track Employee Service Center events**

   To track Employee Service Center events, add cdaAnalytics service to your custom widgets. See Widget developer guide.

   ```javascript
   function($scope, cdaAnalytics) {
       $scope.onButtonClick = function() {
           // track event using the default tracker (no argument for getTracker)
           cdaAnalytics.getTracker().then(function(tracker) {
               tracker.trackEvent(
                   'Desired Category',
                   'Desired Action',
                   'Desired Name'
               );
           });

           // track event using specific tracker
           cdaAnalytics.getTracker('Human Resources Portal Tracker').then(function(tracker) {
               tracker.trackEvent(
                   'Human Resources',
                   'Video Viewed',
                   'Open Enrollment 2018'
               );
           });
       };
   }
   ```


7. Select a widget or create one.

8. Add cdaAnalytics to the Related List of Angular Providers.

9. Update the client controller of the widget to use the cdaAnalytics service.

**Analytics and Reporting Solutions for Content Analytics**

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

**Enabling the Performance Analytics Solutions**

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.
Note: Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable the solution for Content Analytics, an admin navigates to System Definitions > Plugins and activates the Performance Analytics - Content Pack - Content Analytics plugin.

Related information
- Analytics and Reporting Solutions
- Activate your Performance Analytics subscription

Content Analytics dashboard
Provides statistics on employee engagement with the Employee Service Center, emails, views, and selecting individual content.

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Automation PA Admin [sn_ca_pa.admin] user determines what content appears on the Employee Service Portal. Content Automation PA Admins want content to be interesting, engaging, and relevant.</td>
<td>Content Automation PA Admin [sn_ca_pa.admin]</td>
<td>Metrics can provide the Content Automation PA Admin [sn_ca_pa.admin] with valuable information on what content is being consumed and if it should be refreshed.</td>
</tr>
<tr>
<td>The Content Analytics Reader [sn_cda.analytics_reader] role can access and view Content Analytics Performance Analytics.</td>
<td>Content Analytics Reader [sn_cda.analytics_reader]</td>
<td></td>
</tr>
</tbody>
</table>

Measure content on your Employee Service Center or service portal
Content Analytics provides metrics that can illustrate the effectiveness of the content on your Employee Service Center or service portal. These metrics can help you decide if the content is compelling, interesting, or useful.

Indicators
Content Analytics dashboard has the following indicators:

- All Visits in Last 365 Days
  The total number of visits to the Employee Service Center year-to-date. This metric can provide insight into traffic patterns to your Employee Service Center over time.

  Note: An employee can access the Employee Service Center multiple times during a day, but counts as one visit.

- Average Page Views per Session
  The average number of page views from the Employee Service Center for a visit.
Visits per Day
The total number of visits for each day to the Employee Service Center.

Page Views per Day
The total number of page views for a day to the Employee Service Center. This metric can help you determine if content is getting stale and needs a refresh.

Top 5 Pages in the Last 3 Days
Lists the top five page views for the past three days.

Top 5 Pages in the Last 3 Weeks
Lists the top five page views for the past three weeks. The number of page views for a specific week is also listed.

Indicators for Google Analytics
Content Analytics using a Google Analytics profile has the following indicators.

Unique Users
Using cookies and assigning a unique ID determines the number of returning users to view content created from Content Delivery for a specific time. It also provides a percentage that indicates when there is an increase or decline from the previous day.

Average Session Duration
The average length of an Employee Service Center or portal session in a specific time period divided by the total number of sessions.

⚠️ Note: Only available when using Google Analytics.

Average Time per Page
The average amount of time all employees spend on a single page. Only non-bounces for a page are collected.

⚠️ Note: Only available when using Google Analytics.

Bounce Rate
The percentage of visits when an employee leaves the Employee Service Center or portal without browsing further. Calculated by taking the total number of bounces divided by the total number of visits as a percentage.

⚠️ Note: Only available when using Google Analytics.

Adoption
The percentage of employees viewing new information on your Employee Service Center or portal.

Engagement Metrics
Measures the interaction of your employees with the Employee Service Center portal. Three metrics are captured:

- Page Views: The total number a page on your Employee Service Center portal is viewed. Repeated views of a single page are counted.
- Sessions: The number of interactions an employee takes within a specified time frame (default is 30 minutes). Interactions include browsing pages, downloads, and accessing links.
- Average Page Views per Session:
Visits by Browser
Overview showing the number of employees using a specific web browser to access the Employee Service Center.

Visits by Device
Overview showing the number of employees using a specific device to access the Employee Service Center.

Top Pages
Shows the top five pages viewed for the last three days and three weeks. Also the numbers appear by date and a line graph showing the trend.

Page Views per Day
Shows the total number of page views by date with a line graph showing the trend. Also breaks out the number of views by page for the previous day and for the week.

All Visits in Last 365 Days
The total number of visits to the Employee Service Center portal for the year.

Average Page Views Per Session
The average number of page views per session for the past year.

Visits Per Day
A line graph showing the number of visits per day and the trend.

Page Views Per Day
A line graph showing the number of page views per day and the trend.

Analytics and Reporting Solutions for Content Automation
Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Enabling the Performance Analytics Solutions
Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

Note: Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable the solution for Content Automation, an admin navigates to System Definitions > Plugins and activates the:
• Content Automation [com.sn_content_automation]
• Performance Analytics - Content Pack - Content Automation [com.snc.pa.premium.content_automation]

Related information
Analytics and Reporting Solutions
Activate your Performance Analytics subscription

Content Automation (campaigns) dashboard
Provides statistics on employee engagement with a campaign.
### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Automation Campaign Admin [sn_ca.campaign_admin] user can set up all aspects of a campaign. Using the Campaign Analytics dashboard provides the Content Automation Campaign Admin the ability to evaluate campaign content and make changes when necessary.</td>
<td>Content Automation Campaign Admin [sn_ca.campaign_admin].</td>
<td>Can access read and write records to the content automation tables. You can use campaign analytics to determine what content your employees are viewing in a campaign, what is useful, and if you should change content.</td>
</tr>
<tr>
<td>The Content Automation Campaign Manager [sn_ca.campaign_manager] can view Campaign Analytics.</td>
<td>Content Automation Campaign Manager [sn_ca.campaign_manager].</td>
<td>Note: Does not inherit Content Delivery Analytics Admin [sn_cda.analytics_admin] role to set up tracking profiles.</td>
</tr>
</tbody>
</table>

### Filters

There are two filters you can use. The first filter you can choose:

- **Campaign**: Analytics for a specific campaign. In the second filter, select a published campaign you want to view analytics for.

- **Campaign Success Goal**: Analytics for a campaign success goal. In the second filter, select a campaign success goal set up for a specific campaign. For more information, see Analyzing your campaign for effectiveness.

### Measure campaign effectiveness

Use Content Automation Performance Analytics to measure the effectiveness of a campaign and the content provided to your employees. You can choose to change your content based on the metrics showing low traffic. You can also determine if your campaign is driving the intended actions.

### Campaign Engagement Indicators

**Campaign**: Impact Target

The count you hope to reach when no historical data is available.

**Campaign**: Impact Evaluation

Current data during campaign duration. Use this information to compare against your baseline and target count shows how your campaign is progressing.

**Campaign**: Impact Baseline

Historical data based on similar campaigns in the past.

**Days Running**
The start and end dates of a campaign and the total days the campaign has run to date. This metric provides an overview of how long a campaign runs and how many days it has run. Provides context to how effective a campaign is.

**Total Engagement**

This metric provides statistics on how many employees are interacting with the campaign. It shows the percentage of campaign targets who have visited the destination portal and have engaged with content by clicking or viewing. Those campaign targets who have never been to the portal are not part of this calculation.

> **Note:** Currently, email link clicks are tracked as anonymous and do not affect the campaign engagement score.

**Event Activity Over Time**

The number of tracked user interactions with content that tracks independently from a web page or a screen load. Tracking includes when content appears, downloads, link clicks, and video plays.

**Events Over Time by Content**

The number of tracked user interactions with content in a line chart for a selected time.

**Events Over Time by Action**

A line chart that shows actions, clickthrough, and impressions for a selected time.

**Action Activity**

A pie chart that shows the amount of action or interaction with content.

Impressions are when content appears for an employee.

**Top Content**

A bar chart showing the most accessed content. Clicking a bar shows metrics for the specific content and action.

**Top Notifications**

Bar chart showing the top distributed notifications during the campaign.

**All Campaigns To-dos — Last 12 Months**

Total number of completed to-dos for a campaign during the past 12 months.

**To-dos**

Shows campaign data in a bar chart for the last 12 months. Data shows campaign to-dos that are:

- Closed complete
- Closed incomplete
- Open
**Campaign Impact**

To generate the Campaign Impact

Run the scheduled job (runs daily):

- Content Automation: Evaluate Campaign Success Goals

Run the data collector job (runs daily):

- (PA Content Automation) Daily Data Collection

Select a campaign success goal to show a chart that shows how your campaign is progressing. The campaign impact chart shows:

- Evaluation count: Shows current data during campaign duration. Use this information to compare against your baseline and target count shows how your campaign is progressing.
- Baseline count: Shows historical data based on past, similar campaigns.
- Target count: The count you hope to reach when no historical data is available.
- Trend: Depends on how you set your campaign success goal type. If you select Deflection, your trend should point down. If you select Drive action, your trend should point up.
- Forecast Evaluation Count: Shows how close the campaign is to the target count and when it might be reached.
HR Employee Service Center configuration

If you are using Employee Service Center as part of HR Service Delivery, additional configuration is required.

Link the HR ticket page with the Employee Service Center

If you are using Employee Service Center as part of HR Service Delivery, use the Portal Configuration module to link the HR ticket page with the Employee Service Center portal. If you use domain separation in your instance, you can have one active configuration record per domain.

Before you begin

Role required: sn_hr_sp.esc_admin

Procedure

1. Navigate to Employee Service Center > Administration > Portal Configuration.
2. Click New or open a record.

⚠️ Note: If you are a new customer, a preconfigured record is available for you to use.
3. Fill in the fields on the form, as appropriate.

ESC Portal Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal</td>
<td>Name of the portal that you want to link the HR ticket page to. For new customers, this field is set to Employee Service Center. You can use this or another portal.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>URL suffix</strong></td>
<td>URL suffix of the portal. For new customers, this field is set to esc. If there is already an existing portal with that suffix, then the field is set to escm. You can use this or another URL suffix.&lt;br&gt;<strong>Note:</strong> Each portal must have a unique URL suffix. To verify that there are no duplicate suffixes, navigate to Service Portal &gt; Portals.</td>
</tr>
<tr>
<td><strong>Ticket page</strong></td>
<td>Name of the HR ticket page. For new customers, this field is set to hrm_ticket_page. You can use this or another ticket page.&lt;br&gt;<strong>Note:</strong> The HR ticket page is where users can view the details of an HR case. To learn more about the HR ticket page, see HR ticket page.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check box to activate the Employee Service Center portal for use.&lt;br&gt;<strong>Note:</strong> If you are using domain separation in your instance, you can have one active configuration record per domain.</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>If you are using domain separation in your instance, the name of the domain.&lt;br&gt;<strong>Note:</strong> If the Domain field is not visible, add the field to the form by clicking the menu icon in the form header and navigating to Configure &gt; Form Layout.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**HR ticket page**

The HR ticket page is where users can view the details of an HR case. The HR ticket page appears when the user opens an HR request from the Requests page in the portal. Different users have different views of the HR ticket page, and you can configure the HR ticket page header for individual HR services.

**Note:** The HR ticket page is only available if you are using Employee Service Center with HR Service Delivery.

**HR ticket page overview**

The HR ticket page displays the details of an HR case, such as the description, attachments, history, approvers, and to-dos. The following GIF shows an example of an employee opening an HR ticket from the requests page and viewing all the to-dos associated with that case.

**Note:** What a user sees on an HR ticket depends on their persona. For example, because Mara Rineheart is the person that the HR case was opened for, all the to-dos that are associated with the case are visible.
The status for each open and closed to-do are:

- Approved
- Completed
- Closed
- Canceled
- Skipped

Note: The completed status also has a green check mark icon next to it and with information on when the to-do was completed.

**HR ticket page user types**

There are four different user types that can view the HR ticket page: the person that the HR request was opened for, the person that is the subject of the request, any task assignees, and any approvers. Each user type has a unique view.

<table>
<thead>
<tr>
<th>User type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opened for</td>
<td>Person that the HR request was opened for. Sees the HR case when it is created, including all to-dos for all user types.</td>
</tr>
<tr>
<td>User type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Note:**              | • If an HR case has one or more child cases, the children are automatically rolled up with the parent up to three generations. HR child cases that are rolled up with the parent do not appear as separate requests on the requests page. Non-HR child cases appear both as a separate request and as part of the roll-up on the parent case.  
• If you are using Enterprise Onboarding and Transitions with Employee Service Center, an activity sets timeline appears on the HR ticket page for lifecycle event cases. |
| Subject person         | Person that is the subject of the HR request. (This person may or may not be the same person that the HR request was opened for.) Only sees the HR ticket page if an HR task is assigned to the user as a to-do.  
You can further configure the subject person view to:  
• **Show case to subject person:** If selected, the subject person sees the HR case when it is created, as well as:  
  ◦ HR tasks assigned to the subject person  
  ◦ Child HR cases where the subject person is also the opened for person  
  ◦ Child HR cases when the subject person has a task assigned  
  ◦ Requests where the subject person is the requested for person  
  See Configure an HR service for more information.  
• (Enterprise Onboarding and Transitions only) **Show activity sets to subject person:** If selected, the subject person sees the activity sets timeline on the HR ticket page. See Configure a lifecycle event for more information. |
| Task assignee          | Person that is assigned a task to help fulfill the HR request. Only sees the HR ticket page if an HR task is assigned to the user as a to-do.                                                                         |
| Approver               | Person that is an approver for the HR request. Only sees the HR ticket page if an approval is assigned to the user as a to-do.                                                                               |

**HR ticket page header configuration**

The HR ticket page header provides information about the HR case such as the HR service type, description, and who is assigned to the case. In the following
example, you can see how the header appears on the HR ticket page for an HR case.

You can configure the appearance of the HR ticket page header for individual HR services.

- **Configure the HR ticket page header for an HR service**

If you are using Enterprise Onboarding and Transitions with Employee Service Center

If you are using Enterprise Onboarding and Transitions with Employee Service Center, the HR ticket page displays an activity sets timeline to the user. The timeline enables the user to view assignments and to-dos by activity set. It also shows upcoming to-dos so that the user knows what tasks they will need to complete in the future.

The following GIF shows an example of a new hire employee opening an onboarding case and viewing the case details by activity set, assignment type, and current and upcoming to-dos.
The activity sets timeline appears on the HR ticket page for the opened for user by default. Within each activity set, a progress bar appears in the activity set header. You can also show the activity sets timeline to the subject person of the lifecycle event case by selecting Show activity sets to subject person for individual lifecycle event types. (The progress bar for each activity set does not appear to the subject person, however.) See Configure a lifecycle event for more information.

Upcoming to-dos are shown for most types of employee and fulfills activities in upcoming activity sets. Not shown are fulfills activities for order guides, catalog items, flows, and incidents. The opened for person is shown both their and the subject person’s upcoming to-dos. The subject person is shown only their upcoming to-dos.

**Journey Accelerator**

Administrators can use the ServiceNow® Journey Accelerator application to create templates for plans and to-do tasks. Managers then use the templates to create and publish customized plans for key employee transitions. Managers, employees, and mentors can access the plans from the Employee Center (EC).

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

After installing and configuring Journey Accelerator application, administrators create and manage templates for plan types, stages, and tasks.

**Set up**

- Exploring Journey Accelerator
- Install and configure Journey Accelerator
• Microsoft Exchange Online setup for Journey Accelerator

⚠️ Note: If an administrator intends to use the Microsoft Office 365 scheduling capabilities with Journey Accelerator, the administrator needs to install and configure the related Microsoft plugins and integrations before installing Journey Accelerator.

• Components installed with Journey Accelerator

Administer

• Creating and managing audience-specific Journey Accelerator templates
   ◦ Create plan types
   ◦ Create stage names
   ◦ Create and manage task templates
   ◦ Configure and manage plans

• Manage plans
• Monitor plans

Use

Only authorized users with the required user role or users that are included in the access control list can access the Journey Accelerator application. The entries in the Journey Accelerator Plan [sn_ja_plan] table determine user access.

Managers create, modify, and track action plans for their employees

Managers can create individual Journey Accelerator plans for employees.

Employees view and complete action plans

Employees can view, manage, and track the plan progress.

Mentors view, modify, and track action plans assigned to them by managers

• Mentors with Can view permission, can manage, update, and track assigned to-do tasks in a plan.
• Mentors with Can edit permission, are able to add plan stages, to-do tasks, and publish plans.

Exploring Journey Accelerator

By using the Journey Accelerator application on the Now Platform, administrators create templates that enable managers to develop transition plans for employees. Administrators build templates for transition plans, such as promotions, offboarding, onboarding, and role changes for employees.

Administrators can:

• Define and manage plan types for employee transitions, such as promotions, onboarding, offboarding, and more.
• Create and manage plan configurations for specific employee audiences, such as sales associates or IT technicians.
• Create and manage task templates, such as workstation setup or planning and training sessions.
• Track plan progress and template usage from the Journey Accelerator dashboard.
From the Employee Center (EC), managers, employees, and mentors access Journey Accelerator plans.

**Managers can:**

- Create and manage customized plans for employee transitions.
  
  **Note:** Only managers can create plans.
- Add to-do tasks by using a library of existing tasks.
- Create tasks that are unique to an employee transition.
- Publish plans that are based on employee transition dates, such as start dates.
- Assign mentors to employees.

**Mentors can:**

  **Note:** The mentors’ permission level determines what they can do with a plan.

- With the Can view permission, mentors can:
  - View all to-do tasks in a plan
  - Update tasks that are assigned to them
- With the Can edit permission, mentors can:
  - Edit, add, or delete stages and to-do tasks
  - Publish plans
  - Set plan publish dates

**Employees can:**

  View the plans, complete their to-do tasks, and track their progress.

  **Note:** All users can do the following actions:

- Add comments: Send comments or questions to the plan’s owner.
- Add attachments: Add relevant files that support the completion of a to-do item such as certificates and emails.

**Install and configure Journey Accelerator**

Install the Journey Accelerator [sn_ja] application to enable your users to easily create and manage transition plans.

**Before you begin**

The Employee Center must be installed and activated. Managers, employees, and mentors access Journey Accelerator plans from the EC.

- If you are planning to use the Journey Accelerator v2 scheduling feature, see Microsoft Exchange Online setup for Journey Accelerator before you begin installation.
- Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the application using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find an application, you may have to request it from the ServiceNow Store.

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. Click **Install**.

4. In the Application installation dialog box, review the application dependencies.
   
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install the ServiceNow Store application.

5. **Optional:** If demo data is available and you want to install it, click **Load demo data**.
   
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

6. Click **Install**.

**What to do next**
Make sure that the appropriate update sets are loaded.

- **Download update sets for Journey Accelerator**
  
  Download the required update sets for the Journey Accelerator application.

- **Upload, preview, and commit update sets for Journey Accelerator**
  
  Upload and commit the dataset updates for the Journey Accelerator application.

**Related information**

- Verify the Journey Accelerator installation and update sets

**Download update sets for Journey Accelerator**

Download the required update sets for the Journey Accelerator application.

**Before you begin**
Role required: admin

**About this task**

Download the files for update sets from the ServiceNow Store. Links to the files are under the Supporting Links and Docs section in the Journey Accelerator app entry.

**Procedure**

1. Navigate to the Journey Accelerator application in the ServiceNow Store.

2. Under the Supporting Links and Docs section, click each of the following links to download the following files:
   
   - JA_ESC_header_menu_item - Journey Accelerator_Plans.xml
   - JA_Enforce_security_property.xml
   - JA_Allow_Content_Delivery.xml
• JA_HR_Core_Rome_touchpoints.xml
• JA_HR_Lifecycle_Events_Rome_touchpoints.xml

Be sure to note the download location. You need the location of the files to import the update sets.

What to do next
See the Upload, preview, and commit update sets for Journey Accelerator task to import and commit the required update sets.

Related information
Verify the Journey Accelerator installation and update sets

Upload, preview, and commit update sets for Journey Accelerator
Upload and commit the dataset updates for the Journey Accelerator application. These files contain the required datasets for the application to work properly.

Before you begin
Role required: admin

Procedure
2. Click Import Update Set from XML.
3. Upload and commit each file in the sequence listed.
   These update sets are required for all Journey Accelerator versions and all supported family releases.
   • First: JA_ESC_header_menu_item - Journey Accelerator_Plans.xml
   • Second: JA_Enforce_security_property.xml
   • Third: JA_Allow_Content_Delivery.xml
   Only Journey Accelerator v.3.0.0 on the Rome family release requires these update sets.
   • JA_HR_Core_Rome_touchpoints.xml
   • JA_HR_Lifecycle_Events_Rome_touchpoints.xml

a. Click Choose File and open the file to import.

b. Click Upload.

c. Open the uploaded file.

d. Click Preview Update Set.

e. Click Commit Update Set.
   Repeat the process for each of the dataset files.

What to do next
See the Verify the Journey Accelerator installation and update sets task to verify app installation and updates.
Components installed with Journey Accelerator

Several types of components install with the activation of the Journey Accelerator application, including user roles and tables. There are also dependencies on other features or apps.

⚠ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for the Journey Accelerator application. If you want to install the demo data, click Load demo data when installing this application. Demo data includes sample records and configurations for common use cases.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Administrator [sn_ja.admin] | Grants access to create and manage all Journey Accelerator components, tables, and data. | • [sn_ja.reader]  
• [sn_ja.modifier]  
• [sn_cd.content_manager] |
| Modifier [sn_ja.modifier] | Grants access to modify all Journey Accelerator plans, stages, and to-dos.     | [sn_ja.reader]                             |
| Reader [sn_ja.reader]    | Grants access to read all Journey Accelerator plans, stages, to-dos, and dashboards. | none                                       |

You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

Tables installed

<table>
<thead>
<tr>
<th>Table name [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journey Accelerator Plan [sn_ja_plan]</td>
<td>Contains Journey Accelerator plans and manages associations with related tables.</td>
</tr>
<tr>
<td>Journey Accelerator Plan Configuration [sn_ja_plan_config]</td>
<td>Contains details about Journey Accelerator plan configurations.</td>
</tr>
<tr>
<td>Journey Accelerator Plan Header Field [sn_ja_plan_header_field]</td>
<td>Tracks the fields that are available for configuration in the plan header.</td>
</tr>
<tr>
<td>Journey Accelerator Plan Header Configuration [sn_ja_plan_header_config]</td>
<td>Tracks fields used for plan header configuration.</td>
</tr>
<tr>
<td>Journey Accelerator Plan Type [sn_ja_plan_type]</td>
<td>Tracks the different Journey Accelerator plan types.</td>
</tr>
<tr>
<td>Table name [name]</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Journey Accelerator Stage [sn_ja_stage]</td>
<td>Contains Journey Accelerator stage details and relationships to other Journey Accelerator tables.</td>
</tr>
<tr>
<td>Journey Accelerator Stage Configuration [sn_ja_stage_config]</td>
<td>Contains details about a stage's configuration.</td>
</tr>
<tr>
<td>Journey Accelerator Stage Name [sn_ja_stage_name]</td>
<td>Tracks the names of the different Journey Accelerator stages.</td>
</tr>
<tr>
<td>Journey Accelerator Task [sn_ja_task]</td>
<td>Contains Journey Accelerator task details and relationships to other Journey Accelerator tables.</td>
</tr>
<tr>
<td>Journey Accelerator Task Template [sn_ja_task_template]</td>
<td>Contains details about Journey Accelerator task templates.</td>
</tr>
<tr>
<td>Journey Accelerator Task Template for Stage Config [sn_ja_m2m_stage_task_temp]</td>
<td>Used to maintain the relationship of task templates to Journey Accelerator task templates.</td>
</tr>
</tbody>
</table>

For more information on table administration and how to manage data, see Table administration.

**Verify the Journey Accelerator installation and update sets**

Verify the installation and updates are correctly applied for the Journey Accelerator application by using demo data.

**Before you begin**

ℹ️ Note: This task can be completed only if the Journey Accelerator application demo data has been installed.

Role required: admin

**Procedure**

1. Navigate to System Administrator > Impersonate User.
2. In the search field, enter the user name Darcie Schmidt and press Enter.
3. Navigate to Self-Service > Employee Center.
   ℹ️ Note: If the Plans menu is not visible, update sets are not properly installed. Try updating the necessary dataset. For more information, see Download update sets for Journey Accelerator and Upload, preview, and commit update sets for Journey Accelerator.
4. To view and create plans, click Plans.

**Results**

When you see the Plans page, you have correctly installed and updated the Journey Accelerator application.

**Configure and manage the Action Plan Guided Tour for Journey Accelerator**

As an administrator [admin] or a guided tour administrator [guided_tour_admin], you can manage and update the Action Plan Guided Tour for Journey Accelerator.
Journey Accelerator has a guided tour to help managers learn about action plans and come up-to-speed on the available features.

To access the Action Plan Guided Tour from your ServiceNow instance, navigate to **Guided Tour Designer > Guided Tours** and search for Action Plan Guided Tour in the name column.

Guided tours help train role-based users on how to use an application's user interface (UI) and features. Tours contain a series of interactive steps a user completes in their browser window. Administrators can manage and modify guided tours. You can find more information about guided tours in these ServiceNow documentation topics:

- **Guided tours**: This overview covers many of the features administrators use to create and modify tours.
- **Guided Tour Designer interface**: Learn about the Guided Tour Designer features and interface.
- **Edit a guided tour**: This task provides details about how to modify guided tours.

### Modify a scheduled job for Publish Journey Accelerator plans

Update the Publish Journey Accelerator plans job. The job evaluates a plan's publish date to determine when to publish the plan.

**Before you begin**

Role required: admin

**About this task**

You can change the scheduled frequency at which the job runs, modify scripts, and add conditions.

⚠ **Note**: The default scheduled frequency for a Publish Journey Accelerator plan is 12 hours.

**Procedure**

1. Navigate to **System Definition > Scheduled Jobs**.
2. In the **Name** field, enter Publish Journey Accelerator plans, press **Enter**, and then open the job.
3. On the form, fill in the fields.

**Schedule script execution form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies this scheduled job.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that indicates that scheduled job is active and should be executed at the specified date and time.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application that contains the script. <strong>Global</strong> appears if the script is in the global scope.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Option for enabling the running of the scheduled job if certain conditions are met in the associated script.</td>
</tr>
</tbody>
</table>
| Run     | Time interval to use for running the scheduled job:  
  - **Daily**: Runs daily, at a designated time.  
  - **Weekly**: Runs on a weekly basis, at a designated time and day of the week. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Monthly</strong>:</td>
<td>Runs on a monthly basis, at a designated time and day of the month.</td>
</tr>
<tr>
<td>• <strong>Periodically</strong>:</td>
<td>Runs on a designated repeating interval.</td>
</tr>
<tr>
<td>• <strong>Once</strong>:</td>
<td>Runs for a single occurrence only.</td>
</tr>
<tr>
<td>• <strong>On Demand</strong>:</td>
<td>Runs immediately on demand.</td>
</tr>
<tr>
<td>• <strong>Business Calendar: Entry Start</strong>:</td>
<td>Runs on the starting entry dates for the business calendar you select in the <strong>Business Calendar</strong> field. A scheduled job runs for the starting date of each of the business entries you defined for the business calendar. For example, if the business calendar represents a fiscal year, and the starting date of each entry is a fiscal month, the scheduled job runs on the first day of each month.</td>
</tr>
<tr>
<td>• <strong>Business Calendar: Entry End</strong>:</td>
<td>Runs for the ending date for the business calendar you select in the <strong>Business Calendar</strong> field. This selection runs in the same manner as <strong>Business Calendar: Entry Start</strong>, but for end dates of associated business calendar entries.</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>When you select <strong>Business Calendar: Entry Start</strong> or <strong>Business Calendar: Entry End</strong>, you can apply an offset factor to schedule the job to run before or after the time span of the selected business calendar. To learn more, see the <strong>Offset type</strong> and <strong>Offset</strong> fields. To learn more about creating and using business calendars and defining business calendar entries, see Creating business calendars andDefine business calendar entries.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Repeat Interval</th>
<th>Duration of the repeat interval for each scheduled job execution. Enter the duration in the number of days, hours, or minutes. For example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• To run the scheduled job every four days, enter 04 into the <strong>Days</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• To run it every 26 hours, enter 26 into the <strong>Hours</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• If it should repeat at an interval of 13:30:25, enter 13 into the <strong>Hours</strong> field, then 30 and 25 into the two unlabeled fields after it.</td>
<td></td>
</tr>
</tbody>
</table>

| Starting                      | Date and time of the first scheduled job generation. Select the calendar date and time. This field only appears if you select **Periodically** in the **Run** field. |

| Condition                     | Conditional script that determines if a scheduled job should run. The last expression of the script should evaluate to a Boolean (true/false) value. This text box appears only if you select **Conditional**. |

| Run this script               | Name of the script to run at the scheduled date and time. Two examples are copy script logic from a business rule or call a script include. |

4. Click **Update**. To learn more about scheduled jobs, see Scheduled jobs.

**Microsoft Exchange Online setup for Journey Accelerator**

By integrating the Journey Accelerator scheduling feature with the Microsoft Office 365 calendar function, users can schedule plans and to-do tasks.

The Journey Accelerator scheduling feature enables users to schedule Microsoft Office 365 calendar events directly from Journey Accelerator plans and to-do tasks.
If you plan to use the scheduling feature, you must install and configure these plugins and integrations before you install Journey Accelerator.

**Note:**

- All users with access to HR Service Delivery Enterprise have access to any related integrations.
- The embedded scheduling feature includes all plugins, integration APIs, and actions.

Some integrations and related plugins require activation by ServiceNow® personnel. Journey Accelerator uses an embedded Microsoft Exchange Online spoke with limitations for use with Journey Accelerator. The use beyond these embedded limitations may require that you get additional licensing or subscriptions.

Go to the ServiceNow Store to find and download the spoke versions you need.

For Journey Accelerator V2 use the following:

**Microsoft AD Spoke** [com.sn.ad.spoke]

Provides communication between Journey Accelerator and Microsoft Active Directory to manage objects such as users, groups, and computers.

**Microsoft Azure AD spoke** [com.sn.azure_ad.spoke]

Provides security requirements to Journey Accelerator so that users, security groups, and office groups are appropriately managed.

**Microsoft Exchange Online spoke v2.0.1**

Follow the instructions for setting up the spoke in Set up Microsoft Exchange Online spoke.

The Microsoft Exchange Online spoke enables creation and management of calendar events and mail in Microsoft Exchange Online. See, Microsoft Exchange Online spoke

For Journey Accelerator V3 use the following:

**Microsoft Exchange Online spoke v3.0.0**

Follow the instructions for setting up the spoke in Set up Microsoft Exchange Online spoke.

The Microsoft Exchange Online spoke enables creation and management of calendar events and mail in Microsoft Exchange Online. See, Microsoft Exchange Online spoke

**Retry Handler Framework**

A framework that retries failed HTTP request when API rate limits are exceeded.

**Set these Journey Accelerator system properties**

Complete all setup and configuration for the spokes for your version of Journey Accelerator. Once spoke setup is complete, navigate to *sys_properties.list* in ServiceNow and set up the following properties for the Journey Accelerator app.

**Note:** Complete all spoke installation and configuration before updating the Journey Accelerator sys_properties.list.

- sn_ja.calendar_provider_option: Select exchangeOnline
- sn_ja.ex_online_dummy_account_id: Insert <outlook dummy account for querying meeting times>
• sn_ja.ex_online_service_account_id: Insert <outlook service account or delegator for calendar management>

• sn_ja.ex_online_notification_url: Insert <webhook URL from Microsoft Exchange Online Spoke>

**Note:** When using Microsoft Exchange Online spoke v3.0.0 with Retry Handler Framework, the scripted rest API for the retry handler framework is used as the webhook URL.

For detailed steps, see **Update system properties for Microsoft Exchange Online in the Journey Accelerator app**

**Update system properties for Microsoft Exchange Online in the Journey Accelerator app**

Update the Journey Accelerator app system properties to use with Microsoft Exchange Online features support by Journey Accelerator.

**Before you begin**

Complete all the steps required for setting up the right Microsoft Exchange Spoke for your version of Journey Accelerator.

• Journey Accelerator v3.0.0:
  
  **Microsoft Exchange Online Spoke v3.0.0**

• Journey Accelerator v2.0.1: Microsoft Exchange Online Spoke v2.0.1

app.

See, **Microsoft Exchange Online setup for Journey Accelerator** for a list of all the required spokes supported for different versions of Journey Accelerator.

**Role required:** admin

**Procedure**

1. Navigate to **sys_properties.list**.

2. Search **Application** for Journey Accelerator.

3. Locate and update the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_ja.calendar_provider_option</td>
<td>exchangeOnline</td>
</tr>
<tr>
<td>sn_ja.ex_online_dummy_account_id</td>
<td>&lt;Outlook dummy account for querying meeting times&gt;</td>
</tr>
<tr>
<td>sn_ja.ex_online_service_account_id</td>
<td>&lt;Outlook service account or delegator for calendar management&gt;</td>
</tr>
<tr>
<td>sn_ja.ex_online_notification_url</td>
<td>&lt;webhook URL from Microsoft Exchange Online Spoke&gt;</td>
</tr>
</tbody>
</table>

Double-click a Value to edit.

**Note:** When using Microsoft Exchange Online spoke v3.0.0 with Retry Handler Framework, use the scripted rest API for the retry handler framework as the webhook URL.
Creating and managing audience-specific Journey Accelerator templates

Administrators can develop Journey Accelerator templates for customized plans with stages that include user tasks for different audiences.

Using Journey Accelerator, administrators can develop and manage templates for audience-specific transition plans. Plans include templates with stages and to-do lists. Managers can use these templates to create transition plans for their employees.

Manage Plan Types

Plan types are the top-level containers for stages and tasks. Administrators select a plan type and a title for the plan when configuring a specific plan. Administrators enter a meaningful title for the type of plan that they are creating so that users can easily identify the plan type, such as "IT Senior Tech Promotion." For more information about plan types, see Create and manage Journey Accelerator plan types.

Manage Stage Names

Stages are contained inside the Journey Accelerator plan. Stages contain tasks or to-do lists for managers, mentors, or employees to complete. Stage Titles are visible to users. Stages should have an implicitly logical order, such as a time sequence. For more information about stages, see Create and manage action plan stages.

Manage Task Templates

Journey Accelerator task templates appear as to-do lists in the plan list view in the Employee Center for managers, mentors, or employees.

Manage Plan Configurations

Plan configurations are based on a plan type. Plan configurations are customized for specific employee audiences. For more information about plan configurations, see Create and manage Journey Accelerator plan configurations.

Manage Plans

Administrators can access and manage plans for specific users after a manager has created a plan. Administrators only update individual plans when the plan’s owner (manager) makes a request to do so. For more information about managing plans, see Managing existing Journey Accelerator plans created by managers.

Manage Plan Header Configuration

Administrators can configure the header for different plan types. Default header configurations are available for the different Journey Accelerator roles.

- View for manager
- View for employee
- View for mentor

For more information about updating the default header configurations or creating new plan header configurations, see Customize and manage Journey Accelerator plan headers.

From the Employee Center, managers can create customized Journey Accelerator plans that contain stages with specific to-do lists for themselves, mentors, and employees.

Create and manage Journey Accelerator plan types

Create plan types to manage the top-level classification for stages and tasks in a Journey Accelerator plan.
Before you begin
Role required: admin

About this task
Managers select a plan type when they are configuring a specific plan. As an administrator, you should create a title for a plan type that is meaningful. You want managers to quickly understand what plan type they are using, for example New Hire, Promotion, or Offboarding.

Procedure
1. Navigate to Journey Accelerator > Manage Plan Types.
2. Click New.
3. In the Title field, enter a meaningful name for the type of plan that you are creating so that it is easily identifiable. These fields contain default plan header configurations for the plan type.
   • View for manager
   • View for employee
   • View for mentor
   See, Customize and manage Journey Accelerator plan headers to customize headers for a plan.
4. Click the search icon next to a role to change the header configuration for that role.
5. After you have selected any header configuration you want to change, click Submit.

Enable automatic action plan creation
You can configure the Create Journey Accelerator Action Plan template so that a plan is automatically created from a lifecycle event.

Before you begin

Note: This feature is only available in the Rome family release or later. In the Quebec family release, follow the detailed instructions on how to automatically trigger a Journey Accelerator Plan from a Lifecycle event or other HR Services, see How to create Journey Accelerator Action Plans directly from a Lifecycle Event or other HR case (KB0994946).

The Create a new action plan for your employee activity must be active. See, Activate the Create a new action plan for your employee activity.
Role required: admin

Procedure
1. Navigate to Livecycle Events > Administration > Manage HR Templates.
2. Open the Create Journey Accelerator Plan template.
3. Set Create plan automatically.
   • Set Create plan automatically to true to automatically create a plan when the lifecycle event activity is created.
   • Set Create plan automatically to false create a to-do for Opened for person (manager) in the HR case.
4. Click Update to apply and save your changes.
   When Create plan automatically is set to true, an action plan is automatically created for the activity in a lifecycle event.
What to do next
Open an HR case to create a Journey Accelerator action plan

Activate the Create a new action plan for your employee activity
Set activities in Lifecycle Events to active to enable the activity to process fulfillment and closure of related events and activities.

Before you begin
Role required: sn_hr_le.admin or sn_hr_le.activity_set_manager

About this task
The Create a new action plan for your employee activity by default is not active. To create Journey Accelerator action plans, activate the Create a new action plan for your employee activity if it isn’t already active.

Procedure
1. Navigate to Lifecycle Events > Manage Activity Configuration.
2. Click Create a new action plan for your employee.
3. Select the check box for Active.
4. Click Update.

See, Configure the supporting components for a lifecycle event if you want more information about Lifecycle Events and fulfiller activities.

Related information
Open an HR case to create a Journey Accelerator action plan

Customize and manage Journey Accelerator plan headers
Create customized plan headers for different plan types based on user roles.

Before you begin
Role required: admin

About this task
Journey Accelerator plans use three different roles:
• Manager
• Employee
• Mentor

You can customize the plan header for each role. Customizations include role-based permission, customizing field labels, and setting role-based plan preferences. Plan header fields are available in the Journey Accelerator Plan [sn_ja_plan] table.

Procedure
1. Navigate to Journey Accelerator > Manage Plan Header Configuration and click Default for employee.
   The default header configuration for the employee role has these fields configured:
   • Plan created by
   • mentor
2. Click mentor.
3. In the Custom label field, enter buddy to replace mentor.
**Note:** A custom field header can only be used for one mentor field. You can customize the mentor field for either **Mentor can view** or **Mentor can edit**.

4. Click **Update** to save the changes to the mentor field.

5. Click **Update** again to save the changes to the header configuration.

The text **This person's mentor** is changed to **This person's buddy**. This change applies to only the header view of the employee role. Field labels are unique to each role.

The changes are available to use in Journey Accelerator Plan Types.

**Related information**

- [Create and manage Journey Accelerator plan types](#)

**Customize field labels in a Journey Accelerator plan header**

Customize the labels for fields that are available in the Journey Accelerator Plan [sn_ja_plan] table so that users have a customized and consistent experience. You can use customized plan headers for different plan types.

**Before you begin**

- **Role required:** admin

**About this task**

Journey Accelerator plans use three different roles:

- Manager
- Employee
- Mentor

You can customize the plan header for each role. You can also customize role-based permissions, field labels, and role-based plan preferences. Plan header fields are available in the Journey Accelerator Plan [sn_ja_plan] table.

**Procedure**

1. Navigate to **Journey Accelerator > Manage Plan Header Configuration**, and click **New**.

2. In the **Name** field, enter a meaningful name. The name should be meaningful to the role that you are creating the custom header for. For this task, enter **Support Manager Plan Header**.

3. Click **Submit**.

4. Open the plan header configuration that you created.

5. Click **New**.

6. In the Details list, select **Mentors can edit**.

7. In the **Custom label** field, enter **buddy** and click **Update**.

8. Click **Update** again.

Any plan type role that uses this plan header displays the label buddy in the plan header. Labels apply to individual roles. Each role can have its own customized labels.

Configure unique plan headers for different plan types. For more information, see [Create and manage Journey Accelerator plan types](#).
Create and manage action plan stages
Create and manage stages that are contained inside the Journey Accelerator plan. Stages contain tasks or to-do lists for managers, mentors, or employees to complete.

Before you begin
Role required: admin

About this task
Use Journey Accelerator stages to create a logical sequence for task completions. Managers add stages to plans in the Employee Center.

Procedure
1. Navigate to Journey Accelerator > Manage Stage Names.
2. Click New.
3. In the Title field, enter a meaningful name for a stage in a plan. For example, Week 1, Day 1, or Month 2.
4. Click Submit.

Create and manage action plan task templates
Create and manage the task templates that managers, mentors, and employees can use for their Journey Accelerator plans. Use task templates to provide a consistent and streamlined experience for creating Journey Accelerator plans.

Before you begin
Role required: admin

About this task
Journey Accelerator task templates appear as to-do lists in the Employee Center for managers, mentors, or employees.

Procedure
1. Navigate to Journey Accelerator > Manage Task Templates.
2. Create a template or modify an existing template.
   For information about the template fields, see Action plan task template fields.
3. Click Submit or Update.

Action plan task template fields
To make a task template, fill in the Journey Accelerator task template fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the activity that is associated with the task.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that is used to track tasks and fields. Select the Journey Accelerator Task [sn_ja_task] table to enable access to the template fields.</td>
</tr>
<tr>
<td>Template</td>
<td>Template fields that appear only when a table is selected. Template fields are tracked</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>in the Journey Accelerator Task [sn_ja_task] table.</td>
</tr>
<tr>
<td></td>
<td>The following settings apply to the overall properties of the task:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Mandatory</strong>: Set to <strong>true</strong> to make the task required. Set to <strong>false</strong> to make the task optional.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Editable</strong>: Set to <strong>true</strong> to enable users to modify task fields. Set to <strong>false</strong> so that users can’t modify certain fields in the task.</td>
</tr>
<tr>
<td></td>
<td><img src="Note.png" alt="" /> <strong>Note</strong>: When editable = false, the following occurs:</td>
</tr>
<tr>
<td></td>
<td>◦ The plan creator can’t change the <strong>To-do name</strong>, <strong>To-do description</strong>, or <strong>This to-do is optional</strong> fields.</td>
</tr>
<tr>
<td></td>
<td>◦ Users can’t delete the to-do task from a plan.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong></td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Regular</strong>: Standard to-do task template.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Calendar</strong>: Schedulable task. Creates to-do task linked to Microsoft Office 365 calendar event.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that enables the task template when selected. Only active tasks are available for managers to use.</td>
</tr>
<tr>
<td>Task short description</td>
<td>Brief description of the task. This text appears to users from the Journey Accelerator plan. This field appears in the <strong>Short description</strong> field when you are managing tasks in stages.</td>
</tr>
<tr>
<td>Task description</td>
<td>Detailed description of the task.</td>
</tr>
<tr>
<td>Parent plan table</td>
<td>Higher-level table that associates an entry in the Journey Accelerator Task [sn_ja_task] with the table that tracks plans, Journey Accelerator Plan [sn_ja_plan]. Selecting the Journey Accelerator enables access to the plan-related fields.</td>
</tr>
<tr>
<td>Assign to source</td>
<td>User who is assigned the task:</td>
</tr>
<tr>
<td></td>
<td>• Employee</td>
</tr>
<tr>
<td></td>
<td>• Manager</td>
</tr>
<tr>
<td></td>
<td>• Mentor</td>
</tr>
<tr>
<td><img src="Note.png" alt="" /> <strong>Note</strong>: Initially, only the first mentor is assigned with to-do tasks in the list with multiple entries. Managers can reassign the to-do tasks to other mentors after the plan is created.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relative due date trigger</td>
<td>Condition that is used to trigger when a task is assigned based on the publish date of the plan. This condition is evaluated with Date offset type and Date offset type.</td>
</tr>
<tr>
<td></td>
<td>• Created</td>
</tr>
<tr>
<td></td>
<td>• End on</td>
</tr>
<tr>
<td></td>
<td>• Start on</td>
</tr>
<tr>
<td></td>
<td>• Updated</td>
</tr>
<tr>
<td>Note:</td>
<td>Only use the Start on condition. Start on is selected by default.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Condition that is used to trigger when a task is assigned. This condition is evaluated with Relative due date trigger and Number of offset days.</td>
</tr>
<tr>
<td></td>
<td>• On</td>
</tr>
<tr>
<td></td>
<td>• After</td>
</tr>
<tr>
<td>Note:</td>
<td>The After condition is the default selection. We recommend that you use only the After condition.</td>
</tr>
<tr>
<td>Number of offset days</td>
<td>Condition that is used to trigger when a task is assigned. This condition is evaluated with Relative due date trigger and Date offset type.</td>
</tr>
<tr>
<td></td>
<td>• Days</td>
</tr>
<tr>
<td></td>
<td>• Hours</td>
</tr>
<tr>
<td>Note:</td>
<td>Only specify days, and keep hours set at 0 (zero).</td>
</tr>
<tr>
<td></td>
<td>For example: If the Relative Due Date Trigger = Start On, Date Offset type = After, and Number of offset days = 5 days, the task is configured to trigger 5 days after the publish date of the plan.</td>
</tr>
</tbody>
</table>

Create and manage Journey Accelerator plan configurations
Create and manage plan configurations that are based on a plan type. Plan configurations are customized for specific employee audiences.

Before you begin
Role required: admin

Procedure
1. Navigate to Journey Accelerator > Manage Plan Configurations.
2. Click New, or open an existing plan configuration.
3. On the form, fill in the fields.
Plan Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Descriptive title so that managers can identify different plan configurations. For example, Sales Employee Plan Configuration.</td>
</tr>
<tr>
<td>Audience</td>
<td>Group of users. Select an audience so that you can control which specific groups of users can access the plans.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you can select to make the configuration available for use.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>A plan cannot be active until it contains at least one stage.</td>
</tr>
<tr>
<td>Journey Accelerator plan type</td>
<td>Plan types. The top-level classification is used to identify different types.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the plan.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the plan.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. To configure the stages for this plan, click **New**.
   a. Select an available stage name.
   b. Click **Submit**.

6. Click **Update**.

**Managing existing Journey Accelerator plans created by managers**

Plan owners make updates to Journey Accelerator plans only from the Employee Center portal. Administrators should not change existing individual plans. Changes to existing individual Journey Accelerator plans should be made only from the Employee Center portal by the manager who created the plan.

**Monitor Journey Accelerator plans**

Monitor plans and to-do tasks from the Journey Accelerator dashboard.

**Before you begin**

Role required: Reader [sn_ja.reader]

**Procedure**

1. Navigate to **Journey Accelerator > Journey Accelerator Dashboard**.

2. Click the items in the dashboard for more details.
   Here is some of the information you can see about Journey Accelerator plans and to-dos.
   - Overdue Plan To-dos
   - Plans in Draft State
   - Plans in Ready State
   - Plans Published in Last 6 Months
   - To-dos Created in Last 6 Months - From Template (True) Vs. Plan Created (False)
Use action plans created from the Journey Accelerator app

Managers, employees, and mentors can access the Journey Accelerator plans through the Employee Center (EC).

For information about the EC, see Employee Service Center.

Managers create, modify, and track action plans for their employees

Create and manage employee transition plans by using Journey Accelerator templates. You can use role-based plans to create consistent plans for different roles on your team.

Before you begin
Role required: All employees with direct reports

Procedure
1. In the Employee Center (EC) portal, click Action Plans.

   Note: Depending on the Employee Center configuration, the Action plans menu can be in the top header menu or under the More list menu. You can also access action plans from My active items list.

2. Click Create action plan.

3. On the form, fill in the fields.

   Let’s start with a few details about this plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who this plan is for</td>
<td>Name of the employee that this plan is for.</td>
</tr>
<tr>
<td>Plan type</td>
<td>List of available plan types that are configured for role-based groups or types of transitions.</td>
</tr>
<tr>
<td>Plan name</td>
<td>Descriptive name of the plan.</td>
</tr>
<tr>
<td>This person's mentor</td>
<td>Mentors that you can select. You can also set the mentors’ view or edit permission.</td>
</tr>
<tr>
<td>Plan description</td>
<td>Details about this plan.</td>
</tr>
</tbody>
</table>

4. Click Create plan.

   You can create a plan that is based on the plan types and audience. You can either publish the plan immediately or exit and make changes later. Plans save automatically.

   You can perform the following actions in the plan:

   Edit plans
   • To change the plan name, add or delete mentors, and change the plan description, click Edit plan details.

   Note: Mentors are notified when they are added to a plan.

   • To add a stage, click Create stage.
   Edit stages and to-do tasks.
   • Reorder to-do tasks by using the drag capabilities in the UI or from the Move down menu in a stage.
   • Rename a stage from the Rename stage menu in the stage.
   • Delete optional to-do tasks.
Note: Not all editing actions are available for the to-do tasks that are mandatory. You can’t delete mandatory to-do tasks.

- Edit an existing to-do task.
- Click Add to-do to create a to-do task or to choose from a list of available to-do tasks. You can assign to-do tasks to users other than the employee or the mentor. These to-do owners receive to-do tasks with access to only their assigned to-do tasks in a published plan.

5. Review the draft and publish or edit the plan.

Publish:
- Click Publish now to immediately make the plan available.

Note: Only use Publish now for active users. Publishing a plan before the user is active can incorrectly generate to-do tasks.

- Click Publish on a set date to select a date when you want the plan to be published.

Edit:
- Click Edit plan details to edit the plan name, add or remove a mentor, set a mentor’s permission, or edit the plan description.
- Click Delete plan to remove the entire plan from the Employee Center.

You can edit existing plans at any time before the plan is marked complete. See Edit existing action plans.

Edit existing action plans

Edit existing Journey Accelerator plans by adding, removing, or rearranging stages and tasks to meet the needs of the employee and your team.

Before you begin
Role required: All employees with direct reports

Procedure
1. In the Employee Center portal, click Plans.
2. Click the plan that you want to edit.
3. Update, move, or delete stages or to-dos. When you’re done, click Exit editing.

Note:
- Deleting tasks or stages permanently removes them from the plan.
- Plans immediately update with your saved edits.

Manage action plan to-do tasks and create templates

Create, modify, and manage to-do tasks for employees and mentors as part of your management responsibilities.

Journey Accelerator action plans can be customized for employee transitions. Part of that customization is a manager’s ability to add, delete, modify, and save to-do tasks. Save the to-do tasks you create as templates to save time and provide consistent experiences for employees and mentors.

Add or modify an action plan to-do

The to-do form contains fields that a manager uses to customize tasks for employees and mentors to complete as part of a transition plan.
**Action plan to-do task fields**

The to-do form contains fields that a manager uses to customize tasks for employees and mentors to complete as part of a transition plan.

**Add or modify an action plan to-do**

Create, modify, and save to-do tasks as part of an action plan. To-dos are assigned to employees, mentors, or managers to complete.

**Before you begin**

Role required: All employees with direct reports

**Procedure**

1. Navigate to Employee Center > Action plans, and open an action plan.
2. Click Add to-do or open an existing task in a stage.
3. Choose the option that is best suited for your employee or mentor.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select from the To-do template list</strong></td>
<td>Select from a list of available to-do task templates and click Next. Templates make it easy and fast to create consistent to-do tasks for more than one employee or mentor.</td>
</tr>
<tr>
<td><strong>Click Create your own</strong></td>
<td>Click Create your own to create a to-do from scratch. Creating a to-do from scratch is a good option to create a unique task for a single employee or mentor.</td>
</tr>
</tbody>
</table>

4. Fill in the to-do form.

**Note:**

- For to-dos that are appropriate for more than one employee or mentor, select Save as Template. Save the to-do as a template so that it is available to use for other employees or mentors in future action plans.
- The Action plan to-do task fields topic has descriptions of the To-do form fields.

5. Click Save.

**Action plan to-do task fields**

The to-do form contains fields that a manager uses to customize tasks for employees and mentors to complete as part of a transition plan.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To-do name</td>
<td>The name of the to-do to appear as the heading or title of the task.</td>
</tr>
<tr>
<td>Stage</td>
<td>Select from the list of available stages included in the action plan.</td>
</tr>
<tr>
<td>To-do description</td>
<td>A description of the task that appears in the action plan to-do.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Who this to-do is for</td>
<td>The name of the employee or mentor to whom this to-do task is assigned.</td>
</tr>
<tr>
<td>Other people</td>
<td>Assign this to-do to additional people. People have different access and responsibilities based on their role (employee or mentor).</td>
</tr>
<tr>
<td>Due Date</td>
<td>Set a due date based on a specific date or a relative date from the date the action plan is published.</td>
</tr>
<tr>
<td></td>
<td>• An exact date</td>
</tr>
<tr>
<td></td>
<td>• A number of weeks after publishing</td>
</tr>
<tr>
<td></td>
<td>• A number of days after publishing</td>
</tr>
<tr>
<td></td>
<td>• No due date</td>
</tr>
<tr>
<td>This to-do is optional</td>
<td>Mark the to-do as optional to give employees or mentors the option not to complete this task.</td>
</tr>
<tr>
<td>Add scheduling to this to-do</td>
<td>Enable scheduling for this task. Your organization must be using Microsoft Online Exchange to enable this feature.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Drop files in this field to include them as an attachment to the to-do.</td>
</tr>
<tr>
<td>Save as Template</td>
<td>Save a to-do as a template so that you can use it in other action plans.</td>
</tr>
</tbody>
</table>

**Employees view and complete action plans**

View, manage, and track your action plan progress from the Employee Center portal.

**Before you begin**

Role required: Any employee assigned to a plan has access to the plan. You can be assigned as the employee or mentor.

**About this task**

Your manager creates plans for different employee transition events. When you can access your plan from the Employee Center portal, you see only your assigned tasks if your plan is in the Ready or Complete state.

ℹ️ **Note:** Tasks in your plan are also listed under To-dos. The To-dos list does not show the stage that contains the task.

**Procedure**

1. In the Employee Center portal, click **Plans**.
2. Click the plan that you want to work on.
   Stages contain the tasks for you to complete.
3. To view details about a particular task and to manage its progress, click that task.
   You can manually update the status of a task and add additional details when needed.
   The different statuses are as follows:
• **Mark as in progress**: Updates that record for the task so that others can see that you started working on the task.

• **Complete**: Shows that you completed the task.

• **Comments**: Sends messages to the plan manager.

• **Attachments**: Adds files, such as certificates of completion, for training or other documents.

**Mentors view, modify, and track action plans assigned to them by managers**

Mentor employees that are assigned to you and view or edit employee plans depending on your permission type.

**Before you begin**
Role required: You must be assigned as a mentor to an action plan.

**About this task**
Managers create plans for different employee transition events. Some transitions include having a mentor. Mentors access plans from the Employee Center portal.

There are two types of mentor permissions:

**Can view**
Mentors see all tasks in a plan. Mentors with the Can view permission can only update the tasks that are assigned to them. Mentors can view plans in Draft, Ready, or Complete states.

**Can edit**
Mentors with the Can edit permission can edit, add, and delete stages or to-do tasks. The Can edit permission enables mentors to publish plans and set plan publish dates.

⚠️ **Note**: Tasks in a plan are also listed under To-dos. The To-dos list does not show the stage that contains the task.

**Procedure**

1. In the Employee Center portal, click **Plans**.
2. Click the plan that you want to work on.
   Stages contain tasks to complete.
   The type of mentor permission restricts or enables edit access to plan stages, to-do tasks, and publishing a plan.
3. Click a task to view or edit its details so that you can manage the progress of it.
   Manage tasks manually. Mark your tasks and add additional details when needed. You can choose the following task statuses:
   • **Mark as in progress**: Updates that record for the task so that others can see that you started working on the task.
   • **Complete**: Shows that you completed the task.
   • **Comments**: Sends messages to the plan manager.
   • **Attachments**: Adds files, such as certificates of completion, for training or other documents.
Enterprise Onboarding and Transitions

The Enterprise Onboarding and Transitions application allows you to easily automate onboarding and other employee lifecycle events that span multiple departments, which helps to improve employee satisfaction and efficiency across HR and other departments.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Quebec</td>
<td>• Understanding Enterprise Onboarding and Transitions</td>
<td>• Building a lifecycle event</td>
</tr>
<tr>
<td></td>
<td>• Activate Lifecycle Events</td>
<td>• Support multiple jobs in a lifecycle event</td>
</tr>
<tr>
<td></td>
<td>• Activate Lifecycle Events for Enterprise</td>
<td>• Clone a lifecycle event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Preview and test a lifecycle event</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Create an HR case for a lifecycle event</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the HR Service Delivery community</td>
</tr>
<tr>
<td>• Monitor the status of a lifecycle event case</td>
<td>• Developer documentation</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td></td>
<td>• Components installed with Lifecycle Events</td>
<td>• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>

Understanding Enterprise Onboarding and Transitions

Use Enterprise Onboarding and Transitions to automate the fulfillment of employee lifecycle events such as new hire onboarding, offboarding, relocation, promotion, parental leave, and more. Lifecycle events are a collection of activities organized into activity sets to comprise an employee experience.

Overview

Enterprise Onboarding and Transitions enables organizations to easily automate employee experiences and processes that span multiple departments, offering the following benefits.

• Easily snap together experiences and processes to automate cross-departmental work
• Drive action across multiple departments and systems for improved efficiency
• Provide end-to-end visibility on each process to ensure that correct actions are taken
• Guide employees step-by-step so that they know what to do next
• Continually optimize the process with insight from lifecycle event dashboards

The following video provides an overview of the Enterprise Onboarding and Transitions application.

This video provides an overview of the Enterprise Onboarding and Transitions application.

Activation Information

Beginning in the Orlando release, Enterprise Onboarding and Transitions is comprised of two plugins. Depending on the HR Service Delivery package you choose, activate one or both of the plugins.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle Events [com.sn_hr_lifecycle_events]</td>
<td>Enables you to easily configure digital workflows to manage employee lifecycle events within HR. See Activate Lifecycle Events for more information.</td>
</tr>
<tr>
<td>Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent]</td>
<td>Enables you to automate onboarding and other employee lifecycle events that span across multiple departments such as HR, IT, Facilities, Finance, and Legal through a single service delivery platform. See Activate Lifecycle Events for Enterprise for more information.</td>
</tr>
</tbody>
</table>

**Note:** The lifecycle event for new hire onboarding is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

### Configuring Enterprise Onboarding and Transitions

Depending on your role, you can access and configure the following:

**Lifecycle event administrator**

Users with the lifecycle event administrator [sn_hr_le.admin] role can administer and configure any part of the application, including any lifecycle event and its associated activity sets and activities.

- Building a lifecycle event

**Activity set manager**

Users with the activity set manager [sn_hr_le.activity_set_manager] role can build any lifecycle event and the associated activity sets. You can configure any lifecycle event activity, so long as you are a member of the owning group that owns the activity. For example, if you are a member of the HR owning group, then you can configure any activity that is owned by the HR group, such as an employee task to watch an onboarding video or a Fulfiller task to provide relocation assistance.

- Configure a lifecycle event and the associated activity sets

**Activity writer**

Users with the activity writer [sn_hr_le.activity_writer] role can configure any lifecycle event activity, so long as you are a member of the owning group that owns the activity. For example, if you are a member of the IT owning group, then you can configure any activity that is owned by the IT group, such as to set up an active directory account or to set up equipment for a new employee.

- Configure a lifecycle event activity if you are a member of the associated owning group

**Activity reader**

Users with the activity reader [sn_hr_le.activity_reader] role can read any lifecycle event and its associated activity sets and activities.
Using Enterprise Onboarding and Transitions

Once the Enterprise Onboarding and Transitions application is configured, users with the following roles can write and read lifecycle event cases.

ℹ️ Note: A lifecycle event case is an HR case that is fulfilled by a lifecycle event.

**Lifecycle event case writer**

Users with the lifecycle event case writer [sn_hr_le.case_writer] role can create, manage, and monitor the status of any lifecycle event case.

- Create an HR case for a lifecycle event
- Monitor the status of a lifecycle event case

**Lifecycle event case reader**

Users with the lifecycle event case reader [sn_hr_le.case_reader] role can read any lifecycle event case.

### Activate Lifecycle Events

You can activate Human Resources Scoped App: Lifecycle Events [com.sn_hr_lifecycle_events] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Human Resources Scoped App: Lifecycle Events enables you to easily configure digital workflows to manage employee lifecycle events through a single service delivery platform. It activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Scoped App: Core [com.sn_hr_core]</td>
<td>Provides core HR features.</td>
</tr>
<tr>
<td>Employee Service Center [com.sn_hr_service_portal]</td>
<td>Provides Employee Service Center.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

ℹ️ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Components installed with Lifecycle Events

Several types of components install with the activation of the Human Resources Scoped App: Lifecycle Events [com.sn_hr_lifecycle_events] plugin, including tables and user roles.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature, and it is used in some related example tasks.

⚠️ Note: The Human Resources Scoped App: Lifecycle Events [com.sn_hr_lifecycle_events] plugin activates the sn_hr_le.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Enterprise Onboarding and Transition admin user by requiring a minimum number (the default is two) of active users with this role.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle events administrator [sn_hr_le.admin]</td>
<td>Grants access to create, manage, and add users to groups within lifecycle events. Can access: • Guided Setup • Manage Owner Groups • Manage Roles • LE UI Configuration • Onboarding Executive Dashboard • Onboarding Executive View</td>
<td>• sn_hr_le.activity_set_manager • skill_admin • sn_hr_le.case_reader • sn_hr_le.case_writer • sn_hr_core.content_writer • sn_hr_le_pa.admin (When PA-Content Pack - HR LE Scoped App plugin activates) • pa_viewer • survey_admin</td>
</tr>
<tr>
<td>Activity reader [sn_hr_le.activity_reader]</td>
<td>Can read HR activity sets and activities.</td>
<td>• None</td>
</tr>
<tr>
<td>Activity set manager [sn_hr_le.activity_set_manager]</td>
<td>Can activate and trigger HR activity sets.</td>
<td>• sn_hr_le.activity_writer</td>
</tr>
<tr>
<td>Activity writer [sn_hr_le.activity_writer]</td>
<td>Can create HR activity sets and activities.</td>
<td>• sn_hr_le.activity_reader</td>
</tr>
<tr>
<td>Case reader [sn_hr_le.case_reader]</td>
<td>Can read lifecycle event cases.</td>
<td>• sn_hr_core.case_reader</td>
</tr>
<tr>
<td>Case writer [sn_hr_le.case_writer]</td>
<td>Can create lifecycle event cases.</td>
<td>• sn_hr_core.case_writer • sn_hr_le.case_reader</td>
</tr>
<tr>
<td>HR Performance Analytics Administrator [sn_hr_le_pa.admin]</td>
<td>Lifecycle Event Performance Analytics</td>
<td>• None</td>
</tr>
</tbody>
</table>
### Role title [name]

<table>
<thead>
<tr>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin role for the scoped application.</td>
<td></td>
</tr>
<tr>
<td>• Access and modify the Lifecycle Event PA content packs.</td>
<td></td>
</tr>
<tr>
<td>• Edits Performance Analytics properties.</td>
<td></td>
</tr>
<tr>
<td>• Accesses Admin Console.</td>
<td></td>
</tr>
<tr>
<td>• Launch Dependency Assessment.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** This role is contained in the lifecycle events administrator role [sn_hr_le.admin].

## Note:
The Lifecycle Event Administrator (sn_hr_le.admin) role with the Delegated Developer (delegated_developer) role can also configure and create COEs. For more information, see HR Centers of Excellence data model.

You can assign these roles to the appropriate roles, groups, or users in your application.

- To assign a role to another role, see Add a role to an existing role.
- To assign a role to a group, see Assign a role to a group.
- To assign a role to a user, see Assign a role to a user.

For further information on user administration and how to manage users, see User administration.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity [sn_hr_le_activity]</td>
<td>Details of activities that are part of an activity set and together make up a Lifecycle Event. Extends the Activity Base [sn_hr_le_activity_base] table.</td>
</tr>
<tr>
<td>Activity Base [sn_hr_le_activity_base]</td>
<td>Extends sys_metadata.</td>
</tr>
<tr>
<td>Activity Field Mapping [sn_hr_le_activity_field_mapping]</td>
<td>Details of an activity field mapping that pass information from the parent lifecycle event case to an activity.</td>
</tr>
<tr>
<td>Activity Set [sn_hr_le_activity_set]</td>
<td>Details of activity sets and activities that make up Lifecycle Events.</td>
</tr>
<tr>
<td>Activity Set Context [sn_hr_le_activity_set_context]</td>
<td>Created for each Activity Set when the Lifecycle Event initializes. Tracks the state of</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>each set (triggered, waiting for activities to complete, and more).</td>
</tr>
<tr>
<td></td>
<td>Works with the Activity Status [sn_hr_le_activity_status] table to provide filtering for the Lifecycle Event widget on the Ticket page.</td>
</tr>
<tr>
<td>Activity Status</td>
<td>Created when an Activity Set triggers and tracks the state of the activity created. Tracks the progress of the Activity for each Lifecycle Event case that initializes.</td>
</tr>
<tr>
<td>[sn_hr_le_activity_status]</td>
<td>Works with the Activity Set Context [sn_hr_le_activity_set_context] table to provide filtering for the Lifecycle Event widget on the Ticket page.</td>
</tr>
<tr>
<td>Fulfiller Activity Configuration</td>
<td>Fulfiller activity configuration passes field information from the Lifecycle Event Case [sn_hr_le_case] table to the HR case [sn_hr_core_case] table.</td>
</tr>
<tr>
<td>[sn_hr_le_fulfiller_activity_config]</td>
<td></td>
</tr>
<tr>
<td>Fulfiller Activity Configuration Mapping</td>
<td>Fulfiller Activity Configuration Mappings copy to all activities created using the fulfiller configuration.</td>
</tr>
<tr>
<td>[sn_hr_le_fulfiller_activity_config_mapping]</td>
<td></td>
</tr>
<tr>
<td>HR Lifecycle Events Case</td>
<td>Details of a submitted Lifecycle event case.</td>
</tr>
<tr>
<td>[sn_hr_le_case]</td>
<td>• Account Notification</td>
</tr>
<tr>
<td></td>
<td>• Request Onboarding</td>
</tr>
<tr>
<td></td>
<td>Extends the HR Case [sn_hr_core_case] table.</td>
</tr>
<tr>
<td>Lifecycle Event Type</td>
<td>Lifecycle Event Types are a way to organize activity sets and activities together. Lifecycle Event Types act as a container for activity sets and activities. Lifecycle Event Types are also associated with an HR Service.</td>
</tr>
<tr>
<td>[sn_hr_le_type]</td>
<td></td>
</tr>
<tr>
<td>LE UI Configuration</td>
<td>Lifecycle Event user interface configuration details.</td>
</tr>
<tr>
<td>[sn_hr_le_builder_ui_configuration]</td>
<td></td>
</tr>
<tr>
<td>Employee Request</td>
<td>Tracks details of Employee Requests. Created when an Employee Request is created.</td>
</tr>
<tr>
<td>sn_hr_le_employee_request</td>
<td>Works with the Activity Base [sn_hr_le_activity_base] table.</td>
</tr>
<tr>
<td>Future To-dos</td>
<td>Tracks details about activities waiting to be triggered.</td>
</tr>
<tr>
<td>[sn_hr_le_future_todo]</td>
<td></td>
</tr>
</tbody>
</table>

For further information on table administration and how to manage data, see **Table administration**.

**Lifecycle event script includes and APIs**

Script includes call workflows within Lifecycle Events.

The following script includes are provided with Lifecycle Events:
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hr_ActivitySet</td>
<td>Main script include for Lifecycle Events workflows and activity management.</td>
</tr>
<tr>
<td>LaunchActivities</td>
<td>API to launch an instance of all activities under an activity set. Called when a Lifecycle Event case is created.</td>
</tr>
<tr>
<td>getAvailableDependentActivitySets(activitySet)</td>
<td>Retrieves a collection of dependent activity sets for an activity set.</td>
</tr>
<tr>
<td>isActivitySetCompleted</td>
<td>Checks when all activities in a set are complete.</td>
</tr>
<tr>
<td>IsActivitySetActive</td>
<td>Checks when an activity set is active.</td>
</tr>
</tbody>
</table>

The following APIs are provided with Lifecycle Events:

- **hr_LEType** - Contains methods related to Lifecycle Event types, activity sets, and activity set activities.

Methods related to Lifecycle Event Types:

- **createLEType(@param - REQUIRES: Array of js objects having field name value pairs) - Returns js object with status - ‘success’**.
- **updateLEType(@param - REQUIRES: Array of js objects having field's name value pairs and Lifecycle Event Type Id) - Returns js object with status - ‘success’**.
- **removeLEType(@param - REQUIRES: Lifecycle Event Type Id) - Returns js object with status - ‘success’**.

Methods related to Activity Sets:

- **createActivitySet(@param - REQUIRES: Array of js objects having field's name value pairs) - Returns js object with status - ‘success’**.
- **updateActivitySet(@param - REQUIRES: Array of js objects having field's name value pairs and ActivitySetId) - Returns js object with status - ‘success’**.
- **removeActivitySet(@param - REQUIRES: activitySetId) - Returns js object with status - ‘success’**.

Advanced:

- **Hr_triggerUtil** – Convenienc methods for advanced scripting on running activity sets.
- **checkActivitySetsCompleted(activitySetList) - Verify when activity sets in the list are complete.**
- **checkForElapsedTime(date) - Verify when the date passed in has elapsed.**
- **checkForElapsedTimeWithOffset(date, offset, offsetUnits, offsetType)**

**Lifecycle event workflows**

The **HR Activity Set Launcher** workflow drives the entire lifecycle event process. Associated workflows drive each of the activity sets within a lifecycle event.

When a lifecycle event case is created:

- The **Invoke Activity Set Launcher Workflow** business rule runs.
- The **HR Activity Set Launcher** workflow starts.
The workflow runs for the duration of the lifecycle event case and manages the activity sets.

**Note:** You can access the workflows from **Execution Contexts**.

Each activity set in a lifecycle event has an associated workflow. Each workflow:

- Monitors trigger conditions and dependencies on other activity sets to generate activities.
- Checks the status of activities in the workflow every four hours (default) for activity sets triggered by date or a custom script.
- Checks the status of activities when an activity case or request is updated.
- Closes the activity set when activities are marked complete.

The base system limits the total number of activity sets that can run at the same time to 10. This value can be increased, but system performance can be affected.

**Note:** The **Evaluation interval** field is not revealed by default. This field works with the **Max activity count** field on the **Activities** tab under Workflow Properties. See **Workflow properties**. If you reveal the **Evaluation interval** field with the intention of changing the default value (four hours), use caution. Frequent updates mean that more events fire and could cause your lifecycle event activity sets to cancel before the Lifecycle Event completes. For workflows associated with Lifecycle Events, the value of the **Max activity count** field has been increased to accommodate long running business processes that contain multiple workflow activities.

- Open Workflow Editor.
- From Workflows, select **HR Activity Set Launcher**.
- Under Parallel Flow Launcher, click the **Activity Properties**.
Update the **Max Simultaneous** value.
See Parallel Flow Launcher workflow activity.

**Activate Lifecycle Events for Enterprise**
You can activate the Human Resources Scoped App: Lifecycle Events for Enterprise plugin [com.sn_hr_lifecycle_ent] if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
Human Resources Scoped App: Lifecycle Events for Enterprise enables you to automate onboarding and other employee lifecycle events that span across multiple departments such as IT, Facilities, Finance, and Legal.
It activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Scoped App: Core [com.sn_hr_core]</td>
<td>Provides core HR features.</td>
</tr>
<tr>
<td>Employee Service Center [com.sn_hr_service_portal]</td>
<td>Provides Employee Service Center.</td>
</tr>
<tr>
<td>Human Resources Scoped App: Lifecycle Events</td>
<td>Provides lifecycle events.</td>
</tr>
<tr>
<td>[com.sn_hr_lifecycle_events]</td>
<td></td>
</tr>
</tbody>
</table>

**Plugins for Human Resources Scoped App: Lifecycle Events for Enterprise**

**Procedure**
1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Components installed with Lifecycle Events for Enterprise**
Several types of components are installed with activation of the Human Resources Scoped App: Lifecycle Events for Enterprise plugin [com.sn_hr_lifecycle_ent] plugin, including user roles and tables.
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle events for enterprise administrator [sn_hr_le_ent.admin]</td>
<td></td>
<td>None</td>
</tr>
<tr>
<td>Document templates reader [sn_doc.reader]</td>
<td>Provides read-only permission to document templates.</td>
<td>None</td>
</tr>
<tr>
<td>Document templates writer [sn_doc.writer]</td>
<td>Provides read and write permissions to document templates.</td>
<td>sn_doc.reader</td>
</tr>
<tr>
<td>Document templates administrator [sn_doc.admin]</td>
<td>Provides read, write, and delete permissions to document templates.</td>
<td>sn_doc.writer</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF Template Mapping [sn_doc_pdf_template_mapping]</td>
<td>Table to store the fields mappings of a PDF document template.</td>
</tr>
<tr>
<td>HTML Template [sn_doc_html_template]</td>
<td>Table to store HTML document templates.</td>
</tr>
<tr>
<td>PDF Template [sn_doc_pdf_template]</td>
<td>Table to store PDF document templates.</td>
</tr>
<tr>
<td>Participant [sn_doc_participant]</td>
<td>Table to store the details defined for participants.</td>
</tr>
<tr>
<td>Document Task [sn_doc_task]</td>
<td>Table to store document template tasks.</td>
</tr>
<tr>
<td>Document Task Note [sn_doc_task_note]</td>
<td>Table to store the details of review notes.</td>
</tr>
<tr>
<td>Document Template Category [sn_doc_template_category]</td>
<td>Table to store document template categories.</td>
</tr>
<tr>
<td>Document Template Script</td>
<td>Table to store document template scripts.</td>
</tr>
</tbody>
</table>
Building a lifecycle event

Lifecycle events enable you to automate the fulfillment of HR cases such as new hire onboarding. Each lifecycle event is a collection of activities that often span multiple departments and are organized into activity sets. To configure a lifecycle event, you must first document the business process for your event. Next, you must configure all of the supporting components. You can then configure the lifecycle event and its associated activity sets and activities. Finally, you configure a corresponding HR service so that the lifecycle event can be requested for service.

The following video provides an overview on lifecycle event configuration with the Enterprise Onboarding and Transitions application.

This video provides an overview on how to configure the Enterprise Onboarding and Transitions application.

ɪ Note: If you are further customizing an existing lifecycle event, follow the configuration tasks as applicable.

Document the lifecycle event process

Define and document the lifecycle event process. Lifecycle events are generally cross-departmental and require action from different departments. It is thus critical that everyone agrees on the flow and their areas of responsibility. As you map out a lifecycle event, the associated activity sets, and the activities that comprise it, consider who is responsible for owning the activity, what the activity type is, and if there is a targeted audience for that activity.

Defining the lifecycle event

As you map out and define your lifecycle event, consider the following.

- What is the lifecycle event type? Examples of lifecycle events include employee onboarding, offboarding, and parental leave.
- What are the different stages of the lifecycle event? These stages are represented as activity sets, which act as containers for the associated activities. Each activity set is triggered based on specified conditions.
- What are the different activities for each activity set? For each activity, determine the appropriate owning group, activity type, and audience.
  - Who owns the activity? Lifecycle events generally span multiple departments. Each activity must be owned by the relevant group that is responsible for overseeing and maintaining that activity, such as HR, IT, or Facilities.
  - What is the activity type? Is it a task for an employee or fulfiller? An approval or notification?
    - Approvals
    - Tasks for employees
    - Activities for fullfills, which can be configured as order guides, catalog items, HR services, HR tasks, incidents, and more
    - Notifications
  - Is there a targeted audience for the activity? Some activities are not required for all employees, and you can use audience records to target the activity to the appropriate user types.
Example: New hire onboarding

New hire onboarding is a lifecycle event that is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin. The event is organized into activity sets, such as pre-hire, pre-boarding, and day one, which represent different stages in the lifecycle event process. Each activity set contains one or more activities, such as a task for the employee to enroll in medical benefits or a request for an IT fulfiller to set up a new hire's phone and voicemail.

Configure the supporting components for a lifecycle event

Configure the supporting components for a lifecycle event. Lifecycle events are a collection of activities. For each activity, you must identify and configure the underlying components that support it, such as HR task templates, order guides, catalog items, and HR services. You must also identify and configure the relevant owning groups, activity types, and audience records.

- Owning groups
- Activity types
- Audiences

Owning groups

Owning groups control who owns a lifecycle event activity. Because lifecycle events are generally cross-departmental, it is critical that ownership of each activity is assigned to the appropriate group, such as for HR, IT, or Facilities. Each owning group is responsible for overseeing the activities that fall under their purview. See Configure an owning group for a lifecycle event for more information.

To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role. For example, only members of the HR activity writers owning group with the sn_hr_le.activity_writer role can configure an HR activity.
### Activity types

Lifecycle event activities can be approvals, employee activities, fulfiller activities, notifications, and more. Depending on the activity type, you must configure the appropriate components that underlie it.

A key benefit of the Enterprise Onboarding and Transitions application is that you can reuse existing components and processes, such as existing HR services, HR task templates, or catalog items. For each activity, determine whether there is an existing component that you can use or if you must configure a new one.

<table>
<thead>
<tr>
<th>Activity type</th>
<th>Configuration requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval</td>
<td>• N/A</td>
</tr>
<tr>
<td></td>
<td>To learn more about approvals, see <a href="#">Approvals</a></td>
</tr>
<tr>
<td>Employee task</td>
<td>• Configure an HR task template</td>
</tr>
<tr>
<td></td>
<td>To learn more about HR templates, see <a href="#">HR templates</a></td>
</tr>
<tr>
<td>Fulfiller activity</td>
<td>Depending on the fulfiller activity type, configure the appropriate supporting components.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The following fulfiller activity types are preconfigured with the Enterprise Onboarding and Transitions application. To configure additional types, see <a href="#">Configure an activity configuration for a lifecycle event</a>.</td>
</tr>
<tr>
<td>Automated Order Guide</td>
<td>• Create an order guide</td>
</tr>
<tr>
<td></td>
<td>To learn more about order guides, see <a href="#">Order guides</a></td>
</tr>
<tr>
<td>Activity type</td>
<td>Configuration requirements</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Catalog item</td>
<td>• Create or edit a catalog item&lt;br&gt;<strong>Important:</strong>&lt;br&gt;Only the <em>Switch primary job</em> subflow that is used to support multiple jobs in a lifecycle event is available to use out-of-box.&lt;br&gt;To use a different subflow with the activity, additional configuration is required. See the <a href="https://knowledge.citrix.com/en-US/KB0817520.html">Implementing multiple subflows in an LE activity</a> article in the HI Knowledge Base for more information.</td>
</tr>
<tr>
<td>HR service</td>
<td>• Configure an HR service&lt;br&gt;<strong>Important:</strong> To learn more about HR services, see <a href="https://knowledge.citrix.com/en-US/KB0817520.html">HR services</a>.</td>
</tr>
<tr>
<td>HR task</td>
<td>• Configure an HR task template&lt;br&gt;<strong>Important:</strong> To learn more about HR templates, see <a href="https://knowledge.citrix.com/en-US/KB0817520.html">HR templates</a>.</td>
</tr>
<tr>
<td>Incident</td>
<td>• Create an incident template&lt;br&gt;<strong>Important:</strong> To learn more about incident management, see <a href="https://knowledge.citrix.com/en-US/KB0817520.html">Incident Management</a>.</td>
</tr>
<tr>
<td>Notification</td>
<td>• Create an email template&lt;br&gt;<strong>Important:</strong> To learn more about notifications, see <a href="https://knowledge.citrix.com/en-US/KB0817520.html">Notifications</a>.</td>
</tr>
<tr>
<td>Flow</td>
<td>• Create a subflow&lt;br&gt;<strong>Important:</strong> To learn more about subflows, see <a href="https://knowledge.citrix.com/en-US/KB0817520.html">Subflows</a>.</td>
</tr>
<tr>
<td>Content</td>
<td>• Configure a schedule content template for a lifecycle event activity&lt;br&gt;<strong>Important:</strong> To learn more about content delivery, see <a href="https://knowledge.citrix.com/en-US/KB0817520.html">Employee content publishing and delivery</a>.</td>
</tr>
<tr>
<td>Activity container</td>
<td>• N/A</td>
</tr>
</tbody>
</table>

**Audiences**

Not all lifecycle event activities are required for all employees. Some activities have a targeted audience, and you can use audience records to define the conditions or criteria that the subject person of a lifecycle event case must meet for the activity to trigger on their behalf. See [Configure an audience record](https://knowledge.citrix.com/en-US/KB0817520.html) for more information.
This allows you to create targeted workflows for different audience types. For example, you can create a tailored onboarding experience for new hire employees depending on whether the employee is office-based or remote.

**Note:** If no audience record is applied to an activity, then the activity triggers for all employees.

Configure an owning group for a lifecycle event

Create or modify an owning group to define the user group that owns a lifecycle event activity. Each owning group is responsible for overseeing the activities that fall under their purview. To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role. For example, only members of the IT activity writers owning group with the sn_hr_le.activity_writer role can configure an IT activity.

**Before you begin**
Role required: sn_hr_le.admin

**Procedure**
1. Navigate to Lifecycle Events > Administration > Manage Owner Groups.
2. Click New or open a record.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the owning group.</td>
</tr>
<tr>
<td>Manager</td>
<td>Manager of the owning group.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the owning group.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Group email | Email address to associate with the owning group. This email acts as a group notification that sends an email to every member of the group.
Parent | Parent group to associate with the owning group.

4. Click **Save**.

5. In the **Roles**, **Group members**, **Groups**, and **Skills** related lists, assign the appropriate roles, users, groups, or HR skills to the owning group.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
</table>
| Roles | Roles assigned to the owning group.  
   **Note:** Any roles assigned to the parent group are automatically assigned to the owning group. |
| Group members | Users assigned to the owning group. |
| Groups | Groups assigned to the owning group.  
   **Note:** Any groups assigned to the parent group are automatically assigned to the owning group. |
| Skills | HR skills assigned to the owning group.  
   **Note:** Any HR skills assigned to the parent group are automatically assigned to the owning group. |

6. Click **Update**.

**Configure an activity configuration for a lifecycle event**

Create or modify an activity configuration to define the fulfillment process and conditions for closure for a lifecycle event activity. A key benefit of the Enterprise Onboarding and Transitions application is that you can leverage existing fulfillment processes from different departments to fulfill lifecycle event activities that are assigned to them. For example, you can use a fulfillment process set up by the IT department to fulfill lifecycle event activities assigned to IT. Preconfigured activity types are available to use. You can also configure your own custom activity types.

**Before you begin**

Role required: sn_hr_le.admin or sn_hr_le.activity_set_manager

**Procedure**

1. Navigate to **Lifecycle Events > Administration > Manage Activity Configuration**.
2. Click **New** or open a record.
3. Fill in the fields on the form.

**Fulfiller Activity Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fulfiller activity</td>
<td>Name of the fulfiller activity type.</td>
</tr>
</tbody>
</table>
| Configuration type | Configuration type. Select one of the following:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog item</td>
<td>Creates a task, request, or case based on an existing catalog item. In the <strong>Catalog</strong> field, select a catalog.</td>
</tr>
<tr>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>Flow</td>
<td>Creates a flow on the parent lifecycle event case.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>A flow automates a process with a sequence of reusable actions. See <strong>Flow designer</strong> for more information.</td>
</tr>
<tr>
<td>HR service</td>
<td>Creates a case based on an HR service.</td>
</tr>
<tr>
<td>HR task template</td>
<td>Creates a task based on an HR task template.</td>
</tr>
<tr>
<td>Order guide</td>
<td>Creates an IT request based on an order guide. In the <strong>Catalog</strong> field, select a catalog.</td>
</tr>
<tr>
<td>Template</td>
<td>Creates a record on a task table that supports templates.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Creates a workflow on the parent lifecycle event case. In the following fields, provide the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Workflow</strong>: A workflow that runs on the parent lifecycle event case.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Workflow required fields</strong>: Fields on the activity form that are required to be populated for the workflow.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Workflow optional fields</strong>: Fields on the activity form that are optional and populated for the workflow.</td>
</tr>
<tr>
<td>Activity closure</td>
<td>Conditions that must be met for the fulfiller activity to close and for the State value to change to Completed.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Once all of the activities in an activity set are completed, then the State value of the activity set will change to Finished.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the fulfiller activity type for use.</td>
</tr>
<tr>
<td>Task table</td>
<td>Table that the fulfiller activity type is associated with. Depending on the <strong>Configuration type</strong> selected, you can select a table or the field is automatically set to a table.</td>
</tr>
<tr>
<td>Badge</td>
<td>Badge that the fulfiller activity type is associated with.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Badges display on the portal to indicate to the employee which department is fulfilling that activity. See <strong>Configure an HR badge</strong> for more information.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
5. In the **Fulfiller Activity Configuration Mappings** section, map one or more fields from the parent lifecycle event case to the child activity.

   a. Click **New** or open a record.

   b. Fill in the fields on the form.

   **Fulfiller Activity Configuration Mapping table**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity type configuration</td>
<td>This field is automatically set to the name of the fulfiller activity type.</td>
</tr>
<tr>
<td>Map from table</td>
<td>HR case table that the parent HR service is associated with.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure that this table matches that of the HR case table associated with the parent HR service.</td>
</tr>
<tr>
<td>Map from field</td>
<td>Field that is being mapped from.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure that the data type matches that of the target field.</td>
</tr>
<tr>
<td>Map to table</td>
<td>This field is automatically set to the table that the fulfiller activity type is associated with.</td>
</tr>
<tr>
<td>Map to field</td>
<td>Field that is being mapped to.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure that the data type matches that of the source field.</td>
</tr>
</tbody>
</table>

   **Example**
   For example, the preconfigured fulfiller activity type for catalog items maps the subject_person field from the HR Lifecycle Events Case [sn_hr_le_case] table to the requested_for field on the Request [sc_request] table so that the activity form is automatically populated with the name of the user that the catalog item is being requested for.

   c. Click **Submit** or **Update**.

   d. Repeat the process as needed.

6. Click **Update**.

**Configure a schedule content template for a lifecycle event activity**

Create or modify a schedule content template to deliver content as part of a lifecycle event. Each template must be associated with the Schedule Content [sn_cd_content_visibility] table, and you can configure the template for mobile content, portal content, notification content, or to-do content.

**Before you begin**

Have the content that you want to use with the schedule content template. You can use the following types of content:
Content types

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile content</td>
<td>Mobile content is delivered as a mobile banner in the Now Mobile and Mobile Onboarding apps.</td>
</tr>
<tr>
<td>Portal content</td>
<td>Portal content is delivered as content (such as a banner, calendar, or video) in a portal such as the Employee Service Center.</td>
</tr>
<tr>
<td>Notification content</td>
<td>Notification content is delivered as a notification.</td>
</tr>
<tr>
<td>To-do content</td>
<td>To-do content is delivered as a to-do in both portal and mobile.</td>
</tr>
</tbody>
</table>

Role required: admin

Procedure
1. Navigate to **System Definition > Templates**.
2. Click **New** or open a record.
3. Fill in the following fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the template.</td>
</tr>
<tr>
<td>Table</td>
<td>Set the value to Schedule Content [sn_cd_content_visibility].</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description of the template.</td>
</tr>
</tbody>
</table>

4. From the **Template** field, add the **Content** field.

5. For the **Content** field, select a content record to use with the template.

**Example**

For example, this is a schedule content template for a content record called “Welcome to Content Delivery Banner.”
6. Add additional fields with corresponding values, as needed.

Depending on the content type, you must add additional fields with corresponding values. Content is one of the following types.

- Mobile content
- Portal content
- Notification content
- To-do content

For a list of the available fields for each content type, see Schedule the delivery of HR content.

Example

For example, the content type for the "Welcome to Content Delivery Banner" record is portal content. Portal content requires, at a minimum, the addition of the Title, Widget instance, and Audience fields.

7. Click Submit or Update.

What to do next

Use the schedule content template to deliver content as part of a lifecycle event. See Configure a lifecycle event activity for content for more information.
Configure a lifecycle event

Build a lifecycle event and its associated activity sets and activities with the lifecycle event builder. Begin by defining the event type, such as new hire onboarding. Each lifecycle event has one or more activity sets, which represent different stages in the lifecycle event process. And each activity set has one or more activities, which can be requests for approvals, tasks for employees, activities for fulfillers, or the sending of notifications.

Before you begin
Role required: sn_hr_le.admin or sn_hr_le.activity_set_manager

Procedure
1. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events.
2. Click New or open a record.
3. Fill in the fields on the form.

Manage Lifecycle Event form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event.</td>
</tr>
<tr>
<td>Display activity sets to subject person</td>
<td>(Employee Service Center only) Option to show the activity sets timeline on the HR ticket page to the subject person of the lifecycle event case. This is a two-part process. In addition to selecting the box here, you must also select Show case to subject person for the HR service that the lifecycle event is associated with. To select the latter, see Configure an HR service.</td>
</tr>
</tbody>
</table>

Note:

- If Show case to subject person for the corresponding HR service is not selected, then the activity sets timeline will not display for the subject person.
- The progress bar for each activity set does not appear for the subject person. It only appears for the opened for person.
- The HR ticket page is where users can view the details of an HR case in the Employee Service Center. See HR ticket page for more information.

<table>
<thead>
<tr>
<th>Event type</th>
<th>Event type of the lifecycle event. Select one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboarding</td>
<td>Lifecycle event to use with the Mobile Onboarding app.</td>
</tr>
<tr>
<td>Note:</td>
<td>You must also make sure that the Display activity sets to subject person option on the lifecycle event form and the Show case to subject person option on the corresponding HR service form are selected. See Select a lifecycle event for mobile onboarding for more information.</td>
</tr>
<tr>
<td>Offboarding</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transitions</td>
<td></td>
</tr>
<tr>
<td>HR Services</td>
<td></td>
</tr>
<tr>
<td>Parental Journey</td>
<td>A referenced implementation for leaves of absence needed when an employee has a child. For example, maternity, paternity, or adoption leave.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the lifecycle event for use.</td>
</tr>
</tbody>
</table>

4. Click the **Activity Sets** tab or **Next** to configure the activity sets and activities for the lifecycle event.
   You can create new or modify existing activity sets and activities. For further details on the form fields, see:
   - Configure a lifecycle event activity set
   - Configure a lifecycle event activity

5. Click **Submit** or **Update**.

**Configure a lifecycle event activity set**
Create or modify a lifecycle event activity set to define a container for a group of activities. Activity sets represent different stages in the lifecycle event process, and you must define when the activity set is triggered, such as immediately upon creation of the lifecycle event case or after the completion of another activity set. Each activity set is associated with a single lifecycle event.

**Before you begin**
Role required: sn_hr_le.admin or sn_hr_le.activity_set_manager
Procedure

1. Navigate to **Lifecycle Events > Administration > Manage Lifecycle Events**, and open a record.

2. Click the **Activity Sets** tab to access the lifecycle event builder.

3. Create a new or modify an existing activity set.
   - To create a new activity set, click **New Activity Set**.
   - To modify an existing activity set, hover over the activity set and click **Edit Activity Set**.

4. Fill in the fields on the form.

### Activity Set form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity set.</td>
</tr>
<tr>
<td>Display title</td>
<td>Display title of the activity set. The display title is employee-facing only, and appears on the activity sets timeline on the HR ticket page in both portal and mobile. For example, an employee-facing title for the preboarding activity set could be &quot;Get ready for day one.&quot; If no display title is provided, the default activity set name will be used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity set.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the lifecycle event activity set for use.</td>
</tr>
<tr>
<td>Display order</td>
<td>Order number for when the activity set appears in the lifecycle event builder and in the activity sets timeline on the HR ticket page.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>• The order number has no relation to when the activity set is triggered.</td>
</tr>
<tr>
<td></td>
<td>• If no order number is provided, then the activity set will appear after all of the numbered activity sets.</td>
</tr>
<tr>
<td></td>
<td>• The HR ticket page is where users can view the details of an HR case in the Employee Service Center. See <a href="#">HR ticket page</a> for more information.</td>
</tr>
</tbody>
</table>

**Display to opened for**

Option to show or hide the activity set to the opened for person of the lifecycle event case. If selected, the activity set will appear in the activity sets timeline on the HR ticket page in both portal and mobile.

**Note:** If not selected, the activity set will not appear in the activity sets timeline. Any associated to-dos assigned to the opened for and subject person will still appear on the HR ticket page. However, to-dos that are assigned to anyone else will be hidden.

**Display to subject person**

Option to show or hide the activity set to the subject person of the lifecycle event case. If selected, the activity set will appear in the activity sets timeline on the HR ticket page in both portal and mobile. This is a three-part process. In addition to selecting the check box here, you must also:

• Select **Display activity sets to the subject person** for the lifecycle event type. See [Configure a lifecycle event](#) for more information.

• Select **Show case to subject person** for the HR service that the lifecycle event is associated with. See [Configure an HR service](#) for more information.

**Note:** If not selected, the activity set will not appear in the activity sets timeline. Any associated to-dos assigned to the subject person will still appear on the HR ticket page. However, to-dos that are not assigned to the subject person will be hidden.

5. In the **Activity Set Trigger Condition** section, set the trigger condition for the activity set.

<table>
<thead>
<tr>
<th>Trigger condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immediate</td>
<td>Activity set triggers upon creation of the lifecycle event case.</td>
</tr>
<tr>
<td>Date</td>
<td>Activity set triggers before, on, or after the specified date.</td>
</tr>
</tbody>
</table>

**Note:** If the date for the activity set is updated, then the change will apply only to open HR cases with active activity sets that have not yet triggered.

<p>| Trigger table | Select an HR case or profile table.                                                                                                                     |
| Trigger field | Select a date field.                                                                                                                                      |</p>
<table>
<thead>
<tr>
<th>Trigger condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore empty date</td>
<td>Option to not trigger the activity set when the date field is empty. If selected, the activity set will not trigger when the date field does not have a value.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Select the date offset type:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Before</td>
</tr>
<tr>
<td></td>
<td>• After</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>Provide an offset quantity. This field is available when Before or After is selected from Date offset type.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>Provide a unit of measure of days, weeks, or months. This field is available when Before or After is selected from Date offset type.</td>
</tr>
</tbody>
</table>

| Other Activity Sets      | Activity set triggers after the completion of one or more activity sets.                                                                     |
|                         | Activity set dependencies Select one or more activity sets that must complete before the activity set triggers.                             |

| Advanced                 | Activity set triggers per the provided script.                                                                                               |
|                         | Trigger script                                                                                                                                 |
|                         | Provide a custom script to determine when the activity set triggers.                                                                         |
|                         | There are two variables in the scripts:                                                                                                      |
|                         |     • parentCase: Reference to parent lifecycle event case.                                                                                   |
|                         |     • hrTriggerUtil: Allows checking of other activity sets or dates from other types of triggers.                                            |
|                         | The Activity Set Launcher workflow runs every four hours to verify these conditions. See Lifecycle event workflows.                             |

| Condition                | Activity set triggers per the specified conditions.                                                                                          |
|                         | Condition table Select an HR case or HR profile table.                                                                                       |
|                         | Condition Use the condition builder to define the conditions that must be met for the activity set to trigger.                               |

<p>| Combination              | Activity set triggers based on a combination of a specified date, other activity sets, and/or conditions.                                    |
|                         | Combination type Select when the activity set triggers:                                                                                     |
|                         |     • And: Activity set triggers only when all of the specified triggers are met.                                                           |
|                         |     • Or: Activity set triggers when any of the specified triggers are met.                                                                 |</p>
<table>
<thead>
<tr>
<th>Trigger condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>You can specify a date as part of the combination trigger type.</td>
</tr>
<tr>
<td>Other Activity Sets</td>
<td>You can select one or more activity sets that must complete as part of the combination trigger type.</td>
</tr>
<tr>
<td>Condition</td>
<td>You can use the condition builder to define the conditions that must be met as part of the combination trigger type.</td>
</tr>
</tbody>
</table>

6. Click **Submit** or **Update**.

**Example: Advanced trigger script**

- Trigger type = advanced.
- The new hire (Subject Person) has an assigned manager.
- The start date for the new hire has been reached (cannot be empty).
- Two specific activity sets have completed.

```javascript
function shouldActivitySetTrigger(parentCase /* GlideRecord for parent case */,
hrTriggerUtil /* hr_TriggerUtil script include instance */) {
    // Check that employee has a manager
    var employeeLocationType = parentCase.subject_person.manager;
    if (gs.nil(employeeLocationType))
        return false;

    // Check that the employee's start date is populated and on or before today
    var employeeStartDate = parentCase.subject_person.hr_profile.employment_start_date;
    if (gs.nil(employeeStartDate) || ![hrTriggerUtil.checkForElapsedDate(employeeStartDate, getDisplayValue())])
        return false;

    // Check Previous sets have finished
    var prerequisiteActivitySetIds = ['207a9c84b61309664b37fc82f556f', '58123661dfb2930058a4a50c9f619b'];
    if (hrTriggerUtil.checkActivitySetsCompleted(prerequisiteActivitySetIds))
        return false;

    return true;
}(parentCase, hrTriggerUtil);
```

Replace the sys_ids in the example with your activity set sys_ids. From your activity set, click the **Form Context Menu** icon and select **Copy sys_id**.

**Configure a lifecycle event activity**

Create or modify a lifecycle event activity. Lifecycle event activities can be approvals, employee tasks, fulfiller activities, notifications, flows, content, or activity containers. Each activity must be associated with an owning group. If the activity has a targeted audience, you can use audience records to define the conditions or criteria that the subject person of a lifecycle event case must meet for the activity to trigger on their behalf. Each activity is associated with a single activity set.

**Before you begin**

Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

**Procedure**

1. Navigate to **Lifecycle Events > Administration > Manage Lifecycle Events**, and open a record.
2. Click the **Activity Sets** tab to access the lifecycle event builder.
3. Create a new or modify an existing activity.
   • To create a new activity, click **Add Activity**.
   • To modify an existing activity, hover over the activity and click **Edit Activity**.

4. On the Activity form, set the **Activity type** field to one of the following:
   • Approval
   • Employee task
   • Fulfiller activity
   • Notification
   • Flow
   • Content
   • Activity container
   For each activity type, follow the applicable task.

   **For an approval**
   Configure a lifecycle event activity that is an approval. Approvals create a to-do for the specified approvers to approve or reject.

   **Before you begin**
   Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

   **Procedure**
   1. On the Activity form, set the **Activity type** field to Approval.
   2. Fill in the fields on the form, as appropriate.

   **Activity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to Approval.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td>Owning group</td>
<td>Owning group that the activity is associated with.</td>
</tr>
</tbody>
</table>

**Note:**
- Owning groups control who owns a lifecycle event activity. To learn more, see Configure an owning group for a lifecycle event.
- To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity set</td>
<td>Activity set that the activity is associated with.</td>
</tr>
<tr>
<td>Audience</td>
<td>Defines whether the activity should trigger for the lifecycle event case.</td>
</tr>
<tr>
<td></td>
<td>You can apply one or more audience records. The subject person of the</td>
</tr>
<tr>
<td></td>
<td>lifecycle event case must meet the conditions or criteria of all audience</td>
</tr>
<tr>
<td></td>
<td>records for the activity to trigger in the case. If no audience record is</td>
</tr>
<tr>
<td></td>
<td>selected, then the activity will always trigger for the case.</td>
</tr>
</tbody>
</table>

**Note:** Audience records define the conditions or criteria that a user must meet. To learn more, see Configure an audience record.

3. In the **Approvers** related list, define the approvers for the lifecycle event activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approver groups</td>
<td>Groups to approve the activity.</td>
</tr>
<tr>
<td>Approver users</td>
<td>Users to approve the activity.</td>
</tr>
<tr>
<td>Approvers from case</td>
<td>User from the lifecycle event case to approve the activity.</td>
</tr>
</tbody>
</table>

4. In the **Approval Options** related list, set how the activity is approved.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait for</td>
<td>Select one of the following actions for when an approval is completed:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Anyone to approve</td>
<td>Only one person is required to approve the HR activity.</td>
</tr>
<tr>
<td>Everyone to approve</td>
<td>Everyone assigned to the HR activity is required to approve it. If one person rejects, the Assigned to person receives a message with a link to select a substitute approver.</td>
</tr>
<tr>
<td>First response from anyone</td>
<td>The first person to respond (approve or reject) to the activity determines the state.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>On rejection</strong></td>
<td>Select one of the following actions for when an approval is rejected:</td>
</tr>
<tr>
<td>Allow resubmit of approvals</td>
<td>An HR agent can resubmit for approval. The Assigned to person receives a message on the case with a link to resubmit approval requests. All approvers are resubmitted the approval request.</td>
</tr>
<tr>
<td>Close incomplete</td>
<td>When the HR service is rejected, change the State of the case or task to <strong>Closed and Incomplete</strong>.</td>
</tr>
<tr>
<td><strong>Missing any approver</strong></td>
<td>Select one of the following actions for when any approver is missing:</td>
</tr>
<tr>
<td>Select replacements</td>
<td>When an approver is missing, the Assigned to person can select a replacement. If the activity is configured to have the Opened for Manager to approve, but the Opened for person has no manager assigned, the activity has a missing approver. If <strong>Select replacements</strong> is selected in the <strong>Missing any approver</strong> field, the Assigned to person receives a message with a link to select a substitute approver.</td>
</tr>
<tr>
<td>Skip missing</td>
<td>Bypass any missing approver and continue.</td>
</tr>
<tr>
<td>Close incomplete</td>
<td>Change the state of the case or task to <strong>Closed Incomplete</strong> when there is a missing approver.</td>
</tr>
<tr>
<td><strong>Missing all approvers</strong></td>
<td>Select one of the following actions for when all approvers are missing:</td>
</tr>
<tr>
<td>Select replacements</td>
<td>When all approvers are missing, the Assigned to person can select replacements. If the activity is configured to have the Opened for Manager to approve, but the Opened for person has no manager assigned, the activity has a missing approver. If <strong>Select replacements</strong> is selected in the <strong>Missing any approver</strong> field, the Assigned to person receives a message with a link to select a substitute approver.</td>
</tr>
<tr>
<td>Close incomplete</td>
<td>Change the state of the case or task to <strong>Closed and Incomplete</strong> when all approvers are missing.</td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Update**.

**For an employee task**

Configure a lifecycle event activity that is a task for an employee. Employee tasks are assigned to the subject person of the lifecycle event case.
Before you begin
Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

Procedure
1. On the Activity form, set the Activity type field to Employee.
2. Fill in the fields on the form, as appropriate.

### Activity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to Employee.</td>
</tr>
<tr>
<td>HR task template</td>
<td>HR task template to use with the activity.</td>
</tr>
<tr>
<td></td>
<td>Note: An HR task template automatically populates fields on the HR task form when the task is generated. See Configure an HR task template for more information.</td>
</tr>
<tr>
<td>Wait for generated task to complete</td>
<td>Option to wait for the generated task to complete before the activity closes. This field appears when you select one of the following task types in the HR task template form. If selected:</td>
</tr>
<tr>
<td></td>
<td>• <strong>HR Service</strong>: Completion of the HR task results in the creation of an HR case. The HR case must complete in order for the activity to close.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Submit Catalog Item</strong>: Completion of the HR task results in the creation of a request. The request must complete in order for the activity to close.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Submit Order Guide</strong>: Completion of the HR task results in the creation of an IT request. The IT request must complete in order for the activity to close.</td>
</tr>
<tr>
<td></td>
<td>Note: The condition for closure depends on the activity type, and can be modified.</td>
</tr>
<tr>
<td></td>
<td>• If selected, the change applies only to new lifecycle event cases. Activities in existing cases will not wait for the generated task to complete before the activity closes.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td>Owning group</td>
<td>Owning group that the activity is associated with.</td>
</tr>
<tr>
<td></td>
<td>Note: Owning groups control who owns a lifecycle event activity. To learn more, see Configure an owning group for a lifecycle event.</td>
</tr>
<tr>
<td></td>
<td>• To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity set</td>
<td>Activity set that the activity is associated with.</td>
</tr>
<tr>
<td>Use badge from HR service configuration</td>
<td>(If for the associated HR task template, the HR task type value is HR service) Option to use the badge that is associated with the parent HR service.</td>
</tr>
<tr>
<td>Badge</td>
<td>Badge that the fulfiller activity type is associated with.</td>
</tr>
<tr>
<td>Note:</td>
<td>Badges display on the portal to indicate to the employee which department is fulfilling that activity. See Configure an HR badge for more information.</td>
</tr>
<tr>
<td>Audience</td>
<td>Defines whether the activity should trigger for the lifecycle event case. You can apply one or more audience records. The subject person of the lifecycle event case must meet the conditions or criteria of all audience records for the activity to trigger in the case. If no audience record is selected, then the activity will always trigger for the case.</td>
</tr>
<tr>
<td>Note:</td>
<td>Audience records define the conditions or criteria that a user must meet. To learn more, see Configure an audience record.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. (If for the associated HR task template, the HR task type value is HR service, Submit catalog item, or Submit order guide) In the Activity Field Mappings section, you can map fields from the parent lifecycle event case to the appropriate variables on the child activity that is generated when the employee activity is triggered.

   a. Click **New** or open a record.

   b. Fill in the fields on the form.

### Activity Field Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>This field is automatically set to the name of the associated lifecycle event activity.</td>
</tr>
<tr>
<td>Map from table</td>
<td>Source table that the activity field is mapped from. This field is automatically set to the name of the HR case table that the parent lifecycle event case is associated with.</td>
</tr>
<tr>
<td>Map from</td>
<td>Map from type. Select one of the following:</td>
</tr>
<tr>
<td>Field</td>
<td>Map from a field. In the <strong>Map from field</strong> field, select the field in the source table that the activity field is mapped from.</td>
</tr>
<tr>
<td>Note:</td>
<td>Make sure that the data type of the field being mapped from is the same as the data type of the field being mapped to.</td>
</tr>
<tr>
<td>Custom text</td>
<td>Map from custom text. In the <strong>Custom Text</strong> field, provide a string value. Custom text can be static or include variables that are</td>
</tr>
</tbody>
</table>
For a fulfiller activity

Configure a lifecycle event activity that is for a fulfiller. Fulfiller activities are assigned to an agent or fulfiller in a department such as HR, IT, or Facilities.

Before you begin
Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

Procedure
1. On the Activity form, set the Activity type field to Fulfiller.
2. Fill in the fields on the form, as appropriate.

Activity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to Fulfiller.</td>
</tr>
<tr>
<td>Fulfiller activity</td>
<td>Select one of the following fulfiller activity types:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automated Order Guide</td>
<td>(Lifecycle Events for Enterprise only) An order guide fulfills the activity. In the Order guide field, select the order guide to use.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note: You can control the different fulfiller activity types that appear here. See Configure an activity configuration for a lifecycle event for more information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
</tr>
</tbody>
</table>

| Note: An order guide submits a single service catalog request that generates several items. See Order guides for more information. |

<p>| Note: Make sure that the data type of the field being mapped from is the same as the data type of the field being mapped to. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Catalog item</strong> field</td>
<td><strong>Catalog item field</strong>, select the catalog item to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A catalog item is a good or service. See <strong>Service catalog items</strong> for more information.</td>
</tr>
<tr>
<td><strong>Flow</strong></td>
<td>A flow fulfills the activity. In the <strong>Flow</strong> field, select the flow to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A flow automates a process with a sequence of reusable actions. See <strong>Flow designer</strong> for more information.</td>
</tr>
<tr>
<td><strong>HR Service</strong></td>
<td>An HR service fulfills the activity. In the <strong>HR service</strong> field, select the HR service to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> HR services are the requests and assistance an HR organization provides its employees. See <strong>HR services</strong> for more information.</td>
</tr>
<tr>
<td><strong>HR Task</strong></td>
<td>An HR task fulfills the activity. In the <strong>HR task template</strong> field, select the HR task template to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> An HR task template automatically populates fields on the HR task form when the task is generated. See <strong>Configure an HR task template</strong> for more information.</td>
</tr>
<tr>
<td><strong>Incident</strong></td>
<td>(Lifecycle Events for Enterprise only) An incident fulfills the activity. In the <strong>Template</strong> field, select the incident template to use.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> An incident template automatically populates fields on the Incident form. See <strong>Incident Management</strong> for more information.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td><strong>Use badge from HR service configuration</strong></td>
<td>(If for the associated HR task template, the <strong>HR task type</strong> value is <strong>HR service</strong>) Option to use the badge that is associated with the parent HR service.</td>
</tr>
<tr>
<td><strong>Badge</strong></td>
<td>Badge that the fulfiller activity type is associated with.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Badges display on the portal to indicate to the employee which department is fulfilling that activity. See <strong>Configure an HR badge</strong> for more information.</td>
</tr>
<tr>
<td><strong>Owning group</strong></td>
<td>Owning group that the activity is associated with.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Note:**  
- Owning groups control who owns a lifecycle event activity. To learn more, see Configure an owning group for a lifecycle event.
- To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role.

<table>
<thead>
<tr>
<th>Activity set</th>
<th>Activity set that the activity is associated with.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience</td>
<td>Defines whether the activity should trigger for the lifecycle event case. You can apply one or more audience records. The subject person of the lifecycle event case must meet the conditions or criteria of all audience records for the activity to trigger in the case. If no audience record is selected, then the activity will always trigger for the case.</td>
</tr>
</tbody>
</table>

**Note:** Audience records define the conditions or criteria that a user must meet. To learn more, see Configure an audience record.

3. Click **Save**.

4. In the **Activity Field Mappings** section, you can map fields from the parent lifecycle event case to the appropriate fields on the child activity that is generated when the fulfiller activity is triggered.

**Note:** This section inherits any mappings from the associated fulfiller activity type. You can use the default fulfiller activity type mappings as-is or further modify them.

- **a.** Click **New** or open a record.
- **b.** Fill in the fields on the form.

#### Activity Field Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>This field is automatically set to the name of the associated lifecycle event activity.</td>
</tr>
<tr>
<td>Map from table</td>
<td>Source table that the activity field is mapped from. This field is automatically set to the name of the HR case table that the parent lifecycle event case is associated with.</td>
</tr>
<tr>
<td>Map from</td>
<td>Map from type. Select one of the following:</td>
</tr>
<tr>
<td>Field</td>
<td>Map from a field. In the <strong>Map from field</strong> field, select the field in the source table that the activity field is mapped from.</td>
</tr>
</tbody>
</table>

**Note:** Make sure that the data type of the field being mapped from is the same as the data type of the field being mapped to.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom text</td>
<td>Map from custom text. In the Custom Text field, provide a string value. Custom text can be static or include variables that are pulled from the source table. For example, you can provide a short description for an IT request, such as, “Provide laptop for new hire: ${subject_person}.”</td>
</tr>
<tr>
<td>Map to table</td>
<td>Target table that the activity field is mapped to. This field is automatically set to the name of the table that the child activity is associated with.</td>
</tr>
<tr>
<td>Map to field</td>
<td>Field in the target table that the activity field is mapped to. Note: Make sure that the data type of the field being mapped from is the same as the data type of the field being mapped to.</td>
</tr>
</tbody>
</table>

**c. Click Submit or Update.**

d. Repeat the process as needed.

**5. Click Update.**

**For a notification**

Configure a lifecycle event activity that is a notification. Notifications automate the sending of an email to the specified recipients.

**Before you begin**

Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

**Procedure**

1. On the Activity form, set the Activity type field to Notification.
2. Fill in the fields on the form, as appropriate.

**Activity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to Notification.</td>
</tr>
<tr>
<td>Email template</td>
<td>Select an existing or create a new email template.</td>
</tr>
<tr>
<td>From</td>
<td>Provide the name of the sender.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td>Owning group</td>
<td>Owning group that the activity is associated with.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
| Note: | • Owning groups control who owns a lifecycle event activity. To learn more, see Configure an owning group for a lifecycle event.
| | • To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role.
| Activity set | Activity set that the activity is associated with.
| Audience | Defines whether the activity should trigger for the lifecycle event case. You can apply one or more audience records. The subject person of the lifecycle event case must meet the conditions or criteria of all audience records for the activity to trigger in the case. If no audience record is selected, then the activity will always trigger for the case.
| | **Note:** Audience records define the conditions or criteria that a user must meet. To learn more, see Configure an audience record.

3. In the **Recipients** related list, define the notification recipients for the lifecycle event activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient users</td>
<td>Users to receive the email notification.</td>
</tr>
<tr>
<td>Recipient groups</td>
<td>Groups to receive the email notification.</td>
</tr>
<tr>
<td>Users/Groups on case</td>
<td>User fields from the lifecycle event case to receive the email notification.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Flow activity parameters**

Use flow activity parameters on a lifecycle event activity to automatically populate values from a subflow within an activity.

You can configure subflows for a lifecycle event and pass the values for the input parameters of the subflow within the activity.

Having the ability to call any subflow from a lifecycle event activity provides you with a low code or no code configuration.

Calling subflows from a lifecycle event activity provides an enterprise-wide workflow you can use to interact with third-party applications at a specific point in a lifecycle event.

For more information, see Flows.

**Use cases**

You can use flow activity parameters for:
**Offboarding**

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminate employee in Workday.</td>
<td>• Employee: Subject person</td>
</tr>
<tr>
<td></td>
<td>• End Date: Subject person HR</td>
</tr>
<tr>
<td></td>
<td>Profile.Employment End Date</td>
</tr>
</tbody>
</table>

**Onboarding**

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark employee as a no show in Workday.</td>
<td>• Employee: Subject person</td>
</tr>
<tr>
<td>(Employee accepted an offer of employment,</td>
<td>• Reason: Reason for no show</td>
</tr>
<tr>
<td>but at some point decided to back out of</td>
<td></td>
</tr>
<tr>
<td>agreement.)</td>
<td></td>
</tr>
</tbody>
</table>

**Transition/Rehire**

<table>
<thead>
<tr>
<th>Subflow</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch primary job</td>
<td>• Employee: Subject person</td>
</tr>
<tr>
<td></td>
<td>• Job: Subject person job</td>
</tr>
</tbody>
</table>

For more information, see [Subflows](#).

**Map activity fields and input parameters**

You can use fields from a table to map your activity field to an input parameter. Or, you can map activity fields to an input parameter using a custom script.

**For a flow**

Configure a lifecycle event activity that uses a subflow.

**Before you begin**

Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

**Procedure**

1. On the Activity form, set the **Activity type** field to Flow.
2. Fill in the fields on the form, as appropriate.

**Activity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to Flow.</td>
</tr>
<tr>
<td>Flow</td>
<td>Subflow to use with the activity.</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Important:</strong></td>
<td>• Only the Switch primary job subflow that is used to support multiple jobs in a lifecycle event is available to use out-of-box.</td>
</tr>
<tr>
<td></td>
<td>• To use a different subflow with the activity, additional configuration is required. See the Implementing multiple subflows in an LE activity [KB0817520 article in the HI Knowledge Base for more information.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td>Badge</td>
<td>Badge that the fulfiller activity type is associated with.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Badges display on the portal to indicate to the employee which department is fulfilling that activity. See Configure an HR badge for more information.</td>
</tr>
<tr>
<td>Owning group</td>
<td>Owning group that the activity is associated with.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• Owning groups control who owns a lifecycle event activity. To learn more, see Configure an owning group for a lifecycle event.</td>
</tr>
<tr>
<td></td>
<td>• To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role.</td>
</tr>
<tr>
<td>Activity set</td>
<td>Activity set that the activity is associated with.</td>
</tr>
<tr>
<td>Audience</td>
<td>Defines whether the activity should trigger for the lifecycle event case. You can apply one or more audience records. The subject person of the lifecycle event case must meet the conditions or criteria of all audience records for the activity to trigger in the case. If no audience record is selected, then the activity will always trigger for the case.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Audience records define the conditions or criteria that a user must meet. To learn more, see Configure an audience record.</td>
</tr>
</tbody>
</table>

3. Click **Save**. The Activity Field Mappings and Rescind activities tabs appear. These fields pass from the subflow.

### Configure activity field mapping

Use activity field mappings to map information from a field on a table, custom text, or a custom script to a flow input from a subflow.

**Before you begin**

Role required: sn_hr_le.activity_writer

**About this task**

The activity field mappings pass fields from the subflow you selected when configuring the lifecycle event activity.
Procedure

1. Navigate to Lifecycle Events > Manage Activities.
2. Select an activity that has Flow as the Activity type. For more information, see For a flow.
3. Click the Activity Field Mappings tab.
4. Click an activity field mapping.
5. Fill in the fields on the form, as appropriate.

### Activity Field Mapping

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>The activity you are creating field mappings for.</td>
</tr>
<tr>
<td>Map from table</td>
<td>The table you want to map values from.</td>
</tr>
<tr>
<td>Map from</td>
<td>How you want to map values from the table you selected. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Field</td>
</tr>
<tr>
<td></td>
<td>• Custom Text</td>
</tr>
<tr>
<td></td>
<td>• Custom Script</td>
</tr>
<tr>
<td>Map from field</td>
<td>The field from the table you selected that you want to map your activity field.</td>
</tr>
<tr>
<td></td>
<td>For example, you can select the Activity [sn_hr_le_case] table and the subject-person field from that table to map to the User flow input.</td>
</tr>
<tr>
<td></td>
<td>Appears when you select Field from the Map from field.</td>
</tr>
<tr>
<td>Custom text</td>
<td>The text you want to map to your activity field.</td>
</tr>
<tr>
<td></td>
<td>Appears when you select Custom Text from the Map from field.</td>
</tr>
<tr>
<td>Script</td>
<td>The script you want to map to your activity field.</td>
</tr>
<tr>
<td></td>
<td>Appears when you select Custom Script from the Map from field.</td>
</tr>
<tr>
<td>Map to flow input</td>
<td>The input parameter from your subflow that you are mapping from a field from a table, custom text, or custom script.</td>
</tr>
<tr>
<td></td>
<td>For more information, see For a flow.</td>
</tr>
<tr>
<td>Input mandatory</td>
<td>Indicates if the input is required and reflects the settings from the subflow you selected.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Subflows.</td>
</tr>
</tbody>
</table>

6. Click Submit or Update.
**For content**

Configure a lifecycle event activity to schedule content. This activity type enables you to deliver relevant and tailored content to employees as part of the lifecycle event. For example, you can push company-related information or a first day at work banner to new hires as part of their onboarding.

**Before you begin**

Role required: sn_cd.content_manager, sn_hr_le.activity_writer, and membership in the owning group that owns the activity.

**Procedure**

1. On the Activity form, set the **Activity type** field to **Content**.
2. Fill in the fields on the form, as appropriate.

### Activity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to <strong>Content</strong>.</td>
</tr>
<tr>
<td>Template</td>
<td>Schedule content template to use with the activity.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A schedule content template schedules and delivers</td>
</tr>
<tr>
<td></td>
<td>content to users as part of a lifecycle event. See <strong>Configure a</strong></td>
</tr>
<tr>
<td></td>
<td><strong>schedule content template for a lifecycle event activity</strong> for</td>
</tr>
<tr>
<td></td>
<td>more information.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td>Owning group</td>
<td>Owning group that the activity is associated with.</td>
</tr>
<tr>
<td>Audience</td>
<td>Defines whether the activity should trigger for the lifecycle</td>
</tr>
<tr>
<td></td>
<td>event case. You can apply one or more audience records to target</td>
</tr>
<tr>
<td></td>
<td>the content to the subject person, opened for person, or a person</td>
</tr>
<tr>
<td></td>
<td>working on the lifecycle event case.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Audience records define the conditions or criteria</td>
</tr>
<tr>
<td></td>
<td>that a user must meet. To learn more, see <strong>Configure an</strong></td>
</tr>
<tr>
<td></td>
<td><strong>audience record</strong>.</td>
</tr>
</tbody>
</table>

3. In the **Activity Field Mappings** section, you can map fields from the parent lifecycle event case to the appropriate fields on the content activity.
   You can use the activity field mappings to define who the content is delivered to, when the content is delivered, how long the content is available for, and more.
a. Click **New** or open a record.

b. Fill in the fields on the form.

### Activity Field Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>This field is automatically set to the name of the associated lifecycle event activity.</td>
</tr>
<tr>
<td>Map from table</td>
<td>Source table that the activity field is mapped from. This field is automatically set to the name of the HR case table that the parent lifecycle event case is associated with.</td>
</tr>
<tr>
<td>Map from</td>
<td>Map from type. Select one of the following:</td>
</tr>
<tr>
<td>Field</td>
<td>Map from a field. In the <strong>Map from field</strong> field, select the field in the source table that the activity field is mapped from.</td>
</tr>
<tr>
<td></td>
<td>Note: Make sure that the data type of the field being mapped from is the same as the data type of the field being mapped to.</td>
</tr>
<tr>
<td>Custom text</td>
<td>Map from custom text. In the <strong>Custom Text</strong> field, provide a string value. Custom text can be static or include variables that are pulled from the source table. For example, you can provide a short description for an IT request, such as, &quot;Provide laptop for new hire: ${subject_person}&quot;.</td>
</tr>
<tr>
<td>Map to table</td>
<td>Target table that the activity field is mapped to. This field is automatically set to the name of the table that the child activity is associated with.</td>
</tr>
<tr>
<td>Map to field</td>
<td>Field in the target table that the activity field is mapped to.</td>
</tr>
<tr>
<td></td>
<td>Note: Make sure that the data type of the field being mapped from is the same as the data type of the field being mapped to.</td>
</tr>
</tbody>
</table>

c. Click **Submit** or **Update**.

d. Repeat the process as needed.

4. Click **Submit** or **Update**.

**For an activity container**

Configure a lifecycle event activity that is a container for a group of activities. This activity type enables you to manage the dependencies of activities within an activity set. You can use activity containers to order activities, in parallel or sequence, as well as configure multiple activity containers within an activity set.
Before you begin
Role required: sn_hr_le.activity_writer and membership in the owning group that owns the activity.

Procedure
1. On the Activity form, set the Activity type field to Activity container.
2. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the lifecycle event activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the lifecycle event activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Set the value to Activity container.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the activity for use.</td>
</tr>
<tr>
<td>Owning group</td>
<td>Owning group that the activity is associated with.</td>
</tr>
</tbody>
</table>

**Note:**
- Owning groups control who owns a lifecycle event activity. To learn more, see Configure an owning group for a lifecycle event.
- To create, update, or delete an activity, you must be both a member of the associated owning group and have the sn_hr_le.activity_writer role.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience</td>
<td>Defines whether the activity should trigger for the lifecycle event case. You can apply one or more audience records. The subject person of the lifecycle event case must meet the conditions or criteria of all audience records for the activity to trigger in the case. If no audience record is selected, then the activity will always trigger for the case.</td>
</tr>
</tbody>
</table>

**Note:** Audience records define the conditions or criteria that a user must meet. To learn more, see Configure an audience record.

3. Right-click the former header and click Save.
The Member activities related list appears.

4. In the Member activities related list, create one or more member activities of the following types:

**Note:**
- Member activities inherit the audience of the activity container.
- Member activities trigger based on the order number assigned. Activities with the same order number trigger at the same time.
- New member activities must be created for each activity container. You cannot move existing activities into an activity container, nor can you move member activities out of the container to use as standalone activities.
- Member activities cannot be activity containers. You cannot place an activity container inside another activity container.
• Approval
• Employee
• Fulfiller
• Notification
• Flow
• Content

Example
For example, this is an activity container to request a credit card. The activity container has three member activities. The first is to approve the credit card request, the second is to submit the request, and the third is to notify relevant groups about the request.

5. Click **Update**.

**Configure the rescind process for a lifecycle event**
Cancel and revert work done in a lifecycle event case with the rescind process. Rescind activities can be defined to notify employees and departments when a case is rescinded, trigger automated flows, and revert work already completed, such as the provisioning of equipment or the setting up of a workplace.

**Before you begin**
Role required: sn_hr_le.admin or sn_hr_le.activity_set_manager

**About this task**
The rescind process enables you to cancel and revert work done in a lifecycle event case. For example, if a new hire decides not to join the company or a job offer is revoked, you can revert work done in the onboarding case.
Procedure

1. Enable the rescind activity set.

   a. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events, and open a lifecycle event record.

   b. Click the Activity Sets tab.

   c. Click Enable Rescind.
The rescind activity set displays on the right-hand side of the lifecycle event builder.

2. Add one or more rescind activities.

   a. Click Add to add a rescind activity to the rescind activity set.

   b. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the rescind activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the rescind activity.</td>
</tr>
<tr>
<td>Activity to rescind</td>
<td>Name of the activity to rescind. You can select any activity that is associated with the same lifecycle event type, with the exception of activity containers (you can select member activities) and other rescind activities.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Activity type of the rescind activity. Select one of the following activity types:</td>
</tr>
<tr>
<td></td>
<td>• Approval</td>
</tr>
<tr>
<td></td>
<td>• Employee activity</td>
</tr>
<tr>
<td></td>
<td>• Fulfiller activity</td>
</tr>
<tr>
<td></td>
<td>• Notification</td>
</tr>
</tbody>
</table>
### Field Description

- **Flow**
- **Content**
- **Activity container**

**Note:** For this activity type, there is no Activity to rescind field at the container level. When configuring the rescind member activities, you can select the corresponding activity to rescind at the member activity level.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Option to activate the rescind activity for use.</td>
</tr>
<tr>
<td><strong>Owning group</strong></td>
<td>Owning group that the rescind activity is associated with.</td>
</tr>
<tr>
<td><strong>Audience</strong></td>
<td>Defines whether the activity should trigger for the lifecycle event case. You can apply one or more audience records. The subject person of the lifecycle event case must meet the conditions or criteria of all audience records for the activity to trigger in the case. If no audience record is selected, then the activity will always trigger for the case. <strong>Important:</strong> The rescind activity automatically inherits the audience of the underlying activity to rescind. If you clear or update the activity to rescind, the audience is also automatically cleared or updated.</td>
</tr>
</tbody>
</table>

### c. Repeat the process as needed.

**Configure an HR service for a lifecycle event**

Create a corresponding HR service so that the lifecycle event can be requested for service. For example, the lifecycle event for New Hire Onboarding has a corresponding HR service also named New Hire Onboarding. When an HR case for that HR service is created, the HR case will be fulfilled by the associated lifecycle event.

**Before you begin**

Role required: sn_hr_core.admin

**About this task**

HR services are the requests and assistance an HR organization provides its employees, and they are the starting point for HR case creation. You must create an HR service for a lifecycle event so that it can be requested for service. To learn more about HR services, including whether to make an HR service available for internal use only or for employee self-service, see [HR services](https://servicenow.com).
Procedure

1. Navigate to **HR Administration > HR Services > HR Service Configuration**.
2. Click **New**.
3. On the HR Service form, provide the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fulfillment type</td>
<td>Set the value to Lifecycle Event.</td>
</tr>
<tr>
<td>Lifecycle event type</td>
<td>Select the lifecycle event you want to fulfill the HR service.</td>
</tr>
<tr>
<td>COE</td>
<td>Select the COE you want the HR service to be categorized under.</td>
</tr>
</tbody>
</table>

**Note:** An HR service for a lifecycle event can be associated with any HR Center of Excellence (COE).

4. Fill in the other fields on the form, as appropriate.
   For further details on the form fields, see **Configure an HR service**.
5. Click **Submit** or **Update**.

**Lifecycle Events employee requests**

You can create and track requests that are opened by users from within Lifecycle Events so that your users don’t have to create a new HR case or request. Requests from your users can be either an HR service or a catalog item.

If you have the sn_hr_le.admin or admin role, you can configure employee requests from the Human Resources (HR) app. Your users can open requests in the Employee Service Center from an activity set that is assigned to them.

**Configure Lifecycle Events employee requests**

Enable your managers and employees to open employee requests directly from Lifecycle events so that they don’t have to create a new HR case or request.

**Before you begin**
Role required: sn_hr_le.admin or admin
Procedure

1. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events.

2. To add employee requests to the event, open a Lifecycle Event and click the Activity Sets tab.

3. Navigate to Add New > Employee Request.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title that appears in the Action list menu in the HR case.</td>
</tr>
<tr>
<td>Description</td>
<td>Details about the request.</td>
</tr>
<tr>
<td>Requester</td>
<td>Person who has access to view and make requests.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opened for:</strong> Person that the Lifecycle Events case was opened for.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Subject person:</strong> Person that is the subject of the LE case. (This person may or may not be the same person that the request was opened for.)</td>
</tr>
<tr>
<td>Category</td>
<td>Employee Requests category types.</td>
</tr>
<tr>
<td></td>
<td>• For the HR Service category type, see <a href="#">HR services</a>.</td>
</tr>
<tr>
<td></td>
<td>• For the Catalog Item category type, see <a href="#">Service catalog items</a>.</td>
</tr>
<tr>
<td>HR Service</td>
<td>Requests and assistance that an HR organization provides its employees.</td>
</tr>
<tr>
<td>Catalog Item</td>
<td>Goods or services that are available for requests.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that an employee or manager can select to make the request available.</td>
</tr>
<tr>
<td>Blocks activity set completion</td>
<td>• When selected, the employee request must be completed before an activity set is marked as completed.</td>
</tr>
<tr>
<td></td>
<td>• If unselected, the activity set completes if all the underlying activities are complete regardless of whether the employee request is fulfilled.</td>
</tr>
<tr>
<td>Activity Sets</td>
<td>Sets of activities that the employee request is available in.</td>
</tr>
<tr>
<td>Audience</td>
<td>Specific groups of users that have access to the employee request. For more information about these groups, see <a href="#">Audiences</a>.</td>
</tr>
</tbody>
</table>

5. Click Submit.
**Related information**

- Verify Lifecycle Events Employee requests configuration
- Filter lifecycle event activities

**Verify Lifecycle Events Employee requests configuration**

Use the Preview and Test capabilities to verify that the employee request activity has been configured correctly.

**Before you begin**

Role required: sn_hr_le.admin or admin

**About this task**

Verify that the Employee request menu item for "Request Change in Start Date" is available in an activity set.

This task requires that you download the demo data that is provided with the Human Resources Scoped App: Lifecycle Events for Enterprise.

**Procedure**

1. Navigate to Application > Lifecycle Events > Administration > Manage Lifecycle Events.
2. Click New Hire Onboarding (Demo), and open the Activity Sets tab.

   **Note:** If you don’t see this life-cycle event, download the demo data provided with the Human Resources Scoped App: Lifecycle Events for Enterprise.

3. Click the Test Activity Sets icon.
4. Click Preview then click Test.
   Wait for the confirmation message "New Hire Onboarding (Demo) case created..." to display.

   **Note:** In preview mode, all employee requests appear regardless of audience, Opened for, or Subject person settings. Employee requests for the appropriate configuration appear in the completed test results.

5. Navigate to Self-Service > Employee Service Center and click To-dos.
6. Open the "New Hire Onboarding - administrator" activity set.
   The "New Hire Onboarding - System Administrator" activity set link is below the title of each of the To-dos.
7. Click Actions to view the available menu items.
   Verify that the "Request Change in Start Date" menu item is available in the activity set.

   **Note:** Menu items are visible to different users depending on the audience configuration for the request. In this example that uses demo data, all users see the menu item.

**Create a Lifecycle Events Employee Request from the Employee Service Center**

Enable your users to create common requests from Lifecycle Events so that they don’t have to create a new HR case or request. When your users open a request, any related cases and tasks are automatically associated with the parent event.

**About this task**

**Note:** This task is based on the demo data that is available with the Human Resources Scoped App: Lifecycle Events for Enterprise. Download the HR Scoped App demo data before completing this task.
Procedure
1. From your Employee Service Center home page, click To-dos.
2. Open the New Hire Onboarding request.
3. From the Actions list, click Request Standup Desk.
4. Click Order Now.
5. Complete the Order Confirmation, and click Checkout.

What to do next
Click Requests to view your request.

Note: The HR case or catalog request that was initiated from the employee request is associated with the parent Lifecycle Events case. Agents can see the status of the employee request from the Lifecycle event.

Clone a lifecycle event
Clone a lifecycle event and its associated activity sets and activities with the lifecycle event builder.

Before you begin
Role required: sn_hr_le.admin

Procedure
1. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events, and open a record.
2. Click Clone Lifecycle Event to clone the lifecycle event and all of its associated activity sets and activities.

Once complete, a message that the lifecycle event was successfully cloned appears.

Preview and test a lifecycle event
Preview and test a lifecycle event for different audience types. You can preview a lifecycle event to validate which activities will trigger or not for a particular audience. You can then create a test lifecycle event case for different users and select which activities to include or exclude in your test.

Before you begin
Role required: sn_hr_le.admin
Procedure

1. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events, and open a record.

2. Click the Activity Sets tab to access the lifecycle event builder.

3. Click the Test icon to open the Test side panel.

4. In the Test side panel, select a subject person for the lifecycle event test and whether to include inapplicable or indeterminate activities in the test.

   ![Image of the Test side panel]

   **Note:** To select a subject person based on the audience, click Advanced Search to find and select a user based on the specified conditions or criteria.

5. Click Preview to preview the lifecycle event workflow.

6. Click Test to create a lifecycle event case.

   An HR case for the lifecycle event for the selected subject person is created.

Filter lifecycle event activities

Filter lifecycle event activities by activity type, owning group, audience, and rescind. You can also search for individual activities by name.
Before you begin
Role required: sn_hr_le.admin

Procedure
1. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events, and open a record.
2. Click the Activity Sets tab to access the lifecycle event builder.
3. Click the Filter icon to open the Filters side panel.
4. In the Filters side panel, select filters from the list, or type an activity's tile in the input field.

Lifecycle event properties
Lifecycle event properties control the behavior of lifecycle events. You can set the duration of the activity set closure time in hours.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to Lifecycle Events > Properties.
2. Update the lifecycle event properties, as appropriate.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_le.All activity set closure timer</td>
<td>Duration of the activity set closure time in hours. By default, the time is set to four hours.</td>
</tr>
</tbody>
</table>

3. Click Save.

Support multiple jobs in a lifecycle event
Use the Jobs table to create lifecycle event cases where you can specify which job the case pertains to. For example, say that you have an intern that is being transferred to a full-time position. The intern has two associated job records. When an onboarding case for the full-time position is created, the case is associated with the full-time job record, ensuring that downstream activity sets and activities are triggered based on information from that relevant job record.

Before you begin
Role required: sn_hr_core.admin

About this task
Beginning in the New York release, you can use the new Jobs (sn_hr_core_job) table to store multiple job records per user and capture the job history of users within your organization. See Capturing multiple job records for a user for more information.

Procedure
1. If you are using an integration to pull HR profiles from a third-party system, configure your integration to pull jobs information into the Jobs (sn_hr_core_job) table. For details on how to configure a third-party integration with HR Service Delivery, see Custom third-party HR management system integrations.
2. For HR case creation, associate the subject person's job to the HR case with the `subject_person_job` field.

**Example**
For example, for the preconfigured New Hire Onboarding lifecycle event, the Create HR Case if Start Date is Future business rule for the Jobs table is configured to automatically create onboarding cases for users with a future job start date. When the rule creates the onboarding case, it uses the `subject_person_job` field to specify which job the user is being onboarded for.

**Note:** If you use the Jobs table, make sure to disable the Create HR Case if Start Date is Future business rule for the HR Profile table.

3. For the lifecycle event, make sure that the relevant activity sets are triggered by the subject person's job by updating the `Trigger field` value to `subject_person_job`.

**Example**
For example, the Day 1 activity set in the preconfigured New Hire Onboarding lifecycle event is triggered by the subject person's job start date.

4. If you are not using a third-party integration and need to configure the switch of a primary job, you can use the `Switch primary job` subflow to switch the subject person's primary job through a lifecycle event activity.
Example
For example, you can create a lifecycle event activity to switch the primary job of the subject person from the old to the new job by setting the Activity type value to Flow and the Flow value to Switch primary job.

Related information
hr_Utils - Global
hr_ActivitySet - Global
hr_ActivityUtils - Global

Configure the UI of the lifecycle event builder
Customize the appearance of the lifecycle event builder. You can change the colors of the different activity types, as well as change the color and size of the activity set columns.

Before you begin
Role required: sn_hr_le.admin

Procedure
1. Navigate to Lifecycle Events > Administration > LE UI Configuration.

2. To configure the activity type colors, enter the hex color or the name of the color you want.

3. To configure the columns, you can define the colors and size (in pixels).

4. After making any edits, click Update.
Create an HR case for a lifecycle event

Create a lifecycle event case. A lifecycle event case is an HR case that is fulfilled by a lifecycle event. For example, the HR service for New Hire Onboarding is fulfilled by the lifecycle event for New Hire Onboarding.

Before you begin
A lifecycle event administrator must have built the lifecycle event and created a corresponding HR service before you can create a case for that event. See Building a lifecycle event for more information.
Role required: sn_hr_le.case_writer

Procedure
1. Navigate to HR Case Management > Create New Case.
2. In the Search for Employee field, select the employee you are creating the case for.
   Note: You can search by employee name, partial employee name, case number, or any indexed field on the HR Profile of the sys_user table.
3. On the HR case creation form, under the Case Details section, select the HR service you are requesting for the employee.
4. Click Create Case to create the HR case.
5. On the HR case form, fill in the fields on the form, as appropriate.
   For further details on the form fields, see Work an HR case.
6. Click Ready for Work to change the state from Draft to Ready.

What to do next
After you create a lifecycle event case, you can track the case's progress and monitor the status of the individual activity sets and activities.

The following GIF shows an example of an in-progress lifecycle event case.

Note: You can drill down from the lifecycle event case list view to monitor the status of the individual activity sets and activities. You can also drill down from the individual event case form.
Monitor the status of a lifecycle event case

Monitor the status of a lifecycle event case with activity set execution contexts. You can monitor the state of each activity set in a lifecycle event case. You can further monitor the state of the individual activities. You can also report on the activity set contexts table in conjunction with the HR case table.

Before you begin
Role required: sn_hr_le.activity_reader

Procedure

1. Navigate to Lifecycle Events > Lifecycle Events Cases.

   Note: Alternatively, you can navigate to Lifecycle Events > Administration > Execution Contexts to view all execution context records.

2. Open a lifecycle event case.

3. Under the Related Links section, click Activity Set Execution.

   Related Links

   Add Task
   Show Workflow
   Activity Set Execution

4. From the Activity Set Contexts list, you can monitor the state of each activity set in the lifecycle event case.
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity set</td>
<td>Activity set that is associated with the lifecycle event case.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the activity set:</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Trigger</td>
</tr>
<tr>
<td></td>
<td>• Running Activities</td>
</tr>
<tr>
<td></td>
<td>• Finished</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
</tbody>
</table>

**Note:** You can monitor the status of individual activities by opening the activity set context record.

5. To further monitor the state of each activity within an activity set:

a. Click the preview button for the applicable activity set.
b. On the Activity Set Context form, under the Activity Status section, you can monitor the state of each activity within the activity set.

Resume a lifecycle event case
Resume a lifecycle event case after a workflow error or workflow timeout.

Before you begin
Role required: sn_hr_le.case_writer

Procedure
1. Navigate to Lifecycle Events > Lifecycle Events Cases, and open the lifecycle event case that errored.

2. Identify and fix the error.

   Tip: Navigate to the Comments and Work Notes section in the case to view the work note on why the workflow failed.

3. Click Resume to resume the case.
The lifecycle event case resumes from where it was errored out.

   Important: You cannot resume the case if it was in Closed Complete, Closed Incomplete, or Cancelled state.
Lifecycle event dashboards

Use lifecycle event dashboards to gain visibility into active lifecycle event and onboarding cases.

There are two dashboards available with the Human Resources Scoped App: Lifecycle Events (com.sn_hr.lifecycle_events) plugin:

- Active Lifecycle Event Cases
- Active Onboarding Cases

The following dashboard requires the Performance Analytics - Content Pack - Human Resources Lifecycle Events Scoped App [com.sn_hr.lifecycle_pa] plugin.

- Onboarding Executive View

Active Lifecycle Event Cases

- The Active Lifecycle Event Cases dashboard provides a list of all active lifecycle events or onboarding cases with the subject person, state, assigned to, and opened for information. You drill into each case using this dashboard.
- It also provides charts for active and overdue tasks.

Active Onboarding Cases

- The Active Onboarding Cases dashboard provides a view into active onboarding cases with the following tabs:
  - Employees that have started
  - Employees starting this week
  - Employees starting next week
  - Employees starting later
- It also provides charts for active and overdue onboarding tasks.

Onboarding Executive view

- Provides management a review of onboarding new hires and areas in the process that can be improved.
- The Overview tab shows a recap of new hire onboarding cases. Data on the number of onboarding cases that have not yet started, in various stages, and overdue activities appear.
- The Activity Analysis tab shows bottlenecks in the onboarding process. Details on each activity set per week by fulfiller or employee. The time it takes to close activities and overdue activities by fulfiller and employee also appears.
- The New Hire Experience tab shows the results of the new hire survey that helps measure the new hire experience. Information on employees leaving within a year also appears.

See . Performance Analytics

Business roles

Business roles enable you to automatically provision applications to employees through licensed identity provider (IDP) services. If you are subscribed to HR Service Delivery, preconfigured integrations for select systems may be available to use.
Preconfigured integrations for new hire onboarding

The following integrations are available to use with new hire onboarding. These integrations require subscriptions to the relevant spoke in IntegrationHub, as well as the Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

Note: The lifecycle event for new hire onboarding is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

- Okta integration for new hire onboarding
- Microsoft Azure AD integration for new hire onboarding

Activation information


Configure a business role

Create or modify a business role. Modeled after the organizational hierarchy for applications access, business roles enable you to provision applications to your employees. Depending on their job function, employees need different applications to perform their work. For example, the applications that a product designer requires differs from that of a software engineer. Each business role is mapped to one or more groups, and you can create default business roles and parent-child hierarchies to provision applications based on job function, geography, and so on.

Before you begin

Role required: sn_businessroles.writer

Procedure

1. Navigate to Business Roles > Business Roles.
2. Click New or open a record.
3. Fill in the fields on the form.

Business Role form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business role.</td>
</tr>
<tr>
<td>Parent business role</td>
<td>Other business roles of which this business role is a member. If the business role has a parent, then the child inherits all the applications that are provisioned to the parent. For example, say you have a parent business role called All Employees that provisions applications A and B, and a child business role called Marketing that provisions applications C, D, and E. When a new hire is assigned the Marketing business role, that user is provisioned applications A through E.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the business role.</td>
</tr>
<tr>
<td>Default</td>
<td>Option to set this record as a default business rule. If selected, the business role is automatically assigned to all new hires that meet the audience criteria for that record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For example, a default business role called Active Users can be used to provision basic applications that users across your entire organization require.</td>
</tr>
<tr>
<td>Audience</td>
<td>Defines the conditions or criteria that the new hire must meet for the hiring manager to be able to assign the business role on their behalf.</td>
</tr>
<tr>
<td></td>
<td>For example, you can use audience records so that one business role is only available for on-site workers and another business role is only available for remote workers.</td>
</tr>
<tr>
<td></td>
<td>For details on how to configure an audience record, see Audiences.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the business role for use.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click Save.

5. If you are integrating with the Okta service, map the business role to one or more Okta groups.

   a. In the Map to Okta groups related list, click Edit.

   b. From the list of available Okta groups on the left, move the groups that you want mapped to the business role to the list on the right.

   ![Important:](image) If an Okta group is deleted from within the Okta system, that change will not be reflected in your instance. You must manually delete the record by navigating to Okta Spoke > Okta groups, as well as remove it from any business role mappings.

   c. Click Save.

6. If you are integrating with the Microsoft Azure AD service, map the business role to one or more groups.

   a. In the Group related list, click Edit

   b. From the list of available groups on the left, move the groups that you want mapped to the business role to the list on the right.

   ![Important:](image) If a group is deleted from within the Microsoft Azure AD system, that change will not be reflected in your instance. You must manually delete the record by navigating to Directory Sync > Groups, as well as remove it from any business role mappings.

   c. Click Save.

7. Click Update.

**Update the assign_business_roles_catalog system property**

The `assign_business_roles_catalog` system property enables you to assign business roles to users through a catalog item as part of a lifecycle event, and is included with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin. If you are using a custom catalog item with your lifecycle event, you must update the system property with the sys id of that item.
**Before you begin**
Copy the sys id of the catalog item that you want to use to assign business roles as part of a lifecycle event.

Role required: sn_hr_le_ent.admin

**Procedure**

1. In the navigation filter, enter sys_properties.list. The System Properties list is displayed.
2. Open the sn_hr_le_ent.assign_business_roles_catalog record.
3. In the Value field, add the sys id of the catalog item that will be used to assign business roles as part of a lifecycle event.

   **Note:** The default value is the sys id of the Assign business roles to new hire catalog item that is included as part of the demo data for the lifecycle event for new hire onboarding.

4. Click Update.

**Okta integration for new hire onboarding**

Automatically provision relevant applications for new hires as part of the onboarding process with the Okta integration. This integration requires the Okta spoke v1.1.1 in IntegrationHub, and is configured to work with the lifecycle event for new hire onboarding that is included as demo data with the Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

**Setting up the Okta integration**

To set up the Okta integration for new hire onboarding, you must first set up the Okta spoke v1.1.1, next fetch the Okta groups into your instance, and last configure the relevant business roles. For details on how to set up the integration, see Set up the Okta integration for new hire onboarding.

**Using the Okta integration with new hire onboarding**

Once the integration is set up, you can use it with new hire onboarding. The following components are included in the demo data for your use and example.

   **Note:** The lifecycle event for new hire onboarding is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.
<table>
<thead>
<tr>
<th>Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle event activity</td>
<td>Account and Application Access (in the Day One activity set)</td>
</tr>
<tr>
<td>HR task template</td>
<td>Groups Assignment for New Hires</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Assign business roles to new hire</td>
</tr>
</tbody>
</table>

**How the application provisioning works**

The application provisioning process works as follows. When an onboarding case is created, the hiring manager receives a task to assign business roles for the new hire. Once assigned, IT then receives a request to supervise the provisioning of those applications. When the provisioning is complete, the new hire should see their applications in the Okta service.

**Important:** New hires must have a user record in the Okta system in order for their applications to be provisioned to them.

**Set up the Okta integration for new hire onboarding**

To set up the Okta integration for new hire onboarding, you must first set up the Okta spoke v1.1.1, next fetch the Okta groups into your instance, and last configure the required business roles.
Before you begin
This integration requires subscriptions to the following:

- Okta spoke v1.1.1
- Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin

⚠️ Note: The lifecycle event for new hire onboarding is included as demo data with this plugin.

Role required: admin

Procedure

1. Set up the Okta spoke v1.1.1.
   For instructions on how to set up the spoke, see Set up Okta spoke v1.1.1.

2. Fetch the Okta groups into your instance.
   For instructions on how to fetch the groups, see Fetch Okta groups.

   ⚠️ Important: If an Okta group is deleted from within the Okta system, that change will not be reflected in your instance. You must manually delete the record by navigating to Okta Spoke > Okta groups, as well as remove it from any business role mappings.

3. Configure the required business roles.


   For instructions on how to configure the business roles and map them to the relevant groups, see Configure a business role.

Microsoft Azure AD integration for new hire onboarding

Automatically provision relevant applications for new hires as part of the onboarding process with the Microsoft Azure AD integration. This integration requires the Microsoft Azure AD spoke in IntegrationHub, and is configured to work with the lifecycle event for new hire onboarding that is included as demo data with the Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

Setting up the Microsoft Azure AD integration

To set up the Microsoft Azure AD integration for new hire onboarding, you must first set up the Microsoft Azure AD spoke, next configure the remote directory sync to fetch the groups into your instance, and last configure the relevant business roles. For details on how to set up the integration, see Set up the Microsoft Azure AD integration for new hire onboarding.

Using the Microsoft Azure AD integration with new hire onboarding

Once the integration is set up, you can use the it with new hire onboarding. The following components are included in the demo data for your use and example.

⚠️ Note: The lifecycle event for new hire onboarding is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.
<table>
<thead>
<tr>
<th>Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle event activity</td>
<td>Account and Application Access (in the Day One activity set)</td>
</tr>
<tr>
<td>HR task template</td>
<td>Groups Assignment for New Hires</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Assign business roles to new hire</td>
</tr>
</tbody>
</table>

**How the application provisioning works**

The application provisioning process works as follows. When an onboarding case is created, the hiring manager receives a task to assign business roles for the new hire. Once assigned, IT then receives a request to supervise the provisioning of those applications. When the provisioning is complete, the new hire should see their applications in the Microsoft Azure AD service.

**Important:** New hires must have a user record in the Microsoft Azure AD system in order for their applications to be provisioned to them.

---

**Set up the Microsoft Azure AD integration for new hire onboarding**

To set up the Microsoft Azure AD integration for new hire onboarding, you must first set up the Microsoft Azure AD spoke, next configure the remote directory sync to fetch the groups into your instance, and last configure the required business roles.
Before you begin
This integration requires subscriptions to the following:

- Microsoft Azure AD spoke
- Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin

Note: The lifecycle event for new hire onboarding is included as demo data with this plugin.

Role required: admin

Procedure

1. Set up the Microsoft Azure AD spoke.
   For instructions on how to set up the spoke, see Set up Microsoft Azure AD spoke.

2. Configure the remote directory sync to fetch the groups into your instance.


   a. Navigate to Directory Sync > Integrations.
   
   b. Click New.
   
   c. Fill in the fields on the form.

   Directory Integrations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Display name for the integration.</td>
</tr>
<tr>
<td>Connection &amp; Credential</td>
<td>Set the value to sn_azure_ad_spoke.AzureAD.</td>
</tr>
<tr>
<td>Directory provider</td>
<td>Set the value to Microsoft Azure AD.</td>
</tr>
</tbody>
</table>

   d. Right-click the form header and click Submit.
   
   e. Click Publish to publish the record.

   Publication triggers the fetching of groups into your instance so that you can assign them to different users. Groups are fetched on a scheduled basis. You can view the fetched groups by navigating to Directory Sync > Groups.

3. Configure the required business roles.


   For instructions on how to configure the business roles and map them to the relevant groups, see Configure a business role.
Sailpoint integration for new hire onboarding

Automatically provision relevant applications for new hires as part of the onboarding process with the Sailpoint integration. This integration requires the Sailpoint IdentityIQ for Service Catalog v2 app from the ServiceNow Store, and is configured to work with the lifecycle event for new hire onboarding that is included as demo data with the Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

Setting up the Sailpoint integration

To set up the Sailpoint integration for new hire onboarding, you must install the Sailpoint IdentityIQ for Service Catalog v2 app from the ServiceNow Store. For the installation guide and further information, see SailPoint IdentityIQ for Service Catalog v2.

Note: Make sure to use version 2.0.10 or later.

Using the Sailpoint integration with new hire onboarding

Once the integration is set up, you can use it with new hire onboarding. The following components are included in the demo data for your use and example.

Note: The lifecycle event for new hire onboarding is included as demo data with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin.

<table>
<thead>
<tr>
<th>Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle event activity</td>
<td>Account and Application Access in Sailpoint (in the Day One activity set)</td>
</tr>
<tr>
<td>HR task template</td>
<td>Assign Roles in Sailpoint</td>
</tr>
</tbody>
</table>

How the application provisioning works

The application provisioning process works as follows. When an onboarding case is created, the hiring manager receives a task to assign roles and entitlements for the new hire. The hiring manager must then manually complete the task. Once assigned, IT then receives a request to supervise the provisioning of those applications. When the provisioning is complete, the new hire should see their applications in the Sailpoint service.

Important: New hires must have a user record in the Sailpoint system in order for their applications to be provisioned to them.
Document Templates

With the ServiceNow® Document Templates application, you can create HTML and PDF document templates to generate standard letters or documents. You can automate and simplify the process of filling, signing, and reviewing a document online.

In addition, you can perform the following tasks:

Enable multiple participants to collaboratively work on a single document
Create specific tasks for specific participants such as sign, fill, or review. Auto initiate tasks based on the order defined for the participants.

Collect repetitive information and furnish it wherever necessary
Retain information on the document so that the participants do not have to fill the document all over again. Validate and retrieve data at any point in time.

Gain a real-time insight
Preview the document at any stage during the information input process. Understand at what stage and with which participant is the action pending.

Notify the participant
Notify participants about their assigned document tasks.

Secure a document
Provide document access only to mapped participants.
Understanding Document Templates

Understand how you can use the Document Templates application from activating the plugin until filling, signing, and approving a document online.

Activating plugin

An administrator activates the Human Resources Scoped App: Lifecycle Events for Enterprise plugin [com.sn_hr_lifecycle_ent] that activates the Document Templates plugin [com.snc.document_templates]. For information on plugin activation, see Activate Lifecycle Events for Enterprise. For information about user roles and tables installed with the plugin, see Components installed with Lifecycle Events for Enterprise.

Configuring Document Templates and HR service

An administrator configures a document template by defining participants, defining tasks for participants, and marking signature blocks. Associates the document template to the HR template of a service and initiates document tasks from a case.

Working on assigned document tasks

Participants receive document tasks for filling, signing, and reviewing a document. When the document tasks of all the participants are complete, the final document is added as an attachment to the case.

Use Cases

Possible use cases for Document Templates.
Submitting and approving a document online

This is a use case where a document is to be filled out by an employee and reviewed by an HR agent.

An administrator configures an HR service (by selecting a document template and enabling the case option) and creates a case with that HR service. When the state of the case changes to Ready or Work in progress, document tasks get initiated for both employee and HR agent.

The employee fills in the details and submits the document for review. If there are no corrections, the HR agent approves the document, else, the HR agent adds notes and rejects the document.

Document tasks are again initiated for both employee and HR agent. The employee makes the appropriate revisions and resubmits the document. After the HR agent approves the document, it gets added as an attachment to the case.

Completing onboarding activities for an employee

This is a use case where an employee requires to complete onboarding activities such as submitting a document, requesting an ID card, and requesting a laptop.

An administrator configures an HR service (by selecting the document template and enabling the case option) and configures an activity in a lifecycle event with that HR service.

When the lifecycle activity is triggered, a case gets created with that HR service. When the state of the case changes to Ready or Work in progress, a document task gets initiated for the employee. After all the tasks of the HR case are complete, the document (submitted by the employee) gets added as an attachment to the case.

Document template categories

Document template categories help you to categorize similar documents together. It makes finding the correct document template easier.

For example, you can have multiple employee verification letters depending on if the employee is full-time, part time, or contingent. You can create a document category and have those document templates stored in that category.
You can create a document category by navigating to Document Templates > Document Template Categories. After creating a document template category, you can add document templates to that category.

**Important:** Document categories and document templates appear based on your user criteria.

**Document Templates of type HTML**

An HTML document template uses variables to pre-fill information from tables into the document. You can create how the document looks by defining the header, footer, images, placement of footer, and the text within the template. Using the HTML document template, you can collect e-signatures from multiple participants and generate a PDF document online.

Before you begin generating documents, configure the templates with your company logo and text. Obtain the following items and information to create or configure HTML templates.

- A page of your company letterhead.
- Copies of your current company employment verification letter and offer letter templates, if available.
- The logo image to use in your header.
- The logo image to use in your footer.

The following flow describes how you can use an HTML document template from configuring the template until signing and generating a PDF document online.

- Configure an HTML document template.
- Define participants.
- Insert signatures by selecting participants from the list.
- Publish the HTML document template.
- Document tasks generation.

**Note:** You can also edit the body of the HTML template and generate a PDF copy before initiating document tasks.

**Configure an HTML document template**

Create or modify the document template with your unique company logo and audience criteria.

**Before you begin**

Role required: sn_hr_core.admin and Delegated developer

**Procedure**

1. Navigate to Document Templates > All Document Templates.
2. Click New.
4. On the form, fill in the fields.
## HTML Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the document template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table associated with the type of template. The table determines the available variables that can be used. <strong>Note:</strong> Tables appear based on the application scope that is selected.</td>
</tr>
<tr>
<td>Category</td>
<td>Document category in which the template is added.</td>
</tr>
<tr>
<td>User criteria</td>
<td>Audience criteria for this document. For example, you can create a letter intended for only Canadian employees.</td>
</tr>
<tr>
<td>Body</td>
<td>Text in the template.</td>
</tr>
</tbody>
</table>
|                | To insert variables, place your cursor in the desired location and click the variable. Available variables are listed under **Fields**. Use the formatting tools in the **Body** to apply formatting options, such as bold, italic, underline, font styling. The body is a place holder for HTML text and tokenized variables. **Note:**  
  - Jelly and CSS Styling are not supported.  
  - You can also use **Document template scripts** to dynamically change the text in the HTML body. |
| Select variables | List of variables that can be used in the body of the template. Variables pull information from the selected table to customize the template. Offsets are supported for date variables. Offsets extend or subtract days, weeks, or months from a date used in a template. Valid date offset variables are:  
  - + (plus)  
  - - (minus)  
  - d (days)  
  - w (weeks)  
  - m (months)  
  Examples:  
  - Offer letter (five days after stated date): Your offer is valid until ${Date +5d}.  
  - Benefits for terminated employee (two weeks from termination date): Your benefits end effective ${subject_person.hr_profile.employment_end_date +2w}.  
  **Note:** Only variables that you have access appear. |

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Header image               | Image to be displayed in the header. You can add your company logo using this feature.  
  Note: Supported file types are: JPEG, JPEG2000, GIF, PNG, BMP, WMF, TIFF, and JBIG2. |
| Header image position      | Position where you want the header image to appear: left, right, or center. |
| Header image height        | Height of the image in the header.                                           |
|                            | Important:  
  • The height and width of the image is scaled proportionally based on the value you specify.  
  • Ensure that the height of the image is lesser than the value specified in the Page size field, otherwise, the image will be cropped. |

**Footer**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footer image</td>
<td>Image to be displayed in the footer.</td>
</tr>
</tbody>
</table>
  Note: Supported file types are: JPEG, JPEG2000, GIF, PNG, BMP, WMF, TIFF, and JBIG2. |
| Footer image height        | Height of the image in the footer.                                           |
|                            | Important:  
  • The height and width of the image is scaled proportionally based on the value you specify.  
  • Ensure that the height of the image is lesser than the value specified in the Page size field, else, the image will be cropped. |
| Footer image position      | Position where you want the footer image to appear: left, right, or center. |
| Footer text                | Text to be displayed in the footer. For example, you can add proprietary and confidential statements. |
| Footer text position       | Position where you want the footer image to appear: left, right, or center. |
| Vertical alignment         | Vertical alignment of the footer text with the footer image.                |

**Page**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page size</td>
<td>Size of the page that can be selected from the list such as Letter, A4, or Legal.</td>
</tr>
<tr>
<td>Custom font</td>
<td>Custom font from the PDF Generation Font Families table.</td>
</tr>
</tbody>
</table>
  Important: Make sure that you use the custom font family in the CSS of the HTML body. |
| Top/Bottom margin          | Space from the top of the page until the starting of the HTML content or space from the bottom of the page until the ending of the HTML content. |
5. Place the mouse in the desired location in the body of the template and click the **Insert Date** button to insert date variables. You can use the button multiple times to add different types of dates based on the variables you choose.

6. Click **Save** to save your document and remain on the **HTML Document Template** form or click **Submit** to save and return to the All Document Templates list.

**Document template scripts**

With document template scripts, you can dynamically change the text in the body of the HTML template. Document template scripts allow you to perform simple tasks, such as displaying HR data, and complex ones, such as making advanced database queries.

You can add a `${template_script:script name}` embedded script tag to the body of the HTML template, replacing script name with the name of the script you created. This makes it easy to use the same scripts in multiple document templates. You can create a script by navigating to **Document Templates > Document Templates Script**.

**Example of how to create and use a document template script in an HTML template**

1. The employee_emergency_contacts script populates the emergency contacts list in an Employee Profile document.

```javascript
(function runTemplateScript(target /*GlideRecord for target task*/ ) { 
var getHeaderCell = function(label) { 
   return '<th style="border: 1px solid #dddddd; text-align: left; padding: 8px;">' + 
label + '</th>'; 
};
var getDataCell = function(value) { 
   return '<td style="border: 1px solid #dddddd; text-align: left; padding: 8px;">' + 
value + '</td>'; 
};
var html = ';
var hrTaskGr = new GlideRecord('sn_hr_core_contact');
hrTaskGr.addQuery('user', target.getValue('subject_person'));
hrTaskGr.query();
while(hrTaskGr.next()) { 
   html = html + '<tr>;
   html = html + getDataCell(hrTaskGr.getDisplayValue('name'));
   html = html + getDataCell(hrTaskGr.getDisplayValue('mobile_phone'));
   html = html + getDataCell(hrTaskGr.getDisplayValue('relation_to_employee'));
   html = html + '</tr>';
}
if(!gs.nil(html)) { 
   html = '<h4>Emergency Contact Information</h4><table width="500px;">' + 
   getHeaderCell('Name') + getHeaderCell('Mobile phone') + getHeaderCell('Relationship') 
   + html + '</table>;</
   return html;
})(target);
```
2. The employee_emergency_contacts script is called in an HTML document template by typing `$ {template_script:employee_emergency_contacts}` in the body of the Employee Profile HTML document template.

3. The Employee Profile HTML document template is selected on a case and the document template is generated with emergency contacts list as follows:
Employee Profile

Name: Beth Anglin
Manager: Joanna Pilfer
Location: 6304 Northwest Barry Road, Kansas City, MO
Employment start date: 2018-01-10

Emergency Contact Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Mobile phone</th>
<th>Relationship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urielle Walton</td>
<td>+1 (575) 966-6509</td>
<td>Friend</td>
</tr>
<tr>
<td>Ramona Gibbs</td>
<td>+1 (229) 971-0970</td>
<td>Domestic partner</td>
</tr>
<tr>
<td>Aileen Weeks</td>
<td>+1 (387) 787-1966</td>
<td>Cousin</td>
</tr>
</tbody>
</table>

Document Templates of type PDF (Advanced forms)

A PDF document template originates from a fillable PDF or a standard PDF with inline signatures. Using the PDF document template, you can collect details and e-signatures from multiple participants, review, and generate a filled PDF document.

Important:

- You can create a PDF document template either:
  - uploading a fillable, editable PDF document into the form.
  - using a PDF from Managed Documents.

The following flow describes how you can use a PDF document template from configuring the template until filling, signing, reviewing, and generating a filled PDF document.

- Configure a PDF document template.
- Create participants in Document Templates.
- Define a PDF field mapping in Document Templates.
- Mark a signature block.
- Publish the PDF document template.
- Document tasks generation.

**Configure a PDF document template**
Upload an editable, fillable PDF template and customize the template as per your business needs.

**Before you begin**
Role required: sn_hr_core.admin and Delegated developer

**Procedure**
1. Navigate to Document Templates > All Document Templates.
2. Click New.
4. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the PDF document template.</td>
</tr>
<tr>
<td>Table</td>
<td>Tables appear based on the application scope selected.</td>
</tr>
<tr>
<td>Category</td>
<td>Document category in which the template is added.</td>
</tr>
<tr>
<td>Application</td>
<td>Scope of the application in which the document template is created.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the document template.</td>
</tr>
<tr>
<td></td>
<td>• Draft: Indicates that the document template is not yet published.</td>
</tr>
<tr>
<td></td>
<td>• Editing: Indicates that the document template is being edited after it has been published.</td>
</tr>
<tr>
<td></td>
<td>• Published: Indicates that the document template can be consumed by services and cases.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for enabling the PDF document template for use.</td>
</tr>
<tr>
<td>User criteria</td>
<td>Audience criteria for this document. For example, you can create a letter intended for only Canadian employees.</td>
</tr>
<tr>
<td>Document</td>
<td>Option to upload the attachment of a fillable PDF for further customization.</td>
</tr>
<tr>
<td>Acknowledgment text</td>
<td>Text that prompts the user to select a check box when submitting a filled document.</td>
</tr>
</tbody>
</table>

5. Click Submit or Save.

**What to do next**
- Click the Parse PDF related link to automatically parse information on the PDF and store that information in the PDF Mapping table for reuse.
- In the Participants related list, create participants.
- In the PDF Template Mappings related list, define field mappings.
• Click Mark a signature block.
• Publish the template. Flows using the template might get effected in case you want to edit a published template.

Create participants in Document Templates
Define actions and the order of actions for participants. The type of action and order are considered while initiating document tasks in Document Templates.

Before you begin
Role required: sn_hr_core.admin

**Note:** You need to define participants only when you want to use the document template flow. If you only want to generate a PDF document, defining participants is not mandatory.

Procedure
1. Navigate to Document Template > All Document Templates.
2. Select the template you want to use.
3. Configure the template and click Submit.

**Note:** To configure an HTML document template, see Document Templates of type HTML. To configure a PDF document template, see Configure a PDF document template.

4. In the Participants related list, click New.
5. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the mapped participant.</td>
</tr>
<tr>
<td>Action</td>
<td>Type of action to be performed by the participant such as Fill, Sign, or Review.</td>
</tr>
</tbody>
</table>

**Important:** Fill and Review actions are for PDF template, and Sign action is for HTML template.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order in which a task has to be initiated for the participant to complete the action.</td>
</tr>
<tr>
<td>User</td>
<td>Mapping user field to a participant.</td>
</tr>
<tr>
<td>Table</td>
<td>Table (sys_user table or any table extending sys_user table) from which you are choosing to populate the variables.</td>
</tr>
<tr>
<td>Document template</td>
<td>Name of the document template.</td>
</tr>
<tr>
<td>Document task template</td>
<td>Template selected on the Document Template task table to populate additional details for the document task, such as description and short description for fill, sign and review tasks.</td>
</tr>
</tbody>
</table>
Define a PDF field mapping in Document Templates

Define editable fields and store signature mappings using the PDF field mappings section.

Before you begin
Role required: sn_hr_core.admin

About this task
Information on the PDF is parsed and stored in the PDF Mapping table. **Parse PDF** will allow you to store the fillable fields and **Mark signatures** will allow you to add signature mappings.

Procedure
1. Navigate to **Document Templates > All Document Templates**.
2. Select **PDF Document Template**.
3. Configure the PDF template.
4. Click the **Parse PDF** related link.

**Note:** The link appears only for an editable PDF.

The PDF Mapping related list displays field mappings.

### PDF Template Mapping

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Display name that represents the document field.</td>
</tr>
<tr>
<td>PDF template</td>
<td>PDF template to which the mapping record belongs.</td>
</tr>
<tr>
<td>Document field</td>
<td>Field from the fillable PDF document that is automatically created through the <strong>Parse PDF</strong> related link.</td>
</tr>
<tr>
<td>Document field type</td>
<td>Type of field you are mapping, such as Signature or Checkbox.</td>
</tr>
<tr>
<td>Preview value</td>
<td>Field-mapping value for preview.</td>
</tr>
</tbody>
</table>

**Note:** If additional details are not defined, the default values of the template are used in the document template task.

CAUTION: Editing Document field is not allowed as it might break the document template flow.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Note:</td>
<td>Use this field to test a field value without going through the process of mapping fields or creating a case to test your mappings. What you enter here appears while you preview the document.</td>
</tr>
<tr>
<td>Advanced script</td>
<td>Use to configure script fields for complex mapping of a field. For example, to map a Social Security Number from the HR Profile [sn_hr_core_profile] table to a document and format it correctly, a script is used.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Mandatory field to be filled by the assigned participant.</td>
</tr>
<tr>
<td>Mapping table</td>
<td>Table that the mapped fields come from.</td>
</tr>
<tr>
<td>Read only</td>
<td>Option for enabling the editing of the field by the selected participant.</td>
</tr>
<tr>
<td>Mapping field</td>
<td>Field that maps information into your document.</td>
</tr>
<tr>
<td>Participant</td>
<td>Participant who can edit the field in the document.</td>
</tr>
<tr>
<td>Page number</td>
<td>Page number of the PDF document which contains the field. Page number where the field is present.</td>
</tr>
<tr>
<td>Format</td>
<td>Format in which values are to be entered by the participant. If the participant does not enter value in the specified format, a validation error appears for the participant.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the field mapping.</td>
</tr>
<tr>
<td>Date offset type</td>
<td>Indicates if the date should be Before, On, or After the specified date.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field appears only for a date field when the Advanced script option is deselected.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>Measuring units for the offset such as days, weeks, or months.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field appears only for a date field mapping when the Advanced script option is deselected. It appears only when the Before or After values are selected in the Date offset type field.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>Number of units to offset.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field appears only for a date field mapping when the Advanced script option is deselected. It appears only when the Before or After values are selected in the Date offset type field.</td>
</tr>
<tr>
<td>Select date format</td>
<td>Format for the date field. Values are:</td>
</tr>
<tr>
<td></td>
<td>• User date format: Indicates that the date format is picked from the participant's user preference.</td>
</tr>
<tr>
<td></td>
<td>• Specific format: Indicates the format in which you want the participant to enter the date.</td>
</tr>
<tr>
<td>Specific date format</td>
<td>Specific format in which you want the participant to enter the date.</td>
</tr>
<tr>
<td>States</td>
<td>Options stored for the non text fields. For example, social status might includes options such as Married or Single.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Mark a signature block
Choose participants and specify the area in the PDF document where you want to collect the signatures of those participants.

Before you begin
Role required: sn_doc.admin

Important: You can mark signatures only if you have defined participants and mapped users to those participants.

Procedure
1. Navigate to Document Template > All Document Templates.
2. Select the PDF document template you want to use.
3. Configure a PDF document template.
4. Create participants in Document Templates.
5. Click Mark Signatures.
6. In the Mark Signature Blocks window:
   a. Click Add Field and select the area where you want to collect the signature of a participant.
   b. In the Name field, specify a name for the signature mapping record.
   c. In the Mapping list, select a user from the mapped participants.
   d. Click Save.
7. Click Submit.
The signature mapping is added to the PDF Template Mappings section.

**Important:** Signature mapping is a mandatory field mapping. Disable the mapping if you do not want to use the signature mapping.

Document tasks generation

Document tasks can be generated either automatically or manually. The tasks get generated in the order defined for the participants.

**Automatically**

Document tasks are automatically initiated for the participants when you:

- Select the **Automatically Initiate Document tasks** option on the HR service of a case.

  **Note:** Make sure that the configured template is added to the HR template of a service.

- Change the state of the HR case to **Ready**.

**Manually**

Document tasks are manually initiated when you click the **Initiate document tasks** button on the **Preview Document** option on the case.
Note: The Initiate document tasks option does not appear when the Automatically Initiate Document tasks option is already enabled on the HR service of a case.

Preview Document

Employee Profile

Name: Beth Anglin
Manager: Joanna Pilfer
Location: 6304 Northwest Barry Road, Kansas City, MO
Employment start date: 2018-01-10

Emergency Contact Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Mobilephone</th>
<th>Relationship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urielle Walton</td>
<td>+1 (575) 966-6509</td>
<td>Friend</td>
</tr>
<tr>
<td>Ramona Gibbs</td>
<td>+1 (229) 971-0970</td>
<td>Domestic partner</td>
</tr>
<tr>
<td>Aileen Weeks</td>
<td>+1 (387) 787-1966</td>
<td>Cousin</td>
</tr>
</tbody>
</table>

Work on a document task

Complete your document tasks from Employee Service Center.

Before you begin
Role required: none
You must have activated the Employee Service Center (com.sn_hr_service_portal) plugin.

Procedure
1. Navigate to Self-service > Employee Service Centre.

Important: Alternatively, you can complete your document tasks by navigating to Self-Service > My Document tasks.
2. Select the To-dos page.
3. Work on any one of these document tasks that is assigned to you.

**Fill and sign a PDF document**
Complete your document task by filling in the required details and submitting the PDF document.

**Before you begin**
Role required: none

**Procedure**
1. Navigate to Self-service > Employee Service Center.
   Alternatively, you can complete your document tasks by navigating to Self-Service > My Document Tasks.
2. Select the To-dos page.
3. Select the document task (filling) that is assigned to you.
4. Fill details in the editable fields.
5. Click the Please Acknowledge check box.
   This check box is displayed only if Acknowledgement text is added on the template.
6. Add your signature by typing or drawing. Click Clear Signature if you want to clear the signature and sign again.
7. To view your signature in the document, click Generate.
8. To save your changes in the document, click Save.
9. Click Submit.
   The task is complete and appears in your Completed To Dos section. You can view and print the document with the submitted details.

**Example of a fillable PDF document**

![Example of a fillable PDF document](image)
Sign an HTML document
Complete your document task by signing and generating a PDF copy of the HTML document.

Before you begin
Role required: none

Procedure
2. Select the document template task (signing) that is assigned to you.
3. Add your signature by typing or drawing. Click Clear Signature if you want to clear the signature and sign again.
4. To view your signature in the document, click Generate.
5. Click Submit. The task is complete and appears in your Completed To Dos section. You can view and print the document with the signatures.

Review a PDF document
Complete your document task by reviewing a PDF document. Send your review comments to one or more participants who are working on the document.

Before you begin
Role required: none

Procedure
2. Select the To-dos page.
3. Select the document template task that is assigned to you.
5. If you do not have any comments, click Approve.
6. If you want to add a note in the document:
   a. In the Field Note field, add your comments. If you want to associate the comment to a specific field, select the value from the Field list.
   b. Click Add. You can edit or delete the note if required. You can also save your changes and review them again at any point in time.
7. Click Send Notes.
The state of the document task is changed to Complete Rejected. Document tasks are reinitiated for all the participants of the template.

Resubmit a PDF document
Complete your document task by incorporating the reviewer's suggestions.

Before you begin
Role required: none

Procedure
2. Select the To-dos page.
3. Select the document task that is assigned to you.
4. If a change note has been associated to a field, clicking View Page will navigate you to that field directly.
5. Select the check box to indicate that you have incorporated the change note.
6. Add your signature by typing or drawing. Click Clear Signature if you want to clear the signature and sign again.
7. To view your signature in the document, click Generate.
8. Click Resubmit.
The task is complete and appears in the Completed To Dos section. You can view and print the document with the submitted details.

**Document generation methods**

A PDF document can be generated automatically, manually, or by using an API.

**Automatically**

A PDF document is automatically added as an attachment to the case when:

1. The configured template is selected on the HR template of a service.
2. The **Automatically Initiate Document tasks** case option is selected on the HR service of a case.
3. The state of the HR case is changed to work in progress.
4. The document tasks of all the participants are complete.

**Manually**

A PDF document can be generated manually using the **Generate** option on the **Preview Document** option on the case.

**API**

A PDF document can be generated using the following API:

```javascript
//recordId - Sys ID of the record in the table to use for generation.
//documentTemplateId - Sys ID of the document template to use for pdf generation.
//pdfName - Name of the pdf generated
```
Listening Posts

With ServiceNow® Listening Posts, you can create simple pulse surveys to capture employee touch points and gain insights from employee feedback.

Create short surveys
Set up a short pulse survey based on your business objective or goal. Gather feedback in moments that help to improve employee experience and HR Service Delivery.

Deliver pulse surveys
Deliver pulse surveys from Listening Posts or Content Automation or Content Delivery applications.

Notify users
Send notifications to users when a pulse survey is assigned.

Secure responses
Create response sharing rules by defining groups with which pulse survey responses are shared.
Keep respondent details anonymous.

Gain pulse insights
- Visualize pulse survey metrics to understand overall employee experience.
- Gain insights based on country, department, and other parameters.
- View average scores, trends, response rates, and summary of responses for surveys under a theme.
- Identify problem areas by drilling down to survey questions with lower scores.

Activating the application
You can activate the Listening Posts (sn_lp) plugin from ServiceNow Store. Note that this application is available with HR Enterprise packages.

Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Components installed with Listening Posts
Several types of components are installed with activation of the Listening Posts (sn_lp) plugin, including tables, user roles, and scheduled jobs.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listening Posts Admin [sn_lp.admin]</td>
<td>Can create, read, and delete all records in Listening Posts.</td>
<td>• sn_lp.manager</td>
</tr>
</tbody>
</table>
### Role Title [name]

**Creator [sn_lp.creator]**
- Can create pulse surveys.
- Can access the dashboard view.

**Manager [sn_lp.manager]**
- Can create pulse surveys.
- Can access the dashboard view.

**Dashboard viewer [sn_lp.dashboard_view]**
- Can access the dashboard view.

### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Content Automation: Create LP Pulse survey** | Creates pulse surveys for campaigns that are in published state with Content Type Pulse Survey.  
The scheduled job verifies if the Re-evaluate campaign check box is enabled. Based on Re-evaluate frequency, the scheduled job creates or cancels instances for the users who are added or removed from the campaign. |

**Note:** When you refine the audience in a campaign, the intersection of the users at campaign and campaign content level are considered for delivering pulse surveys.

| **Listening Posts: Create Group Pulse Instance** | Creates instances for surveys that are in published state. If the end date of a survey has passed, the schedule job changes the state of the pulse survey to Closed.  
Creates instances for surveys that are in ready state. If the start date of a pulse survey has passed, the scheduled job creates instances for that pulse survey. If the end date of a pulse survey has passed, the schedule job changes the state of the pulse survey to Closed. |

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pulse Content [sn_lp_cd_pulse_survey_content]</strong></td>
<td>Store records of Content Type Pulse Survey.</td>
</tr>
<tr>
<td><strong>Pulse Content Question [sn_lp_m2m_pulse_content_question]</strong></td>
<td>Links questions to Pulse content.</td>
</tr>
<tr>
<td><strong>Pulse Survey [sn_lp_pulse_survey]</strong></td>
<td>Stores details of pulse surveys.</td>
</tr>
<tr>
<td><strong>Pulse Theme [sn_lp_pulse_theme]</strong></td>
<td>Store details of themes. Theme is a group of pulse surveys.</td>
</tr>
</tbody>
</table>
Create a question bank in Listening Posts

Create a repository of questions to use in pulse survey.

**Before you begin**
Role required: sn_lp.creator

**Procedure**
1. Navigate to Listening Posts > Pulse Question bank.
2. Click **New**.
3. On the form, fill in the fields:

   **Pulse Survey Question Bank form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the question bank.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the question bank.</td>
</tr>
</tbody>
</table>

4. In the Questions related list, click **New** to add questions to the question bank. For more information, see Create a pulse question in Listening Posts.

Create a pulse question in Listening Posts

Create a question in a pulse survey or add a question to pulse question bank.

**Before you begin**
Role required: sn_lp.creator

**Procedure**
1. Navigate to Listening Posts > Pulse Question Bank.
2. In the Questions related list, click **New**.

   **Note:** You can also open a pulse survey and directly add questions to the pulse survey by clicking **New**.

3. On the form, fill in the fields:

   **Pulse Survey Question form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the question.</td>
</tr>
<tr>
<td>Question</td>
<td>Description of the question.</td>
</tr>
<tr>
<td>Type</td>
<td>Name of the pulse survey.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rating option</td>
<td>Format in which the rating is provided for questions asked in a pulse survey. For example, Star or Number.</td>
</tr>
<tr>
<td>Description</td>
<td>Description to appear when a user points to a question in the pulse survey.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which you want to place the question in the survey. For example, a question with a lesser order is placed first in the survey.</td>
</tr>
<tr>
<td>Allow additional information</td>
<td>Option to provide a text box in the survey for the user to enter more details.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate that the question is used for assessments and metric calculations.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option to indicate that the question is mandatory and must be answered by the survey recipient.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create a pulse theme in Listening Posts**

Theme is a group of pulse surveys with a common purpose. For example, onboarding an employee can be a theme, and Day 1, Week 1 can be a pulse survey.

**Before you begin**
Role required: sn_lp.creator

**Procedure**
1. Navigate to **Listening Posts > Pulse Theme**.
2. Click **New**.
3. On the form, fill in the fields:

**Pulse Theme form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the theme.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the theme:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Group pulse</strong>: The audience, start date, and end date of the theme are fixed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Employee lifecycle</strong>: The audience, start date, and end date of the theme vary based on criteria.</td>
</tr>
</tbody>
</table>

**Note**: Employee lifecycle is assigned to audience depending on the configured lifecycle event.

<table>
<thead>
<tr>
<th>Description</th>
<th>Additional description for the theme.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to indicate that the theme is active and available for use.</td>
</tr>
<tr>
<td>Filters</td>
<td>Filters that appear in Pulse Dashboard to refine employee responses.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Order | Order in which the report must appear in the Pulse Dashboard. A report with a lesser order appears first.
Theme | Theme to which the report belongs.

4. Click **Submit**.

**What to do next**

- View the list of pulse surveys under a theme in the **Pulse Surveys** related list. To create a pulse survey under a theme, see **Create a pulse survey in Listening Posts**.

- Add reports and specify order in which you want the reports associated to the theme to be displayed in Pulse Dashboard. To add a report under a theme, see **Add a pulse report in Listening Posts**.

- View the list of response sharing rules in the **Response Sharing Rules** related list. To create a response sharing rule, see **Create a response sharing rule in Listening Posts**.

Add a pulse report in Listening Posts

Capture more demographics and have relevant breakdown by adding more reports within a theme. Add a report by specifying an order in which the report must appear in the Pulse Dashboard.

**Before you begin**

Role required: sn_lp.creator

**Procedure**

1. Navigate to **Listening Posts > Pulse Theme**.
2. In the **Reports** related list, click **New**.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order in which the report must appear in the Pulse Dashboard. A report with a lesser order appears first.</td>
</tr>
<tr>
<td>Theme</td>
<td>Theme to which the report belongs.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Create a response sharing rule in Listening Posts

Create response sharing rules defining groups with which pulse survey responses are shared.

**Before you begin**

Role required: sn_lp.creator

**Procedure**

1. Navigate to **Listening Posts > Pulse Theme**.
2. In the **Response Sharing Rules** related list, click **New**.
3. On the form, fill in the fields:

### Response Sharing Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the response sharing rule.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the response sharing rule.</td>
</tr>
<tr>
<td>Demographic Condition</td>
<td>Only user responses that satisfy this condition are displayed to the viewer on Pulse Dashboard.</td>
</tr>
<tr>
<td>User criteria</td>
<td>User groups with which you want to share the pulse survey responses.</td>
</tr>
</tbody>
</table>

**Note:**
- Only the **Users** and **Groups** fields are applicable in user criteria for response sharing rules in pulse survey.
- The **Advanced field** option is not honoured.
- If user criteria is empty, no notifications are sent.

4. Click **Submit**.

### Create a pulse survey in Listening Posts

Create a pulse survey under a theme. Publish the survey to enable users to receive and complete the survey.

**Before you begin**
Role required: sn_lp.creator

**Procedure**
1. Navigate to **Listening Posts > Pulse Survey**.
2. Click **New**.
3. On the form, fill in the fields:

### Pulse Survey form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the pulse survey.</td>
</tr>
<tr>
<td>Theme</td>
<td>Theme with which you want to associate the pulse survey.</td>
</tr>
<tr>
<td>Add Audience</td>
<td>Option to add users who receive the pulse survey instances.</td>
</tr>
</tbody>
</table>

**Note:** This field appears only when the Content Delivery plugin is installed.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience</td>
<td>Users with whom you want to share the pulse survey instances.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This field appears only when you enable the Add Audience check box.</td>
</tr>
<tr>
<td></td>
<td>• You can add audience for a survey using the Audience field or the Survey</td>
</tr>
<tr>
<td></td>
<td>Recipients List related list. When you add users in both the Audience</td>
</tr>
<tr>
<td></td>
<td>field and Survey recipients List, a union of those users receive pulse</td>
</tr>
<tr>
<td></td>
<td>survey instances.</td>
</tr>
<tr>
<td>Send notifications</td>
<td>Option to notify users when a survey is assigned to them.</td>
</tr>
<tr>
<td>Send Mobile notifications</td>
<td>Option to send notifications on mobile application.</td>
</tr>
<tr>
<td>Virtual Agent notifications</td>
<td>Option to send actionable notifications via Virtual Agent.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the pulse survey.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating that the pulse survey is active and available for use.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the pulse survey.</td>
</tr>
<tr>
<td></td>
<td>• Draft: State of the pulse survey when created.</td>
</tr>
<tr>
<td></td>
<td>• Ready: State of the pulse survey before instances are created by the</td>
</tr>
<tr>
<td></td>
<td>scheduled job.</td>
</tr>
<tr>
<td></td>
<td>• Published: State after the survey instance is available to audience.</td>
</tr>
<tr>
<td></td>
<td>• Closed: State after the end date of the pulse survey. The survey is</td>
</tr>
<tr>
<td></td>
<td>automatically set to Closed state after its end date.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date starting which the pulse survey instances are sent to users.</td>
</tr>
<tr>
<td>End date</td>
<td>Date until which the pulse survey instances are available for the users to respond.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. In the **Questions** related list:
   - To add a question to the content, click **New**. For more information, see **Create a pulse question in Listening Posts**.
   - To add a question from the Question Bank, click **From Question Bank**.

6. To create another copy of the survey, click **Copy**.
7. Click Publish.

**Note:** You must publish a survey to enable users to receive and complete survey instances. After you publish a survey, you will no longer be able to edit it.

**What to do next**

- In the **Questions** related list, click **New** to directly add questions to the pulse survey, or click **From Question Bank** to add questions from the Question bank.

- In the **Pulse Users** related list, view the final lists of users to whom the pulse survey instances are sent. This related list is displayed only after a pulse survey is published and instances are available to users.

- In the **Survey Recipients List**, add recipients to whom you want to send the survey instances.

**Use the Pulse Dashboard in Listening Posts**

Visualize pulse survey metrics to understand overall employee experience.

**Before you begin**

Role required: sn_lp.dashboard_view

**About this task**

- Gain insights based on location, department, and other parameters.

- View average scores, trends, response rates, and summary of user responses for surveys under a theme.

- Identify problem areas by drilling down to survey questions with lower scores.

**Procedure**

1. Navigate to **Listening Posts > Pulse Dashboard**.

2. In the Global filters section:

   a. In the **Theme** field, select a theme for which you want to view user responses.

   b. In the **Surveys** field, select the survey in the theme for which you want to view user responses.

   c. In the **Start Date** field, specify the date from which you want to view the data of pulse surveys.

   **Note:** For a survey under the theme type **Group Pulse**, **Start Date** corresponds to the start date of pulse survey. For a survey under the theme type **Employee Lifecycle**, **Start Date** corresponds to the date starting which instances are created.

   d. In the **End Date** field, specify the date until which you want to view the data of pulse surveys.

   **Note:** For a survey under the theme type **Group Pulse**, **End Date** corresponds to the surveys whose start date falls before the selected end date. For a survey under the theme type **Employee Lifecycle**, **End Date** corresponds to date until which the instances are created.

3. In the **Overall Score** section, view the aggregate scores of all surveys under a given theme.

4. In the **Overall Summary** tab, you can do the following tasks:
a. View the aggregated user response scores to which you have access in Viewable Score.

b. View average aggregate scores broken down by user demographics. For example, view Average scores by Country, Average scores by Department, and Average scores by Title.

c. Drill down to data of a specific department or country by applying filters in the Filters section.

5. In the Trend History tab, view the average scores trending (quarterly/yearly) for a survey selected under a theme. Drill down to data of a specific department or country by applying filters in the Filters section.

6. In the Response Details tab, view the response rates and average scores for all pulse surveys under a theme.

Create pulse survey as content
Use the Content Type Pulse Survey to create pulse surveys that can be delivered through ServiceNow Content Delivery or Content Automation.

Before you begin
Role required: sn_lp.creator, sn_cd.content_manager, sn_ca.campaign_manager

Procedure
1. Navigate to Content Delivery > Pulse Content.

2. Click New.

3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Suitable name for the pulse content.</td>
</tr>
<tr>
<td>Theme</td>
<td>Theme with which you want to associate the pulse content.</td>
</tr>
</tbody>
</table>

| Note: Only the themes of type Group Pulse can be selected in the pulse content. |

| Active     | Option to indicate that the pulse content is active and available for use. |

4. Click Submit.

5. In the Questions related list:
   • To add a question to content, click New. For more information, see Create a pulse question in Listening Posts.
   • To add a question from Question Bank, click From Question Bank.

What to do next
Add Content (of type Pulse Content) to a campaign in Content Automation or schedule content in Content Delivery. For more information, see Delivering pulse surveys.
Delivering pulse surveys

Deliver pulse surveys to employees using various applications such as Listening Posts, Content Automation, and Content Delivery.

Using Listening posts

After you create pulse surveys in the Listening Posts application and define the required pulse surveys fields such as Start date and End date, the Listening Posts: Create Group Pulse Instance schedule job:

- selects all pulse surveys that are in Published state and creates survey instances. If the end date of a survey has passed, the survey is automatically moved to Closed state.
- selects all pulse surveys that are in Ready state. If the start date of a pulse survey has passed, the scheduled job creates instances for that pulse survey. If the end date of a pulse survey has passed, the schedule job changes the state of the pulse survey to Closed.

Using Content Automation

After you create content of type Pulse Content in Content Automation, use campaigns to create pulse instances. For more information, see Deliver pulse content using campaigns.

Using Content Delivery

After you create content of type Pulse Content in Content Delivery, use schedule content to create pulse instances. For information on how to create a schedule content, see Schedule the delivery of HR content. The Listening Posts: Create Group Pulse Instance schedule job considers the availability state date of the schedule content and creates instances for published surveys.

Deliver pulse content using campaigns

After you create content of type Pulse Content in Content Automation, use campaigns to create pulse instances.

Before you begin

Role required: sn_ca.campaign_manager

Procedure

1. Create a campaign.
2. Create a campaign bundle of a trigger type Fixed Date or To dos completion. For more information, see create a campaign bundle
3. Create content of type Pulse Content. For more information, see Create pulse survey as content.
4. Add the Content Type Pulse Content to the campaign bundle.
5. After completing all parts of a campaign, click the Publish button. The schedule job Content Automation: Create LP Pulse survey creates pulse surveys for campaigns that are in published state with Content Type Pulse Content. The scheduled job verifies if the Re-evaluate campaign check box is enabled. Depending on the re-evaluation frequency, the scheduled job creates or cancels pulse survey instances for the users who are added or removed from the campaign.

Listening Posts integration with Virtual Agent

Enable an employee to complete a pulse survey from other communication channels such as Virtual Agent, Slack, Microsoft teams, and chat web client in Employee Service Center.
Listening Posts integrates with Virtual Agent to deliver pulse survey as an actionable notification on Virtual Agent. Integration with Virtual Agent allows integrating with other communication applications, such as Slack and Microsoft teams.

For sending pulse survey notifications on Virtual Agent, the Virtual Agent notifications option must be enabled while creating the pulse survey in Listening Posts. Once the pulse survey is published, an actionable pulse survey notification is automatically sent to all pulse survey users on Virtual Agent. The actionable pulse survey notification is also displayed in chat web client in Employee Service Center.

For sending pulse survey notifications on Slack and Microsoft Teams, ensure that notifications are enabled on Slack and Microsoft Teams. For more details, see Virtual Agent integrations with messaging apps.

Widgets for Listening Posts
The pre-configured widgets helps to display a pulse survey that is raised from Listening Posts onto Employee Service Center.

For more information on these widgets, navigate to Service Portal > Widgets.

- Listening Posts My Survey: Displays pulse survey as a widget on Employee Service Center.
- Listening Posts Take Survey: Displays the pulse survey page with pulse questions on Employee Service Center.
- Listening Posts Survey List: Displays all pulse surveys assigned to user in a list view on Employee Service Center.

Complete a pulse survey
Provide your rating for the questions asked in a pulse survey. Your feedback will be used to gauge overall employee experience.

Before you begin
Role required: none

Procedure
Complete a pulse survey using one of the following options.

a. Open the pulse survey email that you have received. Click the Take Survey link to answer and complete the pulse survey.

b. Click Take Survey on the Listening Posts widget in Employee Service Center.

Learning Posts
With the ServiceNow® Learning Posts application, create an omni-channel learning experience for your employees empowering them with the right learning at the right time of need.

Assign learning tasks from a lifecycle event and deliver courses according to the time of need. For example, update an employee who has returned from sabbatical leave with the latest company policies and strategies.

Activation and set up
First, you must activate the Learning Posts [sn_inp] from ServiceNow Store. Learning Posts automatically activates the Learning Core [sn_lc] application that contains the base set of tables, content, learning bases, roles, and access configuration that are used in the Learning Posts [sn_inp] application. For more information, see .

Important: Learning Posts is available with the HRSD Enterprise package.
Request apps on the Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Initiate a learning task from a lifecycle event
When a lifecycle event is triggered, a learning task is created and assigned to the subject person of the case. The task is displayed in the To-dos page in Employee Service Center.

Before you begin
Role required: learning_admin

Procedure
1. Create a learning task template.
   For more information, see Create a learning template
2. Configure a lifecycle event activity set.
   For more information, see Configure a lifecycle event activity set.
3. Configure a lifecycle event activity.
   While creating a lifecycle activity, make sure you select Activity Type as Employee, Employee Activity as Learning task, and HR Template as any learning template task. For more information, see Configure a lifecycle event activity.
   When the lifecycle event is triggered, a learning task is created and assigned to the subject person of the case.

Create a learning template
Create a learning template to simplify the process of creating learning tasks by populating fields automatically.

Before you begin
Role required: learning_admin

Procedure
1. Navigate to Learning Administration > Administration > Templates
2. Click New.
3. On the form, fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the learning template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this template applies to. Select Learning task [sn_lc_learning_task]</td>
</tr>
<tr>
<td>Template</td>
<td>Content that automatically populates records that are based on this template.</td>
</tr>
<tr>
<td></td>
<td>• From the list, select Catalog and search for the catalog item.</td>
</tr>
<tr>
<td></td>
<td>• From the list, select Course item and search for course item.</td>
</tr>
<tr>
<td></td>
<td>• From the list, select State and select a state for the learning task.</td>
</tr>
<tr>
<td></td>
<td>• From the list, select Short description and add a suitable description for the learning task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use global descriptions for translations</td>
<td>Option to enable the use of global descriptions for translations. If selected, you can provide the short description and description for the learning task template in one or more languages.</td>
</tr>
<tr>
<td>Link template</td>
<td>Template that links a child table with the template for the parent table. In the template for the child table, set the value to the field that references the parent table. After you set the value, the child template is explicitly linked to the parent table.</td>
</tr>
<tr>
<td>Additional fields</td>
<td>In the Assign to field, specify the user to whom the learning task is applicable.</td>
</tr>
</tbody>
</table>

**Important:** You must specify values in Catalog, Course item, State Short description, and Assign to fields while creating the template. If any of the fields is left empty, the learning task will not be created as part of the life cycle event and an error is recorded in System Logs.

4. Click Submit.

**Learning tasks widgets**

The Learning tasks and Learning tasks – Completed (pre-configured widgets) help to display learning tasks in the To-dos page in Employee Service Center.

For more information on these learning widgets, navigate to Employee Service Center > To-dos Configuration.

**Alumni Service Center**

The Alumni Service Center (ASC) provides a way to stay connected with former employees and non-employees like volunteers and contractors.

The ASC acts as a portal to provide unique content, services, and community.

Maintaining relationships with former employees and other external audiences helps morale, productivity, and drive down training and hiring costs.

**ASC benefits**

Having a portal that alumni can access has many benefits:

- Alumni can make service or catalog requests like:
  - Requesting paycheck information
  - Requesting tax documentation
  - Accessing information about COBRA benefits
- Alumni can also:
  - Keep personal contact information up to date
  - Connect to community for networking opportunities
  - Stay informed of company news and announcements
  - Access job listings
- Administrators can:
  - Assign employees to manage alumni requests
  - Assign tasks to alumni
Content analytics
The ASC provides a separate content analytics tracking profile. For more information, see Configure content analytics for ServiceNow.

Employee to alumni transition
A personal email is required to transition from an employee to an alumni.
You can perform this transition for individuals or in bulk.

Exploring the Alumni Service Center
Use the Alumni Service Center (ASC) to communicate with your former employees or non-employees to foster future employment opportunities.
The base system uses some of the widgets from Content Delivery. For more information, see Employee content publishing and delivery.
An example of the ASC provided with the base system:

For more information about the service portal, see Service Portal.
For more information on the Employee Service Center, see Employee Service Center.

Setting up your Alumni Service Center
Set up your Alumni Service Center (ASC) so you can communicate with your former employees or non-employees.
The following plugins must be activated prior to activating the Alumni Service Center (sn_asc) plugin:
• Human Resources Scoped App: Core (com.sn_hr_core)
• Employee Service Center (com.sn_hr_service_portal)
To set up the ASC, you must request activation for the following plugin:
• Explicit Roles (com.glide.explicit_roles)
  ◦ The ASC uses this plugin to help segregate external users from internal users.

Note: For more information on requesting activation of a plugin, see Request a plugin.
Via the ServiceNow Store, activate the:

- Alumni Service Center (sn_asc)

**Note:** The Explicit Roles (com.glide.explicit_roles) plugin must be activated before activating the Alumni Service Center (sn_asc) plugin. For information on installing a ServiceNow Store application, see [Install a ServiceNow Store application](#).

### Roles installed

By activating the Alumni Service Center (sn_asc) plugin, the following roles install:

<table>
<thead>
<tr>
<th>ASC role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Alumni Service Center admin [sn_asc.admin] | Lets you configure all aspects of the ASC. | • Role delegator [role_delegator]  
• Skill user [skill_user]  
• ASC manager [sn_asc.manager]  
• Live feed administrator [live_feed_admin]  
• Chat administrator [chat_admin]  
• Service Portal administrator [sp_admin]  
• Service Catalog administrator [catalog_admin] |
| Alumni Service Center Alumni [sn_asc.alumni] | Lets you access the ASC as an alumnus. | • External Alumni Service Center user [snc_external] |
| Alumni Manager [sn_asc.manager] | Lets you manage the ASC, which includes alumni records and some of the import process. | • Content Delivery manager [sn_cd.content_manager] |

### Catalog items

The base system provides the following catalog items:

- Payroll Discrepancy - Alumni
- Employment Verification Letter - Alumni
- General Inquiry - Alumni

### Supported task types

The base system supports the following task types:

- Collect Employee Input
- Checklist
Adding content
The ASC uses the same widgets as the HR Service Delivery Employee Service Center. For more information, see Employee Service Center.

Use Content Delivery to add and display content to your ASC. For more information, see Employee content publishing and delivery.

To add content as part of a campaign, use Content Automation. For more information, see Campaigns for HR Service Delivery.

Load data
To add alumni users in bulk, use System Import Sets. For more information, see Import sets key concepts.

At a minimum, the file you upload must have a header and the personal email for each alumnus.

⚠️ Note: Use the Imported Alumni [sn_asc_user_imp] table when importing users.

Transform and edit
After loading your file:
• Transform your import set so that it moves to staging.
• Go to Staged Alumni to view what was loaded from your file.
• You can edit the loaded users, ensure unique user IDs, or approve if they look valid.
• From the list view of Staged Alumni, click Import All Approved to start the Import Approved Staged to Alumni scheduled job.

Configure the Alumni Service Center properties
Use properties to control the behavior of the Alumni Service Center (ASC).

Before you begin
Role required: sn_asc.admin

Procedure
1. Navigate to Alumni Service Center > Administration > Properties.
2. Configure the ASC properties.
## Alumni Service Center Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_asc.import.default.state</td>
<td>The default state for Staged Alumni records when created by an import set and the out-of-box transform map. Approved is the default state.</td>
</tr>
<tr>
<td>sn_asc.import.alumni.suffix</td>
<td>Suffix added to the end of user names for alumni records. Having a suffix distinguishes between your alumni and current workforce.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default suffix provided is .alum. You can customize the suffix to match your requirements.</td>
</tr>
<tr>
<td>sn_asc.import.user_name.max.tries</td>
<td>The number of times the application attempts to add a digit to an alumni user ID to create a unique ID.</td>
</tr>
<tr>
<td></td>
<td>For example, when you have multiple people with the same name, the system adds a unique number to the end of each user name. This number distinguishes it between the others. This property determines how many times the system adds a unique number to similar user IDs.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Add an import set of alumni for Alumni Service Center**

Use **System Import Sets** to upload your file of alumni.

**Before you begin**

Role required: import_set_loader

**Procedure**

1. Navigate to **System Import Sets > Load Data**.
2. Select **Existing table** from **Import set table**.
3. Select the **Imported Alumni [sn_asc_user-imp]** table from **Import set table**.
4. Check **File** from the **Source of the import** field.
5. Click **Choose File**.
6. Find the file that contains your list of alumni and select it.
7. Click **Open**.
8. Click **Submit**.
9. Click **Run Transform**.
10. Click **Transform**.
11. To view the import set, click the import (ISET) set number link. To view a list of staged alumni, see **Edit staged users for Alumni Service Center**.
Edit staged users for Alumni Service Center

Use Staged Alumni to ensure the import set upload and transform process ran correctly. It also ensures that your uploaded alumni are configured with the correct user ID.

Before you begin
Role required: sn_asc.admin

Procedure
1. Navigate to Alumni Service Center > Administration > Staged Alumni.
2. Review the list of staged alumni. Look for and correct duplicate names and duplicate user IDs.
3. Click the number associated with a user to edit it.
4. Enter or edit the fields on the form for the user.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned staging number of the user.</td>
</tr>
<tr>
<td>State</td>
<td>The status of the user.</td>
</tr>
<tr>
<td></td>
<td>• Approval Needed</td>
</tr>
<tr>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td>• Alumni Created</td>
</tr>
<tr>
<td></td>
<td>• Duplicate</td>
</tr>
<tr>
<td></td>
<td>• Invalid</td>
</tr>
<tr>
<td></td>
<td>• Denied</td>
</tr>
<tr>
<td>Personal email</td>
<td>The personal email of the user. How your company contacts the user.</td>
</tr>
<tr>
<td>Internal user</td>
<td>The user record found in the User [sys_user] table for the alumnus.</td>
</tr>
<tr>
<td>Internal profile</td>
<td>The HR profile of the user.</td>
</tr>
<tr>
<td>Alumni</td>
<td>The name of the user found in the Alumni [sn_asc_user] table.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the user.</td>
</tr>
<tr>
<td>Last name</td>
<td>Last name of the user.</td>
</tr>
<tr>
<td>Date format</td>
<td>Date format to override the system date format.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone the user resides in.</td>
</tr>
<tr>
<td>Proposed user ID</td>
<td>The user ID created after you fill in the fields and click Generate Proposed User ID. The user ID creates based on the personal email address provided with a suffix from the properties. For more information on the suffix, see Configure the Alumni Service Center properties.</td>
</tr>
</tbody>
</table>

5. Select Save.
6. Select **Generate Proposed User ID**.
7. Select **Update**.
8. After making edits, ensure that valid users are in the **Approved** state. Return to the **Staged Alumni** list view.
9. Select **Import** or from the **Staged Alumni** list, select **Import All Approved** at the bottom.
10. Select **Import All**. The Import Approved Staged to Alumni scheduled job runs.
   For more information about the default state for staged alumni, see **Configure the Alumni Service Center properties**.

**System notifications for Alumni Service Center**

The Alumni Service Center (ASC) uses system notifications to alert alumni with an email providing their user ID and a separate email with a password.

When an alumnus logs in for the first time, they are prompted to change the password provided.

The base system provides the following email notifications:
- Invite Alumni Email - Username
- Invite Alumni Email - Temp Password

You can customize the message to suite your company’s requirements.
For more information, refer to **Email and SMS notifications**.

**Configure email and password resets for the Alumni Service Center**

Use **Notifications**, to configure the emails that send the user ID and password reset for your alumni.

**Before you begin**

Role required: admin

**Procedure**

1. **System Notification** > **Email** > **Notifications**.
2. Click **Invite Alumni Email - Username** and edit the **Message HTML** to reflect your company’s message on providing an alumnus with a user ID.
3. Click **Preview Notification** to preview your message.
4. Click **Update**.
5. Click **Invite Alumni email - Temp Password** and edit the **Message HTML** to reflect your company’s message on providing a temporary password to your alumni.
6. Click **Preview Notification** to preview your message.
7. Click **Update**.

**Using your Alumni Service Center**

Company alumni or former employees use the Alumni Service Center (ASC) to obtain information or maintain communication with your former company.

**Accessing the ASC**

Users must have the following role:
- alumni (sn_asc.alumni)
Articles

The Articles tab at the top, left menu bar provides an FAQ and Knowledge Base (KB) articles. For more information, see HR Knowledge Management and Employee knowledge page.

Services

When the Services tab appears in the top, left menu bar, alumni can make service requests. For more information, see HR services and Employee requests page.

To-dos

Use the To-dos tab to respond to requests. For more information, see Employee to-dos page.

Requests

Use the Requests tab to view all requests you have made in the past. For more information, see Employee requests page.

Profile

Select Profile from the list and edit your contact information. For more information, see HR Profile.

Employee Document Management

Manage large numbers of documents more efficiently with the ServiceNow™ Employee Document Management product. Employee Document Management provides storage space, a filing system, the ability to easily retrieve documents, defining who can view sensitive documents, and when to purge documents.

Your company asks employees to complete and return documents related to benefits, payroll, employee relations, access to internal systems, and other services. Employee Document Management is cloud-based, efficient, secure, and it reduces compliance risks.

Streamline management of employee documents

With Employee Document Management, you can:
• Centralize files that are currently stored on multiple cases.
• Automatically or manually move employee documents from a case to the employee file.
• Find documents using metadata tags.
• Place legal holds on all documents for an employee (HR profile), or for all documents by document type.
• Define who can access what documents.
• Define retention policies that determine how long to retain employee documents and prevent purging for legal holds.
• Define when to purge documents.

Configure employee document management
The base system provides pre-configured records that can be used immediately to expedite the configuration of Employee Document Management.

Employee document definitions
To use Employee Document Management, you must define the following:

• Document type: Defines how documents are categorized and are associated with Center of Excellence (COE), topic categories, and topic details. For example, you can create a document type for all documents related to Total Rewards or for each benefit. Document types also determine who can access, how long to retain, and if a legal hold is in effect.

• Retention periods: Defines how long to keep an employee document based on regulations or company policy.

• Retention policies: Combined with a retention period and criteria, determines how long to retain an employee document.

• Security policies: Determines who can view, create, move, or authorize to purge employee documents.

You can configure employee documents to automatically move to the document repository when an HR case is completed and closed.

Administrator, agent, and employee access to Employee Document Management
There are multiple levels of access for Employee Document Management.
• Administrators configure the Employee Document Management application.
• Agents upload employee documents on behalf of employees or as part of a case.
• Employees who can upload and view their documents.

Employee Document Management administrators assign appropriate roles to employees who require access to employee documents. The security policy determines access and purge authorization.

The document type and the associated retention policy and retention period determine when to purge employee documents. The security policy can require approval to purge. The security policy requires a user to belong to the group that has purge authorization.

Legal holds can be placed on HR profiles. Legal holds prevent employee documents from being purged. You can also place and manage legal holds by document type. Managing by document type provides bulk-processing for increased efficiency.

Employee Document Management for agents

Employee Document Management agents can:

• Search for existing employee documents using different filters.
• Place or upload employee documents directly into the repository.
• When your company is also using HR Service Delivery, you can move employee documents from the HR case form to the repository. Employee documents can also be configured to automatically move when an HR case is closed.

Employee access

Employees can view their own employee documents when the document type provides employee access. Employee documents are also available on HR cases and the Service Portal or Employee Service Center profile page. See Define policies for a document type.

Activate Employee Document Management

You can activate the Employee Document Management [com.sn_employee_document_management] plugin with the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running; Plugin Activation for <plugin name>.
Request employee document management bulk uploads

The Employee Document Management Bulk Uploads requires separate subscriptions to the Orchestration [com.snc.runbook_automation] and ServiceNow IntegrationHub Installer [com.glide.hub.integrations] plugins. These plugins must be activated by ServiceNow personnel.

Before you begin
Role required: admin

About this task
There is demo data available that provides configuration examples of a local directory and third-party, cloud-based document repositories. These examples help you to configure Employee Document Management bulk uploads with your own internal document repository.

To view the demo data, you must activate the Orchestration [com.snc.runbook_automation] and ServiceNow IntegrationHub Installer [com.glide.hub.integrations] plugins first.

The Employee Document Management [com.sn_hr_employee_document_management] plugin must be activated last.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration [com.snc.runbook_automation]</td>
<td>Required for bulk imports from local drives.</td>
</tr>
<tr>
<td>ServiceNow IntegrationHub Installer</td>
<td>Required for bulk imports from third-party, cloud-based document repositories.</td>
</tr>
</tbody>
</table>

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

![Activate Plugin](image)

In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new IT Service Portal ‘Activate a Plugin’ service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.

Take me to the IT Service Portal Activate a Plugin Service Catalog.

4. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td>days from the current time.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Plugins are activated in two batches,</td>
</tr>
<tr>
<td></td>
<td>once in the morning and once in the evening, on</td>
</tr>
<tr>
<td></td>
<td>every business day in the US Pacific time zone.</td>
</tr>
<tr>
<td></td>
<td>If the plugin must be activated at a specific</td>
</tr>
<tr>
<td></td>
<td>time, enter the request in the Reason/Comments</td>
</tr>
<tr>
<td></td>
<td>field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the</td>
</tr>
<tr>
<td></td>
<td>ServiceNow personnel who are activating the</td>
</tr>
<tr>
<td></td>
<td>plugin. For example, if you need the plugin</td>
</tr>
<tr>
<td></td>
<td>activated at a specific time instead of during</td>
</tr>
<tr>
<td></td>
<td>one of the default activation windows, specify</td>
</tr>
<tr>
<td></td>
<td>that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
### Related information

List of plugins (Madrid)

### Components installed with Employee Document Management

Several types of components install with the activation of the Employee Document Management [com.sn_employee_document_management] plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Note:** The Employee Document Management [com.sn_employee_document_management] plugin activates the sn_hr_ef.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Employee Document Management admin user by requiring a minimum number (default is two) of active users with this role.

### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| EF admin [sn_hr_ef.admin] | Has full control over the Employee Document Management application. Can:  
  • Access Employee Document Management.  
  • Assign Employee Document Management roles.  
  • Search and read employee documents.  
  • Create and update employee documents.  
  • Manage administration of employee documents. Can create, read, and write to the following tables:  
    ◦ Retention Period [sn_hr_ef_retention_period]  
    ◦ Retention Policy [sn_hr_ef_retention_policy]  
    ◦ Security Policy [sn_hr_ef_security_policy]  
    ◦ Document Type [sn_hr_ef_document_type]  
  • Manage legal holds on profiles and document types. |  
  • Employee Document Management Reader [sn_hr_ef.document_reader]  
  • Employee Document Management Writer [sn_hr_ef.document_writer]  
  • Employee Document Management Legal Hold Writer [sn_hr_ef.legal_hold_writer]  
  • Employee Document Management Manager [sn_hr_ef.manager]  
  • HR basic [sn_hr_core.basic]  
  • sn_hrEf.document_import |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> Contains the HR basic [sn_hr_core.basic] role that contains the HR profile writer [sn_hr_core.profile_writer] role.</td>
<td></td>
</tr>
<tr>
<td>• Administer the Employee Documents Properties.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Configure and administer Employee Document Management Bulk Imports.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Employee Document Management Reader [sn_hr_ef.document_reader]** Can:

• Access Employee Document Management.

• Search and read employee documents.

**Note:** Add this role to the Read access tab on the security policy of the employee document. See Add or modify document security policies.

**Employee Document Management Writer [sn_hr_ef.document_writer]** Can:

• Access Employee Document Management.

• Search and read employee documents.

• Create and update employee documents.

**Note:** Add this role to the Write access tab on the security policy of the employee document. See Add or modify document security policies.

**Employee Document Management Legal Hold Writer [sn_hr_ef.legal_hold_writer]** Can:

• Access Legal Holds to view employee documents on legal hold.

• Manage legal holds on HR profiles.

**Employee Document Management Reader [sn_hr_ef.document_reader]**

• None

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> Requires the HR profile writer [sn_hr_core.profile_writer] role. HR profile writer can also create and search for employee documents.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Cannot manage legal holds on document types unless combined with the Employee Document Management Manager [sn_hr_ef.manager] role.</td>
<td></td>
</tr>
<tr>
<td>Employee Document Management Manager</td>
<td><strong>Can:</strong></td>
<td></td>
</tr>
<tr>
<td>[sn_hr_ef.manager]</td>
<td>• Access Employee Document Management.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Search and read employee documents.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create and update employee documents.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Manage administration of employee documents. Can create, read, and write to the following tables:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Retention Period [sn_hr_ef_retention_period]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Retention Policy [sn_hr_ef_retention_policy]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Security Policy [sn_hr_ef_security_policy]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Document Type [sn_hr_ef_document_type]</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All default security policies with the base system are part of the sn_hr_ef.manager role by default. Provides both read and write capabilities. No roles are automatically part of new security policies.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Employee Document Management Reader [sn_hr_ef.document_reader]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Employee Document Management Writer [sn_hr_ef.document_writer]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Employee Document Management Legal Hold Writer [sn_hr_ef.legal_hold_writer]</td>
<td></td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Add or remove legal holds on profiles and document types.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Requires the HR profile writer [sn_hr_core.profile_writer] role with the Employee File Management Legal Hold Writer [sn_hr_ef.legal_hold_writer] role to place HR profiles on legal hold.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Document Import [sn_hr_ef.document_import]**

Grants access to the Employee Document Management Bulk Import Employee Document Staging [sn_hr_ef.import_staging] table and process flow.

**Scheduled jobs installed**

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean up inactive employee documents</td>
<td>Deletes uploaded but not submitted employee documents.</td>
</tr>
<tr>
<td>EF Bulk Import from Staging - Hourly</td>
<td>Processes up to 100 import staging records in the Ready state. It runs the capture step to upload the attachments and create an employee document. This job picks up 100 records per configuration. This job picks up the oldest configurations first regardless of the number of associated staging records. For example: • Configuration A has only one staging record created on 11/01/2018 at 8:00 AM. • Configuration B has 99 staging records created on 11/01/2018 at 8:05 AM. • Configuration A runs first and Configuration B runs in an hour.</td>
</tr>
<tr>
<td>Purge employee documents</td>
<td>This job purges employee documents flagged as eligible for purging.</td>
</tr>
<tr>
<td>Purge Notification Daily Job</td>
<td>Determines what documents require notification or authorization to purge based on security policy. This job sends an email with a link to the list of documents to all members of the group assigned.</td>
</tr>
<tr>
<td>Refresh Purge Dates for Employee Documents</td>
<td>This job ensures that any employee documents that have a changed retention period since the last run does not purge a document. This scheduled job works with the sn_hr_ef.purge_stride_length property to determine which employee documents for a user [sys_user] record get purge dates recalculated.</td>
</tr>
</tbody>
</table>
Note: The Employee Document Management scheduled jobs run daily by default. To change when a scheduled job runs, see Default schedules.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment Tracking</td>
<td>Tracks copied attachments for purging. Also used to for attachments that get copied to an HR case from an HR task.</td>
</tr>
<tr>
<td>[sn_hr_ef_attachment_tracking]</td>
<td></td>
</tr>
<tr>
<td>Document Type</td>
<td>Records about employee document categorization, access, retention policy, and legal holds.</td>
</tr>
<tr>
<td>[sn_hr_ef_document_type]</td>
<td></td>
</tr>
<tr>
<td>Employee Document</td>
<td>Records about an employee document, document type, purge hold, purge date, employee, tags, size, format, creation date, and created by.</td>
</tr>
<tr>
<td>[sn_hr_ef_employee_document]</td>
<td></td>
</tr>
<tr>
<td>Employee Document Staging</td>
<td>Contains information on employee documents from your source repository. This information maps to elements required for import to Employee Document Management.</td>
</tr>
<tr>
<td>sn_hr_ef_import_staging</td>
<td></td>
</tr>
<tr>
<td>Legal Hold</td>
<td>Records about legal hold placed on either a document type or HR profile.</td>
</tr>
<tr>
<td>[sn_hr_ef_legal_hold]</td>
<td></td>
</tr>
<tr>
<td>[sn_hr_ef_purge_log]</td>
<td></td>
</tr>
<tr>
<td>Retention Period</td>
<td>Records about retention periods including date offset type, units, and quantity.</td>
</tr>
<tr>
<td>[sn_hr_ef_retention_period]</td>
<td></td>
</tr>
<tr>
<td>Retention Policy</td>
<td>Records about retention policies including conditions the policy applies to, retention period, and created by.</td>
</tr>
<tr>
<td>[sn_hr_ef_retention_policy]</td>
<td></td>
</tr>
<tr>
<td>Security Policy</td>
<td>Records about security policies including COE, purge authorization, groups, roles, and created by.</td>
</tr>
<tr>
<td>[sn_hr_ef_security_policy]</td>
<td></td>
</tr>
<tr>
<td>Document Type Security Policy</td>
<td>Associates security policies to a document type.</td>
</tr>
<tr>
<td>[sn_hr_ef_m2m_doc_type_sec_policy]</td>
<td></td>
</tr>
</tbody>
</table>

### Properties for Employee Document Management application

Activating the Employee Document Management [com.sn_employee_document_management] plugin adds the following properties.

Properties control the behavior of the Employee Document Management application.

For optimal system performance and depending on your internal processes, employee documentation is purged based on the security policy established by your company.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_ef.enable_document_viewer</td>
<td>Enables document viewer to view .pdf documents only. Other document types (.docx, .txt, .png, .xls, and so on) must be downloaded and cannot be viewed directly from Employee Document Management. The default value is Yes.</td>
</tr>
<tr>
<td>sn_hr_ef.enable_download_multiple</td>
<td>Lets you download multiple employee documents from Employee Documents list into a .zip file. The default value is Yes.</td>
</tr>
<tr>
<td>sn_hr_ef.max_file_size</td>
<td>The maximum file size of a document you can upload. The default is 30 megabytes. You can change this value, but system performance can be affected.</td>
</tr>
</tbody>
</table>
| sn_hr_ef.purge_stride_length | Determines the stride value for recalculating the purge dates for employee documents. The stride value determines the range of values that can be assigned to every user [sys_user] record that has associated employee documents. For example, if 30 is entered, the range of values that can be randomly assigned is from 1 through 30. When the Refresh Purge Dates for Employee Documents scheduled job runs, based on the current date, it determines the stride value. Any user record assigned that stride value has their employee documents purge date recalculated. Also, purge dates are recalculated for employee documents that match the following requirements:  
- Employee document is active.  
- There are no legal holds or purge holds on the employee document.  
- The stride value for the user record matches the stride value for the current date.  
The number you enter determines the stride value range. For example, Entering a 1 indicates that there is no stride range and the purge recalculation is performed for all employee documents daily. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_hr_ef.purge_authorization_interval</td>
<td>The number of days before the beginning of the month for the purge notification to be sent out. The Purge Notification Daily Job scheduled job uses this value to determine when to send a purge notification or authorization. The default value is 7 and can be changed.</td>
</tr>
<tr>
<td>sn_hr_ef.enable_purge_logs</td>
<td>Indicates if you want a purge log to be created for deleted documents. A purge log lists all deleted documents with the fields you specify in the <strong>These fields will be included in the purge logs if enabled</strong> field. The default value is Yes.</td>
</tr>
<tr>
<td>sn_hr_ef.purge_log_fields_to_include</td>
<td>If you checked Yes for the <strong>Enable purge logs to log the files deleted during document purge</strong> field, enter the fields you want to appear in the purge logs. Separate the fields with a comma. Purge logs can be downloaded into a .csv file. The default values are: <strong>employee, hr_case</strong>.</td>
</tr>
</tbody>
</table>

**Defining and setting retention and security policies for employee documents**

Use Employee Document Management to configure how employee documents should be handled based on company policy, processes, and regulatory compliance.

To configure Employee Document Management.

**Document types**

Document types are at the center of the Employee Document Management application. All employee documents are required to have a document type assigned. Categorize your employee documents by assigning document types. Use document types to combine policies that determine handling of an employee document. Use document types to:
• Associate a security policy. Security policies determine who can access employee documents and determine purge authorization.
• Associate a retention policy. Retention policies determine how long to keep a document and who the document is applicable to.
• Place a legal hold. Legal holds temporarily prevent document purging or changes to the document.
• Allow access to employees.
• Configure employee documents to be moved automatically when an HR case is closed. Assign a topic detail associated with an HR service that has the **Automatically move attachments** box checked to a document type. See Configure an HR service.

![Diagram of Document type, Topic detail, Security policies, Retention policies, Document conditions, Read/Write/Purge, Retention period, HR criteria or document conditions]

**Define policies for a document type**
For each document type, you can determine who can access a document as well as define the retention policies associated with it, or place a legal hold. A document type can manage multiple documents.

**Before you begin**
Role required: sn_hr_ef.manager

**About this task**
Document types combine topic detail, retention policies, and legal holds. The default retention period for a document type is defined on the corresponding Center of Excellence (COE). For details on COEs, see **HR Centers of Excellence data model**.

**Note:** The base system provides various document types as examples.

**Procedure**
1. Navigate to **HR Administration > Employee Documents > Document Types**.
2. Click **New** or an existing document type to edit.
3. Fill in the fields as appropriate.

**Document Type form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that describes the document type.</td>
</tr>
<tr>
<td>Topic detail</td>
<td>Topic detail associated with an HR service.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
The topic detail categorizes the document type. The HR service can be used to automatically move employee documents to the employee document repository when an HR case is closed.
Active | Option for activating or deactivating a document type. On deactivating a document type, the document type does not appear for selection when creating a document or moving attachments.
Application type | Application associated with the document type.
Legal hold | Indicates if a legal hold has been placed on the document type. When checked, all employee documents with this document type are placed on legal hold.
Employee access | Enables employees to access their own employee documents.

4. From the Context Menu, click **Save** to remain on the Document Type form. The following tabs appear.

**Document type tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Policies</td>
<td>Security policy associated with the document type. Security policies grant authorized users the ability to view, create, move, or authorization to purge employee documents. When you select a topic detail, the default security policy associated with that topic detail (if any) is automatically displayed in the <strong>Security Policies</strong> tab. In the <strong>Security Policies</strong> tab, you can, • Add and associate multiple security policies to a document type. • Define an order in which a security policy must be evaluated. Lower numbers are placed ahead of higher numbers. For example, a security policy with an order set to 100 is evaluated before a security policy with an order set to 200. • Enable or disable a security policy. When you disable a security policy, it implies...</td>
</tr>
<tr>
<td>Tab</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tab</td>
<td>Description</td>
</tr>
</tbody>
</table>
| Retention Policies  | Retention policy associated with the document type.  
The retention policy combines the retention period (determines how long a document should be saved) and HR criteria (filters who the policy is applicable to).  
See Add or modify a retention policy. |
| Legal Holds         | Shows any legal holds placed on the document type with reason, date, and time stamps.                                                      |

5. After adding or editing the retention policy, click **Save** to remain on the Document Type form or click **Submit** to return to the Document Type list.

**Define how long to retain employee documents**

A retention period defines how long an employee document should be saved before being discarded. Retention periods are combined with conditions or criteria to form a retention policy.

**Before you begin**

Role required: sn_hr_ef.manager

**Note:** Retention periods are unique and cannot be duplicated. Before you can delete a retention period, you must be sure that a document type is not associated with the retention policy.

**Procedure**

1. Navigate to **HR Administration > Employee Documents > Retention Periods**.
2. Fill in the fields as appropriate.

### Retention Period form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name that describes the retention period.</td>
</tr>
</tbody>
</table>
| Date field     | Starting point of the retention period. The fields that are available depend on the Employee Document [sn_hr_ef_employee_document] table.  
Fields from the Employee Document [sn_hr_ef_employee_document] table used to define the beginning of the retention period.  
Dot-walk and select a field to determine the starting point of the retention period. |
| Application type | Application associated with the retention period.                                                                                                                                                   |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date offset type</td>
<td>Offset that determines if the retention period should start before or after what was selected in the Date field.</td>
</tr>
<tr>
<td></td>
<td>Combined with the Date field, Date offset units, and Date offset quantity determines the length of the retention period.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>• Date field = Created</td>
</tr>
<tr>
<td></td>
<td>• Date offset type = After</td>
</tr>
<tr>
<td></td>
<td>• Date offset units = Years</td>
</tr>
<tr>
<td></td>
<td>• Date offset quantity = 1</td>
</tr>
<tr>
<td></td>
<td>Using this configuration, the retention period is one year after the created date of the document.</td>
</tr>
<tr>
<td>Date offset units</td>
<td>Unit of time that determines if the retention period should be measured in months or years.</td>
</tr>
<tr>
<td>Date offset quantity</td>
<td>Number of months or years before or after the Date field selection.</td>
</tr>
</tbody>
</table>

3. Click **Submit** or **Update**.

### Add or modify default retention policies

Default retention policies ensure that employee documents are not mistakenly purged. When a retention policy has not been assigned to a document type, the default retention policy is used.

### Before you begin

**Role required:** sn_hr_ef.manager

### About this task

You can edit default retention policies.

The HR Service Delivery base system provides default retention policies for each employee document associated with a Center or Excellence (COE) table.

Default retention policies are assigned to all documents that fall under a COE and the retention period is indefinite and never purged.

**Note:** If you change the default retention period, all new documents are assigned the new period, but existing documents still use the original retention period.

Default retention policies cannot be deleted when being used by a document type. Only one default policy for a COE is allowed.

Once a purge date is calculated and a legal hold is placed, the purge date does not change.

### Procedure

1. Navigate to **HR Administration > Employee Documents > Default Retention Policies**.
2. Click **New** to create a default retention policy or on an existing policy to edit.
3. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Default Retention Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Table</td>
</tr>
<tr>
<td>Retention period</td>
</tr>
<tr>
<td>Application type</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

Add or modify a retention policy

Set policies determining how long documents should be retained and who is covered. Retention policies combine the retention period and conditions or criteria.

Before you begin
Role required: sn_hr_ef.manager

About this task

Regulations, laws, and your company policies determine how long documents should be retained.

Once a purge date is calculated and a legal hold is placed, the purge date does not change.

To ensure that there are no accidental purging, the base system provides default retention policies. When a retention policy has not been assigned to a document type, the default retention policy is used.

When a document type is covered by multiple retention policies:

- The policy with the longest retention period applies.
- When there is a non-default default retention policy and a default retention policy with a retention period of indefinite, the non-default retention policy applies. Assuming the HR criteria matches and the retention period is applicable.

Retention policies have a one-to-one relationship to a document type, you cannot have the same retention policy for multiple document types.

Note: You can use the same retention period for multiple retention policies.

When you have multiple retention policies, but there is an overlap in criteria, the retention policy with the longest retention period is used.

For example: Document type = Disciplinary Notice

- Retention policies:
  - US employees (retention period = End Date + 7 years)
  - US contract employees (retention period = End Date + 5 years)
- If a user is both a US employee and contract employee, the US employees retention policy is used because it has a longer retention period.
**Note:** You can use the default retention policy for all document types. The default retention policy defines that all employee documents are retained while an employee is a current employee of your company. Once an employee leaves the company, a second retention policy is triggered based on HR criteria. When an employee does not satisfy the HR criteria and leaves the company, the original default retention policy is still in effect. The employee documents are retained indefinitely.

**Procedure**

1. Navigate to **HR Administration > Employee Documents > Retention Policies**.
2. Click **New** or an existing retention policy to edit.
3. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th><strong>Retention Policy form</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Applies to</td>
</tr>
<tr>
<td>HR criteria</td>
</tr>
<tr>
<td>Retention period</td>
</tr>
<tr>
<td>Active</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Add or modify default security policies**

Default security policies ensure that employee documents are secure. The HR Service Delivery base system provides default security policies for each document type and determines who can access and has purge authorization.

**Before you begin**

Role required: sn_hr_ef.manager

Users are granted access to employee documents by:

- Groups
- Roles
- Both groups and roles

The security policy can require authorization to purge and requires a user to belong to the group that has purge authorization.
See Manage HR Groups and Manage HR roles.

Procedure
1. Navigate to HR Administration > Employee Documents > Default Security Policies.
2. Click New or an existing default security policy to edit.
3. Fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Security Policies fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Phrase that describes the HR employee document security policy.</td>
</tr>
<tr>
<td>Application type</td>
</tr>
<tr>
<td>Application associated with the security policy.</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Option for enabling or disabling the security policy. When you disable a security policy, it implies that the security policy will be associated with the document type, but will not be considered for evaluation.</td>
</tr>
<tr>
<td>Applies when</td>
</tr>
<tr>
<td>Filters defining additional conditions on a security policy.</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>You can apply conditions only on the Effective date, Employee, HR case, HR profile and Payroll country fields.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

Add or modify document security policies
Many employee documents contain confidential and personal information. Use document security policies to define access to employee documents and ensure that they are secure.

Before you begin
Role required: sn_hr_ef.admin

About this task
You can determine who can read, write, or authorize purging of documents by adding or modifying document security policies.

Note: You can provide employees visibility into their own employee documents through their HR profile. Check the Employee access box on the Document type form. See Define policies for a document type.

Users are granted access to employee documents by:
• Groups
• Roles
• Both groups and roles

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The security policy can require authorization to purge and requires a user to belong to a group that has purge authorization.

See Manage HR Groups and Manage HR roles. Or see Groups and Roles.

**Procedure**

1. Navigate to **HR Administration > Employee Documents > Security Policies**.
2. Click **New** or an existing security policy to edit.
3. Fill in the fields as appropriate.

### Security Policies fields

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Phrase that describes the HR employee document security policy.</td>
</tr>
<tr>
<td>Application type</td>
<td>Application associated with the security policy.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for enabling or disabling the security policy.</td>
</tr>
<tr>
<td></td>
<td>When you disable a security policy, it implies that the security policy will be associated with the document type, but will not be considered for evaluation.</td>
</tr>
<tr>
<td>Applies when</td>
<td>Filters defining additional conditions on a security policy.</td>
</tr>
</tbody>
</table>

**Note:** You can apply conditions only on the **Effective date**, **Employee**, **HR case**, **HR profile** and **Payroll country** fields.

Use the three tabs to determine what groups or roles are required to search, access, and edit meta data for an employee document by document type. You can also define what groups receive purge notifications or can authorize purging of employee documents.

### Security Policy tabs

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>Groups: Groups a user must belong to search and read an employee document with the associated document type and security policy. Roles: Roles a user must have to search and read an employee document with the associated document type and security policy.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Users with the Employee Document Management Reader [sn_hr_ef.document_reader] role must also be added here to search and read documents associated with the document type and security policy.</td>
<td></td>
</tr>
<tr>
<td>Match all: Determines if both the conditions for groups and roles must be met for access.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you leave unchecked, the user only has to meet conditions from either Groups or Roles, not both.</td>
<td></td>
</tr>
</tbody>
</table>
Managing employee documents

Use Employee Document Management to search, create, move, or manage legal holds on employee documents.

Employee Document Management is your virtual file cabinet containing any or all your organization’s employee documents. With Employee Document Management, you can:

- **Search for employee documents:**
  - There are many ways you can use to narrow down your search for employee documents.

- **Create employee documents:**
  - Employee documents can be added directly to the document repository.
  - When combined with HR Service Delivery, HR agents can move documents from an HR case or add directly to the document repository.

- **Place an HR profile or document type on legal hold:**
  - Placing an HR profile or document type on legal hold prevents associated employee documents from being purged after the retention period has been reached.

- **Move employee documents:**
  - When employee documents are attached to an HR case, you can manually move them to the document repository. Or, you can configure HR services to automatically move employee documents when the case is closed/complete.

- **View employee documents:** Employees can view their own employee documents on the service portal or Employee Service Center. Here Define policies for a document type is how you give them access by document type. The base system provides example document types.

Searching for employee documents

Search for and view employee documents using different filters from the employee document repository. You can also download documents for audit purposes.

Before you begin

Role required: sn_hr_ef.document_reader

About this task

Employee Documents is the repository for employee documents. No matter how large your repository of employee documents is, you can search on the fly or set up pre-set search filters to find the documents you need quickly.

Procedure

1. Navigate to **HR Profile > Employee Documents > Search Documents**.

2. Use the column filters to identify documents you are looking for.
   - For example, sorting on the Employee column shows all documents by employee.

3. To download documents, select the check the box next to the documents and then select **Download** from the Actions choice list.
   - Downloading multiple documents with the same name appends each document with the employee name. A number is added when documents are still duplicated.

4. To view more information about a document, click the document name.
   - If Yes is checked in the **sn_hr_ef-enable_document_viewer** Employee Document Property, the employee document appears. You can only view PDFs. You can download and view or rename any type of document.
Create or modify an employee document

With the employee document writer [sn_hr_ef.document_writer] role, you can create or upload an employee document directly to the employee document management repository.

Before you begin
Role required: sn_hr_ef.document_writer

About this task
Documents can also be uploaded from the HR case form and then moved to the document repository.

⚠️ Note: Employee documents can also be moved from the HR case form automatically when the case is closed by configuring the HR service. For information on configuring this feature, see Configure an HR service.

Procedure

1. Navigate to **HR Profile > Employee Documents > Create New Document**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>Employee document to upload. Click <strong>Choose File</strong> to upload an employee document.</td>
</tr>
</tbody>
</table>

⚠️ Note: By default, the maximum size of a document allowed is 30 MB. The default can be changed from the **Maximum file upload size in megabytes** field in Employee Document Properties. For more information, see Properties for Employee Document Management application.

After selecting a document, the read-only fields show the file size, file format, created on, and created by.

The viewer within the UI only supports viewing .pdf documents. Other types of documents can be downloaded and then viewed.

For optimal search results, do not use dashes (-) in the name of the document. Using full words separated by spaces or underscores provides better search results.

The **Enable "Document Viewer" to preview pdf documents** in the Employee Documents property must be checked **Yes** to view .pdf documents.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the employee document.</td>
</tr>
<tr>
<td>Employee</td>
<td>Name of the employee the document is associated with.</td>
</tr>
<tr>
<td>Payroll country</td>
<td>Payroll country of the employee at the time of document creation.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type associated with the employee document.</td>
</tr>
<tr>
<td>Effective date</td>
<td>Date and time from when the employee document is valid.</td>
</tr>
</tbody>
</table>

**Note:**
- Viewing documents is not supported for FedRAMP, on-premise customers, mobile devices, customers using edge encryption, or encryption support.
- When you upload the document or move the case attachments to employee file, the value in the Payroll country field defaults to the user profile of the employee.

**Note:**
- You can read and write a document only if you fulfill the read or write configuration requirement of at least one security policy associated with the document type.
- You can purge a document only if you fulfill the purge authorization configuration requirement of at least one security policy associated with the document type.
- You can receive a purge notification only if you fulfill the purge authorization or notification configuration requirement of at least one security policy that is associated with the document type.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR case</td>
<td>HR case number the employee document is associated with when moved from an HR case.</td>
</tr>
<tr>
<td>Purge hold</td>
<td>Purge hold status of a document.</td>
</tr>
<tr>
<td></td>
<td>• Pending purge authorization: Purge notification has been sent out, but authorization has not been received.</td>
</tr>
<tr>
<td></td>
<td>• Purge Approved: Purge authorization was received, the document is scheduled to be purged.</td>
</tr>
<tr>
<td></td>
<td>• Purged Rejected: Purge authorization was rejected, the document is not scheduled to be purged.</td>
</tr>
<tr>
<td></td>
<td>The security policy associated with a document type sets purge authorization.</td>
</tr>
<tr>
<td></td>
<td>The following roles have permission to change purge authorization:</td>
</tr>
<tr>
<td></td>
<td>◦ EF admin [sn_hr_ef.admin]</td>
</tr>
<tr>
<td></td>
<td>◦ Employee File Management Manager [sn_hr_ef.manager]</td>
</tr>
</tbody>
</table>

3. Click **Submit** to create the employee document record. The Employee Document Audit Trail related list tab appears.

Provides view of all actions for an employee document from creation or uploaded to the time it is purged.

The following actions are captured:

- Record created
- Fields updated
- Attachment removed
- Attachment updated
- Attachment renamed
- Platform tag added
- Platform tag removed
- Document viewed
- Document downloaded
- Document downloaded by employee on Employee Service Center

Move employee documents to the document repository

You can move employee documents from an HR case to the employee document repository. You can also move employee documents automatically by HR service when an HR case is closed complete.

**Before you begin**

Role required: sn_hr_ef.document_writer or sn_hr_core.case_reader
About this task
Employee documents can also be added directly to the employee document repository. The employee document repository provides a central repository for quick and easy identification using different sorting features. See Create or modify an employee document.

Procedure
1. Navigate to HR Case Management > All HR Cases.
2. Select a case that has employee documents attached.
   From the list view, there is no way to identify HR cases with employee documents attached. The HR case number or the Opened for person are required to locate an HR case.
3. From the form header, click Move Attachments.
   The Move Attachments to Employee File menu appears.
4. Select the check box next to the documents you want to move.
   The Select COE for attachments to be moved and Topic Detail fields can be modified, but only if the document was added under the wrong type of HR case.
5. Select the Document Type for each document.
   The document type determines categorization, who can access it, and the retention policy. If no document type appears for the associated topic detail, one should be created to ensure correct categorization. See Define policies for a document type.
6. Click Move Selected.

Results
The employee documents move from the HR case to the employee document repository. After an employee document is moved, the file name, format, and size are copied from the attachment to the document.

Note: You can also automate this process by checking the Automatically move attachments box from HR services. See Configure an HR service.

What to do next
Once you have moved the attachments, the attachments are displayed in the Employee Documents section in the case.

Add or remove a legal hold for employee documents
Legal or litigation holds prevent the deletion of documents related to a document type or all employee documents for an HR profile.

Before you begin
Role required: sn_hr_ef.admin, sn_hr_ef.manager, sn_hr_core.profile_writer, sn_hr_ef.legal_hold_writer

About this task
A legal hold suspends all retention policies for associated employee documentation.

Note: If you are logged in as System Admin [admin], ensure that you are viewing in the Employee Document Management scope. If you change your scope, you also have to refresh the page.

Procedure
1. Navigate to HR Profile > HR Profiles.
2. Select an HR profile you want to place on legal hold.
3. Click Add Legal Hold in the form header.
4. From **Add legal hold on this profile**, select a reason and add comments.
5. Click **OK**.
6. Add comments.
7. Click **OK**.
8. To place a document type on legal hold, navigate to **HR Administration > Employee Documents > Document Types**.
9. Select a document type.
10. Click **Add Legal Hold**. The **Add Legal Hold** button is in the form header.
11. Add comments.
12. Click **Ok**.
13. Click **Update**.

Manage documents on legal hold

You can view a list of all document types or HR profiles that are currently under or had been under a legal hold. You can review the reasons a document type or HR profile was placed on legal hold and remove the legal hold.

**Before you begin**
Role required: sn_hr_ef.legal_hold_writer

**About this task**
Legal holds are placed on employee documents by HR profile or by document type. See **Add or remove a legal hold for employee documents**.

**Procedure**
1. Navigate to **HR Administration > Employee Documents > Legal Holds**.
2. Select a document type or HR profile.
3. Change the **Legal hold reason** if applicable.
4. Enter **Comments**.
5. Click **Update**.

View employee document purge logs

For optimal system performance and depending on your internal processes, employee documentation is purged based on the security policy established by your company.

**Before you begin**
Role required: sn_hr_ef.manager

**About this task**
Purging permanently deletes employee documents from the instance. Purging frees up overall storage.
• The purge log shows what documents were deleted.
• Attributes of the deleted documents are stored.
• The default attributes that identify deleted documents are employee and HR case number. You can change the default in the Properties for Employee Document Management.

See Properties for Employee Document Management application.

Procedure
Navigate to HR Administration > Employee Documents > Purge Logs. A list of purged documents with the fields specified in the These fields will be included in the purge logs if enabled of Properties for Employee Document Management Application appear.

Employee Document Management dashboard
Gain insight into macro trends more efficiently on a single dashboard-style page showing you important metrics on employee documents, status of purging and purge settings, and legal holds.


For more information on configuring your dashboard, see Dashboards overview.
The Employee Documents Dashboard has two tabs:
• Documents and Purging
• Legal holds

Documents
Provides totals for:
• Total Documents
• Documents Added in Last 30 Days
• Employees without Documents
• Unused Document Types

Also provides totals for:

Purging
Provides totals for:
• Pending Purge Authorization
• Purged Rejected
• Purge Date Not Calculated
• Purge Authorization Approver Group
• Purge Date Passed
• Purge Schedule for Next 6 Months

Legal holds
Shows number of legal holds for:
• Employees
• Document Types
• Documents
• Documents on Legal hold

Note: You can also group and stack your data by different categories.

**View Employee Document Management Dashboard**

The Employee Document Management Dashboard provides a quick and easy way to view statistics about the purge and legal hold status of your employee documents.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **HR Administration > Employee Documents > Dashboard**.

2. The **Documents and Purging** tab shows by default. Click the **Legal Holds** tab to view the number of employees, document types, and documents on legal hold.

**Employee document management bulk imports**

Use the Employee Document Management Bulk Imports feature to copy your employee documents from an external third-party cloud-based storage or a local network directory to Employee Document Management. Having your employee documents within HR Service Delivery makes administration efficient and convenient.

If you currently store your employee documents outside of HR Service Delivery, you can consolidate and maintain these documents over the duration of your employees tenure.

**Your current document repository**

Where you currently store your employee documents determines bulk import configuration. The Employee Document Management bulk imports feature provides integration with:

• Local document storage solution.

• Third-party, cloud-based document storage solutions.

**Configuring local document storage**

Activating the Orchestration [com.snc.runbook_automation] plugin is required for importing employee documents from a local document repository.

Note: Java JRE 6 or later is also required.
The process for configuring HR Service Delivery with a local document repository is:

1. **Configure HR Service Delivery** to communicate with the source location from Employee Document Import Configuration.

   Before you can configure a local document storage, ensure that a **MID Server** is configured and available. A MID server is required to facilitate communication and movement of data between a ServiceNow instance and applications, data sources, and services.

   Create a credential to use for authentication with the local document storage. See **Set up SSH credentials to the MID Server**.

   **Note:** When connecting to a local document repository, you may need to grant admin rights.

2. **Create or edit the Verify source step**. This step creates a source step required to validate the connection between your local directory and Employee Document Management.

   **Note:** Having your source employee documents in a central repository, simple directory structure, and consistent file naming convention is highly recommended and reduces errors.

3. Run the **Start verify source job** to verify the connection and validate source employee documents are identified and located.

4. **Create or edit the Employee Document Import Sources**. This step identifies the source documents you want to import from your local document storage to Employee Document Management.

5. Run the **staging job**. This step saves information about your source employee documents into the Employee Document Staging [sn_hr_ef_import_staging] table. All required information to import the employee document is contained in this record.

6. Verify that steps 3 and 4 are correct by viewing your staging records. You can fix errors in the staging table.
7. Create or edit the Capture Source step. This source step imports the staging records and source employee documents to Employee Document Management.

8. Start the Capture job that processes the staging records that have a state of **Ready** and pulls or looks up the source employee documents. Your source employee documents are copied to Employee Document Management.

### Configuring third-party, cloud-based document storage

Activating the ServiceNow IntegrationHub Installer [com.glide.hub.integrations] plugin is required for importing employee documents from a third-party, cloud-based document repository.

You need the following to configure with your third-party cloud-based (source) document repository:

- The URL to your source document repository.
- Credential alias.

The process for configuring **HR Service Delivery** with a third-party cloud-based document storage is:

1. Configure **HR Service Delivery** to communicate with the third-party, cloud-based source document repository.

2. Create or edit the Verify source step. This step creates a source step required to validate the connection between your third-party, cloud-based document repository and Employee Document Management.

   **Note:** Having your source employee documents in a simple directory structure and consistent file naming convention is highly recommended and reduces errors.

3. Run the Start verify source job to verify your connection from your third-party, cloud-based document repository is communicating with Employee Document Management.

4. Create or edit the Directory import sources step. This step identifies the directory your source documents are located in your third-party, cloud-based document storage.

5. Create or edit the File import sources step. This step identifies the source documents you want to import from your third-party, cloud-based document storage to Employee Document Management.
6. Run the staging job. This step saves information about your source employee documents into the Employee Document Staging [sn_hr_ef_import_staging] table. All required information to import the employee document is contained in this record.

7. Verify that steps 3 and 4 are correct by viewing your staging records. You can fix errors in the staging table.

8. Create or edit the Capture Source step. This source step imports the staging records and source employee documents to Employee Document Management.

9. Start the Capture job that processes the staging records that have a state of Ready and pulls or looks up the source employee documents. Your source employee documents are copied to Employee Document Management.

File size limitations
The base system allows you to import employee documents that are 30 megabytes or smaller.

Use the sn_hr_ef.max_file_size field in the Properties for Employee Document Management Application to set the maximum file size allowed.

Note: Increasing the maximum size can affect system performance.

For more information, see Properties for Employee Document Management application.

Use import mapping to locate and transform source employee documents
Import mapping locates your source employee documents from your source document repository and transforms them to import them to Employee Document Management.

Import maps define mapping variables used to acquire meta data from the source document repository. It also allows you to correctly identify the employee documents you want to import and maps them to required elements in Employee Document Management.

The required elements for a local network directory:
- Employee name
- Document type
- File name

The required elements for a third-party, cloud-based directory:
- items
- item
- Employee name
- Document type
- File name
- url

Parsing for fields and values from an output file
If your source document repository provides an output file, you can transform mapping locates, parse, and map the output file into values that Employee Document Management requires. To transform an output file, do the following:

- Create a Field mapping type that finds an array of items in the output file (JSON is an example of an output file).
- Create a Field mapping type that for each item in the array that locates the file ID.
• Create a Field mapping type that locates the employee mapped element.
• Create a Field mapping type that locates the docType mapped element.
• Create a Field mapping type that locates the fileName mapped element.
• Create a Field mapping type that locates the url mapped element.

**Extracting from a file name**
If your source employee documents have:
• A consistent naming convention.
• The employee file has all required meta data in the file name.

You can use import maps to locate and transform the source employee document into values that Employee Document Management requires.

For example, your employee documents have a consistent naming convention:

• Abel_Tuter_LOARequestLeave.pdf

You can map parts of the file name to the required elements for Employee Document Management:

• Employee name: abel.tuter
• Document type: LOARequestLeave
• File name: Abel_Tuter_LOARequestLeave.pdf

**Scripting**
You can also use scripts to map source elements to the required map elements for Employee Document Management. See [Scripts](#).

ℹ️ **Note:** The base system provides import map examples you can use as models.

**Configuring employee document management bulk import with source document repository**
Use Employee Document Import Configuration to identify and communicate with the source document repository. The source document repository is where you currently store your employee documents.

**Before you begin**
Role required: sn_hr_ef.admin, sn_hr_ef.document_import

**About this task**
Before you can move your employee documents from your source document repository, you must:

• Identify the type of repository you are pulling documents from.
• Identify the URL and credentials from the repository you are pulling documents from. Or, identify the directory you are pulling documents from.
• Test to make sure that there is communication from your source repository and Employee Document Management.

**Procedure**
1. Navigate to **HR Administration > Bulk Import > Import Configuration**.
2. Fill in the fields on the form.
# Employee Document Import Configuration

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name that identifies your employee document bulk upload configuration.</td>
</tr>
<tr>
<td>Source type</td>
<td>Identifies the source you are moving employee documents from.</td>
</tr>
<tr>
<td>• Local:</td>
<td>The source employee document repository is local.</td>
</tr>
<tr>
<td>• URL:</td>
<td>The source employee document repository is cloud-based.</td>
</tr>
<tr>
<td>Host</td>
<td>Appears when <strong>Local</strong> is selected from <strong>Source type</strong>. The IP address of the local source employee document repository you are pulling from.</td>
</tr>
<tr>
<td></td>
<td>When pulling from a local directory, the IP address of the source connected via the MID server.</td>
</tr>
<tr>
<td>URL</td>
<td>Appears when <strong>URL</strong> is selected from <strong>Source Type</strong>. The URL of the source third-party, cloud-based document repository.</td>
</tr>
<tr>
<td>Directory</td>
<td>The directory in the source employee document repository you are pulling from.</td>
</tr>
<tr>
<td></td>
<td>For Local source type, you can specify a recursive directory structure.</td>
</tr>
<tr>
<td></td>
<td>For third-party, cloud-based (URL) source type, you can only specify the root directory.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you have multiple directories in your third-party, cloud-based repository, a separate Employee Document Import Configuration is required for each one. Use the Clone Configuration button to make cloning easier.</td>
</tr>
<tr>
<td>Staging record state</td>
<td>The state assigned to the imported employee document staging records before being inserted into the employee documents.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Draft</td>
<td>Allows you to verify the staging records prior to inserting into the employee documents. Note: Use the Draft state as the default in a testing environment when adjusting your mapping configurations. Employee documents that have a Draft state must be changed to Ready before the Capture step can process it.</td>
</tr>
<tr>
<td>Ready</td>
<td>When the staging records for employee documents are accurate and does not require verification, use this state. You can still fix any errors that occur. The state changes to Error when verification cannot be confirmed. Note: Use the Ready state as the default in a production environment after testing ensures that your mapping configurations are error-free. Employee documents in the Ready state process automatically in the Capture step.</td>
</tr>
<tr>
<td>Credential alias</td>
<td>The connection and credential alias ID that labels a credential or connection record. The credential alias is required to connect to the local source document repository. The credential alias is configured from the local document repository. The credentials to access the local document repository are stored on the instance and tagged with the alias.</td>
</tr>
<tr>
<td>Domain</td>
<td>Automatically populated via domain separation and identifies the specific domain you are configuring employee documentation bulk uploads for.</td>
</tr>
<tr>
<td>Log mapping</td>
<td>Indicates that you want to write debug statements to the system log during the staging phase. Log mapping provides an easier debugging of mapping. Recommended when first configuring bulk imports during the testing phase.</td>
</tr>
</tbody>
</table>

**Note:** For more information on credentials and aliases, see Introduction to credentials, connections, and aliases. For more information on domain separation, see Domain separation and HR Service Delivery.
3. Select **Save**, **Submit**, or **Update**.
   The Employee Document Import Sources and Employee Document Import Map tabs appear.

**Create or edit import configuration**

To import employee documents, map the source employee documents from your local document repository or third-party cloud-based repository to Employee Document Management.

**Before you begin**
Role required: sn_hr_ef.document_import

**About this task**
For a local document repository, name mapping acquires file meta data from the file name.

**Procedure**
1. From **Employee Document Import Configuration** form, click the **Employee Document Import Map** tab.
2. Click **New** or on an existing import configuration.
3. Fill in the form.

### Employee Document Import Map

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>The name of the employee document bulk import configuration. See Configuring employee document management bulk import with source document repository.</td>
</tr>
<tr>
<td>Mapping type</td>
<td>Defines how you are locating the source employee documents within your source document repository.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Field</strong>: Indicates that within an array of information about your source document you want to identify a specific part of the array to map.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value</strong>: Indicates that you are identifying a specific term within an array of information from your source document you want to map.</td>
</tr>
<tr>
<td>Regex</td>
<td>The regular expression string that identifies files you want to include from the source repository.</td>
</tr>
<tr>
<td></td>
<td>For example, (\w+)(\w+)(\w+). matches file names that contain alphanumeric, underscore, and a period.</td>
</tr>
<tr>
<td></td>
<td>Once you have identified specific parts of information in the array, you can then map it.</td>
</tr>
<tr>
<td></td>
<td>The more consistent your existing naming convention, the easier to locate your files.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Replace</td>
<td>The information you want the source employee document to contain when imported to Employee Document Management. For example, the array for your source employee document has school. You want the new value to equal transcripts for document type. Enter:</td>
</tr>
<tr>
<td></td>
<td>• Replace: transcripts</td>
</tr>
<tr>
<td></td>
<td>• Mapped element: docType</td>
</tr>
<tr>
<td></td>
<td>• Source element: school</td>
</tr>
<tr>
<td>Note</td>
<td>You can also use regular expressions (RegEx) to define the replacement value. When using RegEx, use a regular expression test site to ensure correct parsing.</td>
</tr>
<tr>
<td>Mapped element</td>
<td>Determines what meta data field is acquired and the value included in the final staging record created. Fields from the Import Document Staging [sn_hr_ef_import_staging] table that you want to map your source employee documents to.</td>
</tr>
<tr>
<td></td>
<td>The base system provides the following fields you can map your source employee documents to:</td>
</tr>
<tr>
<td></td>
<td>• docType: Document type</td>
</tr>
<tr>
<td></td>
<td>• fileName: File name</td>
</tr>
<tr>
<td></td>
<td>• employee: Employee name</td>
</tr>
<tr>
<td>Source element</td>
<td>The field or value from a local or third-party cloud-based employee document repository you want to map to Employee Document Management. For example, if your source file name contains the employee name, you can use the employee name as the source element and use the Mapped element of employee.</td>
</tr>
<tr>
<td>Filter regex</td>
<td>A regular expression sequence that matches text found in the array from your source employee document repository. Use this field to refine your identification of source employee documents.</td>
</tr>
<tr>
<td>Filter field</td>
<td>Locates specific text found in the array of information returned from the source repository.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>repository when files matching the RegEx are imported.</td>
</tr>
<tr>
<td></td>
<td>Note: You can also use regular expressions (RegEx) to define the replacement value. When using RegEx, use a regular expression test site to ensure correct parsing.</td>
</tr>
<tr>
<td></td>
<td>Use this field to help refine the information you want mapped.</td>
</tr>
<tr>
<td></td>
<td>For example, to import only files with a file name formatted first_last_xxx.pdf (abel_tuter_tuition.pdf):</td>
</tr>
<tr>
<td></td>
<td>• Regex: (\w+)<em>(</em>\w+)<em>(</em>\w+).(_\w+)</td>
</tr>
<tr>
<td></td>
<td>• Mapped element: fileName</td>
</tr>
<tr>
<td></td>
<td>• Source element: fileName</td>
</tr>
<tr>
<td></td>
<td>• Filter field: .pdf</td>
</tr>
</tbody>
</table>

**File name example**

The example file name is abel_tuter_tuition.pdf.

To find and extract the file name from the source repository, see this example:

The import map is looking for a source element called fileName.

The import map is going to translate this source element to a mapped element called fileName.

The Regex is looking for the format of the file name first_last_xxx.pdf.

**File name to employee name example**

From the file name, the employee name is extracted. Employee name is a requirement for Employee Document Management.
The import map is looking for a source element called fileName.

The import map is going to translate this source element to a mapped element called employee.

The Regex is looking for the format of the file name to be first_last_tuition.pdf \( (\w+)_(\w+)_(\w+).\w+ \).

It replaces the original file name with first.last ($1.$2)

**File name to document type example**

From the file name, the document type is extracted. Document type is a requirement for Employee Document Management.

The import map is looking for a source element called fileName.

The import map is going to translate this source element to a mapped element called docType.
The Regex is looking for the format of the file name to be first_last_tuition.pdf \(\w+\)_(\w+)_(\w+).(\w+).

It creates a docType of tuition ($3).

4. Click **Submit** or **Update**.

Create or edit the verify source step

Use Employee Document Import Jobs to create a Verify source step. Verify is required to validate the connection between your local directory or your third-party, cloud-based document repository and Employee Document Management. The Verify source step also validates that source employee files are there to be processed.

**Before you begin**

Role required: sn_hr_ef.admin, sn_hr_ef.document_import

**About this task**

The base system provides a sample Verify source step you can use as a model.

**Procedure**

1. Navigate to **HR Administration > Import Configuration**.

2. Click an existing Import Configuration record.

3. From the Employee Document Import Source tab, click an existing Verify source step or **New**.

4. Fill in or edit the form.

**Employee Document Import Source — Verify**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>A descriptive name that identifies your employee document bulk upload configuration.</td>
</tr>
<tr>
<td>Source step</td>
<td>The import step that makes up the import job. Select Verify.</td>
</tr>
<tr>
<td></td>
<td>• Verify: Ensures the connection between the Employee Document instance and source repository (third-party cloud-based or local) is configured correctly and can communicate.</td>
</tr>
<tr>
<td>Import type</td>
<td>The import type that drives the source step. You can select the method that drives the source step.</td>
</tr>
<tr>
<td></td>
<td>• Sub flow: A workflow launched by another workflow to drive the import step. See Workflows used as subflows.</td>
</tr>
<tr>
<td></td>
<td>• Flow action: The Flow Designer action that drives the import step. See Flow Designer.</td>
</tr>
</tbody>
</table>
5. Click Submit or Update.

6. Click the Start verify configuration related link to start the verify job. The Employee Document Import Jobs tab appears with the Verify job in the Queued state.

7. Reload the form to see if the import step validated. Validated indicates that the credentials are correct, the directory is valid, and shows the number of source employee files found in the directory.

Create or edit the stage directory lookup source step
Use Employee Document Import Jobs to create or edit the Stage Directory source step.

Before you begin
Role required: sn_hr_ef.admin, sn_hr_ef.document_import

About this task
Stage directory is required to locate your source employee documents from your local or third-party, cloud-based document repository. This step also uses the mapping to parse file names and create a record in the staging table for each of the files with the parsed data. The base system provides a sample Stage - Directory source step you can use as a model.

Procedure
1. Navigate to HR Administration > Import Configuration.
2. Click an existing Import Configuration record.
3. From the Employee Document Import Source tab, click an existing Stage - Directory source step or New.
4. Fill in or edit the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>A descriptive name that identifies your employee document bulk upload</td>
</tr>
<tr>
<td>configuration.</td>
<td>configuration.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source step</td>
<td>The import step that makes up the import job. Select Stage - Directory.</td>
</tr>
<tr>
<td>Import type</td>
<td>The import type that drives the source step. You can select the method that drives the source step.</td>
</tr>
<tr>
<td></td>
<td>• Sub flow: A workflow launched by another workflow to drive the import step. See Workflows used as subflows.</td>
</tr>
<tr>
<td></td>
<td>• Flow action: The Flow Designer action that drives the import step. See Flow Designer.</td>
</tr>
<tr>
<td></td>
<td>• Workflow: An automated way to provide a multi-step process. See Workflow.</td>
</tr>
<tr>
<td></td>
<td>• Script: Use to automate the import step. See Scripts.</td>
</tr>
<tr>
<td>Application</td>
<td>The application the import source is used in.</td>
</tr>
<tr>
<td>Domain</td>
<td>Automatically populated via domain separation and identifies the specific domain you are configuring employee documentation bulk uploads for.</td>
</tr>
<tr>
<td>Sub Flow</td>
<td>The subflow, flow action, workflow, or script that launches the source step based on the import type. For example, if you are using Flow Action as your Import type, the Action drop-down appears to select the action you previously created.</td>
</tr>
<tr>
<td>Action</td>
<td></td>
</tr>
<tr>
<td>Workflow</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Update**.

**Create or edit the stage file source step**

Use Employee Document Import Jobs to create or edit the stage file source step. Stage file is required to stage your source employee documents from your third-party, cloud-based document repository.

**Before you begin**

Role required: sn_hr_ef.admin, sn_hr_ef.document_import

**About this task**

The base system provides a sample Stage - File source step you can use as a model.
**Procedure**

1. **Navigate to HR Administration > Import Configuration.**
2. **Click an existing Import Configuration record.**
3. **From the Employee Document Import Source tab, click an existing Stage - File source step or New.**
4. **Fill in or edit the form.**

**Employee Document Import Source — Stage - File**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>A descriptive name that identifies your employee document bulk upload configuration. The name comes from the Employee Document Import Configuration. See Configuring employee document management bulk import with source document repository.</td>
</tr>
<tr>
<td>Source step</td>
<td>The import step that makes up the import job. Select Stage - File. Stage — File: Ensures that the employee documents from the source repository are located and mapped correctly.</td>
</tr>
</tbody>
</table>
| Import type          | The import type that drives the source step. You can select the method that drives the source step.  
\- • Sub flow: A workflow launched by another workflow to drive the import step. See Workflows used as subflows.  
\- • Flow action: The Flow Designer action that drives the import step. See Flow Designer.  
\- • Workflow: An automated way to provide a multi-step process. See Workflow.  
\- • Script: Use to automate the import step. See Scripts. |
| Application          | The application the import source is used in. |
| Domain               | Automatically populated via domain separation and identifies the specific domain you are configuring employee documentation bulk uploads for. |
| Sub Flow Action      | The subflow, flow action, workflow, or script that launches the source step based on the import type. For example, if you are using Flow Action as your Import type, the Action drop-down appears to select the action you previously created. |
6. Click the **Start staging job** related link. The staging job verifies that the source document directory and source files can be staged. The **Employee Document Import Jobs** tab appears with the Stage import step in the **Queued** state.

7. Reload the form to see if the Stage import step completed. The **Employee Document Staging** tab appears. You can view all source documents that are in the staging table and make corrections if necessary. See Correcting employee documents in the staging table.

8. Change staged documents that have a state of **Draft** to **Ready**. Staged documents must be in **Ready** state for it to be picked up in the **Capture** step. You can change the state by checking all staged documents that have a **Draft** state and selecting **Ready for import** from **Action on selected rows** or opening a specific staged document and selecting **Ready for Import**.

Creating or editing capture source step

Use Employee Document Import Jobs to create or edit the capture source step. Capture is required to import your source employee documents from your local or third-party, cloud-based document repository.

**Before you begin**

Role required: sn_hr_ef.admin, sn_hr_ef.document_import

**About this task**

The base system provides a sample Capture source step you can use as a model. The example for the local document repository provides a sample script that can be used.

**Procedure**

1. Navigate to **HR Administration > Import Configuration**.
2. Click an existing Import Configuration record.
3. From the Employee Document Import Source tab, click an existing Capture source step or **New**.
4. Fill in or edit the form.

<table>
<thead>
<tr>
<th>Employee Document Import Source — Capture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration</strong></td>
<td>A descriptive name that identifies your employee document bulk upload configuration. The name comes from the Employee Document Import Configuration. See Configuring employee document management bulk import with source document repository.</td>
</tr>
<tr>
<td><strong>Source step</strong></td>
<td>The import step that makes up the import job. Select Verify.</td>
</tr>
<tr>
<td></td>
<td>• Capture: Ensures that the employee documents from the source repository are imported to Employee Document Management.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Import type</td>
<td>The import type that drives the source step. You can select the method that drives the source step.</td>
</tr>
<tr>
<td></td>
<td>• Sub flow: A workflow launched by another workflow to drive the import step. See Workflows used as subflows.</td>
</tr>
<tr>
<td></td>
<td>• Flow action: The Flow Designer action that drives the import step. See Flow Designer.</td>
</tr>
<tr>
<td></td>
<td>• Workflow: An automated way to provide a multi-step process. See Workflow.</td>
</tr>
<tr>
<td></td>
<td>• Script: Use to automate the import step. See Scripts.</td>
</tr>
<tr>
<td>Application</td>
<td>The application the import source is used in.</td>
</tr>
<tr>
<td>Domain</td>
<td>Automatically populated via domain separation and identifies the specific domain you are configuring employee documentation bulk uploads for.</td>
</tr>
<tr>
<td>Sub Flow</td>
<td>The subflow, flow action, workflow, or script that launches the source step based on the import type. For example, if you are using Flow Action as your Import type, the Action drop-down appears to select the action you previously created.</td>
</tr>
<tr>
<td>Action</td>
<td></td>
</tr>
<tr>
<td>Workflow</td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Submit** or **Update**. Run the Capture job after the Verify configuration and Staging jobs have run successfully.

6. Click the **Start capture job** related link. The capture job imports the source documents into Employee Document Management. The Employee Document Import Jobs tab appears with the Stage import step in the Queued state.

7. Reload the form to see if the Stage import step completed and have a state of **Complete**.

**Bulk import map examples**

Mapping your source employee documents to required elements in Employee Document Management is crucial for a successful bulk import.

This topic provides examples on how to map your source employee documents to the required elements in Employee Document Management. The values provided are examples designed to guide you through the import map configuration.

**Map fields and values directly from existing file names.**

Using your existing employee document file names is recommended when your source employee documents reside in a local repository.

For example, an employee document can have all the meta data in the file name Abel_Tuter_tuition.pdf to map to Employee Document Management.

**Note:** When using regular expressions (RegEx) to define the replacement value, use a regular expression test site to ensure correct parsing.
**File name example**

The example file name is abel_tuter_tuition.pdf.

To find and extract the file name from the source repository, see this example:

The import map is looking for a source element called fileName.

The import map is going to translate this source element to a mapped element called fileName.

The Regex is looking for the format of the file name first_last_xxx.pdf.

**File name to employee name example**

From the file name, the employee name is extracted. Employee name is a requirement for Employee Document Management.

The import map is looking for a source element called fileName.

The import map is going to translate this source element to a mapped element called employee.
The Regex is looking for the format of the file name to be first_last_tuition.pdf (\w+)_\(\w+\)_\(\w+\).\(\w+\).

It replaces the original file name with first.last ($1.$2)

**File name to document type example**

From the file name, the document type is extracted. Document type is a requirement for Employee Document Management.

The import map is looking for a source element called fileName.

The import map is going to translate this source element to a mapped element called docType.

The Regex is looking for the format of the file name to be first_last_tuition.pdf (\w+)_\(\w+\)_\(\w+\).\(\w+\).

It creates a docType of tuition ($3).

**Note:** Having the source employee documents in a central repository, simple directory structure, and consistent file naming convention are highly recommended and reduces errors.

**Parse and map fields and values from a JSON output**

Using a JSON output is recommended when your source employee documents reside in a third-party, cloud-based repository.

**Map record for element item**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>Field</td>
</tr>
<tr>
<td>Mapped element</td>
<td>items</td>
</tr>
<tr>
<td></td>
<td>Looks for the items mapping element in an array of items in the folder.</td>
</tr>
</tbody>
</table>
### Map record for element item (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source element</td>
<td>entries</td>
</tr>
<tr>
<td></td>
<td>Source element in the JSON output and represents the items in a folder. For example, Box uses entries as the source element.</td>
</tr>
</tbody>
</table>

```
{ "total_count": 1, "entries": [{ "type": "file", "id": 518545525, "sequence_id": 1, "etag": 1, "name": "Meeting Notes", "type": "file" }, { "type": "file", "id": 30755777676, "sequence_id": 1, "etag": 1, "name": "Admin Guide (v1.0)" }]
```

### Map record for element employee

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>Field</td>
</tr>
<tr>
<td>Mapped element</td>
<td>item</td>
</tr>
<tr>
<td></td>
<td>Looks for item, an entry in an array of items in the folder. This mapping is used after Stage — Directory import source to run operations against a single item.</td>
</tr>
<tr>
<td>Source element</td>
<td>id</td>
</tr>
<tr>
<td></td>
<td>For each item in the array, find the file ID in the JSON output.</td>
</tr>
<tr>
<td>Filter regex</td>
<td>file</td>
</tr>
<tr>
<td></td>
<td>Combined with the Filter field to exclude subfolders.</td>
</tr>
<tr>
<td>Filter field</td>
<td>type</td>
</tr>
<tr>
<td></td>
<td>Filter output to where the type field is equal to file to exclude subfolders.</td>
</tr>
</tbody>
</table>

```
{ "id": "324844500259", "type": "file", "name": "Valid Document.pdf", "size": 100, "order": HTTP, "directory": "ASC", "name": "Welcome to Box.pdf", "offset": 0, "limit": 100, "order": "[by]" }
```

### Add map records for element employee (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>Field</td>
</tr>
</tbody>
</table>
Add map records for element employee (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regex</td>
<td>(\w+)\s(\w+)</td>
</tr>
<tr>
<td>Replace</td>
<td>$1.$2</td>
</tr>
<tr>
<td>Mapped element</td>
<td>employee</td>
</tr>
<tr>
<td>Source element</td>
<td>owned_by.name</td>
</tr>
</tbody>
</table>

String translation to convert fname lname to fname.lname.
Converts files found in Regex field fname lname to fname.lname.
Looks for employee mapping element. Employee is a field in the file item.
This mapping is used after Stage — file import source.
Looks for name in owned_by object. Bypass nested objects with a dot notation.

Add map record for element employee (alternative)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>Value</td>
</tr>
<tr>
<td>Replace</td>
<td>david.lloo</td>
</tr>
<tr>
<td>Mapped element</td>
<td>employee</td>
</tr>
<tr>
<td>Source element</td>
<td>davidl</td>
</tr>
</tbody>
</table>

Selecting **Value** maps the employee element within an array of information from your source document to a specific value in Employee Document Management.
The value you want to replace the source element with in Employee Document Management.
Employee Document Management requires employee names to be formatted fname.lname.
This mapping is used after Stage — file import source.
Add map record for element employee (alternative) (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Looks for the source value of davidl.</td>
</tr>
</tbody>
</table>

This example illustrates how to use Value mapping to take an employee name from your source document and map it to the format that Employee Document Management requires.

Add map records for element docType

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>Field</td>
</tr>
<tr>
<td>Mapped element</td>
<td>docType</td>
</tr>
<tr>
<td></td>
<td>Looks for the docType mapping element embedded in the description field in the file item.</td>
</tr>
<tr>
<td></td>
<td>This mapping is used after Stage — file import source.</td>
</tr>
<tr>
<td>Source element</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Looks for name in description.</td>
</tr>
<tr>
<td>Filter regex</td>
<td></td>
</tr>
</tbody>
</table>

Add map records for element docType (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>Value</td>
</tr>
<tr>
<td></td>
<td>Use Value to map a specific value in your third-party, cloud-based repository to a value in Employee Document Management.</td>
</tr>
<tr>
<td>Replace</td>
<td>employee verifications</td>
</tr>
<tr>
<td></td>
<td>Replace verification (source) with employee verifications (Employee Document Management).</td>
</tr>
<tr>
<td>Mapped element</td>
<td>docType</td>
</tr>
<tr>
<td></td>
<td>Looks for the docType mapping element embedded in the description field in the file item.</td>
</tr>
<tr>
<td></td>
<td>This mapping is used after Stage — file import source.</td>
</tr>
<tr>
<td>Source element</td>
<td>verification</td>
</tr>
</tbody>
</table>
Add map records for element docType (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Look for the name value of verification in the JSON.</td>
<td></td>
</tr>
</tbody>
</table>

Field          Description
---------------- ----------------------------------
Mapping type    Value                 Use Value to map a specific value in your third-party, cloud-based repository to a value in Employee Document Management.
Replace         transcripts           Replace school (source) with transcripts (Employee Document Management).
Mapped element  docType             Looks for the docType mapping element embedded in the description field in the file item. This mapping is used after the Stage — file import source.
Source element  school               Looks for the name value school.

Add map record for element fileName

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>field</td>
</tr>
<tr>
<td>Mapped element</td>
<td>fileName                      Looks for the fileName mapping element embedded in the name field in the file item. This mapping is used after Stage — file import source.</td>
</tr>
<tr>
<td>Source element</td>
<td>name                          Looks for filename in the description in the JSON output.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Add map record for element url**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping type</td>
<td>field</td>
</tr>
<tr>
<td>Mapped element</td>
<td>url</td>
</tr>
<tr>
<td></td>
<td>Looks for the url mapping element embedded in the id field in the file item. This mapping is used after Stage — file import source.</td>
</tr>
<tr>
<td>Source element</td>
<td>Looks for id in JSON output.</td>
</tr>
</tbody>
</table>

> **Note:** some third-party, cloud-based repositories use the file ID. The capture import source builds a URL from this value.

---

**Bulk import mapping records**

An example of Employee Document Import Map.

---

When a connection to your source repository is confirmed and import maps are set up correctly, you can click **Start staging job** from Related Links.

**Correcting employee documents in the staging table**

Use the Employee Document Staging form to correct staging records prior to importing to HR Service Delivery. Staging records are created after you have mapped your source employee documents and the Start staging job has run.

**Before you begin**

- Role required: sn_hr_ef.admin, sn_hr_ef.document_import
Procedure
1. Navigate to HR Administration > Bulk Import > Document Staging. Or, from the Employee Document Import Configuration form, click the Start staging job related link. After the Employee Document Staging job runs successfully, you can review and correct any errors.

2. Click an employee name.

3. Click the Validate button. The Verify Fields pop-up appears.

4. Edit incorrect information.

5. Click Complete.

6. Click Ready for Import. You can also correct fields from the Employee Document Staging form.

### Employee Document Staging

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Employee associated with the staged employee document.</td>
</tr>
<tr>
<td>Document Type</td>
<td>The document type you want associated with the employee document.</td>
</tr>
<tr>
<td></td>
<td>Document types categorize your employee documents and determine access and retention.</td>
</tr>
<tr>
<td></td>
<td>See Define policies for a document type.</td>
</tr>
<tr>
<td>File name</td>
<td>File name of the employee document.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the employee document.</td>
</tr>
<tr>
<td></td>
<td>• Ready: Document is ready to be captured and moved to Employee Document Management.</td>
</tr>
<tr>
<td></td>
<td>• Draft: Document ignored when the Capture job is run and not moved to Employee Document Management.</td>
</tr>
</tbody>
</table>

7. Click the Attachment Content tab.

### Attachment Content

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content source</td>
<td>The type of source document repository your employee documents are being pulled from.</td>
</tr>
<tr>
<td></td>
<td>• URL: The source employee document repository is cloud-based.</td>
</tr>
<tr>
<td></td>
<td>• Local: The source employee document repository is local.</td>
</tr>
<tr>
<td>Content</td>
<td>The path in the source repository that the staged document resides.</td>
</tr>
</tbody>
</table>

8. Click the Additional Information tab.
9. Click **Validate** to ensure that the employee and document type are correct. You can change this information from the pop-up.

10. After making changes, click **Update**. The Employee Document Import Configuration form returns. You can continue reviewing and correcting Employee Document Staging records.

11. After reviewing and determining the staging records look correct, click the **Start capture job** related link to start the import process.

**Employee Experience Pack**

Employee Experience Packs are prepackaged configurations, content, and workflows that you can use as is or customize for your own HR processes.

Employee Experience Packs reduce your time and effort to implement best practices.

**Applications**

Applications for Employee Experience Packs may include:

- HR Service Delivery
- Case and Knowledge Management
- Employee Service Center
- Enterprise Onboarding and Transitions
- Content Delivery
- Content Automation

**Note:** The required licenses and plugins that you may need depend on the type of experience that you are implementing for your own HR processes.

**Preconfigured package**
Employee Experience Packs use preconfigured data, configurations, and content so that customizing or starting from the beginning is unnecessary, but you can still modify or create your own experiences. Employee Experience Packs provide you with:

- A complete implementation for a specific use case. An example is Parental Leave of Absence (LOA).

⚠️ Note: Parental LOA requires the HR Professional license. You can submit a plugin request through the HI Portal Service Catalog.

- Elements that your employees can use for self-help, such as sample knowledge articles, virtual agent conversations, and catalog items.
- Sample HR cases and tasks to help you manage your own HR processes.
- Targeted and other content that helps you to engage with your employees.
- Surveys, reports, or dashboards so that you can measure how successful your program and processes are.

**Employee Experience Packs**

For information about Employee Experience Packs and content, see the Employee Experience Packs on the SHARE site.

These Employee Experience Packs can guide you through the HR processes that require configuration:

- Pre-built services
- Activities
- Communications

**Parental leaves of absence**

Use a prepackaged configuration or customize your own Employee Journey for parental leaves of absence (LOAs) in your HR organization. Parental LOAs include maternity, paternity, or adoption leave.

Parental LOAs require that you activate these plugins:


⚠️ Note: This plugin activates the sn_hr_pj.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Parental Journey admin user by requiring a minimum number (the default is two) of active users with this role.

- Human Resources Scoped App: Lifecycle Events [com.sn_hr_lifecycle_events] plugin

The Lifecycle Events plugin requires:

- Human Resources Scoped App: Core [com.sn_hr_core] plugin
- Employee Service Center [com.sn_hr_service_portal]

⚠️ Note: Parental LOA requires the HR Professional license. To get this license, submit a plugin request through the HI Portal Service Catalog.

**HR Case Management**

You can standardize the documentation, interaction, and fulfillment of employee inquiries and requests with the HR Case and Knowledge Management application.
For more information, see Case and Knowledge Management and HR Administration.

With the HR Case and Knowledge Management application, you can manage and modify the features that make up parental LOAs.

The features are:

**HR Catalog**

Provide an HR service catalog so that employees can request services directly from HR.

See HR service catalog management.

The catalog items for parental leave are:

- Parental Leave of Absence Request
- Confirm your child’s birth or adoption date
- How to pay Benefits contributions on Leave

**HR case and task templates**

Use HR templates that automatically populate some fields on an HR case or task form that is based on an HR service to automate your agent’s work. HR templates also customize and automate the catalog item request form for your employees.

See HR templates.

The HR case and task templates that are related to parental LOAs are:

<table>
<thead>
<tr>
<th>HR templates</th>
<th>HR templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Choose how to pay benefits contribution during leave [sn_hr_core_task]</td>
<td>• Confirm child’s birth, adoption, or placement date [sn_hr_core_task]</td>
</tr>
<tr>
<td>• Confirm that employee has returned from leave [sn_hr_core_task]</td>
<td>• Confirm employee’s return to work date [sn_hr_core_task]</td>
</tr>
<tr>
<td>• Confirm that employee’s leave has started [sn_hr_core_task]</td>
<td>• Confirm that the employee returned to work from leave [sn_hr_core_case_total_rewards]</td>
</tr>
<tr>
<td>• Create transition plan for leave [sn_hr_core_task]</td>
<td>• Employee survey for leave approval [sn_hr_core_task]</td>
</tr>
<tr>
<td>• Enroll child in benefits [sn_hr_core_task]</td>
<td>• Notify the manager of the employee’s leave request [sn_hr_core_case_total_rewards]</td>
</tr>
<tr>
<td>• Notify payroll of the employee’s leave status [sn_hr_core_case_payroll]</td>
<td>• Order a company gift card for the new child [sn_hr_core_task]</td>
</tr>
<tr>
<td>• Parental Leave Employee Survey [sn_hr_core_task]</td>
<td>• Parental Leave of Absence Request [sn_hr_core_case_total_rewards]</td>
</tr>
<tr>
<td>HR templates</td>
<td>HR templates</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>• Pre-Leave pulse survey [sn_hr_core_task]</td>
<td>• Prepare a return to work plan for the employee [sn_hr_core_task]</td>
</tr>
<tr>
<td>• Prepare returning employee’s work setup [sn_hr_core_task]</td>
<td>• Process benefits deductions for an employee on leave [sn_hr_core_case_payroll]</td>
</tr>
<tr>
<td>• Review request and consult with employee [sn_hr_core_task]</td>
<td>• Schedule a one-on-one with Employee returning from Leave [sn_hr_core_task]</td>
</tr>
<tr>
<td>• Upload release to return to work document [sn_hr_core_task]</td>
<td>• Upload your documents to confirm your parental leave [sn_hr_core_task]</td>
</tr>
</tbody>
</table>

**HR Services**

Provide HR services that are related to parental LOAs to your employees.

See [HR services](#).

The HR services for parental LOAs are:

- Confirm or update new child’s info
  - Order company gift for new child
  - Update child’s birth or adoption date in HR system
  - Update Benefits with new child
- Confirm Return to work from Leave
  - Confirm Employee has returned from Leave
  - Update Leave Status to Completed
- Notify Manager of Leave of Absence Request
  - Speak with your Manager
  - Review Manager Guide to leaves of absence
- Notify payroll of employee’s leave status
- Parental Leave of Absence Request
- Process Benefits deductions for an employee on leave

**Knowledge articles**

Provide employees with a searchable knowledge base of HR policies, procedures, and other articles.

See [HR Knowledge Management](#).

The knowledge articles for parental LOAs are:

- KB0010006 — Managers’ Transition Plan guide for Leaves of Absence
- KB0010004 — Manager Guide to Parental Leave
- KB0010003 — Tips for discussing your leave of absence with your manager
- KB0010002 — Sample Parental Leave Policy FAQ
• KB0010001 — How to prepare for your Parental Leave of Absence
• KB0000102 — Employee Leave of Absence

**HR fulfillment instructions**

Provide focused and targeted information so that your HR employees can complete an HR case faster and more efficiently.

See [HR fulfillment instructions](#).

The HR Fulfillment Instruction for parental LOAs is:

• Parental Leave of Absence request instructions

**HR Administration**

Provide administrative services for the Case and Knowledge Management application.

See [HR Administration](#).

The following are under HR Administration and Parental LOA as part of Employee Journeys:

• Leaves of Absence show all employees that have requested parental LOA and provides:
  ◦ Leave type
  ◦ Leave status
  ◦ First day of leave
  ◦ Estimated last day of leave

• HR criteria filters employees for campaigns, communication, lifecycle events, knowledge articles, HR services, and content for employees requesting or on parental LOA.

**Enterprise Onboarding and Transitions**

You can use the pre-configured data for Parental Leave of Absence to make sure that your employees have a smooth transition process. The data has:

• 1 Lifecycle Event
• 10 Activity Sets
• 28 Activities
See Enterprise Onboarding and Transitions.

**Employee Service Center**

Employees can use the pre-configured Employee Service Center to view information, create inquiries or requests, and help them through each stage of the process.

For more information, see Employee Service Center.

**Content Delivery**

Content Delivery lets you create content for your employees that you can deliver through the Employee Service Center. You can create different types of information and target specific employees.

See Employee content publishing and delivery.

**Parental Leave Guide Pages**

Employees can access the Employee Service Center at any time to learn about the process. After the employee submits a parental leave request, the employee receives lifecycle event and campaign announcements on the Employee Service Center that link to pages that are based on the particular stage in the process.
Content Delivery widgets provide examples that are available to use as is or you can modify for your own process.

The portal content under Content Delivery contains content that your company wants to appear on your Employee Service Center or portal.

The audience for this content are employees.

The portal content for parental LOAs include content under the following:

**Getting started**

The following data, either links to content or rich text that you can customize to better reflect your processes.

- Getting Started: URL link
- Parental Leave Guide: URL link
- Pre-leave information: Rich text

**Awaiting Approval**

- Awaiting Approval: URL link

**Planning Leave**

- Planning Leave: URL link

**On Leave**

- On Leave: URL link

**Planning Return**
Content Automation

Works with Content Delivery and the Employee Service Center to build campaigns that target specific employees for defined dates and times.

For more information about campaigns, see Campaigns for HR Service Delivery.

The Parental Journey campaign has two campaign bundles and two campaign contents. These content items add announcements on the Employee Service Center after a request for parental leave and when the employee returns to work.

- Leave is requested
  - Pre-leave information
- Leave is completed
  - Post-leave information

Because the leave and return dates are unknown when requesting a parental LOA, the Condition trigger type is available for campaign bundles. For more information about campaigns and content automation, see Create campaign bundles.

The following business rules are available and are created on the Leave of Absence table [sn_hr_core_leave_of_absence]:

- Campaign condition start: Triggers on the insert of a new record and adds an employee to the campaign. It triggers the start condition event.
- Campaign condition stop: Triggers upon completion of the leave of absence. It triggers the stop condition for an employee and removes them from the campaign.

Other related factors

The Employee Journeys parental LOA has other areas that affect the base system and any configuration changes that you may want:

- Leave of Absence [sn_hr_core_leave_of_absence] table
  - Table under HR Administration.
  - Contains employee name, leave type, leave status, first day of leave, and estimated last day of leave.
  - Available in HR core without activating Employee Journeys.
- HR Total Rewards Case [sn_hr_core_case_total_rewards]
  - HR case table that initiates the leave of absence HR service.
- Campaign [sn_ca_campaign]
  - Table that contains the conditions from the campaign bundle.
- Campaign Bundle [sn_ca_campaign_bundle]
  - Table that contains the campaign bundle with condition triggers that applies to a campaign user.
• Leave Status
  ◦ New field for an HR profile that provides the status of an employee who requested a parental LOA.

• HR Criteria
  ◦ HR criteria that customizes who activities, content, or targets tasks to
  ◦ Employee Birthing Parent: The Upload your release to return to work activity in the Plan Return activity set uses this HR criteria. It prompts the birthing parent to upload a doctor release form to return to work.
  ◦ Employees enrolled in Benefits: The Choose how to pay Premium Benefits premiums activity in the Prepare for Leave activity set uses this HR criteria. It targets employees that are enrolled in company benefits and creates a case to payroll to process deductions as needed.
  ◦ Employees on Parental Journey: The Parental Journey campaign uses this HR criteria to determine who to target for pre-LOA information and post leave information.

• Parental LOA types are:
  ◦ Requested
  ◦ Approved
  ◦ On Leave
  ◦ Rejected
  ◦ Completed
  ◦ Canceled

Create an HR case for parental leaves of absence

Create an HR case so you can help employees, through chat, email, or by phone start the parental leaves of absence (LOA) process. Employees can also create HR cases by submitting a request.

Before you begin
Role required: sn_hr_core.case_writer

About this task
For specific details on creating an HR case, see Create an HR case and Work an HR case. Follow the instructions to create an HR case using the HR Case Creation form for parental LOAs.

Procedure
1. Navigate to HR Case Management > Create New Case. Search for Employee appears.
2. Enter the employee name that requested the parental LOA.
3. From HR service, select Parental Leave of Absence Request.
4. Select Create Case.
   • The system assigns the case to agents with the LOA skill. See Assignment and matching rules in HR.
   • Two child cases are created and assigned to agents with the payroll skill.
   • Fulfillment instructions appear for the case.
5. Select the Parental Leave Details tab.
6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave subtype</td>
<td>Identifies the role of who is requesting a parental LOA or the type of parental leave:</td>
</tr>
<tr>
<td></td>
<td>• Birthing parent</td>
</tr>
<tr>
<td></td>
<td>• Partner of birthing parent</td>
</tr>
<tr>
<td></td>
<td>• Adoption</td>
</tr>
<tr>
<td></td>
<td>• Surrogate</td>
</tr>
<tr>
<td></td>
<td>• Foster placement</td>
</tr>
<tr>
<td>Leave status</td>
<td>Indicates the status of the parental LOA:</td>
</tr>
<tr>
<td></td>
<td>• Requested</td>
</tr>
<tr>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td>• On Leave</td>
</tr>
<tr>
<td></td>
<td>• Rejected</td>
</tr>
<tr>
<td></td>
<td>• Completed</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td>Child arrival date</td>
<td>Date that the child arrives.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use this field when adoption or foster placement is selected from</td>
</tr>
<tr>
<td></td>
<td>Leave subtype.</td>
</tr>
<tr>
<td>First day of leave</td>
<td>Date that the employee is requesting to start an LOA.</td>
</tr>
<tr>
<td>Estimated last day of leave</td>
<td>Estimated date that the parental LOA ends.</td>
</tr>
<tr>
<td>Due date</td>
<td>Birth date of the child.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use this field when you select one of the following from the Leave</td>
</tr>
<tr>
<td></td>
<td>subtype field:</td>
</tr>
<tr>
<td></td>
<td>• Partner of birthing parent</td>
</tr>
<tr>
<td></td>
<td>• Surrogacy</td>
</tr>
<tr>
<td></td>
<td>• Birthing parent</td>
</tr>
</tbody>
</table>

7. Select **Save** to remain on the HR case or **Update** to save the HR case and return to the HR case list.

8. Select **Ready for Work**.
   - The 10 Activity Sets appear at the top of the form with the status of each activity.
   - The system creates and assigns a child case with child tasks.
   - The case progresses based on the completion of each child case and task.
   - The employee appears under **HR Administration > Leaves of Absence**.
HR Predictive Intelligence Workbench

The HR Predictive Intelligence Workbench application provides prebuilt use case templates and guides you through your predictive machine-learning implementation to create intelligent HR processes. Business process architects use prebuilt functionality, including pretrained models, to get started with machine learning use cases.

Overview

The HR Predictive Intelligence Workbench includes prebuilt use case templates that systematically guides you through the process of creating and training new predictive models, evaluating and testing them, and finally adding them to your business process to add value to your HR organization.

Once you train your custom use cases, they are usable immediately. No prior knowledge or experience with artificial intelligence or machine learning is required when you use HR Predictive Intelligence Workbench.

The application includes a template with prebuilt guidance to assist you in creating, training, evaluating, testing, and producing, your unique predictive models.

**Important:** The HR Predictive Intelligence Workbench application depends on the activation of the Predictive Intelligence Workbench and Human Resources Scope App: Core plugins.

HR Predictive Intelligence Workbench administration

With the sn_piwb_hr_content.admin role, you can activate and configure the application to meet specific requirements.

- Configure Predictive Intelligence Workbench property settings, such as the minimum number of predictions for evaluating use cases that under perform and the minimum percentage of net automation to show an auto-trained model.
- Create a Predictive Intelligence Workbench user group and assign users necessary roles to move through the model implementation process.
- Configure notifications to alert Predictive Intelligence Workbench users via email when a new model is trained and ready for evaluation.
- Create use case templates and make them available to your Predictive Intelligence Workbench users.

Activate HR Predictive Intelligence Workbench

You can activate the Predictive Intelligence Workbench HRSD content plugin [com.sn_piwb_hrsd_content] if you have the admin role.

Before you begin

Role required: admin

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Related reference**

- List of plugins (Quebec)

**Components installed with HR Predictive Intelligence Workbench**

Several types of components are installed with activation of the HR Predictive Intelligence Workbench HRSD content plugin [com.sn_piwb_hrsd_content] plugin, including user roles.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_piwb_hr_content.admin</td>
<td>With this role, you can:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure Predictive Intelligence Workbench property settings, such as the minimum number of predictions for evaluating use cases that under perform and the minimum percentage of net automation to show an auto-trained model.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create a Predictive Intelligence Workbench user group and assign users necessary roles to move through the model implementation process.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure notifications to alert Predictive Intelligence Workbench users via email when a new model is trained and ready for evaluation.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create use case templates and make them available to your Predictive Intelligence Workbench users.</td>
<td></td>
</tr>
</tbody>
</table>

**HR Predictive Intelligence Workbench notifications**

HR Predictive Intelligence Workbench includes several email notifications that alert users throughout the use-case model implementation.

The Predictive Intelligence process architects who are creating and training use-case models receive an email notification when a use case model is successfully trained and when batch testing has finished successfully. If a use case fails training or if batch testing produces errors, users will receive notifications about these scenarios, as well.

Users can click a link in the email notification to view a newly trained use case or batch test results. They can also download the test results, if desired. Users can receive the following notifications:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use case model training successful</td>
<td>Sends an email to a specified user group when a use case model is successfully trained.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Batch test run complete</td>
<td>Sends an email to a specified user group when batch testing is complete.</td>
</tr>
<tr>
<td>Use case Model training failed</td>
<td>Sends an email to a specified user group when a use case model training has failed.</td>
</tr>
<tr>
<td>Table: PI Solution Model [piwb_model]</td>
<td></td>
</tr>
</tbody>
</table>

For more details about email notifications for Predictive Intelligence Workbench, see Preview email notification.

Create an HR Predictive Intelligence Workbench user group

Create an HR Predictive Intelligence Workbench user group and add users or roles to the group to receive email notifications when the use-case model training and testing phase are complete.

About this task

Create an HR Predictive Intelligence Workbench user group and add either users or roles to the group so that email notifications are sent to alert users throughout the use case model training and testing phases. Users can receive notifications for the following Predictive Intelligence Workbench events.

- Use case training is successful
- Batch testing is complete
- Use case training has failed

To create an HR Predictive Intelligence Workbench user group and add users, see Create a user group. For more information about the email notifications provided with this application, refer to HR Predictive Intelligence Workbench notifications.

HR Predictive Intelligence Workbench implementation

You can use machine learning to optimize your business processes. You can train and implement HR Predictive Intelligence Workbench use cases to augment your existing application workflows.

Explore common use case templates

With the sn_piwb_hr_content.admin role, you can explore the use case templates and create predictive machine learning models. To create a machine learning model, you first select a pre-built use case template. Some of the pre-built templates are guided. Guided templates include a comprehensive setup process to help you through implementation. Templates with available auto-trained models accelerate your setup process, by providing a pre-generated model based on your data.

When a template indicates Auto-trained model available, this means you can go directly to the evaluation phase of the use case setup. If the auto-trained model is acceptable, you can directly integrate it with your business processes. Otherwise, you can tune this model or create another model. You may change the name and description of the use case later. The auto-trained model estimates that 88% of your services are correctly predicted.

Use case creation phases

Creating a predictive machine learning model involves several phases. After you create your use case model, you need to train it, evaluate and tune it, test it for prediction results, and then integrate it with your business process. Use case creation phases include:
• Create and train models: Define parameters to create a model that you’ll train based on your unique data. It is common to create multiple models in this phase.

• Evaluate and tune your models: After you create your models, you’ll refine them by defining the right combination of coverage and precision to use.

• Test your models: Get prediction results from your models to decide which one is best to integrate with your business process. You can use a single or batch testing process to see if a model returns a correct result.

• Integrate the best model: Deploy the best model into your business process. After you determine which model returns the best, correct result, integrate it into production.

**HR PIWB template: Predict the HR service for incoming cases**

Use a guided template that walks you through setting up a machine learning model to predict the correct HR service for cases.

**Before you begin**

Role required: sn_piwb_hr_content.admin

**Procedure**

1. Navigate to Predictive Intelligence Workbench > Use cases > All Created Use Cases.
2. Click Go to templates.
3. Select the Predict the Service for HR Cases guided template. The Use case - Predict the Service for HR Cases window appears.
4. Provide a unique name for your use case in the Use case name field.
5. Provide unique details about the use case in the Short description field.
6. Click Start.

   **Note:** To start implementation, you must provide a use case name and short description.

The use case set up page opens displaying the name and description of the use case you created. On this page, you can see all the implementation phases you will work through to create and implement your use case model.

7. In the Create and train models section of the setup, click Start to create a model associated with your use case.

8. Fill in the required fields with a Model name and Short description.

   **Note:** Other data related to the model is pre-filled by default, such as the Data table, Predicted field, and Processing Language.

9. Expand the Review the filters used to train this model section to view the default filters. You can customize the filters to best represent your business data or add new criteria by clicking New Criteria.

10. Expand the Review the input fields for this model section to view the pre-populated fields. You can customize the fields to best represent your business data by moving fields between the Available and Selected slush buckets.

11. Click Save.

   The use case ML Model setup page opens.

12. Click Continue in the Create and train models section.

   The Create a model page opens.

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
13. Click **Train this model**.
   The **Train this model** window appears letting you know that the process will take a while.

14. Click **Start** to initiate training.
   You are returned to the ML Model setup page.

15. Click **View Progress** below the header on the ML Model setup page to monitor the training process.

16. Click **Start** to initiate training.
   You are returned to the use case setup page.

17. Click **View Progress** below the header on the use case setup page to monitor the training process.

18. On the use case setup page, click **Start** in the **Evaluate and tune your models** section.
   The use case **Evaluate and tune your models** page opens. Here you can refine your use case model, defining the right combination of coverage and precision to use.

19. Click the box next to the use case model that you want to evaluate and tune.
   You can view the evaluation data for the use case model by clicking the chevron icon next to the model name to expand details.

20. In the **Select an Action** list menu, select **Open model record**.
    The use case model record opens. You can view the **Precision(%)**, **Coverage(%)**, and **Net Automation(%)** scores.

21. In the **Retraining Schedule** field you can change the definition, if desired. The default value is **Run Once**, but you can retrain as often as every 30 days to every 180 days.

22. If you made evaluation or tuning changes to the use case model, click either **Update** or **Update and retrain**, to run retraining again one time.
   The use case **Evaluate and tune your models** page opens.

23. If you are ready to test your use case model, click the box next to the model that you want to test.

24. In the **Select an Action** list, select **Test this model**.
    The use case **Testing your models** page opens with the use case model you selected to test is in the **Selected** slush bucket.

25. In the **Select models to test** section, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

26. In the **Define testing parameters** section, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

27. Determine the number of top results you want to display.

28. In the **Input fields** section, provide a short description of your use case model test.

29. Click **Run Test**.

30. View the test results data for the use case model in the **View test results** section.

31. If you are ready to integrate your use case model into your business processes, return to the use case **Evaluate and tune your models** page and select the box next to the model that you want to integrate. **Start** in the **Integrate the best model** section.

32. In the **Select an Action** list menu, select **Integrate this model**.
    The **Select a model to integrate** page opens.

33. Click **Integrate**.

34. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action.
You have integrated a use case model into your business process.

⚠️ Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

**HR PIWB template: Predict the assignment group for incoming cases**

Use a guided template that walks you through setting up a machine learning model to predict the correct assignment group for cases.

**Before you begin**
Role required: sn_piwb_hr_content.admin

**Procedure**

1. Navigate to **Predictive Intelligence Workbench > Use cases > All Created Use Cases**.
2. Click **Go to templates**.
3. Select the **Predict Assignment Group for HR Cases** guided template and click **Start**. The **Use case - Predict Assignment Group for HR Cases** window appears.
4. Provide a unique name for your use case in the **Use case name** field.
5. Provide a unique name for the model in the **Model name** field.
6. Click **Advanced Setup**. The use case set up page opens displaying the name and description of the use case you created. On this page, you can see all the implementation phases you will work through to create and implement your use case model.
7. In the **Create a model** section of the setup, fill in the required fields with a **Model name** and **Short description**

⚠️ Note: Other data related to the model is pre-filled by default, such as the **Data table**, **Predicted field**, and **Processing Language**.
8. Expand the **Review the filters used to train this model** section to view the default filters. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**.
9. Expand the **Review the input fields for this model** section to view the pre-populated fields. You can customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets.
10. Click **Save**. The use case **ML Model** setup page opens.
11. Click **Continue** in the **Create and train models** section. The **Create a model** page opens.
12. Click **Train this model**. The **Train this model** window appears letting you know that the process will take a while.
13. Click **Start** to initiate training. You are returned to the **ML Model setup page**.
14. Click **View Progress** below the header on the **ML Model setup page** to monitor the training process.
15. Click **Start** to initiate training. You are returned to the use case setup page.
16. Click **View Progress** below the header on the use case setup page to monitor the training process.
17. On the use case setup page, click **Start** in the **Evaluate and tune your models** section. The use case **Evaluate and tune your models** page opens. Here you can refine your use case model, defining the right combination of coverage and precision to use.

18. Click the box next to the use case model that you want to evaluate and tune. You can view the evaluation data for the use case model by clicking the chevron icon next to the model name to expand details.

19. In the **Select an Action** list menu, select **Open model record**. The use case model record opens. You can view the **Precision(%)**, **Coverage(%)**, and **Net Automation(%)** scores.

20. In the **Retraining Schedule** field you can change the definition, if desired. The default value is **Run Once**, but you can retrain as often as every 30 days to every 180 days.

21. If you made evaluation or tuning changes to the use case model, click either **Update** or **Update and retrain**, to run retraining again one time. The use case **Evaluate and tune your models** page opens.

22. If you are ready to test your use case model, click the box next to the model that you want to test.

23. In the **Select an Action** list, select **Test this model**. The use case **Testing your models** page opens with the use case model you selected to test is in the **Selected** slush bucket.

24. In the **Select models to test** section, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

25. In the **Define testing parameters** section, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

26. Determine the number of top results you want to display.

27. In the **Input fields** section, provide a short description of your use case model test.

28. Click **Run Test**.

29. View the test results data for the use case model in the **View test results** section.

30. If you are ready to integrate your use case model into your business processes, return to the use case **Evaluate and tune your models** page and select the box next to the model that you want to integrate. **Start** in the **Integrate the best model** section.

31. In the **Select an Action** list menu, select **Integrate this model**. The **Select a model to integrate** page opens.

32. Click **Integrate**.

33. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action. You have integrated a use case model into your business process.

   **Note:** For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

**HR Service Delivery Agent Workspace**

As an HR agent, you use HR Service Delivery Agent Workspace to interact with employees, respond to inquiries, and resolve issues quickly.
HR Service Delivery Agent Workspace is a configurable service desk application that is based on Agent Workspace. This application puts all the tools that you need in one place so that you can assist employees with their needs.

With HR Service Delivery Agent Workspace, you can:

• Chat with employees and create or work on their requests.
• Take calls from employees and create or work on their requests.
• Create or work on HR cases to completion.
• View information that is related to the employee or the case.
• Search for an employee and verify that it is the correct employee by address, location, or other HR profile information.
• Manage and view the case list.

Using the HR Service Delivery Agent Workspace
Here’s how you use HR Service Delivery Agent Workspace.

Agent Workspace for HR

Key benefits

Single-pane view

See all details about an issue in one place.

Integrated communication channels

Communicate in real time with employees by chat or phone in the same interface.
Agent Assist

Close cases and incidents faster with Agent Assist recommendations.

Get started
Select a tile to get started.
Exploring HR Service Delivery Agent Workspace

Use HR Service Delivery Agent Workspace to manage your employee HR requests from one place.

Home page

The Home page provides you with an overview of your work at a glance. It provides you with information that can help you decide what you should act on first, like HR cases and their Service Level Agreement (SLA) status, items that affect your team, and general information and announcements.

Case list

From the Home page, you can access the Case list. The Case list provides you with a view into all HR cases or you can filter and sort by what is relevant to you.
HR case form

Manage multiple cases, view information that is related to the case, and use knowledge articles or similar cases to manage the case.

<table>
<thead>
<tr>
<th>Number</th>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tabs</td>
<td>Tabs that you click to see lists, HR case numbers, and the new record icon.</td>
</tr>
<tr>
<td>Number</td>
<td>Agent Workspace feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>2</td>
<td>Form header</td>
<td>Header information of an HR case. You can see the details of an HR case including the HR service, priority, state, and assigned-to agent.</td>
</tr>
</tbody>
</table>
| 3      | UI actions              | Button that you click to save changes you made, change the state, cancel, or other actions for a case.  

**Note:** The buttons that appear are similar to the native platform UI.

The button types that appear depends on the type and state of the HR case. |
| 4      | Related items           | Shows details about the HR case and records from other tables that have a relationship with the HR case.  

**Note:** When a case appears under Playbook, these tabs change. For more information, see Exploring HR Service Delivery Playbook. |
| 5      | Case details            | Information about the case:  

- Subject person  
- HR service requested  
- Priority assigned  
- Assignment group  
- Assigned agent  
- Description  
- Comments and Work notes |
| 6      | Activity stream         | Comments, work notes, and current and past states of the case. |
| 7      | Contextual side panel   | Help to manage your case. What appears depends on the type of case that you are working on. The following can help you:  

- Agent assist: Shows you relevant knowledge articles about the case.  
- Employee documents: Shows all documents that are related to the subject person or the HR case.  

**Note:** The Contextual side panel requires the Employee Document Management [com.sn_employee_document_management] plugin. For more information, see Employee Document Management.  

- Attachments: Shows the attachments that are relevant or related to the case. Attachments become employee documents after they
are moved. For example, receipts for tuition reimbursement are attachments to an HR case. After you move attachments to Employee Document Management, they are now employee documents. See Move employee documents using HR Service Delivery Agent Workspace.

**Note:** A small green dot indicates there are attachments.

- **Fulfillment instructions:** Provides instructions to help you work and complete the case.
- **Response templates:** Provides responses that you can cut and paste into the comments and work notes of the case. These templates can also provide you with responses for any communication that you have with the subject person.

### Tabs

Use tabs to display the records that are associated with an HR case, like case details and tasks. You can select a tab and jump to the information.

<table>
<thead>
<tr>
<th>Number</th>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tabs</td>
<td>High-level information like Home, Lists, and the Inbox. Child tabs appear below the top tabs and</td>
</tr>
<tr>
<td>Number</td>
<td>Agent Workspace feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Related Items menu</td>
<td>Menu that appears for all HR cases. This menu provides a quick and easy way to look up information about a case and subject person.</td>
</tr>
</tbody>
</table>

**HR profile icons**

Learn about the icons in the HR profile section.
<table>
<thead>
<tr>
<th>Number</th>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HR profile icons</td>
<td>Icons that enable you to get quick access to information about the opened for and subject person.</td>
</tr>
</tbody>
</table>

- : Select the HR profile icon to access the HR profile for people who are related to the case. Selecting an HR profile also displays the at-a-glance side panel where you can see information that your HR admin configures and other things like the email, office location, and the employee’s organization information. For more information, see the At a Glance panel.

- : Select the Search for record icon to access a list of all HR profiles within your company.

- : Select the Open deep link icon to access information outside of the application to help fulfill the case. For information about configuring deep links, see Link generator for HR Service Delivery.

**Note:** For information on how to set up custom actions on record fields, see Set up custom actions on record fields in Workspace.
**HR Service Delivery Agent Workspace contextual side panel**

The contextual side panel in HR Service Delivery Agent Workspace provides information designed to help you work an HR case and interact with your employees. The contextual side panel provides a column of icons that provides you with information. Use the information when you interact with your employees or to complete the case.

### At a Glance

**Employee**
- Jv, James Vittolo
- VP, Client Services

**Number**
- HRP0000354

**Employment start date**
- 2019-06-09

**Office location**
- 322 West 52nd Street, New York, NY

**Email**
- jvittolo@example.com

---

The icons that appear depend on the type of HR case you are looking at.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="At a Glance" /></td>
<td><strong>At a Glance</strong>: Provides key HR profile details for fast recall. Having this information readily available helps agents understand who they are trying to help when communicating with an employee.</td>
</tr>
<tr>
<td><img src="image" alt="Agent Assist" /></td>
<td><strong>Agent Assist</strong>: Provides Knowledge articles related to the type of case. You can also provide comments (visible to employee) or work notes (not visible to employee) or view all activities related to the case.</td>
</tr>
<tr>
<td><img src="image" alt="Employee Documents" /></td>
<td><strong>Employee Documents</strong>: Lists documents related to the case you are on. Select the document and you can download it or rename it.</td>
</tr>
<tr>
<td><img src="image" alt="Attachments" /></td>
<td><strong>Attachments</strong>: Documents associated with an HR case that are attachments. These attachments can be moved to Employee Document Management (EDM) for archival and historical purposes. Select an attachment and you can download or delete it. For more information about EDM, see <a href="#">Employee Document Management</a>.</td>
</tr>
<tr>
<td><img src="image" alt="Response Templates" /></td>
<td><strong>Response Templates</strong>: Shows reusable messages that you can use when responding to an employee that has a question about their case. Copy the text from the response template you want to use and paste the text into the Comments or Work notes section of the HR case.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>An HR service configures response templates and are a fast, consistent, and efficient way to respond to common questions related to HR cases. For more information, see <a href="https://servicenow.com">Response templates for HR Service Delivery</a>.</td>
</tr>
<tr>
<td>✔</td>
<td>Fulfillment Instructions: Provides you with focused and targeted information on how to complete an HR case faster and more efficiently. Can include specific instructions, KB articles, or a checklist of what to do on the case. For more information, see <a href="https://servicenow.com">HR fulfillment instructions</a>.</td>
</tr>
</tbody>
</table>

**Setting up HR Service Delivery Agent Workspace**

Set up HR Service Delivery Agent Workspace so that your agents can engage with your employees, answer questions, create cases, and resolve issues.

**ServiceNow® HR Service Delivery Agent Workspace** uses the Agent Workspace application as a platform.

To set up HR Service Delivery Agent Workspace, you can:

- Activate the Human Resources Scoped App: Core [com.sn_hr_core] plugin.
- Set up these components of the HR Service Delivery Agent Workspace:
  - Communication channels and routing.
  - Additional components and settings that are specific to HR Service Delivery.
  - Forms in workspace. See [Set up forms in Workspace](https://servicenow.com).
  - Workspace setup. See [Set up Workspace](https://servicenow.com).

**Guided setup**

Use **HR Agent Workspace Guided Setup** to step through the initial configuration of **HR Agent Workspace**.

**HR Agent Workspace Guided Setup** provides an introduction to starting your configuration. It also organizes configuration activities into categories. Each category provides information like planning guidance, pre-setup steps, and links to useful information. Each category also provides links to the pages in your instance where you perform the configuration.

To access **HR Agent Workspace Guided Setup**, navigate to **HR Case Management > HR Agent Workspace Guided Setup**.

For more information on **Guided Setup**, see [Using guided setup](https://servicenow.com).

**Roles installed**

By activating the Human Resources Scoped App: Core [com.sn_hr_core] and Human Resources Scoped App: Workspace [com.sn_hr_agent_workspace] plugins, you install the following roles:
<table>
<thead>
<tr>
<th>HR role title [name]</th>
<th>Description</th>
<th>Contains</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR manager [sn_hr_core.manager]</td>
<td>Grants access to all HR cases, profiles, and secure information. With this role, you can manage HR Service Delivery Agent Workspace lists and categories. This role contains the Workspace List Admin, which is an elevated role. For more information on elevated roles, see Elevated privilege roles. The Workspace user [workspace_user] role allows you to access HR Service Delivery Agent Workspace and create and access interactions.</td>
<td>• Workspaces (workspace_list_admin) &lt;br&gt;○ Workspace user [workspace_user]</td>
</tr>
<tr>
<td>HR case writer [sn_hr_core.case_writer]</td>
<td>Grants access to write all HR cases. With this role, you can access HR Service Delivery Agent Workspace and view, create, and work on existing cases. You can also access all areas of Case and Knowledge Management. This role contains the Workspace user role, which allows you to perform interaction agent and interaction queue transfers.</td>
<td>• Workspaces (workspace_user) &lt;br&gt;○ Interaction agent [interaction_agent]</td>
</tr>
<tr>
<td>HR agent [sn_hr_core.basic]</td>
<td>Grants access to basic HR agents to HR Service Delivery Agent Workspace modules. This role contains the Advanced Work Assignment Agent [awa_agent] role, which allows an HR agent to work customer interactions and manages workload across multiple service channels.</td>
<td>• Advanced Work Assignment Agents [awa_agent] &lt;br&gt;○ To see all the roles contained within the HR agent [sn_hr_core.basic] role, see Components installed with Case and Knowledge Management.</td>
</tr>
<tr>
<td>Workspace content manager [sn_cd.workspace_content_manager]</td>
<td>Lets you schedule content to workspace. &lt;ul&gt;&lt;li&gt;The uxframework_user role allows you to browse and select from the library of UX component records so they can set a component reference field on any accessible table.&lt;/li&gt;&lt;li&gt;The sn_cd.content_manager role grants access to Content Delivery.&lt;/li&gt;&lt;li&gt;The sn_esign.config_manager role can manage the e-signature configurations.&lt;/li&gt;&lt;li&gt;The sn_cd.content_approver role can approve content that is scheduled to appear on the Employee Service Center or Service Portal.&lt;/li&gt;&lt;/ul&gt;</td>
<td>• UX Components (uxframework_user) &lt;br&gt;○ Content Delivery Content Manager [sn_cd.content_manager] &lt;br&gt;○ E-Signature Configuration Manager [sn_esign.config_manager] &lt;br&gt;○ Content Delivery Approver [sn_cd.content_approver]</td>
</tr>
</tbody>
</table>
| HR Workspace Admin [sn_hr_ws.admin] | Lets you configure all aspects of HR Service Delivery Agent Workspace. <ul><li>The workspace_admin role allows you to configure.</li><li>The chat_admin role administers the chat tables.</li><li>The uxframework_designer role has write access to UX page element records for designing UIs.</li></ul> | • Workspaces (workspace_admin) <br>○ Chat Administration [chat_admin] <br>○ UX Framework Designer [uxframework_designer] <br>○ Agent Workspace User [agent_workspace_user] <br>○ Agent Recommendation Admin [sn_agent_recommend.recommendation_admin] <br>○ Interaction Administration [interaction_admin] <br>○ Workspace List Administration [workspace_list_admin]
<table>
<thead>
<tr>
<th>HR role title [name]</th>
<th>Description</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ The agent_workspace_user role allows you to perform interaction agent and interaction queue transfers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The sn_agent_recommend.recommendation_admin role manages agent assist recommendation configurations.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The interaction_admin role allows you to administer the Interaction Management system.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The workspace_list_admin role allows you to manage workspace lists and categories.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The ui_action_admin role allows you to manage UI actions.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The ui_builder_admin role provides permission to use the UI Builder APIs so you can create, update, read, and delete UX pages.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The uxframework_user role allows you to browse and select from the library of UX component records so they can set a component reference field on any accessible table.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The sn_intel_analyzer.similarity_analyzer_admin role allows you to administer the Similarity Analyzer. The Similarity Analyzer defines patterns and trends that can help you resolve a record.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The form_admin role manages forms, form sections, and section elements.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The personalize_form role allows you to personalize forms.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✅ The ui_notification_admin role allows you to configure notification triggers.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Rich text

Rich text allows you to format your comments or work notes to emphasize your message and is readable across many programs and platforms.

You can enable rich text for HR Service Delivery Agent Workspace by using the glide.ui.journal.use_html system property (sys_properties.list). By default, this property is set to false (off).
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Toggle compose settings icon that you select to show the rich text editor and stacked view icons.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Rich text editor slider that you can toggle on to turn on the rich text.</td>
</tr>
<tr>
<td>![icon]</td>
<td>Stacked view slider that places Comments and Work notes side-by-side or stacked above one another.</td>
</tr>
</tbody>
</table>

⚠️ **Warning:** If your company is using other Agent Workspace applications, turning this property to `true` (on), might impact your system performance.

**HR Service Delivery Agent Workspace Guided Setup**

Use **HR Agent Workspace Guided Setup** to step through the initial configuration of HR Service Delivery Agent Workspace.

**HR Agent Workspace Guided Setup** provides an introduction to starting your configuration. It also organizes configuration activities into categories. Each category provides information like planning guidance, pre-setup steps, and links to useful information. Each category also provides links to the pages in your instance where you perform the configuration.

To access **HR Agent Workspace Guided Setup**, navigate to **HR Case Management > HR Agent Workspace Guided Setup**.
The landing page provides information on the different categories, roles, and Update sets. Select the Get Started button in the top, right corner to start your configuration.

The HR Agent Workspace Guided Setup page provides a list of different categories. Select the Get Started button under each category to start configuring HR Service Delivery Agent Workspace.
For more information on Guided Setup, see Using guided setup.

HR Service Delivery Agent Workspace landing page

The first thing HR agents see when accessing HR Agent Workspace is the landing page. The landing page provides a personalized and engaging experience for the HR agent.

The landing page shows high priority cases, cases at risk for violating service level agreements (SLA), and cases with recent changes.

Information related to the teams your HR agents belong to display below the Overview section.

The bottom of the landing page provides company information, links, and tools available. This section is part of Content Delivery. For more information, see Employee content publishing and delivery.

Configuration

The base system provides two (2) landing pages:

- HR Landing Page
- HR Landing Page (CD)
The Landing Page (CD) is available when the Content Delivery (com.sn_content_delivery) plugin is activated. The base system provides the ability to configure your landing pages in a limited manner.

- Card List Configuration: Determines which cards display in the middle section of the landing page.
- Card Tag Configuration: Determines which tags appear on the cards.

For more information, see:

- Configure the Card List Configuration for the HR Agent Workspace landing page
- Configure the Tag Configuration for the HR Agent Workspace landing page

Modifying your landing page
The base system landing pages can only be modified if you make a copy first.

⚠️ Note: For more information on configuring a new landing page, see Setting up landing pages in a workspace.

HR Service Delivery Agent Workspace landing page
In order to modify a landing page supplied by the base system, you must first make a copy. To make a copy of your landing page, use the Now® Experience UI Builder. For more information, see UI Builder.

Configure the Card List Configuration for the HR Agent Workspace landing page
Use the Card List Configuration to configure the cards that appear on the HR Service Delivery Agent Workspace landing page.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Landing Page > Card List Configurations.
   The base system provides three (3) pre-configured records:
   - High Priority HR Cases
   - HR Case SLAs at Risk
   - Updated HR Cases
2. Select one of the pre-configured records or New.
3. Complete or edit the fields on the form.

### Landing Page Card List Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A description of the record.</td>
</tr>
<tr>
<td>Query</td>
<td>A set of conditions that when valid determine what appears on the landing page. For example, to show all high priority HR cases for the logged in agent:</td>
</tr>
<tr>
<td></td>
<td>• Active is true</td>
</tr>
<tr>
<td></td>
<td>◦ AND OR</td>
</tr>
<tr>
<td></td>
<td>• Assigned to is (dynamic) Me</td>
</tr>
<tr>
<td></td>
<td>◦ AND OR</td>
</tr>
<tr>
<td></td>
<td>• Priority is one of 1 - Critical 2 - High</td>
</tr>
<tr>
<td></td>
<td>◦ AND OR</td>
</tr>
<tr>
<td>Application</td>
<td>The application that contains this record.</td>
</tr>
<tr>
<td>Text to view all records</td>
<td>Text that appears when the record has data.</td>
</tr>
<tr>
<td>Text to display if list is empty</td>
<td>Text that appears when the list has no data.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Configure the Tag Configuration for the HR Agent Workspace landing page**

Use the Land Page Tag Configuration to define the tags to display on the cards list configuration.
Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > Landing Page > Card Tag Configurations.
The base system provides three (3) pre-configured records:
   • SLA
   • Blue “VIP” if opened for or subject person is VIP
   • Green “New” if created in last 24 hours

2. Select one of the pre-configured records or New.
3. Complete or edit the fields on the form.

Landing Page Tag Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A description of the tag configuration record.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of tag configuration record:</td>
</tr>
<tr>
<td>SLA timer configuration</td>
<td>The configuration of the SLA timer that determines which task SLA displays</td>
</tr>
<tr>
<td></td>
<td>as part of the timer component.</td>
</tr>
</tbody>
</table>

Note: For more information, see SLA timer configurations.

Field appears when you select SLA Timer in the Type field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag text</td>
<td>Text that appears for the tag on the card. Field appears when you select <strong>Highlighted value</strong> in the <strong>Type</strong> field.</td>
</tr>
</tbody>
</table>
| Color       | The color you want the tag to appear as. Each color has a meaning:  
• critical = Red  
• high = Orange  
• warning = Yellow  
• moderate = Purple  
• positive = Green  
• info (VIP) = Blue  
• low = Gray                                                                 |
| Condition   | Applies this configuration when specific conditions are met. For example, conditions when to flag for a VIP are:  
• Opened for.VIP is true  
• Or  
• Subject person.VIP is true  
The fields available to you to create a condition are from the HR case [sn_hr_case] table. |
| Application | The application that contains this record.                                                                                                                                                   |
| Order       | Order in which the configuration processes first. Configurations with lower numbers process first.                                                                                           |
| Icon        | Use to display an icon for any non-SLA tag.                                                                                                                                                 |

**Note:** For more information, see Icon.

4. Click **Submit** or **Update**.

**At a Glance panel**

Enable HR agents to better assist and resolve employee requests with the At a Glance panel in HR Service Delivery Agent Workspace. The At a Glance panel displays key HR profile details such as the employee's job title, manager, and methods of contact. Agents can quickly access this information so that they have a better understanding of the employees they are trying to help.

**Overview**

The At a Glance panel displays key HR profile details about the employee, such as the employee's job title, employment start date, office location, contact information, and organizational details. The following GIF shows an example of an HR agent navigating to the at a glance panel in HR Service Delivery Agent Workspace for an employee named Abel Tuter.
If the subject person on an HR case does not have an HR profile record, the At a Glance icon in the contextual side panel does not appear.

Configure the At a Glance panel

You can configure the At a Glance panel by adding or removing HR profile fields for the Employee Details and Contacts sections.

Before you begin
Role required: sn_hr_core.admin

About this task
By default, the At a Glance panel is configured to display the following information. You can add or remove fields from the Employee Details and Contacts sections.

If a field does not have a corresponding value, then it does not appear in the panel.

Note: The At a Glance panel replaces the Customer 360 Ribbon component.
Procedure

1. Navigate to HR Profile > HR Profiles.
2. Open any HR profile record.
3. Right-click the form header, and navigate to Configure > Form Layout.
4. Under **Form view and section**, click the **View name** drop-down and select the **At a Glance** field.

5. Select the section that you want to configure.
- Employee Details
- Contacts

6. Add or remove fields for that section.

7. Click **Save**.

**HR Service Delivery Agent Workspace contextual side panel**

The contextual side panel provides your agents with tools to research and resolve HR cases. For information on setting up Contextual Sidebar, see **Set up Agent Assist**.

**Response Templates**

Defined in **Search Contexts**.

For more information, see **Set up Agent Assist information sources**.

**Note:** The base system provides table configurations for each HR case table. If you use a different Center for Excellence (COE), you must create a new table configuration record.

**Employee Documents**

Defined in **Search Contexts**.
The Search Context for Employee Documents has Filter Configurations for each table and match the filter options on the HR Service Delivery Agent Workspace.

- You can have one filter condition per HR case table.
- You can customize conditions with basic conditionals.
- You can disable filter configurations to prevent showing documents from the table.

For more information, see Filter configuration for contextual search.

**Advanced Work Assignment (AWA) for HR Service Delivery Agent Workspace overview**

Use the ServiceNow Advanced Work Assignment (AWA) for HR Service Delivery Agent Workspace to automatically assign a work item to agents based on their availability, capacity, and skills.

**Plugins**

Activate the Advanced Work Assignment for HRSD [com.sn_hr_awa] plugin if you have the HR admin role. Activating this plugin also activates:
• Advanced Work Assignment [com.glide.awa]
  ◦ When activated, the Advanced Work Assignment for HRSD [com.sn_hr_awa] plugin supports the AWA routing with historical affinity for chat and cases when the Advanced Work Assignment - Agent Affinity [com.glide.awa.agent_affinity] plugin is activated.

• Agent Chat [com.glide.interaction.awa]

• Human Resources Scoped App: Core [com.sn_hr_core]

You can also activate:

• Skills Management [com.snc.skills_management]
  ◦ Activated by default when the Human Resources Core [com.sn_hr_core] plugin is activated.
  ◦ Only activate when you are using skill determination rules to map a skill to an HR case.

• Skill Determination [com.snc.skill_determination]
  ◦ Activate when using skill determination rules. For more information, see Using rules to identify skills for work items.

• Interactions Management [com.glide.interaction]

• Human Resources Scoped App: Virtual Agent Conversations [com.sn_hr_virtual_agent]
  ◦ Only activate when using Virtual Agent. For more information, see Virtual Agent for HR Service Delivery.

Chat setup

Ensure the HR Fulfiller UI field is set to Agent Workspace. For more information, see Configure Chat Setup for HR Service Delivery Agent Workspace.

HR case

AWA is an alternative to using:

• HR templates (based on the HR service)
• HR assignment rules
• HR matching rules

AWA automatically routes HR cases, chats, or interactions based on:

• Availability
• Capacity
• Capacity and Skills

AWA pushes cases to qualified HR agents using work item queues, routing conditions, and assignment criteria that you define. HR agents see their assignments in their inbox. You can set the capacity for an agent, which is the number of work items on a particular service channel that an agent may actively work on. You can set assignment rules to determine how AWA routes work items to a group of agents. If an agent rejects a work item, the item is rerouted to another agent.

For more information, see Advanced Work Assignment.

Note: To use AWA, you must ensure your:

• HR templates do not identify assignment groups or skills.
• Deactivate your existing HR Assignment Rules and HR Matching Rules.
Agent Inbox

Using AWA you can automatically assign an HR case and have it appear in an agent's inbox.

For more information, see Agent Inbox controls.

The inbox layouts determine what appears on work item cards in an agent's inbox. For more information, see Inbox layout.

Skill Determination Rules

Use Skill Determination Rules as an alternative way to map skills to an HR case.

The base system provides a skill determination rule for each COE and is inactive by default. There is also a skill determination rule for interactions:

- Skill determination rules for Interactions [Human Resources]

Defines what skills are required in chat and when creating an interaction. The script defines the mappings. By default, this skill determination rule is inactive.

For more information, see Using rules to identify skills for work items.

Service channels

Service channels help assign specific types of chats or HR cases to the correct agents. For more information, see Service channels.

There are two service channels provided with the base system:

- Chat
- HR Case

Each service channel has eight (8) queues.

- Each queue corresponds to a COE and HR table.
- HR cases route to a corresponding queue.
- Each queue defines an assignment group.
- AWA logic reviews the assignment group and routes to the appropriate agent.

AWA uses service channels to organize incoming requests from chats, cases, and incidents. AWA routes these work items to specific queues. For more information about AWA, see Agent Workspace Advanced Work Assignment (AWA).

Business rules

There are three (3) business rules. Activate only one:

- Skill determination for HR Cases
  - Use this business rule when you are using skill determination rules to map a skill to an HR case.
  
- Copy skills to task_m2m_skill table
  - Use this business rule when you are using HR templates to map a skill to an HR case.

⚠️ Note: These business rules make entries in the Task Skill [task_m2m_skill] table. AWA uses this table to determine final mapping between a task and a skill.

- Skill determination for Interaction[HR]
Only activate this business rule when using chat assignment by skill.

- Works with the Skill determination rules for interactions [Human Resources] to populate the Interaction Skill [interaction_m2m_skill] table.
- AWA uses this table to check the mapping between interaction and skill.
- Interaction records are automatically created when an employee initiates a chat.

**AWA Assignment Rules**

The base system provides two (2) AWA assignment rules. For more information, see Configure agent assignment rules.

- **Capacity based assignment for HR work items assignment rule**
  - Considers agents with the greatest availability for handling the work.
- **Capacity and skill-based assignment for HR work items assignment rule**
  - Considers agents with the greatest availability and their assigned skills for handling the work. Assigned skills can optionally be made mandatory.
  - When skills are considered mandatory, only considers routing work items to agents that have the skills.

**Note:** When agents with the correct skills are not available or their capacity is full, it does not route to other agents but will wait until one is available.

**Workspace Agent Chat**

Workspace Agent Chat is the real-time messaging system you use in HR Service Delivery Agent Workspace.

Similar to HR case, there is a service channel for chat with eight (8) queues.

**Virtual Agent**

When Virtual Agent is active, the chat window shows Virtual Agent topics. Under the Chat service channel under AWA, there is a script that maps the additional Virtual Agent topics to the queue.

When Virtual Agent is not active, the chat window shows the Employee Service Center (ESC) pre-chat categories. Under the Chat service channel under AWA, there is a script that maps the additional Virtual Agent topics to the queue.

**Note:** You can distinguish the queues by the ESC pre-chat categories and Virtual Agent topics.

For more information, see Virtual Agent.

If you are migrating from Connect Support, use AWA to create the chat queues for routing chat work items to agents and the Chat Setup form to configure Agent Chat. For more information, see Migrate from Connect Support to Advanced Work Assignment and Agent Chat.

For more information on Workspace Agent Chat, see Workspace Agent Chat.

**Configure Chat Setup for HR Service Delivery Agent Workspace**

Use Chat Setup to configure Agent Chat for HR Service Delivery Agent Workspace.

**Before you begin**

Role required: sn_hr_core.admin
Note: Ensure you have activated the Agent Chat [com.glide.interaction.awa] plugin prior to using this feature. For more information on setting up chat, see Set up Workspace Agent Chat.

Procedure
1. Navigate to Collaboration > Chat Setup.
2. In the HR Fulfiller field, change to Agent Workspace.
3. Select Save or Update.

Configure AWA queues for HR Service Delivery Agent Workspace
Use Advanced Work Assignment Queues to define what work items are routed automatically to agents through a service channel.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to Advanced Work Assignment > Settings > Queues.
2. From the Queues list, change the Active field to false for Agent Chat Queue.
3. Or, select a queue to edit. For more information, see Work item queues.
4. Select the Save icon.

Configure AWA chat groups for HR Service Delivery Agent Workspace
Adding your HR agents to chat groups to route chat requests to the correct agent.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to User Administration > Groups.
2. Select a group. The base systems provides:

<table>
<thead>
<tr>
<th>Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HR</td>
<td>• HR Systems</td>
</tr>
<tr>
<td>• HR Activity Writers</td>
<td>• HR Talent Management</td>
</tr>
<tr>
<td>• HR Admin</td>
<td>• HR Tier 1</td>
</tr>
<tr>
<td>• HR Benefits</td>
<td>• HR Tier 2</td>
</tr>
<tr>
<td>• HR Employee Relations</td>
<td>• HR Tier 3</td>
</tr>
<tr>
<td>• HR Investigations</td>
<td>• HR Tier 4</td>
</tr>
<tr>
<td>• HR Leadership</td>
<td>• HR Total Rewards</td>
</tr>
<tr>
<td>• HR Onboarding</td>
<td>• HR VIP Watchlist</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>• HR Payroll</td>
<td>• HR Workforce Administration</td>
</tr>
<tr>
<td>• HR Recruiting</td>
<td>• HRIT Operations</td>
</tr>
</tbody>
</table>

3. Select the **Group Members** tab.

4. Select **Edit**.

5. Add users from the **Collection** column to the **Group Members List**.

6. Select **Save**.

7. Select **Update**.

**Service channels for HR Service Delivery Agent Workspace**

Service channels help you automatically route HR cases. Service channels assign specific type and scope of work to agents. The base system provides pre-configured channels.

For more information, see [Service channels](#).

**Work item sizing and capacity**

Service channels also use work item sizing and capacity to determine the number of cases an agent supporting the channel can handle.

The base system provides a default capacity, but can be overridden.

For more information, see [Service channel capacity and utilization](#).

**Agent Affinity for HR Service Delivery Agent Workspace**

Agent Affinity is an Advanced Work Assignment enhancement that enables you to streamline the routing of work items based on historical, task based, and account team affinity.

Agent Affinity works with HR Service Delivery Agent Workspace to assign HR agents based on:

- **Historical affinity**: Assign agents based on whether an agent fulfilled past requests for similar cases or tasks.
- **Task based affinity**: Assign agents based on past assignments for similar cases or tasks.
- **Account team affinity**: Assign agents based on the team they are on.

There are three pre-configured affinity rules available:

- Chat Context Affinity
- Chat Historical Affinity
- HR case Historical Affinity

Activate the Agent Affinity plugin (com.glide.awa.agent_affinity) to use this feature.

The role structure to administer and configure AWA:

- **HR Admin [sn_hr_core.admin]**
  - Contains the HR AWA Admin [sn_hr_awa.admin] role.
  - Contains the Advanced Work Assignment Administrator [awa_admin] role.

For more information, see [Agent Affinity](#).
Computer telephony integration (CTI) for HR Service Delivery Agent Workspace

Computer Telephony Integration (CTI) allows HR Service Delivery Agent Workspace to support inbound and outbound telephone calls.
For more information, see Setting up phones in workspace.

Computer telephony integration (CTI) demo installation and configuration for HR Service Delivery Agent Workspace

The Computer Telephony Integration (CTI) enables HR Service Delivery Agent Workspace to test the phone communication channel for inbound telephone calls in a non-production instance.

To use this feature, activate the CTI Demo Data for HRSD [com.sn_hr_cti_demo] plugin.

ℹ️ Note: Only incoming calls are supported.

Special handling notes with HR Service Delivery Agent Workspace

Get an agent's attention by adding special handling notes to a case.
You can set up special handling notes to appear as a pop-up modal or as a related list on the form.
Special handling notes have a status, an assigned priority, and an expiration date.
To configure special handling notes for HR Service Delivery Agent Workspace, do the following:

1. Edit the special handling notes properties.
   • For more information, see Configure special handling notes properties.
2. Create special handling notes for an HR table.
   • For more information, see Configure special handling notes.
3. Create a special handling note.
   • For more information, see Configure an entity table to use special handling notes.

For more information, see Highlighted values in the form header and Special handling notes.

Configure special handling notes in HR Service Delivery Agent Workspace

Configure an HR table to use special handling notes. You must do this before you can create special handling notes.

Before you begin
Role required: sn_hr_core.admin

Procedure

1. Navigate to Special Handling Notes > Configuration.
2. Click New or select an existing record.
3. In the Table name list, select an HR table.
   Selecting the HR case [sn_hr_core_case] does not automatically include any child tables.
4. Move a related field to the Selected list.
5. Click Submit.
   The Special Handling Notes Configuration list appears.
Add a special handling note in HR Service Delivery Agent Workspace

Create special handling notes that an agent can see for a specific HR case or an HR case with a set of conditions.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to Special Handling Notes > Special Handling Notes.
2. Click New or select an existing record.
3. On the form, fill in the fields.

Special Handling Notes form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description that describes the special handling note.</td>
</tr>
<tr>
<td>Message</td>
<td>Message that appears in the special handling notes. Rich text formatting is available.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of special handling note that you can select:</td>
</tr>
<tr>
<td></td>
<td>• Standard: Select this option to display a special handling note for a specific record. When you select the Lookup documents using list icon, you can select a table and associated record.</td>
</tr>
<tr>
<td></td>
<td>• Conditional: Select this option to use filter conditions to specify when a special handling note appears.</td>
</tr>
<tr>
<td>Display as a pop-up alert</td>
<td>Special handling note that appears as a pop-up alert.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Currently, a pop-up alert is the only way to show special handling notes. Select this option to show special handling notes. If you leave this option clear, special handling notes appear on the HR case form as an embedded list on the platform version of HR. For more information, see Work an HR case.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority that you assign to the special handling note. The choices are:&lt;br&gt;• 1 - Critical (red)&lt;br&gt;• 2 - High (orange)&lt;br&gt;• 3 - Moderate (light green)&lt;br&gt;• 4 - Low (light blue)&lt;br&gt;The priority and color appear in the special handling note.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the special handling note: The status based on the Expires on date.&lt;br&gt;• Active: The special handling note is active.&lt;br&gt;  ◦ Active notes appear in the pop-up window.&lt;br&gt;  ◦ Active notes remain until dismissed or set to Inactive or Expired.&lt;br&gt;• Inactive: The special handling note is no longer active and does not appear in a pop-up window. Inactive special handling notes still appear when you navigate to Special Handling Notes &gt; Special Handling Notes.&lt;br&gt;  ◦ Expired: The special handling note is no longer active. The expiration date has passed or manually expired.</td>
</tr>
<tr>
<td>Effective immediately</td>
<td>Option to activate the special handling note immediately.&lt;br&gt;If you leave this option unselected, you can specify a date and time that the special handling note appears.</td>
</tr>
<tr>
<td>Effective on</td>
<td>Field that is available when you leave the Effective immediately option unselected.&lt;br&gt;  Select the Select date and time icon to select the date and time when the special handling note appears.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expires on</td>
<td>Field where you can set a date and time to automatically inactivate a special handling note. Click the Select date and time icon to access the calendar where you can choose the date and time to activate the special handling note.</td>
</tr>
<tr>
<td>Table name</td>
<td>List that is available when you select <strong>Conditional</strong> from the <strong>Type</strong> field. Select the HR table where you want the special handling note to appear in for a specific HR case or when you satisfy filter conditions. <strong>Note:</strong> Special handling notes do not support child tables. For example, if you select the HR case [sn_hr_core_case], the special handling note only appears for cases that are specific to the table. To create a special handling note for child tables, you must create a special handling note for each table.</td>
</tr>
<tr>
<td>Related record</td>
<td>Field that is available when you select <strong>Standard</strong> from the <strong>Type</strong> field. When you select this option, a pop-up window appears where you can select the table name and a case from the <strong>Document</strong> field. For example, you can select HR case from the <strong>Table name</strong> field and the HR case where you want the special handling note to appear.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Field that is available when you select <strong>Conditional</strong> from the <strong>Type</strong> field. Select the conditions when met that would show the special handling note. For example, let’s say that you want to add a special handling note for a General Inquiry case for an employee named Aileen Mottern, you would select: [HR profile] [is] [Aileen Mottern].</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Using HR Service Delivery Agent Workspace**

As an HR agent, use **HR Service Delivery Agent Workspace** to interact with employees, respond to inquiries, and resolve issues.

You can start work in **HR Service Delivery Agent Workspace** from one of these areas:

- **Landing page**
- **List queue**

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Agent inbox
• Chat
• Phone
• Global search

For additional information on working within Agent Workspace, see Using workspace.

Along the left side and top of the Home page are a series of icons you can select.

<table>
<thead>
<tr>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏡</td>
<td>Select to take you back to the Home page.</td>
</tr>
<tr>
<td>📄 HR case list</td>
<td>Select to view a list of HR cases, interactions, HR tasks, and more. You can access the list icon from any screen. Shows any work items assigned to you. You can also indicate if you are: • Available • Offline • Away you are available</td>
</tr>
<tr>
<td>🌟 Add New</td>
<td>Select to create one of the following: • Interaction • HR case</td>
</tr>
</tbody>
</table>

🌟 Note: Requires activation of the Advanced Work Assignment (com.glide.awa) and Agent Chat (com.glide.interaction.awa) plugins.
Searching for an existing case or employee

You can search for an existing case or create a case from any screen. Select the create case icon.

Searching for an employee also helps to verify that you are creating a case for the correct person.

### Agent Workspace feature

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search field</td>
</tr>
</tbody>
</table>

**Note:** Unlike the platform web-based UI, you can't search for or create cases for inactive users.

### Starting from the List queue

You can select a case or an interaction from the list icon.
### Agent Responsibilities

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an HR case in the List queue.</td>
</tr>
</tbody>
</table>
| List queue that contains all HR cases. Sort the list by column:  
  - Case number  
  - State  
  - Opened for  
  - Subject person  
  - HR service  
  - Short description  
  - Assignment group  
  - Assigned to  
| You can also view all cases that are assigned to you. The left side navigation bar also offers ways to sort cases. |

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an HR interaction in the List queue.</td>
</tr>
<tr>
<td>Interactions assigned to you are listed in the Interactions list. Use interaction records to create an HR case or reference employee information to decide to create a case or request from the chat conversation. You can send an SMS message directly from a chat.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a custom list</td>
</tr>
<tr>
<td>Click the List actions icon and select Save as. You can rename the list and click Save. The list appears in the My Lists column.</td>
</tr>
</tbody>
</table>

For additional information, see [Setting up list view in a workspace](#).

### Working from the agent inbox

You can also start work by going to the agent inbox, which is on the left side of the navigation bar.

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an HR case from agent inbox.</td>
</tr>
<tr>
<td>Inbox that contains the HR cases that are assigned to you. Chats and interactions also appear in agent inbox.</td>
</tr>
</tbody>
</table>

For additional information, see [Working from the agent inbox](#).
Create a tuition reimbursement case in HR Service Delivery Agent Workspace

Creating a tuition reimbursement case in HR Service Delivery Agent Workspace is easy and all the information you need is on one page.

**Before you begin**
Role required: sn_hr_core.case_writer

**Procedure**
1. Navigate to **HR Case Management > HR Agent Workspace**. The landing page appears.
2. To create an HR case, select the **Add New** icon.
3. Select **HR Case**. For information on **Interactions**, see Using interactions in HR Service Delivery Agent Workspace.
4. Enter an employee name. If an employee is flagged as a VIP in their HR profile, VIP appears when you enter their name.
5. Verify that the employee is the correct person the case is for.
6. Select the HR service for Tuition Reimbursement Request.
7. In the Case Details section, enter the School or Program name, Course title, Course start date, Course end date, and Course cost.

8. Select the **Create Case**.
   If the duplicate case warning appears, verify that you are creating a unique case.
   When there are no similar cases, an HR case number is assigned and the State is **Draft**.
   If there is a similar case for the subject person, HR service, and if the case was created within three days (configurable from HR Administration/Properties), a warning appears.

9. Select **Create new case**.
   If your company requires approvals or signed agreements, you must resolve these requirements before you can close the case.
10. Check the contextual side panel for information that can help you work this case. You can choose from Agent Assist, Response Templates, or Fulfillment Instructions depending on what information you need.

At a Glance

Employee

James Vittolo
VP, Client Services

Number

HRP0000354

Employment start date

2019-06-05

Office location

322 West 52nd Street, New York,NY

Email

jvittolo@example.com

Org Info

James's team
Sales (0054)

Create a task for a case using HR Service Delivery Agent Workspace

You can add a checklist for an HR task. Use the checklist as a step-by-step guide to ensure a consistent and efficient process.

Before you begin
Role required: sn_hr_core.case_writer

About this task
When assigning a task to an employee, you can request how the employee acknowledges completion of the task. The tasks appear on the Employee Service Center or HR Service Portal for the employee.

Procedure

1. Navigate to HR Case Management > HR Agent Workspace and select a case you want to add a task to.
2. From the Child tabs above the Case details section, select the HR Tasks tab.
3. Select **New**.

4. Select an **HR task type**.
The different task types you can select are:

**HR task types**

<table>
<thead>
<tr>
<th>Task type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Service:</td>
<td>An HR service fulfills the HR task. In the <strong>HR Service</strong> field, select an HR service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <strong>Bulk Parent Case</strong> only appears as a selection when creating a parent case for child bulk cases. Refer to Add or modify bulk HR cases.</td>
</tr>
<tr>
<td>Submit Catalog Item:</td>
<td>A catalog item fulfills the HR task. In the <strong>Catalog Item</strong> field, select a catalog item.</td>
</tr>
<tr>
<td>Submit Order Guide:</td>
<td>An order guide fulfills the HR task. In the <strong>Order Guide</strong> field, select an order guide.</td>
</tr>
<tr>
<td>Collect Employee Input:</td>
<td>Collects information from employees. In the <strong>Employee form</strong> field, select the employee form that the user fills out or verifies.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Employee forms are questionnaires built using the survey designer to collect information from employees. See Collect employee input for more information.</td>
</tr>
<tr>
<td>Checklist:</td>
<td>In the <strong>Checklist Items</strong> field, provide the checklist items. Checklists are instructions or steps on how to complete the task.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For more information, see Using checklists in HR Service Delivery Agent Workspace.</td>
</tr>
<tr>
<td>Credential:</td>
<td>Indicates that you want the user to acknowledge reading a document by</td>
</tr>
<tr>
<td>Task type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Logging in</td>
<td>logging in with their login credentials. The <strong>Acknowledgment text</strong> and <strong>Acknowledgment document</strong> fields appear. Using these fields shows a check box and text above the login credentials. In the Acknowledgment document field, select a document you want the user to read.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This option is only available for existing customers that have not yet migrated to e-signature. For more information, see <em>Migrate existing HR task templates and open HR tasks to e-signature.</em></td>
</tr>
<tr>
<td>E-signature:</td>
<td>User electronically signs a document. In the <strong>E-signature template</strong> field, select the e-signature template to use.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>*E-signature is a scoped application that enables you to sign managed documents, knowledge articles, or HR document templates. You can type or draw your signature, credentials, or acknowledgment. For more information, see <em>HR e-signature.</em></td>
</tr>
<tr>
<td></td>
<td>• If HR document template has a document type of e-signature template, select the HR document template that the signatory signs on the HR case form. For more information, see <em>Select an HR document template for an e-signature task.</em></td>
</tr>
<tr>
<td>Mark When Complete</td>
<td>Notify the user a <strong>Completed</strong> button appears on the HR Service Portal. Use the <strong>Short description</strong> to provide details about this task.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Mark When Complete changes the state of the task to <strong>Closed Complete.</strong></td>
</tr>
<tr>
<td>Sign Document:</td>
<td>Requests the user to sign a document. An example is sending an education agreement for signature on a tuition reimbursement. The <strong>Acknowledgment text</strong> field appears. Using this field shows a check box and text above the signature.</td>
</tr>
</tbody>
</table>
### Task type and Description

<table>
<thead>
<tr>
<th>Task type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• This option is only available for existing customers that have not yet migrated to e-signature. For more information see <a href="#">Migrate existing HR task templates and open HR tasks to e-signature</a>.</td>
</tr>
<tr>
<td></td>
<td>• After the user signs the document, the document generates with the signature and attaches to the task. The task closes and the document is attached to the case.</td>
</tr>
<tr>
<td>Take Survey:</td>
<td>In the Survey field, select a survey that the user is assigned to take.</td>
</tr>
<tr>
<td>Upload Documents:</td>
<td>Requests the person assigned to the task to upload documents. Examples are receipts, course registration, or transcripts for tuition reimbursement. Use the Short description field to provide instructions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The task must be in Ready or Work in Progress.</td>
</tr>
<tr>
<td>URL:</td>
<td>The URL field appears. Enter a URL link that the user acknowledges when accessed.</td>
</tr>
<tr>
<td>View Video:</td>
<td>The URL field appears. Requests the person assigned to the task to view a video.</td>
</tr>
</tbody>
</table>

**Note:** For information on all the fields, see Adding an HR task to an HR case.

5. Select **Save**.

You can also add a task by selecting **Add Task** from the ... from Details.

### Using At a Glance for HR Service Delivery Agent Workspace

Use the At a Glance feature from the contextual sidebar to quickly view HR profile information for the opened for person on an HR case.

You can configure what information you want to appear in At a Glance from the HR profile form.

### HR profile

What appears on your At a Glance panel depends on what you configure on an HR profile. You can open any HR profile and add or remove the fields you want to appear. What you select appears for all HR profiles, but only fields with data appear on the At a Glance panel.

**Note:** If the subject person on an HR case does not have an HR profile record, the At a Glance icon in the contextual side panel does not appear.

For more information, see [HR profile editable field configuration](#). For more information on adding fields to an HR profile, see [Configuring the form layout](#).
Viewing SLAs for HR Service Delivery Agent Workspace

Service Level Agreements (SLAs) can be viewed for cases or tasks and provide progress information.

HR Agent Workspace SLAs

View SLAs for HR cases from the Agent Workspace home page:

View SLAs for HR tasks from the Related Items menu.
HR Playbook SLAs

View SLAs for HR Playbook from the case card.

Note: For more information on SLAs, see Service Level Management.

Custom My List for HR Service Delivery Agent Workspace

You can create your own My Lists to show specific cases that are relevant to you. Having a custom My Lists helps you work faster and efficiently.

The default Lists show all HR cases categorized into the following:

<table>
<thead>
<tr>
<th>HR case lists</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• All HR Cases</td>
<td>• HR Profile</td>
</tr>
<tr>
<td>• Lifecycle Events</td>
<td>• Employee Documents</td>
</tr>
<tr>
<td>• Other</td>
<td>• Knowledge</td>
</tr>
<tr>
<td>• Interactions</td>
<td>• Reminders</td>
</tr>
<tr>
<td>• HR Tasks</td>
<td></td>
</tr>
</tbody>
</table>

Create My Lists

Use My Lists to create a custom list of HR cases that you can readily access and start working on.

Before you begin
Role required: sn_hr_core.case_writer
Procedure

1. Navigate to **HR Case Management > HR Agent Workspace**.

2. Click the **Lists** icon (  ).

3. Click **My Lists**.

4. Click **+New list**.

5. Click **Start from existing** or **Create your own**.
   
   Clicking **Start from existing** provides existing HR case lists you can select to create a custom **My Lists**. Clicking **Create your own** provides you with a list of all tables you can create a list from.

6. Select how you want to create your **My List** and fill in the fields.

---

### Start from existing

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Select the HR case categories that you want to base your <strong>My Lists</strong> on.</td>
</tr>
<tr>
<td>List Name</td>
<td>Fills in based on what you select from <strong>List</strong>. You can change the name by typing over what displays.</td>
</tr>
<tr>
<td>Select columns</td>
<td>The columns are pre-display for you. Click the X to delete columns you don’t want to appear.</td>
</tr>
<tr>
<td>Add filters</td>
<td>Add filters to further define what cases appear in your <strong>My Lists</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Criteria pre-fills based on what you selected in the **List**. You can edit, add, or delete the defaults.

---

### Create your own

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List name</td>
<td>The name that identifies your <strong>My Lists</strong>. Enter a name for your list.</td>
</tr>
<tr>
<td>Select Source</td>
<td>The table that your <strong>My Lists</strong> is based on. Enter letters or the name of the table to start a search, then select a table.</td>
</tr>
<tr>
<td>Select columns</td>
<td>The columns you want to appear in your <strong>My Lists</strong>. A list of columns appears based on the table you selected. Click the X to delete columns you don’t want to appear.</td>
</tr>
<tr>
<td>Add filters</td>
<td>Add filters to further define what cases appear in your <strong>My Lists</strong>.</td>
</tr>
</tbody>
</table>
7. Click Create.

Using checklists in HR Service Delivery Agent Workspace

Creating and using checklists on an HR case or task helps you resolve issues faster, more efficiently, and with fewer errors.

Checklists appear in the contextual side panel along with Fulfillment instructions for HR cases only.

When the configuration for an HR service or HR task template has checklists, they automatically appear. Having a checklist for an HR service or HR task template ensures consistency when resolving issues. For information on configuring checklists, see Configure an HR service and Configure an HR task template.

Creating a checklist directly into an HR case

To create a one-time checklist directly into an HR case, create the case in HR Service Delivery Agent Workspace.

- Go to the platform HR Case Management and open the case you created.
- Scroll down and select the down arrow and select Create

Note: Criteria pre-fills based on what you selected in the List. You can edit, add, or delete the defaults.
• Enter instructions.

Creating a checklist directly into an HR Task

Create an HR task with Checklist for the HR Task Type. See Create a task for a case using HR Service Delivery Agent Workspace.

Go to the legacy HR Case Management and open the task you created.

From the Fulfillment Instructions tab, create your checklist.

⚠️ Note: These types of checklists are a one-time use and only appears for the specific case or task.

Response template for HR Service Delivery Agent Workspace
Response templates provide you with information on resolving an HR case or how to help an employee making an inquiry.
Response templates help you to be efficient and consistent when working on similar HR cases.
Response templates provide reusable messages. Copy and paste these messages into an email, chat, comments, work notes, or use as talking points when on the phone.

Response template channels
Response template channels segregate your response templates into media categories. You may want responses to have slightly different text in a chat response compared to an email response. Or, you don’t want a specific template to appear for chat. The base system provides the following channels:

• Chat
• Email
• Form

⚠️ Note: Form provides text you can use in the comments or work notes on an HR case.

For more information on setting up a response template channel, see Create a response template channel.
For more information on setting up response templates, see Response templates for HR Service Delivery.

Use Response templates on an HR case
Use response templates as reusable messages that you can copy and paste into the comments or work notes for an HR case.

Before you begin
Role required: sn_hr_core.case_writer

Procedure
1. Navigate to HR Case Management > HR Agent Workspace.

2. Click the Lists icon (List) and select an HR case.

3. From the contextual sidebar, click the Response Templates icon (Response Templates).
4. Select the Copy to clipboard button to copy all text and paste into the Comments or Work notes area.

**Note:** Use the space next to the Search for Record icon to search for a specific response template.

5. Click Post Comments.

**Use Response templates in an email**

Use response templates as reusable messages that you can copy and paste into an email.

**Before you begin**

Role required: sn_hr_core.case_writer

**Procedure**

1. Navigate to HR Case ManagementHR Agent Workspace.

2. Click the More Actions icon and select Compose Email.
3. From the New Email Draft tab, click the Response Templates icon.

4. Open the response template, copy, and paste the text into the body of the email.

5. Enter the name of the person you are sending the email to in the To field.

6. Click Send Email.

Use Response templates in chat

HR agents can use response templates as reusable messages that you can use related to an interaction.
Before you begin
Role required: sn_hr_core.case_writer

The Advanced Work Assignment for HRSD (com.sn_hr_awa) plugin must be activated to use response templates in chat. For more information, see Response templates for HR Service Delivery.

⚠️ Note: Currently, chat is only available for Interactions in HR Service Delivery Agent Workspace.

Procedure
1. Navigate to HR Case Management HR Agent Workspace.
2. Ensure your Inbox status is set to Available.
3. When a chat routes to you, select Accept.
4. An interaction record automatically creates and you can start chatting with the employee. To display response templates, enter a / in the chat area and a list of response templates appears.
5. Select the response template and the text appears in the chat window.

6. Select the Send button to transmit the message.

Receiving a duplicate case warning with HR Service Delivery Agent Workspace

HR Service Delivery Agent Workspace provides a feature that warns you that there might be a similar case already created.

If there is a similar case for the subject person, HR service, and if the case was created within three days (configurable from HR Administration/Properties), a warning appears.

Note: For information on the sn_hr_core.duplicate_hr_case_time_out property, see HR properties.
Select **Create new case** or **Cancel**.

**Using the More icon in HR Service Delivery Agent Workspace**

You can use the more icon from HR Service Delivery Agent Workspace to perform many duties related to working an HR case.

When working a case, select the more icon in the far, upper right.

### Number | Description
--- | ---
1 | Select the more icon. From here, you can:

- **Associate Interaction**: Associate the displayed case with an interaction. For more information, see [Using interactions in HR Service Delivery Agent Workspace](#).

- **Compose Email**: Send an email from an HR case. For more information, see [Sending an email](#).

- **Create Additional Case**: Create another HR case without leaving the case you are viewing or working on. For more information, see [Creating a case from a case or HR profile](#).

- **Set reminder**: Create a reminder to ensure followup by a specific date. For more information, see [Create a reminder in HR Service Delivery Agent Workspace](#).

- **Transfer Case**: Reclassify a case for another HR service. For more information, see [Reclassify a case using HR Service Delivery Agent Workspace](#).

- **Add Task**: Add an HR task to the case. For more information, see [Create a task for a case using HR Service Delivery Agent Workspace](#).
### Creating a case from a case or HR profile

From HR Service Delivery Agent Workspace, you can create additional cases from either an existing case or from a user’s HR profile.

A convenient and time saving feature of HR Service Delivery Agent Workspace is having everything you need as an HR agent in one place.

You don’t have to leave a case you are working on and try to find it later. You can create another HR case from:

- An HR case you are viewing.
- From an HR profile that displays on a case you are viewing.

#### From an open case

Use this feature when you want to create a different HR case for the employee that already appears in an existing case.

Select the "more" icon.

Select **Create Additional Case**. The employee name from the first case pre-populates in the new case.

#### From an HR profile

When viewing an HR case, you can create another case from the Opened for or Subject person’s HR profile.

---

**Number | Description**

- Escalate Case: Assign hot or important cases to another tier or agent with more expertise. For more information, see [Escalating a case in HR Service Delivery Agent Workspace](#).
- Delete: Delete the case you are working on.
Select the **more** icon.

Note: The At-a-glance panel displays. See At a Glance panel.

Select New Case.

Reclassify a case using HR Service Delivery Agent Workspace

You can reclassify or transfer an HR case from one HR service to a different HR service.

Before you begin
Role required: sn_hr_core.case_writer

About this task
Many cases are created as a General Inquiry case. After researching the employee’s needs, you can reclassify an existing case to a different HR service.
For information on configuring HR case reclassification, see Transfer an HR case.

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Find the case you want to reclassify. For more information on finding an HR case, see Using HR Service Delivery Agent Workspace.
3. Select the more icon.

4. Select **Transfer Case**.

5. From **Transfer type**:
   - **Transfer with existing case number**: The HR case number does not change, links redirect with new case, and work notes transfer to new case.
   - **Transfer to a new case number**: The HR case number changes, links do not redirect, and work notes do not transfer. Both HR case numbers appear on the HR case for reference. The original case state changes to **Closed Complete** and cancels.
6. From **New HR Service**, select the HR service you want to assign to your original case.

7. Select **OK**.

   The current case and its child tasks close. When you transfer an HR case from one HR service to another, some field values do not transfer to the new case.

   **Note:** Priority transfers from the original case and does not override the HR template for the new HR case.

   The subject person receives a notification email with the closed case and transferred case information. Replies to the email appear in the Comments section of the HR case. If the subject person replies to the email associated with the closed case, the reply appears in the comments for both the closed and transferred cases.

   **Note:** If the `sn_hr_core.restrict_guest_email` system property is False (default), text from an email appears in the Work notes field when the employee is responding from a personal email account.

See **Email setup**.
Escalating a case in HR Service Delivery Agent Workspace

Escalate an HR case when you are unable to resolve an issue and must amplify the importance of a case.

Depending on how you have implemented matching rules determines what group and agent the case is escalated to. For more information, see Assignment and matching rules in HR and Add or modify escalation rules.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the more icon. From here, select <strong>Escalate Case</strong>.</td>
</tr>
</tbody>
</table>
Adding or substituting approvers to a case in HR Service Delivery Agent Workspace

HR cases can be set up to require approvals before it can progress to completion.

The HR service configures actions related to approvals. For more information on HR service configuration, see Configure an HR service.

When a case requires an approver, the request for approval appears in the approver's Employee Service Center or portal under To-dos.

In HR Service Delivery Agent Workspace, the child tab Approvers lists all requested approvers.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select To-dos.</td>
</tr>
<tr>
<td>2</td>
<td>To approve, select Approve. To reject, enter a reason and select Reject.</td>
</tr>
</tbody>
</table>
Multiple approvers required

HR services has an optional configuration that requires multiple approvers. When configuring an HR service, select approvers from the fields on the HR case. For example, select Subject person manager as an approver. Using fields from a case provides maximum flexibility when assigning an approver.

By assigning an approver from the case, it's possible an approver cannot be found. For example:

- Subject person manager is the approver.
- The Subject person's HR profile does not contain a manager.
- Or, the Subject person's manager recently left the company.

When an approver is missing, the following message appears:

Add or substitute an approver to a case in HR Service Delivery Agent Workspace

Using HR Service Delivery Agent Workspace you can add an approver or substitute missing approvers for cases that require approval.

Before you begin
Role required: sn_hr_core.case_writer

Procedure
1. Navigate to HR Case Management > HR Agent Workspace.
2. Locate and open an HR case that requires approvers.
3. Select Add Approvers from the list of UI actions (tabs at the top of the form).
4. Select replacement approvers or add new ones.

5. Select OK.

6. Select Save.

**Sending an email notification after reassignment**

After you reassign an agent to an HR case, you can send an email to notify the agent. There are multiple ways to notify other agents that you have assigned them to an HR case.
<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select next to the Assigned to field.</td>
</tr>
<tr>
<td>2</td>
<td>Select an agent.</td>
</tr>
</tbody>
</table>
From the More icon

You can also create an email from the More icon.
Employee Document Management for HR Service Delivery Agent Workspace

Employee Document Management provides storage space, a filing system, the ability to easily retrieve documents, defining who can view sensitive documents, and when to purge documents.

For more information about Employee Document Management, see Employee Document Management.

Create or upload employee documents using HR Service Delivery Agent Workspace

Create or upload employee documents to an HR case using the HR Service Delivery Agent Workspace.

Before you begin
Role required: sn_hr_ef.document_writer

Procedure
1. Navigate to HR Agent Workspace > Lists > Employee Documents > All. Alternatively, you can also create an employee document from HR Agent Workspace > Lists > HR Profiles.
2. Click New.
3. On the form, fill in the fields.

Employee Document form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Document</td>
<td>Employee document to upload. Click Browse to upload an employee document. By default, the maximum size of a document allowed is 30 MB. The default</td>
</tr>
</tbody>
</table>
can be changed from the **Maximum file upload size in megabytes** field in Employee Document Properties. For more information, see **Properties for Employee Document Management application**.

After selecting a document, the read-only fields show the file size, file format, created on, and created by.

The viewer within the UI only supports viewing .pdf documents. Other types of documents can be downloaded and then viewed.

For optimal search results, do not use dashes (-) in the name of the document. Using full words separated by spaces or underbars provides better search results.

Check **Yes** in the **Enable Document Viewer to preview pdf documents** in the Employee Documents property to view .pdf documents.

**Note:** FedRAMP, on-premise customers, mobile devices, customers using edge encryption, or encryption support does not support viewing documents.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the employee document.</td>
</tr>
<tr>
<td>Employee</td>
<td>Name of the employee the document is associated with.</td>
</tr>
<tr>
<td>Document type</td>
<td>Document type associated with the employee document. Document types provide categorization, security, and retention policies.</td>
</tr>
<tr>
<td>HR case</td>
<td>HR case number the employee document is associated with when moved from an HR case.</td>
</tr>
<tr>
<td>Purge hold</td>
<td>Purge hold status of a document.</td>
</tr>
<tr>
<td></td>
<td>• Pending purge authorization: Awaiting authorization for document purging.</td>
</tr>
<tr>
<td></td>
<td>• Purge Approved: Document has authorization to schedule purging.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purged Rejected</td>
<td>Document did not receive purge authorization.</td>
</tr>
</tbody>
</table>

**Important:** Document type’s security policy determines purge authorization. The following roles have permission to change purge authorization:

- EF admin [sn_hr_ef.admin]
- Employee File Management Manager [sn_hr_ef.manager]

4. Click **Save** to create the employee document record. The **Audit Trail** tab appears.

   Provides view of all actions for an employee document from creation or uploaded to the time it is purged.

---

**Move employee documents using HR Service Delivery Agent Workspace**

Move employee documents from a case in HR Service Delivery Agent Workspace to employee document repository. The employee document repository provides a central repository for quick and easy identification of documents using different sorting features.

**Before you begin**

Role required: sn_hr_ef.document_writer, sn_hr_core.case_writer

**Procedure**

1. Navigate to **HR Agent Workspace > Lists > All HR Cases > All**.
2. Select a case that has employee documents attached.

   **Note:** From the list view, there is no way to identify HR cases with employee documents attached. To locate an HR case, you need the HR case number or the Opened for person.

3. Click **Move Attachments**.
4. In the Move Attachments to Employee documents window:

a. Select the check box next to the documents you want to move.

b. Select the **Document Type** for each document. The document type determines categorization, who can access it, and the retention policy. Create a document type if none appears for the associated topic detail. Creating a document type ensures correct categorization.

c. Click **Move Selected**.

**Note:** The **Target COE** and **Topic Detail** fields can be modified only if the document has been added under the wrong type of HR case.
Results

• The employee documents move from the HR case to the employee document repository.

• To view a list of all employee documents in the list column, select Employee Documents.

• The moved attachments appears in the contextual side panel under the employee documents icon within the case.

Machine learning solutions for HR Service Delivery Agent Workspace

Use machine learning solutions to auto determine the correct HR service and assignment group for cases in HR Service Delivery Agent Workspace.

Auto determination of HR service in HR Service Delivery Agent Workspace

Auto determine the correct HR service for a case in HR Service Delivery Agent Workspace. Enable an HR agent to transfer the case to the appropriate HR service rather than having to spend significant time manually triaging cases to appropriate HR services.
Important: This feature is available with the HR Professional and HR Enterprise packages when you activate the HR Service Delivery Agent Workspace and Predictive Intelligence applications. If you do not want to use this feature, disable the sn_hr_core.case_auto_categorization system property.

After you create the case, the HR Case Classification solution definition auto determines the HR service based on the short description of the case. The appropriate HR service for the case is displayed in a banner.

Important: The banner is not displayed if:
- you have logged the case under the correct HR service
- you have manually transferred or auto-transferred the case
- the case is not in the ready or draft state

Auto training the predictive model

The HR Case Classification solution definition is configured and the predictive model is auto trained only when all the following conditions are met.

- The Human Resources Scoped App: Workspace (com.sn_hr_agent_workspace) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- There are 10000 records of HR case study matching the filters defined in the solution definition.
- The glide.platform_ml.auto_training.enabled system property is set to true.

Note: Auto training does not happen if any one of the preceding conditions is not met. In such a case, Manually train the HR predictive model. Navigate to the HR AI configuration module, open the HR Case Classification record, and map the manually configured solution definition.

Auto determination of assignment group in HR Service Delivery Agent Workspace

Auto determine the assignment group for a case in HR Service Delivery Agent Workspace. Enable an HR agent to transfer the case to the correct assignment group rather than having to spend significant time manually identifying groups for the HR cases.

Important: This feature is available with the HR Professional and HR Enterprise packages when you activate HR Service Delivery Agent Workspace and Predictive Intelligence applications. If you do not want to use this feature, disable the sn_hr_core.case_auto_assignment system property.

After a case is created, the Auto Assignment Group for HR Cases solution definition auto determines the assignment group from the Short description, Description, Opened for Title, Opened for Location Name, HR service of the case. The appropriate assignment group for the case is displayed in a banner.

Important: The banner is not displayed if:
- You have manually assigned the case to an assignment group.
- The assignment group is not identified for the case.
- The case is not in the ready or draft state.
Auto training the predictive model
By default the Auto Assignment Group for HR Cases solution definition is configured and the predictive model is auto trained when all the following conditions are met:

- The Human Resources Scoped App: Workspace (com.sn_hr_agent_workspace) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- There are 10000 records of HR case study matching the filters defined in the solution definition.
- The glide.platform_ml.auto_training.enabled system property is set to true.

Note: Auto training does not happen if any one of the preceding conditions is not met. In such a case, Manually train the HR predictive model. Navigate to the HR AI configuration module, open the Case Assignment group record, and map the manually configured solution definition.

Similar closed cases in HR Service Delivery Agent Workspace
Help an HR agent resolve the current case by displaying similar closed cases.

Important: This feature is available with the HR Professional and HR Enterprise packages when you activate HR Service Delivery Agent Workspace and Predictive Intelligence applications.

Similar Closed HR Cases
When the Similar Closed HR Cases (ml_sn_sn_hr_core_global_similar_closed_hr_cases) is configured and the predictive model is trained:

- Similar closed cases are displayed in Similar Closed HR Cases in the Related Search Results section. If there are three or more similar closed HR cases whose COE matches that of the current case, then the case with the highest confidence is displayed as a recommended HR case.
- If there is no recommended HR Case, then the knowledge article that is attached to more than three similar closed cases is displayed as a recommended article. The recommended article can be attached to the current HR case.

Auto training the predictive model
The Similar Closed HR Cases (ml_sn_sn_hr_core_global_similar_closed_hr_cases) is configured and the predictive model is auto trained when all the following conditions are met:

- The Human Resources Scoped App: Workspace (com.sn_hr_agent_workspace) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- The glide.platform_ml.auto_training.enabled system property is set to true.

Using the deep link feature in HR Service Delivery Agent Workspace
Deep links are a way to quickly access information from outside of HR Service Delivery Agent Workspace.

Use deep links to access information that is not readily available within HR Service Delivery Agent Workspace. For example, use deep links to access a third-party application that you use frequently.
E-signature in HR Service Delivery Agent Workspace

When working on an HR case, you can use e-signature to sign documents that require signatures.

When an employee creates a case requesting an employment verification letter, you can:
- Preview the document.
- Use e-signature to sign it.
- Generate the document.

Previewing a document ensures you sign the correct document. This step is useful if you have multiple employment verification letters.

E-signature provides multiple methods to sign. You can choose to type your name or use your mouse to draw your signature.

You can optionally require a user to check an acknowledgment box before the signature is accepted.

Generating the document combines the document template with your signature and creates an attachment to the case. If you use Employee Document Management, you can move the attachment to your document repository for storage.

**Note:** For more information, see [Configure an e-signature template](#).

**Sign and generate a document in HR Service Delivery Agent Workspace**

Depending on the case or situation, you can electronically sign a document.
Before you begin
Role required: sn_hr_core.case_writer

Procedure
1. Navigate to HR Case Management > HR Agent Workspace.
2. Locate and open an HR case. Ensure that the state of the case is Work in Progress.
3. Select the Sign Document button.

4. Preview the document. Ensure it is the correct document for the case.

5. You have two choices on how to sign the document. Select Type signature to type your signature. Or, select Draw signature to draw your signature using your mouse.

6. Select Generate to attach your signature to the document.
7. Select the Attachments icon.

The document moves to Attachments in the contextual side panel. If your company uses Employee Document Management (EDM), you can move the document to the EDM repository. For more information on EDM, see Create or upload employee documents using HR Service Delivery Agent Workspace.

Using chat in HR Service Delivery Agent Workspace
Agent chat for HR Service Delivery Agent Workspace enables you to ask questions and receive information through live or virtual agent chat.

Activation
Ensure you have activated the Agent Chat [com.glide.interaction.awa] plugin prior to using this feature. For more information on setting up chat, see Agent Workspace chat.

HR groups
Ensure that your HR agents are part of an HR group or subgroup. Having subgroups helps to ensure HR agents with the correct skills and knowledge pair up when an employee initiates a chat.
For example, an employee initiates a chat requesting information about your company’s benefits. Having a benefits subgroup with agents that specialize in your company’s benefits ensures the employee’s chat is directed to the correct agents.

For more information about HR groups, see Manage HR Groups.

Interaction records
Agent chat automatically creates interaction records. When an employee initiates a chat with an HR agent, an Interaction case is automatically created.

Quick actions
Using quick actions, you can:
• Create an HR case.
• Show applicable response templates.
• Transfer chat to another agent.
• Transfer chat to another queue.

Virtual agent
Automating chat can enhance the employee experience by addressing queries immediately. At any time during a virtual chat, the employee can request to interact with a live HR agent.

For more information on virtual agent, see Virtual Agent for HR Service Delivery.

Working from the agent inbox in HR Service Delivery Agent Workspace
Use the agent inbox to manage your incoming work, such as chats, HR cases, and interactions.

Before you begin
Role required: sn_hr_core.case_writer

Procedure
1. Navigate to HR Case Management > HR Agent Workspace.

2. Select the inbox icon.

3. From Status, select Available.
4. When a chat comes through the chat queue, select **Accept**.

5. From the active chat panel, you can start chatting.

6. Select the ![quick action icon](image) quick action icon. Or enter a back slash (/) in the chat area.
7. Select a quick action to quickly create an HR case, show related response templates, transfer chat to another agent, or transfer the chat to another queue.

**SMS conversations in HR Service Delivery Agent Workspace**

Using the Conversational SMS service channel app, available on the ServiceNow Store, HR agents can provide support for long-running SMS conversations via HR Service Delivery Agent Workspace. Requesters can initiate HR support conversations through SMS.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**SMS support conversations**

SMS support conversations can run long. For this reason, HR Service Delivery workspace agents need the ability to track ongoing conversations on the HR SMS service channel. HR Service Delivery workspace agents can initiate or continue SMS conversations and also accept SMS work items from the HR Service Delivery Agent Workspace Inbox.

For SMS support conversations, in the Workspace Chat panel, when the interaction type is Messaging, an interaction sub-type of SMS is indicated as Active SMS.

For complete details about SMS support conversations, associated service channels, requestor initiated, and agent initiated SMS conversations, refer to Conversational SMS service channel.

**SMS support conversations for HR Service Delivery agents**

HR agents can access new SMS messaging interactions, as well as access ongoing SMS messaging conversations. Agents can switch from an in-progress messaging interaction, such as a chat, to a new SMS messaging interaction.

Advanced Work Assignment HR agents and managers can end an SMS messaging conversation. HR agents with the awa_agent role can end an active SMS messaging conversation assigned to them using the End conversation action button. Users with the awa_manager role can end the conversation even when it is not assigned to them on the interaction. When an agent ends the conversation, a confirmation to close the interaction appears.
HR AWA agents and managers can switch from an in-progress messaging interaction to a new messaging conversation. Switching to a new messaging interaction does not close the original messaging interaction, but enables agents to carry on multiple messaging conversations. AWA agents can access ongoing messaging conversations when the

HR AWA agents and managers have access to ongoing messaging conversations and are notified when there is a new message on any long running assigned interactions. When an ongoing messaging conversation has a new message that needs attention, an icon is displayed after the Inbox icon in HR Service Delivery Workspace. A new tab carries a counter badge that indicates the number of messaging conversations that have unread messages. AWA agents and managers can view cards for messaging conversations.

HR AWA agents and managers can view a list of all in Progress or On Hold Messaging Work Items assigned to other agents. The list indicates the service channel, interaction number, and last updated date. Agents can click the list item to open it in a Workspace tab. Agents can open a messaging interaction in a sub tab and, if the interaction is active, view the chat panel on the interaction record. Agents can type messages in the chat panel to have an SMS conversation with an employee.

Quick actions for agents
Access existing chat-based quick actions for SMS messaging. For details, refer to Quick actions in Workspace Agent Chat.

Conversation desktop notifications
HR agents can set preferences to receive conversation desktop notifications, audio alerts, and Google Chrome browser toasts. Audio alerts and desktop notifications occur when agents opt in to receiving Conversation Audio Alerts and Conversation Desktop Notifications via the HR Service Delivery Agent Workspace Inbox settings.

Once opted in, agents hear an audio alert when a new message occurs on a conversation that is currently open in a workspace tab, but not in focus. Audio alerts also notify when a long running conversation is assigned to an agent, but is not currently open in a workspace tab. Agents decide if they want to enable these alerts and notifications.

Use the edit menu 🏷️ in the HR Service Delivery Agent Workspace Inbox to enable alerts and notifications.

Agents can receive Google Chrome browser toasts when the following criteria is met:

• The agent has opted in to receive Conversation Desktop Notifications.
• The agent is using Google Chrome browser.
• The Workspace browser tab is not in focus.
• A new message on an existing conversation, assigned to the agent, is in one of the following places:
  ◦ A currently open Workspace tab.
  ◦ Not in a currently open Workspace tab, but in a long running conversation in an ongoing section of Workspace.

Employee initiated SMS conversations
Employees can initiate HR support conversations through SMS. Agents can expect the system to automatically associate the sender phone number to the channel user profile. If an SMS message is received for a non-existing channel user profile, a new channel user profile is automatically created by the system. The system queries the Mobile phone field on employee HR profile for a match. When a match is found, the system associates the employee with the newly created channel user profile. If more than one match is found no association is made on the channel user profile. If no match is found no association is made on channel user profile.

When an employee adds a phone number to an SMS messaging interaction or updates a phone number on the interaction, the Number field on the interaction updates from null to the employee’s name. The HR profile for that employee is associated to the phone number. Only one active channel user profile can exist for a given phone number at any time.

Set up HR Service Delivery Conversational SMS service channel
Configure the Conversational SMS service channel store app for HR Service Delivery.

Before you begin
Role required: admin

About this task
The HR Service Delivery base system includes the HR SMS service channel queue with the default HR SMS Support Group assignment group. The Agent assignment rule is capacity based by default. For HR Service Delivery, you’ll configure the SMS service channel for the HR SMS queue.

Procedure
1. Navigate to Advanced Work Assignment > Service Channels.
2. Click the SMS service channel. On the Service Channel SMS form, select the Active check box to activate the service channel.

Note: By default, most of the form is populated for you. Capacity and Utilization fields are set to 1 for Default work item size and 4 for Default capacity. You can change these, and any form values, if desired.
3. Click the Queues related list to view and configure the HR SMS queue.

4. View the default configurations on the Queue HR SMS form, ensuring the **Active** check box is checked. Modify values as you desire.

5. Click on any of the related lists to view or modify default configured values.

**Note:** Notice that the Assignment Eligibility related list defaults to the **HR SMS Support Group**. You’ll need to manually add users to this group to route assignments. Refer to **Add a user to a group** to learn how to add users to this group.

6. Click **Update** to save any changes you made.
7. Update the Advanced Work Assignment Presence States by navigating to **Advanced Work Assignment > Settings > Presence States.**

8. Click **Available** in the Presence States list.

9. In the Presence State Available form, select **SMS** in the **Service channels Available** column and move it to the **Selected** column using the right-pointing arrow.

10. Click **Update**.

   **Note:** For complete information regarding Conversational SMS service channels and setup guidance, refer to **Conversational SMS service channel.**

**Compose an SMS message from a chat in HR Service Delivery Agent Workspace**

Create and send an outbound SMS message to a recipient directly from a chat interaction. Access interactions assigned to you to follow up via SMS message when you need more details from the employee.

**Before you begin**
Role required: sn_hr_core.case_writer

**About this task**
An interaction is a request for assistance made through chat, phone, or in person. Interaction records are automatically created when you are using agent chat. The **Compose SMS** option is only enabled for active chat interactions. For more information about interactions in HR Service Delivery, refer to **Using interactions in HR Service Delivery Agent Workspace.**

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace.**

2. Select the **List** HR case list icon and navigate to **Interactions > Assigned to me.**

3. Select an active chat interaction for which you would like to respond to the recipient via an SMS message.

4. In the chat interaction modal, click the **more options** icon and select **Compose SMS** to initiate an SMS conversation with the recipient.

   The **Send via SMS** modal launches with **Send from** and **Send to** fields.

5. Use the drop-down **Send to** field to select the SMS recipient.
Note: You can choose an automatically populated phone number or choose Other to enter the phone number manually in the Other number field. Automatically populated phone numbers display based on the following criteria:

- The Opened for field is populated on the interaction with phone number.
  The phone numbers as specified on the HR Profile record. The label for each phone number on the Send via SMS modal will match the label for the Phone number field on HR Profile record.
  If a manually added phone number is not associated with an existing active channel user profile record, the record is created automatically when you send the SMS message.

Note: When an interaction is created with phone number p1, not associated with an existing HR Profile, a channel user profile is be created as a Guest. When the user updates an HR Profile, HRP1, with a phone number p1, the user is treated as HRP1.

6. Compose the SMS message, add an attachment if necessary, and send to the employee.

You can also select the quick action icon, or enter a back slash (/) in the chat area, to use quick actions for SMS messaging. See Quick actions for more information.

You will receive a confirmation when the SMS message is sent. Click the confirmation to view the interaction details, if desired.

Note: For complete details regarding initiating SMS conversations in Agent Workspace, refer to Agent initiated SMS conversation. For details about using Agent Workspace with HR Service Delivery, refer to Using HR Service Delivery Agent Workspace.

Using interactions in HR Service Delivery Agent Workspace

Use interaction records to create an HR case or reference employee information to decide to create a case or request from the chat conversation.

An interaction is a request for assistance made through chat, phone, or in person. You can route interactions by skill, group, or directly to an HR agent.

You can also create an interaction for one-and-done type requests where you decide you might not want to create an HR case or associated tasks.

Interaction records are automatically created when you are using agent chat.

For more information on interactions, see Interaction records in Agent Workspace.

Create interactions in HR Service Delivery Agent Workspace

You can create interaction records from the HR Service Delivery Agent Workspace form.

Before you begin

Role required: sn_hr_core.case_writer

Procedure

1. Navigate to HR Case Management > HR Agent Workspace.

2. To create an interaction, select the Create case icon. Select Interaction.
3. In the details section, enter information about the interaction.

4. Fill in the fields.

**Interaction fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Every interaction record defaults to the Details form, showing initial interaction record information.</td>
</tr>
<tr>
<td>Number</td>
<td>The number assigned to the interaction record.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of communication responsible for the interaction record. The values are:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>The status of the interaction record.</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Abandoned</td>
</tr>
<tr>
<td>Opened for</td>
<td>The employee the interaction is about.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The HR agent responsible for the interaction.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description about the interaction.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information specific to the interaction and can help other HR agents. Work notes are not visible to the Opened for person.</td>
</tr>
</tbody>
</table>

5. Select **Save**.

**Interaction tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Tasks</td>
<td>Any tasks or cases opened from the interaction, for example, a new incident or new case.</td>
</tr>
<tr>
<td>User’s Tasks</td>
<td>Incidents related to the interaction.</td>
</tr>
<tr>
<td>User’s Interactions</td>
<td>Logs all interactions tied to each specific user.</td>
</tr>
<tr>
<td>Cases opened for &quot;Opened for&quot;</td>
<td>Shows all HR cases related to the Opened for person.</td>
</tr>
</tbody>
</table>

6. You can select from the following: **more icon**.

7. Select **Create HR Case** to create a case based on the interaction. **Create Incident** is part of demo data and not available to HR Service Delivery Agent Workspace.

8. Select the **more icon** to display additional actions you can take.

**more icon choices**

<table>
<thead>
<tr>
<th>Choice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Standard Change</td>
<td>Part of demo data and not available to HR Service Delivery Agent Workspace.</td>
</tr>
<tr>
<td>Choice</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Associate Record</td>
<td>Use to associate an interaction to an HR case. After linking, the interaction appears under the Interactions tab for an HR case. Select Task under Record Type then optionally select a task record. You can also associate an interaction record that contains a knowledge article. Under Record Type, select Knowledge then select a knowledge article.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select to delete the interaction record.</td>
</tr>
</tbody>
</table>

9. Select **Save** to save work entered for an interaction.

10. To view interactions, select the **Interactions for Subject Person** tab on the child tab.

---

**Working lifecycle event cases in HR Service Delivery Agent Workspace**

Manage lifecycle event cases using HR Service Delivery Agent Workspace.

A lifecycle event case is an HR case fulfilled by a lifecycle event. For example, the HR service for New Hire Onboarding fulfills the lifecycle event for New Hire Onboarding.

**Note:** This section assumes you have Enterprise Onboarding and Transitions activated. For more information, see [Understanding Enterprise Onboarding and Transitions](#).

**List lifecycle event cases using HR Service Delivery Agent Workspace**

You can show all lifecycle event cases by using lists.

**Before you begin**

Role required: sn_hr_le.case_writer

**Procedure**

1. Navigate to HR Case Management > HR Agent Workspace.

2. Select the **List** icon.
3. Select Lifecycle Events.

4. Select Lifecycle Events Cases.

Create a lifecycle event case using HR Service Delivery Agent Workspace

There are multiple ways to create a Lifecycle Event case.

Before you begin
Role required: sn_hr_le.case_writer

Procedure

1. Navigate to HR Case Management > HR Agent Workspace.

2. From the HR Service Delivery Agent Workspace landing page, select the Add New icon. Select HR Case.

3. From the Lifecycle Events Cases list, select the Add New icon or the New button.

4. Enter an employee name or case number.
5. Verify that the employee is the correct person for the case.

6. Enter **New Hire Onboarding** in the **HR service** field.

7. Select **Create Case**.

8. Select **Ready for Work**.
   
The state changes to **Ready**. In the Details section, the **Assignment group** and **Assigned to** fields populate based on your case assignment rules or HR case template. For more information, see Assignment and matching rules in HR and HR templates.

**View activity set status in HR Service Delivery Agent Workspace**

Monitor the status of a lifecycle event case with the **Activity Set Status** tab. You can also monitor the state of each activity set and activities in a lifecycle event case.

**Before you begin**

Role required: sn_hr_le.case_writer
Procedure
1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Locate and display a lifecycle event case that is in progress. For more information, see List lifecycle event cases using HR Service Delivery Agent Workspace.
3. Select the **Activity Set Status** tab.
4. Select **Activity Set Status**.

View a special handling note in HR Service Delivery Agent Workspace
When configured, special handling notes appear for HR cases that require special attention.

Before you begin
Role required: sn_hr_core.case_writer

Procedure
1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Locate and display an HR case. If the HR case is configured to show a special handling note, it appears as a pop-up.
3. Read the note and select **Dismiss**.

**Using the activity stream in HR Service Delivery Agent Workspace**

Use the activity stream section of HR Service Delivery Agent Workspace to document work notes (private) or comments, respond to email, or view the state of the HR case.

**Create a work note or comment in HR Agent Workspace**

You can add a work note (private) or comment to an activity.

**Before you begin**

Role required: sn_hr_core.case_writer

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace**.
2. In the Compose section, select **Comments** (visible to subject person) or **Work notes** (not visible to subject person).
3. Click **Post Comments**.

**Note:** There is also a **Comments/Worknotes** section at the bottom, left side of the form. This section is turned off by default, but can be used to enter text by clicking the accordion icon (⋮). After entering text, click **Save**.

**Create a reminder in HR Service Delivery Agent Workspace**

You can create reminders tied to HR cases or tasks to provide timely communication and actions are taken. Use reminders to make certain you follow up by a specific date.

**Before you begin**

Role required: sn_hr_core.case_writer

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Click the Lists icon (⋯) along the left side.
3. Navigate to and open a case you want to add a reminder.
4. Click the **More Actions** icon (⋯), scroll down and click **Set reminder**.
5. Fill in the fields.

**Create New Reminder**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Text that describes the reminder.</td>
</tr>
<tr>
<td>Date time</td>
<td>The date and time you want to receive the reminder.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Task</td>
<td>The task or case associated with the reminder. Automatically appears based on the case or task you have displayed when creating the reminder.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the logged in user that created the reminder.</td>
</tr>
<tr>
<td>Reminder</td>
<td>Status of the reminder.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

ℹ️ **Note:** To view reminders, click **more** from the Related Items menu, scroll down, and select **Reminders**. When an alert is activated, a number appears inside the Notifications icon (_circle_1_1_8) and the notifications message scrolls across the screen.

**HR Service Delivery Playbook**

Currently, HR Service Delivery Playbook offers you a single pane to view and work all tasks and steps required for resolving a lifecycle event case.

ℹ️ **Note:** Only lifecycle event cases are supported at this time.

Having all case information in a single pane allows you to quickly and easily decide what your top priorities are. Having top priorities allows you to:

- View all in-progress steps across different departments so you don’t waste time searching and opening different forms.
- View all completed actions.
- Easily and quickly see what you should do next.

**Lifecycle event cases**

Because there can be multiple activity sets in a lifecycle event case that also contain multiple activities, being able to view all aspects is crucial to an HR agent.

Using an accordion button, you can expand or collapse activity sets to view the activities within.

Within an activity set, you can view all tasks, state, owners, and have the ability to take action.

ℹ️ **Note:** For more information about lifecycle events, see **Enterprise Onboarding and Transitions**.

**Exploring HR Service Delivery Playbook**

Use HR Service Delivery Agent Workspace to manage lifecycle event cases.

**HR Agent Workspace case form with Playbook**

When Playbook is activated with HR Service Delivery Agent Workspace, the **Playbook** tab appears in the Related Items menu.

**Playbook Header**

The Playbook Header shows the title of an activity set.
Note: For more information on lifecycle event structure, see Configure a lifecycle event.

Stage panel

Along the left side of the Playbook form, you'll see the stage panel that shows the lifecycle event and each activity set. Below each activity set shows the number of activities completed and a status circle. A check inside the circle indicates a completed activity set.

A check mark inside the Playbook Header indicates that the activity set is complete.

You can quickly see how many activities there are for an activity set and how many are completed.

In the example, the activity set Start onboarding has a total of nine activities with one completed (1 of 9).
**Activity stream**

Click on an activity set in the stage panel to view all activities within the activity set.

**HR card**

You can drill into an activity from the activity stream by clicking on an activity to view details about case or task.

The HR case opens in a separate widow and tab.

**HR card details**

Click the activity and the **Assigned to**, **HR service**, **Opened for**, **Subject person**, **State**, and attachments appear.

At the top, right of an HR Playbook card are a series of icons.
The first icon on the left provides the state of the HR case or task. Hovering over shows details of the SLA.

Click the Add note or comment icon to add comments or notes related to the activity.

To view comments or notes, click the See activity button.

Click the Open task icon to view the details of the HR case or task. A new tab with the HR case or tab opens.

Click the Minimize task icon to close the details of the HR case or task.

The other areas of Playbook are covered in Exploring HR Service Delivery Agent Workspace.

**Setting up HR Service Delivery Playbook**

Set up HR Service Delivery Playbook so that your agents can easily manage, track, and lifecycle event cases.

The Playbook tab under HR Service Delivery Agent Workspace has the following:

- HR cards
  - HR cards show each activity in the activity set or child task generated from an activity.
- The Verify Work Authorization card has an HR task type = Mark When Complete condition.

- Each activity shows an HR task, case, request, and others. The activities look at the HR Playbook Card Configuration table to match the lowest order record.

- The HR Playbook Card Configuration can have filters to determine what values to render.

- Use HR Playbook Card Configuration to configure cards.

- For more information, see Configure HR Service Delivery playbook card.
As an HR administrator, use this to configure how each playbook looks in HR Service Delivery Playbook for different types of records (HR case, task, and others). Different record types have different relevant information to show.

The base system provides 19 records.

⚠️ Note: For more information on playbook configuration, see Set up a playbook.

**Configure HR Service Delivery playbook card**

Use Playbook Card Configuration to view and manage what appears for each card in an activity set.

**Before you begin**

Role required: sn_hr_ws.admin

For example, the Verify Work Authorization is a mark when complete card that the base system provides.

Each activity attempts to show a record (HR task, HR case, request, and so on) and goes through the card configuration and attempts to match to the lowest ordered record in the table.

The properties from the card configuration record are filled in from the record (HR task, HR case, request, and so on).

**Procedure**

1. Navigate to **HR Administration > Playbook Card Configuration**.
2. Fill in the fields on the form.

---

### HR Playbook Card Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the HR Playbook Card Configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>The record type of the configuration. Determines what card appears for each activity within an activity set (lane). Also determines what properties the card uses.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions that determine if the type values render to an HR Playbook card.</td>
</tr>
<tr>
<td>Activity type</td>
<td>The activity type from a lifecycle event activity. Activity types can be approvals, employee activities, fulfiller activities, notifications, and more.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates if the record is active and available for use.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the activity attempts to match this record. The lowest values are evaluated first.</td>
</tr>
</tbody>
</table>
The Type Values section determines what appears on each card.

### Type Values

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated table</td>
<td>Not applicable at this time.</td>
</tr>
<tr>
<td>Footer</td>
<td>Information you want to appear in the footer of an HR Playbook card. Enter text or click the pill picker icon to display references you can select from to automate the placement of information.</td>
</tr>
<tr>
<td>Associated record</td>
<td>Not applicable at this time.</td>
</tr>
<tr>
<td>Icon</td>
<td>Displays an icon that appears in the upper, left-side of the card. Click the Lookup using list icon to select the icon you want to appear.</td>
</tr>
</tbody>
</table>
| Description                   | Select the pill picker icon to display a description on the card. 

**Note:** This is not a free-form field, you must select from the available options. |
| Attachments read only         | Check to indicate existing attachments can only be read. 

**Note:** This is a read only field and not for adding attachments to the activity. See the Attachment source field. |
| Title                         | The title of the card. You can enter free-form text or select from the list after clicking the pill picker icon.                                                                                           |
| Form fields                   | Displays a vertical column of fields that render below the row of record fields. 

**Note:** The fields are editable when at least one button on the card says Form fields required. You can enter comma separated text or select fields by clicking the pill picker icon. The fields you select appear as a column on the left-side of the card. |
<p>| Show SLA                      | Check to indicate you want the SLA icon to appear at the top, right-side of the card. The icon shows the state of the SLA.                                                                                |
| Tagline                       | Enter or select information that appears at the top of the card above the title.                                                                                                                            |
| Attachment source             | Use to allow uploading of attachments.                                                                                                                                                                          |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting associated_record</td>
<td>Selecting associated_record allows the user to upload an attachment from the card.</td>
</tr>
<tr>
<td>Fields you want to appear across the upper section of the card. Enter comma separated list of fields you want to appear on the card or click the xx icon to select references.</td>
<td></td>
</tr>
<tr>
<td>Show Checklist</td>
<td>Check to display the checklist from the activity. Users can check off tasks the same way they do on the case form.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Identifies the Assigned to agent. You can enter free-form text or select from the references after clicking the pill picker icon ![pill-picker]. The name appears next to the title.</td>
</tr>
<tr>
<td>Form View</td>
<td>Works with the Form fields and allows you to define an entire section you want to appear on the card.</td>
</tr>
</tbody>
</table>

3. Click Submit or Update.

**HR Playbook Experience**

Use Playbook Experiences to select the playbook your company uses. The base HR Service Delivery Playbook contains a pre-configured playbook experience. A Playbook experience is tied to Playbook Configurations and Playbook Activity Overrides.

**Playbook Configuration**

- Decide if you want the activity state icon on the card.
- Determine what fields to use in the Playbook filter.
- Determine the maximum number of form fields allowed on a card before a model is used.
- Define the conditions to display on the card for the SLA time icon.

**Playbook Experiences**

Controls the playbook user experience.

- Sets up display and activity filters.
- Provides SLA integration.
- Provides access control.

**Activity Overrides**

The base system uses activity overrides to show the list card for requests and the default record card for collapsing and expanding tasks. Activity overrides are also for expanding cards assigned to the user, overdue, SLA breached, and so on that agents see by default.
Activity overrides control the logic and conditions for cards that are expanded and cards that are collapsed.

Enables you to override three (3) defaults for each card (from the **What to override** tab):

- The type of card used (default card, list card, create record card, knowledge card, and so on).
- Expand state (should this card open by default when playbook loads).
- Roles Required (should you limit this card to specific roles).

**Activity Actions**

Defines playbook actions like add using forms, conditions, and scripts, and what buttons appear on a card. You can configure these buttons:

- Location, where the buttons appear.
- Button type and color.
- How the button is implemented (server script, client action, or a UI component modal).

Activity actions also work with displaying buttons and icons that can:

- Render a component (Add Approvers or Close Complete).
- Update the record (change its state).

To make changes to the default configurations, see **Update playbook experience configurations**.

**Configure HR Playbook Experiences**

Use Playbook Experiences to modify the default playbook experience configurations.

**Before you begin**

Role required: sn_hr_ws.admin

**Note:** To make changes, clone the HR Playbook Experience record first.

**Procedure**

1. Navigate to **Playbook Experience > Playbook Experiences**.
2. Select **HR Playbook**.
3. Select the **Playbook Configurations** tab and select **true**. For information on the form fields, see **Update playbook experience configurations**.
4. Select the **Playbook Activity Overrides** tab and an activity override. For information on the form fields, see **Set up playbook activity overrides**.
5. After editing or creating, click **Update** or **Submit**.

**Configure HR Playbook activity overrides**

Create optional activity overrides for the default behavior of activities in your HR playbook.

**Before you begin**

Role required: sn_hr_ws.admin

**Note:** You can also access Playbook Activity Overrides from Playbook Experiences. See **Configure HR Playbook Experiences**.
Procedure
1. Navigate to Playbook Experience > Activity Overrides.
2. Select an activity override or New.
   For information on the form fields, see Set up playbook activity overrides.
3. After editing or creating, click Update or Submit.

Configure HR Playbook activity actions
Use playbook actions to enable users to complete (add buttons and lists) and skip activities.

Before you begin
Role required: sn_hr_ws.admin

Procedure
1. Navigate to Playbook Experience > Activity Actions.
2. Enter or edit the form fields.
   For information on the form fields, see Customize Playbook actions.
3. After editing or creating, click Update or Submit.

Using HR Service Delivery Playbook
Currently, HR Service Delivery Playbook is only available for use with lifecycle event HR cases. Playbook shows as a tab on the HR Agent Workspace form after displaying an LE case.

Note: The Playbook tab only appears after the HR case has moved to Ready or Work in Progress. This triggers the lifecycle event and data appears for all launched activities.

Selecting the Playbook tab allows you to view and work all lifecycle event activities and their child tasks in a single pane.

Note: Tasks that are created ad-hoc and not part of the workflow do not appear in the tab, but may be accessible in regular related lists.
Lifecycle event

The title of the lifecycle event is at the top below the Playbook tab in the stage panel.

Activity sets

The list of lanes along with their status icon appear below the lifecycle event description.

Under the New Hire Onboarding (Demo) lifecycle event are five (5) activity sets:

• Start onboarding
• Prepare for day 1
• Start your new job!
• Ramp up
• Initial check-in

Activities

Click on an activity set to view the associated activities.
HR Playbook add a note or comment

You can add a work note or comment to an HR lifecycle event case from Playbook.

Before you begin
Role required: sn_hr_le.case_writer

Procedure
1. Navigate to HR Case Management > HR Agent Workspace.
2. Select a lifecycle event case.
3. Click an activity set.
4. Click an activity within the opened activity set.
5. Click the **Add note or comment** icon.

6. Select **Work notes (Private)** or **Comments**.
7. Enter text and click **Post Work notes (Private)** or **Post Comments**.

8. Click the **Filter by** icon to filter by activities.

9. Check the filters you want to show activities under.

10. Click the **More Options** icon.
11. Select the filters you want to use to show activities by.

**HR Playbook open a case or a task**

You can open a sub-case or task on an HR lifecycle event case from Playbook.

**Before you begin**
Role required: sn_hr_le.case_writer

**Procedure**
1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Select a lifecycle event case.
3. Click an activity set.

4. Click an activity within the opened activity set.
5. Click the **Open task** icon.

6. The details of a sub-case or task opens.
7. You can make edits and click **Save**.
8. To return to Playbook, click the **Details** tab.

**HR Playbook see activity**

You can view the activity stream in a modal from HR Playbook.

**Before you begin**

Role required: sn_hr_le.case_writer

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Select a lifecycle event case.
3. Click an activity set.
4. Click an activity within the opened activity set.

5. Click the **See activity** button.

**Note:** Only agents with access to the case card and not assigned to the case can see this button. The Assigned to agent does not see this button.
Activities can have links to training, videos, or catalog items. The state of the activity also appears to the right.

HR Playbook add attachment

Depending on the activity, you can add attachments from Playbook.

Before you begin
Role required: sn_hr_le.case_writer

Procedure
1. Navigate to HR Case Management > HR Agent Workspace.
2. Select a lifecycle event case.
3. Click an activity set.
4. Click an activity within the opened activity set.

5. Click +Add File.
6. Select the file you want to upload and click Open.

**HR Playbook rescind an activity**

You can cancel and revert work done in a lifecycle event case using the rescind process.

**Before you begin**

Role required: sn_hr_le.case_writer

For more information, see Configure the rescind process for a lifecycle event.

**Procedure**

1. Navigate to HR Case Management > HR Agent Workspace.
2. Select a lifecycle event case.
3. Click **Rescind**.

4. Enter a reason for rescinding the case. You cannot undo a rescind, so proceed with caution.

5. Click **OK**. The rescind activities appear and future activity sets are cancelled.

View email sent to opened for or subject person

As an HR agent, you can view emails to the opened for or subject person on a lifecycle event case.

**Before you begin**

Role required: sn_hr_le.case_writer

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Select a lifecycle event case.
4. From any activity, when there is a **See email body** button, click it.

The email appears.

5. Click the **X** at the top, right corner of the email to close it.
**HR Service Delivery Agent Workspace integration with Universal Request**

With the integration of HR Service Delivery Agent Workspace and Universal Request applications, you can provide a consistent user experience for employees while creating service requests.

**Overview**

A universal request gets created when an employee clicks the **Request help** option in Employee Service Center. A universal request routing agent analyses the issue (as HR department related) and creates an HR case from that universal request. After the case gets resolved by an HR agent, the state of the HR case changes to **Awaiting Acceptance**. Automatically, the state of the universal request changes to **Awaiting response**. Finally, after the employee accepts the resolution, the universal request gets closed and in turn, the HR case gets closed.

At any point in time, the HR agent can **route the HR case back** to the universal request queue with or without resolution.

All the important details, such as users who are working on the issue, inter-department transfers, and work notes, are recorded in the universal request ticket providing complete visibility to the employee who has raised the request.

**Activating the necessary plugins**

After you have activated the Human Resources Scoped App: Workspace (com.sn_hr_agent_workspace) and Universal Request (com.snc.universal_request) plugins, you will notice that:

- The Universal Request form has the UI action to create an HR case.
- The **Universal Request** field appears on the HR case form only when an HR case is associated with a universal request record.
- The **Transfer** button appears on the HR case form to let an HR agent route an HR case back to the universal request, another department, or service.

**Create an HR case from Universal Request in HR Service Delivery Agent Workspace**

Create an HR case from a universal request record to restore service to a customer as soon as possible. After creating the HR case record, you can investigate potential solutions.

**Before you begin**

Role required: routing_agent and sn_hr_core.case_writer

**Procedure**

1. Navigate to **HR Case Management > HR Agent Workspace**.
2. Navigate to **Universal Requests > All**.
3. Open the universal request record from which you want to create an HR case.
4. Click **Create HR case**.
5. Fill in the required fields on the HR case form.

⚠️ **Note:** The **Employee Information** field values are automatically copied from the universal request to the HR case.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>The Center of Excellence</td>
</tr>
<tr>
<td>HR service</td>
<td>The HR service type</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Opened for</td>
<td>The person the ticket is opened for</td>
</tr>
<tr>
<td>Subject person</td>
<td>The subject person</td>
</tr>
<tr>
<td>Work notes</td>
<td>Other notes if any</td>
</tr>
</tbody>
</table>

6. Click **Submit**.  
The HR case number appears in the **Primary Ticket** field on the universal request form, and the ticket is listed in the **Associated Tickets** related list. Also the universal request number from which the HR case is created appears in the **Universal Request** field on the HR case form.

**Work on an HR case of Universal Request in HR Service Delivery Agent Workspace**

Provide resolution to an HR case that is initiated from a universal request.

**Before you begin**

Role required: routing_agent and sn_hr_core.case_writer

**About this task**

The state changes described in the procedure can be configured to suit your requirements. For more information, see **Universal Request state mapping**

**Procedure**

1. Open the HR case that is created from a Universal Request.

2. Click **Start Work**.  
The state of the case changes to **Work in Progress**.

3. Click **Closed Complete** when the resolution is provided.  
The state of the HR case is changed to **Awaiting acceptance** and the state of the universal request is automatically changed to **Awaiting response**. On the Employee Service Center:
   - If the user accepts the resolution, the state of the universal request is changed to **Closed**.  
The state of the HR case is automatically changed to **Closed Complete**.
   - If the user rejects the resolution, the state of the universal request is changed to **In progress**. The state of the HR case is automatically changed to **Work in progress**.

**Important:** If for some reason the HR agent clicks **Closed Incomplete** without routing the HR case back to universal request, then the behavior is as follows:

   - If the **Needs Additional Review** check box is selected on the universal request, the universal request will be in the **In progress** state, and the HR case will be in the **Close Incomplete** state.
   - If the **Needs Additional Review** check box is deselected on the universal request, the universal request gets closed based on the state mapping.

**Transfer an HR case to Universal Request in HR Service Delivery Agent Workspace**

Transfer an HR case back to the Universal Request queue, or to another department with or without resolution.

**Before you begin**

Role required: routing_agent and sn_hr_core.case_writer
About this task
Configure the sn_uni_req.transfer_type property in the Universal Request properties page to determine how to handle the primary ticket transfers. For more information, see Universal Request properties.

Procedure
1. Open the HR case that you want to transfer.
2. Click Transfer.

⚠️ Note: The Transfer option is displayed only if you are a part of the assignment group or if the case is assigned to you.

3. In the transfer dialog box, provide the following details.

⚠️ Note: Based on your transfer type configuration, the given fields are displayed. For more information, see Universal Request Properties.

- **Action**: Select if the case should be transferred to another department or back to Universal Request
- **Department**: Select the department from the list.
- **Service**: Select the specific service of the chosen department.
- **Transfer reason**: Select the reason from the list.
- **Transfer notes**: A brief description for routing the primary ticket that you want to pass to the UR Routing agent.
- **Copy additional comments and attachments**: Deselect if you do not want to transfer the ticket with additional comments and attachments. By default, all attachments and comments are transferred.

⚠️ Note: Work notes are not copied while transferring.

4. Click Transfer.

Results
- On the HR case form, you can view the transfer reason and transfer notes.
- The state of the HR case is changed to **Closed Incomplete** and the transfer reason and transfer notes are copied to the universal request.
- The state of the universal request remains **In progress**.

⚠️ Note: The state changes mentioned can be configured. See Transfer configuration for more information.

Machine learning solutions for HR Service Delivery
Machine learning solutions for HR Service Delivery help in auto determining assignment groups and services for HR cases, auto creating cases from emails, and discovering knowledge articles that help in faster resolution of cases and tasks.

Demand Insights for HR Cases dashboard
The Demand Insights for HR cases dashboard enables you as an HR agent to identify which HR cases have no or insufficient knowledge coverage. You can then create feedback tasks for knowledge gaps to deflect such HR cases.
Auto-case creation from an email

Automatically categorize HR cases submitted by email. Auto-case creation allows for a faster response time and better case resolution for employees.

HR cases can be created via email, phone, or a self-service Service Portal such as the Employee Service Center. By default, an email sent to the general address for HR requests is created as a general inquiry case. An HR agent then has to review and manually re categorize it to the appropriate HR service. With Predictive Intelligence, a predictive model is auto-trained to categorize HR cases submitted by email. The email is routed to the appropriate HR service based on the subject line and body.

Note: This feature is available with the HR Professional and HR Enterprise packages when you activate the HR Service Delivery and Predictive Intelligence applications. If you do not want to use this feature navigate to HR Administration > Application Properties and disable the Enable HR Case auto categorization property.

Overview

On instances where both Predictive Intelligence and HR Service Delivery are active, the following solution definition and business rule are available to use.

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Case Categorization</td>
<td>Predicts the HR service from the Short description and Description.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict COE, Service after insert</td>
<td>HR Case [sn_hr_core_case]</td>
<td>Generates prediction results for active HR Service Delivery solutions. Runs when a new HR case record submitted by email is inserted.</td>
</tr>
</tbody>
</table>

By default, the solution definition is configured and the predictive model is auto-trained when the following conditions are met. Auto training happens based on the frequency configuration of solution definition.

- The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- There are 10000 records of HR case study matching the filters defined in the solution definition.
- The glide.platform_ml.auto_training.enabled system property is set to true.

When any one of the preceding conditions is not met, you must manually configure the solution definition and train the predictive model from the HR AI configuration module. If you use domain separation in your instance, you can define the solution definition to use for each domain by creating additional configuration records. See Configure the HR solution definition and domain for more information.

Once your solution definition is trained, you can test the solution prediction by sending emails to the general email address for HR requests. You can then verify that the corresponding HR cases are automatically categorized to the appropriate HR service. See Test an HR solution prediction for more information.
Configure the HR solution definition and domain

Configure your solution definition from the HR AI configuration module, as well as access the solution definition record for training. If you use domain separation in your instance, you can define the solution definition to use for each domain by creating additional configuration records.

Before you begin
Role required: sn_hr_core.admin

Procedure
1. Navigate to HR Administration > HR AI Configuration.
2. Click New or open a record.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Solution Capability Definition | Name of the solution definition.  
• To create or select a solution definition, click the Lookup button.  
• To update or train a solution definition, click the Preview button to open the solution definition record.  
• For further information on creating and training a solution definition, see Create and train a solution definition. |
| Use case                | Name of the use case. For example, email categorization or HR service categorization |
| Active                  | Check box to activate the HR AI configuration for use.                       |

4. Click Submit or Update.

Test an HR solution prediction
Test the solution prediction by sending emails to the general email address for HR requests. Verify that the corresponding HR cases are automatically categorized to the appropriate HR service.

Before you begin
Role required: sn_hr_core.admin or sn_hr_core.case_reader

Procedure
1. Send an email to the general email address for HR requests.

   Note: To verify the general email address for HR requests, navigate to HR Administration > Properties, and view the General email address for HR requests property.

2. Navigate to HR Case Management > All HR Cases, and open one of the modules, such as Assigned to me or Open.
3. Open the applicable record.
4. Verify that the HR case was automatically categorized to the appropriate COE and HR service.

**What to do next**
If you need to retrain and review your predictive model, see Create and train a solution definition and Review classification solution statistics.

**Auto determination of HR service**
Auto determine the HR service for a case. Enable an HR agent to transfer the case to the appropriate HR service rather than having to spend significant time manually triaging cases to appropriate HR services.

**Important:** This feature is available with the HR Professional and HR Enterprise packages when you activate the HR Service Delivery and Predictive Intelligence applications. If you do not want to use this feature, disable the `sn_hr_core.case_auto_categorization` system property.

**Auto-determined HR service displayed in a banner**
After you create a case, the HR Case Classification solution definition auto determines the HR service based on the short description of the case. The appropriate HR service for the case is displayed in a banner.

**Important:** The banner is not displayed if:
- you have logged the case under the correct HR service
- you have manually transferred or auto-transferred the case
- case is not in the ready or draft state

You can also transfer the case from one HR service to another, without losing the case number or content, using the link on the banner. The auto-determined HR service is selected by default on the transfer case window. You can ignore the auto-determined HR service for the case, choose to transfer the case to a different HR service, or continue with the HR service that was provided earlier.

**Auto training the predictive model**
The HR Case Classification solution definition is configured and the predictive model is auto trained when all the following conditions are met:

- The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- There are 10000 records of HR case study matching the filters defined in the solution definition.
- The `glide.platform_ml.auto_training.enabled` system property is set to true.

You can manually train the predictive model if it is not auto trained by default. Later, navigate to the HR AI configuration module, open the HR Case Classification record, and map the configured solution definition.

**Manually train the HR predictive model**
Manually train the HR predictive model if it not auto trained by default.
**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Predictive Intelligence > Homepage**.
2. Select the required solution definition.
3. Click **Train**.
4. To configure a solution definition:
   a. Open the solution definition.
   b. Right-click the solution definition, and click **Copy Solution Definition**.

**Important:** Ensure that the Application scope is **Human Resources: Core**.

A copy of the solution definition is created. Update the required field values in this solution definition and click **Submit and Train**.

**Auto determination of assignment group**
Auto determine the assignment group for a case. Enable an HR agent to transfer the case to correct assignment group rather than having to spend significant time manually identifying groups for HR cases.

**Important:** This feature is available with the HR Professional and HR Enterprise packages when you activate the HR Service Delivery and Predictive Intelligence applications. To use this feature, enable the `sn_hr_core.case_auto_assignment` system property.

**Auto-determined assigned group displayed in a banner**
After you create a case, the Auto Assignment Group for HR Cases solution definition auto determines the assignment group for a case based on the Short description, Description, Opened for Title, Opened for Location Name, and HR service of the case. The appropriate assignment group for the case is displayed in a banner.

**Important:** The banner is not displayed if:
- You have manually assigned the case to an assignment group.
- The assignment group is not identified for the case.
- The case is not in the ready or draft state.

**Auto training the predictive model**
By default the Auto Assignment Group for HR Cases solution definition is configured and the predictive model is auto trained when all of the following conditions are met.
- The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- There are 10000 records of HR case study matching the filters defined in the solution definition.
- The `glide.platform_ml.auto_training.enabled` system property is set to true.

You can manually train the predictive model if it is not auto trained by default. After you manually train the predictive model, navigate to the **HR AI configuration** module, open the Case Assignment group record, and map the configured solution definition.
Discovering knowledge articles and catalog items for employees

Discover all the users who have a similar profile as the employee who has logged in to Employee Service Center. Identify the top viewed knowledge articles and top submitted catalog items by those users. Display the top three knowledge articles and top three catalog items to the employee.

Top three knowledge articles and top three catalog items

When the User Profile Based Recommendation (ml_sn_sn_hr_core_global_user_profile_based_recommendation) solution definition is configured and the predictive model is trained, the top three knowledge articles and top three catalog items are displayed to an employee in Employee Service Center and HR Ticket page.

<table>
<thead>
<tr>
<th>Relevant for you</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Articles</td>
</tr>
<tr>
<td>Matching Gift Policy and Form</td>
</tr>
<tr>
<td>Employee Anti-Harrassment Policy</td>
</tr>
<tr>
<td>Bereavement Leave</td>
</tr>
<tr>
<td>Catalog Items</td>
</tr>
<tr>
<td>VM Provisioning</td>
</tr>
<tr>
<td>Do you need a Virtual Machine?</td>
</tr>
<tr>
<td>401(k) Plan Enrollment</td>
</tr>
<tr>
<td>Enroll in or modify your 401(k) plan</td>
</tr>
<tr>
<td>Direct Deposit Inquiry</td>
</tr>
<tr>
<td>Ask a question about direct deposit</td>
</tr>
</tbody>
</table>

Auto training the predictive model

By default, the User Profile Based Recommendation solution definition is configured and the predictive model is auto trained when all the following conditions are met:

- The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.
- The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
- The glide.platform_ml.auto_training.enabled system property is set to true.

You can manually train the predictive model if it is not auto trained by default. After you manually train the predictive model, navigate to the HR AI configuration module, open the Similar users group record, and map the configured solution definition.

Configuring widget options

You can also configure the following widget options:
• **User prediction count**: Number of similar users discovered by the predictive model. By default, the top 25 similar users are discovered for the user.

• **Recent activity cut off days**: Number of days considered by the predictive model for querying the articles and catalog items. By default, the last 30 days activity is checked from the Knowledge Use table, Requested Items table, and Items Produced Records table.

To configure the widget options, navigate to the **Service Portal Configuration** module, select the widget editor, search for **Relevant for you**, and click **Edit Option Schema**.

### Discovering similar knowledge articles for HR cases

Discover similar information across knowledge articles based on the short description of the HR case and the text in Related Search Results. Display such similar knowledge articles to an HR agent to resolve a case.

### Similar knowledge articles

When the Similar Knowledge Articles for HR Case (ml_sn_sn_hr_core_global_case_to_articles) is configured and the predictive model is trained, the **Similar Knowledge Articles** option is displayed on an HR case. This option displays the most relevant knowledge articles to an HR agent to resolve an HR case.

#### Auto training the predictive model

The Similar Knowledge Articles for HR Case solution definition is configured and the predictive model is auto trained when all the following conditions are met:

• The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.

• The Predictive Intelligence for Contextual Search (com.snc.contextual_search_ml) plugin is installed.

• The `glide.platform_ml.auto_training.enabled` system property is set to true.

You can also manually train the predictive model if it is not auto trained by default.

### Discovering similar closed cases for HR cases

Help an HR agent resolve the current case by displaying similar closed cases.
**Similar Closed HR Cases**

When the Similar Closed HR Cases (ml_sn_sn_hr_core_global_similar_closed_hr_cases) is configured and the predictive model is trained, the **Similar Closed HR cases** option is displayed on an HR case. This option displays the most relevant HR closed cases to an HR agent to help resolve the current HR case.

**Auto training the predictive model**

The Similar Closed HR Cases (ml_sn_sn_hr_core_global_similar_closed_hr_cases) is configured and the predictive model is auto trained when all the following conditions are met:

- The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.
- The Predictive Intelligence for Contextual Search (com.snc.contextual_search_ml) plugin is installed.
- The `glide.platform_ml.auto_training.enabled` system property is set to true.

**Displaying related knowledge articles for completing tasks**

Display knowledge articles that help in completing HR and Content tasks in the Employee Service Center To-dos page and the HR Ticket page.

**Related knowledge articles**

When the following solution definitions are configured and predictive models are trained, the related knowledge articles are displayed to an employee in Employee Service Center and the HR Ticket page.

- The related knowledge articles are displayed for an HR task in Employee Service Center and the HR Ticket page, when you train the Similar Knowledge Articles for HR Task (ml_x_sn_hr_core_global_similar_knowledge_articles_for_hr_task) solution definition.
- The related knowledge articles are displayed for a Content task in Employee Service Center and HR Ticket page, when you train the Similar Knowledge Articles for Content task (ml_sn_sn_cd_global_similar_knowledge_articles_for_content_task) solution definition.
Auto training the predictive models

The Similar Knowledge Articles for HR Task and Similar Knowledge Articles for Content Task solution definitions are configured and predictive models are auto trained when the following conditions are met:

• The Human Resources Scoped App: Core (com.sn_hr_core) plugin is installed.
• The Predictive Intelligence (com.glide.platform_ml) plugin is installed.
• The Employee Service Center (com.sn_hr_service_portal) plugin is required to display related articles for HR tasks.
• The Content Delivery (com.sn_content_delivery) plugin is required to display related articles for Content tasks.
• The glide.platform_ml.auto_training.enabled system property is set to true.

You can manually train the predictive models if they are not auto trained by default. After you manually train the predictive models, navigate to the Service Portal Configuration module and select the Widget editor. Search for Recommended articles for to dos, click Edit Option Schema, and add the configured solution definitions in the following widget options:

• Solution name for Content Task
• Solution name for HR Task

User Experience for HR Service Delivery

User Experience Analytics dashboard provides dashboard views for monitoring the key performance indicators (KPIs) of web applications built on the Employee Service Portal. You can access the dashboard from Dashboard and Reporting. Monitor key performance indicators of the users experiences to create more intuitive user journeys. Click the respective session for a detailed analysis.

• Enable the analytics to view the number of users and their engagement rates over time.
• Analyze the analytics such as geographic, sessions, operating system, and more.
• Track user actions, see user flows, and understand user behavior.
• Gain visibility into the workflows and create more intuitive user journeys.
Dashboard overview
From dashboard, you can track the following employee sessions, page views, and actions. Navigate to User Experience Analytics > Dashboard for more information on the following modules and controls:

- Total active users
- Total sessions
- Page views
- Unique users
- Average session duration
- Retention
- Funnel completion
- Top events

To track the actions, you must enable the analytics first.

Enable Analytics
When you launch the application for the first time, you must enable the consent for tracking the user analytics. Based on your geographic location, your consent settings may change.

Event tracking
Track the following events, status, and progress of the following events. Navigate to User Experience Analytics > Analytics > Events for more information.

- To-do opened
- To-do completed
- My requests
- Relevant for you
- Successful login
- Tracking enabled
- Tracking disabled
- View knowledge article
- Submit record producer request
- Submit catalog request
- Search

Employee To-dos
Track the employee to-dos, tasks, actions, short descriptions, and status from the sessions section. Navigate to User Experience Analytics > Sessions > Timeline for more information.

- To-do type
- To-do opened
- To-do completed
Relevant for you
Track the **Relevant for you** information from the sessions section. For example, you can see article title, page id, and more. Navigate to **User Experience Analytics > Dashboard > Sessions > Timeline** for more information.

My Requests
Track the progress of **My Request** information from the sessions section. For example, you can see **Action: Ask A Question, Action: Accept Resolution**, HR Case, HR Service, and more. Navigate to **User Experience Analytics > Dashboard > Sessions > Timeline** for more information.

Knowledge
See how employees use the progress of knowledge articles. Navigate to **User Experience Analytics > Analytics** for more information.

Analytics and reports
See the analytics about usage, technical, geographic, events, retention, and more. Navigate to **User Experience Analytics > Analytics** for more information. You can see the reports for various timelines such as daily, weekly, monthly.

Performance Analytics for HR Service Delivery
HR Performance Analytics measures key performance indicators to track HR performance over time.

Activation information
HR Performance Analytics Scoped requires a separate premium subscription to the Performance Analytics application. Activate the:

- Performance Analytics Premium for Human Resources Management
  [com.snc.pa.premium.hr] plugin

Also, activate one or more of the following content packs:

- Performance Analytics - Content Pack - Human Resources Scoped App [com.sn_hr_pa]
- Performance Analytics - Content Pack - Human Resources Lifecycle Events Scoped App [com.sn_hr_lifecycle_pa]
- Performance Analytics - Content Pack - Human Resources [com.sn_hr_employee_files_pa]

To configure the Performance Analytics (PA) dashboard, assign the Performance Analytics Administrator [pa_admin] role to the HR Administrator [sn_hr_core.admin] role.

**Note:** Only the System Administrator [admin] can assign PA roles to employees.

See **Performance Analytics roles**.

Contact your account manager for more information.

Related information
- Performance Analytics

View HR Performance Analytics Scoped
HR Performance Analytics for the scoped version of HR Service Delivery helps you align resources and systems to strategic objectives.
Before you begin
Before you can view HR Performance Analytics data, your organization must purchase a subscription to Performance Analytics and an administrator activates the plugin.

Role required: sn_hr_core.manager

About this task
After activating HR Performance Analytics, the collection job runs daily by default and is configurable. Collected data is kept for 30 days. The data in performance analytics reports is collected based on a daily scheduled job, therefore, the date is one day in the past. Over time, more data is available for historical trending.

Scheduled Data Collection
There are two jobs specific to the Performance Analytics - Content Pack - Human Resources Scoped App [com.sn_hr_pa] plugin:

- [PA HR Case] Daily Data Collection
- [PA HR Case] Historic Data Collection

See Create or schedule a data collection job.

Indicators
Each job has indicators to make data collection efficient and defines what data to collect.

See Configure a job indicator.

View dashboards
After the PA jobs run, you can view the collected data from the Dashboard.

See Dashboards overview.

HR Manager
Provides detailed data about open cases that helps managers quickly assign agents and look deeper into opened cases. You can sort this dashboard by assignment group.

- You can only filter this dashboard by Groups.
- The Overview tab provides summaries by backlog of all open cases, average time to resolution, and unassigned opened cases.
- The Operational tab shows the number of open cases by backlog, critical, breached SL, not updated in the last 10 days, and unassigned open. You can also filter by priority, state, assigned to, topic category, and HR service.
- The Backlog monitor tab shows the number of all open cases, average reassignment, cases not updated in last 3 days, unassigned, and the average age of open cases. You can also sort by COE, topic category, HR service, assignment group, agent, state, source, or priority and further by type of HR case. The format of the data is interchangeable.

HR Agent
Provides detailed data for the logged in HR agent. It provides the number of backlog of open cases, breached SLA cases, approval requests, and unassigned cases.

Group and stack the opened backlog cases by priority or state.
You can filter by state, topic category, source, and priority.

The **Performance Analytics** dashboard provides the following reports.

**Volume of Open/Closed Cases by Category**

The line chart shows the trend of open and closed cases for each of the last four weeks. Click a point on a line to see open or closed cases for the duration. The **Breakdowns** tab shows the number of open or closed cases by category. Select **Stacked bar** from the choice list for the best data format.

**Active HR Cases per Week - by AVG**

The bar chart shows the average number of active cases by state for each of the last four weeks. It also shows the total number of cases for each week. The **Breakdowns** tab shows the aging buckets and the total number of cases in each bucket.

**Active HR Cases by State**

The trending chart shows a trend of the cases that moved to each HR case state during the past 30 days. The gray bar to the left of the Trend column represents the proportion of moved cases to the total number of cases. The **Breakdowns** tab shows aging buckets and the number of cases in each bucket for that date.

**Active HR Cases Managed by Agent - Weekly AVG**

The trending chart shows the number of cases assigned to each agent over the past four weeks.

**Active HR Cases SLA Indicator per Week- By AVG**

The bar chart shows the average number of cases that were in each aging bucket for each of the last four weeks. The **Breakdown** tab shows the agent and the number of cases on that date in the selected aging bucket. Select **Column** from the choice list for the best data format.

- Point your cursor to an element, such as a bar or pie segment, to see what the element represents.
- Click a segment to see more details about the element. Scroll up to view the information. The detail contains the following tabs, depending on the selected element.
  - **Chart**: The detail of the element displayed in a chart. You can use the controls on the upper right to add or change comments, targets, and thresholds.
  - **Breakdowns**: The breakdown of the buckets used in the report. Select a chart type from the choice list on the upper right to see the data in another format.
  - **Records**: The records that comprise the element you selected. You can view the detail of each record.
  - **Scores**: The number of records for each week in the report.
  - **Comments**: Comments entered for this report. The tab is disabled unless comments exist.
  - **More info**: A description of the logic that generates the report, how often the job runs, and when the data was last collected.
- If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.

**What to do next**

For more information about performance analytics and how to develop and modify widgets for your organization, see [Performance Analytics concepts](#).
HR Performance Analytics Scoped solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution plugin, an admin can navigate to System Definitions > Plugins and activate the Performance Analytics - Content Pack - Human Resources Scoped App and the Performance Analytics - Content Pack - Human Resources Lifecycle Events Scoped App plugins.

**Note:** This solution applies to the scoped Human Resources application and not the Human Resources application available in earlier releases.

Add Self-Service Analytics to your Human Resources dashboards

If you have Self-Service Analytics activated on an instance, you can add Self-Service analytics widgets to your Performance Analytics dashboards or a Service Portal. To obtain a ready-made set of indicators and breakdowns, activate the Self-Service Analytics PA (com.snc.pa.self_service_analytics) plugin. Find the Self-Service indicators through the Performance Analytics Admin Console, then create widgets and add them to your dashboard or portal. Also activate the [SSA] Self-Service Analytics data collection job.

Related information
- Analytics and Reporting Solutions
- Activate your Performance Analytics subscription

Human Resources agent dashboard

The dashboard for HR Agents monitors caseloads to help stay on top of the backlog, enabling the HR Agent to provide a streamlined experience for the organization workforce.

**Note:** This dashboard is available in the Human Resources Scoped App content pack.
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Agent: Needs to monitor his/her cases and measure his/her performance to stay on top of the backlog.</td>
<td>sn_hr_core.basic, sn_hr_core.case_writer</td>
<td>The HR Agent can provide a streamlined experience for the organization workforce.</td>
</tr>
</tbody>
</table>

Use case

Organizations need to understand and meet or exceed the expectations of the modern workforce and provide a delightful employee experience. Using this dashboard, the HR Agent can track the progress of the cases they own, sorted by priority.

Reports

The Human Resources Agent dashboard contains the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approvals Requested</td>
<td>Single Score</td>
</tr>
<tr>
<td>My HR Open Backlog</td>
<td>List</td>
</tr>
<tr>
<td>My Open Backlog</td>
<td></td>
</tr>
<tr>
<td>My Open Backlog Distribution</td>
<td>Horizontal bar</td>
</tr>
</tbody>
</table>
Human Resources manager dashboard

The dashboard for HR Managers provides insights on how HR teams are meeting expectations. The HR Manager can measure and improve the influence of their team on meeting and exceeding workforce expectations.

⚠ Note: This dashboard is available in the Human Resources Scoped App content pack.

Overview tab

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>My SLA Breached Cases</td>
<td>Single Score</td>
</tr>
<tr>
<td>Unassigned Cases</td>
<td>Single Score</td>
</tr>
<tr>
<td>Unassigned Cases Distribution</td>
<td>Horizontal bar</td>
</tr>
</tbody>
</table>
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Manager: Needs clear visibility into the operations of the shared service center.</td>
<td>sn_hr_core.manager</td>
</tr>
</tbody>
</table>

**Use case**

Organizations need to understand and meet or exceed the expectations of the modern workforce and provide a delightful employee experience. This dashboard provides the HR manager with an overview of the number of HR cases and the time and difficulty in resolving them.

**Indicators**

The HR Manager dashboard presents the following key performance indicators:

**Average case survey score**

Measures the average score of the customer satisfaction survey that is sent to the employees after a case is closed. The score should maximize over time.

The CSAT widget on the dashboard presents an average over the last seven days of the average case survey score.

**HR Cases Growth**

Measures the change in volume of your case backlog. This value is calculated from other indicators using the formula \( \text{Number of open cases} - \text{Number of closed HR cases} \).

**Number of open cases with breached SLAs**

Measures the number of open cases that have SLAs greater than 100.

**Average age of open cases**

Measures the average time that a case remains open. This value is calculated from other indicators using the formula \( \frac{\text{Summed duration of open cases}}{\text{Number of open cases}} / 24 \).

On the dashboard, this indicator is labeled **Open Cases Age**.

**Average age of closed cases**

Measures the average amount of time that it takes to close a case. This value is calculated from other indicators using the formula \( \frac{\text{Summed duration of open cases}}{\text{Number of open cases}} / 24 \).

The **Average time to close - Weekly** widget presents an average over the last seven days of the average age of closed cases.

**Number of open cases**

Measures the number of cases that were opened on or before today that have not been closed yet.

The number of open cases is plotted against the age of open cases.

**Average reassignment of open cases**

Measures the average number of times a case is reassigned. This value is calculated from other indicators using the formula \( \frac{\text{Summed reassignment of open cases}}{\text{Number of open cases}} \).

**Number of cases with no updates in last 3 days**

**Number of cases with no updates in last 10 days**
The number of open cases that have gone 3 or 10 days, respectively, without any updates.

**Summed duration of open cases**

Measures how long all open cases have been open for.

**Number of reassigned open cases**

Measures the number of cases that have a reassignment count greater than 0.

**Summed reassignment of open cases**

Measures how many times a case is reassigned.

**Number of unassigned open cases**

Measures number of open cases that are yet to be assigned.

**Number of closed HR cases**

Measures the number of cases that were closed today.

**Summed duration of closed cases**

Measures the time taken to close all cases.

**Number of new cases**

Measures the number of cases that were opened today.

**Breakdowns**

- Age
- Agent
- Assignment Group
- COE
- HR Service
- Priority
- Source
- State
- Topic Category

**Reports**

The Human Resources Manager dashboard contains the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td># Breached SLA</td>
<td>Single Score</td>
</tr>
<tr>
<td># Critical Cases</td>
<td>Single Score</td>
</tr>
<tr>
<td># Not updated last 10 days</td>
<td>Single Score</td>
</tr>
</tbody>
</table>
### HR Onboarding Executive dashboard

This dashboard gives Human Resources executives insights into how smoothly new employees progress through onboarding activities. Real-time information gives them all the insights they need to measure and improve the influence of their team on providing a delightful employee experience.

**Note:** This dashboard is available in the Human Resources Lifecycle Events Scoped App content pack.
**Overview tab**

<table>
<thead>
<tr>
<th>Date</th>
<th>Open/Ending Cases: Open/Ending Cases: 0.0%</th>
<th>Open/Ending Cases: 0.0%</th>
<th>Open/Ending Cases: 0.0%</th>
<th>Open/Ending Cases: 0.0%</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/2019</td>
<td>21 (20%)</td>
<td>2 (20%)</td>
<td>17 (20%)</td>
<td>54 (20%)</td>
</tr>
<tr>
<td>02/01/2019</td>
<td>21 (20%)</td>
<td>2 (20%)</td>
<td>17 (20%)</td>
<td>54 (20%)</td>
</tr>
<tr>
<td>03/01/2019</td>
<td>21 (20%)</td>
<td>2 (20%)</td>
<td>17 (20%)</td>
<td>54 (20%)</td>
</tr>
<tr>
<td>04/01/2019</td>
<td>21 (20%)</td>
<td>2 (20%)</td>
<td>17 (20%)</td>
<td>54 (20%)</td>
</tr>
</tbody>
</table>

**Activity Analysis tab**

**HR Executive: Needs clear visibility into employee experience**

**Required Performance Analytics role**

**End users and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required Performance Analytics role</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Executive: Needs clear visibility into employee experience</td>
<td>sn_hr_core.manager</td>
</tr>
</tbody>
</table>

**HR Onboarding Executive indicators**

**Number of employees leaving the company**

Measures employee attrition. The **Employee Turnover** widget displays this value, broken down by department, employment type, or employment duration.
Average number of onboarding activities per onboarding case
Measures how many activities are closed on average from the total number of closed onboarding cases, using the formula \[ \frac{\text{Number of Closed Onboarding Activities}}{\text{Number of closed lifecycle events cases} > \text{HR Service = Request Onboarding}} \]

Average new hire satisfaction survey score
Measures the average score of the new hire satisfaction survey which is sent to the employees after they have onboarded

Average time taken for onboarding activities
Measures the time taken on an average to finish onboarding activities per onboarding case, using the formula \[ \frac{\text{Summed duration of onboarding activities}}{\text{Number of closed lifecycle events cases} > \text{HR Service = Request Onboarding}} / 24 \]

Number of HR Cases logged in first 30 days of employment
Measures the number of non-onboarding HR cases that were logged by employees during the first 30 days of their employment

Average number of onboarding activities per onboarding case - Fulfiller
Measures how many activities assigned to the fulfiller are closed on average from the total number of closed onboarding cases, using the formula \[ \frac{\text{Number of closed onboarding activities - Fulfiller}}{\text{Number of closed lifecycle events cases} > \text{HR Service = Request Onboarding}} \]

Average number of onboarding activities per onboarding case - Employee
Measures how many activities assigned to the employee are closed on average from the total number of closed onboarding cases, using the formula \[ \frac{\text{Number of closed onboarding activities - Employee}}{\text{Number of closed lifecycle events cases} > \text{HR Service = Request Onboarding}} \]

Average time taken for onboarding activities - Employee
Measures the time employees take on average to finish their onboarding activities as part of onboarding case, using the formula \[ \frac{\text{Summed duration of onboarding activities - Employee}}{\text{Number of closed lifecycle events cases} > \text{HR Service = Request Onboarding}} / 24 \]

Average time taken for onboarding activities - Fulfillers
Measures the time fulfillers take on average to finish their onboarding activities as part of onboarding case, using the formula \[ \frac{\text{Summed duration of onboarding activities - Fulfiller}}{\text{Number of closed lifecycle events cases} > \text{HR Service = Request Onboarding}} / 24 \]

Number of closed lifecycle events cases
Measures number of lifecycle events cases closed today

Number of closed onboarding activities
Measures the number of all activities closed as part of a lifecycle case, using the formula \[ \text{Number of closed onboarding activities - Employee} + \text{Number of closed onboarding activities - Fulfiller} \]

Number of closed onboarding activities - Employee
Measures the number of closed activities assigned to the new hire

Number of closed onboarding activities - Fulfiller
Measures the number of closed activities assigned to the fulfiller

Number of IT Requests logged in first 30 days of employment
Measures the number of IT Requests that were logged by employees during the first 30 days of their employment

**Number of new lifecycle events cases**
Measures number of lifecycle events cases opened today

**Number of open lifecycle events cases - Employees starting in next 7 days**
Measures number of open cases for employees starting in the next 7 days

**Number of open lifecycle events cases - Post day 1**
Measures number of open cases for employees who have already started

**Number of open lifecycle events cases - Pre day 1**
Measures number of open cases for employees who have yet to start

**Breakdowns**
- Activity
- Activity Set
- Department
- Employment duration
- Employment Type
- Location
- Owner Group
- Region

**Reports**
The dashboards include the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overdue Activities - Employee</td>
<td>Single Score</td>
</tr>
<tr>
<td>Overdue Activities - Fulfiller</td>
<td>Single Score</td>
</tr>
</tbody>
</table>

**Virtual Agent for HR Service Delivery**

HR Service Delivery and Virtual Agent provide an automated chat with an employee requesting HR services. You can program Virtual Agent to understand the intent of an employee to handle repeatable requests.

Virtual Agent enhances the employee experience by addressing queries immediately.

At any time during a virtual chat, the employee can request to interact with a live HR agent.

For more information, see Virtual Agent.
**Predefined Virtual Agent topics for HR Service Delivery**

The base system provides the predefined Virtual Agent topics (chatbot conversations) designed to help your customers complete common self-service HR tasks. These topics are not published and found under the Virtual Agent Designer. For more information, see Virtual Agent Designer.

For more information on predefined virtual agent topics, see Predefined Virtual Agent topics, topic blocks, and ServiceNow NLU models.

The following predefined, HR Service Delivery Virtual Agent topics are available:

- Add Emergency Contact (Template)
- Ask a Question (Template)
- Benefits Overview (Template)
- Create HR General Inquiry Case (Template)
- Delete Emergency Contact (Template)
- FAQ Search Fallback Topic (Template)
- General HR Inquiry (Template)
- New Hire Orientation (Template)
- Pay Discrepancy (Template)
- Request for Leave (Template)
- Update Address (Template)
- Update Email (Template)
- Update Emergency Contact (Template)
- Update Phone Number (Template)

A topic defines the dialog between the Virtual Agent (chat support bot) and user to accomplish a specific goal. The information exchanged during the conversation flow (user inputs and bot responses) enables the chatbot to fulfill a user request or assist a user in completing a task.

For more information, see Designing a Virtual Agent topic.

**Custom portals and ticket page**

If your company has created a custom portal and/or ticket page, and you want the HR case link (in Virtual Agent) to redirect to your portal and/or ticket page:

- Create a system property that links the HR case in Virtual Agent to your portal and/or ticket page. For example:
  - Custom portal name: escServiceNow
  - Custom ticket page name: new_ticket_page
  - sys_property: com.glide.cs.portal_url_mapping.escServiceNow.sn_hr_core_case
  - Value: /escServiceNow?id= new_ticket_page&sys_id={{data.sys_id}}
  - Application: Global

  **Note:** See Add a system property.
Natural Language Understanding (NLU) support
You can set up HR Service Delivery Virtual Agent to use Natural Language Understanding (NLU) to understand word meanings and word contexts to infer user or system actions.

For more information about NLU and the NLU Workbench, see Natural Language Understanding. Natural Language Understanding and Activate the NLU Workbench.

Also, see Natural Language Understanding in Virtual Agent.

⚠️ Note: This feature is only available with the HR Professional and HR Enterprise packages.

Reusable HR Service Delivery Virtual Agent topic blocks
Create and reuse topic blocks to perform common functions in HR Service Delivery Virtual Agent conversations, like creating an HR case or performing a search.

Topic blocks help you be more productive by minimizing duplicate subflows, are easier to maintain, and ready to use immediately.

The following predefined, reusable topic blocks are:

- Contextual Search
- Create HR Case
- Survey
- Transfer to Live Agent
- Update HR Case
- Employee Authentication
- Agent Availability
- FAQ Contextual Search
- AI Search
- Request Catalog Item
- Search Catalog Item

The Topics page in Virtual Agent Designer features a sort tab called Topic Blocks for viewing just the reusable topic functions. For detailed information about HR Service Delivery Virtual Agent, refer to Predefined Virtual Agent topics, topic blocks and Now Platform NLU models.

Integration with messaging applications
Your employees can hold Virtual Agent conversations using Slack, a third-party messaging application.

For more information, see Virtual Agent integration with messaging apps.

For more information on integrating with Slack, see Set up Virtual Agent notifications for Slack and Teams.

Activate Virtual Agent for HR Service Delivery
If you have the admin role, you can activate Virtual Agent for HR Service Delivery. You can also activate Virtual Agent for HR Service Delivery with NLU.

Before you begin
Role required: admin
About this task
The Human Resources Scoped App: Virtual Agent Conversations [com.sn_hr_virtual_agent] plugin activates the sn_hr_va.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Virtual Agent admin user by requiring a minimum number (default is two) of active users with this role.

You can activate Virtual Agent with or without NLU. To activate Virtual Agent without NLU:

- Activate the Glide Virtual Agent (com.glide.cs.chatbot) plugin.
- Activate the Human Resources Scoped App: Virtual Agent Conversations (com.sn_hr_virtual_agent) plugin.

Virtual Agent plugins

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glide Virtual Agent (com.glide.cs.chatbot)</td>
<td>Activates the Virtual Agent framework and other necessary plugins. Note: Activate this plugin first.</td>
</tr>
<tr>
<td>Human Resources Scoped App: Virtual Agent Conversations</td>
<td>Activates a conversational bot platform for providing user assistance through conversations within a messaging interface for HR. Important: To use Virtual Agent for HR, activate the Human Resources Scoped App: Core and the Glide Virtual Agent plugins.</td>
</tr>
</tbody>
</table>

To activate Virtual Agent with NLU:

- Activate the Glide Virtual Agent (com.glide.cs.chatbot) plugin.
- Activate the Human Resources Scoped App: Virtual Agent Conversations (com.sn_hr_virtual_agent) plugin.
- Activate the Predictive Intelligence [com.glide.platform_ml] plugin.
- Activate the Human Resources Scoped App: NLU Model (com.sn_hr_nlu_model) plugin.
- Activate the NLU Workbench (com.snc.nlu_studio) plugin.

NLU HR Virtual Agent plugins

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glide Virtual Agent (com.glide.cs.chatbot)</td>
<td>Activates the Virtual Agent framework and other necessary plugins. Note: Activate this plugin first.</td>
</tr>
<tr>
<td>Human Resources Scoped App: Virtual Agent Conversations</td>
<td>Activates a conversational bot platform for providing user assistance through conversations within a messaging interface for HR. Important: To use Virtual Agent for HR, activate the Human Resources Scoped App: Core and the Glide Virtual Agent plugins.</td>
</tr>
</tbody>
</table>
## NLU HR Virtual Agent plugins (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictive Intelligence</td>
<td>Predictive Intelligence enables the creation of machine learning solutions using data in your instance. The plugin provides various capabilities and solution types for training the system to predict, recommend, and drive data outcomes. Invoke a trained solution for any application by using a prediction API.</td>
</tr>
<tr>
<td>Human Resources Scoped App: NLU Model</td>
<td>Activates the NLU model used by HR Virtual Agent to identify conversation topics. Requires the activation of the NLU Workbench (com.snc.nlu_studio) plugin.</td>
</tr>
<tr>
<td>NLU Workbench (com.snc.nlu_studio)</td>
<td>NLU Workbench enables the creation of Natural Language Understanding (NLU) models. These models can understand the intent (action) and entities (details about the action) for a given user utterance/sentence. Invoke an NLU model for any application by using a prediction API.</td>
</tr>
</tbody>
</table>

**Note:** When an employee opens an HR case using Virtual Agent for HR Service Delivery, the Source field on the HR case is Virtual Agent. For more information, see Work an HR case.

### Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Set up Virtual Agent for HR

Setting up Virtual Agent or Virtual Agent with NLU for HR Service Delivery requires multiple steps.

**Before you begin**

Role required: admin, virtual_agent_admin

The base system provides predefined Virtual Agent and Virtual Agent NLU topics (chatbot conversations).

**Note:** You cannot edit the provided topics. You can duplicate a provided topic and then edit it. You can also create additional topics. See Virtual Agent Designer.
After performing the activation steps, the Chat link replaces the Chat with HR link on the Employee Service Center or service portal.

When an employee clicks the Chat link, Virtual Agent launches and the employee is chatting with a virtual agent.

Before your employees can use Virtual Agent topics, you must activate and publish them.

Before existing Virtual Agent topics can use NLU, you must republish them.

**Note:** By default, the base system provides topics as inactive and unpublished.

If your company uses a custom service portal and ticket page, see Virtual Agent for HR Service Delivery.

To view, duplicate, preview, or publish HR topics in the Virtual Agent Designer:

### Procedure

1. Navigate to **Collaboration > Virtual Agent > Designer**.
2. Click **Active** so the button turns green to activate a topic.
3. Click **Publish**.
4. Click **Save**.

### Configure a custom HR Service Delivery greeting experience

Define a custom HR Service Delivery greeting experience for a specific context in which your users run Virtual Agent. Configure your greeting experiences to automatically initiate virtual agent or immediately transfer to a live agent.

**Before you begin**

Prechat is independent of the Glide Virtual Agent (com.glide.cs.chatbot) plugin activation. This enables you to determine if you want the Virtual Agent topic conversation experience implemented or a live agent experience implemented.

For example, if your instance has both IT Service Management Pro and HR Service Delivery Pro subscriptions, you can implement Virtual Agent topic conversations when a chat starts for ITSM and Live Agent transfer when a chat starts for HR Service Delivery.

You can only customize the greeting experience for Virtual Agent setup topics.

Customization of the setup topics is based on the condition you define. The condition is based on context variables. The customizable setup topics include:

<table>
<thead>
<tr>
<th>Setup topic type</th>
<th>Setup topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anything else</td>
<td>N/A</td>
</tr>
<tr>
<td>Live Agent</td>
<td>Live Agent Support</td>
</tr>
<tr>
<td>Error</td>
<td>Error Handling Topic</td>
</tr>
<tr>
<td>Greeting</td>
<td>Greetings</td>
</tr>
<tr>
<td>Closing</td>
<td>Closing Conversation</td>
</tr>
<tr>
<td>Survey</td>
<td>N/A</td>
</tr>
<tr>
<td>AI Search fallback</td>
<td>AI Search Fallback</td>
</tr>
<tr>
<td>Fallback</td>
<td>Fallback Topic</td>
</tr>
<tr>
<td>Explore Help</td>
<td>Virtual Agent Capabilities</td>
</tr>
</tbody>
</table>
You’ll define the custom experience you want to implement in the Provide the context section of the Custom Greetings and Setup record. The Condition Mode field is configured for Advanced and you’ll need to customize the condition logic in the Script field with JavaScript that specifies the context.

Role required: virtual_agent_admin or admin

Procedure

1. Navigate to Collaboration > Virtual Agent > Custom Greetings and Setup and select New.
2. Refer to Configure a Virtual Agent chat experience for complete details regarding this process.

Now Mobile app for HR Service Delivery

You can let your employees view HR requests, request help, complete HR tasks, receive targeted mobile content and push notifications, chat with a virtual agent, and more using the Now Mobile app for HR Service Delivery.
Key features

Now Mobile app for HR Service Delivery

- View HR requests
- Request services
- Complete HR tasks
- Receive mobile content and push notifications
- Chat with a virtual agent
Employees can view their HR requests by navigating to the **For Me** tab and tapping **See All** from the My Requests section.

**Note:** If you're using the Now Mobile app with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin, hiring managers can track the onboarding progress of their new hires in a single and consolidated section. See [Hiring manager experience for new hire onboarding](#) for more information.
Employees can submit HR requests by navigating to the Services tab and searching or browsing for HR services. They can also tap the plus icon, and then tap Create HR case to create a general inquiry HR case.
Employees can view and complete their HR tasks by navigating to the **For Me** tab and tapping **See All** from the My To-Dos section. Supported task types include:

- **HR tasks**, such as signing electronic documents, uploading attachments, and watching videos.
- **Lifecycle event tasks**, including upcoming activities and rescind activities. See [Enterprise Onboarding and Transitions](#) for more information on lifecycle events.
- **Integration tasks**, such as for the SuccessFactors, DocuSign, or Adobe Sign services. See [HR Integrations](#) for more information on third-party integrations.
- **Content tasks**. See [Add or modify task (to-do) content](#) for configuration details.
Receive targeted mobile content and push notifications

Employees can receive targeted mobile content, such as banners, text cards, and videos, and push notifications. See Configure mobile content and Configure mobile push notification content for configuration details for content delivery or for use in campaigns.
Chat with a virtual agent

If enabled, employees can chat with a virtual agent. See Enable Agent Chat in Now Mobile app for configuration details.

**Note:** Chat can be initiated from any screen in the mobile app, except for search and list screens.

---

**Activation information**

Now Mobile for HR Service Delivery is automatically activated when you activate Case and Knowledge Management. If it is not activated, you can manually activate Now Mobile for HR.

**Related information**

Now Mobile app

**Activate Now Mobile for HR Service Delivery**

Activate the Human Resources Scoped App: Mobile plugin (com.sn_hr_mobile) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Human Resources Scoped App: Mobile activates these related plugins if they are not already active.
Plugins for Human Resources Scoped App: Mobile

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow Mobile Request Native Application Screens and Applet Launcher [com.glide.mobile-employee]</td>
<td>This plugin contains the application and configurations required to set up the ServiceNow Mobile Request Native application.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Components installed with Now Mobile for HR Service Delivery**

Several types of components install with the activation of the Now Mobile for HR Service Delivery plugin, including tables and user roles.

   **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

Demo data is available for this feature. Load demo data at the time of the plugin installation, or add the demo data using the repair feature for plugin installations.

   **Note:** The Human Resources Scoped App: Mobile [com.sn_hr_mobile] plugin activates the sn_hr_mobile.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only mobile admin user by requiring a minimum number (default is two) of active users with this role.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now Mobile for HR admin [sn_hr_mobile.admin]</td>
<td></td>
<td>• None</td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scripted Activity Set Context [v_st_hr_activity_set_context]</td>
<td></td>
</tr>
</tbody>
</table>
Configurations for the Now Mobile app for HR Service Delivery

Configure options for the Now Mobile app for HR Service Delivery.
For more information on configuring the Now Mobile app for HR Service Delivery for:

- The For Me page
  - Greeting
  - My To-Dos
- My Requests
- Search
  - People search
    - Note: Customers that do not use the Employee Service Center (ESC), the base system people search configuration is
  - For information on AI Search, see Configure AI Search for mobile devices.
  - Analytics and suggestions
- Items and services
  - Catalog
  - Quick actions
- Knowledge
- Siri shortcuts

Please see Configurations for Now Mobile.

Hiring manager experience for new hire onboarding

If you’re using the Now Mobile app with the Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent] plugin, hiring managers can track the onboarding progress of their new hires in a single and consolidated section.

The hiring manager experience provides a consolidated view of all of the active onboarding cases of that manager's reports. The manager can drill down into each case form to view
and complete their tasks, as well as track tasks that are overdue, view the timeline, and check for any case updates.

**Important:** For the hiring manager section to appear, the hiring manager must:
- Be the manager of the subject person of the onboarding case
- Be the opened for person on the onboarding case

Onboarding cases that are shown in the Track new hires section do not appear under the **My Requests** section. If there are no active cases, then the hiring manager section does not appear on the app.

To learn more about new hire onboarding and lifecycle events, see [Enterprise Onboarding and Transitions](#).

**HR agent manager experience for the mobile application**

Human Resource (HR) agent managers can view real-time updates, track cases, and view reports on their mobile devices when they are away from the desk or office.

The HR mobile agent enables HR managers to coordinate and facilitate real-time updates on HR cases.

**HR agent experience for the mobile application**

Human Resource (HR) agents using the HR mobile application reduce case resolution time and quickly update team members while away from their desk or office.

The HR mobile agent enables HR agents to view, update, and close HR cases from their mobile devices.

**Administer mobile onboarding**

You must select a lifecycle event to use with mobile onboarding. When an onboarding case for that event type is created, the new hire can use the app to complete their onboarding to-dos. You can also configure the different media sections to provide relevant content to new hires at different stages of the onboarding process. And you can enable chat so that new hires can chat with a live or virtual agent from within the app.

The following video provides an overview on how to configure mobile onboarding.

Watch this video to learn how to configure and test the Mobile Onboarding app.

**Select a lifecycle event for mobile onboarding**

Select the lifecycle event that you want to use with mobile onboarding. When an onboarding case for that event type is created, the new hire completes the to-dos that are associated with that case. You must also make sure that the **Display activity sets to subject person** option is selected, as well as the **Show case to subject person** option on the corresponding HR service.

**Before you begin**

A lifecycle event administrator must have set up the lifecycle event and the corresponding HR service you want to use with mobile onboarding. See [Building a lifecycle event](#) for more information.

Role required: sn_hr_le.admin
Procedure

1. Select the lifecycle event you want to use with mobile onboarding. Also make sure that the **Display activity sets to subject person** option is selected.

   a. Navigate to Lifecycle Events > Administration > Manage Lifecycle Events.

   b. Open the lifecycle event record.

   ![Note: A preconfigured lifecycle event named New Hire Onboarding is available to use.]

   c. On the Lifecycle Event form, set the **Event type** field to Onboarding.

   ![Lifecycle Event Activity Sets]

   ![Display activity sets to subject person]

   ![Event type Onboarding]

   d. Make sure that the **Display activity sets to subject person** option is selected.

   ![Lifecycle Event Activity Sets]

   ![Display activity sets to subject person]

   ![Event type Onboarding]

2. On the corresponding HR service form, make sure that the **Show case to subject person** option is selected.

   a. Navigate to HR Administration > HR Services > HR Service Configuration.

   b. Open the corresponding HR service record.

   ![Note: A preconfigured HR service named New Hire Onboarding is available to use.]

   ![Lifecycle Event Activity Sets]

   ![Display activity sets to subject person]

   ![Event type Onboarding]
c. Make sure that the **Show case to subject person** option is selected.

Configure a media section for mobile onboarding

Configure one or more of the media sections for mobile onboarding to provide relevant content to new hires at different stages of the onboarding process.

**Before you begin**

Role required: sn_hr_le.admin

**About this task**

Media sections are a type of UI section that you can add to an applet launcher. The following media sections appear on the Welcome screen at different stages of the onboarding process in the **Mobile Onboarding** app, and you can personalize the content with your own headlines, images, video, text, and function instances.

**Note:** Beginning in the Paris release, media sections are not enabled by default for new customers.

---

**Welcome to ServiceNow (Before joining)**

Displays when the onboarding case is created until one day before the new hire’s start date.

---

**Welcome to ServiceNow!**

We can't wait to see you!

LEARN MORE >

---

**New Hire Orientation**

Displays beginning one day before the new hire’s start date until their first day.

---

**New Hire Orientation**

We look forward to meeting you at New Hire Onboarding Orientation!

LEARN MORE >
Welcome to ServiceNow (After joining)
Displays beginning on the employee’s start date until the onboarding case is complete.

Welcome to ServiceNow!
LEARN MORE

Case Complete
Displays on the upper half of the Welcome screen after the onboarding case is complete.

Nicely done!
Your new hire onboarding is complete. Enjoy the rest of your journey.

Download the employee app
Displays on the lower half of the Welcome screen after the onboarding case is complete.

Download the employee app
Get help with anything at work, access the Knowledge Base and search the Employee Directory
INSTALL

Procedure
1. Navigate to System Mobile > Applet Launcher.
2. Open the Onboarding Homepage record.
3. In the Body related list, open a media section record.
4. Configure the media section.
   You can personalize the headline, text, image/video, or function instance.
   
   - Headline
   - Text
   - Image or video
   - Function instance

   **Note:** You can personalize the label and configure the associated function. To learn more about how to configure functions, see Functions in ServiceNow mobile.

5. Click **Update**.

### Enable Agent Chat in mobile onboarding

Activate the Chat quick action so that your new hires can chat with a live or virtual agent from mobile onboarding.

**Before you begin**

Make sure that live and/or virtual chat are set up for use in the Employee Service Center.

- Employee live chat overview
- Virtual Agent for HR Service Delivery

**Role required:** sn_hr_le.admin

**Procedure**

1. Navigate to **System Mobile > Applet Launchers**.

2. Open the **Onboarding Homepage** record.

3. In the Body related list, under the Quick Actions Menu Maps section, open the **Chat** record.
4. Select the **Active** option to activate the quick action for use.

5. Click **Update**.

**Mobile Onboarding**

Enable your new hires to complete onboarding tasks, receive targeted mobile content and push notifications, view relevant media sections, chat with an agent, and more using the Mobile Onboarding app.

**Key features**

**Note:**

The Mobile Onboarding is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the **Now Mobile app for HR Service Delivery**.
Mobile Onboarding app

- Complete onboarding tasks
- Receive mobile content and push notifications
- View relevant media sections
- Chat with an agent
Complete onboarding tasks

New hires can complete their onboarding tasks from anywhere, such as taking their employee badge photo, signing electronic documents, and setting up direct deposit.
New hires can receive targeted mobile content (banners, text cards, and videos) and push notifications. See Configure mobile content and Configure mobile push notification content for configuration details for content delivery or for use in campaigns.
New hires can view relevant media sections at different stages of the onboarding process. For example, new hires can learn more about their upcoming orientation or have the option to download the Now Mobile app after onboarding is complete. You can configure the different media sections to personalize them to your organization. See Configure a media section for mobile onboarding for further information.

**Note:** Beginning in the Paris release, media sections are not enabled by default for new customers.
Chat with an agent

If enabled, employees can chat with a live or virtual agent. See Enable Agent Chat in mobile onboarding for configuration details.

**Note:** Chat can be initiated from any screen in the mobile app, except for list screens.

<table>
<thead>
<tr>
<th>Done</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi, I'm your NOW Virtual Agent. Let me know how I can help you today.</td>
<td></td>
</tr>
<tr>
<td>What's your issue or request? Or take a look at what I can help with.</td>
<td></td>
</tr>
<tr>
<td>Benefits Overview</td>
<td></td>
</tr>
<tr>
<td>I found some information on benefits available to you. Which type of benefits are you most interested in?</td>
<td></td>
</tr>
<tr>
<td>Retirement and Savings</td>
<td></td>
</tr>
<tr>
<td>Benefits Overview</td>
<td></td>
</tr>
<tr>
<td>and wellness supplemental services, view our benefits portal.</td>
<td></td>
</tr>
<tr>
<td>Finance &amp; Retirement  We not only want more on what you have available to you.</td>
<td></td>
</tr>
<tr>
<td>Retirement and 401(k)  Life, Accident, and Disability Insurance  Health</td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td></td>
</tr>
</tbody>
</table>

Activation information

Mobile Onboarding is automatically activated when you activate Enterprise Onboarding and Transitions. If it is not activated, you can manually activate Mobile Onboarding.

Activate Mobile Onboarding

You can activate the Human Resources Scoped App: Mobile Employee Onboarding plugin (com.sn_hr_onboarding) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin

Role required: admin

About this task

**Note:**

The Mobile Onboarding is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the Now Mobile app for HR Service Delivery."
Human Resources Scoped App: Mobile Employee Onboarding activates these related plugins if they are not already active.

### Plugins for Human Resources Scoped App: Mobile Employee Onboarding

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow Mobile Request Native Application Screens and Applet Launcher [com.glide.mobile-employee]</td>
<td>This plugin contains the application and configurations required to setup the ServiceNow Mobile Request Native Application.</td>
</tr>
</tbody>
</table>

### Procedure

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Components installed with Mobile Onboarding

Several types of components install with the activation of the Mobile Onboarding plugin, including user roles.

**Note:**

The Mobile Onboarding is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the [Now Mobile app for HR Service Delivery](#).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

Demo data is available for this feature.

**Note:** The Human Resources Scoped App: Mobile Employee Onboarding [com.sn_hr_onboarding] plugin activates the sn_hr_onboarding.min_admin_count system property [sys_properties.list]. This property prevents you from deleting your only Mobile Onboarding admin user by requiring a minimum number (default is two) of active users with this role.

### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Onboarding admin</td>
<td>• None</td>
<td></td>
</tr>
</tbody>
</table>
Domain separation and HR Service Delivery

Domain separation is supported in HR Service Delivery. The ServiceNow® HR Service Delivery application improves the employee service experience by automating HR interactions and providing a single platform for all HR services. Domain separation separates data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic*

- There is business logic to ensure data goes into the proper domain for the application’s service provider use cases.
- In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all consider domain at run time.
- The owner of the instance needs to be able to set up the application to function normally across multiple tenants.

Use case: As a service provider when I use chat to respond to a tenant-customer’s message, the client must be able to see my response.

Overview

Domain separation is best for customers who:

- Enforce absolute data segregation between business entities (data separation).
- Customize business process definitions and user interfaces for each domain (delegated administration).
- Maintain some global processes and global reporting in a single instance.

These users can choose to expand or collapse the domain scope to show or hide data from other domains. For example, vendor data from Vendor A can be separated from the vendor data of other vendors. Each vendor using the HR Service Delivery application can have separate data that cannot be shared with other vendors.

Note: Users always have access to data from domains that have been explicitly granted to them by domain visibility.

How domain separation works in HR Service Delivery

- While HR Service Delivery supports separation of data, separation of logic and process is not fully supported.
- When working in a domain-separated implementation, ensure that records are created at the right domain level so that it is visible to the right set of users.

For example, domains that look like:

- Global
  - TOP
    - Domain A
    - Domain B
For users to access an HR case in domains A and B, the HR case should be created at the global level. If the HR case is created in Domain B, you cannot access it in Domain A due to indexing.

For an HR case to be visible to users in TOP and Domain A, create the HR case in Domain A.

- Unless the HR cases are in the Global domain, users should not assign HR cases in a higher domain to users in a lower domain. Users in Domains A or B do not have access to the control.

**Use case: domain separation in HR Service Delivery**

Vendor data for Vendor A can be separated from Vendor B. Each vendor using the HR Service Delivery application can have separate data that cannot be shared with other vendors.

By default, domain separation adds a domain field to the Task [task] and Configuration Items [cmdb_ci] tables and their extensions.

You can extend domain separation to any new tables you create by adding a `sys_domain` field to the dictionary table definition. By default, the system-only domain separates platform and baseline application tables where appropriate.

**Warning:** Do not domain-separate platform tables (sys_prefix) or Dictionary Entry Override [sys_dictionary_override] tables. Doing so can produce unexpected results.

In this use case, client scripts, business rules, workflows, processes, and so on, can be domain-separated.

While the behavior offered with domain separation provides multi-tenancy support, multi-tenancy is still contained within a single instance. Some global properties, some global data, and some global processes are shared across all domains. For example, the system’s “Remember me” option on the login page is global and cannot be specified per domain.

If a complete and total separation of all system properties is needed and does not require global reporting or global processes, separate instances are the best option.

**Use case: domain separation in Lifecycle Events**

Activity Sets set up in a parent domain and shared by children domains. For example:

- Parent Domain:
  - P

- Child domains:
  - Q
  - R

When an Activity Set is created for the Parent Domain P, it is available to Q and R.

Activity Sets that are created in Q and R are not available to P or each other.

To learn more about domain separation, see [Understanding domain separation](#).

**Quick start tests for HR Service Delivery**

Validate the continued functionality of HR Service Delivery after any configuration change such as an upgrade or after developing an application. Copy and customize these quick start tests to pass when using your instance-specific data.
All test suites and tests should pass on a default implementation. To validate a custom implementation, copy the automated tests and configure them for your customizations.

Quick start tests are disabled and read-only test templates. By default, they only produce a pass result when you run them with the default demo data that is provided with the application or feature plugin.

To make quick start tests produce a pass result when you run them with your instance-specific data, copy and configure them to use your instance data.

The Agile Development 2.0 plugin (com.snc.sdlc.agile.2.0) and the Agile Development 2.0 - ATF Tests (com.snc.sdlc.agile.2.0.atf) plugins must be enabled.

⚠️ Note: When running, demo data is required.

### HR Service Delivery case tests

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR: Case updates visible to employees</td>
<td>Cases created and updated by an HR agent are visible to the Opened for or Subject person</td>
<td>Quebec</td>
</tr>
<tr>
<td>HR: Creation of 401k enrollment case from portal</td>
<td>Creates a 401(k) enrollment case from the Employee Service Center portal. Verifies that the case creates successfully.</td>
<td>Madrid</td>
</tr>
<tr>
<td>HR: Creation of Employee Relations case from ESC portal</td>
<td>Creates a Disciplinary Issue case from the Employee Service Center portal. Verifies that the case creates successfully.</td>
<td>New York</td>
</tr>
<tr>
<td>HR: Creation of Employment Verification Letter case from ESC portal</td>
<td>Creates an Employment Verification Letter case from the Employee Service Center. Verifies that the case creates successfully.</td>
<td>Madrid</td>
</tr>
<tr>
<td>HR: Creation of Payroll case from ESC portal</td>
<td>Creates a direct deposit payroll setup case from the Employee Service Center or service portal. Verifies that the case creates successfully.</td>
<td>New York</td>
</tr>
<tr>
<td>HR: Creation of Tuition Reimbursement request from portal</td>
<td>Creates a Tuition Reimbursement Request case from the Employee Service Center portal. Verifies that the case creates successfully.</td>
<td>Madrid</td>
</tr>
<tr>
<td>HR: General Benefits Inquiry Case Creation</td>
<td>Creates a General Benefits case using the native UI.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
## HR Service Delivery case tests (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR: Fulfillment Instructions</td>
<td>It also verifies that the case opens and can be updated after case creation.</td>
<td></td>
</tr>
<tr>
<td>HR: Fulfillment Instructions</td>
<td>Verifies that fulfillment instructions are created for a specific condition for an opened case.</td>
<td>Orlando</td>
</tr>
<tr>
<td>HR: Fulfillment Instructions</td>
<td>Also verifies the fulfillment instructions change when the details of the case changes.</td>
<td></td>
</tr>
<tr>
<td>HR: Fulfillment Instructions conditions for COE specific fields</td>
<td>Verifies the conditions for COE specific fulfillment instruction. Fulfillment instructions update on an HR case based on the conditions defined in the fulfillment instructions.</td>
<td>Quebec</td>
</tr>
<tr>
<td>HR LifeCycle: Trigger Rescind Workflow</td>
<td>Creates a Payroll Discrepancy case using the native UI. It also verifies that the case opens and can be updated after case creation.</td>
<td>Quebec</td>
</tr>
<tr>
<td>HR: Payroll Discrepancy Case Creation</td>
<td>Creates a Payroll Discrepancy case using the native UI. It also verifies that the case opens and can be updated after case creation.</td>
<td>Madrid</td>
</tr>
<tr>
<td>HR: Reclassify Case Transfer</td>
<td>Tests when an HR case transfers from one COE (HR service) to a different COE using the reclassify (HR case number remains the same) method.</td>
<td>Orlando</td>
</tr>
<tr>
<td>HR: Response Template Configuration</td>
<td>Creates a response template for a payroll case and pastes the response in the worknotes.</td>
<td>Quebec</td>
</tr>
<tr>
<td>HR: Search catalog items &amp; KBs in ESC</td>
<td>Verifies the search functionality in the Employee Service Center.</td>
<td>Orlando</td>
</tr>
<tr>
<td>HR: Standard Case Transfer</td>
<td>Tests an HR case transfers from one COE (HR service) to a different COE using the standard (creates HR case number and deletes old number) case transfer.</td>
<td>Orlando</td>
</tr>
<tr>
<td>HR: Tuition Reimbursement Case Creation</td>
<td>Creates a Tuition Reimbursement HR case.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
**HR Service Delivery case tests (continued)**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR: Workforce Administration Case Creation</td>
<td>Creates a Workforce Administration case, signs an employee verification letter, and generates the letter.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create HR Employee Document</td>
<td>Creates an employee document and ensures the Attachment [sys_attachment] table points back to the record in the Employee Document [sn_hr_ef_employee_document] table. Verifies that the employee document is accessible from the Employee Service Center via the employee HR profile.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Note:** Requires the following plugin activation:
- Human Resources Scoped App: Core [com.sn_hr_core]
- Employee Service Center [com.sn_hr_service_portal]

**ESC: Employee Service Center tests**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC: Employee can see ticket updates</td>
<td>Employees can view updates to their tickets.</td>
<td>Quebec</td>
</tr>
<tr>
<td>ESC: Post General HR Inquiry questions on ESC portal</td>
<td>Verifies an HR employee can create a General Inquiry case and post general HR inquiry questions on the ESC.</td>
<td>Quebec</td>
</tr>
<tr>
<td>ESC: Submit a Record Producer which crates Universal Request and HR Case</td>
<td>Verifies a user can submit an HR catalog item that creates a Universal Request. Also verifies the Universal Request and HR case are created and linked.</td>
<td>Quebec</td>
</tr>
<tr>
<td>ESC: Verify Standard Ticket page on ESC for HR Case</td>
<td>Creates a general inquiry case from the service portal and verifies it appears on the standard Ticket page.</td>
<td>Quebec</td>
</tr>
<tr>
<td>ESC: Verify widget contents in Catalog items</td>
<td>Verifies the widget content in a Catalog page.</td>
<td>Orlando</td>
</tr>
<tr>
<td>ESC: Verify widget contents in knowledge pages</td>
<td>Verifies the widget content in a Knowledge page.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
ESC: Employee Service Center tests (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR: Search catalog items &amp; KBs in ESC</td>
<td>Verifies the search functionality in the ESC.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Note:** Requires the following plugin activation:
- Human Resources Scoped App: Core [com.sn_hr_core]
- Employee Service Center [com.sn_hr_service_portal]

Content Delivery: Content Delivery tests

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Delivery: Audience</td>
<td>Tests the audience configurations for Content Delivery.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Content Delivery: Schedule Portal Content</td>
<td>Creates and schedules test content for the Content Delivery demo portal.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Note:** Requires the following plugin activation:
- Human Resources Scoped App: Core [com.sn_hr_core]
- Employee Service Center [com.sn_hr_service_portal]
- Content Delivery [com.sn_content_delivery]

Content Automation: Content Automation tests

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Automation: Create and Publish a Campaign</td>
<td>Creates and publishes a campaign with portal content and verifies against the Content Delivery portal.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Note:** Requires the following plugin activation:
- Human Resources Scoped App: Core [com.sn_hr_core]
- Employee Service Center [com.sn_hr_service_portal]
- Content Automation [com.sn_content_automation]

Lifecycle Events: Tests for verifying Lifecycle Events

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Lifecycle: Access Ticket page for a NewHire Onboarding Case in Employee Service Center</td>
<td>Verifies creation of a new hire and can access the Ticket page of the Employee Service Center.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
### Lifecycle Events: Tests for verifying Lifecycle Events (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HR Lifecycle: Access ESC ticket page and todos page and complete assigned todos</strong></td>
<td>Creates a Tuition Reimbursement Request case from Employee Service Center and the Complete NDA to-do from the subject person.</td>
<td>Orlando</td>
</tr>
<tr>
<td><strong>HR LifeCycle: Request Onboarding Case Creation</strong></td>
<td>Creates a Request Onboarding case using the native UI and updates the case after creation.</td>
<td>Madrid</td>
</tr>
<tr>
<td><strong>HR Lifecycle: Trigger Rescind Workflow</strong></td>
<td>Triggers the Rescind workflow for a New Hire Onboarding Lifecycle Event case.</td>
<td>Quebec</td>
</tr>
<tr>
<td><strong>HR Lifecycle: Verify Requests page for Open and Closed cases</strong></td>
<td>Verifies open and closed cases on the Requests page.</td>
<td>Orlando</td>
</tr>
<tr>
<td><strong>HR Lifecycle: Verify search in Requests Page</strong></td>
<td>Verifies the search functionality on the Requests page for open and closed cases.</td>
<td>Orlando</td>
</tr>
<tr>
<td><strong>Configure HR Service for Auto Case Closure</strong></td>
<td>Verifies that Lifecycle event cases are automatically closed.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Note:** Requires the following plugin activation:
- Human Resources Scoped App: Core [com.sn_hr_core]
- Employee Service Center [com.sn_hr_service_portal]
- Human Resources Scoped App: Lifecycle Events [com.sn_hr_lifecycle_events]
- Human Resources Scoped App: Lifecycle Events for Enterprise [com.sn_hr_lifecycle_ent]

### KB: Knowledge block tests

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create knowledge block and attach block to article</strong></td>
<td>Creates a knowledge block, publishes the block, and attaches the block to a knowledge article.</td>
<td>New York</td>
</tr>
<tr>
<td><strong>Preview Knowledge Articles with Knowledge Blocks</strong></td>
<td>Tests for preview of knowledge article that contains knowledge blocks.</td>
<td>New York</td>
</tr>
</tbody>
</table>

**Note:** Requires the following plugin activation:
- Human Resources Scoped App: Core [com.sn_hr_core]
Run quick start tests for HR
The base HR application provides several Automated Test Frameworks tests you can run.

Before you begin
Role required: sn_hr_core.admin, admin, atf_test_admin, atf_test_designer

Procedure
1. Navigate to Automated Test Framework > Tests.
2. Search and select ATF tests that start with HR. See Quick start tests for HR Service Delivery for available ATF tests.
3. Click Run Test.
   The Test Steps tab provides each step of the ATF test.
   After the tests run, the Step Results tab shows the status of each test step. Screenshots also appear at the top of the form as attachments.

Migration from Legacy to Scoped HR
You can migrate your HR data and roles from the legacy (non-scoped) to the scoped version of HR Service Delivery with the assistance of the HR Migration tool. Scoping encapsulates HR data so that HR administrators can better protect sensitive information. All future development of HR features and functionality will be made to the scoped version.

Migrate HR data and roles
The HR Migration tool can be run multiple times to:

- Migrate HR data to scoped
- Migrate HR roles to scoped

Not included in the migration
- HR cases
- HR services, HR templates, record producers, and catalog items
- Workflows
- Integrations
- Dashboards and reports
- Scripting (business rules, client scripts, data policies, UI actions, UI policies, and so on)
- Custom apps

Activation information
Make sure that both the non-scoped and scoped versions of HR are activated, and then Activate HR Migration. For information on what components are installed with the application, see Components installed with HR Migration.

Activate HR Migration
You can activate Human Resources Scoped App: Data Migration [com.sn_hr_migration] if you have the admin role.
Before you begin
Make sure that both the non-scoped and scoped versions of HR are activated:

- HR Core:
  - Human Resources Application: Core [com.snc.hr.core]
  - Human Resources Scoped App: Core [com.sn_hr_core]

- HR Service Portal (if applicable):
  - Human Resources Application: Service Portal [com.snc.hr.service_portal]
  - Human Resources Scoped App: Service Portal [com.sn_hr_service_portal]

Note: Activating the scoped version will add a -Legacy suffix to all of the non-scoped applications and modules in your instance.

Role required: admin

About this task
Human Resources Scoped App: Data Migration allows you to migrate HR tables and roles from the non-scoped to the scoped version of HR.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with HR Migration
Several types of components are installed with activation of the HR Migration plugin, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| HR migration administrator [sn_hr_migration.admin] | Can access and configure the HR Migration application. | • sn_hr_core.admin
• hr_admin |
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migration Pre Run [sn_hr_migration_pre_run]</td>
<td>Table of migration pre runs.</td>
</tr>
<tr>
<td>HR Choice List Mapping [sn_hr_migration_choice_list]</td>
<td>Table of HR choice list mappings.</td>
</tr>
<tr>
<td>Migration Column [sn_hr_migration_column]</td>
<td>Table of migration columns.</td>
</tr>
<tr>
<td>HR Entity Mapping [sn_hr_migration_entity_mapping]</td>
<td>Table of HR entity mappings.</td>
</tr>
<tr>
<td>Migration Pre Result [sn_hr_migration_pre_result]</td>
<td>Table of migration pre results.</td>
</tr>
<tr>
<td>HR Records Failed [sn_hr_migration_records_failed]</td>
<td>Table of HR records failed.</td>
</tr>
<tr>
<td>Migration Result [sn_hr_migration_result]</td>
<td>Table of migration results.</td>
</tr>
<tr>
<td>Migration HR Roles [sn_hr_migration_role]</td>
<td>Table of migration HR roles.</td>
</tr>
<tr>
<td>Roles Migration Run [sn_hr_migration_roles_run]</td>
<td>Table of roles migration run.</td>
</tr>
<tr>
<td>Migration Run [sn_hr_migration_run]</td>
<td>Table of migration runs.</td>
</tr>
<tr>
<td>Migration Table [sn_hr_migration_table]</td>
<td>Table of migration tables.</td>
</tr>
</tbody>
</table>

Migrate HR data to scoped

HR data migration is a three-part process that requires verification, mapping, and migration.

Procedure

1. Verify that all the base data (tables) are correctly mapped to their scoped counterparts.
2. If there are changed or custom HR tables in the non-scoped version that you want to migrate to scoped, update or add them for mapping.
3. Migrate the data.
   Ensure that there are no duplicate entries/records in the target table before you start the migration process. For example, the HR Profile [sn_hr_core_profile] table rejects duplicate profiles for the same users. The target tables do not have to be clean, but any records already there are not migrated.
Verify mapping of base HR data

In the non-scoped version of HR, there are up to 26 base tables that are automatically mapped for migration to scoped. These tables have default columns and choice lists that are also automatically mapped for migration.

Before you begin
Role required: sn_hr_migration.admin
By default, all base tables (and their corresponding columns and choice lists) should map automatically. You can verify that the mapping is correct.

Procedure
1. Verify that the base tables are correctly mapped to scoped.

   a. Navigate to HR Migration > Data Mapping > Table Mapping.

   b. In the Migration Tables list, verify that the base tables are correctly mapped to their scoped counterparts.

   Note: Some of the non-scoped tables are merged into a single scoped table.

   • If you have HR Core only:

   Base and target tables for HR Core only

<table>
<thead>
<tr>
<th>Global HR table</th>
<th>Scoped HR table</th>
</tr>
</thead>
<tbody>
<tr>
<td>hr_document_acknowledgement</td>
<td>sn_hr_core_document_acknowledgement</td>
</tr>
<tr>
<td>hr_document_template</td>
<td>sn_hr_core_document_template</td>
</tr>
<tr>
<td>hr_emergency_contact</td>
<td>sn_hr_core_contact</td>
</tr>
<tr>
<td>hr_link</td>
<td>sn_hr_core_link</td>
</tr>
<tr>
<td>hr_m2m_link_template_lookup</td>
<td>sn_hr_core_m2m_link_template</td>
</tr>
<tr>
<td>hr_position</td>
<td>sn_hr_core_position</td>
</tr>
<tr>
<td>hr_profile</td>
<td>sn_hr_core_profile</td>
</tr>
</tbody>
</table>

   • If you have HR Core and HR Service Portal:

   Base and target tables for HR Core and HR Service Portal

<table>
<thead>
<tr>
<th>Global HR table</th>
<th>Scoped HR table</th>
</tr>
</thead>
<tbody>
<tr>
<td>hr_bank_account</td>
<td>sn_hr_core_profile_bank_account</td>
</tr>
<tr>
<td>hr_beneficiary</td>
<td>sn_hr_core_beneficiary</td>
</tr>
<tr>
<td>hr_benefit_provider</td>
<td>sn_hr_core_benefit_provider</td>
</tr>
<tr>
<td>hr_benefit_type</td>
<td>sn_hr_core_benefit_type</td>
</tr>
<tr>
<td>hr_dental_benefit</td>
<td>sn_hr_core_health_benefit</td>
</tr>
<tr>
<td>hr_direct_deposit</td>
<td>sn_hr_core_direct_deposit</td>
</tr>
<tr>
<td>hr_disability_benefit</td>
<td>sn_hr_core_disability_benefit</td>
</tr>
<tr>
<td>hr_document_acknowledgement</td>
<td>sn_hr_core_document_acknowledgement</td>
</tr>
</tbody>
</table>
2. Verify that the base columns are correctly mapped to scoped.
   a. Navigate to **HR Migration > Data Mapping > Column Mapping**.
   b. Right-click the **Migration table** column and select **Group By Migration table**.
   c. For each table, click the arrow to expand the list of elements in that group. Verify that the base columns are correctly mapped to their scoped counterparts.

3. Verify that the base choice lists are correctly mapped to scoped.
   a. Navigate to **HR Migration > Data Mapping > Choice List Mapping**.
   b. Right-click the **Global column name** column and select **Group By Global column name**.
   c. For each column, click the arrow to expand the list of elements in that group. Verify that the choice lists are correctly mapped to their scoped counterparts.

Ensure that there are no duplicate entries/records in the target table before you start the migration process. For example, the HR Profile [sn_hr_core_profile] table rejects duplicate profiles for the same users. The target tables do not have to be clean, but any records already there are not migrated.

**What to do next**
If you have changed or custom HR data that you want to migrate to scoped, map this data. Otherwise, you can begin migrating your HR data.

**Map changed or custom HR data**
If you changed any of the base tables or created custom HR tables that you want to migrate to scoped, you can update or manually add them for mapping. For changed or custom HR columns and choice lists, you can update or add them as well.
Before you begin
For custom tables, columns, and choice lists, create the target equivalent in the scoped version of HR. See Create a table.
Role required: sn_hr_migration.admin

Procedure
1. Update or add your changed or custom HR tables.
   a. Navigate to HR Migration > Data Mapping > Table Mapping.
   b. Click New or open a record.
   c. Fill in the fields on the form.

   **Migration Table form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global table name</td>
<td>Name of the global migration table.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the global migration table. Only active tables are</td>
</tr>
<tr>
<td></td>
<td>migrated when data migration runs.</td>
</tr>
<tr>
<td>Scoped table name</td>
<td>Name of the scoped target table.</td>
</tr>
<tr>
<td>Order</td>
<td>Order number for when data migration runs. Lower numbered tables are</td>
</tr>
<tr>
<td></td>
<td>migrated before higher numbered tables.</td>
</tr>
</tbody>
</table>
   d. Click Submit or Update.

2. Update or add your changed or custom HR columns.
   a. Navigate to HR Migration > Data Mapping > Column Mapping.
   b. Click New or open a record.
   c. Fill in the fields on the form.

   **Migration Column form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migration table</td>
<td>Name of the global migration table.</td>
</tr>
<tr>
<td>Global column name</td>
<td>Name of the global column.</td>
</tr>
<tr>
<td>Global column label</td>
<td>Label of the global column.</td>
</tr>
<tr>
<td>Global column data type</td>
<td>Data type of the global column.</td>
</tr>
<tr>
<td>Global column maximum length</td>
<td>Maximum length of the global column.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select if a custom script will be used to perform the migration.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active status for the global column. Only active columns are migrated when data migration runs.</td>
</tr>
<tr>
<td>Scoped column name</td>
<td>Name of the scoped target column.</td>
</tr>
<tr>
<td>Scoped column label</td>
<td>Label of the scoped target column.</td>
</tr>
<tr>
<td>Scoped column data type</td>
<td>Data type of the scoped target column.</td>
</tr>
<tr>
<td>Scoped column maximum length</td>
<td>Maximum length of the scoped target column.</td>
</tr>
<tr>
<td>Has Choice</td>
<td>Select if the column has a choice list.</td>
</tr>
</tbody>
</table>

**d.** Click **Submit** or **Update**.

**3.** Update or add your changed or custom HR choice lists.

**a.** Navigate to **HR Migration > Data Mapping > Choice List Mapping**.

**b.** Click **New** or open a record.

**c.** Fill in the fields on the form.

### Migration Choice List form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migration column</td>
<td>Name of the global migration column.</td>
</tr>
<tr>
<td>Global choice name</td>
<td>Name of the global choice list.</td>
</tr>
<tr>
<td>Global choice value</td>
<td>Value of the global choice list.</td>
</tr>
<tr>
<td>Active</td>
<td>Active status for the global migration choice list. Only active choice lists are migrated when data migration runs.</td>
</tr>
<tr>
<td>Scoped choice name</td>
<td>Name of the scoped target choice list.</td>
</tr>
<tr>
<td>Scoped choice value</td>
<td>Value of the scoped choice list.</td>
</tr>
</tbody>
</table>

**d.** Click **Submit** or **Update**.

### What to do next

After you map all your changed or custom HR data, migrate it.

### Migrate HR data

After you complete your data mapping, migrate your HR data from the non-scoped to the scoped version of HR.

### Before you begin

Make sure that HR data mapping for your tables, columns, and choice lists is complete.

Role required: sn_hr_migration.admin
Procedure
1. Navigate to HR Migration > Data Migration.
3. After the Pre Migration report generates. Click Close.
4. Under Run ID, click the report.
   The Migration Pre Run record displays. In the Migration Pre Results section, a list of changes to the tables, columns, and choice lists displays.
5. Apply or skip the changes for migration.
   • To apply the changes for migration, select the check boxes for the applicable rows, and then select Apply as the action.
   • To skip the changes for migration, select the check boxes for the applicable rows, and then select Skip as the action.
6. Click Apply Schema Changes.
7. The Apply Schema Confirmation form displays. Click Confirm.
8. After the schema update completes, click Close.
9. Click Start Migration.
   A list of the HR tables to be migrated displays.
10. Migrate the tables one at a time or in automatic succession.
    • To migrate the tables individually, click Migrate.
    • To automatically migrate the tables in succession, click Migrate All.

What to do next
If there is more changed or custom HR data that needs to be migrated, you can run the verification, mapping, and migration process again. Otherwise, HR data migration is complete.

Migrate HR roles to scoped
HR roles migration is a three-part process that requires verification, mapping, and migration.

Procedure
1. Verify that all the base HR roles are correctly mapped to their scoped counterparts.
2. If there are changed or custom HR roles in the non-scoped version that you want to migrate to scoped, update or add them for mapping.
3. Migrate the roles.

Verify mapping of base HR roles
In the non-scoped version of HR, there are 20 base roles that are automatically mapped for migration to scoped. By default, all base roles should map automatically. You can verify that the mapping is correct.

Before you begin
Role required: sn_hr_migration.admin
Procedure

1. Navigate to HR Migration > Data Mapping > Role Mapping.

2. In the Migration HR Roles list, verify that the base roles are correctly mapped to their scoped counterparts.

⚠ Note: Some of the non-scoped roles are merged into a single scoped role.

### Base and target roles

<table>
<thead>
<tr>
<th>Global HR role</th>
<th>Scoped HR role</th>
</tr>
</thead>
<tbody>
<tr>
<td>hr_admin</td>
<td>sn_hr_core.admin</td>
</tr>
<tr>
<td>hr_assignment_reader</td>
<td>sn_hr_core.case_reader</td>
</tr>
<tr>
<td>hr_assignment_writer</td>
<td>sn_hr_core.case_writer</td>
</tr>
<tr>
<td>hr_basic</td>
<td>sn_hr_core.basic</td>
</tr>
<tr>
<td>hr_case_reader</td>
<td>sn_hr_core.case_reader</td>
</tr>
<tr>
<td>hr_case_writer</td>
<td>sn_hr_core.case_writer</td>
</tr>
<tr>
<td>hr_director</td>
<td>sn_hr_case.manager</td>
</tr>
<tr>
<td>hr_disciplinary_case_agent</td>
<td>sn_hr.core.case_writer</td>
</tr>
<tr>
<td>hr_generalist</td>
<td>sn_hr.core.case_writer</td>
</tr>
<tr>
<td>hr_kb_writer</td>
<td>sn_hr_core.kb_writer</td>
</tr>
<tr>
<td>hr_manager</td>
<td>sn_hr_core.manager</td>
</tr>
<tr>
<td>hr_payroll</td>
<td>sn_hr_core.case_writer</td>
</tr>
<tr>
<td>hr_position_writer</td>
<td>sn_hr_core.secure_info_writer</td>
</tr>
<tr>
<td>hr_profile_reader</td>
<td>sn_hr_core.profile_reader</td>
</tr>
<tr>
<td>hr_profile_writer</td>
<td>sn_hr_core.secure_info_writer</td>
</tr>
<tr>
<td>hr_read</td>
<td>sn_hr_core.case_reader</td>
</tr>
<tr>
<td>hr_recruiting</td>
<td>sn_hr_core.case_writer</td>
</tr>
<tr>
<td>hr_specialist</td>
<td>sn_hr_core.case_writer</td>
</tr>
<tr>
<td>hr_task_reader</td>
<td>sn_hr_core.case_reader</td>
</tr>
<tr>
<td>hr_task_writer</td>
<td>sn_hr_core.case_writer</td>
</tr>
</tbody>
</table>

### What to do next

If you have changed or custom HR roles that you want to migrate to scoped, you can map them. Otherwise, you can begin migrating your HR roles.

### Map changed or custom HR roles

If you made changes to any of the base roles or created custom HR roles that you want to migrate to scoped, you can update or manually add them for mapping.

### Before you begin

For custom roles, create the target equivalent in the scoped version of HR. See Create a role.

Role required: sn_hr_migration.admin
Procedure
1. Navigate to HR Migration > Data Mapping > Role Mapping.
2. Click New or open a record.
3. Fill in the fields on the form.

Migration HR Roles form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global HR role</td>
<td>Name of the global HR role.</td>
</tr>
<tr>
<td>Scoped HR role</td>
<td>Name of the scoped HR role.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the global HR role. Only active roles are migrated when data migration runs.</td>
</tr>
</tbody>
</table>

4. Click Submit or Update.

What to do next
After you map all your changed or custom HR roles, migrate them.

Migrate HR roles
After you complete mapping your HR roles, migrate them from the non-scoped to the scoped version of HR.

Before you begin
Make sure that HR roles mapping is complete.
Role required: sn_hr_migration.admin

Procedure
1. Navigate to HR Migration > Data Migration.
2. Verify all roles are correctly mapped, and then click Migrate Roles.

What to do next
If there are more changed or custom HR roles that need to be migrated, you can run the verification, mapping, and migration process again. Otherwise, HR roles migration is complete.

HR Service Delivery Legacy
Welcome to the legacy (non-scoped) version of HR Service Delivery. This version is only available for customers that went live with HR in Helsinki or earlier. Beginning with Istanbul, new features and functionality are no longer supported and require migration to the scoped version of HR.

With HR Service Delivery Legacy, you deploy:

**HR Service Management Legacy**
HR Service Management Legacy allows you to standardize the documentation, interaction, and fulfillment of employee inquiries and requests.

You can also deploy:

**HR Service Portal Legacy**
HR Service Portal Legacy provides a single place for employees to quickly and easily get all the HR services they need.

You can also deploy the following supporting application:

- **HR Performance Analytics Legacy** measures key performance indicators to track HR performance over time. It requires a separate premium subscription to the Performance Analytics application.

**HR Service Management Legacy**

The HR Service Management application allows you to standardize the documentation, interaction, and fulfillment of employee inquiries and requests in the legacy (non-scoped) version of HR.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Understanding HR Service Management Legacy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- HR Service Portal Legacy</td>
<td>- Activate HR Service Management Legacy</td>
<td>- HR Administration for legacy HR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>- HR Case Management for legacy HR</td>
<td>- Developer training</td>
<td>- HR Performance Analytics Legacy</td>
</tr>
<tr>
<td></td>
<td>- Developer documentation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Installed with HR Service Management Legacy</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Migrate</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Migration from Legacy to Scoped HR</td>
<td>- Ask or answer questions in the Human Resources community</td>
</tr>
<tr>
<td></td>
<td>- Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td></td>
<td>- Contact Customer Service and Support</td>
</tr>
</tbody>
</table>

**Activate HR Service Management Legacy**

You can activate Human Resources Application: Core [com.snc.hrc.core] for the non-scoped version of HR if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Human Resources Application: Core provides basic HR features.

**Procedure**

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see *Request a plugin*. 
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Installed with HR Service Management Legacy**

Several types of components are installed with HR Service Management in the non-scoped version of HR.

**Tables installed with HR Service Management Legacy**

Human Resources Application: Core plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Case Model</td>
<td>The product models used for HR case record producers.</td>
</tr>
<tr>
<td>[cmdb_hr_case_product_model]</td>
<td></td>
</tr>
<tr>
<td>HR Task Model</td>
<td>The product models used for HR task record producers.</td>
</tr>
<tr>
<td>[cmdb_hr_task_product_model]</td>
<td></td>
</tr>
<tr>
<td>HR Assignment Data Lookup</td>
<td>The details of who HR cases can be assigned to.</td>
</tr>
<tr>
<td>[dl_hr_assignment]</td>
<td></td>
</tr>
<tr>
<td>HR Case</td>
<td>The details of a submitted HR case.</td>
</tr>
<tr>
<td>[hr_case]</td>
<td></td>
</tr>
<tr>
<td>HR Category</td>
<td>The categories that can be assigned to HR cases, used for assignment and reporting.</td>
</tr>
<tr>
<td>[hr_category]</td>
<td></td>
</tr>
<tr>
<td>HR Document Acknowledgement</td>
<td>Record that a preboarding employee has signed an online document.</td>
</tr>
<tr>
<td>[hr_document_acknowledgement]</td>
<td></td>
</tr>
<tr>
<td>HR Document Template</td>
<td>Templates for generating HR documents as PDF files in HR cases.</td>
</tr>
<tr>
<td>[hr_document_template]</td>
<td></td>
</tr>
<tr>
<td>HR Contact</td>
<td>The name and contact information for emergency contacts. The details of emergency contacts, displayed in the hr_profile record for a sys_user. Contains a reference to Profile [hr_profile].</td>
</tr>
<tr>
<td>[hr_emergency_contact]</td>
<td></td>
</tr>
<tr>
<td>Employment History</td>
<td>The details of employment history, displayed in the hr_profile record for a sys_user. Contains a reference to Profile [hr_profile].</td>
</tr>
<tr>
<td>[hr_employment_history]</td>
<td></td>
</tr>
<tr>
<td>Position</td>
<td>The job positions and a reference to the departments the positions are part of.</td>
</tr>
<tr>
<td>[hr_position]</td>
<td></td>
</tr>
<tr>
<td>HR Profile</td>
<td>The details of a profile for an employee that contains sensitive information.</td>
</tr>
<tr>
<td>[hr_profile]</td>
<td></td>
</tr>
<tr>
<td>HR Task</td>
<td>The details of a task associated with a particular HR case.</td>
</tr>
<tr>
<td>[hr_task]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Case Flow</td>
<td>The details of HR case state flows.</td>
</tr>
<tr>
<td>[sf_hr_case]</td>
<td></td>
</tr>
<tr>
<td>HR Task Flow</td>
<td>The details of HR task state flows.</td>
</tr>
<tr>
<td>[sf_hr_task]</td>
<td></td>
</tr>
<tr>
<td>HR link</td>
<td>The details of HR links.</td>
</tr>
<tr>
<td>[hr_link]</td>
<td></td>
</tr>
<tr>
<td>HR links for template lookup</td>
<td>The details of HR links for looking up templates.</td>
</tr>
<tr>
<td>[hr_m2m_link_template_lookup]</td>
<td></td>
</tr>
<tr>
<td>HR todo tasks for template lookup</td>
<td>The details of to-do tasks for looking up templates.</td>
</tr>
<tr>
<td>[hr_m2m_task_template_lookup]</td>
<td></td>
</tr>
<tr>
<td>Task templates</td>
<td>The details of looking up templates.</td>
</tr>
<tr>
<td>[hr_template_lookup]</td>
<td></td>
</tr>
<tr>
<td>Content Block Open Header</td>
<td></td>
</tr>
<tr>
<td>[content_block_open_header]</td>
<td></td>
</tr>
<tr>
<td>Signature Image</td>
<td>Contains images of captured signatures.</td>
</tr>
<tr>
<td>[signature_image]</td>
<td></td>
</tr>
</tbody>
</table>

**Tables for PDF generator**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Element</td>
<td>The formats used by the PDF generator that can be used to customize the template for the PDF document.</td>
</tr>
<tr>
<td>[general_elements]</td>
<td></td>
</tr>
<tr>
<td>General List</td>
<td>A list of the properties and query used to generate the PDF document, for example, the employment verification letter.</td>
</tr>
<tr>
<td>[general_list]</td>
<td></td>
</tr>
</tbody>
</table>

**Roles installed with HR Service Management Legacy**

Human Resources Application: Core plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR specialist hr_specialist</td>
<td>Can create and update HR cases.</td>
<td>• hr_case_writer</td>
</tr>
<tr>
<td>HR generalist hr_generalist</td>
<td>Can create and update HR cases.</td>
<td>• hr_case_writer</td>
</tr>
<tr>
<td>HR recruiter hr_recruiting</td>
<td>Can create and update HR cases.</td>
<td>• hr_specialist</td>
</tr>
<tr>
<td>HR payroll specialist hr_payroll</td>
<td>Can create and update HR cases.</td>
<td>• hr_specialist</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains Roles</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR manager hr_manager</td>
<td>Full control over all HR functions.</td>
<td>• All hr_basic roles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• survey_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_position_writer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_profile_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_case_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_task_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• catalog_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• skill_admin</td>
</tr>
<tr>
<td>Director of HR hr_director</td>
<td>Full control over all HR functions.</td>
<td>• hr_manager</td>
</tr>
<tr>
<td>Assignment rule reviewer</td>
<td>Can read HR assignment rules.</td>
<td>• None</td>
</tr>
<tr>
<td>hr_assignment_reader</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assignment rule updater</td>
<td>Can update HR assignment rules.</td>
<td>• hr_assignment_reader</td>
</tr>
<tr>
<td>hr_assignment_writer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HR system administrator hr_admin</td>
<td>Full control over all human resources data and can administer territories and skills.</td>
<td>• all HR roles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• territory_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• skill_model_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• survey_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• catalog_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• template_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• skill_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• knowledge_manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• assignment_rule_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• model_manager</td>
</tr>
<tr>
<td>HR agent hr_basic</td>
<td>Can create, update, and delete HR cases.</td>
<td>• document_management_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_case_writer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_kb_writer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_profile_writer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_task_writer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• skill_model_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• skill_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• survey_reader</td>
</tr>
<tr>
<td>HR case reviewer hr_case_reader</td>
<td>Can read HR cases and HR profiles.</td>
<td>• hr_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_profile_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_task_reader</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains Roles</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>HR agent hr_read</td>
<td>Can read and create HR cases.</td>
<td>• hr_profile_reader</td>
</tr>
<tr>
<td>HR case worker hr_case_writer</td>
<td>Can create and update HR cases.</td>
<td>• hr_case_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hr_task_writer</td>
</tr>
<tr>
<td>HR approver hr_approver_user</td>
<td>Can approve HR cases.</td>
<td>• approver_user</td>
</tr>
<tr>
<td>HR task reviewer hr_task_reader</td>
<td>Can view HR tasks.</td>
<td>• None</td>
</tr>
<tr>
<td>HR task worker hr_task_writer</td>
<td>Can create and update HR tasks.</td>
<td>• hr_task_reader</td>
</tr>
<tr>
<td>HR profile reviewer hr_profile_reader</td>
<td>Can read HR profiles.</td>
<td>• None</td>
</tr>
<tr>
<td>HR profile specialist hr_profile_writer</td>
<td>Can create and update HR profiles.</td>
<td>• hr_profile_reader</td>
</tr>
<tr>
<td>HR position specialist hr_position_writer</td>
<td>Can create, update, and delete HR position records.</td>
<td>• None</td>
</tr>
<tr>
<td>HR knowledge article writer hr_kb_writer</td>
<td>Can create and update HR knowledge articles.</td>
<td>• None</td>
</tr>
<tr>
<td>Content formatter [content_block_open_header_user] Can edit the HR Portal header.</td>
<td>• None</td>
<td></td>
</tr>
</tbody>
</table>

**User groups installed with HR Service Management Legacy**

Human Resources Application: Core plugin adds the following user groups.

<table>
<thead>
<tr>
<th>User group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR</td>
<td>Parent to other HR groups. It grants the HR manager role, and its child groups inherit the HR manager role.</td>
</tr>
<tr>
<td>HR Benefits</td>
<td>Group members administer HR benefits. Inherits the HR manager role.</td>
</tr>
<tr>
<td>HR Employee Relations</td>
<td>Group members administer employee relations.</td>
</tr>
<tr>
<td>HR Investigations</td>
<td>Group members investigate HR cases. Inherits the HR manager role.</td>
</tr>
<tr>
<td>HR Leadership</td>
<td>Group members manage HR teams. Inherits the HR manager role.</td>
</tr>
<tr>
<td>HR Payroll</td>
<td>Group members administer HR payroll. Inherits the HR manager role.</td>
</tr>
<tr>
<td>HR Recruiting</td>
<td>Group members perform recruiting and hiring activities.</td>
</tr>
<tr>
<td>User group</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Systems</td>
<td>Group members grant system access, perform system password resets, create system reports, and provide HR Service Portal</td>
</tr>
<tr>
<td>HR VIP Watchlist</td>
<td>Members of this group are added to the watchlist of HR cases for VIP users. No roles are granted.</td>
</tr>
</tbody>
</table>

**Script includes installed with HR Service Management Legacy**

Human Resources Application: Core adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneralHRForm</td>
<td>Implementation script for the HR employment verification letter.</td>
</tr>
<tr>
<td>hr</td>
<td>Container for commonly used values.</td>
</tr>
<tr>
<td>GenericHierarchyProcessor</td>
<td>Displays hierarchical data based on a parent child relationship.</td>
</tr>
<tr>
<td>hr_Case</td>
<td>Wrapper class for HR Case records.</td>
</tr>
<tr>
<td>hr_CaseAjax</td>
<td>Wrapper class for HR Case Ajax requests.</td>
</tr>
<tr>
<td>hr_Task</td>
<td>Wrapper class for HR Task.</td>
</tr>
<tr>
<td>hr_Profile</td>
<td>Wrapper class for HR Profile records.</td>
</tr>
<tr>
<td>hr_SysUser</td>
<td>Wrapper class for HR functionality on sys_user records.</td>
</tr>
<tr>
<td>hr_Utils</td>
<td>Generic functionality for the HR application.</td>
</tr>
<tr>
<td>hr_Configuration</td>
<td>Manages data reviewed by the HR Configuration option <strong>HR profile fields that users or managers can edit without HR approval</strong></td>
</tr>
<tr>
<td>hrUserAuthentication</td>
<td>Verifies that users have access to documents that they are being asked to acknowledge.</td>
</tr>
<tr>
<td>hr_AssignmentRulesSecurityManager</td>
<td>Wrapper for Assigned Rules security.</td>
</tr>
<tr>
<td>hr_KnowledgeSecurityManager</td>
<td>Wrapper class for HR Knowledge Base articles security.</td>
</tr>
<tr>
<td>hr_KnowledgeM2MSecurityManager</td>
<td>Wrapper class for Attached Knowledge related list security on hr_case form.</td>
</tr>
<tr>
<td>hr_EmergencyContactSecurityManager</td>
<td>Wrapper class for HR Profile Emergency Contact security.</td>
</tr>
<tr>
<td>hr_EmploymentHistorySecurityManager</td>
<td>Wrapper class for HR Profile Employment History security.</td>
</tr>
<tr>
<td>hr_PositionSecurityManager</td>
<td>Wrapper class for HR Position security.</td>
</tr>
</tbody>
</table>

**Client scripts installed with HR Service Management Legacy**

Human Resources Application: Core adds the following client scripts.
<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset priority on opened_for change</td>
<td>HR Case [hr_case]</td>
<td>Adjusts HR case priority based on whether or not the user is a VIP.</td>
</tr>
<tr>
<td>Auto populate fields</td>
<td>HR Case [hr_case]</td>
<td>Automatically sets location and department fields in HR cases, based on details from the user associated with that record.</td>
</tr>
<tr>
<td>Populate profile and assignment group</td>
<td>HR Case [hr_case]</td>
<td>Populates the Assignment Group and HR profile fields (if the <strong>Opened for</strong> user has an HR profile) in an HR case.</td>
</tr>
<tr>
<td>Custom Knowledge Search</td>
<td>HR Case [hr_case]</td>
<td>Custom knowledge search in the HR case form view.</td>
</tr>
<tr>
<td>End date must be after start date</td>
<td>HR Employment History [hr_employment_history]</td>
<td>Validates that the employment end date is not before the employment start date.</td>
</tr>
<tr>
<td>Enforce unique user</td>
<td>HR Profile [hr_profile]</td>
<td>Prevents creating a new profile when the selected user already has an HR profile.</td>
</tr>
<tr>
<td>Hide Record Producer variables</td>
<td>HR Case [hr_case]</td>
<td>Hides record producer variables which would otherwise be displayed in the HR case form view.</td>
</tr>
<tr>
<td>Highlight VIP employee</td>
<td>HR Case [hr_case]</td>
<td>Formats an HR case for a VIP user in the HR case list.</td>
</tr>
<tr>
<td>Populate Category using template</td>
<td>HR Case [hr_case]</td>
<td>Populates the category based on the selected HR template.</td>
</tr>
<tr>
<td>Populate fields using sys_user</td>
<td>HR Profile [hr_profile]</td>
<td>Updates fields in a new HR profile record when an existing user is selected.</td>
</tr>
<tr>
<td>Populate HR profile onChange</td>
<td>HR Case [hr_case]</td>
<td>Updates the HR profile fields in an HR case automatically when the opened for user is changed.</td>
</tr>
<tr>
<td>Populate Opened for field onChange</td>
<td>HR Case [hr_case]</td>
<td>Updates the <strong>Opened for</strong> field when a profile is added to an HR case.</td>
</tr>
<tr>
<td>Populate template using category</td>
<td>HR Case [hr_case]</td>
<td>Populates the template on an HR case when a category is changed.</td>
</tr>
<tr>
<td>Client script</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start date must be before end date</td>
<td>HR Employment History [hr_employment_history]</td>
<td>Validates that the employment start date is not after the employment end date.</td>
</tr>
<tr>
<td>Field Access [onLoad]</td>
<td>hr_profile</td>
<td>Sets HR Profile fields to read only if the user does not have the hr_case_writer role.</td>
</tr>
<tr>
<td>update manager when department changes</td>
<td>hr_case</td>
<td>When the Department field is updated, sets the Manager field if the case is an Onboarding case.</td>
</tr>
<tr>
<td>Set Category</td>
<td>hr_document_template</td>
<td>Sets the default value for the Category field to Employment Verification.</td>
</tr>
<tr>
<td>Clear task on change of user</td>
<td>hr_document_acknowledgement</td>
<td>Disassociates the document asknowledgement if the user in the referenced task is changed.</td>
</tr>
<tr>
<td>EnforceFields</td>
<td>hr_case</td>
<td>Ensures that the form cannot be submitted unless the mandatory fields are completed.</td>
</tr>
<tr>
<td>Populate Department from Position</td>
<td>hr_case</td>
<td>When the Position field is updated, sets the Department field if the case is an Onboarding case.</td>
</tr>
<tr>
<td>Validate Email Address on submit</td>
<td>hr_emergency_contact</td>
<td>Ensures the email address is valid when the form is submitted.</td>
</tr>
<tr>
<td>Make Ack Type mandatory in HR Task.</td>
<td>hr_task</td>
<td>Make the Acknowledgement type field mandatory when assigned to an Opened for user on the HR case.</td>
</tr>
<tr>
<td>User field is only writable for hr_admin</td>
<td>hr_profile</td>
<td>User field on the hr_profile form is read-only for all the users except for hr_admin users.</td>
</tr>
</tbody>
</table>

### Business rules installed with HR Service Management Legacy

Human Resources Application: Core adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned</td>
<td>HR Case [hr_case]</td>
<td>Invokes the state flow process for HR cases.</td>
</tr>
<tr>
<td>#Ready for work (approval off)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready for approval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready for work (approval on)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>#Start work</td>
<td>HR Task [hr_task]</td>
<td>Invokes the state flow process for HR tasks.</td>
</tr>
<tr>
<td>#Cancellation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accept</td>
<td>HR Case [hr_case]</td>
<td>Loads the HR case types and associated categories and maps the template to the case type.</td>
</tr>
<tr>
<td>Assigned</td>
<td>HR Case [hr_case]</td>
<td>Adds members of the HR VIP Watchlist group to an HR case when the user is a VIP.</td>
</tr>
<tr>
<td>#Cancel cleanup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready for work</td>
<td>HR Case [hr_case]</td>
<td>Places an HR case into Waiting for user acceptance state.</td>
</tr>
<tr>
<td>Reassign</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resume HR case</td>
<td>HR Case [hr_case]</td>
<td></td>
</tr>
<tr>
<td>Start work</td>
<td>HR Case [hr_case]</td>
<td></td>
</tr>
<tr>
<td>Add categories to scratchpad</td>
<td>HR Case [hr_case]</td>
<td>Triggers an HR survey when the case is closed or canceled.</td>
</tr>
<tr>
<td>Add HR Supervisor to watch list</td>
<td>HR Case [hr_case]</td>
<td></td>
</tr>
<tr>
<td>#Add User Acceptance State</td>
<td>HR Case [hr_case]</td>
<td></td>
</tr>
<tr>
<td>#Auto-assessment business rule</td>
<td>HR Case [hr_case]</td>
<td></td>
</tr>
<tr>
<td>#Clear durations</td>
<td>HR Case [hr_case]</td>
<td>Clears the Duration value on hr_case records when the case is reactivated (when Active changes to true on a record inserted or updated).</td>
</tr>
<tr>
<td>Close HR task</td>
<td>HR task [hr_task]</td>
<td>Closes the HR task that was created to request documentation from an employee when the employee replies to the email and attaches the file.</td>
</tr>
<tr>
<td>Display action required</td>
<td>HR Case [hr_case]</td>
<td>Displays HR has requested some actions on your part message.</td>
</tr>
<tr>
<td>Display Ready for Work message</td>
<td>HR Case [hr_case]</td>
<td>Displays a message if the HR case is in draft state instructing the agent to start work.</td>
</tr>
<tr>
<td>Display reminding message on HR case</td>
<td>HR Case [hr_case]</td>
<td>Checks the access level of the current user and displays appropriate information in the HR case. If the admin is impersonating a user, display a message that they are not allowed access.</td>
</tr>
<tr>
<td>Enforce unique user</td>
<td>HR Profile [hr_profile]</td>
<td>Ensures that a duplicate HR profile is not entered for a user.</td>
</tr>
<tr>
<td>Exit survey trigger</td>
<td>HR Task [hr_task]</td>
<td>Sends a link to the exit survey when the exit survey task state changes to Work in Progress.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notify HR Case owner when all task close</td>
<td>HR Task [hr_task]</td>
<td>Sends a notification to the HR case assigned-to agent when all HR tasks are complete.</td>
</tr>
<tr>
<td>Populate case SLAs</td>
<td>Task SLA [task_sla]</td>
<td>Inserts a Service Level Agreement timer when an HR case is active.</td>
</tr>
<tr>
<td>Reassignment counter for Case</td>
<td>HR Case [hr_case]</td>
<td>Counts the number of times the case is reassigned.</td>
</tr>
<tr>
<td>Remove HR Supervisor from watch list</td>
<td>HR Case [hr_case]</td>
<td>Removes HR VIP Watchlist group members from an HR case when the user is no longer a VIP.</td>
</tr>
<tr>
<td>Restrict query</td>
<td>HR Case [hr_case]</td>
<td>Amends the query used to get HR case records to display in list view.</td>
</tr>
<tr>
<td>Restrict query</td>
<td>HR Task [hr_task]</td>
<td>Amends the query used to get HR task records to display in list view.</td>
</tr>
<tr>
<td>Restrict query</td>
<td>Emergency Contact [hr_emergency_contact]</td>
<td>Amends the query used to get records to display in list view.</td>
</tr>
<tr>
<td>Restrict query</td>
<td>Employment History [hr_employment_history]</td>
<td>Amends the query used to get records to display in list view.</td>
</tr>
<tr>
<td>Send hr_case events</td>
<td>HR Case [hr_case]</td>
<td>Adds events to the event queue when records are inserted or updated.</td>
</tr>
<tr>
<td>Set HR mailto</td>
<td>System properties [sys_properties]</td>
<td>Sets the email address specified in the Configuration module when the user selects Email HR on the HR Portal.</td>
</tr>
<tr>
<td>Set user fields</td>
<td>HR Case [hr_case]</td>
<td>Sets the Opened for value on an hr_case record when the record is inserted or updated.</td>
</tr>
<tr>
<td>Start HR User Acceptance timer</td>
<td>HR Case [hr_case]</td>
<td>Starts the timer when an HR case is resolved. The user is notified to accept the resolution and close the case. With no user response, the case is automatically closed when the time ends.</td>
</tr>
<tr>
<td>#Synchronize fields to hr_profile</td>
<td>User [sys_user]</td>
<td>Synchronizes fields between associated hr_profile and sys_user records on update of the sys_user record.</td>
</tr>
<tr>
<td>#Synchronize fields to sys_user</td>
<td>HR Profile [hr_profile]</td>
<td>Synchronizes fields between associated sys_user and hr_profile records on update of the hr_profile record.</td>
</tr>
<tr>
<td>Update durations</td>
<td>HR Case [hr_case]</td>
<td>Sets the Duration value on hr_case records when the case becomes inactive (when Active changes to false on record inserted or updated).</td>
</tr>
<tr>
<td>#Update HR Case percent complete</td>
<td>Task [task]</td>
<td>Updates the task percent complete for an HR case based on the state of associated HR tasks.</td>
</tr>
<tr>
<td>Update name field</td>
<td>HR Profile [hr_profile]</td>
<td>Updates the Name value on an hr_profile record if the First name or Last name value ...</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>#Validate end date is after start date</td>
<td>HR Profile [hr_profile]</td>
<td>Validates that Employment end date is after Employment start date when any of the two values changes when an hr_profile record is inserted or updated.</td>
</tr>
<tr>
<td>#Validate opened_for against hr_profile</td>
<td>HR Case [hr_case]</td>
<td>Updates the Opened for value on hr_case records when State is not Requested and the record is updated.</td>
</tr>
<tr>
<td>ValidateChanges</td>
<td>HR Task [hr_task]</td>
<td>Ensures that changes are valid.</td>
</tr>
<tr>
<td>#Verify Work Notes</td>
<td>HR Case [hr_case]</td>
<td>Requires that work notes are entered when the HR case state changes.</td>
</tr>
<tr>
<td>#Verify Work Notes</td>
<td>HR Task [hr_task]</td>
<td>Requires that work notes are entered when the HR task state changes.</td>
</tr>
</tbody>
</table>

**Email notifications installed with HR Service Management Legacy**

Human Resources Application: Core uses the following email notifications. All are based on the HR Case [hr_case] table.

<table>
<thead>
<tr>
<th>Script action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Case opened</td>
<td>Sends an email to the caller and the user who enters the case when Active is true on record inserted.</td>
</tr>
<tr>
<td>HR Case created from email</td>
<td>Sends an email to the sender when an HR case is created from an inbound email action.</td>
</tr>
<tr>
<td>HR Case assigned to me</td>
<td>Sends an email to the assigned user when Active is true AND Assigned to is not empty AND Assigned to change AND On record inserted or updated.</td>
</tr>
<tr>
<td>HR Case assigned to my group</td>
<td>Sends an email to the assignment group members when Active is true AND Assigned to is empty AND Assignment group changes AND Assignment group is not empty AND On record inserted or updated.</td>
</tr>
<tr>
<td>HR Case commented</td>
<td>Sends an email to the creator, the caller, the assigned user, and members of the watchlist when Active is true AND Additional Comments changes AND On record updated.</td>
</tr>
<tr>
<td>HR Case resumed</td>
<td>Sends an email to the assigned user when an HR task is closed complete and the HR case is automatically resumed.</td>
</tr>
<tr>
<td>HR Case changed</td>
<td>Sends an email to the sender and the assigned user or group when the state, assignee, assignment group, or work notes are changed in an HR case.</td>
</tr>
<tr>
<td>HR Case worknoted</td>
<td>Sends an email to the assigned user when Active is true AND Assigned to is not empty AND Work notes changes AND On record updated.</td>
</tr>
<tr>
<td>HR Case closed</td>
<td>Sends an email to the creator, the caller, the assigned user, and members of the watchlist when Active is false AND On record updated.</td>
</tr>
<tr>
<td>HR Company</td>
<td>Sends an email to the HR profile manager on an event fired by the Employee Onboarding HR Workflow.</td>
</tr>
<tr>
<td>Script action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>welcome email</td>
<td></td>
</tr>
<tr>
<td>HR Task assigned to me</td>
<td>Sends an email to the assigned user when Active is true AND Assigned to is</td>
</tr>
<tr>
<td></td>
<td>not empty AND Assigned to change AND On record inserted or updated.</td>
</tr>
<tr>
<td>HR Task assigned to my group</td>
<td>Sends an email to the assignment group members when Active is true AND</td>
</tr>
<tr>
<td></td>
<td>Assigned to is empty AND Assignment group changes AND Assignment group is</td>
</tr>
<tr>
<td></td>
<td>not empty AND On record inserted or updated.</td>
</tr>
<tr>
<td>HR Task commented</td>
<td>Sends an email to the assigned user, and members of the watchlist when</td>
</tr>
<tr>
<td></td>
<td>Active is true AND Additional Comments changes AND On record updated.</td>
</tr>
<tr>
<td>HR Task closed</td>
<td>Sends an email to the user assigned to the HR case when Active is false AND</td>
</tr>
<tr>
<td></td>
<td>On record updated.</td>
</tr>
<tr>
<td>HR Task changed</td>
<td>Sends an email to the event creator and the users defined in event parms 1</td>
</tr>
<tr>
<td></td>
<td>and 2 when the hr.task.changed event is fired.</td>
</tr>
<tr>
<td>HR Employment Verification</td>
<td>Sends an email to the third party who requested the employment verification</td>
</tr>
<tr>
<td></td>
<td>letter.</td>
</tr>
</tbody>
</table>

**Events installed with HR Service Management Legacy**

Human Resources Application: Core registers the following events.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hrc.case.resume</td>
<td>Triggers when an HR task is closed and the HR case is resumed.</td>
</tr>
<tr>
<td>hrc.request.changed</td>
<td>Triggers when the state, assignee, assignment group and work notes are changed.</td>
</tr>
<tr>
<td>hrc.request.email.creation</td>
<td>Triggers when a request is inserted from an email.</td>
</tr>
<tr>
<td>hrc.task.changed</td>
<td>Triggers when the state, assignee, assignment group and work notes are changed.</td>
</tr>
<tr>
<td>hrc.task.closed</td>
<td>Triggers when a task is closed complete, but the parent case is not resumed and one or more tasks are still pending.</td>
</tr>
<tr>
<td>hr_case.approved</td>
<td>Triggers on approval of an HR case.</td>
</tr>
<tr>
<td>hr_case.assignment_group.changed</td>
<td>Triggers when the assignment group is changed.</td>
</tr>
<tr>
<td>hr_case.commented</td>
<td>Triggers when a comment is added to an HR case.</td>
</tr>
<tr>
<td>hr_case.emp_verification</td>
<td>Triggers from a UI action for employment verification to send the employment verification email to the requestor.</td>
</tr>
<tr>
<td>hr_case.inserted</td>
<td>Triggers on insertion of an HR case.</td>
</tr>
<tr>
<td>hr_case.inserted.assigned</td>
<td>Triggers on insertion and auto-assignment of an HR case.</td>
</tr>
<tr>
<td>Event</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>hr_case.inserted.unassigned</td>
<td>Triggers on insertion of an HR case that is not auto-assigned.</td>
</tr>
<tr>
<td>hr_case.updated</td>
<td>Triggers when an HR case is updated.</td>
</tr>
<tr>
<td>hr_case.welcome_email</td>
<td>Triggers on insertion of an onboarding case to send the welcome email for a new employee.</td>
</tr>
</tbody>
</table>

**HR skills installed with HR Service Management Legacy**

Human Resources Application: Core adds the following HR skills.

<table>
<thead>
<tr>
<th>HR skill</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Career</td>
<td>Provides guidance about an employee’s career path</td>
</tr>
<tr>
<td>Employee Offboarding</td>
<td>Manages offboarding cases to ensure all tasks are completed</td>
</tr>
<tr>
<td>Employee Onboarding</td>
<td>Manages onboarding cases to ensure all tasks are completed</td>
</tr>
<tr>
<td>Employee Relations</td>
<td>Assists employees with employee relations cases</td>
</tr>
<tr>
<td>Employee Transfer</td>
<td>Manages process for transferring employees to ensure all tasks are completed</td>
</tr>
<tr>
<td>Exit Interviews</td>
<td>Interviews offboarding employees to ensure compliance and collect feedback</td>
</tr>
<tr>
<td>Hiring</td>
<td>Manages processes, such as personnel requisitions, for the hiring of new employees</td>
</tr>
<tr>
<td>HR</td>
<td>Is contained within all HR skills.</td>
</tr>
<tr>
<td>HR Benefits</td>
<td>Assists employees with benefits cases</td>
</tr>
<tr>
<td>HR Policy</td>
<td>Assists employees with questions about company policies</td>
</tr>
<tr>
<td>HR Systems</td>
<td>Manages HR systems, such as payroll, learning management system, and employee database</td>
</tr>
<tr>
<td>Leave of Absence</td>
<td>Assists employees to schedule leaves of absence, such as maternity leave</td>
</tr>
<tr>
<td>Payroll</td>
<td>Assists employees with payroll questions and issues</td>
</tr>
<tr>
<td>Spanish Language</td>
<td>Speaks Spanish, and can act as a translator if needed</td>
</tr>
<tr>
<td>Time Tracking</td>
<td>Assists employees with timecard questions</td>
</tr>
<tr>
<td>Vacation/Leave</td>
<td>Assists employees with vacation or leave questions</td>
</tr>
</tbody>
</table>

**HR catalog items installed with HR Service Management Legacy**

Human Resources Application: Core adds the following HR catalog items.
<table>
<thead>
<tr>
<th>HR catalog item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>401(k) benefits</td>
<td>Submit a question about 401(k) benefits. For example: How much can I contribute? or When will withdrawals start?</td>
</tr>
<tr>
<td>Career guidance</td>
<td>Submit a question about your career at the organization. For example: What is required to be considered for a promotion?</td>
</tr>
<tr>
<td>Employee information changes</td>
<td>Enter and submit changes to your HR profile information, such as a new personal email address. Some fields update automatically, and others are updated by an HR agent.</td>
</tr>
<tr>
<td>Employee offboarding</td>
<td>Submit an offboarding request for an employee who is leaving the company. Variables include the employee who is leaving, the offboard type, and the employment end date.</td>
</tr>
<tr>
<td>Employee onboarding</td>
<td>Submit an onboarding request for a new hire that is due to start in the future. Variables include HR profile information, employment information, and personal information.</td>
</tr>
<tr>
<td>Employee relations questions</td>
<td>Submit a question about employee relations. For example: My office mate talks too loudly on the phone all day long.</td>
</tr>
<tr>
<td>Employment verification</td>
<td>Submit a request to have an employment verification letter generated and sent to a third-party contact, such as a bank loan officer. Variables include the name of the institution, contact name and info, and email address.</td>
</tr>
<tr>
<td>General</td>
<td>Submit a question about benefits that are not covered by the other catalog items. For example: Does the company have a discount program?</td>
</tr>
<tr>
<td>Grievance</td>
<td>Submit a case describing an occurrence or situation that needs to be addressed. For example: Someone is smoking cigarettes every afternoon in the 2nd floor bathroom.</td>
</tr>
<tr>
<td>Leave of absence</td>
<td>Submit a request for a leave of absence. Variables include the type of leave and when it starts and ends.</td>
</tr>
<tr>
<td>Life events</td>
<td>Submit a question about life events such as marriage or domestic partnership.</td>
</tr>
<tr>
<td>Medical/dental/vision</td>
<td>Submit a question about your health coverages, such as what you need to do to cover your domestic partner.</td>
</tr>
<tr>
<td>Payroll</td>
<td>Submit a question about payroll. For example: How do I change my W2 deductions?</td>
</tr>
<tr>
<td>Retirement</td>
<td>Submit a question about retirement benefits and options, such as how many years must you have with the company to qualify for retirement.</td>
</tr>
<tr>
<td>Tuition</td>
<td>Submit a request for tuition reimbursement following your company guidelines. Variables include the educational institution, class taken, completion date, and the tuition amount.</td>
</tr>
<tr>
<td>Vacation</td>
<td>Submit a question about vacation policies, such as when you get an additional week per year.</td>
</tr>
</tbody>
</table>
Understanding HR Service Management Legacy

HR Service Management for the non-scoped version of HR benefits your enterprise by automating standard HR processes within your organization that support relationships between employees and the HR department.

Who uses HR Service Management?
The enterprise HR department uses the HR Service Management application. An enterprise HR department is composed of many areas, such as employee relations, benefits administration, policy enforcement, recruitment and employment, and performance management. The members of a large HR organization typically include:

- HR specialists who specialize in one or more HR disciplines. For example, the benefits area has specialists in insurance administration, leave and vacation time, and employee stock purchase.
- HR generalists who work with a business group or in a geographical region to assist employees with questions, careers, performance management, and other employee relations requests.
- HR managers who monitor and measure the effectiveness of the HR group in supporting employees across the organization. They also ensure that the enterprise is compliant with federal, state, and local regulations.
- HR systems administrators who configure and maintain systems such as the central employee database, payroll, learning and performance management system, and others, including the Human Resources application.

How do you use HR Service Management?
The HR Service Management application enhances and supports your enterprise. The relationships between your employees, IT, and the HR department are supported in numerous ways:

- Employees can use the HR Service Portal Legacy or catalog to submit questions and other requests to the HR department.
- If you use the Connect Support feature, employees can chat with an HR agent who is monitoring the HR chat queue. See Connect Support.
- HR staff can create, manage, and view HR cases to answer questions and process the requests that employees submit.
- HR managers can run reports and view overview information to monitor and manage work done by the HR department.
- HR and corporate IT administrators can more effectively manage the company HR systems, such as the payroll and performance management systems, through the Enterprise Configuration Management Database (ECMDB).

How do you benefit from HR Service Management?
Your entire organization benefits by using the application in the following ways:

**Automates standard HR processes**
Several typical HR processes are automated. This automation reduces the number of checklists, email exchanges, and phone calls performed by the HR team.

**Improves employee access**
Employees access HR services through a service catalog, rather than having to write individual emails, make phone calls, or personally visit HR for each request.

**Tracks requests and progress**

HR managers use reports and views to help them understand the work their staff is performing to support the company. Employees can see the status of their requests.

**Integrates with other services**

Human resources processes can include both HR tasks and tasks for other teams, to provide significant service delivery improvements.

**HR Service Management terminology**

The following terminology is used for the application.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Criteria</td>
<td>Way to select groupings of HR and System users based on criteria</td>
</tr>
<tr>
<td>HR Services</td>
<td>List of HR Services</td>
</tr>
<tr>
<td>HR Topic Categories</td>
<td>List of HR Service Topic Categories</td>
</tr>
<tr>
<td>HR Relationships</td>
<td>User relationships with each other</td>
</tr>
<tr>
<td>HR Positions</td>
<td>Positions available in company table</td>
</tr>
<tr>
<td>HR Assignment Tier Definition</td>
<td>Specifies escalation hierarchy</td>
</tr>
<tr>
<td>HR Group Roles</td>
<td>List of groups that have HR group roles</td>
</tr>
<tr>
<td>HR Email Scripts</td>
<td>List of all HR email scripts</td>
</tr>
<tr>
<td>HR User Roles</td>
<td>List of users who have HR user roles</td>
</tr>
<tr>
<td>HR Templates</td>
<td>Templates for Case record creation based on catalog item</td>
</tr>
<tr>
<td>Client Role Rules</td>
<td>Specifies the rules to generate client roles</td>
</tr>
<tr>
<td>HR Topic</td>
<td>DetailsList of HR Service Topic Details</td>
</tr>
<tr>
<td>HR Service Options</td>
<td>List of HR Services options that affect case creation</td>
</tr>
<tr>
<td>HR Departments</td>
<td>Departments available in company table</td>
</tr>
<tr>
<td>HR Locations</td>
<td>Locations available in company table</td>
</tr>
<tr>
<td>HR Chat Queues</td>
<td>List of HR chat queues</td>
</tr>
<tr>
<td>HR Surveys</td>
<td>Surveys used by HR application</td>
</tr>
<tr>
<td>HR Links</td>
<td>External links used by HR application</td>
</tr>
<tr>
<td>HR Properties</td>
<td>System properties used in HR Application</td>
</tr>
<tr>
<td>HR Email Templates</td>
<td>List of all HR-related email templates</td>
</tr>
<tr>
<td>HR Knowledge Bases</td>
<td>Knowledge bases used by HR application</td>
</tr>
<tr>
<td>HR Knowledge Articles</td>
<td>Knowledge articles used by HR application</td>
</tr>
<tr>
<td>HR Notifications</td>
<td>Email notifications used by HR application</td>
</tr>
<tr>
<td>HR Service Catalog Categories</td>
<td>Service catalog categories used by HR application</td>
</tr>
<tr>
<td>HR Service Catalog Items</td>
<td>Service catalog items used by HR application</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Document Templates</td>
<td>Document templates for document content used in HR application</td>
</tr>
<tr>
<td>HR Groups</td>
<td>Groups used by HR users</td>
</tr>
<tr>
<td>HR Skills</td>
<td>Skills available to company users</td>
</tr>
<tr>
<td>HR Roles</td>
<td>Roles used by HR users</td>
</tr>
<tr>
<td>HR Benefit Provider / Plans</td>
<td>Benefit providers and plans used by HR Benefits service</td>
</tr>
<tr>
<td>HR Benefit Type</td>
<td>Benefit types used by HR Benefits service</td>
</tr>
<tr>
<td>Disciplinary Issue Types</td>
<td>Disciplinary issue types used by HR Employee Relations service</td>
</tr>
<tr>
<td>Disciplinary Warning Types</td>
<td>Warning types used by HR Employee Relations service</td>
</tr>
<tr>
<td>HR System Report Frequencies</td>
<td>System Report Frequencies defined for HR Systems Service</td>
</tr>
<tr>
<td>HR System Report Types</td>
<td>HR System Report types used by HR System service</td>
</tr>
</tbody>
</table>

**Implementation guide for legacy HR**

To implement the non-scoped version of HR, HR management works with IT staff to set up HR data and configure the application to work with the organization’s HR processes.

The following topics provide planning, configuration, and implementation guidelines for a successful rollout to your organization.

**HR and IT implementation team for legacy HR**

Begin by assembling the team of HR staff who can make decisions about the configuration of the application and the IT staff who can configure the application, for the non-scoped version of HR.

On the implementation team, include HR and IT staff who can handle the following responsibilities.

**HR project manager**

The project manager understands the department systems and processes, and will be responsible for the timeline, budget, communications, and so on.

**HR IT administrator**

This is typically someone who manages existing HR systems and who will manage the configuration of the Human Resources application.

**HR managers**

Managers who represent different HR functions, such as benefits, payroll, and employee relations.

**Other stakeholders**

Others who must give approval, provide input, or sign off for a successful implementation. For example, the training organization.

**Implementation decisions for legacy HR**

With the HR implementation team, make decisions about system configuration, for the non-scoped version of HR.
As a team, discuss the following topics. You may need help from your account manager or from other internal groups for some of the discussions.

**Integration**
If you have an existing HR employee database, decide whether to integrate it with the HR profile database.
If you use a different system, you may need to use professional services to help with integration.

**Process flow**
Decide whether to use state flows or workflows to drive the process for resolving HR cases.

**HR knowledge bases**
Determine whether to set up HR knowledge bases prior to rollout, meaning you have HR documents available through the knowledge base before employees begin submitting HR cases.
An important benefit of the HR system is the Human Resources knowledge base that can contain policies, benefits, holiday schedules, and so on. When an employee submits a case, the knowledge base is searched based on keywords the employee is entering in the short description. With a detailed knowledge base, the question may be answered without the need to submit the case.
You can also define multiple HR knowledge bases for different sets of employees. For example, create one knowledge base for U.S. employees and another knowledge base for Mexico employees because policies, holidays, and so on, may be different.

**Assignment of HR cases and tasks**
Determine how you are going to assign HR cases and tasks to HR agents. Review the following information to understand the assignment process and become familiar with predefined items and options.
- How cases and tasks are assigned in legacy HR
- User groups installed with HR Service Management Legacy
- HR skills installed with HR Service Management Legacy
- HR catalog items installed with HR Service Management Legacy
- Configuration in legacy HR

**Current HR processes**
Outline important HR processes such as your organization’s onboarding and offboarding processes. Compare the processes to those that are predefined with the Human Resources application, and identify how the predefined processes must be modified. Identify other processes you must configure.

**Service level agreements (SLA)**
Decide how long different types of HR cases should take to resolve, and use this info to define HR service level agreements (SLAs) for tracking the effectiveness of your HR processes.

**HR rollout**
As part of the planning process, determine how you will roll out HR to employees, and what training is needed. Consider the following questions.
• Will you roll it out to groups of employees in phases?
• Will you roll out parts of it in phases? For example, in the first phase, all employees can submit simple HR inquiries. The second phase includes training and implementation of the automated processes, such as onboarding and offboarding.
• How will you get employees excited about the new HR process so they will want to use it?
• What training will each type of user, such as those listed below, need?
  ◦ End users who submit HR requests
  ◦ HR agents who work on cases
  ◦ HR approvers who need to respond in a timely manner
  ◦ HR managers who want to track and monitor HR case activity
  ◦ Other stakeholders not listed

State flows vs. workflows in legacy HR

One configuration setting available for the Human Resources application is whether to automate state flows. If you do not automate state flows, you can manually change the state of HR cases as work is completed, or use workflows to automate the processes.

Definitions

State flows

State flows customize transitions from one state to another in tables derived from the Task [task] table. The system is configured to perform work during transitions to specific states. An example of a state transition is when the **State** field in a case changes from the **Ready** state to **Work in Progress**.

When you create a state flow, the system automatically replaces the usual programming elements that control task states with customizable business rules, client scripts, and UI actions that give you a wide range of processing options. You can configure custom state transitions to occur automatically or manually and in any order. You can create business rules and UI actions that only appear and take effect for certain states.

Workflows

A workflow provides the same customization of processes, however, workflow activities can be based on triggers other than state changes. If you use a workflow, you define activities to change the state but can include other activities such as setting a timer for an action to be taken, adding messages to the activity stream, and initiating another workflow.

You create and modify workflows in the Workflow Editor, where the entire workflow is represented graphically in one screen, as shown in this example HR workflow:
Example HR workflow

Understanding the state flows and workflows installed with HR

When Human Resources is activated, both state flows and workflows are installed. State flows are enabled by default in Human Resources > Administration > Configuration.

The following processes have defined workflows:

**Employee Change HR Workflow**
Checks first whether an approval is needed. If no approval is needed, or when approval is obtained, the profile is updated and the case is closed. If a change is rejected, the case is closed incomplete.

**Employee Onboarding HR Workflow**
Automatically creates an HR profile and sends approval request. When approval is obtained, creates the user record, sends a welcome email template to the new employee’s manager, and initiates the Employee Onboarding HR Tasks workflow. When tasks are complete, closes the case. If the onboarding case is rejected, the case is closed incomplete and the HR profile is marked inactive.

**Employee Onboarding HR Tasks**
When initiated by the onboarding workflow, creates onboarding tasks and assigns them as specified in the properties of each task.

**Employee Offboarding HR Workflow**
Sends approval request. When approval is obtained, initiates the Employee Offboarding HR Tasks workflow. When termination date is reached and tasks are closed, HR profile and user records are set to inactive.

**Employee Offboarding HR Tasks**
When initiated by the offboarding workflow, creates offboarding tasks and assigns them as specified in the properties of each task.

**HR Case User Acceptance**
After an HR agent completes a case, notifies the user to review and accept or reject the resolution. If the user accepts the resolution or does not respond within two business days, closes case. If the user rejects the resolution, notifies the HR agent.

You can view the state flows by navigating to Human Resources > State Flows. Each state flow indicates the starting and ending state when the state flow is processed. If you are
just beginning to use HR, you can leave state flows enabled and if the workflows are not modified they will work with state flows without conflicts.

How cases and tasks are assigned in legacy HR

Understanding how HR agents are assigned to HR cases and tasks is important because it will help you set up auto-assignment to work as expected.

This diagram illustrates the hierarchy of the assignment process.

1. When the HR case is entered, an HR group is assigned from the HR case template or from an assignment rule. The HR case template assigns the group during case entry, before the case is submitted. An assignment rule assigns the group when the case is submitted, if the assignment group is empty.

2. When the case is submitted, the auto-assignment process evaluates the time zone, location, and skills of each member of the assignment group, depending on which configuration options are enabled. It also evaluates the workload, or number of cases assigned to each user. It assigns the closest matching assignment group member based on workload.

The following predefined items support HR case and task assignment.

Predefined HR items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR groups</td>
<td>Several HR groups are predefined, including HR, which is intended to contain all HR staff members.</td>
</tr>
<tr>
<td>HR case templates</td>
<td>Case templates are used to create catalog items. A number of predefined catalog items are provided for common HR requests, such as tuition reimbursement and 401k questions. Most HR case templates assign HR as the assignment group.</td>
</tr>
</tbody>
</table>
Predefined HR items (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>There are also HR task templates that are associated with the catalog items to create tasks for fulfilling HR cases. Both case and task templates can specify the assignment group.</td>
</tr>
<tr>
<td>Assignment rules</td>
<td>A predefined assignment rule assigns HR as the group when an HR case is submitted and there is no assigned group.</td>
</tr>
</tbody>
</table>

The following auto-assignment options are configured in the HR Configuration module.

### HR Configuration auto-assignment options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-selection of agents will consider time zone for tasks</td>
<td>HR tasks are individual pieces of work that must be completed to resolve the HR case. HR tasks can be assigned to a time zone; if you assign a time zone, you can use the time zone of the task and the HR agent's location to auto-assign the agent.</td>
</tr>
<tr>
<td>Auto-selection of agents will consider location of agents.</td>
<td>If the organization is spread across two or more locations, and each has an HR team, you can use the HR agent's location. For example, a vacation question from an employee in Germany is assigned to a member of the Benefits group in the Berlin office.</td>
</tr>
<tr>
<td>Auto-selection of agents for tasks requires them to have [all] [some] [none] skills</td>
<td>Within a group, HR agents may specialize in an area. For example, on the Benefits team, some agents may know more about medical claims or leave requests. You select from [all] [some] [none] based on whether you assign and maintain HR skills.</td>
</tr>
</tbody>
</table>

### Implementation information required for legacy HR

After deciding how to configure the HR application, obtain lists of the information to input or import into HR modules, for the nonScoped version of HR.

Obtain these lists from existing systems or databases, or ask department heads to compile the list of information for their department. Use the information as outlined to develop lists that are ready for input into the Human Resources application.

1. Gather the following information.
   - List of positions within your organization.
   - HR areas of expertise, for example, benefits, payroll, policies, and so on.

2. Use the list of HR areas of expertise to compile the following lists.
   - **HR roles**
     
     Roles identify the parts of the system that each user can access.
     
     Typically, users are placed in groups and then roles are assigned to groups. Every user in a group receives the permissions assigned to the group. Several roles are predefined for you, such as HR admin, specialist, and generalist roles. Review the predefined roles and identify new roles you need to add.

   - **HR groups**
     
     The HR group is predefined to contain all HR users. Identify the additional groups you need. You can often start with a list of the email groups defined in
your organization. You can assign roles to a group, and every member added to the group is assigned the associated roles.

**Note:** HR groups can be set up in a hierarchy. A user assigned to a child group gets the roles assigned to the parent and child groups.

**HR skills**

Compile a list of skills that HR users may have. These can be for areas of expertise and other skills, such as foreign languages spoken. You can assign skills to both groups and users. As with roles, skills assigned to groups are assigned to every member of the group.

**Note:** HR skills can be set up in a hierarchy. A user assigned to a skill receives the skill and all skills that are contained by it.

3. Obtain a hierarchical list of HR users. For each user, identify the following information. The list will be used as an input document for the HR implementation.

   • User’s HR group membership
   • User’s HR skills
   • If a user will not assigned as a member of a group, a list of HR roles to assign to the user
   • User’s location, if applicable
   • Whether the user should approve HR cases. For example, a region’s HR generalist may need to approve offboarding HR cases.

4. Outline any articles to include in the knowledge base, and the source of the information for each article.

**Configuring legacy HR**

Use the configuration checklist to help you set up HR for your organization, for the non-scoped version of HR.

It may take some time to complete all configuration items. Most of these items can be done concurrently; exceptions are noted. If it takes several months to complete implementation, review the information entered during the initial configuration tasks and update it to reflect any changes.

<table>
<thead>
<tr>
<th>Configure</th>
<th>Set Configuration in legacy HR.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter or import the following information before importing user HR profiles.</td>
<td></td>
</tr>
<tr>
<td>• Define organization positions in legacy HR</td>
<td></td>
</tr>
<tr>
<td>• HR Create a user group. Include HR as a prefix in your group name so HR groups are easy to search for.</td>
<td></td>
</tr>
<tr>
<td>• Create or modify an HR skill in legacy HR</td>
<td></td>
</tr>
<tr>
<td>Create or modify an HR profile in legacy HR database, as determined during the decision phase.</td>
<td></td>
</tr>
<tr>
<td>Assign a role to a user to HR groups and staff. Be sure to assign hr_approver_user to anyone who approves cases.</td>
<td></td>
</tr>
<tr>
<td>Assign an HR skill to a group in legacy HR.</td>
<td></td>
</tr>
</tbody>
</table>
Configure Human Resources (continued)

<table>
<thead>
<tr>
<th>✓ Configure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create any HR templates for the HR catalog. These are for the additional processes you identified during the planning phase.</td>
</tr>
<tr>
<td>Review the installed HR case and task state flows and <strong>Customize a state flow</strong> as needed.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you are managing cases manually or with workflows, you can <strong>disable state flows</strong>.</td>
</tr>
<tr>
<td>Review the installed HR <strong>Create a workflow</strong> and edit or create new workflows as needed.</td>
</tr>
<tr>
<td>Review and configure <strong>Assignment rules in legacy HR</strong>.</td>
</tr>
<tr>
<td>Review and configure <strong>Notifications</strong>. You can customize the text of existing notifications and create notifications.</td>
</tr>
<tr>
<td>Review and configure <strong>HR Service Level Agreements (SLA)</strong>.</td>
</tr>
<tr>
<td>Set up <strong>Knowledge management in legacy HR</strong>. This is completed by the HR knowledge base administrator, who owns the content and its creation. The knowledge base administrator also defines and monitors the review, publication, and retirement processes.</td>
</tr>
</tbody>
</table>

**Automated processes for legacy HR**

You can automate HR processes, such as onboarding a new employee, in the non-scoped version of HR. There are predefined processes that launch automated workflows. You can customize the predefined processes and create ones.

Predefined processes are available to fulfill the following requests, or HR catalog items.

- **Employee onboarding**: HR managers can submit an HR onboarding request for a new employee.
- **Employee information change**: HR managers submit requests to update HR profile information for an employee, such as when their name, position, or location changes. Employees can submit requests to change some profile fields, such as home address or personal email. The HR profile fields are changed automatically when a request is submitted.
- **Employee offboarding**: HR managers can submit an HR offboarding request for an employee.

HR catalog items can be customized and integrated with a wider organization, for example to engage the IT team to configure a laptop for a new employee. Standard sets of tasks for HR processes are defined, and the system can be configured to automatically create and assign these tasks at the appropriate time.

Employee information can be passed to other departments automatically to start their processes. The HR team does not need to be aware of the specifics of these other processes. Departments such as IT or facilities retain control over their processes and inform the HR department when they are completed.

Here is how the predefined onboarding process works for a new employee named Allen:
1. The HR manager for Allan submits an **Employee onboarding** request from the HR catalog or HR service portal. The following actions occur.
   - A new HR case is created with a category of **Onboarding**.
   - A new HR profile record is created to hold the personal information of Alan from the onboarding form. The HR team can add information to HR profile to store and track all the data Alan provides.

2. An approval request is generated and assigned automatically to the user who can verify and approve the onboarding request.

3. After approval is obtained, the user record for Alan is automatically created and linked to the HR profile. Standard HR tasks are automatically created for the HR team to fulfill, such as setting up payroll and benefits, and performing a background check.

4. A workflow automatically generates requests to provide Allan with the correct IT hardware, software, and systems access based on department, location, and position.

5. When all the tasks are complete, the HR department confirms that everything is ready for the first day and closes the case record.

The HR team can track the progress of the entire onboarding process.

**Use events to launch HR processes**

You can use events to launch workflow processes, typically when a new HR case is created. This process works as follows:

1. When an HR case is created or modified, an HR fulfillment event occurs. For example, the hr_case.inserted event occurs when a new HR case is created.

2. The event triggers script actions that execute scripts as required and launch workflows. For example, the IT employee onboarding action script action launches the **Employee Onboarding IT Workflow**.

**Related information**

- [Workflow](#)
- [Workflow editor](#)
- [Create Event workflow activity](#)

**Workflow-based process design for legacy HR**

You can design a new workflow-based HR process when the predefined processes are not sufficient, in the non-scoped version of HR. You can create an entirely new workflow or use existing components in your HR process.

To design a new workflow or customize a predefined workflow, you typically work with someone in your organization who has experience with workflow design and customization.

The following components can be used or customized for HR processes.

- The predefined processes provided for onboarding, offboarding, and information change.
- The IT Employee Onboarding Action and IT Employee Offboarding Action script actions.
- Workflows that create HR and IT tasks.
- The order guide that creates catalog item requests.
- Record producers, known as catalog items, that launch HR automated processes.

The following items work by default with HR processes. You can modify them as needed. For example, you can extend the HR Profile table to capture additional information.
• HR Profile [hr_profile] table
• HR Case [hr_case] table
• Script includes

The following list outlines the tasks you perform to design a new automated HR process.

1. Design the process stages, outlining the process flow at a high level. An example is shown in the table.
2. Create or customize a catalog item that creates the HR case.
3. Create the workflow to process the request, including any of the following relevant configurations.

   **Approval rules**
   
   Review and approve, or reject the request. For example, to approve a request for a leave of absence.

   **Assignment rules**
   
   Assign the request to a specific individual or group. For example, to assign benefits change records to a specific benefits administrator. HR groups, skills, and locations can all be considered for auto-assignment.

   **Email notifications**
   
   Alert an HR team member or group about the request. For example, to send a notification to the HR agent a case is assigned to.

   **Fulfillment tasks**
   
   Create HR tasks and requests for items that other departments fulfill. For example, an HR task to reactivate a user’s email account when a leave of absence ends.

4. Customize profile information, if required by the new process. For example, you can extend the HR Profile table to create a Dependents table, which may be required for processing employee insurance claims.

5. Select an event to launch the workflow when the HR case is created.

### Example of the typical stages for an onboarding process

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
</table>
| Capture information | • When an employment offer is accepted, capture basic information about the new employee.  
• Create an HR case and HR profile for the employee with the captured information.  
• Request approval for onboarding. |
| Approval            | • Approve the onboarding request, then generate the tasks for this work, such as:  
◦ HR tasks, such as performing reference checks.  
◦ Non-HR requests, for example, relevant hardware and software that generate service catalog requested items. Non-HR departments fulfill these requests. |
Example of the typical stages for an onboarding process (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fulfillment</td>
<td>• Fulfill the generated tasks required for onboarding.</td>
</tr>
<tr>
<td>Start date</td>
<td>• When the employee joins, perform actions such as:</td>
</tr>
<tr>
<td></td>
<td>◦ Reset a password or unlock the Active Directory account for an employee.</td>
</tr>
<tr>
<td></td>
<td>◦ Add roles to the employee.</td>
</tr>
<tr>
<td></td>
<td>◦ Send a welcome email to the team.</td>
</tr>
</tbody>
</table>

**Employee onboarding workflow in legacy HR**

Review detailed overview of the predefined HR automated process for employee onboarding to ensure that it meets the needs of your organization. Optionally, customize the onboarding workflow or design a new workflow.

To design a new workflow or customize a predefined workflow, you typically work with someone in your organization who has experience with workflow design and customization.

The onboarding process begins when an HR manager submits an onboarding request from the HR catalog or HR service portal, which enters an employee data management case.

An HR employee is assigned the case, approval must be granted before any work can be done. After approval, the HR employee defines the onboarding tasks for onboarding the new hire.

The new hire uses the HR Service Portal to complete the onboarding tasks.

The system first checks for an existing HR profile based on the first name, last name, and personal email address of the person being onboarded. For example, an existing HR profile exists if the person is a previous employee. If a matching HR profile is found, the system adds relevant information to the profile and updates the employment status. If an existing HR profile does not exist, then an HR profile record is created for the new employee. The record is populated with the personal information entered in the catalog form.

HR profiles are created before the approval flow is triggered, to enable the recording of confidential comments and work notes in the secure HR profile record. Sensitive information is captured at an early stage.

ℹ️ **Note:** If the onboarding request is created from the New record form, the user must begin by selecting the **HR - Employee Data Management** category. The user can click **New**, complete the information, and then submit the HR case.

After the request is submitted:

1. A new user record [sys_user] is created for the employee and populated with the information entered in the HR profile.
2. The user record is linked to the HR case, and the name appears in the **Opened for** field in the **Employee Data Management Case** page.
3. The state of the HR case is set to **Ready**.
4. The Employee Onboarding HR Workflow sends an email to approvers to request approval to onboard the new employee.

ℹ️ **Note:** Your instance must be configured to email approvers with a notification that an approval needs their attention.
1. The hr_case.approved fulfillment event occurs. The following subflows and order guides are launched.

2. An HR tasks workflow to generate tasks for the HR team to perform.
   - Employee information change
   - Employee offboarding
   - Employment verification letter
   - New hire onboarding
   - New employee payroll setup
   - New employee background checks
   - New employee anti-corruption policy acceptance
   - New employee benefits set up
   - New employee training requirements

3. An IT tasks workflow generates a service catalog request for the IT team. The IT Employee Onboarding Action script action triggers and runs an order guide using the Scriptable Order Guide activity.
   - The order guide uses rules to specify which items are requested based on questions answered on the onboarding request. These answers populate variable values, and determine which requested items the order guide generates. For example, all employees receive an email account, but only some employees receive a laptop. The questions are Employment type, Department, and Location type.
   - The Requested for field is set to the new employee.
   - An approval request for the service catalog items is generated and a notification is sent to the IT approver.
   - After approval is received, the service catalog request is set to Approved and the requested item state is set to Open.

   Note: If the onboarding case is canceled, requested items are also canceled.

4. On the day before the employment start date, a welcome email is sent to the manager of the new employee. To introduce the new employee, the manager can modify and send this email to the team.

5. When an onboarding request is approved, the following actions occur.

6. When all generated HR tasks and requested items are completed, the following actions take place.
   - The HR profile and HR case are updated to set the employment status to Employed.
   - The HR case is closed.

   Note: The HR case cannot be closed when there are incomplete HR tasks or requests.

If the onboarding request is rejected, the following actions occur.

1. The HR case is closed, and the HR profile is set to Inactive.

2. A work note is added to the HR profile to note the rejection.

3. An appropriate notification is sent to the creator of the onboarding record.
4. Requested items are canceled.
5. The onboarding process terminates.

**Employee offboarding workflow in legacy HR**

Review detailed information about the predefined HR offboarding workflow process to ensure it meets the needs of your organization. You may need to customize the offboarding workflow or design a new workflow.

To design a new workflow or customize a predefined workflow, you typically work with someone in your organization who has experience with workflow design and customization.

The default offboarding process starts when an offboarding request is submitted. This creates an HR case for the terminating employee and triggers the Employee Offboarding HR Workflow. If the employee does not have an HR profile record, it is created when the workflow is triggered.

An approval to offboard the employee is requested and an approval request is sent to members of the **HR Leadership** group. When an offboarding request is approved, the following actions occur.

1. The **Employment status** for the HR case and the employee’s HR profile are both set to **Offboarding**.
2. The state of the HR case becomes **Work in Progress**.
3. The hr_case.approved fulfillment event occurs. This triggers:
   - The Employee Offboarding Tasks Workflow to add HR tasks to the HR case.
     The offboarding workflow dynamically generates tasks from the template just like onboarding.
   - The IT Employee Offboarding Action script action to retrieve the employee’s assets by generating tasks for each asset assigned to the employee.
4. When the employment end date is reached and the Employee Offboarding HR Tasks Workflow is completed, the following actions occur.
   - The state of the HR case is set to **Closed Complete**.

   **Note:** The HR case cannot be closed when there are incomplete HR tasks or requests.
   - The employment status for the HR case and HR profile are both set to **Previous employee**.
   - The HR case and HR profile are both set to inactive.

If the offboarding request is rejected, the following actions occur.

1. The employment status is set to **Employed** on both the HR case and HR profile.
2. The state of the HR case is set to **Closed Incomplete**.
3. The users assigned to the HR case are notified.

**Employee change workflow in legacy HR**

Review detailed information about the predefined Employee Change HR Workflow to ensure it meets the needs of your organization. The Employee Change HR Workflow is used to request updates to HR profile information that employees and their managers are not authorized to edit.
Typically, organizations allow employees to update certain personal information, but not employment information, which is changed by an HR agent or the employee’s manager. For example, the manager updates the profile when the employee is promoted to a new position.

In the Human Resources Configuration, you can select which HR profile fields can be edited. You can select fields for personal and employment information, and other sensitive information. Employees can update any editable personal information field directly in their HR profiles.

The employment information fields that you enable for edit allow the manager of an employee to update the field. However, the manager cannot open the HR profile of the employee. The manager must submit an employee information change request with the updated information. When the request to change the editable fields is submitted, the HR Employee Change Workflow takes the following actions.

- Opens an HR case.
- Updates the HR profile of the employee.
- Closes the HR case.

To update HR profile fields that are not editable, employees or their managers submit an employee information change request. If the specified user has an HR profile, the record producer places the available data into the corresponding fields. The requester updates the fields to be changed and submits the request which launches the following Employee Change HR Workflow.

- Opens an HR case.
- Sends an approval request to members of the HR group. The notification lists the changes that are being requested and contains links to approve or reject the changes.
- If approval is given, the HR profile is updated and the HR case is closed. Because this is a simple HR profile update, no further notifications are sent.
- If the requested changes are rejected, a comment is added to the HR profile to specify who rejected the request, the HR case is set to Closed Incomplete, and HR agents assigned to the case are notified.

When an HR agent submits an HR employee change request, such as when an employee or manager calls the HR agent, the HR profile is updated and the case is closed. No notifications are sent.

**Customized profile information in legacy HR**

As part of designing the HR processes, you can customize the way HR profile information is processed. Keep in mind that some of the fields that appear are referenced from the User [sys_user] table.

If you have the hr_admin role, you can customize HR profile information.

**Extend profile information**

You can collect additional profile information in a separate table. For example, you can create a Dependents table that extends the HR Profile [hr_profile] table.

Because profile information is sensitive and confidential, the system administrator cannot view it. For more information, see HR profile and HR case security in legacy HR.
**Associate profiles with user records**

An HR profile record must be associated with the employee record in the User [sys_user] table, to ensure that both employee records can be accessed conveniently. During the creation of an HR profile record, you can select the user record to associate with the profile.

With the default employee onboarding process, this association occurs automatically when an onboarding record is created and approved. As a general practice, retain automatic association for onboarding processes you design.

Certain fields are displayed in both the user and HR profile records, but they are in only one of the tables, User [sys_user] or HR Profile [hr_profile]. The following fields are in the User [sys_user] table.

- Prefix [introduction]
- First name [first_name]
- Middle name [middle_name]
- Last name [last_name]
- Manager [manager]
- Department [department]
- Location [location]

**Note:** Bot phone number sync is not supported.

The following table describes the other fields that are synchronized by the Synchronize fields to hr_profile business rule.

<table>
<thead>
<tr>
<th>HR profile [hr_profile] field</th>
<th>User [sys_user] field</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Position [position]          | Title [title]         | Position in the HR profile is a referenced field. The HR profile could not be updated message appears:  
  • When the title is updated in the User form  
  • A position record with the same value does not exist |
| Home address [address]       | Street [street]       | |
| Country [country]            | Country code [country] | Although the field names are the same, these fields are of different types. In the HR profile, [country] is a reference field. In the user record, [country] is a choice list. The country code appears in the User form instead of the country name when the country selected in the HR profile is not in the choice list. |
| Work email [work_email]      | Email [email]         | The HR profile contains both personal and work email fields, while the user record only contains the work email. |

**Note:** The User form must be configured to show address, country, and email fields.
HR Administration for legacy HR

You can define and maintain HR organization data that is used for creating and assigning cases in the non-scoped version of HR.

The following information is set up and maintained as part of administering the Human Resources application.

• Positions that describe employee job functions within the organization
• HR skills that facilitate auto-assignment of HR cases
• Rules that automatically assign cases to specific users or groups
• HR templates and catalog items that are used to create HR cases
• HR profile records

HR managers or administrators set up the information. HR agents can create and maintain HR profile records.

A process must be defined to maintain this data. For example, positions may be redefined, new areas of expertise may be set up within the HR organization, or new HR request processes may be needed. It is important for an HR administrator to define the process and assign responsibility appropriately so the HR data is accurate.

HR surveys in legacy HR

HR surveys let users rate their satisfaction with HR case resolution, and provide management with feedback to improve HR processes, in the non-scoped version of HR.

Two predefined HR surveys are provided: HR Request Satisfaction Survey and HR Exit Survey. HR administrators and HR managers can edit HR surveys and the associated trigger conditions.

The HR Request Satisfaction Survey is triggered randomly for 50% of closed HR cases. Users receive an email with the survey link after they accept the resolution or when the HR case is closed incomplete. The HR Exit Survey is triggered for employees in the offboarding process. It is sent to all offboarding employees when the HR task state is Work in Progress.

HR managers and administrators can review responses by question and see a scorecard. Comments entered by users provide feedback that can be used to improve the performance of HR case management. The following survey options can be configured.

• The look and feel of the questionnaire, for example, by adding the company logo.
• Conditional questions that appear when users answer other questions in a certain way.
• The trigger condition, for example, to send it for every case or to a lower percentage of users.

With trigger conditions, the system generates a survey instance each time a specific action occurs on a given table, such as when an HR request closes. Send a survey every time the condition is met, or set a probability to send a survey at random when the condition is met. Trigger conditions are ideal for sending surveys to measure satisfaction with a recent experience, such as closing an HR request.

Create or modify an HR survey in legacy HR

You can modify the predefined HR satisfaction surveys to suit the needs of an organization, and create additional HR surveys.

Before you begin

Role required: admin, hr_admin, or hr_manager
About this task
For example, you may want to create an HR survey to gauge the satisfaction for more complex HR processes, such as onboarding.

The following steps describe how to work with survey questions in the Survey Definition form. You can also click Survey Designer to open the survey and its questions in the survey designer. When you save the survey, the survey definition is automatically added.

Procedure
1. Navigate to HR • Administration > Surveys > HR Surveys.
2. Click New or open an existing survey.
3. Complete the form.

**Survey Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the survey which appears on the questionnaire.</td>
</tr>
<tr>
<td>Description</td>
<td>Helpful information about the survey.</td>
</tr>
<tr>
<td>Signature</td>
<td>Acknowledgement by a survey recipient of requirements, admonitions, or policies related to the survey. The signature may require the recipient to select a check box or to type in a full signature to verify having read these assertions. You can display assertions without requiring a signature. Select an existing signature from the list or click New to create a new one. The signature form contains these fields: • Name: Descriptive name for this signature. • Signature type: Type of signature required. The selections are Check box, Full name, or Assertion only. If Assertion only is selected, no signature is required to submit the survey. • Assertion: Text you want to display to recipients. By default, a property called Require authentication for user signature is configured to require users to authenticate when providing a full name signature.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the survey definition. When the Active check box is cleared, new survey instances cannot be generated and users cannot complete existing survey instances. Use the Active check box to deactivate or activate a published survey.</td>
</tr>
<tr>
<td>Anonymize</td>
<td>Check box to ensure that all responses for this survey are stored without the submitting user names. When a user submits a survey, the system clears the Assigned to field for the associated survey instance. Also, survey responses for anonymous surveys do not contain Assigned to values. Note: The Assigned to field is cleared. However, each response record includes the Created By and Updated By fields that are accessible to users with the survey_admin role.</td>
</tr>
<tr>
<td>response</td>
<td></td>
</tr>
<tr>
<td>Send</td>
<td>Check box to send a notification that the survey has been taken.</td>
</tr>
<tr>
<td>notifications</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>Status of the survey: Draft or Published.</td>
</tr>
<tr>
<td>Schedule period</td>
<td>Option that determines how often a user can take the same survey and whether the system generates survey instances on a schedule.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create or modify HR survey categories and questions in legacy HR

When an HR survey definition is created, a survey category is automatically added. You can create questions that are associated with this category or define another category for questions.

Before you begin
Familiarize yourself with the Survey question data types before you begin entering questions.

Role required: admin, hr_admin, or hr_manager

About this task
For example, the HR Request Satisfaction Survey has one category, with four questions about satisfaction with the HR request process. You can define another category to ask about satisfaction with the HR agent who handled the case, or you can add more questions to the existing category.

The following steps describe how to work with survey questions in the Survey Definition form. You can also click Survey Designer to open the survey and its questions in the survey designer.

Procedure
1. Navigate to HR > Administration > Surveys > HR Surveys, and open the survey to add questions.

2. In the Metrics Categories related list, complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or edit questions in an existing category</td>
<td>Click the category name.</td>
</tr>
<tr>
<td>Add a category and questions</td>
<td>Click New. Enter the category name and description, right-click the form header, and click Save.</td>
</tr>
</tbody>
</table>

The Survey Category form that appears includes the Assessment Metrics related list, which contains any questions that are already defined.

3. To edit a question, complete the following steps.

   a. Click the question text and edit the fields on the form.

   b. Click Update.

   c. If required by the question type, add definitions in the Assessment Metric Definitions related list.

Example
For example, Likert and numeric scale data types require the scale metric definitions.
4. To add a question, complete the following steps.

   a. Click **New** and complete the form.

   b. Right-click the header and click **Save**.
      Additional fields may appear based on the selected data type. For example, if you select **Choice**, you must enter the scale definition.

   c. If applicable, add definitions in the **Assessment Metric Definitions** related list.
      
      **Example**
      For example, the Choice data type requires that you enter the choices.

5. Click **Update**.
   The Survey Definition reopens.

**Publish a new HR survey in legacy HR**

You must publish a new survey before users can complete it.

**Before you begin**
Role required: admin, hr_admin, or hr_manager

**About this task**
After a survey is published, you can edit it and it remains published. The **State** field on the Survey Definition form indicates whether the survey is published.

**Procedure**
1. Navigate to **HR • Administration > Surveys > HR Surveys**, and open the survey to publish.
2. Click **Publish**.

**Results**
If there are assigned users, the system automatically generates a survey instance. You can click **Send Invitations** to send a notification to the assigned users with a link. Assigned users can also navigate to **Self-Service > My Assessments and Surveys** to take the survey.

**Note:** A survey cannot be returned to the **Draft** state after it has been published. You can, however, deactivate a survey by clearing the **Active** check box.

**What to do next**
If you want employees to receive a link to a survey, such as the HR Request Satisfaction Survey, create a notification. To get the URL of the published survey so it can be included in the notification, click the **View Survey URL** related link. You can copy the URL and paste it as a hyperlink in the notification.

**Create a trigger condition for an HR survey in legacy HR**

When you create a new HR survey, you can add a trigger condition to specify when the survey is sent and to whom.

**Before you begin**
Role required: admin, hr_admin, or hr_manager
**About this task**

Trigger conditions are ideal for sending surveys to measure satisfaction with a recent experience, such as closing an HR request. Some of the descriptions use the Incident table as an example; substitute HR case information to create an HR survey trigger condition.

**Procedure**

1. Navigate to **HR • Administration > Surveys > Trigger Conditions**.
2. Click **New**.
3. Complete the form.

**Trigger condition fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment</td>
<td>Survey to send.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to run the trigger condition on. You can select only tables in the current application scope. For example, to send a survey whenever an incident closes, select the Incident [incident] table.</td>
</tr>
<tr>
<td>User field</td>
<td>Field that stores the users you want to send the survey. You can select any field, on the selected table or on a referenced table, that references the User [sys_user] table. Use the tree picker to select a field.</td>
</tr>
<tr>
<td>Repeat interval</td>
<td>Minimum period that must pass before the trigger condition can resend the survey to the same user. For example, assume the repeat interval is set to 30 days. Even if the same user qualifies for multiple surveys from this trigger condition, the system can send only one survey every 30 days.</td>
</tr>
<tr>
<td>Application</td>
<td>[Admin only] Application is set to Core.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that determines whether this trigger condition is active (selected).</td>
</tr>
<tr>
<td>Business rule</td>
<td>[Admin only] Business rule the system creates to monitor the selected table. When the condition is met, the business rule sends the survey to the correct user. No configuration is necessary for this business rule.</td>
</tr>
<tr>
<td>Trigger randomly</td>
<td>Check box that determines whether to send the survey to the appropriate user every time the condition is met (cleared) or only a percentage of the time (selected).</td>
</tr>
<tr>
<td>Probability (%)</td>
<td>Approximate probability that the survey is sent each time the condition is met. For example, if the probability is set to 50, the system sends the survey approximately 50% of the time the conditions are met. There are no repeat interval restrictions is assumed. This field is visible and required only when Trigger randomly is selected.</td>
</tr>
<tr>
<td>Related Field 1-4</td>
<td>Field that contains a value you want to store for reporting purposes. You can pick any reference field on the selected table. When the trigger condition...</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>generates a survey instance, the system stores the value from the triggering record. Specify up to four fields. For example, select the Incident table, <strong>Assigned to</strong> and <strong>Problem</strong> as related fields. The system stores the assigned user and problem associated with the incident as Related record 1 and Related record 2 in the survey instance record. To view the fields, configure the form for any survey instance. <strong>Note:</strong> You cannot use a related field for the ticket number because you cannot select the Number column. You can, however, use the trigger_id column of the table.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Summary information to identify the trigger condition. <strong>Note:</strong> For a triggered record, the table title is used for the survey description.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition builder that defines the criteria that must be true to send the survey. For example, to send a survey whenever an incident closes, create the condition <strong>[State]</strong> [is] <strong>[Closed]</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Knowledge management in legacy HR**

An important benefit of the HR system is the Human Resources knowledge base that can contain policies, benefits, holiday schedules, and so on, in the non-scoped version of HR.

HR knowledge management allows you to create and maintain articles specific to HR and share them across the organization. The Human Resources application provides the Human Resources General Knowledge base specifically for this content. Benefits of using this knowledge base include:

- Employees have one source of information that is easy to search.
- Information can be kept up-to-date, as knowledge articles have a defined life cycle: Create, review and update, publish, and retire.
- Contextual search of the HR knowledge base is performed during HR case entry based on words entered in the short description. A list of the relevant articles displays automatically. If an article answers the question, the employee does not need to submit the case.
- HR agents can attach knowledge articles to HR cases to respond to the employee request.

Organizations may have different HR policies and benefits packages based on location or business unit. For example, holiday schedules and medical benefits may vary by country, or different policies may be in effect for a manufacturing plant than for your corporate offices. You can define multiple HR knowledge bases as needed, and define user criteria to specify which knowledge base users have access to.

It is important to assign a knowledge manager to each HR knowledge base. Users with the hr_kb_writer role can create and edit HR knowledge articles. The HR knowledge manager has the following responsibilities.

- Ensure that the HR knowledge base contains all the HR documentation.
- Devise a way to identify missing content, such as questions from employees that are not answered in knowledge articles, and to add the content.
- Implement a process for HR knowledge article life cycle: Author, review, update, publish, and retire.
- Schedule regular review of content so it can be updated or retired.
HR knowledge articles are managed through **HR • Administration > Knowledge Management** modules.

**Attach a knowledge article to an HR case in legacy HR**

You can add a knowledge article to an HR case to help process that record. For example, you can attach an article about the company dress code policy when an HR case is submitted that asks about wearing shorts to work.

**Before you begin**
Role required: hr_basic or hr_case_writer

**Procedure**

1. Navigate to **HR • Case Management > Case Management** and open one of the modules, such as **Assigned to me** or **Open**.
2. Open the HR case.
3. Click **Knowledge results**.
4. A list of **Knowledge results** appears below the comments based on keywords in the text. There are two tabs of results based on the user criteria that is associated with the knowledge base.
   - **My Results** displays a list of articles you can access.
   - **[employee name] Results** displays a list of articles that the **Opened for** employee can access.
5. Review the list of suggested knowledge articles, and do any of the following:
Option | Description
--- | ---
**Preview the article** | Click **Preview** next to the article. After reviewing the article in the pop-up window, click **Attach to HR Case** if it is relevant, or click (X) to close the article.

**Attach the article without previewing it** | Click **Attach** next to the article.

*Note:* When you attach an article, its text is copied to **Additional comments**. After you save the case, it appears also in the **Attached Knowledge** related list.

6. Click **Save**.

7. Alternatively, to attach a knowledge article in the **Attached Knowledge** related list, complete the following steps.

a. In the **Attached Knowledge** related list, click **Edit**.

b. **Optional:** If necessary, change the knowledge base to search within.

c. To search for articles based on content in the article, add a condition, for example, **[Short description] [contains] [dress code]**, and click **Run filter**.

d. Select the knowledge base number in the **Collection** list and click the right arrow to move it to the **Attached Knowledge List**. When you select an article number, its topic and short description appear below the list.

e. Click **Save**.

**Organization in legacy HR**

You can create, modify, view, define, and maintain employee data for your organization, in the nonScoped version of HR.

Organization information is set up and maintained as follows.

* HR profiles within the organization
* User directory with all users in the organization (view only)
* Organization positions
* Organization locations (view only)
* Organization departments (view only)

HR managers or administrators set up the information. HR agents can create and maintain HR profile records and positions within the organization.
Maintaining this data requires a defined process. Positions may be redefined, new areas of expertise may be set up within the HR organization, or new HR request processes may be needed. It is important for an HR administrator to define the process and assign responsibility appropriately so the HR data is accurate.

**HR profiles within the organization in legacy HR**

HR profile records store confidential employee data, such as name, personal contact information, email addresses, employment history, and contacts, in the non-scoped version of HR.

HR profile records enable the organization to access and track employee information throughout the period of employment and beyond. HR profile records are associated with user records, but unlike user records, HR profile records are stored confidentially and are not publicly viewable.

HR profile records are created as part of an HR process, such as the onboarding process. The default onboarding process creates an HR profile record for the new employee and automatically associates the profile record to the employee user record when the onboarding case is approved.

Organizations can use an integration method to populate HR profile records from their employee database. In addition, an HR profile is created automatically for **Employee Data Management Cases**.

**Note:** HR profiles are automatically created or modified when the HR case category is **New Hire Onboarding**, **Employee Information Change**, **Employee Offboarding**, or **Employment Verification Letter**.

Besides basic user information that is also in the user record, the HR profile includes the following sections and related lists.

<table>
<thead>
<tr>
<th><strong>HR profile sections and related lists</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section or related list</strong></td>
</tr>
<tr>
<td>Notes</td>
</tr>
<tr>
<td>Employment Information</td>
</tr>
<tr>
<td>Contact Information</td>
</tr>
<tr>
<td>Emergency Contacts</td>
</tr>
<tr>
<td>Employment History</td>
</tr>
<tr>
<td>Direct Reports</td>
</tr>
<tr>
<td>Colleagues</td>
</tr>
<tr>
<td>Cases</td>
</tr>
</tbody>
</table>
HR profile and HR case security in legacy HR

Because HR profile information is sensitive and confidential, it is secured from being viewed by the system administrator. The same is true for some of the information in HR cases and HR tasks.

In the system, system administrators with the admin role are able to perform all tasks and view all data. However, HR profile information is confidential and should be viewed only by authorized HR personnel who are assigned a role that includes hr_profile_reader or hr_profile_writer, such as hr_basic.

Similarly, for HR cases and HR tasks, only authorized HR personnel should be allowed to view attachments, work notes and comments, description, calendar, and payload (if your company configured the form to show the Payload field). Authorized HR personnel include those who are assigned a role with hr_case_reader and hr_task_reader, such as hr_basic.

Therefore, access to specific HR profile, case, and task data is restricted from view by users with the admin role.

HR profile information that system administrators can access

System administrators cannot create a new HR profile. They can see the list of HR profiles and open HR profile records, but have access only to the following information.

• The HR profile number and employee’s prefix.

• Employment information that is synchronized with the user record [sys_user]. This includes name, employee number, department, manager, and location.

• Work contact information, such as work email address and work phone number. Personal information is hidden.

• Comments. Work notes are hidden.

• Information that appears in the following related lists.
  ◦ Emergency Contacts
  ◦ Employment History
  ◦ Direct Reports
  ◦ Colleagues
  ◦ Cases

HR case and HR task information that system administrators can access

System administrators can view the employee user information, such as location and department, and the short description. Activities, such as state changes, are displayed in the activity stream, but comments and work notes are hidden.

When the system administrator opens an HR case or HR task, a message describes the information that is not displayed.

Impersonating a user

If the system administrator impersonates a user, even if the impersonated user has an HR role that allows access to the HR profile, the system administrator is restricted from viewing HR profile information. The following constraints are applied when a user is impersonated.

• If the impersonated user has HR profile access, the HR profile list displays a message that the records are removed based on security constraints. No HR profile records are listed.

• For any impersonated user, the My Profile link from the HR Service Portal displays no profile information. It displays only information in the related lists described above.
Customized profile information in legacy HR

As part of designing the HR processes, you can customize the way HR profile information is processed. Keep in mind that some of the fields that appear are referenced from the User [sys_user] table.

If you have the hr_admin role, you can customize HR profile information.

Extend profile information

You can collect additional profile information in a separate table. For example, you can create a Dependents table that extends the HR Profile [hr_profile] table.

Because profile information is sensitive and confidential, the system administrator cannot view it. For more information, see HR profile and HR case security in legacy HR.

Associate profiles with user records

An HR profile record must be associated with the employee record in the User [sys_user] table, to ensure that both employee records can be accessed conveniently. During the creation of an HR profile record, you can select the user record to associate with the profile.

With the default employee onboarding process, this association occurs automatically when an onboarding record is created and approved. As a general practice, retain automatic association for onboarding processes you design.

Certain fields are displayed in both the user and HR profile records, but they are in only one of the tables, User [sys_user] or HR Profile [hr_profile]. The following fields are in the User [sys_user] table.

- Prefix [introduction]
- First name [first_name]
- Middle name [middle_name]
- Last name [last_name]
- Manager [manager]
- Department [department]
- Location [location]

**Note:** Bot phone number sync is not supported.

The following table describes the other fields that are synchronized by the Synchronize fields to hr_profile business rule.

<table>
<thead>
<tr>
<th>HR profile [hr_profile] field</th>
<th>User [sys_user] field</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Position [position]          | Title [title]         | Position in the HR profile is a referenced field. The HR profile could not be updated message appears:  
  • When the title is updated in the User form  
  • A position record with the same value does not exist |
| Home address [address]       | Street [street]       |
Fields synchronized using the business rule (continued)

<table>
<thead>
<tr>
<th>HR profile field</th>
<th>User field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country [country]</td>
<td>Country code [country]</td>
<td>Although the field names are the same, these fields are of different types. In the HR profile, [country] is a reference field. In the user record, [country] is a choice list. The country code appears in the User form instead of the country name when the country selected in the HR profile is not in the choice list.</td>
</tr>
<tr>
<td>Work email [work_email]</td>
<td>Email [email]</td>
<td>The HR profile contains both personal and work email fields, while the user record only contains the work email.</td>
</tr>
</tbody>
</table>

Note: The User form must be configured to show address, country, and email fields.

Create or modify an HR profile in legacy HR

Employees can directly edit some information in their HR profile, such as emergency contact information, but they are restricted from editing certain fields. If employees want to change information that they are restricted from editing, they must submit requests to HR for the changes.

Before you begin
Role required: hr_profile_writer, hr_basic, or hr_manager

About this task
The HR administrator [hr_admin] can configure which HR profile fields an employee can update. The employee submits an HR employee information change request for information that cannot be updated. To update the HR profile when an employee information change request is assigned to you, complete the following steps.

Procedure
1. Navigate to HR • Administration > Organization > HR Profiles.
   The HR Profiles list opens.
2. Find the existing HR Profile to update by selecting User from the HR Profiles list dropdown search menu. You can type the user name, and pressing Enter. Also, you can click a profile number to open a user profile.
   To create an HR profile, click New from HR Profiles. Type the user name in the User field on the HR Profile New record form to create the profile. You cannot change the user name after an HR profile is saved.
3. Click the profile number to open the user profile.
   The profile opens displaying populated name, manager, department, location, and contact fields from the user record.
4. Complete or update the form with as much additional information as you have.

HR profile sections and related lists

<table>
<thead>
<tr>
<th>Section or related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Comments and work notes.</td>
</tr>
<tr>
<td>Section or related list</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Employment Information</td>
<td>Information such as employment status and type of employment, employee number, and start and end dates.</td>
</tr>
<tr>
<td>Contact Information</td>
<td>Information such as address, phone number, personal email address. Some field values are copied from the onboarding form.</td>
</tr>
<tr>
<td>Emergency Contacts</td>
<td>A list of the employee emergency contacts. One contact in the list is designated as the primary and others can be entered as alternates.</td>
</tr>
<tr>
<td>Employment History</td>
<td>List of prior employers and dates of employment.</td>
</tr>
</tbody>
</table>

The following related lists are automatically populated. You can view records in the list, but you cannot enter new records from the related list.

- Direct Reports: List of the employees who report directly to the user.
- Colleagues: List of other employees who have the same manager as the user.
- Cases: Open HR cases for the user.

5. Click **Submit** or **Update**.

**Note:** Some HR profile information, such as department, is synchronized between the User [sys_user] and HR Profile [hr_profile] records. Updating information in one record automatically applies the updates in the other record.

**View the user directory in legacy HR**

HR user directory is a view of the corporate user directory with HR case information in a related list.

**Before you begin**

Role required: admin, hr_admin, hr_basic, or hr_manager

**About this task**

Corporate user directory refers to the records in the User [sys_user] table.

**Procedure**

1. Navigate to **HR • Administration > Organization > User Directory**.
2. Click a user record to view or edit the Human Resources view of a user record. This view is a subset of the user information, including job information and contact details. In addition, there are two related lists:
   - **HR Cases**: Lists all HR cases for a user.
   - **Users**: Lists users managed by that user.

**Define organization positions in legacy HR**

As part of the Human Resources setup process, you define positions to describe employee job functions within the organization. Positions are associated with employees in the HR profile, in the non-scoped version of HR.

**Before you begin**

Role required: admin, hr_admin, hr_position_writer, hr_basic, hr_dispatcher, or hr_manager
About this task
Create position records for your organization. Other organization information, such as location and department information, is already set up in the ServiceNow system and used in User [sys_user] records.

Procedure
1. Navigate to **HR • Administration** > **Organization** > **Positions**.
2. Click **New** to create a position, or click an entry to open an existing position.
   If you view an existing position, the **HR Profiles** related list displays HR profiles of users assigned to the position.
3. Enter the **Position** title and select the **Department**.
4. Click **Submit** or **Update**.

View organization locations in legacy HR
Location records store the address and contact details for each site in your organization and are assigned in the HR profile and user records of an employee, in the non-scoped version of HR. The location of an HR agent can be used for automatic assignment of HR cases.

Before you begin
Role required: admin or hr_basic

About this task
HR agents can view locations but do not have permission to update them.

Procedure
1. Navigate to **HR • Administration** > **Organization** > **Locations**.
2. Click a location name to view details for that location.

Related information
   Configuration in legacy HR

View organization departments in legacy HR
Departments are assigned in an employee’s user profile and are synchronized to the HR profile, in the non-scoped version of HR.

Before you begin
Role required: admin or hr_basic

About this task
HR agents can view departments but do not have permission to update them.

Procedure
1. Navigate to **HR • Administration** > **Organization** > **Departments**.
2. Click a department name to view details for that department.
HR catalog and templates in legacy HR

HR catalog and templates contain the catalog items and templates that employees use to request HR assistance, in the non-scoped version of HR. Predefined catalog items have an associated HR case category and HR case template.

You can review and modify the predefined catalog items as needed. You can create catalog items to use for other types of HR requests that are important to your organization. Maintain a 1:1 relationship between the catalog item, HR case category, and HR case template. Doing so makes it easier to organize items in the catalog, manage case workload, and produce reports. Manage HR Catalog module lets you create catalog items and automatically create the HR case category and HR case template.

Terms used with the HR catalog

Several terms used throughout the Human Resources application are synonymous with each other. These items are often referred to one way in the navigator, but when you open the module the name at the top is different. The following list includes terms used for items associated with the HR catalog.

<table>
<thead>
<tr>
<th>Term</th>
<th>Synonymous with term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog item</td>
<td>Record producer</td>
</tr>
<tr>
<td>HR request</td>
<td>HR case</td>
</tr>
<tr>
<td>HR template</td>
<td>Product model or Model</td>
</tr>
<tr>
<td>Knowledge article</td>
<td>Knowledge model</td>
</tr>
</tbody>
</table>

It is also important to understand the two types of HR categories.

• HR catalog categories, which are used to group catalog items in the HR Service Portal or HR Catalog.

• HR case categories, which are used for reporting and selected to assign a template to an HR case. Typically used when an HR agent is entering a case for a caller through HR • Case Management > Case Management > Create New Case.

Catalog item planning and creation

The following outlines a process to use when planning for and creating catalog items.

1. Define the new catalog item: Determine the purpose of the HR request, and whether it needs variables, tasks, or both.
   • Variables are used to ask questions and to map the answers to fields, such as the comment field.
   • Tasks are used to define work that must be completed in a specified order before the request can be completed. Tasks can be assigned to different HR agents.

2. Create the catalog item: Use the Manage HR Catalog module to create a catalog item. It provides a simplified form where you enter a name and description, and select a catalog category, assignment group, and default priority.

   You can submit or publish the catalog item. If you click Submit, the catalog item is saved but is not active. You can then update it, for example, to add variables, before you publish it. You can publish the catalog item to make it active immediately.

   When you submit or publish in the simplified form, a catalog item, HR case category, and HR case template are all created.
3. Modify the catalog item: After you create the catalog item, you can access the catalog item or the HR case template from the Manage HR Catalog page. Access the HR case template to add fields, define required skills and assignment group, and add tasks. Access the catalog item to add variables and specify user criteria.

Related information
- How cases and tasks are assigned in legacy HR
- Create or modify an HR skill in legacy HR

HR onboard and offboard task templates in legacy HR
HR onboard and offboard task templates contain the catalog items and templates that define the onboarding and offboarding tasks, in the non-scoped version of HR.

HR onboarding and offboarding task templates define the tasks for onboarding a new hire or offboarding an employee leaving the company.

- You can have multiple templates.
- The system prevents duplicated tasks.
- Conditions determine template assignment.
- Each template can have multiple conditions.
- If no conditions are defined, the template is assigned to every onboarded or offboarded employee.

Create or modify an offboarding task template in legacy HR
Offboarding task templates allow you to define assignment tasks for employees leaving the company.

Before you begin
Role required: hr_admin or hr_basic

About this task
You can create offboarding task templates or modify existing ones.

Procedure
1. Navigate to HR • Administration > Catalog & Templates > Offboarding Task Templates. The Task templates list opens and displays offboarding task templates.
2. Click New to create an offboarding template or open an existing template to modify.
3. The Task templates page opens.
4. Edit the fields as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this template.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to activate the template.</td>
</tr>
<tr>
<td>HR Category</td>
<td>The group of HR catalog items associated with the offboarding task template.</td>
</tr>
<tr>
<td>Condition</td>
<td>Use the following to create conditions that when met, trigger the use of the offboarding task template.</td>
</tr>
</tbody>
</table>
Add Filter Condition | Click after the first condition is defined to add more conditions. Skip to the choose field to create first condition.

And "OR" Clause | Click to create more conditions. Skip to the choose field to create first condition.

--choose field-- | Select a filter condition.

--oper-- | Select how to filter the condition.

--value-- | Click and select a value defining the filter condition.

• Location in --choose field--
• is in --oper--
• California in --value--

Creates a condition that assigns this template to all offboarded employees in California.

Description | Information about this offboarding task template.

5. Click the Form context header and Save to save the template and remain on the Task templates Onboarding page or Submit and return to the Task templates page.

6. To assign offboarding tasks, click Edit.

HR task template fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add filter</td>
<td>Click to add more filters. To run one filter, go to --choose field--.</td>
</tr>
<tr>
<td>Run filter</td>
<td>Click after entering the filter criteria to narrow your search of tasks.</td>
</tr>
<tr>
<td>--choose field--</td>
<td>Select a filter to narrow your search of tasks.</td>
</tr>
<tr>
<td>--oper--</td>
<td>Select how to filter the condition.</td>
</tr>
<tr>
<td>--value--</td>
<td>Enter a value to filter.</td>
</tr>
</tbody>
</table>

You can select Assignment group, is, and enter HR to display only tasks assigned to HR.

Collection | Select and move onboarding tasks to the right column. |

Tasks are defined in HR Templates.

7. Click Save and the Task templates page displays.

Create or modify an onboarding task template in legacy HR

Onboarding task templates allow you to define assignment tasks for onboarding new employees.

Before you begin

Role required: hr_admin or hr_basic
About this task
You can create onboarding task templates or modify existing ones.

Procedure
1. Navigate to **HR • Administration > Catalog & Templates > Onboarding Task Templates**.
   Task Templates list opens and displays onboarding task templates.
2. Click **New** to create an onboarding task template or open an existing template to modify.
3. The **Task templates** page opens.
4. Edit the fields as needed.

**HR task template fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this template.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to activate the template.</td>
</tr>
<tr>
<td>HR Category</td>
<td>The group of HR catalog items associated with the onboard template.</td>
</tr>
<tr>
<td>Condition</td>
<td>Use the following to create conditions that when met, trigger the use of the onboarding template. Default templates have the conditions left blank. Default templates are assigned to all onboarded employees.</td>
</tr>
<tr>
<td>Add Filter</td>
<td>Click after the first condition is defined to add more conditions. Skip to the <strong>choose field</strong> to create first condition.</td>
</tr>
<tr>
<td>Condition</td>
<td>Click to create more conditions. Skip to the <strong>choose field</strong> to create first condition.</td>
</tr>
<tr>
<td>--choose field--</td>
<td>Select a filter condition.</td>
</tr>
<tr>
<td>--oper--</td>
<td>Select how to filter the condition</td>
</tr>
<tr>
<td>--value--</td>
<td>Click and select a value defining the filter condition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong> in <strong>--choose field--</strong></td>
</tr>
<tr>
<td></td>
<td>• is in <strong>--oper--</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>California</strong> in <strong>--value--</strong> Creates a condition that assigns this template to all onboarded employees in California.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about this onboarding task template.</td>
</tr>
</tbody>
</table>

5. Click the **Form context header** and **Save** to save the template and remain on the **Task templates Onboarding** page or **Submit** and return to the **Task templates** page.

6. To assign onboarding tasks, click **Edit**.

**HR task template fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add filter</td>
<td>Click to add more filters. To run one filter, go to <strong>--choose field--</strong>.</td>
</tr>
<tr>
<td>Run filter</td>
<td>Click after entering the filter criteria to narrow your search of tasks.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--choose field--</td>
<td>Select a filter to narrow your search of tasks.</td>
</tr>
<tr>
<td>--oper--</td>
<td>Select how to filter the condition.</td>
</tr>
<tr>
<td>--value--</td>
<td>Enter a value to filter. You can select Assignment group, is, and enter HR to display only tasks assigned to HR.</td>
</tr>
<tr>
<td>Collection</td>
<td>Select and move onboarding tasks to the right column. Tasks are defined in HR Templates.</td>
</tr>
</tbody>
</table>

7. Click Save and the Task templates page displays.

### Manage HR catalog categories in legacy HR

HR catalog categories provide a way to group HR catalog items, in the non-scoped version of HR. For example, the HR Benefits catalog category contains catalog items such as Retirement and Vacation.

### Before you begin

Role required: admin, hr_manager, or hr_admin

### About this task

When you create an HR catalog category, assign a catalog item to the category to publish the new catalog category to the HR Service Portal and HR Catalog. An HR case category and HR case template are created automatically.

### Procedure

1. Navigate to **HR • Administration > Catalog & Templates > Manage HR Catalog**.

2. To create or modify a catalog category, perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a catalog category</td>
<td>Click New Category, enter the category name and description, and click Submit.</td>
</tr>
<tr>
<td>Edit an existing catalog category</td>
<td>Point your cursor to the category and click the edit icon. Modify the category or description fields as needed and click Submit.</td>
</tr>
</tbody>
</table>

3. To assign HR catalog items to a category, select the HR category in the list on the left and complete the following steps.
   
   a. Click **Assign / Remove Catalog Items**.
   
   b. Select the catalog items to assign and deselect catalog items to remove.
   
   c. Click **Save**.

4. To assign a category to a catalog item, select **All Catalog Items** in the list on the left and complete the following steps.
   
   a. Locate the catalog item on the right and open the **Categories** choice list.
   
   b. Select the categories to assign the catalog item, and deselect the categories to remove the assignment.
   
   c. Click **Save**.
Create an HR catalog item in legacy HR

You can create an HR catalog item from the Manage HR Catalog module, in the non-scoped version of HR.

Before you begin
Role required: admin, hr_manager, or hr_admin

About this task
When you create a new HR catalog item from the Manage HR Catalog module, an associated HR case category and HR case template are created automatically.

Procedure
1. Navigate to HR • Administration > Catalog & Templates > Manage HR Catalog.
2. Select the HR category in the list on the left that contains the new catalog item.
3. Click New Catalog Item.
4. Enter the catalog item Name and Short description. The short description is used to help the employee make a selection from the HR catalog. It also appears in the Short description field when an employee selects the catalog item.
5. Select the Catalog category from the choice list.
6. Optional: Select the HR Assignment group to enable an HR agent to be auto-assigned when this catalog item is submitted.
7. Optional: Change the Priority to higher or lower when necessary.
8. Click Publish to save the catalog item and make it available for use immediately. When you click Submit, the catalog item is saved, but is not active. You can update it, for example to add variables, before you publish it.

The following three items are created.
• Catalog item that includes the hrsm_benefit_questions variable set. The defined fields include Opened for, Priority, Short description, and Question. Contextual search of the knowledge base is enabled also for the Short description field.
• HR case category with the name of the catalog item.
• HR template with the name of the catalog item.

What to do next
When you want to customize the new, published catalog item, for example, to add variables, point and click the edit icon that appears. If you submitted the catalog item without publishing it, its listing has a gray background. When you edit it, be sure to check Active to enable it for use.

To edit the associated HR case template, you can click the template icon next to the edit icon. Follow the steps in Modify an HR case template in legacy HR.
Add a knowledge article to an HR category item in legacy HR

You can add a knowledge article to an HR category item to help users access information pertaining to the category, in the non-scoped version of HR. For example, you can attach an article about the company dental benefits to the Dental Benefits category item.

Before you begin
Role required: admin, hr_manager, or hr_admin

Procedure
1. The easiest way to add a knowledge article to a category item is to navigate to HR • Administration > Catalog & Templates > Manage HR Catalog.
2. Click the category item you want to add a knowledge article to, such as Dental Benefits. Three icons appear in the bottom right corner of the category item.
3. Click the Manage KB articles icon. The Catalog Item to KB Links list opens.
4. Click New to open the Catalog Item to KB Links new record form.
5. Fill in the required fields, using the reference lookup icon where available.

Catalog Item to KBLinks fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the knowledge article. Can be the actual name of the article.</td>
</tr>
<tr>
<td>Catalog Item</td>
<td>Catalog item to link the knowledge article to, such as Dental Benefits.</td>
</tr>
<tr>
<td>Knowledge Article</td>
<td>Knowledge article to link to the catalog item. such as Dental Benefits Enrollment Form.</td>
</tr>
<tr>
<td>Managed Document</td>
<td>Controlled internal document, such as an insurance provider Dental Claim Form.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies the category item is in use.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the articles are processed in the list. Articles with lower-order numbers appear in the list first.</td>
</tr>
</tbody>
</table>

Modify an HR case template in legacy HR

HR case templates are used to create HR catalog items, in the non-scoped version of HR. HR case templates specify what actions are taken when a certain type of HR case is submitted.

Before you begin
Role required: admin or model_manager

About this task
Several predefined HR case templates are used in HR catalog items. You can modify the predefined HR case templates or create ones.
The easiest way to create catalog items is from the Manage HR Catalog module. When you create a catalog item, an associated HR case category and template are also created. You can then customize the HR case template, for example, to add variables. The following list includes ways to customize an HR case template.

- Specify required skills and assignment group or user.
- Define tasks for HR agents that must be completed.
- Define the order of task completion by assigning a task dependency.

A template can have attached knowledge models. A knowledge model is a knowledge article that is associated with the template. When a new case is created, the knowledge article is automatically assigned to the case to provide information to the HR agent.

You can edit an HR case template after you create the catalog item in the Manage HR Catalog module. If you click the edit HR case template icon for the new catalog item, it opens the same form described in the following steps.

**Procedure**

1. Navigate to **HR • Administration > Catalog & Templates > HR Templates**. The Product Models list opens and displays both HR case and HR task templates. Look at the **Model categories** field to determine whether you are opening an HR case or HR task template.

2. Open an HR case template to modify. If you are creating a template from the list, select **HR Case Model** in the Interceptor page.

3. Complete the form or edit the fields. As you enter information, you can click the min and max buttons to the right of the **Name** field to collapse and expand the displayed fields. The fields listed in the table are from the HR case template that is automatically created with a catalog item from the Manage HR Catalog module.

**HR case template fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this template.</td>
</tr>
<tr>
<td>Short description</td>
<td>Content that is copied into the <strong>Short description</strong> field of an HR request when this HR case template is used to submit an HR request from the associated catalog item.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description copied into an HR request created from this template.</td>
</tr>
<tr>
<td>Checklist template</td>
<td>An informal list of questions or tasks used as a reminder for the HR agent working on this case.</td>
</tr>
<tr>
<td>Workflow</td>
<td>The workflow used to process an HR case from this template.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The HR group to assign to a case or task when this template is used. The HR group provides the list of HR agents for auto-assignment.</td>
</tr>
<tr>
<td>Skills</td>
<td>The skills that the HR agent must have to be assigned to this case or task. Select as many skills as are needed. Click away from the selection list to close it. Your organization configures whether to use skills for auto-assignment.</td>
</tr>
<tr>
<td>Priority</td>
<td>The default priority when the HR request is created from this template.</td>
</tr>
<tr>
<td>Billable</td>
<td>Does not apply to HR cases.</td>
</tr>
</tbody>
</table>
### Field Description

The following field is used in several of the predefined templates. Edit fields and add this field to the template to use it in a new catalog item.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspended reason</td>
<td>Information on why the HR agent may need to suspend the parent HR case.</td>
</tr>
<tr>
<td></td>
<td>Selecting one of the following options places the associated related link in</td>
</tr>
<tr>
<td></td>
<td>the HR task.</td>
</tr>
<tr>
<td></td>
<td>• User: Request additional user info</td>
</tr>
<tr>
<td></td>
<td>• Document: Request document</td>
</tr>
<tr>
<td></td>
<td>• Other, Company, Group: Suspend case</td>
</tr>
</tbody>
</table>

### Task information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Task Template</td>
<td>The task template to use for this task, if any. Click the link, and then select the template from the choice list.</td>
</tr>
<tr>
<td>Task type</td>
<td>The type of task. <strong>HR Task</strong> should be selected.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique and descriptive name for the task. If you are entering a name for a new task, fields for an extra task appear.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you enter information in any of the other fields for a task, the Name field is required.</td>
</tr>
<tr>
<td>Description</td>
<td>Content that is copied into the description of the task when this HR case template is used.</td>
</tr>
<tr>
<td>Depends on</td>
<td>The task that must be completed before this task can be performed. Options appear in this list after you have created subsequent tasks.</td>
</tr>
<tr>
<td>Checklist template</td>
<td>An informal list of questions or tasks used as a reminder for the HR agent working on this task.</td>
</tr>
</tbody>
</table>

4. To add more fields for either the request or task sections, complete the following steps.

   a. Click **Edit Fields**.
      An add field choice list appears in the **Request information** and **Task information** sections.

   b. Select the field to add.
      The field is added to the form and you can add more fields, if desired.

5. To attach a knowledge model to the template, scroll to the **Model knowledges** related list.

6. Complete the following steps for every knowledge model to add.

   a. Click **New**.
   b. Click the lookup icon beside the **Knowledge** field.
   c. Locate the knowledge article to add and click its number.
   d. Click **Submit** in the **Model Knowledge** form.

7. Click **Save**.
   A new HR task template is created for each HR task you added to the HR case template.
Modify an HR task template in legacy HR

HR task templates are created automatically when you add tasks to an HR case template, in the non-scoped version of HR. HR task templates allow you to define assignment rules for the HR tasks.

Before you begin
Role required: admin or model_manager

About this task
Several HR task templates are predefined, and others may be added as you create HR case templates with associated HR tasks. You can modify any HR task template.

Procedure
1. Navigate to HR • Administration > Catalog & Templates > HR Templates.
   The Product Models list opens and displays both HR case and HR task templates. Look at the Model categories field to determine whether you are opening an HR case or HR task template.
2. Open an HR task template to modify.
3. Edit the fields as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Task Template</td>
<td>The task template to use for this task, if any. Click the link, and then select the template from the choice list.</td>
</tr>
<tr>
<td>Task type</td>
<td>Type of task.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique and descriptive name for this template.</td>
</tr>
<tr>
<td>Short description</td>
<td>Content that is copied into the Short description field of an HR task when this template is used.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about this HR task template.</td>
</tr>
<tr>
<td>Checklist template</td>
<td>An informal list of questions or tasks used as a reminder for the HR agent working on this task.</td>
</tr>
<tr>
<td>Acknowledgement document</td>
<td>Document sent to employee as part of a data management task. Documents are created and maintained in Managed Documents or PDF Document Templates.</td>
</tr>
<tr>
<td>Estimated work duration</td>
<td>Estimated amount of time it takes to complete the task in days, hours, and minutes.</td>
</tr>
<tr>
<td>Acknowledgement type</td>
<td>Method of verification that a data management task was completed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assign to opened for</td>
<td>Check to have task assigned to employee. Leave unchecked to have task assigned to HR</td>
</tr>
<tr>
<td>Days due before start</td>
<td>The number of days before the start date of the employee being onboarded that the onboarding task is due.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The HR group to assign to a case or task when this template is used. The HR group provides the list of HR agents for auto-assignment.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Related information**

**Checklists**

**View or modify HR case categories in legacy HR**

You can view and modify the HR case categories that are created automatically when you create a new catalog item in the Manage HR Catalog module, in the non-scoped version of HR.

**Before you begin**

Role required: admin or hr_admin

**About this task**

In the Human Resources application, there is a 1:1 relationship between a catalog item, an HR case category, and an HR case template. If an HR agent creates a new HR case without using a catalog item, selecting the category also selects the associated template. This populates some fields in the form, such as assignment group. Use the Manage HR Catalog module to view case categories and modify them as necessary.

**Procedure**

1. Navigate to **HR • Administration > Catalog & Templates > HR Categories**.
2. Select the category to view or modify.
   - You can create a new HR case category, but it is recommended that you use the Manage HR Catalog module to create catalog items and associated categories.
3. Review the details and edit them as needed.
   - If you need to change the template, only templates that are not assigned to a category are listed. The HR case type is useful for filtering reports.
4. **Optional**: To disable a category you no longer use, clear the **Active** check box.
5. If you made changes, click **Update**.

**HR case categories in legacy HR**

HR case categories are associated with HR catalog items. There is a 1:1 relationship between HR case categories and HR catalog items.

The following HR case categories are predefined. Administrators can create new HR categories in the HR Categories module and define catalog items to use the categories. New catalog items can be created in the Manage HR Catalog module, and the associated HR case category is created automatically.
<table>
<thead>
<tr>
<th>HR categories</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Category</strong></td>
<td><strong>Description</strong></td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td><strong>401(k)</strong></td>
<td>Ask about the 401(k) plan.</td>
<td>How much can I contribute from each paycheck?</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Manage your beneficiaries.</td>
<td>Decide who will receive your insurance benefits should you die and what percentage should be distributed.</td>
</tr>
<tr>
<td>Career guidance</td>
<td>Ask a question regarding your career growth and opportunities.</td>
<td>What do I have to do to get a promotion to senior level?</td>
</tr>
<tr>
<td>Dental Benefits</td>
<td>Enroll, modify, or ask a question about your dental benefits.</td>
<td>Does my dental insurance cover braces?</td>
</tr>
<tr>
<td>Direct Deposit</td>
<td>Enroll, modify, or ask a question about direct deposit.</td>
<td>Can I deposit my paycheck into two different bank accounts?</td>
</tr>
<tr>
<td>Disciplinary Issue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Employee change</td>
<td>Ask for an update to the HR profile.</td>
<td>How do I change my employee's status from temp to permanent?</td>
</tr>
<tr>
<td>Employee Information Change</td>
<td>Request an employee personal information change.</td>
<td>My status has changed from single to married.</td>
</tr>
<tr>
<td>Employee Offboarding</td>
<td>Request to offboard an employee.</td>
<td>I need to offboard an employee.</td>
</tr>
<tr>
<td>Employee relations</td>
<td>Ask an employee relations question.</td>
<td>What should I do about two employees constantly arguing?</td>
</tr>
<tr>
<td>Employment verification</td>
<td>Request a verification of employment.</td>
<td>I need verification of employment for my loan.</td>
</tr>
<tr>
<td>Employment Verification Letter</td>
<td>Request an employment verification letter.</td>
<td>I need a letter sent to my bank to verify employment for my loan.</td>
</tr>
<tr>
<td>General</td>
<td>Ask a general question for which a specific record producer does not exist.</td>
<td>Does the company organize an end-of-year party for its employees?</td>
</tr>
<tr>
<td>Grievance</td>
<td>File a grievance complaint.</td>
<td>My office mate talks on the speaker phone and I can't concentrate on my work.</td>
</tr>
<tr>
<td>HR Password Reset</td>
<td>Request password reset for an HR system.</td>
<td>I need my HR password reset.</td>
</tr>
<tr>
<td>HR Portal Support</td>
<td>Ask a question about the HR portal or request HR Portal support.</td>
<td>I have a technical issue.</td>
</tr>
<tr>
<td>HR System Access</td>
<td>Request or modify access to HR systems.</td>
<td>I need access to a particular system.</td>
</tr>
<tr>
<td>HR System Reports</td>
<td>Request or ask a question about an HR report.</td>
<td>I need access to a particular report.</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Leave</td>
<td>Request a leave of absence.</td>
<td>How do I arrange for paternity leave?</td>
</tr>
<tr>
<td>Leave General Question</td>
<td>Ask a general question about taking time off that is not vacation.</td>
<td>What are the approved reasons for taking a leave of absence?</td>
</tr>
<tr>
<td>Life events</td>
<td>Ask a life events and benefits question.</td>
<td>How do I change my name in the system after getting married?</td>
</tr>
<tr>
<td>Medical/dental/vision</td>
<td>Ask an insurance question.</td>
<td>Can I add my spouse to the vision plan?</td>
</tr>
<tr>
<td>Medical Benefits</td>
<td>Enroll, modify or ask a question about your medical benefits.</td>
<td>Does my medical insurance cover me if I am on vacation in another country?</td>
</tr>
<tr>
<td>New Hire Onboarding</td>
<td>Request to onboard an employee.</td>
<td>Please onboard a new employee.</td>
</tr>
<tr>
<td>Offboarding</td>
<td>Complete tasks to close a terminating employee’s accounts and retrieve company assets.</td>
<td>An employee resigns.</td>
</tr>
<tr>
<td>Onboarding</td>
<td>Complete tasks to set up accounts for a new employee and provide company assets, such as a computer.</td>
<td>A new employee is hired.</td>
</tr>
<tr>
<td>Pay Discrepancy</td>
<td>Ask about or report a discrepancy in your paycheck.</td>
<td>Why is my paycheck less this pay period?</td>
</tr>
<tr>
<td>Payroll</td>
<td>Ask a question about payroll or salary.</td>
<td>On what day of the month does my account get credited?</td>
</tr>
<tr>
<td>Pharmacy Benefits</td>
<td>Enroll, modify, or ask a question about your pharmacy benefits.</td>
<td>Can I get name brand medications or does my benefit only include generic when available?</td>
</tr>
<tr>
<td>Retirement</td>
<td>Ask about retirement benefits.</td>
<td>What is the minimum age at which I can retire?</td>
</tr>
<tr>
<td>Retirement 401(k)</td>
<td>Ask a 401(k) related retirement question.</td>
<td>If I am planning to retire, should I scale back my 401(k) contribution?</td>
</tr>
<tr>
<td>Tuition</td>
<td>Ask a question about tuition.</td>
<td>Will I be reimbursed for training tuition?</td>
</tr>
<tr>
<td>Tuition Reimbursement</td>
<td>Request tuition reimbursement.</td>
<td>Please reimburse me for the class I just completed.</td>
</tr>
<tr>
<td>Vacation</td>
<td>Ask a vacation question.</td>
<td>When will I begin to earn more vacation per year?</td>
</tr>
<tr>
<td>Vision Benefits</td>
<td>Enroll, modify, or ask a question about your vision benefits.</td>
<td>How many pairs of glasses can I buy per year as part of the benefit?</td>
</tr>
</tbody>
</table>
HR PDF document templates in legacy HR

HR document templates are used to generate PDF documents that include information from an employee’s HR profile, in the non-scoped version of HR. You can generate PDF employment verification letters for existing employees. You configure PDF document templates with your company information and logo.

You can configure multiple PDF document templates, for example, if you have different letters for different countries. The following templates are predefined.

- Employee Verification Letter in Canada
- Employee Verification Letter in USA

Before you begin generating documents you need to configure the templates with your company logo and text. It is recommended that you obtain the following items and information to configure the predefined HR document templates, or to create new ones.

- A page of your company’s letterhead.
- Copies of your current employment verification letter and offer letter templates, if available.
- The logo image to use in your header. The header image can be a maximum of 50px high. If your letterhead includes a logo and text, ensure that the logo image includes the text, as you can only configure the image in the header.
- The logo image to use in your footer, if applicable. The logo image can be a maximum of 15px high. You can configure both an image and text in the footer.

Modify an HR PDF document template in legacy HR

You can modify the predefined HR PDF document templates with your company logo and custom text.

Before you begin
Role required: admin, hr_manager, or hr_admin

About this task
Each pdf document template contains configurable areas for the header, body, and footer. You can enter the body of the letter in a WYSIWYG text editor, and place variables to retrieve information from the employee’s or candidate’s HR profile.

Procedure
1. Navigate to HR • Administration > Catalog & Templates > PDF Document Templates.
2. To add a header image, such as your logo, complete the following steps.
   a. Next to Header image, select Click to add.
   b. Click Choose File and select the header logo image from your computer, then click OK.
   c. From the Image position choice list, select the position of the logo.
3. To edit the body, perform the following steps.
   a. Review the text and update it with the text from your current document template.
   b. Add any additional variables as needed. The following list contains all variables that you can add.
<table>
<thead>
<tr>
<th>Variable</th>
<th>Variable</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Work email</td>
<td>Department</td>
</tr>
<tr>
<td>Name</td>
<td>Work phone</td>
<td>Employee number</td>
</tr>
<tr>
<td>Position</td>
<td>Prefix</td>
<td>Employment status</td>
</tr>
<tr>
<td>Time type</td>
<td>Nationality</td>
<td>Employment type</td>
</tr>
<tr>
<td>Employment start date</td>
<td>Manager</td>
<td>Gender</td>
</tr>
<tr>
<td>New Employee</td>
<td>New Employee Address</td>
<td>Position Title</td>
</tr>
<tr>
<td>New Employee Last Name</td>
<td>Position Type</td>
<td>Start Date</td>
</tr>
<tr>
<td>Hiring Manager</td>
<td>Yearly Compensation</td>
<td>Overtime Pay Rate</td>
</tr>
<tr>
<td>Bonus</td>
<td>Number of RSUs</td>
<td>HR Manager</td>
</tr>
<tr>
<td>HR Manager Title</td>
<td>Signature</td>
<td>Start Date</td>
</tr>
</tbody>
</table>

To modify the list of available variables, edit the `generalhrform` script include.

c. **Optional:** Use the formatting tools to perform any of the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format the text</td>
<td>Select the text to format and apply any of the formatting options, such as bold, italic, underline, font styling. You can apply justification, bullets, and numbers as needed.</td>
</tr>
<tr>
<td>Add an image</td>
<td>Click the image icon and attach the image or search for it in the image library. You can also add a new image to the library.</td>
</tr>
</tbody>
</table>

4. To configure the footer, perform the following steps.

a. If you have a footer image, select **Click to add** next to **Footer image**.

b. Click **Choose File**, select the footer logo image from your computer, then click **OK**.

c. From the **Image position** list, select the position of the logo.

d. Enter the footer text, if applicable.

The footer text appears based on the selected footer image position. If you selected to position the image on the right or centered, the footer text is left-justified. If you selected to position the image on the left, the footer text is right-justified. If there is no footer image, the footer text is center-justified.

e. Select the page size.

5. Click **Update**.

**What to do next**

Review the look of the generated letter by impersonating an employee and submitting the associated catalog item. You must impersonate the user assigned to work on the case to generate the letter within the HR case. Continue editing and testing the letter template until you are satisfied with the generated PDF.
Add an HR PDF document template in legacy HR

You can add HR pdf document templates for employment verification or job offers as needed.

Before you begin
Role required: admin, hr_manager, or hr_admin

About this task
The easiest way to add a new HR PDF document template is to open one of the existing templates and save it as a new template. The steps below follow this process.

Procedure
1. Navigate to HR • Administration > Catalog & Templates > PDF Document Templates.
2. Open one of the HR PDF document templates of the type that you want to add.
3. Enter a new name.
4. Right-click the form header and select Insert and Stay.
The new HR PDF document template is saved and the page refreshes with the new name.
5. Perform any of the following actions to modify the template.
   For more information about updating the form sections, see Modify an HR PDF document template in legacy HR.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update the header logo</td>
<td>Select a new image and position, as needed.</td>
</tr>
<tr>
<td>Update the text</td>
<td>Enter and format the text in the Body. Available variables are listed below.</td>
</tr>
<tr>
<td>Update the footer</td>
<td>Select a new footer image and its position, as needed. Modify the text if necessary.</td>
</tr>
<tr>
<td>Change the page size</td>
<td>Select the page size from the choice list.</td>
</tr>
</tbody>
</table>

HR PDF document template variables:

<table>
<thead>
<tr>
<th>{{Date}}</th>
<th>{{Work email}}</th>
<th>{{Department}}</th>
</tr>
</thead>
<tbody>
<tr>
<td>{{Name}}</td>
<td>{{Work phone}}</td>
<td>{{Employee number}}</td>
</tr>
<tr>
<td>{{Position}}</td>
<td>{{Prefix}}</td>
<td>{{Employment status}}</td>
</tr>
<tr>
<td>{{Time type}}</td>
<td>{{Nationality}}</td>
<td>{{Employment type}}</td>
</tr>
<tr>
<td>{{Employment start date}}</td>
<td>{{Manager}}</td>
<td>{{Gender}}</td>
</tr>
<tr>
<td>{{New Employee}}</td>
<td>{{New Employee Address}}</td>
<td>{{Position Title}}</td>
</tr>
<tr>
<td>{{New Employee Last Name}}</td>
<td>{{Position Type}}</td>
<td>{{Start Date}}</td>
</tr>
<tr>
<td>{{Hiring Manager}}</td>
<td>{{Yearly Compensation}}</td>
<td>{{Overtime Pay Rate}}</td>
</tr>
<tr>
<td>{{Bonus}}</td>
<td>{{Number of RSUs}}</td>
<td>{{HR Manager}}</td>
</tr>
<tr>
<td>{{HR Manager Title}}</td>
<td>{{Signature}}</td>
<td>{{Start Date}}</td>
</tr>
</tbody>
</table>

6. Click Update.
What to do next
Review the look of the generated letter by impersonating an employee and submitting the
associated catalog item. You must impersonate the user assigned to work on the case to
generate the letter within the HR case. Continue editing and testing the letter template until
you are satisfied with the generated PDF.

PDF APIs and PDF document templates in legacy HR
Use PDF APIs to create PDF document templates.
PDF APIs are called through server-side scripts like business rules and script includes.

API Details
The GeneralFormAPI.setDocument() sets document parameters for PDF generation. The
parameters are:

- footnote: Footnote at bottom center.
- headerPosition: Position of header image. Values are Left, Right, and Center.
- footerPosition: Position of footer image. Values are Left, Right, and Center.

View the 'generate()' API function in the GeneralHRForm script include to see how the API
works:
Code snippet:

```javascript
var generalFormAPI = new global.GeneralFormAPI(this.fileName, this.targetTable, this.targetId);
generalFormAPI.setDocument(this.headerImage, this.footerImage, this.footnote, this.headerPosition, this.footerPosition, this.pageSize);
generalFormAPI.createPDF(this.body);
```

Document generation APIs and script includes in legacy HR
The following APIs and script includes are available for generating PDF documents.
The GeneralHRForm script include has the following APIs:

<table>
<thead>
<tr>
<th>API</th>
<th>Input</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>generate</td>
<td>manual (Boolean)</td>
<td>Generation status (Boolean)</td>
<td>Generates a PDF document. When set to true, generates documents manually. For example, Generate action on Preview Document. This API returns a boolean value when a pdf is generated.</td>
</tr>
<tr>
<td>createPDF</td>
<td>tableName (String), tableId (String)</td>
<td>N/A</td>
<td>The inactivateRelatedDrafts inactivates draft documents for the tableName and tableId input parameters. When the tableId is the sys_id of a case with</td>
</tr>
</tbody>
</table>
### GeneralFormAPI Script Include APIs

<table>
<thead>
<tr>
<th>API</th>
<th>Input</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>setDocument</td>
<td>headerImage (String), footerImage (String), footnote (String), headerPosition (String), footerPosition (String), pageSize (String)</td>
<td>N/A</td>
<td>Sets the building blocks/parameters of a document for PDF generation.</td>
</tr>
<tr>
<td>createPDF</td>
<td>body (String), pages (number)</td>
<td>N/A</td>
<td>Takes body and number of pages and generates the PDF document. After the document is generated, it is attached to the table that the createPDF action is requested.</td>
</tr>
<tr>
<td>setDocTempleInfo</td>
<td>headerImage (String), footerImage (String), footnote (String), headerPosition (String), footerPosition (String), pageSize (String)</td>
<td>N/A</td>
<td>A setter method for setting document template building blocks.</td>
</tr>
<tr>
<td>startHTMLParser</td>
<td>N/A</td>
<td>N/A</td>
<td>Opens a write stream for htmlparser to enable document generation.</td>
</tr>
</tbody>
</table>

### GeneralPDF Script Include APIs

<table>
<thead>
<tr>
<th>API</th>
<th>Input</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hasDraftDocument</td>
<td>tableName (String), tableId (String)</td>
<td>Boolean</td>
<td>Returns a boolean value when a draft document is attached. Input parameters are tableName (takes name of the table the draft document is attached), tableId (takes the sys_id of the table). The table can be the HR Task or HR Case when the sys_class_name within the api call.</td>
</tr>
<tr>
<td>getDraftDocument</td>
<td>tableName (String), tableId (String)</td>
<td>draft document Glide Record (GlideRecord)</td>
<td>Takes tableName and tableId of the record that the draft document is attached to. It returns the draft document GlideRecord matching queried based on input values.</td>
</tr>
<tr>
<td>remove_all_variables</td>
<td>parsedBody (String)</td>
<td>parsedBody (String)</td>
<td>The remove_all_variables method takes document body and removes tags ( ${dummy_tag_value} ).</td>
</tr>
<tr>
<td>validateTemplate</td>
<td>parsedBody (String), tableName (String)</td>
<td>parsedBody (String)</td>
<td>Validates tags in a document template body. The variables in the tags are matched against the fields/dot-walked fields of the tableName passed as an input argument.</td>
</tr>
</tbody>
</table>

The GeneralFormAPI script include has the following APIs:

<table>
<thead>
<tr>
<th>API</th>
<th>Input</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hasDraftDocument</td>
<td>tableName (String), tableId (String)</td>
<td>Boolean</td>
<td>Returns a boolean value when a draft document is attached. Input parameters are tableName (takes name of the table the draft document is attached), tableId (takes the sys_id of the table). The table can be the HR Task or HR Case when the sys_class_name within the api call.</td>
</tr>
<tr>
<td>getDraftDocument</td>
<td>tableName (String), tableId (String)</td>
<td>draft document Glide Record (GlideRecord)</td>
<td>Takes tableName and tableId of the record that the draft document is attached to. It returns the draft document GlideRecord matching queried based on input values.</td>
</tr>
<tr>
<td>remove_all_variables</td>
<td>parsedBody (String)</td>
<td>parsedBody (String)</td>
<td>The remove_all_variables method takes document body and removes tags ( ${dummy_tag_value} ).</td>
</tr>
<tr>
<td>validateTemplate</td>
<td>parsedBody (String), tableName (String)</td>
<td>parsedBody (String)</td>
<td>Validates tags in a document template body. The variables in the tags are matched against the fields/dot-walked fields of the tableName passed as an input argument.</td>
</tr>
</tbody>
</table>

The GeneralPDF script include has the following APIs:
<table>
<thead>
<tr>
<th>API</th>
<th>Input</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>setDocument</td>
<td>headerImage (String), footerImage (String), footnote (String), headerPosition (String), footerPosition (String), pageSize (String)</td>
<td>N/A</td>
<td>Sets document template building blocks.</td>
</tr>
<tr>
<td>startHTMLParser</td>
<td>N/A</td>
<td>N/A</td>
<td>Opens a write stream for htmlparser to enable document generation.</td>
</tr>
<tr>
<td>stopHTMLParser</td>
<td>N/A</td>
<td>N/A</td>
<td>Closes the write stream after document generation method is complete.</td>
</tr>
<tr>
<td>addHTML</td>
<td>html (String)</td>
<td>N/A</td>
<td>Appends html snipets to the document body.</td>
</tr>
<tr>
<td>addNewPage</td>
<td>N/A</td>
<td>N/A</td>
<td>Moves the cursor to the next page.</td>
</tr>
<tr>
<td>addCells</td>
<td>cells (Object), row_length (String)</td>
<td>N/A</td>
<td>Adds cells, relevant text, and properties to a table.</td>
</tr>
<tr>
<td>addSVG</td>
<td>svg (String), position (Object)</td>
<td>N/A</td>
<td>Adds svg to a document template.</td>
</tr>
<tr>
<td>setPDFDoc</td>
<td>pdfDoc (Object)</td>
<td>N/A</td>
<td>Sets pdfDoc objects.</td>
</tr>
<tr>
<td>setProperties</td>
<td>properties (Object)</td>
<td>N/A</td>
<td>Sets document properties.</td>
</tr>
<tr>
<td>setHeader</td>
<td>header (String)</td>
<td>N/A</td>
<td>Sets the header for a document template.</td>
</tr>
<tr>
<td>setFooter</td>
<td>footer (String)</td>
<td>N/A</td>
<td>Sets the footer for a document template.</td>
</tr>
<tr>
<td>setWatermark</td>
<td>watermark (String)</td>
<td>N/A</td>
<td>Sets watermarks on a generated PDF document.</td>
</tr>
<tr>
<td>get</td>
<td>N/A</td>
<td>ByteArrayInputStream</td>
<td>Returns a document as a ByteArrayInputStream.</td>
</tr>
</tbody>
</table>
HR skills management in legacy HR

Your organization can define HR skills to establish the qualifications of HR staff, in the non-scoped version of HR. Skills can be included in the auto-assignment process used to assign HR agents to HR cases and tasks.

Some HR skills are predefined, and you can create as many other skills as you need. You can assign skills to users or groups. When you assign a skill to a group, the skill is assigned to every group member.

Skills can contain other skills. For example, you may have an HR Policies skill that contains Travel & Expense and Corporate Policies skills.

You can create skills from the Manage HR Skills module in HR - Administration Catalog & Templates or from the Skills application. However, you must use the Skills application to define the skill hierarchy.

Skills and auto-assignment of HR cases and tasks

In the Configuration module for Human Resources, the Auto-selection of agents for tasks requires them to have skills option determines whether the organization is including skills in the auto-assignment of HR cases and tasks. If this option is set to some or all, then it is important to ensure that the proper skills are defined and assigned to HR staff.

You then assign the necessary skills to the HR case and task templates that are used to create HR cases. For example, an HR task template for submitting a travel & expense policy question is assigned the HR Policies and Travel & Expense skills. When the template is used to submit an HR case, the auto-assignment process finds an HR agent with one or both of these skills, depending on the configuration setting.

Create or modify an HR skill in legacy HR

You can create HR skills and assign them to HR staff to assist with the auto-assignment of HR cases and tasks.

Before you begin
Role required: admin or hr_admin

About this task
Skills can contain other skills. For example, you may have an HR Policies skill that contains Travel & Expense and Corporate Policies skills.

The following procedure describes how to create and edit HR skills from the Skills application. Although you can create and edit skills in the HR - Administration > Catalog & Templates > Manage HR Skills module, you must use the Skills application to assign child skills.

Procedure
1. Navigate to Skills > Skills.
2. Click New or open an existing skill.
3. Enter or edit the skill Name and Description.
4. Save or submit your changes.
5. To associate child skills, complete the following steps.
   a. In the Contains Skills related list, click Edit.
   b. Double-click skills in the Collection list to move them to the Contains Skills List.
   c. Click Save.
If you add child skills to a skill that is assigned to a group, the child skills are assigned to the members of the group. Messages are displayed to notify you of the group members who were assigned the child skills.

6. To assign users to the skill, complete the following steps.
   a. In the Users related list, click Edit.
   b. Double-click users in the Collection list to move them to the Users List.
   c. Click Save.
      If you add users to a skill with child skills, the child skills are assigned to the user. Messages are displayed to notify you of the skills that were assigned.

7. To associate task models with the skill, complete the following steps.
   a. In the Models related list, click Edit.
   b. Enter a term in the filter field above the Collections list to see just the HR models.
      Example
      For example, enter hr if this is a standard prefix used to name tasks that are added to HR templates.
   c. Double-click a model in the Collection list to move it to the Models List.
   d. Click Save.

8. Click Submit or Update.

Assign an HR skill to a group in legacy HR
When you assign skills to HR groups, all members of the group inherit the skills and any child skills.

Before you begin
Role required: admin or hr_admin

Procedure
1. Navigate to Skills > Groups.
   This is the same list that appears under User Administration > Groups.
2. Select the HR group that you want to assign skills to.
3. In the Skills related list, click Edit.
4. Double-click skills in the Collection list to move them to the Skills List.
5. Click Save.
Assign an HR skill to a user in legacy HR

You can assign skills to HR users to facilitate the auto-assignment of HR cases and tasks.

Before you begin
For more information about HR skills and the auto-assignment process, see HR skills management in legacy HR.

Role required: admin or hr_manager

About this task
The following procedure describes how to assign HR skills in the Manage HR Skills module. If you want to define a parent and child hierarchy for HR skills, you must use the Skills application.

Procedure
1. Navigate to HR • Administration > Catalog & Templates > Manage HR Skills.
Skills appear on the left. Select a skill to see the assigned users on the right. The user cards indicate how many skills each employee is assigned. If no skills are assigned to a user, the number on the user card is red. Skills with no assigned users are red in the skills list.

2. Select a skill in the All Skills list to assign to users.

3. Click Assign/remove users.
The list of all users in the HR department appears on the right. Users assigned to the skill are highlighted in blue.

4. To search for an HR user, type any information, such as name, location, or title, in the search box above the list of users.
As you type, the list narrows to display user cards that contain those letters in any field.

5. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a user</td>
<td>Click the user card. It is then highlighted in blue.</td>
</tr>
<tr>
<td>Unassign a user</td>
<td>Click the highlighted user card. Its highlight is removed.</td>
</tr>
</tbody>
</table>

6. Click Save.

7. To assign other skills to a user, complete the following steps.
   a. Select All Users in the list on the left and locate the user on the right.
   b. Click the arrow next to Skills: # in the user card.
   c. Select the skills for the user, and click Save.

8. To configure skills, perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a skill</td>
<td>Click New Skill, enter the skill name and description, and click Submit.</td>
</tr>
<tr>
<td>Edit a skill</td>
<td>Click the pencil icon beside the skill name in the HR Skills list. Change the information and click Submit.</td>
</tr>
</tbody>
</table>

Configuration in legacy HR
You can set the configuration of the HR application to determine how to handle day-to-day operations, in the non-scoped version of HR.

Before you begin
Role required: admin or hr_admin

About this task
You must be in the global domain to set HR configuration options. Administrators in domains lower than the global domain can view the Configurations page, but cannot modify the settings.

Procedure
1. Navigate to HR • Administration > Administration > Configuration.
The options on the configuration screen are arranged in a multiple-tabbed layout:
• The **Business Process** tab contains options for setting up the request life cycle, creating catalogs and requests, and configuring notifications.

• The **Assignment** tab contains options for setting up manual and auto-assignment.

• The **Add-ons** tab contains options for enabling the knowledge base, managed documents, and task activities.

• The **Human Resources** tab contains specific options for the HR application.

A configuration option is enabled when the switch appears green and is toggled to the right. All configuration options listed in the **Dependency** column must be enabled for the option to be displayed.

2. Select configurations on the **Business Process** tab.

### Business process tab options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Dependency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifecycle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assignment method for</td>
<td>Select the method for assigning requests.</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled.</td>
</tr>
<tr>
<td>requests</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>using auto-assignment</strong>: Requests are automatically assigned.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>using a workflow</strong>: Select the assignment workflow.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>manually</strong>: Manually assign requests.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: The assigned state was removed from the base system. When you have customizations that use the assigned state, import it into your current version. Go to your previous instance, copy your custom assigned state (export to XML), and import it to your current instance.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use this workflow to</td>
<td>Select the workflow for assigning requests.</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled.</td>
</tr>
<tr>
<td>assign requests</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assignment method for</td>
<td>Select the method for assigning tasks:</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled.</td>
</tr>
<tr>
<td>tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>using auto-assignment</strong>: Tasks are automatically assigned.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>using a workflow</strong>: You are prompted to select the workflow you want to use for assignment.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>manually</strong>: Manually assign tasks.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use this workflow to</td>
<td>Select the workflow for assigning tasks.</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled.</td>
</tr>
<tr>
<td>assign tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Dependency</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lifecycle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy task work notes to request</td>
<td>Enable this option to synchronize task work notes with the work notes on the order or request. When work notes are added in the task, the same work notes appear in the order or request.</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled.</td>
</tr>
<tr>
<td>Catalog and Request Creation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create or update requests by inbound email.</td>
<td>Enable this option to allow inbound email messages to create or update requests.</td>
<td></td>
</tr>
<tr>
<td>Templates create a dedicated catalog item</td>
<td>Enable this option to allow automatic publishing of catalog items for the application.</td>
<td></td>
</tr>
<tr>
<td>Notification</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table Field Recipients</td>
<td>Set up notifications for changes to HR cases or tasks.</td>
<td></td>
</tr>
<tr>
<td>• Table:</td>
<td>Select whether this notification is sent for a change to the Request or the Task table.</td>
<td></td>
</tr>
<tr>
<td>• Field:</td>
<td>Select the field that must change for the notification to be triggered.</td>
<td></td>
</tr>
<tr>
<td>• Recipients:</td>
<td>Select the recipients of the notification. If you select a specific user or a specific group, you are prompted to select a user or group.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enter as many notifications as you need. To remove a notification, click the delete (-) icon on the right.</td>
<td></td>
</tr>
</tbody>
</table>

3. Click the **Assignment** tab and select configurations.

### Assignment tab options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Dependency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Assignment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign requests or tasks based on assignment group coverage areas</td>
<td>Enable this option to limit the selection of groups from the <strong>Dispatch group</strong> and <strong>Assignment group</strong> fields to groups that cover the location of the task.</td>
<td></td>
</tr>
<tr>
<td>Auto-Assignment / Scheduling</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-selection of agents will consider time zone for tasks</td>
<td>Enable this option to consider the time zone of the agent when assigning a task</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Dependency</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manual Assignment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Factors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-selection of agents will consider location of agents</td>
<td>Enable this option to use the agent and location when determining who to assign the task to. Agents closer to the task location get preference.</td>
<td>• <strong>Automate state flows</strong> on the Human Resources tab is enabled. • <strong>Assignment method for requests</strong>: using auto-assignment • Assignment method for tasks: using auto-assignment</td>
</tr>
</tbody>
</table>
| Auto-selection of agents for tasks requires them to have skills | This option determines the degree to which skills must be matched to a task when determining auto-assignment.  
• Select **all** to require that an assigned agent has all the skills to perform the task. An agent who lacks one skill is eliminated.  
• Select **some** if you want agents who have most of the skills to perform the task.  
• Select **none** to auto-assign agents without the required skills. | • **Automate state flows** on the Human Resources tab is enabled. • Assignment method for requests: using auto-assignment • Assignment method for tasks: using auto-assignment |
| Auto-selection will attempt to assign the same agent to all tasks in a request | Enable this option to auto-assign all tasks for a request to the same agent. | • **Automate state flows** on the Human Resources tab is enabled. • Assignment method for requests: using auto-assignment • Assignment method for tasks: using auto-assignment |

4. Click the **Add-ons** tab and select configurations.
### Add-ons tab options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Dependency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable a dedicated knowledge base</td>
<td>Enable this option to install the knowledge base for the application.</td>
<td></td>
</tr>
<tr>
<td>Enable managed documents</td>
<td>Enable this option to add a related list to managed documents.</td>
<td></td>
</tr>
<tr>
<td>Enable task activities</td>
<td>Enable this option to log the task interactions and communications, such as phone calls and email messages.</td>
<td></td>
</tr>
<tr>
<td>Associated Task Tables</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select associated tables</td>
<td>Click Add to select more tables.</td>
<td></td>
</tr>
</tbody>
</table>

5. Click the Human Resources tab and select configurations.

**Note:** If you are using Microsoft Internet Explorer 8 or 9, the Human Resources tab does not appear. You can set these properties in the System Properties [sys_properties] table.

### Human Resources tab options

<table>
<thead>
<tr>
<th>Configuration setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR profile fields that users or managers can edit without HR approval include number of fields</td>
<td>Select the HR profile fields that are editable. Click Save to exit the selection dialog and save your changes. The personal information fields that you enable, such as name, address, and personal contact information, are editable by employees directly in their HR profile. For example, you may allow employees to edit their home address and personal email address, but not their name or marital status. The sensitive and employment information fields marked editable allows the manager of the employee or an HR agent to submit an employee change request. If only editable information is changed, the HR profile is updated and the HR case that is created when the request is submitted and closed.</td>
</tr>
<tr>
<td>Human Resources group email</td>
<td>Enter the email address for the HR team. This email address is for the Contact HR link on the HR Portal. When it is used, an HR case is created using an inbound email action.</td>
</tr>
<tr>
<td>Automate state flows</td>
<td>Enable this option to use state flows for HR cases and tasks. Disable it to use only workflows to automate the status of HR cases and tasks. If state flows are automated, HR agents are not able to manually change the state of HR cases and tasks. If state flows are not automated, the state of HR cases and tasks can be changed manually. Also, the HR business rules that invoke the state flow process are inactive.</td>
</tr>
<tr>
<td>Configuration setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Default HR case priority for VIP user is 2-High</td>
<td>Select the default priority to assign to an HR case that is entered for a VIP user.</td>
</tr>
</tbody>
</table>

6. Click **Save**.  
Clicking **Save** on any tab saves all configuration settings.

**HR profile editable field configuration in legacy HR**

An option in Human Resources Configuration provides a list of HR profile fields that can be enabled for edit. Understand the difference between how the personal and the employment information fields are updated in the HR profile based on this configuration.

Typically, organizations allow employees to update certain personal information, but not sensitive and employment information. HR agents or the manager of the employee changes sensitive information. For example, employees can change their home address and personal email address, but the manager must update the position when the employee is promoted.

The **HR profile fields that users or managers can edit without HR approval include** `<number of fields>` option in Human Resources Configuration provides the list of editable HR profile fields. The following list of fields indicates which of the configurable fields contain personal and which contain sensitive and employment information.

<table>
<thead>
<tr>
<th>Personal information fields</th>
<th>Sensitive and employment information fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Home address</td>
<td>• Date of birth</td>
</tr>
<tr>
<td>• Home city</td>
<td>• Department</td>
</tr>
<tr>
<td>• Home country</td>
<td>• Employee number</td>
</tr>
<tr>
<td>• Home phone</td>
<td>• Employment end date</td>
</tr>
<tr>
<td>• Home state/province</td>
<td>• Employment start date</td>
</tr>
<tr>
<td>• Home zip/postal</td>
<td>• Employment status</td>
</tr>
<tr>
<td>• Middle name</td>
<td>• Employment type</td>
</tr>
<tr>
<td>• Personal email</td>
<td>• Ethnicity</td>
</tr>
<tr>
<td>• Personal mobile phone</td>
<td>• First name</td>
</tr>
<tr>
<td>• Prefix</td>
<td>• Gender</td>
</tr>
<tr>
<td>• Work email</td>
<td>• Last name</td>
</tr>
<tr>
<td>• Work mobile</td>
<td>• Location</td>
</tr>
<tr>
<td>• Work phone</td>
<td>• Location type</td>
</tr>
<tr>
<td></td>
<td>• Manager</td>
</tr>
<tr>
<td></td>
<td>• Marital status</td>
</tr>
<tr>
<td></td>
<td>• Nationality</td>
</tr>
<tr>
<td></td>
<td>• Notice period</td>
</tr>
<tr>
<td></td>
<td>• Place of birth</td>
</tr>
<tr>
<td></td>
<td>• Position</td>
</tr>
<tr>
<td></td>
<td>• Probation end date</td>
</tr>
<tr>
<td>Personal information fields</td>
<td>Sensitive and employment information fields</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Probation period</td>
</tr>
<tr>
<td></td>
<td>• Time type</td>
</tr>
</tbody>
</table>

In the configuration option field list, all personal information fields are enabled for edit by default. All employees can open their HR profile from the HRSM Portal and update these fields. If you do not want to allow employees to update one or more of these fields, disable editing by clearing the check box in the configurable list. For example, you may not want employees updating their work email address or phone number.

ACLs control the HR profile personal information fields, which can be modified when more controlled access is needed.

The employment information fields that you enable for edit allow the manager of an employee to update the field. However, the manager cannot open the HR profile of the employee. The manager must submit an employee information change request with the updated information. When the request to change the editable fields is submitted, the HR Employee Change Workflow takes the following actions.

- Opens an HR case.
- Updates the HR profile of the employee.
- Closes the HR case.

To update any HR profile fields that are not editable, employees or their managers submit an employee information change request. An HR case is created and the HR Employee Change Workflow is started. The workflow requires that the change request is approved. When it is approved, the fields are updated and the HR case is closed.

**Assignment rules in legacy HR**

You can define rules to assign cases to specific users or groups automatically based on the rule conditions, in the non-scoped version of HR.

Assignment rules help quickly assign new or modified HR cases for resolution. For example, an assignment rule could specify that cases submitted by users in Germany are automatically assigned to the HR group in Berlin.

Assignment rules contain the following elements.

- **Applies To**: Conditions that must be met for the rule to process.
- **Assign To**: Users and groups to assign the case to if the conditions are met.
- **Script**: If necessary, entry to customize the assignment rule further.

Assignment rules are applied only when an HR case is submitted and either no template was selected or the selected template does not assign the Assignment group. In either of these cases, a predefined assignment rule assigns HR cases to the HR group.

If you have more than one HR department, you can remove the HR group assignment from the HR template and use assignment rules to assign the HR group. For example, if you have HR departments in both the U.S. and German offices, you can create an HR group for each office. You set up assignment rules to assign the HR group based on the location of the employee who submitted the HR case.

If your organization is using HR skills to qualify HR case assignments, ensure that the assigned user or group members have the required skills. To determine whether skills are being used and assigned, check the following configuration options.
• **HR • Administration > Administration > Configuration**: From the Assignment tab, check Auto-selection of agents for tasks requires them to have skills. If all or some is selected, continue to check the following options.

• **HR • Administration > Catalog & Templates > HR Templates**: Look at the template that corresponds to the assignment rule to see what skills, if any, are required.

• **HR • Administration > Catalog & Templates > Manage HR Skills**: Find the HR user assigned to the case and click the Skills: # button to see whether the required skill is assigned. If not, check the box to assign it, and click Save.

Create an HR assignment rule in legacy HR
Assignment rules are used to assign the HR group when it is not assigned from the catalog item template. You can create HR assignment rules as needed.

**Before you begin**
Role required: admin or hr_admin

**Procedure**
1. Navigate to **HR • Administration > Administration > Assignment Rules**.
2. Click **New**.
   By default, the assignment rule is for the HR Task [hr_task] table.
3. Complete the form.

**Assignment Rules form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the HR assignment rule.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the rule processes. Rules with lower-order numbers are</td>
</tr>
<tr>
<td></td>
<td>processed first. If a rule is applied, the rules with a higher-order number</td>
</tr>
<tr>
<td></td>
<td>are not processed.</td>
</tr>
<tr>
<td></td>
<td>For example, an assignment rule with order 100 states to assign the case to</td>
</tr>
<tr>
<td></td>
<td>a group with the specified skill.</td>
</tr>
<tr>
<td></td>
<td>Assignment rule with order 200 states to assign the case to the group HR.</td>
</tr>
<tr>
<td></td>
<td>If a group has the specified skill, then it is assigned. If not, then the</td>
</tr>
<tr>
<td></td>
<td>second rule runs and assigns it to HR.</td>
</tr>
<tr>
<td>Application</td>
<td>Indicates global application scope.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies the rule is in use.</td>
</tr>
<tr>
<td>Applies To</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Table with the records that the assignment rule applies to. Default is the</td>
</tr>
<tr>
<td></td>
<td>HR Task [hr_task] table.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions in which the assignment rule applies.</td>
</tr>
<tr>
<td>Assign To</td>
<td></td>
</tr>
<tr>
<td>Applies To</td>
<td>User to assign to the case when this rule is applied.</td>
</tr>
<tr>
<td>Assign To</td>
<td>Group to assign to the case when this rule is applied.</td>
</tr>
<tr>
<td>Script</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Script | Script to define advanced assignment rule functionality. Current.variable_pool set of variables is available.  

⚠️ **Note:** Two example scripts are provided as a comment. You can modify either script or use the information as a starting point for your own script. Remove the examples when you are finished. |

4. Click **Update**.

**What to do next**
After creating the assignment rule, you can test it to verify that it works.

**Test an assignment rule in legacy HR**
You can test a new assignment rule to verify that it works as intended.

**Before you begin**
Role required: admin or hr_admin

**Procedure**
1. Create a new HR case.
2. Fill in the fields with data that matches the assignment rule conditions.
3. Submit the HR case.
4. Reopen the case and check that the correct assignment information was added.

**What to do next**
If the correct assignment information was not added, check to see whether you are using HR skills and if the user has the required skills.

- **HR • Administration > Administration > Configuration**: From the Assignment tab, check Auto-selection of agents for tasks requires them to have skills. If all or some is selected, continue to check the following options.

- **HR • Administration > Catalog & Templates > HR Templates**: Look at the template that corresponds to the assignment rule to see what skills, if any, are required.

- **HR • Administration > Catalog & Templates > Manage HR Skills**: Find the HR user assigned to the case and click the **Skills: #** button to see whether the required skill is assigned. If not, check the box to assign it, and click **Save**.

After verifying that the necessary skills are assigned to the correct users, test the assignment rule again.

**HR Case Management for legacy HR**
HR Case Management holds the details of HR requests, such as requests for information, and HR processes, such as onboarding and offboarding, in the non-scoped version of HR.

Users can submit HR cases through the HR Service Portal.

HR specialists, generalists, and managers can perform any of the following tasks.
• Create HR cases for employees to record the processing of HR requests, such as a request from an employee for a leave of absence.
• Create HR cases for automated HR processes, such as employee onboarding and offboarding.
• View HR case information and manage the overall HR workload. For example, a manager may work with all HR cases that are not assigned.

HR cases can have one or more associated HR tasks to manage individual pieces of work within the case.

Administrators can customize the predefined HR case processes such as inquiries, onboarding, and offboarding. New HR processes can be designed to meet your organization's requirements. For example, you may have a process for maternity and paternity leave requests that you can automate.

Processes may vary depending on the employees they relate to, their teams, locations, positions, and other factors. For example, an onboarding process for a sales employee may differ from the onboarding process for an IT employee, and an employee who travels requires a laptop, but an employee based in the office is given a desktop. After a process is defined, the associated department can set up and maintain the rules and conditions for the process.

Example HR request
An employee named Alan wants to find out about the company's paternity leave policy. He also wants to discuss flexible working hours around the expected time of the birth of his child.

1. Alan submits an HR request through the HR Service Portal asking about paternity leave policies and requesting a meeting to discuss flexible working hours.
2. An HR case is created and assigned to an HR agent, such as a specialist or generalist, based on assignment rules.
3. The HR agent processes the HR case, creating two HR tasks for this two-part request. Each task is assigned to the user who can process it.
4. When all the tasks are completed, the HR case is closed.

Create an HR case in legacy HR
HR agents can create HR cases for employees, for example, if an employee calls with a question that must be investigated, in the non-scoped version of HR. Typically, employees use the HR Service Portal to create HR cases for themselves by submitting a request through the HR Service Portal or Catalog.

Before you begin
Role required: hr_basic or hr_case_writer

About this task
HR agents can create a new HR case using the Create New Case form. The HR agent can select a category to create standard tasks for each type of case.

Procedure
1. Navigate to HR • Case Management > Case Management > Create New Case. The HR Case form opens. The workflow stages are listed across the top, and the new case is in the Draft stage.
2. Complete the fields on the left side of the form.
## HR case fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned case ID number, which cannot be changed.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The user who needs HR assistance. Click the lookup icon and select the user. The user's location and department information is filled in automatically if it is known. If you are creating an onboarding case, the user is not yet in the system. Leave this field blank and select the <strong>Onboarding</strong> category.</td>
</tr>
<tr>
<td>Location</td>
<td>The geographical location of the user associated with the case.</td>
</tr>
<tr>
<td>Department</td>
<td>The department of the user associated with the case. If you select the department, the Manager field is populated if there is an assigned department head.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the HR case. By selecting the category, you can save the new case and initiate the auto-assignment process, if one is available. <strong>Note:</strong> Some of the case categories have an associated workflow. If you select the <strong>Onboarding</strong> category the Create Onboarding User dialog opens. Proceed with step 3 below.</td>
</tr>
<tr>
<td>HR profile</td>
<td>The associated HR profile, if any. Click <strong>Create Profile</strong> to automatically generate the HR profile if none exists.</td>
</tr>
</tbody>
</table>

3. **Optional:** If you selected the **Onboarding** category, enter the user's name and email address in the Create Onboarding User dialog.

4. Enter a short description.
   As you enter the short description, a list of knowledge articles matching words you type appears below the notes section. You can preview the articles to determine whether the caller's question is answered.

5. Right-click the form header and click **Save**.
   When the new case is auto-assigned, the workflow stage and State fields move to **Assigned**. The Assignment group and Assigned to fields are populated. You can change these fields if necessary.
   Knowledge articles that appeared when you entered the short description are listed. There are two tabs; one showing articles that you have access to, and one showing articles that the caller can access. These may be different, for example, if you are located in the U.S. and the caller is located in Mexico and there are different articles for each country's holiday schedule.

6. To preview and attach a knowledge article to the case, complete the following steps.

   a. Click **Preview** next to an article.
      If you know the article contains the information you need without previewing it, click **Attach** next to the article.
      The article opens in a pop-up window. Click the up or down arrow to review the previous or next article. Click (X) to close the window.

   b. To attach the article, click **Attach to HR Case**.
The article content is copied into the **Activity** field. After you update the case, the article appears in the **Attached Knowledge** related list.

7. **Complete the form.**

**HR case fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>The state of the case.</td>
</tr>
<tr>
<td>Priority</td>
<td>The precedence of the case, based on the category and whether the employee is a VIP.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time the case is opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The user creating the record.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group the record is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the <strong>Assigned to</strong> field. Assignment groups are restricted to those groups with a type of human_resources.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. If the user is not auto-assigned, click the lookup icon to select a user who is a member of the selected assignment group.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Click the lock icon to add users. Click the add me icon to include yourself.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the case. A default value appears if you selected a category.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer, more detailed description of the case.</td>
</tr>
<tr>
<td>Work notes or additional comments</td>
<td>Additional information about the case. Click <strong>Work notes</strong> to add it as an internal work note. Enter the information and click <strong>Additional comments</strong> if you want the user to see it.</td>
</tr>
</tbody>
</table>

8. **Optional:** Depending on the case category, HR profile fields may appear. Enter any new or changed profile information for the user.

9. **Optional:** Click an option under **Related Links** to add tasks, employment history, or emergency contacts, or to see the caller's organization chart.

10. **Click Update.**

**Results**

After the HR case is created, a service level agreement (SLA) is applied to track its progress. SLAs define the duration of time it takes to close an HR case. By default, HR onboarding and offboarding cases are set to two days, and other HR cases are set to four hours. The SLA can be suspended, for example, if the HR agent has to contact a vendor to obtain the information and the vendor is not immediately available.

HR managers and administrators can view case SLA records by navigating to **HR - Case Management > Case Management > Case SLAs**. You can also run SLA reports.

**Related reference**

- HR case categories in legacy HR
Related information

HR case SLAs in legacy HR

Work on an HR case in legacy HR

You work on an HR case to answer the question or resolve the issue, in the non-scoped version of HR. You can use the HR Case Dashboard to review the priority and work on your assigned cases.

Before you begin
Role required: hr_basic or hr_case_writer

About this task
The HR Case Dashboard shows you, at a glance, how many cases are assigned to you, how many cases are high priority, and the number of breached cases. Your assigned HR cases display in a list.

There are several ways that an HR case may be resolved.

- Enter an answer in the Additional comments field.
- Attach knowledge articles that describe the benefit or policy in question.
- Add request items if applicable. For example, a case to change a department and position may require a task to obtain software needed in the new role.
- Add tasks and assign them to the fulfillment group.

Note: The state changes described are for the default HR configuration. Your organization may have configured the workflow. If so, you may experience differences in the process flow.

Procedure

1. From the HR Case Dashboard or another list of open HR cases, open the HR case to work on.
   When the name in the Opened for field is in red, the HR case is for a VIP user and prioritized over other cases. The service level agreement (SLA) is set to a shorter duration.
   Based on the short description, the system looks for similar cases that may help you resolve this HR case. As you look at the HR case details, review the Similar Cases related list. Also, you can see which knowledge base articles the user looked at by reviewing the KB article read by user (#) related list.

2. Optional: If the HR case is assigned to someone else and you are taking it over, click Assign to Me at the top of the form.
   The form refreshes and your name appears in the Assigned to field.

3. If the state is Draft or Ready, click Start work in the form header.
   The state changes to Work in Progress.

4. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update employee HR profile information</td>
<td>Enter information in any of the following sections or related lists:</td>
</tr>
<tr>
<td></td>
<td>• Employment Information</td>
</tr>
<tr>
<td></td>
<td>• About Employee</td>
</tr>
<tr>
<td></td>
<td>• Contact Information</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Emergency Contacts</td>
<td></td>
</tr>
<tr>
<td>• Employment History</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ Note: Depending on the case category, you may not see all sections and related lists.

| Attach a knowledge article    | Follow the steps in Attach a knowledge article to an HR case in legacy HR.                                                                    |
| Request more information      | Follow the steps in Suspend and resume an HR case in legacy HR.                                                                                |
| Order request items          | Click New in the Requested Items related list. Complete the form and click Submit.                                                            |
| Add tasks                     | Click Add Task under Related Links. Select the type of task to create. Complete the form, click Ready for Work, and click Submit. You can reopen the task and click Start Work when the task is assigned to you and you are ready to work on it. |

5. Optional: To view the manager of the user in the Opened for field, scroll to Related Links and click Show employee org chart. When finished viewing the org chart, click the back arrow on the upper left.

6. Optional: If you determine that the case can be canceled, click Cancel at the top of the form. A popup window appears. Write the reason for canceling the case in the Work note field and click OK.

7. Optional: To add a checklist, click the arrow beside Checklist and select the checklist to add. To create a new checklist, perform the following steps. Checklist appears if the administrator configured the form to display it.
   a. Click the arrow beside Checklist and select Create new.
   b. Enter the first item in the text box that appears and press the enter key.
   c. Enter subsequent items to complete the checklist.
   d. Optional: To save the checklist for reuse, click the arrow beside Checklist and select Save as Template. Enter the name and click Save. You can click the minus icon to the right of a checklist item to delete it. You can click and drag a checklist item to another position in the list.

8. When finished, perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the case</td>
<td>Enter resolution information and click Comment for the caller to see the note or Work Note for internal information. Click Close Complete at the top of the form.</td>
</tr>
</tbody>
</table>

⚠️ Note: All HR tasks must be closed before the parent HR case can be closed.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the case to continue working on it</td>
<td>Enter work notes describing your progress and click Update.</td>
</tr>
</tbody>
</table>

If you closed the case, the state changes to **Awaiting Acceptance** and the caller is notified to review it and accept or reject the resolution or reopen the case. When it is accepted, the state changes to **Closed**. If there is no response within two business days, the case closes automatically.

If the resolution is rejected, the case is reopened to the **Work in Progress** state.

**View and update an HR task in legacy HR**

You can work on the HR tasks assigned to HR cases in the non-scoped version of HR.

**Before you begin**
Role required: hr_basic or hr_task_writer

**About this task**
You can view HR tasks from the parent HR case by scrolling to the **Tasks** related list. To work with HR tasks directly, follow these steps.

**Procedure**
1. Navigate to **HR • Case Management > HR Tasks**, and select a module, such as **Open** or **Assigned to me**.
2. Click the task to view.
3. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Begin working on a new task</strong></td>
<td>Click <strong>Start work</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The parent HR case must be in progress for you to start work on the task.</td>
</tr>
</tbody>
</table>

| Close a task                         | Enter information in the **Work notes** field and other fields as needed, and change the **State** to **Closed Complete**. |
|                                      | **Note:** All HR tasks must be closed before the parent HR case can be closed. |

| Clone the task to create a new task  | Click the **Clone Task** related link. Enter the new task information in the task form and click **Update**. |
| Cancel the task                      | Click **Cancel Task** in the form header.                                     |
| Review the progress of sibling tasks | Scroll to the **Sibling Tasks** related list. If sibling tasks are listed, click a task number to see the details. |

When all tasks are closed for an HR case, an email notification is sent to the HR agent who is assigned to the case.
4. **Optional:** To suspend the parent HR case service level agreement (SLA) because you need more information, look for one of the following options under Related Links. If one appears, select it and enter a description of the information you need.
   - **Request document:** Suspend a task because a document is needed.
   - **Request additional user information:** Suspend a task because more information is needed.
   - **Suspend case:** Suspend a task for any other reason.
   
   When no choices appear and you want to suspend the case, open the parent HR case and suspend it. You can suspend the HR case from more than one task, when needed. The HR case is suspended. The employee receives an email notification and responds by providing the information. You are notified when this action is completed.

5. **Optional:** To add a checklist, click the arrow beside Checklist and select the checklist to add. To create a new checklist, perform the following steps.
   
   Checklist appears if the administrator configured the form to display it.
   
   a. Click the arrow beside Checklist and select Create new.
   b. Enter the first item in the text box that appears and press the enter key.
   c. Enter subsequent items to complete the checklist.
   d. Optional: To save the checklist for reuse, click the arrow beside Checklist and select Save as Template. Enter the name and click Save.
   
   You can click the minus icon to the right of a checklist item to delete it. You can click and drag a checklist item to another position in the list.

6. Click Update.

**Suspend and resume an HR case in legacy HR**

You can suspend an HR case if you are unable to close the case within the duration specified in the service level agreement (SLA).

**Before you begin**

Role required: hr_basic or hr_case_writer

**About this task**

For example, you may need to contact a vendor, such as the insurance administrator or payroll processing company, to obtain the information needed to close the case. After beginning work on the case, you can suspend it until the information is received. This way the HR case does not show that the SLA is breached. When the information is received, you enter it into the case and resume SLA tracking.

**Procedure**

1. Open the HR case to suspend.
   
   You must begin work on the case before you can suspend it.

2. Click Suspend.
   
   The Suspend Reason pop-up window opens.

3. Select one of the following suspension reasons and enter the information you are waiting for.
   
   - **User:** If you need more information from the employee before proceeding.
   - **Company:** If you are waiting for a reply from a vendor or other outside company.
   - **Document:** If the employee needs to attach documentation to the HR case.
• **Group**: If you are waiting for a reply from an internal group.

• **Other**: If you suspend the case for any other reason.

**Example**
For example, if you are waiting for the health insurance administrator to investigate an employee claim, select **Company** for the reason and enter **Results of investigation** or something similar.

4. Click **Suspend**.
   The SLA stops progressing and the suspension notes appear in the activity stream as work notes. You can continue to add work notes to a suspended case.

5. To resume a suspended HR case, open the case and click **Resume**.
   The SLA progress is resumed.

---

**Request user documentation in legacy HR**
You can request that an employee attach required documentation to an HR case.

**Before you begin**
Role required: hr_basic or hr_case_writer

**About this task**
To request documentation, you suspend the case with a **Document** suspend reason. The case SLA is stopped and a task is created and assigned to the **Opened for** employee. Examples of required documentation include the following.

- Receipts for tuition reimbursement
- Affidavits of domestic partnership to extend benefits
- Work visas

**Procedure**
1. Open an HR case that requires documentation.

2. Click **Suspend**.
   The Suspend Reason pop-up window opens.

3. Select **Document** from the **Reason** choice list.

4. Enter a **Work Note** describing the document that is required to resolve the case.
   The employee sees this description in the email notification they receive.

5. Click **Suspend**.
   The case is suspended and a task is assigned to the user who must submit the documents.
   An email notification with a link to the task is sent to the employee.

**Results**
The employee clicks the link in the email to open the task. When the documentation is attached, it is automatically set to **Closed Complete**. The attached documentation is moved to the HR case, and you receive notification that the HR case is resumed and the task is closed.

**What to do next**
You can click the link in the email notification to open the HR case. Review the attachments, and then complete and close the HR case.
Escalate an HR case in legacy HR

You can escalate an HR task if you are unable to resolve the issue. This action reassigns it to the manager of the HR group.

Before you begin
Role required: hr_basic or hr_case_writer

About this task
An HR case may need to be escalated when you encounter any of the following conditions.

- Are unable to complete the task due to excessive workload.
- Do not have the necessary skills.
- Need help with some part of the HR case.

An escalated HR case is reassigned to the manager of the HR group assigned to the case. The manager can resolve the case or reassign it to someone with the necessary skills or available time.

Note: The manager must be a member of the assigned group. If the manager is not a member of the group, then an error message appears when the escalation is submitted and no action is taken.

Procedure
1. Open an HR case to be escalated.
2. Under Related Links, click Escalate case.
3. Enter a reason for the escalation in the dialog window that opens.
4. Click OK. The case is reassigned to the manager. An email notification is sent that contains the escalation reason so the manager can determine how to proceed.

HR cases for VIPs in legacy HR

Your organization can assign VIP status to users, such as the CEO and vice-presidents, to ensure that the resolution of their tasks is given high priority, in the non-scoped version of HR.

If your organization uses the VIP feature, set up the following to ensure that VIP HR cases are handled appropriately.

- Navigate to Skills > Groups.
- Add members or a group to HR VIP Watchlist. When an HR case is submitted, members of this group receive notification as the case progresses.
- Review the HR service level agreement (SLA) for handling VIP cases. The duration is two hours. When the duration is reached, the SLA is breached and the members of the watchlist are notified.
- Navigate to HR Administration > Properties.
- Enter a case priority number in the Default case priority for VIP requestor field.
- For VIP employees, check the VIP box on their HR profile.

Note: Customize the HR profile form in the Form Designer to show the VIP check box.

You can identify VIP HR cases in the following ways:
• HR Cases list: A VIP icon appears in the Opened for field. You may have to personalize the list to see the Opened for field.

• HR Case form: The employee name in the Opened for field is red.

• HR catalog items: When the form is submitted, a message appears at the top identifying the submitter as a VIP.

Checklists in HR cases and tasks in legacy HR

A feature of tasks is the ability to add a checklist, in the non-scoped version of HR. In an HR case or task, a checklist can serve as a reminder to the HR agent to ensure that the procedure is followed.

A checklist can be added as a reminder for just the current case, or the HR agent can save the checklist for reuse. Do not confuse checklists with HR tasks. Here is an example of how both might be used for a request to change employee HR profile information.

1. A manager submits an employee change request through the HR Service Portal when the employee gets a promotion. An HR case is created with the request to change the title and position. This HR case involves changes not only to the HR profile, but also to the records in the payroll and performance management systems for the employee.

2. HR tasks are added to the HR case to update the payroll and performance management systems. Each HR task is assigned to an agent on the appropriate HR team, such as a payroll clerk and an HR generalist.

3. The payroll clerk adds a checklist to the HR task as a reminder of how to time the payroll record update for the correct payroll cycle.

4. The HR agent adds a checklist to the HR case as a reminder to communicate the promotion within the organization. For example, the checklist items are:
   • Get the promotion into next company newsletter
   • Let the manager know when the change reflects in the system
   • Remind the employee to order new business cards, if applicable

Enable and reuse checklists

The checklist does not appear automatically in the HR case and HR task forms. If you decide to use the checklist feature, the administrator must configure the forms in the form designer to add the checklist formatter.

If you plan to reuse checklists for certain types of tasks, determine a naming convention that makes it easy to find the checklist. All checklists are saved in the same list and are available for selection in every type of task. For example, you may construct checklist names to begin with HR and then specify if it is for a case or task, and its purpose. Examples based on the scenario include:

• HR case promotion reminders
• HR task payroll timing

Approve an HR case in legacy HR

HR cases may require review and approval before the HR case process can proceed, in the non-scoped version of HR.

Before you begin
Role required: hr_admin, hr_approver_user, hr_basic, or hr_manager
About this task
Approvals can be assigned to individual users or to members of a specified group. For example, all members of the HR group are approvers for the predefined HR processes, such as onboarding and offboarding.

Only one member of the group must respond and approve or reject the request for it to proceed.

Note: Employee onboarding and offboarding HR cases always require approval.

After a new case is submitted, a group approval task is created and approvers are assigned. An email notification is sent to all approvers. They appear in the Approvers related list in the HR case.

Procedure
1. Open the HR case by performing one of the following actions.
   - Click the link provided in the email.
   - Navigate to HR • Case Management > My Approvals, and then select the record.
   - Navigate to Self-Service > HR Service Portal and click My approvals.

2. Review the HR case and click Approve or Reject.
   - If the request is approved, the process continues and the HR case state moves to Work in Progress. Related items are auto-created, such as HR tasks and requests as defined in the template or workflow.
   - If the request is rejected, the process terminates, the HR case state moves to Closed Incomplete.
   - After one approver responds, the approval state for other approvers changes to No Longer Required.

Related information
Configuration in legacy HR

View and manage HR cases in legacy HR
You can use the Case Management module to view and manage HR cases assigned to you, open and closed cases, as well as unassigned and all cases, in the non-scoped version of HR.

Before you begin
Role required: hr_case_reader

Procedure
1. Navigate to HR • Case Management > Case Management, then select one of the following modules.
   - Assigned to me: all cases assigned to the logged-in user.
   - Open: all open cases.
   - Open - Unassigned: all open cases that have not been assigned.
   - Closed: all closed cases.
   - All: all cases.
   - Case SLAs: all cases with SLAs.

2. Select the case to view.
View and manage HR tasks in legacy HR

You can use the **HR Tasks** module to view and manage tasks assigned to you, open and closed tasks, as well as unassigned and all tasks, in the non-scoped version of HR.

You can view your HR case-related tasks and manage task work.

HR tasks and task states can be viewed at **HR • Case Management > HR Tasks**.

HR dashboards and reports in legacy HR

You can use HR dashboards, reports, and other HR management modules to monitor and manage HR cases and employee satisfaction, in the non-scoped version of HR.

Depending on your HR job function, you can use any of the following tools to help you with day-to-day HR operations.

- Dashboards, including the Overview, Manager Dashboard, and Onboarding Dashboard. Dashboards are a type of homepage containing reports and other widgets. You click a listed record or a segment in a report to see details.
- HR reports, including those that are available on the dashboards. A number of HR reports are predefined for you, and you can create additional reports.
- Survey response charts and detail for the HR case satisfaction survey or other HR surveys that you create.

HR Performance Analytics

You can subscribe to Human Resources Performance Analytics to provide additional metrics for evaluation and planning purposes.

Manage HR cases by category in legacy HR

You can use the Human Resources Overview dashboard to monitor and manage HR cases by category, in the non-scoped version of HR.

**Before you begin**

Role required: hr_basic

**About this task**

By default, the Overview dashboard displays the following reports.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Cases Opened in the Last 6 Months By Category</td>
<td>Evaluate the types of cases that are handled over time and ensure that there is enough skilled HR staff to manage the case load.</td>
</tr>
<tr>
<td>Active HR Cases by Category</td>
<td>See a pie chart of all open HR cases by category.</td>
</tr>
<tr>
<td>Active HR Case Breakdown by Category</td>
<td>Review the numbers of HR cases assigned to each HR agent by category so workload can be adjusted if necessary.</td>
</tr>
<tr>
<td>Active HR Cases Pivot Table by Category</td>
<td>Use another type of report to see HR agent by category.</td>
</tr>
</tbody>
</table>
You can customize any dashboard that you can access to add or remove reports and other widgets. For example, an HR benefits administrator may add a report to the Overview dashboard that displays the status of HR cases in the Benefits category.

**Procedure**

1. Navigate to **HR • Case Management > Overview**.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>See the information represented by a chart segment</strong></td>
<td>Hold your cursor over the segment to see a tooltip with the details.</td>
</tr>
<tr>
<td><strong>See the corresponding cases for a chart segment</strong></td>
<td>Click the chart segment. A list of the cases opens.</td>
</tr>
<tr>
<td><strong>Save the chart as an image file</strong></td>
<td>If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.</td>
</tr>
</tbody>
</table>

**Related information**

- [Customize a homepage](#)

**Manage HR cases by reporting in legacy HR**

You can use the Human Resources Overview (Reporting) dashboard to monitor and manage HR cases by reporting, in the non-scoped version of HR.

**Before you begin**

Role required: hr_basic

**About this task**

By default, the Overview (Reporting) dashboard displays the following reports.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical Cases Open</td>
<td>Overview.</td>
</tr>
<tr>
<td>Unassigned Cases</td>
<td>Overview.</td>
</tr>
<tr>
<td>Open Cases With Breached SLAs</td>
<td>Overview.</td>
</tr>
<tr>
<td>Cases Awaiting Approval</td>
<td>Overview.</td>
</tr>
<tr>
<td>New Hires Starting This Month</td>
<td>Overview.</td>
</tr>
<tr>
<td>Open Cases not updated for 7 Days</td>
<td>Overview.</td>
</tr>
<tr>
<td>Open HR Cases - Grouped</td>
<td>Bar chart.</td>
</tr>
<tr>
<td>Open HR Cases Older Than 30 Days - Grouped</td>
<td>Bar chart.</td>
</tr>
<tr>
<td>Open HR Cases By Priority and State</td>
<td>Heatmap chart.</td>
</tr>
<tr>
<td>Open HR Cases Older Than 30 Days by Priority and State</td>
<td>Heatmap chart.</td>
</tr>
<tr>
<td>HR Cases Open per Month</td>
<td>Line graph.</td>
</tr>
</tbody>
</table>
You can customize the dashboard to add or remove reports and other widgets. You can group and stack the grouped charts using a chart configuration choice list below the charts. Group and stack by: Priority, State, Category, Assignment group, Department, or SLA.

### Procedure

1. Navigate to **HR • Case Management > Overview (Reporting)**.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>See the information represented by a chart segment</strong></td>
<td>Hold your cursor over the segment to see a tooltip with the details.</td>
</tr>
<tr>
<td><strong>See the corresponding cases for a chart segment</strong></td>
<td>Click the chart segment. A list of the cases opens.</td>
</tr>
<tr>
<td><strong>Save the chart as an image file</strong></td>
<td>If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.</td>
</tr>
<tr>
<td><strong>Edit the chart or widget, refresh, or close.</strong></td>
<td>Click and point to the chart segment. Icons appear in the right upper corner of the chart.</td>
</tr>
</tbody>
</table>

### Related information

**Customize a homepage**

**Use the HR Manager Dashboard in legacy HR**

Use the Manager Dashboard to monitor HR team effectiveness based on metrics like state of assigned cases by HR agent and service level agreement (SLA) elapsed time percentage, in the non-scoped version of HR.

**Before you begin**

Role required: hr_manager

**About this task**

By default, the Manager Dashboard displays the following reports:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Satisfaction Survey - 30 Day AVG</td>
<td>Evaluate the satisfaction of employees with the handling of HR cases. This chart displays information if you ask employees to complete the HR Request Satisfaction Survey.</td>
</tr>
<tr>
<td>HR Case SLAs by Elapsed Time Percentage</td>
<td>Monitor the time to resolve HR cases and follow up when case SLAs are breached.</td>
</tr>
<tr>
<td>Active HR Cases by Assignment And State</td>
<td>Review the numbers of HR cases assigned to each HR agent by state, for example, <strong>Ready</strong></td>
</tr>
</tbody>
</table>
You can customize any dashboard that you can access to add or remove reports and other widgets. For example, an HR benefits administrator may add a report to the Manager Dashboard that displays the assignment and state of HR cases in the **Benefits** category.

### Procedure
1. Navigate to **HR • Case Management > Manager Dashboard**.
2. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the information represented by a chart segment</td>
<td>Hold your cursor over the segment to see a tooltip with the details.</td>
</tr>
<tr>
<td>See the corresponding cases for a chart segment</td>
<td>Click the chart segment. A list of the cases opens.</td>
</tr>
<tr>
<td>Save the chart as an image file</td>
<td>If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.</td>
</tr>
</tbody>
</table>

### Related information
- **Customize a homepage**

### Monitor HR onboarding cases in legacy HR
You can use the Onboarding Dashboard to monitor the progress and status of employee onboarding cases, in the non-scoped version of HR. It helps you ensure that onboarding requests are being approved in a timely manner, and that tasks and fulfillment requests are completed before the new employee starts work.

### Before you begin
**Role required**: hr_manager

### About this task
You can also use the Onboarding Dashboard to balance the workload of HR agents and recruiters who work on the tasks associated with onboarding. By default, the dashboard displays the following reports.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active HR Onboarding Cases</td>
<td>View a snapshot of each case and its workflow stage and state, and see who it is assigned to.</td>
</tr>
<tr>
<td>Open Onboarding Cases / Requests Awaiting Approval / Number of HR Profiles</td>
<td>Click any of these quick links to see the corresponding records.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR Onboarding Cases by Location</td>
<td>Review the number of onboarding cases by state for each location.</td>
</tr>
<tr>
<td>Active HR Onboarding Cases by Assigned To</td>
<td>Evaluate the workload of onboarding cases assigned to each HR agent.</td>
</tr>
<tr>
<td>Active HR Onboarding Tasks by Assigned To</td>
<td>Evaluate the workload of onboarding tasks assigned to each HR agent.</td>
</tr>
<tr>
<td>Active HR Onboarding IT Requests</td>
<td>Review a list of IT fulfillment requests by state. An example is the request to set up and deliver a computer to the new employee.</td>
</tr>
</tbody>
</table>

You can customize any dashboard that you can access to add or remove widgets and reports. For example, an HR recruiting manager may add a report to the Onboarding Dashboard that lists the requests waiting approval grouped by location.

**Procedure**
1. Navigate to HR • Case Management > Onboarding Dashboard.
2. Perform any of the following tasks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See workflow task descriptions in the list of onboarding cases</td>
<td>Point your cursor to a workflow icon to see a tooltip with the description. You can also click the arrow to the left of the icons to expand the list of icons and their descriptions.</td>
</tr>
<tr>
<td>Work on an HR case</td>
<td>Click the case number. After you make changes and click <strong>Update</strong>, the Onboarding Dashboard reopens.</td>
</tr>
<tr>
<td>See the cases for a chart segment</td>
<td>Click the chart segment. A list of the cases opens.</td>
</tr>
<tr>
<td>Review the cases or tasks assigned to an HR agent</td>
<td>Click the name of the HR agent in the <strong>Active HR Onboarding Cases by Assigned To</strong> or <strong>Active HR Onboarding Tasks by Assigned To</strong> list.</td>
</tr>
<tr>
<td>See the status of IT fulfillment requests</td>
<td>Click the request state in the <strong>Active HR Onboarding IT Requests</strong> list. Select a request, and view the items in the <strong>Requested Items</strong> related list.</td>
</tr>
<tr>
<td>Save the chart as an image file</td>
<td>If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.</td>
</tr>
</tbody>
</table>

**Related information**
- Employee onboarding workflow in legacy HR
- Customize a homepage
Run HR reports in legacy HR
You can run reports to view and monitor the status of HR cases, in the non-scoped version of HR.

Before you begin
Role required: hr_manager or hr_admin

About this task
Use HR reports to improve overall efficiency and effectiveness. For example, you can view all Employee Relations cases that were created in the past month.

Procedure
1. Navigate to HR • Case Management > Reports.
   Reports in the HR report group are listed. The icon to the left of the report indicates the type of report, such as a list, pie chart, or bar chart. Point your cursor to the icon to see a pop-up window of report information. Click the star on the left to make the report a favorite; you can filter for favorite reports by clicking the star above the Reports list.

2. Click the name of the report to run.
   The report opens with the runtime options at the top and the results at the bottom.

3. Perform any of the following actions.
   • Change any runtime option and click Run to see the results.
   • In a list report, click a listed case to see its details.
   • In a chart, click a segment to see the corresponding cases.
   • Publish or schedule the report.
   • Edit the runtime options and save a new report.

What to do next
If you want to create additional HR reports, click Create a report above the Reports list. After you create reports, share them with the HR report group so they can view them on the Reports list.

Available HR reports in legacy HR
Predefined HR reports are available in the HR - Case Management > Reports list.

Available reports

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active HR Cases</td>
<td>Tabular view of all active cases.</td>
<td>Number, Type, Category, State,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Short description, Opened by,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assignment group, Assigned to</td>
</tr>
<tr>
<td>Active HR Cases Pivot Table</td>
<td>Pivot table view of all active cases.</td>
<td>Assigned to, Category</td>
</tr>
<tr>
<td>by Category</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active HR Onboarding Cases</td>
<td>Tabular view of active onboarding</td>
<td>Number, Priority, State, Short</td>
</tr>
<tr>
<td>by Assigned To</td>
<td>cases, grouped by Assigned to</td>
<td>description, Opened by, Opened for, Assignment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>group, Assigned to</td>
</tr>
<tr>
<td>Report name</td>
<td>Description</td>
<td>Displays</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active HR Onboarding IT Requests</td>
<td>Tabular view of onboarding tasks assigned to IT, for example, for computers and other office equipment.</td>
<td>Number, Priority, State, Short description, Assigned to, Location</td>
</tr>
<tr>
<td>Active HR Onboarding Tasks by Assigned To</td>
<td>Tabular view of open HR tasks for active onboarding HR cases, grouped by Assigned to.</td>
<td>Number, Case, Priority, State, Short description, Assignment group, Assigned to</td>
</tr>
<tr>
<td>Case Satisfaction Survey - 30 Days AVG</td>
<td>Bar chart showing the averages over 30 days of responses to the HR case satisfaction survey.</td>
<td>Average Actual Value, Metric</td>
</tr>
<tr>
<td>Cases Awaiting Approval</td>
<td>Count of unapproved HR cases or requests.</td>
<td>Number</td>
</tr>
<tr>
<td>HR Case SLAs by Assigned</td>
<td>Bar chart showing the number of overdue cases by the assigned user.</td>
<td>Count, User, State</td>
</tr>
<tr>
<td>HR Case SLAs by Elapsed Time Percentage</td>
<td>Bar chart showing the number of cases by the elapsed time percentage until the SLA is breached.</td>
<td>Count, Elapsed time percentage</td>
</tr>
<tr>
<td>HR Case Transfer Rate</td>
<td>Bar chart showing the number of times the assigned HR agent was changed by category for the last six months.</td>
<td>Number of reassignments, Category</td>
</tr>
<tr>
<td>HR Cases Opened Last Month by Category</td>
<td>Bar chart of cases raised over the last month by HR case category.</td>
<td>Category, Count, Month</td>
</tr>
<tr>
<td>HR Cases Opened This Month by Category</td>
<td>Bar chart of cases raised over the current month by HR case category.</td>
<td>Category, Count</td>
</tr>
<tr>
<td>HR Onboarding by Location</td>
<td>Bar chart showing the number of onboarding cases by location.</td>
<td>Location, Count</td>
</tr>
<tr>
<td>My HR Cases by Category</td>
<td>Pie chart of cases assigned to you, where each slice represents an HR case category.</td>
<td>Category, Count</td>
</tr>
<tr>
<td>Number of HR Profiles</td>
<td>Count of HR profile records.</td>
<td>Number</td>
</tr>
<tr>
<td>Open High Priority Cases</td>
<td>Count of active high priority HR cases</td>
<td>Number</td>
</tr>
<tr>
<td>Open Onboarding cases</td>
<td>Count of active onboarding cases</td>
<td>Number</td>
</tr>
</tbody>
</table>
Available reports (continued)

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Breached</td>
<td>Count of HR cases with a breached SLA</td>
<td>Number</td>
</tr>
<tr>
<td>Unassigned HR Cases</td>
<td>List of HR cases not assigned to any user.</td>
<td>Number, Type, Category, State, Short description, Opened by, Assignment group, Assigned to</td>
</tr>
</tbody>
</table>

**HR case SLAs in legacy HR**

HR service level agreements, or SLAs, let you track the progress of HR cases, in the non-scoped version of HR. SLAs are used to ensure that an HR case or task is resolved within a certain amount of time.

An SLA is a record that defines a set amount of time for a task to reach a certain condition. For example, a benefits inquiry should be resolved within a few business days, and an onboarding case should be resolved within two weeks. If the case or task does not reach the condition by the set amount of time, it is marked **Breached**.

SLAs are defined in **Service Level Management > SLA > SLA Definitions**. The following HR SLAs are predefined.

**HR SLAs**

<table>
<thead>
<tr>
<th>SLA</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Case SLA - 4hours</td>
<td>HR cases in the <strong>Case Management</strong> category that are not entered for a VIP.</td>
</tr>
<tr>
<td>HR VIP Case SLA - 2Hours</td>
<td>HR cases entered for a VIP.</td>
</tr>
<tr>
<td>HR Change SLA - 2days</td>
<td>HR cases in the <strong>Employee Change</strong> category that are not entered for a VIP.</td>
</tr>
<tr>
<td></td>
<td>For example, onboarding and offboarding cases are assigned this SLA.</td>
</tr>
</tbody>
</table>

One of these SLAs is automatically assigned to each opened case. An administrator can modify these SLAs or create new SLAs for HR cases.

Whenever a case is entered, an SLA record is created to track the case duration. You can view the SLA progress and status for cases in any of the following modules for the Human Resources application.

**Modules to view HR SLAs**

<table>
<thead>
<tr>
<th>HR Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager Dashboard</td>
<td>Displays the <strong>HR Case SLAs by Elapsed Time Percentage</strong> report, which shows the aging of active HR case SLAs.</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>Displays the <strong>Active HR Cases SLA Indicator per Week- By AVG</strong> chart, which shows the average number of cases that were in each aging bucket, from the past four weeks.</td>
</tr>
<tr>
<td>Case Management &gt; Case SLAs</td>
<td>Displays a list of all HR cases with their SLAs.</td>
</tr>
</tbody>
</table>
Modules to view HR SLAs (continued)

<table>
<thead>
<tr>
<th>HR Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Lists the HR Case SLAs by Assigned and HR Case SLAs by Elapsed time percentage HR reports, which you can run to view SLA information.</td>
</tr>
</tbody>
</table>

The SLA elapsed time is recalculated via scheduled jobs on the Schedule Item [sys_trigger] table. The scheduled job runs based on when the SLA is breached.

SLA scheduled jobs

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA update (already breached)</td>
<td>Repeats every day.</td>
</tr>
<tr>
<td>SLA update (breach after 30 days)</td>
<td>Repeats every 5 days.</td>
</tr>
<tr>
<td>SLA update (breach within 1 day)</td>
<td>Repeats every hour.</td>
</tr>
<tr>
<td>SLA update (breach within 1 hour)</td>
<td>Repeats every 10 minutes.</td>
</tr>
<tr>
<td>SLA update (breach within 10 min)</td>
<td>Repeats every 1 minute.</td>
</tr>
<tr>
<td>SLA update (breach within 30 days)</td>
<td>Repeats every day.</td>
</tr>
</tbody>
</table>

View the SLA of an HR case in legacy HR

You can view the SLA record that is created when an HR case is open.

Before you begin
Role required: hr_admin or hr_manager

Procedure

1. Navigate to HR • Case Management > Case Management > Case SLAs.
   - You can click the HR case number in the Task column to open the case, or click the SLA definition value to view the SLA conditions.
2. To open the SLA record for a case, click the value in the Stage column.
The record includes the actual and business elapsed times and the time left before the SLA is breached. The business elapsed times and time left considers the schedule. In the record example displayed in the figure above, the SLA started at 4:30 PM and the time was paused from 5:00 PM to 8:00 AM.

3. When you are viewing the SLA record, you can perform any of the following actions.
   - To update the SLA percentage and elapsed time values, click **Refresh**.
   - To recreate and recalculate the SLA record, click **Repair**.
   - To view the SLA in a graph, click the **Show SLA Timeline** related link.

### Evaluate HR survey responses in legacy HR

After you have collected responses to an HR survey, you can review the survey responses and scorecard, in the non-scoped version of HR.

#### Before you begin

**Role required:** admin, hr_manager, or hr_admin

#### About this task

A scorecard shows charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.

A scorecard shows charts for survey results, in which category and question responses are analyzed and current ratings are compared with previous ratings. Users can examine ratings over time, compare question ratings, or compare the ratings of all categories. All ratings are averages for the time range selected. The system dynamically updates a scorecard each time you view it, so the ratings reflect recently completed surveys.
Procedure

1. Navigate to **HR • Administration > Surveys > HR Surveys.**

2. Click the survey to evaluate responses.

3. To review individual responses to each question, click the **View Responses** related link and perform any of the following tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>See individual responses for a metric (question)</td>
<td>Expand the metric group in the Metric Results list.</td>
</tr>
<tr>
<td>View responses based on when the survey was taken</td>
<td>Personalize the Metric Results list to include the <strong>Created</strong> column, and add a filter using the condition builder. For example, to see all responses since the beginning of the month, add this condition: <code>[Created] [at or after] [&lt;select date&gt;]</code></td>
</tr>
</tbody>
</table>

If the survey was not submitted anonymously, you can see how users answered and follow up if necessary.

4. To review the survey scorecard, click the **View Scorecard** related link and perform any of the following tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a different view for the scorecard</td>
<td>Select the view from the left choice list above the chart. The interactive scorecard shows the name of the survey and results or comparisons of the ratings. You can show results in the following views: following views:</td>
</tr>
<tr>
<td></td>
<td>• Category Results</td>
</tr>
<tr>
<td></td>
<td>• Question Results</td>
</tr>
<tr>
<td></td>
<td>• Average Ratings</td>
</tr>
<tr>
<td></td>
<td>• History</td>
</tr>
<tr>
<td>Save a chart as an image</td>
<td>Click the menu icon and select the type of image file. After the file is generated, click <strong>Download.</strong> The file is downloaded to the download folder of the browser.</td>
</tr>
</tbody>
</table>

Related information

- HR surveys in legacy HR
- Survey responses and results
- View a survey scorecard

Chat for legacy HR

You can manage and monitor the HR chat queue, as well as create an HR case from a chat, in the non-scoped version of HR.
Manage the HR chat queue in legacy HR
You can configure the HR department chat queue and review the chat records to measure how well employees are being assisted when they initiate a conversation.

Before you begin
To use the HR chat queue, the administrator must activate the Human Resources Application: HR Connect plugin.
Role required: admin or hr_admin

About this task
You can configure the assignment group for monitoring the chat queue and the messages that employees see when they initiate a conversation and while they are waiting.
You can review the chat records to see how long employees waited for a response and who is accepting the chat requests.

Procedure
1. Navigate to Collaborate > Connect Support > Support Administration > Queues.
2. Select HR Department Chat Queue from the Chat Queues list.
3. Fill in the fields, as appropriate.

Chat Queue form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group that contains the support staff for the queue. Any user in the group can view the queue in the Connect sidebar and accept chats. No other users can access the queue. This field must be populated.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average time it takes for an agent to accept a chat in the queue. This value is automatically calculated. Do not manually edit.</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Different queue to which an agent can escalate a chat. For example, there is a queue for high priority support chats. When a queue is defined in this field, agents can access the Escalate option in conversations.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts their chat. For example, Thank you for contacting support. We are looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Not available</td>
<td>Message that users see when they attempt to start a chat outside the defined queue Schedule. You can use HTML to format the message and include links or media.</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example, How can I help you?</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule that defines when the queue is available. Leave the field blank to make the queue available all the time. Users cannot start a new conversation in the queue outside the schedule hours.</td>
</tr>
</tbody>
</table>

4. To review conversations associated with the queue, add the Chat Queue Entries related list and review the records for the following information.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How long the user waited and the result</td>
<td>Review information in the <strong>State</strong> and <strong>Wait time</strong> columns.</td>
</tr>
<tr>
<td>Who is actively helping employees in the queue</td>
<td>Review the names of agents in the <strong>Assigned to</strong> column.</td>
</tr>
</tbody>
</table>

### Monitor the HR chat queue in legacy HR

Employees can ask a question from the **Chat with HR** link on the HR Portal. Their question is placed in the HR chat queue, and any HR agent monitoring the queue can respond to it.

**Before you begin**

To use the HR chat queue, the administrator must activate the Human Resources Application: HR Connect plugin.

Role required: hr_basic

**About this task**

By default, all members of the HR group monitor the HR chat queue. When a question is submitted to the queue, a pop-up notification appears.

![HR chat queue notification](image)

**Procedure**

1. **Navigate to Connect > Connect Support.**
   The Connect workspace opens in a new tab.

2. **Click the support tab of the Connect sidebar, indicated by a headset icon ( OnCollision).**
   The support tab displays **Queues** to which you belong. It also displays your open support conversations under **Cases**. When a user starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue can accept the conversation. An agent can also request to transfer a conversation directly to you.
3. Accept a conversation in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a conversation from a queue</td>
<td>Under Queues, click Accept by the queue. The conversation opens in the</td>
</tr>
<tr>
<td></td>
<td>conversation pane and an entry appears in the Cases section of the sidebar.</td>
</tr>
<tr>
<td>Accept a transfer request</td>
<td>Under Cases, click Accept by a transfer request. The conversation opens in</td>
</tr>
<tr>
<td></td>
<td>the conversation pane. The agent who transferred the conversation can stay</td>
</tr>
<tr>
<td></td>
<td>in the conversation.</td>
</tr>
</tbody>
</table>

4. Respond to the user and help resolve the issue. By default, your messages are added to the conversation record as comments and are visible to the user.

5. Optional: Initiate a Zoom meeting to help resolve customer issues faster. For more information, see [Initiate Zoom meetings from chats](#).
What to do next
If necessary, you can open a new HR case or incident from the conversation for further investigation. You can also transfer the conversation to a different agent or queue, or escalate the conversation to a higher priority queue.

Create an HR case from a chat in legacy HR
If an HR chat results in the need to open a case, create the case directly from the conversation.

Before you begin
Role required: hr_basic or hr_case_writer

About this task
When you create an HR case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

Procedure

2. Click the support tab of the Connect sidebar, indicated by a headset icon (_headset_).

3. Under Cases, open an HR conversation.

4. At the bottom of the conversation, click the menu icon ( ) to open the Connect actions menu.

5. In the Connect actions menu, select Create HR Case. In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details.

6. Complete the form as necessary and click Submit.
   Any comments or work notes in the record conversation appear as comments on the incident form. Work notes do not appear in the chat for the ESS user. The chat agent can select whether a message is a Comment or Work Note in the conversation.

   a. In the record conversation, by the text entry field, click the message type icon ( ).
   b. Select Comment or Work Note.
   c. Enter a message.

   By default, record conversation messages are added as comments.

   Note: If you add an attachment to a record conversation, it is attached to the underlying record as well.

The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table. Any new journal fields added to the record do not appear in the chat. The system also changes the document ID for the conversation to reference the incident number instead of the entry in the Chat Queue Entry table.

Signature pad for legacy HR
Use the signature pad to capture an electronic signature that can be associated with a document or a task.
Use
You can send your employees documents that require a user verification such as a digital signature or by typing their name.
When signature pad is associated with a document or a task, it captures the drawn signature as an image and stores it in the Signature Image [signature_image] table.

ℹ️ Note: Typing a signature provides acknowledgement, but does not capture an image that is stored.

The HR Service Delivery application uses signature pad with onboarding documents like offer letters, background check approval, company policy acknowledgements, and more.


For HR document templates, use the Insert Signature button to insert a variable that prompts a user to sign the document. For HR PDF document templates, use the Employee Signature field name and PDF Template Mappings to prompt a user to sign the document. Refer to HR document templates.

ℹ️ Note: Check the generate document UI action condition to ensure this feature works correctly.

Examples
The HR Delivery System uses PDF documents for various scenarios. An example of the code used to call a UI page or dialog box for the signature pad:

```javascript
var gDialog = new GlideModal('accept_signature');
gDialog.setTitle(new GwtMessage().getMessage('Please sign document'));
gDialog.setWidth("500");
gDialog.setPreference('sysparm_document_id', get('task_sys_id').value);
gDialog.setPreference('sysparm_table_name', get('task_table').value);
gDialog.setPreference('sysparm_draw_only', 'false');
gDialog.render();
```
An example of the code used in a document after a signature has been accepted and a final PDF document is created:

```html
<%xml version="1.0" encoding="utf-8"?>
<jelly trim="false" xmlns:jelly="http://www.jellyframework.org" xmlns:j2="null" xmlns:j2a="null">%>

</jelly>
</xml>
```

Activate the Signature Pad plugin in legacy HR

To activate signature pad in your application, activate the Signature Pad plugin [com.snc.signaturepad]. The Signature Image [signature_image] table installs with this plugin.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the Signature Pad plugin [com.snc.signaturepad] using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

> **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Test Signature Pad in legacy HR

After you have activated the Signature Pad plugin, you can try it.

**Procedure**

1. Navigate to **System UI > UI Pages > accept_signature**.
2. Scroll down and click **Try It**.
3. In the **Print your name** field, type your name.
4. Click **Accept**. A record is inserted in the Signature Image [signature_image] table.
5. To draw your signature, select the **Draw it** tab.
6. Use your mouse to draw your signature.
7. Click **Accept**. A record is inserted in the Signature Image [signature_image] table.

### HR Service Portal Legacy

The HR Service Portal application provides a single place for employees to quickly and easily get all the HR services they need in the legacy (non-scoped) version of HR.

#### Use HR Service Portal as an employee or HR agent

**Employees use legacy HR Service Portal**

As an employee, you can update your HR profile, view your open cases, request HR services, attach documentation to a case, search the HR knowledge base, and chat with or email HR from the self-service HR Service Portal.

**HR agents use legacy HR Service Portal**

As an HR agent, you can define and maintain employee data for HR benefits, employee relations, systems, payroll, and employee data management.

**Activation information**

You need to **Activate HR Service Portal Legacy**.

### HR Service Portal

Depending on the user type, the HR Service Portal view can vary. This is an example of one view.

> **Note:** The HR Service Portal requires Microsoft Internet Explorer 10 or above.
Activate HR Service Portal Legacy

You can activate Human Resources Application: Service Portal [com.snc.hr.service_portal] for the non-scoped version of HR if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Human Resources Application: Service Portal provides the employee self-service HR Service Portal.

It activates these related plugins if they are not already active.

### Plugins for Human Resources Application: Service Portal

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Resources Application:</td>
<td>Provides basic HR features.</td>
</tr>
<tr>
<td>Core [com.snc.hr.core]</td>
<td></td>
</tr>
<tr>
<td>Human Resources Application:</td>
<td>Sets up an HR chat queue and makes it available</td>
</tr>
<tr>
<td>HR Connect [com.snc.hr.hr_connect]</td>
<td>on the</td>
</tr>
<tr>
<td></td>
<td>HR Service Portal.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Employees use legacy HR Service Portal

As an employee, you can update your HR profile, view your open cases, request HR services, attach documentation to a case, search the HR knowledge base, and chat with or email HR from the self-service HR Service Portal in the non-scoped version of HR.

**Note:** The HR Service Portal view is slightly different for employees already working and employees onboarding into the company.

### Update your HR profile in legacy HR Service Portal

Employees can update some of the information in their HR profile, including some personal information, contact information, emergency contacts, and employment history, in the non-scoped version of HR.

**About this task**

The HR administrator configures which personal information fields are editable by the employee. For example, employees may be allowed to update their date and place of birth. Fields that are not editable are disabled when employees view their HR profiles.

**Procedure**

1. Navigate to **Self-Service > HR Service Portal**.
2. Click on your name in the **My Profile** category.
3. Add or update your personal contact information by clicking in the information sections.
4. To add your Bio information, click **Empty** next to **Bio** and add a short description.
5. Click **Upload Picture** to browse to a photo file to add to your profile.
6. Click **Create new contact** to add to your **My Contacts**.
7. Click **Update**.

### Add your contacts in legacy HR Service Portal

Employees can add contact information to their HR profile and specify who to contact in an emergency.

**Procedure**

1. Navigate to **Self-Service > HR Service Portal**.
2. Click your name in the **My Profile** category.
3. Click **Create new contact** under the **My Contacts** category.
4. Enter the contact name, telephone numbers, and other information.
5. To specify the person as an emergency contact, check the **Emergency contact** box.
The **Priority** field appears.

6. Select the priority of the contact, **Primary** or **Alternate**.

7. Click **Save**.

**View your open cases in legacy HR Service Portal**

You can view your open HR cases from the HR Service Portal in the non-scoped version of HR.

**Procedure**

1. Navigate to **Self-Service > HR Service Portal**.
   - You can also navigate to **Self-Service > My Requests**, however, the list that appears contains all your open requests, not just HR cases.

2. Under **My Open Cases**, click the case description to see its details or tasks assigned to you.
   - You must have a Service Portal role (sn_hr_sp.xxxx) to view the task assigned.

3. To edit information, click a field, edit the information, and click **Save**.

4. Optional: Click the **Activity** tab to enter a message if necessary.

**Submit a service catalog request from legacy HR Service Portal**

You can open the HR Service Portal to submit questions and request help from the HR team in the non-scoped version of HR.

**About this task**

There are several ways you can make a request or ask a question on the HR Service Portal.

- **Catalog**
  - Use the **Catalog** link in the top banner of the HR Service Portal to access all the HR categories available on the portal. From any of these categories you can ask a general question or make a request by clicking on the category.

- **Browse the HR service catalog**
  - Click on any of the category links under **Browse HR Service Catalog** to access specific HR categories available on the portal. From any of these categories you can ask a general question or make a request.

- **General inquiries**
  - Click on the **General Inquiries** category link under **Browse HR Service Catalog** to ask a question not specific to any of the portal categories.

- **Chat with or email HR**
  - You can chat with HR or email your questions or requests to HR by using the Chat with HR and Email HR links in the top banner of the HR Service Portal.

**Procedure**

1. Navigate to **Self-Service > HR Service Portal**.
   - **Browse HR Service Catalog** and select the topic that pertains to your question or request.
   - **Catalog** in the top banner of HR Service Portal and select the topic that pertains to your question or request.

2. Review the knowledge documents that appear, and if your question or request is resolved, exit the form. Otherwise, continue with the remaining steps.

3. Answer the questions in the request form.
Questions vary depending on the item selected. Mandatory fields have a red asterisk (*) beside them.

4. Click **Submit**.
The page refreshes to display your open cases and a link to the case in **My Open Cases**. You can check the case to see who it was assigned to.

**Enroll in or modify benefits in legacy HR Service Portal**
You can open the HR Service Portal to enroll in benefits or modify your existing benefit plan.

**About this task**
There are several types of benefits in the **Catalog** section of the HR Service Portal that require enrollment.

**Medical Benefits**
Use this link to download and complete the applicable enrollment form and upload to HR. You can also ask questions about benefit options or the enrollment process.

**Dental Benefits**
Use this link to download and complete the applicable enrollment form and upload to HR. You can also ask questions about benefit options or the enrollment process.

**Vision Benefits**
Use this link to download and complete the applicable enrollment form and upload to HR. You can also ask questions about benefit options or the enrollment process.

**Pharmacy Benefits**
Use this link to download and complete the applicable enrollment form and upload to HR. You can also ask questions about benefit options or the enrollment process.

**401(k) Plan**
Use this link to download and complete the applicable enrollment form and upload to HR. You can also ask questions about benefit options or the enrollment process.

**Direct Deposit**
Enroll in direct deposit for your paycheck by clicking on the Payroll link.

**Procedure**
1. Navigate to **Self-Service > HR Service Portal**.
2. Under **Browse HR Service Catalog**, select **Benefits**. The benefits category opens.
3. Select the item to enroll in or modify, such as **Medical Benefits**.
   The Medical Benefits page opens to display the current medical coverage provider and related knowledge documents available to read for information.
4. Review the knowledge articles that appear if desired. Otherwise, continue with the remaining steps.
5. Under **What would you like to do today?**, select **Enroll in or modify your medical plan**.
   An instruction to download and complete the applicable enrollment form will appear. A link to the form to download will also appear under **Forms**.
6. Click on the applicable form.
   The form will download to your computer.
7. Open the form and complete the required information.
8. Save the form to your computer.
9. Return to the Medical Benefits page on the HR Service Portal to attach your completed form.
10. Click Add attachments.
11. Browse to your completed form on your computer and click or double click the form you want to attach.
12. Click Submit.

Results
After submitting the completed form the process to enroll you in the company medical benefit plan will begin.
Follow the same steps to enroll in dental, vision, pharmacy, 401(k), and direct deposit benefit plans.

Request employment verification in legacy HR Service Portal
You can submit an HR request to generate an employment verification letter and have it sent via email to the institution making the request.

About this task
You can request an employment letter either through the Catalog in the top banner area of the portal page or through Browse HR Service Catalog. The letter is generated based on your HR profile information. The HR agent assigned to your request can attach the letter to an email message and send it to the contact email address you provide.

Procedure
1. Navigate to Self-Service > HR Service Portal.
2. Under Browse HR Service Catalog, select Employee Data Management.
   As an alternative, you can also click on Catalog in the top banner area of the portal page to get to the request form.
3. Select Employment Verification.
   The form to request an employment verification letter opens.
4. Complete the form, entering the reason you need the letter, the name of the company or institution, the name of your contact and the address, and the contact's email address.
5. Click Submit.

Request tuition reimbursement in legacy HR Service Portal
If your organization reimburses the tuition you paid for courses that support your role, a tuition reimbursement request form is available from the HR Service Portal.

About this task
When you submit the request, you and must attach required documentation to the case. Typically this is your payment receipt and transcript/course completion.

You can request tuition reimbursement either through the Catalog in the top banner area of the portal page or through Browse HR Service Catalog.
Procedure

1. Navigate to Self-Service > HR Service Portal.

2. Under Browse HR Service Catalog, select Benefits.

3. Select Tuition Reimbursement.

4. Review the knowledge documents that appear if desired. Otherwise, continue with the remaining steps.

5. Select Submit a reimbursement request for an approved course.

6. Select the approved course for reimbursement from the drop down list.

7. Click the boxes next to each category if you have digital copies of your payment receipt and transcripts/course completion.

8. Drag and drop the documents from your file browser into the form or click the attachment icon to navigate to the document location and select them to attach.

9. Click Submit.

   The case is created with two tasks: one can be seen in HR Tasks for the HR agent to review the documents, and one for a payroll agent to process the reimbursement. You can see the case in My Open Cases on the HR Service Portal.

What to do next

If you did not attach the required documents, you can attach them to the HR request when you are ready. Open the HR request, and drag and drop the documents from your file browser, or click the attachment icon to navigate to the document location and select them.

Attach documentation to a case in legacy HR Service Portal

You may receive a request from an HR agent to submit documentation, such as receipts or legal documents, in the non-scoped version of HR.

About this task

For example, if you are asking for tuition reimbursement, the HR agent needs a copy of the tuition payment receipt to submit the reimbursement request. When documentation is required, a task is generated for you to attach the document(s), and you receive an email notification.

If you have a digital copy of the requested document when you receive the email notification, you can reply to the notification and attach the file to the reply email. The system attaches it to the task and closes the task for you. The following procedure describes how to attach it to the HR case in the system.

Procedure

1. When you receive notification of required documentation, scan or upload the documents to your computer.

2. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To respond from the email notification</td>
<td>Click the link to the task that is in the notification email. The HR Task form opens. The</td>
</tr>
</tbody>
</table>
To navigate to the task in the HR Service Portal

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select My Tasks and complete the following steps.</td>
<td></td>
</tr>
<tr>
<td>a. Open the request that requires documentation. You see a message at the top that action is required.</td>
<td></td>
</tr>
<tr>
<td>b. Click the link in the message. A dialog window opens.</td>
<td></td>
</tr>
<tr>
<td>c. If you know the documents that need to be attached, click the attachment icon and attach them.</td>
<td></td>
</tr>
<tr>
<td>d. If you are not sure what to attach, click the arrow next to the Document requested for HR Case to see what the HR agent asked for.</td>
<td></td>
</tr>
<tr>
<td>e. Click the attachment icon and attach the documents, and then click Update.</td>
<td></td>
</tr>
</tbody>
</table>

You can also attach files by dragging and dropping them from your file browser into the HR task or HR case form.

The task changes from blue to gray and a check mark appears in the task box under My Tasks indicating the task is Closed Complete. A notification is sent to the HR agent that the documentation is available.

Search the HR knowledge base in legacy HR Service Portal

When you have a question about the organization's policies or benefits, search the HR knowledge base in HR Service Portal before submitting an HR question or request in the non-scoped version of HR.

About this task

On the HR Service Portal, you can enter search text and see matching articles as you type. If an article answers your question, you do not need to submit an HR request.

Procedure

1. Navigate to Self-Service > HR Service Portal
2. Click Knowledge Base in the banner. The Knowledge Base window opens.
3. You can read Top Rated Articles or articles associated with various categories, such as, Benefits, FAQ, or Payroll or enter your search text and do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open an article that appears below the search box</td>
<td>Click the article name.</td>
</tr>
<tr>
<td>Open the HR knowledge base advance search</td>
<td>Click Search at the top of the list.</td>
</tr>
</tbody>
</table>
4. To complete the advanced search, enter text above the list of articles and press the Enter key. Matching articles are listed, and a filter appears on the left to let you refine search results by knowledge bases, categories, or authors.

5. Click the article to read.

What to do next
When you access knowledge base articles, it is a good practice to rate and review the information presented, especially if information is missing or out-of-date. Your organization may choose not to show rating and comment fields, but if they appear in the article, take the time to rate it. This helps ensure that information stays current and useful to others.

Chat with HR in legacy HR Service Portal
You can ask a question of an HR agent who is monitoring the chat queue from the HR Service Portal in the non-scoped version of HR. The HR agent can open a case from the conversation if your question needs further investigation.

About this task
The HR chat queue is available if the administrator has enabled it. If it is not enabled, the chat link does not appear in the HR Portal.

Procedure
1. Navigate to Self-Service > HR Service Portal.
2. Click Chat with HR in the banner. The HR department chat queue opens in a new window.
3. Enter your question and press Send. An HR agent who is monitoring the queue will join the conversation. The HR agent can transfer the conversation to another HR agent if necessary, or create an HR case. Either of you can attach files in the chat window, such as policy documents or screen shots.

Email HR in legacy HR Service Portal
You can email HR from the HR Service Portal in the non-scoped version of HR. The HR agent can open a case from the email content if your question or request needs further investigation.

Procedure
1. Navigate to Self-Service > HR Service Portal.
2. Click Email HR in the banner. An new email opens addressed to HR.
3. Type the email subject and your content and press Send. The HR agent or group monitoring the email can transfer the email to another HR agent if necessary, or create an HR case. Either of you can attach files to the email, such as policy documents or screen shots.

HR agents use legacy HR Service Portal
As an HR agent, you can define and maintain employee data for HR benefits, employees relations, systems, payroll, and employee data management in the non-scoped version of HR.
Manage HR Benefits in legacy HR

You can define and maintain HR benefit data that is used for creating and assigning benefits cases in the non-scoped version of HR.

The HR • Benefits module contains a list of all open benefits cases and allows HR agents to enroll employees in the company benefit plans. HR agents can add and modify benefit providers and benefit types. Tuition reimbursement cases are managed through the HR • Benefits module.

The following information is set up and maintained as part of the HR • Benefits module. Employees can access HR benefits information and submit HR benefits cases from the HR Service Portal. HR managers or administrators set up and modify the information.

• HR Benefits Case Management
• HR Benefits
  ◦ Beneficiaries
  ◦ Dental benefits
  ◦ Medical benefits
  ◦ Pharmacy benefits
  ◦ Retirement benefits
  ◦ Vision benefits
• Benefit Providers and Types
• Tuition Reimbursements

HR specialists, generalists, and managers can perform any of the following tasks.

• Create HR benefits cases for employees to record the processing of HR requests, such as a request from an employee for tuition reimbursement or a request for information about a benefit.
• Create HR cases for automated HR processes, such as employee medical insurance enrollment.
• View HR benefits case information and manage the overall HR workload. For example, a manager can work with all HR cases that are not assigned.

HR benefits cases can have one or more associated HR tasks to manage individual pieces of work within the case.

Benefits case management in legacy HR

You can use HR dashboards, reports, and other HR management modules to monitor and manage HR benefits cases in the non-scoped version of HR.

You can view a list of all benefits cases in the HR • Benefits > Case Management > Benefits Cases module.

You can view a list of tuition reimbursement cases in the HR • Benefits > Tuition Reimbursements module.

Depending on your HR job function, you can use any of the following tools to help you with day-to-day HR benefits cases and operations.
• Dashboards, including the Overview, Overview (Reporting), and Manager Dashboard. Dashboards are a type of homepage containing reports and other widgets. You click a listed benefit record or a segment in a report to see details.

• HR reports, including reports available on the dashboards. Various HR reports are predefined for you, and you can create additional reports.

Create or modify a beneficiary in legacy HR
You can create, add, or modify an employee beneficiary using the HR • Benefits module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees request to create, add, or modify a beneficiary to a particular benefit plan by submitting a request through the HR Service Portal. A beneficiaries case is opened and can be viewed and managed at HR • Benefits > Case Management. Once a beneficiary is added to the HR application, HR agents can add the beneficiary to an employee benefit record using the lookup icon.

Procedure
1. Navigate to HR • Benefits > Benefits > Beneficiaries.
The HR Beneficiaries list opens.
2. Click New to open a beneficiary record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name</td>
<td>Full name of the beneficiary.</td>
</tr>
<tr>
<td>SSN</td>
<td>Social security number of the beneficiary.</td>
</tr>
<tr>
<td>Relation to employee</td>
<td>Relationship to the employee.</td>
</tr>
<tr>
<td>Date of birth</td>
<td>Beneficiary birth date.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage amount of the benefit distributed to the beneficiary.</td>
</tr>
<tr>
<td>Benefit type</td>
<td>Type of benefit, such as, 401(k), Basic Life, Retirement Plan, or Voluntary Life.</td>
</tr>
<tr>
<td>Beneficiary contact</td>
<td>Beneficiary contact information if available.</td>
</tr>
<tr>
<td>Beneficiary type</td>
<td>Primary or contingent.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who submitted the case. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the beneficiary.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the beneficiary.</td>
</tr>
</tbody>
</table>

4. Click Submit.
The beneficiary is listed in the HR Beneficiaries list.
5. To modify beneficiary data, find the existing beneficiary in the HR Beneficiaries list. You can use the list search menu by typing the beneficiary name and pressing Enter. You can also search on the employee name the same way.

6. Click the beneficiary name to open the form. The HR Beneficiary form opens displaying full name and other populated fields.

7. Modify the form.

8. Click Update.

Create or modify a dental benefit in legacy HR
You can add or modify a dental benefit for an employee using the HR • Benefits module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees can ask questions about dental benefits and request to enroll in a dental insurance plan by submitting a request through the HR Service Portal. A dental benefits case is opened and can be viewed and managed at HR • Benefits > Case Management.

Procedure
1. Navigate to HR • Benefits > Benefits > Dental Benefits. The HR Dental Benefits list opens.

2. Click New to open a dental benefits record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the benefit.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Provider</td>
<td>Insurance provider.</td>
</tr>
<tr>
<td>Details</td>
<td>Any details about the benefit.</td>
</tr>
<tr>
<td>Paycheck deduction amount</td>
<td>Dollar amount deducted from the employee paycheck toward the benefit.</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Family members eligible for the benefit.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
</tbody>
</table>

4. Click Submit. The dental benefit is listed in the HR Dental Benefits list.

5. To modify dental benefit data, find the existing dental benefit in the HR Dental Benefits list. You can use the list search menu by typing the employee name and pressing Enter.

6. Click the dental benefit to open the form.
The HR Dental Benefit form opens displaying benefit name and other populated fields.

7. Modify the form.
8. Click Update.

Create or modify a medical benefit in legacy HR

You can add or modify a medical benefit for an employee using the HR • Benefits module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees can ask questions about medical benefits and request to enroll in a medical insurance plan by submitting a request through the HR Service Portal. A medical benefits case is opened and can be viewed and managed at HR • Benefits > Case Management.

Procedure
1. Navigate to HR • Benefits > Benefits > Medical Benefits. The HR Medical Benefits list opens.
2. Click New to open a medical benefits record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the benefit.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Provider</td>
<td>Insurance provider.</td>
</tr>
<tr>
<td>Enrollment form</td>
<td>Managed document employee uses to enroll in the benefit.</td>
</tr>
<tr>
<td>Details</td>
<td>Any details about the benefit.</td>
</tr>
<tr>
<td>Paycheck deduction amount</td>
<td>Dollar amount deducted from the employee paycheck toward the benefit.</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Family members eligible for the benefit.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
</tbody>
</table>

4. Click Submit.
The medical benefit is listed in the HR Medical Benefits list.

5. To modify medical benefit data, find the existing medical benefit in the HR Medical Benefits list.
   You can use the list search menu by typing the employee name and pressing Enter.

6. Click the medical benefit to open the form.
The HR Medical Benefit form opens displaying benefit name and other populated fields.
Create or modify a pharmacy benefit in legacy HR
You can add or modify a pharmacy benefit for an employee using the HR • Benefits module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees can ask questions about pharmacy benefits and request to enroll in a pharmacy benefit plan by submitting a request through the HR Service Portal. A pharmacy benefits case is opened and can be viewed and managed at HR • Benefits > Case Management.

Procedure
1. Navigate to HR • Benefits > Benefits > Pharmacy Benefits.
   The HR Pharmacy Benefits list opens.
2. Click New to open a pharmacy benefits record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

   **HR Pharmacy Benefit form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the benefit.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Provider</td>
<td>Benefit provider.</td>
</tr>
<tr>
<td>Details</td>
<td>Any details about the benefit.</td>
</tr>
<tr>
<td>Paycheck deduction amount</td>
<td>Dollar amount deducted from the employee paycheck toward the benefit.</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Family members eligible for the benefit.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The pharmacy benefit is listed in the HR Pharmacy Benefits list.
5. To modify pharmacy benefit data, find the existing pharmacy benefit in the HR Pharmacy Benefits list.
   You can use the list search menu by typing the employee name and pressing Enter.
6. Click the Pharmacy benefit to open the form.
   The HR Pharmacy Benefit form opens displaying benefit name and other populated fields.
7. Modify the form.
8. Click Update.
Create or modify a retirement benefit in legacy HR

You can add or modify a retirement benefit for an employee using the HR • Benefits module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees can ask questions about retirement benefits and request to enroll in a retirement benefit plan by submitting a request through the HR Service Portal. A retirement benefits case is opened and can be viewed and managed at HR • Benefits > Case Management.

Procedure
1. Navigate to HR • Benefits > Benefits > Retirement Benefits. The HR Retirement Benefits list opens.
2. Click New to open a retirement benefit record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

HR Retirement Benefit form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the benefit.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Provider</td>
<td>Benefit provider.</td>
</tr>
<tr>
<td>Details</td>
<td>Any details about the benefit.</td>
</tr>
<tr>
<td>Paycheck deduction amount</td>
<td>Dollar amount deducted from the employee paycheck toward the benefit.</td>
</tr>
<tr>
<td>Paycheck deduction percent</td>
<td>Percentage deducted from the employee paycheck toward the benefit.</td>
</tr>
<tr>
<td>Balance</td>
<td>Amount of currency in the benefit account.</td>
</tr>
<tr>
<td>Contributions</td>
<td>Employer match contributions.</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Family members eligible for the benefit.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
</tbody>
</table>

4. Click Submit. The retirement benefit is listed in the HR Retirement Benefits list.
5. To modify retirement benefit data, find the existing retirement benefit in the HR Retirement Benefits list. You can use the list search menu by typing the employee name and pressing Enter.
6. Click the retirement benefit to open the form. The HR Retirement Benefits form opens displaying benefit name and other populated fields.
7. Modify the form.
8. Click Update.
Create or modify a vision benefit in legacy HR

You can add or modify a retirement benefit for an employee using the **HR • Benefits** module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees can ask questions about vision benefits and request to enroll in a vision benefit plan by submitting a request through the HR Service Portal. A vision benefits case is opened and can be viewed and managed at **HR • Benefits > Case Management**.

Procedure

1. Navigate to **HR • Benefits > Benefits > Vision Benefits**. The HR Vision Benefits list opens.

2. Click **New** to open a vision benefit record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

### HR Vision Benefit form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the benefit.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested enrollment. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Provider</td>
<td>Benefit provider.</td>
</tr>
<tr>
<td>Details</td>
<td>Any details about the benefit.</td>
</tr>
<tr>
<td>Paycheck deduction amount</td>
<td>Dollar amount deducted from the employee paycheck toward the benefit.</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Family members eligible for the benefit.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the benefit is active for the employee and beneficiaries.</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the benefit is no longer active for the employee and beneficiaries.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. The vision benefit is listed in the HR Vision Benefits list.

5. To modify vision benefit data, find the existing vision benefit in the HR Vision Benefits list. You can use the list search menu by typing the employee name and pressing Enter.

6. Click the vision benefit to open the form. The HR Vision Benefits form opens displaying benefit name and other populated fields.

7. Modify the form.

8. Click **Update**.

HR benefit providers in legacy HR

You can use HR Benefit Providers to maintain and add benefit providers and benefit types to the HR application.
The **HR • Benefits** module contains a list of all benefit providers and types of benefits. HR agents can add and modify benefit providers and types. The following information is set up and maintained as part of the **HR • Benefits > Benefit Providers** module.

- **HR Benefits Providers**
  - Dental benefit providers
  - Medical benefit providers
  - Pharmacy benefit providers
  - Retirement benefit providers, such as 401(k) or IRA
  - Vision benefit providers
  - Voluntary life benefit providers
  - Short-term disability benefit providers
  - Long-term disability
  - Basic life benefit providers

- **HR Benefits Types**
  - Dental
  - Medical
  - Pharmacy
  - Retirement
  - Vision
  - Voluntary life
  - Short-term disability
  - Long-term disability
  - Basic life

**Create or modify a benefit provider in legacy HR**

You can add or modify a benefit provider using the HR Benefit Providers module.

**Before you begin**

Role required: hr_basic, or hr_manager

**About this task**

Benefit providers can be viewed at **HR • Benefits > Benefit Providers > HR Benefit Providers.**

**Procedure**

1. Navigate to **HR • Benefits > Benefit Providers > HR Benefits Providers.** The HR Benefit Providers list opens.
2. Click **New** to open an HR benefit provider record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)
HR Benefit Provider form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the benefit.</td>
</tr>
<tr>
<td>Provider</td>
<td>The name of the benefit provider.</td>
</tr>
<tr>
<td>Plan type</td>
<td>Type of plan, such as medical PPO or HMO or Total Life Platinum or Bronze.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to activate a plan provider in the system. Leaving the box empty or</td>
</tr>
<tr>
<td></td>
<td>deselecting deactivates a provider in the system.</td>
</tr>
<tr>
<td>Benefit type</td>
<td>The type of benefit, such as medical, dental, retirement.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
The benefit provider is listed in the HR Benefit Providers list.  

5. To modify benefit provider data, find the existing benefit provider in the HR Benefit Providers list. You can use the list search menu by typing the benefit provider or benefit name and pressing Enter.  

6. Click the benefit provider or benefit name to open the form. The HR Benefit Provider form opens displaying benefit name and other populated fields.  

7. Modify the form.  

8. Click **Update**.

Create or modify a benefit type in legacy HR

You can add or modify a benefit type using the HR Benefit Providers module.  

**Before you begin**
Role required: hr_basic, or hr_manager  

**About this task**
Benefit types can be viewed at **HR • Benefits > Benefit Providers > HR Benefit Types**.

**Procedure**
1. Navigate to **HR • Benefits > Benefit Providers > Benefits Types**. The HR Benefit Types list opens.  

2. Click **New** to open an HR benefit type record.  

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

HR Benefit Types form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The type of benefit, such as medical, dental, pharmacy.</td>
</tr>
<tr>
<td>Value</td>
<td>Value name of benefit, such as pharmacy or medical.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to activate a plan provider in the system. Leaving the box empty or</td>
</tr>
<tr>
<td></td>
<td>deselecting deactivates a provider in the system.</td>
</tr>
</tbody>
</table>
### HR Tuition Reimbursements in Legacy HR

You can maintain and manage tuition reimbursement cases for an employee using the HR Benefits module.

The **HR • Benefits** module contains a list of all tuition reimbursement cases. HR agents can add and modify tuition reimbursement cases.

#### Create or Modify Tuition Reimbursement in Legacy HR

You can add or modify a tuition reimbursement for an employee using the HR Benefits module.

**Before you begin**

Role required: hr_basic, or hr_manager

**About this task**

Employees can ask questions about approved courses and classes and request tuition reimbursement by submitting a request through the HR Service Portal. A tuition reimbursement case is opened and can be viewed and assigned at **HR • Benefits > Tuition Reimbursements**.

**Procedure**

1. Navigate to **HR • Benefits > Tuition Reimbursements**.
   The HR Tuition Reimbursements list opens.

2. Click **New** to open an HR tuition reimbursement record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

#### HR Tuition Reimbursement Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course title</td>
<td>The name of the course.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested tuition reimbursement. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>School/Program name</td>
<td>Name of the school or program where the employee took the course.</td>
</tr>
</tbody>
</table>

---

Field | Description
---|-------------------------------------------------|
Benefit class | Table name of benefit, such as sn_hr_sp_pharmacy_benefit

4. Click **Submit**.
   The benefit type is listed in the HR Benefit Types list.

5. To modify benefit type data, find the existing benefit type in the Benefit Types list.
   You can use the list search menu by typing the benefit type name or benefit value name and pressing Enter.

6. Click the benefit type to open the form.
   The HR Benefit Type form opens displaying benefit type name and other populated fields.

7. Modify the form.

8. Click **Update**.

---

**HR Tuition Reimbursements in Legacy HR**

You can maintain and manage tuition reimbursement cases for an employee using the HR Benefits module.

The **HR • Benefits** module contains a list of all tuition reimbursement cases. HR agents can add and modify tuition reimbursement cases.

### Create or Modify Tuition Reimbursement in Legacy HR

You can add or modify a tuition reimbursement for an employee using the HR Benefits module.

**Before you begin**

Role required: hr_basic, or hr_manager

**About this task**

Employees can ask questions about approved courses and classes and request tuition reimbursement by submitting a request through the HR Service Portal. A tuition reimbursement case is opened and can be viewed and assigned at **HR • Benefits > Tuition Reimbursements**.

**Procedure**

1. Navigate to **HR • Benefits > Tuition Reimbursements**.
   The HR Tuition Reimbursements list opens.

2. Click **New** to open an HR tuition reimbursement record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

#### HR Tuition Reimbursement Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course title</td>
<td>The name of the course.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user who requested tuition reimbursement. Click the lookup icon and select the user.</td>
</tr>
<tr>
<td>School/Program name</td>
<td>Name of the school or program where the employee took the course.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Course grade</td>
<td>Grade the employee received after completing the course.</td>
</tr>
<tr>
<td>Course justification</td>
<td>Explanation of why the employee took the course.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the reimbursement request, such as Approved or Paid.</td>
</tr>
<tr>
<td>Course start date</td>
<td>Date when the course started.</td>
</tr>
<tr>
<td>Course end date</td>
<td>Date when the course ended.</td>
</tr>
<tr>
<td>Course cost</td>
<td>Cost of the course.</td>
</tr>
<tr>
<td>Refund</td>
<td>Amount reimbursed to the employee.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.  
The tuition reimbursement is listed in the HR Tuition Reimbursements list.

5. To modify tuition reimbursement data, find the existing tuition reimbursement in the HR Tuition Reimbursements list.  
You can use the list search menu by typing the course title or employee name and pressing Enter.

6. Click the tuition reimbursement to open the form.  
The HR Tuition Reimbursement form opens displaying course title and other populated fields.

7. Modify the form.

8. Click **Update**.

---

**Approve a tuition reimbursement request in legacy HR**

To approve a tuition reimbursement request, you review the submitted documentation and justification to ensure the course supports the employee job functions.

**Before you begin**

Role required: hr_basic or hr_approver_user

**About this task**

The employee who submits the request attaches the payment receipt and grades to the tuition form using the HR Service Portal. When the request is submitted, two HR tasks are generated: one to review and approve the payment, and one for payroll to process the payment.

**Procedure**

1. Open a tuition reimbursement request and click **Start work**.

2. Verify the documents that are attached and review them to determine whether to approve the request.

3. **Optional:** If one or more of the documents are not attached or are incorrect, click **Suspend**, select **Document** for the reason, and enter a note about the documents that you need.  
The HR case is suspended. The employee receives an email notification and responds by attaching the documents. You are notified when this action is completed.

4. Open the first task and click **Start Work**.

5. Complete one of the following actions.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request is approved</td>
<td>Click <strong>Close complete</strong>, enter a note that the documents and reimbursement are approved, and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Request is not approved</td>
<td>Click <strong>Close incomplete</strong>, enter a note about why you do not approve the documents or justification, and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

6. To notify payroll that this request is approved for payment, open task assigned to HR payroll and enter a comment that the task is ready for work. This sends an email notification with the comment to the assigned payroll agent.

**What to do next**
After the payroll agent processes the payment, they notify you that the case can be closed.

**Process a tuition payment in legacy HR**
After a tuition reimbursement request has been reviewed and approved, you are notified that the task to process the reimbursement payment is ready to work on.

**Before you begin**
Role required: hr_basic or hr_task_writer

**About this task**
When the tuition reimbursement request was submitted, an HR task was created to process the payment. The HR agent who reviews the documents enters a comment in the HR task for payroll, and you receive email notification with a link to the task.

**Procedure**
1. Click the link in the email notification to open the HR task.
   You can also navigate to **HR • Case Management > HR Tasks > Assigned to me**.
2. Click **Start work**.
3. Complete the process in the payroll system to reimburse the employee.
4. In the HR task, click **Close Complete**, enter a note regarding the reimbursement, and click **OK**.

**Results**
When this task is closed, an email notification is sent to the HR agent assigned to the tuition reimbursement case. The HR agent can review the information and close the HR case.

**Manage HR Employee Relations in legacy HR**
You can define and maintain HR employee relations data that is used for creating and assigning employee relations cases in the non-scoped version of HR.

The **HR • Employee Relations** module contains a list of all open employee relations cases. The module allows HR agents to add and modify disciplinary issues and types, as well as warning types.

The following information is set up and maintained as part of the **HR • Employee Relations** module. Employees can access HR employee relations information and submit HR employee relations cases from the HR Service Portal. HR managers or administrators set up and modify the information.
• HR Employee Relations Case Management
• Disciplinary Issues
  ◦ Disciplinary Issue Types
  ◦ Warning Types

HR specialists, generalists, and managers can perform any of the following tasks.

• Create HR employee relations cases for employees to record the processing of HR disciplinary issues, such as a report from an employee about an absent co-worker or co-worker misconduct.

• View HR employee relations case information and manage the overall HR workload. For example, a manager can work with all HR cases that are not assigned.

HR employee relations cases can have one or more associated HR tasks to manage individual pieces of work within the case.

Employee relations case management in legacy HR

You can use HR dashboards, reports, and other HR management modules to monitor and manage HR employee relations cases.

You can view a list of employee relations cases in the HR • Employee Relations > Case Management > Employee Relations Cases module.

Depending on your HR job function, you can use any of the following tools to help you with day-to-day HR employee relations cases and operations.

• Dashboards, including the Overview, Overview (Reporting), and Manager Dashboard. Dashboards are a type of homepage containing reports and other widgets. You click a listed employee relations record or a segment in a report to see details.

• HR reports, including reports available on the dashboards. Various HR reports are predefined for you, and you can create additional reports.

Create or modify a disciplinary issue in legacy HR

You can add or modify a disciplinary issue for an employee using the HR • Employee Relations module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employees can ask employee relations questions or report disciplinary issues by submitting questions and reports through the HR Service Portal. An employee relations case is opened and can be viewed and managed at HR • Employee Relations > Case Management > Employee Relations Cases.

Not every employee relations case results in a disciplinary issue. However, when a case does result in a disciplinary issue, a disciplinary issue is added to the Disciplinary Issue list.

Procedure
1. Navigate to HR • Employee Relations > Disciplinary Issues > Disciplinary Issues.
   The HR Disciplinary Issue list opens.

2. Click New to open a disciplinary issue record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

**HR Disciplinary Issue form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>The user to be disciplined.</td>
</tr>
<tr>
<td>Type</td>
<td>The disciplinary issue, such as tardiness, improper dress, or misconduct.</td>
</tr>
<tr>
<td>Warning Type</td>
<td>The warning given, such as verbal or written warning.</td>
</tr>
<tr>
<td>Description</td>
<td>Details about the disciplinary issue.</td>
</tr>
<tr>
<td>Disciplinary action</td>
<td>Action taken by HR or management.</td>
</tr>
<tr>
<td>Previous interactions</td>
<td>Details regarding other interactions with the employee.</td>
</tr>
<tr>
<td>Suggested improvement</td>
<td>Details about how to correct or better the issue.</td>
</tr>
<tr>
<td>Review date</td>
<td>Date the disciplinary issue is created or modified.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The disciplinary issue is listed in the HR Disciplinary Issue list.

5. To modify disciplinary issue data, find the existing disciplinary issue in the HR Disciplinary Issue list.
   You can use the list search menu by typing the employee name and pressing Enter.

6. Click the disciplinary issue to open the form.
   The HR Disciplinary Issue form opens displaying employee name and other populated fields.

7. Modify the form.

8. Click **Update**.

**Create or modify a disciplinary issue type in legacy HR**

You can add or modify a disciplinary issue type using the **HR • Employee Relations** module.

**Before you begin**
Role required: hr_basic, or hr_manager

**About this task**

Disciplinary issue types can be viewed at **HR • Employee Relations > Disciplinary Issues > Disciplinary Issue Types**.

Types of disciplinary issues include:

- Absenteeism
- Abusive Language or Behavior
- Improper Dress
- Misconduct
- Insubordination
- Tardiness
• Improper Use of Equipment
• Unsatisfactory Work Performance
• Failure to Follow Corporate Policy
• Other

Procedure
1. Navigate to HR • Employee Relations > Disciplinary Issues > Disciplinary Issues Types.
   The HR Disciplinary Issue Types list opens.
2. Click New to open a disciplinary issue type record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

   **HR Disciplinary Issue Type form**
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue</td>
<td>The disciplinary issue.</td>
</tr>
<tr>
<td>Order</td>
<td>Number set to indicate the order in which the issue appears on the record.</td>
</tr>
<tr>
<td>Value</td>
<td>Issue value name, such as absenteeism, or improper_dress.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The disciplinary issue type is listed in the HR Disciplinary Issue Types list.
5. To modify disciplinary issue type data, find the existing disciplinary issue type in the HR Disciplinary Issue Types list.
   You can use the list search menu by typing the disciplinary issue type and pressing Enter.
6. Click the disciplinary issue type to open the form.
   The HR Disciplinary Issue Type form opens displaying the issue and other populated fields.
7. Modify the form.
8. Click Update.

Create or modify a disciplinary warning type in legacy HR
You can add or modify a disciplinary warning type using the HR • Employee Relations module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Disciplinary warning types can be viewed at HR • Employee Relations > Disciplinary Issues > Warning Types.
Types of disciplinary warnings include:
• Verbal Warning
• Written Warning
• Final Warning
• Dismissal
• Other
Procedure

1. **Navigate to HR • Employee Relations > Disciplinary Issues > Warning Types.**
   The HR Disciplinary Warning Types list opens.

2. **Click New to open a disciplinary issue type record.**

3. **Complete the form.** (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>Warning type.</td>
</tr>
<tr>
<td>Order</td>
<td>Number set to indicate the order in which the issue appears on the record.</td>
</tr>
<tr>
<td>Value</td>
<td>Issue value name, such as absenteeism, or improper_dress.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**
   The disciplinary warning type is listed in the HR Disciplinary Warning Types list.

5. **To modify disciplinary warning type data,** find the existing disciplinary warning type in the HR Disciplinary Warning Types list.
   You can use the list search menu by typing the disciplinary warning type and pressing Enter.

6. **Click the disciplinary warning type to open the form.**
   The HR Disciplinary Warning Type form opens displaying the warning type and other populated fields.

7. **Modify the form.**

8. **Click Update.**

Manage HR Systems in legacy HR

You can define and maintain HR systems data that is used for creating and assigning HR systems cases in the non-scoped version of HR.

HR Systems comprises the individual systems that form the HR application.

- Benefits Administration System
- HR Portal
- Learning Management System
- Payroll System
- Performance Management System
- Time and Attendance System

The **HR • Systems** module contains a list of all open HR systems cases. HR agents can grant operational access to systems and create and modify systems reports.

The following information is set up and maintained as part of the **HR • Systems** module. Employees can access HR systems information and submit HR systems cases from the HR Service Portal. HR managers or administrators set up and modify the information.

- HR Password Reset
- HR Portal Support
• HR System Access
• HR System Reports

HR specialists, generalists, and managers can perform any of the following tasks.

• Create HR systems cases for employees to record the processing of HR systems requests, such as an HR password reset or HR Service Portal support.

• View HR systems case information and manage the overall HR workload. For example, a manager can work with all HR cases that are not assigned.

HR systems cases can have one or more associated HR tasks to manage individual pieces of work within the case.

**HR systems case management in legacy HR**

You can use HR dashboards, reports, and other HR management modules to monitor and manage HR systems cases.

You can view a list of all systems cases in the **HR • Systems > Case Management > HR Systems Cases** module.

Depending on your HR job function, you can use any of the following tools to help you with day-to-day HR systems cases and operations.

• Dashboards, including the Overview, Overview (Reporting), and Manager Dashboard. Dashboards are a type of homepage containing reports and other widgets. You click a listed systems record or a segment in a report to see details.

• HR reports, including reports available on the dashboards. Various HR reports are predefined for you, and you can create additional reports.

**Grant or modify HR system access in legacy HR**

You can grant or modify HR system access for an employee using the **HR • Systems** module.

**Before you begin**

Role required: hr_basic, or hr_manager

**About this task**

HR system access is granted for employees eligible for access to certain HR systems, such as the payroll system or benefits administration system. Employees can ask HR systems questions or request system access through the HR Service Portal. An HR systems case is opened and can be viewed and managed at **HR • Systems > Case Management > HR Systems Cases**.

**Procedure**

1. Navigate to **HR • Systems > System Access > System Access**.
   The HR Operations Access (System Access) list opens.

2. Click **New** to open an HR operations access record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)
### HR Operations Access form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the box to activate system access. Deselect to deactivate access.</td>
</tr>
<tr>
<td>Employee</td>
<td>The user requesting systems access.</td>
</tr>
<tr>
<td>Expire date</td>
<td>The date access is deactivated.</td>
</tr>
<tr>
<td>Justification</td>
<td>Details about why the user needs systems access.</td>
</tr>
<tr>
<td>Policy Acceptance</td>
<td>Select the box if a policy acceptance is required. Deselect if not.</td>
</tr>
<tr>
<td>Role</td>
<td>Specific role assignment for the HR system.</td>
</tr>
<tr>
<td>Username</td>
<td>The employee username.</td>
</tr>
<tr>
<td>Granting case</td>
<td>HR systems case number.</td>
</tr>
<tr>
<td>Grant date</td>
<td>Date access is granted.</td>
</tr>
<tr>
<td>HR system</td>
<td>Accessed HR system, such as Payroll System or Benefits Administration System.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. The system access is listed in the HR Operations Access list.

5. To modify system access data, find the existing system access in the HR Operations Access list.
   You can use the list search menu by typing the employee name and pressing Enter.

6. Click the employee name to open the form.
   The HR Operations Access form opens displaying employee name and other populated fields.

7. Modify the form.

8. Click **Update**.

### Create or modify HR system report definitions in legacy HR

You can add or modify HR system reports for an employee using the **HR • Systems** module.

**Before you begin**
Role required: hr_basic, or hr_manager

**About this task**
Employees can ask about HR reports or request an HR report through the HR Service Portal. An HR report case is opened and can be viewed and managed at **HR • Systems > Case Management > HR Systems Cases**.

**Procedure**
1. Navigate to **HR • Systems > Systems Reports > Report Definitions**.
   The HR Operations Reports (Report Definitions) list opens.

2. Click **New** to open an HR operations report record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)
HR Operations Report form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the report.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the report.</td>
</tr>
<tr>
<td>Report type</td>
<td>Type of report, such as Customer Satisfaction, Compliance, or Operational.</td>
</tr>
<tr>
<td>System</td>
<td>System for which the report is needed, such as Payroll System.</td>
</tr>
<tr>
<td>Justification</td>
<td>Why the report is needed.</td>
</tr>
<tr>
<td>Contact</td>
<td>Person to contact about the form.</td>
</tr>
<tr>
<td>Requester</td>
<td>Person requesting the report.</td>
</tr>
<tr>
<td>From</td>
<td>Beginning date for the comprised report data.</td>
</tr>
<tr>
<td>To</td>
<td>End date for the comprised report data.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The system report is listed in the HR Operations Report (Report Definitions) list.

5. To modify system report definitions data, find the existing system report definition in the HR Operations Report (Report Definitions) list.
   You can use the list search menu by typing the report name or the requestor name and pressing Enter.

6. Click the system report to open the form.
   The HR Operations Report form opens displaying report name and other populated fields.

7. Modify the form.

8. Click Update.

Create or modify HR system report frequencies in legacy HR

You can add or modify a system report frequency for an employee using the **HR • Systems** module.

**Before you begin**
Role required: hr_basic, or hr_manager

**About this task**
Employees can ask about HR report frequencies or request an HR report frequency through the HR Service Portal. An HR report case is opened and can be viewed and managed at **HR • Systems > Case Management > HR Systems Cases**.

**Procedure**
1. Navigate to **HR • Systems > Systems Reports > Report Frequencies**.
   The HR Operations Report Frequencies list opens.

2. Click **New** to open an HR operations report frequency record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)
HR Operations Report Frequency form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report frequency</td>
<td>How often the report generates, for example, daily, weekly, monthly.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The system report is listed in the HR Operations Report Frequencies list.

5. To modify system report frequencies data, find the existing system report frequency in the HR Operations Report Frequencies list.
   You can use the list search menu by typing the report frequency name and pressing Enter.

6. Click the system report frequency to open the form.
   The HR Operations Report Frequency form opens displaying the report frequency field.

7. Modify the form.

8. Click **Update**.

Create or modify an HR system report type in legacy HR

You can add or modify a system report type using the **HR • Systems** module.

**Before you begin**
Role required: hr_basic, or hr_manager

**About this task**

   System report types can be viewed at **HR • Systems > Systems Reports > Report Types**.

   Types of system reports include:
   • Customer Satisfaction
   • Compliance
   • Operational
   • Trend Analysis
   • Other

**Procedure**

1. Navigate to **HR • Systems > System Reports > Report Types**.
   The HR Operations Report Types list opens.

2. Click **New** to open a system report type record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

   HR Operations Report Type form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report type</td>
<td>The kind of report to generate, such as, compliance or operational.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The system report type is listed in the HR Operations Report Types list.

5. To modify the system report type data, find the existing system report type in the HR Operations Report Types list.
You can use the list search menu by typing the report type name and pressing Enter.

6. Click the system report type to open the form.
   The HR Operations Report Type form opens displaying the report type.

7. Modify the form.

8. Click **Update**.

**Manage HR Payroll in legacy HR**

You can define and maintain HR payroll data that is used for creating and assigning HR payroll cases in the non-scoped version of HR.

The **HR • Payroll** module contains a list of all open payroll cases. The module allows HR agents to add and modify payroll records, banking accounts, and direct data.

The following information is set up and maintained as part of the **HR • Payroll** module. Employees can access HR payroll information, enroll in direct deposit, and submit HR payroll cases from the HR Service Portal. HR managers or administrators set up and modify the information.

- **HR Payroll Case Management**
- **Employee Payroll Records**
- **Bank Details**
  - **Bank Accounts**
  - **Direct Deposits**

HR specialists, generalists, and managers can perform any of the following tasks.

- Create HR payroll cases for employees to record the processing of HR payroll issues or enrollments.
- View HR payroll case information and manage the overall HR workload. For example, a manager can work with all HR cases that are not assigned.

HR payroll cases can have one or more associated HR tasks to manage individual pieces of work within the case.

**HR payroll case management in legacy HR**

You can use HR dashboards, reports, and other HR management modules to monitor and manage HR payroll cases.

You can view a list of all payroll cases in the **HR • Payroll > Case Management > Payroll Cases** module.

Depending on your HR job function, you can use any of the following tools to help you with day-to-day HR payroll cases and operations.

- Dashboards, including the Overview, Overview (Reporting), and Manager Dashboard. Dashboards are a type of homepage containing reports and other widgets. You click a listed payroll record or a segment in a report to see details.
- HR reports, including reports available on the dashboards. Various HR reports are predefined for you, and you can create additional reports.

**Create or modify an employee payroll record in legacy HR**

You can add or modify an employee payroll record using the **HR • Payroll** module.
Before you begin
Role required: hr_basic, or hr_manager

About this task
Payroll records can be viewed at HR • Payroll > = > Employee Payroll Records > Payroll.

Procedure
1. Navigate to HR • Payroll > Employee Payroll Records > Payroll.
The HR Payrolls list opens.
2. Click New to open an HR payroll record.
3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>The name of the employee.</td>
</tr>
<tr>
<td>Pay period beginning</td>
<td>Day (date) the pay period starts.</td>
</tr>
<tr>
<td>Pay period end</td>
<td>Day (date) the pay period ends.</td>
</tr>
<tr>
<td>Current pay date</td>
<td>Most recent or closest approaching pay date.</td>
</tr>
<tr>
<td>Current income</td>
<td>Amount of income employee has earned to date.</td>
</tr>
<tr>
<td>Year to date income</td>
<td>Total salary and bonus income.</td>
</tr>
<tr>
<td>Current deductions</td>
<td>Amount deducted from income to date.</td>
</tr>
<tr>
<td>Year to date deductions</td>
<td>Total deducted from annual salary.</td>
</tr>
</tbody>
</table>

4. Click Submit.
The payroll record is listed in the HR Payrolls list.
5. To modify payroll record data, find the existing payroll record in the HR Payrolls list.
   You can use the list search menu by typing the employee name.
6. Click the information icon next to the employee name to open the form.
The HR Payroll form opens displaying the employee name and other populated fields.
7. Modify the form.
8. Click Update.

Create or modify an employee bank account in legacy HR
You can add or modify an employee bank account using the HR • Payroll module.

Before you begin
Role required: hr_basic, or hr_manager

About this task
Employee bank account data can be viewed at HR • Payroll > Bank Details > Bank Accounts.

Procedure
1. Navigate to HR • Payroll > Bank Details > Bank Accounts.
The Bank Accounts list opens.
2. Click **New** to open a Bank Account record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)

<table>
<thead>
<tr>
<th><strong>Bank Account form</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Account holder</td>
</tr>
<tr>
<td>Account nickname</td>
</tr>
<tr>
<td>Bank name</td>
</tr>
<tr>
<td>Account type</td>
</tr>
<tr>
<td>Account number</td>
</tr>
<tr>
<td>Routing number</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The bank account is listed in the Bank Accounts list.

5. To modify bank account data, find the existing bank account in the Bank Accounts list.
   You can use the list search menu by typing the employee name and pressing Enter.

6. Click the employee name to open the form.
   The Bank Account form opens displaying employee name and other populated fields.

7. Modify the form.

8. Click **Update**.

Create or modify an employee direct deposit in legacy HR

You can add or modify an employee direct deposit using the **HR • Payroll** module.

**Before you begin**
Role required: hr_basic, or hr_manager

**About this task**
Benefit providers can be viewed at **HR • Payroll > Bank Details > Direct Deposits**.

**Procedure**
1. Navigate to **HR • Payroll > Bank Details > Direct Deposits**.
   The HR Direct Deposits list opens.

2. Click **New** to open an HR direct deposit record.

3. Complete the form. (The fields you see on the form depend on how the form is configured and what fields are selected to display.)
HR Direct Deposit form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Employee name.</td>
</tr>
<tr>
<td>Bank account</td>
<td>Account holder name.</td>
</tr>
<tr>
<td>Deposit amount</td>
<td>Amount of money from paycheck for direct deposit.</td>
</tr>
<tr>
<td>Deposit type</td>
<td>Type of direct deposit, such as, amount, percentage, or remaining.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to activate direct deposit for the employee. Leaving the box empty or deselecting deactivates direct deposit.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. The direct deposit is listed in the HR Direct Deposits list.

5. To modify direct deposit data, find the existing direct deposit in the HR Direct Deposits list. You can use the list search menu by typing the employee name and pressing Enter.

6. Click the information icon or the date in the **Updated** column of the list to open the form. The HR Direct Deposit form opens displaying employee name and other populated fields.

7. Modify the form.

8. Click **Update**.

Manage HR Employee Data Management in legacy HR

HR Employee Data Management manages employee personal information, employment verification letter requests, onboarding tasks for new employees, and offboarding tasks for employees leaving the company in the non-scoped version of HR.

HR specialists, generalists, and managers can:

- Onboard new employees.
- Offboard employees leaving the company.
- Update employee personal information.
- Send employment verification letters.

Employee data management cases can have multiple tasks assigned.

Example HR case request

Alan, an HR recruiter wants to send onboarding documents to new hires.

1. A hiring manager creates an onboarding request through the **HR Service Portal** or, Alan creates an HR onboarding request through **HR • Employee Data Management**. An HR onboarding case is created and assigned to an HR agent, such as a specialist or generalist, based on assignment rules.

2. The case is submitted for approval.

3. After receiving approval, the HR agent processes the HR case, creating HR tasks for this request. Tasks are assigned to the new employee and HR agents.

4. When all the tasks are completed, the HR case is closed.
Create and complete an employee information change case in legacy HR

Employees can request employee information changes through the HR Service Portal. HR agents can create an employee data management case and fulfill this request through HR • Employee Data Management.

About this task
You can fulfill an employee information change request through HR • Employee Data Management.

Procedure
1. Navigate to HR • Employee Data Management > Case Management > Employee Data Management Cases.
   The Employee Data Management Cases list opens.
2. Click New or a case number.
   The Employee Data Management Case form opens. The workflow stages are listed across the top, and the new case is in the Draft stage.
3. Complete the fields on the form.

Employee Data Management Case fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned case ID number, which cannot be changed.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The user who needs HR assistance. Click the Lookup using list icon and select the user. The location and department information is filled in automatically.</td>
</tr>
<tr>
<td>Location</td>
<td>The geographical location of the user associated with the case.</td>
</tr>
<tr>
<td>Department</td>
<td>The department of the user associated with the case.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the HR case. By selecting the category, you can save the new case and initiate the auto-assignment process, if one is available. Select Employee Information Change.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case.</td>
</tr>
<tr>
<td>State</td>
<td>The state or status of the case.</td>
</tr>
<tr>
<td>Priority</td>
<td>The precedence of the case, based on the category and whether the employee is a VIP.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time the case is opened.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group the record is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the Assigned to field. Assignment groups are restricted to those groups with a type of human_resources.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. If the user is not auto-assigned, click the lookup icon to select a user who is a member of the selected assignment group.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Click the Add me icon to include yourself.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the case. A default value appears when a category is selected.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer, more detailed description of the case.</td>
</tr>
<tr>
<td>Work notes or additional comments</td>
<td>Additional information about the case. Click Work notes to add it as an internal work note. Enter the information and click Additional comments if you want the user to see it.</td>
</tr>
</tbody>
</table>

4. Approval is required before the case can move forward. After approval is received, the information is updated and the state changes to **Closed Complete**.

5. To update additional information, click the About Employee, Employment Information, and Contact Information tabs to add or change personal information.

6. Click **Submit** to save and close the case and return to the Employee Data Management Cases list or **Ready for Work** to save and close the case and remain on the Employee Data Management Case form.

Results

After the HR Employee Data Management case is created, a service level agreement (SLA) is applied to track its progress. SLAs define the duration of time it takes to close an HR case. By default, HR onboarding and offboarding cases are set to two days, and other HR cases are set to four hours. The SLA can be suspended in order for the HR agent has to contact a vendor to obtain the information and the vendor is not immediately available. HR managers and administrators can view case SLA records by navigating to **HR • Case Management > Case Management > Case SLAs**. You can also run SLA reports.

**Create an employee offboarding case in legacy HR**

HR agents can offboard employees using the **HR • Employee Data Management** module.

**Before you begin**

Role required: hr_basic or hr_case_writer

**About this task**

HR agents can offboard employees leaving the company using the Employee Data Case Management form.

**Procedure**

1. Navigate to **HR • Employee Data Management > Case Management > Employee Data Management Cases**.
   The Employee Data Management Cases list opens.

2. Click **New** or a case number.
   The Employee Data Management Case form opens. The workflow stages are listed across the top, and the new case is in the Draft stage.

3. Complete the fields on the form.

**Employee Data Management Case fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned case ID number, which cannot be changed.</td>
</tr>
<tr>
<td>Opened for</td>
<td>Click the <strong>Lookup</strong> icon and select the employee to be offboarded.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>The geographical location of the user associated with the case.</td>
</tr>
<tr>
<td>Department</td>
<td>The department of the user associated with the case.</td>
</tr>
<tr>
<td></td>
<td>If you select the department, the <strong>Manager</strong> field is populated if there is an assigned department head.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the HR case. Select <strong>Employee Offboarding</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Some of the case categories have an associated workflow.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the case. The state is also displayed along the top.</td>
</tr>
<tr>
<td>Priority</td>
<td>The precedence of the case, based on the category and whether the employee is a VIP.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time the case is opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The user creating the record.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group the record is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the <strong>Assigned to</strong> field. Assignment groups are restricted to those groups with a type of human_resources.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. If the user is not auto-assigned, click the lookup icon to select a user who is a member of the selected assignment group.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Click the lock icon to add users. Click the <strong>Add me</strong> icon to include yourself.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the case. A default value appears when you select a category.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer, more detailed description of the case.</td>
</tr>
<tr>
<td>Work notes or additional comments</td>
<td>Additional information about the case. Click <strong>Work notes</strong> to add it as an internal work note. Enter the information and click <strong>Additional comments</strong> if you want the user to see it.</td>
</tr>
</tbody>
</table>

4. Approval is required before the case can move forward. After approval is received, the information is updated and the state changes to **Work in Progress**.

5. Scroll down to view the tasks assigned for offboarding.

6. Click a task number (HRTxxxxxxx) to view details and update the state.

7. Click **Update** to save and return to the **Employee Data Management Case** form or **Save** to save and remain on the **HR Task** form.

**Results**

After the HR case is created, a service level agreement (SLA) is applied to track its progress. SLAs define the duration of time it takes to close an HR case. By default, HR onboarding and offboarding cases are set to two days, and other HR cases are set to four hours. The SLA can be suspended when the HR agent has to contact a vendor to obtain the information and the vendor is not immediately available.

HR managers and administrators can view case SLA records by navigating to **HR • Case Management > Case Management > Case SLAs**. You can also run SLA reports.
Complete an employee offboarding case in legacy HR

You can work on an offboarding request to ensure that all required documents have been reviewed and signed prior to the last day of an employee.

Before you begin
Role required: hr_basic or hr_case_writer

About this task
HR agents ensure that all required offboarding tasks have been completed as part of the offboarding process.

Approval is required. Approvers use the HR Service Portal or from the case on the Employee Data Management Case page. After approval is received, the State changes to Work in Progress.

Procedure
1. Navigate to HR • Employee Data Management > Case Management > Employee Data Management Cases or to HR • Case Management > HR Tasks > Assigned to me.
2. Click a case number.
3. Scroll down and review the HR Tasks. As assigned tasks are completed, the State changes to Closed Complete. Tasks in Ready state are not complete.
4. Click the task numbers assigned to you.
5. Click Start Work to save the case information and change the status from Ready to Work in Progress.
6. Change the state to Closed Complete when the task has completed.
7. Click Update to save and return to the Employee Data Management Case form or Save to save and remain on the HR Task form.
8. When all tasks are complete, change the state of the case to Closed Complete.
9. Click Update to save and return to the Employee Data Management Case list or Save to remain on the Employee Data Management Case form.

Results
After the HR Employee Data Management case is created, a service level agreement (SLA) is applied to track its progress. SLAs define the duration of time it takes to close an HR case. By default, HR onboarding and offboarding cases are set to two days, and other HR cases are set to four hours. The SLA can be suspended in order for the HR agent has to contact a vendor to obtain the information and the vendor is not immediately available. HR managers and administrators can view case SLA records by navigating to HR • Case Management > Case Management > Case SLAs. You can also run SLA reports.

Create an employment verification letter case in legacy HR

Employees can request an employment verification letter through the HR Service Portal. HR agents can create an HR case and fulfill this request through HR • Employee Data Management.

About this task
When an employee requests an employment verification letter, HR agents use HR • Employee Data Management to fulfill this request. The letter is generated based on the HR profile information. The HR agent assigned to the request can attach the letter to an email message and send it to the contact email address provided.
Procedure

1. Navigate to HR > Employee Data Management > Case Management > Employee Data Management Cases.
   The Employee Data Management Cases list opens.

2. Click New or a case number.
   The Employee Data Management Case form opens. The workflow stages are listed across the top, and the new case is in the Draft stage.

3. Complete the form.

Employee Data Management Case fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned case ID number, which cannot be changed.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The user who needs HR assistance. Click the Lookup using list icon and select the user. The location and department information is filled in automatically.</td>
</tr>
<tr>
<td>Location</td>
<td>The geographical location of the user associated with the case.</td>
</tr>
<tr>
<td>Department</td>
<td>The department of the user associated with the case.</td>
</tr>
<tr>
<td></td>
<td>The Manager field is populated when there is an assigned department head.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the HR case. By selecting the category, you can save the new case and initiate the auto-assignment process, if one is available.</td>
</tr>
<tr>
<td></td>
<td>Note: Some of the case categories have an associated workflow.</td>
</tr>
<tr>
<td></td>
<td>Select Employment Verification Letter.</td>
</tr>
<tr>
<td>PDF Template</td>
<td>Location of the employee determines the letter template. Change by clicking the Lookup icon to view a list of letters.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the case and also displayed along the top.</td>
</tr>
<tr>
<td>Priority</td>
<td>The precedence of the case, based on the category and whether the employee is a VIP.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time the case is opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The user creating the record.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group the record is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the Assigned to field. Assignment groups are restricted to those groups with a type of human_resources.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. If the user is not auto-assigned, click the lookup icon to select a user who is a member of the selected assignment group.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Click the lock icon to add users. Click the Add me icon to include yourself.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the case. A default value appears when you select a category.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Description | Contact information provided by the employee displays.
Work notes or additional comments | Additional information about the case. Click **Work notes** to add it as an internal work note. Enter the information and click **Additional comments** if you want the user to see it.

4. Click the **About Employee**, **Employment Information**, and **Contact Information** tabs to add or change personal information.

5. Click **Update** to save and return to the **Employee Data Management Cases** list or **Start Work** to save and remain on the **Employee Data Management Case** form. The **State** changes to **Work in Progress**.

Knowledge articles based on the short description are listed. There are two tabs. One showing articles that you have access to, and one showing articles that the caller can access. Different geographic locations or holiday schedules by county determine the article selection.

6. To preview and attach a knowledge article to the case, complete the following steps.

   a. Click **Preview** next to an article.
      
      If you know that the article contains the information you need without previewing it, click **Attach** next to the article.
      
      The article opens in a pop-up window. Click the up or down arrow to review the previous or next article. Click (X) to close the window.

   b. To attach the article, click **Attach to HR Case**.

      The article content is copied into the **Activity** field. After you update the case, the article appears in the **Attached Knowledge** related list.

### Results
After the HR Employee Data Management case is created, a service level agreement (SLA) is applied to track its progress. SLAs define the duration of time it takes to close an HR case. By default, HR onboarding and offboarding cases are set to two days, and other HR cases are set to four hours. The SLA can be suspended when the HR agent has to contact a vendor to obtain the information and the vendor is not immediately available. HR managers and administrators can view case SLA records by navigating to **HR • Case Management** > **Case Management** > **Case SLAs**. You can also run SLA reports.

### Complete an employment verification request in legacy HR

You can generate an employment verification letter when an employee requests one. The letter is generated from a button in the **HR • Employee Data Management** form.

**Before you begin**
Role required: hr_basic or hr_case_writer

**About this task**
The employment verification letter is generated as a PDF. You can print and mail the letter, or attach it to an email from the **Employee Data Management Case** form.

**Procedure**
1. Open an employment verification request and click **Start Work**.
2. Review the contact information provided by the employee in the **Description** field.
3. **Optional:** To obtain missing information, complete the following steps.

   a. Click **Suspend**.

   b. Select **User** as the reason and enter the information you require in **Work Note** field. The employee receives an email notification with your comment about the missing information. After the employee adds the information, you receive an email notification that the information was added in a comment.

   c. Reopen the employment verification request and click **Resume**.

4. The default employee verification letter displays. Click the **Lookup using list** icon to select a different **PDF Template**.

5. To generate the letter as a PDF, click **Generate Document**. The letter opens in the **Edit document** page.

6. Edit the letter.

7. Click **Sign** to draw your signature.

8. Click **Accept**. The letter is generated as a PDF and added to the case as an attachment. You can manage it as you would any attachment. The case is set to the **Awaiting Acceptance** state and the employee who requested the letter is sent notification to review and close the request.

9. To send the letter, click **Send Email**.

10. Verify the email address. Click **OK** to send the email.

11. After receiving acceptance from the employee, change the **State** to **Closed Complete**.

12. Click **Update** to save and remain on the **Employee Data Management Case** form or **Save** to save and return to the **Employee Data Management Cases** list.

Create a new hire onboarding case in legacy HR

HR agents can onboard new employees using the **HR • Employee Data Management** module.

**Before you begin**
Role required: hr_basic or hr_case_writer

**About this task**
HR agents can onboard new employees using the **Employee Data Case Management** form.

**Procedure**

1. Navigate to **HR • Employee Data Management > Case Management > Employee Data Management Cases**.
The **Employee Data Management Cases** list opens.

2. Click **New** or a case number.
The **Employee Data Management Case** form opens. The workflow stages are listed across the top, and the new case is in the **Draft** stage.

3. Complete the form.
### Employee Data Management Case fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The auto-assigned case ID number, which cannot be changed.</td>
</tr>
<tr>
<td>Opened for</td>
<td>For an onboarding case, the user is not yet in the system. Leave this field blank and from <strong>Category</strong> select <strong>New Hire Onboarding</strong>.</td>
</tr>
<tr>
<td>Location</td>
<td>The geographical location of the user associated with the case.</td>
</tr>
<tr>
<td>Department</td>
<td>The department of the user associated with the case. If you select the department, the <strong>Manager</strong> field is populated if there is an assigned department head.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the HR case. By selecting the category, you can save the new case and initiate the auto-assignment process, if one is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Some of the case categories have an associated workflow. Select <strong>New Hire Onboarding</strong> and the <strong>Create Onboarding User</strong> dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>Enter the <strong>First name</strong>, <strong>Last name</strong>, and <strong>Personal email</strong> of the onboarded employee.</td>
</tr>
<tr>
<td>Skills</td>
<td>The required skills of the person assigned to this category of HR case.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the case and also displayed along the top.</td>
</tr>
<tr>
<td>Priority</td>
<td>The precedence of the case, based on the category and whether the employee is a VIP.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time the case is opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The user creating the record.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group the record is assigned to. If the group is not set automatically, assign an HR group to provide a selection of HR users in the <strong>Assigned to</strong> field. Assignment groups are restricted to those groups with a type of human_resources.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to work on this case. If the user is not auto-assigned, click the lookup icon to select a user who is a member of the selected assignment group.</td>
</tr>
<tr>
<td>Watch list</td>
<td>The list of users who receive notifications regarding this case. Click the lock icon to add users. Click the <strong>Add me</strong> icon to include yourself.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the case. A default value appears when you select a category.</td>
</tr>
<tr>
<td>Description</td>
<td>A longer, more detailed description of the case.</td>
</tr>
<tr>
<td>Work notes or additional comments</td>
<td>Additional information about the case. Click <strong>Work notes</strong> to add it as an internal work note. Enter the information and click <strong>Additional comments</strong> if you want the user to see it.</td>
</tr>
</tbody>
</table>
4. Click the **About Employee**, **Employment Information**, and **Contact Information** tabs to add or change personal information.

5. Click **Submit** to save and return to the Employee Data Management Cases list or **Ready for Work** to save and remain on the Employee Data Management Case form. The State changes to **Ready**.

**Results**

After the HR case is created, a service level agreement (SLA) is applied to track its progress. SLAs define the duration of time it takes to close an HR case. By default, HR onboarding and offboarding cases are set to two days, and other HR cases are set to four hours. The SLA can be suspended when the HR agent has to contact a vendor to obtain the information and the vendor is not immediately available.

HR managers and administrators can view case SLA records by navigating to **HR • Case Management > Case Management > Case SLAs**. You can also run SLA reports.

**Complete a new hire onboarding case in legacy HR**

You can work on an onboarding request to ensure that all required documents have been reviewed and signed prior to the first day of a new hire.

**Before you begin**

Role required: hr_basic or hr_case_writer

**About this task**

HR agents ensure that new hires as part of the onboarding process review and sign all required documents.

Approval is required. Approvers use the **HR Service Portal** or from the case on the Employee Data Management Cases form. After approval is received, the State changes to **Work in Progress**.

**Procedure**

1. Navigate to **HR • Employee Data Management > Case Management > Employee Data Management Cases**.

2. Click a case number.

3. Scroll down and review the **HR Tasks**.
   
   As the new employee completes the assigned tasks, the State changes to **Closed Complete**. Tasks in **Ready** state are not complete.

4. Click the task numbers assigned to you.

5. Click **State** or use the buttons at the top of the page.

6. Click **Save** or **Start Work** to save the case information and change the status to **Work in Progress**. Click **Update** to save the case information and return to the Employee Data Management Cases list.
   
   When all tasks are complete, the state of the case changes to **Closed**.
   
   To reactivate a user with a Canceled state, check the **Active** box under the User ID.

**Approve an employee change request in legacy HR**

Approving a request to change employee HR profile information updates the HR profile and automatically closes the case.

**Before you begin**

Role required: hr_basic or hr_approver_user
About this task
Employees can change personal information in their HR profile or a manager can submit a request of a direct report. For example, when a direct report is promoted to a new position.
When a change request is submitted, an HR case is opened, and the Employee Change HR Workflow determines approval requirements.

- If no approval is required, the HR profile is updated automatically and the HR case is closed.
- If it does require approval, HR group members receive a notification with the approval request. When the request is approved, the HR profile is updated and the HR case is closed automatically.

Procedure
1. To approve the request, begin by opening the HR case in one of the following ways.
   - Click a link in the email notification to approve, reject, or view the case.
   - Navigate to HR • Case Management > Case Management > Assigned to me and select the case.
2. If you opened the HR case from the email link or the menu, review the proposed changes.
3. In the Approvers related list, set your approval record to Approved.
   The HR profile is updated and the HR case is set to Closed Complete.

Results
If the HR case is rejected, the HR profile is updated with a reject message and the HR case is set to Closed Incomplete.

HR Performance Analytics Legacy
HR Performance Analytics for the legacy (non-scoped) version of HR Service Delivery measures key performance indicators to track HR performance over time.

Activation information
HR Performance Analytics Non-Scoped requires a separate premium subscription to the Performance Analytics application, as well as activation of the following content pack:

- Performance Analytics - Content Pack - Human Resources [com.snc.pa.hr_core]

Contact your account manager for more information.

Related information
Performance Analytics and Reporting

View HR Performance Analytics Legacy
HR Performance Analytics for the non-scoped version of HR Service Delivery helps you align resources and systems to strategic objectives.

Before you begin
Before HR Performance Analytics data can be viewed, your organization purchases a subscription to Performance Analytics Premium and an administrator activates the plugin.

Role required: hr_basic

About this task
After HR Performance Analytics is activated, the collection job runs daily. Collected data is kept for 30 days. The data in performance analytics reports is collected based on a daily
scheduled job, therefore, the date is one day in the past. Over time, more data is available for historical trending.

The **Performance Analytics** dashboard displays the following reports.

**Volume of Open/Closed Cases by Category**

The line chart displays the trend of open and closed cases for each of the last four weeks. Click a point on a line to see open or closed cases for the duration. The **Breakdowns** tab displays the number of open or closed cases by category. Select **Stacked bar** from the choice list for the best data format.

**Active HR Cases per Week - by AVG**

The bar chart displays the average number of active cases by state for each of the last four weeks. It also displays the total number of cases for each week. The **Breakdowns** tab displays the aging buckets and the total number of cases in each bucket.

**Active HR Cases by State**

The trending chart displays a trend of the cases that moved to each HR case state during the past 30 days. The gray bar to the left of the Trend column represents the proportion of moved cases to the total number of cases. The **Breakdowns** tab displays aging buckets and the number of cases in each bucket for that date.

**Active HR Cases Managed by Agent - Weekly AVG**

The trending chart displays the number of cases that each agent was assigned to over the past four weeks.

**Active HR Cases SLA Indicator per Week- By AVG**

The bar chart displays the average number of cases that were in each aging bucket for each of the last four weeks. The **Breakdown** tab displays the agent and the number of cases on that date in the selected aging bucket. Select **Column** from the choice list for the best data format.

**Procedure**

1. Navigate to **HR • Case Management > Performance Analytics**

2. Perform any of the following actions.

   - Point your cursor to an element, such as a bar or pie segment, to see what the element represents.

   - Click a segment to see more details about the element. You may need to scroll up to view the information. The detail contains the following tabs, depending on the selected element.

     - **Chart**: The detail of the element displayed in a chart. You can use the controls on the upper right to add or change comments, targets, and thresholds.

     - **Breakdowns**: The breakdown of the buckets used in the report. Select a chart type from the choice list on the upper right to see the data in another format.

     - **Records**: The records that comprise the element you selected. You can view the detail of each record.

     - **Scores**: The number of records for each week in the report.
• **Comments**: Comments entered for this report. The tab is disabled unless comments exist.

• **More info**: A description of the logic that generates the report, how often the job runs, and when the data was last collected.

• If a menu icon appears when you point your cursor to a chart, you can click the icon to export the chart to an image file.

**What to do next**
For more information about performance analytics and how to develop and modify widgets for your organization, see [Performance Analytics concepts](#).

**Workplace Service Delivery**

Provide employees with a single place to manage workplace tasks like reserving rooms, ordering supplies, reporting maintenance issues, or requesting cleaning with the ServiceNow® Workplace Service Delivery. Reduce the back-end complexity of setting up and maintaining a streamlined experience for your workplace.

![Image](image-url)

**Prioritize services not processes**

The ServiceNow® Workplace Service Delivery offers flexible solutions for you to balance employee preferences with the changing demands of the business. Define workflows so that employees can find answers, get assistance, and get things done from a single source. Automate back-end processes for employee requests that previously required manual fulfillment. Enable employees to reserve workplace items such as meeting rooms or desks at their convenience.

**View and download the full infocard** for a highlight of Workplace Service Delivery features.

<table>
<thead>
<tr>
<th>Create safe, managed processes for returning employees to the workplace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establish distancing plans, shift assignments, and sanitation scheduling. Manage workplace allocation in stages.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enhance the reservation experience for your employees</strong></td>
<td>Provide a unified reservation experience for employees so that they can submit and track reservation requests for meeting rooms, desks, and more directly from the Service Portal.</td>
</tr>
<tr>
<td><strong>Create workplace services to fulfill employee requests</strong></td>
<td>Automate and standardize the fulfillment of employee inquiries and requests. Improve organizational efficiency and making it easier for employees to get the services they need.</td>
</tr>
<tr>
<td><strong>Provide visitors a smooth and hassle-free experience</strong></td>
<td>Register visitors and customize their visit. Pre-plan what they may require during their stay.</td>
</tr>
<tr>
<td><strong>Synchronize reservations with your calendar service</strong></td>
<td>Enable employees to make reservations in both the Reservation portal or your calendar service. Synchronize the reservations and make it easy for employees to check their reservation details in a single place.</td>
</tr>
<tr>
<td><strong>Provide employees a unique view when making space reservations</strong></td>
<td>Provide employees with a 2D map of your office building floors, meeting rooms, desks, and more when using Reservation Management and Workplace Service Portal.</td>
</tr>
<tr>
<td><strong>Manage spaces and meeting room usages efficiently</strong></td>
<td>Make optimum usage of spaces and other reservable items at your workplace. Manage space assignments, on-boardings, and reuse of spaces to improve layouts and productivity. Track real estate expenses by assigning the spaces to a cost center and/or department.</td>
</tr>
<tr>
<td><strong>Integrate Workplace Reservation Management with Microsoft Outlook</strong></td>
<td>The Workplace Reservations for Microsoft Outlook Add-in enables you to use the Workplace Reservation Management application's capabilities within the Microsoft Outlook application. Create a event or update an existing event or appointment using the add-in. An employee can find all the available spaces easily and request services without the need to open a separate application.</td>
</tr>
<tr>
<td><strong>Enable employees to move easily from one location to another</strong></td>
<td>Manage workplace move requests without any hassle. Enable employees to request a seat change easily through the Workplace Service Portal. As a workplace manager, monitor the progress of a move request, create or assign tasks when necessary and approve or reject a move request.</td>
</tr>
</tbody>
</table>
Create safe, managed processes for returning employees to the workplace

Replace manual and siloed processes with digital workflows to manage space administration, shift assignments, sanitation scheduling, and workplace allocation. Communicate easily with employees, automatically launch workplace maintenance and cleaning workflows, quickly respond to safety concerns, and optimize real estate spending over time by monitoring usage.

Enhance the reservation experience for your employees

Make it easier for your employees to reserve meeting rooms, conference rooms, desks, and other services from the Workplace Service Portal. Manage and track the status of reservation requests. Gain visibility into the usage of workplace items, peak meeting times, and the most-reserved locations.
Create workplace services to fulfill employee requests

Pre-define the fulfillment type of employee inquiries and requests. Based on the type of request, configure whether it needs a manual response, a flow, or a series of activities to resolve.

Provide visitors a smooth and hassle-free experience

Workplace Visitor Management overview

Improve your front-desk operations and customize your visitor’s visit. As an employee, register visitors and plan their requirements in advance. Co-host a visitor with another person. The reception staff can update a visitor’s status while the visitor is on-site.
Synchronize reservations with your calendar service

Workplace Calendar Synchronization

Enable employees to make reservations using Workplace Reservation Management or your calendar service, for example, Microsoft Outlook. Synchronize the reservations using the Workplace Calendar Synchronization application. Create a Connection alias with your calendar service.

Provide employees a unique view when making space reservations

Workplace Space Mapping and Mappedin Integration

Location directory
Explore spaces, find places, and people at your place of work.

Provide employees with a 2D map of your office building floors, meeting rooms, desks, and more when using Reservation Management and Workplace Service Portal. The Location directory in the Workplace Service Portal enables you to search for any workplace location or a user on the world map. You can get directions from one space to another.
Manage space and meeting room usages efficiently

Workplace Space Management

Make optimum usage of spaces and other reservable items at your workplace. Manage space assignments, on-boardings, and reuse of spaces to improve layouts and productivity. Track real estate expenses by assigning the spaces to a cost center and/or department.

Integrate Workplace Reservation Management with Microsoft Outlook

Workplace Reservations for Microsoft Outlook Add-in window

The Workplace Reservations for Microsoft Outlook Add-in enables you to use the Workplace Reservation Management application’s capabilities within the Microsoft Outlook application. Create a event or update an existing event or appointment using the add-in. An employee can find all the available spaces easily and request services without the need to open a separate application.
Enable employees to move easily from one location to another

Workplace Move Management - Request an employee's desk change form

Ask the Workplace Services Team to relocate an employee's workspace

- On behalf of
  
  More information

Requested move date

Move reason
  
  None

From:
  
  Region
  
  Building

To:
  
  Region
  
  Building

What should be moved?
  
  No items to select

Selected Service Items

Add filter  Run filter

Manage workplace move requests without any hassle. Enable employees to request a seat change easily through the Workplace Service Portal. As a workplace manager, monitor the progress of a move request, create or assign tasks when necessary and approve or reject a move request.

Get started

- Work with an implementation specialist to achieve your desired business outcomes. To learn more, visit the Customer Success Center.
- Read the product documentation, beginning with the Workplace Service Delivery Applications.

Products

- Workplace Safety Management
- Workplace Reservation Management
- Workplace Case Management
- Workplace Visitor Management
- Workplace Calendar Synchronization
- Workplace Space Mapping
- Workplace Space Management
- Workplace Reservations for Microsoft Outlook Add-in
- Workplace Move Management
Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Workplace Service Delivery applications

ServiceNow® Workplace Service Delivery provides a suite of applications for improving the employee workplace experience. You can automate workplace management and provide a single platform for all employee services.

Applications installed with Workplace Service Delivery

ServiceNow® Workplace Service Delivery applications help your workforce more efficiently manage workplace-related requests.

Workplace Safety Management

The ServiceNow® Workplace Safety Management application enables you to create safer, managed processes for employees in the workplace. You can establish distancing plans, shift assignments, and sanitation scheduling. Manage your workspace allocation in stages. The Workplace Safety Management is the core application of the Workplace Service Delivery suite.

Workplace Reservation Management

The ServiceNow® Workplace Reservation Management application makes it easier for employees to reserve meeting rooms, conference rooms, desks, and any reservable workplace service from the Service Portal.

Workplace Case Management

The ServiceNow® Workplace Case Management application enables you to analyze the type of request in order to determine if the request needs a human response or automated task. You can create pre-defined steps to fulfill a variety of requests.

Workplace Visitor Management
Welcome your guests and off-site employees with a smoother, more hassle-free experience. Use ServiceNow® Workplace Visitor Management to optimize your front-desk operations and welcome your guests and off-site employees. You can register visitors as well as pre-plan what they will require.

Workplace Calendar Synchronization
Enhance your workplace’s reservation experience by synchronizing your reservations with your calendar provider by using the ServiceNow® Workplace Calendar Synchronization application.

Workplace Space Mapping
Space Mapping enables you to take advantage of the already created building maps produced by applications like Mappedin. The Space Mapping integration with Mappedin allows you to import the data as buildings, floors, spaces, and rooms.

Workplace Space Management
Efficiently supervise every single location of your organization by using the ServiceNow® Workplace Space Management application.

Workplace Reservations for Microsoft Outlook Add-in
Reserve a workplace space in less than a minute without using the Reservation portal. The ServiceNow® Workplace Reservations for Microsoft Outlook Add-in enables you to make a reservation using Microsoft Outlook directly.

The ServiceNow® Workplace Move Management application enables your employees to relocate from one location to another without any hassle and without a required manual permission. Manage and fulfil employee move requests in simple steps.

Workplace Safety Management
The ServiceNow® Workplace Safety Management application enables you to create safer, managed processes for employees in the workplace. You can establish distancing plans, shift assignments, and sanitation scheduling. Manage your workspace allocation in stages. The Workplace Safety Management is the core application of the Workplace Service Delivery suite.
When offices are ready to open and employees return to work...
Space administration

Your organization’s workplace administrators can add details for all workplace locations, such as:

- Areas such as employee workstations, conference rooms, and cafeterias
- Office buildings and campuses
- Regions of all locations

By tracking the availability of workplaces, workplace managers can plan and implement a phased return of employees to the workplace. For example, after the COVID-19 pandemic, your organization might want to allow a certain percentage (for example, 20%) of the total staff to return at a time at each office location, based on office configuration, local health recommendations, and other factors. Workplace managers can indicate workplace availability, leaving space for physical distancing. They can evaluate the situation periodically and make more workplaces available as conditions improve.

As a workplace manager, you can upload floor plans of your organization so employees can more easily view and select available spaces when they request workplace reservations.

Avoid large gatherings or long queues for locations at your workplace such as the cafeteria, gym, and entry and exit gates by defining arrival intervals and having employees schedule their arrivals.

Shift management

Workplace managers can create shifts for employees and schedule them for specific times and days. They can use this data to start planning for the occupancy levels of your workplaces by allocating employees and available workplaces to specific shifts.

For example, workplace managers can create a morning shift schedule with work hours of 08:00 to 13:00. They can then assign available workplaces to this shift based on organizational guidelines. These assigned workplaces can then be reserved for employees operating from the office during this shift.

Shift owners can review and modify the details of the shifts that they own. They can also view workplace reservations and requests made for the shifts they own.

Workplace reservations

Using the information about available employees and workplaces, workplace managers can reserve areas and workplaces for employees. Workplace managers can also generate reservations for multiple employees at once. Both the employee and the workplace manager are notified of reservations through email.

Employees can request workplace reservations when they are ready to return to the office. Using interactive floor plans, they can choose to reserve workplaces for a specified date range, a single day, or a few hours. Depending on your organizational guidelines, reservation requests might require an approval for confirmation.

If the workplace profiles of all employees are set up, the application automatically assigns available workplaces for employees using the data stored in Workplace profile table.

The Workplace Service Delivery provides more advanced workplace reservation options in the Workplace Reservation Management. For more information, see Workplace Reservation Management.

Workplace tasks

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Workplace managers can monitor maintenance activities that are scheduled in the workplace for each shift. They can also schedule planned or on-demand maintenance tasks, and generate reports to track the progress of these activities.

**Workplace Dashboard**

Using data visualizations, you can evaluate the availability of workplaces and occupancy levels of your office locations, and monitor the progress of workplace tasks on the workplace dashboard.

**Use with other Workplace Service Delivery applications**

Workplace Safety Management is the core application of the ServiceNow® Workplace Service Delivery. Use it along with other applications that are part of the suite. For information about other applications available in the suite, see [Workplace Service Delivery applications](#).

All Safe Workplace suite applications are available in the ServiceNow Store.

**Safe Workplace suite for federal customers**

Federal customers using IL4 or FedRAMP environments will see the Safe Workplace suite applications ready and available to install on their nonproduction instances without having to make any special requests. Licenses are required to use Safe Workplace suite applications on production instances. Customers are responsible for configuring the apps to meet U.S. federal regulations and guidelines.

### Installation instructions for self-hosted and federal environments

<table>
<thead>
<tr>
<th>Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial on-premise</td>
<td>Visit the ServiceNow® Store to download and install the application.</td>
</tr>
<tr>
<td>Federal hosted</td>
<td>See the <a href="KB0030260">Federal downloads for the Emergency Response Management and Safe Workplace suite apps</a> article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>Federal on-premise</td>
<td>If you are a federal on-premise customer and you would like to install this application, reach out to your sales representative or open a Now Support or HIWAVE ticket. In the ticket, request to be routed to the SHOT team. See the <a href="KB0030260">Federal downloads for the Emergency Response Management and Safe Workplace suite apps</a> article in the Store Help Center for more information.</td>
</tr>
<tr>
<td>On-premise</td>
<td>See the <a href="KB0030258">Commercial downloads for the Emergency Response Management and Safe Workplace suite apps</a> article in the Store Help Center for more information.</td>
</tr>
</tbody>
</table>

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and
should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Workplace Safety Management

You can install the Workplace Safety Management application if you have the admin role. This application includes optional demo data.

Before you begin

Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

About this task

The following components are installed with installation of the Workplace Safety Management application:

- Roles
- Tables

See Components installed with Workplace Safety Management for more information.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the application using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.

   If your application requires other applications, install them first if they are not already installed.

   Installing your application also automatically installs the dependent applications or plugins if they are not installed already.
5. **Optional:** If demo data is available and you want to install it, click **Load demo data.** Some applications include demo data, which are sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

ℹ️ **Note:** If you don’t load the demo data for a store application during installation, it is not available to load later.

6. Click **Install.**

### Components installed with Workplace Safety Management

Several types of components are installed with installation of the Workplace Safety Management application, including user roles, scheduled jobs, tables, and business rules.

ℹ️ **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

Demo data is available for this feature.

### Roles installed with Workplace Safety Management

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workplace admin [sn_wsd_core.admin] | • Sets up data about the workplace  
• Has complete access to the application | • sn_wsd_core.workplace_manager |
| Workplace manager [sn_wsd_core.workplace_manager] | • Reserves spaces at the workplace  
• Links employees and shifts to spaces  
• Manages preventive maintenance tasks | • sn_wsd_core.workplace_exposure_analyst  
• schedule_admin  
• template_editor_global |
<p>| Workplace exposure analyst [sn_wsd_core.workplace_exposure_analyst] | • Identifies potentially exposed employees in the ServiceNow® Emergency Exposure Management application using workspace reservations. | None |</p>
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workplace shift owner [sn_wsd_core.workplace_shift_owner] | • Has edit access to the shifts that they own.  
• Has edit access to details such as shift schedules, associated users, and spaces of owned shifts.  
• Has read-only access to workplace tasks of owned shifts.  
• Can view workspace requests and reservations for owned shifts. | None |
| Workplace user [sn_wsd_core.workplace_user] | • Requests area or workspace reservations from the Workplace Service Portal or the Now® Mobile app.  
• Schedules arrival to workplace locations using the Workplace Service Portal or the Now® Mobile app. | None |

**Note:** From Workplace Safety Management v1.3.2 onwards, this role is required for employees to request reservations from Workplace Service Portal.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workplace core writer [sn_wsd_core.task_writer] | • Create, read, update, and delete Workplace Tasks.  
• Read Task templates. | sn_wsd_core.task_reader |
| Workplace core reader [sn_wsd_core.task_reader] | Has permission to read all workplace tasks. | None |
| Workplace knowledge base writer [sn_wsd_core.kb_writer] | • Create, view, publish, and update knowledge base articles.  
• Retire and republish knowledge base articles. | None |

### Scheduled jobs installed with Workplace Safety Management

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find upcoming reservation periodically</td>
<td>Finds upcoming workspace reservations between 4–8 hours from the time when this job is executed and sends email notifications to those employees with reservations. By default, this job is set to run every 4 hours.</td>
</tr>
</tbody>
</table>
| Reservation check-in & check-out | Performs the following actions.  
• Notifies employees via email to check in a reservation.  
• Notifies employees via email to check out a reservation.  
• Auto cancels a reservation if it is not checked in within 30 minutes after the employee is notified.  
• Auto checks out a reservation if it is not checked out an hour after the reservation end time. |

### Tables installed with Workplace Safety Management

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Stores the list of areas on office floors.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>[sn_wsd_core_area]</td>
<td>Store the list of scheduled arrival entries of the employees.</td>
</tr>
<tr>
<td>Arrival Entry</td>
<td>[sn_wsd_core_arrival_entry]</td>
</tr>
<tr>
<td>Arrival Schedule</td>
<td>[sn_wsd_core_arrival_schedule]</td>
</tr>
<tr>
<td>Building</td>
<td>[sn_wsd_core_building]</td>
</tr>
<tr>
<td>Campus</td>
<td>[sn_wsd_core_campus]</td>
</tr>
<tr>
<td>Floor</td>
<td>[sn_wsd_core_floor]</td>
</tr>
<tr>
<td>Html Signing Template</td>
<td>[sn_wsd_core_html_signing_template]</td>
</tr>
<tr>
<td>Location Shift</td>
<td>[sn_wsd_core_m2m_location_shift]</td>
</tr>
<tr>
<td>Planned Task Definition</td>
<td>[sn_wsd_core_planned_task_def]</td>
</tr>
<tr>
<td>Region</td>
<td>[sn_wsd_core_region]</td>
</tr>
<tr>
<td>Reservation</td>
<td>[sn_wsd_core_reservation]</td>
</tr>
<tr>
<td>Shift</td>
<td>[sn_wsd_core_shift]</td>
</tr>
<tr>
<td>Site</td>
<td>[sn_wsd_core_site]</td>
</tr>
<tr>
<td>Space</td>
<td>[sn_wsd_core_space]</td>
</tr>
<tr>
<td>Space Type</td>
<td>[sn_wsd_core_space_type]</td>
</tr>
<tr>
<td>Space Staging</td>
<td>[sn_wsd_core_space_staging]</td>
</tr>
<tr>
<td>User Shift</td>
<td>[sn_wsd_core_m2m_user_shift]</td>
</tr>
<tr>
<td>User Workplace Profile</td>
<td>[sn_wsd_core_workplace_profile]</td>
</tr>
</tbody>
</table>

For existing users who are upgrading from the first version of the app, ensure that you have the **User** field as the display value. For more information, see the [Select a field as the table display value](#) guide.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace Client Role Rule</td>
<td>Stores the workplace client role assignment rules created for employees.</td>
</tr>
<tr>
<td>[sn_wsd_core_client_role_rule]</td>
<td></td>
</tr>
<tr>
<td>Workplace Location</td>
<td>Parent table for all workspace entity tables such as Regions, Sites, Campuses, Buildings, Floors, Areas, and Spaces.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_location]</td>
<td></td>
</tr>
<tr>
<td>Workplace Request</td>
<td>Stores the workplace reservation requests created by employees.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_request]</td>
<td></td>
</tr>
<tr>
<td>Workplace Task</td>
<td>Stores all the workplace tasks created for shifts.</td>
</tr>
<tr>
<td>[sn_wsd_core_workplace_task]</td>
<td>If you are upgrading from version 1.1.1 or earlier of the app, ensure that the Default Value field is empty for the workplace_task_type column of this table. For more information on how to modify the default display value of a table column, see Specify a default field value.</td>
</tr>
<tr>
<td>Workplace rooms</td>
<td>Extends the Space [sn_wsd_core_space] table.</td>
</tr>
<tr>
<td>[sn_wsd_core_room]</td>
<td>It holds the reservable items of a room that are available to reserve.</td>
</tr>
</tbody>
</table>

**Properties installed with Workplace Safety Management**

Customize the properties available with the Workplace Safety Management.

These properties are available for Workplace Safety Management.

⚠️ **Note:** All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.

### Properties for Workplace Safety Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_core.AUTO_ASSIGN_LOCATION</td>
<td>Enables auto-assignment of workspaces when employees make workspace reservation requests.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
</tbody>
</table>
### Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> This property is applicable only to the Workplace Safety Management application related record producers. Once this feature is enabled, the fields related to workplace locations such as <strong>Area</strong>, <strong>Space preference</strong>, and <strong>Space</strong> do not appear in any of the Workplace Reservation form of the <strong>Site safety</strong> catalog in the Workplace Service Portal. Enable this feature only if all employees have a designated workspace in their user profiles in the User Workplace Profile [sn_wsd_core_workplace_profile] table. For more information, see Mapping employees to their designated workspaces.</td>
<td></td>
</tr>
</tbody>
</table>

| sn_wsd_core.CANCEL_RES_BUILDING | Determines whether the reservations made for spaces should be canceled based on the value of the **is reservable** field.  
- **Type:** true | false  
- **Default value:** false  
If this property is set to true, then the application cancels all the workspace reservations that are made for the areas and spaces of those buildings or floors for which the value of the **is reservable** field is set to false. |

| sn_wsd_core.CLEANING_TASK_MAX_DURATION | Determines the duration (in days) by when you want the pre-cleaning and post-cleaning tasks to be executed.  
- **Type:** Integer  
- **Default value:** 7  
| sn_wsd_core.enable_wpuser_criteria_for_rp | Enables the user criteria of the workplace_user role to access record producers that are used by employees when they submit requests with the ServiceNow® Workplace Service Portal.  
This property is available only for new users installing v1.2.2 of the application. Users who install v1.3.2 (or later) or who upgrade from v1.1.4 (or

© 2022 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>earlier</strong> will not have this property in their ServiceNow instances.**</td>
<td><strong>earlier</strong> will not have this property in their ServiceNow instances.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: true</td>
<td></td>
</tr>
<tr>
<td>sn_wsd_core.floor_plan.portal.show_non_reservables</td>
<td>Determines whether non-reservable workspaces appear in grey on the floor plan in the Workplace Service Portal.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td></td>
</tr>
</tbody>
</table>

Important note: Changing this value to true can negatively affect performance.

<table>
<thead>
<tr>
<th>sn_wsd_core.floor_plan.portal.show_reservation_details</th>
<th>Determines whether reservation details appear when users point to booked spaces on the floor plan in Workplace Service Portal.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>sn_wsd_core.REQUEST_MAX_DURATION</th>
<th>Determines the maximum number of days that an employee can request a space reservation for at one time. This property is applicable when an employee requests a space reservation for multiple days.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: Integer</td>
<td>7</td>
</tr>
<tr>
<td>• Default value: false</td>
<td></td>
</tr>
<tr>
<td>sn_wsd_core.show_book_uber</td>
<td>Determines the visibility of the Book Uber button on the Now® Mobile app. If this property is set to true, then employees can select Book Uber from their confirmed reservations on their mobile devices. Users are redirected to the Uber mobile app.</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>sn_wsd_core.wsd_inbound_email</th>
<th>Checks for emails that are received for the ServiceNow® Workplace Service Delivery and Workplace Case Management applications. This property has been renamed from the sn_wsd_case.wsd_inbound_email property in Workplace Case Management version 1.0.1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_wsd_core.floor_transform_map</td>
<td>Enables you to configure customized transform maps.</td>
</tr>
<tr>
<td>sn_wsd_core.ENABLE_RSV_CHECK_IN</td>
<td>Enables reservation check-in and check-out via email. If this property is set to true, then employees can check in and check out a reservation.</td>
</tr>
<tr>
<td>sn_wsd_core.dfx.rebuild_cache.max_floors</td>
<td>Enables you to specify the maximum number of floors to build for an entity cache at any time.</td>
</tr>
<tr>
<td>sn_wsd_core.CLEANING_TASK_MAX_DURATION</td>
<td>Enables you to configure the maximum duration until when the cleaning tasks must be performed.</td>
</tr>
<tr>
<td>sn_wsd_core.CANCEL_RES_LOCATION</td>
<td>Enables you to cancel all future reservations made on a location level. Set the Is reservable field to false for the location.</td>
</tr>
<tr>
<td>sn_wsd_core.ALLOW_USER_SHIFT_FILTERING</td>
<td>Enables a user to create shift-based reservations only if the user is part of that shift.</td>
</tr>
</tbody>
</table>
Properties for Workplace Safety Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_core.ALLOW_AVAILABILITY_FILTERING</td>
<td>Displays only the available buildings and floors in the reservation record producers.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td>Note: If the property is set to true, then the selected workplace locations take a longer time to load.</td>
</tr>
<tr>
<td>sn_wsd_core.MULTI_DAY_AVAILABILITY</td>
<td>Displays only the available areas and spaces in multi-day reservation record producers.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td>Note: If the property is set to true, then the selected workplace locations take a longer time to load.</td>
</tr>
<tr>
<td>ARRIVAL_REQUEST_MAX_FUTURE_DAYS</td>
<td>Enables you to specify the maximum number of days in the future until when employees can schedule their arrival.</td>
</tr>
<tr>
<td>• Type: Integer</td>
<td>• Default value: 7</td>
</tr>
</tbody>
</table>

Providing your workplace data

In the Workplace Safety Management application, provide data related to your workplace locations so you can efficiently assign shifts to employees and designate workspaces for these shifts.

Workspace Record

The information available for each workspace record is:

- Region
- Site
- Campus
- Building
- Floor
- Area
- Space
Each designation should use a unique identifier. For example, if you are indicating the fourth floor in building 7, you would name the floor “7-4” rather than just “4.”

**Entering data for several work sites**

If you have a large organization, you might want to consider using a spreadsheet to contain the more global record information such as regions, buildings, and sites so you can avoid having to manually input repeated information for each workspace record. You can either export the information you’ve already entered into the application into a spreadsheet or use that information in an existing workspace spreadsheet. You would then import the spreadsheet that contains the full workspace data into the application in bulk form.

- If you have an existing spreadsheet, you would first manually convert the column headers and data of the global information to match the ServiceNow record names and identifier numbers. You would then do a bulk import of that data into the Workplace Safety Management application so you can assign workspaces.

  For example, say your organization’s spreadsheet uses the name “Location” for Sites or “Bldg 1” for every building 1 on every site. You would have to change the spreadsheet column header “Location” to “Sites” and change each “Bldg 1” to the unique identifier from the Workplace Safety Management application records.

- If you don’t have an existing spreadsheet, you would enter the repeated global information that you don’t want to have to input manually for each space. The data for each field should have a unique identifier. You would then export the information from the application into a spreadsheet where you would have to input only the space information manually.

**Floor plans**

The Now Platform supports Drawing eXchange Format (.dxf) files for floor plans. You can select the layers you need for end-user floorplans and configure the attributes (tags) you want assigned to fields. For information about how to export an AutoCAD .dwg file to a Drawing eXchange Format (.dxf) file, see the documentation for your version of AutoCAD.

Prior to uploading a .dxf file, work with your AutoCAD designers to ensure the following:

- The file uses block references and not single-line or multi-line text for space labels.
- The blocks attributes have human-understandable tags.
- The block references have attribute values appropriately set.

⚠️ Note: Using blocks is highly recommended. Do not use text objects.

Uploading a floor plan creates a floor record. All the workspaces of the floor are automatically added to the Spaces related list of the floor record.

**Create records for your workplace data**

Create individual records of your workspaces, floors, office buildings, and workplace locations within the Workplace Safety Management application. Either insert new data or add records to the existing workplace data.

**Before you begin**

Ensure that you have the following details:

- Workplace data for your organization.
- Data of workspaces that can be marked as available.
**Important:** In the Workplace Service Delivery Suite, from Workplace Safety Management version 2.5.3, the **Space type (space_type)** choice field is depreciated. After the upgrade, Space types are configured in the **Space Type Configuration**. The **Space type (space_type)** field is migrated as **Space type (location_type)** field in the Space table [sn_wsd_core_space]. Customers having customization on the depreciated **Space type (space_type)** field are advised to manually migrate their flow to use the new **Space type (location_type)** field. A new fix script, **Populate Location Type from Space Type**, is introduced to execute the schedule job, **Populate location_type from space_type**, on the Space table [sn_wsd_core_space] to migrate the depreciated **Space type (space_type)** field value to the new **Space type (location_type)** field.

Role required: sn_wsd_core.admin

**About this task**
If you have a small number of workspaces, you can enter information individually for each workspace down to the Spaces level.

If you have many work sites, you might want to do the following:

1. Create a skeleton of repeated global information.
2. Add the individual spaces information in a spreadsheet.
3. Import the spreadsheet into the application.
   For more information on importing, see Configuring spreadsheets to import workplace data.

If you have floor plans, you can create records of data until the Buildings level. Uploading the floor plans loads the data of floors and of the spaces associated with these floors.

**Procedure**

1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select the applicable module.
   Create the records in the following order:
   • Regions
   • Sites
   • Campuses
   • Buildings
   • Floors
   • Areas
   • Spaces
   For example, if you want to locations of your offices, select **Sites**.
3. On the form, fill in the fields.

**Note:**
• The visibility of some of the following fields depends on the module that you selected.
• You can leave a field that does not apply to your organization empty.

The fields on the form differ based on what module you selected. For example, the following form is for Building.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the workplace. Ensure that you enter a unique name. For example, if the <strong>Building</strong> field is set to <strong>1C</strong>, and if the <strong>Space</strong> field is set to <strong>WST 1C 1601</strong>, then an appropriate value for the <strong>Name</strong> field can be <strong>1C-16</strong>.</td>
</tr>
<tr>
<td>Region</td>
<td>Region where the office is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the office building for this workspace.</td>
</tr>
<tr>
<td>Floor</td>
<td>Name or number of the floor where this workspace is present.</td>
</tr>
<tr>
<td>Area</td>
<td>Name of the area on the office floor.</td>
</tr>
<tr>
<td>Space type</td>
<td>Type of the office space. To configure a new space type, see Add a space type configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate that this space is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate that the spaces for this workplace entity are available for reservation. For example, if you do not mark a Building as reservable, then none the floors, areas, and spaces of this building would be available for reservation.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Latitude of a campus or a building. The latitude is displayed in the Workplace Service Portal Location directory map.</td>
</tr>
<tr>
<td>Longitude</td>
<td>Longitude of a campus or a building. The longitude is displayed in the Workplace Service Portal Location directory map.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
What to do next

- If you have floor plans for your workplace, you can upload them to create and display floor and workspace data. For more information, see Upload a workplace floor plan.
- If you are using a spreadsheet to enter and import bulk data for workspaces, see Configuring spreadsheets to import workspace data.
- If you have added all of your workplace data, you can define employee shifts. For more information, see Define shifts for your workplace.

Upload a workplace floor plan

Upload Drawing eXchange Format (.dxf) files of floor plans that you can configure and use to reserve space for your employees.

Before you begin

Role required: sn_wsd_core.workplace_manager

To avoid issues while rendering your floor plan, verify that the dxf.json attachment size is 5 MB or smaller. To view the size, download the dxf.json file and view the file properties. If the file size is larger than 5 MB, you can:

- Work with your AutoCAD designers to ensure that spaces are represented as blocks (not single or multi-line text).
- Ensure that the block reference attributes are appropriately set and try to import the dxf.json file again.
- Set the com.glide.attachment.max_get_size property to a size that is greater or equal to the dxf.json file size. For more information, see Administering attachments.

Procedure

1. Navigate to Workplace Safety Management > Administration > Upload Floor Plan.
2. On the form, fill in the fields.

Manage Workplace Floor form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A unique number automatically generated by the application that identifies the floor plan.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the floor plan.</td>
</tr>
<tr>
<td>Note:</td>
<td>Be specific and have a consistent naming convention when naming your floor plans.</td>
</tr>
<tr>
<td>Region</td>
<td>Geographic location of the building the floor plan represents. Click the Lookup using list icon to view a list of regions you can select.</td>
</tr>
<tr>
<td>Site</td>
<td>The location of the office or campus within a region. Click the Lookup using list icon to view a list of sites you can select.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus if you have multiple buildings at a site.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the specific building if you have multiple buildings at a campus.</td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating whether this plan is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option indicating whether the space manager can reserve this plan for employee use.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>The group that manages the space reservation for the floor plan.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon to view a list of groups you can select.</td>
</tr>
<tr>
<td>Managed by</td>
<td>The workplace manager of the group that manages the space reservation for the floor plan.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon to view a list of group managers you can select.</td>
</tr>
</tbody>
</table>

3. Select the attachment icon and upload your Drawing eXchange Format (.dxf) file. After you attach your .dxf file and import the floor plan, the .dxf file converts to a dxf.json file in your attachments. Don't remove any of these files or your floor plan does not appear. Also, the dxf.json file size must be 5 MB or smaller. Try selecting fewer layers from your .dxf file during the import process.

4. Click Next.

5. In the Select layers column on the right, select the layers that you want to appear the plan. For example, you might not want electrical rooms, kitchens, storage closets, or other elements to appear on the floor plan when it renders.

6. Click Render.
   The floor plan appears under the Preview plan tab. Use your cursor to zoom in and out of the floor plan.

7. Click Next.

8. On the form, fill in the fields.

**Assign tags to fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD tag</td>
<td>The tag you want to map to your space fields. Tags identify spaces on the floor plan and come from the uploaded .dxf file. The tags that appear are the ones you selected in the Select layers column.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** If you do not see any AutoCAD tags, you can use AutoCAD software to change text or text objects into block references.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Field</td>
<td>The field in the Space [sn_wsd_core_space] table with which you want to associate the tag. For example, you could associate an attribute named ROOM_NAME with the Name field and give it a higher order so it is the second part of the Name. The Space Field represents a specific location on the floor plan that you can assign to an employee.</td>
</tr>
<tr>
<td>Order</td>
<td>Determines the order of processing for your AutoCAD tag to Space Field mapping. Note: Lower numbers process first.</td>
</tr>
</tbody>
</table>

9. Click **Submit**.

**Results**
A new floor record is created with the floor plan attached to it. The Spaces related list is populated with all the workspaces of this floor.

**Update a workplace floor plan**
Update a workplace floor plan by uploading a new plan.

**Before you begin**
Role required: sn_wsd_core.workplace_manager

**Procedure**
1. Navigate to **Workplace Safety Management > Space Administration > Floors**.
2. Click the floor you want to update.
3. Click the **Update floor plan** related link.
4. Click **Manage Attachments**, delete the current floor plan file, and attach the new floor plan file.
   You can have only one .dxf file uploaded at a time.
5. Click **Next**.
6. In the Select layers column, select the layers that you want to appear on the floor plan.
   For example, you might not want electrical rooms, kitchens, storage closets, or other elements to appear on the floor plan when it renders.
7. Click **Render**.
   The floor plan appears under the **Preview plan** tab. Use your mouse to zoom in and out.
8. Click **Next**.

### Assign tags to fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD tag</td>
<td>Tags from the uploaded .dxf file identify spaces on the floor plan.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The tags that appear are those that you selected in the Select layers column. <strong>Note:</strong> If you do not see any AutoCAD tags, you can use AutoCAD software to change text or text objects into block references.</td>
<td></td>
</tr>
<tr>
<td>Space Field</td>
<td>The field in the Space [sn_wsd_core_space] table with which you want to associate the tag. For example, you could associate an attribute named ROOM_NAME with the Name field and give it a higher order so it becomes the second part of the name.</td>
</tr>
<tr>
<td>Order</td>
<td>Determines the order of processing for your AutoCAD tag to Space Field mapping. <strong>Note:</strong> Lower numbers process first.</td>
</tr>
</tbody>
</table>

10. Click **Preview Changes** and in the **Preview changes** tab, review the changes you are going to make before you commit them.

11. Click **Submit**.

**Results**

The following changes occur:

- Map values are filled in.
- Existing spaces that no longer match are deleted.
- If old spaces have been renamed, the new names replace the old ones.
- Any reservations are deleted.

A original floor record is updated with the floor plan attached to it. The Spaces related list is also updated. To view your changes, go to **Floor Plan Update Logs**. For more information, see **View your workplace floor plan update logs**.

**View your workplace floor plan update logs**

After updating your workplace floor plan, you can view all changes made.

**Before you begin**

Role required: sn_wsd_core.workplace_manager

**Procedure**

1. Navigate to **Workplace Safety Management > Administration > Floor Plan Update Logs**. Logs appear for each floor plan updated with date and timestamps.

2. Click the Created date link to view the log record.

3. Click the Floor link to view the floor record.

**Configuring spreadsheets to import workplace data**

Doing a bulk import of the data of all your workplaces into the Workplace Safety Management application through a spreadsheet enables you to avoid manually entering redundant data for each workplace, which saves time and effort.
By using a spreadsheet that contains the global information for your work sites, you can enter only the distinguishing space information instead of having to manually repeat information such as the region, site, building, and floor. You can either create an Excel spreadsheet from the data you’ve entered into the Workplace Safety Management application or modify an existing workplaces spreadsheet.

**Configure an existing workplaces spreadsheet**

Customize the information in your organization’s existing workspace spreadsheet to avoid having to manually enter repeated information for each workspace. You can then import the data into your ServiceNow instance.

**Before you begin**
Role required: sn_wsd_core.admin

**About this task**
If you have a spreadsheet containing your organization’s workspaces data, you need to customize it to match the record information in your ServiceNow instance.

This example describes how to modify the floor information for your workspace data. Repeat these instructions to replace the fields for your building, campus, site, and region, as appropriate.

**Procedure**

1. Modify the data in the spreadsheet to match the record information in your ServiceNow instance.

   a. Navigate to Workplace Safety Management > Space Administration > Floors.

   b. Search for the desired floor record and open it.

   c. Copy the value of the Number field.

   d. Paste the value in place of “Floor 1” in the Excel spreadsheet.

   The example uses the following sample entry for workspaces that belong to Floor 1 of Building 1 at Florida Campus 2, Florida, USA:

   - FLOR0001694 represents Floor 1
   - BLDG0001028 represents Building 1
   - CMP500001013 represents Florida Campus 2
   - SITE0001007 represents Florida
   - RG1N0001002 represents USA

   **Note:** You can exclude the Area column as it is not mandatory. Enter a dummy value in the column instead of leaving it empty.
2. In your workspaces spreadsheet, add individual workspace information in the **Name** column.

3. Save your spreadsheet.

**What to do next**
Import your workspaces data from an Excel spreadsheet.

**Create a workplace data spreadsheet**
Create a Microsoft Excel spreadsheet from the data you entered into the Workplace Safety Management so you can avoid having to manually enter global information such as the site or building names for each workspace. You can then import the data into your ServiceNow instance.

**Before you begin**
Role required: sn_wsd_core.admin

**About this task**
If you have a large number of work sites, consider creating a spreadsheet that you can then import into your ServiceNow instance to avoid having to manually enter global information such as the site or building names for each workspace.

⚠️ **Note:** If you already have an existing workspaces spreadsheet for your organization, follow the instructions in Configure an existing workspaces spreadsheet to customize it for exporting the data.

**Procedure**
1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select the module for the smallest unit for which you want to repeat the data.
   For example, if you have created global information records of regions, sites, buildings, and floors, you would select **Floors**.
3. **Optional:** Customize the columns to be displayed.
   For example, you can choose to hide the **Campus** column if your organization does not have campuses by entering a dummy value instead of leaving it empty.
4. Export the data by right-clicking on any column, selecting **Export**, and clicking **Excel (.xlsx)**. Data is exported from the application so that you can download it as an Excel file.
5. Click **Download**.
6. In your workspaces spreadsheet, add individual workspace information in the **Name** column.
7. Save your spreadsheet.

**What to do next**
Import your workspaces data from an Excel spreadsheet

**Import your workspaces data from an Excel spreadsheet**
Import your workspaces data from an Excel spreadsheet into the Workplace Safety Management application.

**About this task**
Complete Configuring spreadsheets to import workplace data.
Role required: sn_wsd_core.admin
Procedure
1. Navigate to System Import Sets > Load Data.
2. Select Existing table.
3. In the Import set table field, select Space Staging [sn_wsd_core_space_staging].
4. In the Source of the import field, select File.
5. Click Choose File and select the source Excel spreadsheet.
6. Optional: Specify the worksheet number in the Sheet number field and header row number in the Header row field.
7. Click Submit.
The imported data is now available in the new Import Set table.
8. Click Run Transform.

Important: Ensure that the Import set field shows sn_wsd_core_space_staging and the selected map is Space Transform map - sn_wsd_core_space.

9. Click Transform.
10. Optional: Verify that the data records were imported into the Spaces table by navigating to Workplace Safety Management > Space Administration > Spaces

What to do next
Define shifts for your workplace

Related information
Run an import
Create a transform map

Add a space type configuration
Configure the different types of spaces available in your workplace. You can add spaces based on different space types. The space types enable your employee to identify the different types of spaces that are available on a floor in a Mappedin floor map

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

Procedure
1. Navigate to Workplace Safety Management > Administration > Space type configuration.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the space type.</td>
</tr>
<tr>
<td>Code</td>
<td>Code for the space type. The code can also be a name.</td>
</tr>
<tr>
<td>Table</td>
<td>Table of the space type. The field is automatically set to Space</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_wsd_core_space]</td>
<td>If the space type is a room, select Room [sn_wsd_core_room].</td>
</tr>
<tr>
<td>Application</td>
<td>Application of the space type. This field is automatically set. Make sure that Workplace Safety Management is selected.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the space type.</td>
</tr>
<tr>
<td>Available for</td>
<td>Option to specify the type of users for whom the space type is available.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Results**
The space type is configured. You can select this space type while creating a space or a type mapping.

### Block a workplace location

Block a workplace location for a specific period. The blocked workplace location is unavailable during the specified period for any type of reservation on the Workplace Reservation Management Reservation portal.

**Before you begin**

**Note:** The blocked location will be unavailable only on the Workplace Reservation Management Reservation portal for reservation.

Role required: sn_wsd_core.admin

**About this task**

You can block a workplace location, such as a region, a site, campus, a building, a floor, an area, a room, or a space. When you block a location, the location is unavailable for any type of reservation on the Workplace Reservation Management Reservation portal. Because of the block action, any existing reservations made on the workplace location are automatically canceled.

You can also block a location directly. Open the location and click the Block location option on the form.

**Procedure**

1. Navigate to Workplace Safety Management > Administration > Block location.
2. Click New.
3. On the form, fill in the fields.

### Block Location form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number of the location. This field is automatically set.</td>
</tr>
<tr>
<td>Location</td>
<td>Location that you want to block.</td>
</tr>
<tr>
<td>Opened by</td>
<td>User who is blocking the location.</td>
</tr>
<tr>
<td>Reason</td>
<td>Reason for blocking the location. Select from a list of available options.</td>
</tr>
</tbody>
</table>
**Field** | **Description**  
--- | ---  
Comment | Comment that explains the reason for blocking the location or any important information.  
Active | Option to activate the block action.  
Progress state | Current progress state of the block action.  
Start time | Start time of the block.  
End time | End time of the block.

4. **Click Submit.**

**Results**
The workplace location is blocked for the specified period. You cannot make any reservations for the location on the Workplace Reservation Management Reservation portal during this period. All existing reservations that are made on the workplace location are canceled.

**Workplace Service Portal**
The Workplace Service Portal is a self-service portal for employees, delivering workplace services from a central location. Employees can make reservations, view knowledge base articles, submit and review requests, and get help using virtual agent chat support.

From the Workplace Service Portal, you can do the following:

- Open the Reservation portal and make reservations for meeting rooms, desks, or any other reservable workplace items.
- You can also make a reservation for a time slot directly using the Reservation widget on the home page.
- Register visitors in advance and customize their visit. You can register a guest or an off-site colleague for either a short duration or a complete day.
- View and search through top-rated knowledge base articles to find information. As you type, the search field displays suggestions based on keywords.
- View your requests and approvals (if you are an approver).
• View the location directory of your organization. Search for a co-worker, a space or any workplace location on the world map.
• Submit requests for general inquiry, registering visitors, shift-based reservations, and other requests.
• Chat with a virtual agent to submit requests and view submitted requests.
• Raise a general help request by selecting from a list of service catalog items.
• Raise a move request to move from one location to another.
• Request a new furniture.

Mapping employees to their designated workspaces

Map your employees to their designated workplace locations in Workplace Safety Management to automatically fill in that detail in reservation requests and to take advantage of auto-assignment of workspaces if that feature has been enabled.

For employees who had a designated workspace before they started working remotely, create a mapping between the user profile and the designated workspace details. This mapping populates the workspace details on reservation request forms so employees don’t have to provide these details manually.

If your system administrator has enabled the auto-assign feature, mapping workspaces for all employees also means that designated workspaces are automatically assigned when employees make a reservation request.

The data from the User Workplace Profile [sn_wsd_core_workplace_profile] table is used to automatically assign the designated workspace to the employee.

• If the user’s designated space is available, this space is reserved for the employee.
• If the designated space is unavailable for the requested date or time, the application searches for and reserves an available space in the employee’s workplace in the order of Area > Floor > Building > Campus > Site > Region.

For example, if no spaces are available in the designated area of the employee, the application finds and reserves an available space from the floor of this area.

If you have installed Workplace Space Management application, as a Workplace manager, you can also view the reason for an anomaly in a workplace profile if there are any. A schedule job will also enable you to view a detailed report of all the anomalies logged in the application via an email. Navigate to Workplace Safety Management > Administration > Workplace profiles and switch to the Space Management view, a Reason for anomaly column appears. An anomaly can happen due to a mismatch in the cost center, department, or an assignment type. The following table explains each anomaly in detail:

<table>
<thead>
<tr>
<th>Reason for anomaly</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No anomaly</td>
<td>There is no anomaly.</td>
</tr>
<tr>
<td>Assignment type mismatch</td>
<td>The Assignment type of both the user profile and the Workplace location to which the user is assigned does not match.</td>
</tr>
<tr>
<td>Cost center / Department mismatch</td>
<td>The Cost center/ Department of both the user profile and the Workplace location to which the user is assigned does not match.</td>
</tr>
<tr>
<td>Reason for anomaly</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Assignment type and CC/Dept mismatch</td>
<td>The <strong>Assignment type</strong> and <strong>Cost center/Department</strong> of both the user profile and the <strong>Workplace location</strong> to which the user is assigned does not match.</td>
</tr>
</tbody>
</table>

**Note:** If you have installed the Workplace Space Management application, only the spaces of Space type **Permanent** or **None**, and the open spaces from the user's Cost Center or Department are listed.

**Map designated workspaces to user profiles**

Map existing designated workspaces to employee user profiles in Workplace Safety Management. This mapping is used to automatically allocate workspaces for employees so they don’t have to select a workspace manually when requesting a reservation.

**Before you begin**

- Ensure that your workplace administrator has completed setting up your workplace data. For more information, see Providing your workplace data.
- Ensure that you have the designated workplace information for all the employees.
- You can also Navigate to the User Workplace Profiles `[sn_wsd_core_workplace_profile]` table by entering `sn_wsd_core_workplace_profile.list` in the navigation filter.

Role required: `sn_wsd_core.admin` or `sn_wsd_core.workplace_manager`

**About this task**

Create a mapping for all employees and their designated workplaces. You can also perform an easy import of your employee workplace data. For more information, see Easy import.

**Procedure**

1. Navigate to **Workplace Safety Management > Administration > Workplace profiles**.
2. Click **New**.
3. On the form, fill in the fields.

  **User Workplace Profile form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Employee for whom you want to create a workspace mapping.</td>
</tr>
<tr>
<td>Workplace location</td>
<td>Designated workplace of the employee.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating that this workspace mapping is active.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
5. Repeat the procedure for all the employees of the workplace that you manage.

**Results**

The User Workplace Profiles `[sn_wsd_core_workplace_profile]` table is populated with all the new profiles.
Assign the workplace user role to employees

Set rules in Workplace Safety Management to assign the workplace user role to employees and apply conditions accordingly.

Before you begin
Ensure that the user profiles of all your employees have required details. You can review the employee user profiles by navigating to User Administration > Users.

Role required: admin or sn_wsd_core.admin

Procedure
1. Navigate to Workplace Safety Management > Administration.
2. Click Client Role Assignment Rules.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for this assignment rule.</td>
</tr>
<tr>
<td>Role</td>
<td>This value is auto-generated with the workplace user role (sn_wsd_core.workplace_user).</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating whether this assignment rule is active.</td>
</tr>
<tr>
<td>Condition</td>
<td>Option to add filter conditions that a user profile must match. To add a condition, select Add filter condition. To add a OR clause, select Add &quot;OR&quot; clause.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which the conditions must be built. The field is automatically selected as sys_user.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The workplace user roles are assigned. If a record is created or updated on this table, a role assignment process is triggered in the background.

Configuring shifts for your workplace
Configure shifts for your organization in the Workplace Safety Management application so you can efficiently plan and manage your workplace by assigning employees and workspaces to those schedules.

Define shifts for your workplace
Define shifts in Workplace Safety Management with specific schedules so you can designate areas or workplaces and assign employees for each shift.

Before you begin
• Add your workplace data.
• Ensure you have the following information:
- Appropriate shift schedules
- Data of the employees who would operate from the office in this shift
- Data of the workplaces to be made available for this shift

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_manager

**About this task**

Workplace managers can later reserve workplaces for employees according to the shifts assigned to them.

If your organization does not organize work in shifts, you can use the general shift schedule that is available with the application by default.

You can also access the Shift form by navigating to Workplace Safety Management > Shift Management > Create New.

**Procedure**

1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
   
   a. Click Catalog.
   
   b. Click Browse by Categories.
   
   c. In the Workplace Services Catalog, select Site safety.

   **Note:** If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.

3. Click Add a shift.
4. On the form, fill in the fields.

**Shift form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the shift, for example, Morning Shift.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule for the shift. For a general shift schedule, select General shift. For more information about how to create a shift schedule, see Define a schedule.</td>
</tr>
<tr>
<td>Owner</td>
<td>Shift owner who monitors activities during this shift.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| State      | Status of the shift. Choose one of the following values:  
|            | • Draft: Indicates that the shift details are incomplete.  
|            | • Ready: Indicates that the shift is ready for assignments.  
|            | • Cancelled: Indicates that the shift is cancelled.  |
| Start      | Date from which this shift is active. |
| End        | Date until which the shift is active. |
| Region     | Region of the workplace site. |
| Site       | Site location of the office campus. |
| Campus     | Name of the campus in which the office building is present. |
| Building   | Name of the building in which the office floor is located. |
| Floor      | Name or number of the floor where the area is located. |
| Area       | Area that is active for operation and use during this shift. |
| Users      | Employees assigned to this shift. This field appears only on Workplace Service Portal. |
| Locations  | Workplaces available for reservation during this shift. This field appears only on Workplace Service Portal. |

**Note:**

- If this shift is applicable to all office buildings on your campus, you can leave the Building, Floor, and Area fields empty. The shift and its schedule will be automatically applied to all the records of buildings, floors, and areas associated with this campus.
- When an employee requests to make a reservation with shifts, only shifts that are active on the dates that the employee selected are displayed on the reservation form.

5. Click **Submit**.
6. If you accessed the Shift form from Workplace Service Portal, on the verification page, you can define another shift or view all the existing shifts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define another shift</td>
<td>Click Add another shift.</td>
</tr>
<tr>
<td>View all existing shifts</td>
<td>Click View all shifts.</td>
</tr>
</tbody>
</table>
Results
The shift is added to the list of all shifts that you can view by navigating to Workplace Safety Management > Shift Management > All.

What to do next
If you created the shift using Workplace Service Portal, you can directly create workplace reservations. For more information, see Managing workplace reservations for employees. You can configure other information such as employees, workplaces, and maintenance tasks associated with this shift later.

- Assign more employees to a shift. For more information, see Assign employees to a shift.
- Associate more workplaces with a shift. For more information, see Associate areas and spaces with a shift.
- Associate tasks with a shift. For more information, see Managing workplace tasks.

Assign employees to a shift
Assign employees with a shift in Workplace Safety Management so that they operate from the office only in the shifts to which they are assigned. Workplace managers can later reserve workspaces for these employees according to their assigned shifts.

Before you begin
- Define shifts for your workplace.
- Ensure you have the data for the employees who will operate from the office in this shift.

Role required: sn_wsd_core.workplace_manager

Procedure
1. Navigate to Workplace Safety Management > Shift Management > All.
2. Open a shift to which you want to add employees.
3. In the Users related list, click Edit.
4. Add all the employees who should operate from the office in this shift.
5. Click Save.

Results
A pre-configured email with the shift details is sent to all employees assigned to this shift.

What to do next
Associate areas and spaces with a shift.

Associate areas and spaces with a shift
Associate work areas and spaces with a shift in Workplace Safety Management so that they are available only for that shift. Workplace managers can later reserve these workplaces for employees operating in that shift.

Before you begin
- Define shifts for your workplace.
- Ensure you have the data for the workplaces to be made available for this shift.
- Ensure that the glide.ui.list.allow_extended_fields system property is set to true so that the filter criteria is displayed appropriately when you're adding areas or spaces.
Role required: sn_wsd_core.workplace_manager

Procedure
1. Navigate to Workplace Safety Management > Shift Management > All.
2. Open a shift to which you want to add employees.
3. In the Locations related list, click Edit.
4. Add all the areas and spaces to be made available for this shift.
5. Click Save.

What to do next
Create workplace reservations for an employee.

Managing workplace shifts that you own
Review the workplace shifts that you own in Workplace Safety Management and update the shift details if necessary. You can also monitor the reservations and requests made for the workspaces associated with these shifts.

Update details of the shifts that you own
Review and modify the details of the workplace shifts that you own in Workplace Safety Management. You can modify the general shift details, and add or remove employees or workspaces associated with the shift.

Before you begin
Role required: sn_wsd_core.workplace_shift_owner

Procedure
2. Click Owned by Me.
3. Open the shift for which you want to view the details.
4. Optional: Modify the shift details.
   a. Edit the details on the shift form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the shift.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule for the shift. (Optional) For a general shift schedule, select General shift.</td>
</tr>
<tr>
<td>Owner</td>
<td>Shift owner who monitors activities during this shift. (Optional) If you select a different user, you will lose access to this shift.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the shift. Choose one of the following values:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Draft</td>
<td>Indicates that the shift details are incomplete.</td>
</tr>
<tr>
<td>Ready</td>
<td>Indicates that the shift is ready for assignments.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Indicates that the shift is cancelled.</td>
</tr>
<tr>
<td>Region</td>
<td>Region of the workplace site.</td>
</tr>
<tr>
<td>Site</td>
<td>Site location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus in which the office building is present.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the building in which the office floor is located.</td>
</tr>
<tr>
<td>Floor</td>
<td>Name or number of the floor where the area is located.</td>
</tr>
<tr>
<td>Area</td>
<td>Area that is active for operation and use during this shift.</td>
</tr>
</tbody>
</table>

**Note:** If this shift is applicable to all office buildings on your campus, you can leave the **Building**, **Floor**, and **Area** fields empty. The shift and its schedule will be automatically applied to all the records of buildings, floors, and areas associated with this campus.

b. Click **Update**.

5. **Optional:** Modify the list of employees assigned to this shift.
   a. In the Users related list, click **Edit**.
   b. Add or remove users.

6. **Optional:** Modify the list of workspaces associated with this shift.
   a. In the Locations related list, click **Edit**.
   b. Add or remove areas and spaces.

**Review workplace reservations for shifts that you own**

Review the workplace reservations and the reservation requests made for the shifts that you own in Workplace Safety Management. You can identify pending requests and work with your workplace manager to resolve them.

**Before you begin**
Role required: sn_wsd_core.workplace_shift_owner

**Procedure**
1. Navigate to the reservation requests from employees or workplace reservations by the workplace manager.

<table>
<thead>
<tr>
<th>Choice</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation requests made by employees</td>
<td>Navigate to Workplace Safety Management &gt; Workplace Requests &gt; All</td>
</tr>
</tbody>
</table>
2. Review all reservations requested or made for your shift.

3. Optional: Open a reservation record to view its details.

(Optional) If you want to make any changes to the reservation such as assigning another workspace to the employee, or changing the date of the reservation, reach out to the workplace manager to request those changes.

4. Optional: If you are viewing employee requests, note any requests in the Pending state so you can work with your workplace manager to resolve them.

Managing workplace reservations for employees

Reserve available areas or spaces for your employees and review pending reservation requests from employees in Workplace Safety Management so you can ensure physical distancing measures when they return to the workplace. Once you make reservations, employees are notified about the locations to which they have access. The Workplace Service Delivery also offers more advanced workplace reservation options in the Workplace Reservation Management application.

Creating workplace reservations for employees

Reserving workplace areas

As a workplace manager, you can make reservations for employees for areas on the floors of your office buildings. When employees return to the office, they can work from any of the spaces from the reserved area. The number of employee reservations that you can make for an area of your workplace depend on the capacity defined for that area. If the Capacity field of an area is set to 0 or left empty, reservations cannot be made for that area.

For more information on setting the capacity for an area, see Define the capacity of workplace areas.

Creating a single space reservation

Using the shifts that you defined, you can create a space reservation for an employee for a single day or multiple days. For more information, see Create workplace reservations for an employee.

Creating space reservations in bulk

You can generate in one action reservations for multiple employees who are assigned to a shift for a specific date range. For example, you can use this feature to create reservations for employees of a specific department who would all be assigned to the same shift. For more information, see Create workspace reservations for multiple employees.

Child reservation records for employee space reservations

When you reserve a workplace for an employee, the reservation generates child reservation records for every applicable working day of the specified period. The applicable days are determined by the shift schedule that you select for this reservation. The reservation that you initially created acts as the parent reservation record.

If a child reservation conflicts with an existing reservation for any day in the specified period, the child reservation is not created for that day. You can manually create a reservation for a different workplace for that day.
For example, say you created a reservation for the workplace 2CN1612 for Mark Andrews in the afternoon shift from 06-01-2020 to 06-10-2020. Eight child reservation records for Mark Andrews for the workplace 2CN1612 would be created for each working day between 06-01-2020 and 06-10-2020. However, if a reservation for 2CN1612 on 06-08-2020 exists for another employee Jane Doe, the child reservation for Mark Andrews on 06-08-2020 is not created. You can manually create a reservation for Mark Andrews for a different workplace for 06-08-2020.

If you update the details of a parent reservation later, all its child reservations except the ones with dates in the past are updated accordingly.

**Working with space reservation requests from employees**

After an employee requests a workplace for a given date range and the manager approves the request, the application checks the availability of the requested space. If the workplace is unavailable for any or all days of the specified period, the request moves to the Pending state. As a workplace manager, you can review these pending reservation requests and allocate a different workplace to the employee to complete the request. For more information, see Approve employee workplace reservation requests.

**Define the capacity of workplace areas**

Set the capacity for areas of your workplace in Workplace Safety Management to enable reservations for the area. The capacity ensures a limit to the workplace reservations for these areas so you can ensure safety guidelines.

**Before you begin**

- Add your workplace data.
- Ensure you have the details of the maximum capacity for the areas of your workplace.

Role required: sn_wsd_core.workplace_manager

**Procedure**

1. Navigate to **Workplace Safety Management > Space Administration > Areas**.
2. Open an area to which you want to add the capacity.
3. On the Area form, enter a value for the **Capacity** field. For example, if this area can accommodate only 8 people safely according to physical distancing guidelines, set the value to 8.
4. Click **Update**.

**Create workplace reservations for an employee**

Create workplace reservations for an employee in the Workplace Safety Management application using the shifts and shift schedules that you defined.

**Before you begin**

- Define shifts for your workplace.
- Assign employees to a shift.
- Associate areas and spaces with a shift.
- Define the capacity of workplace areas.
- Ensure you have the data that shows the mapping of employees to the workplaces in your workplace.
**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_manager

**About this task**
Reserve a workplace for an employee according to the assigned shift for a single day or multiple days.

You can also access the Reservation form by navigating to Workplace Safety Management > Space Reservations > Create New.

**Procedure**
1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.

   ✪ Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.

3. Click Reserve a space.
4. On the form, fill in the fields.

**Reservation form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Shift for which this reservation is being made.</td>
</tr>
<tr>
<td>Location</td>
<td>Area or space for which this reservation is being made.</td>
</tr>
<tr>
<td>Requested for</td>
<td>Employee for whom this reservation is being made.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date and time from which the reservation is active.</td>
</tr>
<tr>
<td>End date</td>
<td>Date and time until which the reservation remains active.</td>
</tr>
</tbody>
</table>

5. Click Submit.

6. If you accessed the Reservation form from Workplace Service Portal, on the verification page, you can create another reservation or view all the existing reservations.
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create another workplace reservation</td>
<td>Click Reserve another space.</td>
</tr>
<tr>
<td>View existing workplace reservations</td>
<td>Click View all reservations.</td>
</tr>
</tbody>
</table>

**Results**

- If you’ve reserved a space, then child reservation records are generated for every applicable occurrence of the specified period.
- A preconfigured email with the reservation details is sent to the shift owner and the employee for whom you reserved the workplace.
- The reservation is added to the list of all reservations that you can view by navigating to Workplace Safety Management > Space Reservations > All Reservations.

**Create workplace reservations for multiple employees**

Automatically generate workplace reservations in bulk for all employees assigned to a shift for a single day or multiple days.

**Before you begin**

- Define shifts for your workplace.
- Assign employees to a shift.
- Associate areas and spaces with a shift.
- Ensure that the number of locations associated with the shift is greater than the number of employees assigned to the shift.

Role required: sn_wsd_core.workplace_manager

**Procedure**

1. Navigate to Workplace Safety Management > Shift Management > All.
2. Open a shift for which you want to generate the bulk reservations.
3. Click Generate Bulk Reservation.
4. Select a date range from the Start date and End date fields.
   - If you want to create the bulk reservation for a single day, you can set the start and end date to the same day. Otherwise, set a date range.
5. Click OK.

**Results**

Reservations for the employees in this shift are created for the locations associated with the shift for the provided dates. You can view these reservations by navigating to Workplace Safety Management > Space Reservations > All Reservations.

**Review pending workspace reservation requests**

Review pending workplace reservation requests from employees in Workplace Safety Management and assign available workplaces to complete these requests.

**Before you begin**

Role required: sn_wsd_core.workplace_manager
Procedure

2. Open a pending request that you want to address.
3. Open the related reservation record, which is the parent reservation:
   a. Click the information (i) icon next to the Reservation field.
   b. Click Open Record for the desired request.
4. On the reservation form, review the reservation details such as the workplace location being requested, the start and end dates, and the number of reservations confirmed for that period.
   From these details, you can review the number of days, with their dates, that are missing a reservation for the employee for the requested location.
5. If any dates are missing a reservation for the requested location, adjust the pending request to assign a workplace for all the missing desired dates.
   a. Change the workplace location in the parent reservation to a workplace available for all dates, which will also update the location for all applicable future child reservations.
      a. Select a different location from the Workplace location field.
      b. Click Update.
   b. Create a child reservation for a new workplace location for this employee for specific dates that are missing a reservation.
      a. In the Reservations related list, click New.
      b. Select the start and end dates in the Start and End fields.
      c. Select a location from the Workplace location field.
      The list of spaces displays the locations that are available for the requested dates.
      d. Click Submit.
6. After all the days that were missing a reservation are addressed, update the status of the pending workplace task to Closed complete.
7. Optional: Repeat this process for all pending workplace requests that you want to address.

Results

Once the status of workplace request is updated to Closed complete, the reservation information is populated in the Notes field of the workplace request.

Setting and tracking arrivals at the workplace

Workplace managers can set arrival intervals in Workplace Safety Management for different locations at your workplace with defined capacities to facilitate staggered entry of employees into the office. Employees can then choose from the defined arrival slots.

Workplace managers can define arrival times and capacity for different locations such as the entry and exit gates, elevator, gym, and cafeteria of your workplace. Employees can then schedule their arrival at these locations for an available time slot.

For example, say you define arrival times for the cafeteria at 12:00 h, 13:00 h, 14:00 h, and 15:00 h, and set a capacity of 15 for every slot. A maximum of 15 employees can schedule their arrival to the cafeteria for each of these times on any given day.

By setting arrival intervals for your workplace, you can facilitate employee actions such as entry and exit to the office, elevator use, lunch pickup, gym use, and so on, without employees having to wait in long lines or causing large gatherings at any of the locations.
Attention: Starting with Workplace Safety Management version 2.3, time zones are introduced in the application. All the arrival schedules that were created on Workplace Safety Management version 2.2 and earlier are deactivated after the upgrade.

Define arrival schedules at the workplace for employees

Define arrival slot times in Workplace Safety Management for different locations at your workplace and indicate the capacity for each slot. Establishing arrival schedules enables safe staggered entry of employees to these locations.

Before you begin

• Add your workplace data.
• Ensure you have the data for arrival schedules of the locations of your workplace.
• Ensure that your time zone is set to the time zone of the building that is used for the arrival.

Attention: Starting with Workplace Safety Management version 2.3, time zones are introduced in the application. All the arrival schedules that were created on Workplace Safety Management version 2.2 and earlier are deactivated after the upgrade. Both existing customers and new customers must perform the following actions on existing arrival schedules to set them to active:

1. Set the time zone of the building where you are creating or updating the arrival schedule.

   Note: If you are creating or updating the arrival schedule for a floor, area or a space, then select the building where it is located.

   a. Go to Workplace Safety Management > Space Administration.
   b. Select Buildings, Floors, Areas, or Spaces based on where you are scheduling an arrival slot.
   c. Select the building, floor, area, or the space for which you want to set the time zone.
   d. Set the building time zone.
      • If you selected a building, set the time zone in the Time zone field.
      • If you selected a floor, area, or the space, on the form, select the preview icon (i) that is next to the Building field.
         • In dialog box, select Open record.
         • On the Buildings form, set the time zone in the Time zone field.
   e. Click Update.

      Note: All the active arrival schedules that were created on this building and on associated floors, areas, or spaces will be deactivated. Any future arrival requests that are related to this schedule will be canceled.

   f. Click Ok on the warning that appears.

2. Change your session's time zone to the building's time zone.

   Note: Ensure that the sn_wsd_core.workplace_manager role is included in the glide.timezone_changer.roles property. If it is not included, ask your system administrator to include the role so that you can change your time zone.
**a.** Select the settings icon ( ) on your instance header.

**b.** Set the **Time zone** field to the time zone of the building where you are creating or updating the arrival schedule.

Role required: sn_wsd_core.workplace_manager

### About this task

#### Procedure

1. Navigate to **Workplace Safety Management > Workplace Arrival Scheduling**.
2. Click **Create Arrival Schedules**.
3. On the form, fill in the fields.

**Arrival Schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace location</td>
<td>Select a building, floor, area or space where you want to schedule the arrival times.</td>
</tr>
<tr>
<td>Arrival schedule time</td>
<td>Time (in hours, minutes, and seconds) at which employee arrivals can start at this location, for example, 12 30 00.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating whether this schedule time is active. If marked as active, this schedule time will appear every day in the list of available time slots.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Maximum number of employees that can schedule their arrival to this location at this slot time.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Results

An arrival schedule is created for this workplace location for the indicated time and capacity. You can view arrival schedules by navigating to **Workplace Safety Management > Workplace Arrival Scheduling > Arrival Schedules**.

**Schedule your arrival time at a workplace location**

Schedule your arrival at a workplace location by using Workplace Safety Management. Prevent long lines and safely enter the location.

**Before you begin**

To schedule an arrival using your mobile device, you must have the Now® Mobile app.
Important: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the ServiceNow® Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_user

About this task
You can also access the Schedule your arrival form using your mobile device. From the Now Mobile app, navigate to Services > Workplace Safety Management.

Procedure
1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.
      Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Select Schedule your arrival.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry point</td>
<td>Location where you want to schedule your arrival.</td>
</tr>
<tr>
<td>Building time zone</td>
<td>Time zone for the building of the selected entry point.</td>
</tr>
<tr>
<td>Date</td>
<td>Date of your arrival.</td>
</tr>
<tr>
<td>Arrival time</td>
<td>Time of your arrival. The time is displayed in 24-hour format.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Results
The arrival request is created. The web page or your mobile screen is refreshed to show your arrival request details.

What to do next
You can check the details of your arrival schedule anytime.
1. Depending on your platform, do one of the following to view your requests:
   • On the Workplace Service Portal, go to the Requests tab to view your requests and reservations.
   • On the Now Mobile navigation bar, tap For Me and scroll down to the My Request section to view your requests.

2. If you want to cancel your arrival, select the arrival request and click Cancel arrival.

**Update arrival schedules at the workplace**
Define building time zones, change the capacity of an arrival schedule, and set the schedule to active or inactive.

**Before you begin**
• Add your workplace data.
• Ensure that you have the data for the arrival schedules of your workplace locations.
• Ensure that your time zone is set to the time zone of the building that is used for the arrival.

**Attention:** Starting with Workplace Safety Management version 2.3, time zones are introduced in the application. All the arrival schedules that were created on Workplace Safety Management version 2.2 and earlier are deactivated after the upgrade. Both existing customers and new customers must perform the following actions on existing arrival schedules to set them to active:

1. Set the time zone of the building where you are creating or updating the arrival schedule.

   ![Note:](image)
   If you are creating or updating the arrival schedule for a floor, area or a space, then select the building where it is located.

   a. If you are updating the arrival schedule, do the following:
      i. Select the workplace location info icon (i) that is next to the **Workplace location** field.
      ii. In the dialog box, select **Open record**.
      iii. If the value of **Workplace location** is a floor, area or a space, then select the workplace location info icon (i) that is next to the **Building** field.

   b. On the Buildings form, set the time zone in the **Time zone** field.

   c. Click **Update**.

   ![Note:](image)
   All the active arrival schedules that were created on this building and on associated floors, areas, or spaces will be deactivated. Any future arrival requests that are related to this schedule will be canceled.

   d. Click **Ok** on the warning that appears.

2. Change your session’s time zone to the building’s time zone.

   ![Note:](image)
   Ensure that the sn_wsd_core.workplace_manager role is included in the glide.timezone_changer.roles property. If it is not included, ask your system administrator to include the role so that you can change your time zone.

   a. Select the settings icon (i) on your instance header.

   b. Set the **Time zone** field to the time zone of the building where you are creating or updating the arrival schedule.

**Role required:** sn_wsd_core.workplace_manager

**Procedure**

1. Navigate to **Workplace Safety Management > Workplace Arrival Scheduling**.

2. Select **Arrival Schedules**.

3. Select the arrival schedule that you want to update.

   ![Note:](image)
   You cannot update the **Workplace location** or **Arrival schedule time** fields of an arrival schedule if there are any arrival requests associated with it. You must create a new arrival schedule for the changed **Workplace location** or **Arrival schedule time** fields.

4. To activate the schedule, select the **Active** option.
5. To change the capacity, edit the **Capacity** field.

6. Click **Update**.

**Results**
The arrival schedule is updated.

**Making workplace reservations**

Make workplace reservations in Workplace Safety Management when you are ready to return to the office. You can reserve a workplace for a day or less directly or request a workplace for a specified period. Once a reservation request is approved and confirmed, you are notified about the reservation details. The Workplace Service Delivery also offers more advanced workplace reservation options in the Workplace Reservation Management application.

⚠️ **Attention:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal and Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

**Reserving a workplace**

As an employee, you can request a workplace reservation using Workplace Service Portal or the Now® Mobile app.

When making a reservation, you can choose an available space that you want to access or select an available area. If you’ve made a reservation for an area, you can work from any available space within that area when you return to office.

You can select a shift of your choice from the shift schedules defined by your organization. If your organization does not use shifts, you can select a custom time period. Depending on your organizational guidelines, your reservation request might require an approval. For more information, see Request a workplace reservation for multiple days.

⚠️ **Note:** If you need a workplace for only a day or less, you can reserve it directly and do not have to submit a request and get approval. For more information, see Reserve a workplace for a day.

You can check the status and details of all your reservation requests on Workplace Service Portal or through the Now Mobile app.

**Space reservation request states**

Once you submit a space reservation request, its status changes depending on the action taken on it by your approving manager or the workplace manager. You receive email notifications of these changes.

If you install the Now® Mobile app on your mobile device, you will also receive push notifications about your reservation requests.

- If your manager has not taken action on your request, the state of the request remains Awaiting approval.
- If your manager approves your request and the space availability is confirmed, the state of the request changes to Closed complete.
- If your manager rejects your request, the state of the request changes to Closed incomplete.
If your manager approves your request but the space you requested for is not available for all or some days, the state of the request changes to Pending. You can follow up with your workplace manager to get a new space assigned and resolve your pending space request.

• If you cancel your request, the state of the request changes to Cancelled.

Request a workplace reservation for multiple days
Request a workplace reservation for the days during which you want to return to office by using Workplace Safety Management.

Before you begin
To request a workplace reservation using your mobile device, you must have installed the Now® Mobile app.

Important: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_user

About this task
Request a workplace reservation either in a defined shift schedule or for a custom time for a specific date range during which you want to work from the office.

You can also access the reservation form using your mobile device. From the Now Mobile app, navigate to Services > Workplace Safety Management and choose either Request a short-term shift and space or Request a short-term space.

Procedure
1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.
      
      Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Reserve a space for a predefined shift or for a custom time.
   • To reserve a space for a defined shift schedule, click Request a short-term shift and space.
   • To reserve a space for a custom time, click Request a short-term space.
4. On the form, fill in the fields.

Note: The visibility of some of the following fields depends on the application settings made by your administrator.
Reserve a short-term space form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Region of your office location.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of your office.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus of your office building.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building that you want to return to.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date from which you want access to the workplace.</td>
</tr>
<tr>
<td>End date</td>
<td>Date until which you want to access the workplace.</td>
</tr>
<tr>
<td>Shift</td>
<td>The shift schedule during which you want to visit the office.</td>
</tr>
<tr>
<td></td>
<td>Only the shifts available for the selected location and date range are displayed.</td>
</tr>
<tr>
<td></td>
<td>Only the shifts that you are part of are displayed. This is dependent on the system properties which were configured by your organization.</td>
</tr>
<tr>
<td>Shift detail</td>
<td>Details of the shift that you selected. The shift detail is auto-filled based on your shift selection.</td>
</tr>
<tr>
<td>Start time for each day</td>
<td>Time from when you would access the workplace. This field is visible if you selected Request a short-term space.</td>
</tr>
<tr>
<td>End time for each day</td>
<td>Time until when you would access the workplace. This field is visible if you selected Request a short-term space.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor of the area or space that you want to access.</td>
</tr>
</tbody>
</table>

5. If the **Area** and **Space preference** fields are available, select an area or a space that you want to reserve.

- If you are using Workplace Service Portal or if you are using the Now Mobile app, and if you know which workplace to select, then select an area or a space from the **Area** or **Space** fields.

- If you are using Workplace Service Portal and floor plans for your workplace have been uploaded, you can also select the area or space from the interactive floor plan that is displayed at the bottom of the form. The animation on the Workplace Service Portal header indicates that the map is rendering. Wait until the map fully renders. The label colors of the workplaces indicate their availability.
◦ Green: The workplace is active for reservation and is available for the date and time that you selected.
◦ Red: The workplace is active for reservation but is unavailable for the date and time that you selected.

You can see who has the reservation by hovering over a reserved space, if your system administrator has enabled this setting.
◦ Grey: The workplace is inactive for reservations.

6. Select **Submit**.

**Results**
The web page or your mobile screen is refreshed to show your submitted reservation request. The state of your request is set to Awaiting approval, which indicates that the request has been sent to your manager for approval.

**What to do next**
You can check the status of your reservation request or choose to cancel your request using Workplace Service Portal or the Now Mobile app.

- On Workplace Service Portal, go to the **Requests** tab to view your requests and reservations.

- On the Now Mobile app’s navigation bar, tap **For Me** and scroll down to the **My request** section to view your requests and reservations.

- To cancel a reservation, go to the **Requests** page in the Workplace Service Portal or **My request** page in the Now Mobile:
  ◦ To cancel the reservation request, click **Cancel request**.
  ◦ To cancel a single reservation within the reservation request, click **Reservation details**. Select the reservation you want to cancel and click **Cancel reservation**.

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Reserve a workplace for a day

Reserve workplaces for a day on which you want to return to the office by using Workplace Safety Management.

Before you begin

To reserve a workplace using your mobile device, you must have the Now® Mobile app.

⚠️ Attention: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_user

About this task

Reserve spaces for a period less than or equal to 24 hours on the day that you want to work from the office. Reserve spaces, either in a defined shift schedule or in your custom timings.

You can also access the reservation form from the Now Mobile app. Navigate to Services > Workplace Safety Management and choose one from Reserve a shift and space for a day or Reserve a space for a day.

Procedure

1. Navigate to Workplace Services Portal > Workplace Services Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.
      ️ Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Reserve a space either for a defined day shift or a custom date.
   • To reserve a space for a defined shift schedule, click Reserve a shift and space for a day.
   • To reserve a space for custom timings, click Reserve a space for a day.
4. On the form, fill in the fields.
   ️ Note: The visibility of some of the following fields depends on the application settings made by your administrator.

Reserve a space form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Region of your office location.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of your office.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus of your office building.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building that you want to return to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>On-site date</td>
<td>Date on which you want access to the workplace.</td>
</tr>
<tr>
<td>Shift</td>
<td>The shift schedule during which you want to visit the office. Only the shifts available for the selected location and date range are displayed. Only the shifts that you are part of are displayed. This depends on the system properties which were configured by your organization.</td>
</tr>
<tr>
<td>Shift detail</td>
<td>Details of the shift that you selected. The shift detail is auto-filled based on your shift selection.</td>
</tr>
<tr>
<td>Start date/time</td>
<td>Date and time from when you would access the workplace. This field is visible if you selected Reserve a space for a day.</td>
</tr>
<tr>
<td>End date/time</td>
<td>Date and time until when you would access the workplace. This field is visible if you selected Reserve a space for a day.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor of the area or space that you want to access.</td>
</tr>
</tbody>
</table>

5. If the Area and Space fields are available, select an area or a space that you want to reserve.

- If you are using the Workplace Service Portal or if you are using the Now Mobile app, and if you know which workplace to select, then select an area or a space from the Area or Space fields.
- If you are using Workplace Service Portal and floor plans for your workplace have been uploaded, you can also select the area or space from the interactive floor plan that is displayed at the bottom of the form. The animation on the Workplace Service Portal header indicates that the map is rendering. Wait until the map fully renders. The label colors of the workplaces indicate their availability.
  - Green: The workplace is active for reservation and is available for the date and time that you selected.
  - Red: The workplace is active for reservation but is unavailable for the date and time that you selected.
You can see who has the reservation by hovering over a reserved space, if your system administrator has enabled this setting.

- Grey: The workplace is inactive for reservations.

6. Select Submit.

Results
The web page or your mobile screen is refreshed to show your reservation details.

What to do next
You can check the details of your reservation or choose to cancel it anytime using Workplace Service Portal or the Now Mobile app.

- On the Workplace Service Portal, go to the Requests tab to view your requests and reservations.
- On the Now Mobile app’s navigation bar, tap For Me and scroll down to the My Request section to view your requests and reservations.

If your organization has enabled the functionality to book an Uber from your mobile device, you would see a Book Uber option on your reservation details screen on Now Mobile. Tapping on it would redirect you to the Uber mobile app, if you have the app installed on your mobile device.

You will receive an email notification 15 minutes before the reservation to check in and another email notification 30 minutes before the reservation end time to check out.

- In the check-in email, select any of the following actions.
  - Check in: Check in your reservation.
  - Cancel this reservation: Cancel if the reservation is no longer required.
  - (Optional) Check out: Check out early before the reservation end time.

**Note:** You must check in within 30 minutes from the reservation start time, otherwise the reservation is canceled.
• In the check-out email received before the reservation end time, select **Check out** to check out the reservation.

**Note:** You must check out within an hour after the reservation end time. Otherwise, the reservation is automatically checked out.

### Approve employee workplace reservation requests

Review employee area and space reservation requests in Workplace Safety Management and approve or reject them.

**Before you begin**

To approve or reject a workplace request using your mobile device, you must have the **Now® Mobile** app.

**Attention:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see **Configure a catalog in Service Portal**.

Role required: approver_user

**Procedure**

1. Navigate to a reservation approval task.

<table>
<thead>
<tr>
<th>Application</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Now Mobile</strong></td>
<td>In the Now Mobile app, open a task from the My Tasks section.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Now Mobile" /></td>
</tr>
<tr>
<td><strong>Workplace Service Portal</strong></td>
<td>a. From your ServiceNow instance, navigate to <strong>Service Portal &gt; Service Portal Home</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Approvals &gt; View all approvals</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Open the request that you want to review.</td>
</tr>
</tbody>
</table>

2. **Optional:** Review the details of the request.

3. Approve or reject the request by selecting **Approve** or **Reject**.
Managing workplace tasks

Using workplace tasks in Workplace Safety Management, workplace managers can monitor workplace activities that are created and scheduled in the workplace for each shift. They can also schedule planned or on-demand maintenance tasks and generate reports to track the progress of these activities.

Workplace task creation

You can create workplace tasks in the Workplace Safety Management application for various situations.

Automatically created pre-cleaning and post-cleaning tasks

Workplace managers can create shifts and associate employees and spaces to the shift. After workspaces are assigned to a shift and the shift's state is set to Ready, the system automatically creates pre-cleaning and post-cleaning tasks for that shift. These tasks are generated using the respective templates available with the application.

**Note:** If a shift doesn't have a space associated to it, pre-cleaning and post-cleaning tasks are not auto-generated for it.

Planned tasks

Tasks for recurring planned activities that are independent of shifts.

Ad hoc tasks

Ad hoc tasks when on-demand cleaning is required.

Task assignment

Assignments for tasks depend on the task type:

- Pre-cleaning and post-cleaning tasks are automatically assigned based on their templates.
- Planned tasks are automatically assigned based on the planned task definition that is used to generate these tasks.
- Ad hoc tasks can be assigned manually by workplace managers when they create these tasks.

Signature of completion

For audit and compliance of workplace activities, workplace managers can electronically sign the completed workplace tasks. This action generates a PDF of the signed form and attaches it to the task.

Configure a workplace task template

Configure templates in Workplace Safety Management that can be used to create workplace tasks. You can either modify predefined workplace task templates or create your own templates and associate them with workplace tasks.

**Before you begin**

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

**About this task**

Templates simplify the process of creating tasks in Workplace Safety Management by populating fields automatically. The following predefined templates are available with the application:
• Pre-cleaning
• Post-cleaning

Procedure
2. Create a new template or modify an existing template.
   • If you are creating a new template, click New.
   • If you are modifying an existing template, open the desired template.
   For information about the template form fields, see Create a template.
3. Select the Workplace Task [sn_wsd_core_workplace_task] table in the Table field.
4. Optional: Apply the template to the required workplace task type.
   a. In the Template section, select the Workplace task type field in the left column.
   b. Select the required task type in the right column.
5. Click Submit.
6. Add a checklist to the template.
   For steps on how to add a checklist, see Create a workplace task checklist.
7. Click Update.

Create a workplace task checklist
You can create a unique checklist for each workplace task template in Workplace Safety Management. You can also quickly create a checklist from an existing checklist template.

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task
You can also create checklists for individual workplace task records.

Procedure
1. Create a checklist to be included in all tasks using the same template or add a checklist to a specific task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>b. In the list, click to open the template to which you want to add the checklist.</td>
</tr>
<tr>
<td></td>
<td>b. In the list, select the task to which you want to add the checklist.</td>
</tr>
</tbody>
</table>

2. In the Checklist section, click the down arrow (▼) beside the Checklist formatter.
3. Add a checklist.
   • If you are creating a new checklist, click **Create new**.
   • If you are using an existing checklist template, click **Create from template** and select a template.

4. Add a checklist item.
   a. Click the Add item icon (➕) and enter text for the checklist item.
   b. Press the Enter key to add the checklist item.
      Add as many additional checklist items as desired.

5. **Optional:** Delete unwanted checklist items by clicking the delete item icon (➖).

6. **Optional:** Change the order of checklist items by clicking the drag icon (Dragging) and dragging the item to a different position in the list.

7. Click **Update**.

**Results**
   • If you created the checklist for a workplace task template, any task created using this workplace template will also contain this checklist.
   • If you created the checklist in a workplace task form, the checklist will be part of only that task.

**What to do next**
You can save the checklist as a template for easy reuse, if required.

**Save a workplace task checklist as a template**
You can save a Workplace Safety Management workplace task checklist as a template for easy reuse. A template saves time by adding checklist items automatically in a record where you use it.

**Before you begin**
Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

**About this task**
When you add a template checklist to a record, you can add, edit, or remove checklist items in the record without affecting the template.

**Procedure**
1. Navigate to the record that contains a checklist you created.
   To find out how to access the record, see Create a workplace task checklist.

2. In the **Checklist** section, click the down arrow (🔧) beside the **Checklist** formatter.

3. Click **Save as Template**.

4. Enter a name for the checklist template.

5. From the **User Group** list, select a group to limit who can use the checklist template.
   Only members of the selected group and the user who created the checklist can use the checklist as a template. Leaving this field blank prevents anyone but the template creator from using the checklist template.

6. Click **Save**.
Configure a workplace task signing template

Configure a signing template that you want to make available for signing the completed Workplace Safety Management workplace tasks. You can configure the default signing template available with the application or create a new template.

Before you begin
Role required: sn_wsd_core.admin

About this task
When a workplace manager signs a completed task, an e-signature PDF document is generated using a signing template and is attached to the task. For information about signing a workplace task, see Sign a completed workplace task.

Procedure
1. Navigate to Workplace Safety Management > Administration > HTML Signing Templates.
2. Click New or open an existing signing template to edit it.
   The application provides a default template called Task Signing Template.
3. On the form, fill in or modify the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgment text</td>
<td>Text clarifying the meaning of the signature. For example, &quot;I acknowledge that this information is true&quot;.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the signing template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain assigned to the template. Select Global to allow any user who can access templates to view and apply this template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table associated with the template. The selected table determines the available variables in the Select variables field.</td>
</tr>
<tr>
<td>Body</td>
<td>Placeholder for HTML text and variables. The variables are resolved when the PDF is generated.</td>
</tr>
<tr>
<td>Select variables</td>
<td>List of variables that can be used in the body of the template. Variables pull information from the selected table to customize the template.</td>
</tr>
</tbody>
</table>

4. Customize the body of the signing template in the Body field.
   a. Enter and format the text to design the body of the template.
      Use the formatting tools to apply formatting options, such as bold, italic, underline, or font styling.
b. Insert variables by locating your cursor at the desired location and selecting the variable under **Fields**.
For example, to indicate which location to clean, you might insert the text Cleaning finished for the Workplace location: and, after a space, click **Workplace location** under **Select variables**. The variable in the **Body** field text would appear as follows:

```
Cleaning finished for the Workplace location: ${workplace_location}
```

The variable is replaced with the actual location when the PDF is generated.

5. At the desired location in the **Body** field, enter the following variables:
   - `{Checklist}`: Adds the checklist variable.
   - `{Signature}`: Adds the signature variable.

   ![Image of variable selection in Fields](image)

   In the signed PDF document, the signature and checklist are embedded at the same location where you entered these variables into the template body.

6. Click **Submit**.

7. **Optional**: Review the look of the PDF document by impersonating a workplace manager and signing a closed task.

**Create planned task definitions**

Create planned task definitions in Workplace Safety Management to help workplace managers easily generate tasks that are often repeated and independent of shifts such as cleaning coffee vending machines or cleaning floors. You can quickly specify the task details and the frequency at which the task is to be performed.

**Before you begin**

**Important**: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal in Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager
About this task
You can also access the planned task definition form by navigating to Workplace Safety Management > Workplace Tasks > Planned Tasks Definitions and clicking New.

Procedure
1. Navigate to Workplace Services Portal > Workplace Services Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.

   Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Click Add planned task definition.
4. On the form, fill in the fields.

   Planned task definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the planned task definition. For example, &quot;Clean conference rooms&quot; for the activity of sanitizing conference rooms.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Work schedule to be used for planned tasks.</td>
</tr>
<tr>
<td>Workplace task template</td>
<td>Template used for the generated planned tasks. Selecting a template automatically populates certain fields such as Assigned to, Short description, and Workplace task type in the generated tasks. For information about workplace task templates, see Configure a workplace task template.</td>
</tr>
<tr>
<td>Processing Time (hours)</td>
<td>Amount of time it should take to complete a planned task.</td>
</tr>
<tr>
<td>Planned end time</td>
<td>Date and time by which the task should be finished.</td>
</tr>
<tr>
<td>Planned start time</td>
<td>Date and time when the task should start.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. If you accessed the form from Workplace Service Portal, on the verification page, you can create another planned task definition or generate planned tasks from this definition immediately.

   Note: You can also use this definition to generate planned tasks later. See the instructions in the Generate planned tasks topic.
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create another planned task definition</td>
<td>Click <strong>Add another task definition</strong>.</td>
</tr>
<tr>
<td>Generate planned tasks immediately</td>
<td>a. Click <strong>View all task definitions</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Open the planned task definition and click <strong>Generate Task</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Workplace Tasks related list to view the generated planned tasks.</td>
</tr>
</tbody>
</table>

**Results**

- The planned task definition is added to the list of all planned task definitions that you can view by navigating to **Workplace Safety Management > Workplace Tasks > Planned Tasks Definitions**.
- If you created planned tasks from this definition, they are added to the list of all planned tasks. You can view those tasks by navigating to **Workplace Safety Management > Workplace Tasks > Planned Tasks**.

**Generate planned workplace tasks**

Using planned task definitions in Workplace Safety Management to create planned tasks independent of shifts for recurring activities. For example, you can generate tasks for a selected number of days for cleaning all floors and buildings at midnight every day.

**Before you begin**

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

**About this task**

You can also create an individual planned task using the **Add a task** option on the Workplace Service Portal. In this case, however, instead of multiple planned tasks for all dates between **Planned start time** and **Planned end time** in the selected planned task definition, only one planned task is created. For more information on creating a one-off planned task, see **Create an ad hoc workplace task**.

**Procedure**

1. Navigate to **Workplace Safety Management > Workplace Tasks > Planned Tasks Definitions**.
2. In the list, open the planned task definition.
   
   You can also generate planned tasks immediately when you create a new planned task definition. For more information, see **Create planned task definitions**.
3. Select **Planned start time** and **Planned end time** values based on the days and time when you need these tasks to be performed.
4. Click **Generate now**.

**Results**

- Based on the planned start time and planned end time, planned tasks are created for all occurrences of the schedule and appear in the Workplace Tasks related list.
- The **Expected start time** in each generated planned task is auto-calculated from the planned end time and processing time values in the respective tasks as follows:

  Planned start time = Planned end time – Processing Time
You can view all planned tasks by navigating to Workplace Safety Management > Workplace Tasks > Planned Tasks.

Create an ad hoc workplace task
Create an ad hoc task in Workplace Safety Management for unplanned activities. For example, if you notice that something isn’t clean in an area or want the area to be cleaned again, you can create an ad hoc workplace task to get the cleaning done immediately.

Before you begin

Important: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.admin or sn_wsd_core.workplace_manager

About this task
You can also access the workplace task form by navigating to Workplace Safety Management > Workplace Tasks > Create New.

Procedure
1. Navigate to Workplace Services Portal > Workplace Services Portal Home.
2. Open the Site safety category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Site safety.

   Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.
3. Click Add a task.
4. On the form, fill in the fields.

Workplace Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace task type</td>
<td>Type of the workplace task. Select Ad-hoc Task.</td>
</tr>
<tr>
<td>Workplace location</td>
<td>Workplace location where the task should be performed.</td>
</tr>
<tr>
<td>Signature template</td>
<td>Task signature template to use for signing off on this task when it is completed. For more information, see Sign a completed workplace task.</td>
</tr>
<tr>
<td>State</td>
<td>State of the task.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group assigned to the task.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>User assigned to the task.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor whose employees should perform the task.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the ad hoc task.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. If you accessed the form from Workplace Service Portal, on the verification page, you can create another task or view this task record in a list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create another task</td>
<td>Click <strong>Add another task</strong>.</td>
</tr>
<tr>
<td>View the task record in a list</td>
<td>Click <strong>View all tasks</strong>.</td>
</tr>
</tbody>
</table>

7. Add a checklist to the task to track the actions required to complete it.
   To add the checklist, open the task by navigating to Workplace Safety Management > Workplace Tasks > All. For more information, see Create a workplace task checklist.

**Results**
The ad hoc task is added to the list of all tasks that you can view by navigating to Workplace Safety Management > Workplace Tasks > All.

**Sign a completed workplace task**
As the workplace manager for a space, sign the workplace tasks Workplace Safety Management for complete and closed activities. Signing a task generates a PDF document for the workplace activity, which is useful for compliance procedures.

**Before you begin**
Role required: sn_wsd_core.workplace_manager

**Procedure**
1. Navigate to Workplace Safety Management > Workplace Tasks > Closed.
2. In the list, click to open the workplace task that you want to sign.
3. In the **Sign template** field, review the signing template selected for the task.
   For more information, see Configure a workplace task signing template.
4. Click **Sign Task**.
   - **Note:** The **Sign Task** button appears only once you have selected a template in the **Sign template** field.
5. In the **Sign Task** form, sign the form in one of the following ways:
   - In the **Type signature** tab, enter your name in the **Full name** field.
   - In the **Draw signature** tab, draw your signature using your mouse.
6. Click **Accept and complete**.

**Results**
A PDF document of the signed form is generated based on the signing template associated with the task and is attached to the task.
View the Location directory

Explore all the campuses, sites, and buildings of your company using the Location directory in the Workplace Service Portal. Submit a request related to a space and get directions to a space.

Before you begin

Important: Ensure that the latitude and longitude of your company's regions, sites, campuses, and buildings are set up. If the latitude and longitude are not specified, then you cannot view a campus or its buildings on the map. Contact your admin for more information.

Role required: sn_wsd_core.workplace_user

About this task

Procedure


2. To open the Site safety category, do the following.

a. Click Catalog.

b. Click Browse by Categories.

c. In the Workplace Services Catalog, select Site safety.

   Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Site safety.

3. Select Location directory.

4. On the Location directory page, search and select a location or an employee.

   a. Optional: Type the name of the location or the name of the user.

   b. Optional: To open a list of available sites, campuses, and buildings, click the location list icon ( ) in the Select a location field.

   c. Optional: Use the filter option to view campuses or buildings. You can select a campus or a building from the list directly.

   d. Optional: Select the sort options to view the locations in the alphabetical order.

   The selected location is displayed with a location pin on the map.

   • If you have selected a campus or building, the location card appears on the world map.
   
   • If you have selected a floor, area, room, space or a user, the location pin appears on the floor plan.

   Note: If you cannot select or view a campus or building, contact your admin to specify the latitude and longitude.

5. To get a close-up view on the map, select the location pin on the map.
a. To view all the buildings of the campus, select the location pin and click View campus buildings.

b. To view all the floors of the building, select the location pin and click View interactive floor map. This option appears only if the building has a floor map. If there is no floor map defined for the building, the View list of building spaces option appears. An interactive floor map of the building is displayed with all the spaces on the floor with space labels. All the spaces of the selected floor are listed in the card view.

c. Optional: To submit a general enquiry related to the space, click Raise a general inquiry on the card view.

6. Optional: In the map view, use the drop-down to select the floor that you want to view on the map.

7. Optional: Use the zoom options on the map to get a closer view of the spaces.

8. Optional: Sort the spaces in alphabetical order or by using the sort option in the card view.

9. Optional: Filter the space based on space types using the filter option in the card view.

10. Optional: To view a space on the floor, select the space from the card view or directly on the map. The map highlights the space.

11. Optional: To search for a user, type the user's name or their location. The user details are displayed based on their desk reservation if there are any or based on their workplace profile's location.

12. Optional: To submit a request related to the space, select the space and click Raise a general inquiry. For more information, see Raise help request for a workplace inquiry. The location details are pre-defined.

13. Optional: To get directions from one space to another, perform the following actions on the map.

   a. Select a space and click Get directions to location.

   b. Select the space from where you want the directions, and click Set as start point.

   c. Select the space to which you want the directions, and click Set as end point.

   d. Optional: Select the start and end point for the direction on the card view. You can also select a user's workspace as the start and end points.

   e. To switch the direction, select Switch on the card view.

   The map displays the navigation path between the selected spaces in an olive green color. You can zoom into the map to get a closer view of the direction. The directions are also listed in detail on the card view.

Workplace knowledge management

As a workplace admin, you can create knowledge base articles for employees. In the articles, provide information to your employees about workplace services, such as workplace updates, self-help, troubleshooting, and others.
With the Workplace Service Delivery application, you can create knowledge base articles and display them as wiki pages or HTML pages. The Workplace Service Delivery Knowledge Management is the same as the Now Platform Knowledge Management, for more information, see Configure Knowledge Management.

You can add attachments and enable employees to view the attachments individually. If a knowledge base article is relevant only for a short duration, you can specify an end date for the knowledge base article.

You can view and update the knowledge base articles at any time. You can view published articles, unpublished articles and retired articles separately. You can also republish an article whenever needed.

The Workplace Service Delivery provides the following knowledge base articles in the Workplace Service Portal by default.

- Cafeteria services
- Parking policy for visitors

Create a workplace knowledge base article

Provide information to employees through knowledge base articles. Create knowledge base articles with information about workplace updates, self-help, troubleshoot steps, and others.

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.kb_writer

Procedure

1. Navigate to Workplace Safety Management > Knowledge management > Create new article.
2. Click New.
3. On the form, fill in the fields.

Knowledge form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge base</td>
<td>Name of the knowledge base. Select the <strong>Workplace services</strong> knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>Relevant category for the knowledge base article. Select an existing category, or click the add category icon (⊕) to add a new category. You can also select or add a subcategory.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date until which the knowledge base article is valid. The date is automatically set to 2100-01-01.</td>
</tr>
<tr>
<td>Article type</td>
<td>Type of article which you want to create. Choices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Wiki</strong> to create a wiki page.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>HTML</strong> to create an html web page.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to give an attachment for the knowledge base article.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display the attachments individually.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the knowledge base article. The short description is displayed as the title of the article.</td>
</tr>
<tr>
<td>Article body</td>
<td>Information that is displayed in the knowledge base article. Use the formatting options to change the style of the content. This field appears only if HTML is selected from the Article type field.</td>
</tr>
<tr>
<td>Wiki</td>
<td>Information that is displayed in the knowledge base article as a wiki. Select the Wikitext option to preview the text. This field appears if Wiki is selected from the Article type field.</td>
</tr>
</tbody>
</table>

4. **Optional:** To search existing articles for any duplicate content, click Search for Duplicates.

5. Click **Submit**.

**Results**
The knowledge base article is created.

**What to do next**
Publish the knowledge base article. For more information, see Publish a workplace knowledge base article.

For more information about the Now Platform Knowledge management, see Configure Knowledge Management.

**Publish a workplace knowledge base article**
After creating a knowledge base article, publish the article on the workplace services portal to make it available for employees.

**Before you begin**
Role required: sn_wsd_core.admin or sn_wsd_core.kb_writer

Before you publish, create a knowledge base article. For more information, see Create a workplace knowledge base article.

**Procedure**
2. Select the knowledge base article that you want to publish.
3. On the knowledge form, click **Publish**.

**Results**
The knowledge base article is published for employees to view.

For more information on how to view the published knowledge base article, see View workplace knowledge base articles.

For more information on how to edit the publish knowledge base article, see Modify a workplace knowledge base article.
View workplace knowledge base articles
View workplace-related updates, processes, and other information in the knowledge base articles that your team created. Rate articles that you find useful.

Before you begin
Role required: sn_wsd_core.workplace_user

Procedure
1. Navigate to Workplace Service Portal > Workplace Service Portal Home.
2. Open the knowledge base page.
   • Click the Knowledge tab.
   • Click the Knowledge Base option.
3. In the KB categories list, select the category of the knowledge base article.
4. (Optional) If you are unsure about the category, search for the article.
5. From the list of published knowledge base articles, select the article that you want to view.
6. (Optional) Perform any of the following actions.
   • Rate the article out of 5.
   • If you found the article useful, Click Yes. If not, click No.
   • Leave a comment about the article and click Submit. You can also attach files.

Modify a workplace knowledge base article
Update a knowledge base article at any time. Retire a published article or republish a retired article.

Before you begin
Role required: sn_wsd_core.admin or sn_wsd_core.kb_writer

Procedure
1. Navigate to Workplace Safety Management > Knowledge management.
2. Select any of the following options to find your knowledge base article.
   • All articles
   • Published articles
   • Unpublished articles
   • Retired articles
3. Select the knowledge base article that you want to modify.
4. Select any of the following options to modify your knowledge base article.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>Select this option to update any changes made to the knowledge base article.</td>
</tr>
<tr>
<td>Retire</td>
<td>Select this option to remove the knowledge base article from the portal.</td>
</tr>
<tr>
<td>Republish</td>
<td>Select this option to republish a retired article.</td>
</tr>
</tbody>
</table>
Results
The knowledge base article is modified with the changes.

Workplace dashboards

Use the Workplace dashboards in Workplace Safety Management to get a consolidated view of multiple workplace-related metrics so you can quickly check space utilization and monitor the progress of workplace tasks. Real-time information provides insights to enable making decisions such as how many people in the workforce can be allowed at a given time into the office space. Track the workplace reservations, workplace cases and visitor registrations at any time.

Workplace manager dashboard

Use the Workplace manager dashboard to monitor the space allocation and workplace maintenance activities at your office campus. For any given day, you can view the details for available spaces, space reservations, pending workplace requests, arrival times for different locations, employee arrivals, and maintenance tasks.
To access the Workplace Manager Dashboard, navigate to **Workplace Safety Management > Workplace dashboards > Safety management.**

Selecting a region, site, and a campus in the Workplace Report Filter at the top of the dashboard displays reports for that campus.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Workplace manager: Needs visibility into the real-time status of the workplace space availability, scheduled arrivals, and workplace maintenance. | sn_wsd_core.workplace_manager | - Review pending workplace requests  
- Monitor workplace reservation requests created by employees  
- Monitor arrival times  
- Estimate employee gatherings at common workplace locations using scheduled arrivals  
- Monitor the progress of workplace tasks |

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending workplace requests</td>
<td>Single score</td>
<td>Number of workplace requests that are pending.</td>
</tr>
<tr>
<td>Today's available spaces</td>
<td>Single score</td>
<td>Number of active workspaces available for reservations today.</td>
</tr>
<tr>
<td>Today's scheduled arrivals</td>
<td>Single score</td>
<td>Number of employee arrivals scheduled for today for different locations on the campus.</td>
</tr>
<tr>
<td>All unassigned cleaning tasks</td>
<td>Single score</td>
<td>Number of active workplace tasks that are not assigned to anyone and not in the Closed state.</td>
</tr>
<tr>
<td>Pending requests</td>
<td>List</td>
<td>List of pending workplace requests for this campus.</td>
</tr>
<tr>
<td>Today's available spaces</td>
<td>List</td>
<td>List of active workspaces available for reservations today.</td>
</tr>
<tr>
<td>Today's arrival times</td>
<td>List</td>
<td>List of arrival times scheduled for today for different locations on the campus.</td>
</tr>
<tr>
<td>Today's scheduled arrivals</td>
<td>List</td>
<td>List of employee arrivals scheduled for today for different locations on the campus.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Today’s reservations by shift</td>
<td>Bar</td>
<td>Number of workplace reservations for today grouped by their shifts.</td>
</tr>
<tr>
<td>Today’s reservations</td>
<td>List</td>
<td>Number of workplace reservations for today.</td>
</tr>
<tr>
<td>Unassigned cleaning tasks by day</td>
<td>Trend</td>
<td>Trend of the number of active cleaning tasks per day that are not assigned to anyone and not in the Closed state. The cleaning tasks in this report have a due date between today and the next seven days and include all task types such as planned, unplanned, and ad hoc.</td>
</tr>
<tr>
<td>Unassigned cleaning tasks</td>
<td>List</td>
<td>List of active workplace tasks that are not assigned to anyone and not in the Closed state.</td>
</tr>
</tbody>
</table>

**Workplace dashboard in Workplace Service Portal**

Use the Workplace Dashboard from Workplace Service Portal to visually analyze the available workspace capacity, space request and reservation trends, and monitor the maintenance tasks of your workplace. You can also reserve a space for an employee or create a workplace maintenance task directly from this Workplace Service Portal page.

To open the Workplace dashboard on the Workplace Service Portal, navigate to Workplace Safety Management > Dashboard.

**Attention:** Starting with Workplace Safety Management (sn_wsd_core) version 2.2, or new customers, the Dashboard is removed from the Workplace Service Portal and Service Portal. Customers using Workplace Safety Management version 2.1 and below can still access the dashboard after an upgrade.

Selecting a region and site in the filter at the top displays reports for available campuses in separate tabs.
Workplace dashboard
Overview of California sites

California California Campus 1

Today's capacity
60

Today's shifts
3

Today's reservable spaces
60

Today's reservations
90

Reserved spaces per day

Reservable spaces per building

Cleaning tasks for this campus

Unassigned cleaning tasks
10

Planned tasks
95

Workplace requests for this campus

Pending workplace requests
7

Workplace requests created today
23
### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Workplace manager: Needs clear visibility into the real-time status of the workplace space utilization and cleaning activities for shifts. | sn_wsd_core.workplace_manager                      | • Can plan for the phased return of employees to the workplace after an emergency situation  
• Can monitor progress of workplace tasks for various office locations                                                                                                                                                                                                 |

### Reports

The data displayed in reports corresponds to the selected campus.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today’s capacity</td>
<td>Single score</td>
<td>Number of active workspaces available today.</td>
</tr>
<tr>
<td>Today’s shifts</td>
<td>Single score</td>
<td>Number of shifts used in today’s reservations.</td>
</tr>
<tr>
<td>Today’s reservable spaces</td>
<td>Single score</td>
<td>Number of active workspaces available to reserve.</td>
</tr>
<tr>
<td>Today’s reservations</td>
<td>Single score</td>
<td>Number of today’s active reservations.</td>
</tr>
<tr>
<td>Reservations per day</td>
<td>Trend</td>
<td>Trend of the number of active reservations per day in the last seven days for which the end date is today or later.</td>
</tr>
<tr>
<td>Reserved spaces per day</td>
<td>Spline</td>
<td>Trend of the number of reserved workspaces per day for all reservations made in the last seven days that are active starting today or later.</td>
</tr>
<tr>
<td>Reservable spaces per building</td>
<td>Bar</td>
<td>Breakdown of active workspaces that are available to reserve for each building on the campus.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unassigned cleaning tasks</td>
<td>Single score</td>
<td>Number of active workplace tasks that are not assigned to anyone and not in the Closed state.</td>
</tr>
<tr>
<td>Planned tasks</td>
<td>Single score</td>
<td>Number of active planned workplace tasks that are not yet closed.</td>
</tr>
<tr>
<td>Cleaning tasks by day</td>
<td>Trend</td>
<td>Trend of the number of active cleaning tasks per day for which the due date is between today and the next seven days, or for which no due date is defined. The tasks in this report are grouped by the workplace task type.</td>
</tr>
<tr>
<td>Workplace requests for this campus</td>
<td></td>
<td>Number of workplace requests that are pending.</td>
</tr>
<tr>
<td>Pending workplace requests</td>
<td>Single score</td>
<td>Number of workplace requests that are pending.</td>
</tr>
<tr>
<td>Workplace requests created today</td>
<td>Single score</td>
<td>Total number of workplace reservation requests created by the employees today.</td>
</tr>
<tr>
<td>Workplace requests by day</td>
<td>Trend</td>
<td>Trend of the number of workplace reservation requests created per day.</td>
</tr>
</tbody>
</table>

**Related information**

- Create workplace reservations for an employee
- Create an ad hoc workplace task

**Workplace Reservation Management**

The ServiceNow® Workplace Reservation Management application makes it easier for employees to reserve meeting rooms, conference rooms, desks, and any reservable workplace service from the Service Portal.
Workplace Reservation Management overview

As an admin, you can access the complete application and perform any action on the Workplace Reservation Management application.

Based on the user role, you can:

### Configure reservation module

As a Workplace Reservation Management admin, you can:

- Configure the Reservations widget to display different types of reservable items which employees can reserve.
- Configure a wide range of standard services that are available with the reservable items.
- Configure reservable modules to group similar types of reservable items. Activate/deactivate a module to control its availability for the employees to reserve.
- Indicate if an approval is required. Doing so triggers an approval request whenever an employee tries to reserve any reservable item of the reservable module.
- Enable shift-based reservation on a reservable module. An employee can make a shift reservation for a workplace item of that reservable module.

### Create reservations

With Workplace Reservation Management, users can:

- Choose from a list of available workplace items.
- Reserve for a day, or a few hours.
- Create a single reservation or recurring reservations.
- View details of workplace item such as capacity, location, layout, and services available.
- View availability of a workplace item for a day using Schedule view.
- Create a reservation for yourself or on behalf of someone else.
- View, update, or cancel your reservations or reservations created for others.
- While reserving a room for a meeting, specify the meeting type as private for confidential meetings.
- Request extra services along with a reservation such as catering or stationery supply.
- Reserve multiple workplace locations in a single reservation.

### Manage reservations

As a Workplace Reservation Management manager, you can:
- Manage reservations created by employees. You can view, update, and approve or reject the reservations created by the employees based on your organization’s guidelines.
- Generate reports to track the reservation requests over time.
- Add reservable purposes to a workplace item.
- Assign neighborhood spaces to an area.

The following diagram explains the journey of a reservation:

**Reservation workflow**

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.
All decisions in connection with the implementation of this application are at the sole
decision of the government agency utilizing this application. Agencies remain solely
responsible for complying with their legal obligations under applicable laws and regulations,
including (but not limited to) data protection and employment laws and regulations, and
should modify any language within the templates provided to meet the agency’s specific
requirements.

Install Workplace Reservation Management

Install the Workplace Reservation Management application from ServiceNow Store
applications. Visit the ServiceNow Store website to view all the available apps and for
information about submitting requests to the store. For cumulative release notes information
for all released apps, see the ServiceNow Store version history release notes.

Before you begin
Complete the following setup checklist for a smooth installation and configuration.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that Workplace Service Delivery - Core (sn_wsd_core) plugin of version 2.0 is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
</tbody>
</table>

Role required: admin

About this task
Activate the Workplace Service Delivery - Core plugin (sn_wsd_core) of version 2.0 in your ServiceNow instance before you install Workplace Reservation Management.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Workplace Reservation Management.

5. Optional: If demo data is available and you want to install it, click Load demo data.
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

6. Click Install.
Components installed with Workplace Reservation Management

Several types of components are installed with activation of the Workplace Reservation Management application, including tables, user roles, and business rules.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this application.

Roles installed with Workplace Reservation Management

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>WSD Core Admin [sn_wsd_core.admin]</td>
<td>• Complete access to Workplace Service Delivery applications.</td>
<td>• sn_wsd_rsv.admin</td>
</tr>
<tr>
<td>WSD Admin [sn_wsd_rsv.admin]</td>
<td>• Manage Standard services and the location to which they are assigned.</td>
<td>• sn_wsd_rsv.admin</td>
</tr>
<tr>
<td></td>
<td>• Add standard services.</td>
<td>• sn_wsd_rsv.admin</td>
</tr>
<tr>
<td></td>
<td>• Add flexible services</td>
<td>• sn_wsd_rsv.dispatcher</td>
</tr>
<tr>
<td></td>
<td>• Add reservable purposes.</td>
<td>• sn_wsd_rsv.staff</td>
</tr>
<tr>
<td></td>
<td>• Assign archiving rule.</td>
<td>• sn_wsd_core.workplace_user</td>
</tr>
<tr>
<td></td>
<td>• Create and assign time slots to a reservable module.</td>
<td></td>
</tr>
<tr>
<td>WSD Manager [sn_wsd_rsv.manager]</td>
<td>• View all reservations.</td>
<td>• sn_wsd_rsv.dispatcher</td>
</tr>
<tr>
<td></td>
<td>• View and generate reports.</td>
<td>• sn_wsd_rsv.staff</td>
</tr>
<tr>
<td></td>
<td>• Manage reservations.</td>
<td>• sn_wsd_core.workplace_user</td>
</tr>
<tr>
<td>WSD Dispatcher [sn_wsd_rsv.dispatcher]</td>
<td>• View all reservations.</td>
<td>• sn_wsd_rsv.staff</td>
</tr>
<tr>
<td>WSD Staff [sn_wsd_rsv.staff]</td>
<td>• View all reservations.</td>
<td>• sn_wsd_rsv.staff</td>
</tr>
<tr>
<td>Workplace user [sn_wsd_core.workplace_user]</td>
<td>• Create room or desk reservations from the Service Portal for self or on behalf of someone.</td>
<td>None</td>
</tr>
</tbody>
</table>
### Role title [name]

- View reservations created on behalf of themselves or someone else.
- Manage (edit and cancel) reservations created by them.
- View private subject of their reservations or reservation created for them.
- View reservable items.
- View services.

### Tables installed with Workplace Reservation Management

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reservable Module  
[sn_wsd_rsv_reservable_module] | Extends the Application File table. Stores information about items that can be reserved. |
| Workplace Reservation  
| Standard Service  
[sn_wsd_rsv_standard_service] | Stores information about standard services. |
| Workplace rooms  
[sn_wsd_core_room_list] | Extends the Space [sn_wsd_core_space] table. It holds the reservable items of a room that are available to reserve. |
| Reservable purpose  
[sn_wsd_rsv_reservable_purpose] | Stores information about reservable purposes added to Workplace spaces and Workplace Rooms. |
| Extra service request  
[sn_wsd_rsv_extra_service_request] | Stores information about extra services requested by employee while making a reservation. |
| Flexible service  
[sn_wsd_rsv_flexible_service] | Stores information about flexible services. |

### Properties installed with Workplace Reservation Management

Customize the properties available with Workplace Reservation Management.

These properties are available for Workplace Reservation Management.

⚠️ **Note:** All of these properties are listed in the System Properties [sys_properties] table. To access the table, enter `sys_properties.list` in the navigation filter.
## Properties for Workplace Reservation Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_wsd_rooms.default_page_size               | This property enables you to specify the number of reservable entries displayed on a page. This value is used on the following pages:  
• On the Search page while loading reservable items.  
• On the Reservation summary page while loading sibling occurrence.  
• On the My reservations page.  
If an incorrect value is configured in the widget, the value specified in this property is used as a default value.  
• Type: Integer  
• Default value: 8                                                                 |
| sn_wsd_rsv.search_limit                      | This property enables you to specify the number of workplace items to be displayed in the search result. If an employee applies any filter or sorting on the search results, the first 100 workplace items that match the criteria are displayed at a time. 100 is the default value. The value specified in this property is used only if there is no value specified in the Search limit field of a reservable module.  
• Type: Integer  
• Default value: 100                                                                 |
| sn_wsd_rsv.time_before_check_in_out_reminder | This property enables you to configure when to send a notification email as a reminder to employees to check in or check out a reservation. The value must be set in minutes.  
• Type: Integer  
• Default value: 30                                                                 |
| sn_wsd_rsv.day_start                         | This property enables you to specify the start time of an all day reservation. The value must be set in 24-hour format.  
• Type: String  
• Default value: 09:00                                                                                                                                                                                                  |
| sn_wsd_rsv.day_end                           | This property enables you to specify the end time of an all-day reservation. The value must be set in 24-hour format.  
• Type: String  
• Default value: 24:00                                                                                                                                                                                                   |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_rsv.is_blocker_mandatory</td>
<td>This property enables you to specify if the blocker reservations are mandatory. The blocker reservations are created for preparation and clean-up activities if an extra service is requested along with the reservation. If you enable this property, and if the blocker reservations collide with another reservation, then the extra service will not be requested. The employee who made the reservation with these extra service, can view the message about the rejected service on the Reservation summary page.</td>
</tr>
<tr>
<td>sn_wsd_rsv.is_blocker_mandatory</td>
<td><strong>Note:</strong> If an extra service is requested for a workplace location that requires approval, the blocker reservations are sent for approval along with the actual reservation.</td>
</tr>
<tr>
<td>sn_wsd_rsv.blocker_user</td>
<td>This property enables you to specify the user who is used to create the blocker reservations.</td>
</tr>
<tr>
<td>sn_wsd_rsv.cancel_unconfirmed_reservations</td>
<td>This property enables you to specify after how many minutes should a reservation be canceled if there is no confirmation from the calendar provider.</td>
</tr>
<tr>
<td>sn_wsd_rsv.time_when_reservation_cancelled_without_check_in</td>
<td>This property enables you to specify after how many minutes should a reservation be canceled if it is not checked in. Ensure that the you have enabled the <strong>Cancel reservations exceeding check-in time</strong> option in the reservable module on which you want to apply this action.</td>
</tr>
</tbody>
</table>
Setting up Workplace Reservation Management portal

As a Workplace Reservation Management admin, you can decide what can be made reservable in the organization. You can add different types of reservable items in the application for employees to reserve.

You can configure what must be available in the application for reservation. You can configure the reservable modules displayed on the application.

As a Workplace Service Delivery admin, you can perform any action on the Workplace Reservation Management application. You can add reservable workplace items and perform other actions.

As a Workplace Reservation Management admin, the application enables you to perform the following actions:

• Enable manager approvals on reservable modules for reservation.
• Make reservations on behalf of others.
• View all the reservations made.
• Modify existing reservable modules.
• Activate or de-activate reservable items and control its availability on the application.
• Configure standard services.
• Add reservable purpose on reservable items for employees to make easy selection.
• Configure check-in and check-out requirement on a reservable module.
• View the current state, synchronization state and the check-in state of a reservation.
• View the source, sub-source, last updated source and last updated sub-source of the reservation.
• If you have the Workplace Space Management application installed, you can specify if a cost center/department check is required to reserve the workplace item.
• Create archiving rules. Select from archive rules provided by ServiceNow®.
• Configure the views of the reservable module such as Map view or Schedule view.
• Specify the search limit on a module.

Add a workplace space for reservation

Add different types of workplace spaces like a workspace, desk, or similar spaces for employees to reserve.

Before you begin

• Ensure that you have the following details:
  ◦ Workplace data for your organization
  ◦ Data of workspaces that can be marked as available

For more information about adding the workspaces, see Create records for your workplace data.
Important: In the Workplace Service Delivery Suite, from Workplace Safety Management version 2.5.3, the *Space type (space_type)* choice field is depreciated. After the upgrade, Space types are configured in the *Space Type Configuration*. The *Space type (space_type)* field is migrated as *Space type (location_type)* field in the Space table [sn_wsd_core_space]. Customers having customization on the depreciated *Space type (space_type)* field are advised to manually migrate their flow to use the new *Space type (location_type)* field. A new fix script, *Populate Location Type from Space Type*, is introduced to execute the schedule job, *Populate location_type from space_type*, on the Space table [sn_wsd_core_space] to migrate the depreciated *Space type (space_type)* field value to the new *Space type (location_type)* field.

Role required: sn_wsd_core.admin

**Procedure**

1. Navigate to All > Workplace Reservation Management > Administration > Workplace spaces.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the space.</td>
</tr>
<tr>
<td>Space type</td>
<td>Type of the office space.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Specify the maximum capacity of the space for reservation.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this option to make the space active for reservation.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Select this option to make the space reservable for employee use.</td>
</tr>
<tr>
<td>Requires check-in</td>
<td>Select this option if the reservation made on this space requires a check-in.</td>
</tr>
</tbody>
</table>

**Organization details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Office region where the room is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Site location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus from which the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building where the space is located.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor on which the space is located.</td>
</tr>
<tr>
<td>Area</td>
<td>Area on the floor where the space is located.</td>
</tr>
</tbody>
</table>

**Extra information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed by</td>
<td>The workplace manager of the group that manages the reservation for the floor plan.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon to view a list of group managers you can select.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Managed by group</td>
<td>The group that manages the reservation for the floor plan. Click the lookup using list icon to view a list of groups you can select.</td>
</tr>
<tr>
<td>Reservable quantity</td>
<td>If there are multiple spaces of the same type, specify the quantity. Employees can reserve the space up to the specified quantity. The quantity is used when assigning neighborhood spaces to an area.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description about the space.</td>
</tr>
<tr>
<td>Image</td>
<td>Upload an image of the space. The supported ratio of an image is: 26:17.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Results**
The space is added and is available for reservation.

**Add a workplace room for reservation**
Add a workplace room for employees to reserve.

**Before you begin**
- Ensure that you have the following details:
  - Workplace data for your organization
  - Data of workspaces that can be marked as available

For more information about adding the workspaces, see Create records for your workplace data.

Role required: sn_wsd_core.admin

**Procedure**

1. Navigate to **All > Workplace Reservation Management > Administration > Workplace Rooms**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the room</td>
</tr>
<tr>
<td>Capacity</td>
<td>Specify the maximum capacity of the room for reservation.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address of the room to make a reservation request. The email address is used to check availability of the room and to block its calendar for a reservation. If you have installed Workplace Calendar Synchronization application, ensure that the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>email address is same as the one set in the calendar provider. Later, as an admin, you can change the email address of the room. The changes are automatically applied in the Reservable Sync Configuration. The calendar provider synchronizes the resources based on the entered email.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Select this option to make the room active for reservation.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Select this option to make the room reservable for employee use.</td>
</tr>
<tr>
<td>Requires check-in</td>
<td>Select this option if the reservation made on this room requires a check-in.</td>
</tr>
<tr>
<td><strong>Organization details</strong></td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td>Office region where the room is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Site location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus from which the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building where the room is located.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor on which the room is located.</td>
</tr>
<tr>
<td>Area</td>
<td>Area on the floor where the room is located.</td>
</tr>
<tr>
<td><strong>Extra information</strong></td>
<td></td>
</tr>
<tr>
<td>Managed by</td>
<td>The workplace manager of the group that manages the reservation for the floor plan.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>The group that manages the reservation for the floor plan.</td>
</tr>
<tr>
<td>Reservable quantity</td>
<td>If there are multiple rooms of the same type, specify the quantity. Employees can reserve the room up to the specified quantity. The quantity is used when assigning neighborhood spaces to an area.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description about the room.</td>
</tr>
<tr>
<td>Image</td>
<td>Upload an image of the room. The supported ratio of an image is: 26:17.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The room is added and is available for reservation in the application.
Configure a reservable module
Create a reservable module to add a group of similar reservable workplace items. These workplace items are displayed in a single category on the Reservation portal.

Before you begin
Ensure that you have the following details:

• Workplace data for your organization.
• Data of workspaces that can be marked as available.
• To configure approvers/performer criteria, refer to .

Refer to Create records for your workplace data to add workplace data.
Role required: sn_wsd_rsv.admin

About this task
A Reservable module groups similar types of workplace items. Employees can view these similar items in one category. For example, a Room is a reservable module and it contains similar workplace items like meeting rooms, conference rooms, and other rooms.

Procedure
1. Navigate to All > Workplace Reservation Management > Administration > Reservable Module.
2. Click New.
3. On the form, fill in the fields.

Reservable module form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the reservable module. For example, for meeting rooms, the name should be categorical like meeting rooms or rooms.</td>
</tr>
<tr>
<td>title</td>
<td>Title for the reservable module. The title is displayed inline with a descriptive text on the Workplace Service Portal.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the module available for reservation.</td>
</tr>
<tr>
<td>Active from</td>
<td>Date from when the reservable module must be active and available for reservation.</td>
</tr>
<tr>
<td>Image</td>
<td>Image of the reservable module.</td>
</tr>
</tbody>
</table>

Reservable Table Configuration

<table>
<thead>
<tr>
<th>Selection type</th>
<th>Type of selection to display in the search results. Select one of the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specific unit</td>
<td>The search result displays every workplace item.</td>
</tr>
<tr>
<td>Container</td>
<td>The search result displays the parent or container of the workplace items.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reservable type</td>
<td>Type of the reservable item.</td>
</tr>
<tr>
<td>Reservable table</td>
<td>Table that contains the reservable workplace items.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you selected <strong>Location</strong> for the <strong>Reservable type</strong> field, then use only the Space [sn_wsd_core_space] table and its extended tables.</td>
</tr>
<tr>
<td>Reservable filter</td>
<td>Filter conditions on the reservable items in the Reservable table. The reservable items are displayed on the application based on the given conditions. You can do the following:</td>
</tr>
<tr>
<td></td>
<td>• To add a condition, select <strong>Add Filter Condition</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To add an OR condition, select <strong>Add &quot;OR&quot; Clause</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are adding a filter on a location, ensure that the <strong>Active</strong> and <strong>Is reservable</strong> fields are set to <strong>True</strong>. If you do not, then inactive items that are not reservable will be displayed as reservable.</td>
</tr>
<tr>
<td>Area (Container) selection</td>
<td></td>
</tr>
<tr>
<td>Reservable container field</td>
<td>Level of the container. The field is automatically set to <strong>Area</strong>.</td>
</tr>
<tr>
<td>Reservable quantity field</td>
<td>Reservable quantity of all the spaces. The quantity is used when assigning neighborhood spaces to an area.</td>
</tr>
<tr>
<td><strong>Reservable Module Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>Short description about the module.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description about the module and the reservable items.</td>
</tr>
<tr>
<td>Require cost center / department check</td>
<td>Option to check if there is a cost center or department mismatch between the workspace item and the logged in user. This option appears only if you have Workplace Space Management installed.</td>
</tr>
<tr>
<td>Requires Approval</td>
<td>Option to make approval required before making a reservation.</td>
</tr>
<tr>
<td>Apply to shift</td>
<td>Option to enable shift-based reservation on the module.</td>
</tr>
<tr>
<td>Override check-in policy</td>
<td>Option to specify how to implement the reservation check-in policy. Choices are as follows:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• <strong>No override</strong>: The check-in policy is implemented as set in the <strong>Requires check-in</strong> field of a workplace space or room.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Always require check-in</strong>: The check-in policy is required regardless of what is set in the <strong>Requires check-in</strong> field of a workplace space or room.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Never require check-in</strong>: The check-in policy is removed irrespective of what is set in the <strong>Requires check-in</strong> field of a workplace space or room.</td>
<td></td>
</tr>
<tr>
<td>Cancel reservations exceeding check-in time</td>
<td>Option to cancel a reservation if an employee does not check in within the specified time.</td>
</tr>
<tr>
<td>Allow whole day reservation</td>
<td>Option to enable employees to reserve a workplace item of the module for an entire day.</td>
</tr>
<tr>
<td>Max days in future</td>
<td>Maximum number of the days in the future up to which the reservable module can be reserved. For example, if you set the number of days to 10, then employees can make future reservation on this module only up to 10 days in advance.</td>
</tr>
<tr>
<td>Min duration</td>
<td>Minimum reservation duration of the reservable module.</td>
</tr>
<tr>
<td>Max duration</td>
<td>Maximum reservation duration of the reservable module.</td>
</tr>
<tr>
<td><strong>Reservation Widget Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Requires subject</td>
<td>Option to make a reservation subject required before making a reservation.</td>
</tr>
<tr>
<td>Require cancel notes</td>
<td>Option to make a cancellation note required before making a cancellation.</td>
</tr>
<tr>
<td>Display number of attendees</td>
<td>Option to enable employees to specify the number of attendees while making a reservation. If the option is not selected, then the number of attendees is automatically set to 1.</td>
</tr>
<tr>
<td>Display on behalf of</td>
<td>Option to enable employees to specify on whose behalf they are making a reservation.</td>
</tr>
</tbody>
</table>
| Display sensitivity                            | Option to enable employees to set the sensitivity of the reservation. They can set a reservation to **Normal** or **Private**. If the option is not selected, the sensitivity is set
4. Click **Submit**.

**Results**
The reservable module is added to the application. The reservable items are available to employees based on the filter conditions.

**Configure a reservable module to add neighborhood spaces**
Create a reservable module to group neighborhood spaces for an area. Enable employees to reserve a neighborhood space of an area.

**Before you begin**
- Ensure that you have the following details.
  - Workplace data for your organization
  - Data of workspaces that can be marked as available
- Create the records in the following order.
  1. Regions
  2. Sites
  3. Campuses
  4. Buildings
  5. Floors
  6. Areas
  7. Spaces

Role required: sn_wsd_rsv.admin

**About this task**
An employee can view all the neighborhood spaces of an area in a single module.

**Procedure**
1. Navigate to **Workplace Reservation Management > Administration > Reservable Module**.
2. Click **New**.
3. On the form, fill in the fields.
   For more detailed information about each field, refer here: Configure a reservable module

### Reservable module form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the reservable module. For example, as the module is to display all the neighborhood spaces of an area, the name should be categorical like 'Desks within an area'.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the reservable module</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the module available for reservation.</td>
</tr>
<tr>
<td>Active from</td>
<td>Date from when the reservable module must be active and available for reservation.</td>
</tr>
<tr>
<td><strong>Reservable Table Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Selection type</td>
<td>Select <strong>Container</strong>.</td>
</tr>
<tr>
<td>Reservable type</td>
<td>Select <strong>Location</strong>.</td>
</tr>
<tr>
<td>Reservable table</td>
<td>Select the <strong>Space [sn_wsd_core_space]</strong> table.</td>
</tr>
<tr>
<td>Reservable quantity field</td>
<td>Select <strong>Reservable quantity</strong>.</td>
</tr>
<tr>
<td>Reservable filter</td>
<td>Filter conditions on the reservable items in the Reservable table. The application displays the reservable items based on the given conditions.</td>
</tr>
<tr>
<td></td>
<td>• To add a condition, select <strong>Add Filter Condition</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To add an OR condition, select <strong>Add &quot;OR&quot; Clause</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you are adding a filter on a location, ensure that the <strong>Active</strong> and <strong>Is reservable</strong> fields are set to <strong>True</strong>. If you do not, the application displays all the inactive items that are not reservable as reservable.</td>
</tr>
<tr>
<td><strong>Container selection, reservable quantity settings</strong></td>
<td></td>
</tr>
<tr>
<td>Reservable container field</td>
<td>Select <strong>Area</strong>.</td>
</tr>
<tr>
<td><strong>Reservable Module Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>Short description about the module.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description about the module and the reservable items.</td>
</tr>
<tr>
<td>Override check-in policy</td>
<td>Option to specify how to implement the reservation check-in policy.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No override</strong>: The check-in policy is implemented as set in the <strong>Requires check-in</strong> field of a workplace space or room.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always require check-in</strong>: The check-in policy is required irrespective of what is set in the <strong>Requires check-in</strong> field of a workplace space or room.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Never require check-in</td>
<td>The check-in policy is removed irrespective of what is set in the Requires check-in field of a workplace space or room.</td>
</tr>
<tr>
<td>Requires Approval</td>
<td>Option to make approval required before making a reservation.</td>
</tr>
<tr>
<td>Requires subject</td>
<td>Option to make a reservation subject required before making a reservation.</td>
</tr>
<tr>
<td>Require cancel notes</td>
<td>Option to make a cancellation note required before making a cancellation.</td>
</tr>
<tr>
<td>Apply to shift</td>
<td>Option to enable shift-based reservation on the module.</td>
</tr>
<tr>
<td>Max days in future</td>
<td>The maximum number of the days in the future up to when an employee can make a reservation. For example, if you set the number of days to 10, employees can make future reservation on this module only up to 10 days in advance.</td>
</tr>
<tr>
<td>Min duration</td>
<td>Minimum reservation duration of the reservable module.</td>
</tr>
<tr>
<td>Max duration</td>
<td>Maximum reservation duration of the reservable module.</td>
</tr>
<tr>
<td>Allow whole day reservation</td>
<td>Option to enable employees to reserve a workplace item of the module for an entire day.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The reservable is added to the application. On the Reservation portal, employees can view the neighborhood spaces of an area in this module.

Enable shift-based reservation
As an admin, enable employees to reserve a workplace item for a shift. Configure the spaces that can be reserved for a shift. Specify the users who can make shift-based reservation.

Before you begin
To enable shift-based reservation, select the Apply to shift field on the reservable module form of the workplace item.

Ensure you have the following information:
- Appropriate shift schedules.
- Data of the employees who would operate from the office in this shift.
- Data of the workplace spaces to be made available for this shift.

Ensure that the Building field on the Shift form has a value.
Role required: sn_wsd_core.workplace_manager
Procedure

1. Navigate to Workplace Safety Management > Shift Management > All.

2. Select the shift to which you want to assign spaces and users.

3. To assign users to the shift, scroll down and click Edit... in the Users related list. Only the assigned users can make reservations for this shift on the Reservation portal.

4. On the Edit members form, add users to the shift by doing the following.
   a. Select the users from the Collection column on the left.
   b. To move the selection to the Users List column on the right, use the add-remove icon (\(\text{\textgreater}\)).
   c. Click Save.

5. To assign spaces to the shift, scroll down and click Edit... in the Locations related list. Only the assigned spaces are displayed for shift-based reservation on the Reservation portal.

6. On the Edit members form, add spaces to the shift by doing the following.
   a. Select the spaces from the Collection column on the left.
   b. To move the selection to the Locations List column on the right, use the add-remove icon (\(\text{\textless}\)).
   c. Click Save.

7. Click Update.

Results
The users and spaces are assigned to the shift. When an employee wants to make a shift reservation, the Reservation portal displays the following information:

• The shifts for which the employee can make a reservation.
• The spaces that are available for reservation in the selected shift.

Assign neighborhood spaces to an area
Add spaces to an area to make them available for reservation. On the Reservation portal, when an employee searches for an area, all the available spaces that are assigned to that area are displayed.

Before you begin
Ensure that the area to which you are assigning neighborhood spaces is configured in the application.

1. Navigate to Workplace Safety Management > Space Administration > Areas.

2. Check that the area is configured.

Ensure that the spaces are assigned to the area.

1. Navigate to Workplace Safety Management > Space Administration > Spaces and select the space.

2. On the form, ensure that the Area field has a value.

For more information, see Providing your workplace data.
Role required: sn_wsd_core.workplace_manager or sn_wsd_rsv.admin
**About this task**
Assign desks or spaces that belong to an area. When an employee searches for an area to make a reservation, all the available spaces or desks that belong to that area are displayed. You can add spaces individually or in bulk. For example, you can add spaces individually like C1 and C2, or you can add one space C with a quantity of 100.

**Procedure**
1. Navigate to **Workplace Safety Management** > **Space Administration** > **Spaces**.
2. Select the space that you want to assign to the area.
3. Open the form in the Workplace view.
   a. On the top-left corner of the form, right-click the additional actions icon (≡).
   b. In the list, select **View** > **Workplace**.
4. On the Space form, in the **Organization details** tab, select the area in the **Area** field.
5. **Optional:** To add a bulk quantity of this space, specify a quantity in **Reservable quantity** field in the **Extra information** tab.
6. Click **Update**.

**Results**
The space is added to the area. On the Reservation portal, the following actions are performed:

- When an employee searches for the area, the assigned space is displayed.
- If you have added bulk quantity for a space, the space is displayed with a maximum capacity in the card view. When an employee makes a reservation for this space, the capacity is deducted. The space is again displayed with the available capacity for the next reservation until the maximum capacity is 0.

**What to do next**
To view the spaces assigned to an area, navigate to **Workplace Safety Management** > **Space Administration** > **Areas** and select an area. The assigned spaces are displayed in the Spaces related list.

**Create a standard service**
Create a Standard service to make it available to employees by default when they make a reservation.

**Before you begin**
Role required: sn_wsd_rsv.admin

**About this task**
A Standard service is a basic provision available with a reservable workplace item when a reservation is made. For example, white board, additional monitor, and similar other standard services.

**Procedure**
1. Navigate to **Workplace Reservation Management** > **Administration** > **Standard Services**.
2. Click **New**.
3. On the form, fill in the fields.
Standard services form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the standard service</td>
</tr>
<tr>
<td>Active</td>
<td>Select active to make it available in reservations.</td>
</tr>
</tbody>
</table>

**Service Configuration**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Enter a short description about the service.</td>
</tr>
<tr>
<td>Font awesome icon</td>
<td>A font awesome icon in the ‘fa-(name)’ format. Currently, the <strong>Font Awesome</strong> library of version 4.7 is supported.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The standard service is added to the application.

**What to do next**
Add the standard service to a workplace room or space. For more information, see **Add a standard service to workplace**.

**Add a standard service to workplace**
Add a standard service to a workplace space or room based on where it is made available.

**Before you begin**
Create a standard service
Role required: sn_wsd_rsv.admin

**Procedure**
1. Navigate to **Workplace Reservation Management > Administration**.
2. Based on where you are adding the standard service, make the following selection:
   - To add the service to a workplace space, select **Workplace Spaces**.
   - To add the service to a workplace room, select **Workplace Rooms**.
3. Select the Workplace Space/Room where you want to add the standard service.
4. On the form, scroll down and click **Edit...** in the **Standard Services** section.
5. On the Edit Members form, select the service.
   a. Select the standard service from the **Collection** column on the left.
   b. Move the selection to the **Standard Services List** column on the right.
      Use the Add-remove icon to move the services.
6. Click **Save**.

**Results**
The Standard service is added to the selected workplace space or room.
Create a flexible service

Create a flexible service and provide it as an extra service to employees. Employees can use the flexible service and other basic standard services when they make a reservation.

Before you begin
Role required: sn_wsd_rsv.admin

Procedure
1. Navigate to Workplace Reservation Management > Administration > Flexible Services.
2. Click New.
3. On the form, fill in the fields.

Flexible Services form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the flexible service.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description about the service.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the flexible service. To add a new category, do the following:</td>
</tr>
<tr>
<td></td>
<td>a. Right-click Category and select Configure choices.</td>
</tr>
<tr>
<td></td>
<td>b. On the Configure Category Choices form, in the Enter a new item field, enter the name of the category that you want to add.</td>
</tr>
<tr>
<td></td>
<td>c. Click Add.</td>
</tr>
<tr>
<td>Sub Category</td>
<td>Subcategory of the selected category of the flexible service. You can also add a subcategory by following the same steps as when adding a category.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the flexible service.</td>
</tr>
<tr>
<td>Image</td>
<td>Image of the flexible service.</td>
</tr>
</tbody>
</table>

Service Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation duration</td>
<td>Time required to prepare the flexible service. For example, if the flexible service is a catering service, then specify the time that is required to prepare the items. The workplace location will be blocked for the specified duration to prepare before the reservation starts. Enable the [sn_wsd_rsv.is_blocker_mandatory] system property to create a blocker reservation.</td>
</tr>
<tr>
<td>Cleanup duration</td>
<td>Time required to clean up the items that are provided in the flexible service. The workplace location will be blocked for the specified duration to clean up after the reservation ends. Enable the</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_wsd_rsv.is_blocker_mandatory] system property to create a blocker reservation.</td>
<td></td>
</tr>
<tr>
<td>Quantity enabled</td>
<td>Maximum quantity of items that are available to reserve.</td>
</tr>
<tr>
<td>Price per unit</td>
<td>Pricing of the flexible service.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The flexible service is added to the application.

**What to do next**
Add the flexible service to a workplace space or room, so that the service is available to employees when they make a reservation. For more information, see **Add a flexible service to workplace item**.

**Add a flexible service to workplace item**
Enable employees to request for extra services. Add an extra service to a workplace space or room, and make the service available to employees when they make a reservation.

**Before you begin**
Make sure you have already created a flexible service. See **Create a flexible service**.
Role required: sn_wsd_rsv.admin

**About this task**
Configure flexible services and add them to a workplace space or room. When an employee makes a reservation for the workplace space or room, they can use the flexible services as extra services.

**Procedure**
1. Navigate to **Workplace Reservation Management > Administration**.
2. Based on where you are adding the flexible service, do one of the following.
   - To add the service to a workplace space, select **Workplace Spaces**.
   - To add the service to a workplace room, select **Workplace Rooms**.
3. Select the workplace space room where you want to add the flexible service.
4. On the form, scroll down and click **Edit...** in the Flexible Services related list.
5. On the Edit Members form, select the service.
   - From the **Collection** column on the left, select the flexible service.
   - To move the service to the **Flexible Services List** column on the right, use the add-remove icon (\(\to\) / \(\leftarrow\)).
6. Click **Save**.

**Results**
The flexible service is added to the selected workplace space or room.
Create a user criteria record
Add a user criteria record to decide which users, roles, and groups can access a reservable module.

Before you begin
Role required: sn_wsd_rsv.admin

Procedure
1. Navigate to Workplace Reservation Management > Administration > User Criteria.
2. Click New.
3. On the form, fill in the fields.

User criteria form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user criteria.</td>
</tr>
<tr>
<td>Users</td>
<td>Users who can access the reservable modules when you apply the user criteria. Click the unlock users icon (🔒) to select users. Click the add me icon (👤) to add yourself as a user.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups who can access the reservable modules when you apply the user criteria. Click the unlock groups icon (🔒) to select the groups.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles who can access the reservable modules when you apply the user criteria. Click the unlock roles icon (🔒) to select the groups.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Option to create a script for the user criteria.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is automatically set to Workplace Reservation Management.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the user criteria available.</td>
</tr>
<tr>
<td>Companies</td>
<td>Companies who can access the reservable modules when you apply the user criteria. Click the unlock companies icon (🔒) to select the companies.</td>
</tr>
<tr>
<td>Location</td>
<td>Locations which can access reservable modules when you apply the user criteria. Click the unlock locations icon (🔒) to select the locations.</td>
</tr>
<tr>
<td>Departments</td>
<td>Departments who can access reservable modules when you apply the user criteria. Click the unlock departments icon (🔒) to select the departments.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match All</td>
<td>Option to make every condition required when the user criteria is applied. The conditions are set in the previous fields, such as Location, Department, and so on</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The user criteria is added to the application.

**What to do next**
Apply user criteria on a reservable module

**Apply user criteria on a reservable module**
Apply a user criteria to give permission for employees and groups to view and make reservations on a reservable module.

**Before you begin**
Role required: sn_wsd_rsv.admin

**About this task**
When a user criteria is applied, the availability of the reservable items in the reservable module will be displayed only to the specified users.

**Procedure**

1. Navigate to Workplace Reservation Management > Administration > Reservable Module.
2. Select the reservable module that you want to apply the user criteria on.
3. In the User criteria's related list, click **Edit**....
4. On the Edit members form, set the filter option **Active** to **True**.
5. Select the user criteria by doing the following:
   
   a. Select the user criteria from the Collection column on the left.
   
   b. Move the selection to the User Criteria's List column on the right.
      
      Use the Add/remove icon (>) to move the user criteria.
   
   c. Click **Save**.
6. Click **Save**.

**Results**
The selected user criteria is applied on the reservable module.

**View or update reservations**
View or update reservation requests submitted through the Reservation portal. You can view the current day's reservations and the ones made by you for the others.

**Before you begin**
Role required: sn_wsd_rsv.admin or sn_wsd_rsv.manager
About this task
You can view all the reservations made through the application and update accordingly. Check the current state, synchronization state and the check-in state of a reservation. View the source, sub-source, last updated source and last updated sub-source of the reservation.

ℹ️ Note: You can also view and edit reservations on the Reservation portal.

Procedure
1. Navigate to Workplace Reservation Management > Reservation Overview.
2. Select any of the following options to view reservations:
   • My Reservations: Select this option to view the reservations that you created.
   • All Reservations: Select this option to view all the reservations made through the application.
   • Today’s Reservations: Select this option to view the current day’s reservations.
3. Select a reservation request to view its details.
4. Optional: Review the reservation details in the Reservation Details and Cancel Details tabs.
   ℹ️ Note: The Cancel Details is populated only when the submitter cancels the reservation request.
5. Optional: Click Open Reservation to view the reservation details in the portal.
6. Optional: If you want to update the reservation information, modify the information and then click Update.

Configure a reservable purpose
Create a purpose that describes the use of a workplace item. Add this purpose to a relevant workplace space or room so that the purpose is displayed on the reservation portal.

Before you begin
Role required: sn_wsd_rsv.manager

Procedure
1. Navigate to Workplace Reservation Management > Administration > Reservable Purposes.
2. Click New.
3. On the form, fill in the fields.

Reservable Purpose form

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the purpose.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the reservable purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description with details on the purpose of the reservable item. The description is not displayed to the employees.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The reservable purpose is added.
What to do next
Add a reservable purpose to a workplace item.

Add a reservable purpose to a workplace item
Define the purpose of a workplace item by adding a reservable purpose. The purpose is displayed in the details of the workplace item so that employees can select the appropriate item.

Before you begin
Role required: sn_wsd_rsv.manager

Procedure
1. Navigate to Workplace Reservation Management > Administration.

2. Based on the type of workplace item that you want to add a reservable purpose to, do one of the following.

<table>
<thead>
<tr>
<th>Workplace item</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace space</td>
<td>a. Click Workplace Spaces.</td>
</tr>
<tr>
<td></td>
<td>b. Select the space that you are adding the</td>
</tr>
<tr>
<td></td>
<td>purpose to.</td>
</tr>
<tr>
<td>Workplace room</td>
<td>a. Click Workplace Rooms.</td>
</tr>
<tr>
<td></td>
<td>b. Select the room that you are adding the</td>
</tr>
<tr>
<td></td>
<td>purpose to.</td>
</tr>
</tbody>
</table>

3. In the Reservable Purposes related list, click Edit.

4. On the Edit Members form, select the reservable purpose.

   a. Select the reservable purpose from the Collection column on the left.

   b. Move the selection to the Reservable Purposes List column on the right.

   To move the purposes, use the add-remove icon ( ).

5. Click Save.

Results
The reservable purpose is added to the workplace item.

Apply an archiving rule
Archive reservations that are created in the application. Apply an archiving rule to archive the reservation automatically.

Before you begin
Role required: admin

Procedure
1. Navigate to Workplace Reservation Management > Administration

2. Select Archiving rules.

3. Select any of the following archiving rules:
• **Archive 6 month old reservation**: Select this archive rule to archive all the reservations that are older than six months. The rule is inactive by default.

• **Archive 6 month old extra services**: Select this archive rule to archive all the extra services that are older than six months. The rule is inactive by default.

**Note:** If you want to create an archiving rule, see Create an archive rule.

4. To enable the archive rule, select the **Active** option.

5. Click **Update**.

**Results**
The selected archive rule is applied.

**Reservation Portal**
The Reservation Portal is your central location for reserving workplace items, such as meeting rooms and desks. You can also view and manage your reservations. Once a reservation request is confirmed, you are notified about the reservation details.

You can reserve a workplace item for any period between 00:00 to 23:59 (midnight to 11:59 p.m.) of the same day. For example, you can make a reservation until anytime before 23:59. If the reservation continues to another day, you must create a separate reservation.

You can access the Reservation portal from the Workplace Reservation Management application and the Workplace Service Portal. The Reservation Portal enables you to do the following:

• View workplace items such as meeting rooms and desks for your location or for a different location.

• View the availability of a meeting room or desk before making a reservation request.

• Check for any standard services that are available with workplace items, such as whiteboards, seating capacity, and projector.

• Reserve a workplace item for yourself or on behalf of someone else.

• View the details of reservations that you have created.

• Modify or cancel reservations that you have created.

You can also use the Virtual agent chat support on the Workplace Service Portal to make a reservation and view your reservation details. The chat support enables you to do the following:

• Create a reservation for a location.

• View reservations that you created on the current day.

• See when your reservation will start or happen.

• Cancel a reservation.

**Recurring reservations**
When you reserve a workplace item for a recurring event, the reservation gets repeated for every applicable working day of the specified period. You determine the applicable days when you create the request. The reservation that you initially created acts as the parent reservation record.

If a reservation occurrence conflicts with an existing reservation on some day, the reservation occurrence for that day is not confirmed and the status changes to Conflicting. In such
cases, you can modify that conflicting reservation by selecting a different workplace item or by changing the time of the reservation.

For example, say you reserved a for a meeting that occurs every Wednesday for a month. Four reservation records are created for each occurrence. But if another employee Jane Doe reserved that same room for the same time as one of your recurring reservations, then your reservation occurrence will conflict with Jane Doe’s reservation. In such a case, you can modify your reservation for that day by selecting a different meeting room or time.

**Reservation states**

Once you make a reservation, the state of the reservation changes to Confirmed.

If the reservation requires approvals, its status changes depending on what your approver does. You receive email notifications of these changes. The possible changes are the following:

- If your approver has not taken action on your reservation, the state of the request stays Awaiting approval.
- If your approver approves your reservation and the availability is confirmed, the state of the reservation changes to Confirmed.
- If your approver rejects your reservation, the state of the reservation changes to Rejected.
- If your approver approves your reservation but the workplace item is not available for the selected date and time, the state of the reservation changes to Conflicted.
- If you are reserving a workplace item for recurring days, the reservation gets confirmed for the days and times when the item is available. For the remaining days and time, the state of the reservation stays Conflicted.

You can modify your reservation and follow up with your approver to resolve your conflicting reservation.

- If you cancel your reservation, the state of the reservation changes to Cancelled.

**Create a reservation**

Reserve a workplace item such as a room for a single or recurring meeting.

**Before you begin**

Role required: sn_wsd_core.workplace_user

**About this task**

Reserve a workplace item for a period less than or equal to 24 hours of that day. The start and end times should be on the same day.

You can reserve an item for yourself or on behalf of someone else.

Before booking a room or desk, you can also check the availability of the selected item using the Schedule view. Review the standard services available with the item. For more information, see Standard services.

If you have Workplace Space Management application installed, the search results appear as follows:

- If a cost center/department check is enabled, only those workspaces/desks are displayed that have the same cost center/department as their user profile’s location.
- Only workspaces/desks that are assigned as flexible or none are displayed. The search will not display permanent workspaces/desks.

You can also make a reservation using the virtual agent chat support.

2. On the bottom right, select the chat icon (💬).

3. To make a reservation, type your question or select Show Me Everything to select from a list of available options.

**Procedure**

1. Navigate to the Make a Reservation page from any of the following starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note: You can also raise a request from the Employee Center. On the home page, navigate to Workplace &gt; Browse all Workplace and select the workplace service.</td>
</tr>
<tr>
<td></td>
<td>b. Open the reservation portal and do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Click Reservations &gt; Make a reservation.</td>
</tr>
<tr>
<td></td>
<td>• Select Make a reservation on the homepage directly.</td>
</tr>
<tr>
<td></td>
<td>• Select New general reservation from the Workplace services catalog.</td>
</tr>
<tr>
<td></td>
<td>i. Select Catalog &gt; Browse by categories &gt; Workplace Services Catalog.</td>
</tr>
<tr>
<td></td>
<td>Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog.</td>
</tr>
<tr>
<td></td>
<td>ii. Select Reservation Management &gt; New general reservation.</td>
</tr>
</tbody>
</table>

The Make a Reservation page opens in a new tab.

2. Click Search.

The workplace items which match the search criteria and which are available for reservation are displayed.

Note: You can switch between the Card view tab and Schedule view tab to review the availability of workplace items. If your company uploads floor maps like Mappedin, the Map view tab also appears. DXF maps are not supported.
3. **Optional:** Sort the workplace items in alphabetical order or by using a filter with the **Show filter** option.

4. Select the workplace item that you want to reserve using any of the following options:
   - Click **Reserve now**.
   - If you have selected the **Schedule view** tab, click **Reserve**.
   - In **Map view**, select any space that is colored green and then select **Reserve**.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation subject</td>
<td>Subject of your meeting.</td>
</tr>
<tr>
<td>Only organizer can view the reservation</td>
<td>Option to set the reservation as private. If you select this option, the Reservation subject becomes hidden for other people and is displayed as <strong>private</strong>. Only you or the person for whom you have requested this meeting for can see the subject.</td>
</tr>
<tr>
<td>On behalf of</td>
<td>If you are requesting a reservation on someone else’s behalf, select the name of that person. Leave this field empty if you are requesting a reservation for yourself.</td>
</tr>
<tr>
<td>Number of attendees</td>
<td>Number of people that will attend the meeting.</td>
</tr>
<tr>
<td>Add extra services</td>
<td>Extra services available with the reservation.</td>
</tr>
</tbody>
</table>

6. Click **Submit reservation**.

**Results**

If the item does not require any approval, the selected workplace item is reserved. The reservation details are displayed on the Reservation summary page. The status of the request is updated to Confirmed.

If you requested reservation for an item that requires approval, then your request is submitted to the approver. The status of the request is updated to Awaiting approval.

**What to do next**

Review your reservation details on the Reservation summary details page.

- To edit or cancel your reservations, see **Share, modify or cancel a reservation**.
- To download an iCalendar, see [ ].

If the workplace item that you have reserved requires check-in and check-out, you must check in within 30 minutes before the reservation start time and check out within 30 minutes after the reservation end time.

- To check in the reservation, go to **My reservations** and open your reservation. On the reservation details page, click **Check in**.

**Note:** If the reservation is not checked in within 30 minutes before the reservation start time, then the reservation is cancelled. You will receive an email about the cancellation.
To check out the reservation, go to My reservations and open your reservation. On the reservation details page, click Check out.

**Note:** If the reservation is not checked out within 30 minutes after the reservation end time, you will receive an email reminder to check out the reservation.

### Standard services

Standard services are amenities or basic services that are available with a workplace item by default with their reservation. You can review the standard services associated with a workplace item at the time of creating a reservation request.

Standard service is like a basic provision available to employees which they can use in their reservation without having to request separately. For example, when an employee reserves a meeting room, services like telephone, computer, plugs, video call items are considered as standard services unless until the company makes it a requested service.

Employees can see details of the available standard services with each workplace item that an employee can reserve in the Workplace Reservation Management. The standard services are also displayed as icons in the card view of workplace items when you search for an item. For example, the following image shows standard services available with a meeting room:

![Standard services image]

### Flexible services

A Flexible service is an extra service provided to employees along with their reservation. The application allows you to configure any type of extra service to provide with a workplace item reservation.

Other than the basic standard services available when a workplace item is reserved, you can also include extra services like catering, IT support, furniture and others. Employees can see details of all the flexible services available with each workplace item that an employee can reserve in the Workplace Reservation Management. The flexible services are displayed as an optional extra service in the reservation form of a workplace item.

### Create reservation for multiple workplace items

Reserve multiple workplace items for the same date and time in a single reservation.

**Before you begin**

Role required: sn_wsd_core.workplace_user

**About this task**

Reserve multiple workplace items at the same time, either for yourself or on behalf of others.
Before booking a room or desk, check the availability of the selected item using the Schedule view. Review the standard services that are available with the workplace items.

**Procedure**

1. Navigate to the Make a Reservation page from any of the following starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>Navigate to <strong>Workplace Reservation Management &gt; Portal &gt; New Reservation.</strong></td>
</tr>
<tr>
<td>From Workplace Service Portal</td>
<td>a. Navigate to <strong>Workplace Safety Management &gt; Workplace service portal &gt; Workplace Service Portal Home.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also raise a request from the Employee Center. On the home page, navigate to <strong>Workplace &gt; Browse all Workplace</strong> and select the workplace service.</td>
</tr>
<tr>
<td></td>
<td>b. Open the reservation portal and do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Reservations &gt; Make a reservation.</strong></td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Make a reservation</strong> on the homepage directly.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>New general reservation</strong> from the Workplace services catalog.</td>
</tr>
<tr>
<td></td>
<td>i. Select <strong>Catalog &gt; Browse by categories &gt; Workplace Services Catalog.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If there are multiple catalogs configured on the portal, go to the Catalogs list and select <strong>Workplace Services Catalog.</strong></td>
</tr>
<tr>
<td></td>
<td>ii. Select <strong>Reservation Management &gt; New general reservation.</strong></td>
</tr>
</tbody>
</table>

The Make a Reservation page opens in a new tab.

2. Click **Search.**

   The available workplace items which match the search criteria appear.

   **Note:** You can switch between **Card view** tab and **Schedule view** tab to review the availability of workplace items. If your company uploads floor maps like Mappedin, **Map view** tab appears.

3. (Optional) Sort the workplace items in alphabetical order or by using a filter with the **Show filter** option.

4. Select the workplace items that you want to reserve. In the **Map view** tab, check the circle at the top, right corner of each reservation box.

5. Select **Next.**
6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation subject</td>
<td>Subject of your meeting.</td>
</tr>
<tr>
<td>Reserve these items together for the same person</td>
<td>Select this option to reserve all the workplaces for the same user.</td>
</tr>
<tr>
<td>On behalf of</td>
<td>If you are requesting a reservation on behalf of someone else, select the name of the person. Leave this field empty if you are requesting a reservation for yourself.</td>
</tr>
<tr>
<td>Number of attendees</td>
<td>Number of people expected to attend the meeting.</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>Nature of your meeting. Select <strong>Private</strong> if you want to hold a confidential meeting.</td>
</tr>
</tbody>
</table>

**Note:** When you mark a meeting as **Private**, the Reservation subject becomes hidden for other people and is displayed as **private**. Only you or the person for whom you have requested this meeting can see the subject.

7. Click **Submit reservation**.

**Results**
If the items do not require any approval, the selected workplace items are reserved. The status of the request is updated to Confirmed.

If any of the items needs approval, then your request is submitted to the approver. The status of the request is updated to Awaiting approval.

**What to do next**
Review your reservation details. To edit or cancel your reservations, see Share, modify or cancel a reservation.
If the workplace item that you have reserved requires check-in and check-out, you must check in within 30 minutes before the reservation start time and check out within 30 minutes after the reservation end time.
• To check in the reservation, go to **My reservations** and open your reservation. On the reservation details page, click **Check in**.

**Note:** If the reservation is not checked in within 30 minutes before the reservation start time, then the reservation is cancelled. You will receive an email about the cancellation.

• To check out the reservation, go to **My reservations** and open your reservation. On the reservation details page, click **Check out**.

**Note:** If the reservation is not checked out within 30 minutes after the reservation end time, you will receive an email reminder to check out the reservation.
Share, modify or cancel a reservation

View, modify, or cancel your reservation or the reservation that you created on behalf of someone else. Modify the reserved workplace item or the date/time of the reservation.

Before you begin
Role required: sn_wsd_core.workplace_user

About this task
When you submit a reservation, you receive an email notification with the details of your reservation and its status. However, you can also view the details of your reservations, modify or cancel your reservation, and track the progress of your reservation using the My Reservations page.

You can also view, edit, or cancel a reservation using the Virtual agent chat support.

Navigate to Workplace Safety Management > Workplace service portal > Workplace Service Portal Home and click the chat icon (🔗) on the bottom right. Type your question or select Show Me Everything to select from a list of available options to make your reservation changes.

You can also modify the reserved workplace item in your reservation and change the date/time of the reservation if required.

Note: You cannot edit a reservation made using Microsoft Exchange Online.

Procedure
1. Navigate to My Reservations page from any of the following starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>a. Navigate to Workplace Reservation Management &gt; Portal &gt; My Reservations</td>
</tr>
</tbody>
</table>

Note: You can also raise a request from the Employee Center. On the home page, navigate to Workplace > Browse all Workplace and select the workplace service.

b. Open My reservations, do one of the following:

   i. Click Reservations > My reservations
   ii. Select Open my reservation list from the Workplace services catalog.
Location | Steps
--- | ---

1. Select **Catalog > Browse by categories > Workplace Services Catalog**

   [Note]: If there are multiple catalogs configured on the portal, go to the Catalogs list and select **Workplace Services Catalog**.

2. Select **Reservation Management > Open my reservation list.**

The **My Reservations** page opens in a new tab. All the reservations are listed according to the reservation date. The time is displayed based on the selected building's time zone.

2. **Optional**: To search for a reservation, type the details in **Search my reservation**.

3. Click a reservation to view its details.
   Review the details of your reservation such as reservation number, status, item details, and services available.

4. Perform the following actions on your reservation:

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
   | Update a reservation | a. Select **Change reservation details** from the Actions list.  
b. On the form, update the information that you want to change.  
c. Click **Update reservation details**. |

   | Cancel a reservation | a. Select **Cancel reservation** from the Actions list.  
b. Specify a reason for canceling the request in the **Cancel notes** field.  
c. Click **Yes**. |

**Results**
An email notification is sent with the details of your reservation and the reservation is updated with your changes.

**Create a shift reservation**
Reserve a workplace item for a shift. Create a single reservation or a recurring reservation for the same shift.

**Before you begin**
Role required: sn_wsd_core.workplace_user
Procedure

1. Navigate to the Make a Reservation page from any of the following starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>Navigate to Workplace Reservation Management &gt; Portal &gt; New Reservation.</td>
</tr>
<tr>
<td></td>
<td>b. Open the reservation portal and do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Click Reservations &gt; Make a reservation.</td>
</tr>
<tr>
<td></td>
<td>• On the homepage, select Make a reservation.</td>
</tr>
<tr>
<td></td>
<td>• From the Workplace services catalog, do the following:</td>
</tr>
<tr>
<td></td>
<td>i. Select Catalog &gt; Browse by categories &gt; Workplace Services Catalog.</td>
</tr>
<tr>
<td></td>
<td>Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog.</td>
</tr>
<tr>
<td></td>
<td>ii. Select Reservation Management &gt; New general reservation.</td>
</tr>
</tbody>
</table>

The Make a Reservation page opens in a new tab.

2. Search for a workplace item that you want to reserve using the following available criteria.

- **Building**: Name of the building.
- **Type**: Workplace item that you want to reserve, such as a meeting room or desk.
- **Shift schedule**: Shift for which you want to reserve a workplace item.
- **Start date**: Date when you want to reserve the workplace item.
- **Recurring**: Option for reserving the workplace item on a recurring basis.
- **Recurring end date**: This option appears if you select the **Recurring** option. Select the end date of the recurring reservation.

3. Click **Search**.

The workplace items which match the search criteria and which are available during this shift are displayed.

**Note**: You can switch between the **Card view** tab and **Schedule view** tab to review the availability of workplace items. If your company uploads floor maps like Mappedin, the **Map view** tab also appears.

4. **Optional**: Sort the workplace items in alphabetical order or by using a filter with the **Show filter** option.

5. Select the workplace item that you want to reserve using any of the following options.
• Click **Reserve now**.
  • If you have selected the **Schedule view** tab, click **Reserve**.
  • If you have selected the **Map view** tab, select any space that is colored green and click **Reserve**.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation subject</td>
<td>Subject of your meeting.</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>Nature of your meeting. Select <strong>Private</strong> if you want to hold a confidential meeting.</td>
</tr>
<tr>
<td>Note:</td>
<td>When you mark a meeting as <strong>Private</strong>, the <strong>Reservation subject</strong> becomes hidden for other people and is displayed as <strong>private</strong>. The only people who can see the subject are you or the person for whom you have requested this meeting.</td>
</tr>
<tr>
<td>On behalf of</td>
<td>If you are requesting a reservation on someone else's behalf, select the name of that person. Leave this field empty if you are requesting a reservation for yourself.</td>
</tr>
</tbody>
</table>

7. Click **Submit reservation**.

**Results**
If the item does not require any approval, then the selected workplace item is reserved. The status of the request is updated to Confirmed.
If you requested reservation for an item that requires approval, then your request is submitted to the approver. The status of the request is updated to Awaiting approval.

**What to do next**
Review your reservation details. To edit or cancel your reservations, see **Share, modify or cancel a reservation**.

**Manage reservations**
Using the Reservation Overview, workplace managers and reservation desk executives can monitor the reservations created and scheduled for a location. They can also view the reservations they have created on behalf of their employees. They can use the dashboard to track the trend of reservations over a time period.
After an employee submits a reservation for a workplace item for a given date, the reservation is confirmed based on the availability of that item. If the workplace item requires an approval before reservation, the approver receives an approval request in the approval queue.
If the workplace item is unavailable for the specified day or time, the request moves to the Conflicted state. As a workplace manager, you can review the reservations submitted by the employees for that day. You can view the reservations that you created, all the reservations, and the reservations scheduled for that day. For more information, see **View or update reservations**.
Based on the pending reservations for the items that require approval you can take appropriate actions to complete the reservation. For more information, see Approve a reservation.

**Approve a reservation**

Review employee reservations raised using Workplace Reservation Management and approve or reject them.

**Before you begin**

Role required: approver_user

**Procedure**

1. Navigate to **Self-Service > My Approvals**.
2. Select the reservation that you want to approve or reject.
3. **Optional**: Review the details of the reservation.
4. Approve or reject the reservation by selecting **Approve** or **Reject**.

**Reservation Management dashboard**

Use the Reservation Management dashboard to monitor the reservations and meeting frequency in your organization. On any day, you can view details such as number of reservations, peak meeting times, and number of meetings for different locations.

To access the Reservation Management Dashboard, navigate to **Workplace Safety Management > Workplace dashboards > Reservation Management**.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace manager: Needs visibility into the real-time status and number of the</td>
<td>sn_wsd_rsv.manager</td>
<td>• Review current day's reservations</td>
</tr>
<tr>
<td>reservations, most reserved locations, peak timings for meetings, and current</td>
<td></td>
<td>• Monitor reservations created by employees</td>
</tr>
<tr>
<td>day's reservations.</td>
<td></td>
<td>• Monitor peak time when maximum meetings are organized</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitor the number of meetings for each location</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meetings per location last month</td>
<td>Column</td>
<td>Number of meetings scheduled in each location in the last month.</td>
</tr>
<tr>
<td>Peak meeting hours last 3 months</td>
<td>Line</td>
<td>Peak hours when the maximum number of meetings were scheduled in the last 3 months.</td>
</tr>
<tr>
<td>Location reservations per day this</td>
<td>Stacked columns</td>
<td>Number of reservations made each day for the current week.</td>
</tr>
<tr>
<td>week</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location reservations today</td>
<td>List</td>
<td>Number of reservations scheduled for today grouped by location.</td>
</tr>
</tbody>
</table>

Workplace Case Management

Fulfilling employee workplace requests involves multiple, complex back-end processes, including analyzing the requests for type and routing them to human or automated responses, approvals, or other tasks. The ServiceNow® Workplace Case Management application makes these processes simpler and more efficient by letting you create pre-defined steps to fulfill requests.
Request a workplace service

As an employee, the Workplace Service Portal allows you to submit requests for workplace services like general inquiries, cleanliness requests, and travel-related requests. For example, you can create a request for HVAC issues, broken chairs, floor spills, move requests, and more.

Manage workplace cases

As a Workplace Case Management Manager and Admin, you can:

- Configure whether a request must be fulfilled manually or if it requires a set of automated tasks.
- Configure approval options for tasks.
- Create case and task templates.
- Create catalog items called record producers so that employees can raise requests.
- View and modify all cases created in the application.
- Configure an escalation rule for an assignment group.
- Add fulfillment instructions.
- Create an SLA definition.

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not
be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

**Install Workplace Case Management**

Install the Workplace Case Management application from ServiceNow Store applications. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Before you begin**

Complete the following setup checklist.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that Workplace Service Delivery - Core (sn_wsd_core) plugin of version 2.0 is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
<tr>
<td>Verify that Workplace Case Management (sn_wsd_case) plugin of version 1.0 is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
</tbody>
</table>

Activate the Workplace Service Delivery - Core plugin of version 2.0 (sn_wsd_core) in your ServiceNow instance before you install Workplace Case Management.

Use the following details when required:

- Name of the application: Workplace Case Management
- ID of the application: sn_wsd_case

Role required: admin

**About this task**

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Workplace Case Management.

5. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

6. Click **Install**.

**Components installed with Workplace Case Management**

Several types of components are installed with activation of the Workplace Case Management application, including tables, user roles, and business rules.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see *Find components installed with an application*.

Demo data is available for this feature.

**Roles installed with Workplace Case Management**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workplace Case Management admin [sn_wsd_case.admin] | • Sets up data related to workplaces services.  
• Creates workplace services.  
• Has complete access to the application. | • sn_wsd_case.manager                     |
| Workplace case Manager [sn_wsd_case.manager] | • View all cases.  
• Manage cases.  
• Create, read, update, and delete Case templates.  
• Create, read, update, and delete Task templates.  
• Create, read, update, and delete Workplace Services.  
• Create, read, update, and delete Workplace Service Activities. | • template_editor_global  
• sn_wsd_case.workplace_agent               |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Workplace case agent [sn_wsd_case.workplace_agent] | • Create, read, update, and delete Approval options.  
• Create, read, update, and delete an Escalation rule.  
• Create, read, update, and delete Fulfillment instructions.  
• Perform agent-related actions. | • sn_wsd_case.case_writer  
• sn_wsd_core.kb_writer  
• flow_operator |
| Workplace case writer [sn_wsd_case.case_writer] | • Create, read, update, and delete Workplace Tasks.  
• Read Task templates.  
• Create, read, update, and delete Workplace cases.  
• Read the following:  
  ◦ Escalation rules  
  ◦ Fulfillment instructions | • sn_wsd_core.task_writer  
• sn_wsd_case.case_reader |
| Workplace case reader [sn_wsd_case.case_reader] | Has read permissions to access all  
• Workplace tasks  
• Workplace cases | • sn_wsd_core.task_reader |

**Tables installed with Workplace Case Management**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Option [sn_wsd_case_approval_option]</td>
<td>Extends the Application File table. Stores information about Workplace case approvers.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workplace Case [sn_wsd_case_workplace_case]</td>
<td>Extends Workplace Task [sn_wsd_core_workplace_task] table. Stores information about all the Workplace cases in the application.</td>
</tr>
<tr>
<td>Workplace Service [sn_wsd_case_workplace_service]</td>
<td>Extends the Application File table. Stores information about all the Workplace Services in the application.</td>
</tr>
<tr>
<td>Workplace Service Activity [sn_wsd_case_workplace_service_activity]</td>
<td>Extends the Application File table. Stores information about all the Workplace Service Activities in the application.</td>
</tr>
<tr>
<td>Case Tier Escalation sn_wsd_case_tier_definition</td>
<td>Stores information about all the workplace case escalation rules created in the application.</td>
</tr>
<tr>
<td>Fulfillment Instruction sn_wsd_case_fulfillment_instruction</td>
<td>Stores information about all the fulfillment instructions created for workplace services in the application.</td>
</tr>
<tr>
<td>Request Service Items [sn_wsd_case_service_item_request]</td>
<td>Stores information about all the workplace service items requested using a workplace service.</td>
</tr>
<tr>
<td>Workplace Service Item Location [sn_wsd_case_m2m_service_item_location]</td>
<td>Extends the Workplace Service Location table. Stores information about all the workplace service item locations added in the application.</td>
</tr>
<tr>
<td>Workplace Service Location [sn_wsd_case_m2m_service_location]</td>
<td>Stores information about all the workplace service locations.</td>
</tr>
<tr>
<td>Workplace Field Mapping [sn_wsd_case_workplace_field_mapping]</td>
<td>Stores information about all the workplace field mappings created in the application.</td>
</tr>
<tr>
<td>Workplace Service Item [sn_wsd_case_workplace_service_item]</td>
<td>Stores information about all the workplace service items created in the application.</td>
</tr>
<tr>
<td>Workplace Template Configuration [sn_wsd_case_workplace_template_configuration]</td>
<td>Stores information about all the workplace template configurations created in the application.</td>
</tr>
</tbody>
</table>

**Properties installed with Workplace Case Management**

Customize the properties available with Workplace Case Management.

These properties are available for Workplace Case Management.

⚠️ **Note:** All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.
## Properties for Workplace Case Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_wsd_case.wsd_inbound_email         | Checks for email received for Workplace Case Management.  
This property is available only for Workplace Case Management version 1.0.1.  
This property will no longer be available if you upgrade to Workplace Case Management version 1.0.2 or later.  
This property is available as sn_wsd_core.wsd_inbound_email for Workplace Case Management version 1.0.2 and later.  
  
  - Type: String  
  - Default value: askwsd@example.com  
  - Location: System Property [sys_properties] table |
| sn_wsd_case.acceptance_timeout        | If a Workplace case has 'Enable user acceptance' set to True and no 'Acceptance Timeout' specified, this property applies the default timeout to 172800 seconds (two days).  
  
  - Type: Integer  
  - Default value: 172800 Seconds  
  - Location: System Property [sys_properties] table |

## Workplace Case Management Setup

As an admin, you can configure Workplace services and enable Workplace Services users to submit requests through it. The application enables you to configure workplace services with pre-defined fulfillment types.

The ServiceNow® Workplace Case Management application enables you to administrate all the workplace services and cases created using these workplace services.

As a workplace case admin or a case manager, you can perform the following actions.

- Configure Workplace services
- Configure Case templates for workplaces cases.
- Configure Task templates for workplace tasks.
- Configure Record producers and link them with a workplace service.
- Configure the Approval options and select the type of approvals that are required for a service activity.
- Create Workplace Service Activities such as tasks, approvals, and child cases.

## Template

As a Workplace case manager, you can create templates to simplify the process of creating tasks and cases by populating fields automatically.

You can create the following types of template:
• **Case template**: A case template auto-populates fields when a case is being created.

• **Task template**: A task template auto-populates fields when a task is being created. You can modify predefined workplace task templates or create your own templates and associate them with workplace tasks.

**Create a Workplace case template**

Create a Workplace case template for use when creating workplace services.

**Before you begin**

Role required: sn_wsd_case.admin or sn_wsd_case.manager

**About this task**

A Case template simplifies the process of creating cases in Workplace Case Management by populating fields automatically.

**Procedure**

1. Navigate to Workplace Case Management > Workplace Case Management - Setup > Case templates.

2. Create a template or modify an existing template.
   - If you are creating a new template, click **New**.
   - If you are modifying an existing template, open that template.
     For information about the template form fields, see **Create a template**.

3. In the **Table** field, select the Workplace case [sn_wsd_case_workplace_case] table.

4. Click **Submit**.

**Results**

The case template is created. You can use this template for workplace services.

To create a case template with user acceptance, see **Create a User acceptance Workplace case template**.

**What to do next**

To create a case template with user acceptance, see **Create a User acceptance Workplace case template**.

---

**Create a User acceptance Workplace case template**

Create a Workplace case template with user acceptance.

**Before you begin**

Role required: sn_wsd_case.admin or sn_wsd_case.manager

**About this task**

Create this case template for use when a user's approval or rejection is required to close the request.

**Procedure**

1. Navigate to Workplace Case Management > Workplace Case Management - Setup > Case templates.

2. Create a template or modify an existing template.
   - If you are creating a new template, click **New**.
   - If you are modifying an existing template, open the desired template.
For information about the template form fields, see Create a template.

3. In the **Table** field, select the **Workplace case [sn_wsd_case_workplace_case]** table.

4. In the **Template** field, enable user acceptance and acceptance timeout.
   a. In the left column, select **Enable user acceptance** and in the right column, select **True**.
   b. In the left column, select **Acceptance timeout** and in the right column, specify the duration after which the acceptance request can expire.

5. Click **Submit**.

**Results**

The Case template is created with user acceptance options enabled.

**What to do next**

Use the template in Workplace services where user acceptance is required. For more information about creating Workplace services, see Create a Workplace service.

**Create a Workplace task template**

A Task template simplifies the process of creating tasks in Workplace Case Management by populating fields automatically.

**Before you begin**

Role required: sn_wsd_case.admin or sn_wsd_case.manager

**About this task**

Create a task template for use when creating a workplace service.

ℹ️ **Note:** Administrators may use task assignment rules to control the automatic assignment of workplace tasks as long as the task template is not already assigning a person or group to the task. For more information on assignment rules, see Define assignment rules.

**Procedure**

1. Navigate to **Workplace Case Management > Workplace Case Management - Setup > Task templates**.

2. Create a template or modify an existing template.
   - If you are creating a template, click **New**.
   - If you are modifying an existing template, open that template.

   For information about the template form fields, see Create a template.

3. In the **Table** field, select the **Workplace Task [sn_wsd_core_workplace_task]** table.

4. Click **Submit**.

**Results**

The task template is created. You can use this template for Workplace services.

**Configure Approval options**

Add approvers to approve cases created through Workplace services.

**Before you begin**

Ensure that you have the following details:
• Workplace Case table.
• User fields to select an approver from.

Role required: sn_wsd_case.admin or sn_wsd_case.manager

About this task
The ServiceNow® Workplace Case Management application provides the following default Approval options:
• Manager
• Workplace location managed by
• Workplace location managed by group

Procedure
1. Navigate to All > Workplace Case Management > Workplace Case Management - Setup > Approval options.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Approval option.</td>
</tr>
<tr>
<td>Case table</td>
<td>Case table for the option. Select the Workplace Case [sn_wsd_case_workplace_case] table.</td>
</tr>
<tr>
<td>User field</td>
<td>User or a user group to set as approver.</td>
</tr>
<tr>
<td>Application</td>
<td>Application for the option. This field is automatically set. Make sure the application is set to Workplace Case Management.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the approval option. Select this option.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The Approval option is added and will be listed wherever approvals are configured.

Configure a Record producer
Make a Workplace service available to employees as a self-service option. Configure a record producer to display the service as catalog item in the Workplace Services catalog.

Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager
Procedure

1. Navigate to Workplace Case Management > Workplace Case Management - Setup > Record producers

2. Click New.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record producer.</td>
</tr>
<tr>
<td>Table name</td>
<td>Workplace Case (sn_wsd_case_workplace_case) table that the record producer is associated with. Note: Make sure that the workplace case table for the record producer matches that of the associated workplace service.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model table if relevant for the record producer.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is already set to Workplace Case Management.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the record producer for use.</td>
</tr>
<tr>
<td>Preview link</td>
<td>Link to preview how the record producer appears to users in the Workplace Service Delivery catalog</td>
</tr>
<tr>
<td>Expand help for all questions</td>
<td>Select this option to enable users to expand help for all questions.</td>
</tr>
</tbody>
</table>

4. Fill the following related lists fields appropriately:
   - **What it will contain**
   - **Accessibility**
   - **Generated Record Data**
   - **Portal Settings**

5. In the **What it will contain** related list, provide the following script:

   ```javascript
   new sn_wsd_case.WSDServiceUtils(current, gs).createCaseFromProducer(producer, cat_item.sys_id);
   ```

6. In the **Variables** related list, configure the variables for the Workplace Services catalog item as appropriate.
   Variables collect information from the user, and are used to ask questions and map answers to fields. You can add as many variables as you need to the Workplace Services catalog item. Commonly used variables types include:
   - Checkbox
   - Multiple Choice
   - Reference
To learn more about the different types of variables and how to configure them, see Types of service catalog variables.

7. Click Submit.

Results
The record producer is created.

What to do next
Link the record producer to the workplace service, see Create a Workplace service.

Create an SLA Definition
Configure SLAs to ensure that cases are resolved according to the expectations of customers. SLAs set up performance parameters, such as specifying minimum uptime or the amount of time that a task needs in order to reach a certain condition.

Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager

About this task
Create an SLA definition and use it in Workplace cases.

Procedure
2. Create an SLA Definition or modify an existing one.
   - If you are creating an SLA Definition, click New.
   - If you are modifying an existing SLA Definition, open the desired SLA Definition.
     For information about the template form fields, see Create an SLA Definition.
3. In the Table field, select the Incident [incident] table.
4. In the Flow field, select Default SLA flow.
5. In the Application field, ensure Workplace Case Management is selected.
6. Click Submit.

Results
The SLA Definition is created.

Workplace Services
The ServiceNow® Workplace Case Management application enables you to create a workplace service with pre-defined steps for fulfillment. You can create workplace services for requests like cleanliness, IT, office setup, and travel requests. For example, you can create a request for HVAC issues, broken chairs, floor spills, move requests, and more.

When you create a workplace service, you can configure the steps based on the type of fulfillment required. The ServiceNow® Workplace Case Management application provides the following fulfillment types:
• **Manual**: The Manual option enables you to configure a workplace service with human response. This works for services like general inquiries or complaints, and similar requests.

• **Service Activity**: The Service activity option enables you to select the type of activity triggered when a request is raised. You can specify the order in which these activities must be executed. You can select from the following types of workplace service activities:
  ◦ **Approval**: Enables you to set approvals on workplace service activity. You can configure what type of approval is required on selecting the workplace service. You cannot set more than one approval activity in a single order.
  ◦ **Task**: Enables you to add a task using a task template. When the workplace service is selected, the task is created based on the order specified.
  ◦ **Child case**: Enables you to trigger child cases on selecting the workplace service. A workplace service must be provided for a child case. The child case is created based on the order specified.

• **Flow**: The flow option enables you to select an existing sub-flow from the application. For more information about Flows, see Flows.

**Create a Workplace service**
Create a workplace service with pre-defined steps of fulfillment. Select the fulfillment type required based on the workplace service.

**Before you begin**
Role required: sn_wsd_case.admin or sn_wsd_case.manager
Ensure that you have the following details:

• Task templates and Case templates to link it to the workplace service.
• Record producer to which the workplace service must be linked.
• Active flows in case you want to create workplace service flow.

**Procedure**
1. Navigate to All > Workplace Case Management > Workplace Case Management - Setup > Workplace services.
2. Click **New**.
3. On the form, fill in the fields.

**Workplace service form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service name</td>
<td>Enter a name for the Workplace service.</td>
</tr>
<tr>
<td>Case table</td>
<td>Table that is used for the workplace service.</td>
</tr>
<tr>
<td>Fulfillment type</td>
<td>Select the fulfillment type for the workplace service:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manual</strong>: Select this option for manual fulfillment. This option enables you to fulfill the request with a human response.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Service activity</strong>: Select this option to trigger activities to fulfill the workplace service. Save the form to create or update workplace service activities.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For more information, see Create a Workplace service activity</td>
</tr>
<tr>
<td></td>
<td>• <strong>Flow</strong>: Select this option to use an existing subflow from the application for fulfillment. For more information about Flows, see Create a subflow.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If you are creating a custom subflow, ensure that the input fields are set to following:</td>
</tr>
<tr>
<td></td>
<td>◦ Label: Workplace Case</td>
</tr>
<tr>
<td></td>
<td>◦ Name: workplace_case</td>
</tr>
<tr>
<td></td>
<td>◦ Type: Reference.Workplace Case</td>
</tr>
<tr>
<td>Automatically close case</td>
<td>This field appears if you select the <strong>Fulfillment type</strong> as <strong>Service Activity</strong>. Select this option to close the case automatically.</td>
</tr>
<tr>
<td>Flow</td>
<td>This field appears if you select the <strong>Fulfillment type</strong> as <strong>Flow</strong>. Select a Flow for the Workplace service from the list of options.</td>
</tr>
<tr>
<td>Application</td>
<td>Select <strong>Workplace Case Management</strong> from the list of applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Select to activate the workplace service.</td>
</tr>
<tr>
<td>Available for</td>
<td>Option to specify which users can use the workplace service:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Case</strong>: Select this option to make the workplace service available only to Workplace Case Management users.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reservation</strong>: Select this option to make the workplace service available for employees while making a reservation.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Case and Reservation</strong>: Select this option to make the workplace service available to both Workplace Case Management users and to employees making a reservation.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The <strong>Reservation</strong> and <strong>Case and Reservation</strong> options appear only if the Workplace Reservation Management application is installed.</td>
</tr>
<tr>
<td>Allow only single service item selection</td>
<td>This field appears only if <strong>Reservation</strong> option is selected in the <strong>Available for</strong> field. Select this field to restrict users to select only one option from a list of choices.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if Workplace Reservation Management application is installed.</td>
</tr>
</tbody>
</table>
4. Click Submit.

Results
The workplace service is created and is requested whenever the associated record producer is selected.

Create a Workplace service activity
Create a Workplace service activity to trigger a background activity when a Workplace service is selected. The activity can be an approval action, task, or a child case.

Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager
Ensure that you have the following details:
- Task templates and Case templates to link to a workplace service activity.
- A workplace service with fulfillment type selected as Service activity. For more information, see Create a Workplace service.

About this task
Activities can be approvals, tasks, or child cases. You can specify the order in which these activities must be triggered.

Procedure
1. Navigate to All > Workplace Case Management > Workplace Case Management - Setup > Workplace services.
2. Select the workplace service that you want to modify to add more workplace service activities.
3. Click New under the Workplace Service Activities section in the Workplace services form.
4. On the form, fill in the fields.

Workplace service form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the service activity.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Select the type of service activity that you want to create:</td>
</tr>
<tr>
<td>Missing all approves</td>
<td>This field appears if you select the Activity type Approval. From the list of options,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>select what action to take if all the approvers are missing.</td>
<td>This field appears if you select the <strong>Activity type Approval</strong>. Select the type of approval required to close the case. From the options, select whether any approver can approve, all approvers must approve, or if the first response from any approver is an approval. Point to the options to view more details.</td>
</tr>
<tr>
<td>Wait for</td>
<td>This field is auto-generated. However, ensure that Workplace Case Management is selected.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is auto-populated with the Workplace service to which you are adding this activity.</td>
</tr>
<tr>
<td>Parent service</td>
<td>Specify an order for this activity. Depending on the order, the service activity initiated.</td>
</tr>
<tr>
<td>Order</td>
<td>You can specify only one Service Activity of type Approval in a single order.</td>
</tr>
<tr>
<td>Approvers</td>
<td>This field appears if you select the <strong>Activity type Approval</strong>. Select approvers for the case from the configured performer criteria.</td>
</tr>
<tr>
<td>Task template</td>
<td>This field appears if you select the <strong>Activity type as Task</strong>. Click the search ( ) icon and select the suitable task template. You can also create a task template, for more information, see Create a Workplace task template.</td>
</tr>
<tr>
<td>Workplace case service</td>
<td>This field appears if you select the <strong>Activity type as Child case</strong>. Click the search ( ) icon and select the Workplace service you want to set as a child case. To add a Workplace service, see Create a Workplace service.</td>
</tr>
<tr>
<td>Continue if incomplete</td>
<td>Select this option if you want this activity to continue even if the activity is closed or incomplete.</td>
</tr>
</tbody>
</table>

5. **Optional**: Enter the conditions in the condition builder that you want to trigger the background activity.

**Example**
For example, a task for the activity will be created only when the condition matches the case record.
In releases prior to the Quebec release, fields had to be selected from the Workplace Case [sn_wsd_case_workplace_case] table and service catalog variables such as questions could not be referenced.

6. Click Submit.

Results
The Workplace Service Activity is created and will be executed when the parent Workplace service is requested.

Configure an escalation rule
Escalate a workplace case to the relevant assignment group by using an escalation rule.

Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager

Procedure
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalate from</td>
<td>Assignment group from which you want to escalate the workplace case.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Assignment group to which you want to escalate the workplace case.</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain of your application. This field is automatically set to your application domain.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The escalation rule is created. The rule is displayed under the Related links of those workplace cases that have the assignment group (specified in Escalated from) for which the rule is created.

Add Fulfillment instructions
Provide instructions to workplace agents on how to fulfill a workplace case. Add instructions for new workplace agents and for complicated workplace cases.

Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager

About this task
Add instructions for fulfilling a workplace case.
Procedure
2. Click New.
3. On the form, fill in the fields.

Fulfillment Instruction form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the fulfillment instruction.</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing workplace cases. The field is automatically set to the Workplace Case table.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that a workplace case should satisfy before you implement the fulfillment instruction. The instruction appears in the workplace case records which match this condition.</td>
</tr>
<tr>
<td></td>
<td>• To add a condition, select Add Filter Condition.</td>
</tr>
<tr>
<td></td>
<td>• To add an &quot;OR&quot; condition, select Add &quot;OR&quot; Clause.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the fulfillment instruction.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the instruction is followed when there are multiple fulfillment instructions for a workplace case record.</td>
</tr>
<tr>
<td>Instruction</td>
<td>Fulfillment instructions to follow. Use the formatting options to change the style of the content.</td>
</tr>
<tr>
<td>Knowledge articles</td>
<td>Knowledge article to support the instructions. Select the unlock knowledge articles icon (🔒) to add an article. Select the lookup icon (🔍) to search for an article.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The fulfillment instruction is added. The instruction is displayed in the workplace case records that match the specified conditions.

Group similar workplace cases under a parent case
Categorize cases that have similar issues and that require the same resolution under a single parent case. Reduce the time spent on resolving multiple workplace cases.
Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager or sn_wsd_case_workplace_agent

About this task
Assign a workplace case to a parent workplace case. The resolution provided to the parent case will also be applied to the child case.
You can also assign a case to a parent case even if the State field of the parent is set as Canceled or Closed Complete. When the case is assigned, the state of the child case is automatically updated as Canceled or Closed complete.
The following dependencies can occur when you assign a parent case:
• You can view all the cases associated to a parent case in the Related Cases tab.
• The child case is updated whenever the parent case is updated. Updates like comments, work notes, and state changes are automatically applied to the child case. If the state of the child case is set as Canceled, the updates will no longer be applied. If you do not want to copy the comments, work notes and state changes to the child cases, you can set the Update Child Case - Work Notes & Comments to False.
• State changes in the parent case are copied to the child case, except for state changes to Awaiting acceptance.
• Any updates individually made on the child case will not be applied to the parent case.

Procedure
1. Navigate to Workplace Case Management > Workplace Cases.
2. Select one of the following modules:
   • All
   • Open - Unassigned
   • Open
   • Assigned to my group
   • Assigned to me
3. Select the workplace case to which you want to assign a parent workplace case.
4. In the Parent case field, select the workplace case that you want to assign as a parent.
   Important: Do not select a child case as a parent case. Otherwise, the case will encounter looping. For example, if WCASE0001001 is parent of WCASE0001002 and WCASE0001003, then WCASE0001002 and WCASE0001003 can't be parent of WCASE0001001.
5. Click Save.

Results
The workplace case is assigned to a parent case.
Important: The case selected in the Parent case field and the case displayed in the Parent field are different. The workplace case displayed in the Parent field is generated from the workplace service to which the case is associated. A parent is assigned automatically if the Activity type of the workplace service is Task or Child case.

Workplace Service Delivery integration with Universal Request
Combine Workplace Service Delivery services with Universal Request so that you can provide a convenient workplace experience to your employees. Provide a common help desk so
that your employees can submit requests that are related to their workplace without having to search the Workplace services catalog.

The integration with Universal Request enables an employee to submit a general inquiry for any workplace-related issue. An employee can get support by selecting a single-help option for services that are not included in the catalog.

For more information about a Universal Request, see Universal Request.

**Benefits of integrations with Universal Request**
The integration enables you to perform the following actions:

- Create a workplace case directly from the Universal Request application using the **Create a workplace case** option.
- Transfer a workplace case to another department or back to the Universal Request queue by using the **Transfer** option.
- Configure a workplace service as a Universal Request.
- View workplace cases created by Universal Requests under **Workplace Cases > All**.
- On the Workplace Service Portal, an employee can view the Universal Request raised by them in **Workplace Service Portal > Requests**.

**System requirements to integrate Workplace Service Delivery with Universal Request**
The following plugins must be installed:

- Universal Request (com.snc.universal_request)
- Workplace Service Delivery - Core (sn_wsd_core)
- Workplace Case Management (sn_wsd_case)

**Universal Request and workplace cases**
When employees cannot find a workplace service that is suitable to their issue on the Workplace Service Portal, they can select the **Request help** option. The following actions are performed when an employee selects **Request help**:

1. The option navigates the employee to a help form where the employee can specify any issue details. This help request triggers a Universal Request.
2. The Universal Request is assigned to a routing agent. The agent analyzes the request as a workplace-related query and creates a workplace case.
3. The workplace manager handles the workplace case and changes the state of the case depending on the progress.
4. The Universal Request is then closed only when the employee accepts the resolution.

As a workplace manager, you can transfer a workplace case that was created by Universal Request back to the Universal Request queue if it does not relate to workplace services. Employees can view the details related to their Universal Request anytime.

**Configure a workplace service record producer as a Universal Request**
Enable an employee to submit a universal request using a workplace service record producer from the Workplace Service Portal. Configure a workplace service to create Universal Requests whenever an employee makes a selection.

**Before you begin**
Ensure that you have activated the Universal Request plugin.
Ensure that you have the following:

- A workplace service that is linked to a record producer. For more information, see Configure a Record producer.
- An active record producer.

Role required: sn_wsd_case.admin or sn_wsd_case.manager

Procedure
1. Navigate to Workplace Case Management > Workplace Case Management - Setup > Record producers.
2. Select the record producer that you want to configure as a universal request.
3. Select Universal Request Config tab.
4. To enable the universal request feature, select Create Universal Request.
5. If the universal request requires an extra review, select Requires Additional Review.
6. Click Update.

Results
The workplace service record producer is configured as a universal request.

When an employee submits an inquiry using this workplace service, a universal request is created. The request is automatically assigned to the Workplace services assignment group.

Create a workplace case from Universal Request
As a routing agent, create a workplace case from a universal request and then assign it to the Workplace services assignment group. The workplace manager handles the workplace case and takes further actions to fulfill the request.

Before you begin
Ensure that you have the following plugins installed:

- Universal Request (com.snc.universal_request)
- Workplace Service Delivery - Core (sn_wsd_core)
- Workplace Case Management (sn_wsd_case)

Role required: routing_agent and sn_wsd_case.case_writer

Procedure
1. Navigate to Universal Requests > All.
2. Open the universal request record from which you want to create a workplace case.
3. Click Create Workplace Case.

Results
A workplace case is created and is automatically assigned to the Workplace services assignment group. If required, you can also add more details on the Workplace Case form.

On the Workplace Case form, the universal request number that was used for creating the workplace case is displayed. The Workplace case number appears in the primary Ticket field on the Universal Request form and also under the Associated Tickets related list.
Work on a workplace case from a Universal Request

As a workplace manager, work on a workplace case that is created from a Universal Request. Provide a resolution to the workplace case.

Before you begin
Role required: sn_wsd_case.case_writer

About this task
You can configure the state changes that are described in the following procedure as per your requirements. For more information, see Universal Request state mapping.

Procedure
1. Navigate to Workplace Case Management > Workplace cases > All.
2. Select the workplace case record that is created from the Universal Request.
3. On the form, change the State field to Work in progress.
   
   Note: If the workplace case does not relate to any workplace service, then transfer the case to the relevant department or back to the Universal Request queue. Select Transfer to transfer the case. For more details on how to transfer a case, see Transfer a workplace case created from a universal request.
4. When you resolve the case, change the state to Closed complete.

Results
The state of the Universal Request is updated based on the state of the workplace case. For more information about state changes of a Universal Request, see Universal Request states and reasons.

If you change the state of the workplace case to Close incomplete without transferring the case back to the Universal Request queue or to another department, then one of the following actions is performed:

- If the Needs Additional Review option is selected on the Universal Request, then the state of the request changes to the In progress state.
- If the Needs Additional Review option is not selected on the Universal Request, then the request is closed based on the state mapping.

Transfer a workplace case created from a universal request
Transfer a workplace case back to the Universal Request, to another department, or to another service. You can transfer the request with or without providing a resolution.

Before you begin

Note: To transfer a case, either you must be part of the assignment group or the case must have been assigned to you.

Role required: sn_wsd_case.case_writer

Procedure
1. Navigate to Workplace Case Management > Workplace cases > All.
2. Select the workplace case record that you want to transfer.
3. Click Transfer.
4. In the Transfer Ticket dialog box, provide the transfer details.
Transfer Ticket form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Department that you want to transfer the case to.</td>
</tr>
<tr>
<td>Transfer reason</td>
<td>Reason why you are transferring the request to the department.</td>
</tr>
<tr>
<td>Transfer notes</td>
<td>Brief description on the reason for transferring the primary ticket. These notes are read by the UR Routing agent who handles universal requests.</td>
</tr>
<tr>
<td>Copy additional comments and attachments</td>
<td>Option to copy the comments and attachments of this case while transferring. The option is automatically selected.</td>
</tr>
</tbody>
</table>

Note: The transfer action does not copy work notes.

5. Click Transfer.

Results
The case is transferred to the selected department.

Manage Workplace cases
As a Workplace case manager, you can manage workplace cases created through workplace services. You can view and update cases if required.

The application enables you to view and make the following changes to the Workplace cases:
- Add new child cases, and child tasks when required.
- Add and edit approvers.
- Modify SLAs.

View workplace cases
Track open, closed and unassigned cases.

Before you begin
Role required: sn_wsd_case.admin or sn_wsd_case.manager

About this task
You can modify any Workplace cases when required. You can view the details provided by the user under the Variables section of the workplace case.

Procedure
1. Navigate to Workplace Case Management > Workplace Cases.
2. Select any of the following options to view workplace cases:
   - Assigned to me: Select this option to view workplace cases assigned to you.
   - Assigned to my group: Select this option to view workplace cases assigned to your group.
• **Open**: Select this option to view open workplace cases.
• **Open - Unassigned**: Select this option to view open but unassigned workplace cases.
• **Closed**: Select this option to view closed workplace cases.
• **All**: Select this option to view the workplace cases.

### Requesting a Workplace service

Employees can request a Workspace service using the Workplace Service Portal or the Now Mobile app.

The Workplace Services catalog displays a list of workplace services from which your employees can submit requests. The following default Workplace services are provided by ServiceNow®:

• Request general workplace help.
• Reconfigure an office space.

You can also use the Virtual agent chat support on the Workplace Service Portal to submit a general inquiry. The chat support enables you to do the following:

• Request a workplace help.
• View the status of your submitted cases.
• View the cases that are awaiting acceptance.

### Reconfigure an office space

Provide details on how an office space should be reconfigured.

### Before you begin

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_use

### About this task

Raise this request to rearrange your office space. Specify any extra information needed by the team responsible for the reconfiguration.

### Procedure

1. Navigate to **Workplace service portal > Workplace Service Portal Home**
2. To open the **General** category where the workplace service is located, do the following:
   a. Click **Catalog**.
   b. Click **Browse by Categories**.
   c. In the Workplace Services Catalog, select **General**.

   **Note:** If there are multiple catalogs configured on the portal, go to the Catalogs list and select **Workplace Services Catalog > General**.
3. Select **Reconfigure an office space**.
4. On the form, fill in the fields.

**Reconfigure office space form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On behalf of</td>
<td>Name of the requester who is requesting to reconfigure.</td>
</tr>
<tr>
<td>Region</td>
<td>Region of your office location.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of your office.</td>
</tr>
<tr>
<td>Campus</td>
<td>Campus of your office building.</td>
</tr>
<tr>
<td>Building</td>
<td>Office building of your space.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor of the area or space that you want to reconfigure</td>
</tr>
<tr>
<td>Area</td>
<td>Area of the space you want to reconfigure.</td>
</tr>
<tr>
<td>Space</td>
<td>Office space you want to reconfigure.</td>
</tr>
<tr>
<td>Is there anything else we should know?</td>
<td>Extra information about the reconfiguration you are requesting.</td>
</tr>
</tbody>
</table>

5. Add attachments if required.
6. Click **Submit**.

**Results**
Your request is submitted.

**What to do next**
You can check the details of your request or choose to cancel it anytime using the Workplace Service Portal or the Now Mobile app. Click **Cancel Request** to cancel the request.

- On Workplace Service Portal, go to the Requests tab to view your requests and reservations.
- On the Now Mobile app’s navigation bar, tap **For Me** and scroll down to the My Request section to view your requests.

When the request is resolved, select **Accept** or **Reject** based on the resolution received.

**Raise help request for a workplace inquiry**
Submit a general workplace service request for issues that need a human response. Request help for issues that are not covered by current automated workflows.

**Before you begin**

**Important:** Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates, and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see **Configure a catalog in Service Portal**.

Role required: sn_wsd_core.workplace_user
About this task
Request a workplace-related help or raise an issue about anything related to the workplace.
You can also submit a general question using the Virtual agent chat support. Navigate to Workplace Safety Management > Workplace service portal > Workplace Service Portal Home and click the chat icon ( ). Type your question or select Show Me Everything to choose from the list of options to submit your query.

Procedure
1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the General category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select General.

   Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > General.
3. Click Submit a general request.
4. In the What can we help you with? field, enter your query or issue.
5. Add attachments if required.
6. In the What area needs attention, specify the location details for which you are raising the request.
   If the Workplace Space Mapping plugin is installed, you can also click the Find the space on a floor map option to select the space directly on the map.
   a. In the Location field, select the building where the space is located.
   b. In the Floor field, select the floor where the space is located.
   c. In the Space type field, select the type of space.
   d. In the Space name field, select the space.
7. Click Submit.

Results
Your request is submitted.

What to do next
Depending on your platform, do one of the following to view your requests:
• On the Workplace Service Portal, go to the Requests tab to view your requests and reservations.
• On the Now Mobile app’s navigation bar, tap For Me and scroll down to the My Request section to view your requests.
• In the virtual agent chat, type your question or select Show Me Everything to select from a list of available options.

If you want to cancel a request, Click Cancel Request.
When the request is resolved, select Accept or Reject.
Workplace Case dashboard

Use this dashboard to track the number of workplace cases that were created using the workplace services from the Workplace Service Delivery or from the Workplace Service Portal. Monitor the number of open cases, cases that require approval, and other cases on any given day.

To access the Workplace Case dashboard, navigate to Workplace Safety Management > Workplace dashboards > Case management.

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Workplace case manager: Needs visibility into the real-time status of workplace cases. | sn_wsd_case.manager | • Reviews all open cases  
• Monitors high priority cases |
End user and goal | Required role | Benefits
--- | --- | ---

| • Monitors cases that have breached an SLA. • Monitors number of cases awaiting approval. |

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Open cases</td>
<td>Single score</td>
<td>Number of open workplace cases.</td>
</tr>
<tr>
<td>Open High Priority Cases</td>
<td>Single score</td>
<td>Number of high priorities workplace cases that are open.</td>
</tr>
<tr>
<td>SLA Breached</td>
<td>Single score</td>
<td>Number of workplace cases that breached SLA.</td>
</tr>
<tr>
<td>Cases Awaiting Approval</td>
<td>Single score</td>
<td>Number of workplace cases awaiting approval.</td>
</tr>
<tr>
<td>WSD Cases Opened This Month by Service</td>
<td>Column</td>
<td>Number of workplace cases created using the associated workplace services.</td>
</tr>
<tr>
<td>WSD Cases Opened in Last 3 Months by Service</td>
<td>Column</td>
<td>Number of workplace cases created in the last three months using the associated workplace services.</td>
</tr>
<tr>
<td>WSD Overdue Case SLAs by Assignee and State</td>
<td>Column</td>
<td>Number of workplace cases that have crossed the SLA deadline represented with respected to the assignee.</td>
</tr>
<tr>
<td>Active WSD Cases</td>
<td>List</td>
<td>List of active workplace cases on the current day.</td>
</tr>
<tr>
<td>Unassigned Cases</td>
<td>List</td>
<td>List of unassigned workplace cases on the current day.</td>
</tr>
</tbody>
</table>

**Workplace Visitor Management**

Welcome your guests and off-site employees with a smoother, more hassle-free experience. Use ServiceNow® Workplace Visitor Management to optimize your front-desk operations and welcome your guests and off-site employees. You can register visitors as well as pre-plan what they will require.
Workplace Visitor Management overview

Employee, admin, and reception staff can use the Workplace Visitor Management application for different purposes.

**Register visitors**

Employees can register external visitors and off-site company colleagues for a visit. You can specify their visit dates, their parking, and WiFi requirements. You can co-host visitors with others. You can specify if a visitor is a VIP. You can leave a special note to receptionists to customize their visit.

**Manage visitor registrations**

Admins and reception staffs can manage and update visitor registrations. Using the Workplace Visitor Management, you can view visitors who are currently checked in, expected visitors, the visitors who are on break and the visitors who have checked out. Once the visitors are on the premises, the application allows you to perform the following actions:

- Check in
- Break check out
- Break check in
- Check out
- Cancel
- Print badges
- Update with no show

**Notice regarding use by organizations**

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.
Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Workplace Visitor Management

Install the Workplace Visitor Management application from ServiceNow Store applications. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Before you begin

Complete the following setup instructions.

1. Navigate to Subscription Management > Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.

2. Verify that the following plugins are activated:
   - Workplace Safety Management (sn_wsd_core) version 2.0.3.
   - Workplace Visitor Management (sn_wsd_visitor) version 1.0.6.

Role required: admin

Use the following details when required:
- Name of the application: Workplace Visitor Management
- ID of the application: sn_wsd_visitor

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the application using the filter criteria and search bar. Search for the application by its name (Workplace Visitor Management) or ID (sn_wsd_visitor). If you cannot find the application, you may have to request it from ServiceNow store.

3. Click Install.

4. In the Application installation dialog box, review the application dependencies. Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Workplace Visitor Management.

5. Optional: If demo data is available and you want to install it, click Load demo data.
(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

6. Click **Install**.

**Components installed with Workplace Visitor Management**

Several types of components are installed with the Workplace Visitor Management application, including tables, user roles, and business rules.

**Important:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Demo data is available for this feature.

**Roles installed with Workplace Visitor Management**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace visitors admin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[sn_wsd_visitor.admin]</td>
<td>As an admin, you can:</td>
<td>• sn_wsd_visitor.manager</td>
</tr>
<tr>
<td></td>
<td>• Have complete access to the application.</td>
<td>• catalog_editor</td>
</tr>
<tr>
<td></td>
<td>• View, manage, and update visitor registrations.</td>
<td>• catalog_admin</td>
</tr>
<tr>
<td></td>
<td>• View the Visitor Reception Dashboard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View visit logs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Register visitors.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create record producers.</td>
<td></td>
</tr>
</tbody>
</table>

| Workplace visitors manager |             |                                 |
| [sn_wsd_visitor.manager]   | As a manager, you can: | sn_wsd_visitor.staff           |
|                            | • View, manage, and update visitor registrations. |                                 |
|                            | • View the Visitor Reception Dashboard. |                                 |
|                            | • Register visitors. |                                 |

| Workplace reception staff  |             |                                 |
| [sn_wsd_visitor.staff]     | As a reception staff, you can: | sn_wsd_core.workplace_user      |
|                            | • View, manage, and update visitor registrations. |                                 |
|                            | • Register visitors |                                 |
|                            | • View the Visitor Reception Dashboard. |                                 |
|                            | • Print badges for visitors. |                                 |
Tables installed with Workplace Visitor Management

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Visitor</td>
<td>Stores information about the link between a visitor and an employee. The employee must have specified this information while registering the visitor.</td>
</tr>
<tr>
<td>[sn_wsd_visitor_m2m_user_visitor]</td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>Stores information about the visitor’s organization, such as the organization’s name and description.</td>
</tr>
<tr>
<td>[sn_wsd_visitor_organization]</td>
<td></td>
</tr>
<tr>
<td>Visit</td>
<td>Stores information about the visit. Each visitor is linked to a visit. A visit can hold multiple visitors.</td>
</tr>
<tr>
<td>[sn_wsd_visitor_visit]</td>
<td></td>
</tr>
<tr>
<td>Visitor</td>
<td>Stores information about all the visitors who have visited. An employee can reuse the visitor details for future registrations.</td>
</tr>
<tr>
<td>[sn_wsd_visitor_visitor]</td>
<td></td>
</tr>
<tr>
<td>Visitor Registration</td>
<td>Stores information about all the visitor registrations created in the application.</td>
</tr>
<tr>
<td>[sn_wsd_visitor_visitor_registration]</td>
<td></td>
</tr>
<tr>
<td>Visit Log</td>
<td>Stores information about the state changes that were logged during a visit.</td>
</tr>
<tr>
<td>[sn_wsd_visitor_visit_log]</td>
<td></td>
</tr>
</tbody>
</table>

Properties installed with Workplace Visitor Management

There are several properties available with Workplace Visitor Management.

⚠️ Note: All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.

Properties for Workplace Visitor Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_visitor.policy_response_due_in_days</td>
<td>This property enables you to set the visitor policy response due date in days.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1</td>
</tr>
<tr>
<td>sn_wsd_visitor.visitor_inbound_email</td>
<td>This property enables you to specify a generic email address to send or receive visitor requests.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: <a href="mailto:askvisitor@example.com">askvisitor@example.com</a></td>
</tr>
<tr>
<td>sn_imt_core.visitor_syncing</td>
<td>This property enables visitor synchronization between the Safe Workplace and Workplace Visitor Management applications.</td>
</tr>
<tr>
<td></td>
<td>When a visitor is registered with the Workplace Visitor Management application, the visitor details are also sent to the Safe Workplace application so that other visitor-related actions can be performed.</td>
</tr>
</tbody>
</table>
Properties for Workplace Visitor Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Type: true/false  
• Default value: true  
• Location: System Property [sys_properties] table |

Registering visitors
As an employee, the Workplace Visitor Management application enables you to register visitors in advance.

With Workplace Visitor Management, you can do the following:
• Register visitors and specify their visit date, timings, and visiting location.
• Reserve a complete day or a short duration.
• Specify a co-host, especially if you are unavailable.
• Provide any private information to the receptionist if the visitor has special requests.
• Register an off-site colleague.
• Notify the visitors with all the information that they need during their visit.

You can also use the Virtual agent chat support on the Workplace Service Portal to register a visitor and view your visitor registration details. The chat support enables you to do the following:
• Register a guest.
• Know your expected visitors on the current day.
• Know when your visitor is expected to arrive.
• Cancel a registered visitor

Once you submit the registration, the reception staff receives the registration in the application. When visitors are at the premises, the reception staff checks in the visitors, prints their badges, updates their breaks, and updates their other statuses during the day.

Register a guest
Pre-plan your visitor or off-site colleagues visit. Specify their visit details like date, time, location and more.

Before you begin

Important: Starting with Workplace Safety Management (sn_wsd_core) version 2.1, all updates, and new features are available only on the Workplace Service Portal. The workplace services provided by ServiceNow® are removed from the Service Portal on Workplace Safety Management (sn_wsd_core) beginning with version 2.1. To configure the Workplace service catalog in the Service Portal, see Configure a catalog in Service Portal.

Role required: sn_wsd_core.workplace_user

About this task
Submit this request to register a guest. Specify if there are any additional requirements for the visit as a private note to the reception staff.
Workplace Visitor Management admin and reception staff can also register visitors directly from the application. Navigate to Workplace Visitor Management > Reception Staff > Register Visitors.

You can also register a visitor using the Virtual agent chat support. Navigate to Workplace Safety Management > Workplace service portal > Workplace Service Portal Home and click the chat icon (💬) on the bottom right. Type your question or select Show Me Everything to select from a list of available options to register a visitor.

Procedure
1. Navigate to Workplace service portal > Workplace Service Portal Home.
2. Open the Visitor Management category.
   a. Click Catalog.
   b. Click Browse by Categories.
   c. In the Workplace Services Catalog, select Visitor Management.

   Note: If there are multiple catalogs configured on the portal, go to the Catalogs list and select Workplace Services Catalog > Visitor Management.

3. Select Register a guest.
4. On the form, fill in the fields.

Register a guest form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visit description</td>
<td>Description with details about the purpose of the visit.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of the visit.</td>
</tr>
<tr>
<td>Host</td>
<td>The name of the host of the visitor. By default, the field is set to System Administrator.</td>
</tr>
<tr>
<td>Arrival date and time</td>
<td>The date and arrival time of the visit, shown as the arrival date and time icon (/type).</td>
</tr>
<tr>
<td>Departure date and time</td>
<td>This field is automatically set to 2 hours after the specified arrival date and time. You can change this field by selecting your own time using the departure date and time icon (type).</td>
</tr>
<tr>
<td>All day</td>
<td>Option for visits which last for an entire day.</td>
</tr>
<tr>
<td>Private note to receptionist</td>
<td>Additional requirements or a private note to the receptionist.</td>
</tr>
<tr>
<td>Co-hosts</td>
<td>Co-hosts for the visitor. The co-hosts and the main host are notified about the registration.</td>
</tr>
</tbody>
</table>

5. Select Add an external visitor, to add a visitor.
a. Click Add.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Add an external visitor form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select a known visitor</strong></td>
</tr>
<tr>
<td><strong>Visitor type</strong></td>
</tr>
<tr>
<td><strong>First name</strong></td>
</tr>
<tr>
<td><strong>Last name</strong></td>
</tr>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td><strong>Visitor's email</strong></td>
</tr>
<tr>
<td><strong>Visitor's phone number</strong></td>
</tr>
<tr>
<td><strong>Organization</strong></td>
</tr>
<tr>
<td><strong>Wifi</strong></td>
</tr>
<tr>
<td><strong>VIP</strong></td>
</tr>
<tr>
<td><strong>Parking preferences</strong></td>
</tr>
<tr>
<td><strong>License plate</strong></td>
</tr>
</tbody>
</table>

c. Click Add.

You can edit or remove a row from the form table using the add-remove row icon ( ✗ ).

6. Select **Add a company employee**, to add a colleague.

a. Click Add.

b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Add a company employee form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select a colleague</strong></td>
</tr>
<tr>
<td><strong>Email</strong></td>
</tr>
<tr>
<td>Parking Type</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>License plate</td>
</tr>
</tbody>
</table>

c. Click Add.

You can edit or remove a row from the form table using the Add-remove row icon (♀️ ×).

7. In the Notification options field, select how you and your visitor must be notified about the registration.

8. Click Submit.

Results
Your visitor registration is submitted. You can view your requests.

What to do next
You can check the details of your request or choose to cancel it anytime.

1. Depending on your platform, do one of the following to view your requests.
   - On the Workplace Service Portal, go to the Requests tab to view your requests and reservations.
   - On the Now Mobile app’s navigation bar, tap For Me and scroll down to the My Request section to view your requests.
   - In the virtual agent chat, type your question or select Show Me Everything to select from a list of available options to view your visitor details.

2. If you want to cancel a request, Click Cancel Request.

3. You can search for registered visitors in the Visitors list using the search option.

Manage visitor registrations
As an admin and as a reception staff, you can track visitor registrations and update their status while the visitors are on the premises.

As an admin and as a reception staff, you can perform the following actions on visitor registrations:

- Register visitors using the application as well as the service portal.
- View all the visitor registrations.
- View any visitor registrations for the current day or which were created by you.
- Create visitor-related services for your employees as a self-service.
- Monitor visitor registrations using the Visitor Reception Dashboard.
- Create visitor policies and assign it to workplace locations.

As an admin, you can also view visit logs containing details about the state changes for the visitor registrations.

Update a visitor registration
Track visitor registrations and update the status of a visitor while the visitor is on the premises.

Before you begin
Role required: sn_wsd_visitor.admin or sn_wsd_visitor.staff
Procedure

1. Navigate to Workplace Visitor Management > Visitor Overview.
2. Select any of the following options to update the visitor registration:
   - All Visitor Registrations
   - My Visitor Registrations
   - Today's Registrations
3. Select the visitor registration which you want to update.
4. (Optional) Select multiple registrations if you want to update them with the same status.
5. Based on the state change that you want to make, select any of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check in</td>
<td>Check in the visitor when they enter the premises.</td>
</tr>
<tr>
<td>Print badges</td>
<td>Print the visitor badge for the visitor. A preview of the badge displays before you print.</td>
</tr>
<tr>
<td>Break check out</td>
<td>Check out the visitor when the visitor leaves the premises for a break.</td>
</tr>
<tr>
<td>Break check in</td>
<td>Check in the visitor when the visitor is back to the premises after a break.</td>
</tr>
<tr>
<td>Check out</td>
<td>Check out the visitor when the visitor leaves the premises and ends the visit.</td>
</tr>
<tr>
<td>Didn't show up</td>
<td>The visitor did not show up.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel the visitor registration.</td>
</tr>
</tbody>
</table>

For more information about different states and about allowed state changes on a visitor registration, see Visitor registration states.

Results
The status of the visitor registration is updated.

View visitor registrations
View visitor registrations submitted through the service portal. You can view all visitor registrations, the ones for the current day, and the ones that were made by you.

Before you begin
Role required: sn_wsd_visitor.admin or sn_wsd_visitor.staff

- A reception staff can update the state of the visitor registration.
- You can print badges from anywhere in the Workplace Visitor Management application.

Procedure
1. Navigate to Workplace Visitor Management > Visitor Overview.
2. Select any of the following options to view visitor registrations:
- All Visitor Registrations: Select this option to view all the visitor registrations made through the application.

- My Visitor Registrations: Select this option to view the visitor registrations that you created.

- Today’s Registrations: Select this option to view the current day’s visitor registrations.

3. Select a visitor registration to view its state.

Visitor registration states

The visitor logs display the current state of visitor registrations. These states can be changed to other states.

The different states of a visitor registration are explained as follows.

<table>
<thead>
<tr>
<th>Visitor registration states</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>State</strong></td>
</tr>
<tr>
<td>Planned</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Checked in</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Checked out</td>
</tr>
<tr>
<td>Break checked in</td>
</tr>
<tr>
<td>Break checked out</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Completed</td>
</tr>
<tr>
<td>Cancelled</td>
</tr>
<tr>
<td>No show</td>
</tr>
<tr>
<td>Disappeared</td>
</tr>
</tbody>
</table>
Anonymize a visitor

As an admin, you can anonymize a visitor to delete the visitor record and all the details of the visitor. Any future registrations of the visitor are canceled.

Before you begin
Role required: sn_wsd_visitor.admin

About this task
As an admin, you can anonymize a visitor. Employees can request to anonymize a visitor due to security reasons or for any other reason.

When you anonymize a visitor, the visitor record is deleted. In all current visitor registrations, the visitor data is replaced with a random value. Any future registrations of the visitor are canceled.

Procedure
1. Navigate to System Definition > Tables.
   - In the Label field, type Visitor.
   - In the Name field, type sn_wsd_visitor_visitor.
4. Under Related links, select Show List.
5. (Optional) In the application Filter navigator, type sn_wsd_visitor_visitor.list and search.
6. From the list of visitors, select the visitor that you want to anonymize.
7. On the visitor form, select Anonymize Visitor Data.
8. In the Confirmation dialog box, click OK.

Results
The visitor is anonymized and all the details of the visitor are deleted. Any future registrations for the visitor are canceled, and the data in the fields are replaced with random values.

Create a visitor policy

Define a policy that must be accepted by a visitor prior to their arrival. Send email notification to the visitor about the policy and enable them to accept the policy by replying to the email.

Before you begin
Role required: sn_wsd_visitor.admin

Procedure
1. Navigate to Workplace Visitor Management > Administration > Visitor Policies.
2. Click New.
3. On the form, fill in the fields.

Policy form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of the visitor policy.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the policy.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description about the policy.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the policy. Policy content that should be read and accepted by the visitors.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The visitor policy is added.

**What to do next**
Assign the visitor policy to workplace locations.

**Assign visitor policy to a workplace location**
Add one or more workplace location to a visitor policy. Visitors who are registered to arrive at that locations will receive an email notification in prior to accept the policy.

**Before you begin**
Role required: sn_wsd_visitor.admin

**About this task**
Assign visitor policy to a workplace location.
You can also assign visitor policy by selecting the workplace location in **Building**. Select the building and ensure that the **Visitor policy view** option is enabled. Click **Edit** and assign the policy.

- Go to Building
- Select the building
- Ensure we have the view “Visitor policy view” selected
- Click on Edit to assign the available policies to the location

**Procedure**
1. Navigate to **Workplace Visitor Management > Administration > Visitor Policies**.
2. Select the visitor policy to which you want add the workplace location.
3. (Option)In the Locations related list, apply the policy to internal/external visitors. Select **True** or **False** under the **Required for external** and **Required for internal** column of the workplace location.
4. In the Locations related list, click **Edit**.
5. On the Edit Members form, select the workplace location.
   a. Select the workplace location from the **Collection** column on the left.
   b. Move the selection to the **Locations List** column on the right.

   To move the location, use the add-remove icon (↑)

6. Click **Save**.
Results
The visitor policy is assigned to the selected workplace location.

Create a record producer for visitor management
Make visitor-related services available to employees as a self-service option. Create a record producer to display these services as catalog items in the Workplace Services catalog.

Before you begin
Role required: sn_wsd_visitor.admin

Procedure
1. Navigate to Workplace Visitor Management > Administration > Record producers.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the record producer.</td>
</tr>
<tr>
<td>Table name</td>
<td>Visitor Registration (sn_wsd_visitor_visitor_registration) table that the record producer is associated with.</td>
</tr>
<tr>
<td>Note:</td>
<td>Make sure that the Visitor Registration table for the record producer matches that of the associated workplace service.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model table if relevant for the record producer.</td>
</tr>
<tr>
<td>Application</td>
<td>This field is set to Workplace Visitor Management.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the record producer for use.</td>
</tr>
<tr>
<td>Expand help for all questions</td>
<td>Select this option to enable users to expand help for all questions.</td>
</tr>
</tbody>
</table>

4. Fill the following tab fields appropriately:
   • What it will contain
   • Accessibility
   • Generated Record Data
   • Portal Settings

5. In the What it will contain tab, provide the following script:
   ```javascript
   var visitorService = new sn_wsd_visitor.WSDVMVisitorService();
   visitorService.createVisitorRegistrationRecord(producer, current.sys_id);
   producer.portal_redirect = "?id=my_requests";
   ```

6. In the Variables tab, configure the variables for the Workplace Services catalog item as appropriate.
Variables collect information from the user, and are used to ask questions and map answers to fields.
To learn more about the different types of variables and how to configure them, see Types of service catalog variables.

7. Click Submit.

Results
The record producer is created.

View visit logs
View the visit logs which display all the state changes of a visitor registration.

Before you begin
Role required: sn_wsd_visitor.admin

About this task
You can view all the status changes of a visitor registration at any point. You can also make status updates from here.

Procedure
1. Navigate to Workplace Visitor Management > Administration > Visit Logs.
2. Search for the visitor registration which you want to view.
3. (Optional) View the current and previous states by selecting the info icon (i) next to the visit log.
   For more information about each state, see Visitor registration states.

Visitor Reception Dashboard
With the Visitor Reception Dashboard, you can track visitor registrations created in the application on any day. Track the statuses of visitors who are on the premises. View the number of visitors who are expected, have checked in, have checked out, are on break, or have not showed up.
To access the Visitor Reception Dashboard, navigate to **Workplace Safety Management > Workplace dashboards > Visitor reception.**

Select a location in the **Visiting Location** field at the top to display reports for that location in separate tabs.

### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Workplace Visitor Management manager: Needs visibility into the real-time status and the number of the visitor registrations created. | sn_wsd_visitor.manager | - Review current day’s visitor registrations  
- Monitor visitor registrations created by employees.  
- Monitor visitors who are currently checked in and the visitors who have checked out.  
- Monitor visitors who are on break. |
<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Monitor expected visitors on the current day and at any hour.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check cancelled registrations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check visitor's who did not show up.</td>
</tr>
</tbody>
</table>

**Reports**

The Visitor reception dashboard allows you to view the following reports.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected visitors today</td>
<td>Single score</td>
<td>Number of expected visitors on the current day.</td>
</tr>
<tr>
<td>Visitors that are checked in</td>
<td>Single score</td>
<td>Number of visitors who are currently checked.</td>
</tr>
<tr>
<td>Visitors on break</td>
<td>Single score</td>
<td>Number of visitors who are currently on break.</td>
</tr>
<tr>
<td>Visitors that are checked out</td>
<td>Single score</td>
<td>Number of visitors who have checked out on the current day.</td>
</tr>
<tr>
<td>Cancelled visitor registrations</td>
<td>Single score</td>
<td>Number of cancelled visitor registrations.</td>
</tr>
<tr>
<td>Visitors expected today per hour</td>
<td>Column</td>
<td>Number of visitors expected at any hour on the current day. It shows the trend of the day according to when visitors are expected.</td>
</tr>
<tr>
<td>Expected visitors today</td>
<td>List</td>
<td>Visitor registrations of the expected visitors on the current day.</td>
</tr>
<tr>
<td>Visitors that are checked in</td>
<td>List</td>
<td>Visitor registrations of the visitors who are currently checked in.</td>
</tr>
<tr>
<td>Visitors on break</td>
<td>List</td>
<td>Visitor registrations of the visitors who are currently on break.</td>
</tr>
</tbody>
</table>
Workplace Calendar Synchronization

Enhance your workplace’s reservation experience by synchronizing your reservations with your calendar provider by using the ServiceNow® Workplace Calendar Synchronization application. Enable your employees to make reservations with ServiceNow® Workplace Reservation Management or with your organization’s calendar service providers, such as Microsoft Exchange Online.

When synchronized, reservations are directly added to the calendars of your employees and of your workplace items. The Workplace Calendar Synchronization application supports the Microsoft Exchange Online, and Google Workspace calendar services.

Employees can also view their reservation details in a calendar service such as Microsoft Outlook. Workplace Calendar Synchronization supports Microsoft Graph Security API.

The Workplace Calendar Synchronization application uses the calendar service as the primary source to check for the availability of a workplace item. The application enables you to perform the following actions.

**Synchronize reservations**

As an employee, you can do the following:

- Make a reservation for a workplace item in both the Workplace Reservation Management application and your calendar service.
- Check the availability of workplace items using both Workplace Reservation Management and your calendar service.
- Plan meetings using your calendar service, add a location, and invite attendees. The meeting is synchronized to Workplace Reservation Management as a reservation.
- See all your workplace reservations in a single place.

**Specify connection and synchronization settings**

As an admin, you can do the following:

- Configure connections with a calendar service.
- Configure workplace items that require synchronization when they are reserved.
- Monitor events and calendar events that are created in the applications.
- View synchronization deltas (Sync deltas) that are generated in the application. A Sync delta contains a token using which the application retrieves only the changes that happened since the last interval instead of displaying the complete calendar history of the workplace item.

You can create a connection with your calendar service by using the following configuration form:

---

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visitors that are checked out</td>
<td>List</td>
<td>Visitor registrations of the visitors who have checked out.</td>
</tr>
<tr>
<td>Cancelled visitor registrations</td>
<td>List</td>
<td>Cancelled visitor registrations.</td>
</tr>
</tbody>
</table>
Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Workplace Calendar Synchronization

Install the Workplace Calendar Synchronization application from ServiceNow Store applications. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Before you begin

Complete the following setup instructions:

1. Navigate to Subscription Management > Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.
2. Verify that the following plugins are activated:
Workplace Safety Management (sn_wsd_core) version 2.3.3
Workplace Reservation Management (sn_wsd_rsv) version 1.3.3

Use the following details when required:
- Name of the application: Workplace Calendar Synchronization
- ID of the application: sn_wsd_rsvsync

Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the application by using the filter criteria and search bar.
   Search for the application by its name (Workplace Calendar Synchronization) or ID (sn_wsd_rsvsync). If you cannot find the application, you may have to request it from the ServiceNow Store.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
   A list of dependent plugins and applications are displayed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Workplace Calendar Synchronization.
5. Optional: If demo data is available and you want to install it, click Load demo data.
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   ! IMPORTANT: If you don't load the demo data during installation, it's unavailable to load later.

6. Click Install.

Components installed with Workplace Calendar Synchronization
Several types of components are installed with the Workplace Calendar Synchronization application, including tables and user roles.

! Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed with Workplace Calendar Synchronization

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace Calendar Synchronization admin [sn_wsd_rsvsync.admin]</td>
<td>As a system admin, you can do the following:</td>
<td>None</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>• Access the application completely.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create, manage, and edit a Connection configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Establish OAuth credentials.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create, manage, and edit Calendar providers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>As a Workplace Calendar Synchronization admin, you can do the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create, manage, and edit a Reservable Sync Configuration.</td>
<td></td>
</tr>
</tbody>
</table>

### Tables installed with Workplace Calendar Synchronization

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Item [sn_wsd_rsvsync_calendar_item]</td>
<td>Stores information about all the calendar items that are created in the application.</td>
</tr>
<tr>
<td>Synchronization Delta [sn_wsd_rsvsync_delta]</td>
<td>Stores information about the last successful synchronization of a workplace item. Each sync delta contains a token that indicates how much information was synced last time so that a delta with the new changes can be returned in the next request instead of the complete calendar history.</td>
</tr>
<tr>
<td>Event [sn_wsd_rsvsync_event]</td>
<td>Store information about all the events that are created in the application. Events are created for actions such as create, read, update or delete.</td>
</tr>
<tr>
<td>Provider [sn_wsd_rsvsync_provider]</td>
<td>Stores information about the configuration settings that are used for synchronizing the reservations with the calendar provider.</td>
</tr>
<tr>
<td>Reservable Sync Configuration [sn_wsd_rsvsync_reservable_sync_configuration]</td>
<td>Stores information about all the workplace items that are configured to synchronize with a calendar service whenever a reservation is made.</td>
</tr>
</tbody>
</table>

**Note:** Starting from Workplace Calendar Synchronization version 2.0.1, for Microsoft Exchange Online, only Webhook is used for an improvised approach.
Properties installed with Workplace Calendar Synchronization

Customize the properties available with Workplace Calendar Synchronization.

These properties are available for Workplace Calendar Synchronization.

Note: All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.

Properties for Workplace Calendar Synchronization

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_rsvsync.use_user_default_tz</td>
<td>This property enables you to synchronize reservation created by a user according to their timezone. Either the system’s time zone or the user’s time zone is used to update and synchronize reservation. Firstly, the property checks if the user has a timezone specified or not. If the user has not specified any timezone, the system’s timezone is used. Again, if the system has no timezone specified, then the property uses the UTC timezone. Reservations synchronized from Microsoft Exchange to Workplace Service Delivery are not impacted.</td>
</tr>
<tr>
<td>sn_wsd_rsvsync.create_blocking_rsv</td>
<td>This property enables you to create blocker reservations on workplace locations that are synchronized with the calendar provider.</td>
</tr>
<tr>
<td>sn_wsd_rsvsync.max_event_retry_count</td>
<td>This property enables you to specify after how many times an event must be reprocessed.</td>
</tr>
</tbody>
</table>

Reservation synchronization

When you make a reservation using the calendar service or the ServiceNow® Workplace Reservation Management application, the Workplace Calendar Synchronization application synchronizes reservation-related information based on the configuration made on requested workplace item.

If the workplace item is configured to synchronize with the calendar service, events are sent to the calendar service during the synchronization. These events check for the reservation confirmation and if there are any new reservations requested on the workplace item.

When a reservation is made, the following information is synchronized:

- Details of the reserved location
- Subject of the reservation
• Start and end times of the reservation
• Privacy of the reservation

Synchronization involves the following processes:
• A scheduled job runs every five minutes to get the latest information from the workplace items.
• After the scheduled job is run, the Sync delta returns details of the changes that occurred between the previous and the current synchronizations.
• The synchronization returns information about new, updated, and canceled reservations.
• The reservations are updated, created, or deleted in Workplace Reservation Management. The reservation states are set to Awaiting confirmation, confirmed, canceled.

Workplace Calendar Synchronization Setup
As an admin, you can configure connections and add calendar providers to synchronize reservations.

The Workplace Calendar Synchronization enables you to perform the following actions:
• Configure connection & credential aliases: Specify the connection type and the configuration templates.
• Configure calendar providers: Select the calendar processor and specify how and when to perform synchronization.
• Setup connection & credential aliases for OAuth 2.0.
• Sync calendar items: The interval changes of the spaces are synchronized from the calendar provider and processed in the Workplace Reservation Management. This scheduled job requires a user account to run and the account must have the system admin role assigned to it.
• Reprocess Events: In case an event results in error, the system will reprocess the event. This scheduled job requires a user account to run and the account must have the system admin roles assigned to it.

Create a connection for synchronization
Set up a connection with the calendar service. Specify the connection type and select a configuration template.

Before you begin
Role required: admin

Procedure
1. Navigate to Workplace Calendar Synchronization > Configuration > Connection configuration.
2. Click New.
3. On the form, fill in the fields.

Connection & Credential Aliases form
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the alias.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ID</td>
<td>System-generated ID.</td>
</tr>
<tr>
<td>Application</td>
<td>Application of the connection. This field is auto-generated. Make sure this field is set to <strong>Workplace Calendar Synchronization</strong>.</td>
</tr>
<tr>
<td>Type</td>
<td>Alias type. Select <strong>Connection and Credential</strong>.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Type of connection.</td>
</tr>
<tr>
<td>Support Multiple Active Connections</td>
<td>Option to specify if the alias supports multiple active connections.</td>
</tr>
<tr>
<td>Default Retry policy</td>
<td>Default retry policy that is associated with the connection alias.</td>
</tr>
<tr>
<td>Configuration Template</td>
<td>Template that defines the inputs that are required to set up the spoke.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The connection is configured.

**What to do next**
Create a Connection and Credential alias.

**Create a connection alias for Microsoft Exchange**
Connect to the Microsoft Exchange Online service by creating a connection. Provide information that is used by HTTPs actions or activities to connect to the service.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Workplace Calendar Synchronization > Configuration > Connection configuration**.
2. Click **New**.
3. On the form, fill in the fields.

### Connection & Credential Aliases form
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the alias.</td>
</tr>
<tr>
<td>ID</td>
<td>System-generated ID.</td>
</tr>
<tr>
<td>Application</td>
<td>Application of the connection. This field is auto-generated. Make sure this field is set to <strong>Workplace Calendar Synchronization</strong>.</td>
</tr>
<tr>
<td>Type</td>
<td>Alias type. Select <strong>Connection and Credential</strong>.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Type of connection.</td>
</tr>
<tr>
<td>Default Retry policy</td>
<td>Default retry policy that is associated with the connection alias.</td>
</tr>
<tr>
<td>Configuration Template</td>
<td>Template that defines the inputs that are required to set up the spoke.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Support Multiple Active Connections</td>
<td>Option to specify if the alias supports multiple active connections. Clear this check box.</td>
</tr>
<tr>
<td>Default Retry policy</td>
<td>Default retry policy that is associated with the connection alias. Select Default HTTP Retry Policy.</td>
</tr>
<tr>
<td>Configuration Template</td>
<td>Template that defines the inputs that are required to set up the spoke.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Results
The connection is configured.

What to do next
Create a Connection & Credentials alias for Microsoft Exchange.

Create a Connection & Credentials alias for Microsoft Exchange
Establish OAuth credentials for Microsoft Exchange so that you can synchronize reservations.

Before you begin

🎁 Note: Starting from Workplace Calendar Synchronization version 2.0.1, to synchronize the reservations automatically with Microsoft Exchange Online, create a connection with Microsoft Exchange spoke version 3.2.1. The following procedure is no longer required if you have upgraded to Workplace Calendar Synchronization version 2.0.1. For more information on how to install Microsoft Exchange spoke and to set up connection, refer to .

Role required: admin

Procedure
1. Navigate to Workplace Calendar Synchronization > Configuration > Connection configuration.
2. Select the Microsoft Exchange alias.
3. In the Connections tab, click New.
4. On the form, fill in the fields.

HTTP(S) Connection form

<table>
<thead>
<tr>
<th>Name</th>
<th>Name of the HTTPs connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credential</td>
<td>Credential record that is used to authorize the connection. To set this field, do the following:</td>
</tr>
<tr>
<td></td>
<td>a. Click the credential lookup icon (🔍).</td>
</tr>
<tr>
<td></td>
<td>b. In the Credentials dialog box, click New.</td>
</tr>
<tr>
<td></td>
<td>c. Select OAuth 2.0 Credentials.</td>
</tr>
<tr>
<td></td>
<td>d. On the OAuth 2.0 Credentials form, specify the values for the credentials.</td>
</tr>
</tbody>
</table>
i. In the Name field, provide a name for the credential, such as ServiceNow Microsoft Exchange credentials.

ii. In the OAuth entity Profile field, enter the OAuth entity profile information.

iii. Click Submit.

**Connection alias**
Alias record that is associated with the connection. Using an alias enables you to update the connection record without having to reconfigure any actions or activities that use the alias.

**Active**
Option to activate the connection.

**Domain**
Domain where the connection is applicable.

**URL builder**
Option to enable the system to build the connection URL. Clear this check box.

**Connection URL**
This field is not used by the application. You can enter a random value.

**Use MID server**
Option to use a MID Server for this connection. Clear this check box.

5. Click Submit.

**Configure calendar providers**
Add a calendar service that your reservations can be synchronized with.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to Workplace Calendar Synchronization > Configuration > Calendar Providers.
2. Click New.
3. On the form, fill in the fields.

**Provider form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the calendar service.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the calendar service.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the calendar provider.</td>
</tr>
</tbody>
</table>

**Provider Configuration**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar processor</td>
<td>Calendar processor for the synchronization. Currently, the application only supports GraphAPI.</td>
</tr>
<tr>
<td>Page size</td>
<td>Page size of the calendar items.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sync batch size</td>
<td>Size of batches during a synchronization. This field is automatically set to <strong>500</strong>, which means a sync batch handles 500 items at a time. If there are more than 500 items, the rest is displayed in the next sync batch.</td>
</tr>
<tr>
<td>Sync batch interval</td>
<td>Time interval between sync batches. This field is automatically set to <strong>60</strong> seconds.</td>
</tr>
<tr>
<td>Sync start date time</td>
<td>Start date and time of the synchronization. The sync generates information from this date.</td>
</tr>
<tr>
<td>Sync end date time</td>
<td>End date and time of the synchronization. The sync generates information until this date. The recommended setting is at least 5 years from the <strong>Sync start date time</strong>.</td>
</tr>
<tr>
<td>Strict mode</td>
<td>Option to restrict emails so that employees do not directly receive emails. Instead, notifications are sent to a single email address at the organization. This option also restricts employees from making any calendar reservations. If the option is enabled, employees cannot update or cancel a reservation using the calendar service. They can only make changes using the Workplace Reservation Management application.</td>
</tr>
<tr>
<td>Strict mode email</td>
<td>Email which is used to create reservations and to receive reservation-related notifications if the <strong>Strict mode</strong> is enabled. Employees are considered as invitees in the reservation.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The calendar provider is added.

**Add a Reservable Sync Configuration**
Add workplace items that must be synchronized with the calendar provider whenever an employee makes a reservation.

**Before you begin**
Role required: **sn_wsd_rsvsync.admin**

**Procedure**
1. Navigate to **Workplace Calendar Synchronization > Configuration > Reservable Sync Configuration**.
2. Click **New**.
3. On the form, fill in the fields.
### Reservable Sync Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Workplace item that you want to synchronize with the calendar provider whenever an employee makes a reservation. For example, this field can be the location of a meeting room, conference room, or board room.</td>
</tr>
<tr>
<td>Reservable module</td>
<td>The reservable module which contains the workplace item.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address of the workplace room, such as for a meeting room or conference room. The email address is used to check calendar statuses and events. If an email address is already specified in the room configuration form, this field is auto-filled with that email address.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the workplace item for synchronization.</td>
</tr>
</tbody>
</table>

#### Provider Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>Calendar provider that you want to synchronize with the workplace item.</td>
</tr>
<tr>
<td>No request</td>
<td>Option to test synchronization. Select this option to test if a reservation is synchronized or not when the workplace item is active. Validate the configuration and events to ensure that everything is set up correctly. Selecting this option will only generate events and not send them to the calendar service.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Results**
The workplace item is added.

**Note:** When a Reservable Sync configuration is changed or updated, the synchronization deltas (Sync delta) are cleared from the application.

**Integrate Microsoft Exchange to connect with Workplace Service Delivery**
Set up authentication with Microsoft Exchange. Create an app registration in Microsoft Azure.

**Before you begin**
Role required: Exchange administrator

**Procedure**

1. Log in to the Microsoft Azure portal.
2. Navigate to **Azure Services > Azure Active Directory > Manage > App registrations**.
3. Add a web platform.
a. Navigate to Manager > Authentication.

b. Navigate to Add a platform > Web applications > Web.

c. On the Configure Web form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirect URL</td>
<td>Enter a URL in the format: https://[instance].service-now.com/oauth_redirect.do</td>
</tr>
<tr>
<td>Implicit grant</td>
<td>Check Access tokens, and ID tokens</td>
</tr>
</tbody>
</table>

d. Click Configure.

4. Add a client secret.
   a. Navigate to Manager > Certificates and secrets.
   b. In the Description field, enter a short description about the secret.
   c. Under Expires, select an expiry.
   d. Click Add.

5. Add a permission.
   a. Navigate to Manager > API permissions.
   b. Click Add a permission.
   c. Select Microsoft Graph.
   d. Select Application permissions.
   e. Under Calendars, select Calendars.ReadWrite.
   f. Click Add permissions.
   g. On the Configured permissions screen, click Grant admin consent for ServiceNow.

Results
The authentication with Microsoft Exchange is set up.

What to do next
After the setup, perform the following actions:

- Configure new rooms(resources) in Microsoft Exchange to synchronize reservations.
- After synchronization, ensure that the meeting subject is unchanged. If the meeting subject is changed, use Microsoft PowerShell to make changes.

Managing calendar synchronizations
As an admin, monitor the number of events and calendar items in the Workplace Calendar Synchronization application whenever a reservation is synchronized.

As an admin, the application enables you to view and manage the following:
• Events
• Calendar items
• Synchronization deltas

Events
Every action during a reservation synchronization triggers an event. These actions include creating, updating, or canceling a reservation. The Workplace Calendar Synchronization handles these events and sends notifications to the calendar services.

• An event can create one or more calendar items.
• An event contains a request and a response to the request.
• To ensure that multiple calendar services can communicate with Workplace Reservation Management, events translate the reservations and messages from the calendar provider into standardized actions in Workplace Reservation Management.

When a workplace item is synchronized with the calendar service, an event is created to get the latest details. The response from the calendar service also creates an event. Similarly, events are created whenever a reservation is created or updated within Workplace Reservation Management for workplace items that are configured to synchronize. You can convert an event into JSON format. You can also re-process an event if there was an error or for any other reason.

Calendar items
Every action performed by the calendar service is converted to a calendar item that is handled in the Workplace Reservation Management application. A calendar item is either a new reservation or a reservation update. Using calendar items, you can also create, update, or cancel a reservation in the Workplace Reservation Management application. You can convert a calendar item into JSON format

Synchronization deltas
When a workplace item is synchronized, a delta key is generated. A delta key is used and updated every time a workplace item synchronizes with the calendar service. Each sync delta contains a token that indicates how much information was synced last time so that a delta with the new changes can be returned in the next request instead of the complete calendar history. You can know the details of the workplace item such as the number of reservations created or any changes made on the reservation. The delta key ensures that only the changes that occurred between the previous and the current synchronization are retrieved. The delta key retrieves details of any new, updated, and canceled reservations on the workplace item.

View synchronization details
Check the number of the events and calendar items that are created during a synchronization.

Before you begin
Role required: sn_wsd_rsvsync.admin

Procedure
1. Navigate to Workplace Reservation Synchronization > Synchronization.
2. Select any of the following options to view the synchronization details:
• **Calendar Items**: Option to view calendar items that are created after a reservation synchronization.

• **Events**: Option to view events that are created by actions taken on a reservation.

• **Sync Deltas**: Option to view synchronization deltas of workplace items that are synchronized.

**Synchronization Health Dashboard**

Use this dashboard to track the reservation synchronization. Monitor number of events and calendar items created in the application and other details related to them.

![Synchronization Health Dashboard](image)

To access the Synchronization health dashboard, navigate to **Workplace Safety Management > Workplace dashboards > Synchronization management.**
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>System administrator and Workplace Calendar Synchronization admin: Needs visibility into the real-time status of the events and calendar items created in the application.</td>
<td>sn_wsd_rsvsync.admin</td>
<td>• View Connection configuration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View Calendar providers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create, manage, and edit a Reservable Sync Configuration.</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total events today</td>
<td>Single score</td>
<td>Number of events created on the current day.</td>
</tr>
<tr>
<td>Calendar items generated today</td>
<td>Single score</td>
<td>Number of calendar items generated in the current day.</td>
</tr>
<tr>
<td>Breakdown calendar items by type</td>
<td>Pie breakdown</td>
<td>Breakdown of the calendar items based on their type</td>
</tr>
<tr>
<td>Calendar items generated over last 7 days</td>
<td>Step time</td>
<td>Number of calendar items generated in the last 7 days.</td>
</tr>
<tr>
<td>Events processed over last 7 days</td>
<td>Step time</td>
<td>Number of events processed in the last 7 days.</td>
</tr>
</tbody>
</table>
Workplace Space Mapping

Workplace Space Mapping enables you to take advantage of the already created building maps produced by applications like Mappedin. The Workplace Space Mapping integration with Mappedin allows you to import the data as buildings, floors, spaces, and rooms.

Using Workplace Space Mapping

With Workplace Space Mapping, your organization can integrate with third-party applications such as Mappedin, customize imported maps, and manage the required data.

Type mappings

When you integrate with a third-party map application, you must first associate the third-party’s map types to the map types used by Workplace Service Delivery. This association
ensures that your spaces are imported to the correct table with the correct type (Workplace and Desk). The base system provides entries that can be used.

**Import flow**

The weekly (Saturday) **Auto-Import Buildings** iHub Flow keeps your map up to date by querying the API of your integrated applications. Any changes to one building in the application's software should be reflected in Workplace Space Mapping.

For example, if you integrate with Mappedin and the Auto-Import Buildings iHub Flow runs successfully:

- The Auto-Import Buildings iHub Flow queries for all buildings associated with Mappedin.
- The Auto-Import Buildings iHub Flow works with the Mappedin export API to look for any changes to a building made by Mappedin. If there are changes, the building is updated.

**Note:** For more information, see Flow Designer.

**Import a new building**

You can define the building details like location, floors, areas, and spaces of an imported Mappedin map.

**External IDs**

Use external IDs to resolve spaces that don’t match locations between Workplace Service Delivery and Mappedin after importing a building or for existing buildings. For more information, see Use external IDs to match spaces between Workplace Service Delivery.

**Interactive location directories**

View interactive Mappedin floor maps of your company's buildings in the Workplace Service Portal Location directory.

**Important:** For Workplace Space Mapping version 1.3.2, to view the Location directory on the Workplace Service Portal, follow the procedure specified in the Knowledge article.

The Workplace Service Portal enables you to view any of your workplace locations on the map. Select a location from the list of your company's sites, campuses, and buildings.

You can also view the location directory in the Employee Center. On the home page, navigate to **Workplace > Browse all Workplace** and select the workplace service.

You can also search for a user directly on the map. Specify the user's name or their location details in the search field. The directory returns the details of the user based either on their recent desk reservation or based on their workplace profile's location.

**Important:** Ensure that the latitude and longitude of your company's regions, sites, campuses, and buildings are set up. If the latitude and longitude are not specified, then you cannot view a campus or its buildings on the map. Contact your admin for more information.

**Interactive floor map**

The Workplace Service Portal Location directory feature enables you to view an interactive floor map of a building. You can also view your campus and building on the world map. The features enable you to make selections directly on the map. You can also use your keyboard, drag your cursor on the map to view locations on the map.
Interactive floor map

With the interactive floor map, you can do the following:

• Zoom into areas.
• Raise a general inquiry about a space. This option is available only if you have Workplace Case Management application installed.
• Get directions to a space.

The interactive floor map is designed with smart labeling. You can use the zoom options to get a closer or a higher-level view of the floor map. The space labels appear based on your zoom actions. The map also enables you to switch between floors. The map enables you to select a location from a list under the search option or directly on the map.

From the floor map, you can directly submit a general workplace inquiry that is related to a space. Select the space on the map directly and click Raise a general inquiry option. The option navigates you to the Submit a general request form where you can provide further details. The map pre-fills the location details. For more information, see Raise help request for a workplace inquiry.

The interactive floor map also enables you to view directions to a space. You can get directions to a space that is located on the same floor or on another floor. Specify a start point and an end point directly on the map. Use the zoom option on the map to get a closer view of the direction. You can also select the start and end points on the selection panel under the search option and also get the direction details.

Maintain import properties

Use Import Properties when you create your own credential records, scheduled imports, or data sources. Currently, the properties are configured for the records used when importing.

Before you begin
Role required: sn_wsd_mappedin.admin

Procedure
1. Navigate to Space Mapping > Mappedin Administration > Import properties.
   
   **Note:** Only make edits if you are configuring your own credential records, scheduled imports, or data sources.

2. Make edits to properties.

3. Click Save.

4. Enter sys_properties.list in the navigation filter and open the following properties

<table>
<thead>
<tr>
<th>System property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_core.external_id_generator.field</td>
<td>Defines the external ID.</td>
</tr>
<tr>
<td>sn_wsd_core.external_id_generator.max_buildings</td>
<td>The maximum number of buildings to generate IDs for with a single selection.</td>
</tr>
<tr>
<td></td>
<td>50 is the default.</td>
</tr>
<tr>
<td>sn_wsd_core.external_id_generator.max_spaces</td>
<td>The maximum number of spaces to generate IDs for at a given time.</td>
</tr>
<tr>
<td></td>
<td>The default is 5000.</td>
</tr>
</tbody>
</table>
### System property

<table>
<thead>
<tr>
<th>System property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_wsd_core.external_id_generator.stagger</code></td>
<td>The amount of time (in seconds) to stagger processing external ID generations. The default is 300 seconds.</td>
</tr>
</tbody>
</table>

### Convert Mappedin data to Workplace Space Mapping data

Use the **Mappedin Type Mappings** table to convert data from Mappedin to Workplace Space Mapping data.

The **Mappedin Type Mappings** table has configurations to convert the Type and Subtype data used in a Mappedin map to **Table** and **Space type** used in Workplace Safety Management.

### Terms

The terms used in Mappedin and how they relate to Workplace Safety Management:

<table>
<thead>
<tr>
<th>Mappedin term</th>
<th>Workplace Safety Management term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Venue</td>
<td>Building</td>
</tr>
<tr>
<td>Map</td>
<td>Floor</td>
</tr>
<tr>
<td>Location</td>
<td>Spaces</td>
</tr>
</tbody>
</table>

### Mappedin data

For example, you want to convert a Mappedin map with the following information:

- Single floor building
- 14 total locations
  - 10 desks (Mappedin type = Desk)
  - Two conference rooms (Mappedin type = Meeting room)
  - Two restrooms (Mappedin type = Amenities, Subtype = Universal Washroom)

### Workplace Safety Management data

You want to convert the Mappedin data from the 14 locations, and want them converted to:

- Desks
- Rooms
- Restrooms

**Note:** You don’t want all the Mappedin data to be converted to Spaces or Desks.

### Type mappings

To ensure your locations move to the correct **Space** (`sn_wsd_core_space`) or **Room** (`sn_wsd_core_room`) tables, and ensure that the locations have the correct type (Restroom or Desk), make the following type mappings in the **Mappedin Type Mappings** table:
• Mappedin locations with the type = Desk (no subtype) converted to the Space (sn_wsd_core_space) table and have the Space type set to Workspace/Desk.

• Mappedin locations with the type = Meeting room (no subtype) converted to the Room (sn_wsd_core_room) table and have the Space type set to Room.

• Mappedin locations with the type = Amenities and subtype = Universal Washroom converted to the Space (sn_wsd_core_space) table and have the Space type set to Restroom.

You can import a Mappedin building (single floor building) and the 14 locations go to the correct tables and have the correct types.

**Maintain type mappings**

Use **Type mappings** to convert the Type and Subtype locations in Mappedin to the Table and Space type used in Workplace Space Mapping.

**Before you begin**

Role required: sn_wsd_mappedin.admin

---

**Important:** In the Workplace Service Delivery Suite, from Workplace Safety Management version 2.5.3, the **Space type (space_type)** choice field is depreciated. After the upgrade, Space types are configured in the **Space Type Configuration**. The **Space type (space_type)** field is migrated as **Space type (location_type)** field in the Space table [sn_wsd_core_space]. Customers having customization on the depreciated **Space type (space_type)** field are advised to manually migrate their flow to use the new **Space type (location_type)** field. A new fix script, **Populate Location Type from Space Type**, is introduced to execute the schedule job. **Populate location_type from space_type**, on the Space table [sn_wsd_core_space] to migrate the depreciated **Space type (space_type)** field value to the new **Space type (location_type)** field.

---

**Procedure**

1. Navigate to **Space Mapping > Mappedin Administration > Type mappings**.

2. Click **New**. Fill in the fields.

**Mappedin Type Mapping**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mappedin type</td>
<td>The Mappedin Location type. When a Mappedin map imports, the type is associated with the Space type. The base system provides Mappedin types and subtypes that are associated with Workplace Safety Management Table and Space type.</td>
</tr>
<tr>
<td>Mappedin subtype</td>
<td>The Mappedin Location Amenities type. For example:</td>
</tr>
<tr>
<td></td>
<td>• Women's washroom</td>
</tr>
<tr>
<td></td>
<td>• Men's washroom</td>
</tr>
</tbody>
</table>
The Space (sn_wsd_core_space) table you want to import a Mappedin Location into.

**Note:** The Location type and Subtype must match the Mappedin type and Mappedin subtype fields.

**Space type**

The space type you are associating a Mappedin location.

**Note:** The Location type and subtype must match the Mappedin type and Mappedin subtype fields.

The value in this field appears on the rendered map when an employee reserves a space.

**Note:** To configure new space types, see Add a space type configuration.

---

3. Click **Submit** or **Update**.

Import a new building - Mappedin

Use **Import a new building** to import the Mappedin map and define the building details.

**Before you begin**

Role required: sn_wsd_mappedin.admin

**Note:** Before running an import, back up the building, floor, and spaces. For more information, see Exporting data.

**Procedure**

1. Navigate to **Workplace Safety Management > Administration > Import a new building**.
2. Fill in the fields.

**Mappedin venue**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A unique number automatically generated by the application that identifies the building.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the building.</td>
</tr>
<tr>
<td>Region</td>
<td>Geographic location of the building. Click the Lookup using list icon to view a list of regions you can select.</td>
</tr>
<tr>
<td>Site</td>
<td>The location of the building within a region.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon to view a list of sites you can select.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus if you have multiple buildings at a site.</td>
</tr>
<tr>
<td>Select a venue to import</td>
<td>The name of the Mappedin venue you want to import.</td>
</tr>
<tr>
<td>External ID</td>
<td>The Mappedin external ID that represents the map you are importing.</td>
</tr>
<tr>
<td></td>
<td>The value defaults to the name of the Mappedin venue.</td>
</tr>
<tr>
<td>Note: After selecting a venue, do not change the External ID.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Option indicating whether this building is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option indicating whether a workplace user can reserve spaces for the building.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>The group that manages the space reservation for the building.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon to view a list of groups you can select.</td>
</tr>
<tr>
<td>Managed by</td>
<td>The workplace manager of the group that manages the space reservation for the building.</td>
</tr>
<tr>
<td></td>
<td>Click the Lookup using list icon to view a list of group managers you can select.</td>
</tr>
</tbody>
</table>

3. Click **Import**.  
   The **Import Building On-Demand** designer flow initiates. For more information on designer flows, see **Flow Designer**. You can also check the Import Sets to see if the process was successful. For more information, see **Import sets key concepts**, The **Floors**, **Areas**, and **Spaces** related list tabs appears. If values do not appear, try refreshing the form.

4. Review the imported Mappedin data and make corrections.

5. Click **Update**.

**Import an existing building - Mappedin**

Follow these steps to import an existing building for a Mappedin map.

**Before you begin**

Role required: sn_wsd_mappedin.admin

**Procedure**

1. Create external IDs for the buildings you want to import. For instructions, see **Use external IDs to match spaces between Workplace Service Delivery**.  
   A Confirm pop-up appears.

2. Click **Yes**.
An email arrives with links to the buildings, floors, and space lists in a specific view. The list layout in the email has columns relevant to Mappedin.

3. Export the records in a spreadsheet and send to Mappedin with the floor plans. Mappedin creates floor plans with the external IDs.


5. Select the building and click the Update this building’s Mappedin import related link.

6. From the Select a venue to import list, select the venue.

7. Select Update.

Use external IDs to match spaces between Workplace Service Delivery
Use external IDs to resolve spaces that don’t match locations between Mappedin and Workplace Service Delivery after importing a building or for existing buildings.

Before you begin
Role required: sn_wsd_mappedin.admin

Procedure

2. Click a building that has spaces that don’t match locations.

3. Click the Generate external IDs related link.

4. Click the Spaces tab. External IDs appear for each space. You can also create external IDs for multiple buildings.

5. From the Buildings list, check each building that you want external IDs for.

6. Click Action on selected rows and select Generate external IDs.

⚠️ Note: Buildings with spaces that have existing external IDs are ignored.

7. Click Yes on the Confirm pop-up.
   An email notification verifies the generated external IDs for the spaces, floors, and buildings. Use the links in the email to export a file that you can provide to Mappedin.

Workplace Space Mapping reference
Learn more about Workplace Space Mapping and the components installed with it, such as specific user roles.

Components installed with Workplace Space Mapping
Several types of components are installed with Workplace Space Mapping, including tables and user roles.

Roles installed with Workplace Space Mapping

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workplace Space Mapping admin</td>
<td>As a system admin, you can do the following:</td>
<td>sn_wsd_mappedin.admin</td>
</tr>
</tbody>
</table>
## Workplace Space Management

Efficiently supervise every single location of your organization by using the ServiceNow® Workplace Space Management application.

Make efficient use of spaces in your workplace. The Workplace Space Management application enables you to do the following:

- Make the best use of spaces on a floor.
- Track real estate expenses using the space utilization tools.
- Manage space assignments, onboarding, and space usages to improve productivity.
- Measure the area of workplace locations and configure flexible and permanent space types within the workplace.
- Implement proactive workplace cleaning schedules with templates, checklists, and planned tasks.

### Enhanced space administration

The Workplace Space Management application is an enhanced and upgraded version of the existing Space administration module that is available in the ServiceNow® Workplace Safety Management application. While you have a complete access to the Workplace Safety Management application, the Workplace Space Management application in addition enables you to perform workplace-related forms in the Space Management view.
Workplace Space Management

Monitor workplace locations
As a Workplace manager, the application enables you to administer any workplace location, such as employee workspaces, conference rooms, office buildings, campuses and more. You can perform any action on a workplace location at a single place in simple steps. You can manage regions, sites, campuses, buildings, floors, areas, rooms, and spaces using the application.

Perform exclusive space-related actions
Apart from the features provided by Workplace Safety Management, the Workplace Space Management application enables you to do the following exclusive space-related actions:

- Use all space administration-related actions available in the Workplace Safety Management application.
- Specify the measurement details of a location such as the measuring unit and size of a space.
- Assign a cost center or department to a space.
- Configure a workspace or desk as flexible or permanent.
- Configure a space type as usable.
- Update or recalculate a workplace location’s total and usable size whenever there are changes.
- View the reason for anomalies caused in a workplace profile.

For more information about each feature, refer to Creating workplace location records using Workplace Space Management.

Use Workplace Safety Management features
The application enables you to perform the following actions the same as you would do in the Workplace Safety Management application, but with extra features:

- Create records for your workplace data.
- Configuring spreadsheets to import workplace data.
- Add a space type configuration.
- Block a workplace location.
Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection and employment laws and regulations, and should modify any language within the templates provided to meet the agency’s specific requirements.

Install Workplace Space Management

Install the Workplace Space Management application from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Before you begin

Complete the following setup instructions:

1. Navigate to Subscription Management > Subscriptions in your instance.
   The list displays the subscriptions that your organization has purchased.

2. Verify that the following plugins are activated:

   • Workplace Safety Management (sn_wsd_core) version 2.6.2.
   • Workplace Space Management (sn_wsd_spcmgmt) version 1.0.

Use the following details when required:

• Name of the application: Workplace Space Management
• ID of the application: sn_wsd_spcmgmt

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the application by using the filter criteria and search bar.
Search for the application by its name (Workplace Space Management) or ID (sn_wsd_spcmpgmt). If you cannot find the application, you may have to request it from the ServiceNow Store.

3. Click **Install**.

4. In the Application installation dialog box, review the application dependencies. A list of dependent plugins and applications are displayed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Workplace Space Management.

5. **Optional:** If demo data is available and you want to install it, click **Load demo data**. (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don't load the demo data during installation, it's unavailable to load later.

6. Click **Install**.

**Components installed with Workplace Space Management**

Several types of components are installed with the Workplace Space Management application, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Roles installed with Workplace Space Management**

**Roles for Workplace Space Management**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_spcmpgmt.admin</td>
<td>As a Workplace Space Management admin, you can access the application completely.</td>
<td>sn_wsd_spcmpgmt.manager</td>
</tr>
<tr>
<td>sn_wsd_spcmpgmt.manager</td>
<td>As a Workplace Space Manager, you can access the application completely.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Tables installed with Workplace Space Management**

**Tables for Workplace Space Management**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Center / Department</td>
<td>Stores information about all the cost centers and departments that are created in the application.</td>
</tr>
</tbody>
</table>
Properties installed with Workplace Space Management

Customize the properties available with Workplace Space Management.

These properties are available for Workplace Space Management.

ℹ️ Note: All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.

### Properties for Workplace Space Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_spcmgmt.default_area_measurement_unit</td>
<td>This property enables you to specify the default measuring unit of an area.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Choices: sq_feet, sq_meter</td>
</tr>
<tr>
<td></td>
<td>• Default value: sq_feet</td>
</tr>
</tbody>
</table>

Creating workplace location records using Workplace Space Management

Apart from the space administration features provided by Workplace Safety Management, the Workplace Space Management application enables you to configure exclusive space-related settings.

For buildings, floors, areas, and spaces, you can either use Workplace Safety Management or Workplace Space Management. But, the Workplace Space Management application provides more workplace-related functionalities and options for these records.

To add a workplace records using Workplace Safety Management, refer to Create records for your workplace data. To add workplace records using Workplace Space Management, refer to the following:

- Add a building using Workplace Space Management.
- Add a floor using Workplace Space Management.
- Add an area using Workplace Space Management.
- Add a room using Workplace Space Management.
- Add a space using Workplace Space Management.

Using the Workplace Space Management application, you can view the regular workplace location-related forms in the Space Management view. On the form, you can switch to the Space Management view by right-clicking the form header and selecting View > Space Management.

The following features are available when you switch to the Space Management view on the workplace location form:

**Measurement details**

Specify the measurement details of the workplace location such as the location size and the unit of measurement. For buildings, floors, and areas, you can also specify the total size and the usable size to plan infrastructure and other maintenance activities.

**Cost center or department**

Assign a cost center or department to a workplace location to track all the real-estate expenses incurred for the maintenance and other activities.
Push down the cost center or department to child locations

Instead of assigning a cost center or department to every location manually, you can automatically assign the cost center or department of the parent location to the child locations. Specify how you want to implement the push down functionality in the **Push down** field. You can track the progress of the push down process in the **Push down state** field.

The push down functionality depends on several conditions. The conditions are as follows:

- If the child location has a cost center or department already assigned, then depending on the **Push down** option specified in the parent location, the child location's cost center or department is either replaced or not replaced.
- The accessibility of the spaces assigned to a cost center or department depends on the configuration match of both the user workplace profile and the Space type configuration. For more information, see **Push down functionality in Workplace Space Management**.

Space usability

Specify if a space type is usable or not. If you specify a space type as usable, the spaces assigned to that space type will be made available for reservation. And, the size of the spaces will be included in the parent location’s usable size calculation. If a space type is not set as usable, then the spaces assigned to that space type will not be included in reservation-related activities. And, the size of the spaces will not be included in the usable size calculation of the parent location.

Flexible or permanent spaces

Configure a space as a flexible or a permanent space. This feature is applicable only to spaces of the space type **Workspace/desk**. If you configure a space as flexible, then the space will be available for reservation on the Reservation portal. If you configure a space as permanent, then the space will not be available for reservation on the Reservation portal.

View anomalies caused in a workplace profile

You can view the reason for anomalies in a workplace profile. Anomalies in workplace profiles are caused by a mismatch in the cost center, department, or assignment type between the user and the workplace location.

Add a building using Workplace Space Management

Create a record for every building that is part of your organization. Specify the region, site, and time zone of the building.

Before you begin

Ensure that the region, site, and the campus of the building are active.

Role required: sn_wsd_core.admin and sn_wsd_spcmgmt.manager

Procedure

1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select **Buildings**.
3. Click **New**.
4. Open the form in the Space Management view.
a. Right-click the form header.

b. Select **View > Space Management.**
   The form view changes.

5. On the form, fill in the fields.

### Building form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the building. Ensure that you enter a unique name. For example, use the location name <code>&lt;location-name&gt;-16</code> rather than just 16.</td>
</tr>
<tr>
<td>Region</td>
<td>Region where the office is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>Group that manages the workplace-related operations.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Workplace manager who manages all the workplace-related operations.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate that this space is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate that the spaces for this workplace entity are available for reservation. For example, if you do not mark a Building as reservable, then none the floors, areas, and spaces of this building would be available for reservation.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone of the building.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Latitude of a campus or a building. The latitude is displayed in the Workplace Service Portal Location directory map.</td>
</tr>
<tr>
<td>Longitude</td>
<td>Longitude of a campus or a building. The longitude is displayed in the Workplace Service Portal Location directory map.</td>
</tr>
</tbody>
</table>

### Measurement Details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement unit</td>
<td>Measuring unit of the size.</td>
</tr>
<tr>
<td>Total size</td>
<td>Total size of the building that is calculated based on the <strong>Size</strong> specified for each room or space on the floor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>The size is calculated regardless of the usability that is specified in the Space type configuration for child rooms and spaces.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set based on the size specified in its child locations.</td>
</tr>
<tr>
<td>Usable size</td>
<td>Usable size in the building.</td>
</tr>
<tr>
<td></td>
<td>This is the amount of space that is available for planning maintenance activities, infrastructure, and so on. The usable size is calculated based on the Space type configuration for child rooms and spaces.</td>
</tr>
<tr>
<td></td>
<td>If the Space type of a space is configured as Usable, then the size of the space is included in the calculation.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set based on the size specified in its child locations.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Results**
The building is added to the selected region, site, and campus.

**Add a floor using Workplace Space Management**
Create a record for every floor of a building. Specify the measurement details of the floor such as the total size and the usable size.

**Before you begin**
Ensure that the building of the floor record is active.
Role required: sn_wsd_core.admin

**About this task**
You can assign a cost center and a department to all the entities of the floor by using the push down functionality. Specify the gross and usable size of the floor to plan maintenance activities, infrastructure, workspace allocation and more.

**Procedure**
1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select **Floors**.
3. Click **New**.
4. Open the form in the Space Management view.
   a. Right-click the form header.
   b. Select **View > Space Management**.
      The form view changes.
5. On the form, fill in the fields.
### Floor form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the floor. Ensure that you enter a unique name. For example, use the location name <code>&lt;location-name&gt;-16</code> rather than just 16.</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>Do not use duplicate names because it may affect the reservation process.</td>
</tr>
<tr>
<td>Region</td>
<td>Region where the office is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Building where the floor is located.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the floor.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate whether the areas, rooms, and spaces that are located on this floor are available for reservation.</td>
</tr>
</tbody>
</table>
| Push down   | Option to define the push down functionality if the floor is associated to a cost center or department. The cost center or department is assigned to the child locations of the floor, such as rooms, areas, and spaces, based on the selected push down action. The following choices are available:  

- **No**: The cost center or department is not assigned to the areas, rooms, and spaces of the floor.  
- **Yes and replace**: The cost center or department is assigned to all the areas, rooms, and spaces of the floor. If an area, room, or space already has a defined cost center or department already, then it is replaced.  
- **Yes and no replace**: The cost center or department is assigned to all the areas, rooms, and spaces of the floor. If an area, room, or space already has a defined cost center or department, then it is not replaced.  

For more information about the push down functionality, refer to [Push down functionality in Workplace Space Management](#). |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> The push down functionality also depends on the <strong>Push down</strong> option enabled in the area, room, and space of the floor.</td>
</tr>
</tbody>
</table>
| Push down state       | State of the push down functionality. Choices are as follows:  
  - **In progress**: The push down process is still running.  
  - **Completed**: The push down process is complete. |
| Managed by group      | Group that manages the workplace-related operations.                                                                                           |
| Managed by            | Workplace manager who manages all the workplace-related operations.                                                                               |
| **Measurement Details** |                                                                                                                                               |
| Measurement unit      | Measuring unit of the size.                                                                                                                  |
| Total size            | Total size of the floor that is calculated based on the **Size** specified for each space or room on the floor.  
  The size is calculated regardless of the usability that is specified in the Space type configuration for child rooms and spaces.  
  This field is automatically set based on the size specified in its child locations. |
| Usable size           | Usable size on the floor.  
  This is the amount of space that is available for planning maintenance activities, infrastructure, and so on. The usable size is calculated based on the Space type configuration for child rooms and spaces.  
  If the **Space type** of a space is configured as **Usable**, then the size of the space is included in the calculation.  
  This field is automatically set based on the size specified in its child locations. |

6. Click **Submit**.

**Results**
The floor is added to the building.

Add an area using Workplace Space Management
Create a record for every area that is located on a floor.

**Before you begin**
Ensure that the floor of the area record is active.

Role required: sn_wsd_core.admin and sn_wsd_spcmgmt.manager
Procedure
1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select **Areas**.
3. Click **New**.
4. Open the form in the Space Management view.
   a. Right-click the form header.
   b. Select **View > Space Management**.
      The form view changes.
5. On the form, fill in the fields.

**Area form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the area. Ensure that you enter a unique name. For example, use the location name <code>&lt;location-name&gt;-16</code> rather than just 16.</td>
</tr>
<tr>
<td>Note: Do not use duplicate names because it may affect the reservation process.</td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td>Region where the office is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the building where the area is located.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor name or the number of the floor where this area is located.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the area.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate whether the area, rooms, and spaces that are located in this area are available for reservation.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Capacity of the area.</td>
</tr>
<tr>
<td>Push down</td>
<td>Option to define the push down functionality if the area is associated to a cost center or department assigned. The cost center or department is assigned to the child locations of the area, such as rooms and spaces, based on the selected push down action. Choices are as follows:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>: The cost center or department is not assigned to the rooms and spaces of the area.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes and replace</strong>: The cost center or department is assigned to all the rooms and spaces of the area. If a room or a space already has a defined cost center or department, then it is replaced.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes and no replace</strong>: The cost center or department is assigned to all the rooms and spaces of the area. If a room or a space already has a defined cost center or department, then it is not replaced.</td>
</tr>
<tr>
<td></td>
<td>For more information about the push down functionality, refer to <a href="#">Push down functionality in Workplace Space Management</a>.</td>
</tr>
<tr>
<td><strong>Note</strong>:</td>
<td>The push down functionality also depends on the <strong>Push down</strong> option enabled in the room and space of the area.</td>
</tr>
<tr>
<td>Push down state</td>
<td>State of the push down functionality. Choices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>In progress</strong>: The push down process is still running.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Completed</strong>: The push down process is complete.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>Group that manages the workplace-related operations.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Workplace manager who manages all the workplace-related operations.</td>
</tr>
<tr>
<td><strong>Measurement Details</strong></td>
<td></td>
</tr>
<tr>
<td>Measurement unit</td>
<td>Measuring unit of the size.</td>
</tr>
<tr>
<td>Total size</td>
<td>Total size of the area that is calculated based on the <strong>Size</strong> specified for each room, or space in the area.</td>
</tr>
<tr>
<td></td>
<td>The size is calculated regardless of the usability that is specified in the Space type configuration for child rooms and spaces.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set based on the size specified in its child locations.</td>
</tr>
<tr>
<td>Usable size</td>
<td>Usable size in the area.</td>
</tr>
<tr>
<td></td>
<td>This is the amount of space that is available for planning maintenance activities, infrastructure, and so on. The usable size</td>
</tr>
<tr>
<td></td>
<td>is calculated based on the Space type configuration for child rooms and spaces.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Name | Name of the room. Ensure that you enter a unique name. For example, use the location name `<location-name>-16` rather than just `16`.

**Note:** Do not use duplicate names because it may affect the reservation process.

Region | Region where the office is located.
Site | Location of the office campus.

6. Click **Submit**.

**Results**
The area is added to the floor.

**What to do next**
You can add a cost center or department if there is none. For more information on how to add a cost center or department, see **Add a cost center or department**. In the procedure, select the Areas module instead of the Floors module.

**Add a room using Workplace Space Management**
Create a record for every room located in an area or a floor. Specify the size of the room. Assign the room to a cost center or a department.

**Before you begin**
Ensure that the area and floor of the room are active.

Role required: sn_wsd_core.admin and sn_wsd_spcremgmt.manager

**Procedure**
1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select **Rooms**.
3. Click **New**.
4. Open the form in the Space Management view.
   a. Right-click the form header.
   b. Select **View > Space Management**. The form view changes.
5. On the form, fill in the fields.

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the building where the room is located.</td>
</tr>
<tr>
<td>Floor</td>
<td>Floor where the room is located.</td>
</tr>
<tr>
<td>Area</td>
<td>Area where you are adding the room.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the area.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate whether the room and the spaces that are located in the room are available for reservation.</td>
</tr>
<tr>
<td>Space type</td>
<td>Type of the office space. To configure a new space type, see Add a space type configuration.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>Group that manages the workplace-related operations.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Workplace manager who manages all the workplace-related operations.</td>
</tr>
<tr>
<td><strong>Measurement Details</strong></td>
<td></td>
</tr>
<tr>
<td>Measurement unit</td>
<td>Measuring unit of the size.</td>
</tr>
<tr>
<td>Size</td>
<td>Size of the room.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Results**
The room is added to the area and room.

**What to do next**
You can add a cost center or a department if there is none. For more information on how to add a cost center or a department, see **Add a cost center or department**. In the procedure, select the Rooms module instead of the Floors module.

**Add a space using Workplace Space Management**
Create a space record for every workspace located on a floor. Specify the space type and the size of the space.

**Before you begin**
Ensure that the room, area, and floor of the space are active.

Role required: `sn_wsd_core.admin` and `sn_wsd_spcmgmt.manager`

**Procedure**
1. Navigate to **Workplace Safety Management > Space Administration**.
2. Select **Spaces**.
3. Click **New**.
4. Open the form in the Space Management view.
a. Right-click the form header.

b. Select View > Space Management.
The form view changes.

5. On the form, fill in the fields.

### Space form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the space. Ensure that you enter a unique name. For example, use the location name <code>&lt;location-name&gt;-16</code> rather than just 16.</td>
</tr>
<tr>
<td>Note:</td>
<td>Do not use duplicate names because it may affect the reservation process.</td>
</tr>
<tr>
<td>Region</td>
<td>Region where the office is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the office campus.</td>
</tr>
<tr>
<td>Campus</td>
<td>Name of the campus where the office operates.</td>
</tr>
<tr>
<td>Building</td>
<td>Name of the office building for this workspace.</td>
</tr>
<tr>
<td>Floor</td>
<td>Name or number of the floor where this workspace is present.</td>
</tr>
<tr>
<td>Area</td>
<td>Name of the area on the office floor.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate that this space is active.</td>
</tr>
<tr>
<td>Is reservable</td>
<td>Option to indicate whether the space is available for reservation.</td>
</tr>
<tr>
<td>Space type</td>
<td>Type of the office space. To configure a new space type, see Add a space type configuration.</td>
</tr>
<tr>
<td>Assignment type</td>
<td>Assignment type of the space. Specify if the space is a flexible or a permanent workspace. This field appears only when you select the Space type as Workspace/Desk.</td>
</tr>
<tr>
<td>Managed by group</td>
<td>Group that manages the workplace-related operations.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Workplace manager who manages all the workplace-related operations.</td>
</tr>
<tr>
<td>Measurement Details</td>
<td>Measuring unit of the size.</td>
</tr>
<tr>
<td>Measurement unit</td>
<td>Size of the space.</td>
</tr>
</tbody>
</table>

6. Click Submit.
Results
The space is added to the area. The size of the area and the floor are calculated based on the specified space size.

What to do next
You can add a cost center or department if there is none. For more information on how to add a cost center or department, see Add a cost center or department. In the procedure, select the Spaces module instead of the Floors module.

Configure a space type as usable with Workplace Space Management
Specify if a space type is usable or not by using the Space type configuration functionality. Specify if the space can or cannot be used for reservations.

Before you begin
Ensure that you have the following:

• The space type is configured in the application. Otherwise, refer to Add a space type configuration.

• Workplace Space Management is installed.

Role required: sn_wsd_spcmgmt.manager

About this task
Configure a space type as usable. Specify if the space type can be used for reservations or for any space-related planning. The space type is not usable if it is a storage space or a standalone space that cannot be reserved nor included in space-related activities.

Procedure
1. Navigate to Workplace Safety Management > Administration > Space type configuration.
2. Select the space type that you want to configure as usable.
3. Open the form in the Space Management view.
   a. Right-click the form header.
   b. Select View > Space Management. The form view changes.
4. Select the Usable check box to enable the feature.
5. Click Update.

Results
The space type is configured as usable. The size of all the spaces that are assigned to this space type is calculated in the Usable size fields of their areas, floors, and buildings.

Push down functionality in Workplace Space Management
The Workplace Space Management application enables you to push down the cost center or department of a parent workplace location to its child locations.

You can assign the cost center or department to child locations such as areas, rooms, and spaces. Select the Push down option on the Floor or Area form to apply the values of the Cost center or Department fields. The cost center or department is applied based on the Push down option selected in child workplace locations.
The following table explains how the push down functionality works with respect to configuring the **Cost center** and **Department** fields of a workplace profile and a space:

<table>
<thead>
<tr>
<th>Workplace profile configuration</th>
<th>Space configuration</th>
<th>Accessibility on the space based on the configuration match</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cost center</strong>: Null</td>
<td><strong>Cost center</strong>: Null</td>
<td>User can access.</td>
</tr>
<tr>
<td><strong>Department</strong>: Null</td>
<td><strong>Department</strong>: Null</td>
<td>User can access.</td>
</tr>
<tr>
<td><strong>Cost center</strong>: &lt;value&gt;</td>
<td><strong>Department</strong>: Null</td>
<td>User can access.</td>
</tr>
<tr>
<td></td>
<td><strong>Cost center</strong>: Null</td>
<td>User can access if the <strong>Cost Center</strong> matches.</td>
</tr>
<tr>
<td><strong>Cost center</strong>: Null</td>
<td><strong>Department</strong>: &lt;value&gt;</td>
<td>User can access if the <strong>Department</strong> matches.</td>
</tr>
<tr>
<td><strong>Department</strong>: &lt;value&gt;</td>
<td><strong>Cost center</strong>: Null</td>
<td>User can access if both the <strong>Cost Center</strong> and <strong>Department</strong> matches.</td>
</tr>
<tr>
<td><strong>Cost center</strong>: Null</td>
<td><strong>Department</strong>: Null</td>
<td>User can access if the <strong>Cost Center</strong> matches.</td>
</tr>
<tr>
<td><strong>Department</strong>: &lt;value&gt;</td>
<td><strong>Cost center</strong>: &lt;value&gt;</td>
<td>User can access if the <strong>Cost Center</strong> matches.</td>
</tr>
<tr>
<td><strong>Cost center</strong>: Null</td>
<td><strong>Department</strong>: Null</td>
<td>User can access if the <strong>Department</strong> matches.</td>
</tr>
<tr>
<td><strong>Department</strong>: &lt;value&gt;</td>
<td><strong>Cost center</strong>: &lt;value&gt;</td>
<td>User can access if both the <strong>Cost Center</strong> and <strong>Department</strong> matches.</td>
</tr>
</tbody>
</table>
Add a cost center or department

Assign either a cost center, department, or both to a workplace location. Manage real-estate expenses, workplace assignments, and reservations based on the employee’s cost center or department.

Before you begin
Role required: sn_wsd_spcmgmt.manager

Procedure
1. Navigate to Workplace Safety Management > Space Administration.
2. Select the applicable module.
   • Spaces
   • Rooms
   • Areas
   • Floors
   For example, if you want to add a cost center or a department to a floor, select the Floors module.
3. Select the location to which you want to add the cost center or department.
4. On the form, scroll down and click **New** in the Cost Centers / Departments section.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Option to specify if you want to add a cost center, a department, or both.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center to which you want to assign the floor. This field appears only when Both or Cost center is selected in the Type field.</td>
</tr>
<tr>
<td>Department</td>
<td>Department to which you want to assign the floor. This field appears only when Both or Department is selected in the Type field.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the cost center or department.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the cost center or department. This field is automatically set to the name of the workplace location to which you are adding the cost center or department.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

Results
The cost center or department is added to the workplace location.
You can assign the cost center or department to the child locations such as areas, rooms, and spaces. Select the **Push down** option on the Floor or Area form to apply the cost center or department. The cost center or department is applied depending on the **Push down** option specified in the child locations.
Configure a workspace or desk as flexible or permanent

Define if a space is flexible or permanent. On the Reservation portal, the availability of a space for a user profile depends on its assignment type. Only flexible spaces are available for reservation.

Before you begin
Ensure the following:

• The space is added in the application. Otherwise, refer to Add a space using Workplace Space Management.
• The Space type field of the space is set to Workspace/desk.

Role required: sn_wsd_spcregistration.manager

About this task
You can specify if a desk or workspace is a permanent space or flexible. If you set a space as permanent, then the space will not be displayed to employees when they are making a reservation on the portal.

Procedure
1. Navigate to Workplace Safety Management > Space Administration.
2. Select Spaces.
3. Select the space that you want to assign as a flexible or permanent space.
4. Open the form in the Space Management view.

   a. Right-click the form header.

   b. Select View > Space Management.

      The form view changes.

5. In the Assignment type field, select any one of the following options:

   • None: The Assignment type is set to None by default. The space is available both for reservation on the Reservation portal and for the workplace user profiles created in the Workplace Safety Management application.
   • Flexible: Select this option if the space is a flexible workspace. If you select this option, the space is displayed as available for reservation only on the Reservation portal. The space will not be available for users.
   • Permanent: Select this option if the space is a permanent workspace. If you select this option, the space is displayed as available only for users created in the Workplace Safety Management application. The space will not be available for reservation on the Reservation portal.

      If you are changing the Assignment type from None or Flexible to Permanent, then all the future reservations made on this space will be automatically canceled. A notification will be sent about the cancellation.

6. Click Update.

Results
The space is configured as flexible or permanent based on the assignment type that you selected.
Update the measurement details of a workplace location

Specify the size of a location. If the location is an area, floor or building, then you can update or recalculate the total and usable size.

Before you begin
Ensure that the space, room, area, floor, or building is active.
Role required: sn_wsd_spcmgmt.manager

Procedure
1. Navigate to Workplace Safety Management > Space Administration.
2. Select the applicable module.
   • Spaces
   • Rooms
   • Areas
   • Floors
   • Buildings
   For example, if you want to update the size of a space, select Spaces.
3. Go to the Measurement details section and update the measurements.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Size of the area, floor, or building. This field appears if you selected the Spaces or Rooms module.</td>
</tr>
<tr>
<td>Total size</td>
<td>Total size of the area, floor, or building.</td>
</tr>
<tr>
<td>Usable size</td>
<td>Usable size of the area, floor, or building.</td>
</tr>
<tr>
<td>Measurement unit</td>
<td>Measurement unit that is used to view the sizes. This field is automatically set based on the value selected in the sn_wsd_spcmgmt.default_area_measurement_unit system property.</td>
</tr>
</tbody>
</table>

4. Optional: To manually recalculate the size, click the recalculate size icon (✓) next to the Total size or Usable size field.
The recalculate size icon appears if you change the sizes manually. If the size of any child location of the selected location changes, the sizes are automatically recalculated.

5. Click Update.

6. Optional: To recalculate the sizes of multiple workplace locations at a time, do the following:
   a. Select the workplace location module on which you want to perform the recalculation.
      For example, to recalculate the sizes of multiple buildings, go to Workplace Safety Management > Space Administration > Buildings.
   b. Select the locations on which you want to perform recalculation.
      For example, if you are in the Buildings module, select the check box next to each building that you want to recalculate.
c. **Optional:** To perform the recalculation on all the locations at the same time, select the check box on the bottom, next to the **Action on selected rows...** option.

d. Click **Action on selected rows...** and do the following.

- **Recalculate Total Sizes:** Select this option to recalculate the **Total size** of all the locations.
- **Recalculate Usable Sizes:** Select this option to recalculate the **Usable size** of all the locations.

**Results**
The size of the workplace location is updated.

### Workplace Reservations for Microsoft Outlook Add-in

Reserve a workplace space in less than a minute without using the Reservation portal. The ServiceNow® Workplace Reservations for Microsoft Outlook Add-in enables you to make a reservation using Microsoft Outlook directly.

The Workplace Reservations for Microsoft Outlook Add-in application is created on the Seismic workspace and uses Seismic components. The components are stored in the Workplace Service Delivery Components plugin to enhance the employee experience while using the add-in.

As an employee, you can easily reserve a space using Microsoft Outlook directly. The add-in provides you the capabilities of the Workplace Reservation Management application within the Microsoft Outlook application. The add-in enables an employee to create an appointment or edit an existing appointment. An employee can find the available spaces easily and request extra services without the need to open a separate application.

Configure a manifest file and upload it to the Microsoft Outlook application to view the add-in feature. To start using the add-in, add the add-in as a shortcut in the Microsoft Outlook ribbon. When you select the add-in option, it displays a reservation form in a separate panel.

As a workplace admin, you can specify the reservable module that you want to use for reservations in a system property. Only the workplace locations that are assigned to the reservable module are displayed to employees while making a reservation. All the reservations and the extra services requested by employees are managed within the Workplace Reservation Management application.
Workplace Reservation Management and the Microsoft Outlook Add-in

As an employee, the add-in enables you to make a reservation without using the Workplace Reservation Management Reservation portal directly, thus saving time. The add-in reduces the time to search for a location by directly displaying the available locations. The add-in enables you to perform the following actions:

- Find available spaces by applying multiple search criteria.
- Add spaces directly to an existing or a new event using the add-in directly.
- Reserve a workplace location for a meeting, conference, or for any other event.
- Specify the reservation duration.
- Request extra services.
- Update an existing reservation or modify the extra services. You can change the location and add or remove services.

Add-in option to request extra services
If any selected space becomes unavailable for any reason or if the date or time has changed, the add-in indicates that information.

You can use the existing reporting tools available with Workplace Reservation Management application to report any issue.

**Important:** Currently, it is not possible to use Microsoft Outlook on the web using the Apple Safari browser. Instead, you can use Mozilla Firefox, Microsoft Edge, or Google Chrome.

**Install Workplace Reservations for Microsoft Outlook Add-in**

Install the Workplace Reservations for Microsoft Outlook Add-in application from ServiceNow Store applications. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Before you begin**

Install the Workplace Service Delivery Components application from the store because the Workplace Reservations for Microsoft Outlook Add-in application is built on the Seismic workspace. The Workplace Service Delivery Components store the components that are built on Seismic. The components enhance the experience of employees who are using the Workplace Reservations for Microsoft Outlook Add-in application.

Complete the following setup instructions:

1. Navigate to Subscription Management > Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.
2. Verify that the following plugins are activated:
   - Workplace Safety Management (sn_wsd_core) version 2.6.
   - Workplace Reservations for Microsoft Outlook Add-in (sn_wsd_msaddin) version 1.0.
   - Workplace Calendar Synchronization (sn_wsd_rsvsync) version 1.4
   - Workplace Reservation Management (sn_wsd_rsv) version 1.7

Use the following details when required:

- Name of the application: Workplace Reservations for Microsoft Outlook Add-in
- ID of the application: sn_wsd_msaddin

Role required: admin

**Warning:** If you are installing Workplace Reservations for Microsoft Outlook Add-in application in a Windows system, it is required to have the “WebView2 runtime” installed on the client devices. You can downloaded it from Microsoft. If you are using Windows, it is currently not possible to use Microsoft Outlook on the web using the Internet Explorer 11 browser. Instead, you can use Mozilla Firefox, Microsoft Edge, or Google Chrome.

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the application by using the filter criteria and search bar.
   - Search for the application by its name (Workplace Reservations for Microsoft Outlook Add-in) or ID (sn_wsd_msaddin). If you cannot find the application, you may have to request it from the ServiceNow Store.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies. A list of dependent plugins and applications are displayed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Workplace Reservations for Microsoft Outlook Add-in.

5. Optional: If demo data is available and you want to install it, click Load demo data. (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

6. Click Install.

**Components installed with Workplace Reservations for Microsoft Outlook Add-in**

Several types of components are installed with the Workplace Reservations for Microsoft Outlook Add-in application, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Roles installed with Workplace Reservations for Microsoft Outlook Add-in**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_msaddin.admin</td>
<td>As a Workplace Reservations for Microsoft Outlook Add-in admin, you can access the application completely.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Properties installed with Workplace Reservations for Microsoft Outlook Add-in**

Customize the properties available with Workplace Reservations for Microsoft Outlook Add-in. These properties are available for Workplace Space Management.

**Note:** All of these properties are located in the System Properties [sys_properties] table. To access the table, enter sys_properties.list in the navigation filter.

**Properties for Workplace Reservations for Microsoft Outlook Add-in**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_msaddin.default_reservable_module</td>
<td>This property enables you to specify the default reservable module that must be used to make a reservation. The workplace items of the reservable module are displayed to make a reservation. Specify the sys_id of the reservable module.</td>
</tr>
</tbody>
</table>
## Properties for Workplace Reservations for Microsoft Outlook Add-in (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_wsd_msaddin.oauth.debug</td>
<td>This property enables logging of the debug information when using the Microsoft Outlook Add-in page. You can view information like the browser used and supported features.</td>
</tr>
</tbody>
</table>

### Create a manifest file for Microsoft Outlook Add-in

Create a manifest file, customize it based on your organization standards, and configure the add-in in Microsoft Outlook.

**Before you begin**

Download the sample manifest file Workplace_Outlook_add_in_manifest_example.xml along with the Workplace Reservations for Microsoft Outlook Add-in application from the ServiceNow Store. You can also create a manifest file. For more information on how to create a manifest file, refer to the [Microsoft documentation](#).

Role required: sn_wsd_msaddin.admin

**About this task**

In this task, you can create a manifest file by customizing the sample manifest file downloaded from the ServiceNow Store. This procedure explains the parameters in the manifest file that can be customized.

**Procedure**

1. Navigate to the directory where you have downloaded the sample manifest file.
2. Open the manifest file to make the customization.
3. In the sample manifest file, change the following parameters based on your organization requirements.

#### Parameters in the manifest file that can be customized

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Unique ID for the add-in. For more information, refer to the <a href="#">Microsoft documentation</a>.</td>
</tr>
<tr>
<td>DisplayName</td>
<td>Display name of the add-in. The name is displayed in the Microsoft Outlook app ribbon.</td>
</tr>
<tr>
<td>Description</td>
<td>Description about the add-in.</td>
</tr>
<tr>
<td>IconUrl</td>
<td>Link to the icon image. A Youmoji icon is installed along with the application for the add-in. If you are setting your own icon, ensure that you specify a URL linking to the icon. The following icon formats are supported:</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• 16x16</td>
<td></td>
</tr>
<tr>
<td>• 32x32</td>
<td></td>
</tr>
<tr>
<td>• 64x64</td>
<td></td>
</tr>
<tr>
<td>• 80x80</td>
<td></td>
</tr>
<tr>
<td>Images</td>
<td>Link to the images used in the add-in.</td>
</tr>
<tr>
<td>SupportUrl</td>
<td>Link to a supporting environment.</td>
</tr>
<tr>
<td>SourceLocation</td>
<td>Link to a supporting environment. You can link your own environment, or a different website.</td>
</tr>
<tr>
<td>Url</td>
<td>Link to the instance where the add-in is installed.</td>
</tr>
</tbody>
</table>

4. Save the manifest file with a different name.

**Results**
The manifest file for the add-in is created.

**What to do next**
Perform any of the following actions based on your requirements:

- Upload the manifest file for a single user.
- Upload the manifest file in Microsoft Office 365.

**Upload the manifest file for a single user**
After you create the manifest file, make it available for usage within Microsoft Outlook. You can upload the add-in for a single user use.

**Before you begin**
Ensure that you have created a manifest file for the add-in.

**Procedure**
1. Open Microsoft Outlook.
2. On the Outlook ribbon, click Get Add-ins.
3. Select My add-ins.
4. In the Custom add-ins section, select Add a custom add-in > Add from file.
5. Select the manifest file that you have created for the add-in.
6. Click Next > Install.

**Results**
The Workplace Reservations for Microsoft Outlook Add-in is installed. The add-in appears while scheduling a meeting in Outlook.

**Upload the manifest file in Microsoft Office 365**
After you create a manifest file, upload it to Microsoft Office 365. You can view and use the add-in after you upload the manifest file.

**Before you begin**
Ensure that you have created a manifest file for the add-in.
Procedure

1. Log in to Microsoft Office 365 with your admin account.
2. Select the app launcher icon in the upper-left and click Admin.
3. In the admin center, go to Settings > Services & add-ins.
4. Select Deploy Add-in and click Next in the overview page.
5. To upload your manifest file, do the following:
   a. Select Upload custom apps.
   b. Select the I have the manifest (.xml) file on this device check box.
   c. Click Choose file and select the manifest file that you have created for the add-in.
   d. Click Upload.
6. In the Assign users section, select one of the following options to specify who can use the add-in.
   - **Everyone**: Select this option to deploy the add-in to everyone.
   - **Specific users/groups**: Select this option to deploy the add-in to only selected users or user groups. Use the search option to find users or groups to whom you want to deploy the add-in.
   - **Just me**: Select this option to deploy the add-in only to you.
7. In the Deployment method section, select a deployment method based on how you want to deploy the add-in to users.
8. Click Deploy.
   A green tick appears when the add-in deployment is successful. Follow the instructions provided on the page to test if the add-in deployment is successful.
9. Click Next.
10. On the final page, click Cancel to close the dialog box.

Results

The add-in is uploaded to Microsoft Office 365. The users who have the add-in can view the add-in option while scheduling a meeting.

Make a reservation using Workplace Reservations for Microsoft Outlook Add-in

Schedule an event or appointment in Microsoft Outlook using the additional features provided by the Workplace Reservations for Microsoft Outlook Add-in application.

Before you begin

You must have created and uploaded a manifest file. To create a file, see Create a manifest file for Microsoft Outlook Add-in. To upload the file, do any of the following:

- Upload the manifest file for a single user.
- Upload the manifest file in Microsoft Office 365.

Role required: admin
Procedure

1. Open the Microsoft Outlook application.

2. Perform any one of the following actions depending on what type of reservation you want to make:
   • To create an appointment or event, navigate to New items > Appointment.
   • If you want to send a meeting invite, navigate to New items > Meeting.

3. In the Appointment window, select the reservation add-in.
   The add-in opens a side-bar that contains a reservation form.

   ✉ Note: The name of the add-in depends on the name specified in the manifest file.

4. In the Reserve a space sidebar, fill in the following fields:
   a. Building: Building in which you want to make an appointment.
   b. Floor: Floor in which you want to reserve a space for the appointment.
   c. Capacity: Required capacity of the space. The spaces will be displayed depending on the capacity specified.

5. To search for spaces to add, do the following:
   a. Click Search.
      The available spaces are displayed based on the search.
   b. Select a space from the list of available spaces.
      You can also select multiple spaces.

6. Click Save and next.

7. To request extra services for your reservation, do the following:
   a. Click +Add extra services to request extra services along with your reservation.
   b. Optional: If you have selected multiple spaces, select +Add extra services under each space separately.
   c. In the services form, select any of the following services if needed:
      • Catering: Option to request food services. Specify breakfast or lunch preferences and the quantity required.
      • Equipment: Option to request any special equipment for the meeting.
   d. Click Save services.

8. Review your reservation details.

9. Optional: If you need to edit your reservation, do the following:
   a. To edit your reservation, click Change reservation.
   b. To edit the extra services requested, click +Add/manage extra services.

10. Click Save reservation.
    The reservation is created and logged in the Workplace Reservation Management application.

11. In the Outlook appointment window, click Send to send the meeting request.
    The meeting request will be sent to the selected spaces to confirm the reservation.
Results
The reservation is created.

Legal Service Delivery

ServiceNow® Legal Service Delivery provides a unified experience between the employees requesting legal support and the legal teams serving them.

Employees can request legal services from an interface with guided intelligent workflow. Legal departments can automate or streamline routine legal requests so they can focus on higher value work.

The legal teams can use the ServiceNow® Legal Counsel Center which provides the request visibility, prioritized work queue, and practice-specific tools to manage complex legal affairs.

The following video provides an overview of Legal Service Delivery Video providing an overview of Legal Service Delivery. Approximately five minutes long.

Benefits
Legal Service Delivery enhances your organization’s in-house counsel and legal teams processes by enabling self-service for employees driving operational efficiencies and providing actionable insights.

- Provide employees with self-service experiences and faster resolution of legal requests
- Enable legal department to focus on and prioritize time on more complex business affairs
- Gain insight to operations and drive cross-department efficiency through the Legal Service Delivery Dashboard

Legal Service Delivery applications
Legal Service Delivery includes the following core applications:

Legal Request Management

The ServiceNow® Legal Request Management application provides a single, unified mechanism for employees to get all the information, services, and help that they need from the legal department. Employees can submit legal requests, monitor their progress, read legal knowledge base articles—all through an omni-channel experience across portal, mobile, and virtual agent.

Legal Request Management is the core and required application in the Legal Service Delivery suite. All other applications you choose to install rest on top of Legal Request Management.

Legal Matter Management

The ServiceNow® Legal Matter Management application enables you to complete legal requests that need cross-departmental tasking and workflow with a mechanism to store documents and track important milestones. With its embedded record level security, you can maintain the confidential and sensitive information of each record.

Matter templates help you with standardized process and workflow for various matter types.

Legal Practice Applications

Legal practice applications in the Legal Service Delivery suite provide solutions for the specific needs of different legal practice areas.

Legal Conflict of Interest
The ServiceNow® Legal Conflict of Interest application enables you to manage the disclosure, approval, and registry of conflict of interest that might arise from employees having competing interests or loyalties.

**Legal Digital Forensics**

The ServiceNow® Legal Digital Forensics application enables you to handle digital forensics requests for data discovery related to custodial and non-custodial data sources that are subject to investigations or litigation.

**Legal Simple Contracts**

The ServiceNow® Legal Simple Contracts application enables employees to submit legal requests for creating contracts with third parties such as vendors, customers, and partners. The legal department can manage and process them from a centralized location.

**Legal Stock Preclearance**

The ServiceNow® Legal Stock Preclearance application enables you to manage stock preclearance requests complying with the company’s stock preclearance policy. You can set up trading windows, manage an access persons list, and approve or reject stock preclearance requests.

**Virtual Agent for Legal Service Delivery**

**Legal Virtual Agent Conversations**

The ServiceNow® Legal Virtual Agent Conversations application provides predefined conversation topics to enable automated chats with employees seeking legal services. You can build new topics or customize the predefined topics to handle common legal requests from employees or guide them through self-service tasks.

**Mobile experience for Legal Service Delivery**

You can use the following ServiceNow® mobile apps to work on the Legal Service Delivery applications.

**Now Mobile app**

The Now Mobile app enables your employees to get legal information and support through their mobile device. They can submit legal requests and track the status of requests, and read knowledge articles using the Now Mobile app.

**Mobile Agent app**

The Mobile Agent app enables the legal department users to resolve legal requests and legal matters assigned to them using the Mobile Agent app app.

For more information, see **Legal Mobile**.

**Domain separation for Legal Service Delivery applications**

The Legal Service Delivery applications support domain separation at the Basic level. For more information, see **Domain separation and Legal Service Delivery**. For a deeper understanding of the support levels, see **Application support for domain separation**.

**Legal Request Management**

The ServiceNow® Legal Request Management application provides a unified mechanism for employees to get all the information, services, and help that they need from the legal department and a streamlined, collaborative process for the legal department to quickly resolve these requests. Employees can submit legal requests, monitor their progress, and read legal knowledge base articles across a web portal, mobile platform, and Virtual Agent.
Legal teams can collaborate in a centralized Legal Counsel Center to manage legal intake volume, resolve legal requests, and monitor work analytics.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Legal Service Delivery release notes</td>
<td>• Install Legal Request Management</td>
<td>• Setting up Legal Request Management</td>
</tr>
<tr>
<td>• Legal Request Management overview</td>
<td></td>
<td>• Create or modify a practice area</td>
</tr>
<tr>
<td>• Legal Counsel Center overview</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Submit a legal request</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the Legal Service Delivery forum on the Now Community</td>
</tr>
<tr>
<td>• Assign a legal request</td>
<td>• Developer documentation</td>
<td>• Search the HI Knowledge Base for known error articles</td>
</tr>
<tr>
<td>• Work on a legal request</td>
<td>• Components installed with Legal Request Management</td>
<td>• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>

Legal Request Management overview

Legal Request Management enables authorized employees in the organization to submit legal requests and to track their progress while users in the legal department with appropriate roles can work to resolve these requests.

Employees can read legal knowledge base articles, submit legal requests, monitor the progress of submitted requests, and interact through Virtual Agent.

Legal Service Delivery

- Track legal requests with self-service experiences
- Increase practitioner productivity through Legal Counsel Center
- Get insight into Legal demand and trends with real-time reporting

Features

The features of this application include:
• Submitting legal request across a service portal, mobile device, and Virtual Agent
• Managing legal requests by resolving the issue or answering queries
• Promoting legal request to legal matters that needs cross-departmental tasking and workflow

Benefits
The benefits of this application include:
• Remove manual, unstructured email processes and tasks with an easily accessed self-service experience
• Automate responses for common legal requests with virtual agents
• Make meaningful decisions by gaining real-time visibility on legal service demands
• Track, prioritize, and work on multiple requests concurrently with an optimized Legal Counsel Center

Install Legal Request Management
You can install the Legal Request Management application (sn_lg_ops) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin
• Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
• If the application requires plugins or other store applications, install them first if they are not already installed.

Activate the following ServiceNow plugins in your instance before you install the Legal Request Management application:
• Workspace Core (com.workspace_core)
• Checklist (com.glide.ui.checklist)

Role required: admin

About this task
The following components are installed with installation of the Legal Request Management application:
• Plugins
• Store applications
• Roles
• Tables
• Tables specific to practice areas
• Business Rules

For more information, see Components installed with Legal Request Management.

You can also install the following applications:
Legal Counsel Center (sn_lg_workspace)
The ServiceNow® Legal Counsel Center application enables lawyers to solve issues faster with a workspace built to facilitate resolutions. From a single view, get the full context of legal issues to resolve them quickly.

**Legal Counsel Center Components (sn_lg_ws_comps)**

The ServiceNow® Legal Counsel Center Components application enhances the workspace experience for the Legal Counsel Center by decoupling the components in the Legal Counsel Center to offer better performance.

**Legal Mobile (sn_lg_mobile)**

The ServiceNow® Legal Mobile (sn_lg_mobile) application provides the ability to find legal information, submit and track legal requests, and work on these requests on mobile devices. For more information, see Legal Mobile.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the Legal: Request Management application (sn_lg_ops) using the filter criteria and search bar.
   
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
   
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal: Request Management.
4. Optional: If demo data is available and you want to install it, click **Load demo data**.
   
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.
5. Click **Install**.

**What to do next**

Use the Legal Service Delivery Guided Setup to configure the application on your instance.

To access Legal Service Delivery Guided Setup, navigate to **Legal Administration > Legal Guided Setup**. For more information about using the guided setup interface, see Using guided setup.

**Components installed with Legal Request Management**

Several types of components are installed with activation of the Legal Request Management application, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.
Roles installed

Note: Some roles in the Contains roles column are available with installation of the respective Legal Service Delivery application. For example, roles with an sn_lg_matter prefix are added when you install the Legal Matter Management application.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Legal Administrator [sn_lg_ops.legal_admin] | Provides the administrative access to all legal apps and the underlying data. | • sn_lg_ops.request_admin  
• sn_lg_matter.matter_admin  
• sn_lg_stock_cp.stock_config |
| Legal Assignment Rules Administrator [sn_lg_ops.legal_assignment_rules_admin] | Provides administrative access to the Assignment Rules module in legal apps. | • assignment_rule_admin  
• sn_lg_ops.legal_user |
| Legal Catalog Administrator [sn_lg_ops.legal_catalog_admin] | Provides the administrative access to the Catalog administration module in legal apps. | • catalog_admin  
• catalog_editor  
• sn_lg_ops.legal_user |
| Legal Configurator [sn_lg_ops.legal_config] | Provides access to configure data such as practice area, category, and legal matter templates. It does not provide access to the transactional data of legal requests and matters. | • sn_lg_ops.request_config  
• sn_lg_matter.matter_config |
| Legal Event Administrator [sn_lg_ops.legal_event_manager] | Provides read-only access to the Events module in legal apps. | • sn_lg_ops.legal_user |
| Legal Fulfiller [sn_lg_ops.legal_fulfiller] | Provides fulfiller access for working on assigned legal requests and matters. | • sn_lg_ops.request_fulfiller  
• sn_lg_matter.matter_fulfiller |
| Legal Manager [sn_lg_ops.legal_manager] | Provides access to all transactional data of legal requests and matters and permission to assign owners for requests and matters. | • sn_lg_ops.legal_event_manager  
• sn_lg_ops.request_manager  
• sn_lg_matter.matter_manager |
| Legal Report Publisher [sn_lg_ops.legal_report_publisher] | Provides the restricted access to legal request and matter data for publishing related reports. | • report_publisher  
• sn_lg_ops.legal_report_viewer  
• sn_lg_ops.legal_user |
| Legal Report Viewer [sn_lg_ops.legal_report_viewer] | Provides restricted access to users to view summary reports for legal requests and matters. | • report_user  
• sn_lg_ops.legal_user |
| Legal Request Fulfiller [sn_lg_ops.request_fulfiller] | Provides fulfiller access for working on assigned requests. | • approver_user  
• knowledge  
• sn_lg_ops.legal_report_viewer  
• sn_lg_ops.legal_sla_read  
• sn_lg_ops.legal_user |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal SLA Read [sn_lg_ops.legal_sla_read]</td>
<td>Provides access to view SLAs created on requests.</td>
<td>• task_editor&lt;br&gt;• workspace_user&lt;br&gt;• sn_lg_ops.legal_user</td>
</tr>
<tr>
<td>Legal User [sn_lg_ops.legal_user]</td>
<td>Provides access to submit legal requests and track their progress. Can work on assigned tasks related to matters.</td>
<td>• knowledge</td>
</tr>
<tr>
<td>Legal User Admin [sn_lg_ops.legal_user_admin]</td>
<td>Provides access to manage legal groups.</td>
<td>• sn_lg_ops.legal_user&lt;br&gt;• user_admin</td>
</tr>
<tr>
<td>Notification Administrator [sn_lg_ops.legal_notification_admin]</td>
<td>Provides administrative access to the Notifications module in legal apps to configure email notifications.</td>
<td>• sn_lg_ops.legal_user&lt;br&gt;• usage_admin</td>
</tr>
<tr>
<td>Request Administrator [sn_lg_ops.request_admin]</td>
<td>Provides administrative access to the Legal Request module with full access to data.</td>
<td>• sn_lg_ops.legal_catalog_admin&lt;br&gt;• sn_lg_ops.request_config&lt;br&gt;• sn_lg_ops.request_manager</td>
</tr>
<tr>
<td>Request Configurator [sn_lg_ops.request_config]</td>
<td>Provides access to configure data such as a practice area and category. It does not provide access to the transactional data of legal requests.</td>
<td>• sla_manager&lt;br&gt;• sn_lg_ops.legal_assignment_rules_admin&lt;br&gt;• sn_lg_ops.legal_notification_admin&lt;br&gt;• sn_lg_ops.legal_user&lt;br&gt;• sn_lg_ops.legal_user_admin&lt;br&gt;• sn_lg_stock_cp.stock_config</td>
</tr>
<tr>
<td>Request Manager [sn_lg_ops.request_manager]</td>
<td>Provides access to all transactional data of legal requests and permission to assign requests.</td>
<td>• sn_lg_ops.request_fulfiller</td>
</tr>
</tbody>
</table>

### Tables installed

**Note:** In addition to the following tables, tables specific to practice areas are installed with Legal Request Management. For more information, see Practice area tables for legal requests.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Defaults [sn_lg_ops_catalog_default]</td>
<td>Stores service catalog defaults such as any declarations content or templates for specific legal request.</td>
</tr>
<tr>
<td>Category [sn_lg_ops_category]</td>
<td>Stores intake forms of a practice area. These intake forms categorize legal requests into relevant groups.</td>
</tr>
<tr>
<td>Legal Event Schedule Entry [sn_lg_ops_schedule_span]</td>
<td>Stores scheduled items such as meetings or appointments for a legal department user.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Legal Profile [sn_lg_ops_legal_profile]</td>
<td>Stores all legal data associated with an employee such as active legal holds, full legal name, and citizenship information that can be used for specific Legal Practice Applications (LPAs).</td>
</tr>
<tr>
<td>Legal Profile Association [sn_lg_ops_legal_profile_association]</td>
<td>Stores the association between a legal profile and legal requests or legal matters.</td>
</tr>
<tr>
<td>Legal Request [sn_lg_ops_request]</td>
<td>Stores legal requests submitted by a user.</td>
</tr>
<tr>
<td>Legal Schedules [sn_lg Ops_schedule]</td>
<td>Stores the schedule for a legal department user.</td>
</tr>
<tr>
<td>Legal Types [sn_lg Ops_legal_type_mapping]</td>
<td>Stores the legal request type: Legal request, matter, or matter task.</td>
</tr>
<tr>
<td>Milestones [sn_lg Ops_milestone_schedule_span]</td>
<td>Stores the milestones related to a legal request.</td>
</tr>
<tr>
<td>Practice Area [sn_lg_ops_practice_area]</td>
<td>Stores practice area details.</td>
</tr>
<tr>
<td>Subcategory [sn_lg_ops_subcategory]</td>
<td>Stores the subcategories associated with an intake form of a practice area.</td>
</tr>
</tbody>
</table>

**Practice area tables for legal requests**

Tables specific to practice areas are installed with the Legal Request Management application.

These practice area tables extend the Legal Request [sn_lg_ops_request] table. If you add columns in a practice area table, you can configure the table to add those columns in the Lists section of Legal Counsel Center. You can also use these tables in other configuration.

For more information, see Configure a practice area table.

- Compliance [sn_lg_ops_compliance]
- Corporate Support [sn_lg_ops_corporate_support]
- Digital Forensics [sn_lg_ops_digital_forensics]
- Ethics [sn_lg_ops_ethics]
- General Contract Support [sn_lg_ops_general_contract_support]
- General Legal [sn_lg_ops_general_legal]
- Government Affairs [sn_lg_ops_government_affairs]
- Labor and Employment [sn_lg_ops_labor_and_employment]
- Legal Operations [sn_lg_ops_legal_operations]
- Licensing and Tech Transactions [sn_lg_ops/licensing_and_tech_transactions]
- Litigation [sn_lg_ops_litigation]
- Marketing Support [sn_lg_ops_marketing_support]
- Mergers and Acquisitions [sn_lg_ops_mergers_and_acquisitions]
• Patents, Trademark and Trade Secrets [sn_lg_ops_patents_trademark_and_trade_secrets]
• Privacy and Data Security [sn_lg_ops_privacy_and_data_security]
• Procurement Contract Support [sn_lg_ops_procurement_contract_support]
• Sales Contract Support [sn_lg_ops_sales_contract_support]
• Stock Plan Support [sn_lg_ops_stock_plan_support]

Setting up Legal Request Management

Configure the foundation data to provide legal request services to employees who can use these services to submit requests to the legal department.

As an administrator, review the installed components and modify them or add new ones as applicable.

Practice areas

Set up practice areas for your legal department specific to law practices such as Intellectual Property, Privacy, or Compliance. Associate categories to the practice area and also assign them a legal department user as the practice area lead.

Catalog categories

Create catalog categories to group legal services that employees can use to find a specific legal service request on the Legal Service Portal.

Record producers

Create record producers to define the intake forms for legal request services. These record producers are available in the Legal Operations Catalog on the Legal Service Portal. Employees can use them to submit legal service requests.

Notifications

Create notifications to be sent when various events occur. Some possible event triggers might be when a request is assigned to a legal department member to work on, a request is closed or canceled, or a message is posted to get additional information.

Create or modify a practice area

Create or modify practice areas for specific areas of law practice, such as Intellectual Property, Privacy, or Compliance.

Before you begin
Role required: sn_lg_ops.legal_config

Procedure

1. Navigate to Legal Administration > Practice Areas.
2. Click New.
3. On the form, fill in the fields.

Practice Area form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the practice area.</td>
</tr>
<tr>
<td>Practice area lead</td>
<td>User who leads the practice area.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the intake form.</td>
</tr>
<tr>
<td>Default subcategory</td>
<td>Default subcategory to associate with the intake form.</td>
</tr>
<tr>
<td>Practice area</td>
<td>Practice area to which the intake form belongs.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the intake form.</td>
</tr>
<tr>
<td>Record Producer section</td>
<td>Type of record producers to associate with the intake form. You can select from the following options:</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The practice area is created and the Intake Forms related list is displayed.

**What to do next**
Add an intake form to a practice area from the Intake Forms related list.

Add an intake form to a practice area
Add an intake form to a practice area to associate it with a record producer and define assignment rules and service level agreements.

**Before you begin**
Role required: sn-lg_ops.legal_config

**Procedure**
1. Navigate to Legal Administration > Practice Areas.
2. Open a practice area to which you want to add an intake form.
3. In the Intake Forms related list, click **New**.
4. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request record producer</td>
<td>Record producer to submit requests in the associated practice area. Select an existing request record producer or use the <strong>Create Request record producer</strong> related link to create one. The newly created request record producer contains default values for a few fields that will be pre-populated in the request form. <strong>Note:</strong> The <strong>Create Request record producer</strong> related link appears only when this field is empty. This field appears only when <strong>Request</strong> or <strong>Request and Matter</strong> is selected as the Type value.</td>
</tr>
<tr>
<td>Matter record producer</td>
<td>Record producer to create a legal matter. If a matter can be created directly, associate an existing matter record producer. To create and associate a new matter record producer, click the <strong>Create Matter record producer</strong> related link. <strong>Note:</strong> The <strong>Create Matter record producer</strong> related link is available when this field is empty. This field appears only when <strong>Matter</strong> is selected as the Type value.</td>
</tr>
<tr>
<td>Default matter template</td>
<td>Matter template that is selected by default while promoting the associated legal request to a matter. This field appears only when <strong>Matter</strong> or <strong>Request and Matter</strong> is selected as the Type value.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

An intake form is added to the practice area. The Checklist section and related lists to manage subcategories, service level agreement definitions, assignment rules, and matter templates appear.
6. **Optional:** Add to-do items in the Checklist section to provide a list of activities for the request fulfiller.
When an employee submits a new legal request through the intake form, this predefined checklist appears as the default to-do items in the corresponding request.

a. Click the more actions icon ( 동시성) next to the Checklist.

b. Click Create new.

c. Enter a description for the to-do item and press the Enter key.

7. **Optional:** In the Subcategories related list, associate an existing subcategory or create a new one and associate it with the intake form.
Subcategories enable you to further organize legal requests and assignments through the intake form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a new subcategory</td>
<td>a. In the Subcategories related list, click New.</td>
</tr>
<tr>
<td></td>
<td>b. On the Subcategory form, enter a subcategory name in the Subcategory field.</td>
</tr>
<tr>
<td></td>
<td>c. Click Submit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Associate an existing subcategory</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. In the Subcategories related list, click Edit.</td>
</tr>
<tr>
<td></td>
<td>b. On the Edit Members form, select a subcategory in the Collection list and click &gt; to move it to the Subcategories List list.</td>
</tr>
<tr>
<td></td>
<td>c. Click Save.</td>
</tr>
</tbody>
</table>

**What to do next**

- From the Matter Templates related list, associate a matter template with the intake form if a matter record producer is selected.
- From the SLA Definitions related list, create a service level agreements (SLA) definition, if required.
- From the Assignments Rules related list, create an assignment rule for an intake form.
- Update the record producer for a legal request or matter or both based on the Type field value.

**Create a rule to automatically assign legal requests or matters**
Create an assignment rule for an intake form to assign the associated legal request or matter to a user or group.

**Before you begin**
Role required: sn_lg_ops.legal_config or sn_lg_matter.matter_config

**Procedure**
1. Navigate to Legal Administration > Practice Areas.
2. Open the intake form from the Intake Form related list.
3. In the Assignment Rules related list, click New.
4. On the form, fill in the fields.
## Assignment Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the assignment rule.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the assignment rule active.</td>
</tr>
<tr>
<td></td>
<td>A legal request is assigned to a group or user based on active assignment</td>
</tr>
<tr>
<td></td>
<td>rules only.</td>
</tr>
</tbody>
</table>

### Applies To tab

<table>
<thead>
<tr>
<th>Table</th>
<th>Name of the table to which the assignment rule applies.</th>
</tr>
</thead>
</table>

| Conditions       | Conditions under which the assignment rule applies.                         |
|                  | For example, to apply a rule when a legal request is submitted in a Privacy |
|                  | category, you would enter the following condition: [Category][is][Privacy].  |

### Assign To tab

<table>
<thead>
<tr>
<th>User</th>
<th>User to whom the legal request is assigned.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Group</th>
<th>User group to which the legal request is assigned.</th>
</tr>
</thead>
</table>

5. Click **Submit**.

### Results

An assignment rule with conditions is created. Any legal request or matter that meets the rule’s conditions is assigned to the specified group or user.

### Associate a matter template with an intake form

Associate a matter template with an intake form that can be used when promoting a legal request to a legal matter to include predefined data.

### Before you begin

**Note:** The Matter Template related list is available on the **Intake Form** form only when you have selected **Matter** or **Request and Matter** as the **Type** value.

Role required: sn_lg_ops.legal_config or sn_lg_matter.matter_config

### Procedure

1. Navigate to **Legal Administration > Practice Areas**.
2. Open a practice area.
3. Open the intake form from the Intake Form related list to which you want to associate a matter template.
4. In the Matter Template related list, associate an existing matter template or create and associate a new matter template.
<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate an existing matter template</td>
<td>a. Click <em>Edit</em>.</td>
</tr>
<tr>
<td></td>
<td>b. Move the required template from the <em>Collection</em> list to the <em>Matter Templates List</em>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <em>Save</em>.</td>
</tr>
<tr>
<td>Create a template and associate it with the intake form</td>
<td>a. Click <em>New</em>.</td>
</tr>
<tr>
<td></td>
<td>b. Create a legal matter template.</td>
</tr>
<tr>
<td></td>
<td>In the <em>Intake form mapping</em> field of the Matter Template form, ensure that the current intake form is selected.</td>
</tr>
</tbody>
</table>

**Results**
The selected matter template is associated with the intake form.

**Create or modify a legal catalog category**
Create or modify a catalog category to organize your legal catalog items into logical groups in the Legal Operations Catalog.

**Before you begin**
Role required: sn_lg_ops.legal_catalog_admin

**Procedure**
1. Navigate to *Legal Administration > Legal Catalog > Maintain Categories*.
2. Create or modify a catalog category.
   - To create a catalog category, click *New*.
   - To modify an existing catalog category, click *New*.
3. On the form, fill in the fields.

**Category form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique name of the catalog category.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Name of the catalog to which the category belongs.</td>
</tr>
<tr>
<td></td>
<td>Select <em>Legal Operations Catalog</em>.</td>
</tr>
<tr>
<td>Location</td>
<td>Location relevant for the category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description about the category. The description appears under the catalog category name when you select the category on the Legal Service Portal.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope in which the category is applicable.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the category available on the portal.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>Legal catalog category that is the parent for this category.</td>
</tr>
<tr>
<td>Desktop image</td>
<td>Large image that appears with the category on the portal.</td>
</tr>
<tr>
<td>Icon</td>
<td>Small icon that appears next to the category name when the category is listed as a subcategory.</td>
</tr>
<tr>
<td>Header icon</td>
<td>Icon that appears next to the category header when the category is a top-level category.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Results**
The service catalog category is created. The catalog categories are listed in the **Service catalog category** field on the **Practice Area form**.

**What to do next**
- Associate a record producer with the category using the **Catalog Item** related list.
- Associate the catalog category with a practice area to map the practice area, record producer, and catalog category together. This mapping helps employees to use the relevant categories to submit legal requests. In turn, these requests are assigned to the correct groups or users through the associated practice area.
  
  For more information, see Create or modify a practice area.

**Create or modify a record producer for legal requests**
Create or modify a record producer to define an intake form for a legal request. Employees can use these intake forms on the Legal Service Portal to submit legal requests.

**Before you begin**
Ensure that you have the Legal Request Management application scope selected.

**Role required:** `sn_lg_ops.legal_catalog_admin`

**About this task**
A record producer helps you set up a legal intake form containing fields that a requester has to fill in and initiate a legal request. A record producer for a legal request is associated to a practice area and appears under a service catalog category defined in the practice area. The practice area also has the service level agreement and assignment rules configured. Based on the assignment rules, the request is assigned to an appropriate legal group or legal user to resolve.

**Procedure**
1. Navigate to **Legal Administration > Legal Catalog > Record Producers**.
2. Create or modify a record producer.
   - To create a record producer, click **New**.
   - To modify an existing record producer, open the record producer from the list.
3. On the form, fill in the fields.
# Record Producer form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the record producer.</td>
</tr>
<tr>
<td>Table name</td>
<td>Name of the table that stores the data collected through the record producer.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Legal Request [sn_lg_ops_request]</strong> if you are creating the record producer for legal requests.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Legal Matter [sn_lg_matter_matter]</strong> if you are creating the record producer for legal matters.</td>
</tr>
<tr>
<td>• Note: You must have installed the Legal Matter Management app to use this option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Select a table specific to a practice area if you want to use the data collected from the record producer for reporting. For more information, see Configure a practice area table.</td>
</tr>
<tr>
<td>Application</td>
<td>Application to which the record producer belongs.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set to the application scope in which you are creating the record producer.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the record producer active.</td>
</tr>
<tr>
<td></td>
<td>Only active record producers are available as legal intake forms in the Legal Service Portal.</td>
</tr>
<tr>
<td>What it will contain tab</td>
<td>Brief description of the record producer.</td>
</tr>
<tr>
<td>Short description</td>
<td>Full description of the record producer.</td>
</tr>
<tr>
<td>Description</td>
<td>Script that dynamically assigns values to specific fields on the created record.</td>
</tr>
<tr>
<td>Accessibility tab</td>
<td>Name of the service catalog to which the record producer belongs.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Select <strong>Legal Operations Catalog</strong>.</td>
</tr>
<tr>
<td>Category</td>
<td>Name of the service catalog category in which the intake form should appear in the Legal Service Portal.</td>
</tr>
</tbody>
</table>

4. Save the record producer.
• Save a new record producer by clicking Submit.
• Save the changes to an existing record producer by clicking Update.

5. In the Variables related list, add or modify variables.
Variables in a record producer appear as fields on the legal intake form to collect information from employees when they’re submitting a legal request.

**Important:** If you are configuring the record producer for a practice area table, you must map the variable with a column name of the selected table. On the Variable form, select the Map to field check box and the column name of the selected practice area table in the Field. Only the mapped variables are copied to the columns of the selected table.

For more information on creating variables, see Create a service catalog variable.

6. In the Applicable For and Not Applicable For related lists, apply the user criteria to control access of the record producer. User criteria define conditions for user records that enable you to grant or deny access to the record producer for users matching those conditions. For more information on creating a user criteria, see Set up the user criteria.

**Configure a practice area table**
Configure a practice area table so you can use fields from legal request and legal matter tables to include in the Lists section of Legal Counsel Center.

**Before you begin**
Role required: admin

**About this task**
The record producer uses variables to store field information submitted via intake forms for a legal request or legal matter. If you have to use any of these variables as columns in the list view in Legal Counsel Center, you must add them as columns in the respective practice area tables. These practice area tables extend the Legal Request [sn_lgs_ops_request] table for legal requests and the Legal Matter [sn_lg_matter_matter] table for legal matters. For more information, see Practice area tables for legal requests and Practice area tables for legal matters.

**Note:** For using practice area tables for legal matters, you must have the Legal Matter Management installed.

**Procedure**
1. Add new columns in a practice area table that you want to use to create reports for legal requests or legal matters submitted for the practice area.
   For more information, see Add and customize a field in a table.
2. Create or modify a record producer for a legal request or legal matter for the associated practice area.
   For more information, see Create or modify a record producer for legal requests.
3. Update the business rule to synchronize variables with the mapped table columns when users modify the intake form data after they’ve submitted a legal request or matter.
   b. Open the Sync variable with mapped columns business rule.
c. In the **When to run** tab, add a new OR condition for the category. For example, to synchronize the variables of a Compliance intake form with the mapped columns of the Compliance [sn_lg_ops_compliance] table, you would enter the following OR condition:

```
[Category] [is] [Compliance [sn_lg_ops_compliance]]
```

For more information, see [Create a business rule](#).

---

**Exploring Legal Counsel Center**

Legal Counsel Center enables legal department members to categorize, prioritize, and efficiently address legal issues.

Legal Counsel Center is available if you have installed the following apps:

- Legal Counsel Center (sn_lg_workspace)
- Legal Counsel Center Components (sn_lg_ws_comps)

Legal Counsel Center is built using the ServiceNow® Agent Workspace. You can customize Legal Counsel Center as per your departmental needs. For more information, see [Configure Legal Counsel Center](#).

**Key features**

Legal Counsel Center includes the following features:

**Department and user level metrics**

- Get an overview of new, assigned, unassigned, and high-priority requests.
- Review and act on upcoming milestones and pending approvals.

**Multi-tab interface**

- Track and address multiple requests concurrently by navigating between multiple open records.

**Real-time activity feed**

- View activities related to legal requests and legal matters and notifications in real time.

**Intuitive search and filter capabilities**

- Search for relevant information across multiple sources such as knowledge bases, open and resolved legal requests and legal matters, and catalog items in Counsel Assist.

**Configure Legal Counsel Center**

Configure the Legal Counsel Center to enable legal department members to quickly resolve legal requests and legal matters.

**Before you begin**

Legal Counsel Center is built using the ServiceNow® Agent Workspace, so make sure you're familiar with the Agent Workspace basics.

Role required: admin
Procedure

1. Navigate to **Workplace Experience > Administration > All Workspaces**.
2. Open the **Legal Counsel Workspace** record to configure.
3. **Optional:** On the Legal Counsel Workspace form, update fields as required.
   For more information about the fields, see [Get started setting up your workspace](#).

   ✨ **Note:** You can also customize the workspace in the UI Builder by clicking **Open in UI Builder**.
4. **Optional:** In the Workspace Lists related list, click **New** to set up filtered lists.
   List filters display a subset of the records in a table. For more information, see [Setting up list view in a workspace](#).
5. **Optional:** In the Landing Pages related list, open the **Legal Workspace Default Landing Page** record to customize and set up the landing page.
   For more information about creating a landing page, see [Creating custom landing pages for workspaces](#), and about customizing a landing page, see [Set up supplied landing pages in workspace](#).
6. **Optional:** In the Landing Page form, in the UX Page Element Permissions related list, click **New** to set up landing page permissions.
   These landing page permissions enable users to see the page based on their roles or groups they belong to. For more information, see [Set up landing page permissions](#).

Submit a legal request

Submit a legal request for yourself or on behalf of another user to seek services from the legal department.

**Before you begin**
Role required: sn_lg_ops.legal_user

**About this task**
You can also submit a legal request through your mobile device or the Virtual Agent chat.

- For more information on submitting a legal request through a mobile device, see [Submit a legal request through Now Mobile](#).
- To submit a legal request through Virtual Agent chat, you must have the Legal Virtual Agent Conversations application installed on your instance. For more information, see [Legal Virtual Agent Conversations](#).

**Procedure**

1. Navigate to **Legal Request > Legal Service Portal**.
2. Search for a legal service request or click **Service Catalog** to view all available request categories.
3. Filter and search in the categories for the legal service request.
4. Click a legal service item for which you want to submit a request.
   If you are not sure which legal service item to choose to submit your request, select **General Legal Request**.
5. On the form, fill in the fields.

   ✨ **Note:** Each legal service request form has a different set of fields based on the selected legal service item.
6. Click **Submit**.
**Results**

A legal request is created in the New state and is assigned to a group or user in the legal department based on the assignment rule set in the associated practice area.

If the administrator has configured notifications, you will receive notifications about the progress of the request.

**Legal request record details**

List of fields in the Details tab of a legal request in the Legal Counsel Center.

A legal request record in the Legal Counsel Center contains the complete information about the request. The Details tab contains fields from the legal intake form and other fields required by legal department users.

**Details tab fields for a legal request**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the legal request.</td>
</tr>
<tr>
<td>Practice area</td>
<td>Practice area to which the request belongs.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the legal request associated with the selected practice area.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Subcategory of the legal request associated with the category.</td>
</tr>
<tr>
<td>Priority</td>
<td>Level of priority to address the legal request. A higher priority means that the assigned user should act on the legal request sooner.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Users with read-only access who can review the legal request and post additional comments in the request. The list shows all users who have the sn_legal_user role. The request fulfiller can add any user from the list or enter the email address of a user who is not in the list.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date the legal request was submitted.</td>
</tr>
<tr>
<td>Opened by</td>
<td>User who submitted the legal request.</td>
</tr>
<tr>
<td>Requested for</td>
<td>User for whom the requester submitted the legal request.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the legal request.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Legal group to which the legal request is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User from the assignment group to whom the legal request is assigned.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the legal request.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Comments or notes for the internal users of the legal department who have the access to view the legal request.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Comments or notes for the requester or users in the Watch list field who have the access to view the request.</td>
</tr>
</tbody>
</table>
Update a submitted legal request

Update request details, add comments, or upload documents in a legal request you submitted while it is still in the New or Assigned state. You can cancel a submitted request irrespective of its state.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Service Portal.
2. Open your submitted legal request from the My Requests option on the header menu.
3. On the Standard Ticket page, review and edit the request details, manage attachments, or cancel the request.

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the request details</td>
<td><strong>Note:</strong> This option is available only if the request is in the New state.</td>
</tr>
<tr>
<td></td>
<td>a. From the Actions menu, select Edit Request.</td>
</tr>
<tr>
<td></td>
<td>b. In the Variables form, modify the request details.</td>
</tr>
<tr>
<td></td>
<td>c. Click Save.</td>
</tr>
<tr>
<td></td>
<td>d. Click Back to return to the Standard Ticket page.</td>
</tr>
<tr>
<td></td>
<td>The legal request is updated with the new information. The changes appear as comments in the Additional Comments section of the request.</td>
</tr>
</tbody>
</table>

| Cancel the request          | a. From the Actions menu, select Cancel Request.                      |
|                             | b. In the Confirm request cancellation dialog box, provide the reason for the cancellation in the Comments field and click Confirm Cancellation. |
|                             | The request is canceled and the cancellation comments appear in the Additional Comments section of the request. |
|                             | Any associated active flows are terminated. Any pending approval record is also canceled and a comment is posted in the Additional Comments section of the approval record. |

4. Optional: In the Activity tab, provide comments or more information about your request for the request fulfiller.

5. Optional: In the Attachments tab, manage the attachments supporting your request.
   - To upload a new document, click the add attachment icon (🪞) and select a file.
   - To rename an attached file, click the edit file name icon (✍️) and update the file name.
   - To remove the attached file, click the delete icon (🗑️).

Assign a legal request

Assign a legal request to yourself or to someone in your assignment group.

Before you begin
Role required: sn_lg_ops.legal_fulfiller
About this task
When an employee submits a legal request, it is automatically assigned to a group or user in the legal department. The assignment is done based on the assignment rules configured for the intake form of the associated practice area. If the request is assigned to a legal group, any member from the group can triage the request themselves or assign it to another member of the group.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon ().
3. In the Legal Requests, click Unassigned.
4. In the list of unassigned requests, open a request by clicking the request number.
5. Assign the request to yourself or to another member from the assigned group.
   • To assign the request to yourself, click Assign to me.
   • To assign the request to another member, on the Details tab, select a user in the Assigned to field and click Save.

Results
The state of the request updates to Assigned.

What to do next
The assigned user can start working on the legal request.

Work on a legal request
As a member of the legal department, work on legal requests assigned to you and resolve issues or answer queries.

Before you begin
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon ().
3. In the Lists tab, under Legal Requests, click Assigned to Me.
4. Open a legal request to work on.
5. Click Start to start working on the request.
   The state of the legal request updates to Work in Progress.
6. Work on the legal request to fulfill the requested services or information.
   If the request needs detailed investigation, you can promote the request to a legal matter.

Note: To promote a legal request to a legal matter, you must have the Legal Matter Management app installed and the record producer type for the associated intake form must be set to Request and Matter. For more information on setting a record producer type, see Add an intake form to a practice area.
7. Optional: Initiate an ad hoc approval for the legal request or its attachments when an approval is required from other stakeholders.
8. Either close the request or cancel it.
• After you resolve the request, you can close the request.
• If you identify that the request doesn’t need any action, you can cancel it.

Initiate an ad hoc approval for a legal request or its attachment

Initiate an ad hoc approval for a legal request or its attachments from a user or a user group.

Before you begin
Role required: sn-lg_ops.legal_fulfiller

About this task
Some cases where approvals can be requested for a legal request or its attachment include:
• Approval for legal contract documents from stakeholders.
• Ad hoc approval for a legal request that needs an authorization from the privacy team before it can be processed.

You can assign these approvals to any user or user group in your organization regardless of whether they have the required roles to access the request record. When you initiate an approval, the approvers receive an email notification and can review and act on the approval. An approver who doesn’t have access to the item is granted read-only access to the record until the assigned approval record is completed.

Note: If a legal request or attachment already has a pending approval record, you cannot initiate another approval for the same item.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon ( ).
3. In the Lists tab, under Legal Requests, click Assigned to Me.
4. Open a legal request.
5. If the legal request is newly assigned to you, click Start Work. The state of the legal request updates to Work in Progress.
6. In the Approvers tab, click Initiate Approval.
   You can also initiate an approval by clicking the more actions button ( ) and selecting Initiate Approval.
7. On the Initiate Approval dialog box, fill in the fields.

Initiate Approval dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval for</td>
<td>Item that needs an approval.</td>
</tr>
<tr>
<td></td>
<td>• Request: Get approval for the entire legal request.</td>
</tr>
<tr>
<td></td>
<td>• Attachment: Get approval for an attachment in the legal request.</td>
</tr>
<tr>
<td>Select attachment</td>
<td>Attachment in the legal request for which approval is required.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>This field appears only when <strong>Attachment</strong> is selected from <strong>Approval for</strong>.</td>
</tr>
<tr>
<td>Approval by</td>
<td>Approval required at user level or user group level.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User</strong>: Get approval from an individual user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User group</strong>: Get approval from a set of users. The <strong>Select user</strong> field is replaced by the <strong>Select user group</strong> field.</td>
</tr>
<tr>
<td>Select user</td>
<td>User or user group who must approve the item.</td>
</tr>
<tr>
<td></td>
<td>• If you selected <strong>User</strong> in the <strong>Approval by</strong> field, select a user from whom the approval is required.</td>
</tr>
<tr>
<td></td>
<td>• If you selected <strong>User group</strong> in the <strong>Approval by</strong> field, select a user group from whom the approval is required.</td>
</tr>
<tr>
<td>Approval note</td>
<td>Note for the selected user or user group.</td>
</tr>
</tbody>
</table>

8. Click **Initiate**.

**Results**
Assigned approvers are added in the **Approvers** tab based on the following conditions:

- If you selected **User** in the **Approval by** field, an approval record is created for the selected user.
- If you selected **User group** in the **Approval by** field, an approval record for each user in the selected user group is created. Anyone from the group can approve.

The assigned approvers get an email notification with a link to open the record for review and action.

ℹ️ **Note:** An attachment cannot be deleted after an ad hoc approval is initiated and is in the Requested state.

**What to do next**
Approvers can review and **approve or reject the requested item**.

**Cancel an ad hoc approval for a legal request**
Cancel an ad hoc approval for a legal request if it no longer requires any action.

**Before you begin**
You can only cancel an ad hoc approval that is in the Requested state.

Role required: sn/lg_ops.legal_fulfiller

**Procedure**
1. Navigate to **Legal Request > Legal Counsel Center**.
2. Click the list icon (･･･).
3. In the Lists tab, under **Legal Requests**, click **Assigned to Me**.
4. In the **Approvers** tab, click **Cancel Approval**.

5. In the Cancel Approval dialog box, select the approval record from the **Approval for** field that you want to cancel.

6. Enter comments for canceling the approval record and click **Confirm Cancellation**.

**Results**
The approval record is canceled and its state updates to Cancelled and comments are added to the approval record. If the approval was requested from a user group, then the corresponding approval records for all users in the user group are canceled.

**Approve or reject a legal request or its attachment**
Review a legal request or attachment and approve or reject it.

**Before you begin**
You must have received an email notification with a link to the legal item for approval.
Role required: None

**Procedure**

1. Click the link in the email to open the legal item that needs approval.
   You can also open the item by navigating to **Self-Service > My Approvals**.

2. Review the item and either approve or reject:
   - To approve the item, click **Approve**.
   - To reject the item, enter comments for rejection in the **Comments** field and click **Reject**.

**Results**
The following table shows the result of approve and reject actions on the approval record.

<table>
<thead>
<tr>
<th>Result of approving or rejecting a legal item</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve</strong></td>
</tr>
<tr>
<td>• The state of the approval record updates</td>
</tr>
<tr>
<td>from Requested to Approved.</td>
</tr>
<tr>
<td>If the requested item was assigned to a</td>
</tr>
<tr>
<td>user group for approval, then the state of</td>
</tr>
<tr>
<td>the approval records for the remaining</td>
</tr>
<tr>
<td>users updates from Requested to No</td>
</tr>
<tr>
<td>Longer Required.</td>
</tr>
<tr>
<td><strong>Note:</strong> If the approval was for an</td>
</tr>
<tr>
<td>attachment of a legal request, the</td>
</tr>
<tr>
<td>attachment cannot be deleted from</td>
</tr>
<tr>
<td>the legal request.</td>
</tr>
<tr>
<td>• If the approvers are not the collaborators</td>
</tr>
<tr>
<td>(added to the Watchlist) of the legal</td>
</tr>
<tr>
<td>request, they would lose access to the</td>
</tr>
<tr>
<td>approved item.</td>
</tr>
</tbody>
</table>

**Promote a legal request to a legal matter**
Promote a legal request to a legal matter when the request needs additional investigation and cross-departmental collaboration that might take more time to resolve.
Before you begin
Ensure you have the Legal Matter Management app installed and the record producer type in the associated intake form set to Request and Matter. For more information, see Add an intake form to a practice area.
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Requests, click Assigned to Me.
4. Open an assigned request that you want to promote to a legal matter.
5. Click Create Matter.
6. In the Create Matter dialog, indicate whether to use a template to create a legal matter.
   • To create a legal matter record with predefined data, such as phases and tasks, select a template name from the Matter template list, and click OK.
   • To create a legal matter record without any predefined data, leave the Matter template field empty and click OK.

Results
• A legal matter is created with details copied from the legal request.
• If you selected a matter template, then the matter has predefined phases, tasks, and attributes from the template.

Close a legal request
You can close a legal request assigned to you when you’ve resolved it.

Before you begin
If you’ve installed Legal Matter Management and have a legal request promoted to a legal matter, the system closes legal requests automatically when the matter owner chooses to close the related requests while closing the matter.

⚠️ Note: A legal request cannot be closed if there are any open ad hoc approval records for it or its attachments.

Role required: sn_lg_ops.legal_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Requests, click Assigned to Me.
4. Open a legal request that you want to close.
5. Optional: Attach files that are a solution for the request or a knowledge base article as reference material for the requester.
6. Close the request based on the work done on the request:
   • If your work on the request resolved the request, click Close Complete.
   • If you have done some work on the request but were unable to resolve the request, click Close Incomplete.
7. In the dialog box, enter comments to explain why the request was closed in the Additional comments field.

8. Click OK.

Results
The legal request is closed. Based on the selected close option, the state of the request changes to Closed Complete or Closed Incomplete.

Legal Matter Management

The ServiceNow® Legal Matter Management application enables you to complete legal requests that need cross-departmental tasking and a workflow with a mechanism to store supporting documents and track important milestones. With its embedded record-level security, maintain the confidential and sensitive information of each record. Define a standardized process and workflow for various matter types using matter templates.

### Explore
- Legal Service Delivery release notes
- Legal Matter Management overview
- Legal Counsel Center overview

### Set up
- Install Legal: Matter Management

### Administer
- Legal matter templates

### Use
- Assign a legal matter to a legal group user
- Work on a legal matter

### Develop
- Developer training
- Developer documentation
- Components installed with Legal Matter Management

### Troubleshoot and get help
- Ask or answer questions in the Legal Service Delivery forum on the Now Community
- Search the HI Knowledge Base for known error articles
- Contact Customer Service and Support

Legal Matter Management overview

Legal Matter Management enables you to manage legal matters and cross-functional tasking to effectively complete legal work. You can store relevant documents and track important milestones of these legal matters from a single place.

Creating a legal matter
You can create a legal matter in two ways:

- A paralegal staff or lawyer can promote a legal request to a legal matter if the request needs additional investigation and substantial time to work on.
- A practice area lead can create a legal matter directly. These matters do not have any parent legal request though related requests can be added to them.

Features
The features of this application include:
• Matter templates for different practice areas with predefined phases and tasks
• Privacy and confidentiality at the record level of a legal matter to secure the sensitive information
• Artifacts within the matter record to better manage the legal documents relevant to a legal matter
• Milestones to track the progress of a legal matter

Benefits
The benefits of this application include:
• Manage and track every aspect of a legal matter
• Remove manual, unstructured email processes and tasks
• Track and complete tasks and milestones through notifications
• Make meaningful decisions by gaining real-time visibility on legal matters
• Track, prioritize, and work on multiple legal matters concurrently with an optimized Legal Counsel Center

Install Legal: Matter Management
You can install the Legal: Matter Management application (sn_lg_matter) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin
• Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
• If the application requires plugins or other store applications, install them first if they are not already installed.

Install the following application before you install Legal: Matter Management application (sn_lg_matter):
• Legal: Request Management (sn_lg_ops)

Role required: admin

About this task
The following components are installed with installation of the Legal: Request Management application:
• Plugins
• Store applications
• Roles
• Tables
• Tables specific to practice areas
• Business Rules

See Components installed with Legal Matter Management for more information.
You can also install the following applications:
Legal Counsel Center (sn_lg_workspace)

The ServiceNow® Legal Counsel Center application enables lawyers to solve issues faster with a workspace built to facilitate resolutions. From a single view, get the full context of legal issues to resolve them quickly.

Legal Counsel Center Components (sn_lg_ws_comps)

The ServiceNow® Legal Counsel Center Components application enhances the workspace experience for the Legal Counsel Center by decoupling the components in the Legal Counsel Center to offer better performance.

Legal Mobile (sn_lg_mobile)

The ServiceNow® Legal Mobile (sn_lg_mobile) application provides the ability to find legal information, submit and track legal requests, and work on these requests on mobile devices. For more information, see Legal Mobile.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Legal: Matter Management application (sn_lg_matter) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal: Matter Management.

4. Optional: If demo data is available and you want to install it, click Load demo data.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   Important: If you don't load the demo data during installation, it's unavailable to load later.

5. Click Install.

What to do next

Use the Legal Service Delivery Guided Setup to configure the application on your instance.

To access Legal Service Delivery Guided Setup, navigate to Legal Administration > Legal Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Components installed with Legal Matter Management

Several types of components are installed with installation of the Legal Matter Management application, including tables, and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.
Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Matter Administrator [sn_lg_matter.matter_admin] | Provides the administrative access to legal matters and the underlying data. | • sn_lg_matter.matter_config
• sn_lg_matter.matter_manager |
| Matter Configurator [sn_lg_matter.matter_config] | Provides access to configure data such as practice areas, intake forms, and matter templates. It does not provide access to transactional data of legal requests and legal matters. | • flow_designer
• flow_designer_scripting
• sla_manager
• sn_lg_matter.matter_config_read |
| Matter Configurator Read-only [sn_lg_matter.matter_config_read] | Provides read-only access to legal apps configuration data such as practice areas and matter templates. | • sn_lg_ops.legal_user |
| Matter Fulfiller [sn_lg_matter.matter_fulfiller] | Provides the fulfiller access for working on assigned matters. | • approver_user
• catalog
• knowledge
• sn_lg_matter.matter_config_read
• sn_lg_ops.legal_report_viewer
• sn_lg_ops.legal_sla_read
• task_editor
• workspace_user |
| Matter Manager [sn_lg_matter.matter_manager] | Provides access to all transactional data of matters and permission to assign matters. | • sn_lg_matter.matter_fulfiller |

Tables installed

⚠️ Note: In addition to the following tables, tables specific to practice areas are installed with Legal Matter Management. For more information, see Practice area tables for legal matters.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Artifact Content Type [sn_lg_matter_artifact_content_type]</td>
<td>Stores the content type used for categorizing matter artifacts.</td>
</tr>
<tr>
<td>External Storage [sn_lg_matter_artifact_external_storage]</td>
<td>Stores links of external systems such as OneDrive or SharePoint where matter documents can be stored.</td>
</tr>
<tr>
<td>Legal Artifact [sn_lg_matter_artifact]</td>
<td>Stores the artifact details collected for a matter.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Legal Matter Core [sn_lg_matter_core]</td>
<td>Stores the core details of a matter.</td>
</tr>
<tr>
<td>Legal Matter Phase [sn_lg_matter_phase]</td>
<td>Stores the phases of a matter.</td>
</tr>
<tr>
<td>Legal Matter Task [sn_lg_matter_task]</td>
<td>Stores the tasks associated to a phase or a matter.</td>
</tr>
<tr>
<td>Matter Task Artifact [sn_lg_matter_m2m_matter_task_artifact]</td>
<td>Stores the details of the relationship between an artifact and a matter task.</td>
</tr>
<tr>
<td>Matter Task Template [sn_lg_matter_template_task]</td>
<td>Stores the tasks defined in a matter template.</td>
</tr>
<tr>
<td>Matter Template [sn_lg_matter_template]</td>
<td>Stores the matter template that defines the default values for a matter. Creating a matter from the matter template populates predefined values in the matter.</td>
</tr>
<tr>
<td>Request - Matter m2m [sn_lg_matter_m2m_request_matter]</td>
<td>Stores the details of the relationship between a request and a matter.</td>
</tr>
</tbody>
</table>

### Practice area tables for legal matters

Tables specific to practice areas are installed with the Legal Matter Management application.

These practice area tables extend the Legal Matter [sn_lg_matter_matter] table.

If you add columns in a practice area table, you can configure the table to add those columns in the Lists section of Legal Counsel Center. You can also use these tables in other configuration.

For more information, see Configure a practice area table.

- Compliance [sn_lg_matter_compliance]
- Corporate Support [sn_lg_matter_corporate_support]
- Digital Forensics [sn_lg_matter_digital_forensics]
- Ethics [sn_lg_matter_ethics]
- General Contract Support [sn_lg_matter_general_contract_support]
- General Legal [sn_lg_matter_general_legal]
- Government Affairs [sn_lg_mattergovernment_affairs]
- Labor and Employment [sn_lg_matter_labor_and_employment]
- Legal Operations [sn_lg_matter_legal_operations]
- Licensing and Tech Transactions [sn_lg_matter_licensing_and_tech_transactions]
- Litigation [sn_lg_matter_litigation]
- Marketing Support [sn_lg_matter_marketing_support]
- Mergers and Acquisitions [sn_lg_matter_mergers_and_acquisitions]
- Patents, Trademark and Trade Secrets [sn_lg_matter_patents_trademark_and_trade_secrets]
• Privacy and Data Security [sn_lg_matter_privacy_and_data_security]
• Procurement Contract Support [sn_lg_matter_procurement_contract_support]
• Sales Contract Support [sn_lg_matter_sales_contract_support]
• Stock Plan Support [sn_lg_matter_stock_plan_support]

Legal matter templates
Legal matter templates help you standardize legal procedures, policies, and workflows for various matter types.

Create a legal matter template
Create a legal matter template that you can apply to a legal matter when promoting from a legal request. The legal matter created using the template contains predefined data such as phases, tasks, ownership, and approvals.

Before you begin
Role required: sn_lg_matter.matter_config

About this task
You can also reuse an existing matter template to create a new matter template. To do that, you can open an existing template and copy it using the Copy Template related link. You can then modify the newly created template as required.

Procedure
1. Navigate to Legal Matter > Templates > All.
2. Click New.
3. On the form, fill in the fields.

Matter Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated template number.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the matter template.</td>
</tr>
<tr>
<td>Approver group</td>
<td>User group to approve the matter template to publish. Any user belonging to the selected approver group can approve the matter template. If the approver group is empty, the template is published when saved. The state of the template updates to Published.</td>
</tr>
<tr>
<td>Flow</td>
<td>Workflow associated with the matter.</td>
</tr>
<tr>
<td>State</td>
<td>State of the matter template. The default value when creating a matter template is Draft.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the matter template active. Only active matter templates are available for selection when creating a matter.</td>
</tr>
</tbody>
</table>
### Intake form mapping

The intake form to which the matter is mapped. While promoting a legal request to a matter, the intake form mapping enables the associated matter template available for legal fulfillers to select and apply to the promoted matter.

### Matter Defaults section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>Default values that pre-populate the fields of a legal matter form that is created using the template. Select a field from the list and enter a default value.</td>
</tr>
</tbody>
</table>

#### 4. Click **Submit**.

A legal matter template is created in the Draft state.

#### 5. Create **phase templates** and **task templates** for the matter template.

#### 6. Click **Submit for approval**.

- If an approver group is selected, the template is sent to the group for approval. The state of the matter template updates to Waiting Approval. Anyone from the approver group can **review and approve the matter template** to publish it.

- If an approver group is not selected, the matter is directly published and its state is Published.

---

### Create a phase template for a matter template

Create a phase template for a matter template for resolving the matter in an organized way. When you apply a legal matter template while creating a matter, the associated phases from the template are added by default to the matter.

#### Before you begin

**Role required:** sn_lg_matter.matter_config

#### Procedure

1. Navigate to **Legal Matter > Templates > All**.
2. Open a matter template.
3. In the Phases related list, click **New**.
4. On the form, fill in the fields.

### Matter Phase Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated phase template number.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the phase template.</td>
</tr>
<tr>
<td>Parent matter</td>
<td>Matter template to which the phase template belongs.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that determines the order in which the phase should be worked on to resolve</td>
</tr>
</tbody>
</table>
5. Click Submit.

**What to do next**
Create task templates within a phase template.

**Create a task template within a phase template**
Create a task template within a phase template of a legal matter template. When you apply a legal matter template while creating a matter, the associated phases and tasks from the template are added by default to the matter.

**Before you begin**
Role required: sn_lg_matter.matter_config

**Procedure**
1. Navigate to Legal Matter > Templates > All.
2. Open a matter template.
3. In the Phases related list, open a phase template to which you want to add a task template.
4. In the Matter Task Templates related list, click New.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated task template number.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the task template.</td>
</tr>
<tr>
<td>Parent</td>
<td>Phase template to which the task template belongs.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that determines the order in which the task should be worked on to resolve the matter. A task template with a lower-order number is higher in the queue to be worked on.</td>
</tr>
</tbody>
</table>

**Task Defaults section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>Default values populated in fields on a task form in the legal matter that is created using the matter template. Select a field from the list and enter value for it.</td>
</tr>
</tbody>
</table>

6. Click Submit.
A task template is created. The Checklist section appears.

7. **Optional:** Add to-do items in the Checklist section to provide a list of activities for the task fulfiller.
a. Click the more actions icon (⟳) next to the Checklist.

b. Click Create new.

c. Enter a description for the to-do item and press the Enter key. This checklist appears as the default to-do items in the task.

8. Click Update.

Approve or reject a matter template

Review and approve or reject a matter template that is assigned to a user group of which you are a member. An approved matter template is published and is available for use when promoting legal requests to legal matters.

Before you begin
Role required: approver_user

Procedure
1. Navigate to Self-Service > My Approvals.
2. Open a matter template for review that has a state of Requested.
3. In the Summary of Item being approved section, review the matter template details.
4. Approve or reject the matter template.
   • To approve the matter template for publication, click Approve. The state of the approval request updates to Approved.
   • To reject the matter template, click Reject. The state of the approval request updates to Rejected.

Results
• If you approve, the matter template is published. The state of the matter template record updates to Published.
• If you reject, the matter template state updates to Draft. The user who created the matter template can work on the template again to complete the required information and resubmit for approval.

Assign a legal matter to a legal group user

Assign a legal matter to yourself or to someone in the assignment group to start working on the matter.

Before you begin
Role required: sn_lg_matter.matter_manager

About this task
During the creation of a legal matter either directly or by promoting a legal request, it is assigned to an assignment group. The practice area lead or the group manager can assign the legal matter to themselves or to another member of the group.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Unassigned.
4. In the list of unassigned matters, click a matter number to open.
5. In the Details tab, select your name or the name of another user in the Matter owner field to work on the matter.
6. Click Save.

Results
The legal matter is assigned to the selected member of the user group. The state of the matter updates to Assigned.

What to do next
The assigned member can start working on the legal matter.

Work on a legal matter
As a matter owner, work on a legal matter assigned to you to resolve issues or answer queries.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter that you want to work on.
5. Click Start to start working on the legal matter.
   The state of the legal matter updates to Work in Progress.
6. Optional: Initiate an ad hoc approval for the legal matter or its artifact’s content when an approval is required from other stakeholders.
7. Optional: In the Counsel Assist section, create and manage a checklist of items to track what should be done to resolve the legal matter.
8. Create phases and tasks under phases to organize the investigation.
   You can assign these tasks to users across various departments in your organization.
9. Add milestones to keep a track of timelines to complete important tasks.
10. Create artifacts (folders) and upload files into these artifacts to record and store supporting documents within the matter.
11. Optional: Associate the matter with another legal request that is similar in nature.
12. Either close the legal matter after you have completed the required activities or cancel it if it does not need further action.
   • To close the matter, follow the instructions in Close the legal matter.
   • To cancel the matter, click the more actions button (…) and select Cancel.
13. If new information surfaces or further investigation is required reopen the legal matter after it has been closed or canceled.

Initiate an ad hoc approval for a legal matter or its artifact
Initiate an ad hoc approval for a legal matter or its artifacts from a user or a user group.
Before you begin
Role required: sn_lg_ops.legal_fulfiller

About this task
Some cases where approvals can be requested for a legal matter or its artifact include:

- Approval for legal contract documents from stakeholders.
- Ad hoc approval for a legal matter that needs an authorization from the privacy team before it can be processed.

You can assign these approvals to any user or user group in your organization regardless of whether they have the required roles to access the matter record. When you initiate an approval, the approvers receive an email notification and can review and act on the approval. An approver who doesn’t have access to the item is granted read-only access to the record until the assigned approval record is pending.

Note: If a legal matter or artifact already has a pending approval record, you cannot initiate another approval for the same item.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter.
5. If the legal matter is newly assigned to you, click Start Work. The state of the legal matter updates to Work in Progress.
6. In the Approvers tab, click Initiate Approval.
   You can also initiate an approval by clicking the more actions button (⋯) and selecting Initiate Approval.
7. On the Initiate Approval dialog box, fill in the fields.

Initiate Approval dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval for</td>
<td>Item that needs an approval.</td>
</tr>
<tr>
<td>Select artifact</td>
<td>Artifact in the legal matter for which approval is required. This field appears only when Artifact is selected from Approval for.</td>
</tr>
<tr>
<td>Select attachment</td>
<td>Attachment in the selected artifact for which approval is required. Choose a specific attachment for approval, or leave the field empty to get approval for all attachments.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>This field appears only when Artifact is selected from Approval for.</td>
<td></td>
</tr>
<tr>
<td>Approval by</td>
<td>Approval required at user level or user group level.</td>
</tr>
<tr>
<td>• User: Get approval from an individual user.</td>
<td></td>
</tr>
<tr>
<td>• User group: Get approval from a set of users. The Select user field is replaced by the Select user group field.</td>
<td></td>
</tr>
<tr>
<td>Select user</td>
<td>User or user group who must approve the item.</td>
</tr>
<tr>
<td>• If you selected User in the Approval by field, select a user from whom the approval is required.</td>
<td></td>
</tr>
<tr>
<td>• If you selected User group in the Approval by field, select a user group from which the approval is required.</td>
<td></td>
</tr>
<tr>
<td>Approval note</td>
<td>Note for the selected user or user group.</td>
</tr>
</tbody>
</table>

8. Click **Initiate**.

**Results**
Assigned approvers are added in the **Approvers** tab based on the following conditions:

- If you selected **User** in the **Approval by** field, an approval record is created for the selected user.
- If you selected **User group** in the **Approval by** field, an approval record for each user in the selected user group is created. Anyone from the group can approve.

The assigned approvers get an email notification with a link to open the record for review and action.

⚠️ **Note:** An attachment cannot be deleted after an ad hoc approval is initiated and is in the Requested state.

**What to do next**
Approvers can review and approve or reject the requested item.

**Cancel an ad hoc approval for a legal matter**
Cancel an ad hoc approval for a legal matter if it no longer requires any action.

**Before you begin**
You can only cancel an ad hoc approval that is in the Requested state.
Role required: sn_lg_ops.legal_fulfiller

**Procedure**
1. Navigate to **Legal Request > Legal Counsel Center**.
2. Click the list icon (≡).
3. In the Lists tab, under **Legal Matters**, click **Assigned to Me**.
4. In the **Approvers** tab, click **Cancel Approval**.

5. In the Cancel Approval dialog box, select the approval record from the **Approval for** field that you want to cancel.

6. Enter comments for canceling the approval record and click **Confirm Cancellation**.

**Results**
The approval record is canceled and its state updates to Cancelled and comments are added to the approval record. If the approval was requested from a user group, then the corresponding approval records for all users in the user group are canceled.

**Approve or reject a legal matter or its artifact**
Review a legal matter or its artifact’s content and approve or reject it.

**Before you begin**
You must have received an email notification with a link to the legal item for approval.  
Role required: None

**Procedure**
1. Click the link in the email to open the legal item that needs approval.  
   You can also open the item by navigating to **Self-Service > My Approvals**.

2. Review the item and either approve or reject:
   - To approve the item, click **Approve**.
   - To reject the item, enter comments for rejection in the **Comments** field and click **Reject**.

**Results**
The following table shows the result of approve and reject actions on the approval record.

<table>
<thead>
<tr>
<th>Result of approving or rejecting a legal item</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve</strong></td>
</tr>
<tr>
<td>• The state of the approval record updates</td>
</tr>
<tr>
<td>from Requested to Approved.</td>
</tr>
<tr>
<td>If the requested item was assigned to a</td>
</tr>
<tr>
<td>user group for approval, then the state of</td>
</tr>
<tr>
<td>the approval records for the remaining users</td>
</tr>
<tr>
<td>updates from Requested to No Longer Required.</td>
</tr>
<tr>
<td><strong>Reject</strong></td>
</tr>
<tr>
<td>• The state of the current approval record</td>
</tr>
<tr>
<td>updates to Rejected.</td>
</tr>
<tr>
<td>If the requested item was assigned to a</td>
</tr>
<tr>
<td>user group for approval, then the state of</td>
</tr>
<tr>
<td>the approval records for the remaining users</td>
</tr>
<tr>
<td>updates from Requested to No Longer Required.</td>
</tr>
</tbody>
</table>

**Note**: If the approval was for an attachment of the legal matter artifact, the attachment cannot be deleted from the legal matter artifact.

• If the approvers are not the collaborators (added to the Watchlist) of the legal matter, they would lose access to the approved item.

Add a phase to a legal matter
Add a phase to a legal matter to track specific tasks to complete the matter.
Before you begin
Role required: sn_lg_matter.matter_fulfiller

About this task
If you created a legal matter using a matter template, you might already have the predefined phases in the matter from the template.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter to which you want to add a phase.
5. In the Phases tab, click New.
6. In the Name field, enter a unique name for the phase.
7. In the Order field, enter a number to determine the order in which the phase should be processed.
8. Click Save.

Results
A phase is added to the matter.

What to do next
Add tasks in the phase to manage activities in the matter. If the task has to be done by a different user, assign it to them.

Create a task for a legal matter
Create a task in a legal matter or a phase of the matter that you or another user should perform to resolve the matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter to add tasks to a matter or a phase.
   • To add a task to a matter, in the Tasks tab of the Legal Matter form, click New.
   • To add a task to a phase, open a phase from the Phases tab and click New in the Legal Matter Tasks tab of the phase record.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the task.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
</tbody>
</table>

6. Click **Save**.

7. **Optional**: In the contextual sidebar, add instructions and to-do items for the task.
   - In the **Instructions** section, click **Add** to add instructions for the assigned user to do to complete the task.
   - In the **Checklist** section, click **Create** to add to-do items to track the progress of activities in the matter task.

8. **Optional**: Add an artifact (folder) in which you or the assigned user can upload files related to the task or its investigation.
Results
A legal matter task is created and is listed in the matter's Tasks tab. If the task was added in a phase record, then the task is also listed in the phase’s Legal Matter Tasks tab.

💡 Tip: If the new task doesn’t appear in the list, click the refresh list button (⟳).

Complete a legal matter task
When you finish working on an assigned matter task, mark the task as complete.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the My Work, click Tasks to do.
4. In the My Tasks list, open the task.
5. Optional: In the Activity section of the task, enter comments or add attachments.
6. Click Mark as Complete.

Results
The matter task is completed and its state updates to Review. It sent to the matter owner for approval.

Approve or reject a legal matter task
As a matter owner, you can review and approve or reject matter tasks that are marked as complete by the task owners.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. In the My Work, click Items Pending Approvals.
3. In the Tasks To Do list, click Requested to open a matter task for review for approval.
4. Approve or reject the matter task:
   • To approve the matter task, click Approve. The state of the approval request updates to Approved.
   • To reject the matter task, click Reject. In the dialog box, enter comments for approval or rejection in the Comments field. The state of the approval request updates to Rejected.

Results
• If you approve the matter task, the task is closed. The state of the task updates to Closed Complete.
• If you reject the matter task, the task is opened again. The state of the task updates to Work in Progress. The task owner can work on the task again to fulfill the requirements of the task and mark it complete for approval.
Cancel a legal matter task

You can cancel a matter task if it no longer requires any action.

Before you begin

You can cancel only tasks that are in any of these states: Draft, Assigned, or Work in Progress.

Role required: sn_lg_ops.legal_user

Procedure

1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. In the Tasks tab, open the task you want to cancel.

Note: You can also cancel multiple tasks in one go. Select tasks in the list and click Cancel Tasks.
5. In the Legal Matter Task form, click Cancel.
6. In the Cancel Task dialog box, enter comments for cancelling the task and click OK.

Results

The matter task is cancelled and its state updates to Cancelled.

Create an artifact for a legal matter

Create an artifact for a legal matter to upload and store documents, emails, and files related to the matter.

Before you begin

Role required: sn_lg_matter.matter_fulfiller

About this task

As a matter owner or a task fulfiller, you can also add an artifact to a matter task from the Tasks tab.

Note: If the requester attached any files when submitting a request, a default artifact containing those files is created in the matter promoted from the request.

Procedure

1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open the legal matter to which you want to add an artifact.
5. In the Artifacts tab, click New.
6. On the form, fill in the fields.

Artifact form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number of the artifact.</td>
</tr>
<tr>
<td>Parent matter</td>
<td>Matter with which the artifact is associated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content type</td>
<td>Type of content the artifact can contain, such as emails, documents, or images.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the artifact, for example, the name of the artifact.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description for the artifact, for example, the purpose and content of the artifact.</td>
</tr>
<tr>
<td>Notes section</td>
<td></td>
</tr>
<tr>
<td>Work notes</td>
<td>Comments or notes that only authorized users related to the artifact and parent matter can see.</td>
</tr>
</tbody>
</table>

7. Click **Save**.
   The artifact with the specified details is created.

8. In the **External Storage** tab, add the path or link of the directory where the files attached to the artifact would be uploaded and stored.
   a. Click **New** to add a new storage path.
   b. Enter a valid link to the storage folder and a short description.
   c. Click **Save**.

9. **Optional**: Associate the artifact with a matter task.

   • **Note**: If you create an artifact from a matter task, the artifact is associated to the task by default.
     a. In the Matter Task tab, select an artifact and click **Add**.
     b. In the Add Legal Task dialog box, select a matter task and click **Add**.
        When the matter owner assigns this task to a group or a user, they get the access to the artifact automatically. Users who can access the artifact are listed in the Artifact Users tab.

10. **Optional**: Revoke the access permission of users who were given default access through the associated matter task.
    a. In the Artifact Users tab, select one or more users to whom you want to deny access to the artifact.
    b. Click **Revoke permissions**.
    c. Click **Save**.

**What to do next**
**Attach files to a legal matter.**

**Attach files to a legal matter**
Upload supporting documentation, such as documents, email copies, images, or any other files into the artifact while you are working on a legal matter or matter task. You can also use these artifacts as a reference material to solve similar requests in future.

**Before you begin**
Role required: sn_lg_matter.matter_fulfiller or sn_lg_ops.legal_user
Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter to attach a file.
5. In the Artifacts tab, open an artifact.
6. In the Attachments section, attach a file.
   - If you are attaching a file for the first time, click Browse.
   - If you are attaching files to an artifact that already has attachments, click the add attachment icon (✚).
7. Select a file to attach and click Open.

Results
The attached file is listed in the Attachments list.

Add a milestone to a legal matter
Add a milestone to a legal matter to track important calendar events related to the matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

About this task
You can track the upcoming milestones in a matter in the Home tab of the Legal Counsel Center.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter to which you want to add a milestone.
5. In the Milestones tab, click New.
6. In the Name field, enter a unique name for the milestone.
7. In the Due date field, select a date by which the milestone should be accomplished.
8. Click Save.

Results
A milestone with the specified due date is created.

Associate related legal requests with a legal matter
Associate one or more legal requests with a legal matter to organize and resolve related requests through a single matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller
Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open a legal matter to which you want to associate a legal request.
5. In the Related Requests tab, click Add.
6. In the Add Legal Request dialog box, select the requests you want to add to the matter and click Add.

⚠️ Note: Any legal request can be associated with a matter including closed or cancelled requests.

Results
The selected legal requests are added to the matter and listed in the Related Requests tab.

Associate an existing legal matter with a legal request
Associate an existing legal matter with a legal request that is similar to provide helpful information in resolving the request.

Before you begin
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Requests, click Assigned to Me.
4. Open the request to which you want to associate an existing matter.
5. In the Legal Matters tab, click Add.
6. In the Add Legal Matter dialog box, select a legal matter you want to add to the request and click Add.

Results
The selected legal matter is associated with the legal request and shows up in the list in the Legal Matters tab.

Close a legal matter
Close a legal matter assigned to you when you complete all activities for resolving the legal matter. You can also close the matter if you find that it doesn’t need any further action.

Before you begin
Ensure that you’ve closed all related matter tasks before closing the legal matter.

⚠️ Note: A legal matter cannot be closed if it has any open ad hoc approval records or for its artifacts.

Role required: sn_lg_matter.matter_fulfiller
Procedure

1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open the legal matter that you want to close.
5. Optional: In the Activity section, enter comments, add links to related knowledge base articles, or attach files.
6. Click Close Complete.
7. In the Close Complete Matter dialog box, enter comments in the Comments field. Comments entered in the Close Complete Matter dialog box will be posted in all open related requests.
8. Close related legal requests in the Assigned or Work in Progress states along with the parent request by selecting the Close related requests check box.
9. Click OK.

Results

- The legal matter is closed and its state updates to Closed Complete.
- If the parent legal request of the matter is not associated with any other open matters, the request is also closed.
- If you chose to also close all related requests, they are also closed if they meet the following conditions:
  - The state is either Assigned or Work in Progress.
  - The requests are not associated with any other open matters.

Reopen a legal matter

If a legal matter requires further investigation after it was closed or canceled, you can reopen it to work on it again.

Before you begin

Role required: sn_lg_matter.matter_fulfiller

Procedure

1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned to Me.
4. Open the legal matter that you want to reopen.
5. Click Reopen.
6. In the Reopen Matter dialog box, enter comments in the Comments field to note why you are reopening the matter. Comments entered in the Reopen Matter dialog box will be posted in all related requests.
7. Reopen related closed or canceled legal requests along with the parent request by selecting the Reopen related requests check box.
8. Click OK.
## Results
- The legal matter is reopened.
- The state of the matter updates to the state it was in before it was closed or canceled.
- If the primary legal request of the matter is closed or canceled, then the request is reopened.
- If you chose to reopen all related requests also, any related legal requests that are in the Closed Complete, Closed Incomplete, or Cancelled state are also reopened.

## What to do next
**Work on the legal matter** to complete it.

## Legal Conflict of Interest
Legal Conflict of Interest enables you to manage the disclosure, approval, and registry of conflict of interest that might arise from employees having competing interests or loyalties.

### Features
- Configurable approval flows in accordance with the organization’s Conflict of Interest (COI) policy.
- Centralized register for all the disclosure of potential conflicts.
- Continuous monitoring of all disclosure requests for their validity.
- Automated reminders to the requesters before the expiry of their conflict approvals.

### Explore
- Legal Service Delivery release notes
- Legal Conflict of Interest
- Conflict of Interest – Approval flow

### Set up
- Install Legal: LPA: Conflict of Interest

### Administer
- Setting up Legal Conflict of Interest
- Configure flows for Legal Conflict of Interest

### Use
- Submit a new conflict of interest disclosure request
- Update an existing conflict of interest disclosure request
- Approve or reject a conflict of interest disclosure request
- Update an existing conflict of interest disclosure record

### Develop
- Developer training
- Developer documentation
- Components installed with Legal Conflict of Interest

### Troubleshoot and get help
- Ask or answer questions in the Legal Service Delivery forum on the Now Community
- Search the HI Knowledge Base for known error articles
- Contact Customer Service and Support

### Legal Conflict of Interest
The Legal Conflict of Interest application enables you to manage the disclosure, approval, and registry of conflict of interest that might arise from employees having competing interests or loyalties.
Here's an example workflow for an employee disclosing outside employment.

Conflict of Interest Disclosure
Request for legal clearance of potential conflicts of interest.

→ $ ←

Submit a request for legal clearance of potential conflicts arising from secondary employment, board service, or personal relationships.

Employee chooses the conflict type
Employee completes and submits the form
The request enters an approval workflow
The request is approved or denied
The decision is emailed to employee
A record is generated automatically
Automated approval flow

The approval flow for approving a conflict of interest disclosure request is automated. When all designated approvers have approved the conflict of interest disclosure request, a corresponding registry for the conflict is created.

A notification is sent to the requesters before the expiry of the validity of their COI disclosure records. If the requesters need an extension, they should review and resubmit a request to get the legal clearance for the extended period.

The approvers and the number of approval levels differ based on the conflict type.

Following illustration shows the approvers and number of approval levels for each conflict type. For example, the Outside Employment conflict type has two approval levels. The first-level approver is the manager of the requester, and the second-level approver is the legal compliance group.

The administrator can modify the approval flow in the following ways:

- Change the number of levels of approval required.
- Add or modify approvers or approver groups at each level of approval.

For more information, see Configure flows for Legal Conflict of Interest.

Install Legal: LPA: Conflict of Interest

You can install the Legal: LPA: Conflict of Interest application (sn_lg_coi) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

- Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- If the application requires plugins or other store applications, install them first if they are not already installed.

Install the following application before you install Legal: LPA: Conflict of Interest:
• Legal: Request Management (sn_lg_ops)

Role required: admin

About this task
The following components are installed with installation of the Legal: LPA: Conflict of Interest application:
• Plugins
• Store applications
• Roles
• Tables
• Business Rules

For more information, see Components installed with Legal Conflict of Interest.

You can also install the following application:

Legal Mobile (sn_lg_mobile)
The ServiceNow® Legal Mobile (sn_lg_mobile) application provides the ability to find legal information, submit and track legal requests, and work on these requests on mobile devices. For more information, see Legal Mobile.

Procedure
1. Navigate to System Applications > All Available Applications > All.

2. Find the Legal: LPA: Conflict of Interest application (sn_lg_coi) using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal: LPA: Conflict of Interest.

4. Optional: If demo data is available and you want to install it, click Load demo data.
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don't load the demo data during installation, it's unavailable to load later.

5. Click Install.

What to do next
Use the Legal Service Delivery Guided Setup to configure the application on your instance.

To access Legal Service Delivery guided setup, navigate to Legal Administration > Legal Guided Setup. For more information about using the guided setup interface, see Using guided setup.
Components installed with Legal Conflict of Interest

Several types of components are installed with installation of the Legal Conflict of Interest, including tables and user roles.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>COI Admin [sn_lg_coi.coi_admin]</td>
<td>Provides the administrative permissions for Conflict of Interest app and full access to the underlying data.</td>
<td>• sn_lg_coi.coi_fulfiller</td>
</tr>
<tr>
<td>COI Fulfiller [sn_lg_coi.coi_fulfiller]</td>
<td>Provides fulfiller access to all conflict of interest disclosure records.</td>
<td>• sn_lg_coi.coi_read</td>
</tr>
<tr>
<td>COI Read [sn_lg_coi.coi_read]</td>
<td>Provides the read-only access to view all conflict of interest records.</td>
<td>• sn_lg_ops.legal_user</td>
</tr>
</tbody>
</table>

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Reminder Email to COI Requestor</td>
<td>The job checks for the active conflict of interest disclosure records that have the end date in the next 30 days. For all such records, it sends reminder notifications to requesters to update any changes in their conflicts records.</td>
</tr>
</tbody>
</table>

Flows installed

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COI Approval flow</td>
<td>This flow controls the multi-level approvals for conflict of interest disclosure requests.</td>
</tr>
<tr>
<td>Scheduled Flow to Deactivate COI</td>
<td>This scheduled flow runs daily to check for the active conflict of interest disclosure records for which the end date has passed the current date. For all such records, it updates the state from Active to Inactive.</td>
</tr>
</tbody>
</table>
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflict of Interest Associated Requests [sn_lg_coi_coi_request]</td>
<td>Stores the mapping of legal requests submitted by the user and the conflict of interest disclosure records.</td>
</tr>
<tr>
<td>Conflict of Interest Disclosure [sn_lg_coi_conflict_of_interest]</td>
<td>Stores conflict of interest disclosure records.</td>
</tr>
</tbody>
</table>

Setting up Legal Conflict of Interest

Configure the foundation data required for managing the conflict of interest requests.

As an administrator, you can review the installed components and modify them or add new ones as applicable.

- Approver group for conflict of interest requests
- Configure flows for Legal Conflict of Interest
- Notifications

Configure flows for Legal Conflict of Interest

Review the flows installed with the Legal Conflict of Interest application and configure them to align with your business needs.

Before you begin

Ensure that the Legal Conflict of Interest application scope is selected.

Role required: sn_lg_coi.coi_admin and admin

About this task

Legal Conflict of Interest uses the following flows:

- COI Approval flow: Triggers multi-level approvals when an employee submits a conflict of interest request
- Scheduled Flow to Deactivate COI: Triggers to validate and deactivate any existing conflict of interest disclosure record that has the end date before the current date. The flow triggers at a scheduled time.

The flows are built using ServiceNow Flow Designer, so make sure you’re familiar with the Flow Designer basics.

Procedure

2. Find the COI Approval flow and click the name of the flow to open.
3. Modify the trigger to set the conditions for the flow to trigger and actions to add or update the approval levels.
   For information on how to create or modify flows, see Create a flow.
4. Click Save.
5. Test the flow by clicking Test.
Submit a new conflict of interest disclosure request

Submit a request to obtain the legal clearance before you involve in any activity that might pose a risk of potential conflict with the primary employer duties.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Service Portal.
2. Click Service Catalog to view all available request categories.
3. Search for the conflict of interest disclosure request item.
4. Click Conflict of Interest Disclosure.
5. In the Conflict type field, select the type of conflict. The following options are available to select:
   - Board Service: A conflict of interest when a board member's interest might compromise the organization's interest or derive a financial or personal gain from a direct or indirect relationship.
   - Outside Employment: A conflict of interest when employees take up a second job that might be in conflict with the primary job duties.
   - Personal Relationship: A conflict of interest when employees having personal relationships also have a professional relationship within the organization. Based on the selection, more fields appear to fill in the required information.
6. On the form, fill in the fields and click Submit.

Results
A conflict of interest disclosure request is created in the New state and is sent for approval. The approval flow for the selected conflict type controls the request to go through the required number of approval levels. Approvers assigned at each approval level can approve the request. Once the approval flow gets triggered, the state of the request updates to Work in Progress.

Update an existing conflict of interest disclosure request

Update an existing conflict of interest disclosure request to obtain the legal clearance again before it expires. You might want to get fresh approvals for an extension of the period or for the revised conditions that might pose a risk of potential conflict with the primary employer duties.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Service Portal.
2. Click Service Catalog to view all available request categories.
3. Search for the conflict of interest disclosure request item.
4. Click Conflict of Interest Disclosure.
If you have any existing conflict of interest records, the form shows the **Do you want to create new / update existing COI ?** field.

5. In the **Do you want to create new / update existing COI ?**, select **Update** to update the details of the request you submitted in the past.
   To submit a fresh request, select **New**. See **Submit a new conflict of interest disclosure request**.

6. In the **Active / Inactive COI Records** field, select a COI record that you want to update.
   More fields appear with the values filled in from the previous request. Update these fields as required.

7. On the form, update the fields and click **Submit**.

   **Note:** You cannot update a few fields on the form and so they show up as disabled.

**Results**
The conflict of interest disclosure request is updated and the state is set as New. The request is sent for approval. The approval flow for the selected conflict type controls the request to go through the required number of approval levels. Approvers assigned at each approval level can approve the request. Once the approval flow gets triggered, the state of the request updates to Work in Progress.

**Approve or reject a conflict of interest disclosure request**
Approve or reject a conflict of interest disclosure request assigned to you or a legal user group of which you’re a member.

**Before you begin**
Role required: sn_lg_ops.coi_fulfiller or sn_lg_ops.request_fulfiller

**About this task**
The multi-level approval flow for a conflict of interest disclosure request is automated through the COI Approval flow. The flow controls the request to advance to the next approval level when approved at one approval level. After the final-level approval, a conflict of interest disclosure record is created. The approval or rejection of the request and the end date specified in the request determines the state of the newly created disclosure record.

For more information on approval flow, see **Conflict of Interest – Approval flow**.

   **Note:** If the approval is assigned to an approval group, any member from the group can approve or reject the request.

**Procedure**
1. Navigate to **Legal Request > Legal Counsel Center**.
2. Click the list icon (≡).
3. In the Lists tab, under **My Work**, click **Items Pending Approval**.
4. In the Items Pending Approval list, open a request by clicking the request number in the **Approval for** column.
5. On the Approvers tab, click **Requested** in the **State** column to open the approval form.
6. Approve or reject the request.
   - To approve the conflict of interest disclosure request, click **Approve**.
   - To reject the conflict of interest disclosure request, click **Reject**.
**Results**
The approval status of the request is updated in the Approvers tab.
The following table shows the results of approve and reject actions on the approval request.

<table>
<thead>
<tr>
<th>Approve</th>
<th>Reject</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The state of the current approval level in the request updates to Approved.</td>
<td>• The state of the current approval level in the request updates to Rejected.</td>
</tr>
<tr>
<td>• If available, the request advances to the next approval level and is assigned to an approver or approver group set in the approval level. The state of the next approval is set as Requested.</td>
<td>• All the subsequent approval levels in the approval flow are skipped.</td>
</tr>
<tr>
<td>• If the current approval is the last in the approval flow, the approval moves to the Approved state. The legal request status changes to Closed.</td>
<td>• The legal request status updates to Closed.</td>
</tr>
<tr>
<td>• For a new request, a corresponding conflict of interest disclosure record is created. For an existing request, the related conflict of interest disclosure record is updated.</td>
<td>• For a new request, a corresponding conflict of interest disclosure record is created in the Rejected state.</td>
</tr>
<tr>
<td>The state of the conflict of interest disclosure record is based on the following conditions:</td>
<td>• For an existing request, the related conflict of interest disclosure record is updated without changing its existing state.</td>
</tr>
<tr>
<td>◦ If the end date of the record is empty or later than the approval date, the state is Active.</td>
<td></td>
</tr>
<tr>
<td>◦ If the end date of the record is prior to the approval date, the state of the record is Inactive.</td>
<td></td>
</tr>
</tbody>
</table>

**Update an existing conflict of interest disclosure record**
You can update an existing conflict of interest disclosure record to change the validity period or the status of the record.

**Before you begin**
Role required: sn_lg_ops.coi_fulfiller

**About this task**
You can only update conflict of interest disclosure records that have the conflict status as Active.

**Procedure**
1. Navigate to Legal Practice Apps > Conflict of Interest > All.
2. Open a conflict of interest disclosure record that you want to review or update.
3. On the form, update the fields as required.
You can update only the following fields that are available based on the conflict type of the disclosure record:

- **Start date**: Available in Board Service and Outside Employment conflict types.
- **End date**: Available in Board Service and Outside Employment conflict types.
- **Conflict status**: Available in all conflict types.

4. Click Update.

**Legal Digital Forensics**

The ServiceNow® Legal Digital Forensics application enables you to handle digital forensics requests for data discovery related to custodial and non-custodial data sources that are subject to investigations or litigation.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>- <a href="#">Legal Service Delivery release notes</a></td>
<td>- <a href="#">Install Legal Digital Forensics</a></td>
<td>- <a href="#">Setting up Legal Digital Forensics</a></td>
</tr>
<tr>
<td>- <a href="#">Legal Digital Forensics</a></td>
<td></td>
<td>- Configure a data source for digital forensics</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Submit a digital forensic request</td>
<td>- <a href="#">Developer training</a></td>
<td>- Ask or answer questions in the Legal Service Delivery forum on the Now Community</td>
</tr>
<tr>
<td>- Update a submitted digital forensic request</td>
<td>- <a href="#">Developer documentation</a></td>
<td>- Search the HI Knowledge Base for known error articles</td>
</tr>
<tr>
<td>- Work on a digital forensic request</td>
<td>- <a href="#">Components installed with Legal Digital Forensics</a></td>
<td>- Contact Customer Service and Support</td>
</tr>
<tr>
<td>- Approve or reject the processing of custodial and non-custodial data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Work on a digital forensic legal matter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Legal Digital Forensics**

Legal Digital Forensics enables different departments in your organization to submit legal requests for discovery and processing of digital data of employees suspected of malicious activity or litigation.

**Features**

- Intake form to gather request background, custodial and non-custodial data sources with keywords and filter dates.
- Flagging of e-discovery data sources with instructions for data processing.
- Integrated privacy approval flow to get the required approvals before starting the investigation.
- Pre-defined standard digital forensic tasks using a template.
- Record and audit trail of all activities done in support of the investigation and litigation.
You can submit a digital forensics request for the following actions for custodial and non-custodial data on the specified data sources:

- Preserve: Option for preserving relevant digital information of custodial and non-custodial data and documenting the facts.

- Collect: Option for collecting digital information of custodial and non-custodial data that may be relevant to the investigation. Collection might involve activities such as imaging storage devices, or copying or printing of the digital information.

- Review: Option for an in-depth, systematic search of facts in the collected information related to the investigation.

- Present: Option for presenting the relevant information of custodial and non-custodial data in an appropriate format to stakeholders.

After the required privacy approvals for investigation, the digital forensics team member working on the digital forensic request can promote it to a legal matter. The legal matter for the digital forensics request can have phases based on the requested actions. Each phase can have tasks for each custodial or non-custodial data for a keyword, data source, and date range.
Legal Digital Forensics workflow

Workflow:
Digital Forensics Request

Here's an example workflow to request data discovery related for custodial and non-custodial data sources that are subject to investigation or litigation.

Set up the following items in the application:
1) List of data sources for e-discovery
2) Privacy approval workflows
3) Digital Forensics matter template

After setup, here's what the workflow looks like:

- Authorized employee submits a data discovery request for custodial and non-custodial data
- Fulfiller reviews request and gets approvals for data processing
- Fulfiller promotes approved data sources as matter using the predefined matter template
- Legal matter is created with phases and tasks needed to fulfill the request
- Fulfiller assigns the task to teams to process and handle the data
- After all tasks are complete, fulfiller closes the matter
- The legal request is automatically closed
Install Legal Digital Forensics

You can install the Legal Digital Forensics application (sn_lg_forensics) if you have the admin role. The application installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

• Legal Digital Forensics requires the following ServiceNow Store applications. Ensure that these applications are installed before you install Legal Digital Forensics.

  Required ServiceNow Store applications

  Legal: Request Management (sn_lg_ops)
  
  Legal Request Management provides a single, unified mechanism for employees to get all the information, services, and help that they need from the legal department. For more information, see Install Legal Request Management.

  Legal: Matter Management (sn_lg_matter)
  
  Legal Matter Management enables you to complete legal requests that need cross-departmental tasking and workflow with a mechanism to store documents and track important milestones. For more information, see Install Legal: Matter Management.

Role required: admin

About this task

The following items are installed with Legal Digital Forensics:

• Roles
• Tables

For more information, see Components installed with Legal Digital Forensics.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Legal Digital Forensics application (sn_lg_forensics) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal Digital Forensics.

4. Click Install.
Components installed with Legal Digital Forensics

Several types of components are installed with activation of the Legal Digital Forensics application, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

## Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Forensics Administrator [sn_lg_forensics.forensics_admin] | Application-specific administrator role for the Legal Digital Forensics app having the administrative access for the app and full access to the underlying data. | • sn_lg_forensics.forensics_config  
• sn_lg_forensics.forensics_fulfiller |
| Forensics Configurator [sn_lg_forensics.forensics_config] | Provides access to configure data for the Legal Digital Forensics app such as search sources. | • None |
| Forensics Fulfiller [sn_lg_forensics.forensics_fulfiller] | Provides the fulfiller access for working on assigned digital forensic requests and matters. | • None |

## Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custodial Core [sn_lg_forensics_custodian]</td>
<td>Users from the Legal Profile table that are added in a digital forensics request.</td>
</tr>
<tr>
<td>Custodial Data [sn_lg_forensics_custodial_data]</td>
<td>Extends the Custodial Core table and has additional fields to store information of users added in a digital forensics request.</td>
</tr>
<tr>
<td>Data Source [sn_lg_forensics_search_source]</td>
<td>Search sources, checklist items, and instructions for the task owners for the resolution of legal requests. You can configure search sources such as Slack, Box, OneDrive, or Microsoft Outlook.</td>
</tr>
<tr>
<td>Data Source Details [sn_lg_forensics_search_source_detail]</td>
<td>Details recorded for a search source for custodians by the task owner while working on a digital forensics matter task.</td>
</tr>
<tr>
<td>Fulfillment Steps [sn_lg_forensics_fulfillment_steps]</td>
<td>Steps required for a task owner to fulfill an assigned digital forensics request.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Non Custodial Core</td>
<td>Extends the Custodial Core table and has additional fields to store information of non-custodial records added in a digital forensics request.</td>
</tr>
</tbody>
</table>

Setting up Legal Digital Forensics

Configure the foundation data required for managing the digital forensics requests.

As an administrator, you can review the installed components and modify them or add new ones as applicable.

- Configure a data source for digital forensics
- Add fulfillment instructions and checklist for a data source

Configure a data source for digital forensics

Configure a data source a requester can select in a digital forensics request as the source of potentially evidential data.

Before you begin

Role required: sn_lg_forensics.forensics_config or admin

Procedure

1. Navigate to Legal Administration > Digital Forensics Admin > Data Sources.
2. Create or modify a data source.
   - To create a data source, click New.
   - To modify an existing data source, open the data source from the list.
3. On the form, fill in the fields.

Data Source form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Name of the data source.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the data source active. Only active data sources are available on the digital forensics request intake form in the Legal Service Portal.</td>
</tr>
</tbody>
</table>

Source detail fields

Fields that are applicable for the data source.

The selected fields appear on the data source details form in a digital forensics request matter. Task owners provide details in these fields based on the fulfillment activities done by them. For more information, see Create a task for a digital forensic legal matter.

The field options in the list are populated from the Data Source Detail.
4. Save the data source.
   - Save a new data source by clicking Submit.
   - Save the changes to an existing data source by clicking Update.

What to do next
Add fulfillment instructions and checklist for a data source. When a matter owner creates a task for the source in a legal matter, these instructions are pre-populated in the task. The users to whom the legal matter task is assigned can follow these instructions to resolve the task.

Add fulfillment instructions and checklist for a data source
Add instructions for a data source that a task owner in a legal matter can follow to resolve the task.

Before you begin
Role required: sn_lg_forensics.forensics_config or admin

Procedure
1. Navigate to Legal Administration > Digital Forensics Admin > Data Sources.
2. Open a data source to which you want to add instructions.
3. In the Fulfillment Steps related list, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase</td>
<td>Name of the phase in which the task is created in a legal matter for a digital forensics request.</td>
</tr>
<tr>
<td>Search source</td>
<td>Name of the data source for which you are adding the instructions.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Instructions for the assigned user to perform to resolve the legal matter task.</td>
</tr>
</tbody>
</table>

5. Click Submit. A fulfillment step record is created. The Checklist section appears.

6. Optional: Add to-do items in the Checklist section to provide a list of activities for the task fulfills.
   a. Click the more actions icon (⋮) next to the Checklist.
   b. Click Create new.
   c. Enter a description for the to-do item and press the Enter key.
      This checklist appears as the default to-do items in the corresponding legal matter task.

7. Click Update.
Submit a digital forensic request

Submit a legal request to access data of current or former employees for internal investigation or litigation reasons.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Service Portal.
2. Click Service Catalog to view all available request categories.
3. Search for the digital forensic request item.
4. Click Digital Forensic Request.
5. On the form, fill in the fields.

Digital Forensic Request intake form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matter</td>
<td>Option to associate the legal request with an existing legal matter or to a new legal matter.</td>
</tr>
<tr>
<td></td>
<td>• To create a new legal matter and associate the legal request with it, select <strong>New</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To associate the legal request with an existing legal matter, select that legal matter from the list.</td>
</tr>
<tr>
<td></td>
<td>Only current legal matters that you have permission to access appear in the list.</td>
</tr>
<tr>
<td>New matter</td>
<td>Name of the new legal matter.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when <strong>New</strong> is selected from <strong>Matter</strong>.</td>
</tr>
<tr>
<td>Activity request</td>
<td>Short description of the request.</td>
</tr>
<tr>
<td>Detailed description</td>
<td>Detail information of the request, for example, details of the suspicious activities by the custodians or details of the litigation.</td>
</tr>
<tr>
<td>Custodial data</td>
<td>Employees on whose data you are requesting the investigation. Also provide other investigation details for a custodian—search keywords, data sources, and search period.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Add a custodian to a digital forensic request.</td>
</tr>
<tr>
<td>Non-custodial data</td>
<td>Resources and assets, such as server, laptop, mobile, or cloud storage, on which you are requesting the investigation. Also provide other investigation details for a non-custodian—search keywords, data sources, and search period.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Add a non-custodial data to a digital forensic request.</td>
</tr>
<tr>
<td>Bulk upload</td>
<td>Export multiple custodian and non-custodial data from a file.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>For more information on uploading the data from a file, see Add custodial and non-custodial data from a file.</td>
<td></td>
</tr>
<tr>
<td>Activities requested</td>
<td>Type of actions required on the data for the investigation.</td>
</tr>
<tr>
<td></td>
<td>- Preserve: Secure the original data from the source devices in compliance with departmental guidelines to protect and preserve the evidence.</td>
</tr>
<tr>
<td></td>
<td>- Collect: Acquire the digital evidence that may be relevant to the investigation. Collection might involve activities such as imaging storage devices, or copying or printing of the digital information.</td>
</tr>
<tr>
<td></td>
<td>- Review: Conduct an in-depth, systematic examination of the facts in the collected digital evidence related to the investigation.</td>
</tr>
<tr>
<td></td>
<td>- Present: Document and present the relevant information and findings of the examination in an appropriate format to stakeholders.</td>
</tr>
<tr>
<td>Third party reference ID</td>
<td>Reference to a legal matter ID stored in your other matter management system.</td>
</tr>
<tr>
<td>Third party reference system</td>
<td>Reference to your other matter management system.</td>
</tr>
<tr>
<td>Preferred completion date and time</td>
<td>Date by which the investigation must be complete. The date and time is based on the time zone you are in while requesting.</td>
</tr>
</tbody>
</table>

6. Click Submit.

Results
- A digital forensic request is created in the New state.
- The Standard Ticket page displays that has the following tabs to perform different tasks:
  - Activity: Track the activity history of the request and post messages for the fulfiller working on the request.
  - Attachments: Upload and manage documents.
  - Custodial data: View existing custodial details. You can also export the data to a file.
  - Non-custodial data: View existing non-custodial details. You can also export the data to a file.
  - Request Details: Review request details.
- If you uploaded custodial and non-custodial data from an Excel or CSV file, the file is attached as a reference document to the request.

The number of records successfully uploaded from the file into the request is posted as additional comments in the Activity tab on the Standard Ticket page.

If a record from the file isn’t added to the request, an error log file is added in the Activity tab. You can review the reason for failure in the error log file, fix the errors in your file, and upload it again by editing the request.

- For each custodian added in the request a record is created in the Custodial Data [sn_lg_forensics_custodial_data] table. If a legal profile record for each custodian is not
already present in the Legal Profile [sn_lg_ops_legal_profile] table, a corresponding record is created.

• For each non-custodial data added in the request a record is created in the Non Custodial Data [sn_lg_forensics_non_custodial_data] table.

**What to do next**

On the Standard Ticket page, you can update request details, add comments, manage custodial and non-custodial data, upload supporting documents, or cancel the request. For more information, see Update a submitted digital forensic request.

Any member from the digital forensic team can triage and assign the request to themselves or to any other member in the group. Once the request is assigned, an approval flow is triggered. The flow creates an approval record for each custodial and non-custodial added in the digital forensic request. These approval records are assigned to the privacy team in the legal department. Any member from the legal privacy team can approve the request. After the approval, a digital forensic team member to whom the legal request is assigned can start working on the request. For more information, see Work on a digital forensic request.

**Add a custodian to a digital forensic request**

Add a custodian and related data source details in your digital forensic request.

**Before you begin**

Role required: sn_lg_ops.legal_user

**Procedure**

1. On the Digital Forensic Request intake form, in the Custodial data section, click **Add**.
2. On the Add Row dialog box, fill in the fields.

### Add a custodian in a digital forensic request

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custodian name</td>
<td>Name of the custodian on whose digital assets you are requesting a digital forensic investigation.</td>
</tr>
<tr>
<td>Data source</td>
<td>Source (hardware or software) from which the data for investigation is to be collected.</td>
</tr>
<tr>
<td>Other data sources</td>
<td>Source (hardware or software), not listed in the Data source field, from which the data for investigation is to be collected. This field appears only when Other is selected from Data source.</td>
</tr>
<tr>
<td>Keywords</td>
<td>Terms to look for within the data collected from the custodian data sources. You can provide multiple search terms each separated by a comma.</td>
</tr>
<tr>
<td>Filter start date</td>
<td>Start date of the digital forensics investigation period. The digital forensic team member would check for the search terms in the data from this date onwards.</td>
</tr>
<tr>
<td>Filter end date</td>
<td>End date of the digital forensics investigation period. The digital forensic</td>
</tr>
</tbody>
</table>
Add a non-custodial data to a digital forensic request

Add a non-custodial data and related search source details in your digital forensic request.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
2. On the Add Row dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-custodial details</td>
<td>Details of the non-custodial data on which you are requesting a digital forensic investigation. For example, you can enter details such as model number, serial number, or product name of the non-custodial data.</td>
</tr>
<tr>
<td>Data source</td>
<td>Source from which the data for investigation is to be collected.</td>
</tr>
<tr>
<td>Other data sources</td>
<td>Source (hardware or software), not listed in the Data source field, from which the data for investigation is to be collected. This field appears only when Other is selected from Data source.</td>
</tr>
<tr>
<td>Search location/File path</td>
<td>Location of the folder or file from where the data for investigation is to be collected. For example, a URL on a cloud storage or a folder or file in a system.</td>
</tr>
<tr>
<td>Keywords</td>
<td>Terms to look for within the data collected from the data sources. You can provide multiple search terms each separated by a comma.</td>
</tr>
<tr>
<td>Filter start date</td>
<td>Start date of the digital forensics investigation period. The digital forensic team member would check for the search terms in the data from this date onwards.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter end date</td>
<td>End date of the digital forensics investigation period. The digital forensic team member would check for the search terms in the data until this date.</td>
</tr>
<tr>
<td>Additional information</td>
<td>Additional details about the non-custodial data that would be helpful in resolving the request.</td>
</tr>
</tbody>
</table>

3. Click **Add**.

   The non-custodial record appears in the Non-custodial data list on the Digital Forensic Request intake form.

**Add custodial and non-custodial data from a file**

Upload a Microsoft Excel or CSV file containing custodial and non-custodial data to quickly add multiple records in a digital forensic request in one go.

**Before you begin**

Role required: sn_lg_ops.legal_user

**About this task**

Use a file with a predefined format available on the digital forensics request page to upload custodial and non-custodial data.

**Procedure**

1. Download the template file with the predefined columns and add custodial and non-custodial details.

   a. Click the **Download an upload template here** link to download the Excel file template. The template file contains sample records for custodial and non-custodial data. During import, the columns marked as Not applicable in the file are ignored.

   b. Review the sample data in the downloaded Excel file and add custodial and non-custodial details in the same format, and then save.

2. On the Digital Forensic Request intake form, in the Bulk Upload section, click **Upload**.

3. Browse and select the Excel file containing the custodial and non-custodial data. The file is attached to the request. The data from the file is uploaded into the request when you submit the request.

**Update a submitted digital forensic request**

Update the request details, add comments, manage custodial and non-custodial data, or upload documents in a digital forensic request you submitted while it is still in the New state. You can cancel a submitted request irrespective of its state.

**Before you begin**

Role required: sn_lg_ops.legal_user

**Procedure**

1. Navigate to **Legal Request > Legal Service Portal**.

2. Open your submitted digital forensic request from the **My Requests** option on the header menu.
3. On the Standard Ticket page, review and edit the request details or cancel the request.

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit request details</td>
<td><strong>Note:</strong> This option is available if the request is in the New state.</td>
</tr>
<tr>
<td></td>
<td>a. From the Actions menu, select <strong>Edit Request</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the Variables form, complete any of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• To modify the request details, update fields as needed.</td>
</tr>
<tr>
<td></td>
<td>• To add custodial data, click <strong>Add</strong>. For more information, see <strong>Add a custodian to a digital forensic request</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To remove all custodial data, click <strong>Remove All</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To add non-custodial data, click <strong>Add</strong>. For more information, see <strong>Add custodial and non-custodial data from a file</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To remove all non-custodial data, click <strong>Remove All</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Save</strong>.</td>
</tr>
<tr>
<td></td>
<td>d. Click <strong>Back</strong> to return to the Standard Ticket page. The digital forensic request is updated with the new information. The changes appear as comments in the Additional Comments section of the request.</td>
</tr>
<tr>
<td>Cancel the request</td>
<td>a. From the Actions menu, select <strong>Cancel Request</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the Confirm request cancellation dialog box, provide the reason of cancellation in the <strong>Comments</strong> field and click <strong>Confirm Cancellation</strong>. The request is canceled and the cancellation comments appear in the Additional Comments section of the request.</td>
</tr>
</tbody>
</table>

4. Optional: In the **Activity** tab, provide comments supporting your request.

5. Optional: In the **Attachments** tab, manage the attachments supporting your request.
   • To upload a new document, click the add attachment icon (●) and select a file.
   • To rename the attached file, click the edit file name icon (●) and update the file name.
   • To remove the attached file, click the delete icon (●).

6. Optional: In the **Custodial Data** tab, view the existing custodians added to the request or export to a file by clicking the more options icon (●).

7. Optional: In the **Non-Custodial Data** tab, view the existing non-custodial data added to the request or export to a file by clicking the more options icon (●).

**Work on a digital forensic request**

As a member of the digital forensic team, you work on a legal request to investigate and resolve the request.
Before you begin
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon ( ).
3. In the Lists tab, under Legal Requests, click All.
4. Open a digital forensic request to work on.
   • If the legal request is unassigned, click Assign to me to assign it to yourself. To assign to another member, select the member's name in the Assigned to field and click Save.

   The state of the legal request updates to Assigned. If the Digital Forensics - Privacy Approval flow is active, an approval flow is triggered. For each custodial and non-custodial data in the digital forensic request, one corresponding approval record is created and is assigned to each member in the legal privacy group. Any member from the legal privacy group can review and approve or reject these approval records.

   The status of custodial and non-custodial data updates to Pending Approval. You can review the status of the approval records in the Approvers tab.

   • In the Custodial Data and Non-custodial Data, you can add new custodial and non-custodial data by clicking New and filling the details. The approval flow is triggered for the newly added custodial and non-custodial records that creates approval records and assigns them to each member in the legal privacy group.

   • After approval, promote the approved custodial data in the Custodial Data tab and the approved non-custodial data in the Non-custodial Data tab to a new or existing legal matter.

      ◦ To promote them to a new legal matter, select them and click Create Matter. You can choose to create the matter using a digital forensic matter template to populate the matter with predefined phases and tasks.

      ◦ To promote them to an existing legal matter, select them and click Add to an Existing Matter. In the Add to Existing Matter dialog box, select a matter from the list, and click OK.

   For more information, see Promote a legal request to a legal matter.

   Note: You can promote the legal request to a legal matter only if you have installed Legal Matter Management and set the record producer type in the associated intake form as Request and Matter.

The legal matter to which the custodial and non-custodial data records are promoted appears in the Legal Matters tab.

• Associate other related legal matters to the legal request. In the Legal Matters tab, click Add and select the legal matter to associate.

• Remove a legal matter from the legal request if the legal matter is not required to be tracked for the request. In the Legal Matters tab, select the legal matter to remove, and click Remove. If the removed matter is a digital forensic legal matter, all custodial and non-custodial records from the legal matter are also removed. The legal matter owner should cancel the associated phases and tasks from the matter manually.

• Close the legal request after you complete the required activities to resolve the matter.

   Note: A legal request is automatically closed when it is associated to a legal matter and the matter owner chooses to close the related requests while closing the matter.
Approve or reject the processing of custodial and non-custodial data

Review and approve or reject the processing of a custodial or non-custodial record of a digital forensic request.

Before you begin
Role required: sn_lg_ops.request_fulfiller

About this task
The approval flow for permitting a digital forensic team member to access the custodial or non-custodial data for a digital forensic request is automated through the Digital Forensics - Privacy Approval flow. The flow must be in the Published state. The flow is triggered when a digital forensic request is assigned to a digital forensic team member. For each custodial and non-custodial record in the digital forensic request, one corresponding approval record is created and is assigned to each member in the legal privacy group. Any member from the group can review and approve or reject the custodian approval.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon ( ).
3. In the Lists tab, under My Work, click Items Pending Approval.
4. In the Items Pending Approval list, open a request by clicking Requested in the State column.
5. Review the details of custodial and non-custodial data, and approve or reject the request.
   • To approve, click Approve.
   • To reject, click Reject.

Results
The following table shows the results of approve and reject actions on the approval request.

<table>
<thead>
<tr>
<th>Result of approving or rejecting a custodial or non-custodial data</th>
<th>Approve</th>
<th>Reject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>The state of the approval record updates from Requested to Approved.</td>
<td>The state of the approval record updates from Requested to Rejected.</td>
</tr>
<tr>
<td></td>
<td>The status of the custodial record and non-custodial record in the legal request updates from Pending Approval to Approved.</td>
<td>The status of the custodial record and non-custodial record in the legal request updates from Pending Approval to Rejected. A rejected custodian record cannot be moved to a legal matter.</td>
</tr>
<tr>
<td></td>
<td>The state of the legal request updates from Assigned to Work in Progress.</td>
<td>The state of the legal request remains Assigned.</td>
</tr>
</tbody>
</table>

Work on a digital forensic legal matter
Work on a digital forensic legal matter assigned to you to get the requested actions for the custodial and non-custodial data done to resolve the request.

Before you begin
The practice area lead or the group manager would have assigned the legal matter to you to work on.
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (Ξ).
3. In the Lists tab, under Legal Matters, click All.
4. Open a legal matter to work on.
5. Click Start Work to start working on the legal matter.
   The state of the legal matter updates to Work in Progress.
6. Optional: Add other approved custodians from the associated legal requests.
   a. In the Custodial Data tab, click Add.
   b. In the Add Custodial Data dialog box, select the custodian records you want to add to the matter.
   All approved custodians in the associated requests but not already added to the legal matter are listed.
   c. Click Add.
7. Optional: Add new non-custodial data to the matter.
   a. In the Non-custodial Data tab, click Add.
   b. In the Add Non-Custodial Data dialog box, select the non-custodial records you want to add to the matter.
   All approved non-custodial records in the associated requests but not already added to the legal matter are listed.
   c. Click Add.
   d. Click Save.
8. Optional: If any existing custodial or non-custodial data doesn't need further investigation or was added to the matter by mistake, remove them from the matter by selecting the record in the Custodial Data tab or Non-custodial Data tab and clicking Remove.
9. Review phases and tasks in the respective tabs and, if needed, create more phases and create digital forensic matter tasks to organize the data processing of custodial and non-custodial data.
   i. Note: The phases and tasks are available in the legal matter only if you created the matter using the digital forensic matter template.
10. Assign tasks to users across various departments in your organization to work on.
    a. In the Tasks tab, open the task by clicking the task number.
    b. On the form, fill in the required fields, and click Save.
11. Review legal matter tasks to determine if all its required actions are complete and approve or reject the tasks.
12. Update the status of the associated custodial and non-custodial records to complete.
a. In the Custodial Data tab, open the custodian record, update its Status to Complete, and click Save.

b. In the Non-custodial Data tab, open the non-custodial record, update its Status to Complete, and click Save.

13. Optional: Add milestones to keep a track of timelines to complete important tasks.

14. Create artifacts (folders) and upload files into these artifacts to record and store supporting documents within the legal matter.

15. Optional: Associate a new legal request with the legal matter to combine multiple legal requests with the same underlying needs into a single matter. All custodial and non-custodial data from the selected request are added to the matter and appear in the respective tabs.

16. Optional: Associate the matter with another legal request that is similar in nature.

17. Close or cancel the request as appropriate.
   - Close the legal matter after you complete the required actions for all custodial and non-custodial data in the matter. Ensure you have completed the following items before closing the legal matter.
     - Closed all tasks that are complete or have canceled the ones which don’t need any actions.
     - Updated the status of all custodial and non-custodial data in the matter to either Complete or Cancelled, as appropriate.
   - If the matter doesn’t need any action, you can cancel it by clicking the more button (…) and selecting Cancel.
     You can cancel the requests associated with the matter by selecting the Cancel related requests check box in the Cancel Matter dialog box. These requests are canceled only if they are not related to any other open matters.
     - If a related request gets canceled, the status of all its open custodial and non-custodial data (status other than Complete) updates to Cancelled.
     - If a related request cannot be canceled, all its open custodial and non-custodial data is removed from the matter. The status of such records updates to Approved.

When you cancel the matter without opting to cancel related requests, all custodial and non-custodial data, except with the Complete status, are removed from the matter. The status of such records updates to Approved.

Create a task for a digital forensic legal matter

Create a task for a digital forensic legal matter and add instructions and to-do items in a checklist for the task owner to work on.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Legal Matters, click Assigned.
4. Open a legal matter to which you want to add a matter task.
5. In the Tasks tab, click New to add a task.
The matter task is created. Artifacts, Approvers, and Data Source Details tabs appear.


   a. In the Data Source Details tab, click **New**.

   b. On the form, fill in the fields.

   **Data Source Details form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search source</td>
<td>Source in which the digital evidence is to be investigated. One or more fields appear on the form based on the data source configuration. For more information, see <a href="#">Configure a data source for digital forensics</a>.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of data—custodial or non-custodial—to investigate.</td>
</tr>
<tr>
<td>Custodial data</td>
<td>User whose data need investigation. The list displays custodians added in the legal matter. This field appears only when <strong>Custodial Data</strong> is selected from <strong>Type</strong>.</td>
</tr>
<tr>
<td>Non-custodial data</td>
<td>Details of the non-custodial data to investigate. The list displays non-custodial data added in the legal matter. This field appears only when <strong>Non Custodial Data</strong> is selected from <strong>Type</strong>.</td>
</tr>
<tr>
<td>Hold notice issued</td>
<td>Option for indicating that the custodian has been notified of the legal hold on the data or device.</td>
</tr>
</tbody>
</table>

   c. Click **Save**.

   A data source detail record for a selected custodial or non-custodial data is added in the matter task. It appears in the Data Source Details tab on both the Task form and Matter form.

   If there are fulfillment steps associated with the selected data source, they are added in the Task form as well.

7. Go back to the Task form and in the contextual side bar, add instructions and to-do items for the task.

   • In the Instructions section, click **Add** to add instructions for the assigned user to do for completing the task.

   • In the Checklist section, click **Create** to add to-do items to track the progress of activities in the matter task.
8. Optional: Add an artifact (folder) in which you or the assigned person can upload files related to the task or its investigation.

9. In the Details tab of the Task form, select a user in the Assigned to field to assign the task to work on.

What to do next
The assigned user can work on the matter task by following the instructions and completing the checklist items.

Work on a task for a digital forensic legal matter
Follow the instructions and complete the to-do items in the checklist of a legal matter task assigned to you.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under My Work, click Tasks to do.
4. In the Tasks To Do list, open a task you want to work on and mark as complete.
5. Follow the instructions listed in the Instructions section on the form and complete the to-do items in the Checklist section.
6. Update the data source details with required information.
   a. In the Data Source Details tab, click the value in the Hold notice issued column to open the data source details record.
   b. On the Data Source Details form, fill in the required fields.
      ❗️ Note: The Data Source Details form has a different set of fields as configured in the data source. For more information, see Configure a data source for digital forensics.
   c. If you have notified the custodians of their data or device being on legal hold, select Hold notice issued.
   d. Upload relevant documents from the Attachments section.
   e. Click Save.
7. Optional: In the Activity section of the task, enter comments or add attachments.
8. Click Mark as Complete.

Results
The matter task is completed and sent to the matter owner for approval.
Legal Simple Contracts

The ServiceNow® Legal Simple Contracts application enables employees to submit legal requests for creating contracts with third parties such as vendors, customers, and partners. The legal department can manage and process them from a centralized location.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Legal Service Delivery release notes</td>
<td>• Install Legal Simple Contracts</td>
<td>• Define a user as an internal signer</td>
</tr>
<tr>
<td>• Legal Simple Contracts</td>
<td></td>
<td>• Create a legal contract template</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Configure a rule for selecting a legal contract template</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Setting up an external app configuration for legal contracts</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Submit a legal request for a non-disclosure agreement</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the Legal Service Delivery forum on the Now Community</td>
</tr>
<tr>
<td>• Work on a legal contract request</td>
<td>• Developer documentation</td>
<td>• Search the HI Knowledge Base for known error articles</td>
</tr>
<tr>
<td>• Preview and download a signed contract document</td>
<td>• Components installed with Legal Simple Contracts</td>
<td>• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>

Legal Simple Contracts

Legal Simple Contracts enables employees to submit legal requests for creating contracts with third parties such as vendors, customers, and partners. The legal department can manage and process the submitted contracts from a centralized location.

Features

• Document templates for standard contract documents such as Non-disclosure Agreements (NDA).
• Version history and change request of contract documents.
• Integration with external apps for electronic signature of contract documents such as DocuSign and Adobe Sign, and for saving the signed contract documents in an external storage such as Box.
• Electronic signature of contract documents by external and internal signers.
• Centralized repository of all signed and signed contract documents.
Legal Simple Contracts - Non-disclosure Agreement workflow

Workflow:
Non-disclosure Agreement

Legal > Legal Operations Catalog > Legal Requests > Contract Requests > Non-disclosure Agreement

Here’s an example workflow for self-served non-disclosure agreement creation, execution, and storage using standard NDA templates and e-signature integration.

Set up the following items in the application:

1) Multiple variations of NDA templates
2) Template selection rule to choose the right template based on the legal request
3) Internal signatories for different templates
4) E-signature integration - Adobe Sign or DocuSign
5) (Optional) Integration with Box as external storage to store signed contracts

After setup, here’s what the workflow looks like:

Employee fills out the NDA intake form

Employee previews the generated contract with metadata and sends it to signatories

All signatories complete the e-signatures

Signed contract comes back into the legal request

Contract repository record is created with the metadata and signed contract

(Optional) Signed contract is moved to Box and referenced in the contract repository record
Install Legal Simple Contracts

You can install the Legal Simple Contracts application (sn_lg_contracts) if you have the admin role. The application installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- Legal Simple Contracts requires the following ServiceNow Store applications. Ensure that these applications are installed before you install Legal Simple Contracts.

  Required ServiceNow plugins

  Document Templates (com.snc.document_templates)
  The ServiceNow® Document Templates enables you to create document templates to generate standard contract documents.

  Required ServiceNow Store applications

  Legal Request Management (sn_lg_ops)
  Legal Request Management provides a single, unified mechanism for employees to get all the information, services, and help that they need from the legal department. For more information, see Install Legal Request Management.

Role required: admin

About this task
The following items are installed with Legal Simple Contracts:

- Roles
- Tables

For more information, see Components installed with Legal Simple Contracts.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the Legal Simple Contracts application (sn_lg_contracts) using the filter criteria and search bar.
   - You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   - Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.
   - Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal Simple Contracts.
4. Optional: If demo data is available and you want to install it, click Load demo data.
   - (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.
Important: If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

Components installed with Legal Simple Contracts

Several types of components are installed with activation of the Legal Simple Contracts application, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contracts Administrator [sn_lg_contracts.contracts_admin]</td>
<td>Application-specific administrator role for the Legal Simple Contracts app having the administrative access for the app and full access to the underlying data.</td>
<td>• sn_lg_contracts.contracts_config&lt;br&gt;• sn_lg_contracts.contracts_fulfiller</td>
</tr>
<tr>
<td>Contracts Configurator [sn_lg_contracts.contracts_config]</td>
<td>Provides access to configure data such as document templates, internal signatories, template rules. It does not provide access to transactional data of requests and matters. It does not provide access to transactional data of legal</td>
<td>• connection_admin&lt;br&gt;• sn_docusign_spoke.docusign_user&lt;br&gt;• sn_adobesign_spoke.Adobe_Sign_User&lt;br&gt;• sn_lg_ops.legal_user</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Contracts Fulfiller</td>
<td>Provides the fulfiller access for working on assigned contract requests.</td>
<td>• sn_lg_ops.legal_user</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Draft [sn_lg_contracts_contract_draft]</td>
<td>Stores the first draft and other revisions of a contract document for a legal request.</td>
</tr>
<tr>
<td>Contract Repository [sn_lg_contracts_repository]</td>
<td>Stores all signed contract documents.</td>
</tr>
<tr>
<td>Contract Template Rule [sn_lg_contracts_template_rule]</td>
<td>Stores rules to identify a template contract document based on the input data in a request.</td>
</tr>
<tr>
<td>Signer [sn_lg_contracts_signer]</td>
<td>Stores information of internal and external signatories.</td>
</tr>
<tr>
<td>Signer Config [sn_lg_contracts_signer_config]</td>
<td>Stores the mapping between an internal signatory and the participant field of a document template.</td>
</tr>
<tr>
<td>Signer Task [sn_lg_contracts_signer_task]</td>
<td>Stores all signatory information, including the order of signatories to sign the contract document and current signature status a request.</td>
</tr>
</tbody>
</table>

### Setting up Legal Simple Contracts

Configure the foundation data to provide legal request services to employees who can use these services to submit requests for getting the standard contract documents to the legal department.

As an administrator, review the installed components and modify them or add new ones as applicable.

**Define a user as an internal signer**

Define a user as an internal signer so that the signer can be added to a contract template to automatically populate in a contract document for a request.

**Create a legal contract template**
Create a document template that can be used when submitting a legal contract request to generate a standard legal contract with predefined content. You can create templates of HTML and PDF types.

**Configure a rule for selecting a legal contract template**

Configure a rule to identify and use the correct contract template based on the submitted legal request and generate a contract document for the requester.

**Set up external signature and storage configurations**

Set up external app configurations for legal contracts to enable services for electronic signature of contract documents and saving the signed contract documents in an external storage.

**Email notifications**

Configure email notifications to be sent when various events occur. Some possible event triggers might be when a signatory signs or declines to sign a contract document or all signatories have signed the contract document.

**Define a user as an internal signer**

Define a user as an internal signer so that the signer can be added to a contract template to automatically populate in a contract document.

**Before you begin**

Role required: sn/lg_ops.legal_config

**Procedure**

1. Navigate to Legal Administration > Simple Contracts > Internal Signatories.
2. Define or modify an internal signer.
   - To define a new internal signer, click New.
   - To modify an existing internal signer, open the internal signer from the list.
3. On the form, fill in the fields.

**Internal Signatories form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal signer</td>
<td>User designated as an internal signer. The list shows users from the Users [sys_user] table.</td>
</tr>
<tr>
<td>Authorized signatory name</td>
<td>Legal name of the selected user.</td>
</tr>
<tr>
<td>Signatory title</td>
<td>Official title of the selected user.</td>
</tr>
<tr>
<td>Signatory email</td>
<td>Email id of the selected user.</td>
</tr>
</tbody>
</table>

4. Save the internal signer.
   - Save an internal signer by clicking Submit.
   - Save the changes to an existing internal signer by clicking Update.

**Create a legal contract template**

Create a document template that can be used to generate a standard legal contract with predefined content when an employee submits a contract request.
Before you begin
Ensure that you have the Legal Request Management application scope selected.
Role required: admin

About this task
Legal contract templates help you to create and organize standard contract templates along with fillable metadata placeholders. You can create templates of HTML and PDF types.

- In an HTML document template type, you can map the intake form variables to the fillable metadata placeholders.
- In a PDF document template type, you can upload a fillable PDF file and map fields in the PDF file with fields in a table.

Procedure
1. Navigate to Legal Administration > Simple Contracts > Contract Templates.
2. Create or modify a contract template.
   - To create a contract template, click New and then select a document template type:
     - HTML Document Template
     - PDF Document Template
   - To modify an existing contract template, open the contract template from the list.

Create a legal contract template of type HTML
Create a document template of type HTML.

Before you begin
Role required: admin

Procedure
1. On the form, fill in the fields.

**HTML Template form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the template.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Name of the table that contains the fields to include in the document template. Select General Contract Support [sn_lg_ops_general_contract_support].</td>
</tr>
<tr>
<td>Category</td>
<td>Document category in which the template is added.</td>
</tr>
<tr>
<td>User criteria</td>
<td>User criteria to control which users can use the document.</td>
</tr>
<tr>
<td>Body</td>
<td>Content to include in the generated legal contract document. Insert fields from the selected table.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>a.</strong> Point the cursor to the desired location in the text editor</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Click the plus icon (➕) beside <strong>Fields</strong> in the Select variables pane.</td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> From the fields list, select a field. The selected field is added at the cursor position.</td>
</tr>
<tr>
<td></td>
<td>To insert a date variable at the cursor location in the text editor, click <strong>Insert Date</strong>. You can insert multiple date variables for different date types such as start date, end date, or current date.</td>
</tr>
</tbody>
</table>

#### Header tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Image</td>
<td>Image file to use in the document header.</td>
</tr>
<tr>
<td>Header image height</td>
<td>Maximum height of the header image.</td>
</tr>
<tr>
<td>Header Position</td>
<td>Position of the image within the header.</td>
</tr>
</tbody>
</table>

#### Footer tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footer image</td>
<td>Image file to use in the document footer.</td>
</tr>
<tr>
<td>Footer image height</td>
<td>Maximum height of the footer image.</td>
</tr>
<tr>
<td>Footer image position</td>
<td>Position of the image within the footer.</td>
</tr>
<tr>
<td>Footer text</td>
<td>Text such as privacy and confidential statement to appear in the footer.</td>
</tr>
<tr>
<td>Footer text position</td>
<td>Position of the footer text within the footer.</td>
</tr>
</tbody>
</table>

#### Page tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page size</td>
<td>Page size of the document.</td>
</tr>
<tr>
<td>Custom font</td>
<td>Font of the text on the page.</td>
</tr>
<tr>
<td>Top/Bottom margin</td>
<td>Margin to leave on the top and bottom sides of the page.</td>
</tr>
<tr>
<td>Left/Right margin</td>
<td>Margin to leave on the left and right sides of the page.</td>
</tr>
</tbody>
</table>

2. Save the contract template.

- Save a contract template by clicking **Submit**.
- Save the changes to an existing contract template by clicking **Update**.

The contract template is saved in the Draft state. The Participants related list appears.

3. Add participants in the contract template.

**a.** In the Participants related list, click **New**.

**b.** In the **Name** field, enter the display name for the participant. For example, for an internal signatory, you could enter **Internal Signer 1**.
c. In the **Order** field, enter the order in which the signature request will be initiated for the participant.

d. In the **Signer** field, select a user field from the list of fields populated from the selected table.
   The user in the mapped field is automatically added as a signatory in the document.

e. In the **User** field, select the same field as in the **Signer** field.

f. Click **Submit**.

Create a legal contract template of type PDF
Create a document template of type PDF by uploading an editable and fillable PDF file.

**Before you begin**
Role required: admin

**Procedure**
1. On the form, fill in the fields.

   **PDF Template form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the template.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Name of the table that contains the fields to include in the document template.</td>
</tr>
<tr>
<td></td>
<td>Select [General Contract Support][sn_lg_ops_general_contract_support].</td>
</tr>
<tr>
<td>Category</td>
<td>Document category in which the template is added.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the contract template as active.</td>
</tr>
<tr>
<td>User criteria</td>
<td>User criteria to control which users can use the document.</td>
</tr>
<tr>
<td>Document</td>
<td>Option to upload a fillable PDF for further customization.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Click to add</strong> link to upload a PDF file.</td>
</tr>
</tbody>
</table>

2. Save the contract template.
   - Save a contract template by clicking **Submit**.
   - Save the changes to an existing contract template by clicking **Update**.
     The contract template is saved in the Draft state. Related lists to manage participants and to map PDF Template fields appear.

3. Add participants in the contract template.
a. In the Participants related list, click **New**.

b. In the **Name** field, enter the display name for the participant. For example, for an internal signatory, you could enter **Internal Signer 1**.

c. In the **Order** field, enter the order in which the signature request will be initiated for the participant.

d. In the **Signer** field, select a user field from the list of fields that are populated from the Signer [sn_lg_contracts_signer] table.

   📌 **Note:** You can select only the highlighted user fields.
   
The user in the mapped field is automatically added as a signatory in the document.

e. In the **User** field, select a user field from the list of fields that are populated from the Users [sys_user] table.

f. Click **Submit**.

4. Map a PDF field mapping to a field in the selected table.

   a. Click the **Parse PDF** related link.

      📌 **Note:** The related link appears only if the attached PDF file is editable.

      The editable fields from the attached PDF file are added in the PDF Template Mappings related list.

   b. In the PDF Template Mappings related list, click **Field name** to open the field mapping.

   c. On the PDF Template Mappings form, update the fields.

   **PDF Template Mapping form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Name that represents the field mapping and stored as part of the document mapping in the database.</td>
</tr>
<tr>
<td>PDF template</td>
<td>Name of the PDF template to which the mapping record belongs.</td>
</tr>
<tr>
<td>Document field</td>
<td>Field from the editable PDF file.</td>
</tr>
<tr>
<td></td>
<td>🚨 <strong>CAUTION:</strong> Editing the document field might break the document template flow.</td>
</tr>
<tr>
<td>Document field type</td>
<td>Type of the mapping field.</td>
</tr>
<tr>
<td>Preview value</td>
<td>Value of the mapping field for preview.</td>
</tr>
<tr>
<td></td>
<td>You can use this field to validate a field value that would appear in the generated document without creating a legal request to test your mappings.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Format</td>
<td>Format to enter values by the participant in the field.</td>
</tr>
<tr>
<td></td>
<td>A validation error appears when the participant doesn't enter a value in</td>
</tr>
<tr>
<td></td>
<td>the specified format.</td>
</tr>
<tr>
<td>Read only</td>
<td>Option for enabling the editing of the field by the selected participant.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Option for marking the field as required to be filled by the assigned</td>
</tr>
<tr>
<td></td>
<td>participant.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the field mapping as active.</td>
</tr>
<tr>
<td>Mapping table</td>
<td>Table from which the mapping fields are referenced.</td>
</tr>
<tr>
<td>Mapping field</td>
<td>Field from the mapping table that maps to the field in the <strong>Document field</strong>.</td>
</tr>
<tr>
<td>Participant</td>
<td>User who can edit the field in the document.</td>
</tr>
<tr>
<td></td>
<td>The list is populated from the Participants related list.</td>
</tr>
<tr>
<td>Advanced script</td>
<td>Option for using scripted fields for complex mapping of a field.</td>
</tr>
<tr>
<td></td>
<td>On selecting, the <strong>Script</strong> field appears.</td>
</tr>
<tr>
<td>Script</td>
<td>Enter a script to configure script fields for a complex field mapping.</td>
</tr>
</tbody>
</table>

d. Click **Update**.

5. Specify an area in the PDF document where you want to collect the signatures of the participants.

a. Click the **Mark Signatures** related link.

b. In the Mark Signature Blocks dialog box, mark an area in the document preview pane by dragging the mouse device.

c. Click **Add Field**.

d. In the **Name** field, enter a name for the signature-mapping record.

e. In the **Mapping** list, select a user as the singer.
   The list shows participants from the Participants related list.

f. Click **Save**.

6. **Optional:** Click **PDF Preview** to preview the document.

7. Click **Publish** to publish the contract template to use.

**Configure a rule for selecting a legal contract template**

Configure a rule to identify and use the correct legal contract document template based on the submitted legal request and generate a contract document for the requester.

**Before you begin**

Role required: sn_lg_ops.legal_config
Procedure

1. Navigate to Legal Administration > Simple Contracts > Contract Template Rules.

2. Configure or modify a contract template rule.
   - To configure a new contract template rule, click New.
   - To modify an existing contract template rule, open the contract template rule from the list.

3. On the form, fill in the fields.

   **Contract Template Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the contract template rule.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the rule as active.</td>
</tr>
<tr>
<td>Contracts table</td>
<td>Table in which the contract requests are saved.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions under which the contract template selection rule applies.</td>
</tr>
<tr>
<td></td>
<td>For example, to apply a rule when a legal request is submitted in an NDA category, you would enter the following condition:</td>
</tr>
<tr>
<td></td>
<td>[Category][is][NDA].</td>
</tr>
<tr>
<td>Document template</td>
<td>Legal contract template that can be used in the legal request that meets the specified conditions.</td>
</tr>
<tr>
<td>Execution order</td>
<td>Order in which the selection rule is run.</td>
</tr>
<tr>
<td></td>
<td>If there are multiple rules that meet the conditions from a legal request, a template rule with a lower-order number is run for selecting the template.</td>
</tr>
</tbody>
</table>

4. Save the contract template rule.
   - Save a contract template rule by clicking Submit.
   - Save the changes to an existing contract template rule by clicking Update.

The Internal Signatories Mapping related list appears.

5. Map internal signers.
   a. In the Internal Signatories Mapping related list, click New.
   b. In the **Internal Signer** field, select a user from the list of internal signers.
      The list shows all users from the Signer [sn_lg_contracts_signer] table.
   c. In the Participant field, select user from the list of participants added in the template selected in the **Document template** field.
   d. Click Submit.
Setting up an external app configuration for legal contracts

Integration with external applications enables services such as electronic signing of contract documents and storage of signed contract documents in an external storage location.

As an administrator, you can configure the following electronic signature app integrations for your contract documents:

- DocuSign
- Adobe Sign

**Note:** Only one electronic signature app configuration must be active at a time.

You can configure the following external storage app integration for storing the signed contract documents:

- Box

Set up Adobe Sign integration for legal contracts

Set up integration with the Adobe Sign to enable users to sign contract documents electronically.

**Before you begin**

Get familiar with Adobe Sign spoke.

Role required: sn_lg_ops.request_config or sn_lg_contracts.contracts_config or sn_lg_matter.matter_config

**Procedure**

1. Install Adobe Sign spoke v 1.1.1 or later version.
2. Set up the Adobe Sign services.
   For more information on the setup and synchronizing the Adobe Sign group, see Synchronize Adobe Sign group with ServiceNow.
3. Navigate to Legal Request > Legal Integrations.
4. Create or modify an external app configuration.
   - To create an external app configuration, click New.
   - To modify an existing external app configuration, open the external app configuration from the list.
5. On the form, fill in the fields.

**External Apps Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the external app configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the external app configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the external app configuration as active.</td>
</tr>
</tbody>
</table>
| Configuration type | Type of configuration.  
    Select **External Signature**. |
| Third party app  | Name of the third-party app.                        |
6. Save the external app configuration.
   - Save a new external app configuration by clicking **Submit**.
   - Save the changes to an existing external app configuration by clicking **Update**. The external app configuration record is saved and the Adobe Sign Details tab appears.

7. In the Adobe Sign Details tab, select the Adobe Sign group associated with Legal.

8. Click **Publish**.

**Results**
The Adobe Sign configuration is published and is ready to be used for electronic signature for contract documents.

**Set up DocuSign integration for legal contracts**
Set up integration with the DocuSign service to enable users to sign contract documents electronically.

**Before you begin**
Get familiar with DocuSign spoke.

Role required: sn_lg_ops.request_config or sn_lg_contracts.contracts_config or sn_lg_matter.matter_config

**Procedure**
1. Install DocuSign spoke v 2.0.1 or later version.

2. Set up the DocuSign services.
   For more information on the setup and creating the DocuSign account, see Set up DocuSign spoke.

3. Navigate to **Legal Request > Legal Integrations**.

4. Create or modify an external app configuration.
   - To create an external app configuration, click **New**.
   - To modify an existing external app configuration, open the external app configuration from the list.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the external app configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the external app configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the external app configuration as active.</td>
</tr>
<tr>
<td>Configuration type</td>
<td>Type of configuration. Select <strong>External Signature</strong>.</td>
</tr>
<tr>
<td>Third party app</td>
<td>Name of the third-party app.</td>
</tr>
</tbody>
</table>
From the list, select the connection and credentials aliases set up in Step 1 for the DocuSign service.

6. Save the external app configuration.
   - Save a new external app configuration by clicking Submit.
   - Save the changes to an existing external app configuration by clicking Update. The external app configuration record is saved and the Docusign Details tab appears.

7. In the Docusign Details tab, select the account number associated with the DocuSign service.

8. Click Publish.

Results
The DocuSign configuration is published and is ready to be used for electronic signature for contract documents.

Set up Box integration for legal contracts
Set up integration with the Box storage to store signed contract documents.

Before you begin
Get familiar with Box spoke.
Role required: sn_lg_ops.request_config or sn_lg_contracts.contracts_config or sn_lg_matter.matter_config

Procedure
1. Install Box spoke v 2.0.4 or later version.
2. Set up the Box services.
   For more information on the setup and creating the Box account, see Set up Box spoke.
3. Navigate to Legal Request > Legal Integrations.
4. Create or modify an external app configuration.
   - To create an external app configuration, click New.
   - To modify an existing external app configuration, open the external app configuration from the list.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the external app configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the external app configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for marking the external app configuration as active.</td>
</tr>
<tr>
<td>Configuration type</td>
<td>Type of configuration. Select <strong>External Storage</strong>.</td>
</tr>
<tr>
<td>Third party app</td>
<td>Name of the third-party app.</td>
</tr>
</tbody>
</table>
From the list, select the connection and credentials aliases set up in Step 1 for the Box service.

6. Save the external app configuration.
   • Save a new external app configuration by clicking Submit.
   • Save the changes to an existing external app configuration by clicking Update. The external app configuration record is saved and the External Storage Details tab appears.

7. In the External Storage Details tab, configure the external storage settings.
   a. In the Table field, select the Legal Request [sn_lg_ops_request] table.
   b. In the File path field, enter the base file path where the documents will be stored in Box.
   c. In the Folder structure, enter the structure for folders to be created. You can select a column from the table so that the folder can be dynamically created with the value in the column. For example, to create a folder in the name of the company, select the company_name column.

8. Click Publish.

Results
The Box configuration is published and is ready to be used for storing contract documents.

Submit a legal request for a non-disclosure agreement
Submit a legal request for non-disclosure agreement with third parties such as vendors, customers, or partners.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Navigate to Legal Request > Legal Service Portal.
2. Click Service Catalog to view all available request categories.
3. Search and open the Non-disclosure agreement request item.
4. On the form, fill in the fields.

Non-disclosure agreement intake form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is this for a Vendor, Customer, or Partner?</td>
<td>Category of the third party.</td>
</tr>
<tr>
<td>Purpose of the Agreement</td>
<td>Purpose of the agreement.</td>
</tr>
<tr>
<td>Company legal name</td>
<td>Legal name of the third party with whom you are making an agreement.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If the company name is not listed, select <strong>Company not listed</strong> option and enter the name in the <strong>New company legal name</strong>.</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>Mailing address of the third party.</td>
</tr>
<tr>
<td>Country</td>
<td>Country of the third party.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the agreement period.</td>
</tr>
<tr>
<td>External signatory details</td>
<td>List of people from the selected third party who would sign the agreement.</td>
</tr>
<tr>
<td></td>
<td>To add a signatory, click <strong>Add</strong> and provide the signatory's details.</td>
</tr>
<tr>
<td></td>
<td>To edit a signatory, click edit row icon (🌿) on the signatory's row and update the details.</td>
</tr>
<tr>
<td></td>
<td>To remove a signatory, click remove row icon (🗑️) on the signatory's row.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

- A legal request for generating a contract document for non-disclosure agreement is created in the New state.
- A contract document in Document Ready status is generated with the pre-filled data from the request using a contract template based on the **contract template rules**. Internal signatories based on the template are also populated in the generated document.

**Note:**
- If there are more signatories added in the request than needed for the contract (defaulted from the contract template), only the default number of signatories are considered for signing the contract. Other signatories are marked as Not Considered.
- If there are fewer signatories added in the request than needed for the contract, you can add more signatories as required for signing the contract. In either cases, you can submit a change request to update the number of signatories as required for your contract.
- A record for each external signatory is created in the Signer [sn_lg_contracts_signer] table.

The Standard Ticket page displays that has the following tabs:

- **Preview**: Review the contract document generated.
- **Signatories**: View a list of signatories and their details.
- **Activity**: Track the activities history of the request and post messages for the fulfiller working on the request.
- **Attachments**: Upload and manage documents.
- **Request Details**: Review the request details.

6. **Optional**: If you need changes in the generated document, submit a change request to the legal department:
a. Click Actions and select Request Changes.

b. In the Request Changes dialog box, enter the details you want to update in the document in the Describe your changes needed field.

c. Click Submit.
The legal request is submitted to the legal department for revision in the contract document and its status updates to Work in Progress. The document status of the contract document updates to Internal Legal Review.
Anyone from the legal department can make the requested changes in the document and send the updated document back to you.

⚠️ Note: The document preview is no longer available until the legal department sends back the revised document.

7. Optional: To modify the request details or manage signatories, click Actions and select Edit Request.
This option is available only if the request state is New and the document status is Document Ready.

8. When the contract document is finalized, click Send for signature.

Results
• The document status updates to Sent for Signature and a flow is triggered based on the contract template rule. The flow sends an email notification to the first signatory notifying that a contract document is available for signature. The first signatory is the one whose Order value in the list of signatories is set the lowest in the contract template rule. The email contains a link to the contract document that the signatories can open and sign the document through the DocuSign or Adobe Sign eSignature as configured in the corresponding contract template.

• If the system receives a success notification from the eSignature app, the document status updates to Pending Signature.

What to do next
Signatories can review and sign or decline to sign the contract document.

• If all signatories sign the contract document, the document status updates to Contract Signed. A contract repository record is created where the signed document is attached or linked.

• If any signatory declines to sign the contract document, the document status updates to Contract Declined. You can review the reasons of decline in the Activity tab and request for changes to address them, and resend the document to the signatories for signing.

Work on a legal contract request
As a member of the legal contracts support team, review and revise a contract document as per the requested changes. Upload the revised document to the request and send the document to the requester from within the request.

Before you begin
Role required: sn_lg_ops.legal_fulfiller

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (Ξ).
3. In the Lists tab, under Legal Requests, click All.
4. Open a legal contract request to work on.
5. If the legal request is unassigned, assign the request to yourself or to another member.
   • To assign the request to yourself, click Assign to me.
   • To assign the request to another member, select the member's name in the Assigned to field in the Details tab and click Save.
6. Optional: In the Signatories tab, review the signatories for the contract document and their status.
7. In the Activity section, review the changes requested by the requester and make necessary changes in the contract document.
8. Upload the revised contract document.
   a. In the Document Revisions tab, click Upload Revision.
   b. In the Upload Revision dialog box, click the Attach File link and upload the revised document.
   c. Optional: Add work notes to provide any information on the attached document.
   d. If the attached file is the final revision and is ready to be sent to the requester for review and confirmation, select the Mark as ready check box.
   e. Click Upload.
      The attached document is added to the request. The revision number of the latest document is one higher than the previous document revision number. The document is listed in the Document Revisions tab.
9. Click Send Document to send the contract document that is marked as ready to the requester.

Results
The updated document is sent to the requester for the review. The document status updates to Document Ready.

Sign or decline a legal contract document
As a signatory for a contract document, you can review and sign or decline to sign the document.

Before you begin
Role required: None

About this task
When a contract document is sent for signature, the signatory receives an email notification with a link to the document. The signatory can open the contract document, review, and sign or decline to sign.

Procedure

1. Open the contract document by clicking the link in the email notification.
2. Review the contract document and sign it or decline to sign it.
Results
The following table shows the results of signing the contract document and declining to sign it.

Result of approving or rejecting a custodian

<table>
<thead>
<tr>
<th>Sign the contract document</th>
<th>Decline to sign the contract document</th>
</tr>
</thead>
<tbody>
<tr>
<td>• If there are more signatories to sign the contract document, it is sent to the next signatory in the order. The status of current signatory in the request updates from Pending Signature to Signed. The status of the next signatory updates from Not Started to Pending Signature.</td>
<td>• The contract document is sent back to the requester. An email notification to notify that the signer has declined to sign the document is sent to the requester. The requester can review the document and request changes in the document and resend to signatories for signature.</td>
</tr>
<tr>
<td>• If the last signatory has signed the document, a contract repository record is created. The document status in the request updates to Contract Signed.</td>
<td>• The document status in the request updates from Pending Signature to Contract Declined.</td>
</tr>
</tbody>
</table>

Preview and download a signed contract document
Preview and download a signed contract document.

Before you begin
Role required: sn_lg_ops.legal_user

About this task
When all signatories have signed a contract document, it is considered as the final contract document and is stored in the Contract Repository [sn_lg_contracts_repository] table.

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under Simple Contracts, click Contracts Repository.
4. In the list of contracts repository, click a company name to open the contract.
5. Review the contract document and associated request details.
   • If an external integration is active and published, click the link in the Signed Contract to open the external storage location to download the contract document.
   • If the external storage integration is not available, in the Attachments section, click the menu icon (⋮) and select Download.

Legal Stock Preclearance
Legal Stock Preclearance enables you to manage stock preclearance requests complying with the company’s stock preclearance policy. You can set up trading windows, manage an access persons list, and approve or reject stock preclearance requests.
### Legal Stock Preclearance

Legal Stock Preclearance application keeps you in compliance with your organization's stock preclearance policy through automation of submission and approvals of preclearance requests.

Employees of your organization on designation as an access person, such as directors and executives, must obtain the preclearance approval from the legal department before they can trade in securities of the organization.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Legal Service Delivery release notes&lt;br&gt;• Legal Stock Preclearance</td>
<td>• Install Legal: LPA: Stock Preclearance</td>
<td>• Set up a trading window&lt;br&gt;• Add trading holidays&lt;br&gt;• Manage access persons list</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Submit a preclearance approval request&lt;br&gt;• Approve or reject a stock preclearance approval</td>
<td>• Developer training&lt;br&gt;• Developer documentation&lt;br&gt;• Components installed with Legal Stock Preclearance</td>
<td>• Ask or answer questions in the Legal Service Delivery forum on the Now Community&lt;br&gt;• Search the HI Knowledge Base for known error articles&lt;br&gt;• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>
Legal Stock Preclearance workflow

**Workflow:**

**Stock Preclearance**

Legal Administration > Stock Preclearance Admin

Even with an open trading window, some employees need pre-approval to trade in company securities due to their access to material, non-public information. For instance, a sales person working on a major account or an employee that has access to company strategy (like VP and above).

Set up the following items in the application:

1) Access persons list
2) Trading windows
3) Trading exchange holidays

After setup, here's what the workflow looks like:

Trading window opens

Employee submits request

Compliance team reviews request

The request is approved or denied

If approved, the employee can initiate a transaction through brokerage firm.
Install Legal: LPA: Stock Preclearance

You can install the Legal: LPA: Stock Preclearance application (sn_lg_stock_cp) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

• If the application requires plugins or other store applications, install them first if they are not already installed.

Install the following application before you install Legal: LPA: Stock Preclearance:

• Legal: Request Management (sn_lg_ops)

Role required: admin

About this task

The following components are installed with installation of the Legal: LPA: Stock Preclearance application:

• Plugins
• Store applications
• Roles
• Tables
• Business Rules

For more information, see Components installed with Legal Stock Preclearance.

You can also install the following application:

Legal Mobile (sn_lg_mobile)

The ServiceNow® Legal Mobile (sn_lg_mobile) application provides the ability to find legal information, submit and track legal requests, and work on these requests on mobile devices. For more information, see Legal Mobile.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Legal: LPA: Stock Preclearance application (sn_lg_stock_cp) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal: LPA: Stock Preclearance.

4. Optional: If demo data is available and you want to install it, click Load demo data.
Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

**Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click **Install**.

**What to do next**
Use the Legal Service Delivery Guided Setup to configure the application on your instance.

To access Legal Service Delivery Guided Setup, navigate to **Legal Administration > Legal Guided Setup**. For more information about using the guided setup interface, see Using guided setup.

**Components installed with Legal Stock Preclearance**
Several types of components are installed with activation of the Legal: LPA: Stock Preclearance application, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock Preclearance Administrator</td>
<td>Provides access to set up stock preclearance data such as trading windows, holidays, and access persons.</td>
<td>• sn_lg_ops.legal_user</td>
</tr>
<tr>
<td>[sn_lg_stock_cp.stock_config]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Persons [sn_lg_stock_cp_access_person]</td>
<td>Stores users designated as Access Persons to submit a stock preclearance request.</td>
</tr>
<tr>
<td>Calendar Year [sn_lg_stock_cp_trading_year]</td>
<td>Stores calendar years used for setting up trading holidays for your organization during which no trading in securities is permitted.</td>
</tr>
<tr>
<td>Holiday [sn_lg_stock_cp_trading_holiday]</td>
<td>Stores the stock exchange trading holidays for your organization.</td>
</tr>
<tr>
<td>Trading Window [sn_lg_stock_cp_trading_window]</td>
<td>Stores the trading window details for stock preclearance requests.</td>
</tr>
<tr>
<td>Trading Window Requests [sn_lg_stock_cp_trading_window_request]</td>
<td>Stores the trading window requests for stock preclearance requests.</td>
</tr>
</tbody>
</table>
Setting up Legal Stock Preclearance

Configure the foundation data for your stock preclearance process to enable employees to submit preclearance approval requests before they trade in the securities.

As an administrator, you can review the installed components and modify them or add new ones as applicable.

- Legal stock approvers
- Fiscal calendar
- Trading windows
- Trading holidays
- Access Persons list
- Notifications

Set up a trading window

Set up a trading window for a period in which certain designated employees of the organization are permitted to trade in the securities of your organization.

Before you begin
Role required: sn_lg_stock_cp.stock_config

About this task
During an open trading window, the designated employees such as directors and executives can trade in compliance with your organization’s Insider Trading Policies.

Procedure

1. Navigate to Legal Administration > Stock Preclearance Admin > Trading Windows.
2. Click New to set up a trading window.
3. On the form, fill in the fields.

Trading Window form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Unique short description for the trading window.</td>
</tr>
<tr>
<td>Fiscal quarter</td>
<td>Fiscal quarter for which the trading window is open.</td>
</tr>
<tr>
<td>Opening date</td>
<td>Date the trading window opens.</td>
</tr>
<tr>
<td>Closing date</td>
<td>Date the trading window closes.</td>
</tr>
<tr>
<td>Request submission start date</td>
<td>Date from which you can start submitting preclearance requests.</td>
</tr>
<tr>
<td>Earnings date</td>
<td>Date of your company’s earnings.</td>
</tr>
<tr>
<td>Approval validity days</td>
<td>Number of days a stock preclearance approval is valid for.</td>
</tr>
<tr>
<td>Exclude trading holidays</td>
<td>Option to exclude trading on holidays that fall within the trading window. Selecting this option extends the approval validity days by the number of holidays during the trading period.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Unique short description for the trading holiday, such as New Year, Labor Day, or Christmas.</td>
</tr>
</tbody>
</table>

| Note: By default, weekend days are excluded for calculating the validity due date. |

For example, say that a trading window opens from January 1 to January 31 and you have set the approval validity days to 10 days. If January 24 and 25 are trading holidays, then,

- If the preclearance is approved on January 8, the approval validity is until January 22 (10 days from January 8 + 4 days of two weekends).
- If the preclearance is approved on January 15, the approval validity is until January 31 instead of January 25 (10 days + 4 days of two weekends + 2 holidays from January 15).
- If the preclearance is approved on January 21, the approval validity is until February 6 (10 days + 2 holidays from January 20 + 4 days of two weekends). However, as the trading window closes earlier than the validity of approval, the last date is January 31 rather than February 6.

4. Click **Submit**.

**Add trading holidays**
Add trading holidays during which the trading is closed.

**Before you begin**
Role required: sn_lg_stock_cp.stock_config

**About this task**
A trading holiday might impact the stock preclearance approval validity period based on the **Exclude trading holidays** field’s setting in the trading window. For more information, see **Set up a trading window**.

**Procedure**
1. Navigate to Legal Administration > Stock Preclearance Admin > Trading Holidays.
2. Click **New**.
3. Enter the calendar year for which you want to add trading holidays and click **Submit**.
4. Open the calendar year you created to add trading holidays.
5. In the Holidays related list, click **New**.
6. On the form, fill in the fields.
Manage access persons list

Add users who have access to non-public information regarding the trade of securities of your organization.

Before you begin
Role required: sn_lg_stock_cp.stock_config

Procedure

1. Navigate to Legal Administration > Stock Preclearance Admin > Access Persons.
2. To add a user to the access persons list,
   a. Click Add Users.
   b. In the Add User dialog box, select users from the list to add as access persons. The list shows only active users from the Users [sys_user] table.
   a. Scroll down to the Actions on selected rows menu and choose Add Users to Access List. The selected users are added to the Access Persons list.
3. To modify a user’s information in the Access Persons list,
   a. Click the preview icon (i) and click Open Record.
   b. On the form, update the fields.

Access Persons form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>Entry date</td>
<td>Date on which the user was added to the access persons list. This field is not available for modification.</td>
</tr>
<tr>
<td>Exit date</td>
<td>Date the user is automatically removed from the access persons list.</td>
</tr>
<tr>
<td>Sec 16 officer</td>
<td>Option for marking the user as a Section 16 officer.</td>
</tr>
</tbody>
</table>

Submit a preclearance approval request

As a designated access person, submit a request to obtain the preclearance approval from the legal department before you can trade in the securities of your organization.

Before you begin
Role required: sn_lg_ops.legal_user
About this task
You can submit a preclearance request during an open trading window period only if you are in the Access Persons list.

Procedure
1. Navigate to Legal Request > Legal Service Portal.
2. Click Service Catalog to view all available request categories.
3. Search for the stock preclearance request item.
4. Click Stock Preclearance.
5. On the form, fill in the fields.

Stock Preclearance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction type</td>
<td>Type of securities transaction for which you need a preclearance approval.</td>
</tr>
<tr>
<td>Number of securities</td>
<td>Number of shares to trade.</td>
</tr>
<tr>
<td>Nature of securities</td>
<td>Type of shares for which you need a preclearance approval.</td>
</tr>
<tr>
<td>Proposed transaction date</td>
<td>Date on which you want to perform the securities transaction. The date must be within the current trading window.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description for the preclearance approval.</td>
</tr>
<tr>
<td>I agree</td>
<td>Option to confirm your consent to trade in securities in accordance with your organization's insider trading policies.</td>
</tr>
</tbody>
</table>

6. Click Submit.

Results
A preclearance approval request is created and assigned to the legal stock approvers group. If configured by the administrator, you get the notification about the progress of your request.

When submitting the stock preclearance request as a Sec-16 officer, the Subcategory in the request is automatically set as Sec-16 Officer.
Approve or reject a stock preclearance approval

As a member of the legal stock approvers group, approve or reject a stock preclearance approval request so that the requester can trade in the securities of the organization.

Before you begin
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the list icon (≡).
3. In the Lists tab, under My Work, click Items Pending Approvals.
4. Open a stock preclearance approval request record by clicking Requested.
5. Approve or reject the stock preclearance approval request.
   - To approve the stock preclearance approval request, click Approve. The state of the approval request updates to Approved.
   - To reject the stock preclearance approval request, click Reject. The state of the approval request updates to Rejected.

Results
- If you approve the stock preclearance approval request, the requester can perform the requested securities transaction within the current trading window. The approval is valid based on the approval validity days settings or the closing date of the current trading window, whichever is earlier.
- If you approve the request on a holiday, the approval validity starts from the next business day.
- If you reject the request, the requester cannot perform any securities transactions.

Legal Virtual Agent Conversations

The ServiceNow® Legal Virtual Agent Conversations application provides predefined conversation topics to enable automated chats with employees seeking legal services. You can build new topics or customize the predefined topics to handle common legal requests from employees or guide them through self-service tasks.

Features
- Automates handling of repetitive requests
- Reduces the response time for your employee queries
- Integrates with legal services to create requests on behalf of employees
- Provides live agent chat support

Predefined conversation topics for Legal Service Delivery

The Legal Virtual Agent Conversations application installs the following virtual agent conversation topics (chatbot conversations) to help employees with common self-service tasks in Legal Service Delivery.

Check Legal Request and Matter status
Displays the status of legal requests and matters submitted by employees for themselves or on behalf of another employee.

**General Legal Request**

Helps employees create a general legal request. Based on the entered short description, it also provides links to relevant Legal knowledge base articles to resolve issues.

**Legal Knowledge Base**

Finds and displays Legal knowledge base articles based on the entered search string.

**Privacy Assessment**

Helps employees create a legal request to review whether projects comply with an organization’s applicable privacy regulations and accepted privacy policy. The Legal department reviews such requests for potential risks and might recommend a mitigation plan if necessary.

**Stock Trading**

Helps employees to know about the stock trading window of your organization and with stock pre-clearance requests.

This virtual agent conversation topic is available only if you’ve installed the Legal Stock Preclearance application.

**Install Legal Virtual Agent Conversations**

You can install the Legal Virtual Agent Conversations application (sn_lg_va) if you have the admin role. The application installs related ServiceNow® Store applications and plugins if they are not already installed.

**Before you begin**

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

- Legal Virtual Agent Conversations requires the following ServiceNow Store applications. Ensure that these applications are installed before you install Legal Virtual Agent Conversations.

  **Required ServiceNow plugins**

  **Glide Virtual Agent (com.glide.cs.chatbot)**

  ServiceNow® Virtual Agent is a platform for providing user assistance through conversations within a messaging interface. Use Virtual Agent to design and build automated conversations that help your users quickly obtain information, make decisions, and perform common work tasks.

  **Required ServiceNow Store applications**

  **Legal: Request Management (sn_lg_ops)**

  Legal Request Management provides a single, unified mechanism for employees to get all the information, services, and help that they need from their legal department. For more information, see Install Legal Request Management.

Role required: admin
About this task

Note: To use the Live Agent support, install the Agent Chat (com.glide.interaction.awa) plugin.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Legal Virtual Agent Conversations application (sn_lg_va) using the filter criteria and search bar.
   
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.
   
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal Virtual Agent Conversations.

4. Click Install.

Configure Virtual Agent conversation topics for legal services

Create or modify Virtual Agent conversation topics for legal services.

Before you begin

Role required: admin or virtual_agent_admin

About this task

The Legal Virtual Agent Conversations application installs various virtual agent conversation topics for seeking legal services.

These virtual agent conversation topics are built using ServiceNow Virtual Agent Designer, so make sure you’re familiar with the Virtual Agent Designer basics.

Procedure

1. Navigate to Collaboration > Virtual Agent > Designer > Topics.

2. Configure a new conversation topic or customize a predefined conversation topic for a legal service.

<table>
<thead>
<tr>
<th>Options</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Create a new virtual agent conversation topic | a. In the Topics page, click + Create.  
  | b. On the form, fill in the fields.  
  | For more information on creating a conversation topic and description of fields on the form, see Create a Virtual Agent topic. |
| Customize a predefined conversation topic | a. In the Topics page, click a conversation topic item to open.  
  | b. On the form, update the required fields and click Update. |
3. Click **Publish** to make the conversation topic available to employees on the Virtual Agent client.
   For more information, see **Publish a Virtual Agent topic**.

### Live agent support for legal services

Employees can contact a live agent from the Legal department (a paralegal staff or lawyer) via the Virtual Agent chat window to seek legal help.

**Note:** To use the Live agent support, you must install the Agent Chat (com.glide.interaction.awa) plugin.

### Requester experience

Employees can connect to a live agent at any time during their ongoing virtual chats in the Legal Service Portal by clicking the support options icon (.contract) in the Virtual Agent chat window and selecting **Contact Live Agent**.

**Note:** The **Contact Live Agent** option is not available in Virtual Agent chat window on the Employee Service Center to connect with live agents in the Legal department.
If no agent accepts the chat request, the conversation automatically times out for the requesters.

**Fulfiller experience**

In the Legal Counsel Center, users in the Legal department with the legal_fulfiller role can make themselves available when they are ready to take any incoming chat requests.

**Interaction records**

When a live agent accepts an employee’s chat request, an Interaction record is automatically created.

**Other actions for live agents**

While on a chat, live agents can do the following actions:

- Transfer the chat to another agent.
- Transfer the chat to another queue.
- Send attachments to the chat.

**Related information**

- Start a chat session through Legal Counsel Center Inbox
- Configure live agent support settings for legal services

Configure settings to enable live agent support for legal services.

**Before you begin**

Ensure that you have the following applications installed:
• Legal Request Management
• Legal Virtual Agent Conversations
• Legal Counsel Center

Role required: admin

**Procedure**

1. Install Agent Chat.
   For more information, see Agent Chat and Advanced Work Assignment.

2. Configure the assignment rule to provide the criteria for routing the chat conversations to live agents in the Legal department.
   a. Navigate to Advanced Work Assignment > Settings > Assignment Rules.
   b. Open the base system assignment rule Legal Chat Assignment Rule.
   c. Update fields as required.
      For more information on the fields, see Configure agent assignment rules.
   d. Click Update.

3. Configure the work item queue and the associated assignment eligibility.
   a. Navigate to Advanced Work Assignment > Settings > Queues.
   b. Open the base system Queue Legal Chat.
   c. Update fields as required.
      For more information on the fields, see Create a work item queue.
   d. Click Update.
   e. In the Assignment Eligibility related list, open the base system record Legal Department.
   f. Update fields as required.
      For more information on the fields, see Define Assignment Eligibility.

**Start a chat session through Legal Counsel Center Inbox**

Accept an incoming chat request through Legal Counsel Center Inbox to start a chat session with the requester.

**Before you begin**
Role required: legal_fulfiller

**About this task**
The live agent support enables a chat interaction between an employees and legal department users. For more information, see Live agent support for legal services.
Procedure
1. Navigate to Legal Request > Legal Counsel Center.
2. Click the inbox icon ( ).
3. Select Available from Status to make yourself ready to take incoming chat request.
   Employees on a Virtual Agent chat can use the Contact Live Agent option to connect.
4. When a chat comes through the chat queue, select Accept.
   A new interaction record is created and appears on the Legal Counsel Center.
5. From the Active Chat panel, interact with the employee who initiated the chat from the Public Chat tab and with another Legal department user for any information related to the current chat queries from the Private Chat tab.
   - To chat, enter a message and click the send icon ( ) or press the Enter key.
   - To send an attachment, click the send attachment to chat icon ( ), select the file to attach, and click Open.
   - To transfer the chat to another queue, click the transfer to queue icon ( ) and select the queue.
   - To transfer the chat to another available agent, click the transfer to agent icon ( ) and select the agent name.

Related information
   Getting work from chats
   Interaction records in Workspace

Legal Mobile
The ServiceNow® Legal Mobile application enables your employees to submit and track legal requests and lawyers to work on these requests on their mobile devices.
Employees can use the Now® Mobile app to do the following tasks:
   - Submit and track legal requests
   - Track the status of submitted requests

Lawyers can use the ServiceNow Agent app to do the following tasks:
   - Triage unassigned requests and matters
   - Approve or reject requests
   - Create and manage matters
   - Create and assign tasks
   - Create and manage artifacts
   - View legal events and milestones

These apps run on the ServiceNow® mobile platform. You can download these mobile apps for the iOS platform from the Apple App Store or for the Android platform from the Google Play Store.

Install Legal Mobile
You can install the Legal Mobile application (sn_lg_mobile) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and
plugins if they are not already installed. This app makes Legal Service Delivery applications available on Now Mobile and Mobile Agent app mobile apps.

**Before you begin**

- Ensure that the Legal Mobile application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- If the application requires plugins or other store applications, install them first if they are not already installed.

Install the following application before you install Legal Mobile application (sn_lg_mobile):
- Legal: Request Management (sn_lg_ops)

Role required: admin

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
   2. Find the Legal Mobile application (sn_lg_mobile) using the filter criteria and search bar.
      
      You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
      
      Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.
   
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Legal Mobile.

4. Click **Install**.

**Download and log in to mobile apps to access legal services**

Download the Now Mobile app to submit and track legal requests and the Mobile Agent app mobile app to work on the submitted legal requests.

**Before you begin**

Role required: None

**About this task**

After you install the Legal Mobile app in your instance, employees and lawyers can start using the legal services on their mobile device.

**Procedure**

1. Download the following mobile apps for the iOS platform from the Apple App Store or for the Android platform from the Google Play Store.

   - As a requester, download the Now Mobile app for submitting and tracking legal requests.
     
     For more information on using this mobile app, see Now Mobile app.
- As a member of the legal department, download the Mobile Agent app mobile app for working on legal requests.

For more information on using this mobile app, see Agent mobile app.

2. Add your ServiceNow instance to the mobile app.
3. Log in to access the Legal Mobile apps functionality through the mobile device.
4. Open the Now Mobile or Mobile Agent app mobile app and tap the plus icon (+).
5. Add your ServiceNow instance by entering the instance address.
   You do not need to include service-now.com at the end of the instance name.
6. Optional: In the Enter nickname field, enter an alias to quickly identify the instance.
7. Tap Save and login.
8. Log in to your instance.

Submit a legal request through Now Mobile
Submit a request to seek legal services from your organization’s legal department.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. Open the Now Mobile app on your mobile device.
2. In the navigation bar, tap Services.
3. In the Browse Services tab on the page tap Legal Requests to view all available request categories.
4. Tap a request category.
5. Tap a legal service item for which you want to submit a request.
   If you are not sure which category to choose, tap the General Legal Request service item.
6. Fill in the fields.

   Note: Every legal service request has different set of fields based on the selected legal service item.
7. Tap Submit.
   A confirmation that your request has been submitted is displayed.
8. Tap Close to return to the list of service items.

Assign a legal request through Mobile Agent app
As a legal group manager or a practice area lead, assign a legal request to a legal department’s member to work on.

Before you begin
Role required: sn_lg_ops.legal_fulfiller

About this task
When an employee submits a legal request, it is automatically assigned to a group or user in the legal department based on the assignment rules configured for the intake form of the associated practice area. If the request is assigned to a legal group, any member from the group can triage the request themselves or assign it to another member of the group.
Procedure
1. In the Mobile Agent app, navigate to the Practice Area Work list.
2. Tap Unassigned Requests to open the list of unassigned requests.
3. Tap a request item to assign it to a legal department’s member.
4. In the Details tab, tap Assign.
5. In the Assigned to list, select the user to whom you want to assign the request.
6. Tap the submit icon (✓).

Results
The legal request is assigned to the selected user. The state of the legal request changes to Assigned.

Work on a legal request through Mobile Agent app
As a member of the legal department, work on legal requests submitted by employees to resolve their issues or to answer their queries.

Before you begin
Role required: sn-lg_ops.legal_fulfiller

Procedure
1. Open the Mobile Agent app on your mobile.
2. In the navigation bar, tap Legal.
3. Open an assigned request you want to work on in any of the following ways:
   • In the global search bar, search for a request and tap on a request to open.
   • In the Critical Requests Assigned to Me list, tap on a request applet.
   • In the My Work list, tap on the Assigned Requests and then tap on a request.
4. Tap Start Work to start working on the legal request.

Results
The state of the legal request changes from Assigned to Work in Progress.

What to do next
• Create and manage checklist to track what should be done to resolve the legal request.
• Add documents, videos, images.
• Promote the legal request to a legal matter. This option is available only if you have installed the Legal Matter Management application.
• Close the legal request when the request is resolved.

Manage a checklist for a legal request through ServiceNow Agent
Create and manage a checklist in an assigned legal request to ensure that you complete all the items necessary to fulfill the request.

Before you begin
Role required: sn-lg_ops.legal_fulfiller
Procedure
1. In the Mobile Agent app, navigate to the Assigned Requests list.
2. Open a request for which you want to create the checklist.
3. In the Checklist tab, tap Add Item to add a new checklist item.
4. In the Add Item field, enter the checklist item description.
5. Tap the submit icon (✓).
6. Continue to add checklist items for the necessary actions to handle the request.
7. Check off completed items by tapping the corresponding item.

Promote a legal request to a legal matter through Mobile Agent app
Promote a legal request to a legal matter when the request needs additional investigation and evaluation and substantial time to work on.

Before you begin
Ensure you have the Legal Matter Management app installed and the record producer type in the associated intake form is set to Request and Matter. For more information, see Add an intake form to a practice area.
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. In the Mobile Agent app, navigate to the Assigned Requests list.
2. Tap the assigned request you want to work on.
3. In the Details tab, tap Create Matter.
4. In the Create Matter from Template screen, indicate whether to use a template to create a legal matter.
   • To create a legal matter record with predefined data, such as phases and tasks, select a template name from the Matter template.
   • To create a legal matter record without any predefined data, leave the Matter template field empty.
5. Tap the submit icon (✓).

Results
• A legal matter is created with details copied from the legal request.
• If you selected a matter template, the matter has predefined phases, tasks, and attributes from the template.

Add collaborators to a legal matter through Mobile Agent app
Add other users as collaborators so that they can view the details and progress of a legal matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller
Procedure
1. In the Mobile Agent app, navigate to the Assigned Matters list.
2. Tap the assigned matter to which you want to add a collaborator.
3. Tap the actions icon ( três ) and select the Add Collaborators option.
4. Tap the Add Collaborators field and select the users to add as collaborators.
5. Tap the ok icon ( checked )
6. Tap the submit icon ( chevron right ).

Add a phase in a legal matter through Mobile Agent app
Add a phase to a legal matter to follow a structured approach to perform specific tasks to complete the matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

About this task
If you created a legal matter using a matter template, the predefined phases are available in the matter from the template. You can add more phases as required.

Procedure
1. In the Mobile Agent app, navigate to the Assigned Matters list.
2. Tap an assigned matter in which you want to add a phase.
3. Tap the actions icon ( três ) and select the Create Phase option.
4. In the Enter Phase Name field, enter a unique name for the phase.
5. In the Enter Phase Order field, enter the order in which the phase should be worked on.
6. Tap the submit icon ( chevron right ).

Results
A phase is added to the matter.

What to do next
Add tasks in the phase to manage activities in the legal matter. If the task has to be done by a different user, you can assign these tasks to that person.

Add a task in a legal matter through Mobile Agent app
Add a task in a legal matter or a phase of the matter that you or another user should perform to resolve the matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. In the Mobile Agent app, navigate to the Assigned Matters list.
2. Tap an assigned matter.
3. In the Others tab, tap Phase and Tasks.
4. Open a phase in which you want to add a task.

5. Tap the actions icon (⋮) and select the Create Task option.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Name</td>
<td>Unique name for the task.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the task should be worked on.</td>
</tr>
</tbody>
</table>
| Type              | Type of the task:  
|                   | • Data collection  
|                   | • Risk and Mitigation                           |
| Due date          | Date by which the task should be completed.     |
| Short description | Short description to specify the expected activities and output involved in completing the task. |

7. Tap the submit icon (✓).

8. Create a checklist to complete all the items necessary to fulfill the task.
   a. In the Checklist tab, tap Add Item to add a new checklist item.
   b. In the Add Item field, enter the checklist item description.
   c. Tap the submit icon (✓).
   d. Continue to add checklist items for the necessary actions to handle the task.

9. Assign the task to a user who can work on the task by tapping the Assign button.

Results
A legal matter task is created and is listed in the matter's Tasks tab. If the task was added in a phase record, then the task is also listed in the phase’s Legal Matter Tasks tab.

Complete a legal matter task through Mobile Agent app
When you finish working on an assigned matter task, you can mark the task as complete.

Before you begin
Role required: sn_lg_ops.legal_user

Procedure
1. In the Mobile Agent app, navigate to the Assigned Tasks list.
2. Tap an assigned task.
3. In the Details tab, tap Mark as Complete.

Results
The matter task is completed and its state updates to Review. It sent to the matter owner for approval.
Approve or reject a legal matter task through Mobile Agent app

As a legal matter owner, you can review and approve or reject matter tasks that are marked as complete by the task owners.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. In the Mobile Agent app, navigate to the Pending Approvals list.
2. Tap an assigned task.
3. Optional: Review the task details and activities done by the task owner.
   a. Tap the task number on the Approval for field.
   b. Tap the back icon (←) to return to the task Pending Legal Matter Task Approval screen.
4. Approve or reject the task by tapping Approve or Reject.

Results
• If you approve the matter task, the task is closed. The state of the task updates to Closed Complete.
• If you reject the matter task, the task is opened again. The state of the task updates to Work in Progress. The task owner can work on the task again to fulfill the requirements of the task and mark it complete for approval.

Add an artifact to a legal matter through Mobile Agent app

Add an artifact to a legal matter to upload and store documents, emails, and files related to the matter.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

About this task
Note: If the requester attached any files when submitting a request, a default artifact containing those files is created in the matter promoted from the request.

Procedure
1. In the Mobile Agent app, navigate to the Assigned Matters list.
2. Tap an assigned matter to which you want to add an artifact.
3. Tap the actions icon (…) and select the Create Artifact option.
4. In the Enter short description field, enter a description for the artifact.
5. Tap the submit icon (✓).

Results
An artifact folder is created for the matter.

What to do next
Attach the matter-related files to the folder.
Attach files to a legal matter through Mobile Agent app

Upload supporting documentation, such as documents, copies of email messages, images, or any other files into the artifact while you are working on a legal matter or matter task. You can also use these artifacts as a reference material to solve similar requests in future.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. In the Mobile Agent app, navigate to the Assigned Matters list.
2. Tap an assigned matter.
3. In the Others tab, tap Artifacts.
4. Open an artifact to which you want to attach a file.
5. Tap Add Attachment and select one of the options:
   - Take Photo
   - Record Video
   - Open Gallery
   - Attach File
   The file is attached and listed.
6. Optional: You can rename the file by tapping the edit icon (✓) and entering a new name.

ℹ️ Note: If a file is no longer required for the legal matter, you can remove the file by tapping the delete icon (🗑️).

Close a legal matter through Mobile Agent app

Close a legal matter assigned to you when you complete all activities for resolving it, or if you find that it doesn’t need any further action.

Before you begin
Role required: sn_lg_matter.matter_fulfiller

Procedure
1. In the Mobile Agent app, navigate to the Assigned Matters list.
2. Tap an assigned matter.
3. Tap Close Complete.
4. In the Close Matter screen, enter comments in the Comments field describing the resolution of the matter or why it is being closed if not resolved.
5. To close related legal requests along with the parent request, tap Close related requests and select Yes.
   Only related legal requests that are in the Assigned or Work in Progress states are closed.
6. Tap Submit.
Results

• The legal matter is closed and its state updates to Closed Complete.

• If the parent legal request of the matter is not associated with any other open matters, the request is also closed.

• If you chose to close all related requests also, then they are also closed if they meet the following conditions:
  ◦ The state of those requests is either Assigned or Work in Progress.
  ◦ Those requests are not associated with any other open matters.

• Comments entered in the Close Matter screen are posted in all the open related requests.

Close a legal request through Mobile Agent app
Close a legal request assigned to you when you’ve resolved it.

Before you begin
Role required: sn_lg_ops.legal_fulfiller

Procedure
1. In the Mobile Agent app, navigate to the Assigned Requests list.
2. Tap the request item that you want to close.
3. Tap Close Complete.

Results
The legal request is closed and the state changes to Close Complete.

Security in Legal Service Delivery
Legal Service Delivery provides security through various Now Platform security features such as Restricted Caller Access, Encryption Support, and Edge Encryption.

Restricted caller access for Legal Service Delivery
Restricted caller access (RCA) privilege settings define cross-scope access to an application, application resource (for example, access control role, business rule, UI action, script include), event, or to allow or deny requests for access. Using RCA, the administrators can track cross-scope applications or scripts that request access to a Legal Service Delivery application, application resources, or events and secure sensitive information in scoped tables and script includes.

For more information on tracking cross-scope requests for access and approve or deny those requests, see Define cross-scope access to an application resource.

Edge Encryption for Legal Service Delivery
ServiceNow® Edge Encryption™ encrypts sensitive data on your company premises before sending it over the internet to your ServiceNow instance (encrypted in flight), where it remains encrypted at rest.

For more information, see Understanding Edge Encryption.
The Legal Service Delivery dashboard provides comprehensive reports to the legal department. The dashboard uses Performance Analytics to provide reports and metrics on legal requests and legal matters.

### Open Requests & Matters tab

- **Open Requests**: 72
- **Unassigned Requests**: 19
- **Open Matters**: 14
- **Unassigned Matters**: 5

**Open Requests by Assigned to**

- **Open Requests by Matter Owner**

**Group by**: Practice area, Stacked by: None

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Trend Analysis tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Report Viewer: Has visibility in count, state, assigned and unassigned, trend over specific time for legal requests and legal matters.</td>
<td>sn_lg_ops.legal_report_viewer</td>
</tr>
<tr>
<td>Legal Report Publisher: Has access to create, modify, and publish reports for legal request and legal matter.</td>
<td>sn_lg_ops.legal_report_publisher</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Requests &amp; Matters tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Requests</td>
<td>Single score</td>
<td>Number of legal requests that are not in any of these states: Closed Complete, Closed Incomplete, or Cancelled.</td>
</tr>
<tr>
<td>Unassigned Requests</td>
<td>Single score</td>
<td>Number of legal requests that are in the New state and not yet assigned to anyone.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open Matters</td>
<td>Single score</td>
<td>Number of legal matters that are not in any of these states: Closed Complete, or Cancelled.</td>
</tr>
<tr>
<td>Unassigned Matters</td>
<td>Single score</td>
<td>Number of legal matters that are in the New state and not yet assigned to anyone.</td>
</tr>
<tr>
<td>Open Requests</td>
<td>Bar</td>
<td>Number of open legal requests. The requests in this report are grouped by practice area. Use the <strong>Group by</strong> and <strong>Stacked By</strong> lists to change the data representation of the chart.</td>
</tr>
<tr>
<td>Open Matters</td>
<td>Bar</td>
<td>Number of open legal matters. The matters in this report are grouped by practice area. Use the <strong>Group by</strong> and <strong>Stacked By</strong> lists to change the data representation of the chart.</td>
</tr>
<tr>
<td>Open Requests by Assigned to</td>
<td>Bar</td>
<td>Number of open legal requests that are in any of these states: New, Assigned, Work In Progress. The requests in this report are grouped by assigned users.</td>
</tr>
<tr>
<td>Open Matters by Matter Owner</td>
<td>Bar</td>
<td>Number of open legal matters that are in any of these states: New, Assigned, Work In Progress. The matters in this report are grouped by matter owners.</td>
</tr>
</tbody>
</table>

**Trend Analysis tab**

- **Opened & Closed Request per Month**: Time series line
  - Monthly trend of closed legal requests over opened requests that were created in the current year.
- **Opened Requests & Matters per Month**: Time series line
  - Monthly trend of legal requests and legal matters.
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requests This Year</td>
<td>Stacked column</td>
<td>Legal requests created in the current year. The requests in this report are grouped by practice areas.</td>
</tr>
<tr>
<td>Matters This Year</td>
<td>Stacked column</td>
<td>Legal matters created in the current year. The matters in this report are grouped by practice areas.</td>
</tr>
<tr>
<td>Knowledge Articles Viewed</td>
<td>Stacked column</td>
<td>Number of knowledge articles created in the current year that have been viewed. The articles in this report are grouped by article categories.</td>
</tr>
<tr>
<td>Top 10 Knowledge Articles Viewed</td>
<td>Bar</td>
<td>Top 10 knowledge articles viewed the most number of times. The articles in this report are grouped by the short description of the articles.</td>
</tr>
</tbody>
</table>

**Domain separation and Legal Service Delivery**

Domain separation is supported for applications in Legal Service Delivery. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- **Business logic:** Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

To learn more, see Application support for domain separation.

**Overview**

Legal Service Delivery includes the following applications:

- Legal Request Management
- Legal Matter Management
- Legal Conflict of Interest
- Legal Digital Forensics

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Legal Simple Contracts
• Legal Stock Preclearance
• Legal Counsel Center
• Legal Virtual Agent Conversations
• Legal Mobile

All tables installed with the following applications can be domain-separated:
• Legal Request Management
• Legal Matter Management
• Legal Conflict of Interest
• Legal Digital Forensics
• Legal Simple Contracts
• Legal Stock Preclearance

How domain separation works in Legal Service Delivery

• If an employee submits a legal service request, the request can be assigned to legal department users who are in the same domain as the employee.

• Lawyers or paralegal staff can work only on those legal requests that have been created within the domain that they belong to.

Related information

Domain separation for service providers

Universal Request

ServiceNow Universal Request empowers customers in their journey towards Enterprise Service Management (ESM) or Global Business Services (GBS) by allowing agents to resolve cases seamlessly across the enterprise to provide a better employee experience.
Employee experience
Enhance the experience by eliminating the employee’s confusion in figuring out which department to reach out to for help. Hide the service delivery process complexities by handling request transfers across the enterprise behind the scenes.

Enterprise security
Restrict access to the request at the time of creation or after assessing the request for an agent to view the ticket that has sensitive information. This enhanced security ensures that security is maintained while transferring the request between scoped applications.

Cross-department ticket transfers
Transfer tickets between scoped applications by configuring the transfer type without compromising on the security protocols. Also, route tickets using artificial intelligence.

Tasking capabilities
Task employees to get additional information needed to fulfil the employee’s request. Integrate Universal Task framework to create a general and standard task experience for both the agent/fulfiller and the employee.

Explore
Learn about how employees, agents, and managers use Universal Request.

Configure
Plan and configure your implementation.

Integrate
Extend Universal Request capabilities by integrating with other applications.

Use
Work on universal requests, and manage security and transfers.

Analytics and Reporting Solutions
Coordinate work and improve processes with dashboards and reports.

Reference
Get details about components like fields, tables, and properties.

Exploring Universal Request
The ServiceNow Universal Request application enables cross-departmental reporting from the time of an initial employee request through the final issue resolution. You can map various departmental ticket states and activity streams into a unified and simplified experience for your employees and agents.
Universal Request application supports the following two most common ESM or GBS service delivery models.

**Cross-departmental Tier 1 support desk**
If your organization has a cross-trained group of Tier 1 agents to resolve routine requests, then you can use this support desk model. In this model, universal requests are assigned to the cross-departmental tier 1 support desk agents to triage, resolve, or forward unresolved requests to a higher support level within a specific department.

**Embedded Tier 1 Support Desks**
If your organization has tier 1 agents in each department, such as IT, HR, and Finance, then you can use this support desk model. In this model, universal requests are routed to the appropriate departmental tier 1 agents who resolve, escalate, or transfer the requests to the correct department.

The Universal Request application provides the following key benefits to employees and agents of your organization:

- Facilitates employees to create a request by just clicking **Request Help** in the Service Portal if they cannot find the relevant search results or are unsure of which department to contact for help.
- Provides a consistent and unified ticket page experience to employees across service departments.
• Enables agents to effectively resolve a case or request through cross-departmental interactions rather than working in silos.
• Provide an end-to-end user experience with complete visibility to the case details.
• Enables ticket transfers across departments or between a Tier-1 support desk and higher-level departmental support teams, with enhanced security.
• Enables agents to task employees using the Universal Task application to complete a catalog item or upload a document to facilitate quick resolution of a request.
• Monitor and improve the end-to-end experience with cross-departmental SLAs and metrics.

**Universal Request versus Interaction Records (New Call record)**

Universal request and interaction records are created and used by agents of various departments. However, they differ in the way they are handled. The following information provides an overview of both the records and how they differ from each other.

An Interaction Record or a New Call record is used by an agent to take notes and determine the next steps during a live chat or phone call. From an Interaction Record, an agent can perform one of the following actions:

• Attach the interaction to an existing request, such as an IT incident, an HR case, or a Universal Request.
• Create a new department ticket, such as an IT incident or an HR case.
• Create a Universal Request and assign it to a Tier 1 agent or assignment group in a specific department.

A Universal Request is created from an Interaction Record or New Call record when an agent determines that the universal request must be transferred to a different department by assigning it to a Tier 1 assignment group. The following table lists the high-level differences between an Interaction Record and a Universal Request.

<table>
<thead>
<tr>
<th>Universal Request</th>
<th>Interaction Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Requests are task records used by Tier 1 agents to either resolve or escalate an employee issue through any channel.</td>
<td>Interaction records are temporary records used by agents to capture initial interactions with an employee from a chat or phone call. The agent determines whether to create a new task record or add it to an existing record.</td>
</tr>
<tr>
<td>Universal Requests are requester-facing records. The universal requests are listed on the requester's ticket list page. They can view the individual tickets in the standard ticket page.</td>
<td>Interaction records are not requester-facing records.</td>
</tr>
<tr>
<td>Universal Request is a task type that agents work on. Universal Request supports cross-departmental ticket transfers and a unified ticket page experience for the requester.</td>
<td>Interaction record is not a task type.</td>
</tr>
<tr>
<td>Universal Request is a task type that serves as a parent record for other records that are created as child records, such as INC, HRC, and custom task types. It is also used for all cross-departmental reporting.</td>
<td>Interaction records cannot be used for cross-departmental SLA reporting.</td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Universal Request data model

Universal Request is a task type that supports cross-departmental collaboration and unified employee experience. Universal Request becomes the parent record for departmental primary tickets, such as IT incidents and HR cases, and enables your organization to measure cross-departmental SLAs and OLAs.

The Universal Request (UR) is a task that can be created from any of the following sources.

- Requester-created: An employee uses any of following options to submit a request.
  - Clicks Request Help on the Service Portal or Employee Service Center.
  - Taps Needs Help on a mobile device.
  - Uses the virtual agent chat on the portals.
- Agent created: An IT service desk agent receives a phone call or live chat from an employee, starts a new call record or an Interaction Record, and in some cases, can create a Universal Request instead of a department ticket. The agent can then assign that UR to an appropriate Tier 1 assignment group.
- System generated: Based on configuration, a universal request is created when an employee submits a Record Producer. The Record Producer is configured to automatically create a Universal Request to enable cross-departmental request transfer and a consistent ticket view for the requester.

The following diagram shows a high-level overview of the Universal Request data model.

The Universal Request data model uses a combination of tables to store data:

- Now Platform tables
- Tables included with Universal Request

For information, see the list of Universal Request plugins.

The Task [task] table is modified to include the following fields:
• A Universal Request (UR) field points to the parent UR record. This model allows any table extending the Task table to be a child of the UR.

• Effective Number field (identifying number) stores the UR number, if the request has a UR associated with it. If it is not associated with a UR, then the Effective Number stores the current department-specific request number.

• Transfer Reason field stores the reason for the transfer of the request. The possible options are:
  
  **With resolution**
  
  Indicates that the request is completed and is transferred back to Universal Request, the specific department or service.

  **Without resolution**
  
  Indicates that the request is not completed and is transferred back to Universal Request, the specific department or service.

The Universal Request table includes:

• State reasons for the customer-facing states

• Primary ticket details of the department-specific requests

• Restricted field to indicate if the request created is sensitive or not

Universal Request also includes user roles and ACLs that customers can use to provide access to different tables. This includes both internal and external user roles.

Let’s look at the Universal Request table. The Universal Request is a new task type that is extended from the base Task [task] table and is uniquely identified by a number prefixed with **UR**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary ticket</td>
<td>References the request that is currently active under the Universal Request. For example, INC1022201.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The requester for whom the Universal Request is created.</td>
</tr>
</tbody>
</table>
| State         | Current state of the Universal Request. A UR can be in any of the following states:  
  - New 
  - In Progress 
  - Awaiting Response from user 
  - Closed  
  For more information on the UR states, see **Universal Request states and reasons**. |
| State reason  | The agent-facing reason for some requester-facing states. The state reason values are as follows:  
  **Triaging:**  
  A possible state reason when a Universal Request state is **In Progress**, and indicates that |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the Universal Request is being triaged.</td>
</tr>
<tr>
<td><strong>Primary ticket WIP:</strong></td>
<td>A possible state reason when a Universal Request state is In Progress, and indicates that the work for an active primary ticket is in progress.</td>
</tr>
<tr>
<td><strong>Confirm response:</strong></td>
<td>A possible state reason when a Universal Request state is In Progress, but the state reason changes to Confirm Response notifying the tier 1 agents to either accept or reject the response before closing the ticket for the requester. This happens when the Needs Review flag of the Universal Request is set to true.</td>
</tr>
<tr>
<td><strong>Accept Resolution:</strong></td>
<td>A possible state reason when a Universal Request is in Awaiting Response state indicating that there is a pending requestor’s action to accept the resolution provided.</td>
</tr>
<tr>
<td><strong>Action required:</strong></td>
<td>A possible state reason when a Universal Request is in Awaiting Response state that there is an additional action to be performed by the requester.</td>
</tr>
</tbody>
</table>

| Restricted | Option for restricting access to a ticket that has sensitive data. If a ticket is marked as Restricted, then only the agents with the sensitive request access can view and resolve the ticket. |

**Primary Ticket field of the Universal Request table**

The Primary Ticket field in the Universal Request determines the UR state and the requester’s ticket view experience. Use the Standard Ticket page configuration of the primary ticket to determine the content that must be displayed in various sections of a standard ticket page. The primary ticket for an UR is a departmental ticket such as an IT incident or an HR case.

**Note:** A Universal Request can have only one primary ticket at a time.

For a Universal Request that is created for the first time, no primary tickets exist. If a child department ticket, such as an IT incident or an HR case is created from the UR, then the child ticket becomes the primary ticket. If the primary ticket is transferred back to UR or to another
department, then the primary ticket field becomes empty. This sequence continues as new primary tickets are added and transferred back to UR or to another department.

When a record producer is configured to automatically create a Universal Request, then the UR becomes the parent record. And, when a department ticket is created, then that record becomes the primary ticket and remains until it is transferred back to the UR, to another department, or service.

**Universal Request roles and groups**

Users with certain roles and access can use Universal Request.

### Universal Request roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_uni_req.universal_request_read</code></td>
<td>Users with this role have read access to the Universal Request application and the related functions.</td>
</tr>
<tr>
<td><code>sn_uni_req.ur_admin</code></td>
<td>UR administrators can setup and configure Universal Request.</td>
</tr>
<tr>
<td><code>sn_uni_req.routing_agent</code></td>
<td>Users with this role can open, update, and close Universal requests. By default, the users with the <code>sn_uni_req.routing_agent</code> role alone can have Universal requests assigned to them.</td>
</tr>
<tr>
<td><code>sn_uni_req.universal_request_write</code></td>
<td>Users with this role have both read and write access to the Universal Request application and the related functions.</td>
</tr>
<tr>
<td><code>sn_uni_req.ur_service_owner</code></td>
<td>Users with this role act as the Universal Request service owner that defines the process to service the universal request.</td>
</tr>
<tr>
<td><code>sn_uni_req.sensitiveinfo_agent</code></td>
<td>Users with this role can view and work on the tickets that are marked as restricted. Restricted tickets contain sensitive information and are secured from general viewing.</td>
</tr>
</tbody>
</table>

Universal Request application provides the following default assignment groups as part of the demo data. You can customize the default groups or create your organization-specific assignment groups.

### Default assignment groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
</table>
| IT Routing group | Assignment group that consists of tier-1 agents who manage both Universal Requests and IT incidents. The agents of this assignment group have both Universal Request role and the ITIL role. Agents assigned to the IT Routing group can:
**Default assignment groups (continued)**

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Manage Universal Request.</td>
</tr>
<tr>
<td></td>
<td>• Create child IT incidents from the UR parent.</td>
</tr>
<tr>
<td>HR Routing group</td>
<td>Assignment group that consists of tier-1 agents who manage both Universal</td>
</tr>
<tr>
<td></td>
<td>Requests and HR cases. The agents of this assignment group have both Universal</td>
</tr>
<tr>
<td></td>
<td>Request role and the HR role. Agents assigned to the HR Routing group can:</td>
</tr>
<tr>
<td></td>
<td>• Manage Universal Request</td>
</tr>
<tr>
<td></td>
<td>• Create child HR cases from the UR parent.</td>
</tr>
<tr>
<td>Universal Request Routing</td>
<td>Assignment group that consists of tier 1 agents who focus primarily on</td>
</tr>
<tr>
<td>group</td>
<td>managing Universal Requests. The agents of this assignment group have</td>
</tr>
<tr>
<td></td>
<td>both Universal Request role. Agents assigned to the Universal Request Routing</td>
</tr>
<tr>
<td></td>
<td>group can:</td>
</tr>
<tr>
<td></td>
<td>• Resolve the Universal Request at the parent level.</td>
</tr>
<tr>
<td></td>
<td>• Assign the Universal Request to another assignment group, such as HR</td>
</tr>
<tr>
<td></td>
<td>routing group or IT routing group.</td>
</tr>
</tbody>
</table>

**Universal Request states and reasons**

The Universal Request (UR) state is determined by the state of the primary ticket. The primary ticket for a UR is a child department ticket, such as an IT incident or a HR case. A Universal Request can have only one primary ticket at a time.

Given are some examples of the impact of the primary ticket on UR:

- If there is no primary ticket, then the Standard Ticket configuration for UR determines requester page view of the UR ticket.
- If a child IT incident is the primary ticket of a UR, then the Incident Standard Ticket configuration determines the requester page view of the UR ticket.
- If a child HR case is the primary ticket of a UR, then the Case Standard Ticket configuration determines the requester page view of the UR ticket.

**UR states and state reasons**

The Universal Request (UR) state describes where in the life cycle the UR request is.

<table>
<thead>
<tr>
<th>States</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>The UR request is created and is ready to be triaged. This is the first state</td>
</tr>
<tr>
<td></td>
<td>in the life cycle.</td>
</tr>
</tbody>
</table>
## UR states and reasons (continued)

<table>
<thead>
<tr>
<th>States</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In progress</td>
<td>The state when the UR is being triaged and worked on. For example, the state can be In progress because of the following state reasons:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Triage</strong>: Is being triaged by the routing agent.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Primary Task - In Progress</strong>: Primary task is currently work in progress.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Confirm Response</strong>: Waiting on the routing agent’s confirmation on the resolution provided by the department agent.</td>
</tr>
<tr>
<td>Awaiting Response</td>
<td>The state when there is a user action is pending. For example, the possible state reasons are one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Action Required</strong>: When the agent has requested the user for some action or information.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Accept Resolution</strong>: When the agent has requested the requester for accepting the resolution.</td>
</tr>
<tr>
<td>Closed</td>
<td>The UR is closed.</td>
</tr>
</tbody>
</table>

### Mobile experience for Universal Request

Create universal requests from a mobile device using the Now Mobile app. Stay connected and access information in real time.

A requester can use the mobile device to create universal requests by tapping on the Get help link within the context menu of the Services tab.
The mobile experience for Universal Request provides a snapshot of the Universal Requests created in the list view along with their statuses. Tapping on the Universal Request takes you to the detailed view of the request with the updates.
Guided setup for Universal Request

Before you start using the ServiceNow® Universal Request application in your organization, you must set up Universal Request (UR). Work with your stakeholders to define requirements for setting up the application effectively to meet the needs of your organization.

Requirement
Role required: admin

Before you begin
Meet with stakeholders and determine the following requirements:
• UR workflow for your organization
• Users, groups, and roles
• Services and departments to leverage UR

What to do next
The Universal Request application provides two guided setups to configure the application on the ServiceNow instance.
• Guided setup for UR to configure the Universal Request application.
• Guided setup for Services to configure your custom departmental applications in UR.

Using guided setup
Use the Universal Request guided setup and complete tasks in sequence to configure UR and your custom departmental application in UR.

Navigate to Universal Request > Administration, open the following guided setups, and complete the tasks.
• Guided setup for UR
• Guided setup for Services

Setting up and configuring Universal Request

Set up and configure Universal Request to enable agents to create universal requests and work on them to resolve employee issues.

Universal Request plugins
Request and activate the following plugins to use Universal Request in your application.

Activate Universal Request
You can activate the Universal Request plugin (com.snc.universal_request) if you have the admin role. This plugin is not active by default, and you must install it to use the Universal Request application. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
The Universal Request plugin (com.snc.universal_request) plugin activates these related plugins if they are not already active.
Plugins for Universal Request plugin (com.snc.universal_request)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Request: Reporting</td>
<td>To create and view various Universal Request reports.</td>
</tr>
<tr>
<td>[com.snc.universal_request.reporting]</td>
<td></td>
</tr>
<tr>
<td>Agent Workspace</td>
<td>To create, view, and resolve universal requests from the Agent Workspace.</td>
</tr>
<tr>
<td>[com.agent_workspace]</td>
<td></td>
</tr>
<tr>
<td>Agent Assist Recommendation</td>
<td>To use Agent Assist recommendation in Agent Workspaces.</td>
</tr>
<tr>
<td>[com.snc.agent_recommend]</td>
<td></td>
</tr>
<tr>
<td>Universal Request Core</td>
<td>Contains the data model changes on the Task table to support the Universal Request application.</td>
</tr>
<tr>
<td>[com.snc.universal_request_core]</td>
<td></td>
</tr>
<tr>
<td>Service Catalog - Workspace</td>
<td>To use Service Catalog in Agent Workspace.</td>
</tr>
<tr>
<td>[com.glideapp.servicecatalog.workspace]</td>
<td></td>
</tr>
<tr>
<td>Service Portal - Standard Ticket</td>
<td>To enable the Standard Ticket page for your Service Portal.</td>
</tr>
<tr>
<td>[com.glideapp.servicecatalog.standard_ticket]</td>
<td></td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

⚠️ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference

List of plugins (Quebec)

Components installed with Universal Request

Several types of components are installed with activation of the Universal Request plugin, including tables, user roles, and scheduled jobs.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing Agent [sn_uni_req.routing_agent]</td>
<td>Responsible for initial triaging of the universal requests and routing them to</td>
<td>• sn_uni_req.universal_request_write</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Universal Request read</td>
<td>Access to view the Universal Request records.</td>
<td>• None</td>
</tr>
<tr>
<td>[sn_uni_req.universal_request_read]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Request write</td>
<td>Access to create or update the universal request in the application.</td>
<td>• sn_uni_req.universal_request_read</td>
</tr>
<tr>
<td>[sn_uni_req.universal_request_write]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Request admin</td>
<td>View the configuration of the Universal Request application.</td>
<td>• sn_uni_req.routing_agent</td>
</tr>
<tr>
<td>[sn_uni_req.ur_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Request Service Owner</td>
<td>Access the process overview reports of the Universal Request application.</td>
<td>None</td>
</tr>
<tr>
<td>[sn_uni_req.ur_service_owner]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Request SensitiveInfo Agent</td>
<td>View and work on the tickets that are marked as <strong>Restricted</strong>. Restricted tickets contain sensitive information and are secured from general viewing.</td>
<td>None</td>
</tr>
<tr>
<td>[sn_uni_req.sensitiveinfo_agent]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
Only users with this role can have universal requests assigned to them.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Request [universal_request]</td>
<td>Stores the Universal Request records and the state reasons.</td>
</tr>
<tr>
<td>Transfer Configuration [universal_request_route_conf]</td>
<td>Holds the routing configuration that is used when the task is routed.</td>
</tr>
</tbody>
</table>
Activate Universal Request: Advanced Work Assignment

You can activate the Universal Request: Advanced Work Assignment plugin (com.snc.universal_request.awa) if you have the admin role. Activating this plugin enables you to use Advanced Work Assignment and automatically assign work items to your agents, based on their availability in the Universal Request application. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin

Note: The Universal Request: Advanced Work Assignment plugin (com.snc.universal_request.awa) plugin requires a separate subscription and must be activated by a ServiceNow personnel.

Before installing the Universal Request: Advanced Work Assignment plugin (com.snc.universal_request.awa) plugin, install the Universal Request plugin. For more information, see Activate Universal Request.

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference

List of plugins (Quebec)
Activate Universal Request: Integration for Incident management

You can activate the Universal Request: Integration for Incident management plugin (com.snc.incident.universal_request) if you have the admin role. Activating this plugin enables ServiceNow Incident Management application integration with Universal Request. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Before installing the Universal Request Integration for Incident management (com.snc.incident.universal_request) plugin, install the Universal Request plugin.
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference
List of plugins (Quebec)

Activate Universal Request: NLU Model for Virtual Agent Conversations

You can activate the Universal Request: NLU Model for Virtual Agent Conversations plugin (com.snc.universal_request.nlu) if you have the admin role. Activating this plugin allows you to use NLU for virtual agent conversations in Universal Request. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin

   Note: The Universal Request: NLU Model for Virtual Agent Conversations plugin (com.snc.universal_request.nlu) plugin requires a separate subscription and must be activated by a ServiceNow personnel.

Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Activate Universal Request: Reporting

You can activate the Universal Request: Reporting plugin (com.snc.universal_request.reporting) if you have the admin role. Activate this plugin to use reports in Universal Request. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Activate Universal Request: Virtual Agent Conversations

You can activate the Universal Request: Virtual Agent Conversations plugin (com.snc.universal_request.va) if you have the admin role. Activate this plugin to set up and use Virtual Agent in Universal Request. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin

   Note: The Universal Request: Virtual Agent Conversations plugin (com.snc.universal_request.va) plugin requires a separate subscription and must be activated by a ServiceNow personnel.

Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Activate Predictive Intelligence for Universal Request

You can activate the Predictive Intelligence for Universal Request plugin (com.snc.universal_request.ml) to use machine-learning solutions in the Universal Request application, if you have the admin role. The application includes demo data and installs related applications and plugins if they are not already installed.

Before you begin

Note: The Predictive Intelligence for Universal Request plugin (com.snc.universal_request.ml) plugin requires a separate subscription and must be activated by a ServiceNow personnel.

- Predictive Intelligence for Universal Request requires the following plugins. Ensure that these plugins are activated before you install this plugin.

  Required ServiceNow plugins

  Predictive Intelligence

  Install this plugin to enable the creation of machine learning solutions using data in your instance. The plugin provides various capabilities and solution types for training the system to predict, recommend, and drive data outcomes. A trained solution can be invoked by any application through the use of a prediction API.

  Universal Request

  Install this plugin to use the Universal Request application.

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Predictive Intelligence for Universal Request plugin (com.snc.universal_request.ml) using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Configuring Universal Request

Set up the Universal Request features, components, and integrations that you need to set up your organization to provide service and support to your employees and agents.

Understand the given information before you set up and configure to use Universal Request.

Universal Request application uses HTML mark-up to render comments that are copied between UR and the child tickets. This feature uses [CODE] tags, which are controlled by the glide.ui.security.allow_codetag property value that is set to true by default. If you change this property value to false, comments may not render properly, and HTML tags might appear in your comments.
Configure users and groups

A user is an individual who can access your instance and a group is a set of users who share a common purpose. The users associated with a group are listed as group members.

Before you begin
Role required: admin

About this task
Group information is used across most processes in the Now Platform for assigning work to teams and requesting approvals. Any rule that is applied to a UR group is automatically assigned to all the group members, for example, roles and assignment rules.

Procedure

• You can import existing users and groups using guided setup.

• You can create new users and groups using the Now Platform user administration feature.
  ◦ Create a user
  ◦ Create a user group
  ◦ Add a user to a group

Assign roles to UR users

Roles control access to features, capabilities, and data in the Universal Request application.

Before you begin
Role required: admin
Before you can assign roles to your users, make sure that users and groups have already been configured. For more information, see Configure users and groups.

About this task
You can assign roles to individual users or groups. Apply roles to groups and the members of those groups inherit those roles. Universal Request application provides a list of default roles and groups that can be used by your organization. For more information, see Universal Request roles and groups.

Procedure

• You can assign roles to users and groups using guided setup.

• You can also assign roles to users and groups using the Now Platform user administration feature.
  ◦ Assign a role to a user
  ◦ Assign a role to a group

Service Level Agreement configuration for Universal Request

View, modify, or create Service Level Agreement (SLA) definitions that is provided for the Universal Request application to make sure that the requests are closed within a defined time frame.

Before you begin
Role required: admin

About this task
The SLA definitions created for the Universal Request are for the UR and does not depend on the SLAs defined for the individual child tasks of the specific departments.
Procedure
1. Navigate to Service Level Management > SLA > SLA definitions.
   List of all the SLA definitions available is displayed.
2. Click New to create an SLA definition for your tasks.
3. On the form, fill the fields.
   For field descriptions and detailed instructions, see Create an SLA definition.

Results
The SLA definition is created for the specified task table.

Transfer configuration
You can enable agents to transfer department-specific tickets, such as an incident ticket or an HR case back to the Universal Request (UR), to another department, or service. This transfer configuration allows you to determine what happens to the departmental ticket when the request is transferred to another department or back to UR.

Before you begin
Role required: admin

About this task
The transfer configuration has the following two main configurations.

   Transfer Information
   Determines the state and template to apply on the department ticket when a department ticket is transferred.

   Closure Information
   Determines the final closure state and template to apply on the department ticket associated with a UR that is closed.

When you transfer a department ticket, you can transfer it with one of the following reasons:

   Transfer with resolution
   When the request is resolved and transferred back to UR, to the specific department, or service.

   Transfer without resolution
   When the request is not resolved or does not belong to the specific department and is transferred back to UR, to the specific department, or service.

For example, if an incident ticket is transferred without resolution, in the Transfer Information tab, you can configure the Transfer state as Canceled. In the Closure Information tab, you can configure the closed state of the incident ticket when the UR is closed.

To perform this transfer action, you must configure the transfer configuration details in the Universal Request application.
Procedure

1. Navigate to Universal Request > Administration > Transfer Configuration.
2. Open and edit an existing configuration or click **New** for a new configuration record.
3. On the form, fill in the fields. For more information on the field descriptions, see **Transfer configuration form**.

Configure Chat queues

Configure chat queues to enable users to communicate with the agents for assistance on their request.

You can configure chat queues using one of the given options.

- Advanced Work Assignment for agent workspace
- Connect Chat support

By default, a sample Universal Request Chat Queue is available for both the options. You can create your own queue or customize the default queue.

Configure Advanced Work Assignment chat queue

Create or modify the default chat queue for UR in Advanced Work Assignment automatically assign work items to your agents, based on their availability.

**Before you begin**

Role required: admin

Ensure that you have activated the Agent Chat (com.glide.interaction.awa) plugin.

Procedure

1. Navigate to **Advanced Work Assignment > Queues**.
2. Perform any of the following task.
   - Open the **Universal Request Chat Queue** chat queue and modify it
   - Create the **Assignment Eligibility** record for the chat queue modifying the application provided Universal Request assignment rule.
   - Click **New** to create a new record.
For more information, see Advanced Work Assignment.

3. Click Submit.

Configure Connect chat support queue
Connect Support is a real-time messaging tool that enables support agents to easily track their support cases, find solutions, and resolve problems quickly.

Before you begin
Role required: admin

Procedure
1. Navigate to Connect > Support Administration > Queues.
2. Click New or open the default Universal Request Chat queue.
3. On the form, update or fill in the details. For more information, see Administer Connect Support queues topic on the product documentation site.
4. Click Submit.

Predictive Intelligence for Universal Request
The Predictive Intelligence for Universal Request uses machine-learning algorithms for the auto-assignment of universal requests and to find similar knowledge articles and closed universal requests.

Predictive Intelligence for Universal Request has the following benefits:
- Use of machine learning algorithms to predict the assignment group across various departments based on the data provided by the requester in the short description and description fields of the request.
- Use of machine learning similarity solution to provide recommendations for similar Knowledge Base articles and similar closed Universal Requests. These recommendations are based on the data provided in the short description and description fields of the request, and help agents to resolve universal requests quickly.

Solution definitions for Predictive Intelligence for Universal Request
The solution definition for Predictive Intelligence for Universal Request is available when you activate the Predictive Intelligence plugin (com.glide.platform_ml). You can customize the solution to meet your business requirements.

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Request Categorization</td>
<td>Classification</td>
<td>Predicts the assignment group from the short description and description of a Universal Request.</td>
</tr>
<tr>
<td>Similar Knowledge Articles for UR</td>
<td>Similarity</td>
<td>Predicts similar knowledge base articles based on the short description and description of a Universal Request.</td>
</tr>
<tr>
<td>Similar closed Universal Request</td>
<td>Similarity</td>
<td>Predicts closed Universal Requests that have similar</td>
</tr>
</tbody>
</table>
Train the classification solution for Universal Request

Train the Universal Request Classification solution definition to identify and predict an assignment group using the short description. When an employee or agent logs a universal request, the request gets routed to the machine-learning solution to predict the assignment group.

**Before you begin**
Role required: admin
Ensure that you have installed the Predictive Intelligence (com.glide.platform_ml) plugin.
Set the Enable universal request auto categorization property to true by navigating to **Universal Request > Administration > Properties**. Enabling this property enables the application to use the **Universal Request Classification solution** for UR.

ℹ️ **Note:** A minimum of ten thousand closed records are needed to train this solution.

**Other Properties**

Enable service transition comments while creating department requests from Universal Request
- Yes | No

Enable universal request auto categorization
- Yes | No

### Procedure

1. Navigate to **Predictive Intelligence > Classification > Solution Definitions**.
2. In the Classification Definitions list, search for and select the Universal Request Categorization (ml_universal_request_categorization) solution.
3. On the form, verify the default field values and customize the solution as required. For more information about the Classification Definition form fields, see **Create and train classification solution**.

Train the similarity solution for similar knowledge articles

Train the Similar Knowledge articles for UR solution definition to identify and predict knowledge articles using the short description. When an agent opens a universal request, similar knowledge articles are displayed in the Related Search section of the Universal Request record.

**Before you begin**
Role required: admin

ℹ️ **Note:** A minimum of ten thousand closed records are needed to train this solution.
Procedure

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.

2. In the Similarity Definitions list, search for and select the Similar Knowledge articles for UR (ml_sn_sn_uni_req_global_similar_knowledge-articles-for-ur) solution.

3. On the form, verify the default field values and customize the solution as required. For more information about the Similarity Definition form fields, see Create and train a similarity solution.

Train the similarity solution for similar closed Universal Requests

Train the Similar Closed Universal Request solution definition to identify and predict similar Universal Requests that are closed based on the short description, description, and the assignment group of the Universal Request created. When an agent opens a universal request, similar closed universal requests can be searched in the Related Search section of the Universal Request record.

Before you begin

Role required: admin or sn_un_req.ur_admin
This solution is available only if you enable the Enable to view similar closed Universal Request recommendations (sn_uni_req.similar_closed_universal_request) property. For more information on this property, see Universal Request properties.

Note: A minimum of ten thousand closed records are needed to train this solution.

Procedure

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.

2. In the Similarity Definitions list, search for and select the Similar Closed Universal Request (ml_x_snc_sn_uni_req_global_similar_closed_universal_request) solution.

3. On the form, verify the default field values and customize the solution as required. For more information about the Similarity Definition form fields, see Create and train a similarity solution.

Set up Virtual Agent for Universal Request

Use Virtual Agent (VA) capabilities to provide a better user experience for your chat channel using the natural language understanding model. You can view and modify the default Virtual Agent topic for Universal Request or create your own topics to use during the chat bot conversations.

Before you begin

Role required: admin

About this task

To use VA capabilities, you must activate the following plugins:

- Universal Request: Virtual Agent Conversations (com.snc.universal_request.va) plugin - To set up and use Virtual Agent in Universal Request. This plugin installs a default Employee Help Request topic that must be made active. By default, the topic is set to inactive.

- Universal Request: NLU Model for Virtual Agent Conversations (com.snc.universal_request.nlu) plugin - To set up and use Natural Language Understanding (NLU) model for Virtual Agent conversations.

For more information, see Create a Virtual Agent topic
Procedure

1. Navigate to Collaboration > Virtual Agent > Designer.

2. Search for Employee Help Request topic in the Search field.

3. Click on the Employee Help Request topic to open.

4. On the header section, click Active and then click Publish. This makes the topic available and active in the chat window.

Enable NLU model for Universal Request topic

Apply the Natural Language Understanding vocabulary in the Universal Request application to help the system to better understand human-expressed language.

Before you begin
Role required: admin

To use the Universal Request topic for your chat bot conversations, select and enable the NLU model.

Procedure

1. Navigate to Collaboration > Virtual Agent > General Settings.

2. On the NLU Settings tab, click Enable NLU in Virtual Agent to make it active.

3. Select ServiceNow NLU in the NLU service provider drop down list.

4. Click Save.

Standard Ticket page for Universal Request

The Universal Request (UR) standard ticket page enables requesters to view the details of their universal requests from the Service Portal.

A requester can view the aggregated and simplified view of the UR activity and all activities from one or more child department tickets (primary tickets). Using the UR standard ticket page has the following advantages:

- A ticket reference number (UR number) that is always consistent for the requester, even when the request is transferred between various departments.
- The UR state details that is derived from the mapping between the UR states and the states of the primary ticket associated with UR. With this state mapping enabled, the requester sees only the UR state.
• An activity stream that shows a logical and sequential record of comments to and from any fulfiller who worked on the UR or its primary tickets.

• An info region that displays department-specific fields of the current primary ticket. For example, configure the page to show Opened For and Subject Person fields from a child HR case or to show Caller and Urgency fields from a child IT incident.

The Standard ticket page configuration for UR tickets enables you to determine what you want to display as a view. By default, a Universal Request Standard Ticket configuration is available that you can use and customize. Information displayed in different sections of a standard ticket page depends on the individual request type.

Note: If you are upgrading from a previous release and want to use the Standard Ticket page for your department, ensure that you enable the Page Route map in Service Portal. For more information, see Enable the page route map for standard ticket page.
<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Header section</td>
<td>Displays the information submitted for the Universal Request record, such as the UR request number, created and updated details of the request, and the current status. This section is not a configurable section. <strong>Updated</strong> field displays the details of the last activity time of the primary ticket if it exists. If there is no primary ticket attached, the <strong>Updated</strong> field displays the last activity time of the Universal Request.</td>
</tr>
<tr>
<td>2</td>
<td>Number</td>
<td>Displays the unique UR number that identifies the request.</td>
</tr>
<tr>
<td>3</td>
<td>State</td>
<td>Shows the state of the Universal Request.</td>
</tr>
<tr>
<td>4</td>
<td>Short Description</td>
<td>Always displays the short description of the Universal Request submitted.</td>
</tr>
<tr>
<td>5</td>
<td>Actions region</td>
<td>Actions that are configured as part of the primary ticket page. If the primary ticket does not exist, then the default actions of the Universal Request are displayed.</td>
</tr>
<tr>
<td>6</td>
<td>Info region</td>
<td>Configurable fields that are part of the primary ticket. If the primary ticket does not exist, then the default fields configured for Universal Request are displayed.</td>
</tr>
<tr>
<td>7</td>
<td>Tabs section</td>
<td>Tabs that are configured as part of the primary ticket page. If the primary ticket does not exist, then the default tabs, such as the <strong>Activity</strong> and <strong>Attachments</strong> are displayed.</td>
</tr>
<tr>
<td>9</td>
<td>Activity stream</td>
<td>Displays the activity and attachments from UR, and all the previously associated primary tickets in a sequential order.</td>
</tr>
</tbody>
</table>

When a routing agent chooses not to share additional comments or attachments while routing, a system-generated message is displayed in the header and in the activity stream. However, the requester can view all comments in the activity stream.

When a user clicks to view the Standard Ticket page from a department ticket that was previously a primary ticket of the UR, then the Standard Ticket configuration validates and displays a message asking the user to open the latest page that displays only the activity streams and attachments. The following image displays the message containing a link to open the latest activity stream.
Related information

Configure Standard Ticket page for Universal Request

Configure Standard Ticket page for Universal Request

Use the Standard ticket page configuration for Universal Request to provide a consistent layout across all tickets raised and associated.

Before you begin
Role required: admin
By default, a standard ticket configuration is provided for UR. You can customize the layout or create a new ticket layout as per your organizational requirements.

Procedure

1. Navigate to **Standard Ticket > Standard Ticket Configuration**.
   A list of default ticket configurations is displayed.
2. Click and open **universal request** configuration.
3. Click the link **here** that appears in the message displayed to edit the record.
4. Modify the form field as per your requirements.
5. Click **Update**.
6. **Optional**: Click **New** to create your custom configuration. For more information, see **Standard ticket page**.

Configure service to use Universal Request

Configure the Universal Request application with any service to manage requests across multiple services under one unified request. Using Universal Request integrated with your service helps deliver a seamless employee experience in your organization.

Create a service set

Create your service set (department) name in the Universal Request (UR) application to use the UR capabilities for a specific service set in your organization. Service sets are the various departments in your organization.

Before you begin
Role required: admin
Your organisation must have one service set without any services that is marked as a Universal Set. The Universal Set acts as the default department that receives new Universal
Requests that are not routed to a specific department. This service set makes sure that when a UR is created it is assigned to the assignment group of the service set under one of the following conditions.

- A UR is created from Request Help with no department selected. For example, when an employee creates a UR from Request Help with no department selected and when the automatic assignment is not suggested by the ML routing algorithm, then the UR is assigned to the Service Set that is marked as Universal Set.

- When a UR is transferred with the I’m not sure option. For example, when a UR is transferred by a department agent, and the agent is unsure of the department to transfer the request to, the agent can select I’m not sure in the department field. In this case, the UR is routed to the Service Set that is marked as the Universal Set.

Note: You can have only one service set marked as a Universal Set for your organization.

Procedure
1. Navigate to Universal Request > Administration > Service Sets.
2. Click New.
3. Enter your service specific department name.
4. Select the Universal Set check box. If this check box is selected, the new service set is considered as a Universal Set.
5. Click Submit.

Create your service-specific assignment groups
Set up your service-specific groups and assign the necessary roles and users. The users in the group inherit the roles of the group, so you do not have to assign roles to each user separately.

Before you begin
Role required: admin

About this task
Here are a few good practices for creating groups:

- Create one group for administrators and assign the admin role to this group only.
- Create as many groups as needed in your organization. For example, you can create a HR department specific assignment group or IT specific group. Assign the necessary users to those groups, and then assign the staff role to those groups.

Procedure
1. Navigate to User Administration > Groups.
2. Click New.
3. On the form, fill in the fields. For more information, see Create a user group
4. Click the lock icon beside the Type field. If the field is not visible, configure the form to add it.
   The Type field expands.
5. Click the reference lookup icon and select the [application] type.
6. Right-click the form header and select Save.
7. Add the roles to the **Roles** related list.
8. Add users to the **Group Member**’s related list.
9. Click **Update**.

**Assign assignment group to service sets**

After creating your service-specific assignment groups, assign them to the service sets. Assigning assignment groups to the various departmental service sets facilitates in automatically routing universal requests to the right agents (assignment group) within a specific department (service set).

**Before you begin**
Role required: admin

**About this task**
Also, after triaging, agents can also transfer universal requests and department tickets to the appropriate agents (assignment group) within a specific department (service set).

**Procedure**
1. Navigate to **Universal Request > Administration > Service Set Assignment Groups**.
2. Select the **Service Set** from the look-up list.
3. Select the **Assignment Group** for the service set.
4. Click **Submit**.

**Create your service for Universal Request**

Register your service name for your service specific table and associate it with a service set (department) to use the Universal Request capabilities for a specific service in your organization.

**Before you begin**
Role required: admin

**About this task**
Service categorizes the application according to the area of the work within the service set (department) in the organization.

**Note:** By default, HR cases and IT incidents are configured as services in the Universal Request application. This step can be ignored.

**Procedure**
1. Navigate to **Universal Request > Administration > Service Configuration**.
2. Click **New** to register your service.
3. On the form, enter the **Service Name**.
4. Select the **Service Table** from the list of available tables.
5. Select the **Service Set** from the list of available service sets registered for your organization.
6. Click **Submit**.

**Assign assignment group to your service**

After creating the services for your service set (department), assign the assignment groups to the services in the service sets to enable agents to transfer tickets to the appropriate routing group.
Before you begin
Role required: admin

About this task
Assigning assignment groups to the various departmental service sets facilitates in automatically routing universal requests to the right agents (assignment group) within a specific department (service set). Also, after triaging, agents can also transfer universal requests and department tickets to the appropriate agents (assignment group) within a specific department (service set).

Procedure
1. Navigate to **Universal Request > Administration > Service Assignment Groups**.
2. Select the **Assignment Group** for the service set.
3. Select the **Service** from the look-up list.
4. Click **Submit**.

Create service specific UI actions
Create a UI action or modify an existing one to enable your service to create department tickets under a universal request.

Before you begin
Role required: admin
Administrators and users with the ui_action_admin role can define UI actions.

About this task
For example, consider a scenario when a Tier 1 agent of a service department receives a universal request, and is not able to resolve it. The agent escalates the request to another department or to an agent within the same department. In this case, the Tier 1 agent uses the **Create case** or similarly labeled action to create a new case within the service (department). This case can then be routed to the appropriate assignment group for resolution.

To perform this action, you must create a UI action for your service.

Procedure
1. Navigate to **System Definition > UI Actions**.
   A list of all UI actions specific to Universal Request table appears.
2. Click **New** or open an existing record.
   
   ✨ **Note:** For a new UI action, ensure that you always select the Universal Request table.
3. On the form, fill in the fields to define the UI action. For more information, see Create a UI action

Register application administration enabled scoped application
If your application is an application admin enabled scoped application, register the application with Universal Request to make your application’s service and service set data available for the Universal Request application to work.

Before you begin
Role required: admin
About this task
After you configure your service, you must perform these steps and create the following ACL-inheritance entries. This enables Universal Request to use your application’s service and service set data.

Only UR administrator [sn_uni_req.ur_admin] can assign scoped UR roles.

To configure your system, you must log in as a System Administrator [admin]. The UR Administrator [sn_uni_req.ur_admin] role is contained in the System Administrator [admin] role. The combination of these two roles allows a user to perform all tasks associated with configuring your system.

After system configuration, ensure that only the UR Administrator [sn_uni_req.ur_admin] role has access to sensitive information. Remove the UR Administrator role from System Administrator [admin] role to prevent the System Administrator from viewing sensitive UR information. For more information, see Remove UR administrator role from system administrator.

After granting access, define the sn_uni_req.min_admin_count property in the system properties for UR to ensure that a minimum number of scoped administrators exist and the application is not locked out in one administrators absence.

Procedure
1. In the navigation panel, enter sysScopedAdminAclInheritance.list.
2. In the Application Administration ACL Inheritance page, click New.
3. Select Service Set from the Table drop-down list.
4. Check that the Application is your scoped application.
5. Click Submit.
   Creates an ACL inheritance record for the service set table in your scoped application.
6. In the Application Administration ACL Inheritance page, click New again.
7. Select Service Configuration from the Table drop-down list.
8. Check that the Application is your scoped application.
9. Click Submit.
   Creates an ACL inheritance record for the service configuration table in your scoped application.

Remove UR administrator role from system administrator
To secure your information from undue access, after system configuration, ensure that only the Universal Request (UR) administrator [sn_uni_req.ur_admin] role has access to sensitive information.

Before you begin
Role required: admin with sn_uni_req.ur_admin

About this task
By default, a System Administrator also has a UR admin role and can access the UR information. Add UR Admin role to specific users who would work on the UR configuration for their respective services. The user with this role can make another user a UR admin based on the roles and responsibilities. After this step is complete, to secure your application, remove the UR administrator role [sn_uni_req.ur_admin] from the System Administrator [admin] role.

By doing so, you prevent the user with a default System Administrator [admin] role from viewing all the Universal Request information.
Ensure that you have at least two users with the UR administrator role. If you assign only one person with the role and that person is deactivated, you no longer will have a user that can perform the UR admin duties.

Also, ensure that the same users have the System Administrator [admin] role to access the UR modules.

**Procedure**

1. Log in as admin.
2. From **User Administration**, go to **Roles** (left navigation menu).
3. Click **admin**.
4. On the **Contains Roles** tab, click **Edit**.

   **Note:** If you do not see the **Edit** button, change the **Application** scope to **Global**.

5. From the **Contains Roles List** column, highlight and move **sn_uni_req.ur_admin** to the **Collection** column.
6. Click **Save**.
7. Log out.

**Create a business rule for your service**

Create a business rule on the service table to attach the newly created department ticket with a universal request.

**Before you begin**

Role required: admin

**About this task**

You can create a business rule for your service for any of the following reasons.

- Provide a unified and simplified ticketing experience for your requester by configuring UR creation from all channels.
- Enable agents to transfer the primary ticket to other departments if the original request was initially sent to the wrong department by the requester.
- Facilitate cross-departmental reporting on the overall SLA if the ticket is transferred between departments.

**Procedure**

1. Navigate to **System Definition > Business Rules**.
2. Click **New**.
3. In the **Name** field, enter your business rule name.
4. Select your service table from the **Table** list.
5. Select **Advanced**.
6. On the **When to run** tab, in the **When** condition select **after** and select the **insert** check box. This action specifies that the business rules should run after the insert or update.
7. On the **Advanced** tab, add your condition. For example, add the below condition in the **Condition** field.

```plaintext
!current.universal_request.nil() && current.universal_request.primary_task.nil()
```
8. Enter the script in the **Script** field that you want to run when the defined condition is true. For example, add the below script to attach the service ticket as a primary ticket for UR.

```javascript
(function executeRule(current, previous /*null when async*/) {
    var urUtilsApi = new sn_uni_req.UniversalRequestUtils();
    urUtilsApi.attachPrimaryTicket(current.universal_request, current.getUniqueValue(), null, true);
})(current, previous);
```

9. Click **Update**. For more information on other fields of this form, see Create a business rule.

### Create extension points for departments

Create a scripted extension point to create your department specific primary ticket during cross-department ticket transfers. Using extension point enables you to create a primary ticket type as per the extension point definition.

**Before you begin**

- **Role required:** admin

**About this task**

When configuring your department for **Universal Request**, to use transfer to other department capability, create scripted extension points and add them to the script includes of the application code. A sample **CreateDepartmentTicket** extension point is provided for you to modify and use.

**Procedure**

1. Navigate to **System Extension Points > Scripted Extension Points**.
2. Search for **sn-uni_req.CreateDepartmentTicket**.
3. On the form banner, click the link **here** to edit the record.
4. Click **Create Implementation** in the related list to create your department specific extension point script. For more information, see Using extension points to extend application functionality.

### Unified ticket experience setting

Set up your service to provide your employees with a unified and consistent ticket experience. This setup automatically creates a universal request when requests are raised from an interaction record, email, or record producer.

You can customise and configure to automatically create universal request for a task from various channels using APIs provided with the **Universal Request** application. For more information, see UniversalRequestUtilsSNC API.

Universal Request application supports the creation of universal request from an interaction record in the **Agent Workspace**. For more information, see Create universal request automatically for department tickets via other channels.

Modifying email notification preferences helps in controlling the outbound email actions. For more information, see Email notification preferences for your service.

Configure your service record producer to create universal request from a request raised from the record producer. For more information, see Configure a record producer to support the universal request framework.

### Create universal request automatically for department tickets via other channels

Universal request is not automatically created when a fulfills or employee creates a department ticket from channels other than the **Service Portal** or **Virtual Agent** topics. Create universal request automatically by adding the business rule to the specific service table, such as an **Incident** or **HR** service.
Before you begin
Role required: admin

About this task
The universal request created by using a business rule, is then automatically associated to the department ticket, such as an Incident or a HR case created in that table. You may want to automatically create universal request in the following scenarios.

- To provide a consistent user experience when viewing the UR ticket.
- Transfer the department ticket at any time, as UR is already associated with the ticket.
- Use cross-departmental SLA/OLA reporting for the UR, the department ticket, and any other tasks associated with the parent UR.

You can achieve this by creating a business rule using the Universal Request API. For more information, see UniversalRequestUtilsSNC API.

Follow the given steps to enable create universal request automatically from an interaction record.

Procedure
1. Modify the UI action of the department ticket to pass the URL parameter that is retrieved from the client script.
2. Create an AJAX script include to set the data in the glide session.
3. Create an onSubmit() client script to fetch the URL parameter. For more information, see Client scripts
4. Set the URL parameter and the sys_id to the glide session using the AJAX script include.
5. Create a before insert business rule on the department ticket and retrieve the data from the glide session.
6. Create universal request record using the UniversalRequestUtils API and attach the universal request to the task.

Email notification preferences for your service
Customize email notifications to control which email notifications are sent to requesters when a universal request is created. This setting prevents employees from receiving duplicate or inconsistent email notifications.

Before you begin
Role required: admin
About this task
Set up your notification preferences, so that the communications to the requester come from the Universal Request instead of the department ticket, and the links in the communications link back to the Universal Request instead of the department ticket.

Email notifications are usually sent when one of the following activities is performed:

- A universal request is created for a requester.
- Comments are added to the request.
- Resolution is provided for the request.
- Request is closed.

Suppress outbound notifications for services leveraging Universal Request

Configure outbound email notifications to define what emails a requester must receive when a universal request is created. For example, if your service (department) ticket is associated with a universal request, you can customize the notifications to send only the emails that are relevant to the requester. Service emails, such as, service ticket creation, notes or state changes, can be suppressed from being distributed.

Before you begin
Role required: admin

Procedure

1. Navigate to System Notification > Notifications.

2. Open your service specific notification that you want to customize.

3. In the When to send tab, under the condition builder, add a new condition step as shown.

4. Click Update.
Use effective number in email subject

Modify the email subject to display the relevant ticket number by using the task effective number. For example, if your service ticket is associated with a universal request, then you must mask the service ticket number and show the UR number.

Before you begin
Role required: admin

About this task
The task_effective_number is a dynamic field value that displays the UR number when the service ticket is associated with UR and displays the actual service ticket number when there is no UR associated.

Procedure
1. Navigate to System Notification > Notifications.
2. Open your service specific notification that you want to customize.
3. In the When it will contain tab, in the Subject field use the task_effective_number. For example, in the Incident Opened and Unassigned notification, in the Subject field, enter Incident ${task_effective_number} - open and unassigned.
4. Click Update.

Configure a record producer to support the universal request framework
Create a seamless flow between a task-based record and universal request created from a record producer.

Before you begin
Role required: admin

About this task
You should activate the Universal Request plugin (com.snc.universal_request). This plugin adds the following:
The following fields to the Catalog Item[sc_cat_item] table
- Requires Additional Review
- Create Universal Request

The **Universal Request Config** section to a record producer

For information on creating a record producer, see Create a record producer.

**Procedure**

1. Navigate to **Service Catalog > Catalog Definitions > Record Producers**.
2. Select the required record producer.
3. In the Record Producer form, configure these fields in the **Universal Request Config** section.

### Universal Request Config section in the Record Producer form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create Universal Request | Option to specify that a universal request should also be created along with the task-based record. It creates a record in the Universal Request [universal_request] table along with the task-extended table. In the task-based record, the **Universal Request** field is displayed with the corresponding universal request number. Similarly, in the universal request, a reference is created to the associated task-based record, which becomes the primary task of the universal request. This field is not available:  
  - When the record producer is not based on a task-extended table.  
  - For any record producer configured on the Universal Request [universal_request] table. For example, the Request Help record producer. |
| Requires Additional Review | Option to specify that a universal request can be closed only after a Universal Request routing agent accepts the resolution provided in the task-based record. However, even if this check box is selected, a requester can close the universal request without any review from the Universal Request routing agent.  
When this check box is selected, the **Needs resolution review** check box is automatically selected on the corresponding universal request.  
**Note:** The **Requires Additional Review** field appears only when the **Create Universal Request** check box is selected. |

4. Click **Update**.

**Universal Request state mapping**

All workflows consist of states, transitions, and reasons. Map your service-specific states to the Universal Request states to provide a better user experience during request state transition.

**Before you begin**

Role required: admin

**About this task**

For example, consider a universal request that has an HR payroll case attached to it as a primary task. When the HR case state changes from **In-progress** to **Awaiting Acceptance**, then the universal request state is updated to **Awaiting Response From User**.
By mapping the states of the service to the UR state, it is ensured that the correct state of UR is displayed. The state transition of the primary ticket is hidden from the requester and they only see the simplified UR state transitions that are driven by the state mappings. The following table describes the universal request states and the suggested mappings.

<table>
<thead>
<tr>
<th>Primary ticket status</th>
<th>UR State</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a UR is created and there is no primary ticket</td>
<td>New</td>
</tr>
<tr>
<td>All states when a ticket is being worked upon, like WIP, awaiting approval</td>
<td>In progress</td>
</tr>
<tr>
<td>All states that require response from a requester</td>
<td>Awaiting response</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to Universal Request > Administration > State Mapping.
2. Click New.
3. On the form, fill in the fields. For more information on the field description, see State mapping form.

**Using Universal Request**

Agents and managers can use the Universal Request application to create requests, manage information and security, and connect with other departments and services to assist with request resolution.

**Create Universal Request**

Create a universal request record on behalf of the requester from the Universal Request application.
Before you begin
Role required: sn_uni_req.routing_agent or admin

Procedure
1. Navigate to Universal Request > Create New.
2. On the form, fill in the fields. For more information on the field description, see Universal Request form.
3. Click Submit.

View universal requests with primary ticket
A universal request can have multiple child requests, such as an IT ticket or an HR case. An active child request is called the primary ticket. At a given time, a universal request can have only one primary ticket.

Before you begin
Role required: admin, itil, or routing agents
To view the universal request with an active primary ticket, do the following.

Procedure
1. Navigate to Universal Request > With Primary Ticket.
   A list all universal requests that have a primary ticket is displayed
2. Open and view the universal request you want to work on.

Universal Request sensitive information security
Universal Request provides the ability to flag a request that has sensitive information and should be restricted to most agents.

Key advantages
• Requester can mark the request as sensitive at the time of creating the universal request.
• Routing agents without Sensitive Info Agent role can mark the universal request as restricted while triaging
• A Sensitive Info routing agent from the current assignment group can mark the universal request restricted or unrestricted. For more information.
• The primary ticket agent can mark the universal request as restricted or unrestricted.
• When a restricted universal request is created or transferred, only a sensitive info routing agent from the current assignment group, or the primary ticket agent can view the complete details of the ticket.
• When a ticket is transferred, the above rules are evaluated in context of new assignment group and new primary ticket.

Sensitive Info Agent role
The sn_uni_req.sensitiveinfo_agent role controls who views and acts on the details of universal requests with sensitive information. The following agents will be able to see restricted details for Universal Request records flagged with sensitive information.
• If the UR is not assigned and has no primary ticket associated, agents with the sn_uni_req.sensitiveinfo_agent role can see the UR, irrespective of their department.

• If the UR is assigned to an assignment group and has no primary ticket associated, only the agents belonging to that assignment group with the sn_uni_req.sensitiveinfo_agent role can see the UR.

• If the UR has a primary ticket associated, all primary ticket agents can view the primary ticket and the UR, even without the sn_uni_req.sensitiveinfo_agent role.

For example, if an HR case (primary ticket) is created for a universal request, then only the HR routing agent with the sn_uni_req.sensitiveinfo_agent role, or the HR case agent can view the complete details of the request, such as the short description, description, attachments, and comments.

An agent without the sensitive agent role can access only the primary information of the request. The secured fields (short description, description), attachments, and comments in the activity stream are hidden.

Application Administration enabled scoped application

Universal Request is an Application administration enabled application. If you are configuring your service that is also an application administration enabled application or has its own security modal, then you must register your application. For more information, see Register application administration enabled scoped application. This ensures that the security is maintained within the universal request.

Raising a sensitive universal request from the portal

When requesters create a request using the Request Help option on the Service Portal, Employee Service Center, or Mobile app, they can secure the information provided as sensitive.

To help requesters identify sensitive information, a knowledge article is provided on the Request Help page. After determining if the request is sensitive, they can select the Issue contains sensitive or confidential information check box. If the check box is selected, the requester can select the department to which the issue might belong, or choose the I'm not sure (general submission).

If the Predictive Intelligence for Universal Request plugin [com.snc.universal_request.ml] is installed, then the department is auto-selected, and the requester is notified about the selection. For more information, see Activate Predictive Intelligence for Universal Request. The requester can then choose to override the suggestion. On submission, this action creates a universal request marked as Restricted.

At times, agents can also create a request from an interaction, a call, or from the Self-Service module. In such cases, the agent can mark the request as Restricted.

Transferring a restricted request

A restricted request means the parent universal request is marked as restricted. When a primary ticket of the sensitive universal request is transferred to another department, the security controls are also transferred, as the assignment group of the UR changes.

Restrict universal request access

Mark a universal request as restricted when you identify the request contains sensitive information.

Before you begin

Role required: employees, routing agents, sn_uni_req.sensitiveinfo_agent or service specific assignment group members
Procedure

1. Navigate to the universal request that you want to mark as restricted.

2. On the form, click the **Restrict** button.

The restricted fields are hidden, and the form is only for view purpose.

**Note:** To mark the request as unrestricted only agents with the access role can modify.

**Mark universal request as unrestricted**

You can unrestrict a restricted universal request if you identify that the request does not have any sensitive information.

**Before you begin**

Role required: sn_uni_req.sensitiveinfo_agent, Primary ticket agent, or members of assignment group of that UR
Procedure

1. Navigate to the universal request that you want to mark as unrestricted or to the primary ticket that you are resolving.

2. On the form, click the **Unrestrict** button. The hidden restricted fields are now visible, and any agent can view the content.

   **Note:** To mark the request as unrestricted only agents who is part of the primary ticket assignment group or with the access role can modify.

Transfer a primary ticket

You can transfer a primary ticket back to Universal Request, service set (department), or service either with or without resolution.

**Before you begin**

Role required: agent part of the assignment group on the primary ticket

**About this task**

Configure the sn_uni_req.transfer_type property in the **Universal Request properties** page to determine how to handle the primary ticket transfers. For more information, see **Universal Request properties**.

A routing agent can either resolve and close a primary ticket or transfer it to back to UR or another department for review and closure. When a primary ticket is transferred back to UR, the ticket is no longer a primary ticket and the primary ticket field of the Universal Request becomes empty.
When transferring the ticket, the routing agent can choose the department and a specific service within the department or can select I’m not sure when they are unsure of the correct department or service.

The agent can transfer a ticket with one of the following reasons:

**Transfer with resolution**

The request is resolved and transferred back to UR, a specific department, or a service. Agents can select this option when another department's help is required to fulfill the request.

**Transfer without resolution**

The request is not resolved or does not belong to the specific department and transferred back to UR, a specific department, or a service.

---

**Transfer Ticket**

Enter the details for this transfer request.

- **Department**: Human Resource
- **Service**: General Inquiry
- **Transfer reason**: -- None --
- **Transfer notes**:

*Copy additional comments and attachments (work notes are never copied)*

[Cancel] [Transfer]
Procedure

1. Navigate to the Primary ticket record that you want to transfer. For example, to open an incident primary ticket, navigate to Universal Request > With Primary Ticket.

2. Open the universal request and then click the associated primary ticket. For example, the Incident ticket associated is be displayed as a link in the message. The primary ticket record appears on the page.

3. Verify and click Transfer.

4. In the Transfer Ticket dialog, provide the following details and then click Transfer.

   Note: Based on the transfer type configuration, different fields display on the form. For more information, see Universal Request properties.

   • Action: Select if you want to transfer the ticket to another department or back to the Universal Request.
   • Department: Select the department from the list.
   • Service: Select the specific service of the chosen department.
   • Transfer reason: Select the reason from the list.
   • Transfer notes: A brief description for routing the primary ticket to the UR Routing agent.
   • Copy additional comments and attachments: Clear the check box if you do not want to transfer the ticket with additional comments and attachments. By default, all attachments and comments are transferred.

   Note: Work notes are not copied while transferring.

Results
The ticket is transferred based on the transfer and transfer type configuration. For more information on configuring routing, see Transfer configuration.

Search similar and closed Universal Requests

When creating a Universal Request, search for closed universal requests that are similar using Predictive Intelligence.

Before you begin
Role required: admin

Note: This search option is available only if you install the Predictive Intelligence plugin (com.glide.platform_ml) plugin and then enable the Enable related search for similar closed Universal Requests (sn_uni_req.similar_closed_universal_request) property. For more information on this property, see Universal Request properties.

Procedure

1. Navigate to Universal Request.

2. Create new or open an existing request that is not closed.

3. Select Similar Closed Universal Request under the Related Search Results section.
   All closed universal requests that are similar are displayed based on the short description, description, and assignment group of the selected universal request.

What to do next
Review the solutions to copy the closed information or mark the solution as This helped.
Reporting solutions for Universal Request

Universal Request (UR) reporting solutions contain preconfigured dashboards with actionable data visualizations to improve your employee service delivery processes.

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. To view the Universal Request reports and dashboard, install the Universal Request Reporting (com.snc.universal_request.reporting) plugin.

⚠️ Note: The Universal Request Reporting (com.snc.universal_request.reporting) plugin is part of the Universal Request Professional subscription. For more information, see Activate Universal Request: Reporting.

Depending on your role, you can use any of the following dashboards for your day-to-day operations.

- **Overview dashboard**: For routing agents to view the details of the universal requests assigned and trends.
- **Process Overview dashboard**: For Process owners to analyze the behaviors of the tickets in your organization.

**Universal Request Overview dashboard**

View and analyze the general statistics of the universal requests for routing agents, such as the number of open requests, breached, unassigned, and requests at risk. You can also view the weekly opening and closing universal requests along with the number of department tasks that are part of each UR.

To view the Universal Request Overview dashboard, navigate to Universal Request > Overview.

**Overview of universal requests**

![Image of a dashboard with statistical data]

Click and open each indicator to view the details of the requests.

**End users and roles**

<table>
<thead>
<tr>
<th>Users and goals</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing agent: View the dashboard.</td>
<td>sn_uni_req.routing_agent</td>
</tr>
<tr>
<td>UR admin: View and edit the dashboard and manage users, groups, and roles of</td>
<td>admin, sn_uni_req.ur_admin</td>
</tr>
<tr>
<td>the dashboard</td>
<td></td>
</tr>
<tr>
<td>Users and goals</td>
<td>Required role</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>UR service owner: View and analyze the UR behaviors and track transfers to make informed decisions.</td>
<td>sn_uni_req.ur_service_owner</td>
</tr>
</tbody>
</table>

**Indicators**

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open P1s</td>
<td>Count of all open P1 requests.</td>
</tr>
<tr>
<td>Unassigned</td>
<td>Count of all requests that are open and not assigned to any UR agents.</td>
</tr>
<tr>
<td>SLAs Breached</td>
<td>Count of all requests that breached the resolution SLA.</td>
</tr>
<tr>
<td>Open</td>
<td>Count of all requests that are open.</td>
</tr>
<tr>
<td>SLAs at Risk</td>
<td>Count of all requests that crossed 75 percent of the business elapsed time.</td>
</tr>
<tr>
<td>Open for &gt;30 days</td>
<td>Request that are open for more than 30 days.</td>
</tr>
</tbody>
</table>

**Department tasks count and details**

This report shows all the universal requests that were created in the last 3 months along with the associated department tickets. You can view the type of department ticket created by hovering over the bars. Also, you can view the list of all the department ticket clicking on the bars.
Open and closed weekly request trend

This report shows the universal request that were opened and closed over the last 3 months, aggregated weekly.

Universal Request Process Overview dashboard

Analyze the behavior of the universal requests in the organization and track transfers. This dashboard helps process owners to measure and determine necessary improvements in the process.

To view the Universal Request Process Overview dashboard, navigate to Universal Request > Process Overview.

The report mainly focuses on the universal requests that were closed in the past 15 days.

Universal Request process overview for 15 days

Click and open each indicator for more details.
## End users and roles

<table>
<thead>
<tr>
<th>Users and goals</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>UR admin: View and edit the dashboard and manage users, groups, and roles of the dashboard</td>
<td>admin, sn_uni_req.ur_admin</td>
</tr>
<tr>
<td>UR service owner: View and analyze the UR behaviors and track transfers to make informed decisions.</td>
<td>sn_uni_req.ur_service_owner</td>
</tr>
</tbody>
</table>

## Indicators

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer disposition</td>
<td>The disposition selected by the routing agents while transferring the tickets back to UR. The statuses captured are the percentages of tickets that are:</td>
</tr>
<tr>
<td></td>
<td>• Transferred with resolution</td>
</tr>
<tr>
<td></td>
<td>• Transferred without resolution</td>
</tr>
<tr>
<td>Sources</td>
<td>Displays the percentage of universal requests created from various sources, such as interaction, UR record producers, virtual agent, or email interactions.</td>
</tr>
<tr>
<td>Transfer with sensitive information</td>
<td>Shows the percentage of universal requests that were transferred with sensitive information.</td>
</tr>
<tr>
<td>Resolution time consumed by group</td>
<td>The total resolution time consumed by universal requests spread across different assignment groups, such as IT, UR, or HR routing group. Resolution time is the total time consumed by the UR from the creation to closure.</td>
</tr>
<tr>
<td>Triage time consumed by group</td>
<td>The total triage time consumed by different assignment groups on the UR. Triage time is the time consumed by the ticket in the UR assignment group queue before the department ticket is created. The triage time pauses as soon as the department ticket is created.</td>
</tr>
<tr>
<td>Resolution time consumed by service</td>
<td>The total resolution time consumed by the each department on the primary ticket. Resolution time is the total time consumed by the primary ticket from its creation to closure.</td>
</tr>
<tr>
<td>Sensitive Universal Requests</td>
<td>Displays the number of tickets restricted by the employees and agents.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assignment group changes by group report</td>
<td>Displays the number of times the UR is moved between the UR assignment group.</td>
</tr>
</tbody>
</table>

### Universal Request reference

Reference topics provide additional information about the universal requests, including lists and forms.

### Universal Request properties

Administrators can use Universal Request properties to determine and configure the application behavior.

Navigate to **Universal Request > Administration > Properties** to view and edit the properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Universal Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable copy universal request feature</td>
<td>sn_uni_req.com.snc.universal_request.copy.enable</td>
<td>Copies the details of an existing Universal Request to a new record.</td>
</tr>
<tr>
<td>Copy attachments from originating universal request</td>
<td>sn_uni_req.com.snc.universal_request.copy.attach</td>
<td>Copies an attachment of an UR record to a target record.</td>
</tr>
<tr>
<td>List of attributes (comma-separated) that will be copied from the originating universal request</td>
<td>sn_uni_req.com.snc.universal_request.copy.attributes</td>
<td>List of attributes that will be copied from the originating Universal Request record.</td>
</tr>
<tr>
<td>Transfer type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select the transfer type to determine how the primary ticket is handled</td>
<td>sn_uni_req.transfer_type</td>
<td>Determines how the primary ticket is handled based on the selection.</td>
</tr>
<tr>
<td>• Universal_request: If this transfer type is selected, then the primary ticket is transferred back to UR and UR assignment group is changed based on the Service selected during transfer. The Primary ticket is handled based on the transfer reason and no new primary ticket is created.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Department only: If your organization has a department level routing agent group to handle requests, then select this transfer type. When this transfer type is selected, UR</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2022 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Universal Request properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>is directly transferred to the department level routing group, and a general inquiry primary ticket is created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Department</strong>: If this transfer type is selected, then based on the Transfer Action and Service selected, the UR is transferred back to the service level or department assignment group. The Primary ticket is handled based on the transfer reason.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: If the Service is disabled, then a general primary task is created for the selected department.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Service</strong>: If this transfer type is selected, then based on the Action and Service selected, the UR is transferred back to the service level or department assignment group. The Primary ticket is handled based on the transfer reason. For Transfer to department transfer action:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ If the no service is selected, a general inquiry primary ticket is created for the selected department.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ If a specific service is selected, a primary ticket is created for the selected service.</td>
</tr>
</tbody>
</table>

### Portal

- **Portal**
  - Portal suffix to which the UR link is redirected.
  - `sn_uni_req.universal_request_portal`
  - Default portal to which all the UR links are redirected.

### Other Properties

- **Enable service transition comments while creating**
  - `sn_uni_req.universal_request_service_transition_comments`
  - Enables or disables the visibility of additional comments to the requester.
### Universal Request properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>department requests from Universal Request</td>
<td></td>
<td>that mentions the details of the department transition.</td>
</tr>
<tr>
<td>Enable universal request auto categorization</td>
<td>sn_uni_req.auto_categorization</td>
<td>Enables the application to use the Universal Request Categorization solution for UR to predict the assignment group.</td>
</tr>
<tr>
<td>Enable to view similar closed Universal Request recommendations</td>
<td>sn_uni_req.similar_closed_universal_request</td>
<td>Enables the application to use the Universal Request Similarity solution for UR to search and display closed Universal Requests that are similar to the UR created.</td>
</tr>
<tr>
<td>The minimum confidence level required for the Universal Request auto categorization predictive intelligence suggestions to be considered</td>
<td>sn_uni_req_ml.auto_categorization.min_confidence</td>
<td>Determines the minimum confidence level required for the Universal Request application to provide auto categorization suggestions using predictive intelligence solution.</td>
</tr>
</tbody>
</table>

#### State mapping form

Use the State Mapping form to map your service specific state to the Universal request states.

#### State mapping form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the service or department table that you want to map to.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order value to consider if multiple state mapping entries conditions are matched.</td>
</tr>
<tr>
<td>Note:</td>
<td>If there are multiple mappings and order value, the least order value is considered.</td>
</tr>
<tr>
<td>Condition</td>
<td>Enter the condition to evaluate and match when a service request state changes. For example, when the service request state is Close Complete, then the UR state is mapped to Close.</td>
</tr>
<tr>
<td>Universal Request state</td>
<td>Select the UR state to map.</td>
</tr>
<tr>
<td>Universal Request template</td>
<td>Select the fields that you want to populate other than the state.</td>
</tr>
</tbody>
</table>

#### Transfer configuration form

Use the Transfer configuration form to configure your transfer details in the Universal Request application.
Transfer configuration form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the service or department table that you want to map for.</td>
</tr>
<tr>
<td>Transfer reason</td>
<td>The reason given when the task is transferred. The options to choose are:</td>
</tr>
<tr>
<td></td>
<td>With resolution</td>
</tr>
<tr>
<td></td>
<td>The primary task is addressed and is transferred with the resolution.</td>
</tr>
<tr>
<td></td>
<td>Without resolution</td>
</tr>
<tr>
<td></td>
<td>The primary task is not completed and is transferred without resolution.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates if the configuration for the department is active or not.</td>
</tr>
</tbody>
</table>

Transfer Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer state</td>
<td>The state of the department-specific ticket that you want to populate on the transfer action. The states are listed based on the department specific table that you select.</td>
</tr>
<tr>
<td>Transfer template</td>
<td>Select the fields that you want to populate other than the state.</td>
</tr>
</tbody>
</table>

Closure Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed state</td>
<td>State that you want to populate for the already transferred department ticket when UR is getting closed. The states are listed based on the department specific table that you select.</td>
</tr>
<tr>
<td>Closed template</td>
<td>Select the fields that you want to populate other than the state.</td>
</tr>
</tbody>
</table>

Service Configuration form

Use the Service Configuration form to register your service to use the Universal Request application.

Service configuration form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Name</td>
<td>Enter the name for your service.</td>
</tr>
<tr>
<td>Service Table</td>
<td>Select the application table that you want to use from the list.</td>
</tr>
<tr>
<td>Application</td>
<td>The application scope that the service belongs to.</td>
</tr>
</tbody>
</table>

Universal Request form

Use the Universal Request form to create a universal request task record.

Universal Request form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number generated for the universal request.</td>
</tr>
</tbody>
</table>
### Universal Request form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opened</td>
<td>The date and time when the universal request was created.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The agent who created the universal request.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The user who requested for this universal request.</td>
</tr>
<tr>
<td>Primary task</td>
<td>The task number, for example, an incident or HR case number that is associated with the universal request.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The medium from which the universal request was created.</td>
</tr>
<tr>
<td>Priority</td>
<td>It identifies how quickly the service desk should address the request.</td>
</tr>
<tr>
<td>State</td>
<td>State of the universal request. By default, the state is <strong>New</strong>.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact value indicates a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the universal request.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User assigned to the universal request.</td>
</tr>
<tr>
<td>Needs resolution review</td>
<td>When checked, and when the department agent closes the primary ticket, the Universal Request does not get closed. Universal Request state remains in <strong>In Progress</strong> and the state reason changes to <strong>Confirm Response</strong>. This notifies the tier 1 agent (Routing agent) to either Accept or Reject the resolution provided in the primary ticket before closing the Universal Request for the requester.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the request.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the request.</td>
</tr>
<tr>
<td>Related Search Results section</td>
<td>Displays a list of knowledge articles, catalog items, pinned articles, or similar Universal Requests based on the <strong>Short description</strong> entered.</td>
</tr>
<tr>
<td>Notes section</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
</tbody>
</table>

**Note:** The administrator must create an email notification for the work notes list.
### Universal Request form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional comments (Customer visible)</td>
<td>More information about the change.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the universal request or steps taken to resolve it, if applicable. This note is for internal use. The work notes information is not visible to your customer.</td>
</tr>
</tbody>
</table>

**Closure Information section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>The date and time when the universal request was closed.</td>
</tr>
<tr>
<td>Closed by</td>
<td>The agent that closed the request.</td>
</tr>
<tr>
<td>Close notes</td>
<td>How or why the universal request was closed.</td>
</tr>
</tbody>
</table>

### Integrating Universal Request with other applications

Extend the capabilities of Universal Request and connect with other departments to assist with ticket resolution. By integrating with other applications, you provide a consistent ticketing experience and facilitate inter-department request transfers and multi-department use cases.

#### Integrate with IT Service Management

Universal Request provides an integration with the Incident Management application after you install Universal Request integration- Incident Management. With this integration, employees and agents can create incident records from universal request. IT routing agents can view these records from the Universal Request application. To modify the integration with the Incident Management application, use the Universal Request guided setup. The guided setup takes you through the setup and configuration process.

**Note:** Integration with the IT Service Catalog product is not yet supported.

#### Integrate with HR Service Delivery

Universal Request provides an integration with the HR Service Delivery application after you install HR Service Delivery integration with Universal Request. This integration gives flexibility to the employees to create HR cases in the universal request record using the Now® Mobile app and Employee Service Center. HR routing agents can view these records from the Universal Request application. To modify the integration with the HR Service Delivery application, use the Universal Request guided setup.

#### Integrate with Universal Task

Universal Request provides an integration with the Universal Task application. This integration enables agents to task employees, track task progress, and provide quick resolution. For more information, see Configure your service for Universal Task

#### Quick start test for Universal Request

Validate that Universal Request still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.
Universal Request quick start tests require activating the Universal Request (com.snc.universal_request) and Human Resources Scoped App: Core (com.sn_hr_core) plugins.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>UR: Transferring an HR case to an Incident</td>
<td>Validate if an HR case is transferred to an incident and an incident is created.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

**Universal Request in Agent Workspaces**

Use Universal Request in the IT and HR Agent Workspaces to create, view, and work on the universal request.

Using Universal Request in the Agent Workspaces allows agents to:

- Create universal requests
- Manage and triage universal requests
- Assign and route the universal requests to the appropriate department

Agents can view all universal requests in a list view based on the states, such as new, in progress, or closed along with the primary task association.

For more information on the additional actions agents can perform in Agent Workspaces, see the following.

- Create a Universal Request from an Interaction Record
- Transfer primary ticket in Agent Workspace
Exploring UR in Agent Workspaces

Learn to create universal requests and understand how user requests are resolved in the Universal Request in Agent Workspace.

As a user, when you initiate a chat using the service portal, the routing agent can interact with you using the workspace.

The routing agents can then perform the following actions:

• Create a Universal Request manually or from an Interaction Record.

• Self assign a Universal Request by clicking the Assign to me button or assign to an assignment group.

• Use Agent Assist capability to find similar UR, related knowledge articles, or catalog items that can help.

• If the agents have a routing agent role of a particular department, then they can create a department specific ticket. For example, an IT routing agent role can create an Incident from the Universal Request.

• Resolve, accept, or reject the resolution based on the state mapping configuration of your department.

• Route primary tasks back to UR with resolution or without resolution.

Universal Request Overview dashboard

The Universal Request Overview dashboard is the default landing page of Universal Request in Agent Workspace. This dashboard contains the basic score card and reports. The information available on this page are:

• List of all Universal Request tasks that are assigned to you in the My Work section.

• Report on your team’s work.

You can view more details of the UR tasks by clicking the UR task number.
Setting up Universal Request in Agent Workspaces

Activate Universal Request in agent workspace and set up roles for performing the tasks.

Activating Universal Request in Agent Workspaces

Universal Request is activated in Agent Workspaces when you enable the Universal Request plugin (com.snc.universal_request) or Universal Request: Advanced Work Assignment plugin (com.snc.universal_request.awa).

Roles used for Universal Request in Agent Workspaces

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UR administrator [sn_uni_req.ur_admin]</td>
<td>Set up and configure Universal Request roles for the agent workspace.</td>
</tr>
<tr>
<td>Routing agent [sn_uni_req.routing_agent, agent_workspace_user, workspace_user, sn_uni_req.universal_request_write, sn_uni_req.universal_request_read]</td>
<td>Create, edit, view and resolve Universal requests.</td>
</tr>
<tr>
<td>Routing agent [sn_uni_req.routing_agent, agent_workspace_user, workspace_user, sn_uni_req.universal_request_write, sn_uni_req.universal_request_read, interaction_agent]</td>
<td>Handle interactions and create universal request from interaction.</td>
</tr>
</tbody>
</table>

Using UR in Agent Workspaces

As a Routing Agent, use the Agent Workspace to view, create, edit and resolve universal requests.

You can start your work in the agent workspace from one of these areas:
Create a universal request from Agent Workspace

Universal Request is a task that a requester creates from any of the following sources, such as mobile application, service portal, agent workspace, or using a virtual agent chat. As a routing agent, you can create universal requests from the Universal Request application on behalf of the requester to track and resolve issues.

Before you begin
Role required: sn_uni_req.routing_agent or admin

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Universal Request > Open.
3. Click New.
4. On the form, fill in the fields.

Universal Request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number generated for the universal request.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time when the universal request was created.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The agent who created the universal request.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The user who requested for this universal request.</td>
</tr>
<tr>
<td>Primary task</td>
<td>The task number, for example, an incident or HR case number that is associated with the universal request.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The medium from which the universal request was created.</td>
</tr>
<tr>
<td>Priority</td>
<td>It identifies how quickly the service desk should address the request.</td>
</tr>
<tr>
<td>State</td>
<td>State of the universal request. By default, the state is New.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact value indicates a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the universal request.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User assigned to the universal request.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Needs resolution review</td>
<td>When checked, and when the department agent closes the primary ticket, the Universal Request does not get closed. Universal Request state remains in <strong>In Progress</strong> and the state reason changes to <strong>Confirm Response</strong>. This notifies the tier 1 agent (Routing agent) to either Accept or Reject the resolution provided in the primary ticket before closing the Universal Request for the requester.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the request.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the request.</td>
</tr>
<tr>
<td>Notes section</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The administrator must create an email notification for the work notes list.</td>
</tr>
<tr>
<td>Additional comments (Customer visible)</td>
<td>More information about the change.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the universal request or steps taken to resolve it, if applicable. The work notes information is not visible to your customer.</td>
</tr>
<tr>
<td>Closure Information section</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>The date and time when the universal request was closed.</td>
</tr>
<tr>
<td>Closed by</td>
<td>The agent that closed the request.</td>
</tr>
<tr>
<td>Close notes</td>
<td>How or why the universal request was closed.</td>
</tr>
</tbody>
</table>

**Create a Universal Request from an Interaction Record**

Convert an Interaction Record to a Universal Request from the Agent Workspace.

**Before you begin**
Role required: sn_uni_req.routing_agent or admin

**About this task**
Consider the following scenario. An IT service desk agent with a routing agent role receives a phone call on a request and creates a new call record or an Interaction Record with the notes. After reviewing the record, the agent realizes that the request belongs to HR and not IT. In this case, the IT Agent can create a Universal Record from the interaction record and assign it to the HR assignment group.
Note: Universal Request is not automatically created when a fulfiller creates a department ticket from an Interaction Record. You have to perform few manual steps to get this. For more information, see Create universal request automatically for department tickets via other channels.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Interactions > My Interactions.
3. Open the interaction record for which you want to create a Universal Request.
4. Click the Create UR button.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Universal Request > Open.
3. Click the universal request from the list or create a request.
4. In **Agent Assist**, click the settings icon ( ) and select your resource from the list.

- Similar Closed Universal Request: To display all similar Universal Requests that are closed.
- Universal Request: To display all similar Universal Requests that are available.
- Knowledge and Catalog: To display all related knowledge articles and catalog items.
- Knowledge Articles: To display all related knowledge articles.
- Catalog Items: To display all related catalog items.
- Pinned articles: To display all related pinned articles.

**Transfer primary ticket in Agent Workspace**

You can transfer a primary ticket back to Universal Request, service set (department), or service either with resolution or without resolution.

**Before you begin**

Role required: No specific role is required. Agents part of the assignment group or assigned-to agents on the primary ticket can perform this task.

A routing agent can either resolve and close a primary ticket or transfer it to back to UR or another department for review and closure. When a primary task is transferred back to UR, the ticket is no longer a primary ticket and the primary ticket field of the universal request becomes empty.

When transferring the ticket, the routing agent can choose the department and a specific service within the department or can just choose 'I'm not sure' when they are not sure of the department or service to transfer to.

When you transfer a ticket back to universal request, you can transfer it with one of the following reasons:

**Transfer with resolution**

The request is resolved and transferred back to UR, a specific department, or service. Agents can choose this option when another department’s help is required to fulfill the request.

**Transfer without resolution**

The request is not resolved or does not belong to the specific department, and is transferred back to UR.
Configure the sn_uni_req.transfer_type property in the Universal Request properties page to determine how to handle the primary ticket transfers. For more information, see Universal Request properties.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Open the primary task that you want to route to UR.
3. Click Transfer.
4. In the Transfer Ticket dialog, provide the following details.

   Note: Based on your transfer type configuration, the given fields are displayed. For more information, see Universal Request properties.

   • Department: Select the department from the list.
   • Service: Select the specific service of the chosen department.
   • Transfer reason: Select the reason from the list.
   • Transfer notes: A brief description for routing the primary ticket that you want to pass to the UR Routing agent.
   • Copy additional comments and attachments: Deselect if you do not want to transfer the ticket with additional comments and attachments. By default, all attachments and comments are transferred.

   Note: Work notes are not copied while transferring.

5. Click Transfer.
   The ticket is transferred based on the transfer and transfer type configuration. For more information, see Transfer configuration.

Restrict universal request access in Agent Workspace
Mark a universal request as restricted when you identify the request contains sensitive information.
Before you begin
Role required: routing agents, sn_uni_req.sensitiveinfo_agent or service specific assignment group members

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Universal Request > Open.
3. Navigate to the universal request that you want to mark as restricted.
4. On the form, click the Restrict button.

The restricted fields are hidden, and the form is only for view purpose.

Note: To mark the request as unrestricted only agents with the access role can modify.

Mark universal request as unrestricted in Agent Workspace
You can unrestrict a restricted universal request if you identify that the request does not have any sensitive information.

Before you begin
Role required: sn_uni_req.sensitiveinfo_agent or service specific assignment group members

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Universal Request > Open.
3. Navigate to the universal request that you want to mark as unrestricted.
4. On the form, click the **Unrestrict** button.

The hidden restricted fields are now visible, and any agent can view the content.

**Note:** To mark the request as unrestricted only agents with the access role can modify.

---

**Universal Task**

The ServiceNow Universal Task application is a tasking framework that enables your agents to request extra information from employees who submit tickets or to task employees to accomplish an activity in order to resolve a ticket.

Let’s consider an example. Aditi, an employee, has lost a laptop and has requested a replacement laptop. Dan, who is the agent working on this incident, needs the lost report from Aditi to proceed with the incident resolution. Dan could choose to use an activity stream to request the lost report but that adds a lot of extra work for Dan. By using an activity stream to get the report, Dan must close the incident and open a new request for the laptop. This process creates a disjointed experience for both Dan and Aditi.

With Universal Task, Dan can task Aditi to upload a lost report from within the incident. On receiving the report, Dan can task Aditi to order a new laptop by using a submit catalog item task under the same incident.

**Enhance employee experience**

Activity streams can be confusing for agents and employees. Universal Task ensures a guided tasking experience where both agents and employees are aware of all the action items and the status of each item throughout the ticket resolution process.

**Standardize employee experience across services**

You can configure Universal tasks for any ticket type that extends the task table to ensure a consistent experience for your employees regardless of the ticket type or service type.
Increase fulfillment efficiency

Predefined task types enable agents to quickly task employees to get the information required for fulfilling the ticket in the most efficient way possible. Universal Task due dates ensure that your agents can share the fulfillment responsibility with your employees.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Configure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about how employees, agents, and managers use Universal Task.</td>
<td>Plan and configure your implementation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work on universal tasks.</td>
<td>Get details about components like fields, tables, and properties.</td>
</tr>
</tbody>
</table>

Exploring Universal Task

With the ServiceNow Universal Task application, agents can create tasks for your employees. The agent can ask for additional information or request an action to resolve the parent ticket or request.

Universal Task offers pre-defined tasks for the agent to use. With Universal Task, you can:

- Create employee tasks from any ticket type that extends the task table.
- Enable departments to configure the tasks that solve their domain-specific use cases.
- Enable departments to create templates for commonly used task forms.
- Notify employees about the tasks that need their attention.
- Enable employees to complete tasks by using standard Universal Task portal widgets and the Now Mobile app.

Requester experience

Universal Task enables employees to view the tasks that are assigned to them within the same request that must be completed. Employees can also communicate with the agents within the task that was created. For example, an employee creates a universal request for a laptop. The agent that is assigned for this request can task the employee to submit a catalog request to order the laptop. Employees can view the task in the To-Do tab of the Employee Service Center. Employees can also view the task under the Tasks tab, under individual Requests in the Requests page of the Employee Service Center and Service Portal, if the respective service configures the tab as shown in Add a Task tab on the Standard Ticket page.
**Agent Experience**

Agents get an insight on the employees' actions and can task the employees as needed. Agents can create multiple tasks for a single request and view all universal tasks that were created for a ticket in the Related Lists section.

For more information on the types of task available, see Universal Task types.

**Universal Task types**

The task types in the Universal Task application enable your agent to assign pre-defined tasks to an employee. With these pre-defined tasks, your agent can task employees quicker and more efficiently. You decide which task types that you want to make available to the agents in your organization.

You can choose to make the following task types available in your own organization:

- **Submit Catalog Item**: Enables agents to task employees to submit catalog items.
- **Upload Documents**: Enable agents to task employees to upload documents that might be required for fulfilling a request.
- **Checklist**: Enables agents to create a checklist of tasks that the employee must complete.
- **Collect Employee Input**: Enables agents to collect information from the employee without creating additional case records or adding new fields to existing tables.
- **Mark When Complete**: Enables agents to assign a task that contains fulfillment instructions as rich text descriptions. An employee can show that a task is complete by clicking the Mark complete button.

**Universal Task data model**

The Universal Task is a tasking framework that you can append to the ticketing system of any department in your organization. The Universal Task data model explains the tasking framework and its customizations.

You can create Universal Task for any department or service, such as a universal request, an incident, an HR case, or a legal matter. You can also assign multiple universal tasks for a single request.

The following diagram is a high-level overview of the Universal Task data model.
The Universal Task data model uses a combination of tables to store data:

- Now Platform tables.
- Tables that are included with the Universal Task application.

For information on the tables and components that are installed with the Universal Task application, see Components installed with Universal Task.

The Universal Task [sn_uni_task_universal_task] table extends the Task [task] table to include:

- The type of task for the current record, for example, Upload document.
- The catalog item if the task is of type Submit Catalog Item.
- The generated table that stores the table name that contains the requested catalog items.
- The generated ID that is the sys_id of the requested catalog item.

†Note: The catalog item, generated table, and generated ID are only applicable for the Submit Catalog item task type.

- The employee form that is used to request information for the Collect Employee Input task type.
- The survey instance that stores the instance ID of the employee form for the Collect Employee Input task type.
- Task template to be used, if any, to auto-fill the Universal Task [universal-task] form.

The values for the State and Priority fields in the Task [task] table have been modified for Universal Task. The valid states for Universal Task are:

- 1: New (Draft state). Tasks at this state are only visible to the agent.
- 2: Work in Progress. Tasks at this state are assigned to and visible to the employee.
- 3: Complete. Tasks transition to the complete state when the employee completes the task.
- 4: Canceled. Tasks at this state can be canceled by gents before the task is completed.
The valid priority values for Universal Task are:

- **1**: Critical. Highest priority for urgent or time-sensitive tasks.
- **2**: High. Tasks that are important but not urgent.
- **3**: Moderate. Tasks that should be completed.
- **4**: Low. Optional tasks.

The Universal Task [sn_uni_task_universal_task] table follows data separation.

**Universal Task configuration table**

The Universal Task configuration table is configured to identify the following details:

- **The Parent table**, or the department-specific table that uses Universal Task. For example, if Universal Task is being used with HR cases, then the HR case table is the parent table. Universal Task can only be created on a table that is an extension of the task table.

- **The task types that are available to the agents to task the requester with**. For more details, see **Universal Task types**.

- **The Default Assigned to** field that points to the **requester** field in the parent table. To autofill the **Assigned to** field with the assignee while creating a task, configure the **Default Assigned to** field.

For more details, see **Configure Universal Task for your service**.

Specific task types might have additional configuration tables. For example, for the Submit catalog item task type, the Catalog task configuration [sn_uni_task_catalog_task_config] table determines which filters to apply to the catalog items that are available to an agent. For more information, see **Configure the catalog items for your service**.

The Universal task configuration [sn_uni_task_config] table and the Catalog task configuration [sn_uni_task_catalog_task_config] table follow process separation.

**Universal Task in Now Mobile**

You can complete universal tasks that are assigned to you in real time from your own mobile device by using the Now Mobile application.

From your mobile device, you can get notifications about updates in your universal tasks, you can learn when a new task is assigned to you, or you can see new comments that are added to one of your tasks.
View and complete the universal tasks that are assigned to you in the To-Do tab. For detailed instructions, see View and update Universal Task using Now Mobile.

Stay updated about any activity on your universal tasks by finding the task details in the Learn More tab. You can add comments about your task or add pictures and documents as
attachments in the **Updates** tab. You can even start a chat conversation with a virtual agent by using the icon.

---

**Setting up and configuring Universal Task**

You must set up and configure the Universal Task application before you can enable agents to assign tasks to employees in order to fulfill a request.

**Install Universal Task**

You can install the Universal Task application (`sn_uni_task`) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

**Before you begin**

- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see [Get entitlement for a ServiceNow product or application](#).

Role required: admin

**About this task**

The required Roles and Tables are installed with Universal Task. Ensure that the `glide.enforce_security_scope.sn_uni_task` property is set to true in Global scope.

For more information, see [Components installed with Universal Task](#).
Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Universal Task application (sn_uni_task) using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Universal Task.

4. Optional: If demo data is available and you want to install it, click Load demo data.
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

Components installed with Universal Task

Several types of components are installed with activation of the Universal Task application, including tables, user roles, and scheduled jobs.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin [sn_uni_task.admin]</td>
<td>View and configure the Universal Task application</td>
<td>None</td>
</tr>
<tr>
<td>Report view [sn_uni_task.report_view]</td>
<td>Access and view Universal Task reports</td>
<td>None</td>
</tr>
<tr>
<td>Employee form admin [sn_uni_task.emp_form_admin]</td>
<td>Create and manage Employee forms</td>
<td>survey_admin</td>
</tr>
<tr>
<td>Employee form creator [sn_uni_task.emp_form_creator]</td>
<td>Create and modify employee forms</td>
<td>survey_creator</td>
</tr>
<tr>
<td>sn_uni_task.template_admin</td>
<td>Create and manage Universal Task templates</td>
<td>None</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Task [sn_uni_task_universal_task]</td>
<td>Store the Universal Task record details for a department-specific table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Universal Task Configuration [sn_uni_task_config]</td>
<td>Store the list of task types for each department-specific table.</td>
</tr>
<tr>
<td>Catalog Task Configuration [sn_uni_task_catalog_task_config]</td>
<td>Stores the catalog items details of the department-specific table.</td>
</tr>
<tr>
<td>Base Task Configuration [sn_uni_task_base_task_config]</td>
<td>Serves as the base table for the configuration tables for all task types.</td>
</tr>
<tr>
<td>Employee Form [sn_uni_task_employee_form]</td>
<td>Stores the employee form records that were created for the Collect employee input task type.</td>
</tr>
<tr>
<td>Employee Input Task Configuration [sn_uni_task_emp_input_task_config]</td>
<td>Stores the roles that can view the responses of completed employee forms for each department-specific table.</td>
</tr>
<tr>
<td>Universal Task Template [sn_uni_task_template]</td>
<td>Stores the universal task templates with predefined field values that can be applied on Universal Task forms.</td>
</tr>
<tr>
<td>Universal Task Dynamic Template Mapping [sn_uni_task_dynamic_template_mapping]</td>
<td>Stores the dynamic template mappings between Universal Task fields and parent table fields.</td>
</tr>
</tbody>
</table>

**Configuring your service for Universal Task**

You can configure the UI actions and related lists for the Universal Task application so that you can view and create universal tasks for your service. Services are the various departments in your organization, such as IT, HR, and Legal.

**Assign Universal Task admin role**

Assign the sn_uni_task.admin role to the application administrators so that they can integrate and configure Universal Task. Roles control access to features, capabilities, and data.

**Before you begin**

Role required: sn_uni_task.admin

**About this task**

You can assign roles to individual users or groups. When you apply roles to groups, the members of those groups inherit those roles.

Before you can assign the sn_uni_task.admin role to specific users, the logged-in user must also have the sn_uni_task.admin role. By default, the admin role contains the sn_uni_task.admin role. Administrators can assign the sn_uni_task.admin role to other agents who will work on the Universal Task configuration for their respective services.

**Procedure**

1. Navigate to User Administration > Groups.
2. Open the group that you want to assign the sn_uni_task.admin role to.
3. In the Roles related list, click Edit.
4. In the Collection list, select sn_uni_task.admin.
5. Click Add.
6. Click Save.
The `sn_uni_task.min_admin_count` property in the System Properties `[sys_properties]` table ensures that a minimum number of scoped administrators are active at any given time for managing the application. For Universal Task, the minimum count of scoped admins is set to two by default. You can modify this property to increase the minimum count.

**Note:** Ensure that you have at least two agents with the `sn_uni_task.admin` role. If you assign only one agent with the role and that person is deactivated, you no longer will have an agent who can perform the Universal Task admin duties.

Create UI actions for your service with Universal Task

Create UI actions for your service so that agents can create universal tasks.

**Before you begin**
Role required: admin

Administrators and users with the `ui_action_admin` role can define UI actions. The UI actions must be configured for both the Now Platform form and the Agent Workspace form.

**Procedure**

1. Navigate to **System Definition > UI Actions**.
2. In the UI actions list, click **New**.
3. Enter the name of the UI action. For example, enter the name as **Assign Task**.
4. Select the service-specific table that Universal Task is being configured for. For example, select the Universal Request `[universal_request]` table for placing the Assign Task UI action on the Universal Task form view or workspace.

   **Note:** For any new UI action, ensure that you always select the appropriate service table.

5. **Optional:** Clear the **Show insert** check box. If the **Show Insert** check box remains checked, the UI action to create a task is displayed even when the main ticket is being created.
6. Select the **Form Button** check box.
7. In the **Script** field, enter the following script.

   ```javascript
   var gr = new GlideRecord("sn_uni_task_universal_task");
gr.initialize();
gr.setValue("parent",current.sys_id);
action.openGlideRecord(gr);
action.setReturnURL(current);
   ```
8. On the **Workspace** tab, select the **Workspace Form Button** check box.
9. On the form, fill in the fields. For more information on fields and descriptions, see **Create a UI action**.
10. Click **Submit**.

Add a Universal Task related list

Add a Universal Task related list to a service-specific form in both the Now Platform and Agent Workspace to let agents view a universal task for the request.

**Before you begin**
Role required: admin
Procedure
1. Navigate to the table that the related list must be added to.
2. Open a service-specific form.
3. Right-click the additional actions context menu.
5. On the form, select the Universal Task->Parent.
6. Select a view name:
   - Default view: To add the Universal Task related list in the Now Platform form.
   - Workspace: To add the Universal Task related list in the Agent Workspace form.
7. Click Save.

Note: Due to access control list (ACL) restrictions, the New button might not work while you are creating a task. You can hide the New button on the related list and use the UI action to create a universal task.

For more information on adding related lists, see Related lists.

Add a Task tab on the Standard Ticket page
Add a Task tab on the Standard Ticket page to let employees view the tasks that are assigned to them by the agents.

Before you begin
Role required: admin

Procedure
2. Click your service-specific table to open it.
3. In the Tabs Configurations related list, click New.
4. On the Tab configuration form, in the Type field, select Custom.
5. Enter the Tab name.
   For example, Tasks/To-dos.
6. Add the appropriate filter conditions to control the visibility of the tab.
   For example, set Sys ID to javascript:new sn_uni_task.UniversalTaskUtils().hasTasksToShow(current) to make
the task tab visible only if there tasks are assigned to the employee.

7. In the **Widget** field, add a widget.

   - **Note:** The Uni Task Parent is the default widget that you can use to add the **Universal Task** tab in the Standard Ticket.

8. Click **Submit**.

**Define the agent criteria for Universal Task**

Define the criteria for an agent so that the agent can access the parent table for Universal Task. The default criteria is that agents must have write access to the parent table.

**Before you begin**

Role required: admin

**About this task**

By using an extension point, you can add more conditions for agents to qualify as Universal Task agents. If this extension point is not implemented, agents with write access to the parent table are treated as UT agents for the parent table by default.

**Procedure**

1. Navigate to **System Extension Points > Scripted Extension Points**.
2. In the API name column, search for **sn_uni_task.UniversalTaskParentAccess**.
3. To create an extension point script that defines the agent criteria for your service, click **Create Implementations** in the related link.
   - To know more about extension points, see Using extension points to extend application functionality.
4. Specify the criteria for an agent to have access to the parent table.
   - For example, you might want to ensure that the agent belongs to a specific assignment group in addition to having write access for the parent table.

**Configure Universal Task for your service**

Configure the Universal Task application for your service so that you can create and assign tasks to employees.

**Before you begin**

Role required: **sn_uni_task.admin**

**Procedure**

1. Navigate to **Universal Task > Administration > Universal Task Configuration**.
2. Click **New**.
3. On the form, fill in the fields.
   - For more information on form fields and descriptions, see **Universal Task Configuration form**.
4. Click **Submit**.
Configure the catalog items for your service
Filter the catalog items that you want to show in the Submit Catalog Item task for your service.

Before you begin
Role required: sn_uni_task.admin

About this task
You can add filters to manage the catalog items that are available to a user. For instance, some catalog items might be restricted based on the location or service type of the request.

Procedure
1. Navigate to Universal Task > Administration > Catalog Task Configuration.
2. Click New.
3. Select your service-specific table as the parent table.
   Note: You can select only the service-specific tables that have been configured for Universal Task with the Submit Catalog Item task type.
4. To filter the items that you show in the Submit Catalog Item task, add the Catalog item filter field.
5. Enter the Order value.
6. Add a parent table Condition for the catalog item, if any.
   For example, in the following configuration, the catalog item filter is applicable only if the assignment group of the parent table [incident] is Change Management.
   You can create multiple conditions to configure your catalog items. The conditions with lower order values get precedence over higher order values.
7. Click Submit.

Configure the roles to view employee forms
Configure the roles to enable your agents to view the employee responses in the completed Universal Task employee forms.

Before you begin
Role required: sn_uni_task.admin

Procedure
1. Navigate to Universal Tasks > Administration > Employee Input Task Configuration.
2. Click New.
3. On the form, fill in the fields.
   For more information on form fields and descriptions, see Employee Input Task Configuration form.
4. In the **Parent table** field, select the parent table.

   **Note:** You can only select the tables that have been configured for Universal Task.

5. In the **Response view roles** field, select the roles for your agents.

6. In the **Condition script** field, add a condition script, if any.

7. Click **Submit**.

**Configure the extension points for Universal Task**

Provide the implementation for childTaskCancelled, childTaskCompleted, childTasksClosed of the scripted extension point to execute the custom logic of the service, when a universal task is canceled, completed, or closed.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Extension Points > Scripted Extension Points**.

2. Search for `sn_uni_task.UniversalTaskCloseEvents`.

3. To create your service-specific extension point script, click **Create Implementations** in the related list.
   
   For more information, see **Using extension points to extend application functionality**.

4. Click **Update**.

**Display the universal tasks for a request in Now Mobile**

Display all the universal tasks that are assigned for a particular request by simply configuring the **Tasks** tab in Now Mobile.

**Before you begin**

Role required: admin

**Procedure**

1. In the navigation panel, enter `sys_sg_form_segment.list`.

2. In the Form Screen Segments page, click **New**.

3. Select the service-specific **My Request** form screen.
   
   To find your service-specific **My Request** form screen, select a **My request** form screen and then preview the record.

4. In the embedded screen field, select **Tasks**.

5. In the **Order** field, enter a number to indicate the order that you want the tab to appear in.

6. Click **Update**.

**Hide the template bar on the Universal Task form**

Hide the template bar for the Universal Task form because it does not include Universal Task templates.

**Before you begin**

Role required: admin
Procedure  
1. In the navigation panel, enter sys_properties_list.do. 
   
   ✪ Note: Ensure that the application is in Global scope. 
3. On the form, fill in the fields. 

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.ui.show_template_bar.sn_uni_task_universal_task</td>
</tr>
<tr>
<td>Type</td>
<td>true</td>
</tr>
<tr>
<td>Value</td>
<td>false</td>
</tr>
</tbody>
</table>

4. Click Submit. 
5. To clear the cache of your instance, in your browser, enter <server_url/cache.do>. 

Remove the Universal Task admin role from the admin role 
Remove the sn_uni_task.admin role from the admin role so that you can prevent a user with the default admin role from viewing all Universal Task tables. 

Before you begin 
Role required: admin 

About this task 
By default, a system administrator also contains the sn_uni_task.admin role and can access the Universal Task information. To secure your application, remove the sn_uni_task.admin from the admin role. By doing so, you prevent the user with a default admin role from viewing all the Universal Task information. 

   ✪ Note: Ensure that you have completed setting up Universal Task before removing the sn_uni_task.admin role from the admin role. 

Procedure  
1. Log in as admin. 
2. Navigate to User Administration > Roles. 
3. Select admin. 
4. On the Contains Roles tab, click Edit. 
   
   ✪ Note: If you do not see the Edit button, change the Application scope to Global. 
5. From the Contains Roles List column, highlight and move sn_uni_task.admin to the Collection column. 
6. Click Save. 

Domain separation and Universal Task 
Domain separation is supported for ServiceNow Universal Task. Universal Task enables agents to request extra information from the employee or to task the employee to accomplish an activity, in order to resolve a ticket. Domain separation enables you to separate data,
processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response. To learn more, see [Application support for domain separation](#).

**Overview**

In the Universal Task framework, all the configurations are process domain-separated, and the data tables, namely, Universal Task table, Employee form table, and Task template table are data domain separation offerings.

**How domain separation works in Universal Task**

The configuration tables in Universal Task are process domain-separated. So, the configurations created by the parent domains are also implemented in the child domains. However, a child domain can override the configuration, if needed. For example, In an organization, the services are the child domains, while the organization is the parent domain. The task types available for Universal Task in a particular organization, will also be available for the various services of the organization. However, a particular service can override the task types as needed.

The data tables in Universal Task are data domain-separated. So the data stored in any of the child domains is accessible to the parent domain. For instance, if a service is using task templates, the data captured in the Task templates table for the service domain is accessible to the organization domain, but not to the domains of other services, unless configured.

**Tables**

The following Configuration tables are process separated.

- sn_uni_task_config
- sn_uni_task_base_task_config
- sn_uni_task_catalog_task_config
- sn_uni_task_emp_input_task_config

The following Data tables are data separated.

- sn_uni_task_universal_task
- sn_uni_task_template
- sn_uni_task_employee_form

**Related information**

- Domain separation for service providers
Using Universal Task

Agents can use the Universal Task application to create tasks for employees and to manage the request resolution. Employees can view and complete tasks assigned to them using the Employee Service Center or the Now® Mobile app.

Create a universal task

Create a universal task for a request and assign it to the employee or create multiple tasks for a request by using Universal Task.

Before you begin
Role required: Configurable by your service

About this task
Universal Task agents, as configured in Define the agent criteria for Universal Task can create a new universal task using the UI action available on the ticket page.

Note: To control the access for creating a task, configure the visibility of the UI action for creating Universal Task. For more information, see Create UI actions for your service with Universal Task.

When a universal task is created, it is auto-assigned to the employee as configured in Configure Universal Task for your service. The employee receives a notification and can view or update the task from the ServiceNow Employee Service Center. If the employee accesses the task from the Now Platform, they can only add a comment and add people to the watch list.

Procedure
1. Open the ticket that you want to create a universal task for.
2. Click the UI action for creating a universal task.
   
   Note: The name of the UI action is configurable and can vary. For more information, see Create UI actions for your service with Universal Task
3. On the form, fill in the fields.
   See Universal Task form for more information.
4. Select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready for work</td>
<td>Task is created. The state of the task changes to Work in Progress, and the employee is notified about the task.</td>
</tr>
<tr>
<td>Submit</td>
<td>Task is created. The state of the task remains New, and no notification is sent to the employee.</td>
</tr>
</tbody>
</table>

Results
Employee experience: A new task is created for your request. You can view and complete the task in the To-Do tab of the Employee Service Center. You can also view and complete the task in the task tab of the associated request, if configured in standard ticket configuration. You receive notifications if the task is canceled, closed, completed, or if a comment is added to the task. Notifications are sent to the stakeholders when changes are made to the task.
Agent experience: You can now view or edit the task. You can also add more tasks to the same request.

View and update Universal Task using Now® Mobile

View and update the universal tasks that are assigned to you by using the Now Mobile app.

Before you begin
Role required: Requester

Procedure

1. On your mobile device, tap the Now Mobile app icon (Now).
2. To view all tasks that are assigned to you, tap My Tasks.
   To view Universal tasks for a particular request, tap My Requests, open the request and go to the Tasks tab.
3. Tap a universal task to open it.
4. Go to each tab to do the following.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To-Do</td>
<td>View and complete the tasks that are assigned to you.</td>
</tr>
<tr>
<td></td>
<td>• If the task type is Upload Documents, upload the required document using Add attachments and mark the task complete. You can upload multiple documents or images.</td>
</tr>
<tr>
<td></td>
<td>• If the task type is Submit Catalog Item, the task is automatically marked complete after you submit the catalog item.</td>
</tr>
<tr>
<td></td>
<td>• If the task type is Mark when Complete, mark the task complete once the task described in the Description is completed.</td>
</tr>
<tr>
<td></td>
<td>• If the task type is Checklist, mark at least one of the items as complete to mark the task complete.</td>
</tr>
<tr>
<td></td>
<td>• If the task type is Collect Employee Input, tap the to open the employee form. After you submit the form, the task is marked complete. If you leave the form midway, your responses are saved. You can complete and submit the form later.</td>
</tr>
</tbody>
</table>

Learn More
View task details.

Updates
View or add comments or attachments to the task.

Create an employee form
Create or modify an employee form to collect employee input. Employee forms are questionnaires that are built using the survey designer to collect or update information from employees.
Before you begin
To use this task, first create an employee form record. Then, use the survey designer to design a questionnaire for the employee.
Role required: sn_uni_task.emp_form_admin or sn_uni_task.emp_form_creator

Procedure
1. Navigate to Universal tasks > Employee forms.
2. Click Create New.
3. On the form, fill in the fields.
   For more information on form fields and descriptions, see Employee form.
4. Right-click the form header and click Save.
   The Form designer button appears.
5. To open the survey designer in a new window, click Form designer.
6. To build the questions for your employee form, use the survey designer.
   For more information on the question types, see Survey designer elements.
7. Click Save and Publish.

Results
You can now assign the form to an employee by using the Collect Employee input task. To view the employee responses, click View Responses after the task is marked complete.

ℹ️ Note: You must have specific roles to view the employee responses. For more information, see Configure the roles to view employee forms

Universal Task templates
Task templates help agents to create Universal Task records by auto-populating fields in a template.
The task template [sn_uni_task_template] table follows data separation. For more information, see Domain separation and Universal Task.

Using task templates, you can create templates for common use-cases. You can also set a schedule to periodically create records based on a template.
A task template can have static and dynamic mappings. In static mappings, the values of fields are individually specified and fixed. In dynamic mappings, the field values are updated and mapped from another table. You can create dynamic template mappings between the fields of the Universal Task table and any other parent table that uses Universal Task. Using the dynamic template mappings, you can do the following:

- Map Universal Task fields to parent table fields.
- Create text templates for fields in the parent table.
- Offset date fields by specific durations.

Create a template using the Universal Task template form
Create a template for any service table to automatically populate fields on a form. Creating templates for common use cases enables agents to create universal tasks faster and ensures uniformity of field values.

Before you begin
Role required: sn_uni_task.template_admin
About this task
A task template can have static and dynamic mappings. In static mappings, the values of fields are individually specified and fixed. The following procedure is for creating a static template mapping. For information on dynamic templates, see Create dynamic template mapping.

Procedure
1. Navigate to Universal task > Task templates > Create new.
2. On the form, fill in the fields.
   For more information on form fields and descriptions, see Universal Task template form
3. Optional: Select Schedule to create a scheduled job to create records based on this template. For detailed instructions, see Create records based on a template.
4. Click Submit.

Create a task template by saving a form
Save a populated Universal Task form as a template. This is an alternative method for creating a task template.

Before you begin
Make sure you have a Universal Task form that you want to use. If you need to create a form, see Create a universal task.

Role required: sn_uni_task.template_admin

Procedure
1. Navigate to a Universal Task form.
2. Complete the form as it should appear when a user applies the template.
3. Right-click the form header and click Save.
4. Click Create Universal Task Template.
   The task template with the filled forms appears.
5. In the Name, enter a descriptive name for the template.
6. Set the Parent table field to a service-specific table.
   If you choose not to select any table, then the configuration will apply to all tables.
7. Make additional changes as required.
8. Click Submit.

Create dynamic template mapping
Create dynamic templates to map fields on a Universal task form to corresponding fields on the parent table form. Dynamic templates help agents to map parent table fields to Universal task fields.

Before you begin
Ensure that you have write access to the parent table that is used for the template mappings.

Role required: sn_uni_task.template_admin

About this task
Dynamic template mappings can be created for templates that have an assigned parent table. In a dynamic mapping, the value of a field is updated with the value of the mapped field in the parent table. Dynamic template mappings get precedence over static template mappings.
mappings. In static template mappings, fields are set to specific values. For more information on how to create a static template, see Create a template using the Universal Task template form.

Procedure
1. Navigate to Universal Task > Task Templates > All.
2. Open the template that you want to create mappings for.
3. In the Universal Task Dynamic Template Mappings related list, click New.
4. In the Universal task field field, select the field that must be mapped.
5. In the Parent table field field, select the field that must be mapped to the previously selected field from the Universal task field field. Depending on what type of field is selected in the Universal task field field, the Advanced option appears. If you select the Advanced option, the following options are available based on the input type of the Universal task field.

<table>
<thead>
<tr>
<th>Input type for the Universal task field</th>
<th>Advanced options</th>
</tr>
</thead>
<tbody>
<tr>
<td>String, such as Short description</td>
<td>The Value field appears. You can map your Universal task to multiple fields from the parent table. You can also add a text template.</td>
</tr>
<tr>
<td>HTML, such as Rich description</td>
<td>The Value field appears. You can map your Universal task to multiple fields from the parent table. You can also add a text template.</td>
</tr>
</tbody>
</table>
| Date field, such as Due date           | • The Date offset type field appears.  
• If you set the Date offset type field to Before or After, then the Date offset by field appears. |

6. Click Submit.

Results
A mapping was created for a specific Universal task field. You can repeat this procedure to map more fields.

Use Task templates
Use a task template to auto-populate a Universal Task form. Using a task template enables agents to create tasks faster.

Before you begin
Role required: write access to the parent table, if the parent table is defined in the template configuration. If no parent table is defined, then any agent can access and use the task templates.

Procedure
1. Open the ticket that you want to create a universal task for.
2. Click the UI action for creating a universal task.
3. In the Template field of the Universal Task form, select the template to be used.
4. Fill in the fields that are left empty by the template.
Depending on what template you used, some of the fields will already be populated by the template. You can fill in the rest of the fields yourself. For more details on what each field means, see Universal Task form.

5. To create your task, click any of the following buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ready for work</strong></td>
<td>Task is created. The state of the task changes to Work in Progress, and the employee is notified about the task.</td>
</tr>
<tr>
<td><strong>Submit</strong></td>
<td>Task is created. The state of the task remains New, and no notification is sent to the employee.</td>
</tr>
</tbody>
</table>

**Universal Task reference**

You can refer to the reference topics to learn more about the universal tasks, including lists and forms.

**Universal Task form**

You can use the Universal Task form to create a task record.

**Universal Task form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number that is generated for the universal task. The universal task number starts with UNT.</td>
</tr>
<tr>
<td>Parent</td>
<td>Number of the parent case or request.</td>
</tr>
<tr>
<td>Parent Assignment Group</td>
<td>Group that is assigned to the parent case or request.</td>
</tr>
<tr>
<td>Parent Assigned to</td>
<td>Agent primarily responsible for working on the parent case or request.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of task that is being assigned. Select one of the following:</td>
</tr>
<tr>
<td>Submit Catalog Item</td>
<td>In the <strong>Catalog item</strong> field, select a catalog item.</td>
</tr>
<tr>
<td>Upload Documents</td>
<td>Use the <strong>Description</strong> field to provide instructions or details of documents to be uploaded.</td>
</tr>
<tr>
<td>Mark When Complete</td>
<td>Use the <strong>Description</strong> field to provide details about this task.</td>
</tr>
<tr>
<td>Checklist</td>
<td>In the <strong>Checklist</strong> section, add the checklist items. For detailed information, see <a href="#">Create a checklist</a>.</td>
</tr>
<tr>
<td>Collect Employee Input</td>
<td>In the <strong>Employee form</strong> field, select the employee form that the user will fill out.</td>
</tr>
</tbody>
</table>
### Universal Task form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee form</strong></td>
<td>Employee form that the employee must fill to complete the task.</td>
<td></td>
</tr>
<tr>
<td><strong>Survey instance</strong></td>
<td>Link to the completed employee form.</td>
<td></td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>Task template to auto-fill the task form.</td>
<td></td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>State of the universal task. Select one of the following:</td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>Default state when the task is a draft. Tasks at this state are only visible to the agent</td>
<td></td>
</tr>
<tr>
<td>Work in Progress</td>
<td>Task is assigned to and visible to the employee.</td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td>Task has been completed by the employee.</td>
<td></td>
</tr>
<tr>
<td>Canceled</td>
<td>Task has been cancelled before completion.</td>
<td></td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>Value that identifies how quickly the service desk should address the request. Select one of the following:</td>
<td></td>
</tr>
<tr>
<td>Critical</td>
<td>Highest priority for urgent or time-sensitive tasks.</td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Tasks that are important but not urgent.</td>
<td></td>
</tr>
<tr>
<td>Moderate</td>
<td>Tasks that should ideally be completed.</td>
<td></td>
</tr>
<tr>
<td>Low</td>
<td>Optional tasks.</td>
<td></td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>Employee that is assigned to the universal task.</td>
<td></td>
</tr>
<tr>
<td><strong>Due date</strong></td>
<td>Expected date for the employee to complete the task.</td>
<td></td>
</tr>
<tr>
<td><strong>Watch list</strong></td>
<td>Users to receive notifications when there is any change in the task status.</td>
<td></td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>Brief description of the request</td>
<td></td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Detailed description of the request</td>
<td></td>
</tr>
<tr>
<td><strong>Additional comments</strong></td>
<td>More information about the change. The information in this field is visible to the customer.</td>
<td></td>
</tr>
<tr>
<td><strong>Work notes</strong></td>
<td>Information about how to resolve the universal task or steps taken to resolve it, if applicable. This note is for internal use. The work notes information is not visible to your customer.</td>
<td></td>
</tr>
</tbody>
</table>
**Universal Task Configuration form**

Use the Universal Task Configuration form to associate Universal Task to your service.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent table</td>
<td>Department-specific table that the universal task should be associated to.</td>
</tr>
<tr>
<td>Task Types</td>
<td>Task types that are available to the agents for use.</td>
</tr>
<tr>
<td>Default Assigned to</td>
<td>User field on the parent table that the universal task must be assigned to on creation.</td>
</tr>
</tbody>
</table>

**Note:** Agents can still change the value of **assigned to** at the time of creating a universal task.

**Employee form**

Use the employee form to create a new employee form record for Universal Task.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the employee form.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the employee form.</td>
</tr>
<tr>
<td>Parent table</td>
<td>Parent tables the form is available for. Only the tables that have been configured for Universal Task with Collect Employee Input task type can be selected.</td>
</tr>
</tbody>
</table>

**Note:** You can select a parent table only if you have write access to it.

| Active | Option to activate the employee form for use.                               |
| State  | State of the form. This field gets auto-populated.                          |

**Employee Input Task Configuration form**

Use the Employee Input Task configuration form to configure the roles that can view completed Universal Task employee form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent table</td>
<td>Department-specific table that the universal task should be associated to.</td>
</tr>
</tbody>
</table>

**Note:** You can only select the tables that have been configured for Universal Task.
Employee Input Task Configuration (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response view roles</td>
<td>Roles that will contain the Response view role</td>
</tr>
<tr>
<td>Condition script</td>
<td>Script to add conditions to the role, if any</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application scope. This field is auto-selected.</td>
</tr>
</tbody>
</table>

Universal Task template form

Use the Universal Task template form to create a Universal Task template.

Universal Task template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of this template.</td>
</tr>
<tr>
<td>Parent table</td>
<td>Table that this template applies to. By default, the template is applicable to all tables.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Adding content to this field does not add that content to the Short description field of the forms that use this template.</td>
</tr>
<tr>
<td>Template</td>
<td>Content that automatically populates records that are based on this template. Select a field from the specified table in the left column. Then enter the data to automatically populate in the right column.</td>
</tr>
<tr>
<td>Application</td>
<td>Field that is automatically set based on the scope of your organization.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
</tbody>
</table>

ServiceNow for Microsoft Teams

The ServiceNow integrations with Microsoft Teams help users to create a better, more connected experience for their users. It drives productivity for the entire enterprise as employees get seamless self-service and agents can resolve their cases faster.

ServiceNow for Microsoft Teams extends the Now Virtual Agent integration with Microsoft Teams to enable employees to more effectively request and receive service from within Microsoft Teams.

The table below depicts the plugins available for ServiceNow integrations with Microsoft Teams.
### ServiceNow integrations with Microsoft Teams plugins

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
<th>Use case</th>
<th>Dependent plugins</th>
</tr>
</thead>
</table>
| IT Service Management integration with Microsoft Teams                 | This application enables employees to effectively request and receive IT service from within Microsoft Teams. It extends the Now Virtual Agent integration to improve the experience and offers advanced features where an agent can initiate chat on Microsoft Teams with an employee.                                                                                          | • Offer IT services through Microsoft Teams to improve employee and agent productivity.  
• Enable IT agents to initiate chat with an employee via Microsoft Teams                                                                                                                                       | This plug-in automatically installs the below plugins:  
• Microsoft Teams Graph Spoke  
• ServiceNow for Microsoft Teams  
• Collaboration Services  
You need to install the Notify Connector for Microsoft Teams app, to make a Microsoft Teams call from the Agent Workspace.                                                                  |
| HR Service Delivery Management with Microsoft Teams                    | This application enables employees to create HR cases and communicate with agents to resolve them quickly within Microsoft Teams. It extends the Now Virtual Agent integration to improve the experience and offers advanced features where an agent can initiate chat on Microsoft Teams with an employee.                                                                                                           | • Offer HR services through Microsoft Teams as an additional channel  
• Enable HR agents to initiate chat with an employee via Microsoft Teams  
                                                                                                                                     | This plug-in automatically installs:  
• Microsoft Teams Graph Spoke  
• ServiceNow for Microsoft Teams  
• Collaboration Services  
• Virtual Agent for HR Service Delivery (Human Resources Scoped App: Virtual Agent Conversations (com.sn_hr_virtual_agent) )                                                                                                                                                                                                                       |
| Conversational Integration with Microsoft Teams                       | Conversational Integration with Microsoft Teams plugin makes the ServiceNow Virtual Agent available on Microsoft Teams.                                                                                                                                                                                                                                               | • Enable ServiceNow Virtual Agent on Microsoft Teams.                                                                                                          | This application gets installed with IT Service Management integration with Microsoft Teams and HR Service Delivery                                                                                                                                                                                                                      |
## ServiceNow integrations with Microsoft Teams plugins (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
<th>Use case</th>
<th>Dependent plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversational Integration with Microsoft Teams</td>
<td>Microsoft Teams. Supports Virtual Agent features such as Virtual Agent designer controls for creating conversations, notifications, AI Search results, and more.</td>
<td>Note: If you require only the Virtual Agent features on Microsoft Teams, you need to install this plugin. The IT Service Management integration with Microsoft Teams and HR Service Delivery Management with Microsoft Teams plugins provide advanced features built on top of this integration.</td>
<td>Management with Microsoft Teams plugins.</td>
</tr>
<tr>
<td>Notify connector for Microsoft Teams</td>
<td>Enables the agents to manage and initiate a Microsoft Teams call directly from any record such as an incident, or a task.</td>
<td>• Enable agents to initiate a Microsoft Teams call or meeting with an employee directly from their Workspace or from Agent Chat. • Work and manage the major incidents from Major Incident Management (MIM) workbench through Microsoft Teams.</td>
<td>You need to install either IT Service Management integration with Microsoft Teams and HR Service Delivery Management with Microsoft Teams plugins to enable the agents to make calls. To effectively perform major incident management through Microsoft Teams, customers must have the meeting extension for Microsoft Teams app.</td>
</tr>
<tr>
<td>Meeting Extensibility for Microsoft Teams</td>
<td>It enables the incident manager, and the participants of an active Microsoft Teams conference call, to view the incident details and the communication tasks from the major incident workbench.</td>
<td>Perform Major Incident Management (MIM) through Microsoft Teams.</td>
<td>Customers must install Notify Connector Microsoft Teams Connector plugin before installing this.</td>
</tr>
</tbody>
</table>
### ServiceNow integrations with Microsoft Teams plugins (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
<th>Use case</th>
<th>Dependent plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Teams Graph spoke</td>
<td>This application provides the actions required to manage chat-based collaboration on Microsoft Teams for your ServiceNow app except calling functionality.</td>
<td>Build custom integrations for Microsoft Teams.</td>
<td>This plug-in is automatically installed in the backend as needed.</td>
</tr>
<tr>
<td>Microsoft Teams Communications spoke</td>
<td>It provides the actions you need to manage meetings calling functionality via Microsoft Teams.</td>
<td>Build custom integrations for Microsoft Teams.</td>
<td>It gets automatically installed through the Notify Connector for Microsoft Teams application</td>
</tr>
</tbody>
</table>

If you want to install both **IT Service Management integration with Microsoft Teams** application and **HR Service Delivery integration with Microsoft Teams** application, you need to configure your ServiceNow instance only once. To configure ServiceNow instance for Microsoft Teams, perform the setup tasks.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Setup</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow store release notes</td>
<td>Install IT Service Management integration with Microsoft Teams</td>
<td>• Employee actions</td>
</tr>
<tr>
<td></td>
<td>• application</td>
<td>• Agent actions</td>
</tr>
<tr>
<td></td>
<td>Install HR Service Delivery integration with Microsoft Teams</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Teams application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setup and configure IT Service Management integration with Microsoft Teams</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Teams</td>
<td></td>
</tr>
</tbody>
</table>
Overview of IT Service Management integration with Microsoft Teams

IT Service Management integration with Microsoft Teams extends the Now Virtual Agent integration with Microsoft Teams to enable employees to more effectively request and receive service from within Microsoft Teams.

The IT Service Management integration with Microsoft Teams application includes the following additional capabilities:

• Actionable notifications – for approval and comments on tickets. Users can reply on the notifications from within Microsoft Teams.
  ◦ Approval – for Request (single Requested Item), Change Request
  ◦ Ticket comments: Employees are able to respond to notifications on the tickets from within Microsoft Teams: Incident, Requested Item, and Change Request.

• Provides agents the ability to initiate a Microsoft Teams chat with an employee from an incident, change request, and request item and then to copy the chat transcript back to the ticket as a comment.

• Additional informational notifications for:
  ◦ Incident: Resolved, Updated
  ◦ Requested Item: Completed, Approved, Rejected, Updated
  ◦ Approval (for all approvals other than Request (with a single requested item), and Change Request)

⚠️ Note: Approvals with e-Signature are not yet supported for IT Service Management integration with Microsoft Teams.

Feature mapping

<table>
<thead>
<tr>
<th>Feature</th>
<th>License Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actionable Notifications</td>
<td>ITSM Pro</td>
</tr>
<tr>
<td>Chat - Agent to Employee/Agent to Agent</td>
<td>ITSM Standard or above</td>
</tr>
<tr>
<td>Employee Dashboard</td>
<td>ITSM Standard or above</td>
</tr>
</tbody>
</table>

An enhanced version of the Your Hub dashboard is available with Employee Service Center.

You need to perform the following activities to configure IT Service Management integration with Microsoft Teams in ServiceNow instance:

1. Install IT Service Management integration with Microsoft Teams application
2. Setup and configure IT Service Management integration with Microsoft Teams
3. Configure IT Service Management integration with Microsoft Teams

Setup and configure IT Service Management integration Microsoft Teams

The IT Service Management integration with Microsoft Teams application uses the Now Virtual Agent in application. Customers already using the Now Virtual Agent application can skip the configuration process.

However, you must configure the application you are using in your environment to use Your Hub dashboard and Request based chat features. For more information, visit Configure IT Service Management integration with Microsoft Teams and Configure HR Service Delivery integration with Microsoft Teams.
The following steps are common for **IT Service Management integration with Microsoft Teams**, **HR Service Delivery integration with Microsoft Teams** and **Universal Request integration with Microsoft Teams** applications and must be done only once.

**Admin setup and tasks**
Configuring ServiceNow with Microsoft Teams application involves setup and installation tasks that you and your users must perform.

**Install IT Service Management integration with Microsoft Teams application**
Install the IT Service Management integration with Microsoft Teams application for the collaboration between the agents and employees.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System Application > All Available Applications > All**.
2. In the search field, enter **IT Service Management integration with Microsoft Teams**. You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.
3. Click **Install** button.
   
   ! **Note:** All the dependent plugins are automatically installed in this process.

   You must also install the fix_script_start_chat_field_decorator_IT update set to have a field decorator in a ticket to initiate a chat with the requester. Visit the app store IT Service Management integration with Microsoft Teams to download the fix script.

**Install fix-script for IT Service Management integration with Microsoft Teams**
Install the fix_script_start_chat_field_decorator_IT in the ServiceNow instance to display **Start Microsoft Teams chat** field decorator in the ticket to initiate a chat with the requester.

**Before you begin**
Role required: admin

Download the fix_script_start_chat_field_decorator_IT update set from the app store. Visit the app store IT Service Management integration with Microsoft Teams to download the fix script.
Procedure

1. Navigate to System Update Sets > Related Links > Import Update Set from XML.

2. In the XML file field, click Choose file button and select fix_script_start_chat_field_decorator_IT XML file and upload the XML file.

3. Click Fix script to add start Microsoft Teams chat field decorator.

4. Click Preview Update Set.
5. Click **Commit Update Set**.

The Fix script to add start Microsoft Teams chat field decorator will be in Committed state.
6. Navigate to **System Definition** > **Fix Scripts**.

7. In the **Name** search field, enter **Add Teams chat Field Decorator**.

8. Click **Add Teams chat Field Decorator** fix script.

9. Check **Active** check box.

10. Click **Run Fix Script** button.

    The icon is displayed as a field decorator in a record.

**Setup and configure IT Service Management integration with Microsoft Teams**

Setup the IT Service Management integration with Microsoft Teams in your instance.

To connect your ServiceNow instance to your M365 tenant and to Authorize apps, the user must have both the external_app_install_admin role as well as the application administrator role in M365. Application administrator is a Microsoft driven role, for more information on roles, refer [Azure AD built-in roles](#).

**Note:**

The following steps are common for both **IT Service Management integration with Microsoft Teams** and the **HR Service Delivery integration with Microsoft Teams** applications and must be done only once.

**Setup and configure IT Service Management integration with Microsoft Teams for multi-tenant**

Configure the IT Service Management integration with Microsoft Teams using the multi-tenant app. You can use the Microsoft Azure apps instead of creating a separate Microsoft Azure app for the integration.

The following steps are common for **IT Service Management integration with Microsoft Teams**, and **HR Service Delivery integration with Microsoft Teams** applications and must be done only once.

**Connect the ServiceNow instance to your Microsoft Teams tenant**

Connect your ServiceNow instance to your Microsoft Teams tenant to enable the users to create their requests from within Microsoft Teams.
Before you begin
Role required: External admin (external_app_install_admin)

Procedure
1. Navigate to ServiceNow for Microsoft Teams > Install Azure apps.
2. Click Install to install Microsoft Teams in your instance.
   This connects your tenant to the ServiceNow instance.
3. Select the Consent on behalf of your organization option to provide the consent for all your
   users, and click Accept button to provide the admin consent.

Permissions requested
Tab SSO
ServiceNow

This app would like to:

✓ View users' basic profile
✓ Maintain access to data you have given it access to
✓ Consent on behalf of your organization

If you accept, this app will get access to the specified resources for all users in your organization. No one else will be prompted to
review these permissions.

Accepting these permissions means that you allow this app to
use your data as specified in their terms of service and privacy
statement. The publisher has not provided links to their terms
for you to review. You can change these permissions at
https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

Cancel Accept
Tab SSO is one of the apps to verify the users and connect the Microsoft tenant to the ServiceNow instance. Provide the desired Microsoft tenant details to connect to the ServiceNow instance.

Select the **Consent on behalf of your organization** option to provide the consent for all your users.

**Note:** If you do not select **Consent on behalf of your organization** option, each individual user must accept the permissions in order to use the respective functionality. Consenting on behalf of the organization will improve the first time user experience.

If you have installed the single-tenant app, and upgrade to the multi-tenant app, all the configuration (client ID, tenant ID, and the OIDC configuration) will be automatically updated when you install the multi-tenant app. Your users have no impact when you upgrade from single-tenant to multi-tenant app.

### Authorize multi-tenant Azure apps to grant required permissions
Authorize the multi-tenant apps to enable ServiceNow to make API calls to Microsoft to enable each of the ServiceNow for Teams application workflows.

#### Before you begin
Role required: External admin (external_app_install_admin) (This role is available out of the box for users and is a part of channel proxy plugin)

Install Virtual Agent Lite or Virtual Agent. For more information on installing Virtual Agent, refer [Virtual Agent integrations with messaging apps](#).

Install Notify Connector for Microsoft Teams to use chat to call feature. For more information on installing the Notify Connector for Microsoft Teams, refer [Notify connector for Microsoft Teams](#).

#### About this task
The ServiceNow for Teams multi-tenant apps comprise the following apps:

- Tab SSO
- Notify Connector
- Request-Based Chats

To connect your ServiceNow instance to your M365 tenant and to Authorize apps, the user must have both the external_app_install_admin role as well as the application administrator role in M365. Application administrator is a Microsoft driven role, for more information on roles, refer [Azure AD built-in roles](#).
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Install Azure apps.

2. Authorize the apps as required.

   a. Click Authorize for Notify Connector.

      i. Provide the admin consent by clicking on Accept button.

      This authorizes to create a new app for Meeting extensibility app, and to create a new tab for a major incident meeting from the major incident workbench in Microsoft Teams.
Permissions requested
Review for your organization

Notify Connector
ServiceNow

This app would like to:

✓ Sign in and read user profile
✓ Read all users' full profiles
✓ Read and create online meetings
✓ Join group calls and meetings as a guest
✓ Join group calls and meetings as an app
✓ Initiate outgoing group calls from the app
✓ Initiate outgoing 1 to 1 calls from the app
✓ Manage Teams apps for all chats
✓ Allow the Teams app to manage all tabs for all chats

If you accept, this app will get access to the specified resources for all users in your organization. No one else will be prompted to review these permissions.

Accepting these permissions means that you allow this app to use your data as specified in their terms of service and privacy statement. The publisher has not provided links to their terms for you to review. You can change these permissions at https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

[Cancel] [Accept]

Upon successful authorization, the app is shown as Installed.
b. Click **Authorize** for Request-based Chats app.
   
   i. Provide the admin consent by clicking on **Accept** button.
Permissions requested
Review for your organization

Request Based Chats
ServiceNow

This app would like to:
- Read user chat messages
- Read and write user chat messages
- Maintain access to data you have given it access to
- Sign in and read user profile
- Read all users’ basic profiles
- Read all files that user can access
- Read names and members of user chat threads
- Create chats

If you accept, this app will get access to the specified resources for all users in your organization. No one else will be prompted to review these permissions.

Accepting these permissions means that you allow this app to use your data as specified in their terms of service and privacy statement. The publisher has not provided links to their terms for you to review. You can change these permissions at https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

Cancel  Accept

On successful authorization, the app is shown as Installed.
c. Click **Authorize** for Tab SSO.
   i. Provide the admin consent by clicking on **Accept** button.
Upon successful authorization, the app is installed in the instance.

Create OAuth OIDC Provider Configuration record in ServiceNow

Create the OIDC provider configuration record that enables the users to connect to meetings in Microsoft Teams application.

Before you begin
Role required: admin

Ensure that you install the Azure apps in your environment.

About this task
This step is only required if the upn is different from email ID.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Click the OIDC record in the format Azure AD – sso - <tenantname>. Where <tenantname> is the name of your tenant.
3. Preview the OAuth OIDC Provider Configuration entry.
4. Click Open Record.
5. In the **User Claim** field, provide the value as email.

Change tenant to configure multi-tenant apps

Change the tenant to use multi-tenant apps in your environment.

**Before you begin**
Role required: External admin (external_app_install_admin)

**About this task**
If you have already set up a connection on a different Microsoft Teams tenant, changing to a new tenant will stop the integration from working on the originally configured tenant. All users using the integration on the original tenant will no longer be able to use it. If you are only changing from single-tenant Azure apps to multi-tenant Azure apps, but keeping the integration on the same Microsoft Teams tenant, there will not be an impact to users.

**Procedure**

1. Navigate to **ServiceNow for Microsoft Teams > Install Azure apps**.

2. Click **Install** to install Microsoft Teams in your instance.

   This connects your tenant to the ServiceNow instance.

3. Select the **Consent on behalf of your organization** option to provide the consent for all your users, and click **Accept** button to provide the admin consent.
Select the **Consent on behalf of your organization** option to provide the consent for all your users.

4. Click **Change tenant** to map the tenant with your new ServiceNow instance.

Once the tenant is mapped with the ServiceNow instance, you must authorize the apps by providing the admin consent.

The Notify Connector and Import Chat apps appear only if you install Notify plugin in your instance.
- **Tab SSO**: Authorize this app to display *Your Hub* tab in Microsoft Teams app.
- **Notify Connector**: Authorize this app to enable agents to initiate a Microsoft Teams meeting from a task record.
- **Request-based Chats**: Authorize this app to enable the agents to initiate chat in Microsoft Teams and import chat messages to the respective record.

5. Authorize the apps as required.

**What to do next**
You need to upload the manifest file in Microsoft Teams. For more information, refer [Create and download the manifest file](#).

**Create and download the manifest file**
Create and download the ServiceNow for Microsoft Teams manifest file from your instance to enable Microsoft Teams to use the ServiceNow for Teams app.

**Before you begin**
Role required: `external_app_install_admin`

**About this task**
You can connect multiple ServiceNow instances to one Microsoft Teams tenant. Only one multi-tenant setup can be connected to the Microsoft Teams tenant, however, you can connect multiple single-tenant environments to the Microsoft Teams Tenant since you can create separate Azure apps for each single tenant environment.

**Procedure**

1. Navigate to *ServiceNow for Microsoft Teams > Application Manifest > ServiceNow for Teams*.
2. Click **New**.

   ![The Generic Info tab appears.](image)

The **Generic Info** tab appears.
3. In the **Generic Info** section, enter the details.

a. **Short name**: Option to provide a short name for the manifest file.

b. **Full name**: Option to provide the complete name for the manifest file.

c. **Version**: Version of the manifest file. Ex: 1.0.0

d. **Unfurl Links**: Option to unfurl the links in Microsoft Teams.
   
   Link unfurling generates a content-rich preview (adaptive card) when a supported link is shared in a conversation with a user in Microsoft Teams. For more details about link unfurling, refer [Unfurl the web links in Microsoft Teams chat conversations](#).

e. **Short description**: Short description about the manifest file.

f. **Description**: Detailed description about the manifest file.

g. **Accent Color**: Option to choose a custom color for the conversations in Microsoft Teams as per the company branding. The accent color should be in HTML color code format.

   **Note**: If you want to customize the company branding, clear the **Use default images** option and then upload the icons. For more information on the size of icons, refer [App icons](#) and [manifest schema icons](#).

4. Click **Submit**.

5. In the **Generic Info** section, click **Next** to navigate to **Configure Virtual Agent** tab.
6. In the **Configure Virtual Agent** section, do one of the following.

To configure the Virtual Agent in your instance, click **Configure Virtual Agent**. For more information, see Conversational Integration with Microsoft Teams.

- If you want to connect one ServiceNow instance to a Microsoft Teams tenant, select **Connect one ServiceNow instance to one Microsoft Teams Tenant**. The Virtual Agent Bot ID is auto-populated if you select this option.

- If you want to connect multiple ServiceNow instances to one Microsoft Teams tenant, select **Connect multiple ServiceNow instances to one Teams Tenant**.
a. Click **Configure Virtual Agent**.

b. On the form, fill the fields.

i. **Tenant ID**: Option to enter the tenant ID. Capture the tenant ID of the Azure app from the Azure portal.

ii. **Client ID (App ID)**: Option to enter the client ID. Capture the client ID of the Azure app from the Azure portal.

iii. **Client Secret**: Option to enter the client secret. Capture the client secret of the Azure app from the Azure portal.

iv. **Bot Name**: Option to provide the bot name.

v. Click **Submit**.

The application is redirected to the manifest configuration page.

7. In the **Configure Tab** section, enter the following.
a. **Enable tabs**: Option to add tabs in Microsoft Teams application. Select the Enable tabs check box.

b. **Tab name**: Option to provide a name for the Service portal tab that appears in Microsoft Teams.

c. **Click Next**.

![Image of Microsoft Teams configuration]

For single tenant, you must provide the Application (client) ID and Directory (tenant) ID in the **Configure Tab** section.

![Image of Application and Directory IDs]

8. In the **Ready** section, verify the details provided and click **Download Manifest** to download the manifest file.

![Image of Download Manifest button]

The manifest file downloads in the zip format.

9. **Launch Microsoft Teams application.**

10. **Navigate to Apps > Upload a customised app.**

11. **Navigate to the location where the manifest file is downloaded and select the zip file.**

12. **Click Open.**

The **ServiceNow for Teams** appears in **Apps** screen.
13. Click **ServiceNow for Teams** app.

14. Click **Add**.

The ServiceNow for Teams app appears in Microsoft Teams.
• **Chat:** Begin your conversation with the Virtual Agent to get help.

![Chat Image]

• **Employee Center:** Click **Employee Center** tab to view the organization updates and the status on your tasks and requests.

![Employee Center Image]

⚠️ **Note:** If you don’t want to create a manifest file, you can edit an existing manifest file as required. Upon updating the existing manifest file, you can download and upload the manifest file in Microsoft Teams to make the changes effective.

---

**Manage Now Virtual Agent permission policies**

Disable the NOW Virtual Agent app to avoid duplicate notifications from Microsoft Teams when you install and integrate ServiceNow for Microsoft Teams app with ServiceNow instance.

**Before you begin**

⚠️ **Note:** Your employees will not see or use the Now Virtual Agent app.

Role required: Microsoft Teams admin
About this task
ServiceNow has two apps available for Microsoft Teams:

• **Now Virtual Agent**
  This app displays Virtual Agent within Microsoft Teams, has been available within Microsoft Teams app since 2019.

• **ServiceNow for Microsoft Teams**
  ServiceNow for Microsoft Teams is a new app that provides a broader employee experience, including and expanding beyond Virtual Agent, with an embedded portal experience called **Your Hub**, and the ability for agents to reach out to employees in Microsoft Teams to quickly resolve open tickets.

Since the same Bot (Virtual Agent) is shared in both apps, blocking the Now Virtual Agent app also results in the same bot ID being blocked for the ServiceNow for Microsoft Teams app, making the Virtual Agent unusable in the ServiceNow for Microsoft Teams app. To work around this, it is necessary to make sure that the Now Virtual Agent app is in the list of allowed apps.

You must first block the **Now Virtual Agent** app, so that it stops showing up for employees and then add the app to the allowed list. After this configuration, your employees will not see or use the Now Virtual Agent app, but will be able to use Virtual Agent within the **ServiceNow for Microsoft Teams** app.

**Procedure**

1. Login to Microsoft Teams admin portal.
2. Navigate to **Teams apps > Manage apps**.
3. In the search field, enter **NOW Virtual Agent**.
4. Click **NOW Virtual Agent** app.
5. Swipe the status to block the app.
6. Navigate to Teams apps > Permission policies.

7. Select Allow specific apps and block others for Third-party apps and Custom apps.

a. Ensure that NOW Virtual Agent app is allowed for Third-party apps.

b. Ensure ServiceNow for Teams app is allowed for Custom apps.

8. Click Save.

Install ServiceNow for Teams app

Enables users to interact with the agents from Microsoft Teams application.
Before you begin
Role required: admin

Procedure
1. Launch Microsoft Teams application.
2. Click Apps menu.
3. Click Upload a custom app.
4. Select the manifest file from the directory, and click Open.
5. Click ServiceNow for Teams app.
6. Click Add.

Results
The ServiceNow for Teams app appears in Microsoft Teams.

Connect Virtual Agent in Microsoft Teams with ServiceNow instance
ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Before you begin
Note the following important issues before installing:

• The Virtual Agent integration with Microsoft Teams creates a one-to-one association between the ServiceNow instance that you are installing from and the Microsoft Teams tenant in which the integration runs. Use a separate Microsoft Teams tenant for each instance that you plan to install the integration in.

• The Virtual Agent integration is only supported for users who have a user record in ServiceNow.

• ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Roles required:
• virtual_agent_admin and external_app_install_admin or admin
• Administrator for third-party applications

Procedure
1. Navigate to Collaboration > Messaging Apps Integration.
2. Click Install that appears next to Microsoft Teams.
3. In the Entering a third-party site dialog, click OK.
4. Log in to Microsoft Teams.

5. On the Microsoft dialog box, click **Accept**.

6. If the selected tenant has already been assigned to NOW Virtual Agent, click **Override** to change the tenant or **Cancel** to leave the current assignment in place.

7. Click **Go to MS Teams** to log in to Microsoft Teams.

8. Click **Apps** menu.

9. In the search field, enter **ServiceNow for Microsoft Teams**.

10. Click **ServiceNow for Microsoft Teams** app.
11. Click **Open** button to add the app to Microsoft Teams.

12. In your instance, check the Messaging Apps Integration page **Collaboration > Messaging Apps Integration** to verify the installation.

   ![Microsoft Teams Integration](image)

   **Note:** Select **Enable notifications for all users** option, to receive non-actionable notifications (Provider Notifications).

**Translate the Microsoft Teams manifest file**

ServiceNow for Microsoft Teams supports localization to multiple languages, using UTF-8 for international characters.

You must activate the localized plugins in your instance. To install the language plugin, see **Activate a language**.

After installing the language plugin, you must create and download the manifest file and upload the file to Microsoft Teams. To download the manifest file, refer **Create and download the manifest file**.

**Setup and configure IT Service Management integration with Microsoft Teams for single-tenant**

Configure the IT Service Management integration with Microsoft Teams using the single-tenant app.

If you have a single tenant environment, you need to perform the following setup procedures to integrate ServiceNow with Microsoft Teams.

You may need to use single tenant setup in certain cases due to your company or regulatory requirements.

The following steps are common for both **IT Service Management integration with Microsoft Teams** and the **HR Service Delivery integration with Microsoft Teams** applications and must be done only once.

**Note:** After completing the common setup, you need to configure the **IT Service Management integration with Microsoft Teams** and **HR Service Delivery integration with Microsoft Teams**. For more information, visit **Configure IT Service Management integration with Microsoft Teams** and **Configure HR Service Delivery integration with Microsoft Teams**.

**Create Microsoft Azure application to authenticate Microsoft Teams users with ServiceNow**

Create a Microsoft Azure application in Microsoft Azure portal to enable agents to import the conversations and access **Your Hub** dashboard from Microsoft Teams to ServiceNow.

**Before you begin**

Role required: admin

**Note:** You can use one Microsoft Azure application if you use both **IT Service Management integration with Microsoft Teams**, and **HR Service Delivery integration with Microsoft Teams** applications.
Procedure
1. Log in to Microsoft Azure portal.
3. Click New registration. The New registration page displays.
4. On the New registration form, perform the following actions:
   a. Name: Enter the name of your application. Example: ServiceNow Auth app.
   b. Redirect URI: Enter https://<instance-name>/sn_now_teams_ms_login_redirect.do, where <instance-name> is the name of your ServiceNow instance.
5. Click Register.
6. Click Redirect URIs.
7. Select the Access tokens check box.
8. Click Save.

Authenticate users to access Your Hub dashboard
Assign permissions to users to view Your Hub dashboard in Microsoft Teams application.

Before you begin
Role required: admin

Procedure
1. Log in to Microsoft Azure portal.
3. Click the app created to enable agents to import the conversations from Microsoft Teams to the ServiceNow instance. Example: ServiceNow Auth app.


5. Navigate to Add a platform > Web applications > Web.

6. On the Configure Web form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirect URIs</td>
<td>Provide the redirect URI. The redirect URI should be in the format: https://&lt;instance-url&gt;/sn_now_teams_ms_login.do where &lt;instance-url&gt; is the URL of your ServiceNow instance.</td>
</tr>
<tr>
<td>Implicit grant</td>
<td>Check Access tokens, and ID tokens.</td>
</tr>
</tbody>
</table>
7. Click Configure.
8. Navigate to Manage > API Permissions > Add a permission > Microsoft Graph.
9. Click Delegated permissions.
10. Click Openid permissions accordion, and select email, offline_access, openid, and profile check-boxes.
11. Click Add permissions.

12. In the API permissions screen, click Grant admin consent for {tenant} link.

13. Click Yes on the pop-up dialog box.

14. Navigate to Manage > Expose an API.

15. Click Set against Application ID URI, and enter the application URI in the format: api:// {instance}.service-now.com/{client_id}.

16. Click Save.

17. Click Add a scope. In the Add a scope form, fill the following fields.

### Add a scope form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope name</td>
<td>access_as_user</td>
</tr>
<tr>
<td>Who can consent</td>
<td>Admins and users</td>
</tr>
<tr>
<td>Admin consent display name</td>
<td>Teams can access the user's profile.</td>
</tr>
<tr>
<td>Admin consent description</td>
<td>Allows Teams to call the app’s web APIs as the current user.</td>
</tr>
<tr>
<td>User consent display name</td>
<td>Teams can access the user profile and make requests on the user's behalf.</td>
</tr>
<tr>
<td>User consent description</td>
<td>Enable Teams to call this app’s APIs with the same rights as the user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>State</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

18. Click **Add scope** button.

19. Navigate to **Authorized client applications > Add a client application**.

20. In the **Add a client application** form, fill the fields.

### Add client application form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>• Microsoft Teams mobile/desktop application: 1fec8e78-bce4-4aaf-ab1b-5451cc387264</td>
</tr>
<tr>
<td></td>
<td>• Value for Microsoft Teams web application: 5e3ce6c0-2b1f-4285-8d4b-75ee78787346</td>
</tr>
<tr>
<td>Authorized scopes</td>
<td>Check the authorized scope</td>
</tr>
</tbody>
</table>
For more information on the client IDs, refer Single sign-on (SSO) support for tabs.

Authorized client applications

Authorizing a client application indicates that this API trusts the application and users should not be asked to consent when the client calls this API.

Add a client application

<table>
<thead>
<tr>
<th>Client Id</th>
<th>Scopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>5e3c6e6c-2b1f-4285-6d4b-75ee78787345</td>
<td>1</td>
</tr>
<tr>
<td>1f2ebe78-bce4-4aaf-ab1b-5451cc387264</td>
<td>1</td>
</tr>
</tbody>
</table>

21. Click Add application button.

Copy the Application (client) ID, and Directory (tenant) ID from the application overview page in the Microsoft Azure portal to update the details in the ServiceNow instance.

Create OAuth OIDC Provider Configuration record in ServiceNow

Create the OIDC provider configuration record that enables the users to connect to meetings in Microsoft Teams application.

Before you begin
Role required: admin

Ensure that you install the Azure apps in your environment.

About this task
This step is only required if the upn is different from email ID.

Procedure

1. Navigate to System OAuth > Application Registry.

2. Click the OIDC record in the format Azure AD – sso - <tenantname>. Where <tenantname> is the name of your tenant.

3. Preview the OAuth OIDC Provider Configuration entry.
4. Click **Open Record**.

5. In the **User Claim** field, provide the value as **email**.

---

**Create and download the manifest file**

Create and download the ServiceNow for Microsoft Teams manifest file from your instance to enable Microsoft Teams to use the ServiceNow for Teams app.

---

**Before you begin**

Role required: **external_app_install_admin**

---

**About this task**

You can connect multiple ServiceNow instances to one Microsoft Teams tenant.

Only one multi-tenant setup can be connected to the Microsoft Teams tenant, however, you can connect multiple single-tenant environments to the Microsoft Teams Tenant since you can create separate Azure apps for each single tenant environment.

---

**Procedure**

1. Navigate to **ServiceNow for Microsoft Teams > Application Manifest > ServiceNow for Teams**.

2. Click **New**.

The **Generic Info** tab appears.
3. In the **Generic Info** section, enter the details.

   a. **Short name**: Option to provide a short name for the manifest file.

   b. **Full name**: Option to provide the complete name for the manifest file.

   c. **Version**: Version of the manifest file. Ex: 1.0.0

   d. **Unfurl Links**: Option to unfurl the links in Microsoft Teams.

      Link unfurling generates a content-rich preview (adaptive card) when a supported link is shared in a conversation with a user in Microsoft Teams. For more details about link unfurling, refer [Unfurl the web links in Microsoft Teams chat conversations](#).

   e. **Short description**: Short description about the manifest file.

   f. **Description**: Detailed description about the manifest file.

   g. **Accent Color**: Option to choose a custom color for the conversations in Microsoft Teams as per the company branding. The accent color should be in HTML color code format.

      **Note**: If you want to customize the company branding, clear the **Use default images** option and then upload the icons. For more information on the size of icons, refer [App icons](#) and [manifest schema icons](#).

4. Click **Submit**.

5. In the **Generic Info** section, click **Next** to navigate to the **Configure Virtual Agent** tab.
6. In the **Configure Virtual Agent** section, do one of the following.

To configure the Virtual Agent in your instance, click **Configure Virtual Agent**. For more information, see Conversational Integration with Microsoft Teams.

- If you want to connect one ServiceNow instance to a Microsoft Teams tenant, select **Connect one ServiceNow instance to one Microsoft Teams Tenant**. The Virtual Agent Bot ID is auto-populated if you select this option.

- If you want to connect multiple ServiceNow instances to one Microsoft Teams tenant, select **Connect multiple ServiceNow instance to one Teams Tenant**.
a. Click **Configure Virtual Agent**.

b. On the form, fill the fields.
   
i. **Tenant ID**: Option to enter the tenant ID. Capture the tenant ID of the Azure app from the Azure portal.

   ii. **Client ID (App ID)**: Option to enter the client ID. Capture the client ID of the Azure app from the Azure portal.

   iii. **Client Secret**: Option to enter the client secret. Capture the client secret of the Azure app from the Azure portal.

   iv. **Bot Name**: Option to provide the bot name.

   v. Click **Submit**.

The application is redirected to the manifest configuration page.

7. In the **Configure Tab** section, enter the following.
a. **Enable tabs**: Option to add tabs in Microsoft Teams application. Select the Enable tabs check box.

b. **Tab name**: Option to provide a name for the Service portal tab that appears in Microsoft Teams.

c. Click **Next**.

For single tenant, you must provide the Application (client) ID and Directory (tenant) ID in the **Configure Tab** section.

8. In the **Ready** section, verify the details provided and click **Download Manifest** to download the manifest file.

9. Launch Microsoft Teams application.

10. Navigate to **Apps > Upload a customised app**.

11. Navigate to the location where the manifest file is downloaded and select the zip file.

12. Click **Open**.

The **ServiceNow for Teams** appears in **Apps** screen.
13. Click **ServiceNow for Teams** app.

14. Click **Add**.

The ServiceNow for Teams app appears in Microsoft Teams.
• Chat: Begin your conversation with the Virtual Agent to get help.

![Microsoft Teams Chat](image)

• Employee Center: Click Employee Center tab to view the organization updates and the status on your tasks and requests.

![Microsoft Teams Employee Center](image)

Note: If you don’t want to create a manifest file, you can edit an existing manifest file as required. Upon updating the existing manifest file, you can download and upload the manifest file in Microsoft Teams to make the changes effective.

Verify and update application registry values
Verify and update the application registry values to authenticate the users in Microsoft Teams application.

Before you begin
Verify the ServiceNow for Microsoft Teams application registry and modify the Application (client) ID and Directory (tenant) ID if required after you create a manifest file.

Role required: admin

© 2022 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure
1. Navigate to **System OAuth > Application Registry**.
2. Click **ServiceNow for Microsoft Teams APP**.
3. Edit the entry.
4. On the **OAuth OIDC Entity – ServiceNow for Microsoft Teams app** form, fill the fields.

### OAuth OIDC Entity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Client ID                           | Verify and update the domain name and client ID in api://
|                                     | {domainName}/{clientID}                                                    |
| OAuth OIDC Provider Configuration   | Verify and update tenant ID value in https://
|                                     | sts.windows.net/{tenantID}/.well-known/openid-configuration/               |

**Note:**
If your app has custom signing keys as a result of using the claims-mapping feature, you must append an appid query parameter containing the app ID. For more information, refer the Microsoft documentation, [Validating the signature](https://sts.windows.net/f3211d0e-125b-42c3-86db-322b19a65a22/.well-known/openid-configuration?appId=<client_id>). The client ID can be fetched from the Microsoft Azure portal.

5. Right-click on the form header, and click **Save**.

**Manage Now Virtual Agent permission policies**
Disable the NOW Virtual Agent app to avoid duplicate notifications from Microsoft Teams when you install and integrate ServiceNow for Microsoft Teams app with ServiceNow instance.

**Before you begin**

**Note:** Your employees will not see or use the Now Virtual Agent app.

Role required: Microsoft Teams admin
About this task
ServiceNow has two apps available for Microsoft Teams:

• **Now Virtual Agent**
  
  This app displays Virtual Agent within Microsoft Teams, has been available within Microsoft Teams app since 2019.

• **ServiceNow for Microsoft Teams**
  
  ServiceNow for Microsoft Teams is a new app that provides a broader employee experience, including and expanding beyond Virtual Agent, with an embedded portal experience called **Your Hub**, and the ability for agents to reach out to employees in Microsoft Teams to quickly resolve open tickets.

Since the same Bot (Virtual Agent) is shared in both apps, blocking the Now Virtual Agent app also results in the same bot ID being blocked for the ServiceNow for Microsoft Teams app, making the Virtual Agent unusable in the ServiceNow for Microsoft Teams app. To work around this, it is necessary to make sure that the Now Virtual Agent app is in the list of allowed apps.

You must first block the **Now Virtual Agent** app, so that it stops showing up for employees and then add the app to the allowed list. After this configuration, your employees will not see or use the Now Virtual Agent app, but will be able to use Virtual Agent within the **ServiceNow for Microsoft Teams** app.

**Procedure**

1. Login to Microsoft Teams admin portal.
2. Navigate to **Teams apps > Manage apps**.
3. In the search field, enter **NOW Virtual Agent**.
4. Click **NOW Virtual Agent** app.
5. Swipe the status to block the app.
6. Navigate to Teams apps > Permission policies.

7. Select Allow specific apps and block others for Third-party apps and Custom apps.

   a. Ensure that NOW Virtual Agent app is allowed for Third-party apps.

   b. Ensure ServiceNow for Teams app is allowed for Custom apps.

8. Click Save.

   Install ServiceNow for Teams app

   Enables users to interact with the agents from Microsoft Teams application.
Before you begin
Role required: admin

Procedure
1. Launch Microsoft Teams application.
2. Click Apps menu.
3. Click Upload a custom app.
4. Select the manifest file from the directory, and click Open.
5. Click ServiceNow for Teams app.
6. Click Add.

Results
The ServiceNow for Teams app appears in Microsoft Teams.

Connect Virtual Agent in Microsoft Teams with ServiceNow instance
ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Before you begin
Note the following important issues before installing:
• The Virtual Agent integration with Microsoft Teams creates a one-to-one association between the ServiceNow instance that you are installing from and the Microsoft Teams tenant in which the integration runs. Use a separate Microsoft Teams tenant for each instance that you plan to install the integration in.
• The Virtual Agent integration is only supported for users who have a user record in ServiceNow.
• ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Roles required:
• virtual_agent_admin and external_app_install_admin or admin
• Administrator for third-party applications

Procedure
1. Navigate to Collaboration > Messaging Apps Integration.
2. Click Install that appears next to Microsoft Teams.
3. In the Entering a third-party site dialog, click OK.

Entering a third-party site

You are about to enter a third-party site to verify identity. Please have your login credentials ready in order to complete the installation process.

Cancel OK
4. Log in to Microsoft Teams.
5. On the Microsoft dialog box, click Accept.

6. If the selected tenant has already been assigned to NOW Virtual Agent, click Override to change the tenant or Cancel to leave the current assignment in place.

7. Click Go to MS Teams to log in to Microsoft Teams.
8. Click Apps menu.
9. In the search field, enter ServiceNow for Microsoft Teams.
10. Click ServiceNow for Microsoft Teams app.
11. Click **Open** button to add the app to Microsoft Teams.

12. In your instance, check the Messaging Apps Integration page **Collaboration > Messaging Apps Integration** to verify the installation.

⚠️ **Note:** Select **Enable notifications for all users** option, to receive non-actionable notifications (Provider Notifications).

Register the chat app with ServiceNow instance

Register the chat app with your instance to use Microsoft Teams chat for single-tenant environment.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System OAuth > Application Registry**.

2. Do one of the following.

   - If Microsoft Teams chat single tenant application registry is available, click on the application registry for Microsoft Teams.

   - If you want to create a new application registry entry, click **New** and select **Connect to a third party OAuth Provider**

3. On the form, fill the fields.

### Microsoft Teams chat for single tenant

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Microsoft Teams chat single tenant</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created in Azure portal. Provide the value of the Azure application ID in this field.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>The password you generated when creating the app in Microsoft Teams.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Authorization URL that includes the tenant ID of your app with the format &lt;br&gt;<a href="https://login.microsoftonline.com/%7Btenantid%7D/oauth2/v2.0/authorize">https://login.microsoftonline.com/{tenantid}/oauth2/v2.0/authorize</a> &lt;br&gt;where is the tenant ID created during the app creation in Microsoft Teams.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Token URL that includes the tenant ID of your app with the format &lt;br&gt;<a href="https://login.microsoftonline.com/%7Btenantid%7D/oauth2/v2.0/token">https://login.microsoftonline.com/{tenantid}/oauth2/v2.0/token</a></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Redirect URL that includes the instance URL with the format &lt;instanceURL&gt;/oauth_redirect.do Update the &lt;instanceURL&gt; value with your instance URL.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. Navigate to **ServiceNow for Microsoft Teams > Properties**.

6. Enable the option **Set this property to true to use integration hub action for Start Chat / Import chat flows**.

7. Click **Save**.

**Translate the Microsoft Teams manifest file**

ServiceNow for Microsoft Teams supports localization to multiple languages, using UTF-8 for international characters.

You must activate the localized plugins in your instance. To install the language plugin, see **Activate a language**.
After installing the language plugin, you must create and download the manifest file and upload the file to Microsoft Teams. To download the manifest file, refer to [Create and download the manifest file](#).

**Configure IT Service Management integration with Microsoft Teams**
Complete the following procedures to configure IT Service Management integration with Microsoft Teams.

**Customize IT Service Management integration with ServiceNow**
Customize the features in your instance to meet your organization needs.
You can customize:
- UI actions
- Business rules

**Customize business rules for actionable notifications**
Enables you to customize the business rules for actionable notifications.

**Before you begin**
Role required: admin

**Procedure**
2. Open a business rule you would like to extend to another table. Ex: Send comment to caller.
3. Click New.
4. On the UI Action form, fill the fields.

**UI action for business rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Send comment to caller is to be assigned.</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
<tr>
<td>Where to run</td>
<td>• When: after</td>
</tr>
<tr>
<td></td>
<td>• Insert: Check this box</td>
</tr>
<tr>
<td></td>
<td>• Update: Check this box</td>
</tr>
<tr>
<td></td>
<td>• Filter Conditions: Apply the filter condition of the Send comment to caller business rule</td>
</tr>
</tbody>
</table>
5. Click Submit.

**Customize Start Microsoft Teams chat UI action**

Enables you to extend the Start Microsoft Teams chat UI actions to the tables you require.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to ServiceNow for Microsoft Teams > UI Actions.
2. Open the existing Start Microsoft Teams chat UI action in a new window.
3. Click New.
4. On the UI action form, fill the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the UI action. Ex: Start Microsoft Teams chat</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Start Microsoft Teams chat UI action is to be available</td>
</tr>
<tr>
<td>Form button</td>
<td>Check this box</td>
</tr>
<tr>
<td>Show insert</td>
<td>Uncheck this box</td>
</tr>
<tr>
<td>Client</td>
<td>Check this box</td>
</tr>
<tr>
<td>Condition</td>
<td>Copy and paste the condition of the existing Start Microsoft Teams chat. Modify the column name as required.</td>
</tr>
<tr>
<td>Script</td>
<td>Copy and paste the script of the existing Start Microsoft Teams chat. Modify the column name as required.</td>
</tr>
<tr>
<td>Workspace Form Button</td>
<td>Check this box. Copy and paste the <strong>Workspace Client Script</strong> of the existing Start Microsoft Teams chat. Modify the column name as required.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Customize Import Messages from Microsoft Teams UI action**

Enables you to extend the Import Messages from Microsoft Teams UI action to the tables you require.
Before you begin
Role required: admin

Procedure
1. Navigate to ServiceNow for Microsoft Teams > UI Actions.
2. Open the existing Import Messages from Microsoft Teams UI action in a new window.
3. On the UI Actions screen, Click New.
4. On the UI Action form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the UI action. Ex: Import Messages from Microsoft Teams</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Import Messages from Microsoft Teams UI action is to be available</td>
</tr>
<tr>
<td>Form button</td>
<td>Check this box</td>
</tr>
<tr>
<td>Show insert</td>
<td>Uncheck this box</td>
</tr>
<tr>
<td>Client</td>
<td>Check this box</td>
</tr>
<tr>
<td>Condition</td>
<td>Copy and paste the condition of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
<tr>
<td>Script</td>
<td>Copy and paste the script of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
</tbody>
</table>
| Workspace Form Button | Check this box.  
Copy and paste the **Workspace Client Script** of the existing Import Messages from Microsoft Teams. Modify the column name as required. |

5. Click Submit.

Configure business rule for reassigning tickets
Configure the business rule for reassigning the tickets.

Before you begin
Role required: admin
Procedure

1. Navigate to **System Definition > Business Rules**.

2. Click **New**.

3. On the form, fill in the fields.

   In the **Advanced** tab, update the **Script** fields.
### Business rule for reassigning ticket

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the ticket should be re-assigned.</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
<tr>
<td>Where to run</td>
<td>• When: <strong>async</strong></td>
</tr>
<tr>
<td></td>
<td>• Update: Check this box</td>
</tr>
<tr>
<td></td>
<td>• Filter Conditions: Apply the filter condition of the reassigning the ticket business rule. Select the fields to which the ticket should be re-assigned. Ex: Assigned to field.</td>
</tr>
<tr>
<td>Advanced</td>
<td>• Script: Copy and paste the script. Modify the values as required.</td>
</tr>
<tr>
<td></td>
<td>Update the field name in the <code>assigned_to</code> if you are using a different value.</td>
</tr>
</tbody>
</table>

```javascript
var importChatUtils = new sn_tcm_collab_hook.MSTeamsImportChatUtils();
var chatUtil = new sn_tcm_collab_hook.MSTeamsChatUtil();

var azureIds =
  chatUtil.getAzureIds([current.getValue('assigned_to')]);  // Update the assigned_to field if required
var credentialAlias =
  chatUtil.getTeamsChatCredentialsAliasGr();
var chats =
  importChatUtils.getChatsofADocument(current.sys_id);
var azureId = '';```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>

```javascript
if (azureIds && azureIds.azureUserIds &&
    azureIds.azureUserIds.length > 0)
    azureId = azureIds.azureUserIds[0];

if (gs.nil(azureId)) {
    gs.addErrorMessage(gs.getMessage('Invalid Azure Id, cannot add user to Chat'));
    return;
}

chats.forEach(function(chat) {
    importChatUtils.addMemberToChat(chat, azureId, credentialAlias, current.getValue('assigned_to')); //Update the assigned_to field if required
});
```

4. Click **Submit**.

**Configure business rule for close condition**

Configure the business rule for close condition to auto-import the chats.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Definition > Business Rules**.

   ![System Definition Business Rules](image)

2. Click **New**.

3. On the form, fill in the fields.
In the Advanced tab, update the **Condition** and the **Script** fields.

### Business rule for close condition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the close condition is to be assigned.</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
<tr>
<td>Where to run</td>
<td>• When: <strong>async</strong>  &lt;br&gt; • Update: Check this box  &lt;br&gt; • Filter Conditions: Apply the filter condition of the close condition business rule</td>
</tr>
</tbody>
</table>
| Advanced  | • Condition: Copy and paste the value of the condition. Modify the values as required.  
  ```
  !current.avoid_closing_chat_records && new sn_tcm_collab_hook.MSTeamsImportChatUtils().hasMatchingCloseCondition(current)
  ``` |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Script: Copy and paste the value for the script. Modify the values as required.</td>
<td></td>
</tr>
<tr>
<td>new sn_tcm_collab_hook.MSTeamsImportChatUtils().closeChatStorageRecords(current);</td>
<td></td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Your Hub dashboard in Microsoft Teams**

Use the Your Hub dashboard from Microsoft Teams to view the widgets that show pending tasks, requests, and the internal company announcements.

Launch Microsoft Teams. Navigate to **ServiceNow for Microsoft Teams > Your Hub**.

You can customize the following in the Your Hub dashboard:

- Banner image
- Quick links widget
- Complete your to-dos widget
- Track your request widget
Your Hub

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner image</td>
<td>Welcome name, along with the count of requests, and to-dos</td>
</tr>
<tr>
<td>Visit your employee portal</td>
<td>Link to navigate to the employee portal</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>List of your pending tickets</td>
</tr>
<tr>
<td>Track your requests</td>
<td>List of your requests</td>
</tr>
<tr>
<td>IT announcements</td>
<td>IT announcements released by the IT department</td>
</tr>
<tr>
<td>Upcoming events</td>
<td>Upcoming events in your company</td>
</tr>
<tr>
<td>Holiday calendar</td>
<td>Upcoming holidays for the current year</td>
</tr>
<tr>
<td>IT outages</td>
<td>Active IT outage details</td>
</tr>
<tr>
<td>Find your apps</td>
<td>Apps provided by your company</td>
</tr>
</tbody>
</table>

If the Employee Service Center (com.sn_hr_service_portal) plugin is activated, Your Hub dashboard displays as shown in the screen below:

The banner will display the count of the tasks to be completed by the logged in user.
Quick Links

Visit your Employee portal displays in the quick links section. When you click this link, it will redirect to Employee Service Center portal.

![Visit your employee portal](image)

Complete Your To-dos

Complete your to-dos is displayed as the title of the widget.
The data is fetched from the sn_hr_sp.todos_config table and displays in the **Complete your to-dos** widget.

Each record displays the following attributes:

- Short description
- Requester (This field will not display if the requester field is empty)
- Due date of the record

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Abel Tuter</td>
<td>Due today</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Abraham Lincoln</td>
<td>Due today</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Arpita Gupta</td>
<td>Due today</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Arpita Gupta</td>
<td>Due today</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>

The table is showing 1-5 of 10 records.
Track your request

Customize the data to be displayed for the users in the track your request widget.

The data is fetched from the "request_filter" table and displays the pending requests for the user.

<table>
<thead>
<tr>
<th>Track your requests</th>
<th>1-6 of 24</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open 2h ago</strong></td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open 2h ago</strong></td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open 2h ago</strong></td>
</tr>
<tr>
<td><strong>Apple iPad 3</strong></td>
<td><strong>Open 2h ago</strong></td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open 2h ago</strong></td>
</tr>
</tbody>
</table>

Each record displays the following attributes:

- Short description
- State
Customize Script Includes

You can customize to display the data in Your Hub dashboard in Microsoft Teams.

Before you begin
Role required: admin

About this task
You can customize the approval notifications, and dashboard widgets for ServiceNow for Microsoft Teams application in your ServiceNow instance:

- Approval Notifications
- Your Hub dashboard widgets: Quick links, Complete your To-dos, Track your requests

Procedure

1. Navigate to System Definition > Script Includes.
2. Click PortalLinkConfig script include.
3. In the Script field, review the code-comments and add the quick links.

Customize script includes form

<table>
<thead>
<tr>
<th>Widget</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Notifications</td>
<td>You can customise the card fields in – MSTeamsApprovalNotificationUtil script include’s buildCardFieldsObj function for approval notification</td>
</tr>
<tr>
<td>Quick Links</td>
<td>You can specify up to five quick links under PORTAL_LINK_GROUP object.</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>You can override the portal in sn_now_teams.PortalLinkConfig script include. Override the implementation for getPortalSuffix: function(sourceGr) {} .</td>
</tr>
<tr>
<td>Track your requests</td>
<td>You can override the portal in sn_now_teams.PortalLinkConfig script include. Override the implementation for getPortalSuffix: function(sourceGr) {} .</td>
</tr>
</tbody>
</table>

4. Click Update.

Embed a custom portal dashboard

Embed your custom portal to replace the Your Hub dashboard in Microsoft Teams by configuring the system property.

Before you begin
Role required: admin

If you are using a custom portal, you can replace the embedded Your Hub dashboard with your custom portal, so that it is accessible within Microsoft Teams. The following steps take you through the configuration to embed your portal.
Procedure

1. In the navigation pane, enter sys_properties.list.

2. Search for sn_now_teams.portal.suffix property under Name.

3. Click sn_now_teams.portal.suffix.

4. Provide the value of your custom portal in Value field.

5. Click Update.

   Note: After you configure your custom portal, you must create a custom header for the embedded portal. For more information on adding header, refer Configure HTTP response headers.

Provide the values for the HTTP header response as defined:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that designates that this HTTP response header configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the custom portal record.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Specify Type</td>
</tr>
<tr>
<td>Type</td>
<td>Service Portal [sp_portal]</td>
</tr>
<tr>
<td>Record</td>
<td>Option to select the record for your custom portal</td>
</tr>
<tr>
<td>Name</td>
<td>Content-Security-Policy</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Frame-ancestors 'self' <a href="https://teams.microsoft.com">https://teams.microsoft.com</a></td>
</tr>
<tr>
<td>Description</td>
<td>Description for the HTTP response header</td>
</tr>
</tbody>
</table>

### Disable chat button in Microsoft Teams on custom portal

You can hide the chat option for your custom portal that appears in Microsoft Teams.

#### Before you begin

Role required: admin

#### Procedure

1. **Navigate to Service Portal > CSS.**

2. Click on your custom CSS.

3. Click **here** to edit the CSS.

4. Customize the following code as required and paste in the CSS.

```css
/* Embedded portal */

The code shared to disable chat button is an example. You need to customize as required to disable chat button.

.embedded-experience .sp-ac-btn {
    display: none;
}
```

5. Click **Update**.

6. Refresh the custom portal tab in Microsoft Teams.
Disable logout button in Microsoft Teams on custom portal

You can hide the logout option for your custom portal that appears in Microsoft Teams.

Before you begin
Role required: admin

Procedure

1. Navigate to Service Portal > CSS.

2. Click on your custom CSS.

3. Click here to edit the CSS.

4. To disable the logout button from Microsoft Teams desktop application.
   a. Customize the following code as required and paste in the CSS.

   /* Embedded portal */

   /* The code shared to disable the logout button is an example. You need to customize as required to disable logout button. */

   .embedded-experience .avatar-drop-down .header-menu-item:last-child {
     display: none;
   }

5. To disable the logout button from Microsoft Teams mobile application.
   a. Customize the following code as required and paste in the CSS.

   /* Embedded portal */

   /* The code shared to disable the logout button is an example. You need to customize as required to disable logout button. */
6. Click **Update**.

7. Refresh the custom portal tab in Microsoft Teams.

**Review the active notifications for Microsoft Teams**

The notifications added by ServiceNow for Microsoft Teams, might duplicate existing notifications in your instance. Review and disable any duplicate notifications to avoid notifying users multiple times for the same event.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Provider > Notifications**.

![System Notification Provider Notifications](image)

2. Identify a duplicate notification. Example: **Incident Update**.

3. Open the **Incident Update** notification.

4. Clear **Active**.
5. Click **Update**.

6. Repeat the process for the following notifications:
   - SysApproval Approver Insert
   - Incident Update
   - Requested Item Update

**Results**

Leave a comment on an incident record, only one notification appears about the comment in Microsoft Teams.

**Configure Chat group to include On-Call Scheduling users for Start Microsoft Teams Chat**

On Call Scheduling users will be shown for Start Microsoft Teams chat for an incident record. The users who are associated with On-Call Scheduling will be displayed on the Selected column in **Start Microsoft Teams Chat** modal.
sn_tcm_collab_hook.on_call_tables_for_start_chat_action system property is created to support this functionality. You can extend this functionality to change, and request tables.

Extend On-Call users for Start Microsoft Teams Chat
Shows the list of On-Call users in Start Microsoft Teams chat for a change, request, or a request item.

Before you begin
Role required: admin

Procedure
1. In the Navigation filter, enter sys_properties.list.
   The entire list of properties in the System Properties [sys_properties] table appears.
2. In the Name search field, enter `sn_tcm_collab_hook.on_call_tables_for_start_chat_action`.

3. Click on `sn_tcm_collab_hook.on_call_tables_for_start_chat_action` system property.

4. In the Value field, provide the tables to which you need to extend the functionality. Example: change, request.

5. Click Update.

**Request-based chats to import messages from Microsoft Teams to ServiceNow**

**IT Service management for Microsoft Teams** and **HR Service Management for Microsoft Teams** applications enable the system to auto import the chat conversations between the agents and the employees.

If you are installing the ServiceNow for Microsoft Teams in your environment, the auto-import functionality is applicable by default for the following tables.

- HR Core task (sn_hr_core_task)
- HR Life events Case (sn_hr_le_case)
- HR Core case (sn_hr_core_case)
- Request Item (sc_req_item)
• Task (sc_task)
• Incident (incident)
• Request (sc_request)
• Change request (change_request)

The admin can extend the auto import feature to the other tables as required.

If you are upgrading your ServiceNow instance to IT Service Management integration with Microsoft Teams 2.2.0 or HR Service Delivery integration with Microsoft Teams 2.2.0, you must manually enable the auto import feature.

**Functionality of auto importing messages**

All the chat messages from Microsoft Teams will be auto imported to the ServiceNow instance at an interval of 30 minutes. The system looks for all the new messages across all the chats and import the messages to ServiceNow instance.

To prevent polling from running indefinitely on inactive conversations, if there are no new messages, the polling interval will gradually lengthen until, eventually, polling stops.

The system verifies the record for new messages for every 30 minutes. If there are no new messages, the system checks for the new messages for an interval of one hour, two hour, four hour and eight hours. If there are no new messages in an interval of eight hours for seven days, the Auto Import polling activity is disabled.

If there is any message during any of the intervals, the auto import timer will look for the new messages in the next interval, and import the messages. The timer is then reset to 30-minutes interval.

**System Limits**

The system imports a maximum of 500 active chats in a 30-minute interval. If there are more than active 500 chats the system will not auto-import the new chat records for the 30-minute interval.

The system executes a maximum of 10000 sub-flows to import the chats for an interval of 30 minutes, 1 hour, 2 hour, 4-hour, 8-hour intervals. This is a count of all the active sub-flows that auto-import the messages into ServiceNow.

If the system reaches the limit, a message is displayed to the agent that the system level is reached and the chat can’t be auto imported on the **Start Microsoft Teams Chat** modal.
When the ticket is closed, the system will trigger auto import for one last time posts the new messages in the Work notes (Chat history).

If there is an interaction record associated with the parent record then interaction record is also closed. The chat record will also be closed as part of this flow.

**Create chat configuration to auto-import chats**

Create a chat configuration to automatically import the chats between the agents and the requesters for additional tables to extend the auto import functionality.

**Before you begin**

Role required: admin
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Chat Configuration.

2. Click Default option to view the default OOB configuration.
Note: If you want to auto-import chats for certain conditions, create a new condition.

3. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Chat Configuration.
4. Click New.
5. On the form, fill the fields.

**Chat configuration**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Value for the configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order for the configuration. You can define multiple chat configurations for a single table. The system executes the query based on the descending order.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the configuration. Select the check box to activate the configuration.</td>
</tr>
<tr>
<td>Auto Import</td>
<td>Option to automatically import the chat. Select the check box to automatically import the chat.</td>
</tr>
<tr>
<td>Default</td>
<td>Option to keep the configuration as default. **Note:** You cannot define multiple default values for chat configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>Option to select the auto-import for a table.</td>
</tr>
<tr>
<td>Inherit</td>
<td>Extend and apply to the child tables.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Option to define a condition for a chat to be auto-imported.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Opening message</td>
<td>Option to provide a text message that displays to the agent when the agent initiates a chat. This field is enabled only if the <strong>Auto Import</strong> option is selected.</td>
</tr>
</tbody>
</table>

6. **Click Submit.**

The chat configuration defined will be applicable only for the table selected. You can extend the chat configuration to other tables by creating another chat configuration record.

**Create requester mapping**

Create a requester mapping to extend the auto-import functionality to other tables.

**Before you begin**

Role required: admin

**Note:**

If there is no requester mapping defined for a table, the interaction records will not be created. An error log is created for the admin to notify that the requester mapping is not defined for a table.

A requester-mapping record defines which field, in any given table, is the field representing the requester of a ticket.
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Requestor Mapping.

2. Click New.

3. On the form, fill in the fields.

Requester mapping

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table to which the requester mapping (auto-import feature) should be applicable.</td>
</tr>
<tr>
<td>Requestor field</td>
<td>Field to select the requester for a record.</td>
</tr>
<tr>
<td>Inherit</td>
<td>Extend and apply the auto-import feature to the child tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the requester-mapping record.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Configure close condition

Configure the condition to exclude the chat conversation from auto importing.

Before you begin

Role required: admin

About this task

When a ticket is set to inactive, the system does one final poll for any messages in the chat, removes the participants such that no further messages about the ticket can be exchanged in the chat, and then stops polling that chat. This is determined by the "active" field on a table being set to "false".

For any table with an active field, this behavior works automatically. If your custom application does not use an "active" field for determining whether the ticket remains active, define an alternate condition which can be used to denote the ticket as being closed or inactive.

Alternately, to adhere to platform standards, consider adding an active field to your custom application and maintaining the state of that field in accordance with the business logic of your application.
Procedure
1. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Close Conditions.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Option to select a table to which the requester mapping (auto-import feature) should be applicable.</td>
</tr>
<tr>
<td>Inherit</td>
<td>Extend and apply the auto-import feature to the child tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the requester-mapping record.</td>
</tr>
<tr>
<td>Close conditions</td>
<td>Condition builder to define a condition that the record is closed.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Note:
If you are creating a close condition for a new table, ensure to create business rule for close condition. For more information, refer Configure business rule for close condition.

Set up Chat to call
Set up the chat to call functionality in your instance to enable the agents to collaborate with the requester to resolve the issue.
The Chat to call functionality helps the requester to quickly get the resolution for their issues.
Here is the flow-diagram of the chat to call functionality:
To enable the Chat to Call functionality you must install the Workspace Agent chat, Notify, and the Notify connector for Microsoft Teams plugins in your instance. You must also install ServiceNow for Teams installed with Virtual Agent or Virtual Agent Lite. For more information, refer the following topics:

- Set up Workspace Agent Chat
- Activate Notify
- Setup and configure Notify connector for Microsoft Teams for multi-tenant

For more information on the workflow for chat to call flow, refer Promote chat to a call from workspace.

Create User Principal Name (custom email) field for users to use Microsoft Teams to initiate chats

Create a custom email field to use Microsoft Teams app to initiate chat conversation for the agents to resolve the IT and HR related issues of the users.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System Security > Users and Groups > Users.**
2. Click a user.
3. Right-click on the form header and select **Configure > Form Layout**.
4. In the Create new field section, fill in the fields.

### Create new field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the field as you want it to appear on forms and lists. Example: User Principal Name.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a field type as email.</td>
</tr>
<tr>
<td>Field length</td>
<td>Select a field length. This field is visible only for certain field types.</td>
</tr>
</tbody>
</table>

5. Click **Add**.

6. In the Selected slush bucket column, move the field in the desired location on the form.
7. Click **Save**.

The field now appears on the form in the designated location.

The admin must enter the email used for Microsoft Teams in this field.
You need to configure the newly created field value as the default field for initiating chats with the employee in Microsoft Teams.

8. Right-click on the field and click **Show <value of the field name>**.

The dictionary info of the field name can be viewed.

9. Right click the **Field** and copy the value.

10. In the search field, enter `sys_properties.LIST` to view the system properties.
11. In the Name column, search for *user_email property.

12. Click the entry.

13. Update the Value field with the new field name that is created.

   The default value is email.

14. Click Update.

   Note: Ensure that the email address for all the users for the newly created field is updated with the email associated with Microsoft Teams app.

Unfurl the web links in Microsoft Teams chat conversations

ServiceNow for Microsoft Teams supports link unfurling. Link unfurling generates a content-rich preview when a supported link is shared in a conversation with a user in Microsoft Teams.
To enable link unfurling, you must create and download the manifest file and upload the file to Microsoft Teams. To download the manifest file, refer Create and download the manifest file.

In a conversation in Microsoft Teams application, the content in the URL appears as a preview to the user in the form of an adaptive card. The preview is generated based on the content shared in the URL.

The content in the adaptive card will be shown only for public knowledge articles, and the catalog items. However, the adaptive card shows generic content for all private links in the chat conversations.

Enable link unfurling
Enable link unfurling in the manifest file to preview the content of the link shared in the chat conversations.

Before you begin
Role required: admin

Procedure
1. Create and download the manifest file.
   Enable link unfurling option in Generic info tab while working on the manifest file.
   After uploading the manifest file in Microsoft Teams app, you must update the value of ServiceNow for Teams app ID from Microsoft Teams admin center in your ServiceNow instance.

2. Log in to Microsoft Teams admin center.

3. Navigate to Teams apps > Manage apps.

4. Search and click ServiceNow for Teams app.

5. Copy the App ID value.
6. In your ServiceNow instance, search for `sys_properties.LIST`.

7. In the Name field, search for `sn_now_azure.teams_installed_app_id` value.

8. Click the entry to view the properties. If the record is uneditable, click here to edit the record.
9. Update the App ID value and click Update.

Configure the system property to open the unfurled links in Microsoft Teams

Configure the property to view the content when the user clicks the adaptive card shared in the Microsoft Teams chat conversation.

Before you begin
Role required: admin

About this task
Setting the property to true opens all the configured portal-related links within the application. All the non-portal links are opened in the browser.

By default, this property is set as true. If you set the property as false, all the links shared in the chat conversations will be opened in the browser.

Procedure
1. In your ServiceNow instance, search for sys_properties.list.

2. In the Name column, search for sn_now_teams.link_unfurl.view_action_choice property.

3. Click the property. If the record is uneditable, click here to edit the record.
4. Update the Value field as false to view the links in a browser.

5. Click Update.

User setup and actions

Link your ServiceNow account with Microsoft Teams application to access non-public Virtual Agent topics that use ServiceNow records.

Add ServiceNow for Microsoft Teams app

Enables users to interact with the agents from Microsoft Teams application.

Before you begin

Role required: admin

About this task

To receive notifications from Virtual Agent, users must link their accounts to Microsoft Teams. Guest users can't receive notifications.

Procedure

1. Launch Microsoft Teams application.
2. Click Apps.
3. In the apps search field, enter ServiceNow for Microsoft Teams.
4. Click **ServiceNow for Microsoft Teams** app.
5. Click **Open**.

**Results**
The **ServiceNow for Microsoft Teams** app is successfully installed in your Microsoft Teams application.

**Link ServiceNow user account to Microsoft Teams application for Virtual Agent**
Link your ServiceNow account to Microsoft Teams application to access the non-public Virtual Agent topics that use ServiceNow records.

**Before you begin**
**Role required:** user
The authentication step occurs in your instance or in a specific Service Portal, if set by your admin.

**Procedure**
1. Open the Microsoft Teams application.
2. Find your Virtual Agent bot.
3. Start a conversation with your Virtual Agent bot.
   The bot then presents a prompt that provides options to authenticate **Link to ServiceNow**, continue as a guest user, or see the help menu **Check out Tips**.

4. Click **Link to ServiceNow** to authenticate.
   Authentication directs you to your instance or a specific Service Portal set by your admin. If you are not already logged in to your instance or a Service Portal, you are prompted to enter your login credentials.
   The system administrator can auto link the ServiceNow user accounts to Microsoft Teams from Quebec. For more information, see **Account linking in pre-built messaging integrations**.
5. On the confirmation dialog, click **Confirm** to link your account.

**Unlink your ServiceNow user account from Microsoft Teams for Virtual Agent**
Unlinking your account from Microsoft Teams to deactivate the association between your ServiceNow account and the Microsoft Teams application.

**Before you begin**
**Role required:** user
After you unlink your account, you can no longer engage in Virtual Agent conversations that query or change records in the ServiceNow database.

Procedure

1. From the application navigator, navigate to Self-Service > My Profile.
2. Click the View Linked Accounts related link.
3. In the linked accounts page, select the check box for the messaging integration to be unlinked.
4. Select Actions on selected rows and then click Unlink account.

The link between your ServiceNow account and the Virtual Agent messaging integration becomes inactive.

⚠️ Note: Even though you unlinked your account, you can still run public Virtual Agent conversations. To link your account again, repeat steps 1 through 3 for the associated messaging integration and in the Actions on selected rows... click Link account.

Overview of HR Service Delivery integration with Microsoft Teams

HR Service Delivery integration with Microsoft Teams extends the Now Virtual Agent integration with Microsoft Teams to enable employees to more effectively request and receive service from within Microsoft Teams.

The HR Service Delivery integration with Microsoft Teams application includes the following additional capabilities:

- **Actionable notifications** – for approval and comments on tickets. Users can take action on the notifications from within Microsoft Teams.
  - **Ticket comments**: Employees are able to respond to notifications on the tickets from within Microsoft Teams.
    - This `respond_to_comment_notification_inclusion_list_for_hr` property specifies the HR tables for which the Respond to Comments notification triggers. 
      - `<HR services>`
      - `sn_hr_core_case_total_rewards`
      - `sn_hr_core_case_global_mobility`
      - `sn_hr_core_case_operations`
      - `sn_hr_core_case_performance`
      - `sn_hr_core_case_benefits`
      - `sn_hr_core_case_workforce_admin`
      - `sn_hr_core_case_talent_management`
      - `sn_hr_core_case_corporate_communication`
      - `sn_hr_core_case_payroll`
      - `sn_hr_core_case_compensation`
  - Provides agents the ability to initiate a Microsoft Teams chat with an employee from an HR case and then to copy the chat transcript back to the ticket as a comment.
    - `sn_now_teams_hr.chat_sn_hr_core_case_fields`
      - This system property contains the list of HR Case table fields which will be shown as recommended participants for “Start Chat” feature. By default, the recommended participants contains the participants comprising of “opened_for”, “subject_person”, “collaborators” fields.
This system property contains the list of HR Task table fields which will be shown as recommended participants for "Start Chat" feature. By default, the recommended participants contain the participant defined in "assigned_to" field.

This system property contains the list of HR Case tables for which "Start Chat" and "Import Messages" UI Action. By default, this list does not include highly sensitive HR Cases such as "Employee Relations", "Investigation", and "Ethics" cases.

This system property contains the list of HR Case tables for which "Respond to Comment" actionable notifications will be sent. By default, this list does not include highly sensitive HR Cases such as "Employee Relations", "Investigation", and "Ethics" cases.

Note: Approvals for HR cases and Approvals with e-Signature are not yet supported for HR Service Delivery integration with Microsoft Teams.

<table>
<thead>
<tr>
<th>Feature</th>
<th>License Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actionable Notifications</td>
<td>HR Pro or above</td>
</tr>
<tr>
<td>Chat - Agent to Employee/Agent to Agent</td>
<td>HR Pro or above</td>
</tr>
<tr>
<td>Employee Dashboard</td>
<td>HR Pro or above</td>
</tr>
</tbody>
</table>

An enhanced version of the Your Hub dashboard is available with Employee Service Center. You need to perform the following activities to configure **HR Service Delivery integration with Microsoft Teams** in ServiceNow instance:

1. Install HR Service Delivery integration with Microsoft Teams application
2. Setup and configure IT Service Management integration with Microsoft Teams
3. Configure HR Service Delivery integration with Microsoft Teams

**Setup and configure HR Service Delivery with Microsoft Teams**

The HR Service delivery integration with Microsoft Teams plugin uses the Virtual Agent in application. Customers already using the Virtual Agent application can skip the configuration process.

However, you must configure the application you are using in your environment to use Your Hub dashboard and Request based chat features. For more information, visit Configure IT Service Management integration with Microsoft Teams and Configure HR Service Delivery integration with Microsoft Teams.

The following steps are common for **IT Service Management integration with Microsoft Teams**, **HR Service Delivery integration with Microsoft Teams** and **Universal Request Integration with Microsoft Teams** applications and must be done only once.

**Admin setup and tasks**

Configuring the HR service delivery integration with Microsoft Teams application involves setup and installation tasks that you and your users must perform.
Install HR Service Delivery integration with Microsoft Teams application

Install the HR Service Delivery integration with Microsoft Teams application to integrate with ServiceNow instance for the collaboration between the agents and employees.

Before you begin
Role required: admin

Procedure
1. Navigate to System Application > All Available Applications > All.

2. In the search field, enter HR Service Delivery integration with Microsoft Teams. You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.

3. Click Install.

   Note: All the dependent plugins are automatically installed in this process.

What to do next
You must also install the following update sets from the app store for HR Service Delivery integration with Microsoft Teams:

- human_resources_integrations_rca_records
- human_resources_service_portal_rca_records
- human_resources_lifecycle_events_rca_records
- human_resources_core_rca_records
- content_automation_rca_records
- document_templates_rca_records.xml
- fix_script_start_chat_field_decorator_HR

All the Restricted Caller Access(RCA) privileges are displayed in Application Restricted Caller Access Privileges list.

Download and execute the fix_script_start_chat_field_decorator_HR to display the field decorator in the ticket to initiate a chat with the requester.

Verify Application Restricted Caller Access(RCA) Privileges
Verify that there are no duplicate entries in the Restricted Caller Access(RCA) records before uploading an RCA data set to fix the configuration issues.

Before you begin
Role required: admin

Procedure

2. In the Source Scope search, enter: ServiceNow for Microsoft Teams.

3. Right-click on Source Scope column header, and select Group By Source Scope.
4. Expand **ServiceNow for Microsoft Teams**, and **Collaboration Services** source scopes.

5. Delete all the entries under **ServiceNow for Microsoft Teams**, and **Collaboration Services** source scopes.

**Import Update set from XML**

Import update set from XML to provide cross-scope access to HR Service delivery applications.

**Before you begin**

Role required: admin

**About this task**

Following table depicts the RCA record mapping to its feature.

<table>
<thead>
<tr>
<th>RCA Record</th>
<th>Plugin Name</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>content_automation_rca_record</td>
<td>[Content Automation]</td>
<td>[com.sn_content_automation]</td>
</tr>
<tr>
<td>document_templates_rca_record</td>
<td>[Document Templates]</td>
<td>[com.snc.document_templates]</td>
</tr>
<tr>
<td>human_resources_core_rca_record</td>
<td>[Human Resources Scoped App: Core]</td>
<td>[com.sn_hr_core]</td>
</tr>
<tr>
<td>human_resources_integrations_rca_record</td>
<td>[Human Resources Scoped App: Integrations]</td>
<td>[com.sn_hr_integrations]</td>
</tr>
<tr>
<td>human_resources_lifecycle_events_rca_record</td>
<td>[Human Resources Scoped App: Lifecycle Events]</td>
<td>[com.sn_hr_lifecycle_events]</td>
</tr>
<tr>
<td>human_resources_service_portal_rca_record</td>
<td>[Employee Service Center]</td>
<td>[com.sn_hr_service_portal]</td>
</tr>
<tr>
<td>human_resources_workspace_rca_record</td>
<td>[Human Resources Scoped App: Workspace]</td>
<td>[com.sn_hr_agent_workspace]</td>
</tr>
</tbody>
</table>

For more information on Update sets, refer [Update set transfers](#).

**Procedure**

1. Navigate to **System Update Sets > Local Update Sets**.
2. Right-click on the **Name** column, and click **Import XML** menu.
3. On the **Import XML** form, click **Choose file** button, and select the update set XML file.
4. Click **Upload** button.

**Install Fix Script for HR Service Delivery integration with Microsoft Teams**

Download and execute the `fix_script_start_chat_field_decorator_HR` in the ServiceNow instance to display **Start Microsoft Teams chat** field decorator in the ticket to initiate a chat with the requester.

**Before you begin**

Role required: admin

Download the following update sets from the app store for **HR Service Delivery integration with Microsoft Teams**:
**RCA Update Sets**

**Procedure**

1. **Navigate to** System Update Sets > Related Links > Import Update Set from XML.

2. In the XML file field, click Choose file button and select fix_script_start_chat_field_decorator_HR XML file and upload the XML file.
3. Click **Fix script to add start Microsoft Teams chat field decorator.**

4. Click **Preview Update Set.**

5. Click **Commit Update Set.**

The Fix script to add start Microsoft Teams chat field decorator will be in Committed state.
6. Navigate to **System Definition** > **Fix Scripts**.

7. In the **Name** search field, enter **Add Teams chat Field Decorator**.

8. Click **Add Teams chat Field Decorator** fix script.

9. Check **Active** check box.

10. Click **Run Fix Script** button.

    The icon is displayed as a field decorator in a record.

**Setup and configure HR Service Delivery Management integration with Microsoft Teams**

Setup the HR Service Delivery Management integration with Microsoft Teams in your instance. The following steps are common for both **IT Service Management integration with Microsoft Teams** and the **HR Service Delivery Management integration with Microsoft Teams** applications and must be done only once.

![Image](image-url)

**Note:** After completing the common setup, you need to configure the **HR Service Delivery Management integration with Microsoft Teams**. For more information, visit Configure HR Service Delivery integration with Microsoft Teams.

**Setup and configure HR Service Delivery integration with Microsoft Teams for multi-tenant**

Configure HR Service Delivery integration with Microsoft Teams application using the multi-tenant app.

The following steps are common for **IT Service Management integration with Microsoft Teams**, **HR Service Delivery integration with Microsoft Teams** and **Universal Request integration with Microsoft Teams** applications and must be done only once.

**Connect the ServiceNow instance to your Microsoft Teams tenant**

Connect your ServiceNow instance to your Microsoft Teams tenant to enable the users to create their requests from within Microsoft Teams.

**Before you begin**

Role required: External admin (external_app_install_admin)
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Install Azure apps.

2. Click Install to install Microsoft Teams in your instance.
   
   This connects your tenant to the ServiceNow instance.

3. Select the Consent on behalf of your organization option to provide the consent for all your users, and click Accept button to provide the admin consent.

Tab SSO is one of the apps to verify the users and connect the Microsoft tenant to the ServiceNow instance. Provide the desired Microsoft tenant details to connect to the ServiceNow instance.
Select the **Consent on behalf of your organization** option to provide the consent for all your users.

**Note:** If you do not select **Consent on behalf of your organization** option, each individual user must accept the permissions in order to use the respective functionality. Consenting on behalf of the organization will improve the first time user experience.

If you have installed the single-tenant app, and upgrade to the multi-tenant app, all the configuration (client ID, tenant ID, and the OIDC configuration) will be automatically updated when you install the multi-tenant app. Your users have no impact when you upgrade from single-tenant to multi-tenant app.

**Authorize multi-tenant Azure apps to grant required permissions**

Authorize the multi-tenant apps to enable ServiceNow to make API calls to Microsoft to enable each of the ServiceNow for Teams application workflows.

**Before you begin**

Role required: External admin (external_app_install_admin) (This role is available out of the box for users and is a part of channel proxy plugin)

Install Virtual Agent Lite or Virtual Agent. For more information on installing Virtual Agent, refer [Virtual Agent integrations with messaging apps](#).

Install Notify Connector for Microsoft Teams to use chat to call feature. For more information on installing the Notify Connector for Microsoft Teams, refer [Notify connector for Microsoft Teams](#).

**About this task**

The ServiceNow for Teams multi-tenant apps comprise the following apps:

- Tab SSO
- Notify Connector
- Request-Based Chats

To connect your ServiceNow instance to your M365 tenant and to Authorize apps, the user must have both the external_app_install_admin role as well as the application administrator role in M365. Application administrator is a Microsoft driven role, for more information on roles, refer [Azure AD built-in roles](#).

**Procedure**

1. Navigate to **ServiceNow for Microsoft Teams > Install Azure apps.**

   ![Install Azure Apps](#)
2. Authorize the apps as required.

   a. Click **Authorize** for Notify Connector.

      i. Provide the admin consent by clicking on **Accept** button.

      This authorizes to create a new app for Meeting extensibility app, and to create a new tab for a major incident meeting from the major incident workbench in Microsoft Teams.

Upon successful authorization, the app is shown as **Installed**.
b. Click **Authorize** for Request-based Chats app.

   i. Provide the admin consent by clicking on **Accept** button.
Permissions requested
Review for your organization

Request Based Chats
ServiceNow

This app would like to:

- Read user chat messages
- Read and write user chat messages
- Maintain access to data you have given it access to
- Sign in and read user profile
- Read all users’ basic profiles
- Read all files that user can access
- Read names and members of user chat threads
- Create chats

If you accept, this app will get access to the specified resources for all users in your organization. No one else will be prompted to review these permissions.

Accepting these permissions means that you allow this app to use your data as specified in their terms of service and privacy statement. The publisher has not provided links to their terms for you to review. You can change these permissions at https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

[Cancel] [Accept]

On successful authorization, the app is shown as Installed.
c. Click **Authorize** for Tab SSO.
   i. Provide the admin consent by clicking on **Accept** button.
Upon successful authorization, the app is installed in the instance.

Create OAuth OIDC Provider Configuration record in ServiceNow

Create the OIDC provider configuration record that enables the users to connect to meetings in Microsoft Teams application.

Before you begin
Role required: admin

Ensure that you install the Azure apps in your environment.

About this task
This step is only required if the upn is different from email ID.

Procedure
1. Navigate to System OAuth > Application Registry.
2. Click the OIDC record in the format Azure AD – sso - <tenantname>. Where <tenantname> is the name of your tenant.
3. Preview the OAuth OIDC Provider Configuration entry.
4. Click Open Record.
5. In the **User Claim** field, provide the value as email.

Change tenant to configure multi-tenant apps

Change the tenant to use multi-tenant apps in your environment.

**Before you begin**
Role required: External admin (external_app_install_admin)

**About this task**
If you have already set up a connection on a different Microsoft Teams tenant, changing to a new tenant will stop the integration from working on the originally configured tenant. All users using the integration on the original tenant will no longer be able to use it. If you are only changing from single-tenant Azure apps to multi-tenant Azure apps, but keeping the integration on the same Microsoft Teams tenant, there will not be an impact to users.

**Procedure**

1. Navigate to **ServiceNow for Microsoft Teams > Install Azure apps.**
2. Click **Install** to install Microsoft Teams in your instance.
   This connects your tenant to the ServiceNow instance.
3. Select the **Consent on behalf of your organization** option to provide the consent for all your users, and click **Accept** button to provide the admin consent.
Select the **Consent on behalf of your organization** option to provide the consent for all your users.

4. Click **Change tenant** to map the tenant with your new ServiceNow instance.

Once the tenant is mapped with the ServiceNow instance, you must authorize the apps by providing the admin consent.

The Notify Connector and Import Chat apps appear only if you install Notify plugin in your instance.
• **Tab SSO**: Authorize this app to display **Your Hub** tab in Microsoft Teams app.

• **Notify Connector**: Authorize this app to enable agents to initiate a Microsoft Teams meeting from a task record.

• **Request-based Chats**: Authorize this app to enable the agents to initiate chat in Microsoft Teams and import chat messages to the respective record.

5. Authorize the apps as required.

**What to do next**
You need to upload the manifest file in Microsoft Teams. For more information, refer [Create and download the manifest file](#).

**Create and download the manifest file**
Create and download the ServiceNow for Microsoft Teams manifest file from your instance to enable Microsoft Teams to use the ServiceNow for Teams app.

**Before you begin**
Role required: external_app_install_admin

**About this task**
You can connect multiple ServiceNow instances to one Microsoft Teams tenant.

Only one multi-tenant setup can be connected to the Microsoft Teams tenant, however, you can connect multiple single-tenant environments to the Microsoft Teams Tenant since you can create separate Azure apps for each single tenant environment.

**Procedure**
1. Navigate to **ServiceNow for Microsoft Teams > Application Manifest > ServiceNow for Teams**.
2. Click **New**.

The **Generic Info** tab appears.
3. In the **Generic Info** section, enter the details.

   a. **Short name**: Option to provide a short name for the manifest file.

   b. **Full name**: Option to provide the complete name for the manifest file.

   c. **Version**: Version of the manifest file. Ex: 1.0.0

   d. **Unfurl Links**: Option to unfurl the links in Microsoft Teams.

      Link unfurling generates a content-rich preview (adaptive card) when a supported link is shared in a conversation with a user in Microsoft Teams. For more details about link unfurling, refer [Unfurl the web links in Microsoft Teams chat conversations](#).

   e. **Short description**: Short description about the manifest file.

   f. **Description**: Detailed description about the manifest file.

   g. **Accent Color**: Option to choose a custom color for the conversations in Microsoft Teams as per the company branding. The accent color should be in HTML color code format.

   **Note**: If you want to customize the company branding, clear the **Use default images** option and then upload the icons. For more information on the size of icons, refer [App icons](#) and [manifest schema icons](#).

4. Click **Submit**.

5. In the **Generic Info** section, click **Next** to navigate to **Configure Virtual Agent** tab.
6. In the **Configure Virtual Agent** section, do one of the following.

To configure the Virtual Agent in your instance, click **Configure Virtual Agent**. For more information, see Conversational Integration with Microsoft Teams.

- If you want to connect one ServiceNow instance to a Microsoft Teams tenant, select **Connect one ServiceNow instance to one Microsoft Teams Tenant**. The Virtual Agent Bot ID is auto-populated if you select this option.
- If you want to connect multiple ServiceNow instances to one Microsoft Teams tenant, select **Connect multiple ServiceNow instance to one Teams Tenant**.
a. Click **Configure Virtual Agent**.

Integrate ServiceNow Virtual Agent with third-party messaging apps.

The ServiceNow Virtual Agent integrates with these messaging apps.

To configure the integration, please provide the following information:

- **Tenant ID**
- **Client ID (App ID)**
- **Client Secret**
- **Bot Name**

b. On the form, fill the fields.

i. **Tenant ID**: Option to enter the tenant ID. Capture the tenant ID of the Azure app from the Azure portal.

ii. **Client ID (App ID)**: Option to enter the client ID. Capture the client ID of the Azure app from the Azure portal.

iii. **Client Secret**: Option to enter the client secret. Capture the client secret of the Azure app from the Azure portal.

iv. **Bot Name**: Option to provide the bot name.

v. Click **Submit**.

The application is redirected to the manifest configuration page.

7. In the **Configure Tab** section, enter the following.

Integrate multiple ServiceNow instances with a single Microsoft Teams tenant

Once you've created a bot in Azure portal, please note the following for the integration:

- **Tenant ID**
- **Client ID (App ID)**
- **Client Secret**
- **Bot Name**

The application is redirected to the manifest configuration page.
a. **Enable tabs**: Option to add tabs in Microsoft Teams application. Select the Enable tabs check box.

b. **Tab name**: Option to provide a name for the Service portal tab that appears in Microsoft Teams.

c. **Click Next**.

![Microsoft Teams application configuration screen](image)

For single tenant, you must provide the Application (client) ID and Directory (tenant) ID in the **Configure Tab** section.

![Configure Tab section](image)

8. In the **Ready** section, verify the details provided and click **Download Manifest** to download the manifest file.

9. Launch Microsoft Teams application.

10. Navigate to **Apps > Upload a customised app**.

11. Navigate to the location where the manifest file is downloaded and select the zip file.

12. Click **Open**.

The **ServiceNow for Teams** appears in **Apps** screen.
13. Click **ServiceNow for Teams** app.

14. Click **Add**.

The ServiceNow for Teams app appears in Microsoft Teams.
• **Chat:** Begin your conversation with the Virtual Agent to get help.

![Chat Interface](image)

• **Employee Center:** Click Employee Center tab to view the organization updates and the status on your tasks and requests.

![Employee Center Interface](image)

ℹ️ **Note:** If you don’t want to create a manifest file, you can edit an existing manifest file as required. Upon updating the existing manifest file, you can download and upload the manifest file in Microsoft Teams to make the changes effective.

**Manage Now Virtual Agent permission policies**

Disable the NOW Virtual Agent app to avoid duplicate notifications from Microsoft Teams when you install and integrate ServiceNow for Microsoft Teams app with ServiceNow instance.

**Before you begin**

ℹ️ **Note:** Your employees will not see or use the Now Virtual Agent app.

Role required: Microsoft Teams admin
About this task
ServiceNow has two apps available for Microsoft Teams:

- **Now Virtual Agent**
  This app displays Virtual Agent within Microsoft Teams, has been available within Microsoft Teams app since 2019.

- **ServiceNow for Microsoft Teams**
  ServiceNow for Microsoft Teams is a new app that provides a broader employee experience, including and expanding beyond Virtual Agent, with an embedded portal experience called **Your Hub**, and the ability for agents to reach out to employees in Microsoft Teams to quickly resolve open tickets.

Since the same Bot (Virtual Agent) is shared in both apps, blocking the Now Virtual Agent app also results in the same bot ID being blocked for the ServiceNow for Microsoft Teams app, making the Virtual Agent unusable in the ServiceNow for Microsoft Teams app. To work around this, it is necessary to make sure that the Now Virtual Agent app is in the list of allowed apps.

You must first block the **Now Virtual Agent** app, so that it stops showing up for employees and then add the app to the allowed list. After this configuration, your employees will not see or use the Now Virtual Agent app, but will be able to use Virtual Agent within the **ServiceNow for Microsoft Teams** app.

Procedure
1. Login to Microsoft Teams admin portal.
2. Navigate to Teams apps > Manage apps.
3. In the search field, enter NOW Virtual Agent.
4. Click NOW Virtual Agent app.
5. Swipe the status to block the app.
6. Navigate to Teams apps > Permission policies.
7. Select Allow specific apps and block others for Third-party apps and Custom apps.

   a. Ensure that NOW Virtual Agent app is allowed for Third-party apps.

   b. Ensure ServiceNow for Teams app is allowed for Custom apps.

8. Click Save.

Install ServiceNow for Teams app

Enables users to interact with the agents from Microsoft Teams application.
Before you begin
Role required: admin

Procedure
1. Launch Microsoft Teams application.
2. Click Apps menu.
3. Click Upload a custom app.
4. Select the manifest file from the directory, and click Open.
5. Click ServiceNow for Teams app.
6. Click Add.

Results
The ServiceNow for Teams app appears in Microsoft Teams.

Connect Virtual Agent in Microsoft Teams with ServiceNow instance
ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Before you begin
Note the following important issues before installing:
• The Virtual Agent integration with Microsoft Teams creates a one-to-one association between the ServiceNow instance that you are installing from and the Microsoft Teams tenant in which the integration runs. Use a separate Microsoft Teams tenant for each instance that you plan to install the integration in.
• The Virtual Agent integration is only supported for users who have a user record in ServiceNow.
• ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Roles required:
• virtual_agent_admin and external_app_install_admin or admin
• Administrator for third-party applications

Procedure
1. Navigate to Collaboration > Messaging Apps Integration.
2. Click Install that appears next to Microsoft Teams.
3. In the Entering a third-party site dialog, click OK.
4. Log in to Microsoft Teams.

5. On the Microsoft dialog box, click **Accept**.

6. If the selected tenant has already been assigned to NOW Virtual Agent, click **Override** to change the tenant or **Cancel** to leave the current assignment in place.

7. Click **Go to MS Teams** to log in to Microsoft Teams.

8. Click **Apps** menu.

9. In the search field, enter ServiceNow for Microsoft Teams.

10. Click **ServiceNow for Microsoft Teams** app.
11. Click **Open** button to add the app to Microsoft Teams.

12. In your instance, check the Messaging Apps Integration page **Collaboration > Messaging Apps Integration** to verify the installation.

![Microsoft Teams integration setup](image)

**Note:** Select **Enable notifications for all users** option, to receive non-actionable notifications (Provider Notifications).

**Translate the Microsoft Teams manifest file**

ServiceNow for Microsoft Teams supports localization to multiple languages, using UTF-8 for international characters.

You must activate the localized plugins in your instance. To install the language plugin, see **Activate a language**.

After installing the language plugin, you must create and download the manifest file and upload the file to Microsoft Teams. To download the manifest file, refer **Create and download the manifest file**.

**Setup and configure HR Service Delivery integration with Microsoft Teams for single-tenant**

Configure HR Service Delivery integration with Microsoft Teams application using the single-tenant app.

If you have a single tenant environment, you need to perform the following setup procedures to integrate ServiceNow with Microsoft Teams.

You may need to use single tenant setup in certain cases due to your company or regulatory requirements.

The following steps are common for both **IT Service Management integration with Microsoft Teams** and the **HR Service Delivery integration with Microsoft Teams** applications and must be done only once.

**Note:** After completing the common setup, you need to configure the **IT Service Management integration with Microsoft Teams** and **HR Service Delivery integration with Microsoft Teams**. For more information, visit **Configure IT Service Management integration with Microsoft Teams** and **Configure HR Service Delivery integration with Microsoft Teams**.

**Create Microsoft Azure application to authenticate Microsoft Teams users with ServiceNow**

Create a Microsoft Azure application in Microsoft Azure portal to enable agents to import the conversations and access Your Hub dashboard from Microsoft Teams to ServiceNow.

**Before you begin**

Role required: admin

**Note:** You can use one Microsoft Azure application if you use both **IT Service Management integration with Microsoft Teams**, and **HR Service Delivery integration with Microsoft Teams** applications.

**Procedure**

1. Log in to Microsoft Azure portal.

2. Navigate to **Azure Services > Azure Active Directory > Manage > App registrations**.
3. Click **New registration**.
   The **New registration** page displays.

4. On the **New registration** form, perform the following actions:
   
   a. **Name**: Enter the name of your application. Example: ServiceNow Auth app.
   
   b. **Redirect URI**: Enter https://<instance-name>/sn_now_teams_ms_login_redirect.do, where `<instance-name>` is the name of your ServiceNow instance.

5. Click **Register**.

6. Click **Redirect URIs**.

7. Select the **Access tokens** check box.

8. Click **Save**.

   **Authenticate users to access Your Hub dashboard**
   Assign permissions to users to view Your Hub dashboard in Microsoft Teams application.

**Before you begin**
Role required: admin

**Procedure**

1. Log in to Microsoft Azure portal.
2. Navigate to **Azure Services > Azure Active Directory > Manage > App registrations**.
3. Click the app created to enable agents to import the conversations from Microsoft Teams to the ServiceNow instance. Example: ServiceNow Auth app.
4. Navigate to **Manage > Authentication**.
5. Navigate to **Add a platform > Web applications > Web**.
6. On the **Configure Web** form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirect URIs</td>
<td>Provide the redirect URI. The redirect URI should be in the format: https://&lt;instance-url&gt;/sn_now_teams_ms_login.do where &lt;instance-url&gt; is the URL of your ServiceNow instance.</td>
</tr>
<tr>
<td>Implicit grant</td>
<td>Check <strong>Access tokens</strong>, and <strong>ID tokens</strong>.</td>
</tr>
</tbody>
</table>

7. Click **Configure**.

8. Navigate to **Manage > API Permissions > Add a permission > Microsoft Graph.**

9. Click **Delegated permissions**.
10. Click **Openid permissions** accordion, and select **email**, **offline_access**, **openid**, and **profile** check-boxes.

   ![Request API permissions](image)

11. Click **Add permissions**.

12. In the **API permissions** screen, click **Grant admin consent for {tenant}** link.

13. Click **Yes** on the pop-up dialog box.

14. Navigate to **Manage > Expose an API**.

15. Click **Set against Application ID URI**, and enter the application URI in the format: api:// {instance}.service-now.com/{client_id}.

16. Click **Save**.

17. Click **Add a scope**. In the **Add a scope** form, fill the following fields.

   ![Add a scope form](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope name</td>
<td>access_as_user</td>
</tr>
<tr>
<td>Who can consent</td>
<td>Admins and users</td>
</tr>
<tr>
<td>Admin consent display name</td>
<td>Teams can access the user's profile.</td>
</tr>
<tr>
<td>Admin consent description</td>
<td>Allows Teams to call the app's web APIs as the current user.</td>
</tr>
<tr>
<td>User consent display name</td>
<td>Teams can access the user profile and make requests on the user's behalf.</td>
</tr>
</tbody>
</table>
18. Click **Add scope** button.

19. Navigate to **Authorized client applications** > **Add a client application**.

20. In the **Add a client application form**, fill the fields.

**Add client application form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Client ID      | • Microsoft Teams mobile/desktop application: 1fec8e78-bce4-4aaf-ab1b-5451cc387264
<p>|                | • Value for Microsoft Teams web application: 5e3ce6c0-2b1f-4285-8d4b-75ee78787346 |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorized scopes</td>
<td>Check the authorized scope</td>
</tr>
</tbody>
</table>

For more information on the client IDs, refer [Single sign-on (SSO) support for tabs](#).

### Authorized client applications

Authorizing a client application indicates that this API trusts the application and users should not be asked to consent when the client calls this API.

#### Add a client application

<table>
<thead>
<tr>
<th>Client ID</th>
<th>Scopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>5e3ce6c0-2b1f-4285-8d4b-75ee7878346</td>
<td>1</td>
</tr>
<tr>
<td>1f0c8e78-bce4-4aaf-abad-b451c3c87264</td>
<td>1</td>
</tr>
</tbody>
</table>

Before you begin

Role required: admin

Ensure that you install the Azure apps in your environment.

About this task

This step is only required if the upn is different from email ID.

#### Procedure

1. Navigate to **System OAuth > Application Registry**.

2. Click the OIDC record in the format **Azure AD – sso - <tenantname>**. Where `<tenantname>` is the name of your tenant.

3. Preview the **OAuth OIDC Provider Configuration** entry.
4. Click **Open Record**.

5. In the **User Claim** field, provide the value as **email**.

---

**Create and download the manifest file**

Create and download the ServiceNow for Microsoft Teams manifest file from your instance to enable Microsoft Teams to use the ServiceNow for Teams app.

**Before you begin**

Role required: **external_app_install_admin**

**About this task**

You can connect multiple ServiceNow instances to one Microsoft Teams tenant.

Only one multi-tenant setup can be connected to the Microsoft Teams tenant, however, you can connect multiple single-tenant environments to the Microsoft Teams Tenant since you can create separate Azure apps for each single tenant environment.

**Procedure**

1. Navigate to **ServiceNow for Microsoft Teams > Application Manifest > ServiceNow for Teams**.

2. Click **New**.

   The **Generic Info** tab appears.
3. In the **Generic Info** section, enter the details.

   a. **Short name**: Option to provide a short name for the manifest file.

   b. **Full name**: Option to provide the complete name for the manifest file.

   c. **Version**: Version of the manifest file. Ex: 1.0.0

   d. **Unfurl Links**: Option to unfurl the links in Microsoft Teams.

   Link unfurling generates a content-rich preview (adaptive card) when a supported link is shared in a conversation with a user in Microsoft Teams. For more details about link unfurling, refer [Unfurl the web links in Microsoft Teams chat conversations](#).

   e. **Short description**: Short description about the manifest file.

   f. **Description**: Detailed description about the manifest file.

   g. **Accent Color**: Option to choose a custom color for the conversations in Microsoft Teams as per the company branding. The accent color should be in HTML color code format.

   **Note**: If you want to customize the company branding, clear the **Use default images** option and then upload the icons. For more information on the size of icons, refer [App icons](#) and [manifest schema icons](#).

4. **Click Submit**.

5. In the **Generic Info** section, click **Next** to navigate to **Configure Virtual Agent** tab.
6. In the **Configure Virtual Agent** section, do one of the following.

To configure the Virtual Agent in your instance, click **Configure Virtual Agent**. For more information, see [Conversational Integration with Microsoft Teams](#).

- If you want to connect one ServiceNow instance to a Microsoft Teams tenant, select **Connect one ServiceNow instance to one Microsoft Teams Tenant**. The Virtual Agent Bot ID is auto-populated if you select this option.
- If you want to connect multiple ServiceNow instances to one Microsoft Teams tenant, select **Connect multiple ServiceNow instance to one Teams Tenant**.
a. Click **Configure Virtual Agent.**

In the Configure Virtual Agent panel, select the integration method with third-party messaging apps.

To use the ServiceNow Virtual Agent app to integrate with the Azure portal, you need to set up the integration. For more information, refer to the Integration with Azure portal documentation.

1. Click **Configure.**
2. On the form, fill the fields.
   - **Tenant ID:** Option to enter the tenant ID. Capture the tenant ID of the Azure app from the Azure portal.
   - **Client ID (App ID):** Option to enter the client ID. Capture the client ID of the Azure app from the Azure portal.
   - **Client Secret:** Option to enter the client secret. Capture the client secret of the Azure app from the Azure portal.
   - **Bot Name:** Option to provide the bot name.
3. Click **Submit.**

The application is redirected to the manifest configuration page.

b. On the form, fill the fields.
   
i. **Tenant ID:** Option to enter the tenant ID. Capture the tenant ID of the Azure app from the Azure portal.

   ii. **Client ID (App ID):** Option to enter the client ID. Capture the client ID of the Azure app from the Azure portal.

   iii. **Client Secret:** Option to enter the client secret. Capture the client secret of the Azure app from the Azure portal.

   iv. **Bot Name:** Option to provide the bot name.

   v. Click **Submit.**

Integrate multiple ServiceNow instances with a single Microsoft Teams tenant

Once you've created a bot in Azure portal, please note the following for the integration:

<table>
<thead>
<tr>
<th>Tenant ID</th>
<th>Client ID (App ID)</th>
<th>Client Secret</th>
<th>Bot Name</th>
</tr>
</thead>
</table>

The application is redirected to the manifest configuration page.

7. In the **Configure Tab** section, enter the following.
a. **Enable tabs**: Option to add tabs in Microsoft Teams application. Select the Enable tabs check box.

b. **Tab name**: Option to provide a name for the Service portal tab that appears in Microsoft Teams.

c. **Click Next**.

For single tenant, you must provide the Application (client) ID and Directory (tenant) ID in the **Configure Tab** section.

8. In the **Ready** section, verify the details provided and click **Download Manifest** to download the manifest file.

The manifest file downloads in the zip format.

9. Launch Microsoft Teams application.

10. Navigate to **Apps** > **Upload a customised app**.

11. Navigate to the location where the manifest file is downloaded and select the zip file.

12. **Click Open**.

The **ServiceNow for Teams** appears in **Apps** screen.
13. Click **ServiceNow for Teams** app.

14. Click **Add**.

The ServiceNow for Teams app appears in Microsoft Teams.
• **Chat**: Begin your conversation with the Virtual Agent to get help.

![Chat screenshot](image)

• **Employee Center**: Click **Employee Center** tab to view the organization updates and the status on your tasks and requests.

![Employee Center screenshot](image)

**Note**: If you don’t want to create a manifest file, you can edit an existing manifest file as required. Upon updating the existing manifest file, you can download and upload the manifest file in Microsoft Teams to make the changes effective.

**Verify and update application registry values**

Verify and update the application registry values to authenticate the users in Microsoft Teams application.

**Before you begin**

Verify the **ServiceNow for Microsoft Teams** application registry and modify the Application (client) ID and Directory (tenant) ID if required after you create a manifest file.

Role required: admin
Procedure
1. Navigate to System OAuth > Application Registry.
2. Click ServiceNow for Microsoft Teams APP.
3. Edit the entry.
4. On the OAuth OIDC Entity – ServiceNow for Microsoft Teams app form, fill the fields.

<table>
<thead>
<tr>
<th>OAuth OIDC Entity form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Client ID</td>
</tr>
<tr>
<td>OAuth OIDC Provider Configuration</td>
</tr>
</tbody>
</table>

**Note:**
If your app has custom signing keys as a result of using the claims-mapping feature, you must append an appid query parameter containing the app ID. For more information, refer the Microsoft documentation, Validating the signature. (For example, https://sts.windows.net/f3211d0e-125b-42c3-86db-322b19a65a22/.well-known/openid-configuration?appid=<client_id>). The client ID can be fetched from the Microsoft Azure portal.

5. Right-click on the form header, and click **Save**.

Manage Now Virtual Agent permission policies
Disable the NOW Virtual Agent app to avoid duplicate notifications from Microsoft Teams when you install and integrate ServiceNow for Microsoft Teams app with ServiceNow instance.

Before you begin

**Note:** Your employees will not see or use the Now Virtual Agent app.

Role required: Microsoft Teams admin
About this task
ServiceNow has two apps available for Microsoft Teams:

- **Now Virtual Agent**
  This app displays Virtual Agent within Microsoft Teams, has been available within Microsoft Teams app since 2019.

- **ServiceNow for Microsoft Teams**
  ServiceNow for Microsoft Teams is a new app that provides a broader employee experience, including and expanding beyond Virtual Agent, with an embedded portal experience called Your Hub, and the ability for agents to reach out to employees in Microsoft Teams to quickly resolve open tickets.

Since the same Bot (Virtual Agent) is shared in both apps, blocking the Now Virtual Agent app also results in the same bot ID being blocked for the ServiceNow for Microsoft Teams app, making the Virtual Agent unusable in the ServiceNow for Microsoft Teams app. To work around this, it is necessary to make sure that the Now Virtual Agent app is in the list of allowed apps.

You must first block the **Now Virtual Agent** app, so that it stops showing up for employees and then add the app to the allowed list. After this configuration, your employees will not see or use the Now Virtual Agent app, but will be able to use Virtual Agent within the **ServiceNow for Microsoft Teams** app.

**Procedure**
1. Login to Microsoft Teams admin portal.
2. Navigate to Teams apps > Manage apps.
3. In the search field, enter NOW Virtual Agent.
4. Click NOW Virtual Agent app.
5. Swipe the status to block the app.
6. Navigate to **Teams apps > Permission policies**.

7. Select **Allow specific apps and block others** for **Third-party apps** and **Custom apps**.

   a. Ensure that **NOW Virtual Agent** app is allowed for **Third-party apps**.

   b. Ensure **ServiceNow for Teams** app is allowed for **Custom apps**.

8. Click **Save**.

**Install ServiceNow for Teams app**

Enables users to interact with the agents from Microsoft Teams application.
Before you begin
Role required: admin

Procedure
1. Launch Microsoft Teams application.
2. Click Apps menu.
3. Click Upload a custom app.
4. Select the manifest file from the directory, and click Open.
5. Click ServiceNow for Teams app.
6. Click Add.

Results
The ServiceNow for Teams app appears in Microsoft Teams.

Connect Virtual Agent in Microsoft Teams with ServiceNow instance
ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Before you begin
Note the following important issues before installing:
• The Virtual Agent integration with Microsoft Teams creates a one-to-one association between the ServiceNow instance that you are installing from and the Microsoft Teams tenant in which the integration runs. Use a separate Microsoft Teams tenant for each instance that you plan to install the integration in.
• The Virtual Agent integration is only supported for users who have a user record in ServiceNow.
• ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Roles required:
• virtual_agent_admin and external_app_install_admin or admin
• Administrator for third-party applications

Procedure
1. Navigate to Collaboration > Messaging Apps Integration.
2. Click Install that appears next to Microsoft Teams.
3. In the Entering a third-party site dialog, click OK.

Entering a third-party site
You are about to enter a third-party site to verify identity. Please have your login credentials ready in order to complete the installation process.

Cancel OK
4. Log in to Microsoft Teams.

5. On the Microsoft dialog box, click **Accept**.

6. If the selected tenant has already been assigned to NOW Virtual Agent, click **Override** to change the tenant or **Cancel** to leave the current assignment in place.

7. Click **Go to MS Teams** to log in to Microsoft Teams.

8. Click **Apps** menu.

9. In the search field, enter **ServiceNow for Microsoft Teams**.

10. Click **ServiceNow for Microsoft Teams** app.
11. Click Open button to add the app to Microsoft Teams.

12. In your instance, check the Messaging Apps Integration page Collaboration > Messaging Apps Integration to verify the installation.

Note: Select Enable notifications for all users option, to receive non-actionable notifications (Provider Notifications).

Register the chat app with ServiceNow instance

Register the chat app with your instance to use Microsoft Teams chat for single-tenant environment.

Before you begin
Role required: admin

Procedure
1. Navigate to System OAuth > Application Registry.
2. Do one of the following.
   • If Microsoft Teams chat single tenant application registry is available, click on the application registry for Microsoft Teams.
   • If you want to create a new application registry entry, click New. and select Connect to a third party OAuth Provider
3. On the form, fill the fields.

Microsoft Teams chat for single tenant

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to uniquely identify the record. For example, enter: Microsoft Teams chat single tenant</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID created in Azure portal. Provide the value of the Azure application ID in this field.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>The password you generated when creating the app in Microsoft Teams.</td>
</tr>
<tr>
<td>Authorization URL</td>
<td>Authorization URL that includes the tenant ID of your app with the format <a href="https://login.microsoftonline.com/%7Btenantid%7D/oauth2/v2.0/authorize">https://login.microsoftonline.com/{tenantid}/oauth2/v2.0/authorize</a> where is the tenant ID created during the app creation in Microsoft Teams.</td>
</tr>
<tr>
<td>Token URL</td>
<td>Token URL that includes the tenant ID of your app with the format <a href="https://login.microsoftonline.com/%7Btenantid%7D/oauth2/v2.0/token">https://login.microsoftonline.com/{tenantid}/oauth2/v2.0/token</a></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Redirect URL</td>
<td>Redirect URL that includes the instance URL with the format https://&lt;instanceURL&gt;/oauth_redirect.do. Update the &lt;instanceURL&gt; value with your instance URL.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

5. Navigate to **ServiceNow for Microsoft Teams > Properties**.

6. Enable the option **Set this property to true to use integration hub action for Start Chat / Import chat flows**.

7. Click **Save**.

**Translate the Microsoft Teams manifest file**

ServiceNow for Microsoft Teams supports localization to multiple languages, using UTF-8 for international characters.

You must activate the localized plugins in your instance. To install the language plugin, see **Activate a language**.
After installing the language plugin, you must create and download the manifest file and upload the file to Microsoft Teams. To download the manifest file, refer Create and download the manifest file.

Configure HR Service Delivery integration with Microsoft Teams
Complete the following procedures to configure the HR Service Delivery integration with Microsoft Teams.

Customize HR Service Delivery integration with Microsoft Teams
Customize the features in your instance to meet your organization needs. You can customize:

• UI actions
• Business rules

Customize business rules for actionable notifications
Enables you to customize the business rules for actionable notifications.

Before you begin
Role required: admin

Procedure
2. Open a business rule you would like to extend to another table. Ex: Send comment to caller.
3. On the UI Actions screen, Click New.
4. On the UI Action form, fill the fields.

UI Action for business rule

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Send comment to caller is to be assigned.</td>
</tr>
<tr>
<td>Application</td>
<td>HR Service Delivery integration with Microsoft Teams</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
<tr>
<td>Where to run</td>
<td>• When: after</td>
</tr>
<tr>
<td></td>
<td>• Insert: Check this box</td>
</tr>
<tr>
<td></td>
<td>• Update: Check this box</td>
</tr>
<tr>
<td></td>
<td>• Filter Conditions: Apply the filter condition of the Send comment to caller business rule</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
Advanced  | • Condition: Copy and paste the value of the condition from the existing Send comment to caller business rule. Modify the values as required.  
          | • Script: Copy and paste the script from the existing Send comment to caller business rule. Modify the values as required.

5. Click Submit.

**Customize Start Microsoft Teams chat UI action**
Enables you to extend the Start Microsoft Teams chat UI actions to the tables you require.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to ServiceNow for Microsoft Teams > UI Actions.
2. Open the existing Start Microsoft Teams chat UI action in a new window.
3. On the UI Actions screen, Click New.
4. On the UI Action form, fill the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the UI action. Ex: Start Microsoft Teams chat</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Start Microsoft Teams chat UI action is to be available</td>
</tr>
<tr>
<td>Application</td>
<td>HR Service Delivery integration with Microsoft Teams</td>
</tr>
<tr>
<td>Form button</td>
<td>Check this box</td>
</tr>
<tr>
<td>Show insert</td>
<td>Uncheck this box</td>
</tr>
<tr>
<td>Client</td>
<td>Check this box</td>
</tr>
<tr>
<td>Condition</td>
<td>Copy and paste the condition of the existing Start Microsoft Teams chat. Modify the column name as required.</td>
</tr>
<tr>
<td>Script</td>
<td>Copy and paste the script of the existing Start Microsoft Teams chat. Modify the column name as required.</td>
</tr>
<tr>
<td>Workspace Form Button</td>
<td>Check this box. Copy and paste the <strong>Workspace Client Script</strong> of the existing Start Microsoft Teams chat. Modify the column name as required.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Customize Import Messages from Microsoft Teams UI action**
Enables you to extend the Import Messages from Microsoft Teams UI action to the tables you require.
Before you begin
Role required: admin

Procedure
1. Navigate to ServiceNow for Microsoft Teams > UI Actions.
2. Open the existing Import Messages from Microsoft Teams UI action in a new window.
3. On the UI Actions screen, click New.
4. On the UI Action form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the UI action. Ex: Import Messages from Microsoft Teams</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Import Messages from Microsoft Teams UI action is to be available</td>
</tr>
<tr>
<td>Application</td>
<td>HR Service Delivery integration with Microsoft Teams</td>
</tr>
<tr>
<td>Form button</td>
<td>Check this box</td>
</tr>
<tr>
<td>Show insert</td>
<td>Uncheck this box</td>
</tr>
<tr>
<td>Client</td>
<td>Check this box</td>
</tr>
<tr>
<td>Condition</td>
<td>Copy and paste the condition of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
<tr>
<td>Script</td>
<td>Copy and paste the script of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
</tbody>
</table>
| Workspace Form Button | Check this box.  
Copy and paste the **Workspace Client Script** of the existing Import Messages from Microsoft Teams. Modify the column name as required. |

5. Click Submit.

Configure business rule for reassigning tickets
Configure the business rule for reassigning the tickets.

Before you begin
Role required: admin
Procedure

1. Navigate to **System Definition > Business Rules**.

2. Click **New**.

3. On the form, fill in the fields.

   In the **Advanced** tab, update the **Script** fields.
## Business rule for reassigning ticket

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the ticket should be re-assigned.</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
</tbody>
</table>

### Where to run

- **When:** async
- **Update:** Check this box
- **Filter Conditions:** Apply the filter condition of the reassigning the ticket business rule.

Select the fields to which the ticket should be re-assigned. Ex: Assigned to field.

### Advanced

- **Script:** Copy and paste the script. Modify the values as required.

Update the field name in the assigned_to if you are using a different value.

```javascript
var importChatUtils = new sn_tcm_collab_hook.MSTeamsImportChatUtils();
var chatUtil = new sn_tcm_collab_hook.MSTeamsChatUtil();

var azureIds = chatUtil.getAzureIds([current.getValue('assigned_to')]); // Update the assigned_to field if required
var credentialAlias = chatUtil.getTeamsChatCredentialsAliasGr();
var chats = importChatUtils.getChatsofADocument(current.sys_id);
var azureld = '';```
if (azureIds && azureIds.azureUserIds &&
    azureIds.azureUserIds.length > 0)
.azureId = azureIds.azureUserIds[0];

if(gs.nil(azureId)){
    gs.addErrorMessage(gs.getMessage('Invalid Azure Id,
cannot add user to Chat'));
    return;
}

chats.forEach(function(chat) {
    importChatUtils.addMemberToChat(chat,azureId,credentialAlias, current.getValue('assigned_to')); //Update the assigned_to field if required
});

4. Click Submit.

Configure business rule for close condition

Configure the business rule for close condition to auto-import the chats.

Before you begin
Role required: admin

Procedure
1. Navigate to System Definition > Business Rules.

2. Click New.

3. On the form, fill in the fields.
In the Advanced tab, update the **Condition** and the **Script** fields.

### Business rule for close condition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the close condition is to be assigned.</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
</tbody>
</table>

**Where to run**

- **When:** async
- Update: Check this box
- Filter Conditions: Apply the filter condition of the close condition business rule

**Advanced**

- Condition: Copy and paste the value of the condition. Modify the values as required.

```javascript
!current.avoid_closing_chat_records && new sn_tcm_collab_hook.MSTeamsImportChatUtils().hasMatchingCloseCondition(current)
```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Script: Copy and paste the value for the script. Modify the values as required.</td>
<td></td>
</tr>
<tr>
<td>new sn_tcm_collab_hook.MSTeamsImportChatUtils().closeChatStorageRecords(current);</td>
<td></td>
</tr>
</tbody>
</table>

4. Click Submit.

**Your Hub dashboard in Microsoft Teams**

Use the Your Hub dashboard from Microsoft Teams to view the widgets that show pending tasks, requests, and the internal company announcements.

Launch Microsoft Teams. Navigate to ServiceNow for Teams > Your hub.

You can customize the following in the Your Hub dashboard:

• Banner image
• Quick links widget
• Complete your to-dos widget
• Track your request widget
Your Hub

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner image</td>
<td>Welcome name, along with the count of requests, and to-dos</td>
</tr>
<tr>
<td>Visit your employee portal</td>
<td>Link to navigate to the employee portal</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>List of your pending tickets</td>
</tr>
<tr>
<td>Track your requests</td>
<td>List of your requests</td>
</tr>
<tr>
<td>IT announcements</td>
<td>IT announcements released by the IT department</td>
</tr>
<tr>
<td>Upcoming events</td>
<td>Upcoming events in your company</td>
</tr>
<tr>
<td>Holiday calendar</td>
<td>Upcoming holidays for the current year</td>
</tr>
<tr>
<td>IT outages</td>
<td>Active IT outage details</td>
</tr>
<tr>
<td>Find your apps</td>
<td>Apps provided by your company</td>
</tr>
</tbody>
</table>

If the Employee Service Center (com.sn_hr_service_portal) plugin is activated, Your Hub dashboard displays as shown in the screen below:

The banner will display the count of the tasks to be completed by the logged in user.
Quick Links

Visit your Employee portal displays in the quick links section. When you click this link, it will redirect to Employee Service Center portal.

Complete Your To-dos

Complete your to-dos is displayed as the title of the widget.
The data is fetched from `sn_hr_sp_todos_config` table and displays in the **Complete your to-dos** widget.

Each record displays the following attributes:

- Short description
- Requester (This field will not display if the requester field is empty)
- Due date of the record

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th>1-5 of 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Abel Tuter</td>
<td></td>
</tr>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Abraham Lincoln</td>
<td></td>
</tr>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Arpita Gupta</td>
<td></td>
</tr>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Arpita Gupta</td>
<td></td>
</tr>
<tr>
<td>Due today</td>
<td></td>
</tr>
</tbody>
</table>
Track your request

Customize the data to be displayed for the users in the track your request widget.

The data is fetched from the `request_filter` table and displays the pending requests for the user.

<table>
<thead>
<tr>
<th>Track your requests</th>
<th>1-6 of 24</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open</strong> 2h ago</td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open</strong> 2h ago</td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open</strong> 2h ago</td>
</tr>
<tr>
<td><strong>Apple iPad 3</strong></td>
<td><strong>Open</strong> 2h ago</td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td><strong>Open</strong> 2h ago</td>
</tr>
</tbody>
</table>

Each record displays the following attributes:

- Short description
- State
Customize Script Includes
You can customize to display the data in Your Hub dashboard in Microsoft Teams.

Before you begin
Role required: admin

About this task
You can customize the approval notifications, and dashboard widgets for ServiceNow for Microsoft Teams application in your ServiceNow instance:

- Approval Notifications
- Your Hub dashboard widgets: Quick links, Complete your To-dos, Track your requests

Procedure
1. Navigate to System Definition > Script Includes.
2. Click PortalLinkConfig script include.
3. In the Script field, review the code-comments and add the quick links.

Customize script includes form

<table>
<thead>
<tr>
<th>Widget</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Notifications</td>
<td>You can customise the card fields in – MSTeamsApprovalNotificationUtil script include’s buildCardFieldsObj function for approval notification</td>
</tr>
<tr>
<td>Quick Links</td>
<td>You can specify up to five quick links under PORTAL_LINK_GROUP object.</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>You can override the portal in sn_now_teams.PortalLinkConfig script include. Override the implementation for getPortalSuffix: function(sourceGr) { }.</td>
</tr>
<tr>
<td>Track your requests</td>
<td>You can override the portal in sn_now_teams.PortalLinkConfig script include. Override the implementation for getPortalSuffix: function(sourceGr) { }.</td>
</tr>
</tbody>
</table>

4. Click Update.

Embed a custom portal dashboard
Embed your custom portal to replace the Your Hub dashboard in Microsoft Teams by configuring the system property.

Before you begin
Role required: admin

If you are using a custom portal, you can replace the embedded Your Hub dashboard with your custom portal, so that it is accessible within Microsoft Teams. The following steps take you through the configuration to embed your portal.
Procedure

1. In the navigation pane, enter sys_properties.list.

2. Search for sn_now_teams.portal.suffix property under Name.

3. Click sn_now_teams.portal.suffix.

4. Provide the value of your custom portal in Value field.

5. Click Update.

Note: After you configure your custom portal, you must create a custom header for the embedded portal. For more information on adding header, refer Configure HTTP response headers.

Provide the values for the HTTP header response as defined:

**Custom portal values**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that designates that this HTTP response header configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for the custom portal record.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Specify Type</td>
</tr>
<tr>
<td>Type</td>
<td>Service Portal [sp_portal]</td>
</tr>
<tr>
<td>Record</td>
<td>Option to select the record for your custom portal</td>
</tr>
<tr>
<td>Name</td>
<td>Content-Security-Policy</td>
</tr>
</tbody>
</table>
### Disable chat button in Microsoft Teams on custom portal

You can hide the chat option for your custom portal that appears in Microsoft Teams.

#### Before you begin

**Role required:** admin

#### Procedure

1. **Navigate to Service Portal > CSS.**

2. Click on your custom CSS.

3. Click **here** to edit the CSS.

4. Customize the following code as required and paste in the CSS.

   ```css
   .embedded-experience .sp-ac-btn {
       display: none;
   }
   ```

5. Click **Update**.

6. Refresh the custom portal tab in Microsoft Teams.
Disable logout button in Microsoft Teams on custom portal

You can hide the logout option for your custom portal that appears in Microsoft Teams.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Service Portal > CSS**.

2. Click on your custom CSS.

3. Click here to edit the CSS.

4. To disable the logout button from Microsoft Teams desktop application.
   a. Customize the following code as required and paste in the CSS.

   ```css
   /* Embedded portal */
   /* The code shared to disable the logout button is an example. You need to customize as required to disable logout button. */

   .embedded-experience .avatar-drop-down .header-menu-item:last-child {
     display: none;
   }
   ```

5. To disable the logout button from Microsoft Teams mobile application.
   a. Customize the following code as required and paste in the CSS.

   ```css
   /* Embedded portal */
   /* The code shared to disable the logout button is an example. You need to customize as required to disable logout button. */
   ```
6. Click **Update**.

7. Refresh the custom portal tab in Microsoft Teams.

**Review the active notifications for Microsoft Teams**

The notifications added by ServiceNow for Microsoft Teams, might duplicate existing notifications in your instance. Review and disable any duplicate notifications to avoid notifying users multiple times for the same event.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Provider > Notifications**.

2. Identify a duplicate notification. Example: **HR Case**.

3. Open the **HR Case** notification.

4. Clear **Active**.
5. Click **Update**.

**Request-based chats to import messages from Microsoft Teams to ServiceNow**

**IT Service management for Microsoft Teams** and **HR Service Management for Microsoft Teams** applications enable the system to auto import the chat conversations between the agents and the employees.

If you are installing the ServiceNow for Microsoft Teams in your environment, the auto-import functionality is applicable by default for the following tables.

- HR Core task (sn_hr_core_task)
- HR Life events Case (sn_hr_le_case)
- HR Core case (sn_hr_core_case)
- Request Item (sc_req_item)
- Task (sc_task)
- Incident (incident)
• Request (sc_request)
• Change request (change_request)

The admin can extend the auto import feature to the other tables as required.

If you are upgrading your ServiceNow instance to IT Service Management integration with Microsoft Teams 2.2.0 or HR Service Delivery integration with Microsoft Teams 2.2.0, you must manually enable the auto import feature.

Functionality of auto importing messages

All the chat messages from Microsoft Teams will be auto imported to the ServiceNow instance at an interval of 30 minutes. The system looks for all the new messages across all the chats and import the messages to ServiceNow instance.

To prevent polling from running indefinitely on inactive conversations, if there are no new messages, the polling interval will gradually lengthen until, eventually, polling stops.

The system verifies the record for new messages for every 30 minutes. If there are no new messages, the system checks for the new messages for an interval of one hour, two hour, four hour and eight hours. If there are no new messages in an interval of eight hours for seven days, the Auto Import polling activity is disabled.

If there is any message during any of the intervals, the auto import timer will look for the new messages in the next interval, and import the messages. The timer is then reset to 30-minutes interval.

System Limits

The system imports a maximum of 500 active chats in a 30-minute interval. If there are more than active 500 chats the system will not auto-import the new chat records for the 30-minute interval.

The system executes a maximum of 10000 sub-flows to import the chats for an interval of 30 minutes, 1 hour, 2 hour, 4-hour, 8-hour intervals. This is a count of all the active sub-flows that auto-import the messages into ServiceNow.

If the system reaches the limit, a message is displayed to the agent that the system level is reached and the chat can’t be auto imported on the Start Microsoft Teams Chat modal.
When the ticket is closed, the system will trigger auto import for one last time posts the new messages in the Work notes (Chat history).

If there is an interaction record associated with the parent record then interaction record is also closed. The chat record will also be closed as part of this flow.

**Create chat configuration to auto-import chats**

Create a chat configuration to automatically import the chats between the agents and the requesters for additional tables to extend the auto import functionality.

**Before you begin**

Role required: admin
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Chat Configuration.

2. Click **Default** option to view the default OOB configuration.
Note: If you want to auto-import chats for certain conditions, create a new condition.

3. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Chat Configuration.
4. Click New.
5. On the form, fill the fields.

**Chat configuration**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Value for the configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>Order for the configuration. You can define multiple chat configurations for a single table. The system executes the query based on the descending order.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the configuration. Select the check box to activate the configuration.</td>
</tr>
<tr>
<td>Auto Import</td>
<td>Option to automatically import the chat. Select the check box to automatically import the chat.</td>
</tr>
<tr>
<td>Default</td>
<td>Option to keep the configuration as default.</td>
</tr>
<tr>
<td>Note:</td>
<td>You cannot define multiple default values for chat configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>Option to select the auto-import for a table.</td>
</tr>
<tr>
<td>Inherit</td>
<td>Extend and apply to the child tables.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Option to define a condition for a chat to be auto-imported.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening message</td>
<td>Option to provide a text message that displays to the agent when the agent initiates a chat. This field is enabled only if the Auto Import option is selected.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

   The chat configuration defined will be applicable only for the table selected. You can extend the chat configuration to other tables by creating another chat configuration record.

**Create requester mapping**

Create a requester mapping to extend the auto-import functionality to other tables.

**Before you begin**

Role required: admin

**Note:**

If there is no requester mapping defined for a table, the interaction records will not be created. An error log is created for the admin to notify that the requester mapping is not defined for a table.

A requester-mapping record defines which field, in any given table, is the field representing the requester of a ticket.
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Requestor Mapping.

2. Click New.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table to which the requester mapping (auto-import feature) should be applicable.</td>
</tr>
<tr>
<td>Requestor field</td>
<td>Field to select the requester for a record.</td>
</tr>
<tr>
<td>Inherit</td>
<td>Extend and apply the auto-import feature to the child tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the requester-mapping record.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Configure close condition

Configure the condition to exclude the chat conversation from auto importing.

Before you begin

Role required: admin

About this task

When a ticket is set to inactive, the system does one final poll for any messages in the chat, removes the participants such that no further messages about the ticket can be exchanged in the chat, and then stops polling that chat. This is determined by the “active” field on a table being set to "false".

For any table with an active field, this behavior works automatically. If your custom application does not use an "active" field for determining whether the ticket remains active, define an alternate condition which can be used to denote the ticket as being closed or inactive.

Alternately, to adhere to platform standards, consider adding an active field to your custom application and maintaining the state of that field in accordance with the business logic of your application.
Procedure

1. Navigate to ServiceNow for Microsoft Teams > Chat Administration > Close Conditions.

2. Click New.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Close condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Option to select a table to which the requester mapping (auto-import feature) should be applicable.</td>
</tr>
<tr>
<td>Inherit</td>
<td>Extend and apply the auto-import feature to the child tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the requester-mapping record.</td>
</tr>
<tr>
<td>Close conditions</td>
<td>Condition builder to define a condition that the record is closed.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Note:**

If you are creating a close condition for a new table, ensure to create business rule for close condition. For more information, refer Configure business rule for close condition.

Set up Chat to call

Set up the chat to call functionality in your instance to enable the agents to collaborate with the requester to resolve the issue.

The Chat to call functionality helps the requester to quickly get the resolution for their issues.

Here is the flow-diagram of the chat to call functionality:
To enable the Chat to Call functionality you must install the Workspace Agent chat, Notify, and the Notify connector for Microsoft Teams plugins in your instance. You must also install ServiceNow for Teams installed with Virtual Agent or Virtual Agent Lite. For more information, refer the following topics:

- Set up Workspace Agent Chat
- Activate Notify
- Setup and configure Notify connector for Microsoft Teams for multi-tenant

For more information on the workflow for chat to call flow, refer Promote chat to a call from workspace.

Create User Principal Name (custom email) field for users to use Microsoft Teams to initiate chats
Create a custom email field to use Microsoft Teams app to initiate chat conversation for the agents to resolve the IT and HR related issues of the users.

Before you begin
Role required: admin

Procedure
2. Click a user.
3. Right-click on the form header and select **Configure > Form Layout**.

4. In the Create new field section, fill in the fields.

### Create new field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the field as you want it to appear on forms and lists. Example: User Principal Name.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a field type as email.</td>
</tr>
<tr>
<td>Field length</td>
<td>Select a field length. This field is visible only for certain field types.</td>
</tr>
</tbody>
</table>

5. Click **Add**.

6. In the Selected slush bucket column, move the field in the desired location on the form.

7. Click **Save**.

The field now appears on the form in the designated location.

The admin must enter the email used for Microsoft Teams in this field.
You need to configure the newly created field value as the default field for initiating chats with the employee in Microsoft Teams.

8. Right-click on the field and click **Show `<value of the field name>`**.

The dictionary info of the field name can be viewed.

9. Right click the **Field** and copy the value.

10. In the search field, enter `sys_properties.LIST` to view the system properties.
11. In the Name column, search for `*user_email` property.

12. Click the entry.

If the record is not editable, click **Edit** on the header to edit the record.

13. Update the **Value** field with the new field name that is created.
   The default value is `email`.

14. Click **Update**.

   **Note:** Ensure that the email address for all the users for the newly created field is updated with the email associated with Microsoft Teams app.

**Unfurl the web links in Microsoft Teams chat conversations**

ServiceNow for Microsoft Teams supports link unfurling. Link unfurling generates a content-rich preview when a supported link is shared in a conversation with a user in Microsoft Teams.
To enable link unfurling, you must create and download the manifest file and upload the file to Microsoft Teams. To download the manifest file, refer to Create and download the manifest file.

In a conversation in Microsoft Teams application, the content in the URL appears as a preview to the user in the form of an adaptive card. The preview is generated based on the content shared in the URL.

The content in the adaptive card will be shown only for public knowledge articles, and the catalog items. However, the adaptive card shows generic content for all private links in the chat conversations.

Enable link unfurling

Enable link unfurling in the manifest file to preview the content of the link shared in the chat conversations.

Before you begin
Role required: admin

Procedure

1. Create and download the manifest file.
   Enable link unfurling option in Generic info tab while working on the manifest file.
   After uploading the manifest file in Microsoft Teams app, you must update the value of ServiceNow for Teams app ID from Microsoft Teams admin center in your ServiceNow instance.

2. Log in to Microsoft Teams admin center.

3. Navigate to Teams apps > Manage apps.

4. Search and click ServiceNow for Teams app.

5. Copy the App ID value.
6. In your ServiceNow instance, search for `sys_properties.LIST`.

7. In the Name field, search for `sn_now_azure.teams_installed_app_id` value.

8. Click the entry to view the properties. If the record is uneditable, click here to edit the record.
9. Update the App ID value and click **Update**.

Configure the system property to open the unfurled links in Microsoft Teams

Configure the property to view the content when the user clicks the adaptive card shared in the Microsoft Teams chat conversation.

**Before you begin**
Role required: admin

**About this task**
Setting the property to true opens all the configured portal-related links within the application. All the non-portal links are opened in the browser.

By default, this property is set as true. If you set the property as false, all the links shared in the chat conversations will be opened in the browser.

**Procedure**

1. In your ServiceNow instance, search for sys_properties.list.

2. In the Name column, search for `sn_now_teams.link_unfurl.view_action_choice` property.

3. Click the property. If the record is uneditable, click here to edit the record.
4. Update the **Value** field as false to view the links in a browser.

5. Click **Update**.

**User setup and actions**

Link your ServiceNow account with Microsoft Teams application to access non-public Virtual Agent topics that use ServiceNow records.

**Add ServiceNow for Microsoft Teams app**

Enables users to interact with the agents from Microsoft Teams application.

**Before you begin**

Role required: admin

**About this task**

To receive notifications from Virtual Agent, users must link their accounts to Microsoft Teams. Guest users can't receive notifications.

**Procedure**

1. Launch Microsoft Teams application.
2. Click **Apps**.
3. In the apps search field, enter ServiceNow for Microsoft Teams.
4. Click **ServiceNow for Microsoft Teams** app.
5. Click **Open**.

**Results**
The **ServiceNow for Microsoft Teams** app is successfully installed in your Microsoft Teams application.

**Link ServiceNow user account to Microsoft Teams application for Virtual Agent**
Link your ServiceNow account to Microsoft Teams application to access the non-public Virtual Agent topics that use ServiceNow records.

**Before you begin**
Role required: user
The authentication step occurs in your instance or in a specific Service Portal, if set by your admin.

**Procedure**
1. Open the Microsoft Teams application.
2. Find your Virtual Agent bot.
3. Start a conversation with your Virtual Agent bot.
   The bot then presents a prompt that provides options to authenticate **Link to ServiceNow**, continue as a guest user, or see the help menu **Check out Tips**.

4. Click **Link to ServiceNow** to authenticate.
   Authentication directs you to your instance or a specific Service Portal set by your admin. If you are not already logged in to your instance or a Service Portal, you are prompted to enter your login credentials.
   The system administrator can auto link the ServiceNow user accounts to Microsoft Teams from Quebec. For more information, see [Account linking in pre-built messaging integrations](#).
5. On the confirmation dialog, click **Confirm** to link your account.

**Unlink your ServiceNow user account from Microsoft Teams for Virtual Agent**
Unlinking your account from Microsoft Teams to deactivate the association between your ServiceNow account and the Microsoft Teams application.

**Before you begin**
Role required: user
After you unlink your account, you can no longer engage in Virtual Agent conversations that query or change records in the ServiceNow database.

Procedure
1. From the application navigator, navigate to Self-Service > My Profile.
2. Click the View Linked Accounts related link.
3. In the linked accounts page, select the check box for the messaging integration to be unlinked.
4. Select Actions on selected rows and then click Unlink account.

The link between your ServiceNow account and the Virtual Agent messaging integration becomes inactive.

⚠️ Note: Even though you unlinked your account, you can still run public Virtual Agent conversations. To link your account again, repeat steps 1 through 3 for the associated messaging integration and in the Actions on selected rows... click Link account.

Using ServiceNow for Microsoft Teams

Employees and agents can collaborate to receive service and resolve issues effectively from Microsoft Teams.

Employee actions
Respond to the approval notifications and the comments against the service-related tickets. Actionable notifications sent through Virtual Agent in Microsoft Teams. You can:
• Accept or reject approvals in response to an actionable notification
• Respond to a comment from an agent in an actionable notification

View informational notifications
View the notifications that are sent during specific events in a ticket life cycle. These notifications are sent to the requester associated with the ticket.

Before you begin
Role required: user

About this task
The following informational notifications are included with ServiceNow for Microsoft Teams application:
• Incident resolved
• Incident state update
• Requested item complete
• Requested item approved
• Request item rejected
• Request item update

Procedure
1. Launch Microsoft Teams application.
2. Click Activity.
3. View the list of notifications feeds for:
   • Incident
   • HR case
   • Change request
   • Requested item

4. Click the notification to view the details.

Approval Notifications
The user receives a notification with an Approve or Reject action. If rejecting, a comment must be provided.

Before you begin
Role required: user

Procedure
1. Launch Microsoft Teams application.
2. Click Activity.
3. View the list of notifications feeds for:
   • Request
   • Change Request
4. Click the notification to view the details.
5. Enter a comment as required.
6. Click either Approve or Reject the request.
7. Click View details to view the complete details of the ticket.

Respond to a comment in a notification
A comment in the activity stream generates a notification to which the user can respond directly, without leaving Microsoft Teams.

Before you begin
Role required: user

About this task
If the user needs to take an additional action, such as attaching a document, they must click View Ticket Details to go to the ticket in a Service Portal.

Procedure
1. Launch Microsoft Teams application.
2. Click Activity.
3. View the list of notifications feeds for:
   • Incident
   • HR case
• Change request
• Requested item

4. Click the notification to view the details.

Phone order request
REQ1028

Hello Ron,

My name is Ethan and I'm working on your phone order. Unfortunately, we don't currently have the Google Pixel 4 you ordered in white.

We do have that model in black. I can change your order to the black model if you'd like. Otherwise we'll let you know when we have a white model available.

Send reply  
View ticket details

Send message

Type messages

Send

5. Click Send reply.
6. Enter your comment.
7. Click Send.
8. Click View ticket details to view the complete details of the ticket.

View notifications for a major incident

View the notifications that are sent during specific events in a major incident. These notifications are sent to all the stakeholders associated with the major incident.

Before you begin
Role required: major_incident_manager, agent

About this task
The following informational notifications are triggered for a major incident when:
• A communication task is created for a major incident
• SLA reaches 75%
• SLA is breached

**Procedure**
1. Launch **Microsoft Teams** application.
2. Click **Activity**.
3. View the list of notifications feeds for the major incident.
4. Click the notification to view the details.

![New communication task]

**INC0000530**

Naveen Mallepally created First technical communication for this Incident

<table>
<thead>
<tr>
<th>Task name</th>
<th>First technical communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication plan</td>
<td>Immediate response</td>
</tr>
<tr>
<td>Channels</td>
<td>E-mail</td>
</tr>
<tr>
<td>Due</td>
<td>2020-09-29 23:45:23</td>
</tr>
</tbody>
</table>

5. Click **View workbench** to view the ticket details in ServiceNow.

**Your hub dashboard**

Use the Your Hub dashboard from Microsoft Teams to view the widgets that show pending tasks, requests, and the internal company announcements.

For customers with Employee Service Center, Content managers and Communications Specialists will be able to leverage Microsoft Teams as an additional channel to reach employees with personalized and timely communications.

Launch Microsoft Teams. Navigate to **ServiceNow for Microsoft Teams > Your hub**.

Click the tickets you would like to work to open in the ServiceNow instance.
You can view and access the following widgets:

**Your Hub table**

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View your employee portal</td>
<td>Click to navigate to the employee portal</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>List of your pending tickets</td>
</tr>
<tr>
<td>Track your requests</td>
<td>List of your requests</td>
</tr>
<tr>
<td>IT announcements</td>
<td>View the IT announcements released by the IT department</td>
</tr>
<tr>
<td>Upcoming events</td>
<td>View the upcoming events in your company</td>
</tr>
<tr>
<td>Holiday calendar</td>
<td>View the upcoming holidays for the current year</td>
</tr>
<tr>
<td>IT outages</td>
<td>View the active IT outage details</td>
</tr>
<tr>
<td>Find your apps</td>
<td>List of apps provided by your company</td>
</tr>
</tbody>
</table>

**Agent actions**

Work on the service-related tickets created by the employees.

**Request based chat - Start and import chat from classic view**

Initiate a conversation with the requester to resolve the ticket.

You must have the "write" role to use the **Start Microsoft Teams chat** and **Import messages from Microsoft Teams** features for an incident, request, change request and a catalog task. This role is available when you activate the ITSM roles plugin, or for all the instances starting the Madrid release.
### Record and Role

<table>
<thead>
<tr>
<th>Record</th>
<th>Role</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>sn_incident_write</td>
<td>ITSM Roles - Incident Management (com.snc.itsm.roles.incident_management) plugin</td>
</tr>
<tr>
<td>Change Request</td>
<td>sn_change_write</td>
<td>ITSM Roles — Change Management (com.snc.itsm.roles.change_management) plugin</td>
</tr>
<tr>
<td>Request</td>
<td>sn_request_write</td>
<td>ITSM Roles — Request Management (com.snc.itsm.roles.request_management) plugin</td>
</tr>
<tr>
<td>HR Case</td>
<td>sn_hr_core.case_writer</td>
<td>Human Resources Scoped App — Employee Relations [com.sn_hr_employee_relations] plugin</td>
</tr>
</tbody>
</table>

### Request-based chat - Start and import chat from field decorator

Interact with a requester in Microsoft Teams from the chat icon from the workspace to quickly resolve the ticket.

**Before you begin**

Role required: user with access to the respective records

**Procedure**

1. Navigate to an open ticket (an incident, a change request, a request item, an HR case or a catalog task) in your ServiceNow instance.

2. Point to next to the **Caller** field.

3. Within the dialog box that appears, select the participants for the chat.
The dialog box displays the **Recommended** and **Selected** participants for the chat. All users from the assigned group for the ticket are in the recommended section by default. The user who initiates the chat is added to the selected list of participants.

4. On the form, fill the fields.

### Start chat modal fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Participants</td>
<td>Option to add the users and the stakeholders to work towards the resolution of the ticket.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Users</td>
<td>Enter the name of the user to include in the chat.</td>
</tr>
<tr>
<td>Group</td>
<td>Enter the group of users to be included in the chat.</td>
</tr>
<tr>
<td>◦ On-Call Scheduling</td>
<td>If the On-Call Scheduling (com.snc.on_call_rotation) plugin is activated, the On-Call Scheduling users will be added when you select a group. On-Call Scheduling (com.snc.on_call_rotation) plugin isn’t activated, it adds all users from the selected group.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter a valid email of the participant to be included in the chat. After adding the required stakeholders, click <strong>Add to selected</strong>.</td>
</tr>
<tr>
<td>Chat title</td>
<td>The chat title specified shows up as the title of the chat in Microsoft Teams. The default title is the ticket number appended with the short description. You can modify the chat title.</td>
</tr>
<tr>
<td>Create an opening message</td>
<td>Option to provide an opening message to the user before beginning the interaction.</td>
</tr>
<tr>
<td>Choose your preferred chat client</td>
<td>Option to choose the default chat client.</td>
</tr>
<tr>
<td>◦ Desktop Application</td>
<td>Open the chat interaction in Microsoft Teams desktop application.</td>
</tr>
<tr>
<td>◦ Web Client</td>
<td>Opens the chat interaction in Microsoft Teams web client.</td>
</tr>
<tr>
<td></td>
<td>The system remembers the selected option and will open the chats in the preferred chat client for all the further chat interactions.</td>
</tr>
</tbody>
</table>

5. **Click Start Chat.**

The Microsoft Teams app displays the chat title and the opening message provided by the agent.
The system captures the work notes about the chat details.

If the agent initiates the chat from the record with the same user, the **Start Microsoft Teams Chat** appears as shown.

The system displays **Continue Chat** button to resume the conversation. However, if any other user is added, the chat modal displays the **Chat title** and the **Create an opening message** fields.

The interaction is only created when the conversation is with the requester. If the conversation doesn’t include the requester, such as a conversation between the agent and a collaborator, an interaction is not created, but the Microsoft Teams chat record is still created.

A Microsoft Teams chat interaction is automatically created and you can access the chat details from the Activities log.
a. In the Activities log of the record, look for the comment that has the link to access the chat interaction.

b. • Click the link.
   • The chat transcript is stored in the Activities section.

Chat activities table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Users associated with the chat</td>
</tr>
<tr>
<td>Document</td>
<td>Source record number</td>
</tr>
<tr>
<td>Initiated by</td>
<td>Agent who has initiated the chat interaction.</td>
</tr>
<tr>
<td>Auto Import</td>
<td>Status of the auto-import messages. If the option is not selected, the messages pertaining to the record will not be auto-imported.</td>
</tr>
<tr>
<td>Topic</td>
<td>Chat title</td>
</tr>
<tr>
<td>Activities</td>
<td>Chat transcript</td>
</tr>
</tbody>
</table>

Request-based chat - Start and import chat from Start Microsoft Teams chat action

Interact with a requester in Microsoft Teams for an issue related to an incident, request item, change request, and HR case records to quickly resolve the ticket.

Before you begin
Role required: user with access to the respective records

Procedure
1. Navigate to an open ticket (Incident, change request, request item, HR case or a catalog task) in your ServiceNow instance.
2. Click Start Microsoft Teams Chat.
3. Within the dialog box that appears, select the participants for the chat.
The dialog box displays the **Recommended** and **Selected** participants for the chat.

All users from the assigned group for the ticket are in the recommended section by default. The user who initiates the chat is added to the selected list of participants.

4. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Start chat modal fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Add Participants</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
• **Users**: Enter the name of the user to include in the chat.  
• **Group**: Enter the group of users to be included in the chat.  
  ◦ If the On-Call Scheduling (com.snc.on_call_rotation) plugin is activated, the On-Call Scheduling users will be added when you select a group. On-Call Scheduling (com.snc.on_call_rotation) plugin isn’t activated, it adds all users from the selected group.  
• **Email**: Enter a valid email of the participant to be included in the chat.  
After adding the required stakeholders, click **Add to selected**.

**Chat title**  
The chat title specified shows up as the title of the chat in Microsoft Teams. The default title is the ticket number appended with the short description. You can modify the chat title.

**Create an opening message**  
Option to provide an opening message to the user before beginning the interaction.

**Choose your preferred chat client**  
Option to choose the default chat client.  
• **Desktop Application** – Open the chat interaction in Microsoft Teams desktop application.  
• **Web Client** – Opens the chat interaction in Microsoft Teams web client.  
The system will remember the selected option and will open the chats in the preferred chat client for all the further chat interactions.

5. Click **Start Chat**.
   
The Microsoft Teams app displays the chat title and the opening message provided by the agent.
The system will capture the work notes about the chat details.

If the agent initiates the chat from the record with the same user, the **Start Microsoft Teams Chat** appears as shown.

The system displays **Continue Chat** button to resume the conversation. However, if any other user is added, the chat modal displays the **Chat title** and the **Create an opening message** fields.

A Microsoft Teams chat interaction will be automatically created and you can access the chat details from the Activities log.

a. In the Activities log of the record, look for the comment that has the link to access the chat interaction.

b. Click on the link.
The chat transcript is stored in the **Activities** section.

Chat activities table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Users associated with the chat</td>
</tr>
<tr>
<td>Document</td>
<td>Source record number</td>
</tr>
<tr>
<td>Initiated by</td>
<td>Agent who has initiated the chat interaction.</td>
</tr>
<tr>
<td>Auto Import</td>
<td>Status of the auto-import messages. If the option is not selected, the messages pertaining to the record will not be auto-imported.</td>
</tr>
<tr>
<td>Topic</td>
<td>Chat title</td>
</tr>
<tr>
<td>Activities</td>
<td>Chat transcript</td>
</tr>
</tbody>
</table>

**Import messages from a ticket manually**

You can import the conversation with a user from Microsoft Teams and append them in the **Comments** to store all the important messages in the ServiceNow instance.

**Before you begin**

Role required: user

**About this task**

Importing messages helps agents to view the history of the ticket, allow the requester to see all discussions about their ticket in one place. This helps to capture the information required for post-ticket review and continuous improvement processes.

**Procedure**

1. Navigate to an open ticket (Incident, change request, request item, HR case or a catalog task) in your ServiceNow instance.
2. Click **Import messages from Microsoft Teams**.
3. On the **Import messages from Microsoft Teams** form, fill in the fields:

Import messages from Microsoft Teams table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show conversations</td>
<td>Choose from:</td>
</tr>
</tbody>
</table>
### Field Description
- **• Started from this record**: Lists all the communication tasks created for the record.
- **• List all conversations**: Lists all conversations by the logged in agent.

**Select a conversation**
Choose a conversation to import the messages for the record.

**Import messages as**
- **Additional comments**: The messages will be appended under Additional comments.
- **Work notes**: The messages will be appended under Work notes.

---

**4. Select the messages, files, and the images you would like to import and click Import messages.**
If you try to import the messages manually for a ticket that will automatically import the messages, the system displays a message that the chat is being imported using auto-import.

**Import messages from Microsoft Teams**

Show conversations
Related to this record ▾

Select a conversation

INC0010050 - VPN is not working cannot remote access to customer instance - Adele Vance, Megan Bowen, Isaiah

Request-based chat - Start and import chat from Workspace
Initiate a conversation with the requester to resolve the ticket.

Request-based chat - Start and import chat from field decorator
Interact with a requester in Microsoft Teams for an issue related to an incident, request item, change request, and a catalog task ticket to quickly resolve the ticket.

**Before you begin**
Role required: user with access to the respective records

**Procedure**
1. Navigate to an open ticket (an incident, a change request, a request item, an HR case, or a catalog task) in your ServiceNow instance.

2. Point to next to the **Opened for** field.
   The chat is initiated with the user in **Microsoft Teams**.
3. On the form, fill in the fields.

**Start chat**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants</td>
<td>Option to add the users and the stakeholders to work towards the resolution of the ticket.</td>
</tr>
<tr>
<td>Groups</td>
<td>Option to add the groups required to work towards the resolution of the ticket.</td>
</tr>
<tr>
<td>Recommended</td>
<td>System displays the list of users associated with the ticket. Select the user to include in the chat conversation.</td>
</tr>
<tr>
<td>Chat title</td>
<td>The chat title specified shows up as the title of the chat in Microsoft Teams. The default title is the ticket number appended with the short description. You can modify the chat title.</td>
</tr>
<tr>
<td>Create an opening message</td>
<td>Option to provide an opening message to the user before beginning the interaction.</td>
</tr>
<tr>
<td>Choose your preferred chat client</td>
<td>Option to choose the default chat client.</td>
</tr>
<tr>
<td></td>
<td>• Desktop Application – Open the chat interaction in Microsoft Teams desktop application.</td>
</tr>
<tr>
<td></td>
<td>• Web Client – Opens the chat interaction in Microsoft Teams web client. The system remembers the selected option and will open the chats in the preferred chat client for all the further chat interactions.</td>
</tr>
</tbody>
</table>
4. Click **Start Chat**.

   The Microsoft Teams app displays the chat title and the opening message provided by the agent.

   The system captures the work notes about the chat details.

---

**Request-based chat - Start and import chat from Start Microsoft Teams chat action**

Interact with a requester in Microsoft Teams from the workspace to quickly resolve the ticket.

**Before you begin**

Role required: user with access to the respective records

**Procedure**

1. Navigate to an open ticket in your ServiceNow instance.

2. Click **Start Microsoft Teams Chat**.

   The chat will be initiated with the requester in Microsoft Teams.
### Start Microsoft Teams Chat

**Participants**
- Beth Anglin (Caller)  

**Groups**

**Recommended**
- Beth Anglin (Caller)  
- Don Goodliffe (Assigned to)

**Chat title**
- INC0010001 - Outlook sync issue | New Email are not synced

**We recommend using the record number and describe what the chat is about**

**Create an opening message**
- This chat log may be saved to better serve you in the future.

**Choose your preferred chat client**
- **Web Client**

Chats will be imported using the auto-import feature.

### 3. On the form, fill in the fields.

**Start chat**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants</td>
<td>Option to add the users and the stakeholders to work towards the resolution of the ticket.</td>
</tr>
<tr>
<td>Groups</td>
<td>Option to add the groups required to work towards the resolution of the ticket.</td>
</tr>
<tr>
<td>Recommended</td>
<td>System displays the list of users associated with the ticket. Select the user to include in the chat conversation.</td>
</tr>
<tr>
<td>Chat title</td>
<td>The chat title specified shows up as the title of the chat in Microsoft Teams. The default title is the ticket number appended with the short description. You can modify the chat title.</td>
</tr>
<tr>
<td>Create an opening message</td>
<td>Option to provide an opening message to the user before beginning the interaction.</td>
</tr>
<tr>
<td>Choose your preferred chat client</td>
<td>Option to choose the default chat client.</td>
</tr>
<tr>
<td></td>
<td>• Desktop Application – Open the chat interaction in Microsoft Teams desktop application.</td>
</tr>
<tr>
<td></td>
<td>• Web Client – Opens the chat interaction in Microsoft Teams web client. The system remembers the selected option and opens the chats in the preferred chat client for all the further chat interactions.</td>
</tr>
</tbody>
</table>
4. Click **Start Chat**.

The Microsoft Teams app displays the chat title and the opening message provided by the agent.

The system captures the work notes about the chat details.

---

**Import messages from Workspace manually**

You can import the conversation with a user from the workspace and append them in the **Comments** to store all the important messages in the ServiceNow.

**Before you begin**

Role required: user

**Procedure**

1. Navigate to an open ticket (an incident, a change request, a request item, an HR case or a catalog task) in your ServiceNow instance.

2. Click **Start Microsoft Teams Chat** list.
3. Click **Import messages**.

4. Select the messages you would like to import and click **Import messages**.

### Import messages from Microsoft Teams table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show conversations</td>
<td>Choose from:</td>
</tr>
<tr>
<td></td>
<td>• Started from this record: Lists all the communication tasks created for the record.</td>
</tr>
<tr>
<td></td>
<td>• List all conversations: Lists all conversations by the logged in agent.</td>
</tr>
<tr>
<td>Select a conversation</td>
<td>Choose a conversation to import the messages for the record.</td>
</tr>
<tr>
<td>Import messages as</td>
<td>• <strong>Additional comments</strong>: The messages will be appended under Additional comments.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work notes</strong>: The messages will be appended under Work notes.</td>
</tr>
</tbody>
</table>
Import messages from Microsoft Teams

Show conversations

Started from this record

Select a conversation

INC0010050 - VPN is not working cannot remote access to customer instance [1] - Adele Vance, Pradeep Gupta, Isaiah Langer

- Today 2021-09-01

- AV
  - You 04:28:33
  - This chat log started from Major Incident may be saved to better serve you in the future.

- AV
  - You 04:29:10
  - Hi how can I help you today?

- IL
  - Isaiah Langer 04:30:52
  - The VPN is not working

- IL
  - Isaiah Langer 04:30:56
  - I need to be on the customer call

Import messages as

Additional comments

Cancel Import (5)
If you try to import the messages manually for a ticket that will automatically import the messages, the system displays a message that the chat is being imported using auto-import.

**Promote chat to a call from workspace**

As an agent, you can initiate a chat with the caller from the workspace to quickly resolve the issue.

**Before you begin**
Role required: itil, itil_admin

**Procedure**
1. Navigate to **Workspace Home > Inbox**.
2. From your inbox, click **Accept** to accept a chat.
The interaction record appears in the agent workspace.

3. In the message input field, enter the command `/teams_call`. 
A Microsoft Teams conference call will be initiated, and the link appears in the active chat area.

4. Click the meeting link to join the conference call.
The user receives a call in Microsoft Teams.

The user’s can initiate a chat conversation in Microsoft Teams.

5. Click to open the conversation pane.

6. After the conversation ends, click to leave the conference call.

All the information is logged in the Activity (Work notes). You can view the child interaction, and the chat conversation occurred in Microsoft Teams.
7. Do one of the following:

- Click the child interaction record to view the participants, call duration details.

- Click meeting chat link to view the conversation occurred in Microsoft Teams.

Add communication plan from MIM workbench

You can create a new communication plan or add a new communication task to an existing communication plan from the workbench.
Before you begin
Role required: major_incident_manager

Procedure
1. Navigate to Incident > Major Incidents > Open.
2. Open the relevant major incident.
3. Click View Workbench.
4. Click Communications tab, and then click Add that appears in Communication Tasks section.
5. On the form, fill the fields.

Create New template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan</td>
<td>List to select a new communication plan or to select an existing plan and add communication tasks to the plan.</td>
</tr>
<tr>
<td>Plan Short description</td>
<td>Brief description of what the communication plan is all about.</td>
</tr>
<tr>
<td>Task Short description</td>
<td>Brief description of what the communication task is all about.</td>
</tr>
<tr>
<td>Channels</td>
<td>Check box to select email, SMS, Microsoft Teams notification, or conference as mode of communication for the plan.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency at which a specific task must be executed. A task can be executed only once or on specific durations.</td>
</tr>
<tr>
<td>Due in (Minutes)</td>
<td>Time span when the task must be executed after the task initiates. For recurring tasks, it also indicates the time span after which the task must repeat.</td>
</tr>
</tbody>
</table>

6. Click Next.
7. In the Manage Recipients tab, add the users required to be involved in the major incident communication plan.
8. Click Save.

Send a notification from Major incident management workbench
Send Microsoft Teams notification to the stakeholders associated with a major incident.

Before you begin
Role required: admin

Procedure
1. Navigate to Incident > Major Incidents > Open.
2. Open the relevant major incident.
3. Click View Workbench.
4. Click Communications tab.
5. Add a new communication task.
The communication task appears.
6. Click **Compose** button.

7. In the Compose modal screen, enter the following details:
   a. To: Enter the recipients associated with the communication task.
   b. Message: Enter the notification message.
   c. Click **Send** button.

The notification is sent to the recipients in Microsoft Teams.

8. Click **View ticket details** to view the ticket in ServiceNow.

**View notifications for a major incident**

View the notifications that are sent during specific events in a major incident. These notifications are sent to all the stakeholders associated with the major incident.

**Before you begin**
Role required: major_incident_manager, agent
About this task
The following informational notifications are triggered for a major incident when:

- A communication task is created for a major incident
- SLA reaches 75%
- SLA is breached

Procedure
1. Launch Microsoft Teams application.
2. Click Activity.
3. View the list of notifications feeds for the major incident.
4. Click the notification to view the details.

New communication task
INC0000530
Naveen Mallepally created First technical communication for this Incident

<table>
<thead>
<tr>
<th>Task name</th>
<th>First technical communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication plan</td>
<td>Immediate response</td>
</tr>
<tr>
<td>Channels</td>
<td>E-mail</td>
</tr>
<tr>
<td>Due</td>
<td>2020-09-29 23:45:23</td>
</tr>
</tbody>
</table>

5. Click View workbench to view the ticket details in ServiceNow.

Add collaborative communication task from MIM workbench
You can create a new communication plan or add a new communication task to an existing communication plan from the workbench.

Before you begin
Role required: major_incident_manager

Procedure
1. Navigate to Incident > Major Incidents > Open.
2. Open the relevant major incident.
3. Click View Workbench.
4. Click **Collaborate** tab.
5. Click **Add** that appears in **Communication Tasks** section.
6. On the form, fill the fields.

**Communication task form.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan</td>
<td>List to select a new communication plan or to select an existing plan and add communication tasks to the plan.</td>
</tr>
<tr>
<td>Task Short description</td>
<td>Brief description of what the communication task is all about.</td>
</tr>
<tr>
<td>Channels</td>
<td>Select Microsoft Teams group chat.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency at which a specific task must be executed. A task can be executed only once or on specific durations.</td>
</tr>
<tr>
<td>Due in (Minutes)</td>
<td>Time span when the task must be executed after the task initiates. For recurring tasks, it also indicates the time span after which the task must repeat.</td>
</tr>
</tbody>
</table>

7. Click **Next**.
8. In the **Manage Recipients** tab, add the users required to be involved in the major incident communication plan.
9. Click **Add**.
    The task appears in the **Collaborate** tab.

**Initiate Microsoft Teams group chat from MIM workbench**

You can initiate a Microsoft Teams group chat from the MIM workbench to work towards the resolution of the task.

**Before you begin**

Role required: major_incident_manager
Procedure

1. Navigate to **Incident > Major Incidents > Open**.
2. Open the relevant major incident.
3. Click **View Workbench**.
4. Click **Collaborate** tab.
5. Click **Initiate** button.

6. Within the dialog box that appears, select the participants for the chat.

The dialog box displays the **Recommended** and **Selected** participants for the chat.

All users from the assigned group for the ticket are in the recommended section by default. The user who initiates the chat is added to the selected list of participants.

7. Click **Add Participants** list to:
   - **Users**: Enter the name of the user to include in the chat.
   - **Group**: Enter the group of users to be included in the chat.
If the On-Call Scheduling (com.snc.on_call_rotation) plugin is activated, the On-Call Scheduling users will be added when you select a group. On-Call Scheduling (com.snc.on_call_rotation) plugin isn’t activated, it adds all users from the selected group.

- **Email**: Enter a valid email of the participant to be included in the chat.

8. Click **Add to selected**.

   The **Chat Title** appears only if there are more than two participants in the chat.

9. Click **Start Chat**.

**Results**

The Microsoft Teams application opens the tab where the agent can chat with all the selected participants.

**Now Mobile app**

Enable your users to submit incidents and requests, manage tasks, and access company resources from anywhere using the Now Mobile app.
Features of the Now Mobile app

The Now Mobile app is a downloadable app designed to help your employees with the following tasks:

- Get help by submitting requests and issues.
- Find answers using global search and knowledge base.
- View and report issues around your assets.
- View and complete tasks.
- Upload images and attachments to ServiceNow records.
- Request help from Agent Chat and Virtual Agent.
- Use pre-configured Siri shortcuts unique to the Now Mobile app to complete common actions.

Note: For more information, see Base system functionality for ServiceNow mobile.

Download the app

Download the Now Mobile app for Apple iOS or Google Android from the Apple App Store or the Google Play store.

Access the demo

Take a look at the Now Mobile app demo. The demo is a curated experience designed to show how your employees can accomplish their work from anywhere. For more information on the app, see Now Mobile app demo.

Now Mobile app demo

Access the demo in your Now Mobile app to learn how the app can help you work from anywhere using your mobile device.
The Now Mobile demo includes curated demonstrations to show how employees, new hires, and Chief Information Officers (CIO) can get work done on their mobile device.

**Access the demo**
In the Now Mobile app, tap the **Try with a demo account** button at the bottom of your login screen. Then select the role that matches the demo you’d like to see:

- **Employee** - quickly submit incidents and requests, manage tasks, and access company resources
- **Chief Information Officer** - quickly measure the performance of IT as a business unit, be informed of key updates, and monitor progress of major initiatives
- **New Hire** - get access to resources and information necessary to start a new job successfully
Demo highlights

The Now Mobile demo displays an applet launcher page divided into UI sections. Tap an item in any section to open the item. For details on how applet launchers, applets, and actions work together in the mobile environment, see Mobile hierarchy.

Employee

Campaigns

The carousel display shows how you can easily present targeted information to employees based on location, job role, and other key criteria. Rich media, including in-app video playback, can cover a variety of important company communications.

Frequently Used Items

The display includes an example of shortcuts to items employee users are likely to access frequently, such as scheduling a visit to the tech lounge. These can be configured by the organization to keep them readily available for employees. For more information about the tech lounge example, see Understanding Walk-up Experience. For more information on office entry codes, see Verify your health status and compliance.

My Items

The My items section provides links to active tasks, requests, assets, and team members.

Tasks

Items assigned to a user for completion, such as approvals or policy acknowledgement, will appear in the tasks for the employee. Inline action can be taken to respond to approval requests.

Requests

Once the employee has submitted a request for an item or service the open ticket or case will be available here to track. Universal requests, indicated with a UR at the beginning of the case number, can be easily transferred between departments as needed. For more information on services and requests, see Request experience in Now Mobile.

Assets

Items assigned to a user are itemized for easy reference, making it simple to report an issue or review all checked out assets. For more information, see Hardware Asset Management.

Team

Reaching colleagues is just a tap away. In addition to contact information, profiles show examples of how deeplinks can directly launch other apps, such as a Microsoft Teams chat or a LinkedIn profile. For more information on employee directory applets, see Employee directory screen. For information on configuring native mobile functions like those used to make calls and send emails, see Mobile functions.

Services

Employees can request items or help from departments across the enterprise. Popular services makes the most commonly requested needs easy to find. Other items are easy to browse by topic or can be reached via the search.

Saved
Use saved views to gain quick access to frequently used screens and views. Saved views enable you to save any screen or web page within your mobile app. Learn more about Mobile saved views.

Health
Employees have everything they need for workplace health and safety. Users can verify health, make reservations, or report vaccinations. For more information, see Safe Workplace for mobile.

Virtual Agent Chat
Use the chat button to connect to a virtual agent. Virtual agent is an automated conversational interface you can use to address common issues, such as password resets, or email account setup. The Now Mobile uses a quick action to access chat. For more information on Virtual Agent, see Virtual Agent. The chat button on the demo launch page is a quick action. For details on how to add a virtual agent to your mobile apps, see Enable Live Agent in the Now Mobile app.

Chief Information Officer (CIO)
Value
CIOs need to always have a pulse on the value being delivered by IT to the business. Implementing this core value is delivered within the following sections:

Targets
Quickly glance at how IT is performing against its set targets. This ultimately ties to the CIOs objectives and key results (OKRs). Possible targets could be:

- IT spend to plan YTD
- Employee satisfaction
- Number of projects delivered YTD

Investments
What strategies and business units are investing in IT.

Business Enablement
Review and identify any current Capability gaps and take action to address them.

Business Consumption
See the details of subscription or license costs, the vendor, type of agreement, and most importantly when a contract is ending.

Risk and Resiliency
Service Degradation
Service availability and performance issues that the CIO needs to be aware of.

Security and Compliance
Security vulnerabilities that are possible risks to the business and compliance issues that need to be addressed to avoid audits.

Execution
Goals
Standards compliance goals as well as applications retired or cloud migration business goals.
Projects in Red
Understand what the project is slated for along with access to current and past status reports. These reports can include executive summaries on the status to decide whether or not to engage with the project.

Upcoming Releases
Single view to track all new products, features, and enhancements being delivered across the organization.

Digital Transformation
Measure and track execution of the digital transformation efforts within IT, in support of all business units.

Saved Items
Any of the cards or graphs or metrics have drill-down capability, allowing the CIO to navigate down to specific records in ServiceNow. In addition, any section of the CIO mobile has a Save item feature that can serve as bookmarks, so the CIO has a place to go directly to what is top of mind rather than having to navigate to a particular area of the mobile.

Saved items are all available with a single tap and swipe under Saved at the bottom of the CIO mobile app.

New Hire

Note:
The Mobile Onboarding app is being deprecated!

With the Now Platform Rome release in September 2021, we started phasing out support for the Mobile Onboarding app. Customers may no longer activate it, and we are not offering enhancements or non-critical bug fixes. Mobile onboarding features are available in the Now Mobile app for HR Service Delivery.

Welcome Section
Easily present targeted information to employees based on location, job role, and other key criteria. Rich media, including in-app video playback, can cover a variety of important company communications.

Get Ready
A list of common tasks from across the organization that new employees may complete as part of their onboarding experience. These tasks are lifecycle activities, which are part of the Enterprise Onboarding and Transitions application. For more information on lifecycle activities, see Configure a lifecycle event activity.

New Hire Contacts
Use the contacts in this section to view and connect with colleagues using your mobile device’s built-in capabilities.

For more information on employee directory applets, see Configure an employee directory applet.

For information on configuring functions like those used to make calls and send emails, see Mobile functions.

Get Informed
Use targeted mobile campaigns to push relevant information to employees at the right moment. Tapping into this section opens a screen with helpful info about New Hire orientation.

Learn more about the Now Mobile app

Use the following links to learn more about on how to use and configure the Now Mobile app.

- Now Mobile app
- ServiceNow mobile app configuration

Configurations for Now Mobile

Configure options for the Now Mobile app. For example, you can link the app with a service catalog and knowledge base, personalize the greeting for the home page, and specify which records appear under My Requests in the For Me tab.

Note: Offline mode is not supported in the Now Mobile app.

For Me

This page includes these configuration options:

Greeting

Configure the greeting that your users see when they log in to the Now Mobile app. For example, you can add a hello message that includes the user's first and last name.

My To-Dos

Users can view items that are assigned to them and complete their tasks. By default, My To-Dos show the user things that they need to approve from the Requests [sc_request] and Requested Items [sc_req_item] tables. Other applications, such as HR Service Delivery, might include other types of tasks. For more information about HR Service Delivery, see Now Mobile for HR Service Delivery.
My Requests

Specify which records that you want your users to see under **My Requests** so that they can track their work assignments. For example, you can add a filter to display records that are opened by the user from the Problem table. By default, the app displays records that are opened by the user from the Incident and Requested Item tables.
Search

Search includes these configuration options:

People search

Configure whether users can search for other users in the system. By default, people search is enabled. For people search to display results, your users must have read-only access to the User [sys_user] table. You can test people search by logging in as a user without any roles and searching for another user. If search results do not include meaningful data, for example, locations and phone numbers, update the access control lists (ACLs) on the User table to allow read access. For more information, see Access control list rules.

Analytics and suggestions

The Now Mobile app collects search data and analytics that generate search suggestions. If you are upgrading from a previous release, the search analytics do not contain any data yet. To immediately provide suggestions to your users, you can populate the search suggestions using knowledge, catalog, and user search records from the Text Searches [text_search] table.

Search Suggestions is a Now Platform feature. For more information, see Search Suggestions.

Items and services

Service Catalog items and services include these configuration options.

Catalog
Enable your users to view and request their associated items in the Now Mobile app. If no catalogs are selected, users can view and request items from all catalogs in the system. By default, the app uses Service Catalog.

For more information, see Now Mobile for Service Catalog.

**Quick actions**

Select catalog items to display as additional user menu actions. For example, add the **Report an Incident** catalog item to enable users to quickly navigate to the form. Users can only see items if they have the required user criteria permissions.

**Knowledge**

Enable users to view knowledge articles from the mobile app. If no knowledge bases are selected, users can view articles from all knowledge bases in the system. By default, the app uses the IT knowledge base.

For more information, see Now Mobile for Knowledge Management.
Siri shortcuts
In the base system, iOS users can use Siri shortcuts to open these pages in the app:

- Open a chat window.
- Browse items and services.
- Open my tasks.
- Open my requests.

Configure a personalized greeting
Configure the greeting that your users see when they log in to the Now Mobile app. For example, you can add a hello message that includes the user's first and last name.

Before you begin
Role required: admin

Procedure
1. Navigate to Now Mobile App > Applet Launchers.
2. In the Applet Launchers [sys_sg_applet_launcher] table, open the Homepage record.
3. Add the Header Titles field to the form.
4. In the Header Titles field, open the record.
5. Update the **Text** field as desired.
   This text displays in the Now Mobile app heading.
   This field uses the `{{sys_id}}` syntax to reference a variable for the first and last name of the currently logged-in user. Changing the variable is not supported.

6. Click **Submit**.

**Results**
When a user logs in to the Now Mobile app, they see your personalized greeting.

**Configure My Requests to track open records**
Specify which records that you want your users to see under **My Requests** so that they can track their work assignments. For example, you can add a filter to display records that are opened by the user from the Problem table. By default, the app displays records that are opened by the user from the Incident and Requested Item tables.

**Before you begin**
Role required: admin

**About this task**

**Procedure**
1. Navigate to **Now Mobile App > My Request Filters**.
2. In the My Request Filters [request_filter] table, create a filter to display records from a specific table:
   a. Click **New**.
   b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name for the filter.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that extends the Task table. The app displays records from this table under <strong>My Requests</strong>.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter for the table. For example, you can set the filter to <code>[Opened by] [is (dynamic)] [Me]</code> to enable users to view their own requests.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that you can select to make the filter active.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Option that you can select to apply to Mobile apps.</td>
</tr>
</tbody>
</table>

c. Click **Submit**.

Records from the defined filter are displayed in the app under **My Requests** in the **For Me** tab.
AI Search in mobile

The AI Search search engine in the Now Mobile platform enables users to find answers to issues and then proceed quickly with their tasks.

The mobile platform supports two search engines within applet launchers: AI Search and Zing.

AI Search uses user data sources (people), catalog items (services), and knowledge articles. The Zing search engine uses additional data sources not associated with AI Search, for example, user tasks and requests.

- For more information on AI Search configuration, see AI Search.
- For more information about Zing configuration, see Global search for mobile.

Note: You cannot simultaneously use both AI Search and Zing search engines within the same search field. However, you can configure individual applet launchers to host a different search engine per applet. For more information, see Add your search configuration to an applet launcher.

AI Search offers the following features Perry added this is Quebec:

- Navigation tab filters - Filters help users narrow down results on a site.
- Auto-complete - As the user enters text, AI Search predicts the query and helps formulate the user’s question.
- Recent and popular searches - When the user starts to search, two categories of search answers display: the user’s personal search history and the most common queries by all users on the instance.
- Auto-correct typos - Typos are auto-corrected based on indexed content.
- Synonym handling - The search engine also looks for words similar to the search term.
- Genius cards and action items - Genius result cards display the most relevant answers and offer users the option to perform actions within the card, for example, adding buttons to make a call, send an email, or add to a shopping basket.
Configure AI Search for mobile devices

Before you begin
To enable the AI Search capability to search for people and customers, ensure that you have the ESC plugin [com.sn_hr_service_portal] installed. For more information, see Activate Employee Service Center. You must purchase a subscription before activating the plugin. For more details, see ServiceNow plugins.

Make sure you are working in a scoped application where you can add new item configurations.

Role required: admin

Procedure
1. Change the search engine from Zing to AI Search and select the relevant profile.
   a. In the web-based UI, enter sys_sg_global_search.list in the filter navigator, to open a list of global search configurations.
   b. Select the record **Homepage Search - Catalog, Knowledge, People**.
   c. Select click here at the top of the page to edit the record.
d. Select the reference lookup icon (🔍) in the **Search Application Configuration** field, **Search Application Configuration** and select **Open Record** to open the Search Context Configuration form.

e. Select AI Search in the **Search Engine** field.

f. Select the information icon (ℹ️) in the **Search Profile** field and select the NowMobile Default Search profile.

g. Select **Yes** in the confirmation message.

h. Select the form header (📝) and select **Save**.

2. Remove the item configuration, Catalog Item Main item.

   a. In the web-based UI, enter `sys_sg_global_search.list` in the filter navigator to reopen the list of global search configurations.

   b. Select the record **Homepage Search - Catalog, Knowledge, People**.

   c. In the **Catalog Item Main Item** row, right-click the information icon (ℹ️) and select **Open Link in New Tab**.

   d. Select **Delete** in the top-right of the page and select **Delete** in the subsequent confirmation message.

3. In the Global Search M2M Item Configurations related list, add the new catalog item to be the main item.

   a. Select **New**.

   b. Select the reference lookup icon (🔍) in the **Item Configuration** field.

   c. In the Item Configuration form search bar, search for **Catalog Item Search Result Main Item** and then select the entry

   d. Select **Submit**.

4. In the Global Search M2M Item Configurations related list, remove the two existing knowledge item configuration records.

   a. Select the **Knowledge article search main item** row and the **Knowledge article search main item (viewcount1)** row.

   b. Select **Actions on selected rows**, and then select **Delete**.

   c. Select **Delete** in the subsequent confirmation message.

5. In the Global Search M2M Item Configurations related list, add the new knowledge item as the main item.

   a. Select **New**.

   b. Select the reference lookup icon (🔍) in the **Item Configuration** field.

   c. In the Item Configuration form search bar, search for **Knowledge AIS Search Main Item** and then select the entry.

   d. Select **Submit**.

6. Activate the view configuration for the people-based records.
a. In the web-based UI, enter `sys_sg_master_item.list` in the filter navigator, to open a list of item configurations.

b. In the Name search bar, search for `People Search Main Item`.

c. Select the information icon (𝑖) next to `People Search Main Item` and select Open Record.

d. In the Item Configuration form, select **Use View Config**.

e. Select the menu icon (≡) and select **Save**.

**Results**
The Global Search Configuration page should contain the items shown in the following figure.

---

**Customize AI Search results**
Customize AI Search results to provide users with a tailored search experience.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System Mobile > Search > Search Configurations**.
2. Select the AI Search configuration to customize.
3. On the form, fill in the fields.

**Search Context Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This field is automatically set to the name of the search context configuration.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search Engine</td>
<td>This field is automatically set to the selected search engine. For this configuration, the value is AI Search.</td>
</tr>
<tr>
<td>Search Profile</td>
<td>The search experience offered to users. This field is automatically set to <strong>NowMobile Default Search Profile</strong>.</td>
</tr>
<tr>
<td>Search Results Limit</td>
<td>The number of standard results displayed per page not including Genius results. The default value is 10.</td>
</tr>
<tr>
<td>Genius Results Limit</td>
<td>Number of Genius results listed at the top of the results. The default value is 1 and the maximum value is 3.</td>
</tr>
<tr>
<td>Enable Typo Handling</td>
<td>Option for replacing misspelled search query terms with auto-correction terms derived from indexed content.</td>
</tr>
</tbody>
</table>

4. **Optional:** Modify the display name and the navigation tab filters for the People, Services, and Articles categories. These filters display under the search bar.

   a. Select the **Navigation Tabs** tab.

   b. Select the information icon 🔄 next to either People, Articles, or Services and select **Open Record** to open the record for that navigation tab.

   c. On the form, fill in the fields.

   **Navigation Tab form**

<table>
<thead>
<tr>
<th>Name</th>
<th>Name of the navigation tab category.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option for determining whether the navigation tab filter displays.</td>
</tr>
<tr>
<td>Order</td>
<td>The position in which the navigation tab displays. The lower the order value, the further left it displays.</td>
</tr>
<tr>
<td>Label</td>
<td>Label to display for the navigation tab filter in the search application.</td>
</tr>
<tr>
<td>Search Context Config</td>
<td>This field is automatically set to the name of the search context configuration.</td>
</tr>
</tbody>
</table>

   d. Repeat this process for each category you want to display.

5. **Optional:** Customize the Autocomplete Suggestions tab, which relates to the display of relevant auto-complete suggestions as the user enters text.

   **Note:** The only options available for mobile applications are the section headers, **Recent searches** and **Popular searches**.
a. Select the Autocomplete Suggestions tab.

b. Select the information icon (ℹ️) next to either Recent searches or Popular searches and select Open Record to open the record for that navigation tab.

c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Suggestion Reader Group form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggestion Type</td>
</tr>
<tr>
<td>Section Header</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Order</td>
</tr>
<tr>
<td>Suggestion Limit</td>
</tr>
<tr>
<td>Click-in Mode</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

d. Repeat this process for each section header you want to display.

What to do next
After you have customized the display of your search results, select the AI Search results to be displayed in an applet launcher. See, Add AI Search to an applet launcher.

Consider configuring a customized empty state display to inform users that their search has not produced any results. If you do not customize an empty state, a preconfigured default empty state is displayed. To customize an empty state, see Configure an empty state for search results.
Add AI Search to an applet launcher

Configure your applet launcher to use the AI Search search engine.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > Studio.
2. Select your application.
3. In Application Explorer, navigate to Mobile Studio > Applet Launchers.
4. Open the applet launcher where you want to add search.
5. Select the Include Search option to enable it.
6. In the Search Criteria field, select the search configuration record to associate with your search option.
7. Click Save.

Define people search as inactive

Configure whether users can search for other users in the system. By default, people search is enabled.

Before you begin
Role required: admin

Procedure
1. Navigate to Now Mobile App > Applet Launchers.
2. Open the page where you want to disable people search.
3. In the Search Configuration field, select Homepage Search - Catalog and Knowledge.
4. Click Update.

Results
Your users can no longer see search results for other users in the system.

Configure catalogs

Enable your users to view and request their associated items in the Now Mobile app. If no catalogs are selected, users can view and request items from all catalogs in the system. By default, the app uses Service Catalog.

Before you begin
Role required: admin

About this task
Procedure

1. Navigate to Now Mobile App > Catalogs.

2. Optional: In the portal catalogs [m2m_sp_portal_catalog] table, add a catalog in addition to the base system catalog, or change the catalog that is associated with the base system record:
   
a. Click New or open the base system record.

   b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal</td>
<td>Portal that you select. Select Mobile Employee Service Portal.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Catalog that you would like to associate with the app.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that indicates the order that the configurations should run. If there are multiple configurations on a portal, the system runs the configurations from the lowest to the highest order that you selected.</td>
</tr>
</tbody>
</table>

Results
Your users can view and request items from all added catalogs.

Configure knowledge bases
Enable users to view knowledge articles from the mobile app. If no knowledge bases are selected, users can view articles from all knowledge bases in the system. By default, the app uses the IT knowledge base.

Before you begin
Role required: admin

About this task

Procedure


2. Optional: In the portal knowledge bases [m2m_sp_portal_knowledge_base] table, add a knowledge base in addition to the IT knowledge base.
   
a. Click New.

   b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option that you can select to make the configuration active.</td>
</tr>
<tr>
<td>Portal</td>
<td>Portal that you select. Select Mobile Employee Service Portal.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Knowledge base that you would like to associate with the app.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that indicates the order that the configurations should run. If there are multiple configurations on a portal, the system runs the configurations from the lowest to the highest order that you selected.</td>
</tr>
</tbody>
</table>

3. **Optional:** Change the default knowledge base that is associated with the Now Mobile app.
   a. In the **Portal** field, open the record with **Mobile Employee Service Portal**.
   b. In the **Knowledge Base** field, select the knowledge base that you would like to associate with the app.
   c. Click **Update**.

**Results**

Users can select the + icon on the applet launcher page to open the quick action.

**Configure Siri shortcuts for Now Mobile**

Configure Siri shortcuts for quick access to common features on your iOS mobile device.

**Before you begin**

Role required: admin

**Procedure**

1. Log in to a ServiceNow mobile app.
2. On the navigation bar, tap the **Settings**.
3. On the settings page, tap **Siri shortcuts**.
4. In the Siri shortcuts section, tap the plus button (+) to configure a Siri shortcut.

   **Note:** The currently available shortcuts are limited to **Open My Tasks**, **Browse Services**, and **Open My Requests**.
5. In the **When I say** field, add the phrase you want to say to Siri to open your app and use the selected shortcut.
Add to Siri

Add a custom phrase Siri can use to tell Mobile to run this shortcut.

When I say:

Shortcut Name

Do:

Open My Requests

Add to Siri
6. Tap Add to Siri.

Note: You can repeat this process to configure the remaining shortcuts, or change the phrase used to activate previously configured shortcuts.

Add a quick action in your mobile applications
Provide your users with a shortcut, which is also known as a quick action, to an item or action in your mobile apps. Quick actions appear on the applet launcher page.

Before you begin
Role required: admin

About this task
Demonstrates adding shortcuts, called quick actions, to applet launcher pages in the Now Mobile App.

Procedure
1. Navigate to Now Mobile App > Applet Launchers.
2. In the applet launchers [sys_sg_applet_launcher] table, open the applet launcher record that you would like to add the catalog item to.
   For example, open the Homepage record to add the catalog item under the icon on the home page.
3. Select the Body tab.
4. Add a record under the Quick Actions Menu Maps related list.
   If you’re not able to insert a row, make sure that you’re in the ServiceNow Now Mobile App Screens and Applet Launcher application scope.
5. Add one of the quick actions from the list.

<table>
<thead>
<tr>
<th>Quick action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report an Issue</td>
<td>Opens the Create Incident catalog item.</td>
</tr>
<tr>
<td>Chat</td>
<td>Opens Agent Chat.</td>
</tr>
</tbody>
</table>

Results
Your users can open the quick action by selecting the icon on the applet launcher page.

Create a quick action in your mobile applications
Provide easy access to an important item by creating a quick action. For example, you can create a quick action that opens a Service Catalog item.

Before you begin
Role required: admin
Procedure

1. Create a function for the quick action.

   a. Navigate to **System Mobile > Functions**.
   
   The Function [sys_sg_button] table opens.

   b. Click **New**.

   c. On the form, fill in the fields.

### Button fields form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the function record.</td>
</tr>
<tr>
<td>Description</td>
<td>Description to enable other users to easily understand the purpose of the function.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of quick action that you want to create.</td>
</tr>
<tr>
<td></td>
<td>To create a quick action that opens a Service Catalog item, select <strong>URL</strong>.</td>
</tr>
<tr>
<td></td>
<td>For more information about function types, see <strong>Configure a smart button</strong>.</td>
</tr>
<tr>
<td>Context</td>
<td>Whether the function applies at the record or table level.</td>
</tr>
<tr>
<td></td>
<td>• Record: Action only applies at the record level. For example, updating a field.</td>
</tr>
<tr>
<td></td>
<td>• Global: Action that only applies at the table level. For example, creating or deleting a record.</td>
</tr>
<tr>
<td></td>
<td>For this example, select <strong>Global</strong>.</td>
</tr>
<tr>
<td>Link Label</td>
<td>Label for the link. This value does not display in the user interface.</td>
</tr>
<tr>
<td>Link URL</td>
<td>Relative URL for the item that you want to open when the user clicks the function. For example, to open a Service Catalog item in the Now Mobile portal, enter <code>/mesp?id=sc_cat_item&amp;sys_id=060f3a3731300054b6a3549db5d3e</code>.</td>
</tr>
<tr>
<td></td>
<td>This field only displays if the <strong>Type</strong> field is <strong>URL</strong>.</td>
</tr>
<tr>
<td>Relative URL</td>
<td>Option that is selected to determine whether the URL is relative. For this example, choose <strong>Selected</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field only displays if the <strong>Type</strong> field is <strong>URL</strong>.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which the condition runs.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition that should be met for the action to be successful. For a catalog item, enter <code>var item = new sn_sc.CatItem('3f1dd0320a0a0b99000a53f7604a2ef9'); answer = item.canView() &amp;&amp; item.isVisibleServicePortal();</code> to display the quick action only when the end user has permissions to view the item.</td>
</tr>
<tr>
<td>Roles</td>
<td>Roles that you want users to have to view the quick action.</td>
</tr>
</tbody>
</table>
2. Add an instance of the function that you created to the page.

a. In the native UI, navigate to **Now Mobile App > Applet Launchers**.

b. Open the applet launcher record that you would like to add the quick action to.

c. Select the **Body** tab.

d. Insert a new row in the Quick Actions Menu Maps related list. If you're not able to insert a row, make sure that you're in the **ServiceNow Now Mobile App Screens and Applet Launcher** application scope.

e. Click the magnifying glass to look up an item
   The Function Instances [sys_sg_button_instance] table opens.

f. Click **New**.

g. On the form, fill in the fields.

### Function instance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the function instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Description to enable other users to easily understand the purpose of the function instance.</td>
</tr>
<tr>
<td>Parent</td>
<td>Page on which you are adding the quick action. For example, select <strong>Applet Launcher: Homepage</strong> to add the quick action to the home page. Select a value in the <strong>Parent table</strong> field first.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope.</td>
</tr>
<tr>
<td>Parent table</td>
<td>Table that contains the record type where the button appears. For this example, select <strong>applet Launcher [sys_sg_applet_launcher]</strong> to add the quick action to an applet launcher page.</td>
</tr>
<tr>
<td>Function</td>
<td>Function record that you created earlier.</td>
</tr>
<tr>
<td>Label</td>
<td>Label to help the user understand what the quick action opens. For example, Report an outage.</td>
</tr>
<tr>
<td>Location</td>
<td>Location where the button appears in the UI. For this example, select <strong>Quick Action</strong>.</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon to display next to the label. For more details on mobile icons, see Mobile icons.</td>
</tr>
</tbody>
</table>

**Note:** Not all listed icons work with quick actions. To see a list of compatible icons, filter your list where the **Icons** field contains `now-mobile-icons-buttons`.

**Note:** The **Icons** field is not on the icon list by default. To add the **Icon** field to your list, right-click the list header and select **Configure > List Layout**. Then, add the **Icon** field to the selected list. You should see the icon field on your reference field list.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Number that indicates the order that the functions are listed. If there are multiple instances in the same location, the app displays them from the lowest to the highest.</td>
</tr>
</tbody>
</table>

h. Click **Submit**.

i. Save the applet launcher record.

**Results**

Your users can open the quick action by selecting the 🔍 icon on the applet launcher page.

**Enable Live Agent in the Now Mobile app**

Activate the Chat quick action to allow your users to ask for help from a virtual or live agent from the Now Mobile home page.

**Before you begin**

Role required: admin

Ensure that the Agent Chat plugin is active. For more information, see Agent Chat.

**About this task**

Chat is enabled from the Requests and Knowledge Articles pages by default.

ℹ️ **Note:** Connect Chat and pre-chat conversation routing is not supported in the Now Mobile app.

**Procedure**

1. Navigate to **Now Mobile App > Applet Launchers**.
2. In the Applet Launchers [sys_sg_applet_launcher] table, open the Homepage record and select the **Body** tab.
3. Under the Quick Actions Menu Maps related list, open the Chat record.
4. Select **Active** to activate the record.
5. Click **Update**.

**Results**

Users can select Chat in the Homepage quick actions menu to ask for help from a live or virtual agent.

**Related information**

- ITSM Virtual Agent conversations

**Populate search suggestions in the mobile apps**

If you are upgrading from a previous release, run a script to populate search suggestions with data from a platform search table to provide search suggestions to your users. Alternatively, you can wait until users search for keywords instead of running this script.

**Before you begin**

Role required: admin
In new instances, the search suggestions are enabled by default. In upgraded instances, you must enable the search suggestions. For more information, see Enable search suggestions.

About this task
The Now Platform collects search data and analytics that generate search suggestions. If you are upgrading from a previous release, the search analytics do not contain any data yet. To immediately provide suggestions to your users, you can populate the search suggestions using knowledge, catalog, and user search records from the Text Searches [text_search] table.

Search suggestions improve over time as more people use the app. Search Suggestions is a Now Platform feature. For more information, see Search Suggestions.

⚠️ CAUTION: Populating search suggestions can be a resource-intensive task that may take a while to complete. Do not run this script during peak hours. Populating search suggestions is not supported on domain-separated instances.

Procedure
1. Navigate to System Definition > Scheduled Jobs.
2. Open the Populate Suggestions to avoid Cold Start - NowMobile App scheduled job.
3. Activate the record and select Execute Now.
   Running this scheduled job populates the Search Events [sys_search_event], Search Source Events [sys_search_source_event], and Search Suggestions [sys_search_suggestion] tables with records from the Text Searches [text_search] table.

Results
Users see suggestions when they start typing in a search field in the Now Mobile app.
Index

A
Agent Workspace
1122
assign HR skills
516, 1367
assign HR skills to group
514, 1366
assignment rules
create for HR
522, 1375
human resources
1374
test
523, 1376

B
bank account
create
1435
modify
1435
beneficiary
create
580, 1415
modify
580, 1415
benefit
create
500, 501, 1422
modify
500, 501, 1422
type
500, 1422
benefit provider
create
1421
modify
1421
benefit providers
1420
benefit types
1420
benefitProvider
create
500, 501, 1422
modify
500, 501, 1422
plan
501
provider
501
benefits
case management
1414
Bundle Execution Contexts

catalog categories
human resources
1350
catalog items
human resources
1351
categories, HR case
create or modify
1356
defined
1356
Client role assignment rules
508, 518
client role rules
519
COI
1710
configuration
human resources
1368
Counsel Assist
1680
create HR skills
515, 1365
disclosed developer
512
dental benefit
create
1416
modify
1416
departments
view
498, 1345
disability insurance benefit
create
584
modify
584
disciplinary issue
create
502, 1426, 1427
modify
502, 1426, 1427
type
502, 1427
disciplinary warning
create
503, 1428
modify
503, 1428
Create
595
employee change
1446
escalate
617, 1384
offboarding
1439
onboarding
1444
request and complete
employee information change
1437
request documentation
1384
request employment verification
1410, 1441
request tuition reimbursement
1410
suspend
617, 1383
view progress
1408
work on
1380
HR case categories
create or modify
1356
defined
1356
HR case information
view
601, 616, 1387
HR case management
588, 1376
HR cases
VIP handling
620, 1385
HR catalog
1345, 1347
HR content modify
create
896
HR employee data management
1437
HR Groups
512
HR knowledge
1337
manage
657, 1338
HR manage roles
client role assignment rules
519
escalation rules
517
HR onboarding dashboard
1391
HR portal
monitor chat queue
531, 1400

HR profile
568, 1340
customized
571, 1330, 1341
emergency contacts
578, 1407
synchronized fields
571, 1330, 1341
update
1407

HR profile records
editable fields
568, 1373

HR profile security
570, 1340

HR profiles
generate
585

HR Service Delivery
1122

HR service portal
548, 1407
knowledge base
1412
submit request
1408

HR Service portal
chat
1413
e-mail
1413

HR skills
assign to task models
1365
assign to users
515, 1365
create
515, 1365
management
514, 1364
modify
515, 1365

HR skills, assign
516, 1367

HR skills, assign to group
514, 1366

HR surveys
493, 1332
create
494, 666, 1332
evaluate responses
665, 1397
modify
494, 666, 1332
publish
496, 1335
questions
494, 1334
trigger conditions
496, 1335

HR system report definition
create
1431
modify
1431

HR system report frequencies
create
504, 1432
modify
504, 1432

HR task
add
create
update
605
view
605, 1382

HR task information
view
612

HR task office space request
611

hr tasks
overview
1388

HR templates
1345, 1347

HR tier escalations
517

HRSM
410, 1314

human resources
410, 1314
add a pdf document template
1360
administer
422, 1331
application view
476
assignment rule test
523, 1376
assignment rules
521, 1374
benefits
1413
case templates
1352
catalog
1345, 1347
catalog categories
1350
catalog items
1351, 1352
change information process
workflow
1329
change process design 1325
change process design stages 1325
configuration 1368
criteria 478
customized HR profile 571, 1330, 1341
dashboards and reports 660
employee relations 1425
getting started
  implementation 1317
how auto-assignment works 1321
HR case SLA 1395
HR service portal 548, 1407
implement
  assemble team 1317
  configure system 1323
  gather information 1322
  make decisions 1317
installed components
  business rules 1308
  client scripts 1306
  email notifications 1311
  events 1312
  groups 1305
  HR catalog items 1313
  HR skills 1313
  roles 1303
  script includes 1306
  tables 1302
  user groups 1305
  user roles 1303
knowledge article 1352
lifecycle events dashboard 1003
manage chat queue 530, 1398
matching rules 524
modify pdf document template 1359
offboarding process workflow 1329
offboarding task templates 1347
onboard task templates 1348
onboarding dashboard 1391
onboarding process workflow 1327
organization 1339
overview 1388
overview dashboard 1388
overview reporting dashboard 1389
payroll 1434
pdf document templates 1358
performance analytics 1245, 1447
product models 1352
properties 423
reports 663, 1393
run reports 663, 1392
systems 1429
task templates 1355
templates 1345, 1347
view HR case SLA 1396
Human resources
  installed components 1302
  PDF Template Mapping 487
Human resources document
generation 603
Human resourcesAdd
  Modify 485
operations system
create
HR
modify
organization
positions
relationship
overview
HR dashboard
overview reporting
HR dashboard
payroll
case management
payroll record
create
modify
performance analytics
human resources
pharmacy benefit
create
modify
positions
organization
Practice Area
Legal Intake Form
Practice Area Category
product models
human resources
relationship
organization
reports
human resources
retirement benefit
create
modify
retirement benefit
create
modify
Search Sources
signature pad
activate
Signature-pad
SLA
human resources
view HR case
solution
Submit a legal contract request
synchronized HR profile fields
system access
grant
modify
system report
create
modify
typetype
systems
case management
Submit a legal contract request
task
view
open cases
test
tuition reimbursement
create
modify
user directory
VA Conversation Topics for Legal apps
1766, 1769
VA Conversations for Legal Service Delivery
1766, 1769
visa category
create 506
modify 506
vision benefit
create 1420
modify 1420

Who
covered
create 579
modify 579
workplace reservation
1537